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Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and safety 
instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying 
risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Working with Projects 1
1 Resources

1.1 Working with Projects

Content
Before you can monitor and control a process, you must first create a project in WinCC. You 
define all necessary elements and settings in this project.

This section shows you 

● How to open and close WinCC and the WinCC Explorer

● The structure of the WinCC Explorer

● The types of project in WinCC

● How to create a project and work with it

● How to activate and deactivate a project

● How to copy a project

1.2 Opening WinCC Explorer

Introduction
When you start WinCC, the WinCC Explorer normally is opened.

After installation, WinCC is entered in the start menu of the operating system. WinCC can be 
started with the "WinCC V7.0" command.

The WinCC Explorer can also be opened from the desktop or using the Windows Explorer.

Note

If you only have a Runtime license installed on a computer, you can only work in the WinCC 
Explorer or in a WinCC editor for one hour. If the WinCC Explorer or a WinCC editor remains 
open for more than one hour, WinCC changes to the demonstration mode.
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Principle
You can open the WinCC Explorer in the following ways:

● from the Windows Start menu

● by clicking the WinCCExplorer.exe file in the Windows Explorer

● using a shortcut from the Windows Desktop

● in the Windows Explorer using the <PROJECT>.MCP

● with Autostart

● with a project that opens in Autostart

You can start WinCC only once on a computer. If you attempt to open the WinCC Explorer 
when it is already open, this will be prevented without an error message. You can continue to 
work normally in the open WinCC Explorer.

Start Mode of the WinCC Explorer

Open project
When you start WinCC the first time, the WinCC Explorer is opened without a project. 
Whenever you start WinCC again, the last project you had open will be opened again.

With the key combination <SHIFT> + <ALT>, you can prevent WinCC from opening a project 
immediately. Press the <SHIFT> key and the <ALT> key while WinCC is opening. Keep the 
keys pressed until the window of the WinCC Explorer is displayed. The WinCC Explorer opens 
without opening a project.

Activated Project
If the project was activated when you exited WinCC Runtime, it will be opened in Runtime 
again when you restart WinCC.

If you close a project and open another project that was opened the last time in the activated 
state, WinCC once again opens the project in Runtime.

With the key combination <SHIFT> + <CTRL>, you can prevent WinCC activating Runtime 
immediately. Press the <SHIFT> key and the <CTRL> key while WinCC is opening. Keep the 
keys pressed until the project is open and displayed fully in the WinCC Explorer. WinCC opens 
the last project without starting Runtime.

Opening WinCC Explorer

Windows Start Menu
You can open the WinCC Explorer from the Windows Start menu. In the folder SIMATIC > 
WinCC, select the entry "WinCC V7.0". WinCC Explorer is opened.
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Windows Explorer
You can start WinCC with the WinCCExplorer.exe start file. The WinCCExplorer.exe file can 
be found in the Windows Explorer in your installation path in WinCC\bin.

Windows Desktop
You can create a shortcut for the WinCCExplorer.exe file. You then place this shortcut on the 
desktop of the computer.

Opening a Project in the Windows Explorer
You can start WinCC by opening a WinCC project in the Windows Explorer. Open the 
<PROJECT>.MCP file in the installation path of the project.          
You can only start a project from the Windows Explorer when WinCC has not yet started.

Autostart
You can also start WinCC using Autostart when the computer starts up. Create a shortcut to 
the WinCCExplorer.exe file and move this shortcut to the Autostart folder of your computer. 
Each time you start the Windows system, WinCC will also be started automatically. 

Opening the WinCC Explorer with a Project Open
You can close the WinCC Explorer without closing the open project. You can reopen the WinCC 
Explorer from the Windows Start menu or by clicking a shortcut on the desktop. This also 
applies even if you open a project using Autostart only in Runtime.

Remote WinCC Startup
You can start WinCC of another computer in the network. You find more detailed information 
in the WinCC Information System under Configurations > Multi-User Systems > Remote 
Configuration.

Open project

File > Open
In the WinCC Explorer, you open a project with the Open command in the File menu. In the 
Open window, select the project folder and open the <PROJECT>.MCP project file.

File > Last File
In the File menu, you can open one of the last files opened with the Last File command. Up to 
eight projects are displayed.
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"Open" Button

You can open a project with the  button in the toolbar.

Opening a Project with Autostart
You can open a specific project using Autostart when your computer starts up. To do this, use 
the Autostart tool of WinCC.

Note

If you open a project while another project is active in Runtime, Runtime is deactivated and 
the previously active project is closed.

See also
Editors and Functions in WinCC Explorer (Page 146)

Elements of the WinCC Explorer (Page 35)

How to Start Runtime (Page 132)

Closing WinCC Explorer (Page 32)

1.3 Closing WinCC Explorer

Introduction
When you close the WinCC Explorer, you normally close the project that was last open at the 
same time.

If Runtime is activated, or if you have opened a WinCC editor, you can close the WinCC 
Explorer separately. The project remains open and active if it was already active. Open editors 
are not closed. You can open the WinCC Explorer again from the Windows Start menu or from 
a shortcut on the desktop.

You can close the WinCC Explorer regardless of whether a project is open. The relevant 
WinCC processes continue to run in the background. When you open the WinCC Explorer 
again, WinCC does not need to reload the project data and the Explorer takes less time to 
open.

Principle
You can exit WinCC in the following ways:

● With the Exit command in the WinCC Explorer menu bar

● With the Shut Down command in the WinCC Explorer menu bar

● With the Close button
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● When you shut down Windows

● With a C action in the activated project

Note

After starting, WinCC always opens the last project that was open before you exited. If the 
project was activated when you exited WinCC, it will be opened in Runtime again.

Closing WinCC Explorer

File > Exit
Close the WinCC Explorer with the Exit command in the File menu. The Exit WinCC Explorer 
dialog box is opened.

In the list box, you can select one of the following options:

Selection WinCC Action

Close project and exit WinCC 
Explorer

If active, the project is also deactivated and closed. The WinCC 
Explorer and all open WinCC editors are closed.

Exit WinCC Explorer Only the WinCC Explorer closes. The project remains open and 
active if it was already active. WinCC editors remain open.

File > Shut Down
In the File menu of the menu bar, select the Shut Down command. Depending on your 
computer configuration, you can exit WinCC with Shut Down and at the same time shut down 
the computer.

Close Button

You can close the WinCC Explorer with the  button in the top right corner of the window.

Exiting Windows
When you exit Windows or log off the current user, WinCC closes completely.

C Action in the Activated Project
You can, for example, configure a button in the project with which you can exit WinCC or 
Windows. To do this, use the Exit WinCC or Exit WinCC or Windows dynamic wizards.
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See also
Elements of the WinCC Explorer (Page 35)

How to Exit Runtime (Page 137)

Opening WinCC Explorer (Page 29)

1.4 The WinCC Explorer

1.4.1 The WinCC Explorer

Introduction
When you start WinCC, the WinCC Explorer is opened. With the WinCC Explorer, you can

● Create a project

● Open a project

● Manage project data and archives

● Open editors

● Activate or deactivate a project.

 

See also
Activating Project (Page 132)

Editors and Functions in WinCC Explorer (Page 146)

Elements of the WinCC Explorer (Page 35)

Closing WinCC Explorer (Page 32)

Opening WinCC Explorer (Page 29)
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1.4.2 Elements of the WinCC Explorer

Structure of the WinCC Explorer
The user interface of the WinCC Explorer consists of the elements shown in the screenshot:

① Title bar
② Menu bar
③ Toolbar
④ Navigation window
⑤ Data Window
⑥ Status bar
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See also
Opening WinCC Explorer (Page 29)

Editors and Functions in WinCC Explorer (Page 146)

Search Function (Page 44)

Windows of the WinCC Explorer (Page 41)

Status Bar and Title Bar of WinCC Explorer (Page 40)

Toolbar of the WinCC Explorer (Page 39)

Menu Bar of the WinCC Explorer (Page 36)

1.4.3 Menu Bar of the WinCC Explorer

Introduction
The menu bar of the WinCC Explorer includes most of the commands that you can use in the 
Windows Explorer. Commands that you cannot use in the current situation are disabled 
(displayed in gray).

Some commands are available only when you open the Pop-up menu of an element in a 
window.

Some commands can be activated using the key combinations (shortcut keys) familiar from 
Windows.

The following tables provide brief information on the commands in the menu bar. The Online 
Help (Chapter) column indicates the relevant chapters in the WinCC Information System that 
contain more detailed information.

File Menu
The File menu includes the following commands:

Command Key combination Function Online help (chapter)

New <CTRL+N> Creates a new project. Working with Projects > 
Creating and Editing Projects

Open <CTRL+O> Opens an existing project. Working with Projects > 
Creating and Editing Projects

Close --- Closes an open project. Working with Projects > 
Creating and Editing Projects

Activate --- Starts an open project in Runtime. Working with Projects > 
Activate project

Print Project 
Documentation

--- Prints the project documentation. Documentation of 
Configuration and Runtime 
Data > Project Documentation

View Project 
Documentation

--- Starts the print preview of the project 
documentation.

Documentation of 
Configuration and Runtime 
Data > Project Documentation
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Command Key combination Function Online help (chapter)

Project Documentation 
- Setup

--- Sets up the project documentation for 
printing.

Documentation of 
Configuration and Runtime 
Data > Project Documentation

Recent File --- Displays the most recently opened projects 
up to a maximum of eight. You can select 
one of the projects and open it.

Working with Projects > 
Creating and Editing Projects

Exit <ALT+F4> Opens a dialog in which you can close the 
WinCC Explorer.

Working with projects > 
Closing the WinCC Explorer

Shut Down --- Exits WinCC and shuts down the computer. Working with projects > 
Closing the WinCC Explorer

Edit Menu
The Edit menu includes the following commands:

Command Key combination Function Online Help (Chapter)

Undo <CTRL+Z> Undoes the last action. This command is not 
available for all actions.

---

Cut <CTRL+X> Cuts the selected object. With Paste, the object 
can be moved to another location.

---

Copy <CTRL+C> Copies the selected object to the clipboard. ---
Paste <CTRL+V> Pastes a copied or cut object. ---
Delete <DEL> Deletes a selected element. ---
Properties --- Displays the Properties dialog of a selected 

element.
Refer to the description of the 
relevant editor.

View Menu
The View menu includes the following commands:

Command Key combination Function Online Help (Chapter)

Toolbars --- Displays or hides the toolbar. Working with Projects > The 
WinCC Explorer

Status Bar --- Displays or hides the status bar. Working with Projects > The 
WinCC Explorer

Large Symbols --- Displays the elements in the data window as 
large symbols.

---

Small Symbols --- Displays the elements in the data window as 
small symbols.

---

List --- Displays the elements in the data window as a 
list of names.

---

Details --- Displays the elements in the data window as a 
list of names with additional information, for 
example date modified and file type.

Refer to the description of the 
relevant editor.

Refresh <F5> Refreshes the view in the data window. ---
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Tools Menu
The Tools menu includes the following commands:

Command Key combination Function Online help (chapter)

Language --- Changes the user interface language of the 
WinCC Explorer and editors.

Structure of Multi-language 
Projects > Language Support in 
WinCC

Status of 
Driver 
Connections

--- Displays the status of logical connections in the 
project.

Communication Diagnostics> 
Channel Diagnostics

Status of 
Server 
Connections

--- Displays the communication in a multi-user 
system in the WinCC client or in the WinCC 
server for a server-server communication.
Green = Connection status: Data exchange 
takes place when established.         
The communication between two computers 
and not the redundance status is displayed 
here. Multiple green symbols do not mean 
multiple master servers.         
         
gray = connection status Established, no data 
exchange.         
         
Red = Connection status: Disconnected.         
? = Status unknown.

Working with Projects > The 
WinCC Explorer

Status of 
Client 
Connections

--- Displays the current status of all servers and 
clients involved in a WinCC server.
Green = Connection status: Data exchange 
takes place when established.         
The communication between two computers 
and not the redundance status is displayed 
here. Multiple green symbols do not mean 
multiple master servers.         
         
gray = connection status Established, no data 
exchange.         
         
Red = Connection status: Disconnected.         
? = Status unknown.

Working with Projects > The 
WinCC Explorer

Help Menu
The Help menu includes the following commands:

Command Key combination Function Online help (chapter)

Contents 
and Index

<F1> Opens the WinCC information system. ---

Direct Help <SHIFT+F1> Activates the direct help (What's this?). ---
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Command Key combination Function Online help (chapter)

Use Help --- Tips on working with help. ---
About 
WinCC 
Explorer

--- Displays the installed version and the installed 
components of WinCC.

---

See also
Editors and Functions in WinCC Explorer (Page 146)

Activating Project (Page 132)

Closing WinCC Explorer (Page 32)

Opening WinCC Explorer (Page 29)

Windows of the WinCC Explorer (Page 41)

Status Bar and Title Bar of WinCC Explorer (Page 40)

Toolbar of the WinCC Explorer (Page 39)

1.4.4 Toolbar of the WinCC Explorer

Introduction
Using the buttons in the toolbar, you can activate commands. You can also hide the toolbar 
in the WinCC Explorer by selecting the View menu in the menu bar and clicking the Toolbar 
command.

Buttons in the Toolbar

The toolbar in the WinCC Explorer contains buttons with the following functions:

Icon Tooltip Description

New Creates a new project.

Open Opens a project.

Deactivate Exits Runtime.

Activate Starts the project in Runtime.

Cut Cuts a selected object. The object is deleted at its original location as soon 
as it is pasted elsewhere.

Copy Copies an object to the clipboard. The object can be duplicated at the same 
location or a comparable location in the path.

Paste Pastes a cut or copied object.
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Icon Tooltip Description

Large 
Symbols

Elements in the data window are displayed as large symbols.

Small 
Symbols

Elements in the data window are displayed as small symbols.

List Elements in the data window are displayed as a list of names only.

Details Elements in the data window are displayed as a list with detailed information.

Properties Opens the Properties dialog of an element.

Help Activates the direct help for an element you then left click.

For more information on the commands, refer to chapter Menu Bar.

 

See also
Activating Project (Page 132)

Opening WinCC Explorer (Page 29)

Windows of the WinCC Explorer (Page 41)

Status Bar and Title Bar of WinCC Explorer (Page 40)

Menu Bar of the WinCC Explorer (Page 36)

1.4.5 Status Bar and Title Bar of WinCC Explorer

Introduction
The status bar and title bar contain general information on the project and settings in the editor.

Title bar
The current path of the open WinCC project is displayed.

Status bar
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Field Description

Status Displays tips on editing and displays the current path of a file.
Number of configured tags / 
Number of power tags

Number of configured external tags / number of tags covered by 
a license 

Object(s) Number of objects of the selected editor, e.g. the number of 
pictures in Graphics Designer

CAPS SHIFT function is active (upper case).
NUM The numeric pad on the right of the keyboard is active.
SCRL The Windows Scroll function is active.

See also
Windows of the WinCC Explorer (Page 41)

Toolbar of the WinCC Explorer (Page 39)

Menu Bar of the WinCC Explorer (Page 36)

1.4.6 Windows of the WinCC Explorer

Introduction
In the WinCC Explorer, you work in the navigation window and in the data window.

In these windows, you can open the context-sensitive help for each element with the right 
mouse button. If a project is active in Runtime, a tooltip is available for elements of the tag 
management in the data window.
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① Menu bar
② Toolbar
③ Navigation window
④ Tooltip
⑤ Data Window
⑥ Status bar

Navigation window
The navigation window contains the list of editors and functions in the WinCC Explorer. You 
can open an element in the navigation window by double-clicking it or using the pop-up menu.

You open the pop-up menu with the right mouse button. The Open command is displayed. 
Additional commands for selection are displayed depending on the element.          
For the editors Graphics  Designer and Report Designer > Layouts you can show the 
Information column of the data window using the Display Column Information option. The entry 
in this column shows how the corresponding object was created.
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Method of Creating the Object Entry in the Information column

Object has been created using WinCC Explorer. <No entry>
Object has been created using WinCC Explorer 
and then imported to SIMATIC Manager using the 
Import WinCC Objects function.

Created by SIMATIC Manager

Object has been created using SIMATIC Manager. Created by SIMATIC Manager

If you click the plus character in front of the Tag Management or Structure Tag entries, you 
expand the folder tree. In these folders, you can navigate, create, or move objects.

The Graphics Designer and Global Script editors also have subdirectories. If you click one of 
these editors, WinCC displays these directories. The Report Designer contains the two folders 
Layouts and Print Job. Global Script contains the two folders Actions and Standard Functions.

For more detailed information on the editors, refer to the relevant sections of the WinCC 
Information System.

Data Window
If you click an Editor or a folder in the navigation window, the data window displays the elements 
belonging to the editor or folder. The information displayed varies from editor to editor.

Double-click an element in the data window to open it. Depending on the element, WinCC 
performs one of the following actions:

● Opens an object in the appropriate editor.

● Opens the Properties dialog of an object.

● Displays the next level of a folder path.

Right-click an element to call up the pop-up menu where you can select the Properties dialog 
of the element. With some editors, other commands are displayed that you can select.

You can rename the elements in the data window with the <F2> key or by clicking the selected 
name.

Tooltips
If Runtime is activated, WinCC displays information on tags and connections in the form of a 
tooltip. For more detailed information, refer to the WinCC Information System under Working 
with Tags.

See also
Editors and Functions in WinCC Explorer (Page 146)

Status Bar and Title Bar of WinCC Explorer (Page 40)

Toolbar of the WinCC Explorer (Page 39)

Menu Bar of the WinCC Explorer (Page 36)

Search Function (Page 44)
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1.4.7 Search Function

Starting the Search Function
You can start a search in the navigation window and in the data window of the WinCC Explorer 
by selecting the Find... command in the pop-up menu of the project, the computer, or the tag 
management. The Find dialog opens.

Searchable elements
You can search for the following elements in a project:

● Client computers

● Server computers

● Driver connections

● Channel units

● Connections

● Tag groups

● Tags

Working with Projects
1.4 The WinCC Explorer

MDM - WinCC: Working with WinCC
44 System Manual, 11/2008,  



You can restrict the search to individual element types. Select the required element type on 
the Additional Options tab in the Type list box. In the Parameter Text field, you can specify an 
individual parameter as an additional search criterion.

Searching by Name
On the Name tab, you can enter the name of the required element in the Find What list box. 
If you have made several searches, you can display the list of terms you have searched for in 
the Find What list box.

The entries you make for searches are not case-sensitive.

Wildcard
The "*" character can be used as a wildcard. This replaces any number of characters at the 
beginning or end of the name.

If you enter "var*", all elements whose names start with "var", are displayed, e.g.

● "Variable_2" tag,

● "variablegroup_tank" tag group,

● a computer with the name "VAR0516".

In the same way, you could enter "*tank" to search for all elements whose name ends with 
"tank".

Searching by Date
In the Date of Change tab, you can search for elements created or modified during a specific 
period.

Starting and Stopping a Search
Once you have specified all options for the search, start the search with the Start button. Click 
the Stop button if you want to stop the search.

If you double-click an object that has been found, you change to the path in which this object 
is located in the WinCC Explorer.

To delete all search information you have entered, click the New Search button. You can then 
formulate a new search.

To close the Find dialog, click the  button in the top right corner.
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See also
Editors and Functions in WinCC Explorer (Page 146)

Windows of the WinCC Explorer (Page 41)

Status Bar and Title Bar of WinCC Explorer (Page 40)

Toolbar of the WinCC Explorer (Page 39)

Menu Bar of the WinCC Explorer (Page 36)

1.5 Project Types

1.5.1 Project Types

Introduction
There are three types of project available in WinCC:

● Single-user project

● Multi-user project

● Client project

See also
Changing Project Type (Page 49)

Client Project (Page 48)

Multi-User Project (Page 47)

Single-User Project (Page 46)

1.5.2 Single-User Project

Introduction
If you only want to work with one computer in a WinCC project, create a single-user project.

The WinCC project runs on one computer that functions as the server for processing the data 
and as an operator input station. Other computers cannot access the project.

Principle
The computer on which you create the single-user project is configured as a server.

The computer is connected to the programmable controller via the process communication.

Working with Projects
1.5 Project Types

MDM - WinCC: Working with WinCC
46 System Manual, 11/2008,  



Redundancy
You can also create a single-user project as a redundant system. In this case, you configure 
a single-user project with a second redundant server.

Archive Server
You can also create an archive server for a single-user project. In this case, you configure a 
single-user project and a second server on which the data of the single-user project is archived.

See also
Changing Project Type (Page 49)

Multi-User Project (Page 47)

1.5.3 Multi-User Project

Introduction
If you only want to work with several computers in a WinCC project, create a multi-user project.

For a multi-user system, there are two basic options:

● Multi-user system with one or more servers:          
Several servers with one or more clients. One client accesses several servers. The Runtime 
data is distributed on different servers. The configuration data is on the servers and on the 
clients.

● Multi-user system with only one server:          
One server with one or more clients. All data is on the server.

Principle
You create a multi-user project on the server. The server is connected to the programmable 
controller via the process communication.

In the multi-user project, you configure the clients that access the server. In a second step, 
you create the required client projects on the relevant computers.

If you want to work with several servers, duplicate the multi-user project on the second server. 
Adapt the duplicated project accordingly. You can also create a second multi-user project on 
the second server that is independent of the project on the first server.

A server can also access another server in the role of client. You can use this option, for 
example, when you use an archive server or a file server.
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See also
Changing Project Type (Page 49)

Single-User Project (Page 46)

Client Project (Page 48)

1.5.4 Client Project

Introduction
If you create a multi-user project, you must then create the clients that access the server. You 
create a client program on the computer that will be used as a client.

For a WinCC client, there are two basic options:

● Multi-user system with one or more servers:          
The client accesses several servers. The Runtime data is distributed on different servers. 
The configuration data on the multi-user projects is on the relevant servers. There may be 
local configuration data in the client projects on the clients: Pictures, scripts and tags.

● Multi-user system with only one server:          
The client only attempts to access one specific server. All data is located on the server and 
is referenced on the clients.

An archive server or a file server can also access another server in the role of client.

Note

The WinCC client replaces the clients and multi-clients that were used in WinCC up to version 
V5.1. Depending on the configuration, a WinCC client takes over the role of a V5.1 client or 
a V5.1 multi-client.

Principle
You create a multi-user project on the server. The server is connected to the programmable 
controller via the process communication. In the multi-user project, you create the clients that 
access the server.

If you configure a multi-user system with only one server, you do not create a separate client 
project on the WinCC client.

If you configure a multi-user system with several servers, you must create a separate client 
project on each client. This also applies when you only want to access one server but require 
additional configuration data on the client.

Multi-User System with One or More Servers
To access more than one server, you create a client project on the client. You specify the 
project properties on the WinCC client.
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On the server, you create packages using the Serverdata component. The packages contain 
all important configuration data of the multi-user project. You load the packages on the WinCC 
client.

You only need to create and compile the packages once manually. If the configuration data 
on a server is modified, WinCC automatically generates the required packages. The packages 
can be downloaded to the clients automatically or manually.

Central Server Configuration for a Multi-User System with One Server
If you want to configure a client that accesses only one server, specify all settings in the multi-
user system on the server. When you edit the startup list of the client, you should only start 
applications that are actually required on the client.

You do not create a separate project on the client. You start the server project using remote 
access. You find more detailed information in the WinCC Information System under 
Configurations > Multi-User Systems.

Web Client
You can configure a client that accesses the server over the intranet or over the Internet. If 
you require this type of access, you create a Web client with the WinCC Web Navigator option.

See also
Changing Project Type (Page 49)

Multi-User Project (Page 47)

1.5.5 Changing Project Type

1.5.5.1 Changing Project Type

Introduction
If the configuration in your project changes, you can adapt the project type:

● You want a single-user project to run on a server as a multi-user project.

● You want a multi-user project to run as a single-user project without clients.

See also
How to Change a Multi-User Project to a Single-User Project (Page 50)

How to Change a Single-User Project into a Multi-User Project (Page 50)
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1.5.5.2 How to Change a Single-User Project into a Multi-User Project

Introduction
You can change a project you created as a single-user project to a multi-user project.

This can, for example, be useful when you want to create and test an entire project before 
running it in a multi-user system.

Procedure
1. Select the project name in the navigation window of the WinCC Explorer. Open the Project 

Properties dialog in the pop-up menu.

2. Go to the General tab and select the Multi-User Project project type in the Type list box. 
Click OK to confirm.

3. The Change Project Type dialog is opened with the message: The project type has been 
changed. Do you want to delete the startup list?          
If you want to include the startup list in the modified project, select No.          
If you want to create a new startup list, select Yes. After changing the project type, create 
the startup list.

4. A dialog is opened with the message: The changes to the project type will take effect when 
the project is closed and reopened on all computers on which the project is currently open. 
Click OK to confirm.

5. Close the project in the WinCC Explorer and open it again. WinCC then accepts the 
changed project type.

6. Create the required clients under the Computer component. Create the WinCC clients you 
require and adapt the configuration.

See also
How to Change a Multi-User Project to a Single-User Project (Page 50)

How to Set Up a Startup List (Page 107)

Single-User Project (Page 46)

Multi-User Project (Page 47)

1.5.5.3 How to Change a Multi-User Project to a Single-User Project

Introduction
You can change a project you created as a multi-user project to a single-user project. The 
clients you created are not included because only one computer is created in a single-user 
project.

This can, for example, be useful when you want to use an existing configuration for a new 
project.
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Procedure
1. Select the project name in the navigation window of the WinCC Explorer. Open the Project 

Properties dialog in the pop-up menu.

2. Go to the General tab and select the Single-User Project project type in the Type list box. 
Click OK to confirm.

3. The Project Properties dialog is opened with the message: A change from a multi-user to 
a single-user or client project will delete all configured client computers from the computer 
list. Click OK to perform this change or Cancel to keep the multi-user project. Click OK to 
confirm.

4. The Change Project Type dialog is opened with the message: The project type has been 
changed. Do you want to delete the startup list?          
If you want to include the startup list in the modified project, select No.          
If you want to create a new startup list, select Yes. After changing the project type, create 
the startup list.

5. A dialog is opened with the message: The changes to the project type will take effect when 
the project is closed and reopened on all computers on which the project is currently open. 
Click OK to confirm.

6. Close the project in the WinCC Explorer and open it again. WinCC then accepts the 
changed project type.

7. Adapt the computer properties and the configuration.

 

See also
How to Change a Single-User Project into a Multi-User Project (Page 50)

How to Set Up a Startup List (Page 107)

Single-User Project (Page 46)

Multi-User Project (Page 47)

1.6 Creating and Editing Projects

1.6.1 Preparation to Create a Project

Introduction
You don't yet need detailed planning to create a WinCC project. To create the WinCC project 
efficiently, you should nevertheless give some initial thought to the structure of the project. 
Depending on the size of the planned project and number of configuration engineers involved, 
it may be useful to make certain settings and decide on certain rules.

This chapter contains information on some of the elements in a project that you should specify 
before you start the configuration work: 
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● Project Type

● Project Path

● Naming conventions

● Tag Groups

● Picture Hierarchy

● Faceplate types

● Reusing project sections

Project Type
Before you start to plan your project, you should already know whether you require a single-
user system or multi-user system. If you are planning a project with WinCC clients or Web 
clients, make sure you know the factors affecting performance.

Project Path
A WinCC project does not need to be created on the same partition on which you installed 
WinCC. It is sometimes better to create a separate partition for a project. When you create a 
partition, make sure you have adequate space for the anticipated amounts of data. If you 
archive a lot of data, the WinCC project can take up several gigabytes of space.

A separate partition also ensures that the WinCC project and all data contained in it are not 
lost if there is a system crash.

Note

WinCC projects should not be saved to compressed drives or directories. 

Naming Conventions
Using naming conventions can make it easier to handle large projects. You can increase the 
clarity in your project particularly if you use conventions for naming tags, pictures, or functions 
in your project. Note the restrictions applying to names outlined in chapter Illegal Characters.

Project name
Changing the name of a project once it has been created involves a number of steps. It is 
advisable to decide on a suitable name before creating the project.

Tags
You can give tags a prefix that identifies the tag type or the connection assigned to the tag.  
You could, for example, give all text tags the prefix "txt_" and internal tags the prefix "int_".

If you develop a company standard, the prefixes should be the same for all projects.
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Pictures
You can specify prefixes for pictures, for example to identify plant pictures and system pictures.

If you create a large number of pictures, you can include continuous numbers in the picture 
names.

Functions
With functions, it is useful to introduce a prefix for your company standard. This makes it clear 
at a glance which functions are required for the standard.

Tag Groups
To structure tags, you can create tag groups. In WinCC, you cannot nest groups but can only 
create one level with tag groups.

Picture Hierarchy
If you want to reduce the configuration time, you should plan the picture hierarchy in your 
project before you start the project. It is advisable to work out an overview of the pictures you 
need to create. Using a basic picture and the tag prefix, you can structure navigation within 
your project.

Faceplate types
You can configure, save and reuse individual objects or groups of objects as faceplate types 
in different pictures as faceplate instances. Thus, you can avoid always recompiling and 
configuring frequently used picture elements. 

Reusable Project Sections
You can take various project sections from existing WinCC projects. These include pictures, 
tags, functions, and actions.

Standard project
If you do not want to repeatedly take data from an existing WinCC project, you should create 
a standard project. In this project, you can configure basic project sections to suit your needs. 
When you create a new WinCC project, you can simply copy the standard project and then 
work with the copy. This saves you time during configuration. 

See also
File Structure of a Project (Page 155)

Illegal Characters (Page 152)

Settings for Runtime (Page 105)
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1.6.2 WinCC Project with Basic Process Control

Introduction
WinCC projects can be created and managed in PCS 7 within the framework of Totally 
Integrated Automation. The result is connections between the configuration of operator 
stations and automation systems with the WinCC configuration. You run the WinCC 
configuration in the SIMATIC Manager and in the WinCC Explorer. 

The WinCC Explorer with the "Basic Process Control" option offers various editors, many of 
which you use intensively for configuring the operator station (OS). Much data in the WinCC 
project is already assigned by the configuration of the engineering station (ES). If necessary, 
you can configure the configuration using the editors of the WinCC Explorer.

Requirements
● The "Basic Process Control" option must be installed on all computers in a WinCC project 

with multiple computers.

Overview of Basic Process Control in a WinCC Project
The following editors of Basic Process Control determine the appearance and behavior of the 
operator station:

● OS Project Editor

● Time Synchronization

● Lifebeat monitoring

● Horn

● Picture Tree Manager

● Component List Editor

OS Project Editor - Configuration of the runtime system and message system
When an OS project is created in the PCS 7 ES, the OS Project Editor is called automatically 
and initialized with default settings with reference to the runtime system and the message 
system. Only if you want a configuration other than the default configuration do you have to 
start the OS Project Editor in the WinCC Explorer and configure your desired project settings.

If you create a new WinCC project with Basic Process Control, you must start the OS Project 
Editor. The OS Project Editor must run before the User Administrator is opened, otherwise the 
User Administrator will be initialized with the authorization levels of WinCC.

The OS Project Editor creates the picture construction in overview area, work area, and button 
area as well as basic data in the WinCC server or client projects. The areas in the picture 
hierarchy are displayed automatically in the overview area of Runtime. In Runtime, the Split 
Screen Manager manages the display data, the picture compositions, and the picture changes 
according to the picture hierarchy. The picture change is configured with the standard functions 
of the Split Screen Manager.

Working with Projects
1.6 Creating and Editing Projects

MDM - WinCC: Working with WinCC
54 System Manual, 11/2008,  



All necessary data for the message configuration and the message display is created by the 
OS Project Editor. There is no need to configure a WinCC Alarm Control. You can change the 
default settings for display of the message system on the operator station in the OS Project 
Editor.

Time Synchronization - Time synchronization via LAN and Industrial Ethernet Bus
To ensure time synchronization for all operator stations, you have to configure the time 
synchronization using the "Time Synchronization" editor for every operator station.

Lifebeat Monitoring - Lifebeat monitoring for all automation systems and operator stations
The lifebeat monitoring function monitors functionality of all automation systems and operator 
stations and creates a process control message, if necessary. You configure the lifebeat 
monitoring in WinCC using the "Lifebeat Monitoring" editor.

Horn - Acoustic and optical signal generator for certain messages
The "Horn" editor is used to control optical and acoustic signaling devices or the output from 
audio files when messages come in.

Picture Tree Manager - Management of the system hierarchy with the respective pictures
The "Picture Tree Manager" is used to manage a hierarchy of systems, subsystems and 
Graphics Designer pictures. Using the Picture Tree Manager, the hierarchy of the group 
displays can also be recalculated or updated. 

Component List Editor - Configuration of entry point pictures and areas for the measuring points
You can see all components that you have inserted in the ES configuration in the Component 
List Editor. You can create new measuring points yourself using the Component List Editor. 
You allocate components to the pictures and areas in the Component List Editor. This allows 
the system operator to switch directly to this picture using the "Loop in Alarm" function in the 
message list and the "Picture from measuring point" button. 

1.6.3 How to Create a Project

Introduction
If you want to create a new project, you must first make several basic settings in WinCC. Based 
on these settings, WinCC creates a project that you can edit immediately.
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Principle
Follow the steps outlined below when creating a project:

● Define project type

● Specify the project name and project folder

● If required, enter the name of the configuration engineer, the project version, and a comment

● Defining computer properties

● Specify the settings for Runtime

You can specify the computer properties and the settings for Runtime immediately after 
creating the project or during configuration. For more detailed information, refer to chapters 
Defining Computer Properties and Settings for Runtime.
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Procedure
1. In the toolbar of the WinCC, click the  button.          

The WinCC Explorer dialog is opened.

2. Select the required project type and confirm with OK.          
The Create a New Project window is opened.

3. Enter the project name in the Project Name box. If you want the name of the project folder 
to be different from the project name, enter the required folder name in the New Subfolder 
box.

4. In the Drive list box under Project Path, select the drive on which you want to create the 
project folder.
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5. In the Folder list box under Project Path, select the path in which you want to create the 
project folder.

6. Confirm with Create.          
WinCC creates a project with the required name and opens the project in the WinCC 
Explorer.

7. Click the project name in the navigation window of the WinCC Explorer and select the 
Properties command in the pop-up menu.          
The Project Properties dialog is opened.

8. In the General tab, you go to the name of the configuration engineer, a project version, and 
a comment. Change the project type in the Type list box.

9. Click OK to close the dialog.

Alternative Procedure
You can create a new project in the following ways:

● When you first start WinCC

● In the menu bar of the WinCC Explorer in the File menu with the New command

● With the shortcut key <CTRL+N>
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Activating Runtime on ES
To activate Runtime for an integrated project on the ES, you can centrally release this option 
for the project. In WinCC Explorer, select the Project Properties option in the shortcut menu 
of the current project. In the Options tab, enable the checkbox "Allow activation on ES".         
For additional information refer the Online help for integrating WinCC in the SIMATIC Manager.

Note

To test integrated WinCC projects, use the "Start OS Simulation" function. This ensures that 
the running system operation is not jeopardized.         
The activation of integrated WinCC projects on the ES is not suited for this.

 

See also
Settings for Runtime (Page 105)

Project Types (Page 46)

Opening WinCC Explorer (Page 29)

How to Specify the Computer Properties (Page 59)

Preparation to Create a Project (Page 51)

Managing WinCC Projects and Objects in the SIMATIC Manager (Page 1861)

Starting a Simulation in STEP 7 (Page 1898)

1.6.4 How to Specify the Computer Properties

Introduction       
When you create a project, you must adapt the properties of the computer on which the project 
will be activated.

In a multi-user system, you must adapt the properties individually for each computer you create.
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Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.          

WinCC displays the list of computers in the data window.

2. Select the computer and then click the Properties command in the shortcut menu.          
The Computer Properties dialog is opened.

3. Check whether the correct computer is entered in the Computer Name input box. You will 
find the name of the computer in the Windows Control Panel under "System" on the 
"Computer Name" tab.
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4. When you insert a multi-location project, the Computer type area shows whether the 
computer is projected as a server or a client.         
If you have already inserted other computers in the project, then the same are displayed 
in the Client Name or Server Name area. The labeling of the box depends on whether you 
are displaying the computer properties of a server or of a client.

5. Click OK to close the dialog.

Note

If the field Computer Name does not contain the correct computer name, Graphics 
Designer opens a picture in the English configuration language, regardless of the 
language settings. You may reset the desired language in Graphics Designer.

Changing computer name
You can change the computer name in a project. Before WinCC accepts the modified computer 
name, you must close and reopen the project.

See also
How to Create a Project (Page 55)

Effect of External Applications at Runtime (Page 111)

Settings for Runtime (Page 105)

Opening WinCC Explorer (Page 29)

Project Types (Page 46)

1.6.5 How to support multiple picture windows

Introduction
WinCC supports independent picture windows. Independent picture windows can be can be 
used and positioned absolutely without being connected to the respective process picture. 
With the respective hardware and the support of the operating system, you can control more 
monitors to handle processes with greater scope and differentiation. 

For example, you can visualize the process on monitors 1 to 3 and use monitor 4 to display 
another view of the process with an Excel list. 

The main window, in which you have configured the individual picture window, is no longer 
required. You can hide it to increase the impact of more independent runtime windows. 
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Procedure
1. Configure more picture windows with the desired process pictures in the start picture.

2. Open the properties for each picture window with a double click.
The "Object Properties" dialog is opened. 

3. Set the attribute "Independent window" to "Yes".

4. Define the display for the configured picture window with window mode:

– Standard: configured size in the configured position

– Center: configured size in the central position

– Maximize: display adapted to the size of the monitor

5. If you want to use more monitors:          
Select the desired monitor for the picture window with the "Monitor number" attribute.
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6. If you want to hide the main window:          
Select "Properties" in the WinCC Explorer of the pop-up menu of the computer, select the 
respective computer and click on "Properties".
The "Computer Properties" dialog opens. 

7. Activate check box "Hide main window" on the "Graphics Runtime" tab under "Independent 
picture window".

Results
In runtime, the selected process pictures appear in several picture windows that are to be 
controlled independent of one another. 

See also
How to insert a picture window (Page 516)
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1.6.6 Setting Time in WinCC

1.6.6.1 Setting Time in WinCC

Introduction
In WinCC Runtime, you can display data with the date/time information in the local valid time 
or in coordinated universal time. It is normally practical to display the local time of your 
workstation location. If you wish to display a time zone-independent time, use coordinated 
universal time.

When you create a new project, WinCC uses the local time zone as the default. Internally, 
WinCC works with the coordinated universal time as a time base and converts to the selected 
time zone for the displayed time.

You set the time base for the entire project on one computer. In a multi-user system, you can 
set the time base individually on each computer.

Additionally, you may configure if the date and time format can be configured at the individual 
components or if it should be forced centrally by the WinCC project at all components in ISO 
8601 format. 

Note

Changing the time zone can have effects on date changes.

Multi-User System with Three Servers

The local time zone is displayed in the stations in Los Angeles, New York, and Tokyo.
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Data is collected from the stations in the center in Berlin. With the default setting, the operator 
sees all data in the local Berlin time. To be able to compare the data more easily in discussions 
with the stations, bus operators change over to UTC. 

Note

The use of UTC is always advisable when you want to display or edit time-dependent data 
from different time zones on one computer. If, for example, you want to display messages 
from different time zones on one client, UTC should be selected in the Alarm Control of this 
client so that the messages are sorted in the correct chronological order and appear correctly 
in the single-line message window.

Possible Settings
For Runtime displays, the following settings are available:

Selection Description

Local time zone (LOC) During Runtime, time information is displayed in the local time zone of 
the client or server.          
For this display, UTC is converted to the local time zone. 1)

The local time zone is the default when you create a new project. The 
individual objects use the default setting Apply Project Settings.

Coordinated Universal Time 
(UTC)

During Runtime, coordinated universal time is displayed. UTC stands 
for Universal Time Coordinated.
UTC is not dependent on time zones and is used internationally. This 
time corresponds to the Greenwich Mean Time (Central European Time 
minus an hour). In UTC, there is no daylight saving time.

Server's time zone In Runtime, the local time zone of the server is displayed. In single-user 
systems, this time corresponds to the time of the local time zone. During 
display of the local time zone in ISO 8601 format, no deviations to UTC 
time are shown.
Note:
We recommend using this setting only in projects migrated from WinCC 
V5.x. 

Apply Project Settings 2) This option is available only for layouts and controls.
The object adopts the time zone selected in the project settings.

1) You set the local time zone in the Control Panel of your computer under "Date/Time".
2) We recommend applying the "Apply Project Settings" setting to all objects and only changing it in 
certain cases. This setting facilitates the project-wide conversion of the time zone. 

PLC clock setting
You can adapt the communication with the PLC to the WinCC V5 standard. You use this setting 
if your project was originally created and operated with a WinCC version V5.x. V5-compatible 
communication allows use of projects that you migrated to WinCC V6 but the time setting of 
the programmable controller remains WinCC V5.
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Central Date and Time Formatting in ISO 8601 format
In the computer properties of the WinCC project, you may configure if the date and time format 
should be configured at the individual components or if it should be forced centrally by the 
WinCC project at all components in ISO 8601 format.

The following conditions apply to ISO 8601 format. 

● The date is always displayed in YYYY-MM-DD format.

● The time is shown in 24-hour format.

● UTC times are identified with suffix Z, e.g. 17:01:03.099Z.

● The time of the local time zone is displayed as local time plus the offset to UTC, e.g. 
17:01:03.099+01:30.

● The display of time is specified by the time format hh:mm:ss. Only the additional display of 
milliseconds is optional for the components. The time display is then in the format 
hh:mm:ss.msc, e.g. 17:01:03.099.

Note

If the central display of date and time in ISO 8601 format is forced, this takes effect on 
configurable time formats and time display throughout the project, e.g. in Controls, Reports 
or in Alarm Logging on system message blocks Time and Date. 

See also
Project Types (Page 46)

Opening WinCC Explorer (Page 29)

Preparation to Create a Project (Page 51)

How to Set the Time Base for Communication (Page 71)

How to Set the Time Base for Runtime Documentation (Page 69)

How to Set the Time Base for Controls (Page 67)

How to Set the Time Base in the Project (Page 66)

Displaying Regional Date and Time (Page 1793)

1.6.6.2 How to Set the Time Base in the Project

Introduction
The time basis applicable as default setting for the entire project is entered in the Computer 
Properties dialog. This setting applies to all objects displayed on this computer in Runtime. 
The exceptions to this are objects for which you have set a separate time base. 

You may also use this dialog to set whether or not central date and time formatting according 
to ISO 8601 should be forced in all components. 
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Note

You can also change the time base setting in Runtime. To update the display in Runtime, 
you must reselect the corresponding picture or report.

If the central display of date and time in ISO 8601 format is forced, this takes effect on 
configurable time formats and time display throughout the project, e.g. in ActiveX Controls, 
Reports or in Alarm Logging on system message blocks Time and Date. 

Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.          

WinCC displays the list of computers in the data window.

2. Select the computer and then click the Properties command in the pop-up menu.          
The Computer Properties dialog is opened.

3. Click the Parameters tab.

4. Select required time base in the Time Basis for Time Display in Runtime list box.

5. In the Central Date and Time Formatting area, choose if the format for date and time may 
be configured at individual components, such as Alarm Control, or if the format in 
accordance with ISO 8601 should be forced at all components.

6. Click OK to close the dialog.

See also
How to Set the Time Base for Runtime Documentation (Page 69)

Preparation to Create a Project (Page 51)

How to Set the Time Base for Communication (Page 71)

How to Set the Time Base for Controls (Page 67)

Setting Time in WinCC (Page 64)

1.6.6.3 How to Set the Time Base for Controls

Introduction
For some controls, you can assess the time base individually.

In the default setting, the control takes the time base from the project properties. The Apply 
Project Settings setting makes sure that you always see the same time zone in your controls 
as in the rest of the project. With this setting, you can change the time base for all controls in 
one action in the computer properties.

If you change the time base of a control, the modified setting is retained. You can no longer 
change the time base of the controls in one action in the computer properties. To adapt to 
control to the display in run-time again, you must modify the properties manually or change 
the Apply Project Settings setting.
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Controls
You can adapt the time base individually for the following controls:

● WinCC Online Table Control

● WinCC Online Trend Control

● WinCC Function Trend Control

● WinCC Alarm Control

● WinCC User Archive Table Control

Time Base for Controls
The following settings are available for the time base:

● Apply Project Settings (default)

● Server's time zone

● Local time zone

● Coordinated Universal Time (UTC)

Note

You can also change the time base setting in Runtime.

Procedure
1. Open the Properties dialog of the control.

2. Select the General tab or the Time Axis tab for the Online Trend Control.

3. Select the required time base in the selection window under Time Base.

4. Click OK to close the dialog.

Time Format in Controls
If the central date and time format in ISO 8601 format is forced in the Computer Properties 
dialog, this also has an effect on the configurable time formats and time displays in the controls. 

WinCC User Archive Table Control
For the User Archives Table Control, sets the time base for the LastAccess field in the General 
tab. The time of the last access is displayed in the Last Access column.

WinCC Digital/Analog Clock Control
The Digital/Analog Clock Control always displays the local computer time. The displayed time 
is not influenced by the time base of the project.
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See also
Preparation to Create a Project (Page 51)

How to Set the Time Base for Communication (Page 71)

How to Set the Time Base for Runtime Documentation (Page 69)

How to Set the Time Base in the Project (Page 66)

Setting Time in WinCC (Page 64)

1.6.6.4 How to Set the Time Base for Runtime Documentation

Introduction
In the log system of WinCC, you have dynamic objects available which allow you to output 
Runtime data into a report. You can set the time base of the dynamic objects individually in 
the properties.

In the default setting, WinCC takes the time base from the project properties. The Apply Project 
Settings setting makes sure that you always see the same time zone in your reports as in the 
rest of the project. With this setting, you can change the time base for all dynamic objects in 
one action in the computer properties.

If you change the time base of a dynamic object, the modified setting is retained. You can no 
longer change the time base of the object in one action in the computer properties. To adapt 
the reports to the display in Runtime again, you must modify the settings in the object properties 
manually or change the Apply Project Settings.

Reports
You can change the time base of the following objects:

● Archive reports (Alarm Logging Runtime)

● Message reports (Alarm Logging Runtime)

● User archive tables (User Archive Runtime)

● Tag tables (Tag Logging Runtime)

● Trends (Tag Logging Runtime)

● Message sequence report tables (in the Line Layout Editor)

● Message sequence report tables (in the Page Layout Editor)

Time Base for Line Layouts and Page Layouts
An output is made in the Runtime documentation when an event, for example a message, has 
occurred. If you change the time base output, WinCC converts the time stamps of the 
messages into the new time base.

You can select the following settings as the time base:

Working with Projects
1.6 Creating and Editing Projects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  69



● Apply Project Settings (default)

● Server's time zone

● Local time zone

● Coordinated Universal Time (UTC)

Note

You can also change the time base setting in Runtime.         
Exception: You cannot change the time base of message sequence reports during

Procedure for Page Layouts
1. Open the required page layout in the page layout editor.

2. Double-click the dynamic object you want to edit.          
The "Object Properties" dialog is opened.

3. On the tab Connect, select the object in the navigation window.

4. In the table in the right window, select the Time Base entry and click the Edit 
button.          
The Time Base Entry dialog is displayed.

5. Select the required time base and confirm with OK.

Procedure for Line Layouts
1. Open the desired line layout in the line layout editor.

2. Click in the Table area on the Time Base... button.          
The Time Base Entry dialog is displayed.

3. Select the required time base and confirm with OK.

Selection for Layouts
In the filter criteria for alarm output, WinCC always uses the time base of the corresponding 
dynamic object.

Start Time and Selected Time Range for Print Jobs
The start time and the selected time range of the data to be printed is always shown in local 
computer time. The start time and the selected time range are not influenced by the time base 
of the project nor by the time base of a dynamic object.

Time Format in Reports
If the central date and time format in ISO 8601 format is forced in the Computer Properties 
dialog, this also has an effect on time displays in the reports.
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See also
Preparation to Create a Project (Page 51)

How to Set the Time Base for Communication (Page 71)

How to Set the Time Base for Controls (Page 67)

How to Set the Time Base in the Project (Page 66)

Setting Time in WinCC (Page 64)

1.6.6.5 How to Set the Time Base for Communication

Introduction
Apart from the time base in Runtime, you can also set the time base for communication with 
the programmable controller. You can do this by selecting the PLC Clock Setting:

Project Version WinCC V5 Compatibility Mode Time Base for Communication

V5.x project migrated to V6.0 Activated Local time zone standard time
Created in V6.x and V7.x not activated 1) UTC

1) In projects created in WinCC V7.0, WinCC uses UTC as the default setting.

You use V5-compatible communication if your project was originally created and operated with 
a WinCC version V5.x. V5-compatible communication allows use of projects that you migrated 
to WinCC V6 but the time setting of the programmable controller remains WinCC V5.

You can set the time base for displaying Runtime regardless of the time base for 
communication.

Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.          

WinCC displays the list of computers in the data window.

2. Select the computer and then click the Properties command in the pop-up menu.          
The Computer Properties dialog is opened.

3. Click the Parameters tab.

4. Under PLC clock setting, activate the PLC is set to the local winter time all year (WinCC 
V5 compatibility mode) check box.

5. Click OK to close the dialog.
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See also
How to Set the Time Base in the Project (Page 66)

Preparation to Create a Project (Page 51)

How to Set the Time Base for Runtime Documentation (Page 69)

How to Set the Time Base for Controls (Page 67)

Setting Time in WinCC (Page 64)

1.6.7 Online Configuration

Introduction
You can edit a project in a single-user system or a multi-user system during Runtime. 
Remember, however, that some configuration tasks are not possible.

WinCC also provides the Load Online Changes function. With the Load Online Changes 
function, you can edit a project on one computer while it is running on another computer in 
Runtime. When configuring with Load Online Changes, there are other restrictions than those 
that apply to online configuration.

Note

In time-critical projects, remember that online configuration can affect the response of your 
project over time.

Limitations
For more detailed information on the possibilities for online data editing, refer to the description 
of the relevant editor in the WinCC Information System.

You can edit the following elements while the project is activated in Runtime:

Element Create Delete Edit Remarks

Project name /         
Project properties

--- --- No ---

Computer Yes No No ---
Computer properties --- --- Yes Edit:         

Modifications only become effective in 
Runtime after the project has been 
deactivated and Runtime restarted.

Time base         
(computer properties)

--- --- Yes Edit:         
Depending on the configuration, a 
modification in a picture is updated in 
Runtime after the picture has been 
reselected.
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Element Create Delete Edit Remarks

User cycle          
(project properties)

--- --- No ---

Tags         
(tag management)

Yes Yes Yes Delete/Edit:         
Only possible with external tags when 
the channel used supports the function. 
This currently applies only to the S7 
channel

Tag groups         
(tag management)

Yes Yes Yes Delete:         
Only valid when the contained tags can 
be deleted.

Structure types Yes Yes Yes Delete:         
Only possible if the structure type does 
not contain structure tags.
Edit:         
Only possible as long as no structure 
tag has been set up under the structure 
type.

Structure tags         
(structure types)

Yes Yes Yes Delete:         
Only valid when the associated 
structure tag elements can be deleted.

Connections         
(tag management)

Yes Yes Yes Changes to a connection can lead to 
loss of data.
Delete/Edit:         
Currently only valid for the S7 channel.

Channels         
(tag management)

No No No ---

Channel units         
(tag management)

No No No ---

Text entries         
(Text Library)

Yes Yes Yes ---

Pictures          
(PDL files,         
Graphics Designer)

Yes Yes Yes A picture is updated at runtime only 
after reselection.

Library, color 
palette          
(Graphics Designer)

Yes Yes Yes ---

Archives, archive 
tags         
(Tag Logging, User 
Archives)

Yes Yes Yes Edit:         
Archiving cycle cannot be modified

Reports, layouts         
(Report Designer)

Yes Yes Yes Create/Delete/Edit:         
Only valid for the Runtime 
documentation.

Scripts         
(Global Script)

Yes Yes Yes ---

Access rights         
(User Administrator)

Yes Yes Yes ---

Other files Yes Yes Yes ---
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Element Create Delete Edit Remarks

Packages         
(server data)

Yes Yes Yes ---

Messages         
(Alarm Logging)

--- --- --- Refer to the Online Configuration with 
Messages table below.

 

Configuring Messages Online

Element Attribute Create Delete Edit Remarks

Single messages  Yes Yes Yes Edit:         
Valid for most attributes. 
Exceptions are listed 
individually:

 ● Number
● Group

--- --- No ---

 ● Class --- --- Yes If the acknowledgement 
requirement is changed, 
the message is 
deleted.         
If the message category is 
changed but not the 
acknowledgement 
requirement, the message 
is updated immediately.

 ● Type --- --- Yes The message is updated 
immediately.

 ● Triggered on falling 
edge

● Message tag
● Message bit
● Norm DLL

--- --- Yes If you change the attribute, 
the message is deleted.

 ● Controls the central 
signaling device

● Will be archived
● Priority

--- --- Yes Updated in Runtime only 
when the status of the 
message changes.

 ● Info text --- --- Yes The message is updated 
immediately. 

 ● User text block
● Process value block

--- --- Yes Updated in Runtime only 
when the status of the 
message changes.

Group messages  No No No ---
User-defined 
group message

 Yes Yes Yes ---

Limit value 
monitoring

 Yes Yes Yes Edit:         
If the Message attribute is 
modified, the message is 
deleted.
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Element Attribute Create Delete Edit Remarks

System blocks  Yes Yes Yes Create/Delete/Edit:         
A picture is only updated 
in Runtime when the 
corresponding picture is 
reselected.         
Create/Delete:         
Reconfiguration in OCX 
necessary.

User text blocks  Yes Yes Yes Create/Delete/Edit:         
A picture is only updated 
in Runtime when the 
corresponding picture is 
reselected.         
Create/Delete:         
Reconfiguration in OCX 
necessary.

Process value 
blocks

 Yes Yes Yes Create/Delete/Edit:         
A picture is only updated 
in Runtime when the 
corresponding picture is 
reselected.         
Create/Delete:         
Reconfiguration in OCX 
necessary.

Message classes  Yes No Yes Edit:         
Valid for most attributes. 
Exceptions are listed 
individually:

 ● Class names
● Status text

--- --- Yes Updated in Runtime only 
when the status of the 
message changes or 
when you reselect the 
picture.

 ● Acknowledgment 
theory

--- --- Yes If you modify a message 
so that acknowledgment is 
no longer mandatory, the 
message is deleted.

Message types  Yes No Yes ---
Raw data tags  Yes Yes Yes Edit/Delete:         

The message is deleted. 
Tags  --- Yes Yes Edit/Delete:         

The message is deleted.

 

See also
Use and Limitations of Load Online Changes (Page 80)

Loading Online Changes (Page 76)
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1.6.8 Loading Online Changes

1.6.8.1 Loading Online Changes

Introduction
With the Load Online Changes function, you can edit a project on one computer while it is 
running on another computer in Runtime. Load online changes work under multi-user systems 
and distributed systems under the same conditions as the use in multi-user systems.

The computer on which you configure will be referred to as the configuring station in the 
following description. The computer on which Runtime is activated will be referred to as the 
Operator Station.

If you want to use the changes on the operator station, start a download of the changed data. 
The project is updated in Runtime.

You can test the modified project on the configuring station before you user modifications in 
Runtime. You can update the project at any time.

Working with online downloads of changes is possible only when you maintain a consistent 
project.

Note

In time-critical projects, remember that downloading changes online can affect the response 
of your project over time.

Application Scenarios
During various phases, for example commissioning, operation, or maintenance, you will 
normally find it necessary to make changes to an existing project. These changes can then 
be adopted in the activated project; in other words, online.

You can download changes online in the following situations:
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● Continuous automation tasks:          
All modifications are made online from a central configuration station. As a result, you do 
not need to make a configuration changes directly on site. It is also possible to add, modify, 
and delete Runtime objects, for example tags, alarms, and archives without deactivating 
WinCC.

● Testing modifications in a protected environment:          
The configuring station can be used to run intended modifications offline before they are 
loaded in the activated project. The configuration planner can, therefore, test the 
modifications in a protected environment before adopting them in active operation. This 
allows configuration errors to be detected before they can cause problems in the process 
or stop the plant.

● Simultaneous loading of modifications which influence each other:          
Configuration changes often relate to settings which are linked to each other. Such 
modifications should be downloaded consistently and take effect at the same time.          
This case occurs, for example, when a calculated value of an archive representation is 
added. In may be necessary to create new tags and add them to a new archive. Finally, 
the archive will be displayed in a picture. In the situation, if the information is not adopted 
as a unit, this will lead to error messages.

Note

If Load Online Changes is to be used in redundant systems, STEP7 or PCS7 is required.

Principle
A project runs on the operator station during Runtime. Load Online Changes is automatically 
activated. The menus for Load Online Changes cannot be operated in WinCC Explorer. 

You edit a copy of the project on a second computer, the configuration station. Activate the 
load online changes function in the WinCC Explorer on the configuration station. From this 
point onwards, WinCC records all changes made in the project. Online configurations on the 
configuration station are not, however, recorded. 

When you have completed your modifications in the project, start the online download of the 
changes. This exports the modified data to the operator station. The project is updated in 
Runtime. 

I the case of multi-user systems, WinCC generates packages after each download. Depending 
on the settings selected, the packages can be automatically imported by the clients.
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See also
Online Configuration (Page 72)

How to Download Load Online Changes (Page 87)

How to Reset Load Online Changes (Page 91)

How to Activate Load Online Changes (Page 85)

Use and Limitations of Load Online Changes (Page 80)

Requirements for Loading Online Changes (Page 78)

Run Diagnosis of Online Change Loading (Page 83)

1.6.8.2 Requirements for Loading Online Changes

Introduction
Make sure that you use the function for downloading changes online only with consistent 
projects:

● Before activating the Load Online Changes function, the projects on the configuring station 
and on the operator station must be synchronized to the same project state.

● The project on the engineering station must be tested and run correctly when Load Online 
Changes is started.

● You can only configure changes that can be recorded by the Load Online Changes 
function.          
If the download changes online function cannot record a configuration, a warning is 
displayed. If you configure the change despite this warning, the Load Online Changes 
function is reset. The changes can no longer be transferred.

If you edit an inconsistent project, you take the risk that the activated project will no longer run 
correctly following the download. You can then only correct errors in Runtime in the deactivated 
status.

Note

If you edit a WinCC project which was created using the SIMATIC Manager, there will be no 
menu item "Load Online Changes" in WinCC Explorer. This also applies to WinCC projects 
created in WinCC and subsequently imported into SIMATIC Manager by using the function 
"Import WinCC Object". This type of project is also called a TIA project.         
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item 
Load Online Changes in WinCC Explorer is displayed.

Synchronizing Project to the Same Status
Synchronize the project on the computers participating so they have the same data before 
activating Load Online Changes. You can do this by copying the current version of your project 
from the operator station to the configuring station using the Project Duplicator. 

If the project is edited on the configuring station, observe the following:
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● The project must not be modified on the operator station.

● The project must not be edited either on the configuring station or on the operator station 
from another computer.

● The configuration on the operator station must also not be modified by scripts.

● In the case of a client/server system, the Notify after Export check box must be deactivated 
in the Implicit Update menu on the configuring station in WinCC Explorer/Serverdata.

Configuring with Load Online Changes Activated
Edit the project on the configuring station only when the Load Online Changes function is 
activated. Only configure changes that can be recorded by the download changes online 
function.

Keeping the Project Consistent
Test your edited project on the configuring station before starting Load Online Changes.

This ensures that fully functional data is transferred to the operator station and that no errors 
occur in the activated project.

Configuring in multiple partial steps
You can configure the changes that are to be entered n the online change shop in multiple 
partial steps. For this, exit WinCC after every configuration session if you have switched on 
the online changes shop. During the next configuration session, the project will be started in 
the same status and can be processed further. After completing the partial configurations, 
download the modified project in one step to the operator station.

Quantity Structure
Using the Load Online Changes function, you should not configure and transfer more than 500 
tags, archive tags, and messages. The Load Online Changes function is not intended or 
suitable for transferring mass data.

New segments are created in the archive manager if you make changes to existing archive 
variables. This can decrease performance of the load online changes feature. No additional 
segments are created when adding or removing variables in the TagLogging Editor.

Configure major modifications in several steps. After configuration, transfer each partial 
package to the operator station.

Note

Load Online Changes can also be switched off on the configuring station. However, Load 
Online Changes should only be switched off when no configuration modifications need to be 
carried out online and prefer to execute a complete download onto the OS. Do not select 
Turn Off if Load Online Changes should be interrupted. The consistency of the project can 
then no longer be guaranteed.
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See also
How to Activate Load Online Changes (Page 85)

How to Download Load Online Changes (Page 87)

How to Reset Load Online Changes (Page 91)

Use and Limitations of Load Online Changes (Page 80)

Run Diagnosis of Online Change Loading (Page 83)

1.6.8.3 Use and Limitations of Load Online Changes

Introduction
When Load Online Changes is active, not all configurations can be executed which are possible 
when Load Online Changes is deactivated.

Basic Limitations

Opened Files
In the case of Load Online Changes, no open files are transferred, e.g. screens which are 
open in Graphics Designer at that moment. After the download, an entry is made in the 
message window of the Progress Dialog dialog. Close all applications and editors except Load 
Online Changes and start the transfer again.

Project in Runtime
The project must not be active in Runtime on the configuring station.

WinCC Configuration Tool
Do not work with the WinCC Configuration Tool if Load Online Changes has been activated. 
Using the WinCC Configuration Tool, you can configure changes that cannot be transferred 
with Load Online Changes. The tool is not monitored by Load Online Changes.

Project inconsistencies can result if you transfer data processed with the WinCC Configuration 
Tool with Load Online Changes.

WinCC server
Observe the following procedure during download of Load Online Changes to a server:

The respective WinCC project should be open on all clients with an imported server package.

You can also perform the download if the corresponding project is not open on all clients. You 
must then wait at least 10 minutes after confirmation of the last dialog of Load Online Changes 
before opening the project on the client.
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Redundant Systems
You can only use Load Online Changes in redundant systems when certain requirements have 
been met. If Load Online Changes should be used in redundant systems, SIMATIC Manager 
is required, or STEP7 or PCS7.

You must always start the download of Load Online Changes via the master server. This will 
also perform a download of Load Online Changes on the standby server. Starting the download 
from the standby server is not possible. 

Changes to user archive configuration data, such as deleted fields in the archive, cannot be 
transferred with an online download of changes to a redundant server pair.

Files and Elements
Load Online Changes supports editing of the following elements:

Element Create Delete Edit Remarks

Project name,          
Project properties

--- --- No ---

Computer Yes No No ---
Computer properties --- --- No ---
Time base         
(computer 
properties)

--- --- No ---

User cycle          
(project properties)

--- --- No ---

Tags         
(tag management)

Yes Yes Yes Delete/Edit:         
Only possible with external tags when 
the channel used supports the 
function. Currently only valid for the 
S7 channel.

Tag groups         
(tag management)

Yes Yes Yes Delete:         
Only valid when the contained tags 
can be deleted.

Structure types Yes Yes Yes Delete:         
Only possible if the structure type 
does not contain structure tags.
Edit:         
Only possible as long as no structure 
tag has been set up under the 
structure type.

Structure tags         
(structure types)

Yes Yes Yes Delete:         
Only possible if the associated 
structure tag elements can be deleted.

Connections         
(tag management)

Yes Yes Yes Changes to a connection can lead to 
loss of data.
Delete/Edit:         
Currently only valid for the S7 channel.

Channels         
(tag management)

No No No ---
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Element Create Delete Edit Remarks

Channel units         
(tag management)

No No No ---

Text entries         
(Text Library)

Yes Yes Yes ---

Pictures         
(PDL files, Graphics 
Designer)

Yes Yes Yes A picture is updated at runtime only 
after reselection.

Library, color 
palette          
(Graphics Designer)

--- --- No ---

Messages         
(Alarm Logging)

Yes Yes Yes Processing of message blocks and 
group messages is not supported. 
The processing of user-defined group 
messages is supported.          
Deletion of message classes is not 
supported.

Archives, archive 
tags         
(Tag Logging, User 
Archives)

Yes Yes Yes  

Reports, 
layouts         
(Report Designer)

Yes Yes Yes ---

Scripts         
(Global Script)

Yes Yes Yes ---

Access rights         
(User Administrator)

Yes Yes Yes ---

Other files Yes Yes Yes The files must be in the project 
directory or one of the following 
subdirectories: GraCS, Library, 
ScriptLib, PRT, Textbib.

Support for WinCC Web Navigator
Load Online Changes supports the transfer of published pictures and scripts of WinCC Option 
Web Navigator, if the Web Navigator Server is installed on configuration station and operator 
station. 

Support for WinCC/CAS
Load Online Changes also supports the transfer of configuration changes to the central archive 
server.
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See also
Online Configuration (Page 72)

How to Download Load Online Changes (Page 87)

How to Reset Load Online Changes (Page 91)

How to Activate Load Online Changes (Page 85)

Loading Online Changes (Page 76)

Requirements for Loading Online Changes (Page 78)

1.6.8.4 Run Diagnosis of Online Change Loading

Introduction
After downloading changes online, you should check that all changes have been adopted 
correctly in the project on the operator station. You can export the error messages that occurred 
during download to a diagnosis file.

There are various reasons for a change not being adopted in the activated project.

Notes on Diagnostics and Configuration

Behavior Procedure / Configuration

Changes to picture are not displayed 
(PDL file)

Reselect the picture in Runtime

Changes in a script are not displayed Save the script again in the Global Script editor and reselect 
the picture in Runtime

Changes to a control are not displayed Reconnect the control in the Graphics Designer
Correction required in the configuration If there is an error in the configuration, correct the error on 

the configuring station with Load Online Changes activated.
Transfer the corrected project data to the operator station 
again with the download changes online function.

Network failure during the download If the network fails during the download, the download 
changes online function can only update some of the 
recorded data. The Runtime project is therefore inconsistent.
Start the download again. The operator station must remain 
in Runtime. Load Online Changes is full executed once 
again. Ignore the fault messages displayed. 
No further configurations may be completed on the 
configuring station as long as Load Online Changes is not 
concluded.
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Export error messages to a diagnosis file
You can export the error messages that have occurred while loading online changes to a 
diagnosis file.

1. When loading is complete, click "Export ....".

This will open the "Save As" dialog.

2. Select the desired directory and enter a meaningful file name.

Working with Projects
1.6 Creating and Editing Projects

MDM - WinCC: Working with WinCC
84 System Manual, 11/2008,  



3. Click on the "Save" button. The file is written to the selected directory.

See also
How to Download Load Online Changes (Page 87)

How to Reset Load Online Changes (Page 91)

How to Activate Load Online Changes (Page 85)

Use and Limitations of Load Online Changes (Page 80)

Requirements for Loading Online Changes (Page 78)

1.6.8.5 How to Activate Load Online Changes

Introduction
As soon as Load Online Changes has been activated on the configuring station, WinCC detects 
all configured changes. If you want to use the changes on the operator station, start a download 
of the changed data. The project is updated in Runtime.

Before activating the Load Online Changes, copy the project to the configuring station. Use 
the Project Duplicator for this. This prevents inconsistency. The project can be duplicated from 
the operator station while Runtime is active. When the copied project is opened on the 
configuring station, Runtime is started automatically. If Runtime is terminated, Load Online 
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Changes remains activated. Reset Load Online Changes first to ensure the changes are 
assumed when the project is restarted. 

CAUTION

Ensure that the project is consistent.

Ensure that configuration only takes place on the configuring station on which Load Online 
Changes is active.

If you edit an inconsistent project, you take the risk that the activated project will no longer 
run correctly following the download. You can then only correct errors in Runtime in the 
deactivated status.

Procedure
1. Right-click Load Online Changes in the navigation window of the WinCC Explorer.

2. When the project has been copied, select the Reset option in the pop-up menu before 
starting with the changes.

3. Also select Turn On in the pop-up menu.          
Load Online Changes is activated and immediately records all changes made in the project.

If a change is made that cannot be recorded by Load Online Changes, the following dialog is 
displayed:

It is possible that the change is necessary and that the project would otherwise be inconsistent 
and cause errors in Runtime. In this case, confirm with Yes. Reset the download changes 
online function and continue to configure without it.

Note

If you edit a WinCC project which was created using the SIMATIC Manager, there will be no 
menu item Load Online Changes in WinCC Explorer. This also applies to WinCC projects 
created in WinCC and subsequently imported into SIMATIC Manager by using the function 
Import WinCC Object. This type of project is also called a TIA project.         
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item 
Load Online Changes in WinCC Explorer is displayed.
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See also
How to Copy a Project (Page 139)

How to Download Load Online Changes (Page 87)

How to Reset Load Online Changes (Page 91)

Use and Limitations of Load Online Changes (Page 80)

Loading Online Changes (Page 76)

Requirements for Loading Online Changes (Page 78)

1.6.8.6 How to Download Load Online Changes

Introduction
If you want to adopt the changes recorded by the download online changes function in an 
activated project, start a download. This exports the modified data from the configuring station 
to the operator station. The project is updated in Runtime. 

The changes can be transferred to several operator stations. A condition for this is that the 
same project status prevails on all target systems.

Before downloading, make sure that the modified project is fault-free. Test the changes on the 
configuring station in Runtime.

If you are editing a multi-user project, WinCC generates the required packages on the operator 
station after each download. The automatic package update is used to by the clients to import 
the changes as packages and to load them. To do this, select the "Server data" item in WinCC 
Explorer on the OS client, and activate the Notify After Export check box in the Implicit Update 
menu.

If the package is changed by the server in a redundant multi-user system, so that the clients 
are automatically updated, reregister the preferred server on the clients, or reassign the 
preferred server by reloading of the clients.

Requirements
● The project was copied from the operator station with the Project Duplicator before 

activating the Load Online Changes function.

● The project can only be edited with the Load Online Changes function active at all times.

● The project on the configuring station is consistent and has been tested in Runtime.

● The unchanged project is activated in Runtime on the operator station.

● The operator station should perform as few operations as possible while the download of 
Load Online Changes takes place. In time-critical projects, remember that Load Online 
Changes can affect the response of your project over time.

● Use the configuring station to check that the files to be transferred are not open.

● All WinCC editors must be closed on the configuring station.
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Procedure
1. Right-click Load Online Changes in the navigation window of the WinCC Explorer.

2. Select the Start Download command in the pop-up menu.          
The Remote Computer dialog is opened.

3. Click the  button to select the operator station on which you want to update the project.

4. To transfer the changes to several operator stations, deactivate the check box "Reset after 
download" before the download. After downloading to the first operator station, the same 
data are available for a further download.

5. Start the download with OK.          
The Progress Dialog dialog is opened. The window contains a progress bar for the entire 
download and a second progress bar for the current action.

6. If the Reset After Download check box is selected, a reset occurs after Load Online 
Changes.

7. After the download, close the Progress Dialog dialog with OK.

Note

After Load Online Changes has been reset, the file with the recorded data is deleted. If 
transfer of the changes should be made to an operator station, the entire project must be 
copied from the configuring station. In this case, Runtime must be terminated on the operator 
station and WinCC closed.

If you edit a WinCC project which was created using the SIMATIC Manager, there will be no 
menu item "Load Online Changes" in WinCC Explorer. This also applies to WinCC projects 
created in WinCC and subsequently imported into SIMATIC Manager by using the function 
"Import WinCC Object". This type of project is also called a TIA project.         
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item 
Load Online Changes in WinCC Explorer is displayed.
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Canceling the Download
The downloading process can be stopped. This should only be done in exceptional 
circumstances, e.g. when the procedure threatens to take too much time. Only part of the 
project changes are updated, according to the following sequence:

1. Connections

2. Tag groups, tags, structures

3. Texts

4. Alarms

5. Archives, archive tags

6. User Administrator

7. Images

8. Scripts

9. Reports

If only a part of the download is completed, the project on the operator station is not fully 
functional:

● A tag, for example, has been deleted. The tag management has been updated but the 
screens were not transferred in which the tags are displayed.

● A screen jump, for example has been configured but does not function. One screen was 
transferred but not the other.

Changes already transferred are not reset on the operator station. 

Following a cancellation, the Load Online Changes download can be restarted. The download 
is then completed fully.

Pay attention to the following during the download:

● The operator station remains in Runtime.

● Ignore the fault messages displayed.

● No further configurations may be completed on the configuring station as long as Load 
Online Changes has not been concluded.

Monitoring the Download Process
You can configure a message or use an internal tag that indicate the start and finish of the 
download on the operator station.

Monitoring with control center options
If you have configured the WinCC system messages in the message system, downloading 
changes online triggers the following OS process control messages:

Load online changes Message no. Message text

Download started 1012242 Delta loading was started
Download ended 1012243 Delta loading ended
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The messages can only be displayed when the process control options of WinCC are installed.

Monitoring via the internal tags "@DeltaLoaded", "@SFCDeltaLoaded" and "@SFCDeltaLoaded"
The system tags "@DeltaLoaded", "@SFCDeltaLoaded" and "@DeltaCompiled" indicate the 
download status as follows:

@DeltaLoaded

Value is set

0 at the start of the download on the configuration station and on the operator station
1 at the start of the online change loading on the operator station, directly before sending the 

process control message "1012242"
2 when canceling the online change load on the operator station
2 at the finish of the online change loading on the operator station, directly before sending the 

process control message "1012243"

On the configuration station, "@DeltaLoaded" is always "0". On the operator station, the value 
depends on the delta loading process. The value is not changed during the activation or 
deactivation.

@SFCDeltaLoaded

Value is set

0 at the start of the transfer of the SFC database on the operator station in the course of the 
online change loading

1 at the finish of the transfer of the SFC database on the operator station in the course of the 
online change loading

On the configuration station, "@SFCDeltaLoaded" is not set. On the operator station, 
"@SFCDeltaLoaded" is used to synchronize the SFC clients. The SFC clients must end the 
access to the SFC DB prior to the download. The value is not changed during the activation 
or deactivation.

@DeltaCompiled

Value is set

0 Initial value
1 OS compiling of change is running
2 OS compiling of change has been completed

You can monitor the OS compiling of changes using "@DeltaCompiled" system tag.
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See also
Process Control Runtime: Message system

"Melde-Projektierung" tab

How to Activate Load Online Changes (Page 85)

How to Reset Load Online Changes (Page 91)

Requirements for Loading Online Changes (Page 78)

Loading Online Changes (Page 76)

Use and Limitations of Load Online Changes (Page 80)

Run Diagnosis of Online Change Loading (Page 83)

Integration of WinCC in SIMATIC Manager (Page 1857)

1.6.8.7 How to Reset Load Online Changes

Introduction
When you deactivate the Load Online Changes function, all changes recorded by the function 
are deleted. If you want to record your changes again with the Load Online Changes function, 
you must Runtime it again.

By resetting the download changes online function, you avoid an unwanted configuration being 
transferred to an operator station. You can undo changes you have made and re-edit your 
project with the Load Online Changes function activated. 

Procedure
1. Right-click Load Online Changes in the navigation window of the WinCC Explorer.

2. Select the Reset command in the pop-up menu.         
The following dialog is displayed:

3. Click on OK to confirm.          
The recorded changes are deleted in the download changes online function and can no 
longer be downloaded.
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Note

If you edit a WinCC project which was created using the SIMATIC Manager, there will be no 
menu item Load Online Changes in WinCC Explorer. This also applies to WinCC projects 
created in WinCC and subsequently imported into SIMATIC Manager by using the function 
Import WinCC Object. This type of project is also called a TIA project.         
If you copy a TIA project with WinCC Explorer and subsequently edit the copy, menu item 
Load Online Changes in WinCC Explorer is displayed.

 

See also
How to Download Load Online Changes (Page 87)

How to Activate Load Online Changes (Page 85)

Use and Limitations of Load Online Changes (Page 80)

Loading Online Changes (Page 76)

Requirements for Loading Online Changes (Page 78)

1.7 Determining the Global Design

1.7.1 Global Design of the Objects

Introduction
In WinCC, you have numerous options for changing the way your projects appear in Runtime. 
To do this, you choose from a series of predetermined and self-created designs. The design 
contains colors, patterns and other optical effects. 

You determine the global design in the project properties. 

Global Designs
WinCC provides the following designs for the projects: 

● WinCC Classic          
The standard design as you know it from WinCC V6.2. This new design does not support 
all new program elements as of WinCC V7.0.

● WinCC Simple          
Simple design in light blue color tones.
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● WinCC Glass          
Design in dark blue color tones with a glass-like shimmer effect.

● WinCC 3D          
Design in gray to black color tones with relief-like 3D design of the objects.

In addition to the provided designs, you can create, edit, rename and delete your own designs. 

Design Features 
The design contains determinations on the following properties of the objects: 

● For all objects:

– Shadow

– Hover (changes the view temporarily, as long as the mouse pointer is over the object)

● Different for the different groups of object types:

– Style

– Color scheme

The design features of the global design cannot be used in full for all object types. 

Settings in the Object Properties
If nothing else is set in the object properties, the settings of the selected global design apply 
to all graphical objects in the project. 

Note

As soon as an attribute is determined by a global design, it remains static and can no longer 
be made dynamic. Even a dynamization that has already been performed remains without 
effect.

You can deactivate the global shadow and the global color scheme for an object in the object 
properties. 

For the Windows objects "Button", "Round Button and "Slider Object", you can accept the 
global design or activate the user-defined settings. Alternatively, you can also accept the 
display style of the Windows operating system for the button and the slider object. 

Settings in the Computer Properties
The global design requires the recommended hardware equipment. You can improve the 
computer's reaction behavior by switching off certain elements of the global design in the 
WinCC computer properties. 

See also
How to make computer-specific settings for runtime (Page 128)
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1.7.2 The Elements of the Global Design

Introduction
The global design determines the uniform optical design of the process pictures. If you are 
designing your own design, you have different options in the individual object groups. 

Design Features of a Global Design
A global design has the following design features for the individual object types: 

Object group Objects Style Color scheme

Simple Geometric object         
(standard objects)

Simple Fill color (Fill Pattern Color)          
background color         
fill pattern

Tubes         
(tube objects)

Windows Background color         
(line color)

Background         
(process picture)

Simple Fill color (Fill Pattern Color)          
background color         
fill pattern

Smart Text objects         
(I/O field, combo box, list box, multi-
line text) 

Simple         
Windows         
Style 1

Text color (font color)         
Fill color (fill pattern color)         
Background color         
Fill pattern

Bar graph         
(3D bar)

Simple Text color (font color)         
Fill color (fill pattern color)         
Background color         
Fill pattern

Windows Button Simple         
Progression         
Rectangular         
Aero glass

Text color (font color)         
Background color

Round Button Simple         
3D style         
Aero glass         
Ball

Text color (font color)         
Background color

Scroll bar         
(Slider object)

Simple         
Progression         
Rectangular         
Aero glass

Background Color

Check/radio box         
(check box, radio box)

Simple Text color (font color)         
Fill color (fill pattern color)         
Background color         
Fill pattern
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Object group Objects Style Color scheme

Controls Display gauge / clock Simple         
Progression         
3D style

Text color (font color)         
Fill color (fill pattern color)         
Background color

Runtime controls Simple         
Windows

Text color (font color)         
Fill color (fill pattern color)         
Background color

Toolbar Menus/toolbars Windows         
Progression

Text color (font color)          
Background color

1.7.3 How to work with global object designs

Introduction
You can use global designs in WinCC. In addition to the provided designs, the designs that 
you create on your own are also available. 
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the 

Properties command in the pop-up menu.
The "Project Properties" dialog opens. 

2. On the "User Interface and Design" tab, click "Edit" next to "Active Design".
The "Global Design Properties" dialog opens. 
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All existing designs are displayed in the upper bar. The preview shows how the objects will 
appear for the selected objects. 

Working with Designs
You can display the settings for the provided designs and edit your own designs. You also 
have the following options: 

Function   

Import design Integrates another design into WinCC 

Export design Saves a design as a file in XML format. 

Add new design Adds a new design to the design bar. 
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Function   

Delete current design Deletes the selected self-created design from the design bar. 

Rename current design Opens the dialog for renaming the current self-created design. 

Select design
In order to select a design for the current project, click on its symbol and confirm with "OK".

Import design
In order to integrate another design into WinCC, click on "Import design" and select the desired 
design in the file selection dialog. 

Export design
In order to use a design in another project, select it, click on "Export design" and save it as an 
XML file under a different name. 

Add new design
In order to create a new design, click on "Add new design". The new design appears in the 
design bar with an automatically provided name. 

Rename current design
In order to rename the current self-created design, click on "Rename current design" and enter 
the desired name in the "Rename" dialog. 

Edit current design 
In order to edit the current self-created design, modify the shadow, hover effect and color 
scheme design elements in the "Global Design Settings" dialog. 

Delete current design
In order to delete a design that is no longer required, click on "Delete current design" and 
confirm the security prompt. 
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1.7.4 How to edit your own global design

Introduction
You can determine the design of the objects globally, i.e. project-wide. You can select from 
provided designs or create and activate your own designs. 

The provided designs cannot be changed. You can only edit the designs that you create 
yourself.
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the 

Properties command in the pop-up menu.
The "Project Properties" dialog opens. 

2. On the "User Interface and Design" tab, click "Edit" next to "Active Design".
The "Global Design Settings" dialog opens.
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3.
Click on  "Add new design".
A new design appears in the design bar. 

4.
Click on  "Rename current design" and give the design a new name.

Working with Projects
1.7 Determining the Global Design

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  101



5. If necessary, activate the shadow view and click on the "Shadow" button.
The "Shadow Settings" dialog is opened.

6. Set the shadow offset and the shadow color.
When you check "Synchronize", the offset in x and in y always remains the same. 

7. Click "OK" to confirm the changes.
The "Global Design Settings" dialog opens again. 
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8. If necessary, activate the hover effect and click on the "Hover" button.
The "Hover Settings" dialog is opened. The hover effect changes the object when the mouse 
pointer is moved over it.

9. Set the desired hover effect:

– Increase brightness - when the mouse pointer moves over the object, the entire object 
becomes brighter

– Inner glow - when the mouse pointer is moved over the object, the inside of the object 
glows in the selected color

– Outer glow - when the mouse pointer is moved over the object, the edge of the object 
glows in the selected color

10.Click "OK" to confirm the changes.
The "Global Design Settings" dialog opens again. 

11.Under "Display", select the desired object group or the desired design element and set its 
style and the associated color scheme.

12.Click "OK" to confirm the changes.

13.Click on "Apply" to save.

14.Click "OK" to close the dialog.

The created design is displayed in the preview. 
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1.7.5 How to determine the global design of the objects

Introduction
You can determine the design of the objects globally, i.e. project-wide. You can select from 
provided designs or create and activate your own designs. 

Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the 

Properties command in the pop-up menu.
The "Project Properties" dialog opens.

2. On the "User Interface and Design" tab, click "Edit" next to "Active Design".
The "Global Design Properties" dialog opens. 

3. Under "Designs", click on the desired design and confirm with "OK".
The selected design is displayed in the preview.
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Your Own Designs
You can edit your own designs in any manner. In particular, you can individually determine the 
following settings: 

● Global shadow

● Hover effect

● Style of an object group

● Color scheme of an object group

1.8 Making Settings for Runtime

1.8.1 Settings for Runtime

Introduction
When starting Runtime, WinCC uses the settings that have been specified in the Computer 
Properties dialog.

WinCC adopts the default settings for Runtime in every project. There are, however, some 
settings you must make yourself.

You can change the settings for Runtime at any time. If a project is running in Runtime, while 
you edit the settings, you must exit Runtime and restart. The changes are then applied.

Before you activate a project, you can specify the following settings.

Startup Tab

Entry Function

Start sequence of WinCC Runtime Applications that are loaded in Runtime
Additional Tasks/Applications Programs or tasks started with WinCC Runtime (for example, 

MS Excel)
Make sure that you only start tasks that you actually need on 
the computer.

Parameters Tab

Entry Function

Language Setting at Runtime Runtime language
Default Language at Runtime Runtime uses the text from this language if no text is available 

in the set runtime language. 
Start Information <no function assigned>
Disable Keys Prevent the use of certain combinations of keys
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Entry Function

PLC clock setting Modify communication of projects that were migrated from 
WinCC V5.

Time basis for time display in runtime Base for setting the time in WinCC
Central time and date formatting Determines whether date and time are displayed in 

accordance with ISO8601 everywhere or whether the format 
can be set locally. 

Graphics Runtime Tab

Entry Function

Project file Shows the path and name of the current project file 
Start Picture PDL file opened as the starting picture in Runtime 
Independent picture window Makes it possible to hide the main window in order to let 

picture windows appear like independent windows 
Start configuration menu and toolbars Configuration file with customized menus and toolbars
Window Attributes Appearance of the window in Runtime
Turn Off Prevents operator input in windows and switches of memory-

intensive image operations 
Hotkeys Key combinations for operator input and picture navigation
Cursor control: Behavior Navigation with the cursor in the picture
Cursor control: Keys Navigation with the cursor in the picture
Screen Navigation Navigation in the picture
Hide System Pictures Restrict access to system pictures

Runtime Tab

Entry Function

VBS Debug Options Graphics/Global 
Script:         
Start Debugger         
(only suitable for test and startup 
purposes)

Starts the debugger in Runtime, when the first picture is 
selected with a VBS script.

VBS Debug Options Graphics/Global 
Script:         
Display Errors Dialog         
(only suitable for test and startup 
purposes)

Opens a dialog in Runtime if a VBS error occurs and allows 
you to start the debugger. Script processing is interrupted.

Design Settings Makes it possible to switch off certain design options to 
improve the computer's reaction time. 

Picture Cache Path for the temporary storage of pictures
Mouse Pointer Actions of the mouse pointer in the picture
Monitor Keyboard Enable monitor keyboard
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See also
How to Start Runtime (Page 132)

How to Set the Time Base in the Project (Page 66)

Effect of External Applications at Runtime (Page 111)

How to Assign Hotkeys in the Project (Page 110)

How to Set Up a Startup List (Page 107)

How to Specify the Computer Properties (Page 59)

1.8.2 How to Set Up a Startup List

Introduction
When you activate a project, additional program modules required for execution in Runtime 
are loaded. In the startup list, you specify which applications will be started when you activate 
a project.

Depending on the configuration, WinCC itself enters some applications in the startup list. 
Graphics Runtime is always started and is activated by default.

To achieve better performance, you should only start applications that you actually require in 
Runtime.

Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.          

WinCC displays the list of computers in the data window.

2. Select the computer and then click the Properties command in the pop-up menu.          
The Computer Properties dialog is opened.
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3. Click the Startup tab.

4. Activate the applications to be loaded when Runtime starts in the Start sequence of the 
WinCC Runtime list box.         
The activated modules are marked with a check mark in front of the entry in the list. With 
the Edit button, you can open a dialog in which you can enter start parameters for an 
application.
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5. If you want to open additional programs or tasks when you start Runtime, click the Add 
button.         
The Add Application dialog is opened.

6. Enter the application and the full path in the Application input box. You can locate the file 
using the Browse button.

7. If required, select the start parameters, the working folder for the application, and the 
window properties.         
Click OK to confirm.          
The added application is entered in the Additional Tasks/Applications box. With the Remove 
button, you can delete an application from the startup list.

8. Select an application and click the Up and Down buttons. This is how you specify the order 
in which the applications are started. The list of additional applications is read out from top 
to bottom.

9. Click OK to close the dialog.

Multi-user system
In a multi-user system, make sure that you only start tasks on the client that the client really 
needs.

 

See also
How to Specify the Computer Properties (Page 59)

How to set up Runtime (Page 112)

How to Start Runtime (Page 132)

Settings for Runtime (Page 105)
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1.8.3 How to Assign Hotkeys in the Project

Introduction
You can assign the following hotkeys for your project:

● Logon opens a window to log on a user in Runtime

● Logoff opens a window to log off a user in Runtime

● Hardcopy opens a dialog for printing the screen in Runtime

Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the 

Properties command in the pop-up menu.          
The Project Properties dialog is opened.

2. Select the Hotkeys tab and choose the required action in the Actions list box.

3. Click in the Previously Assigned to input box. Press the required key combination.          
WinCC displays the keys you pressed.

4. Click the Assign button.          
WinCC stores the key combination for calling the action.

5. Assign other shortcut keys to any other actions you require.

6. Click OK to close the dialog.
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See also
How to Start Runtime (Page 132)

Preparation to Create a Project (Page 51)

Settings for Runtime (Page 105)

1.8.4 Effect of External Applications at Runtime

Introduction
There are numerous applications that can place a heavy load on a computer. These 
applications have nothing to do with WinCC but affect the system resources.

Cyclic Printing
Printing large amounts of data can utilize a lot of resources. You should defined cyclic print 
jobs so that they do not all start at the same time in Runtime.

Using Virus Scanners
The following virus scanners have been released for use with WinCC V7.0:

● Trend Micro "Office Scan" V8.0

● Symantec AntiVirus Corporate Edition V10.2 (Norton Antivirus)

● McAfee VirusScan Enterprise V8.5

Note

When using a virus scanner, make sure that the computer has sufficient system resources.

Updates started automatically over the network can cause load on the system.

Screen saver
Using a screen saver takes up processor time. This can lead to overload on the system.

There are bad screen savers that do not release parts of the work memory again and 
continuously reduce the available work memory.

The Windows Start Action Screen Saver can be used.

Optimizing Processor Utilization
During continuous operation, the usable work memory becomes badly fragmented after a time. 
To allow Windows to reorganize the work memory, the average utilization of the processor 
should be below 75%. You can check the processor utilization in the Windows System Monitor.

If you cannot achieve processor utilization less than 75%, you should upgrade your computer.
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Defragmenting a Hard Disk
Working intensively with the Windows file system can lead to inefficient organization of the 
hard disk, for example, when modified data are stored during commissioning.

To avoid loss of performance, the hard disk drive should be optimized regularly.

CAUTION

Before you start defragmentation, all authorizations must be returned to the diskettes, 
otherwise they may be irretrievably lost.

When operating WinCC in Runtime, make sure that no automatic optimization is activated. 
The time required for these activities can serious detrimental effects on WinCC performance.

Deactivating Power Management
To allow the WinCC Runtime system to operate correctly, power management must be 
deactivated in the BIOS setup and in the Control Panel of Windows.

If power management is activated, you may encounter problems when archiving process data 
and messages. The function can lead to a lack of resources when virtual memory is accessed.

Fast reactions to operator input are then no longer possible.

FindFast.exe
The Microsoft FindFast.exe application is used to accelerate searches for documents.

When configuring with WinCC, it is possible that FindFast.exe takes up a considerable 
percentage of processor capacity. You should therefore remove Microsoft Indexing from the 
Autostart folder of the operating system.

 

See also
Preparation to Create a Project (Page 51)

Settings for Runtime (Page 105)

1.8.5 Setting up Runtime

1.8.5.1 How to set up Runtime

Introduction
To test a WinCC project in Runtime, first setup the project's applications and operator functions 
that available in Runtime. These project settings must be adjusted for every computer on which 
the project should run.
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Using the "Computer properties" dialog, which is opened from WinCC Explorer, you can make 
the following project settings:

● "General" tab         
Configure computer name and computer type

● "Startup" tab         
Define modules and applications, which are to be started using the command "Activate 
Runtime".

● "Parameter" tab         
Change default settings for Language and Time in Runtime and lock certain key 
combinations

● "Graphics Runtime" tab         
Change default settings for the use of process pictures in Runtime

● "Runtime" tab         
User-specific settings for all WinCC projects on this computer

Requirements
● A project must be opened.

Open the "Computer properties" dialog
1. Select the entry "Computer" in the navigation window of the WinCC Explorer.         

All computers that are available for the current project, will be displayed in the data window.

2. In WinCC Explorer's data window, double-click the desired computer.         
The "Computer Properties" dialog will open.
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See also
How to change the computer name (Page 114)

How to configure the applications available in Runtime (Page 116)

How to Specify the Computer Properties (Page 59)

How to Set Up a Startup List (Page 107)

How to Change the default settings for Language, Time and Key Combinations (Page 117)

How to define hotkeys for operation and screen navigation (Page 119)

How to define a picture as the start picture in Runtime (Page 122)

How to configure the cursor control in Runtime (Page 124)

How to Activate Zoom Functions in Runtime (Page 126)

How to make computer-specific settings for runtime (Page 128)

How to switch off the optimized drawing (Page 130)

Activating Project (Page 132)

The Graphics Designer in the WinCC Explorer (Page 210)

Virtual keyboard - General Information (Page 673)

How to set up a picture for mouseless operation (Page 677)

Testing Process Pictures in Runtime (Page 656)

1.8.5.2 How to change the computer name

Introduction
To test a WinCC project in Runtime, the local computer name must be entered as a computer 
name in the project.

The computer name is changed on the "General" tab in the "Computer properties" dialog.

Requirements
● A project must be opened.

● The "Computer properties" dialog must be open.
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Procedure
1. Click the "General" tab.

2. Enter the name of the computer in the "Computer name" field.

3. In the "Computer Type" area, define which function is performed by this computer.

4. Confirm your entry with "OK".         
The changed computer name will not be applied until WinCC is restarted.

See also
How to set up Runtime (Page 112)

Working with Projects
1.8 Making Settings for Runtime

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  115



1.8.5.3 How to configure the applications available in Runtime

Introduction
The "Runtime" command is used to load additional program modules, which are required for 
the execution of Runtime. To ensure the maximum performance, activate only the applications 
that are actually needed in Runtime.

The applications, which will be available in Runtime, are configured on the "Startup" tab in the 
"Computer properties" dialog.
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Start sequence of WinCC Runtime
Select the modules that should be loaded while activating Runtime. The activated modules 
will be identified by a tick in front of each associated entry in the list.

Click the "Edit" button to modify the start parameter for a selected Runtime module.

Additional Tasks / Applications
In addition to the modules given in the upper area, other applications can be also be linked to 
start with the "Runtime" command.

Click the "Add" button to add the required applications to the list. You can clear an entry from 
the list by selecting it and then clicking on "Remove".

Click the "Edit" button to modify the start parameter for a selected application.

To change the sequence in which the individual applications are started, use the "Up" and 
"Down" buttons to rearrange the selected entries in the list. The list of additional applications, 
which should be started, is read from top to bottom.

Note

Each module requires computing power. Therefore, make certain that you only activate the 
modules that will be needed in Runtime.

See also
How to set up Runtime (Page 112)

1.8.5.4 How to Change the default settings for Language, Time and Key Combinations

Introduction
The configured language and the display mode for the time can be preset before activating 
Runtime. It is also possible to lock specific key-combinations.

The default settings for language, time and key-combinations are configured on the 
"Parameters" tab in the "Computer properties" dialog.
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Language Settings in Runtime
Select the language with which the project should be activated in Runtime on the selected 
computer.

Default Language at Runtime
Select the alternate language in which the text of graphics objects is supposed to be displayed 
if the respective translations do not exist in the language specified under "Language Setting 
at Runtime". 
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Disable Keys
To prevent operator errors in Runtime, Windows-typical key-combinations can be 
locked.          
Activate a check box to lock the respective key combination in Runtime. 

PLC Time Setting
Select the time setting that is valid for the PLC. A detailed description can be found in the 
chapter entitled "Time Settings in WinCC".

Time base for the time shown in Runtime
Select the mode for displaying the time in Runtime and in the report system. The following 
options are available "Local time zone", "Coordinated world time (UTC)" and "Server's time 
zone".

Central date and time formatting
Specify if date and time formatting should be configured at the components or if it should be 
forced at all components using the ISO 8601 format. A detailed description can be found in 
the chapter entitled "Time Settings in WinCC".

See also
Setting Time in WinCC (Page 64)

How to set up Runtime (Page 112)

1.8.5.5 How to define hotkeys for operation and screen navigation

Introduction
Process pictures can also be operated when a mouse is not available. For this purpose, key-
combinations must be defined to call the required operator functions. 

The most important hotkeys for mouseless operation in Runtime are set on the "Graphics 
Runtime" tab in the "Computer properties" dialog.
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Procedure
1. Click in the entry field for the desired function to activate it for the entry of a hotkey 

(combination).

2. Press and hold down the desired combination key .         
You can use <CTRL>, <ALT> or <SHIFT> as combination keys.

3. Now also press the key which should call the function.         
The selected key combination (such as <ALT+F>) is displayed in the input field.

4. If you want to change your entry, click in the entry field again.

As an alternative, you can enter a single key or a function key <F1> - <F12> instead of a key 
combination.

Note

The function key F12 may not be configured as a systemwide hotkey.
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Hotkey
Changes made to the hotkeys are first effective after the system has been restarted.

Window On Top
This hotkey is used to navigate between multiple picture windows, which are configured in a 
main picture. Whenever the hotkey is pressed, the next picture window will be activated for an 
operation.

Tab or Alpha Cursor
This hotkey toggles the "Cursor Mode" attribute. With this hotkey, a process picture can be 
operated with both an alpha cursor and a tab order cursor. A tab sequence must be configured 
for both types of cursors.

Runtime Cursor On/Off
By default, the selected object in Runtime will not be highlighted. This hotkey can be used to 
activate a Runtime cursor, which will highlight the currently selected object with a frame.

Note

The <DEL> and <HOME> keys cannot be used as hotkeys.

Screen Navigation
In all common Internet browsers, the "Forward" and "Backward" buttons make it easy to switch 
between Internet pages, which were recently examined. A similar technique can be 
implemented in WinCC to navigate between individual process pictures.

In the "Screen Navigation" area, you can configure hotkeys that will make it easy for you to 
switch between the most recently called process pictures in Runtime. Process pictures will be 
recorded in a temporary list whenever they are called. With the "Forward" and "Backward" 
functions, you can page through this list to, for example, call the last five pictures once again. 
The maximum permissible number of entries in this list is set in the field "Picture Buffer Size". 
If this number is exceeded, the oldest entry will be replaced when a new picture is called.

You can define hotkeys for the following functions:

● "Forward": Retrieves the next configured process picture

● "Backward": Retrieves the previous configured process picture

● "Start picture": Retrieves the picture that has been defined as the start picture

● "Stored Picture": Retrieves the picture that was last marked with the function "Store Picture"

● "Store picture": Function for storing the currently displayed picture
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Note

With the default value for "Picture Buffer Size", the list will record the calls for a maximum of 
30 pictures. As a rule, it is not reasonable to substantially increase this value, since the 
switchover can only be done in single steps. You can achieve more efficient screen navigation 
using picture modules.

See also
How to configure the cursor control in Runtime (Page 124)

How to set up Runtime (Page 112)

Virtual keyboard - General Information (Page 673)

How to set up a picture for mouseless operation (Page 677)

1.8.5.6 How to define a picture as the start picture in Runtime

Introduction
Runtime can only be started, when one of the project's process pictures has been defined as 
the start picture. This start picture will be displayed when Runtime is activated from WinCC 
Explorer.

The start picture is defined on the "Graphics Runtime" tab card in the "Computer properties" 
dialog.

Working with Projects
1.8 Making Settings for Runtime

MDM - WinCC: Working with WinCC
122 System Manual, 11/2008,  



Requirements
● A project must be opened.

● The "Computer properties" dialog must be open.

Procedure
In the "Start picture" field, enter the name of the desired picture file in the PDL format or click 
the "Find..." button to select it.

Alternative Procedure
1. Click in the navigation window of the WinCC Explorer with the left-hand mouse button on 

the entry "Graphics Designer".         
All pictures of the current project are displayed in the data window (format PDL).

2. Now right click the desired picture and select "Define screen as start screen".         
The selected picture is entered into the "Start picture" field in the tab "Graphics Runtime".
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See also
How to set up Runtime (Page 112)

The pop-up menu in the Data Window (Page 221)

1.8.5.7 How to configure the cursor control in Runtime

Introduction         
In process pictures with objects arranged in a tabular form, it is possible to define a cursor 
control to permit mouseless navigation between the configured objects.

The hotkeys for the cursor control and the behavior of the cursor are set on the "Graphics 
Runtime" tab in the "Computer properties" dialog.

Reaction
Specify how the cursor should react in a table of listed objects, once it has reached the last 
object in a line or column: This requires all objects are assembled as a complete table. The 
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table cannot have gaps. The height and width of the objects must be identical and the objects 
must be arranged vertically and horizontally to the exact pixel.

Normal
The cursor returns to the first object in the same line or column.

Normal without rollback
The cursor remains positioned on the last object in the line or column.

Extended
The cursor continues to the first object in the next line or column.

keys
Four hotkeys can be defined here for cursor control in Runtime.

First select the desired combination key by placing a tick in the associated check box. Then 
press a key for the desired cursor direction in the corresponding entry field.

Select the option "Turn on during activation", if the hotkeys for cursor control should always 
be available in Runtime.

See also
How to set up Runtime (Page 112)

Virtual keyboard - General Information (Page 673)
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1.8.5.8 How to Activate Zoom Functions in Runtime

Introduction
Zooming in Runtime is supported by three techniques:

● Decluttering         
Layers and the objects stored there can be shown and hidden. Limit values for masking 
and unmasking of objects are specified in menu "Tools>Settings" on the "Hide/Show" tab 
of Graphics Designer.

● Extended Zooming         
The view of the process picture in Runtime may be zoomed in or out using the mouse wheel. 
Hold the <CTRL> key down while turning the mouse wheel. If you turn the mouse wheel 
away from the palm of your hand, you increase the zoom factor.

● Panning         
If a picture has a zoom factor that shows the picture with scrollbars, you can move a picture 
cutout within the document. A navigation crosshair appears upon clicking on the mouse 
wheel. Moving the mouse pointer scrolls in the desired direction. The distance between 
mouse pointer and navigation crosshair determines the scrolling speed. Another click will 
deactivate panning.

Conditions for Using Zoom Function:
● a mouse driver by Logitech or Microsoft Intellimouse

● the mouse wheel must be set to "Autoscroll".

Both functions Decluttering and Extended Zooming may be turned off in the "Graphics 
Runtime" tab of the "Computer Properties" dialog. Activate the checkboxes of both respective 
entries in the area "Turn off". In the default setting the checkboxes are deactivated, i.e. the 
functions Decluttering and Extended Zooming are turned on.

Configuring Extended Zooming Picture-Specific
The function Extended Zooming may be turned on or off picture-specific. The setting is 
specified in the object properties of the selected picture in the "Miscellaneous" property group.

If you turn of the function Extended Zooming for a process picture, Extended Zooming must 
also be turned on for all process pictures in the "Graphics Runtime" tab of the "Computer 
Properties" dialog.
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A detailed description of the zoom function may be found in Chapter "Showing and Hiding 
Layers and Objects".

Note

WinCC Controls cannot be decluttered, except for "WinCC Slider Control", "WinCC Clock 
Control" and "WinCC Gauge Control".

See also
How to set up Runtime (Page 112)

Showing and hiding layers and objects (Page 264)

Elements and Basic Settings of the Graphics Designer (Page 228)

The Zoom Palette (Page 243)
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1.8.5.9 How to make computer-specific settings for runtime

Introduction
Some additional functions for WinCC Runtime can be activated on the "Runtime" tab in the 
"Computer Properties" dialog. The settings made on this tab apply for all WinCC projects run 
on this computer. The following settings can be made: 

● Set debug options for Visual Basic scripts in Graphics Designer

● Set debug options for Visual Basic scripts in Global Script

● Restrict global design effects

● Use picture cache

● Change mouse pointer

● Enable monitor keyboard
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Start Debugger
If the "Start Debugger" function is activated, the Debugger will be started when the first VB 
script is started in Runtime. The prerequisite for this function is that a Debugger for Visual 
Basic must have been installed. The function speeds up the troubleshooting during the 
planning phase.

The "Start Debugger" function can be configured separately for VB scripts in Graphics 
Designer pictures and for VB scripts in Global Script. For this reason, there are separate check 
boxes. 

Display Errors Dialog
If the "Display Errors Dialog" function is activated, an error dialog will be displayed in the event 
that an error occurs in a VB script. The dialog will display information about the error that has 
occurred. A debugger can be started by clicking on the corresponding button in the error dialog. 
The prerequisite for this function is that a Debugger for Visual Basic must have been installed.

The "Display Errors Dialog" function can be configured separately for VB scripts in Graphics 
Designer pictures and for VB scripts in Global Script. For this reason, there are separate check 
boxes. 

Design Settings
The global design requires the recommended hardware equipment. You can improve the 
computer's reaction time by switching off certain elements of the global design: 

● "Use "WinCC Classic" design": WinCC Runtime appears in the WinCC Classic Design 
regardless of the settings in the project properties.          
WinCC Classic Design does not allow for the use of all new program elements in WinCC.

● "Disable shadow": The shadow is generally switched off in the process pictures.

● "Deactivate background/progressions": Switches off the background picture and the color 
progressions.

Picture Cache
To display the Runtime pictures, WinCC normallly accesses the corresponding WinCC Server 
and retrieves the current pictures from it. Using the "Picture cache", it is possible to store the 
WinCC pictures locally for display in Runtime. This function is quite useful when working with 
WinCC Clients which are e.g. connected to the WinCC Server via a modem. When a Picture 
Cache is used, the WinCC Client need not reload the pictures continually. The required pictures 
must be manually saved on the computer which should use the Picture Cache. For this create 
a folder in the standard directory <"WinCC Installationsverzeichnis"/bin/PDLCache> on this 
computer. The name of the folder must have the name of the symbolic computer name of the 
package created on the server. 

The path to the location where the pictures are stored must be entered in the "Path" editing 
field. Enter the path information to the directory where the "PDLCache" folder is located. If you 
use the standard directory, you do not need to enter the path.

The following options are available in the "Use Cache" field: 
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Selection Function

not The Picture Cache will not be used.
Preferred Modified pictures will read from Server, unchanged pictures will be read from the Picture Cache.
always The pictures will always be read from the Picture Cache.

If a picture is changed on the WinCC Server, this picture must be manually updated in the 
Picture Cache.

Note

You must save the pictures in a folder in the "PDL Cache" directory. You must rename the 
folder according to the symbolic computer name of the package saved on the server.

If you do not want to save the folder with the pictures in the default directory, you must always 
create a "PDL Cache" directory first. You can then create the folder with the pictures in this 
directory.

Mouse pointer
In the mouse pointer area, you can configure WinCC Runtime to use a different mouse pointer 

in the display. With the  button, open the file selection dialog and navigate to the place 
where the cursor is saved. Select the desired cursor. The cursor data must be available in the 
"cur" or "ani" file format. 

Monitor keyboard
A tick in the "Enable monitor keyboard" check box will cause the virtual keyboard to be activated 
when WinCC Runtime is started. For further information, please see the chapter entitled 
"Monitor keyboard". 

See also
Global Design of the Objects (Page 92)

How to set up Runtime (Page 112)

Virtual keyboard - General Information (Page 673)

1.8.5.10 How to switch off the optimized drawing

Introduction
The "Optimized Drawing" setting affects the picture setup in Runtime. When the "Optimized 
Drawing" setting is activated, WinCC uses the background buffer. The pictures thus appear 
faster and more consistently in Runtime because they displayed in full right away. 

The optimized drawing is activated by default. It is however very memory-intensive. 
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Optimized drawing deactivated
When you deactivate the optimized drawing, the full picture building takes longer - each object 
is drawn individually. This can in particular cause the objects in the pictures to flicker for 
application objects and controls. 

We recommend deactivating the optimized drawing only in the case of memory bottlenecks 
and very large monitor resolutions. 

Procedure
1. Click "Computer" in WinCC Explorer and select "Properties" in the pop-up menu.

2. Select your computer and click "Properties".
The "Computer Properties" dialog opens. 

3. Activate the "Graphics Runtime" tab and check option "Optimized Drawing" under "Turn 
Off".
When you activate the option, the optimized drawing is switched off in Runtime. 
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1.9 Activating Project

1.9.1 Activating Project

Introduction
If you wish to operate and observe a process, you must Runtime the respective project. WinCC 
starts Runtime and activates communication with the programmable controller. All process 
data is stored in the Runtime databases. 

In this chapter, you will learn

● the settings you can make in Runtime

● how to Runtime a project

● how to deactivate a project

● how to Runtime a project automatically when you boot your computer

Note

When you start WinCC or open a project, holding down the keys <CRTL>+<SHIFT> prevents 
WinCC from activating Runtime at the same time.

When starting WinCC, if you hold down the keys <ALT>+<SHIFT>, you prevent WinCC 
opening a project at the same time. This also prevents Runtime being started at the same 
time.

 

See also
How to Exit Runtime (Page 137)

How to Set Up Autostart (Page 135)

How to Start Runtime (Page 132)

Settings for Runtime (Page 105)

1.9.2 How to Start Runtime

Introduction
When you start Runtime, you activate your project. All configured processes are started and 
run if the status of the system permits. You can also activate your project on a test system. 
You may receive error messages, however, it processes cannot run as intended on the test 
system.
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Principle
You can start Runtime in several ways:

● From the toolbar of the WinCC Explorer

● From the menu bar of the WinCC Explorer

● When you start WinCC

● From Autostart when you start the Windows system

During configuration you can call individual pictures in Runtime:

● From the toolbar of the Graphics Designer

● From the menu bar of the Graphics Designer

Requirements
● The computer must have the required Runtime license installed.

● The correct computer name must be entered in the project.

● A picture must be specified as the start picture.

Note

On project activating, free memory space of at least 100 MB must be available.

Procedure
1. Open the required project in the WinCC Explorer.

2. In the toolbar, click the  button.         
The Activate DATABASENAME dialog is opened. WinCC displays the applications that will 
be started. The WinCC Runtime window opens with the settings you selected in the 
Computer Properties dialog.

Note

During start of WinCC or during opening of a project, holding down the key combination 
<SHIFT>+<CTRL> prevents that WinCC activates the project immediately.

When starting WinCC, if you hold down the keys <SHIFT>+<ALT>, you prevent WinCC 
opening a project immediately. This also prevents Runtime being started at the same time.
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Alternative Procedures

Menu Bar of the WinCC Explorer
Open the File menu in the menu bar and select the Activate command. As long as Runtime is 
activated, WinCC displays a check mark beside the Activate command.

When you start WinCC
You can exit WinCC while a project is activated. When you restart WinCC again, WinCC opens 
the project and starts Runtime immediately.

Autostart when You Start the Windows System
You can also start WinCC using Autostart when the computer starts up. You can also specify 
that WinCC starts immediately in Runtime.

Graphics Designer
You can call a picture opened in the Graphics Designer in Runtime. If Runtime is already open, 
the picture replaces the current screen.

You can use this function in the following situations:

● You want to test a picture in Runtime.

● You want to update a picture in an activated project without any delay.

In the toolbar, you can start Runtime by clicking the  button.

In the menu bar, you can start Runtime in the File menu with the Activate Runtime command.

Note

You cannot exit Runtime from Graphics Designer. Exit Runtime in WinCC Explorer.

Multi-User Systems
In a multi-user system you must start Runtime on all servers first. Once all projects are activated 
you start Runtime on the WinCC clients.

Redundant Systems
When you start a project in a redundant system, you must first start Runtime on the master 
server. You can then start Runtime on the standby server.
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Activating a Project from a Remote Computer
In a multi-user system, you can activate a project on a computer from another computer. You 
must have the necessary access rights. You find more detailed information in the WinCC 
Information System under Configurations > Multi-User Systems.

See also
How to Set Up Autostart (Page 135)

How to Exit Runtime (Page 137)

Settings for Runtime (Page 105)

Opening WinCC Explorer (Page 29)

1.9.3 How to Set Up Autostart

Introduction
When you boot your computer, WinCC can be started with a selected project. Specify the 
project to be opened using the "AutoStart Configuration" tool.

Variants of Autostart
When you set up Autostart, you have the following options:

Setting in Autostart Action when the Windows system starts

Opening a Project WinCC starts up. The project is opened in the WinCC Explorer.
If the project was activated when you last exited, Runtime starts.

Add an alternative / redundant 
project

If you wish to start a client with redundant servers using autostart, 
also enter the alternative/redundant project into the autostart 
configuration. If the server is not available, the alternative project 
is started after a certain amount of time.

Activate project at startup WinCC starts up. The project is started in Runtime. the WinCC 
Explorer is not opened.
If the autostart configuration of the client has set the check box 
Activate Project at Startup and the server is in CS and is available, 
the server and then the client will be activated.

Allow "Cancel" on activation WinCC starts up. If the project is started in Runtime, you can use 
the "Cancel" button to cancel activation of it.
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Note

If the user does not have administrator rights, he may not configure the autostart configuration 
and may not enter a login after clicking the AutostartRT Hangup option. A user with 
administrator rights may enable autostart for users with automatic login by selecting the check 
box Automatic Login for all Windows Users.

In the case of autostart on a client without a separate project, the user needs the "Configure 
remote" WinCC system authorization. The project is opened implicitly in the background on 
the client during autostart.

After the overall loading from the Engineering Station (ES) to the Operator Station (OS), you 
must reconfigure autostart on the client for safety reasons. You must enter user name and 
password again.

Procedure
1. Open the Windows start menu and select "SIMATIC > WinCC" and then the "Autostart" 

command.          
The "AutoStart Configuration" dialog opens.

2. Select the required project by clicking the  button beside the Project box.          
The project file and its full path are entered in the box.

3. If you want the project to be opened in Runtime, check the "Activate project at startup" box.

4. Click the "Activate Autostart" button.          
The next time you boot the computer, WinCC starts automatically and the selected project 
is opened.

Removing WinCC from Autostart
If you no longer want WinCC to start when you boot the computer, you can remove the project 
from Autostart.

Open the "AutoStart Configuration" dialog and click the "Deactivate Autostart" button. WinCC 
is removed from Autostart. The project path remains registered in the Project box.

Note

If you have configured Autostart for a project, the project is also restarted when the "SIMATIC 
WinCC CCProjectMgr" service is restarted.

See also
Opening WinCC Explorer (Page 29)

How to Start Runtime (Page 132)
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1.9.4 How to Exit Runtime

Introduction
When you exit Runtime, you deactivate your project. All active processes are stopped.

Principle
You can exit Runtime in several ways:

● From the toolbar of the WinCC Explorer

● From the menu bar of the WinCC Explorer

● When you close a project

● When you close the WinCC Explorer

● With a C Action in the activated project

Procedure
1. Change to the WinCC Explorer.

2. Click the  button in the toolbar.          
The Deactivate DATABASENAME dialog is opened. WinCC displays the applications that 
will be exited. The WinCC Runtime window is closed.

Alternative Procedure

Menu Bar of the WinCC Explorer
Open the File menu in the menu bar and select the Activate command. WinCC removes the 
check mark beside the command indicating that Runtime is activated.

Closing the Project
You can close the project running in Runtime. This deactivates the project.

Closing the WinCC Explorer
You can close WinCC while a project is activated. This deactivates the project.

Note

After starting, WinCC always opens the last project that was open before you exited. If the 
project was activated when you exited WinCC, it will be opened in Runtime again.
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C Action in the Activated Project
You can, for example, configure a button in the project with which you can exit Windows. To 
do this, use the Exit WinCC Runtime and Exit WinCC dynamic wizards.

Multi-User Systems
In a multi-user system, you can deactivate a project in any order on the servers and clients. If 
you first exit Runtime on a server, the boxes with the missing process values in the client 
projects are deactivated (gray). As soon as you start the corresponding server again, WinCC 
adopts the current values in the client project.

Deactivating a Project from a Remote Computer
In a multi-user system, you can deactivate a project on a computer from another computer. 
You must have the necessary access rights. You find more detailed information in the WinCC 
Information System under Configurations > Multi-User Systems.

See also
How to Start Runtime (Page 132)

Closing WinCC Explorer (Page 32)

Dynamizing Using Dynamic Wizard (Page 822)

1.10 Copying and Duplicating Projects

1.10.1 Copying and Duplicating Projects

Introduction
You copy or duplicate a project with all important data onto the local or another computer using 
the Project Duplicator.

A project can be copied using the "Save As ..." feature in the following cases:

● You want the same project to be edited on several computers.

● You want a project to run in a multi-user system on several computers.

● You want to edit a project and use the download changes online function.

● You want to archive a project as a backup.

After you have copied the project, you can save it to a storage medium.

You duplicate a project in the following case:
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● You want a project to be duplicated on a redundant server.

See also
How to duplicate a redundant project at runtime (Page 145)

How to Duplicate a Project for Redundant Servers (Page 142)

How to Copy a Project (Page 139)

1.10.2 How to Copy a Project

Introduction
You can copy the configuration data and the runtime data of a closed project. 

Note

The copying of variables or structure types from an open project to another project is not 
allowed.     For example, you open an old project and copy a structure type and the structure 
variables. Then you open a new project and add the structure type and the structure variables.

Make regular backups of a project during configuration. This allows you to go back to a 
previous version of the project and continue from there.

If you modify a project later, you should also make a backup on completion of each change. 
If necessary, you can then revert to the original version without having to edit the project 
again.

Principle
Select the project you want to copy in the Project Duplicator.

Enter the folder into which the project will be copied. In the description below, this folder is 
called the target folder.

The target folder can be on the same computer or on another computer in the network for 
which you have access rights. The project folder is created in the target folder. When you copy 
it, you can change the name of the project. The project folder is created with the project name.

You can only copy the entire project and the entire folder structure. You cannot exclude any 
data or folders from the copy operation.

After the project has been copied, you can open and edit or activate it immediately. If you open 
the project on another computer, you must change the computer name.

Working with Projects
1.10 Copying and Duplicating Projects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  139



Note

If the Duplicate or Save As ... options of the Project Duplicator are used, the same WinCC 
version must be installed on the target computer.

Projects created using SIMATIC Manager should not be copied using the Project Duplicator.

Copying to a storage medium
You cannot copy a project directly to a data medium. If you want to copy a project for archiving 
on an external data medium, such as a CD-ROM, copy the project to a local folder. Then copy 
this folder to the data medium.

If you compress the project files before copying, for example in a ZIP archive, you need less 
space on the data medium. This also prevents each individual file from becoming read-only 
after copying to a CD-ROM.

Copying a project with project-based access protection
SIMATIC STEP 7 must be installed in order to create a copy of a WinCC project with project-
based access protection.

When you click the "Save As" button in the "WinCC Project Duplicator" dialog, you have to 
enter the password for the STEP 7 project.

If SIMATIC STEP 7 is not installed or you enter the wrong password, the Project Duplicator 
aborts with an error message.

Requirements
● The project to be copied must be closed. Another project may remain open on the source 

computer and may run in Runtime.

● The target folder has been created.

● You have access rights for the target folder.

● No WinCC project must be open on the target computer since write-protected or system-
accessed data cannot be overwritten by the Project Duplicator.

● The target computer has enough free space on the hard disk.

Working with Projects
1.10 Copying and Duplicating Projects

MDM - WinCC: Working with WinCC
140 System Manual, 11/2008,  



Procedure
1. In the Windows start menu, select "Project Duplicator" under "SIMATIC > WinCC > Tools". 

The WinCC Project Duplicator is opened.

2. Enter the project you want to duplicate in the "Select the source project that is to be 
duplicated" field. Enter the path and the <PROJECT>.MCP project file directly or browse 
for them by clicking the  button.

3. Click the Save As... button. The "Saves a WinCC project" dialog is opened.

4. Select the folder to which you want to copy your project and enter the name of the project 
in the "File name" field.
If you wish to save a copy of the project with a different name, enter the new name. The 
project files are renamed accordingly when the project is copied.

5. Click on the "Save" button.
The "Copy ..." window opens. When copying, the Project Duplicator displays the files and 
folders with a progress bar. Use the "Cancel" button to stop the copying.
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6. Close the Project Duplicator with the Close button.

7. If you have copied the project to another computer, the original computer name is still 
entered in the project properties. Correct the computer name in the project properties when 
the project is opened for the first time. The modified computer name is adopted after you 
close and open the project again.

Alternative procedure
You can also copy a project in the SIMATIC Manager using the "Download to CPU" feature. 
For more detailed information, refer to the WinCC Information System under "Working with 
WinCC > Integration of WinCC in the SIMATIC Manager".

Copying a multi-user project
If you copy a multi-user project to another computer, you must adapt the computer name after 
opening the project.

If you have already created packages in the copied project, the old computer name will be 
used when the packages are generated. Before the packages are created, correct the 
computer name in the "Symbolic computer name" and "Physical computer name" fields. 

1.10.3 How to Duplicate a Project for Redundant Servers

Introduction    
If you have created a redundant system, you must synchronize the WinCC project on the 
redundant servers following any modification.

To transfer the project to a redundant server, you use the WinCC Project Duplicator.

Note

You cannot use Windows Explorer to transfer a project to a redundant server.

Principle
Select the project you want to duplicate in the Project Duplicator.

Specify the computer and folder in which the project will be duplicated. The project folder is 
created in this target folder.

You cannot duplicate a project on the local computer. You always duplicate a project on another 
computer in the network to which you have access rights. In the description below, this is called 
the target computer.

Depending on the status of the project, you can copy the configuration data and the runtime 
data into the selected folder:
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Project Status Configuration Data Runtime Data

Project closed + +
Project open and deactivated + -
Project in Runtime + -

You can only duplicate the entire project and the entire folder structure. You cannot exclude 
any data or folders from the duplicate operation.

Duplicating a project with project-based access protection
SIMATIC STEP 7 must be installed in order to transfer a WinCC project with project-based 
access protection to a redundant server.

When you click the "Duplicate" button in the "WinCC Project Duplicator" dialog, you have to 
enter the password for the STEP 7 project.

If SIMATIC STEP 7 is not installed or you enter the wrong password, the Project Duplicator 
aborts with an error message.

Requirements
● The redundancy option is installed on both computers.

● The target folder for the duplication is created on the target computer and is made available 
for network access.

● You have access rights for the target folder.

● The target computer has enough free space on the hard disk.

● The correct WinCC version must be installed on the target computer. The computer must 
be started.

● Runtime is deactivated on the target computer.

● The project is closed on the target computer.
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Procedure
1. In the Windows start menu, select the "Project Duplicator" entry in the "SIMATIC > WinCC 

> Tools" folder. The WinCC Project Duplicator is opened.

2. Enter the project you want to duplicate in the "Select the source project that is to be 
duplicated" box. Enter the path and the <PROJECT>.MCP project file directly or search by 
clicking the  button.

3. Enter the path where the duplicated project will be stored in the "Store duplicated project 
for redundancy partner at" box. Enter the folder path and the <PROJECT>.MCP project file 
directly or search by clicking the  button.

4. Click the Duplicate button.
The "Copy" window is opened. During duplication, the Project Duplicator displays the files 
and folders with a progress bar. Use the "Cancel" button to stop duplication.
After duplicating the "Notes on the Project Duplicator" window is opened. WinCC indicates 
the settings that you still need to check.

5. Close the Project Duplicator with the Close button.

6. Check the settings in the duplicated project and change them if necessary.

7. Check the following:

– The computer name.

– The settings in the Redundancy Editor.

– If necessary, the settings in the editors.

Note

If you duplicate an open WinCC project on the source computer, no progress bar will 
be displayed. 
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1.10.4 How to duplicate a redundant project at runtime

Introduction
If you edit a redundant project, you can also update the project on the redundant server during 
operation.

You can save minor changes with the Save Online Changes function and then transfer them 
to the servers. You should also refer to the documentation on the topic of "Load Online 
Changes".

Duplication using the Project Duplicator
Some configuration cannot be saved by the download online changes function. In this case, 
you must generate a duplicate of the project to the redundant server using the Project 
Duplicator.

NOTICE

No Redundancy

For changes during normal operation, you must deactivate one of the partner servers. During 
this time, no redundancy is available.

Requirements
● The target folder has been created.

● You have access rights for the target folder.

● The redundant server on which the copied project will be stored has enough free hard disk 
space.

Procedure
This chapter describes how to use this function in a redundant system with the two servers 
Server1 and Server2.

1. Exit Runtime on the redundant Server1 and close the project.

2. Make the configuration changes on Server2 in Runtime and save the changes.

3. Start the Project Duplicator on Server2.

4. Use the "Duplicate" button to duplicate the project on Server1 to the target folder of the 
project deactivated under "1." and overwrite it.

5. Open the project on Server1.

6. Check the settings.

7. Start Runtime and wait for the redundancy synchronization.
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1.11 Appendix

1.11.1 Editors and Functions in WinCC Explorer

Introduction
You can see the installed WinCC editors and functions in the navigation window of the WinCC 
Explorer. The editor belonging to an option is only visible in the navigation window when the 
option is installed.

Some tools and some WinCC options are not displayed in the WinCC Explorer. You can open 
the tools in the Windows Start menu in the Simatic folder under WinCC > Tools. You can open 
some of the editors of the WinCC options independently of WinCC. For more detailed 
information, refer to the help on the specific options.

Opening an Editor
You can open an editor in the WinCC Explorer in the following ways:

● Using the pop-up menu of the editor in the data window or in the navigation window

● By double-clicking the editor in the navigation window

List of Editors and Functions
The following two tables list all editors and functions that you can open using the WinCC 
Explorer.

The tables contain the following information:

● Object:          
Name of the editor or function in the WinCC Explorer.

● Use:          
Information on what the object is used for.

● Online Help:          
This column names the relevant chapters in the WinCC Information System that contain 
more detailed information on the object.

● Import/Export Tools:          
Names tools which can be used to import or export data.

● Switch language:          
Indicates whether or not foreign languages can be configured.

● Online Configuration:          
Indicates whether or not the object can be used while the project is active in Runtime. You 
find information on restrictions regarding online configuration in chapter Online 
Configuration and in the description of the editors.
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Object Usage Online Help 1) Import/Export 
Tools

Language 
Switching

Online 
Configuration

Computer Computer name and 
properties, project 
properties (client and 
servers)

Working with projects --- Yes Yes 2)

Tag Management Tag Management: 
Creating and editing tags 
and Communication 
drivers

Working with tags WinCC 
Configuration 
Tool

--- Yes 2)

Structure Tag Creating and editing 
structure types and 
structure tags

Process picture 
dynamics

WinCC 
Configuration 
Tool

--- Yes 2)

Graphics Designer Creating and editing 
process pictures

Creating Process 
Pictures

Export function 
of the editor

Yes Yes

Menus and 
toolbars

Configure user-defined 
menus and toobars for 
process pictures

Creating Process 
Pictures

--- Yes Yes

Alarm Logging Configuring messages 
and archiving events

Setting up an Alarm 
System

WinCC 
Configuration 
Tool
Text Library

Yes Yes 2)

Tag Logging Logging and archiving tags Working with process 
values

WinCC 
Configuration 
Tool

--- Yes

Report Designer Configuring reports and 
report layouts

Documentation of 
Configuration and 
Runtime Data

--- Yes Yes 2)

Global Script Making a project dynamic 
with C functions and 
actions

ANSI-C for creating 
functions and actions

Export function 
of the editor

Yes Yes

Text Library Creating and editing 
language-dependent user 
texts

Setting up multilingual 
projects

Export function 
of the editor

Yes Yes

Text Distributor Exporting and importing 
language-dependent text

Setting up multilingual 
projects

Export and 
Import function 
of the Editor

Yes Yes

User Administrator Managing access 
permissions for users and 
user groups

Setting up user 
administration

Text Library Yes Yes

Cross Reference Localizing, displaying, and 
rewiring the location at 
which objects are used

Working with cross 
reference lists

--- --- Yes

Load online 
changes

Transferring edited data to 
the operator station

Working with projects --- --- Yes 2)

Server data Creating and editing 
packages for multi-user 
systems

Configurations > 
Multi-user Systems

--- --- Yes

1) You will find the chapters listed in the WinCC Information System in the book Working with 
WinCC.
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2) with restrictions

Options

Object Usage Online Help Import/
Export 
Tools

Language 
Switching

Online 
Configurati
on

WebNavigator Operating and 
monitoring using 
Internet/intranet

Options > 
WebNavigator

--- Yes ---

DataMonitor 
WebEdition

Displaying archive 
values in Internet/
intranet

Options > 
WebNavigator > 
DataMonitor

--- Yes ---

Redundancy Operating two 
servers at the same 
time in a redundant 
system

Configurations > 
Redundant 
Systems

--- --- Yes

User Archive Configurable 
database system 
for data from 
technical 
processes, for 
example for 
recipes and 
setpoints

Options > User 
Archives

Text 
Library

Yes Yes

OS Project Editor Initializing and 
configuring the 
Runtime user 
interface and alarm 
systems in PCS 7

Options for 
Process Control 
> OS Project 
Editor

--- --- ---

Time synchronization Synchronizing the 
time of day on all 
clients and servers

Options for 
Process Control 
> Time 
synchronization

--- --- Yes

Horn Indicating 
message-relevant 
events on signal 
modules and PC 
sound cards

Options for 
Process Control 
> Audio alarm

--- --- Yes

Picture Tree Manager Managing picture 
hierarchies and 
name hierarchies

Options for 
Process Control 
> Picture Tree 
Manager

Text 
Library

Yes Yes

Lifebeat monitoring Permanent 
monitoring of the 
system

Options for 
Process Control 
> Lifebeat 
Monitoring

--- --- ---
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Object Usage Online Help Import/
Export 
Tools

Language 
Switching

Online 
Configurati
on

Component List 
Editor

Allocating entry 
point pictures and 
areas to the 
measuring points

Options for 
Process Control 
> Component 
List Editor

--- --- ---

ProAgent Configuring 
process 
diagnostics to 
detect and 
eliminate problems

Options > 
ProAgent

--- --- Yes

See also
Windows of the WinCC Explorer (Page 41)

Elements of the WinCC Explorer (Page 35)

1.11.2 WinCC status and control in the system tray

Introduction
WinCC shows the "SIMATIC WinCC" symbol in the Taskbar Notification Area, the so-called 
tray area. This symbol provides information on the project status. The WinCC project can be 
activated and deactivated via the symbol's pop-up menu.

Project status
The following table shows which project status goes with which symbol:

SIMATIC WinCC® symbol Status

● WinCC is not active.
● No project is open.
WinCC changes the status:
● WinCC opens a project.
● WinCC activates a project.
● WinCC deactivates a project.
● WinCC closes a project.
Project is open.

The project is activated.
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Control Options via the Pop-up Menu
You can control an open project depending on its status. The pop-up menu of the "SIMATIC 
WinCC" symbol provides the following control options:

● Start Graphics Runtime.

● End Graphics Runtime.

● Activate project.

● Deactivate project.

● Open diagnosis window.

SIMATIC WinCC® Window
To open the "SIMATIC WinCC" window, click on the "SIMATIC WinCC" symbol.

Example: Window with Runtime activated

The window shows the following information:

● Project name

● Project type

● Project status

● Computer List
The local computer is represented in blue.

Computer List
The computer list contains all computers on the network. If the project is activated, the 
connection status of all existing computers is shown.

The following table shows the icons of the connection status and their meaning:

Icon Status

● No connection
● Connection disconnected
● Local computer
● Redundant partner server
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Icon Status

Connected
● With standby server
● With master server, but standby server is the preferred server
Connected
● With master server
● With standby server as preferred server

1.11.3 WinCC diagnostics window and license information

Introduction
The diagnostics window provides information on the diagnostics of the local computer and 
connected servers. 

The "WinCC Diagnostics" dialog shows WinCC e.g. invalid licenses of the local computer and 
the connected servers. 

Diagnostics Window.
Open the diagnostics window using the pop-up menu of the  icon in the tray area.

Working with Projects
1.11 Appendix

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  151



The diagnostics window shows diagnostics information for the local computer and the 
connected computers:

● Information

● License messages

● Warnings

● Error

Control Options
Use the "Computer" and "Diagnosis type" buttons to sort the contents of the displayed 
diagnostics. 

For detailed information on a message, double-click on the desired message.

Information on Invalid Runtime Licenses
WinCC shows invalid Runtime licenses of the local computer and all connected servers in a 
dialog that requires acknowledgement. The name of the concerned computer is listed in 
brackets. 

You can only use the "Details" button locally on the computer with the invalid license.

Use the "Details" button to start the Automation License Manager. The Automation License 
Manager provides further information and installs the required licenses. 

1.11.4 Illegal Characters

Introduction          
Depending on the language and components, only certain characters are permitted in names.

In WinCC, you can use all characters of the ASCII character set. We do, however, recommend 
that you avoid special national characters. Above all, you should avoid special characters in 
object names, if the object names are used in scripts.

The following table lists the characters that must not be used in WinCC components, identifiers, 
and names.
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Illegal characters in WinCC

Component Illegal characters

WinCC project:          
Names of WinCC projects

. , ; : ! ? " '          
+ = / \ @ *          
[ ] { } < >          
Space         
Case-sensitive

Tags:          
Tag names

: ? " '          
\ * $ %          
Space         
Not case-sensitive
@ is used only in system tags.         
The period is used as a separator in structure tags.

Tags:          
Names of process tags in Tag Logging

:  ? " '         
\ * % >          
Space

Tags:          
Names of archive tags in Tag Logging

:  ? " '         
\ * % >          
Space

Tags:          
Names of tag groups

? '          
\          
Space         
Not case-sensitive

Structure types:          
Names of structure types, structure 
elements and structure instances

. : ? '          
\ @ * %          
Space

Graphics Designer:          
Names of pictures (PDL files)

: ? " '         
/ \ *          
< > 

Graphics Designer:          
Names of objects in pictures

The name can be no longer than 180 characters.          
If you use special characters, the maximum number of 
characters is further restricted.
Avoid using special characters if the object name is used in 
scripts.         
For more detailed information, refer to the documentation on 
VBS in the section Testing with the Debugger > Action and 
Procedure Names in the Debugger.

Graphics Designer:          
Text list object type

Restriction for assigned and referenced texts:         
;

Graphics Designer:          
Names in the Dynamic Wizard

%

Graphics Designer:          
Faceplate

The following applies to the names of properties (Properties) 
and events (Events):         
! " § $ % & / () = @         
. , ; - _ # * ~ + ° ^         
Ä Ö Ü ä ö ü         
Spaces         
Lead characters
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Component Illegal characters

Alarm Logging:          
Names of message blocks, message 
classes, message types and message 
texts

'          
ENTER key         
line feed

Tag Logging:          
Archive name

. , ; : ! ? " ' ^ ´ ` ~          
- + = / \ * # % & § °          
( ) [ ] { } < >          
Space

Tag logging / trend control:          
Labeling time axis and value axis

Single & character is not displayed.         
Double & character is displayed once.

Report Designer:          
Names in the page layout and line layout

: ? "          
/ \ *          
< > 

User Administrator:          
User names

'          
\          
Not case-sensitive

User Administrator:          
passwords

'          
\          
Not case-sensitive

User Administrator:          
User authorizations

'          
\ 

User archives:          
Names for archives, fields, views and 
columns

. , ; : ! ? " ' ^ ´ ` ~          
- + = / \ @ * # $ % & § °          
( ) [ ] { } < >          
Space
The first character must be a letter.

Server data:          
Names of packages

,          
/ \ 
National special characters, for example umlauts (ä, ü etc.) 
are not permitted.

Illegal characters for basic settings

Component Illegal characters

Computer name . , ; : ! ? " ' ^ ´ ` ~          
- + = / \ ¦ @ * # $ % & § °          
( ) [ ] { } < >          
Space         
only uppercase relevant
The first character must be a letter.

DNS host names , ; : ! ? " ' ^ ´ ` ~          
_ + = / \ ¦ @ * # $ % & § °          
( ) [ ] { } < >          
Space

Folder path:          
Names of folders

: ? " '         
/ *          
< > 

WinCC Explorer Restrictions depending on individual components
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Component Illegal characters

Communication:          
Names of connections under a channel 
unit

Restrictions in relation to the SQL database

Communication / OPC:          
Used names

. : ? " '          
\ * %          
Space

Web client:          
Used names

. , ; : ! ? " ' ^ ´ ` ~          
- + = / \ @ * # $ % & § °          
( ) [ ] { } < >          
Space

Illegal characters for integrating in the SIMATIC Manager

Component Illegal characters

SIMATIC Manager:          
Names of WinCC projects

. , ; : ! ? " '          
+ = / \ @ * %         
[ ] { } < >          
Space

OS compilation:          
AS-OS connection names

. : ? " '          
\ * %          
Space

PCS7:          
Hierarchy folder

. "          
/ \ % 

See also
Preparation to Create a Project (Page 51)

File Structure of a Project (Page 155)

1.11.5 File Structure of a Project

Introduction
In a WinCC project, you find additional information in certain folders and files. By default, 
WinCC projects are stored in the path Siemens\WinCC\WinCCProjects\<Project>.

Imported Files
Imported files, for example graphics, scripts, texts, programs, OCS files are located within the 
folder structure.
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Data Storage
The table lists the most important data and folders.

Path File Type Function

<Project folder> --- Folder Contains all 
files created 
for the project.

<Project folder>\GraCS --- Folder Contains all 
pictures and 
picture files of 
a project.

<Project folder>
\CommonArchiving

--- Folder Contains all 
databases for 
archiving.

<Project folder> <Project>.MCP Project 
file

Starts WinCC 
and opens the 
project in the 
WinCC 
Explorer.

<Project folder> <Project>.MDF Database Configuration 
database

<Project folder> <Project>RT.MDF Database Runtime 
database,          
database 
management 
(master 
database)

<Project folder> <Computer>_<Project>_ALG_JJJJMMT
THHMM.MDF

Database Runtime Data 
Alarm Logging

<Project folder> <Computer>_<Project>_TLG_F_JJJJMM
TTHHMM.MDF

Database Runtime data 
Tag Logging 
fast 
(acquisition 
cycle < 1 min)

<Project folder> <Computer>_<Project>_TLG_S_JJJJMM
TTHHMM.MDF

Database Runtime data 
Tag Logging 
slow 
(acquisition 
cycle > 1 min)

Siemens\WinCC\bin WinCC_SQL.MDF Database Empty 
Runtime 
database that 
can, when 
necessary, be 
copied to the 
project and 
renamed. 
Created when 
you create a 
new project.
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Path File Type Function

Siemens\WinCC *.LOG Log files Reports: 
setup, system 
status, error 
messages.

<Project folder> UAEditor.loc Temporar
y file

Created when 
the editor's 
user archives 
are opened. 
Must be 
deleted if the 
editor is not 
closed 
correctly.

See also
Preparation to Create a Project (Page 51)
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Working with Tags 2
2 Resources

2.1 Working with Tags

Content
This chapter contains all important items of information about tags:

● Tag Management and tag selection dialog

● Tag Types

● Create and edit tags

● Create and edit tag groups

● Create and edit structure types

● Logging tags in Runtime

 

2.2 Tag management

Introduction
Tag Management administers the tags and communication drivers used in the project. You 
will find Tag Management in the navigation window of WinCC Explorer.

Usage
Tags with values supplied by the process are referred to as process or external tags in WinCC. 
In the case of process tags, Tag Management determines the communication driver by means 
of which WinCC is connected to the automation system and how the exchange of data is taking 
place. The associated tags are created in the directory structure of this communication driver.

Tags not supplied with values by the process, known as the "internal tags", are created in the 
"Internal Tags" directory. 

To provide a better overview, you can arrange the tags in Tag Management in groups.

Creating tags in Tag Management leads to a directory structure in which you can navigate in 
a manner similar to Windows directories.
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Configuration of Tag Management

① Menu bar
② Toolbar
③ Navigation Window
④ Tooltip
⑤ Data Window
⑥ Status bar

Navigation Window
You will find Tag Management in the navigation window of WinCC Explorer.

Internal tags and associated tag groups will be found in the "Internal Tags" directory.

WinCC creates a new directory in Tag Management for each communication driver that is set 
up. Under the communication driver you will find a channel unit, its connections and associated 
tag groups and process tags.

Tag Management uses the following icons:
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Icon Description

Tag management

Internal Tags

Communication Drivers

Channel Unit

Connection

Tag group

Tag

Structure type

Data Window
The data window of WinCC Explorer shows you the contents of the directory you selected in 
the navigation window.

Tooltip
In Runtime you can view the status information on connections and tags as a tooltip. To view 
it, move the mouse pointer in the data window to the connection or tag you want.

The tooltip contains the following information:

● with a connection, brief information about the state

● the current process value of a tag

● the quality code of a tag

● the date on which a tag was last changed

Note

A tooltip is displayed on a WinCC client only when no standard server is defined for tags.

Menu bar
At "Edit" you can cut, copy, paste and delete tags and tag groups. At "Edit" > "Properties" you 
can view the properties of the selected tag, the communication driver, the channel unit or 
connection.

At "View" you can modify the way in which objects are presented in the data window and update 
the display.

Toolbar
For tags and tag groups you can use the "Cut", "Copy", "Paste" and "Properties" buttons.

You can modify the display in the data window by means of the "Large Icons", "Small Icons", 
"List" and "Details" buttons.
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Status bar
The status bar can display the following information, regardless of the operated object:

● current directory path in the project and tips on operation

● External tags: Number of configured process tags

● License: Number of licensed process tags (power tags)

Searching
In Tag Management you can open the search function from the shortcut menu.

You can search for tags, tag groups, connections, channel units and communication drivers.

See also
Tags (Page 163)

2.3 Tag Management and Tags

2.3.1 Tag Management and Tags

Introduction
Communication between WinCC and the automation system takes place by means of 
communication drivers. Data generated by the automation system or the WinCC project are 
transferred by means of tags.

This chapter provides information on managing tags and on the different types of tags.

See also
Communication Driver (Page 174)

Tag Selection Dialog (Page 171)

Tags (Page 163)

Tag management (Page 159)
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2.3.2 Tags

2.3.2.1 Tags

Introduction
Data are passed on in a WinCC project by means of tags. A tag has a data address and a 
symbolic name, which is used in the project. The data address is used in communication with 
the automation system.

WinCC works with two kinds of tags:

● Process Tags

● Internal Tags

WinCC simplifies tag handling by means of two other object types:

● Tag Groups

● Structure types

Naming Conventions
When naming tags, you must respect certain conventions:

● Tag names must be unique throughout the project. When tags are created, WinCC does 
not distinguish between upper and lower case characters in a name.

● Tag names must not be longer than 128 characters. In the case of structure tags, this limit 
applies to the whole expression structure tag name + dot + structure tag element name. 

● You must not use certain characters in tag names. You will find the characters you must 
not include in a name in the WinCC Information System at Working with projects > 
Authorized characters

Note

You must not create tags whose name starts with an '@'. Tags with an @ prefix are created 
only by WinCC and PCS 7.

Remember that WinCC distinguishes between upper and lower case characters in a 
configuration. If you change upper and lower case characters in a tag name, you must adapt 
your configuration accordingly.

Updating Tags
In the case of process tags, the current tag values are transferred over the communication 
connection between WinCC and the connected automation systems in Runtime. In this 
instance, WinCC accesses the data area on the automation system that is defined in the tag 
properties. The current value of the process tag is made available by WinCC in Tag 
Management after it has been transferred for further processing and evaluation. Conversely, 
WinCC can also write data back to the automation system.
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In WinCC you set the frequency of data transfer and of updating in the display. Remember 
while you are configuring that periodic updating of tags results in severe loading of the system 
and can have an adverse effect on performance.

Importing Tags
You can also create tags external to WinCC and import them into your project.

For example, you can establish a connection to the WinCC configuration tool for your project 
and create the tags with the help of the configuration tool in an Excel table. You assign certain 
properties to these tags in the table. WinCC can use the configuration tool to read in the data 
and then automatically creates the tags with the specified properties.

See also
Tag Selection Dialog (Page 171)

Tag management (Page 159)

Tag Groups (Page 170)

Structure Types and Structure Tags (Page 167)

Internal Tags (Page 166)

Process Tags (Page 164)

2.3.2.2 Process Tags

Definition
You use process tags for communication between WinCC and the automation system.

The properties of process tags depend on the communication driver being used. Therefore, 
create process tags in Tag Management also under a specific communication driver, its 
channel unit and its connections.

You can set the following properties for process tags:

● Name

● Data type

● Address on the channel unit

● Type Conversion

● Limit values

● Start value

● Replacement value

● Scaling

Note

Process tags are also referred to "external tags" on the system.
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Usable data types
You can use the following data types for process tags:

● Binary Tag

● Signed 8-bit value

● Unsigned 8-bit value

● Signed 16-bit value

● Unsigned 16-bit value

● Signed 32-bit value

● Unsigned 32-bit value

● Floating-point number 32-bit IEEE 754

● Floating-point number 64-bit IEEE 754

● Text tag, 8-bit

● Text tag 16-bit character set

● Raw data tag

Licensing of Power Tags
For WinCC, you purchase licenses to be able to use a certain number of process tags and 
archive tags.

Power tags are licensed process tags. With a license covering 2048 power tags, for example, 
you are able to operate a WinCC project in Runtime on a computer which uses up to 2048 
process tags. The number of licensed and configured process tags will be seen in the status 
bar of WinCC Explorer.

Licenses are divided into the following types

● "RC": for configuration and Runtime of a certain number of process tags

● "RT": only for Runtime of a certain number of process tags

Note

The process tags required for the System Info channel need no licenses. Thus, the tags 
are not entered in the license count.

See also
Tag Types (Page 174)

Tag Groups (Page 170)

Structure Types and Structure Tags (Page 167)

Internal Tags (Page 166)

Editing Tags (Page 202)

How to Create a Process Tag (Page 189)
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2.3.2.3 Internal Tags

Definition
Internal tags are not connected to the process.

You use Internal tags to manage data within a project or to transfer data to an archive. 

A corresponding setting of the "Runtime persistency" property lets you set retention of the 
internal tags on closing Runtime. The value saved is used as start value for the restart of 
Runtime.

You can set the following properties for internal tags:

● Name

● Data type

● Updates project-wide/on local computers (only relevant with multi-user projects without 
additional client projects)

● Limit values

● Start value

● Runtime persistency

● Tag synchronization (Online synchronization the internal tags in the server project with the 
redundant partner)

Usable Data Types
You can use the following data types for internal tags:

● Text reference

● Binary tag

● Signed 8-bit value

● Unsigned 8-bit value

● Signed 16-bit value

● Unsigned 16-bit value

● Signed 32-bit value

● Unsigned 32-bit value

● Floating-point number 32-bit IEEE 754

● Floating-point number 64-bit IEEE 754

● Text tag, 8-bit

● Text tag, 16-bit font

● Raw Data Tag
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System tags
WinCC applications create tags required for internal administration of the project. The names 
of these tags begin with an "@" character. You cannot delete or rename these tags. You can 
evaluate, but not change, the value of the tag.

Exceptions to this rule are tags created with the "Redundancy" option. They can be set by 
means of scripts, for example:

● @RM_MASTER

● @RM_MASTER_NAME

Note

You must not create tags whose name starts with an '@'. Tags with an @ prefix are created 
only by WinCC and PCS 7.

See also
Tag Groups (Page 170)

Structure Types and Structure Tags (Page 167)

Process Tags (Page 164)

Editing Tags (Page 202)

Tag Types (Page 174)

Creating Internal Tags (Page 190)

2.3.2.4 Structure Types and Structure Tags

Definition
WinCC Structure types simplify the creation of several tags having identical properties.

Name Definition Displayed in...

Structure type A structure type denotes a scheme that is used in WinCC 
to create a certain group of tags. A structure type contains 
at least one structure element.

Component Structure 
Types

Structure 
element

A structure element is a component of a structure type. It 
is used as a template when creating a structure tag with 
the help of a structure type.

Component Structure 
Types > Structure Type > 
Structure Properties dialog
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Name Definition Displayed in...

Structure tag A structure tag is a tag that was created with the help of 
a structure type. The template of a structure tag is a 
structure element.
The name of a structure tag consists of the name of the 
structure instance and the name of the structure element 
being used. Both parts of the name are separated by a dot.

Component Tag 
Management > Internal 
Tags or a connection, 
under which the structure 
tags were created with the 
help of structure type.

Structure 
instance

If the tags defined in a structure type are created with the 
help of the structure type, a structure instance occurs. The 
structure instances created with the same structure type 
are displayed under this structure type in the data window.
The name of a structure instance is also referred to as the 
tag prefix.

Component Structure 
Types > Structure Type

Principle
You define a certain tag structure when you create a structure type.

You create a structure type in WinCC Explorer. You create a structure element for each tag. 
You assign the properties to a structure element which the tag created by that should possess.

When creating a tag, assign a created structure type as data type. The structure types are 
displayed in the Data Type selection window according to standard data types. WinCC creates 
a structure instance under the associated structure type and the structure tags in Tag 
Management. The created structure tags are defined by the structure elements of this type.

In the same structure type, you can define structure elements for internal tags and process 
tags. When a structure instance is created under the connection of a communication driver, 
the process tags defined in the structure type are created under the connection. The internal 
tags, however, are created in Tag Management at Internal tags.

Modifying Structure Types
If you have created a structure instance with a structure type, you can no longer modify the 
properties of this structure type. You must first delete the structure instance. In doing so, you 
also delete all associated structure tags. After that you can change the properties of the 
structure type and the structure elements and regenerate a structure instance.

You can modify the properties of structure instances and structure tags later. If you rename 
the structure instance, then rename the associated tags at the same time.

Usage
If a certain tag configuration occurs several times in your system, use structure types. In this 
instance, for example, several temperature controllers can be involved that are always set up 
according to the same principle.

Consider which tags you require for the temperature controller.

Then create a TEMPERATURE structure type in which each tag is represented by a structure 
element, for example ELEMENT_1, ELEMENT_2, ELEMENT_3. Each time you create a new 
structure instance with this structure type, WinCC automatically generates all structure tags 
for the corresponding temperature regulator.
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You use the created structure tags when, for example, you configure pictures which you would 
like to integrate by means of picture windows.

Structure types in picture windows
You configure a picture, TEMP_REGLER.PDL, for the temperature regulator. You do not 
connect the objects in the picture with tags but with structure elements.

To do this, you have to enter the name manually, since you cannot directly enter elements by 
means of a dialog. Alternatively, you can connect structure tags you have created and delete 
the first part of the name, which is determined by the structure instance. You link e.g. the 
structure tags of the structure REGLER_A. In the tag name displayed, e.g. 
REGLER_A.ELEMENT_1, delete the REGLER_A and the linking point in the input field.

Configure a picture window and integrate the picture TEMP_REGLER.PDL. Open the object 
properties of the picture window. Accept one of the created structure instances with a dot 
behind the name, such as CONTROLLER_A., as the tag prefix.

Configure a second picture window with the picture TEMP_REGLER.PDL and the next 
structure instance, e.g. REGLER_B, as tag prefix, e.g. REGLER_B..

In Runtime, WinCC composes the names of the required structure tags from the following 
elements:

● Tag prefixes of the picture window

● Names of the structure elements linked in the pictureTEMP_REGLER.PDL

Then the first picture window displays the state of regulator A and the second picture window 
the state of regulator B.

Naming Conventions
When naming, you must respect certain conventions:

● Tag names must be unique throughout the project. When tags are created, WinCC does 
not distinguish between upper and lower case characters in a name.

● Tag names must not be longer than 128 characters. In the case of structure tags, this limit 
applies to the whole expression structure tag name + dot + structure tag element name. 

● There are certain characters which you cannot use in the names of structure types, structure 
elements and structure tags. You will find the characters you must not include in a name 
in the WinCC Information System at Working with projects > Non-authorized characters

Note

You must not create tags whose name starts with an '@'. Tags with an @ prefix are created 
only by WinCC and PCS 7.

Remember that WinCC distinguishes between upper and lower case characters in a 
configuration. If you change upper and lower case characters in a tag name, you must adapt 
your configuration accordingly.
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See also
Tag Groups (Page 170)

Internal Tags (Page 166)

Process Tags (Page 164)

Editing Tags (Page 202)

Creating Structure Types (Page 192)

2.3.2.5 Tag Groups

Definition
You can sort your tags into tag groups in Tag Management.

Create a tag group as directory under "Internal Tags" or under the connection to a channel 
unit. Subgroups are not possible.

Usage
When creating a large number of tags in your project, you can combine them in groups 
according to subject.

You can create, for example, a tag group for every picture in your project. You create the tags 
you use in one of your pictures in the appropriate group.

In this way WinCC makes it easier for you to assign and retrieve tags.

Naming Conventions
The names of tag groups must be unique in the whole project. You must not use the same 
name simultaneously for tags and tag groups. When tags and tag groups are created, WinCC 
does not distinguish between upper and lower case characters in a name.

You must not use certain characters in the names of tag groups. You will find a list of characters 
that are not permitted in a name in the WinCC Information System under "Working with 
Projects" > "Disallowed Characters".

Note

Remember that WinCC distinguishes between upper and lower case characters in a 
configuration. If you change upper and lower case characters in a tag name, you must adapt 
your configuration accordingly.
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See also
How to Create a Tag Group (Page 197)

Structure Types and Structure Tags (Page 167)

Internal Tags (Page 166)

Process Tags (Page 164)

Editing Tags (Page 202)

2.3.3 Tag Selection Dialog

Working with the tag selection dialog
WinCC opens the tag selection dialog as soon as you want to attach a tag in an editor.

In Graphics Designer you can view the tag selection dialog continuously. Call the option View 
> Toolbars... on the menu bar. Select the check box next to the Tags entry.

In the Global Script editor, open the tag selection dialog by choosing Edit > Tag Browser.

In the tag selection dialog, you can view either all tags in the project or navigate in the directory 
structure. You select a highlighted tag by clicking OK.

Drag and drop
You can also connect a tag to an object or object attribute by means of drag and drop. There 
are two locations where you can drop the tag:
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● Above an object in the picture

● Above an attribute in the Object Properties dialog, Properties tab

Store the tag above an attribute in the Object Properties dialog, Properties tab. This ensures 
that this attribute is dynamized by the tag.

The attribute to be dynamized is specified in the case of objects which have a simplified 
configuration dialog. The table shows the objects and the dynamized attribute:

Object Attribute

I/O Field Output value
Bar Process driver connection
Status display Current status
Text list Output value
Check box Selected fields
Option button Selected fields
Slider object Process driver connection

Filter
Using the filter function, you can reduce the selected number of tags or symbols so as to search 
more efficiently.

When searching, you can use the placeholders * and ?. You can only use alphanumeric 
characters when searching for names. WinCC saves the last 20 search criteria you entered.

Example
The following internal tags have been created in WinCC, for example: var1; var2; var3; smv2 
and apm1. As a search criterion, enter a* and exit the filter function with the <TAB> key. WinCC 
then shows all the tags whose name starts with a. In this case, the tag 'apm1' in the 'List of all 
Tags' folder.

Note

The search operation in the tag selection dialog can take some time when there is a large 
number of tags. Searching lasts about one minute with 15,000 tags.

It is sensible to arrive at a preselection in the tag selection dialog by means of the filter.

Data Source
This function is available when you are working with WinCC integrated in STEP 7.

In this box you can select the data source from which you would like to attach a tag.
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'WinCC Tags' as data source
WinCC display all configured internal tags and process tags. You can create new tags by 
means of the Create a New Tag function. You can edit existing WinCC tags with the Edit Tag 
function.

Note

In certain situations the tag selection dialog sets a filter to the data type of the tag.

'ES Tags' as data source
WinCC displays all PCS 7 process tags. PCS7 process tags are all operable and visible CFC 
and SFC modules which were configured in the PCS 7 Engineering System. CFC stands for 
Continuous Function Chart. SFC stands for Sequential Function Chart. You can update the 
attributes of the display tag by operating the Update ES Tags button. This is necessary only 
when an attribute is modified in the PCS 7 Engineering System while the tag selection dialog 
is open. Attributes are items such as name, type or comment relating to a process tag.

Further information on this is available in the Chapter Integration in the SIMATIC Manager and 
in the Process Control System PCS7 Operator Station configuration manual.

Update ES Tags button

The  button is available to you after selecting the ES tags data source.

You can use this button to update the CFC/SFC connections. CFC/SFC stands for Continuous 
Function Chart/Sequential Function Chart. When you extend STEP 7 connections, you can 
update the corresponding engineering station with this function.

'STEP7 Symbols' as data source
WinCC displays all the inputs, outputs, and bit memories in the STEP 7 symbol list and all the 
global data blocks. The symbol lists and the data blocks are created in SIMATIC Manager. In 
this case, data blocks themselves cannot be mapped. Only the parameters of the prevailing 
data block displayed in the data window can be mapped.

Transfer Data button

The  button is available to you after selecting the STEP 7 Symbols data source.

The Transfer Data function is used by WinCC to apply the selected symbols or parameters of 
data blocks to the WinCC database.

See also
Creating Tags (Page 188)

Tag management (Page 159)
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2.3.4 Communication Driver

Establishing Communication
A communication driver is used for communication by WinCC with the connected automation 
system. You will find the communication drivers supported by WinCC in the WinCC Information 
System at Communication.

The documentation on the different channels contains detailed information about creating 
channel units and connections.

Licensing of Communication Drivers
If you wish to use a communication driver, you must install the corresponding license on the 
computer.

Deleting Communication Driver
When you delete a communication driver, WinCC automatically deletes all tags created for 
this communication driver. Should you still require tags, move these tags to a different 
communication driver. To do this, use the commands Cut and Paste. After moving them, check 
the addresses of the moved tags.

Note

If a communication driver was created in WinCC using SIMATIC Manager with Compile OS, 
you cannot delete the communication driver in WinCC Explorer.

See also
How to Create a Process Tag (Page 189)

2.4 Tag Types

2.4.1 Tag Types

Introduction
When you create a tag, you assign one of the possible data types to the tag.

This data type depends on the type of data for which you would like to use the tag.
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Note

If you modify the data type of an existing process tag, the previously defined tag address is 
deleted. This reason for this is that the PLC address changes when the data type is modified.

Adapting Format
The data type of a tag in WinCC can differ from the data type used in the automation system. 
You can then set that WinCC converts the data type of a tag for transfer to the automation 
system.

Tag types with type conversion Tag types without type conversion

Signed 8-bit value Text reference
Unsigned 8-bit value Binary Tags
Signed 16-bit value Text tag, 8-bit character set
Unsigned 16-bit value Text tag, 16-bit character set
Signed 32-bit value Raw data type
Unsigned 32-bit value Structure types
Floating-point number 32-bit IEEE 754  
Floating-point number 64-bit IEEE 754  

You will find detailed information about type conversion in the WinCC Information System at 
Communication > Process Communication > WinCC Process Communication > External Tags.

See also
Signed 8-bit value (Page 177)

Tags (Page 163)

Raw Data Tag (Page 187)

Text Tag 8-Bit Character Set and Text Tag 16-Bit Character Set (Page 187)

Floating-Point Number 64-Bit IEEE 754 (Page 185)

Floating-point number 32-bit IEEE 754 (Page 184)

Unsigned 32-bit value (Page 183)

Signed 32-bit value (Page 181)

Unsigned 16-bit value (Page 180)

Signed 16-bit value (Page 179)

Unsigned 8-bit value (Page 178)

Binary Tags (Page 176)

Text Reference (Page 176)
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2.4.2 Text Reference

Definition
With tags having the Text reference data type, you refer to an entry in the WinCC Text Library. 
You can only configure text references as internal tags.

You use text references, for example, when you want to display different blocks of text 
alternately. You assign the corresponding text ID of the entry in the Text Library to the tag.

Creating a Text Reference
You create a tag with the Text reference data type as an internal tag.

In the Tag Properties dialog, select the Start Value check box on the Limits/Reporting tab. 
Enter the text ID from the Text Library as the start value.

Note

In a multi-user system, WinCC uses for text output the language of the computer on which 
the text reference was created.

Adapting Format
Type conversion does not take place for the Text Reference data type.

 

See also
Tag Types (Page 174)

2.4.3 Binary Tags

Definition
The "Binary tag" data type corresponds to a bit. A binary tag can assume the values TRUE or 
"0" and FALSE or "1".

The binary tag is stored as a byte on the system.

Note

Some communication drivers cannot transfer single bits. The use of binary tags can result in 
degraded performance with these communication drivers. Take note of the help for the 
different communication drivers in the WinCC Information System at Communication.
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Bit
The "Binary Tag" data type is also referred to as "Bit".

Adapting format
For "Binary Tag" data type, the format cannot be adapted.

See also
Tag Types (Page 174)

2.4.4 Signed 8-bit value

Definition
The "Signed 8-bit value" data type is one byte long and is signed (plus or minus).

Char/Signed Byte
The "Signed 8-bit value" data type is also referred to as "Char" or "Signed byte".

Adapting Format
If you create a new tag with the "Signed 8-bit value" data type, the "Type Conversion" box will 
display the CharToSignedByte by default. The range of numbers is -128 to +127.

The following type conversions are possible for the "Signed 8-bit value" data type:

Adapting format Number range

CharToSignedByte -128...+127          
(no conversion)

CharToUnsignedByte 0...127
CharToUnsignedWord 0...127
CharToUnsignedDword 0...127
CharToSignedWord -128...+127
CharToSignedDword -128...+127
CharToMSBByte -128...+127
CharToMSBWord -128...+127
CharToMSBDword -128...+127
CharToBCDByte 0...99
CharToBCDWord 0...127
CharToBCDDword 0...127
CharToSignedBCDByte -9...+9
CharToSignedBCDWord -128...+127
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Adapting format Number range

CharToSignedBCDDword -128...+127
CharToExtSignedBCDByte -79...+79
CharToExtSignedBCDWord -128...+127
CharToExtSignedBCDDword -128...+127
CharToAikenByte 0...99
CharToAikenWord 0...127
CharToAikenDword 0...127
CharToSignedAikenByte -9...+9
CharToSignedAikenWord -128...+127
CharToSignedAikenDword -128...+127
CharToExcessByte 0...99
CharToExcessWord 0...127
CharToExcessDword 0...127
CharToSignedExcessByte -9...+9
CharToSignedExcessWord -128...+127
CharToSignedExcessDword -128...+127

See also
Tag Types (Page 174)

2.4.5 Unsigned 8-bit value

Definition
The "Unsigned 8-bit value" data type is one byte long and is not signed.

Byte/Unsigned Byte
The "Unsigned 8-bit value" data type is also referred to as "byte" or "unsigned byte".

Adapting Format
If you create a new tag with the "Unsigned 8-bit value" data type, the Type Conversion box 
will display the ByteToUnsignedByte by default. The range of numbers is 0 to 255.

The following type conversions are possible for the "Unsigned 8-bit value" data type:

Adapting format Number range

ByteToUnsignedByte 0...255          
(no conversion)

ByteToUnsignedWord 0...255
ByteToUnsignedDword 0...255
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Adapting format Number range

ByteToSignedByte 0...127
ByteToSignedWord 0...255
ByteToSignedDword 0...255
ByteToBCDByte 0...99
ByteToBCDWord 0...255
ByteToBCDDword 0...255
ByteToAikenByte 0...99
ByteToAikenWord 0...255
ByteToAikenDword 0...255
ByteToExcessByte 0...99
ByteToExcessWord 0...255
ByteToExcessDword 0...255

See also
Tag Types (Page 174)

2.4.6 Signed 16-bit value

Definition
The "Signed 16-bit value" data type is two bytes long and is signed (plus or minus).

Short/Signed Word
The "Signed 16-bit value" data type is also referred to as "short" or "signed word".

Adapting Format
If you create a new tag with the "Signed 16-bit value" data type, the Type Conversion box will 
display the ShortToSignedWord by default. The range of numbers is -32768 to +32767.

The following type conversions are possible for the "Signed 16-bit value" data type:

Adapting format Number range

ShortToSignedWord -32768...+32767          
(no conversion)

ShortToUnsignedByte 0...255
ShortToUnsignedWord 0...32767
ShortToUnsignedDword 0...32767
ShortToSignedByte -128...+127
ShortToSignedDword -32768...+32767
ShortToMSBByte -127...+127
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Adapting format Number range

ShortToMSBWord -32767...+32767
ShortToMSBDword -32768...+32767
ShortToBCDByte 0...99
ShortToBCDWord 0...9999
ShortToBCDDword 0...32767
ShortToSignedBCDByte -9...+9
ShortToSignedBCDWord -999...+999
ShortToSignedBCDDword -32768...+32767
ShortToExtSignedBCDByte -79...+79
ShortToExtSignedBCDWord -7999...+7999
ShortToExtSignedBCDDword -32768...+32767
ShortToAikenByte 0...99
ShortToAikenWord 0...9999
ShortToAikenDword 0...32767
ShortToSignedAikenByte -9...+9
ShortToSignedAikenWord -999...+999
ShortToSignedAikenDword -32768...+32767
ShortToExcessByte 0...99
ShortToExcessWord 0...9999
ShortToExcessDword 0...32767
ShortToSignedExcessByte -9...+9
ShortToSignedExcessWord -999...+999
ShortToSignedExcessDword -32768...+32767

See also
Tag Types (Page 174)

2.4.7 Unsigned 16-bit value

Definition
The "Unsigned 16-bit value" data type is two bytes long and is not signed.

Word/Unsigned Word
The "Unsigned 16-bit value" data type is also referred to as "word" or "unsigned word".

Adapting Format
If you create a new tag with the "Unsigned 16-bit value" data type, the Type Conversion box 
will display the WordToUnsignedWord by default. The range of numbers is 0 to 65535.
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The following type conversions are possible for the "Unsigned 16-bit value" data type:

Adapting format Number range

WordToUnsignedWord 0...65535          
(no conversion)

WordToUnsignedByte 0...255
WordToUnsignedDword 0...65535
WordToSignedByte 0...127
WordToSignedWord 0...32767
WordToSignedDword 0...65535
WordToBCDByte 0...99
WordToBCDWord 0...9999
WordToBCDDword 0...65535
WordToAikenByte 0...99
WordToAikenWord 0...9999
WordToAikenDword 0...65535
WordToExcessByte 0...99
WordToExcessWord 0...9999
WordToExcessDword 0...65535
WordToSimaticCounter 0...999
WordToSimaticBCDCounter 0...999

See also
Tag Types (Page 174)

2.4.8 Signed 32-bit value

Definition
The "Signed 32-bit value" data type is four bytes long and is signed (plus or minus).

Long / Signed Dword
The "Signed 32-bit value" data type is also referred to as "long" or "signed dword".

Adapting Format
If you create a new tag with the "Signed 32-bit value" data type, the Type Conversion box will 
display the LongToSignedDword by default. The range of numbers is -2147483647 to 
+2147483647.

The following type conversions are possible for the "Signed 32-bit value" data type:
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Adapting format Number range

LongToSignedDword -2147483647...+2147483647          
(no conversion)

LongToUnsignedByte 0...255
LongToUnsignedWord 0...65535
LongToUnsignedDword 0...2147483647
LongToSignedByte -128...+127
LongToSignedWord -32768...+32767
LongToMSBByte -127...+127
LongToMSBWord -32767...+32767
LongToMSBDword -2147483647...+2147483647
LongToBCDByte 0...99
LongToBCDWord 0...9999
LongToBCDDword 0...99999999
LongToSignedBCDByte -9...+9
LongToSignedBCDWord -999...+999
LongToSignedBCDDword -9999999...+9999999
LongToExtSignedBCDByte -79..+79
LongToExtSignedBCDWord -7999...+7999
LongToExtSignedBCDDword -79999999...+79999999
LongToAikenByte 0...99
LongToAikenWord 0...9999
LongToAikenDword 0...99999999
LongToSignedAikenByte -9...+9
LongToSignedAikenWord -999...+999
LongToSignedAikenDword -9999999...+9999999
LongToExcessByte 0...99
LongToExcessWord 0...9999
LongToExcessDword 0...99999999
LongToSignedExcessByte -9...+9
LongToSignedExcessWord -999...+999
LongToSignedExcessDword -9999999...+9999999
LongToSimaticTimer 10...9990000
LongToSimaticBCDTimer 10...9990000

 

See also
Tag Types (Page 174)
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2.4.9 Unsigned 32-bit value

Definition
The "Unsigned 32-bit value" data type is four bytes long and is not signed.

Dword / Unsigned Dword
The "Unsigned 32-bit value" data type is also referred to as "dword" or "unsigned dword".

Adapting Format
If you create a new tag with the "Unsigned 32-bit value" data type, the Type Conversion box 
will display the DwordToUnsignedDword by default. The range of numbers is 0 to 4294967295.

The following type conversions are possible for the "Unsigned 32-bit value" data type:

Adapting format Number range

DwordToUnsignedDword 0...4294967295          
(no conversion)

DwordToUnsignedByte 0...255
DwordToUnsignedWord 0...65535
DwordToSignedByte 0...127
DwordToSignedWord 0...32767
DwordToSignedDword 0...2147483647
DwordToBCDByte 0...99
DwordToBCDWord 0...9999
DwordToBCDDword 0...99999999
DwordToAikenByte 0...99
DwordToAikenWord 0...9999
DwordToAikenDword 0...99999999
DwordToExcessByte 0...99
DwordToExcessWord 0...9999
DwordToExcessDword 0...99999999
DwordToSimaticTimer 10...9990000
DwordToSimaticBCDTimer 10...9990000

See also
Tag Types (Page 174)
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2.4.10 Floating-point number 32-bit IEEE 754

Definition
The "floating-point number 32-bit IEEE 754" data type is four bytes long and is signed (plus or 
minus).

Float
The "floating-point number 32-bit IEEE 754" data tape is also referred to as "float".

Adapting format
If you create a new tag with the "Floating-point number 32-bit IEEE 754" data type, the Type 
Conversion box will display the FloatToFloat by default. The number range is +-3.402823e+38.

Note

For every FloatTo...Dword type conversion, only the first seven places are considered. The 
float data type only allows seven digits. If you have an S7 connection, the range of numbers 
for the FloatToFloat type conversion is +-3.402823e+38.

The following type conversions are possible for the "floating-point number 32-bit IEEE 754" 
data type:

Adapting format Number range

FloatToFloat +-3.402823e+38         
(no conversion)

FloatToUnsignedByte 0...255
FloatToUnsignedWord 0...65535
FloatToUnsignedDword 0 to 4.294967e+09
FloatToSignedByte -128...+127
FloatToSignedWord -32768...+32767
FloatToSignedDword -2.147483e+09 to +2.147483e+09
FloatToDouble +-3.402823e+38
FloatToMSBByte -127...+127
FloatToMSBWord -32767...+32767
FloatToMSBDword -2.147483e+09 to +2.147483e+09
FloatToBCDByte 0...99
FloatToBCDWord 0...9999
FloatToBCDDword 0 to 9.999999e+07
FloatToSignedBCDByte -9...+9
FloatToSignedBCDWord -999...+999
FloatToSignedBCDDword -9999999...+9999999
FloatToExtSignedBCDByte -79...+79
FloatToExtSignedBCDWord -7999...+7999

Working with Tags
2.4 Tag Types

MDM - WinCC: Working with WinCC
184 System Manual, 11/2008,  



Adapting format Number range

FloatToExtSignedBCDDword -7.999999e+07 to +7.999999e+07
FloatToAikenByte 0...99
FloatToAikenWord 0...9999
FloatToAikenDword 0 to 9.999999e+07
FloatToSignedAikenByte -9...+9
FloatToSignedAikenWord -999...+999
FloatToSignedAikenDword -9999999...+9999999
FloatToExcessByte 0...99
FloatToExcessWord 0...9999
FloatToExcessDword 0 to 9.999999e+07
FloatToSignedExcessByte -9...+9
FloatToSignedExcessWord -999...+999
FloatToSignedExcessDword -9999999...+9999999
FloatToS5Timer 10...9990000
FloatToS5Float +-1.701411e+38
FloatToSimaticTimer 10...9990000
FloatToSimaticBCDTimer 10...9990000

See also
Tag Types (Page 174)

2.4.11 Floating-Point Number 64-Bit IEEE 754

Definition
The "Floating-point number 64-bit IEEE 754" data type is eight bytes long and is signed (plus 
or minus).

Double
The "Floating-point number 64-bit IEEE 754" data type is also referred to as "Double".

Type conversion
If you create a new tag with the "Floating-point number 64-bit IEEE 754" data type, the "Type 
Conversion" box will display the "DoubleToDouble" by default. The number range is 
+-1.79769313486231e+308.
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Note

For every "DoubleToFloat" type conversion, only the first seven places are considered. The 
float data type only allows seven digits.

The following type conversions are possible for the "Floating-point number 64-bit IEEE 754" 
data type:

Type conversion Number range

DoubleToDouble +-1.79769313486231e+308          
(no conversion)

DoubleToUnsignedByte 0...255
DoubleToUnsignedWord 0...65535
DoubleToUnsignedDword 0...4294967295
DoubleToSignedByte -128...+127
DoubleToSignedWord -32768...+32767
DoubleToSignedDword -2147483647...+2147483647
DoubleToFloat +-3.402823e+38
DoubleToMSBByte -127...+127
DoubleToMSBWord -32767...+32767
DoubleToMSBDword -2147483647...+2147483647
DoubleToBCDByte 0...99
DoubleToBCDWord 0...9999
DoubleToBCDDword 0...99999999
DoubleToSignedBCDByte -9...+9
DoubleToSignedBCDWord -999...+999
DoubleToSignedBCDDword -9999999...+9999999
DoubleToExtSignedBCDByte -79...+79
DoubleToExtSignedBCDWord -7999...+7999
DoubleToExtSignedBCDDword -79999999...+79999999
DoubleToAikenByte 0...99
DoubleToAikenWord 0...9999
DoubleToAikenDword 0...99999999
DoubleToSignedAikenByte -9...+9
DoubleToSignedAikenWord -999...+999
DoubleToSignedAikenDword -9999999...+9999999
DoubleToExcessByte 0...99
DoubleToExcessWord 0...9999
DoubleToExcessDword 0...99999999
DoubleToSignedExcessByte -9...+9
DoubleToSignedExcessWord -999...+999
DoubleToSignedExcessDword -9999999...+9999999
DoubleToS5Timer 10...9990000
DoubleToS5Float +-1.701411e+38
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Type conversion Number range

DoubleToSimaticTimer 10...9990000
DoubleToSimaticBCDTimer 10...9990000

See also
Tag Types (Page 174)

2.4.12 Text Tag 8-Bit Character Set and Text Tag 16-Bit Character Set

Definition
Text tags are distinguished by the character set that has to be displayed: 

● With the "text tag 8-bit character set" data type, each of the characters that has to be 
displayed in this tag is one byte long. With the 8-bit character set, the ASCII character set 
can be displayed for example. 

● With the "text tag 16-bit character set" data type, each of the characters that has to be 
displayed in this tag is two bytes long. You require a tag of this type to display the Unicode 
character set, for example.

Process Tag with the Text Tag Data Type
For process tags with the Text tag 8-bit character set and Text tag 16-bit character set data 
types, you must specify the length of the text tags. A text tag that is required to accommodate 
10 characters later must be ten long for the "8-bit character set" and 20 long for the "16-bit 
character set".

Adapting Format
There is no type conversion for the "text tag 8-bit character set" and "text tag 16-bit character 
set" data types.

See also
Tag Types (Page 174)

2.4.13 Raw Data Tag

Definition
External and internal Raw Data Type tags can be created in WinCC's Tag Management. The 
format and the length of a raw data tag are not fixed. Its length can be in the range from 1 and 
65535 bytes. It is either defined by the user or results from a specific application.
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The contents of a raw data tag are not fixed. Only senders and receivers can interpret the 
contents of a raw data tag. They are not interpreted by WinCC.

Note

A raw data tag cannot be displayed within Graphics Designer.

Potential Applications within WinCC
Raw data tags can be used in the following modules within WinCC:

● Alarm Logging: For data exchange with the message blocks on the automation system with 
message and acknowledgement processing of the message system.

● Global Scripts: In scripts for data exchange using the Get/SetTagRaw functions.

● Tag Logging: For process controlled archiving with process controlled tags in the process 
value archive.

● User Archives: For transferring jobs, data, processing acknowledgements between WinCC 
and the automation systems.

Address Properties
In the case of external Raw Data tags the Address Properties dialog is not identical for all 
communication drivers, since the parameters of the tag address and the supported raw data 
tag types depend on the communication driver being used.

Adapting Format
Type conversion is not possible in WinCC for the raw data type.

See also
Tag Types (Page 174)

2.5 Creating Tags

2.5.1 Creating Tags

Introduction
This chapter describes how you create tags and structures:

● Process tags

● Internal tags
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● Structure types

● Tag groups

You will find detailed instructions for type conversion in the WinCC Information System at 
Communication > Process Communication > WinCC Process Communication > External Tags.

See also
How to Define Linear Scaling (Page 200)

How to Define a Substitute Value (Page 199)

How to Set Limit Values (Page 198)

How to Create a Tag Group (Page 197)

Creating Structure Types (Page 192)

Creating Internal Tags (Page 190)

How to Create a Process Tag (Page 189)

2.5.2 How to Create a Process Tag

Introduction
You use process tags for communication between WinCC and the automation system.

You can create process tags in tag groups, too, or move them to tag groups once they have 
been created.

Note

Before creating a process tag, you must install a communication driver and create at least a 
connection.

Procedure
1. In Tag Management of WinCC Explorer, open the communication driver for which you would 

like to create a process tag.

2. Select the channel unit you require and the corresponding connection.

3. Choose the "New Tag" option from the shortcut menu for the connection. The "Tag 
Properties" dialog is opened.

4. At "Name" on the General tab, enter a name for the tag. In doing so, pay due consideration 
to the name conventions in the chapter "Tag Management and Tags" > "Tags".

5. Set the "raw data type" data type in the "Data type" field.

6. If necessary, modify the set type conversion and set Linear Scaling if required.
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7. Set the address of the tag. To do this, click the "Select" button. The "Address Properties" 
dialog box opens. After entering the address, close the dialog box by clicking "OK".          
The address properties depend on the channel unit you selected. You will find more 
information on addressing a process tag in the WinCC Information System under 
"Communication" in the respective communication driver.

8. On the Limits/Reporting tab, set limit values, the start value and substitute value as 
necessary.         
A start value is set when no process value is available as the project is activated.

9. Click "OK" to close the dialog box.

Note

If a starting value has been configured, the starting value is returned at the first reading of 
the used process tags, even if a process value already exists. This accelerates the opening 
of the picture when Runtime is started and the picture is changed. To bypass this process, 
you need to run a direct read call using the corresponding functions in VBS and C.

If you want to set both a start value and a substitute value, check the settings in the "Use 
substitute value" segment. 

Addressing Process Tags
You can also address a process tag later.

Select the tag in the tag management and open "Addressing..." on the pop-up menu. The 
Address Properties menu opens. Set the address of the tag.

You will find more information on addressing a process tag in the WinCC Information System 
under "Communication" in the respective communication driver.

See also
How to Create a Tag Group (Page 197)

How to Define Linear Scaling (Page 200)

How to Define a Substitute Value (Page 199)

How to Set Limit Values (Page 198)

Tags (Page 163)

2.5.3 Creating Internal Tags

Introduction
You use internal tags to transfer data within your project.
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You can create internal tags in tag groups, too, or move them to tag groups once they have 
been created.

Note
Updates on clients without local project

Usually, the "Project-wide update" or "Computer-local update" settings do not have any effect. 
Internal tags which you create on a server are always updated for the whole project. Internal 
tags which you create on a WinCC Client are always updated for the local computer.

The setting is only relevant if you configure a client without a local project. 

Procedure
1. Open the "Internal" Tags directory in the Tag Management of WinCC Explorer.

2. Select the "New Tag" entry in the shortcut menu of the connection. The "Tag Properties" 
dialog opens.

3. Enter the tag name in the "Name" field of the General tab. Observe the naming conventions 
defined in the "Tag Management and Tags" > "Tags" chapter.

4. Set the data type.

5. On the Limits/Reporting tab, set limit values, limit values and the start value as necessary.

6. Activate the "Runtime persistency" option to retain the value of the internal tag on closing 
Runtime.
The value saved is used as start value for the restart of Runtime. The start value configured 
is only used at the first start of Runtime and after the data type was changed.

7. Click "OK" to close the dialog.

See also
How to Define Linear Scaling (Page 200)

How to Define a Substitute Value (Page 199)

How to Set Limit Values (Page 198)

How to Create a Tag Group (Page 197)

Tags (Page 163)
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2.5.4 Creating Structure Types

2.5.4.1 Creating Structure Types

Introduction
This chapter describes how to

● Create a structure type and the associated elements

● Use the structure types when creating tags

See also
Creating Internal Tags (Page 190)

How to Create a Process Tag (Page 189)

Copying, Moving and Deleting Tags (Page 202)

How to Rename Tags (Page 204)

Structure Types and Structure Tags (Page 167)

How to Use Structure Types (Page 195)

How to Create a Structure Tag (Page 192)

2.5.4.2 How to Create a Structure Tag

Introduction
You create structure types external to Tag Management at "Structure types".

When creating a structure type, create the different structure elements. You can assign the 
created structure type as data type when creating tags and thereby create all tags defined in 
the structure type.
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Procedure
1. Click in WinCC Explorer on "Structure types" and select the option "New Structure Type..." 

from the shortcut menu. The "Structure Properties" dialog box opens.

2. Change the standard name "NewStructure" and assign the structure name with a useful 
name. To do this mark the element and select "Rename" on the pop-up menu. Pay due 
consideration to the name conventions when doing so.

3. Click the "New Element" button. WinCC creates a new element with the tag type "Short" 
and the name "New Tag". Select the element and choose the "Rename" option from the 
shortcut menu. Enter a useful name instead of "New Tag". Pay due consideration to the 
name conventions when doing so.

4. Set whether the element creates an internal tag or a process tag. The process tag is termed 
an "external tag" in the dialog box. Choose the required data type on the shortcut menu of 
the structure element.

5. Check the offset value at Process tags in the "AS" segment. This value specifies the spacing 
of the structure element from the start address in bytes. The offset value of a new or copied 
element is incremented automatically. Adjust the settings as necessary.

6. For process tags, set Linear scaling as necessary.
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7. For process tags of data type "Text8" and "Text16", set the number of bytes in the "Length" 
field.

8. Change the given type conversion for process tags as necessary.          
You can select a channel unit from the "Use additional Format Adaptations from" selection 
box. WinCC then also features the type conversions that are supported by that channel 
unit.

9. Create the next element. Click the "New Element" button.          
If at least one structure is available, WinCC then copies the currently operated element with 
its properties when creating a new element using the New Element button. WinCC adds a 
number to the element name or rather increments it.         
Repeat the process till you have inserted all the required elements.

10.Click OK to close the dialog.

Note

Perform all settings before applying the structure type for creating tags. You can then only 
modify the properties of the created structure elements such as Scaling, Address and Limits/
Reporting.

To modify the properties of a structure type, you must first delete all associated structure tags.

Data Types
The data type for the tag automatically precedes the name of a structure element in WinCC. 
This data type corresponds to a certain tag type, e.g. the BYTE data type, the tag type Unsigned 
8 Bit Value.

If you want to address a structure tag with a script, then you have to use the C function for this 
data type.

The following designations are used:

Tag type Data type Associated C function

Binary tag BIT GetTagBit
Signed 8-bit value CHAR GetTagSByte
Unsigned 8-bit value BYTE GetTagByte
Signed 16-bit value SHORT GetTagSWord
Unsigned 16-bit value WORD GetTagWord
Signed 32-bit value LONG GetTagSDWord
Unsigned 32-bit value DWORD GetTagDWord
Floating-point number 32-bit IEEE 754 FLOAT GetTagFloat
Floating-point number 64-bit IEEE 754 DOUBLE GetTagDouble
Text tag, 8-bit font TEXT8 GetTagChar
Text tag, 16-bit font TEXT16 GetTagChar
Text reference (internal tags only) TEXTREF GetTagChar
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Further information can be found in the chapter "Tag Types" and in the description of the 
internal functions for ANSI-C.

Note

BIT tags are always one word long in their structure. Therefore, bit positions 0 to 15 are the 
only positions possible. This length of two bytes has to be taken into account for the offset 
value of the following element.

See also
How to Create a Process Tag (Page 189)

Tag Types (Page 174)

Creating Internal Tags (Page 190)

Copying, Moving and Deleting Tags (Page 202)

How to Rename Tags (Page 204)

Structure Types and Structure Tags (Page 167)

How to Use Structure Types (Page 195)

2.5.4.3 How to Use Structure Types

Introduction
Using structure types, you create several tags simultaneously as structure types in just one 
action. You can create internal tags and process tags in doing so.

When configuring in the editors, structure tags do not differ from other tags.

Creating Internal Tags
When creating an internal tag, the structure types available to you are those that do not contain 
structure elements for process tags.

Structure types, in which structure elements are defined for process tags, can only be used 
when you create tags under the connection of a channel unit.

Note

You can create structure tags with a structure type, in which only structure elements for 
internal tags are defined, under the connection of a channel unit. The structure instance is 
displayed under the structure types, while the associated structure tags are displayed under 
internal tags. No entry appears under the connection in the data window. If you try to delete 
a connection, a message appears however that there are still elements which will also be 
deleted. If this message is confirmed, not only the connection but also the structure instance 
and the structure tags will be deleted.
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Procedure
1. In the tag management select the position at which you want to create the tag.

2. Choose the New Tag option from the shortcut menu. The Tag Properties dialog opens.

3. Choose the required structure type in the Data type selection box.

4. Enter a name. This name is used as a tag prefix when creating the tag. WinCC creates a 
structure instance under this name. The structure instance is located in WinCC Explorer at 
Structure Types under the structure type being used.

5. Confirm with OK.

6. For every element created in the structure type, WinCC generates structure tag with the 
appropriate properties. The name of the structure tag is composed of the name of the 
structure instance and the name of the structure element, separated by a dot.

Note

Perform all settings before applying the structure type for creating tags. You can then modify 
the properties of the created structure tags later.

To modify the properties of a structure type, you must first delete all associated structure tags.

Update
If you create internal structure tags in a multi-user project, then you can use the Project-wide 
update or Computer-local update setting. This setting is only then relevant if you do not create 
an individual client project on the WinCC clients.

Define the required update with the created structure tags. The setting in the structure instance 
is not transferred when creating the associated structure tag.

 

See also
Creating Internal Tags (Page 190)

How to Create a Process Tag (Page 189)

Copying, Moving and Deleting Tags (Page 202)

How to Rename Tags (Page 204)

Structure Types and Structure Tags (Page 167)

How to Create a Structure Tag (Page 192)
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2.5.5 How to Create a Tag Group

Introduction
You create tag groups in Tag Management. You create tag groups for internal tags directly in 
the Internal Tags directory. You create tag groups for process tags in the communication driver 
directory under the connection.

You can only create tags in a tag group. A tag group cannot contain another tag group.

Procedure
1. Navigate in Tag Management to the position at which you wish to create the tag group. 

2. Choose the New Group option from the shortcut menu for the connection. The Tag Group 
Properties dialog opens.

3. At Name on the General tab, enter a meaningful name. In doing so, pay due consideration 
to the name conventions in the chapter Tag Management and Tags > Tag Groups.

4. Click the OK button to conclude the dialog.

See also
Creating Internal Tags (Page 190)

How to Create a Process Tag (Page 189)

Tag Groups (Page 170)
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2.5.6 How to Set Limit Values

Introduction
When using limit values, you prevent the value of a tag from being outside the defined limits.

You can set an upper limit value and a lower limit value. If, for example, a process value 
exceeds the upper limit value, WinCC grays out the value and does not process it any more.

If you define a substitute value, WinCC sets the substitute value in the event of the limit being 
violated.

Procedure
1. Select a process tag and open the "Tag Properties" dialog box.

2. On the Limits/Reporting tab, select the "Upper limit" check box and enter the desired value.

3. On the Limits/Reporting tab, select the "Lower limit" check box and enter the desired value.

4. Define a substitute value, if necessary, and activate the At Upper Limit or At Low Limit 
check box.

5. Click OK to close the dialog.
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See also
How to Define Linear Scaling (Page 200)

How to Define a Substitute Value (Page 199)

2.5.7 How to Define a Substitute Value

Introduction
You can define a specific value as a substitute value for a tag.

In the "Use Substitute Value" segment you define when you want WinCC to use this substitute 
value. The current process value is then not accepted from the automation system.

You can define a substitute value for the following cases:

As start value
WinCC sets the substitute value when the project is activated and there is no current process 
value.          
If a start value has already been defined, it is not possible to select "Replacement value as 
start value".
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Upon connection errors
WinCC sets the substitute value when the connection to the automation system is disturbed 
and there is no valid process value.

At upper limit
If you have set an upper limit for the tag, WinCC sets the substitute value as soon as the 
process value exceeds this upper limit.

At lower limit
If you have set a lower limit for the tag, WinCC sets the substitute value as soon as the process 
value falls below this lower limit.

Procedure
1. Select a process tag and open the "Tag Properties" dialog box.

2. On the Limits/Reporting tab, select the "Substitute value" check box and enter the desired 
value.

3. In the "Use Substitute Value" segment, select when you want WinCC to use this substitute 
value in the tag.

4. Click OK to close the dialog.

Note

If you have set an upper or lower limit in an input/output field, you cannot enter any value 
outside these limits.

WinCC ignores incorrect entries and therefore does not set a substitute value. The substitute 
value is only set by WinCC when an incorrect process value is read.

See also
How to Define Linear Scaling (Page 200)

How to Set Limit Values (Page 198)

2.5.8 How to Define Linear Scaling

Introduction
When using linear scaling, you can map values of process tags in WinCC to any second range 
of values.

Linear scaling is only available for process tags. Internal tags cannot be scaled.
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Usage
You use linear scaling when you want to display a process value differently from how it was 
supplied by the automation system. The process value itself is not modified.

This can be practical if you want to use the process value as a percentage or for calculations.

Example
A temperature sensor measures the resistance in the system and transfers the value in ohms. 
Certain resistance values correspond to specific temperatures. When using linear scaling, you 
can automatically convert the resistance values to the temperature scale. This ensures that 
the measured resistance is immediately displayed as a temperature in the project.

In the Tag Properties dialog, this resistance value corresponds to the details at Process value 
range. The temperature corresponds to the details at Tag value range.

Procedure
1. Select a process tag and open the Tag Properties dialog.

2. On the General tab, select the Linear scaling check box.

3. In the Process Value Range segment, enter as Value 1 the value from which linear scaling 
should apply. Enter for example "0". In the Process Value Range segment, enter as Value 
2 the value to which linear scaling should apply. Enter for example "100".

4. In the Tag Value Range segment, enter as Value 1 the value to which Value1 of the process 
should correspond. Enter for example value "0". Enter as Value 2 a value which should 
correspond to value2 of the process. Enter for example value "10". This ensures that the 
process values between 0 and 100 in the project are only displayed in increments of ten 
on a scale from 0 to 10.

5. Click the OK button to conclude the dialog.

Note

The values entered for scaling do not restrict the display. If you scale the values from 0 to 
100, values greater than 100 or less than 0 will still be displayed. You configure necessary 
limits on the Limits/Reporting tab.

See also
How to Define a Substitute Value (Page 199)

How to Set Limit Values (Page 198)
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2.6 Editing Tags

2.6.1 Editing Tags

Introduction
This chapter informs you of the possibilities of editing tags, tag groups and structure types:

● Copy

● Move

● Delete

● Rename

● Edit in Runtime

● Call status information

Note

If a tag was created in WinCC using SIMATIC Manager with Translate OS, you cannot edit 
the tag in WinCC Explorer.

See also
Creating Tags (Page 188)

Status Information of Tags in Runtime (Page 207)

Editing Tags in Runtime (Page 206)

How to Rename Tags (Page 204)

Copying, Moving and Deleting Tags (Page 202)

2.6.2 Copying, Moving and Deleting Tags

Introduction
The shortcut menu and the toolbar can be used to perform the following operations on tags, 
tag groups and structure types:

● Cut

● Copy

● Paste

● Delete
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There is no difference in the ways in which tags, tag groups and structure types behave. 

You can select and edit several objects at a time in each case.

Copying Tags, Tag Groups and Structure Types
If, for example, you wish to configure several tags having the same properties, you can copy 
an existing tag and paste it at the desired position. WinCC automatically increments the name 
or adds a count to the name.

When you copy a tag group, WinCC automatically copies every tag contained in it.

Structure types can be copied separately. Structure tags and structure instances cannot be 
copied separately but only while the associated structure type is being copied.

Examples

Original tag Copied tag

VarOne VarOne_1          
VarOne_2 

VarOne01 VarOne01_1          
VarOne01_2 

VarOne_01 VarOne_1          
VarOne_2 

VarOne_2          
VarOne_3

VarOne_4          
VarOne_5

VarOne_1          
VarOne_3          
VarOne_4          
VarOne_7          
(the values in between are not assigned)

VarOne_2          
VarOne_5          
VarOne_6          
VarOne_8

Note

If a tag was created in WinCC using SIMATIC Manager with Compile OS, you cannot copy 
or delete the tag in WinCC Explorer.

Moving Tags and Tag Groups
If you want to move tags or tag groups, cut the object and paste it at the position you want.

You can move tags

● from one tag group to another tag group

● from the connection of a communication driver to under the connection of another 
communication driver

● from Internal tags Tag Management to under a communication driver

● from the connection of a communication driver to the Internal tags Tag Management
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Structure types, structure tags and structure instances cannot be moved.

Note

If you want to move a tag between the Internal tags Tag Management and a Variable or 
between communication drivers, you must adjust the properties of the tag after doing so.

 

See also
Creating Tags (Page 188)

Editing Tags in Runtime (Page 206)

How to Rename Tags (Page 204)

2.6.3 How to Rename Tags

Introduction
You can rename the following elements in Tag Management:

● Tags

● Tag groups

● Structure types

● Structure instance

Upper/Lower Case Text
WinCC does not distinguish between upper and lower case characters when renaming.

Example
If you would like to change a lower case character to an upper case character in the tag name, 
you have to rename the tag in a roundabout manner. If tag "Varone" should really be called 
"VarOne", change the name first to "Varne" or "1Varone". You can then change the name a 
second time to "VarOne".

Note

Remember that WinCC distinguishes between upper and lower case characters in a 
configuration. If you change upper and lower case characters in a tag name, you must adapt 
your configuration accordingly.
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Procedure
1. Select a tag or a tag group.

2. Choose the Properties option from the shortcut menu.          
The Tag Properties or the  Tag Group Properties dialog opens.

3. Modify the name of the tag or tag group. Pay due consideration to the name conventions 
when doing so.

4. Click the OK button to conclude the dialog.

Alternative Procedure
You can rename selected tags, tag groups and structure tags with F2.

Special Features with Structure Types

Structure types and structure elements
If there are structure tags for a structure type in your project, you cannot rename either the 
structure type itself or the structure elements contained in it. You must first delete all associated 
structure instances and structure tags. After renaming, you must create the necessary 
structure tags again.

Structure instances and structure tags
You can only rename structure tags by changing the name of the structure instance. You 
cannot change the second part of the name, since it is defined by the corresponding structure 
element.

You can directly rename structure instances. You will find the structure instance in WinCC 
Explorer at Structure Types at the structure type being used. When you rename a structure 
instance, all associated structure tags are renamed automatically.

Example
A structure instance Furnace1 includes the structure tags Furnace1.pressure_actual, 
Furnace1.pressure_set and Furnace1.temperature.

If you change the name of the structure instance to Furnace_one, the structure tags will be 
changed to Furnace_one.pressure_actual, Furnace_one.pressure_set and 
Furnace_one.temperature.

Note

If a tag was created in WinCC using SIMATIC Manager with Compile OS, you cannot edit 
the tag in WinCC Explorer.

Working with Tags
2.6 Editing Tags

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  205



See also
Creating Tags (Page 188)

Editing Tags in Runtime (Page 206)

Copying, Moving and Deleting Tags (Page 202)

2.6.4 Editing Tags in Runtime

Introduction
If you have activated a project, you can edit tags in parallel. There are a few constraints, 
however.

Editing in Runtime
You can edit the following elements in Runtime:

 Tags Tag groups Structure types Structure 
instances

Create X X X X
Address X --- --- X
Cut Yes 2) --- --- ---
Copy Yes2) X X X
Paste X X X X
Delete X1) 2) X1) --- X
Modify properties X X X3) X
Rename X 1) 2) X --- X

1)Possible with external tags only if the channel being used supports the function. This currently 
applies only to the SIMATIC S7 Protocol Suite channel.
2)Does not apply to structure tags.
3) Not possible if structure tags are created.

Note

If a tag was created in WinCC using SIMATIC Manager with Compile OS, you cannot edit 
the tag in WinCC Explorer.

See also
Creating Tags (Page 188)

How to Rename Tags (Page 204)

Copying, Moving and Deleting Tags (Page 202)
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2.6.5 Status Information of Tags in Runtime

Introduction
In Runtime you can view information on connections and tags as a tooltip.

Displaying Status Information
In Tag Management of the activated project, change to the subdirectory you require.

If you point the mouse pointer to a connection or a tag in the data window, WinCC outputs the 
status information as a tooltip.

Connections
The tooltip of a connection specifies:

● The status of a connection

Tags
The tooltip of a tag specifies:

● The status of a connection

● The current process value of a tag

● The quality code of a tag

● The date on which a tag was last changed

This status display similarly applies to structure tags.

Quality Codes
Quality codes provided encoded information about the status and quality of a tag.

You will find a list of quality codes in the WinCC Information System at Communication > 
Communication Diagnostics > Quality codes of tags.

See also
Tag management (Page 159)
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Creating Process Pictures 3
3 Resources

3.1 Creating Process Pictures

Contents
The Graphics Designer is an editor for creating process pictures and making them dynamic.

This chapter will show you

● how to use the "Graphics Designer" editor

● how to create and edit process pictures

● how to adapt the object properties to the requirements of your project

● how to configure and use objects of the Object Palette and library

● how to combine and configure objects of the Object Palette

● how to integrate and configure controls in process pictures

● how to test process pictures in Runtime

Chapter "Object properties" describes the properties of the objects of the Graphics Designer.

How to make process pictures dynamic is described in detail in the chapter "Making Process 
Pictures Dynamic".

3.2 How to start the Graphics Designer

Introduction
The Graphics Designer can only be started for the project currently opened in the WinCC 
Explorer.
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Requirements
● A project must be opened.

Procedure
The Graphics Designer can be opened in the following ways:

● Navigation window of WinCC Explorer         
Select the command "Open" in the pop-up menu of the entry "Graphics Designer".         
The Graphics Designer is started and a new picture is opened.

● Data window of WinCC Explorer         
Select the entry "Graphics Designer" in the navigation window. The pictures available in 
the project are shown in the data window. Select the command "Open picture" in the pop-
up menu of a picture.         
The Graphics Designer is started and a new picture is opened.

See also
The pop-up menu in the Data Window (Page 221)

The shortcut menu in the Navigation window (Page 212)

The Graphics Designer in the WinCC Explorer (Page 210)

3.3 The Graphics Designer in the WinCC Explorer

3.3.1 The Graphics Designer in the WinCC Explorer

Introduction  
The Graphics Designer is an editor for creating process pictures and making them dynamic. 
The Graphics Designer can only be started for the project currently opened in the WinCC 

Creating Process Pictures
3.3 The Graphics Designer in the WinCC Explorer

MDM - WinCC: Working with WinCC
210 System Manual, 11/2008,  



Explorer. The WinCC Explorer can be used to display an overview of the pictures available in 
the current project.

For working with the Graphics Designer, the WinCC Explorer offers the following functions and 
configuration options:

● Starting Graphics Designer

● Opening, creating, renaming and deleting a picture

● Properties of the picture

● Configuring object libraries and ActiveX controls

● Converting libraries and pictures from older program versions

● Configuring and starting Runtime

You can call commands via the toolbar and the shortcut menus in the navigation and data 
windows.

Note

If you rename a picture in the WinCC Explorer, you use a picture name once only. The 
software does not check for whether the new name already exists. Duplicate picture names 
can lead to conflicts in accessing via VBA or in making dynamic.
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Picture types in the Graphics Designer
The following types of pictures are differentiated:

Graphics Designer picture

Graphic Designer picture that is used in Runtime as the welcome screen

Faceplate type that can be inserted as an instance in a Graphic Designer picture

Graphic Designer picture with faceplate instances that are affected by type changes

You can find additional information on faceplate types in the section "Working with faceplate 
types".

See also
This is how you configure the Control selection of the Object Palette (Page 218)

This is how to configure the object selection (Page 216)

Displaying the properties of a picture file (Page 224)

Displaying the configured dynamics of a process picture (Page 226)

How to start the Graphics Designer (Page 209)

How to set up Runtime (Page 112)

How to activate / deactivate Runtime (Page 657)

The shortcut menu in the Navigation window (Page 212)

The pop-up menu in the Data Window (Page 221)

3.3.2 The shortcut menu in the Navigation window

Introduction
A pop-up menu permits rapid access to frequently required functions. All of the functions listed 
in the pop-up menu can also be started using the menu bar.

The navigation window is the left-hand window in the WinCC Explorer. The pop-up menu can 
be used to modify the components of the opened project. The pop-up menu of the Graphics 
Designer enables you to create new pictures, to integrate controls or to convert libraries.
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Requirements
● A project must be opened.

Procedure
1. Right-click the entry "Graphics Designer".         

The pop-up menu will be opened.

2. Select one of the entries from the pop-up menu.

Opening
The Graphics Designer is started. A new empty picture is created in the format PDL.

New picture
A new empty picture is created in the format PDL without opening the Graphics Designer. The 
new picture is displayed in the data window of the WinCC Explorer and can be renamed using, 
for example, the context-sensitive menu.
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Graphic OLL
The "Object OLL" dialog is opened. This dialog indicates which object libraries are available 
for the Graphics Designer. The object selection can be configured for the current project. Other 
object libraries can be imported, for example using the "Floppy disk" button. It is possible, for 
example, to integrate other button or text objects and then use them in the project.         
The "Object OLL" dialog is described in detail in the chapter "Configuring the object selection".

Selecting ActiveX controls
The "Select OCX Controls" dialog is opened. This dialog shows all the ActiveX Controls that 
are registered in the operating system. A red check mark indicates those controls that are 
shown in the Object Palette of the Graphics Designer, "Controls" tab dialog. Other controls 
can be made available for the Graphics Designer. It is possible, for example, to integrate 
Windows Controls or foreign controls and then use them in the project.         
The "Select OCXen" dialog is described in detail in the chapter "Configuring control selection 
of the object palette".

Converting pictures
Pictures created with an older version of the Graphics Designer have to be converted into the 
current format.          
    If you select the entry "Convert pictures", a confirmation prompt appears. When you confirm 
the conversion of the pictures with "OK", all of the project's pictures will be converted.

NOTICE

Conversion of pictures can not be undone.

Note

Converting pictures and libraries can take some time.

Converting the global library
Picture objects of the global library that have been imported from an older WinCC version are 
converted into the current format.         
    With this option, all of the picture objects in the global library are converted.

NOTICE

The conversion starts immediately, as soon as you have selected the entry. No confirmation 
prompt appears.         
Conversion of the project library cannot be undone.

Creating Process Pictures
3.3 The Graphics Designer in the WinCC Explorer

MDM - WinCC: Working with WinCC
214 System Manual, 11/2008,  



Converting the project library
Picture objects of the project library that have been imported from an older WinCC version are 
converted into the current format.         
    With this option, all of the picture objects in the project library are converted.

NOTICE

The conversion starts immediately, as soon as you have selected the entry. No confirmation 
prompt appears.         
Conversion of the project library cannot be undone.

Display Column Information
The Display Column Information entry in the data window of WinCC Explorer is used to show 
the Information column.  The entry in this column shows how the corresponding picture was 
created.

Type of object creation Entry in the Information column

Picture has been created using WinCC Explorer. <No entry>
Picture has been created using WinCC Explorer 
and then imported to SIMATIC Manager using the 
Import WinCC Objects function. 

Created by SIMATIC Manager

Picture has been created using SIMATIC Manager. Created by SIMATIC Manager

Do not display the Information column
You can hide this column in the data window using the "Do not display Information column" 
entry.

Properties
An information dialog is opened, showing the general properties from WinCC as well as the 
installed components.

Alternative Operation
All of the commands listed can also be started using the menu bar. 

See also
This is how you configure the Control selection of the Object Palette (Page 218)

This is how to configure the object selection (Page 216)

How to start the Graphics Designer (Page 209)

The pop-up menu in the Data Window (Page 221)

The Graphics Designer in the WinCC Explorer (Page 210)
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3.3.3 This is how to configure the object selection

Introduction
The object selection available in the Graphics Designer can be configured for the current 
project. Other object libraries can be imported, for example using the "Floppy disk" button. It 
is possible, for example, to integrate other button or text objects and then use them in the 
project.

Requirements
● A project must be opened.

Opening the "Object OLL" dialog
Right-click in the navigation window on the entry "Graphics Designer". Select the entry 
"Graphic OLL" from the pop-up menu.

This "Object OLL" dialog indicates which object libraries are available for the Graphics 
Designer. The availability of object libraries can be changed as required.

Available Graphic OLLs
All of the object libraries registered in WinCC in the left-hand area of the dialog.

Selected Graphic OLLs
The right-hand area of the dialog lists all the object libraries that have been selected for use 
in the Graphics Designer.
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Arrow buttons
Use the arrow buttons to move object libraries in the relevant arrow direction.

"Floppy disk" button
Click the "Floppy disk" button to add other object libraries to WinCC.

Button "Preview"
Select the desired OLL file in one of the two upper areas. Click the "Preview" button to display 
the content of the selected object library as a preview.

Configuring the Graphic OLL
In the Graphics Designer, only the object libraries listed in the area "Selected Graphic OLLs" 
are available. Use the arrow buttons to move a selected object library in the relevant arrow 
direction. You can also select a number of OLL files if you click the desired files while holding 
down the <SHIFT> or <CTRL> keys.

The arrow buttons have the following function:

Moves the selected OLL file from the left-hand area into the right-hand area

Moves the selected OLL file from the right-hand area into the left-hand area.

Moves all the OLL files displayed in the left-hand area into the right-hand area.

Moves all the OLL files displayed in the right-hand area into the left-hand area.

Adding Graphic OLLs
You can use the "Object OLL" dialog to link other object libraries in WinCC by copying them 
from a floppy disk or from another directory into the area "Available Graphic OLLs".

1. Click the "Floppy disk" button.         
The dialog "Floppy disk" opens.

2. Enter the path of the desired source directory or click the "Search" button to select the 
source directory.

3. Confirm your selection by clicking "OK".         
The selected OLL files will be displayed in the left area of the dialog "Object OLL".
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Note

    Object libraries are WinCC files of the format OLL and they are located in the subfolder 
"Bin" of the WinCC installation directory.         
Additional object libraries can be purchased through your WinCC sales partner.

See also
How to start the Graphics Designer (Page 209)

The shortcut menu in the Navigation window (Page 212)

The Graphics Designer in the WinCC Explorer (Page 210)

3.3.4 This is how you configure the Control selection of the Object Palette

Introduction
The "Controls" tab in the Object Palette of the Graphics Designer contains a selection of 
controls in the folders "ActiveX Controls", ".NET Controls" and "WPF Controls". You can insert 
these controls directly into a picture. 

You can configure the selection of controls available in the tab yourself: 

● Change the selection of the ActiveX controls in the dialog "Select OCX Controls". You can 
add any of the ActiveX controls registered in the operating system to the list of controls and 
remove individual controls from the selection.

● Change the selection of the .NET controls in the dialog "Select .NET Object".

● Change the selection of the WPF controls in the dialog "Select WPF Object".

NOTICE

The use of controls from third party providers can lead to errors as well as drops in 
performance or system blockage. The user of the software is responsible for problems 
caused by the deployment of external controls.          
We recommend a thorough test before implementation. 

Creating Process Pictures
3.3 The Graphics Designer in the WinCC Explorer

MDM - WinCC: Working with WinCC
218 System Manual, 11/2008,  



Configuring ActiveX controls
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the 

"ActiveX Controls" folder. The "Select OCX Controls" dialog is opened.

In the area "Available OCXs (Number)", the "Select OCX Controls" dialog shows all the 
ActiveX Controls that are registered in the operating system. The exact number is shown 
in the title of the area after the registration has been read in. A red check mark indicates 
those controls that are available in the "Controls" tab dialog of the Object Palette. The path 
and the program ID of the selected ActiveX Controls are displayed in the area "Details". 
You can open the "Select OCX Controls" dialog also from the WinCC Explorer. Click on 
the entry "Graphics Designer" in the navigation window and select the entry "Select ActiveX 
Control" in the shortcut menu. 

2. To add an ActiveX control to the Object Palette, select the desired control in the area 
"Available OCX Controls".
A red check mark indicates that the control will be added to the "Controls" tab of the Object 
Palette. 

3. To remove an ActiveX control from the Object Palette, clear the control in question in the 
area "Available OCX Controls".
The red check mark disappears. 

4. Confirm your changes by clicking "OK".
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Configuring .NET objects and WPF objects
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the 

".NET Controls" folder or the "WPF Controls" folder.
The dialog "Select .NET Object" or "Select WPF Object" opens. 

In the area "Available Controls (Number)", the dialog shows all the .NET objects or WPF 
objects on your computer. The precise number is displayed in the title of the area. A red 
check mark indicates those controls that are available in the "Controls" tab dialog of the 
Object Palette. The assembly, .NET version and path of the selected object are displayed 
in the area "Details". 

2. To add a control to the Object Palette, select the desired control in the area "Available 
Controls".
A red check mark indicates that the control will be added to the "Controls" tab of the Object 
Palette. 

3. To remove a control from the Object Palette, clear the control in question in the area 
"Available Controls".
The red check mark disappears. 

4. Confirm your changes by clicking "OK".

See also
The Graphics Designer in the WinCC Explorer (Page 210)

The shortcut menu in the Navigation window (Page 212)
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3.3.5 The pop-up menu in the Data Window

Introduction
A shortcut menu permits rapid access to frequently required functions. All of the functions listed 
in the shortcut menu can also be started using the menu bar.

The data window is the right-hand window in the WinCC Explorer. Using the shortcut menu, 
the clicked picture can be opened, renamed or deleted, for example. In the data window, a 
picture can also be defined as the welcome screen.

Requirements
● A project must be opened.

Procedure
1. Click in the navigation window of the WinCC Explorer with the left-hand mouse button on 

the entry "Graphics Designer".         
All the pictures (PDL) and faceplate types (FPT) of the current project are displayed in the 
data window.

2. Right-click one of the displayed pictures.         
The shortcut menu will be opened.

3. Select one of the entries from the shortcut menu.

Creating Process Pictures
3.3 The Graphics Designer in the WinCC Explorer

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  221



Open picture
The selected picture is opened in the Graphics Designer. If necessary, the Graphics Designer 
is started.

Rename picture
The selected picture can be renamed in the WinCC Explorer provided it is not opened in the 
Graphics Designer. The file format PDL will be kept.         
Enter the new file name into the text field of the "New name:" dialog. on Click "OK" to confirm 
your entries.

Note

If you rename a picture in the WinCC Explorer, you use a picture name once only. The 
software does not check for whether the new name already exists. Duplicate picture names 
can lead to conflicts in accessing via VBA or in making dynamic.

Delete picture(s)
The selected picture is deleted provided it is not opened in the Graphics Designer.          
    If you select the entry "Delete picture", a confirmation prompt appears. As soon as you 
confirm deletion of the picture with "OK", the picture is removed from the project.

NOTICE

Deletion of pictures can not be undone.

Note

If you create pictures using the SIMATIC Manager, these cannot be renamed or deleted in 
WinCC Explorer. This also applies to WinCC pictures created in WinCC and subsequently 
imported into SIMATIC Manager by using the function "Import WinCC Object". You can 
recognize these pictures from the "Created by SIMATIC Manager" entry in the Information 
column of the data window.
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Define screen as start screen
The selected picture is defined as a welcome screen in Runtime         
The selected picture is entered into the "Start picture" field in the tab "Graphics Runtime" of 
the dialog "Computer properties". 

Open the "Computer properties" dialog
In the navigation window, select the entry "Computer". Double-click the displayed computer 
name.

Properties
The "Properties" window provides an overview of the most important properties of the selected 
picture file. The "Preview" tab shows a preview of the picture and the file properties. A second 
tab contains statistics on the configured dynamic properties of the picture.

Confirm all type changes
All the effects from changing the properties and event of the faceplate types on the given 
faceplate instances are confirmed for the selected Graphics Designer pictures.

The affected pictures are saved again. The status of the faceplate instances is reset. The red 
cross is no longer displayed when the picture is opened in the Graphics Designer, WinCC 
Explorer or in Runtime.

The following actions are combined in one menu command with "Confirm all type changes":

● Open each affected picture

● Confirm the type change via the "Faceplate instances with type change" dialog

● Save the pictures

Use the menu command when you are sure that the changes to the faceplate type will have 
no effect on the instances.

See also
Working with Faceplate types (Page 299)

Displaying the properties of a picture file (Page 224)

Displaying the configured dynamics of a process picture (Page 226)

How to start the Graphics Designer (Page 209)

How to set up Runtime (Page 112)

The shortcut menu in the Navigation window (Page 212)

The Graphics Designer in the WinCC Explorer (Page 210)
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3.3.6 Displaying the properties of a picture file

Introduction
If the entry "Graphics Designer" is selected in the navigation window of the WinCC Explorer, 
all the pictures of the current project are displayed in the data window. The entry "Properties" 
in the pop-up menu of a picture opens the "Properties" dialog. The "Properties" dialog has two 
tabs that provide an overview of the most important picture properties. 

The "Preview" tab shows a preview of the selected process picture as well as the statistical 
characteristics of the picture file.

Requirements
● A project must be opened.

● In the navigation window of the WinCC Explorer, the entry "Graphics Designer" must be 
selected.

● For a complete display of the properties, the desired picture should not be opened in the 
Graphics Designer.

Displaying statistical characteristics
Right-click one of the pictures in the data window and select the entry "Properties" from the 
pop-up menu. Select the "Preview" tab.         
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The picture properties can also be opened using the menu bar of the WinCC Explorer.

Date created
The date and time the picture was created are shown in the "Created on" field.

Date changed
The date and time the picture was last edited are shown in the "Last change on" field.

File Size
Shows the size of the PDL file in bytes.

Picture Size
Shows the dimensions of the picture as "width by height" in pixels.
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Number of Objects
Shows the number of objects contained in the picture. The displayed value is calculated from 
the total number of all configured single, group and customized objects. Also included in the 
calculation are the single objects contained in groups.

See also
The Graphics Designer in the WinCC Explorer (Page 210)

The shortcut menu in the Navigation window (Page 212)

The pop-up menu in the Data Window (Page 221)

Displaying the configured dynamics of a process picture (Page 226)

3.3.7 Displaying the configured dynamics of a process picture

Introduction
If the entry "Graphics Designer" is selected in the navigation window of the WinCC Explorer, 
all the pictures of the current project are displayed in the data window. The entry "Properties" 
in the pop-up menu of a picture opens the "Properties" dialog. The "Properties" dialog has two 
tabs that provide an overview of the most important picture properties.  

With the functions of the "Dynamics" tab dialog, details of all dynamics defined for the selected 
picture can be displayed.

Requirements
● A project must be opened.

● In the navigation window of the WinCC Explorer, the entry "Graphics Designer" must be 
selected.

● For a complete display of the picture properties, the desired picture should not be opened 
in the Graphics Designer.

Displaying configured dynamics
Right-click one of the pictures in the data window and select the entry "Properties" from the 
pop-up menu. Select the "Dynamics" tab.         
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The picture properties can also be opened using the menu bar of the WinCC Explorer.

The first time the "Dynamics" tab is opened, the entry "Statistics" is the default setting as type 
of dynamics. The overview list displays all the types of dynamics as well as the frequency of 
their configuration in the selected picture. Double-clicking with the left-hand mouse button 
directly opens the detail display for the different types of dynamics.

Type of dynamics
From the dropdown list box, select the type of dynamics whose settings you want to display 
in the overview list.

"Statistics" button
Click this button to reset the type of dynamics to the entry "Statistics".

Quantity
The "Number" field shows the total number of dynamics configured in the selected picture for 
the selected type of dynamics.

Overview list
All the objects of the selected picture for which the selected type of dynamics is configured 
are shown in the overview list line by line. The columns of the overview list contain the 
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corresponding settings for these objects. The number and content of the columns depend on 
the selected type of dynamics.

See also
Displaying the properties of a picture file (Page 224)

The pop-up menu in the Data Window (Page 221)

The shortcut menu in the Navigation window (Page 212)

The Graphics Designer in the WinCC Explorer (Page 210)

Basic Dynamic Operations (Page 407)

3.4 Elements and Basic Settings of the Graphics Designer

3.4.1 Elements and Basic Settings of the Graphics Designer

Introduction
The Graphics Designer is a combination of a graphics program and a tool for representing 
processes. Based on the Windows standard, the Graphics Designer provides functions for the 
creation and dynamic modification of process pictures. The familiar Windows program interface 
makes it easy to begin using the complex program. Direct Help provides fast answers to 
questions. The user can set up a personalized working environment.

This chapter contains information on the structure of the Graphics Designer, on the elements 
and basic settings of the program.

See also
Customizing the Working Environment (Page 271)

The Basic Settings of the Graphics Designer (Page 254)

The Start Screen of the Graphics Designer (Page 234)

3.4.2 The Coordinate System of a Process Picture

Introduction
In the Graphics Designer, the basis for setting positions and specifying sizes is a two-
dimensional coordinate system. The two axes of the coordinate system, x-axis and y-axis, are 
perpendicular to one another and intersect at the coordinate origin.

The coordinate origin lies with the coordinates (X = 0 / Y = 0) in the top left corner of the desktop. 
Starting from the coordinate origin, the horizontal x-axis runs in positive direction towards the 
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right-hand border of the desktop. The vertical y-axis points in a positive direction towards the 
lower border of the desktop. The X and Y values of the current position of the mouse pointer 
are displayed in the status bar of the Graphics Designer. The values for X and Y rise when the 
mouse pointer is moved from the top left to the bottom right on the desktop. The coordinates 
are shown in pixels.

The position and size of objects of a picture are determined by the coordinates that an object 
has in the coordinate system. For example, the position of the object origin is set by the 
attributes "Position X" and "Position Y". The object origin therefore has the coordinates X = 
"Position X" / Y = "Position Y". The values of these attributes describe the distance of the object 
origin from the coordinate axes.

Definition of origin
The origin is defined as the point of an area or an object that is used as the reference point for 
entering position and size. For the creation of process pictures in the Graphics Designer, the 
following reference points are of significance:
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Coordinate origin
The "coordinate origin" is the top left corner of the desktop.         
Coordinates: X = 0 / Y = 0

Picture origin
The "picture origin" is the top left corner of a process picture.         
Coordinates: X = 0 / Y = 0         
If the picture on the work area is not displayed as a window but maximized, the picture origin 
is the same as the coordinate origin.

Object origin
The "object origin" is the top left corner of the rectangle surrounding the object.         
Coordinates: X = "Position X" / Y = "Position Y"

See also
Working with Objects (Page 378)

The Status Bar (Page 247)

The Rectangle Surrounding the Object (Page 232)

The Coordinate System of an Object (Page 230)

3.4.3 The Coordinate System of an Object

Introduction
The validity of the normal coordinate system is canceled for displays within an object. The 
following special forms are used for the internal coordinate system of an object:

● 2D coordinate system of an object

● 3D coordinate system of an object

2D coordinate system of an object
The two-dimensional coordinate system of an object differs from that of a process picture in 
the direction of the y-axis:

The positive direction of the Y-axis points upward.         
The positive direction of the X-axis points to the right.

3D coordinate system of an object
For display in the object "3D bar", a three-dimensional coordinate system is used. In addition 
to the horizontal x-axis and the vertical y-axis, this three-dimensional coordinate system has 
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a z-axis that points into the picture level. The coordinate system for the spatial representation 
of the 3D bar can be customized with the following attributes:

● "Display axis"         
Determines the coordinate axis, where the value scale displayed by the 3D bar runs.

● "Bar direction"         
Determines the direction for the "Display axis", which the positive axis section points to.

● "Alpha"         
Determines the angle for the depth display of the Z-axis.

● "Beta"         
Determines the angle for the depth display of the X-axis.

The following graphic illustrates the three adjustable display axes.
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See also
How to Insert a 3D Bar (Page 575)

The Status Bar (Page 247)

The Rectangle Surrounding the Object (Page 232)

The Coordinate System of a Process Picture (Page 228)

3.4.4 The Rectangle Surrounding the Object

Introduction
The rectangle surrounding an object is defined as a rectangular frame which lies on the outer 
border lines of an object. The rectangle surrounding the object itself is not visible in the 
Graphics Designer. As soon as you select an object, selection marks are shown however. 
These handles serve as grab points for changing the object size with the mouse. The handles 
mark the center axes and corner points of the rectangle surrounding the object. 
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Note

If the object has 100% transparency, the selections marks are invisible as well. 

The significance of the rectangle surrounding the object for determining the position is 
illustrated with a circular or ellipse-shaped object as an example:          
The position of an object is defined as the position of its origination in the coordinate system. 
The object origin has the coordinates ("Position X"m "Position Y") and is defined as the upper 
left corner of the rectangle surrounding the object. Specified in this way, the position of a circular 
or ellipse-shaped object is set clearly. 

The handles of the rectangle surrounding the object
The handles of the rectangle surrounding the object appear as soon as you select an object. 
You can change the size of an object by shifting a selection mark to a new position with the 
mouse. 

As soon as the mouse pointer is positioned to a selection mark, it switches into a double arrow. 
The alignment of the double arrow indicates the directions in which the handle can be moved:
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● Horizontal double arrow         
You change the width of the object using the selection marks on the horizontal center axis.

● Vertical double arrow         
You change the height of the object using the selection marks on the vertical center axis.

● Diagonal double arrow         
The selection marks on the corners of the object can be used to change the height and 
width of the object.

Note

You can change the overall size of circular objects. These have no selection marks for 
the center axes. 

See also
Working with Objects (Page 378)

How to scale an object (Page 393)

How to Select Multiple Objects (Page 388)

Multiple Selection of Objects (Page 386)

How to select an object (Page 385)

The Coordinate System of an Object (Page 230)

The Coordinate System of a Process Picture (Page 228)

3.4.5 The Start Screen of the Graphics Designer

3.4.5.1 The Start Screen of the Graphics Designer

Introduction
The Graphics Designer provides objects and tools for creating process pictures. Start the 
Graphics Designer from the navigation window of the WinCC Explorer.

Layout of the Graphics Designer screen
The Graphics Designer is designed according to the Windows standard. The Graphics 
Designer has a desktop, toolbar, menu bar, status bar and various palettes. When you open 
the Graphics Designer, the screen with the default settings appears. As standard, a blank 
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picture is displayed (file format PDL). You can move the palettes and bars on the screen and 
arrange them as you like.

The Toolbars
At "View", "Toolbars...", the following toolbars can be shown or hidden. In the default setting, 
all toolbars, except for the tags, are shown.

● Objects: for inserting Standard Objects, Smart Objects, Windows Objects and Controls.

● Styles: for changing the line style and thickness, and fill patterns.

● Standard: for creating and saving documents, activating the Runtime etc.

● Alignment: for aligning a number of objects.

● Colors: for fast changes to the color of an object.

● Font: for changing the font and font size, font color and border color.

● Zoom: for stepless zooming in and out.
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● Status: for displaying the language setting and coordinates

● Layers: for showing and hiding individual layers.

● Dynamic Wizard: for making objects dynamic with pre-prepared C Actions.

● Tags: for fast assignment of tags to objects that can be made dynamic.

Note

To move the visible area in the case of large pictures, you can use the scroll bars in 
accordance with the Windows standard.          
The Graphics Designer provides additional operation options with the mouse wheel: Click 
the mouse wheel. The mouse pointer changes and you can move the visible picture area 
simply by moving the mouse.

See also
Elements and Basic Settings of the Graphics Designer (Page 228)

The Status Bar (Page 247)

The Tag Palette (Page 246)

The Font Palette (Page 245)

The Color Palette (Page 244)

The Zoom Palette (Page 243)

The Layer Palette (Page 242)

The Alignment Palette (Page 241)

The Dynamic Wizard (Page 240)

The Style Palette (Page 239)

The Object Palette (Page 238)

The Standard Toolbar (Page 236)

3.4.5.2 The Standard Toolbar

Introduction
The default setting is such that the standard toolbar is located beneath the menu bar of the 
Graphics Designer. The buttons of the standard toolbar include both common Windows 
commands such as "Save" and "Copy" and special buttons of the Graphics Designer such as 
"Runtime".

The standard toolbar can be shown or hidden using "View > Toolbars". At the left on the toolbar 
is a gripper, which can be used to move the bar to any position on the screen. 
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The buttons of the standard toolbar

Icon Function Key combination

Create a new process picture. <Ctrl+N>

Creates a new Faceplate type. 
 

<Ctrl+T>

Opens an existing process picture. <Ctrl+O>

Saves the active process picture. <Ctrl+S>

Starts Runtime, for example to test the active process picture. 
This function is only available if a process picture has been 
opened.

-

Cuts out the selected object and copies it onto the clipboard. 
This function is only available if an object has been selected.

<Ctrl+X>

Copies the selected object onto the clipboard. This function 
is only available if an object has been selected.

<Ctrl+C>

Pastes the content of the clipboard into the active process 
picture. This function is not available if the clipboard is empty.

<Ctrl+V>

Undoes the last actions (maximum of 30). This function is 
only available if an action has been performed beforehand.

<Ctrl+Z>

Redoes the last undone action. This function is only available 
if an action has been undone beforehand.

<Ctrl+A>

Prints the content of the active process picture. This function 
is only available if a process picture has been opened.

<Ctrl+P>

Places the selected object within the layer in the foreground. 
Objects in the foreground cover objects lying behind them.

-

Places the selected object within the layer in the background. 
Objects in the background are covered by objects in the 
foreground.

-

Hides and shows the grid in the active window. -

Switches the function "Snap to Grid" on and off. -

Increases the zoom factor in individual steps. The picture is 
enlarged. This function is only active until the largest zoom 
factor (800%) has been reached.

-

Reduces the zoom factor in individual steps; the picture is 
displayed as smaller. This function is only active until the 
smallest zoom factor (10%) has been reached.

-

Zooms in on a selected picture area. This picture area is 
displayed in the size of the picture window.

-

Copies line and color properties of an object to transfer them 
to another object.

-

Assigns properties of an object to another object. This 
function is only active if properties have been copied.

-

Mirrors a selected object on its vertical center axis. If a 
number of objects have been selected, the center axis of the 
individual objects applies in each case.

-
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Icon Function Key combination

Mirrors a selected object on its horizontal center axis. If a 
number of objects have been selected, the center axis of the 
individual objects applies in each case.

-

Rotates a selected object by 90° clockwise around its center 
point. If a number of objects have been selected, the center 
point of the individual objects applies in each case.

-

Opens the "Object Properties" window. -

Opens the "Library" window. Finished system parts, for 
example, can be stored in the libraries of the Graphics 
Designer so that they can be inserted later in another process 
picture. There are a great many standard forms available in 
the libraries, for example electrical circuits. 

-

Opens the VBA Editor. <Alt+F11>

Activates the direct help (What's this?). <SHIFT+F1>

See also
The Start Screen of the Graphics Designer (Page 234)

Customizing the Working Environment (Page 271)

How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

How to Change the Standard Toolbar (Page 277)

3.4.5.3 The Object Palette

Introduction
The Object Palette contains different types of objects that are frequently required in process 
pictures. 

The Object Palette can be shown or hidden using "View", "Toolbars". The Object Palette can 
be moved to any position on the screen.
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Contents
There are the following object groups:

● Standard objects: e.g. line, polygon, ellipse, circle, rectangle, static text

● Smart objects: e.g. application window, picture window, OLE object, I/O field, bars, status 
display

● Windows objects: e.g. button, check box, option group, slider object

● Controls: The 'Controls' tab contains as standard a selection of the most important ActiveX 
controls provided by WinCC. Other controls can be linked.

● You can read about how to configure the Object Palette yourself in the chapter "Configuring 
object selection".

See also
This is how to configure the object selection (Page 216)

How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

The Start Screen of the Graphics Designer (Page 234)

Working with Standard Objects (Page 475)

Working with Smart Objects (Page 509)

Working with Windows Objects (Page 583)

Working with Controls (Page 319)

3.4.5.4 The Style Palette

Introduction
The Style Palette allows fast changes to line style, line weight, line end style and fill patterns. 

The Style Palette can be shown or hidden using "View", "Toolbars". The Style Palette can be 
moved to any position on the screen.
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Contents
● The style group "Line Style" contains different line display options such as dashed, dotted 

etc.

● The style group "Line Weight" sets the thickness of the line. The line weight is specified in 
pixels. 

● The style group "Line End Styles" enables display of the ends of lines as arrows or rounded, 
for example.

● The style group "Fill Pattern" provides the possibility to display closed objects with, for 
example, a transparent or checkered background. 

Displaying the Current Settings
If an object has been selected, the style properties of this object are shown in a bold font.

See also
The Start Screen of the Graphics Designer (Page 234)

How to Arrange the Toolbar and Palettes (Page 276)

How to Show and Hide the Toolbar and Palettes (Page 275)

3.4.5.5 The Dynamic Wizard

Introduction
The Dynamic Wizard provides a large number of predefined C Actions to support configuration 
of frequently recurring processes. The C Actions are sorted in topics in the form of tabs. The 
content of the individual tabs can vary depending on the selected object type.

The Dynamic Wizard can be shown or hidden using "View", "Toolbars". The Dynamic Wizard 
can be moved to any position on the screen.

There is an extensive description of this topic in the chapter "Making Process Pictures 
Dynamic".
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See also
How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

The Start Screen of the Graphics Designer (Page 234)

Process Picture Dynamics (Page 815)

3.4.5.6 The Alignment Palette

Introduction
The functions of the Alignment Palette can be used to process a number of objects together. 
You can also call up these functions from the "Arrange > Align" menu. 

You show or hide the alignment palette with "View > Toolbars". To the left of the Alignment 
Palette is a handle, which you can use to move the palette to any position on the screen. 

The Alignment Palette contains the following functions for processing the objects in a multiple 
selection: 

Prerequisites
● You have selected at least two objects. 

Overview

Buttons Function Reference object

Align:         
The selected objects are aligned on the left, right, 
top or bottom.

If the objects have been selected using a 
selection border (lasso) with the mouse, the 
object located the furthest towards the outside 
is used as reference.          
If the objects have been selected using the 
pressed <SHIFT> key and the left-hand mouse 
button, the first selected object is used as 
reference.          
If the objects have been selected with <Ctrl+A>, 
the reference object of the original selection 
applies; otherwise that on the outermost object. 

Center:         
The selected objects are centered horizontally 
or vertically. 

The reference is the shared center axis of the 
selected objects, independent of the type of 
selection.

Distribute:         
The selected objects are distributed evenly, 
horizontally or vertically.          
The outermost objects remain unchanged. 

No reference object 
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Buttons Function Reference object

Match width or height:         
The selected objects are matched with one 
another in width or height. 

If the objects have been selected using a 
selection border (lasso) with the mouse, the 
object with the largest width or height is used 
as reference.          
If the objects have been selected using the 
pressed <SHIFT> key and the left-hand mouse 
button, the first selected object is used as 
reference.          
If the objects have been selected with <Ctrl+A>, 
the reference object of the original selection 
applies; otherwise the object with the greatest 
width or height. 

Match width and height:         
The selected objects are matched with one 
another in height and width. 

The reference object is then the object 
configured first in the multiple selection.

See also
How to Arrange the Toolbar and Palettes (Page 276)

How to Show and Hide the Toolbar and Palettes (Page 275)

How to Align Multiple Objects (Page 392)

How to Select Multiple Objects (Page 388)

Multiple Selection of Objects (Page 386)

The Start Screen of the Graphics Designer (Page 234)

3.4.5.7 The Layer Palette

Introduction
In order to simplify the processing of individual objects in complex process pictures, the 
Graphics Designer allows you to work with layers. For example, the contents of a process 
picture can be distributed across up to 32 layers. These layers can be shown or hidden 
individually; in the default setting, all layers are visible; the active layer is Layer 0.

The Layer Palette can be shown or hidden using "View", "Toolbars". To the left of the palette 
is a 'gripper', which can be used to move the palette to any position on the screen.

Example: Layers 0 and 1 are displayed, all other layers are hidden. The active layer is Layer 
1; this has been renamed to "Compressor".

Making layers visible / invisible
Pressed buttons indicate the visible layers. Click a button to make the layer visible or invisible.
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Active layer
The active layer can be set in the dropdown list box of the Layer Palette.

Renaming layers
The "Settings..." menu on the "Visible Layers" tabbed card is used to rename layers. Double-
click a layer; you can then enter a new name.

Assigning objects to layers
The assignment of an object to a layer can be changed in the "Object Properties" window.

See also
How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

How to use the layers palette (Page 294)

Working with Layers (Page 290)

The Start Screen of the Graphics Designer (Page 234)

3.4.5.8 The Zoom Palette

Introduction
Alongside the buttons for zooming in the Standard Toolbar, the Graphics Designer provides 
a separate Zoom Bar. This enables very convenient zooming in a process picture. 

On the left side of the Zoom Bar is a slider for finely graded setting of the zoom factor. To the 
right of this are buttons with predefined zoom factors. The currently set zoom factor is displayed 
below the slider in %. 

The Zoom Palette can be shown or hidden using "View", "Toolbars". The Zoom Palette can 
be moved to any position on the screen.
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Note

The minimum and maximum zoom factors can be defined individually for all layers. For 
example, you can set the detail displays on a separate layer and show it only as of a certain 
zoom factor, see chapter "Showing / Hiding tab dialogs".         
 

To move the visible area in the case of a high zoom factor, you can use the scroll bars in 
accordance with the Windows standard.          
The Graphics Designer provides additional operation options with the mouse wheel: Click 
the mouse wheel. The mouse pointer changes and you can move the visible picture area 
simply by moving the mouse.

See also
How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

Showing and hiding layers and objects (Page 264)

The Start Screen of the Graphics Designer (Page 234)

3.4.5.9 The Color Palette

Introduction
Depending on the selected object, the Color Palette enables fast changes to the line or fill 
color. It provides 16 standard colors and the bottom button provides the option of selecting a 
user-defined color or a color from the global color palette. 

Use color palette
Depending on the selected object, a mouse click on a color in the palette has a different effect: 

● In the case of closed objects (e.g. rectangle), the fill color is changed.

● In the case of open objects (e.g. polyline), the line color is changed.
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● In the case of text objects, the background color is changed.

● If no object has been selected, the selected color is assigned to the background of the 
active process picture.

Button  opens the "Color selection" dialog with two tabs. This offers the ability to assign the 
object with a user-defined color or a color from the global color palette. This requires the "Global 
color scheme" being set to "No" in the object properties under "Display". More information on 
this is found in chapter "How to work with user-defined colors". 

You can move the color palette as you wish on the screen and show or hide it with "View > 
Toolbars". 

See also
How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

How to work with user-defined colors (Page 272)

"Colors" Property Group (Page 441)

The Start Screen of the Graphics Designer (Page 234)

3.4.5.10 The Font Palette

Introduction
The most important text characteristics are easy to change using the Font Palette. The Font 
Palette allows changes to the font, font size, font color and line color.

The Font Palette can be shown or hidden using "View", "Toolbars"; it can be moved to any 
position on the screen.

Other text characteristics such as text in italics or bold print are set in the Object Properties 
window.

Note

The default settings of text characteristics can be changed for any text object. You can change 
the default settings via the object properties, see chapter "The basic settings of the Graphics 
Designer". Or you change the default setting via the font palette: First select a text object in 
the Object Palette, then change the properties in the Text Palette and insert the text object. 
The changed text characteristics then apply to all other objects of the same type.
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See also
How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

Managing the default settings of objects (Page 267)

"Font" Property Group (Page 446)

3.4.5.11 The Tag Palette

Introduction
The Tag Palette enables fast linking of process tags to objects. 

The Tag Palette can be shown or hidden using "View", "Toolbars". The Tag Palette can be 
moved to any position on the screen. The default setting is that the Tag Palette is hidden.

Contents
The Tag Palette has the same layout as an Explorer window. The Tag Palette contains a list 
of all of the tags available in the project as well as a list of the internal tags. Filters can be set, 
the view can be changed, and an update of the connections is possible.

With the mouse button pressed, the tags in the right-hand window can be dragged to attributes 
of an object in the "Object Properties" window.

See also
The Start Screen of the Graphics Designer (Page 234)

Basic Dynamic Operations (Page 407)

Selecting a tag (Page 608)

You can link the tag connection of objects (Page 418)

How to Arrange the Toolbar and Palettes (Page 276)

How to Show and Hide the Toolbar and Palettes (Page 275)
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3.4.5.12 The Status Bar

Introduction
The status bar is laid out in accordance with the Windows standard and it contains useful 
information. 

The status bar can be shown or hidden using "View", "Toolbars".

Contents

● Tip: Pressing the <F1> key shows tips related to the currently active window.

● Language: The language currently selected in the Graphics Designer is displayed.

● Object name: The name of the selected object is displayed. If a number of objects have 
been selected, "Multiple Selection" is displayed.

● Coordinates of the selected object         
Example: X:0 Y:0 means that the object origin of the selected object is located at the very 
top left in the picture; see chapter "The coordinate system of a process picture". The values 
are updated automatically during the movement of an object, thus making exact placement 
easier.

● Size of the selected object         
Example: X:70 Y:40 means that the selected object is 70 pixels wide and 40 pixels high. 
The values are updated automatically during the size change of an object, thus making 
exact scaling easier.

● Keyboard Settings         
UE: <CAPS LOCK> was pressed, the text will be entered in capital letters.         
NUM: <NUM> was pressed; numeric keypad is activated.         
RE: <SCROLL LOCK> was pressed.

See also
How to Show and Hide the Toolbar and Palettes (Page 275)

The Coordinate System of a Process Picture (Page 228)

The Coordinate System of an Object (Page 230)

The Start Screen of the Graphics Designer (Page 234)
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3.4.6 The Central Color Palette

3.4.6.1 The central color palette

Introduction
In WinCC, you can work with a central color palette. This requires assigning certain index 
colors of your choice. You can then not only assign explicit colors but color indices from the 
central color palette as well in the Graphics Designer. 

Central color palette for objects
If you use the central color palette, you can change the colors in many objects at the same 
time with just a few steps. Prerequisites for this are: 

● "WinCC Classic" is not set as the global design.

● The central color palette is defined.

● The "Global color scheme" is set to "No" in the object properties under "Display".

● Colors from the central color palette are selected in the object properties.

As soon as you change the central color palette in the project settings, it affects those object 
elements in the objects that have colors assigned from the central color palette. 

Note

The central color palette may contain a maximum of 10 color areas each with 20 colors. It 
does not have to be fully defined. 

Working with palettes 
You have the following options with color palettes: 

● Create color palette         
WinCC does not initially provide a central color palette. You create the color palette yourself. 

● Edit color palette         
You can add or change colors in the color palette at any time.

● Use color palette         
When selecting the color for an object element, you can select a color index from the central 
palette.

● Delete color palette         
You can delete an existing color palette.

● Export color palette         
You can export the color palette from your project as an XML file.

● Import color palette         
You can import a color palette into your project from elsewhere.
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See also
How to define the central color palette (Page 249)

How to export and import color palettes (Page 251)

"Colors" Property Group (Page 441)

3.4.6.2 How to define the central color palette

Introduction
The central color palette contains indices for assigning certain colors. If you change the central 
color palette, you also change all of the indexed colors from the central color palette used in 
the objects along with it. 

The central color palette is divided into a maximum of 10 color ranges of 20 colors each. 

Note

The central color palette does not have to be completely defined.

In order to edit a central color palette, proceed in the same way as for defining the palette. 
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the 

Properties command in the pop-up menu.
The "Project properties" dialog opens.

2. Click on "Edit" on the "Surface & Design" tab next to "Central color palette".
This will open the "Color selection" dialog box.

3.
Click on  "Add color range".
The 20 square boxes of the color palette fill with numbers, the color indices.

4.
Click on  "Rename color range" and instead of the automatic name definition, enter a 
name that means something to you.

Creating Process Pictures
3.4 Elements and Basic Settings of the Graphics Designer

MDM - WinCC: Working with WinCC
250 System Manual, 11/2008,  



5. Define the desired color by moving the three scroll-bars for red, green and blue to the 
desired values.
Alternative procedures: 

– Click on the color square or in the color circle and define the brightness on the scale.

– Enter the RGB value directly or via the HTML code.

6. Determine the transparency of the color.

7. Click on the "To palette" button and then in the respective box.
The color is transferred to the box.

8. Repeat steps 3 and 5 until the color range is full.

9.
Click on  "Add color range", to open the next color range and repeat steps 2 to 6 for 
this area.

10.Repeat step 7 until you have defined all required color ranges.

11.Confirm with "OK".

Results
The central color palette is defined. If you have changed the central color palette, all of the 
colors selected from the central color palette are also changed in the objects. 

See also
How to work with user-defined colors (Page 272)

The central color palette (Page 248)

3.4.6.3 How to export and import color palettes

Introduction
The central color palette contains indices that are assigned to certain colors. If you change the 
central color palette, you also change all indexed colors used in the objects from the central 
color palette. 

The central color palette is subdivided into a maximum of 10 color areas each with 20 colors. 

Note

The central color palette does not need to be fully defined.

You can make a central color palette that you have created available to another project by 
exporting or you can import the palette from another project into your project. To export or 
import a color palette, proceed as follows: 
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Procedure
1. Click the project name in the navigation window of the WinCC Explorer and select the 

Properties command in the pop-up menu.
The "Project properties" dialog will open.

2. On the "User Interface and Design" tab, click "Edit" next to "Central Color Palette".
The "Color Selection" dialog box opens.

3.
To export the current central color palette, click on  "Export palette".

4. Enter the path and name of the XML file in the dialog and confirm with "OK".
The color palette is exported. 
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5.
To import a palette, click on  "Import palette", select the desired XML file in the file 
selection dialog and click "Open".
The dialog box for importing the palettes appears.

6. Select one of the three options.

Note

If the attachment of the imported palette exceeds the total maximum number of colors, 
the excess colors will not be imported.

The palette is imported.
All indexed colors, i.e. those selected from the central color palette, are then automatically 
changed in the objects. 

Attaching a Color Palette That is Too Large
The following example shows the attachment of a color palette that is too large.

Example:

Your palette has five color areas, i.e. 100 indexed colors. You want to import a color palette 
with seven color areas, i.e. 140 indexed colors.

Result:

The first five color areas of the palette to be imported are imported; the last two color areas of 
the palette are not imported.

See also
The central color palette (Page 248)
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3.4.7 The Basic Settings of the Graphics Designer

3.4.7.1 The Basic Settings of the Graphics Designer

Introduction
The following basic settings of the Graphics Designer can be customized:

● Displaying and setting the grid

● Displaying and setting the menu and the toolbars

● Visibility and zoom factors of the individual layers

● Default objects configuration

● General settings and options

Opening the "Settings" window
In the menu bar, select "Extras" and click "Settings...". The window with the tabs for the various 
setting options opens.         
    Alternatively, you can also open the window using the entries "Grid" or "Layers" in the "View" 
menu.

See also
Elements and Basic Settings of the Graphics Designer (Page 228)

Customizing the Working Environment (Page 271)

Working with Layers (Page 290)

Changing the default trigger (Page 269)

Managing the default settings of objects (Page 267)

Showing and hiding layers and objects (Page 264)

Customizing Menu and Toolbars (Page 262)

Making layers invisible (Page 260)

This is how you set the options (Page 256)

How to Set the Grid (Page 254)

3.4.7.2 How to Set the Grid

Introduction
To enable exact work, you can make a background grid appear. If required, you can enable 
the option "Snap to grid". Then, all objects that are created or moved are automatically aligned 
to the grid.
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Showing the grid and aligning to the grid can be set via the Standard Toolbar. The grid width 
is set via the basic settings of the Graphics Designer.

The set grid properties are not saved with the process picture. When opening again or when 
a new picture is created, the default settings of the program are used once again. 

Opening the "Settings" window
In the menu bar, select "Tools" and click "Settings...". The window with the tabs for the various 
setting options opens. Click the "Grid" tab.         
Alternatively, you can also open the window using the entries "Grid" or "Layers" in the "View" 
menu.

Snap to Grid
If the check box is enabled, objects are aligned to the grid points when they are created, 
inserted and moved. Objects that have already been created are only aligned to the grid when 
they are moved.

Display grid
When the check box is enabled, the grid points are shown. 
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Width in pixels
Horizontal spacing of the grid points. Maximum distance: 100 pixels

Height in pixels
Vertical spacing of the grid points. Maximum distance: 100 pixels

With a large grid width, objects are aligned to the left or upper grid points, as the case may be.

Alternative Procedure
All grid properties can be changed in the "Object Properties" window of the active process 
picture. The color of the grid can also be changed there.

Note

The minimum grid spacing that can be displayed on the screen is 10 pixels. If you want to 
set a smaller value, you can align objects to this grid. On the screen, however, the grid spacing 
displayed is the first multiple of the grid value that is greater than or equal to ten.          
Example: You set 6 pixels as grid spacing; a grid or 12 pixels is shown on the screen. Objects 
can be placed on one grid point or between two grid points. 

See also
How to insert an object into a picture (Page 382)

The Standard Toolbar (Page 236)

The Basic Settings of the Graphics Designer (Page 254)

3.4.7.3 This is how you set the options

Introduction                  
Different program settings can be changed and saved. 
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Opening the "Settings" window
In the menu bar, select "Tools" and click on "Settings...". The window with the tabs for the 
various setting options opens. Click on the "Options" tab.

Save settings on exit
If this check box is enabled, the changes you have made in the "Settings" window are saved 
when you exit from the program. If the check box is disabled, the changed settings are lost. 
The default setting is that the check box is enabled.

Note

The "Save settings on exit" check box must be enabled for the settings in this dialog to be 
retained when you exit from the program.

Issue performance warnings
Cyclic triggers can lead to a high system load.
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If the check box is enabled, a warning is issued in the event of a system overload as soon as 
the picture is to be saved. This warning contains the name of the object and the attribute that 
has been made dynamic and has led to the overload. If the check box is disabled, you do not 
receive a warning, i.e. also no indication of the cause of the overload. The default setting is 
that the check box is enabled.

Display effect of the faceplate type change on the dynamic properties
If the check box is selected, the "Faceplate instances with type change" dialog box is shown 
with all faceplate instances that are to be checked. The dialog box opens when you want to 
save a picture with faceplate instances that are affected by changing type-specific properties 
and events. You can use this dialog box to hide the red crosses over invalid faceplate instances.

VBA events
If the check box is enabled, the configured VBA events to monitor the VBA actions is not 
triggered. The default setting is that the check box is disabled.

Use configuration dialog
If the check box is activated, the "Configuration Dialog" window opens automatically if the 
inserted object has a configuration dialog.

Objects with configuration dialog:

● Smart objects: Control, I/O field, bars, graphic object, status display, text list

● Windows objects: Button, slider object

If the check box is not enabled, the objects are inserted with the default settings.

Independent of whether the check box is enabled, the configuration dialog can be opened at 
any time via the context-sensitive menu. Right-click the object and select the entry 
"Configuration Dialog..." in the shortcut menu.

Display tips and tricks
If the check box is enabled, every time the Graphics Designer is started a tip on creating or 
optimizing process pictures is displayed. The default setting is that the check box is disabled; 
no tips and tricks are displayed when the program is started.

Object selection
Objects can be selected by clicking or by drawing a selection border. This selection border is 
also referred to as a 'lasso'. You can specify whether the lasso must fully enclose the objects 
or whether contact with the lasso is sufficient to select an object.

With the Option "Surrounding", the complete objects must lie in the selection border (lasso); 
with the Option "Touching", it is sufficient that an object touches the selection border (lasso). 
The default setting is that the "Surrounding" option is selected.
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Editing properties
Attributes of objects can be changed via the object properties. Whether a value can be entered 
directly in the "Object Properties" window or whether a dialog box is to be opened is specified 
using the "Edit Properties - Edit Directly".

If the check box is enabled, the value of an attribute can be changed by double-clicking on the 
attribute in the "Object Properties" window. If the check box is not enabled, double-clicking 
opens a window for value input. The default setting is that the check box is enabled; digits and 
text can be entered directly in the "Object Properties" window. 

OCX display
If the check box is activated, ActiveX controls in the Graphics Designer are shown in your 
activated look. Setting the OCX representation only has an effect when process pictures are 
being created, not in Runtime. The default setting is that the representation of ActiveX Controls 
is enabled.

Copy and paste objects
If the option "In active layer" is selected, copied objects are pasted into the active layer, 
independent of the layer from which they have been copied.

If the option "in present layer(s)" is selected, copied objects are inserted into the layer from 
which they were copied. If a number of objects are selected and copied from different layers, 
each individual object retains the layer to which it was allocated.

Always reset object type selection
If the check box is enabled, the mouse pointer turns back into the selection mouse pointer 
after an object has been inserted. However, if you want to insert a number of objects of the 
same type, you can disable the check box. Then, the active object type remains active after 
an object has been inserted, and the same object can be quickly inserted a number of times. 
You then do not have to reselect the object type for each object to be inserted. The default 
setting is that the check box is enabled.

Note

The "Save settings on exit" check box must be enabled for the settings in this dialog to be 
retained when you exit from the program.
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See also
How to select an object (Page 385)

Changing the default trigger (Page 269)

Customizing Menu and Toolbars (Page 262)

The Layer Palette (Page 242)

Working with Layers (Page 290)

Working with Objects (Page 378)

The Basic Settings of the Graphics Designer (Page 254)

3.4.7.4 Making layers invisible

Introduction
You can make the individual layers of a picture visible or invisible. This shows or hides the 
objects of the various layers. The settings can be made independently of one another for CS 
(Configuration System) and RT (Runtime). 

When a picture is opened, all layers in the Configuration System are always visible. The 
settings for which layers were invisible for the last processing are not saved when you exit 
from the Graphics Designer.         
The settings for Runtime can be saved with the corresponding setting in the "Options" 
tab.          
    The independent visibility of layers in CS and RT has advantages: You can store more 
information in the picture than is to be visible in Runtime.

Double-click a layer to rename it.
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Opening the "Settings" window
In the menu bar, select "Extras" and click "Settings...". The window with the tabs for the various 
setting options opens. Click on the "Visible Layers" tab.

Layers window
You can make the individual layers of a picture visible or invisible. When the check box is 
enabled, the corresponding layer is visible. The active layer always remains visible.

All layers visible / invisible
Clicking on one of the buttons makes all layers visible or invisible. If you click "All layers hidden", 
only the active layer remains visible. Depending on the setting "Apply to", the buttons change 
the layers in the CS and/or in RT. The active layer always remains visible.

Language
You can change the names of the layers for each language. Set the language and rename the 
layers in the 'Layers' window.
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See also
Showing and hiding layers and objects (Page 264)

The Layer Palette (Page 242)

Working with Layers (Page 290)

Working with Objects (Page 378)

The Basic Settings of the Graphics Designer (Page 254)

3.4.7.5 Customizing Menu and Toolbars

Introduction
The view of the Graphics Designer can be changed Buttons can be shown as three-
dimensional or flat, or keyboard shortcuts can be displayed in the menus. 

Whereas the menus always comprise all entries, you are completely free to configure the 
standard toolbar as you like. 

The settings that can be made here are program settings that are independent of individual 
process pictures and are retained when you exit from the program.
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Open the "Menu / Toolbars" tab
In the menu bar, select "Tools", "Settings" and click the "Menu / Toolbars" tab.

Flat style for toolbars
If the check box is enabled, all buttons are shown as flat. Alternatively, they are shown as three-
dimensional.

Display move handles
Handles are displayed beside or above toolbars, if the check box is activated. These handles 
are used to grip the toolbar if it is to be moved on the screen. When the check box is disabled, 
the handles are not shown.

Deactivated buttons in color
If the check box is enabled, both active and inactive buttons are displayed in color. Alternatively, 
only the active buttons are displayed in color.
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Standard Toolbar - Configurable
If the check box is enabled, the Standard Toolbar is configurable, and the "Drag&Drop with 
ALT key active" check box can be enabled. Alternatively, the toolbar can not be configured, 
but it remains movable.          
The configuration dialog for the standard toolbar is described in chapter "Changing the 
Standard Toolbar".

Standard Toolbar - Drag&Drop with ALT key active
If the check box is enabled, the icons can be shifted within the Standard Toolbar. To do so, 
hold the <ALT> key and drag the icon to be moved to the desired position.

Display buttons in the menu
If the check box is enabled, the icons of the Standard Toolbar are shown to the left of the menu 
entries. Alternatively, only the text appears in the menus.

Display all shortcuts
If the check box is enabled, all the possibilities for input via the keyboard are displayed to the 
right of the menu entries. Alternatively, only the most important keyboard shortcuts appear in 
the menus. For example, copying an object in the clipboard can be made by means of two 
different key combinations: In accordance with the Windows standard, by pressing the <CTRL
+C> key combination or by pressing <CTRL> and <0> on the numeric keypad.

See also
How to Change the Standard Toolbar (Page 277)

How to Show and Hide the Toolbar and Palettes (Page 275)

How to Arrange the Toolbar and Palettes (Page 276)

The Standard Toolbar (Page 236)

The Basic Settings of the Graphics Designer (Page 254)

3.4.7.6 Showing and hiding layers and objects

Introduction
Whether layers and objects are shown or hidden can be made dependent on the current zoom 
factor. For example, it is possible to show details as of a certain zoom factor and not before. 
Each layer can be assigned its own minimum and maximum zoom. It is also possible to show 
only objects whose display size lies within a defined range.

The settings in this tab dialog are retained when you exit from the program if the "Save settings 
on exit" check box is enabled in the "Options" tab.
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Opening the "Settings" window
In the menu bar, select "Extras" and click "Settings...". The window with the tabs for the various 
setting options opens. Click on the "Show/hide" tab.

Setting zoom ranges for individual layers
Double-click the digits in the columns "Min Zoom" or "Max Zoom" to set the zoom range in 
which the contents of a layer is to be displayed. The zoom range is specified in %. Minimum 
value is 2%, maximum value is 800%.         
Activate the "Activate - Planes" chec-box".

Note

If you have set the zoom ranges for the layers and want to zoom into the process picture 
when processing, disable the "Activate - Layers" check box. The set zoom ranges for the 
layers are disabled, but are retained, and you see all the details of your picture.

Example:
The coarse display lies on Layer 8; the detail display of an area lies on Layer 10. Layer 8 is 
displayed in the zoom range between 80% and 800%; Layer 10 is displayed in the zoom range 
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between 100% and 800%, see above picture. With this setting, the details of Layer 10 are only 
shown when the user zooms in to the picture by over 100%.

Setting the size range for the display of objects
If objects are only to be displayed in the range between a minimum and maximum display size, 
you can define the size range. The display size is independent of the object size: An object is 
shown within the zoom factors that show the object in the set size.

Enable the "Object Size" check box and enter the minimum and maximum size in pixels. When 
you confirm this input with OK, only objects in this display size are displayed.

Note

If you have set the display size and want to zoom into the process picture when processing, 
disable the "Activate - Object Size" check box. The "Object Size Settings" are disabled, but 
are retained, and you see all the details of your picture.

Adopting selected zoom value for all layers
If you want to change the zoom range for all layers, set it in the upper window for a layer and 
click the "MinZoom" or "MaxZoom" button. The layer from which the zoom ranges are to be 
adopted must be selected. Enable the "Activate - Layers" check box to receive a display of the 
settings.
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See also
Making layers invisible (Page 260)

The Zoom Palette (Page 243)

The Layer Palette (Page 242)

Working with Layers (Page 290)

Working with Objects (Page 378)

The Basic Settings of the Graphics Designer (Page 254)

3.4.7.7 Managing the default settings of objects

Introduction
In the Graphics Designer, the various object types have default properties. If an object from 
the Object Palette is inserted in a picture, the object adapts to these default settings.

Working with default objects
The default setting for the individual object types can be adapted as required. Ideally, the 
default settings should be adapted before you begin creating a process picture. That way, the 
extent of later adaptations, for example for frequently used objects, can be limited.         
    If you are illustrating a complex process and require a great many process pictures with the 
same object settings, it is recommended that you create a "master picture". You define the 
object settings in this master and use it as a template for all individual process pictures.

All the information on default setting for object types is contained in a file of the format PDD. 
As standard, the file "Default.pdd" is in the graphic folder "GraCS" of each project. You can 
use the "Default Objects Configuration" tab in the "Settings" dialog to select the following 
options for default settings of object types:

● The default settings can be saved immediately or also automatically on exiting from the 
Graphics Designer.

● The default settings of another project can be loaded into the current project.

● The file name and the directory path for storing the PDD file can be changed.
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Opening the "Settings" window
In the menu bar, select "Extras" and click "Settings...". The window with the tabs for the various 
setting options opens. Click on the "Default Objects Configuration" tab.

Saving default settings of objects
1. In the field "File" click the button .         

The dialog "Default objects" will open.

2. Select the PDD file in which you want to save the changes and confirm your selection with 
"OK".         
By default, the PDD file of a project is stored in the graphic folder "GraCS".

3. In the "Save" field, click the "Save Now" button.         
The changed default settings are saved in the selected PDD file.

4. Enable the "Save Configuration on Exit" check box if you want the default object 
configuration to be saved when you exit from the Graphics Designer.
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Loading default settings of objects
1. In the field "File" click the button .         

The dialog "Default objects" will open.

2. Select the PDD file, which you would like to load and confirm your selection with 
"OK".         
By default, the PDD file of a project is stored in the graphic folder "GraCS".

3. Click on the button "Load now".         
The default objects configuration is imported from the selected PDD file into the current 
project.

4. You can now save the loaded default settings in the current project directory:         

    In the field "File" click the button .         
he dialog "Default objects" will open.

5. Select the PDD file of the current project and confirm your selection with "OK".

6. In the "Save" field, click the "Save Now" button.         
The imported default settings of the objects are saved in the PDD file of the current project.

Note

The default settings for objects do not apply across all projects. The changed default settings 
only apply to the pictures of the currently opened WinCC project. The basic settings of the 
Graphics Designer are not changed here.

See also
Changing the default trigger (Page 269)

How to Change an Attribute (Page 434)

How to change the default setting of object types (Page 379)

The Object Palette (Page 238)

The Properties of an Object (Page 423)

The Basic Settings of the Graphics Designer (Page 254)

3.4.7.8 Changing the default trigger

Introduction
The set trigger specifies the update cycle in Runtime. Each attribute of an object that has been 
made dynamic can be assigned an individual update cycle. The value you specify for the default 
trigger is the default update cycle for all objects. If, for example, you want to have a lot of 
objects updated in a cycle of 2 seconds, set the default trigger to 2 s. You then no longer need 
to change the trigger setting for tag connection of the individual attributes.
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Opening the "Settings" window
In the menu bar, select "Extras" and click "Settings...". The window with the tabs for the various 
setting options opens. Click on the "Default Objects Configuration" tab.

Selecting the default trigger
Open the dropdown list box and select a value.

Picture cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update 
Cycle of the picture object. This cycle provides the option of defining the cycles of all the 
actions, tag connections and dynamic dialogs used in a picture centrally.

Window Cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update 
Cycle of the Picture Window object. This values applies to all actions, tag links and dynamic 
dialogs, which were configured with the trigger type "Window cycle".
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Upon change
This trigger updates the object every time a change is made. In the case of external tags, there 
might be a brief delay; internal tags lead to an immediate update.

Time values (250 ms - 1 h)
This trigger updates the object in the set cycle.

User cycle (1 - 5)
You can set this trigger any way you like.         
Define user cycles: 

1. Click in the navigation window of the WinCC Explorer with the right-hand mouse button on 
the project (top entry). 

2. In the context-sensitive menu, select the entry "Properties". 

3. Select the "Update Cycles" tab. 

4. Select one of the user cycles and redefine it.

You have to restart the Graphics Designer to make your individual user cycles available.

Note

The shorter the set update cycles, the higher the system load. To prevent an overload, the 
update should not take place more often than necessary.

See also
How to change the default setting of object types (Page 379)

Managing the default settings of objects (Page 267)

Trigger Types (Page 819)

Quick Object Configuration (Page 606)

The Basic Settings of the Graphics Designer (Page 254)

3.4.8 Customizing the Working Environment

3.4.8.1 Customizing the Working Environment

Introduction
The Graphics Designer provides a great many possibilities to customize the working 
environment. For example, you can change the toolbar and palettes. You can define your own 
colors and change the basic settings of the program.
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Please bear in mind that the default setting of the Graphics Designer is such that changes to 
the working environment are saved when you exit from the program. If you do not want to save 
the settings, open the "Extras" menu, then "Settings..."; select the "Options" tab and disable 
the "Save settings on exit" check box. 

See also
Elements and Basic Settings of the Graphics Designer (Page 228)

The Basic Settings of the Graphics Designer (Page 254)

The Start Screen of the Graphics Designer (Page 234)

How to Change the Standard Toolbar (Page 277)

How to Arrange the Toolbar and Palettes (Page 276)

How to Show and Hide the Toolbar and Palettes (Page 275)

How to work with user-defined colors (Page 272)

3.4.8.2 How to work with user-defined colors

Introduction
In addition to the 16 basic colors from the Color Palette, you are free to use other colors and 
assign them to objects. You can either define and use other colors directly or you can select 
a color from the central color palette. 

The central color palette must be created first. 
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Define color yourself
1. On the Color Palette, click . This will open the "Color selection" dialog box.

2. Define the desired color using the color square, the color circle and the scrollbars or enter 
the value directly on the "Colors" tab.
The currently selected color is displayed in the preview window. 

3. The new color is assigned to the currently selected element of the picture by pressing the 
"OK" button. This changes:

– With a closed object: The fill color

– With an open object: The line color

– With a text object: The background color

– If no object is selected: The background of the active process picture.

This requires the "Global color scheme" being set to "No" in the object properties of the 
respective object under "Display". 
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Select color from central palette
1. On the Color Palette, click . This will open the "Color selection" dialog box.

2. Select a color range and a palette color on the "Palette" tab.

3. The new color is assigned to the currently selected element of the picture by pressing the 
"OK" button. This changes:

– With a closed object: The fill color

– With an open object: The line color

– With a text object: The background color

– If no object is selected: The background of the active process picture.

Note

This requires the "Global color scheme" being set to "No" in the object properties of 
the respective object under "Display".

Change color centrally
If you have selected a color from the central color palette, this color is changed automatically 
if also changed on the color palette. 
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See also
Customizing the Working Environment (Page 271)

"Colors" Property Group (Page 441)

The Color Palette (Page 244)

How to define the central color palette (Page 249)

3.4.8.3 How to Show and Hide the Toolbar and Palettes

Introduction
The default setting of the Graphics Designer is such that all toolbars and palettes are shown, 
except for the Tag Palette. To enlarge the desktop, you can hide toolbars that you do not 
require and show them again if required.

Procedure
1. Open the "View" menu and select the "Toolbars..." option. The "Toolbars" dialog is opened.

2. If the check box is enabled, the corresponding toolbar is displayed; if the check box is 
disabled, it is not displayed.

3. The "Apply" button shows the new settings; the "Restore" button restores the default setting.

4. Save the new settings with "OK". The dialog is closed.

Note

After processing an OLE object, it can occur that the toolbars of the Graphics Designer are 
no longer displayed. You can prevent this error after processing an OLE object if you first 
close the server application (for example Excel or Paint) before exiting the Graphic Designer.

 

To restore the display of toolbars, proceed as follows:

1. Select all of the objects available in the active picture.

2. Open the "View" menu and select the "Toolbars..." option.

3. In the "Toolbars" dialog, click the "Restore" button.

See also
How to Arrange the Toolbar and Palettes (Page 276)

How to Change the Standard Toolbar (Page 277)

The Standard Toolbar (Page 236)

Customizing the Working Environment (Page 271)
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3.4.8.4 How to Arrange the Toolbar and Palettes

Introduction
The Standard Toolbar and the palettes are originally arrange at the border of the screen. You 
can move them to another position or drag them as windows on the desktop.

Special features
● The size of a palette can only be changed if it is located as a window on the desktop.

● If you move a palette from the workspace back to the border of the screen, its size is not 
adapted to the free space. For this reason, you should set the palette size to the size of the 
free space before the move.

● The default setting is such that the changed view is saved when you exit from the Graphics 
Designer. If you do not want to save the settings, open the "Extras" menu, then "Settings..."; 
select the "Options" tab and disable the "Save settings on exit" check box.

Note

If you have greatly enlarged individual palettes and then moved them to the border of the 
screen, your desktop might be too small to drag the palette back onto it to reduce its size. By 
double-clicking on the palette title, you detach the palette from the border of the screen. It is 
displayed as a window and you can reduce its size.

Moving a palette as a window on the desktop
Click on the border or on the handle of the palette; keep the left mouse button pressed and 
drag the palette on the desktop. The size of some palettes can now changed.

Moving a palette to the screen border
Click on the title bar of the palette; keep the left mouse button pressed and drag the palette to 
the border of the screen. If you want to change the size of the palette, convert it back into a 
window by double-clicking on the palette title, change the size, and move it back to the border.

Restoring the original view
The original view can only be restored as long as the Graphics Designer has not saved the 
current settings on exit, see above.

1. Open the "View" menu and select the "Toolbars..." option. 

2. Click on the "Restore" button.
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See also
How to Show and Hide the Toolbar and Palettes (Page 275)

How to Change the Standard Toolbar (Page 277)

The Standard Toolbar (Page 236)

Customizing the Working Environment (Page 271)

3.4.8.5 How to Change the Standard Toolbar

Introduction
The Standard Toolbar can be customized. Buttons can be added, shifted or removed.

Requirements
● The Standard Toolbar must be configurable. To enable this, open the "Extras", "Settings..." 

menu, then the "Menu / Toolbars" tab and enable the check boxes of the Standard Toolbar. 
"Configurable" means that the Configuration Dialog for the Standard Toolbar can be 
opened. "Drag&Drop with ALT key active" means that the buttons can be shifted directly. 

Changing the Standard Toolbar with the Configuration Dialog
Keep <ALT> pressed and double-click the Standard Toolbar. The "Customize Toolbar" window 
opens. Here you can add and remove buttons and change the order of the buttons on the 
toolbar.         
    To restore the original toolbar, click "Reset".

Changing the Standard Toolbar with drag&drop
Hold <ALT> pressed and drag an icon to the desired position with the mouse. To remove a 
button from the toolbar, let go of the button outside the toolbar.
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Restoring the Standard Toolbar
If you have inadvertently removed buttons, you can simply restore the Standard Toolbar. In 
the menu bar, click "View" and "Toolbars". In the "Toolbars" window, click the "Restore" button.

See also
How to Arrange the Toolbar and Palettes (Page 276)

Customizing the Working Environment (Page 271)

The Standard Toolbar (Page 236)

How to Show and Hide the Toolbar and Palettes (Page 275)

3.5 Working with Pictures

3.5.1 Working with Pictures

Introduction
In Graphics Designer, a picture is a file in the form of a sheet of drawing paper. The size of 
the drawing sheet can be adjusted. A drawing sheet has 32 layers, which can be used to 
improve the organization of the drawing. The files are saved in the project directory, GraCS, 
in the PDL format. The complete process can be distributed over several individual pictures, 
which are linked together. Retrievals of other applications and files can also be included in a 
process picture.

The more complex the configured process is, the more detailed the planning should be. 
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Project Planning Notes
● Plan the structure of the process display: How many pictures are required in which 

hierarchy?         
Example: subprocesses can be shown in individual pictures, which are then merged into a 
main picture.

● Plan the navigation within a picture and between the individual pictures: Operating 
sequence, buttons and hotkeys should be uniform in all pictures.

● Create a Master picture in which the picture properties, default settings and object settings 
are defined. This Master picture should then be used as the template for each individual 
picture.

● Use the program functions: Process pictures can be efficiently created by using libraries, 
copying and transferring properties and by working with layers and multiple pictures.

● To avoid changes in the picture layout, make certain that each picture is displayed - during 
the design phase - at the same size that it later will be displayed on the target computer.

● To avoid changes in the picture layout, make certain that you only use fonts that are also 
available on the target computer.

Note

If you save a process picture, the system creates a backup in file format "*.sav" in the 
project folder in the GraCS directory. In order to restore the process picture from the 
backup, change the file format from "*.sav" to "*.pdl". 

If you save a Faceplate type, the system creates a backup in file format "*.saf" in the 
project folder in the GraCS directory. In order to restore the  Faceplate type from the 
backup, change the file format from "*.saf" to "*.fpt".
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See also
Working with Objects (Page 378)

Working with Multiple Pictures (Page 295)

Working with Layers (Page 290)

How to set the picture properties (Page 288)

How to export graphics (Page 287)

How to convert pictures (Page 286)

How to Delete a Picture (Page 284)

How to Rename a Picture (Page 282)

How to Copy the Picture (Page 282)

How to open a picture (Page 281)

How to save the pictures (Page 281)

How to create a new picture (Page 280)

3.5.2 How to create a new picture

Introduction
Depending on the selected method of working, you will either create a new picture using the 
default settings or take your Master picture and save this under a new file name. The advantage 
of working with a master picture is that all of the changes that you make while creating it will 
then be kept consistently throughout the project.

Creating a New Picture
In Graphics Designer, either select "New" in the "File" menu or click the Windows symbol 

. A new picture will be created with the default settings.

You can also create a new picture by using the pop-up menu in WinCC Explorer's navigation 
window. 

See also
Working with Pictures (Page 278)

How to set the picture properties (Page 288)

How to save the pictures (Page 281)
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3.5.3 How to save the pictures

Introduction
Files are saved in Graphics Designer in the usual Windows manner.

Procedure
● An active picture can either be saved via the button , with the menu entry "File", "Save", 

or with the key combination <CTRL+S>.

● To save the active picture under a new file name, select "Save As" in the "File" menu.

● To save all of the open pictures, select "Save All" in the "File" menu.

See also
Working with Pictures (Page 278)

How to Copy the Picture (Page 282)

3.5.4 How to open a picture

Introduction
Picture files are opened in Graphics Designer in the usual Windows manner.

Opening Picture
Click on the button  in the Graphics Designer or select the entry "File", "Open" in the menu 
bar. Select a PDL format file.

You can also open a picture in WinCC Explorer by double-clicking on a PDL format file. This 
will start Graphics Designer, if necessary, and then open the picture.

Note

Pictures may only be opened and edited in Graphics Designer. Pictures may not be opened 
in Windows Explorer or any similar program.

See also
Working with Pictures (Page 278)
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3.5.5 How to Copy the Picture

Introduction
If you want to transfer the settings that you have made in a picture to another one, simply save 
the old picture under a different name and delete or change the new picture's contents.

Saving a picture under a different name
To do this, select "Save As..." from the "File" menu. Enter a new file name in the windows 
"Save as". 

Note

It is not possible to copy a picture and then insert it with a different file name in WinCC 
Explorer. To accomplish this, use Windows Explorer. 

If you copy a picture created with the SIMATIC Manager using "Save As", you may rename 
or delete this copy in WinCC Explorer. This also applies to WinCC pictures created in WinCC 
and subsequently imported into SIMATIC Manager by using the function "Import WinCC 
Object".

Note

If you rename a picture in the WinCC Explorer, you use a picture name once only. The 
software does not check for whether the new name already exists. Doubled picture names 
can lead to conflicts in accessing via VBA or in making dynamic.

See also
How to open a picture (Page 281)

How to Delete a Picture (Page 284)

How to Rename a Picture (Page 282)

Working with Pictures (Page 278)

3.5.6 How to Rename a Picture

Introduction
A picture can only be renamed in WinCC Explorer.         
Of course, you can save a picture with a different name; but the picture will still be in the project 
directory with its old file name.
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Rename picture
Close the picture that you want to rename.          
Start the WinCC Explorer and right-click the picture.          
Select the entry "Rename picture" in the pop-up menu and enter a new name.

Note

If you rename a picture in the WinCC Explorer, you use a picture name once only. The 
software does not check for whether the new name already exists. Doubled picture names 
can lead to conflicts in accessing via VBA or in making dynamic.

Note

If you create pictures using the SIMATIC Manager, these cannot be renamed in WinCC 
Explorer. This also applies to WinCC pictures created in WinCC and subsequently imported 
into SIMATIC Manager by using the function "Import WinCC Object". You can recognize these 
pictures from the "Created by SIMATIC Manager" entry in the Information column of the data 
window.
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See also
How to Copy the Picture (Page 282)

How to open a picture (Page 281)

How to Delete a Picture (Page 284)

Working with Pictures (Page 278)

The shortcut menu in the Navigation window (Page 212)

3.5.7 How to Delete a Picture

Introduction
A picture can only be deleted in WinCC Explorer.

Deleting Picture
Close the picture that you want to delete.          
Start the WinCC Explorer and right-click the picture.          
Select the entry "Delete picture" in the pop-up menu and confirm the security inquiry with "OK".
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Note

If you create pictures using the SIMATIC Manager, these cannot be deleted in WinCC 
Explorer. This also applies to WinCC pictures created in WinCC and subsequently imported 
into SIMATIC Manager by using the function "Import WinCC Object".

See also
How to Copy the Picture (Page 282)

How to open a picture (Page 281)

How to Rename a Picture (Page 282)

Working with Pictures (Page 278)

The shortcut menu in the Navigation window (Page 212)
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3.5.8 How to convert pictures

Introduction
Pictures, which were created with an older version of Graphics Designer, can be converted to 
the current version with WinCC Explorer. 

Converting pictures
In WinCC Explorer, right-click "Graphics Designer". The pop-up menu will open.          
Select the entry "Convert pictures" and a confirmation dialog will be displayed. Please observe 
the warnings.          
When you confirm the conversion of the pictures with "OK", all of the project's pictures will be 
converted. It is not possible to convert an individual picture.

NOTICE

Conversion of pictures can not be undone.
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Note

It may take a while to convert the pictures.

See also
The shortcut menu in the Navigation window (Page 212)

Working with Pictures (Page 278)

3.5.9 How to export graphics

Introduction
Graphics can be exported from Graphics Designer in the EMF (Enhanced Metafile) and WMF 
(Windows Metafile) file formats. However, in this case, dynamic settings and some object-
specific properties will be lost, since they are not supported by the graphic formats.

It is also possible to export graphics in the program's own PDL format. However, it is only 
possible to export an entire picture in the PDL format and not individual objects. On the other 
hand, when a picture is exported to a PDL file, the dynamics are retained and the exported 
picture can then either be inserted in a picture window or opened as a file.

Note

We recommend that you check all pictures, which you export for further processing in other 
programs, for both completeness and interpretation errors.

Special features
● Some programs do not use the same graphic filters. It is possible that some programs will 

not be able to open a graphic that was exported from Graphics Designer. Furthermore, 
fonts and object information will also sometimes be incorrectly interpreted by other 
programs. If the screen must appear precisely as it is in Graphics Designer, but your 
program displays it incorrectly, you can solve this problem by making a screenshot.

● When exporting a picture created with the Graphics Designer, all object properties 
dynamics of the individual objects are lost.

Procedure
1. Select the object which should be exported. If you do not select an object, the entire picture 

will be exported.

2. Open the "Tools" menu and select the entry "Settings". The "Save as metafile" window will 
open.         
By default, the file will be saved in the GraCS directory for the WinCC project. However, 
you can of course export the file to a different directory.
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3. Enter the file name.

4. Select the graphic's export file type - EMF or WMF.

5. Confirm your entry by clicking on "Save".

See also
Working with Pictures (Page 278)

3.5.10 How to set the picture properties

Introduction
In Graphics Designer, a process picture is treated as an object and is called a Picture Object. 
It has properties and can be dynamized. The properties and dynamics of the picture can be 
adjusted at any time. If no object has been selected in the picture, the "Object Properties" 
window will display the properties of the Picture Object.

Procedure
1. If the properties of a picture should be changed, make certain that no objects has been 

selected. Open the window "Object properties" by clicking the button  in the toolbar. As 
an alternative, the "Object Properties" window can also be opened via the pop-up menu or 
by selecting "Properties" in the "View" menu.

2. Check whether the properties of the picture are displayed: The entry "Picture Object" must 
be displayed in the object type field at the top of the window. The picture's file name will be 
shown in the drop-down list at the right.

3. The attributes, which are found by clicking on the "Properties" or "Event" tabs, can be 
changed like the attributes of an object. For more information, please see the chapter 
entitled "Change Attributes".

See also
Working with Pictures (Page 278)

The Properties of an Object (Page 423)

The "Object Properties" Window (Page 424)

How to Change an Attribute (Page 434)

Displaying the configured dynamics of a process picture (Page 226)

Displaying the properties of a picture file (Page 224)

How to transfer picture properties to another picture (Page 295)
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3.5.11 How to configure a picture background

Introduction
You can use a picture file as a background for a process picture. The background picture and 
the respective parameters belong to the properties of the picture. 

Insert background picture
1. Make sure that no object is selected in the picture on which you click in the background 

picture. 

2. Open the window "Object properties" by clicking the button  in the toolbar.
As an alternative, the "Object Properties" window can also be opened via the pop-up menu 
or by selecting "Properties" in the "View > Properties" menu. 
The entry "Picture Object" is then displayed in the "Object type" field in the top line of the 
window. 

3. Click on the "Background picture" property.

4. Double click on "Picture". 

5. Select the desired background picture in the "Picture" dialog. 
Use "Find" to open the file selection dialog for loading other pictures into the selection. You 
can use the following file types as backgrounds:          
EMF, WMF, DB, BMP, GIF, JPG, JPEG, ICO. 

6. Select the layout for the background picture after double clicking on "Show as":

– Normal: The background picture is centered in the original size.

– Stretched (window): If the runtime window is larger than the configured process picture, 
the background picture is scaled to the size of the runtime window. Otherwise, the 
background picture is scaled to the size of the process picture.

– Tiled: The process picture is arranged with the picture in the original size.

– Stretched (Picture): The background picture is scaled to the configured size of the 
process picture.

7. Close the Properties dialog.

The current picture is provided with the selected background. 
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Delete background picture
1. Make sure that no object is selected in the picture.

2. Open the window "Object properties" by clicking the button  in the toolbar.
As an alternative, the "Object Properties" window can also be opened via the pop-up menu 
or by selecting "Properties" in the "View" menu. 
The entry "Picture Object" is then displayed in the "Object type" field in the top line of the 
window. 

3. Click on the "Background picture" property.

4. Double-click on the "Picture".

5. Click on "Cancel selection" and confirm with "OK".
The background picture is removed from the picture. 

6. Close the Properties dialog.

3.5.12 Working with Layers

3.5.12.1 Working with Layers

Introduction
In the Graphics Designer, a picture consists of 32 layers in which the objects can be inserted. 
The position of an object in a picture is set when it is assigned to a layer. Objects of the layer 
0 are located at the screen background, while objects of the layer 32 are located in the 
foreground. Objects are always added on the active layer, but can be quickly moved to another 
layer. An object's assignment to a layer can be changed using the "Layer" attribute in the 
"Object Properties" window.

In addition, it is also possible to change the positioning of the objects with respect to each other 
within a layer. Four functions are available for this purpose in the "Arrange / Within the Layer" 
menu. When creating a process picture, the objects of a level are by default arranged in the 
order in which they were configured: The object inserted first lies at the very back of the level, 
each additional object is inserted one position toward the front.

Creating Process Pictures
3.5 Working with Pictures

MDM - WinCC: Working with WinCC
290 System Manual, 11/2008,  



Note

You can define the level to insert a copied object into with the Graphics Designer settings. 
More information on these settings can be found under topic "Create process pictures > 
Elements and basic settings of the Graphics Designer > The basic settings of the Graphics 
Designer > How to set options" in section "Copying and inserting objects".

Layer Techniques - Principles
When a picture is opened, all 32 layers of the picture will be displayed. This setting cannot be 
changed. The layer palette can be used to hide all but the active layer. In this manner, it is 
possible to concentrate on editing the objects of the active layer. Layers are particularly useful 
when preparing pictures that contain many different types of object types.

For example, you could place all of the "Bar" objects on Layer 1 and all of the "I/O Field" objects 
on Layer 2. If you later decide to change the font color of all of the I/O fields, you can now 
display just Layer 2 and then select all of the objects on this layer. The time-consuming 
selection of individual I/O fields scattered throughout the picture is thus unnecessary.
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See also
How to change the default setting of object types (Page 379)

Working with Layers (Page 290)

The Layer Palette (Page 242)

How to change the position of an object (Page 403)

How to use the layers palette (Page 294)

How to assign a layer (Page 293)

This is how you set the options (Page 256)

3.5.12.2 How to assign a layer

Introduction
The "Object Properties" window can be used to assign the layer in which an object will be 
placed. 

Assigning Layers
Select an object and open the "Object Properties" window. Select the object type, double-click 
the "Layer" attribute and enter the number of the desired layer.

Multiple selection
    If several objects from a number of different layers should be moved to a single common 
layer, this can be quickly accomplished by using a multiple selection.         
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Example: There are objects on Layers 2, 5 and 7, which should be moved to Layer 9. Hide all 
of the layers except Layers 2, 5 and 7, select the objects and then assign Layer 9 to the object 
type "Multiple Selection" in the "Object Properties" window. All of the objects will then be moved 
to Layer 9.

See also
How to assign a layer (Page 293)

Making layers invisible (Page 260)

Showing and hiding layers and objects (Page 264)

How to use the layers palette (Page 294)

The Layer Palette (Page 242)

Working with Layers (Page 290)

3.5.12.3 How to use the layers palette

Introduction
With the aid of the Layers palette, it is possible to display only those layers that are actually 
used for editing a picture. Up to 31 layers can be hidden if need be. The active layer remains 
visible.

Making layers visible / invisible
Click on one of the buttons on the Layers palette. When the button is depressed, the 
corresponding layer will be visible. If you click ">>", Layers 16-31 will be displayed; a click the 
"<<" button will display the Layers 0-15.

Select the Active Layer
Open the drop-down list and select an active layer.

Example: Layers 0 and 1 are displayed, all other layers are hidden. The active layer is Layer 
1; this has been renamed to "Compressor". 

Renaming layers
The "Settings..." menu on the "Visible Layers" tabbed card is used to rename layers. There 
you can double-click a layer and enter a new name.
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See also
Making layers invisible (Page 260)

How to assign a layer (Page 293)

Showing and hiding layers and objects (Page 264)

How to change the default setting of object types (Page 379)

The Layer Palette (Page 242)

Working with Layers (Page 290)

3.5.13 Working with Multiple Pictures

3.5.13.1 Working with Multiple Pictures

Introduction
Multiple process pictures are quite useful when working with complex processes. These 
process pictures are then linked to each other and one picture can be integrated in another. 
Graphics Designer supports a number of features which ease the process of working with 
multiple pictures. 

● The properties of a picture can transferred to another picture.

● Objects can be transferred from one picture to another.

● Objects can be copied from one picture to another.

See also
Working with Pictures (Page 278)

How to copy objects to another picture (Page 298)

How to transfer objects to another picture (Page 296)

How to transfer picture properties to another picture (Page 295)

3.5.13.2 How to transfer picture properties to another picture

Introduction
With the exception of the display of the grid and the grid width, the properties of a picture can 
be transferred to other pictures with the aid of the "Pipette".
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Procedure
1. Open the picture with the properties you want to copy. Make certain that no object is 

selected.

2. In the standard toolbar, click .         
The picture properties will be copied.

3. Open picture to which the properties should be assigned. Make certain that no object is 
selected.

4. In the standard toolbar, click .         
The picture properties will be assigned.

As an alternative, the functions for copying and assigning properties can also be accessed via 
the "Edit /Properties" menu.

See also
How to transfer objects to another picture (Page 296)

How to copy objects to another picture (Page 298)

Working with Multiple Pictures (Page 295)

Working with Pictures (Page 278)

3.5.13.3 How to transfer objects to another picture

Introduction
With "Cut" and "Paste", you can cut out a selected object and paste it from the operating 
system's clipboard. Pasting from the clipboard, it can be copied into any picture. The object 
can be copied any number of times, even into different pictures.

Multiple selection
It is possible to simultaneously cut out several selected objects and paste them into another 
picture.
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Requirements
● Select an object of any type.

Procedure
1. Press the key combination <CTRL+X> in order to cut the selected object and to transfer it 

to the clipboard.         
Alternatively you can click the icon

in the standard toolbar or use the entry "Cut" in the pop-up menu or in the "Edit" menu.

2. Open the picture into which the object in the clipboard should be pasted.

3. Press the key combination <CTRL+V>.         
Alternatively, you can click the icon  in the standard toolbar or use the entry "Cut" in the 
pop-up menu or in the "Edit" menu.         
The current content of the clipboard will be inserted into the active picture and selected.

4. Repeat this step to insert further copies of the contents.

Alternative Operation
Drag&Drop: Select the object to be transferred and drag it with the left mouse button depressed 
to another picture.

Note

Objects from other applications can also be inserted via the clipboard of the operating 
system.         
 

Position X and Position Y of the inserted object are each 20 pixel greater as as Position X 
and Y of the original object.         
 

The inserted object receives the object name of the original object but is supplemented by a 
continuous number.

See also
How to duplicate objects (Page 402)

How to cut objects (Page 399)

How to insert the contents of the clipboard (Page 401)

How to delete objects (Page 398)

How to copy objects to another picture (Page 298)

Working with Multiple Pictures (Page 295)

Working with Pictures (Page 278)

Creating Process Pictures
3.5 Working with Pictures

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  297



3.5.13.4 How to copy objects to another picture

Introduction
With "Copy" and "Paste", a selected object can be copied to the clipboard and pasted from 
there into any picture. The advantage of copying to the clipborad is that that object can be 
inserted several times, and into different pictures.

Multiple selection
It is possible to simultaneously copy several selected objects and paste them into another 
picture.

Requirements
● Select an object of any type.

Procedure
1. Press the key combination <CTRL+C> to copy the selected object to the clipboard.         

Alternatively, you can click the icon  in the standard toolbar or the entry "Copy" in the 
pop-up menu or in the "Edit" menu.

2. Open the picture into which the object in the clipboard should be pasted.

3. Press the key combination <CTRL+V>.         
Alternatively, you can click the icon  in the standard toolbar or use the entry "Cut" in the 
pop-up menu or in the "Edit" menu.         
The current content of the clipboard will be inserted into the active picture and selected.

4. Repeat this step to insert further copies of the contents.

Note

Objects from other applications can also be inserted via the clipboard of the operating 
system.         
 

Position X and Position Y of the inserted object are each 20 pixel greater as as Position X 
and Y of the original object.         
 

The inserted object receives the object name of the original object but is supplemented by a 
continuous number. No special characters are used in the object name. 
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See also
How to duplicate objects (Page 402)

How to cut objects (Page 399)

How to insert the contents of the clipboard (Page 401)

How to delete objects (Page 398)

How to transfer objects to another picture (Page 296)

Working with Pictures (Page 278)

Working with Multiple Pictures (Page 295)

3.6 Working with Faceplate Types

3.6.1 Working with Faceplate types

Introduction
A faceplate is a standardized picture object that you create centrally as a type in a project. 
WinCC saves the faceplate type in a fpt file. Afterward, you can insert the faceplate type as a 
faceplate instance in a process picture. You edit the faceplate instance like an individual object 
of the object palette in the Graphics Designer.

The use of faceplate types reduces the configuration work required, because one faceplate 
type can be used in multiple pictures and the instances can be changed centrally via the 
faceplate type.

Properties and events of faceplate types
Faceplate types have two types of properties and events:

● Type-specific properties and events
These properties and events can only be changed in the faceplate type. Type-specific 
properties and events are the properties and events of the individual objects, which cannot 
be configured in the faceplate instances.

● Instance-specific properties and events
You configure these properties and events in the faceplate instances.

When creating the faceplate type, define whether a property is type- or instance-specific in a 
configuration dialog.

If you insert a faceplate type as an instance in a process picture, the instance-specific 
properties and events are allocated with the predefined values from the faceplate type. You 
can then adapt the instance-specific properties and events individually to the process picture.

The following picture shows the use of the type- and instance-specific properties in the 
faceplate instances.
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The changes of the type-specific properties are not updated automatically in the faceplate 
instances. You get the changes in the instances by closing and reloading the respective 
process picture.

Note

The following menu functions of the Graphics Designer are not available to you when editing 
a faceplate type.
● Activating runtime
● Customized Object
● Tag connections

Copying a faceplate type
If you want to copy a faceplate type from a project into another, you must first copy the fpt file 
of the faceplate type in the Windows Explorer into the project folder of the new project. 
Afterwards, you can insert the instances of the faceplate type into the new project as normal.

Copying and inserting individual objects of a faceplate type
If you are copying individual objects of a faceplate type into a process picture, all dynamics of 
this object are deleted. This prevents e.g. the use of invalid scripts with faceplate tags in a 
process picture.

If you are copying objects from a process picture into a faceplate type, all dynamics of this 
object are deleted. This prevents e.g. the use of invalid scripts with WinCC tags in a faceplate 
type.
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Note

The faceplate instance and the corresponding faceplate type must be located in the currently 
open project. If you open a "PDL" file from another previously edited project in the Graphics 
Designer with the menu command "Last Files", the faceplate instances are shown in white, 
since the associated faceplate types are located in another project directory.

3.6.2 How to create a Faceplate type

Introduction
A Faceplate type is the template for the Faceplate instances. The Faceplate type is created 
centrally in the project. You define which properties and events can be configured in the 
Faceplate type and which can be configured in the Faceplate instance in the Faceplate type.

The Faceplate type is a combination of individual objects from the object palette of the Graphics 
Designer. 

Note

The object types connector, customized object, application window, picture window and 
Faceplate cannot be used.

Procedure
1. Creating a Faceplate type.

2. Inserting and configuring individual objects of the Faceplate type.

3. Configuring a Faceplate type.

4. Creating Faceplate tags.

5. Making a Faceplate type dynamic.
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See also
How to create a Faceplate type (Page 302)

How to insert the individual objects of the Faceplate type (Page 302)

Configuration of a Faceplate type (Page 303)

Properties of a Faceplate type (Page 304)

How to configure the properties of a Faceplate type (Page 306)

Event of a Faceplate type (Page 309)

How to configure the events of a Faceplate type (Page 310)

Definition of the Faceplate tags of a Faceplate type (Page 312)

How to edit the Faceplate tags of a Faceplate type (Page 313)

Making a Faceplate type dynamic (Page 314)

3.6.3 How to create a Faceplate type

Requirements
● Faceplate.oll is integrated in the object palette of the Graphics Designer.

● The Graphics Designer is open.

Procedure
1. Select the "New Faceplate type" command from the "File" menu.

A new picture will be created with format *.fpt.

2. Select the "Save" command on the "File" menu.

3. Save the Faceplate type in the project folder.
The Faceplate type is created.

3.6.4 How to insert the individual objects of the Faceplate type

Introduction
A faceplate type is a combination of objects from the object palette of the Graphics Designer. 
You can insert and configure these individual objects like the objects in a normal WinCC picture.

Note

You cannot use the object types ActiveX control, customized object, application window, 
picture window, faceplate, connector and the icons of the HMISymbol library.
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Requirement
● A faceplate type is opened in the Graphics Designer.

Procedure
1. Insert the individual objects of the faceplate type from the object palette.

2. Position the individual objects in the desired position.

3. Configure the object properties of the individual objects.

Note

The configured object properties, which you later do not define as instance-specific in the 
configuration dialog, are the type-specific properties of this faceplate type.

4. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

You can find additional information on inserting and configuring the individual objects in the 
object palette of the Graphics Designer in the section "Working with objects of the object 
palette".

See also
Working with Objects in the Object Palette (Page 473)

3.6.5 Configuration of a Faceplate type

Introduction
You define which properties and events of a Faceplate type should be able to be configured 
in the instances in the configuration dialog of a Faceplate type. The "Object Properties" window 
of the Faceplate instance shows only the properties and events defined in the configuration 
dialog.

You call the configuration dialog in the "Edit" menu with the "Configure Faceplate type" 
command.

"Properties" Tab
You define the properties that should be able to be configured in the instances in the 
"Properties" tab. Every instance-specific property can be connected with multiple properties 
of the individual objects.

"Events" Tab
You define the events that should be able to be configured in the instances in the "Events" tab. 
You can only connect each instance-specific event with a single event of the individual objects.
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See also
Properties of a Faceplate type (Page 304)

How to configure the properties of a Faceplate type (Page 306)

Event of a Faceplate type (Page 309)

How to configure the events of a Faceplate type (Page 310)

3.6.6 Properties of a Faceplate type

Introduction
You define the properties that should be able to be configured in the instances in the 
"Properties" tab. Every instance-specific property node can be connected with multiple 
properties of the individual objects. Only the name of the property node is shown in the object 
properties of the Faceplate instance. By changing the value of the property node, all of the 
properties of the individual objects connected with the property nodes are changed.

Note

You are not permitted to assign the following properties of the individual objects with a 
property node:
● "OutputFormat" of the I/O field.
● "Layer" for all objects.
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Selected Properties
This area contains the instance-specific property nodes for the Faceplate type. Each of these 
property nodes can be assigned with one or more properties of the individual objects. Only the 
name of the property node is shown in the object properties of the instances. By changing the 
value of the property node, all of the properties of the individual objects connected with the 
property nodes are changed.

Objects
This area contains all objects included in the Faceplate type. Select an object for which you 
want to show the available properties in the "Object Properties" area.

Object Properties
This area contains all available properties for the object selected in the "Objects" area. In order 
to define a property of the individual objects as instance-specific, drag the desired property 
with Drag & Drop into the "Selected properties" area on the respective property node.
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Note

Group the properties of the individual objects in the property nodes in a meaningful fashion. 
You should e.g. not group line thickness together with background color.

Enter a unique name for the property node. There are no language-dependent names for the 
property nodes.

Note

You can only assign each property of an individual object to one property node.

You can only make the properties of an individual object dynamic in the Faceplate type that 
are not assigned to a property node.

You can only assign a property node with properties of an individual object that you have not 
made dynamic in the Faceplate type.

Special aspects of the property node
You have two possibilities for creating property nodes:

● Connect the property nodes with properties of the individual objects.

● Create an "empty" property node without any connection to the property of the individual 
objects.

In order to use an "empty" property node, the following configuration steps are required:

● Make property nodes dynamic with the dynamic capabilities that are available in the 
Faceplate type.
When scripting, you access the "empty" property nodes in the Faceplate type by way of 
SmartTags.

● Connect property nodes in the Faceplate instance with Variable.
The variable can be used to trigger the OnChanged event of the property node.

● Configure the event on an OnChanged event of the property node in the Faceplate instance.
The event is executed if e.g. the value of the property node is changed with a script in the 
Faceplate type.

See also
How to configure the properties of a Faceplate type (Page 306)

3.6.7 How to configure the properties of a Faceplate type

Introduction
You define the properties that should be able to be configured in the instances in the 
"Properties" tab. Every instance-specific property node can be connected with multiple 
properties of the individual objects. Only the name of the property node is shown in the object 
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properties of the faceplate instance. By changing the value of the property node, all of the 
properties of the individual objects connected with the property nodes are changed.

Requirements
● The configuration dialog must be open.

● The "Properties" tab has been selected.

Add properties
1. Click on "Add property" to add a property node in the "Selected properties" area.

2. Rename the property nodes using the context menu when required.
If you want to configure a property node without any connection to the individual objects, 
proceed with step 8.

3. Select an object in the "Objects" area for which you want to define a property as instance-
specific.
The properties available for the selected object are displayed in the "Object Properties" 
area.

4. Select the desired property in the "Object Properties" area.
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5. Drag the desired property using Drag & Drop onto the property node in the "Selected 
properties" area.
The property of the individual object is arranged under the property node.

Note

You can assign each property node with multiple properties of the individual objects. Make 
sure that the properties of the individual objects are grouped in a meaningful fashion. Only 
the name of the property node is shown in the object properties of the faceplate instance. 
By changing the value of the property node, all of the properties of the individual objects 
connected with the property nodes are changed.

6. Repeat steps 1 to 5 until all desired properties are in the "Selected properties" area.

7. Click "Apply".
The configurations that have been defined are accepted.

8. Click "OK".
The configuration dialog is closed.

9. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

Deleting properties
1. Select the property or property nodes that you want to delete in the "Selected Properties" 

area.

2. Select the "Delete" command from the context menu of the selected property or the selected 
property node.
The selected property or the selected property node is deleted from the selection.

3. Click "Apply".
The configurations that have been defined are accepted.

4. Click on "Exit".
The configuration dialog is closed.

5. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

Subsequently changing the properties of the faceplate type
You can assign another object property to an instance-specific property of a faceplate type at 
a later point in time. You need to check and possibly adapt existing faceplate instances.

A red cross is shown on the instance in the pictures with affected instances of the faceplate 
type.

See also
How to use a Faceplate instance (Page 315)
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3.6.8 Event of a Faceplate type

Introduction
You define the events that should be made available in the instances in the "Events" tab. 

"Selected events" area
This area contains the instance-specific event nodes for the faceplate type. Each of these 
event nodes assign exactly one event to the individual objects. Only the name of the event 
node is shown in the "Name" tab for the object properties of the instances. The event of the 
individual object is triggered by triggering the event linked to the event node.

"Object" area
This area contains all objects included in the faceplate type. Select an object for which you 
want to show the available events in the "Object Events" area.
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"Object events" area
This area contains all available events for the object selected in the "Objects" area. In order 
to define an event as instance-specific, drag the desired event with Drag & Drop into the 
"Selected events" area on the respective event node.

Note

Enter a unique name for the event node. There are no language-dependent names for the 
event nodes.

See also
How to configure the events of a Faceplate type (Page 310)

3.6.9 How to configure the events of a Faceplate type

Introduction
You define the events that should be able to be configured in the instances in the "Events" tab. 
Every instance-specific event node can be connected with only one event of the individual 
object. Only the name of the event node is shown in the object properties of the faceplate 
instance. By changing the value of the event node, all of the events of the individual objects 
connected with the event nodes are changed.
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Requirements
● The configuration dialog must be open.

● The "Events" tab has been selected.

Adding events
1. Click on "Add event" to add an event node in the "Selected events" area.

2. Rename the event nodes using the context menu when required.

3. Select an object in the "Objects" area for which you want to define an event as instance-
specific.
The events available for the selected object are displayed in the "Object Events" area.

4. Select the desired event in the "Object Events" area.

5. Drag the desired event using Drag & Drop onto the event node in the "Selected events" 
area.

Note

Every event node can only be assigned to a single event of the individual objects. 
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6. Repeat steps 1 to 5 until all desired events are in the "Selected events" area.

7. Click "Apply".
The configurations that have been defined are accepted.

8. Click on "Exit".
The configuration dialog is closed.

9. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

Deleting events
1. Select the event or the event node that you want to delete in the "Selected events" area.

2. Select the "Delete" command from the context menu of the selected event or the selected 
event node.
The selected event or the selected event node is deleted from the selection.

3. Click "Apply".
The configurations that have been defined are accepted.

4. Click on "Exit".
The configuration dialog is closed.

5. Select the "Save" command in the "File" menu to save the changes in the faceplate type.

Subsequently changing the event of the faceplate type
You can assign another event to an instance-specific event of a faceplate type at a later point 
in time. You need to check and possibly adapt existing faceplate instances.

A red cross is shown on the instance in the pictures with affected instances of the faceplate 
type.

See also
How to use a Faceplate instance (Page 315)

3.6.10 Definition of the Faceplate tags of a Faceplate type

Introduction
You cannot use the tags of the WinCC Tag Management in a faceplate type. You can only use 
faceplate tags for making objects dynamic. These faceplate tags are only valid for this faceplate 
type. The Faceplate tags can only be edited in the Faceplate type.
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"Faceplate tags" configuration dialog

The configuration dialog "Faceplate tags" is called up in the "Edit" menu with the "Edit 
Faceplate tags" command.

You can configure the following for the tags:

● Name

● Data type

● Start value

● Lower limit

● Upper limit

See also
How to edit the Faceplate tags of a Faceplate type (Page 313)

3.6.11 How to edit the Faceplate tags of a Faceplate type

Introduction
You cannot use the tags of the WinCC Tag Management in a faceplate type. You can only use 
faceplate tags for making objects dynamic. These faceplate tags are only valid for this faceplate 
type. The Faceplate tags can only be edited in the Faceplate type.
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Requirements
● A Faceplate type is opened in the Graphics Designer.

Add Tags
1. Select the "Edit Faceplate tags" command from the "Edit" menu.

The "Faceplate tags" dialog opens.

2. Double click on "Add...".
A new tag is created with default values.

Editing Tags
1. Double click on a created tag.

The input fields are activated in the lower portion of the window.

Note

The active input fields depend on the data type of the tags.

2. Enter the desired values in the input fields.

3. Click on "Accept" to accept the changes.

4. Click "Exit" to close the dialog box.

5. Select the "Save" command in the "File" menu to save the changes in the Faceplate type.

Deleting tags
1. Select the tags to be deleted.

2. Clock on the "Delete selected tags" to delete the tags.
The selected tags are deleted.

3. Select the "Save" command in the "File" menu to save the changes in the Faceplate type.

3.6.12 Making a Faceplate type dynamic

Introduction
You cannot use the tags of the WinCC Tag Management in a faceplate type. You can only use 
faceplate tags for making objects dynamic. Not all dynamization options are available in 
WinCC. The dynamizations that you perform in a faceplate type are only valid for this faceplate 
type.
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Available dynamizations
The following dynamizations are possible:

● VB Scripts

● Variable connection to the faceplate variables

Dynamization with VB scripts
You cannot use VB scripts to access data outside of the faceplate type. The "HMIRuntime" 
component in the faceplate type was thus removed. None of the features of HMIRuntime are 
therefore available in the faceplate type. However, you cannot debug scripts in faceplate types. 

The new "SmartTags" component was added in the faceplate type. With "SmartTags", you 
can access the faceplate variables and the properties of the faceplate type. You can find 
additional information on "SmartTags" in the VBS reference under the "SmartTags Object" 
topic.

Use "ScreenItems" to access the individual objects of a faceplate type. You can find additional 
information on "ScreenItems" in the VBS reference under the "ScreenItems Object (Listing)" 
topic.

Dynamizing through a tag connection
You can only use the faceplate tags for tag connections in a faceplate type. Otherwise do just 
the same as you would for a normal process picture. For more information on variable 
connections refer to the section headed "Dynamizing through a tag connection".

See also
Dynamizing by Means of Tag Connection (Page 838)

Dynamizing Using VBS Action (Page 866)

3.6.13 How to use a Faceplate instance

Introduction
You insert the faceplate type as a faceplate instance in a process picture. You configure the 
instance-specific properties in the process picture.
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Requirement
● The Graphics Designer is open.

Procedure
1. Select the "New" command on the "File" menu.

A picture is opened in format *.pdl.

2. Insert the "Faceplate" object from the object palette into the picture with a double click.
An "Open dialog" is opened.

3. Select the desired faceplate type.
The faceplate instance is inserted in the picture.
The selected faceplate type is listed under the "Faceplate type FPT" attribute in the object 
properties.

Note

If you select no faceplate types or an invalid faceplate type, the faceplate object is deleted 
from the picture.

4. Select "Properties" in the context menu of the faceplate instance.
The "Object properties" dialog box opens.

5. Configure the instance-specific properties in the "Properties" tab.
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6. Configure the instance-specific events in the "Events" tab.

7. Close the "Object properties" dialog box.

The configurations that have been defined are accepted.

Effects of the faceplate type change on the given instances
You can change properties and events of the faceplate type, even if an instance of the faceplate 
type already exists. A red cross is shown on the instance in the pictures with affected instances.

A compete automatic adjustment of the scripts in the instances cannot be ensured after 
changing the type-specific properties and events of the faceplate. Scripts can then no longer 
be executed, or no longer executed correctly. A faulty operation can be triggered without this 
being indicated to the user.

Therefore, check all scripts linked with the faceplate instance.

When you want to save a picture with faceplate instances that are affected by changing the 
type-specific properties and events, the following dialog is displayed with all the faceplate 
instances to be checked.
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When you have checked the scripts and, if necessary, adjusted these, select the check box 
in front of the instance. The red cross on the unchecked or invalid faceplate instance is then 
hidden.

In the Graphics Designer you can set the option to have this dialog displayed when saving the 
picture. Use the menu command "Options/Settings" to open the "Options" tab and select the 
check box "Show information at faceplate type change".

See also
How to configure the properties of a Faceplate type (Page 306)

How to configure the events of a Faceplate type (Page 310)

3.6.14 How to update a Faceplate instance

Introduction
The changes of type-specific properties in the Faceplate type are not updated in Faceplate 
instances if the respective process picture of the Faceplate instance is open. You get the 
changes in the instances by closing and reloading the respective process picture.
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Requirements
● A Faceplate type is created.

● An instance of the Faceplate type is inserted in a process picture.

Procedure
1. Select the "Open type" command from the "File" menu.

The "Open" dialog box is opened.

2. Select the desired Faceplate type.

3. Change the desired type-specific properties and events of the individual objects.

4. Select the "Save" command in the "File" menu to accept the changes in the Faceplate type.

5. Close the pictures in which the instances of the Faceplate type are contained.

6. Load the pictures into the Graphics Designer again.
The changes to the Faceplate type are accepted in the Faceplate instances.

3.7 Working with Controls

3.7 Resources

3.7.1 Working with Controls

Contents
ActiveX controls offer the option of integrating elements for controlling and monitoring system 
processes into a process picture. WinCC supports the following types of controls: 

● ActiveX controls
ActiveX controls are control elements from any provider that can be used by other programs 
via a defined interface based on OLE. 

● .NET controls
.NET controls are control elements from any provider based on the .NET framework 2.0 
from Microsoft. 

● WPF controls
WPF controls are control elements from any provider based on the .NET framework 3.0 
from Microsoft. 

The size and properties that a control accepts in Runtime are defined in the Graphics Designer. 

All ActiveX controls registered in the operating system and the .NET and WPF controls on your 
system are available for use in WinCC. 
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However, this chapter only covers the use of ActiveX controls provided by WinCC. The ActiveX 
controls provided by WinCC can be changed as required and embedded dynamically in the 
process. 

This chapter shows you: 

● how to register ActiveX controls in the operating system

● how to embed and configure controls in process pictures with the Graphics Designer

● how to use controls.

3.7.2 Short Description of the WinCC Controls and Additional Controls

Introduction
Controls are used for the monitoring and visualization of measured values and system 
parameters. By appropriate dynamics they can be employed as control elements of the process 
control. 

While installing WinCC, a number of ActiveX controls will also be installed: The WinCC 
controls. 

Overview
Detailed descriptions of the following WinCC controls can be viewed via the links in the menu 
bar. 

Control Abbreviation Function

Siemens HMI Symbol 
Library

Symbol Library The Symbol Library contains a comprehensive 
collection of ready-made symbols for the display of 
systems and system components in process pictures.

WinCC AlarmControl AlarmControl The AlarmControl can be used to display messages 
during runtime.

WinCC Digital/Analog 
Clock Control

Clock Control The Clock Control can be used to integrate a time 
display into a process picture.

WinCC 
FunctionTrendControl

FunctionTrendCo
ntrol

The FunctionTrendControl can be used to display the 
values of tags as functions of other tags and compare 
the trend with the setpoint trend.

WinCC Gauge Control Gauge Control The Gauge Control can be used to display the 
monitored measurement values in the form of an analog 
measurement clock.

WinCC Media Control Media Control The Media Control can be used to play media files. 
WinCC 
OnlineTableControl

OnlineTableContr
ol

The OnlineTableControl can be used to display values 
from archive tags in tabular form.

WinCC 
OnlineTrendControl

OnlineTrendContr
ol

The OnlineTrendControl can be used to display values 
from tags and archive tags as trends.

WinCC 
RulerControl         

RulerControl RulerControl displays the evaluation of process data in 
a statistics or ruler window. 
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Control Abbreviation Function

WinCC Push Button 
Control

Push Button 
Control

The Push Button Control can be used to start execution 
of a command. 

WinCC Slider Control Slider Control The Slider Control can be used to display the monitored 
measurement values in the form of a slider control.

WinCC 
UserArchiveControl

UserArchiveContr
ol

The UserArchiveControl provides options to access 
user archives and views of the user archives.

IXDiskSpace.DiskSpac
e

Disk Space 
Control

Disk Space Control enables the monitoring of the 
capacities available on a storage medium.

See also
How to Resize a Control (Page 326)

How to Change the Properties of a Control (Page 334)

This is how you change the registration of an ActiveX control (Page 332)

This is how you configure the Control selection of the Object Palette (Page 329)

How to Position a Control (Page 328)

How to Insert a Control from the "Controls" Tab (Page 325)

This is how you insert an ActiveX control as a smart object: (Page 322)

The "WinCC Digital/Analog Clock" Control' (Page 349)

The "WinCC Gauge" Control (Page 355)

The "WinCC Slider" Control (Page 368)

WinCC AlarmControl (Page 1014)

WinCC OnlineTrendControl (Page 1220)

WinCC FunctionTrendControl (Page 1274)

WinCC OnlineTableControl (Page 1186)

WinCC Media Control (Page 364)

The "Siemens HMI Symbol Library" Control (Page 340)

The "IXDiskSpace.DiskSpace" Control (Page 335)
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3.7.3 This is how you insert an ActiveX control as a smart object:

Introduction
Insert an ActiveX control from the Object Palette into a process picture. You can insert controls 
as a smart object or from the "Controls" tab. 

If you insert the ActiveX control as a smart object, select the ActiveX control from the "Insert 
a Control" dialog during the insertion process. The dialog shows all the ActiveX controls that 
are registered in the operating system. 

NOTICE

The use of ActiveX Controls from third party providers can lead to errors as well as drops in 
performance or system blocks. The user of the software is responsible for problems caused 
by the deployment of external ActiveX Controls.          
We recommend testing for safe operation before implementation. 

At the end of the insertion process a configuration dialog is usually opened, in which you adapt 
the properties of the control. You can also open this dialog later by double-clicking the control. 
Detailed description of the configuration dialog can be found in the descriptions of the related 
controls. 

Creating Process Pictures
3.7 Working with Controls

MDM - WinCC: Working with WinCC
322 System Manual, 11/2008,  



WinCC uses the designation of the control linked with a sequential number as the object name 
by default. You can change this name with the "Object name" attribute in the "Object 
Properties" window. 

Procedure
1. In the Object Palette, click the smart object "Control".

2. Place the mouse pointer at the position in the picture where you want to insert the ActiveX 
control.
The mouse pointer changes into a crosshair with an object symbol attached. 

3. Drag the control to the desired size with the mouse.
The "Insert a Control" dialog opens. 

4. Select one of the ActiveX controls that are registered in the operating system. Confirm your 
selection with "OK".
With some controls, the corresponding configuration dialog is automatically opened. In any 
case, you can open the configuration dialog with a double-click or via the shortcut menu. 

5. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK."
The insertion process for the "Control" object is finished.

Alternative procedure
Double click in the object palette on the Smart Object "Control", in order to insert it with the 
default properties into the process picture.  Select the desired control in the "Insert a Control" 
dialog. 

See also
How to Change the Properties of a Control (Page 334)

This is how you change the registration of an ActiveX control (Page 332)

This is how you configure the Control selection of the Object Palette (Page 329)

How to Position a Control (Page 328)

How to Resize a Control (Page 326)

How to Insert a Control from the "Controls" Tab (Page 325)

Short Description of the WinCC Controls and Additional Controls (Page 320)
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3.7.4 This is how you insert a .NET or WPF control as a smart object

Introduction
Insert a .NET or WPF control from the Object Palette into a process picture. You can insert 
these controls as a smart object or from the "Controls" tab. 

When inserting the control as a smart object, select the required control in the "Insert a Control" 
dialog. All the controls which were configured for selection are displayed here. 

NOTICE

Possible problems with third-party controls

The user of the software is responsible for problems caused by the deployment of external 
controls.          
We recommend testing for safe operation before implementation. 

At the end of the insertion process a configuration dialog is usually opened, in which you adapt 
the properties of the control. You can also open this dialog later by double-clicking the control. 

By default, WinCC uses the name of the control, linked with a continuous number, as the object 
name. You can change this name with the "Object name" attribute in the "Object Properties" 
window. 

Procedure
1. In the Object Palette, click the smart object ".NET Control" or "WPF Control".

2. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached. 

3. Drag the control to the desired size with the mouse.
The "Insert a Control" dialog with the controls from the "Global Assembly Cache" is opened. 

4. Select the required control and confirm with "OK".
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5. Select the required type in the "Select Type" dialog.
With some controls, the corresponding configuration dialog is now opened.

6. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK."
The insertion process for the ".NET Control" or "WPF Control" object is finished.

Alternative insertion procedure
1. Double click in the Object Palette on the smart object ".NET Control" or "WPF Control", in 

order to insert it with the default properties into the process picture.

2. Select the required control in the "Insert a Control" and "Insert Type" dialog.

3.7.5 How to Insert a Control from the "Controls" Tab

Introduction
Insert a control from the Object Palette into a process picture. You can insert controls as a 
smart object or from the "Controls" tab. ActiveX controls, .NET controls and WPF controls are 
available. 

When WinCC has been installed, the "Controls" tab displays a preset selection of WinCC 
controls under the ActiveX controls; initially there are no controls listed under ".NET Controls" 
and "WPF Controls". You can configure this control selection if necessary. 

When inserting the control from the "Controls" tab, select the required control at the beginning 
of the insertion process in order to insert it directly into a process picture. 

At the end of the insertion process a configuration dialog is usually opened, in which you adapt 
the properties of the control. You can also open this dialog later by double-clicking the control. 
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By default, WinCC uses the name of the control, linked with a continuous number, as the object 
name. You can change this name with the "Object name" attribute in the "Object Properties" 
window. 

Procedure
1. In the Object Palette, click the "Controls" tab.          

Select the control you want.

2. Place the mouse pointer at the position in the picture where you want to insert the control.
The mouse pointer changes into a crosshair with an object symbol attached. 

3. Drag the control to the desired size with the mouse.
With some controls, the corresponding configuration dialog is now opened. 

4. Adapt the settings of the configuration dialog as required and confirm your entry with "OK".
The insertion process for the selected control is finished. 

Alternative procedure
Double click in the object palette on the smart object Control, in order to insert it with the default 
properties into the process picture. 

See also
How to Change the Properties of a Control (Page 334)

This is how you change the registration of an ActiveX control (Page 332)

This is how you configure the Control selection of the Object Palette (Page 329)

How to Position a Control (Page 328)

How to Resize a Control (Page 326)

This is how you insert an ActiveX control as a smart object: (Page 322)

Short Description of the WinCC Controls and Additional Controls (Page 320)

3.7.6 How to Resize a Control

Introduction
The size of an object is defined by the geometry of the rectangle surrounding the object. The 
rectangle surrounding the control is symbolized when selecting an object by showing the 
handles. 

Controls can be resized by:

● dragging the handle to a new position

● Changing the values of the "Width" and "Height" attributes in the window "Object properties"
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Requirements
● Select a control.

Procedure
1. Position the cursor on the handle of the selected control.

The mouse pointer will change to a double arrow. The alignment of the double arrow 
indicates the directions in which you can move the handle:

– Horizontal double arrow
The handles on the horizontal center axis can be used to change the width of the control.

– Vertical double arrow
 The handles on the vertical center axis can be used to change the height of the control.

– Diagonal double arrow
The handles on the corners of the control can be used to change the height and width 
of the control.

2. Use the mouse to drag the handle to the position you want.
In the settings of the Graphics Designer if the Snap to Grid function is activated, the control 
can only be scaled with the mouse according to the settings for the grid.

See also
This is how you change the registration of an ActiveX control (Page 332)

How to Change the Properties of a Control (Page 334)

This is how you configure the Control selection of the Object Palette (Page 329)

How to Position a Control (Page 328)

How to Insert a Control from the "Controls" Tab (Page 325)

This is how you insert an ActiveX control as a smart object: (Page 322)

Short Description of the WinCC Controls and Additional Controls (Page 320)
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3.7.7 How to Position a Control

Introduction
The position of a control is defined by the coordinates of the control origin. The left upper corner 
of the rectangle surrounding the control is called the object origin. Controls can be positioned 
by:

● dragging the control to a new position

● moving the selected control with the aid of the arrow keys for cursor control

● Changing the "Position X" and "Position Y" attributes in the "Object Properties" window

Requirements
● Select a control.

Procedure
1. Position the cursor on the selected control.

The mouse pointer changes to a crosshair with arrowheads.

2. Click the control and hold down the left mouse button.
The cursor changes into an arrow with an outline icon (small rectangle with broken line).

3. Move the cursor.
The rectangle surrounding the control is displayed as broken and shows a possible new 
position for the control. The control initially maintains its original position.
In the settings of the Graphics Designer if the Snap to Grid function is activated, the control 
can only be positioned with the mouse according to the settings for the grid.

4. Release the mouse button.
The control is moved to the position previously displayed by the broken line of the rectangle 
surrounding the object. The mouse pointer again changes into a crosshair with arrow ends.
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See also
This is how you configure the Control selection of the Object Palette (Page 329)

How to Change the Properties of a Control (Page 334)

This is how you change the registration of an ActiveX control (Page 332)

How to Resize a Control (Page 326)

How to Insert a Control from the "Controls" Tab (Page 325)

This is how you insert an ActiveX control as a smart object: (Page 322)

Short Description of the WinCC Controls and Additional Controls (Page 320)

3.7.8 This is how you configure the Control selection of the Object Palette

Introduction
The "Controls" tab in the Object Palette of the Graphics Designer contains a selection of 
controls in the folders "ActiveX Controls", ".NET Controls" and "WPF Controls". You can insert 
these controls directly into a picture. 

You can configure the selection of controls available in the tab yourself: 

● Change the selection of the ActiveX controls in the dialog "Select OCX Controls". You can 
add any of the ActiveX controls registered in the operating system to the list of controls and 
remove individual controls from the selection.

● Change the selection of the .NET controls in the dialog "Select .NET Object".

● Change the selection of the WPF controls in the dialog "Select WPF Object".

NOTICE

The use of controls from third party providers can lead to errors as well as drops in 
performance or system blockage. The user of the software is responsible for problems 
caused by the deployment of external controls.          
We recommend a thorough test before implementation. 
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Configuring ActiveX controls
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the 

"ActiveX Controls" folder. The "Select OCX Controls" dialog is opened.

In the area "Available OCXs (Number)", the "Select OCX Controls" dialog shows all the 
ActiveX Controls that are registered in the operating system. The exact number is shown 
in the title of the area after the registration has been read in. A red check mark indicates 
those controls that are available in the "Controls" tab dialog of the Object Palette. The path 
and the program ID of the selected ActiveX Controls are displayed in the area "Details". 
You can open the "Select OCX Controls" dialog also from the WinCC Explorer. Click on 
the entry "Graphics Designer" in the navigation window and select the entry "Select ActiveX 
Control" in the shortcut menu. 

2. To add an ActiveX control to the Object Palette, select the desired control in the area 
"Available OCX Controls".
A red check mark indicates that the control will be added to the "Controls" tab of the Object 
Palette. 

3. To remove an ActiveX control from the Object Palette, clear the control in question in the 
area "Available OCX Controls".
The red check mark disappears. 

4. Confirm your changes by clicking "OK".
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Configuring .NET objects and WPF objects
1. Open the "Controls" tab and select the entry "Add/Remove" in the shortcut menu of the 

".NET Controls" folder or the "WPF Controls" folder.
The dialog "Select .NET Object" or "Select WPF Object" opens. 

In the area "Available Controls (Number)", the dialog shows all the .NET objects or WPF 
objects on your computer. The precise number is displayed in the title of the area. A red 
check mark indicates those controls that are available in the "Controls" tab dialog of the 
Object Palette. The assembly, .NET version and path of the selected object are displayed 
in the area "Details". 

2. To add a control to the Object Palette, select the desired control in the area "Available 
Controls".
A red check mark indicates that the control will be added to the "Controls" tab of the Object 
Palette. 

3. To remove a control from the Object Palette, clear the control in question in the area 
"Available Controls".
The red check mark disappears. 

4. Confirm your changes by clicking "OK".
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See also
How to Change the Properties of a Control (Page 334)

This is how you change the registration of an ActiveX control (Page 332)

How to Position a Control (Page 328)

How to Resize a Control (Page 326)

How to Insert a Control from the "Controls" Tab (Page 325)

This is how you insert an ActiveX control as a smart object: (Page 322)

Short Description of the WinCC Controls and Additional Controls (Page 320)

.NET controls (Page 376)

WPF controls (Page 377)

3.7.9 This is how you change the registration of an ActiveX control

Introduction
ActiveX Controls must be configured in the operating system, in order to be available for 
applications. Normally the registration is a component of the installation procedure. For 
troubleshooting or also for upgrading of individual controls, you can also perform a registration 
or deregistration manually. In WinCC you can edit the registration in the following dialogs: 

● Dialog "Select OCX Controls"         
Use the button "Deregister OCX" and "Register OCX" ....

● Dialog "Insert a Control"         
Use the buttons "Register..." and "Deregister".

The procedure for changing the registration is the same in both dialogs. We will describe it 
below in the example of the Insert a Control dialog.

NOTICE

You can use these buttons to change the settings of the operating system. Changes are 
made immediately.          
Before the deregistration of an ActiveX control, check in which path the related OCX file is 
saved on the hard disk. How to facilitate a repeated registration of this control.
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Deregistering ActiveX Control
1. Insert a Control as a Smart Object.         

The "Insert a Control" dialog is opened.

2. Select the desired Control in the selection list.

3. Check the details under the selection list (path and name).

4. Click on the button "Deregister".         
The selected control is deregistered and deleted from the selection list. The related OCX 
file is maintained in the specified path on the hard disk.

Registering ActiveX Control
1. Insert a Control as a smart object.

The "Insert a Control" dialog opens.

2. Click the "Register..." button.
You can use the Open dialog to open a browser window for the selection of the desired 
OCX file. 

3. Select the desired OCX file.
During the installation, WinCC Controls are normally copied into the folder "...\Siemens
\WinCC\BIN".

4. Click "OK" to confirm your choice.
The selected control is registered in the operating system and displayed in the selection 
list of the "Insert a Control" dialog.
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See also
How to Change the Properties of a Control (Page 334)

This is how you configure the Control selection of the Object Palette (Page 329)

How to Position a Control (Page 328)

How to Resize a Control (Page 326)

How to Insert a Control from the "Controls" Tab (Page 325)

This is how you insert an ActiveX control as a smart object: (Page 322)

Short Description of the WinCC Controls and Additional Controls (Page 320)

3.7.10 How to Change the Properties of a Control

Introduction
The properties of a control can be adopted according to your needs by:

● Changing the attributes in the "Object Properties" dialog

● Changing the settings in the Configuration dialog

Opening the "Object Properties" Window
In the pop-up menu of a control select the entry "Properties", in order to open the "Object 
Properties" dialog.  The change of an attribute is executed immediately.

The detailed description of the "Object Properties" dialog is found in chapter "The Window 
Object Properties".

Opening the Configuration Dialog
Double-click a control to open the related configuration dialog. Select a tab to carry out the 
desired changes. Click on "Accept" in order to assign the new settings to the control. Confirm 
your configuration with "OK" to close the dialog.

The configuration dialogs are explained in the detailed description of the related control.
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See also
How to Resize a Control (Page 326)

This is how you change the registration of an ActiveX control (Page 332)

This is how you configure the Control selection of the Object Palette (Page 329)

How to Position a Control (Page 328)

How to Insert a Control from the "Controls" Tab (Page 325)

This is how you insert an ActiveX control as a smart object: (Page 322)

Short Description of the WinCC Controls and Additional Controls (Page 320)

3.7.11 ActiveX controls

3.7.11.1 IXDiskSpace.DiskSpace Control

The "IXDiskSpace.DiskSpace" Control

Introduction
The control "IXDiskSpace.DiskSpace" allows the monitoring of the capacities available on a 
storage medium.

Example: You archive measurement values and reports on a hard disk. Use the Disk Space 
Control to configure the limits for the displaying of warning messages.

A displaying of the controlled values can be done in Runtime only.

Inserting Disk Space Control
Insert the Disk Space Control as Smart Object into a picture. The detailed description of the 
insertion procedure can be found in the chapter "Insert control into a picture".
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The Disk Space Control is normally not displayed in the tab "Controls" of the Object Palette. 
The Control can be accepted with the dialog "Select OCX Controls" in the tab "Controls". The 
detailed description can be found in the chapter "Configure control selection of the Object 
Palette".

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

How to Control the Usage of Memory (Page 338)

How to Configure the Disk Space Control (Page 336)

How to Configure the Disk Space Control

Introduction
There is no configuration dialog for the Disk Space Control.          
The properties of the control are changed in the "Object Properties" dialog.

Requirements
● In the pop-up menu of a control select the entry "Properties" in order to open the "Object 

Properties" dialog.

● Select the property group "Control Properties". 

Drive
Enter the letter of the drive which you want to control with the control.

Alarm, Warning, Tolerance
Specify the limit values for the control limits. The values are specified in percent. The values 
are given in percent. The percent part of the occupied memory space is controlled at the total 
capacity of the specified drive.

ToleranceColor, WarningColor, AlarmColor
Specify the colors in which the bar graph is shown as soon as the occupied memory space 
has exceeded the respective control limit.
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Interval
Specify the interval for the update of the displayed measurement values. For the update an 
interval of one minute up to 60 minutes can be defined freely.

Free, Used, Total
These attributes record the measurement values for the occupied and the free memory as well 
as for the total capacity of the drive. The memory space is specified in kilobytes. The values 
can be queried in Runtime. The values cannot be predefined.

UsedPercent, FreePercent
These two attributes record the measurement values for the occupied and the free memory in 
percent. The values can be queried in Runtime. The values cannot be predefined.

See also
The "IXDiskSpace.DiskSpace" Control (Page 335)

How to Control the Usage of Memory (Page 338)
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How to Control the Usage of Memory

Introduction
The function of the Disk Space Control is explained by means of examples for the control of 
five drives. Each drive is thereby controlled by a separate control.

In the Graphics Designer five Disk Space Controls were configured with the same limit values 
and color assignments. These are displayed in the figure above as a multiple selection. 

The object names of the controls are assigned according to the drives to be controlled:          
DiskSpaceC, DiskSpaceD, DiskSpaceE, DiskSpaceH und DiskSpaceZ.

To provide a better overview, blue lines and labels have been added in the figure.

In this example the "Object Properties" window shows the following properties for the control 
"DiskSpaceZ":
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Display of Disk Space Controls in Runtime
The monitored values can be displayed in Runtime only. The resulting graphs are shown in 
the figure below: 

The occupied memory space of drives C and Z are below the tolerance limit of 80%. The 
occupied memory space is displayed in the color (green) configured for this limit.

Drive D with 87% occupied memory space has not exceeded the warning limit yet, but is above 
the value for the tolerance limit. The drive is displayed in the color of the warning limit (yellow).

Above the warning limit the display of the value is in the color configured for the alarm limit 
(red). The same applies to the drive H with a value of 91%.

Drive E shows the control of a CD-ROM drive. In this example there is no colored bar, since 
there is currently no data medium in the drive.

Display of Memory Utilization
The display of the absolute values can be queried in Runtime by mouse control: 

Move the mouse pointer onto the bar of the desired drive (here: drive D). The absolute values 
of the usage of memory are shown as Quick Info. 

The following is displayed:

1. "Drive": Letter code of the controlled drive

2. "Total": Total capacity of the drive in kilobytes

3. "UsedPercent": Used memory space as share in percent of the total

4. "FreePercent": Free memory space as share in percent of the total
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See also
The "IXDiskSpace.DiskSpace" Control (Page 335)

How to Configure the Disk Space Control (Page 336)

3.7.11.2 Siemens HMI Symbol Library

The "Siemens HMI Symbol Library" Control

Introduction
The control "Siemens HMI Symbol Library" contains a comprehensive collection of prepared 
symbols. These symbols can be used for the display of systems and system components in 
process pictures.
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Inserting Symbols of the Symbol Library
The symbols of the Symbol Library are inserted into a picture as a control from the Object 
Palette or from the library of the Graphics Designer:

● As a Smart Object:
The Smart Object "Control" is inserted from the "Standard" tab of the Object Palette. The 
Symbol Library is selected in the dialog "Insert a Control".          
The selection of the desired symbols is done after the insertion procedure in the 
configuration dialog which is opened by double-clicking the control.

● from the tab "Controls"
The control Siemens HMI Symbol Library is inserted directly from the "Controls" tab of the 
Object Palette. 
The selection of the desired symbols is done after the insertion procedure in the 
configuration dialog which is opened by double-clicking the control.

● From the library of the Graphics Designer:
The control Siemens HMI Symbol Library is integrated as a unique folder into the library of 
the Graphics Designer.
The desired symbol is selected directly and inserted from the library. The properties of the 
symbols can be changed in the configuration dialog, which is opened by double-clicking 
the symbol.

Changing the Symbols of the Symbol Library
The properties of the symbols of the Symbol Library can be changed in the window "Object 
Properties" and in the configuration dialog "Properties of Siemens HMI Symbol Library".

The window "Object Properties" is opened from the pop-up menu of the inserted object. The 
dialog "Properties of Siemens HMI Symbol Library" is opened by double-clicking the symbol 
to be changed.

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

How to Change the Colors (Page 347)

How to Change the Display Options (Page 345)

How to Change the Alignment (Page 343)

How to Select a Symbol from the Symbol Library (Page 342)
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How to Select a Symbol from the Symbol Library

Introduction
You can use the "Symbols" tab in the Properties of Siemens HMI Symbol Library dialog to 
replace the displayed symbol with another. The picture contents of the selected symbols is 
changed by the selection of another symbol of the Symbol Library. The other properties of the 
selected symbols are not changed.

Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the 

symbol to be changed.

● Select the "Symbols" tab.

Preview
In the area at the top left, the symbol selected in the selection will be displayed. All settings of 
the "Siemens HMI Symbol Library" dialog are displayed in the preview.
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Categories
In the area at the bottom left all categories containing symbols of the Symbol Library are 
displayed.          
Select the category that contains the desired symbol. All symbols of the selected category are 
displayed in the selection.

Selection
The right area displays all the symbols available for the selected category.          
Position the mouse pointer on a symbol, to show a short description.          
Click on the desired symbol to select it. The selected symbol is displayed in the preview.

See also
How to Change the Colors (Page 347)

The "Siemens HMI Symbol Library" Control (Page 340)

How to Change the Display Options (Page 345)

How to Change the Alignment (Page 343)

How to Change the Alignment

Introduction
You can use the "Style" tab in the Properties of Siemens HMI Symbol Library dialog to set 
different options. The display and the alignment of the selected symbols can be customized.

In the area at the top left, the symbol selected in the "Symbols" tab is displayed. All settings 
of the "Siemens HMI Symbol Library" dialog are displayed in the preview.
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Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the 

symbol to be changed.

● Select the "Style" tab.

Alignment
In the bottom left area the alignment of the symbol in the current picture can be changed. The 
symbol can be mirrored and rotated.

Mirroring
Open the drop-down list box and select the desired mirroring type.          
The picture content is mirrored on the horizontal or vertical central axis of the symbol 
respectively. Objects can be mirrored both horizontally and vertically.

Rotation
Open the drop-down list box and select the desired angle for the rotation.          
The rotation of the picture contents is done around the central axis of the symbol. The rotation 
is done counter-clockwise in steps of 90, 180 and 270 degrees.
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See also
The "Siemens HMI Symbol Library" Control (Page 340)

How to Change the Colors (Page 347)

How to Change the Display Options (Page 345)

How to Select a Symbol from the Symbol Library (Page 342)

How to Change the Display Options

Introduction
You can use the "Style" tab in the Properties of Siemens HMI Symbol Library dialog to set 
different options. The display and the alignment of the selected symbols can be customized.

In the area at the top left, the symbol selected in the "Symbols" tab is displayed. All settings 
of the "Siemens HMI Symbol Library" dialog are displayed in the preview.

Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the 

symbol to be changed.

● Select the "Style" tab.
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Display
Open the drop-down list box and select the desired appearance form for the picture contents.

Original
The appearance form of the symbol corresponds to the multi-colored display in the selection 
of the "Symbols" tab.

Shadow
Lines of the color "Black" are maintained as contour lines. Elements of the symbols in other 
colors are displayed as light grades of the current foreground color.
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Solid
Lines of the color "Black" are maintained as contour lines. All the elements of the symbol in 
other colors are assigned the color value of the current foreground color.

Outline
Lines of the color "Black" are maintained as contour lines. All the elements of the symbol in 
other colors are assigned the color value of the current background color.

Background
Open the drop-down list box and select the desired background type.          
The background can be displayed either "Nontransparent" or "Transparent".

Customizing
Click on the control box next to the "Customize" option, in order to enable or to disable the 
option.          
When selecting the "Customize" option, the picture contents are adapted to the object size of 
the selected symbol.

Display Mouse Pointer
Click on the control box next to the Customize option, in order to enable or to disable the 
option.          
When selecting the Display Mouse Pointer option, the mouse pointer is not hidden in Runtime, 
if it is placed on the symbol.

See also
The "Siemens HMI Symbol Library" Control (Page 340)

How to Change the Colors (Page 347)

How to Change the Alignment (Page 343)

How to Select a Symbol from the Symbol Library (Page 342)

How to Change the Colors

Introduction
Using the "Color" tab in the Properties of Siemens HMI Symbol Library dialog you can set 
different color settings for the display of the selected symbol.
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Requirements
● The "Properties of Siemens HMI Symbol Library" dialog is opened by double-clicking the 

symbol to be changed.

● Select the "Color" tab.

Properties
Select the color attribute you wish to change.

The "Flashing Color" acquires the symbol in the flashing status. The flashing is only visible in 
Runtime. With the "Background Color" you can display the background of the symbol for the 
background type "Nontransparent". In the appearance forms of "Shadow" and "Solid", the 
symbol is shown in the Foreground Color.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in 
the "Color Palette" section.

The "Standard Colors" color group contains the 16 standard colors of the operating system. 
The "Windows System Colors" color group contains the colors which are set in the operating 
system currently as the display options at system start.
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Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color 
attribute.

Editing Custom Colors
Click on this button to access the "Colors" dialog. Depending on the graphic settings of the 
operating system you can define the desired color freely.

See also
The "Siemens HMI Symbol Library" Control (Page 340)

How to Change the Display Options (Page 345)

How to Change the Alignment (Page 343)

How to Select a Symbol from the Symbol Library (Page 342)

3.7.11.3 WinCC Digital/Analog Clock Control

The "WinCC Digital/Analog Clock" Control'

Introduction
● With the "WinCC Digital/Analog Clock" control you can integrate a time display into a 

process picture. In Runtime the current system time of the operating system is displayed. 
The time can be displayed as analog or digital. In addition, the digital display contains the 
current date.

Inserting a Clock Control
The clock control is inserted from the object palette into a picture:

● As a Smart Object:
The Smart Object "Control" is inserted from the "Standard" tab of the Object Palette. The 
Clock Control is selected in the dialog "Insert a Control".

● from the tab "Controls"
The Smart Object Control is inserted from the "Controls" tab of the Object Palette.
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The properties of the control are changed in the configuration dialog "Properties of the WinCC 
Digital/Analog Clock Control" or in the window "Object Properties".

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

How to Change the Background Picture of the Clock Control (Page 354)

How to Change the Color of the Clock Control (Page 352)

How to Change the Font of the Digital Clock Control Display (Page 351)

How to Change the Appearance of the Clock Control (Page 350)

How to Change the Appearance of the Clock Control

Introduction
In the "General" tab, you have the option to set the general appearance of the clock control. 
In addition, the geometry of the pointers can be changed.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.

● Click on the "General" tab.

Pointer width in %
For the analog display you can set the width of the second, minute and hour pointer. The values 
are understood as percent share of the pointer length.

You can only set the pointer width in the classic design. The static values and the configured 
dynamic properties have no effect on the new design.

Pointer length in %
For the analog display you can set the length of the second, minute and hour pointer. The 
values are understood as percent share of the radius of the dial.

Analog display
Choose between analog and digital display of the clock.
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Dial
Hide or unhide the hour marks for the analog display.

Square
Select whether the analog clock is to be displayed in square shape.

Line pointer
Specify whether for the analog display only the border or also the filling color of the pointer will 
be displayed.

Background style
Select "Nontransparent" in order to display the analog clock with a frame. With "Transparent 
border" the colored dial is displayed without a border. Select "Transparent", in order to display 
the analog clock without background.

See also
The "WinCC Digital/Analog Clock" Control' (Page 349)

How to Change the Background Picture of the Clock Control (Page 354)

How to Change the Color of the Clock Control (Page 352)

How to Change the Font of the Digital Clock Control Display (Page 351)

How to Change the Font of the Digital Clock Control Display

Introduction
You can use the "Font" tab to adapt the font to the digital display of the clock.  This setting has 
no effect on the analog display of the Clock Control.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.

● Select the "Font" tab.
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Properties
The currently selected property is shown.

Font
Select the desired font for the digital display of the clock from the drop-down list box. You can 
use any of the fonts registered in the operating system.

Font size
Select the desired font size for the digital display of the clock from the drop-down list box. 
Alternatively, enter the font size directly in the field. The value is specified in points (pt).

Display
Select one or more display options.          
The selected font can be displayed in "Bold", "Italic", "Underline" and "Strikethrough".

Sample Text
The selected settings are displayed in a preview.

See also
The "WinCC Digital/Analog Clock" Control' (Page 349)

How to Change the Background Picture of the Clock Control (Page 354)

How to Change the Color of the Clock Control (Page 352)

How to Change the Appearance of the Clock Control (Page 350)

How to Change the Color of the Clock Control

Introduction
You can use the "Color" tab to adapt the color to the digital display of the clock. For the digital 
display of the Clock Controls only the color attribute "Foreground color" (font color) is relevant.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.

● Select the "Color" tab.
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Properties
Select the color attribute you wish to change.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in 
the "Color Palette" section.

The "Standard Colors" color group contains the 16 standard colors of the operating system. 
The "Windows System Colors" color group contains the colors which are set in the operating 
system currently as the display options at system start.

Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color 
attribute.

Editing Custom Colors
Click on this button to access the "Colors" dialog. Depending on the graphic settings of the 
operating system you can define the desired color freely.

See also
The "WinCC Digital/Analog Clock" Control' (Page 349)

How to Change the Background Picture of the Clock Control (Page 354)

How to Change the Font of the Digital Clock Control Display (Page 351)

How to Change the Appearance of the Clock Control (Page 350)
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How to Change the Background Picture of the Clock Control

Introduction
You can use the "Picture" tab, to assign a background picture to the analog or digital display 
of the clock. The current picture is shown in the "Preview" area.

Requirements
● Double-click the control to open the "Properties of WinCC Digital/Analog Control" dialog.

● Select the "Picture" tab.

Browsing
Click the "Browse..." button to access the "Find Picture" dialog. Select the graphic file, to which 
you want to assign the selected property. 

Pictures in the following formats can be inserted:          
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

Deleting
Click the "Clear" button to move on from the opening picture.

See also
The "WinCC Digital/Analog Clock" Control' (Page 349)

How to Change the Color of the Clock Control (Page 352)

How to Change the Font of the Digital Clock Control Display (Page 351)

How to Change the Appearance of the Clock Control (Page 350)
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3.7.11.4 WinCC Gauge Control

The "WinCC Gauge" Control

Introduction
The "WinCC Gauge" control is used to display the monitored measurement values in the form 
of an analog measurement clock. Warning and danger areas as well as the extreme values of 
the pointer movement can be marked in colors.

Inserting Gauge Control
The gauge control is inserted from the object palette into a picture:

● As a smart object:
The Smart Object "Control" is inserted from the "Standard" tab of the Object Palette. The 
Control is selected in the dialog "Insert a Control".

● From the "Controls" tab
The Gauge Control is inserted from the "Controls" tab of the Object Palette.

Changing Important Properties
The properties of the control are changed in the configuration dialog "Properties of the WinCC 
Gauge Control" or in the window "Object Properties". 

The following attributes can be changed only in the window "Object Properties":

Labeling
Enter a text to be displayed, for example the type of the controlled value on the gauge. As a 
standard, you must enter the label "SIMATIC".
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Unit text
Enter a text to display, for example, the physical unit of the displayed value on the gauge. By 
default, this field is blank.

Unit offset
Specify the position for the display of the physical unit on the gauge. The value is given in 
decimal format. The value is the percent share of the object height, starting from the topmost 
border line of the rectangle encompassing the object.

See also
How to Configure the Scale of the Gauge Control (Page 357)

Short Description of the WinCC Controls and Additional Controls (Page 320)

How to Assign Pictures to the Gauge Control (Page 363)

How to Change the Colors of the Gauge Control (Page 361)

How to Change the Font of the Gauge Control (Page 360)

How to Mark Special Value Ranges (Page 359)

How to change the Appearance of the Gauge Control (Page 356)

How to change the Appearance of the Gauge Control

Introduction
On the "General" tab, you have the option to adapt the general appearance of the Gauge 
Control.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.

● Click on the "General" tab.

Center Point Size
Specify the radius for the display of the center point The value is given in decimal format as 
percent share of the diameter of the gauge.
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Labeling Offset
Specify the position for the labeling of the gauge. The value is given in decimal format. The 
value is the percent share of the object height, starting from the topmost border line of the 
rectangle encompassing the object.

Slave Pointer
For the maximum and the minimum pointer movement a marker function can be activated, 
which marks the real measurement area in Runtime with colored lines:

● A green line marks the minimum pointer movement.

● A red line marks the maximum pointer movement.

Square
Select whether the gauge is to be displayed in square shape.

Background Style
Select "Nontransparent" in order to display the gauge clock with a frame. "Transparent Border" 
hides the frame. With "Transparent", only the scale of the gauge will be displayed.

Mouse Control
The mouse pointer can be shown in Runtime, if it is placed on the symbol.

See also
The "WinCC Gauge" Control (Page 355)

How to Assign Pictures to the Gauge Control (Page 363)

How to Change the Colors of the Gauge Control (Page 361)

How to Change the Font of the Gauge Control (Page 360)

How to Mark Special Value Ranges (Page 359)

How to Configure the Scale of the Gauge Control (Page 357)

How to Configure the Scale of the Gauge Control

Introduction
On the "General" tab, you can set the measuring range to be monitored. In addition, you can 
configure the display of the scale.
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Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.

● Click on the "General" tab.

Minimum value
Enter the lower limit value of the measuring range. This value is shown as the min. scale value.

Maximum value
Enter the upper limit value of the measuring range. This value is shown as the max. scale 
value.

Value
Specify a start value for the pointer of the gauge. If process driver connections are missing, 
this value is shown in Runtime.

Minimum Angle
Enter the angle for the display at the scale start. The value is entered in degrees.

Maximum Angle
Enter the angle for the display at the scale end. The value is entered in degrees.

Tick Width
Enter the distance of the main tick marks as the difference of two neighboring measurements. 
The area between two main tick marks is divided by default by a wider tick mark of half the 
length.

Scale Width
Specify the length of the main tick marks and thus the width of the scale. The value is given 
in decimal format as percent share of the radius of the gauge.
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Scale Offset
Specify the outer radius of the scale. The value is given in decimal format as percent share of 
the radius of the gauge.

Tick Text Offset
Specify the inner radius of the scale labeling. The value is given in decimal format as percent 
share of the radius of the gauge.

Decimal point
The values of the scale labeling can be displayed as whole numbers or as decimal numbers 
with one decimal place.

See also
How to Assign Pictures to the Gauge Control (Page 363)

How to Change the Colors of the Gauge Control (Page 361)

How to Change the Font of the Gauge Control (Page 360)

How to Mark Special Value Ranges (Page 359)

How to change the Appearance of the Gauge Control (Page 356)

How to Mark Special Value Ranges

Introduction
You can use the "General" tab to highlight special range of values in the scale in colors.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.

● Click on the "General" tab.

Danger
Set the limit value for the start of the danger area.
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Warning
Set the limit value for the start of the warning area.

Danger Display
The scale area starting at the limit value "Danger" can be shown in the "Danger color" (default 
color: red).

Warning Display
The scale area starting at the limit value "Warning" can be shown in the "Warning color" (default 
color: yellow).

Normal Display
The scale area ending at the limit value "Warning" can be shown in the "Normal color" (default 
color: green).

See also
The "WinCC Gauge" Control (Page 355)

How to Assign Pictures to the Gauge Control (Page 363)

How to Change the Colors of the Gauge Control (Page 361)

How to Change the Font of the Gauge Control (Page 360)

How to Configure the Scale of the Gauge Control (Page 357)

How to change the Appearance of the Gauge Control (Page 356)

How to Change the Font of the Gauge Control

Introduction
You can use the tab "Font" to adapt the fonts for the different labeling elements of the gauge.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.

● Select the "Font" tab.

Creating Process Pictures
3.7 Working with Controls

MDM - WinCC: Working with WinCC
360 System Manual, 11/2008,  



Properties
Select the font attribute you wish to change.

Select "Labeling font", in order to change the font for the name of the gauge. "Unit font" changes 
the font for the display of the physical unit. You can configure the scale labeling with the "Scale 
text font".

Font
Select from the drop-down list box the desired font for the selected labeling attribute. You can 
use any of the fonts registered in the operating system.

Font size
Select from the drop-down list box the desired font size for the selected labeling attribute. 
Alternatively, enter the font size directly in the field. The value is specified in points (pt).

Display
Select one or more display options.          
The selected font can be displayed in "Bold", "Italic", "Underline" and "Strikethrough".

Sample Text
The selected settings are displayed in a preview.

See also
The "WinCC Gauge" Control (Page 355)

How to Assign Pictures to the Gauge Control (Page 363)

How to Change the Colors of the Gauge Control (Page 361)

How to Mark Special Value Ranges (Page 359)

How to Configure the Scale of the Gauge Control (Page 357)

How to change the Appearance of the Gauge Control (Page 356)

How to Change the Colors of the Gauge Control

Introduction
You can use the "Color" tab to adapt the color for the display of the Gauge Control.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.

● Select the "Color" tab.
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Properties
Select the color attribute you wish to change.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in 
the "Color Palette" section.

The "Standard Colors" color group contains the 16 standard colors of the operating system. 
The "Windows System Colors" color group contains the colors which are set in the operating 
system currently as the display options at system start.

Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color 
attribute.

Editing Custom Colors
Click on this button to access the "Colors" dialog. Depending on the graphic settings of the 
operating system you can define the desired color freely.
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See also
The "WinCC Gauge" Control (Page 355)

How to Assign Pictures to the Gauge Control (Page 363)

How to Change the Font of the Gauge Control (Page 360)

How to Mark Special Value Ranges (Page 359)

How to Configure the Scale of the Gauge Control (Page 357)

How to change the Appearance of the Gauge Control (Page 356)

How to Assign Pictures to the Gauge Control

Introduction
You can use the tab "Picture" to assign a background and a frame image to the Gauge.

Requirements
● Double-click the inserted control to open the "Properties of WinCC Gauge Control" dialog.

● Select the "Picture" tab.

Properties
Select the property for which you want to change the picture assignment. The current picture 
is shown in the "Preview" area.

With the "background picture" option you can assign an image to the circular background of 
the gauge. With the "Frame picture" option you can assign an image to the rectangular 
background of the Control.

Browsing
Click the "Browse..." button to access the "Find Picture" dialog. Select the graphic file, to which 
you want to assign the selected property. 

Pictures in the following formats can be inserted:          
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
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Deleting
Click the "Clear" button to move on from the opening picture.

See also
How to Change the Font of the Gauge Control (Page 360)

The "WinCC Gauge" Control (Page 355)

How to Change the Colors of the Gauge Control (Page 361)

How to Mark Special Value Ranges (Page 359)

How to Configure the Scale of the Gauge Control (Page 357)

How to change the Appearance of the Gauge Control (Page 356)

3.7.11.5 WinCC Media Control

WinCC Media Control

Introduction
You can use WinCC to also integrate multimedia files as controls into your pictures. This is 
what WinCC Media Control is used for. 

The WinCC Media Control can display the following file formats: GIF, BMP, JPG, JPEG, PNG. 

The WinCC Media Control can play the following file formats: ASF, WMV, AVI, MPG, MPEG, 
MP4, QT. The control can only play the formats that the MediaPlayer plays.

NOTICE

Data loss when coping the project

If you copy the project to a different computer, the multimedia files specified in the WinCC 
Media Control will not be copied along with it. You will need to add them to the project again. 

Inserting WinCC Media Control
Insert the WinCC Media Control from the Object Palette into a picture. 

● Drag the smart object "Control" on the "Standard" tab into the picture and select the WinCC 
Media Control.
- or - 

● On the "Controls" tab, double-click "WinCC Media Control".

A placeholder for the WinCC Media Control is inserted in the picture: 
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To configure the WinCC Media Control, double-click it to open the configuration dialog "WinCC 
Media Control Properties". Enter the required information on the file to be played and for display 
of the Media Control. 

The WinCC Media Control will then be displayed differently: 

Runtime
The user can display or play the specified multimedia file with the help of the control elements 
in Runtime. 

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

This is how you configure the WinCC Media Control:

Introduction
The WinCC Media Control can be used to display or play multimedia files in Runtime. 
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Procedure
1. Double-click the object "WinCC Media Control".

The "Properties of WinCC Media Control" dialog is opened. 

Note

If you want to dynamize the attributes, you have to open the object properties with the 
"Properties" entry in the shortcut menu. 

2. Enter the path and file name of the file to be displayed or played under "General" or look 
for the file after clicking the button "...".
Depending on the media type entered, you can select different options. 

3. For pictures, set whether the picture should be adapted to the control or whether the control 
should be adapted to the picture.
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4. For films, set the playback format and playback options.
The option "Skip interval" is used to set the interval for forward or backward skip. 

5. On the "View" tab, define the display of the WinCC Media Control for playing multimedia 
files.
In runtime the WinCC Media Control is displayed with the selected display and operator 
controls. 
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3.7.11.6 WinCC Slider Control

The "WinCC Slider" Control

Introduction
● The "WinCC Slider" control can be used to display the monitored measurement values in 

the form of a slider control. The current value can be displayed under the slider and the 
controlled measurement area can be displayed as scale labeling.

Inserting Slider Control
The slider control is inserted from the object palette into a picture:

● As a smart object:
The Smart Object "Control" is inserted from the "Standard" tab of the Object Palette. The 
Slider Control is selected in the dialog "Insert a Control".

● From the "Controls" tab
The Slider Control is inserted from the "Controls" tab of the Object Palette.

The properties of the control are changed in the configuration dialog "Properties of the WinCC 
Slider Control" or in the window "Object Properties".

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

How to Assign Pictures to the Slider Control (Page 375)

How to Change the Colors of the Slider Control (Page 373)

How to Change the Fonts of the Slider Control (Page 372)

How to Change the 3D Effects of the Slider Control (Page 371)

How to Change the Measurement Area and Labeling of the Slider Control (Page 370)

How to Change the Appearance of the Slider Control (Page 369)
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How to Change the Appearance of the Slider Control

Introduction
On the "General" tab, you have the option to adapt the general appearance of the Slider Control.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.

● Click the "General" tab.

Axis Label
The tick marks of the scale can be labeled with measurement values. The step size is set 
depending on the specified measurement area and the size of the control automatically.

Scaling
On the left side of the slider tick marks can be shown for the display of a scale.

Position Text
The value of the current position of the slider can be displayed under the slider.

Slider
The slider can be hidden.

Bar Graph
The display of the sliding areas above and below the slider can be hidden.

Transparent
The background of the control can be displayed transparent. The configured background color 
is hidden.
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See also
The "WinCC Slider" Control (Page 368)

How to Assign Pictures to the Slider Control (Page 375)

How to Change the Colors of the Slider Control (Page 373)

How to Change the Fonts of the Slider Control (Page 372)

How to Change the 3D Effects of the Slider Control (Page 371)

How to Change the Measurement Area and Labeling of the Slider Control (Page 370)

How to Change the Measurement Area and Labeling of the Slider Control

Introduction
On the "General" tab, you can set the measuring range to be monitored. In addition, you can 
also enter a function description as a label of the Push Button.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.

● Click the "General" tab.

Labeling
Enter a text to be displayed, for example the type of the controlled value at the slider. As a 
standard, you must enter the label "SIMATIC".

Minimum value
Enter the lower limit value of the measuring range. This value is shown as the min. scale value 
of the slider control.

Maximum value
Enter the upper limit value of the measuring range. This value is shown as the max. scale 
value of the slider control.
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Value
Specify a start value for the position of the slider gauge. If the Process Driver Connection is 
missing, the slider is displayed at this position in Runtime.

See also
The "WinCC Slider" Control (Page 368)

How to Assign Pictures to the Slider Control (Page 375)

How to Change the Colors of the Slider Control (Page 373)

How to Change the Fonts of the Slider Control (Page 372)

How to Change the 3D Effects of the Slider Control (Page 371)

How to Change the Appearance of the Slider Control (Page 369)

How to Change the 3D Effects of the Slider Control

Introduction
On the "3D Effects" tab, you can choose the style and width for the 3D display of borders and 
scales.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.

● Select the "3D-Effects" tab.

Style
Select a style for the display of the inner and outer frame as well as the scale.

The border of the Slider Control consists of the three elements outer frame, border and inner 
frame. A 3D effect is created by the two-colored display of the outer and inner frames as well 
as the tick marks of the scaling.

The styles "Depressed" and "Raised" can be distinguished by the changed alignment of the 
two color attributes "Upper Frame color" and "Bottom Frame Color". The "Border" style for the 
scale has the effect that the elements are displayed single-colored.
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Width
Enter a value for the width of the border elements in pixel(s).

See also
How to Change the Fonts of the Slider Control (Page 372)

The "WinCC Slider" Control (Page 368)

How to Assign Pictures to the Slider Control (Page 375)

How to Change the Colors of the Slider Control (Page 373)

How to Change the Measurement Area and Labeling of the Slider Control (Page 370)

How to Change the Appearance of the Slider Control (Page 369)

How to Change the Fonts of the Slider Control

Introduction
You can use the tab "Font" to adapt the fonts for the different labeling elements of the Slider 
Control.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.

● Select the "Font" tab.

Changing Configuration

Properties
Select the font attribute you wish to change.

With the "Position font" option, you can change the display of the value, which is displayed by 
the current position of the slider. A change of the attribute "Font" affects the labeling of the 
control and the scale.
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Font
Select from the drop-down list box the desired font for the selected labeling attribute. You can 
use any of the fonts registered in the operating system.

Font size
Select from the drop-down list box the desired font size for the selected labeling attribute. 
Alternatively, enter the font size directly in the field. The value is specified in points (pt).

Display
Select one or more display options.          
The selected font can be displayed in "Bold", "Italic", "Underline" and "Strikethrough".

Sample Text
The selected settings are displayed in a preview.

See also
How to Change the Appearance of the Slider Control (Page 369)

The "WinCC Slider" Control (Page 368)

How to Assign Pictures to the Slider Control (Page 375)

How to Change the Colors of the Slider Control (Page 373)

How to Change the 3D Effects of the Slider Control (Page 371)

How to Change the Measurement Area and Labeling of the Slider Control (Page 370)

How to Change the Colors of the Slider Control

Introduction
You can use the "Color" tab to adapt the color for the display of the Slider Control.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.

● Select the "Color" tab.
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Properties
Select the color attribute you wish to change.

Color group
Select one of the color groups in the drop-down list box. The related colors are displayed in 
the "Color Palette" section.

The "Standard Colors" color group contains the 16 standard colors of the operating system. 
The "Windows System Colors" color group contains the colors which are set in the operating 
system currently as the display options at system start.

Color palette
Select the desired color. Click "Accept" in order to assign the new color to the selected color 
attribute.

Editing Custom Colors
Click this button to access the "Colors" dialog. Depending on the graphic settings of the 
operating system you can define the desired color freely.
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See also
The "WinCC Slider" Control (Page 368)

How to Assign Pictures to the Slider Control (Page 375)

How to Change the Fonts of the Slider Control (Page 372)

How to Change the 3D Effects of the Slider Control (Page 371)

How to Change the Measurement Area and Labeling of the Slider Control (Page 370)

How to Change the Appearance of the Slider Control (Page 369)

How to Assign Pictures to the Slider Control

Introduction
On the "Picture" tab, you can assign pictures to the Slider Control for the display of the 
background and the slider.

Requirements
● Double-click the inserted control to open the "WinCC Slider Control Properties" dialog.

● Select the "Picture" tab.

Changing Configuration

Properties
Select the property for which you want to change the picture assignment. The current picture 
is shown in the "Preview" area.

With the "Background picture" option, you can assign an image to the background of the 
Control. With "Slider picture", you have the option to display an image on the slider.

Browsing
Click the "Browse..." button to access the "Find Picture" dialog. Select the graphic file, to which 
you want to assign the selected property. 

Pictures in the following formats can be inserted:          
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.
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Deleting
Click the "Clear" button to move on from the opening picture.

See also
The "WinCC Slider" Control (Page 368)

How to Change the Colors of the Slider Control (Page 373)

How to Change the Fonts of the Slider Control (Page 372)

How to Change the 3D Effects of the Slider Control (Page 371)

How to Change the Measurement Area and Labeling of the Slider Control (Page 370)

How to Change the Appearance of the Slider Control (Page 369)

3.7.12 .NET controls

Introduction  
Together with WinCC, the Microsoft .NET Framework 2.0 is also installed. This enables you 
to integrate .NET applications (assemblies) as controls in your pictures. This is what the 
container for the .NET controls is used for. 

NOTICE

The user of the software is responsible for problems caused by the deployment of external 
controls.          
We recommend testing for safe operation before implementation. 

Inserting a .NET control
Insert a .NET control from the Object Palette into a process picture. You can insert the control 
as a smart object or from the "Controls" tab. 

● When inserting the control as a smart object, select the required control in the "Insert a 
Control" dialog. All the controls which were configured for selection are displayed here. 
After selecting the control, define the type.
At the end of the insertion process, normally a configuration dialog is opened, in which you 
adapt the properties of the control. You can also open this dialog later by double-clicking 
the control. 

● When you insert the control from the "Controls" tab, only the controls which you added to 
the Object Palette are available. Click the required control and draw a rectangular in the 
picture for the control. Then define the type.
Configure the control selection with the "Add .NET Object" dialog. 
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Note

For multi-user projects, the ".Net Control" must be saved locally on each client. You have 
saved a ".Net Control" on the server under "C:\Controls" and added a ".Net Control" to the 
project. Then you have to save the ".Net Control" to the associated clients under "C:\Controls" 
or under "C:\Program Files\Common Files\Siemens\Assemblies." Create the "Assemblies" 
folder.

See also
This is how you configure the Control selection of the Object Palette (Page 329)

3.7.13 WPF controls

Introduction
Together with WinCC, the Microsoft .NET Framework 3.0 is also installed. This enables you 
to integrate .WPF files as controls in your pictures. This is what the container for the .WPF 
(WPF = Windows Presentation Framework) controls is used for. 

NOTICE

The user of the software is responsible for problems caused by the deployment of external 
controls.          
We recommend testing for safe operation before implementation. 

Inserting a .WPF control
Insert a WPF control from the Object Palette into a process picture. You can insert the control 
as a smart object or from the "Controls" tab. 

● When inserting the control as a smart object, select the required control in the "Insert a 
Control" dialog. All the controls which were configured for selection are displayed here. 
Then define the type.
At the end of the insertion process normally a configuration dialog is opened, in which you 
adapt the properties of the control. You can also open this dialog later by double-clicking 
the control. 

● When you insert the control from the "Controls" tab, only the controls which you added to 
the Object Palette are available. Click the required control and draw a rectangular in the 
picture for the control. Then define the type.
Configure the control selection in the Object Palette with the "Add WPF Object" dialog. 

See also
This is how you configure the Control selection of the Object Palette (Page 329)

Creating Process Pictures
3.7 Working with Controls

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  377



3.8 Working with Objects

3.8.1 Working with Objects

Introduction
You will find the following information in this chapter: 

● The basic functions of the Graphics Designer for working with objects

● The features of the individual objects

● How to use objects to create process pictures

● How to specifically change object properties

Objects of the Object Palette
"Objects" in the Graphics Designer are the predefined graphic elements that enable efficient 
creation of process pictures. You can easily insert all objects into a picture from the object 
palette. The "Default" register tab of the Object Palette provides the objects in the following 
four object groups: 

Standard objects Smart objects Windows objects Tube objects

Line         
polygon         
polygon line         
ellipse         
circle         
ellipse segment         
circle segment         
ellipse arc         
circle arc         
rectangle         
rounded rectangle         
static text         
connector

Application window         
Picture window         
Control         
OLE object         
I/O Field         
Bar         
Graphic object         
Status display         
Text list         
Multi-line text         
Combobox         
List box         
Faceplate instance         
.NET control         
WPF control         
3D bar         
Group display         
Status display (Ext.)         
Analog display (Ext.)

Button         
Check Box         
Radio Box         
Round button         
Slider object

Polygon tube         
T-piece         
Double T-piece         
Tube bend

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
378 System Manual, 11/2008,  



Combined Objects
You can combine the objects of the object palette with one another by creating a "Group" or 
a "Faceplate type" from a multiple selection. 

● You can prepare a Faceplate type can for reuse as a Faceplate instance in other process 
pictures or projects.

● You can insert a group into the project library and prepare it as a "Library object" for reusing 
in other process pictures or projects.

See also
How to change the default setting of object types (Page 379)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Working with Combined Objects (Page 613)

Working with Controls (Page 319)

3.8.2 How to change the default setting of object types

Introduction
In the Graphics Designer, the various object types have default properties. If an object from 
the Object Palette is inserted in a picture, the object adapts to these default settings.

You can adapt default settings for individual object types to your requirements. We recommend 
that you make predefined settings for objects with multiple application before creating a 
process picture. This is how to limit the scope for later adaptation. 

There is an extensive description on backing up default settings in the chapter The" Graphics 
Designer Basic Settings". 

This section shows the general procedure to view the default setting for the object types. 
Changing the default properties is based on changing the individual attributes of an object. 
There is an extensive description on changing attributes can be found in the chapter "The 
Properties of an Object". 

Note

You can also define the design and colors of object types for an entire project. More 
information on this is found under "Global object design" and "How to change the color 
scheme of an object type". 
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Note

The default setting for the object types applies across the project. The changed default 
settings only apply to the images of the currently opened WinCC project. The basic settings 
of the Graphics Designer are not changed here. 

Prerequisites
● A picture must be opened. This picture can also be empty.

Procedure
1. Right-click in the object palette on the the object type whose default setting you want to 

change.

2. Choose the "Properties" option from the shortcut menu.
The "Object properties" window opens. The name if the object type with the additional 
"Default" is displayed toolbar of this window. 

3. Select the property group in the "Properties" tab that contains the attribute you want to 
change.
Changing attributes in described extensively in the section "Change attribute". 

See also
How to Change an Attribute (Page 434)

Managing the default settings of objects (Page 267)

The "Object Properties" Window (Page 424)

The Object Palette (Page 238)

Elements and Basic Settings of the Graphics Designer (Page 228)

Working with Objects (Page 378)

3.8.3 Basic Static Operations

3.8.3.1 Basic Static Operations

Introduction
To create a process picture, the required objects must be inserted from the Graphics Designer 
object palette into a picture. These objects are then dynamically linked suitably to a process 
to use the process picture to control and monitor processes.

This chapter introduces the basic static operations with which objects are inserted and 
arranged in the picture.
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See also
How to position objects (Page 390)

Working with Objects (Page 378)

Basic Dynamic Operations (Page 407)

You can change the text contents of objects (Page 405)

You can link the tag connection of objects (Page 418)

How to change the position of an object (Page 403)

How to duplicate objects (Page 402)

How to insert the contents of the clipboard (Page 401)

How to copy objects (Page 400)

How to cut objects (Page 399)

How to delete objects (Page 398)

How to rotate the objects (Page 396)

How to mirror the objects (Page 395)

How to scale an object (Page 393)

How to Align Multiple Objects (Page 392)

How to Select Multiple Objects (Page 388)

Multiple Selection of Objects (Page 386)

How to select an object (Page 385)

How to Rename Objects (Page 383)

How to insert an object into a picture (Page 382)

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  381



3.8.3.2 How to insert an object into a picture

Introduction
The objects which should form a process and a subprocess in a process picture are inserted 
from the Graphics Designer object palette into a picture.

In the Graphics Designer, the various object types have default properties. When they are 
inserted the objects import these default properties (except for individual geometric properties). 
After insertion the properties of an object can be modified. In the same way the default settings 
for the object types can be modified as required.

When inserting an object, an object name is automatically assigned. The name of the object 
type is linked with a continuous number as the object name. No special characters are used 
in the object name. You change the object name using the "Object Name" attribute.

Requirements
● The display of the object palette must be enabled.

Procedure
The example of the standard object "Rectangle" is used here to show the general procedure 
as to how to insert an object in a picture. Some object types require additional steps. You can 
learn more about these additional steps in the detailed description of the individual objects.

1. Open the picture into which you want to insert an object.

2. Click the "Rectangle" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the 
rectangle.         
The mouse pointer changes into a crosshair with an object symbol attached.
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Hold down the mouse button and drag the rectangle to the required size.         
As soon as you release the mouse, the rectangle is added. 

Alternative Operation
Double-click the required object in the object palette. The new object is inserted close to the 
picture origin. The properties of the new object correspond to the default settings for the 
selected object type.

See also
How to Rename Objects (Page 383)

How to select an object (Page 385)

How to position objects (Page 390)

How to scale an object (Page 393)

How to delete objects (Page 398)

How to copy objects (Page 400)

How to copy objects to another picture (Page 298)

The Coordinate System of a Process Picture (Page 228)

The Coordinate System of an Object (Page 230)

The Rectangle Surrounding the Object (Page 232)

The Object Palette (Page 238)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.3 How to Rename Objects

Introduction
The "Object Name" attribute specifies the name of an object in the picture. The object name 
is unique within a picture. The name of the object is used for example in configuring C actions 
to call the object.

When an object is inserted, the object name assigned as standard is the description of the 
object type with a consecutive number. This name can be changed using the "Object Name" 
attribute.

Note

Avoid special characters in object names of these object names are used in scripts.
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Requirements
● Select an object of any type.

Procedure
1. Open the "Object Properties" window.

2. On the "Properties" tab select the entry for the selected object type to which the property 
groups of the object are subordinate.

3. Double-click the "Object name" attribute.         
The "Text entry" dialog will open.

4. Enter the new name.

5. Click "OK" to confirm your entries.

See also
How to insert an object into a picture (Page 382)

How to select an object (Page 385)

Illegal Characters (Page 152)

The Toolbar in the "Object Properties" Window (Page 426)

The Object Palette (Page 238)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
384 System Manual, 11/2008,  



3.8.3.4 How to select an object

Introduction
To change the properties of an object, the object must be selected.

Requirements
● The active picture must contain at least one object.

Procedure
1. Position the cursor on the required object.

2. Click the object.         
The mouse pointer changes to a crosshair with arrowheads.         
The handles of the rectangle surrounding the object appear.

Alternative Procedure
1. Open the "Object Properties" window.

2. On the toolbar of the window, open the drop-down list field to select the object.

3. Select the desired object.         
The handles of the object are displayed.
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See also
How to select an object (Page 385)

How to Select Multiple Objects (Page 388)

Multiple Selection of Objects (Page 386)

The Rectangle Surrounding the Object (Page 232)

The Object Palette (Page 238)

The "Object Properties" Window (Page 424)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.5 Multiple Selection of Objects

Introduction
In order to change the properties of several objects at the same time, you must select all desired 
objects. You do this using "Multiple selection". 

All attributes of the selected objects are shown in the "Object properties" window for a multiple 
selection. For an attribute however, a value is only displayed if it is the same for all selected 
objects that have this attribute. 

Along with "selection borders" and the "reference object", a multiple selection has two 
characteristics which play an important role, for example for the common alignment of the 
selected objects. These characteristics are however not visible in the Graphics Designer. 
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Selection Frame of a Multiple Selection
The selection border encloses all objects in a multiple selection, comparable to the rectangle 
surrounding individual objects. The selection border is known as a lasso. 

The position and size of the selection border are dependent on the position of the selected 
object. The midpoint of the selection border corresponds to the common midpoint of the 
selected objects. The limit line of the selection border touches the outer edges of those objects 
which have the greatest distance from the common midpoint. 

The selection border is not visible. After finishing the multiple selection, only the handles of 
the individual objects will be shown. 

Reference object of a multiple selection
One of the selected objects has to be used as a reference object for aligning objects of the 
multiple selection: For example, if the "Same width" function is selected in the Alignment 
palette, then all selected objects will be set to the same width as the respective reference 
object. 

The object to be used as a reference object depends on the type of multiple selection and on 
the function selected in the alignment palette: 
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Selection type Selection borders <Shift> + left mouse button <Ctrl + A>

Function Reference object is: Reference object is: Reference object is:
Aligning the outermost object the object selected first the reference object that is used 

until the selection;          
otherwise the outermost object

Center the common center axis of the selected object
Distribute No reference object 
Match width or 
height 

the object with the greatest 
width or height 

the object selected first the reference object used until the 
selection;          
otherwise the object with the 
greatest width or height

Match width and 
height  

the first configured, therefore the oldest object in the multiple selection 

See also
How to Select Multiple Objects (Page 388)

How to Align Multiple Objects (Page 392)

Working with Combined Objects (Page 613)

The Alignment Palette (Page 241)

The Rectangle Surrounding the Object (Page 232)

3.8.3.6 How to Select Multiple Objects

Introduction
In order to change the properties of several objects at once, all of the objects to be changed 
must be selected. You do this using "Multiple selection". In the Graphics Designer, you can 
make the multiple selection of objects using the following procedures: 

● multiple selection by clicking with the pressed <Shift> key

● multiple selection by dragging a selection border with the mouse

● multiple selection with key combination <Ctrl+A>

Note

With each of these three procedures, you can remove an object that was selected in the 
multiple selection by mistake by clicking on it with the <Shift> key pressed. 
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Prerequisites
● The active picture contains at least two objects.

Multiple selection with <Shift> and click
1. Hold down <SHIFT>.

2. Click the relevant objects, working in succession.
The handles of the rectangle surrounding the object appear for every selected 
object.          
The mouse pointer will change to a crosshair with arrow points when it is positioned over 
a selected object. 

Multiple selection with the mouse
You can also make a multiple selection with the mouse only. This is done by dragging a 
selection border around the desired objects with the mouse. The result depends on the setting 
for the type of object selection: 

● "Surrounding object selection"         
All objects inside the displayed frame are selected.

● "Touching object selection"         
All objects touched by the frame will be selected, in addition to those inside of it.

The procedure described here is for the "surrounding object selection" type.

1. Position the cursor on the picture close to one of the required objects.

2. Hold down the mouse button and drag a frame around the objects you want.          
As soon as you release the mouse button, the handles for the rectangles surrounding the 
objects will be shown for every selected object.

Multiple selection with <Ctrl+A>
1. Select one or more objects.

2. Press <Ctrl+A>.

– If no object was selected, all objects of the picture are selected.

– If at least one object was selected, all objects of the same type are selected like the 
selected objects.
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Reference object
The object to be used as a reference object depends on the type of selection and on the function 
selected in the alignment palette: 

Selection type Selection borders <Shift> + click <Ctrl + A>

Function Reference object is: Reference object is: Reference object is:
Aligning the outermost object the object selected first the reference object that is 

used until the 
selection;          
otherwise the outermost 
object

Center the common center axis of the selected object
Distribute No reference object
Match width or height the object with the greatest 

width or height
the object selected first the reference object used 

until the selection;          
otherwise the object with the 
greatest width or height

Match width and height the first configured, therefore the oldest object in the multiple selection

See also
The Alignment Palette (Page 241)

How to select an object (Page 385)

The Rectangle Surrounding the Object (Page 232)

Multiple Selection of Objects (Page 386)

3.8.3.7 How to position objects

Introduction
The position of an object is defined by the coordinates of the object origin. The left upper corner 
of the rectangle surrounding the control is called the object origin.

Objects can be positioned by:

● dragging the object to a new position

● moving the selected object with the aid of the arrow keys for cursor control

● Changing the "Position X" and "Position Y attributes"
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Multiple selection
It is possible to move several selected objects simultaneously.

Requirements
● Select an object of any type.

Procedure
1. Position the mouse pointer over the selected object.         

The mouse pointer changes to a crosshair with arrow points.

2. Click the object and hold the left mouse button.         
    The cursor changes into an arrow with an outline icon (small rectangle with broken line).

3. Move the mouse pointer.         
The rectangle surrounding the object is displayed as broken and shows a possible new 
position for the object.         
The object itself initially keeps its original position.

4. Release the mouse button.         
The object is moved to the position previously displayed by the broken line of the rectangle 
surrounding the object.         
The mouse pointer turns into crosshairs with arrow pointers

Alternative Operation
Move the selected object using the arrow keys for cursor control or change the value for the 
geometric "Position X" and "Position Y" attributes in the "Object Properties" window.
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Note

In the settings of the Graphics Designer if the "Snap to grid" function is activated, the object 
can only be positioned with the mouse according to the settings for the grid.

See also
The Rectangle Surrounding the Object (Page 232)

Working with Objects (Page 378)

Basic Static Operations (Page 380)

The Coordinate System of an Object (Page 230)

The Coordinate System of a Process Picture (Page 228)

How to Set the Grid (Page 254)

How to position objects (Page 390)

How to select an object (Page 385)

3.8.3.8 How to Align Multiple Objects

Introduction
Using the functions of the alignment palette, the objects of a multiple selection can be arranged 
together in the picture. A detailed description of these functions can be found in the section 
"The Alignment palette".

Aligning
The selected objects are aligned on the border line of the selection frame (up, down, left, right).

Center
The selected objects are centered on a middle axis of the selection frame (horizontally, 
vertically).

Distribute
The selected objects are distributed evenly across the height or width of the selection frame 
(horizontally, vertically).
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Align
The size of the reference object is assigned to the selected objects (height, width or height 
and width).

Requirements
● Select at least two objects of any type.

Procedure
In the "Alignment Palette" click the required icon or on the "Arrange / Align" menu select the 
required entry.         
The alignment or the size of the selected objects changes.

See also
How to position objects (Page 390)

How to Select Multiple Objects (Page 388)

The Alignment Palette (Page 241)

Multiple Selection of Objects (Page 386)

The Coordinate System of a Process Picture (Page 228)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.9 How to scale an object

Introduction
The size of an object is defined by the geometry of the rectangle surrounding the object. The 
rectangle surrounding the object is symbolized when selecting an object by showing the 
selection markers.

Objects can be scaled by:

● dragging the handle to a new position

● changing the values of the "Width" and "Height" attributes
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Multiple selection
It is not possible to scale several selected objects simultaneously using the mouse. To do this, 
the objects must be grouped.

Requirements
● Select an object of any type.

Procedure
1. Position the mouse pointer over a handle of the selected object.         

The mouse pointer changes to double arrow. The alignment of the double arrow indicates 
the directions in which you can move the handle:

– "Horizontal double arrow"         
The width of the object can be changed using the handles on the horizontal center axis.

– "Vertical double arrow"         
The handles on the vertical center axis can be used to change the height of the object.

– "Diagonal double arrow"         
The handles on the corners of the object can be used to change the height and width 
of the object.

2. Use the mouse to drag the handle to the position you want.         
In the settings of the Graphics Designer - if the "Snap to grid" function is activated, the 
object can only be scaled with the mouse according to the settings for the grid.
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Alternative Operation
Change the values for the geometric "Width" and "Height" attributes in the "Object Properties" 
window.

See also
How to select an object (Page 385)

How to position objects (Page 390)

How to Set the Grid (Page 254)

The Rectangle Surrounding the Object (Page 232)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.10 How to mirror the objects

Introduction
Objects can be mirrored on their horizontal or vertical center axis. The mirroring of an object 
can cause its geometric attributes to change. Mirroring can also change the alignment of 
elements contained in the object such as text or check boxes.
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Multiple selection
It is possible to mirror several selected objects simultaneously. The mirroring occurs on the 
horizontal or vertical middle axis of the individual objects.

Requirements
● Select any type of object except circle, application window, picture window, Control, OLE 

object, status display, 3D bars, group display and round button.

Procedure
In the "Standard toolbar" click the icon

in order to mirror the selected object on its horizontal center axis

in order to mirror the selected object on its vertical center axis

Alternatively you can use the entries "Horizontal" and "Vertical" on the "Arrange / Mirror" menu.

See also
How to select an object (Page 385)

How to rotate the objects (Page 396)

Multiple Selection of Objects (Page 386)

The Standard Toolbar (Page 236)

The Coordinate System of a Process Picture (Page 228)

The Coordinate System of an Object (Page 230)

The Rectangle Surrounding the Object (Page 232)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.11 How to rotate the objects

Introduction
Objects can be rotated around their center point. The rotation is clockwise and in steps of 90 
degrees.

The rotation of an object can cause its geometric attributes to change. Rotation can also 
change the alignment of elements in an object such as a text.
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Multiple selection
It is possible to rotate several selected objects simultaneously. The objects are each rotated 
around their center point.

Requirements
● Select any type of object except circle, application window, picture window, Control, OLE 

object, status display, 3D bars, group display and round button.

Procedure
In the standard toolbar, click the icon  to rotate the object clockwise around its center axis. 
It rotates 90 degrees.

Alternatively, you can select the "Rotate entry" in the "Arrange "menu.
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See also
Working with Objects (Page 378)

Basic Static Operations (Page 380)

The Rectangle Surrounding the Object (Page 232)

The Coordinate System of an Object (Page 230)

The Coordinate System of a Process Picture (Page 228)

The Standard Toolbar (Page 236)

Multiple Selection of Objects (Page 386)

How to mirror the objects (Page 395)

How to select an object (Page 385)

3.8.3.12 How to delete objects

Introduction
The "Delete" command removes a selected object from a picture. 

Multiple selection
It is possible to delete several selected objects simultaneously.

Requirements
● Select an object of any type.

Procedure
Press <DEL> to remove the selected object from the picture.

Alternatively you can use the "Delete" entry on the popup menu or on the "Edit" menu.

Note

You can easily correct operating steps unintentionally carried out:

Click the button  in the standard toolbar to undo the last executed action. You can undo 
the last 30 editing steps by repeatedly clicking this button.

Use the button  in the standard toolbar to redo the last executed action.
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See also
How to cut objects (Page 399)

How to copy objects (Page 400)

How to insert the contents of the clipboard (Page 401)

How to duplicate objects (Page 402)

How to insert an object into a picture (Page 382)

How to select an object (Page 385)

How to Select Multiple Objects (Page 388)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.13 How to cut objects

Introduction
The "Cut command" copies a selected object into the clipboard of the operating system. The 
object itself is removed from the picture.

Multiple selection
It is possible to cut several selected objects simultaneously.

Requirements
● Select an object of any type.

Procedure
Use the key combination <CTRL+X> to remove the selected object from the picture and copy 
it to the clipboard.

Alternatively, you can click the icon      in the standard toolbar or use the entry "Cut" in the 
pop-up menu or in the "Edit" menu.

Note

You can easily correct operating steps unintentionally carried out:

Click the button  in the standard toolbar to undo the last executed action. You can undo 
the last 30 editing steps by repeatedly clicking this button.

Use the button  in the standard toolbar to redo the last executed action.
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See also
Working with Objects (Page 378)

Basic Static Operations (Page 380)

How to Select Multiple Objects (Page 388)

How to select an object (Page 385)

How to insert an object into a picture (Page 382)

How to duplicate objects (Page 402)

How to insert the contents of the clipboard (Page 401)

How to copy objects (Page 400)

How to delete objects (Page 398)

3.8.3.14 How to copy objects

Introduction
The "Copy command" copies a selected object into the clipboard of the operating system. The 
advantage of copying to the clipborad is that that object can be inserted several times, and 
into different pictures.

Multiple selection
It is possible to copy several selected objects simultaneously.

Note

When inserting a copied object, an object name is automatically assigned. The name of the 
original object is used as object name and linked with a continuous number. No special 
characters are used in the object name. You change the object name using the "Object Name" 
attribute. 

Requirements
● Select an object of any type.

Procedure
Use the shortcut <CTRL+C> to copy the selected object to the clipboard.

Alternatively, you can click the icon  in the standard toolbar or use the entry "Copy" in the 
pop-up menu or in the "Edit" menu.
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See also
Working with Objects (Page 378)

How to copy objects to another picture (Page 298)

Basic Static Operations (Page 380)

How to Select Multiple Objects (Page 388)

How to select an object (Page 385)

How to insert the contents of the clipboard (Page 401)

How to cut objects (Page 399)

How to Rename Objects (Page 383)

How to duplicate objects (Page 402)

3.8.3.15 How to insert the contents of the clipboard

Introduction
The "Paste" command inserts the current contents of the clipboard into the active picture as 
often as required. If for example an object was copied to the clipboard, any number of copies 
of the object can be inserted into different pictures using this command.

Requirements
● The clipboard must have contents.

Procedure
1. Press the shortcut <CTRL+V>.         

The current contents of the clipboard are inserted into the active picture and selected.

2. Repeat this step to insert further copies of the contents.

Alternatively, you can click the icon  in the standard toolbar or use the entry "Paste" in the 
pop-up menu or in the "Edit" menu.

Note

Objects from other applications can also be inserted via the clipboard of the operating 
system.         
 

Position X and Position Y of the inserted object are each 20 pixel greater as as Position X 
and Y of the original object.         
 

The inserted object receives the object name of the original object but is supplemented by a 
continuous number.
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See also
How to copy objects (Page 400)

How to duplicate objects (Page 402)

How to cut objects (Page 399)

How to delete objects (Page 398)

How to select an object (Page 385)

How to Select Multiple Objects (Page 388)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.16 How to duplicate objects

Introduction
Use the "Duplicate" command to make a copy of the selected objects directly in the active 
picture. The object itself is not modified. The selected object is not copied to the operating 
system clipboard.

Multiple selection
It is possible to duplicate several selected objects simultaneously.

Requirements
● Select an object of any type.

Procedure
Select "Duplicate" on the popup menu or on the "Edit" menu to make a copy of the selected 
object directly in the active picture.

Note

Position X and Position Y of the duplicated object are each 20 pixel greater as as Position X 
and Y of the original object.         
 

The duplicated object receives the object name of the original object but is supplemented by 
a continuous number.
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See also
How to copy objects (Page 400)

How to cut objects (Page 399)

How to insert the contents of the clipboard (Page 401)

How to delete objects (Page 398)

How to select an object (Page 385)

How to Select Multiple Objects (Page 388)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.3.17 How to change the position of an object

Introduction
In the Graphics Designer, a picture consists of 32 layers in which the objects can be inserted. 
By default the objects are inserted in the level prefined for the respective object tye.

The position of the objects to one another can however also be changed within a level. This 
is important for example if several objects overlap and thereby over each other.
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When creating a process picture the objects of a level are by default arranged in the order in 
which they were configured. The object inserted first lies at the very back of the level, each 
additional object is inserted one position toward the front.

Multiple selection
It is possible to change the position of multiple selected objects simultaneously.         
This modification will always apply to the reference object relative to the position of the 
unselected objects. An individual position behind the reference object is assigned to each 
selected object.

Requirements
● The active picture should contain at least two objects of any type which partially overlap.

● Both objects must be on the same level.

● Select one of these objects.
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Procedure
Use one of the following shortcuts to change the position of the selected object:

● <CTRL> und <+> = "All the way to the front"         
The selected object is positioned in front of all the other objects contained in the picture.

● <CTRL> und <-> = "All the way to the back"         
The selected object is positioned behind all the other objects contained in the picture.

● <+> = "one to the front"         
The selected object moves up one position to the front.

● <+> = "one to the back"         
The selected object moves back one position.

Alternative Operation
● Select the required entry on the "Arrange / Within the Level" menu to change the position 

of the selected object.

● In the standard toolbar, click , to position the selected object in the very front.         
In the standard toolbar, click , to position the selected object in the very back.

Note

Some objects of the "Control" type generally are in the foreground.

See also
The Standard Toolbar (Page 236)

Working with Objects (Page 378)

Basic Static Operations (Page 380)

Working with Layers (Page 290)

The Layer Palette (Page 242)

How to change the default setting of object types (Page 379)

How to Select Multiple Objects (Page 388)

How to select an object (Page 385)

3.8.3.18 You can change the text contents of objects

Introduction
The "Linking" command is used to reconfigure the text contents of attributes for all selected 
objects. All configured texts are listed in a dialog and can be edited directly or using the "Find" 
and "Replace" functions.
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Open the "Find and Replace Texts" dialog.
Select all the objects whose text contents you want to change. If you do not select an object, 
all the objects in the active picture are evaluated.          
In the "Edit" menu select "Linking / Text" or from the popup menu of the selection or of the 
active picture.

Sort text contents
The three-columned upper area of the dialog lists the texts configured in the objects selection 
and the associated attributes and objects.          
    Click the column name to sort the list according to texts, properties or objects.
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Directly edit text contents
1. In the "Text" column, select the text contents to be changed.

2. Click the text once to activate the edit function.

3. Enter the new text contents and confirm this by pressing <ENTER>.

Find
You can select certain text contents using the "Find" function in the lower area of the dialog:

● Click "Select All" if you want to change the text contents displayed.

● Enter the text or parts of text you want to search for in the search field. You can also activate 
the options "Find whole words only" and "Match case". All text contents which so not meet 
the search criteria are hidden.

Replace
You can replace the selected text contents using the "Replace" function in the lower area of 
the dialog. Enter the new text in the field and click "Replace".

NOTICE

The "Replace" function replaces only the part of the text contents displayed in the "Find" field.

Note

Grouped objects can only be linked if there are no grouped objects in the group itself.

See also
You can link the tag connection of objects (Page 418)

How to Select Multiple Objects (Page 388)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.4 Basic Dynamic Operations

3.8.4.1 Basic Dynamic Operations

Introduction
To create a process picture, the required objects must be inserted from the Graphics Designer 
object palette into a picture. These objects are then dynamically linked suitably to a process 
to use the process picture to control and monitor processes.
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This chapter introduces the basic dynamic operations provided in the Graphics Designer to 
make objects dynamic:

● Making Attributes Dynamic

● Configuring Events

There is an extensive description of this topic in the chapter "Making Process Pictures 
Dynamic".

See also
How to make attributes dynamic (Page 408)

How to configure events (Page 410)

How to configure a dynamic dialog (Page 411)

How to configure a C action (Page 412)

How to configure a VBS action (Page 414)

How to Configure a Tag Connection (Page 416)

You can link the tag connection of objects (Page 418)

How to Configure a Direct Connection (Page 421)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)

3.8.4.2 How to make attributes dynamic

Introduction
You can make certain attributes dynamic in the "Object properties" dialog on the "Properties" 
tab.          
By linking the attributes with dynamic dialogs, VBS actions, C actions or tags, the properties 
of an object can be dynamically adapted to the requirements of the processes to be displayed. 

Certain attributes cannot be made dynamic because a change has no effect in runtime. These 
attributes have no dynamics icon. 

Note

As soon as an attribute is defined with a global design, it is static and can no longer be made 
dynamic. Pre-defined dynamics have no effect. 

The "Dynamic" column of the "Properties" tab displays the type of configured dynamics for the 
selected attribute and is marked by one of the following icons: 
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Dynamics icon Type of dynamics

White bulb No dynamics
Green bulb Dynamics with a tag
Red lightning Dynamics via a dynamic dialog
Green lightning with attached abbreviation "VB" Dynamics with a VBS action
Green lightning with attached abbreviation "C" Dynamics with a C action
Yellow lightning with attached abbreviation "C" Dynamics with a C action not yet translated

There is an extensive description of this topic in the chapter "Making Process Pictures 
Dynamic".

Prerequisites
● You have selected an object 

Procedure
1. Open the "Object properties" dialog and select the "Properties" tab. 

2. Select the property group containing the attribute to be made dynamic.

3. Right-click the Dynamic icon of the required attribute in the "Dynamics" column. 

4. Select the required dynamics type on the popup menu.
The associated dialog box opens.         
There is a brief description of the dynamics types in this chapter. 

See also
Global Design of the Objects (Page 92)

How to configure a dynamic dialog (Page 411)

How to configure a C action (Page 412)

How to configure a VBS action (Page 414)

How to Configure a Tag Connection (Page 416)

You can link the tag connection of objects (Page 418)

How to configure events (Page 410)

The "Object Properties" Window (Page 424)

Basic Dynamic Operations (Page 407)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)
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3.8.4.3 How to configure events

Introduction
The "Event" tag in the "Object Properties" window allows events to be configured.          
By linking the events with direct connections, VBS actions or C acions, certain actions can be 
triggered in Runtime by the operation of an object.

The "Action" column of the "Event" tab displays the type of configured dynamics for the selected 
event and is marked by one of the following icons.

Action icon Type of dynamics

White lightning There is no action for the event.
Blue lightning There is an action via direct connection for the 

event.
Green lightning with attached abbreviation "VB" There is a VBS action for the event.
Green lightning with attached abbreviation "C" There is a C action for the event.
Yellow lightning with attached abbreviation "C" There is a C action not yet translated for the event.

There are events which cannot be made dynamic because a change in Runtime has no effect. 
They have no action icon.

There is an extensive description of this topic in the chapter "Making Process Pictures 
Dynamic".

Requirements
● Select an object.

Procedure
1. Open the "Object Properties" window and select the "Event" tab.

2. Select the event group containing the event to be configured.

3. Right-click the action icon of the required event in the Action column.

4. Select the required dynamics type on the pop-up menu.         
The associated dialog opens.         
    There is a brief description of the dynamics types in this chapter.
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See also
How to configure a C action (Page 412)

How to configure a VBS action (Page 414)

How to Configure a Direct Connection (Page 421)

How to make attributes dynamic (Page 408)

The "Object Properties" Window (Page 424)

Basic Dynamic Operations (Page 407)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)

3.8.4.4 How to configure a dynamic dialog

Introduction
A dynamic dialog is used to achieve high Runtime performance when making attributes 
dynamic. A C action is automatically generated from the dynamic dialog. This can however be 
extended later. The advantage of higher Runtime performance is then lost.

A dynamic dialog is created with the "Dynamic Value Ranges" dialog which is described breifly 
here. More detailed information on this topic can be found under "Dynamics with the Dynamic 
dialog".

Opening the "Dynamic Value Ranges" dialog
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics column, "select 
the "Dynamic Dialog" Box entry from the popup menu od the attribute to be made dynamic.
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Event Name
The "Event Name" field displays the name of the selected trigger event which defines the 
update cycle for the value to be calculated.

The trigger event is configured using the "Trigger dialog". There is a choice of the events "Tag", 
"Standard cycle", "Picture cycle" and "Window cycle", which can be configured and renamed 
as required.

Click the button  to open the "Change trigger" dialog.

Expression / Formula
Specify the formula with which the new value of the attribute should be calculated in Runtime.

Click the button  in order to create the formula from the configured tags, global script 
functions and operators. Click "Check" to check the formula for errors.

Event of the Expression / Formula
This field displays the calculated value or value range. The evaluation of the event depends 
on the set data type.

Data type
Select the data type for the evaluation of the event. The options "Analog", "Bool", "Bit" and 
"Direct are available".

Evaluate status of tags
Activate this check box to view the current values of the tags in the formula.

See also
Process Picture Dynamics (Page 815)

3.8.4.5 How to configure a C action

Introduction
A C action is used to make attributes and events dynamic. The powerful script language ANSI-
C opens almost endless options for dynamics. However, the Runtime performance achieved 
is lower than with other dynamic types. Therefore, before using a C action you should check 
whether the required dynamics can be implemented with another dynamics type.

A C action is created with the "Edit action" dialog which is briefly described here. More detailed 
information on this topic can be found under "Dynamics with a C Action".
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Open "Edit action" dialog

Attribute
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics" column, select 
the "C Action" entry from the popup menu od the attribute to be made dynamic.

Event
Open the "Event" tab in the "Object Properties" window. In the "Action" column, select the "C 
Action" entry from the pop-up menu of the event to be made dynamic.

toolbar
The toolbar of the "Edit action" dialog also contains the following buttons in addition to the 
familiar icons:

Icon Name Description

Create Action Checks the program codes of the C action for errors

Tag Selection Selects tags which should be evaluated in the C action

Selection of 
Picture

Selects the picture of the PDL format which should be evaluated 
in the C action

Import an Action Imports an existing C action.          
C actions are saved in the ACT file format.

Exporting an 
Action

Exporting the new or modified C action.         
C actions are saved in the file format ACT.
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Event Name
The "Event Name" field displays the name of the selected trigger event which defines the 
update cycle for the value to be calculated.

The trigger event is configured using the "Trigger dialog". There is a choice of the events "Tag", 
"Standard cycle", "Picture cycle" and "Window cycle", which can be configured and renamed 
as required.

Click the button  to open the "Change trigger" dialog.

Editor window
The editor window shows and edits the program code of the C action. Functions, tags and 
pictures can be inserted and modified at the respective current cursor position.

Function selection
The function selection shows the Global Script functions available in the project in the form of 
a directory tree. You can use these functions to create the C actions. 

Double-click the required function to configure the contained paramaters with the Set 
"Parameters" dialog. Confirm the new parameters by clicking "OK" to insert the function with 
the new values at the position of the cursor in the editor window.

See also
Dynamizing Using C Action (Page 877)

3.8.4.6 How to configure a VBS action

Introduction
A VBS action is used to make attributes and events dynamic. The script language of a VBS 
action is Visual Basic.

A VBS action is created with the "Edit VBS action" dialog which is briefly described here. More 
detailed information on this topic can be found under "Dynamics with a VBS Action".

Open "Edit VBS action" dialog

Attribute
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics" column, select 
the "VBS Action" entry from the popup menu od the attribute to be made dynamic.
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Event
Open the "Event" tab in the "Object Properties" window. In the "Action" column, select the 
"VBS Action" entry from the pop-up menu of the event to be made dynamic.

toolbar
The toolbar of the "Edit VBS action" dialog also contains the buttons described below in addition 
to the familiar icons: The composition of the icons on the toolbar varies according to the types 
of attribute or event for which a VBS action was configured.

Icon Name Description

Single view Displays the currently edited module

Full view Displays all modules

Comment Changes marked program lines into commentary 
lines

Uncomment Deletes the commentary marking of a program line

Setting Bookmarks Marks a program line for further editing

Delete Bookmark Deletes the marking of a program line

Next bookmark Jumps from the current cursor position to the next 
bookmark

Previous bookmark Jumps from the current cursor position to the 
previous bookmark

Syntax Check Checks the program codes of the VBS action for 
errors

Tag Selection Selects tags which should be evaluated in the VBS 
action
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Icon Name Description

Tag dialog with extended return 
parameter

Selects tags which should be evaluated in the VBS 
action          
The selection is made via a dialog with extended 
return parameter.

Selection of Picture Selects the picture of the PDL format which should 
be evaluated in the C action

Event Name
The "Event Name" field displays the name of the selected trigger event which defines the 
update cycle for the value to be calculated.

The trigger event is configured using the "Trigger dialog". There is a choice of the events "Tag", 
"Standard cycle", "Picture cycle" and "Window cycle", which can be configured and renamed 
as required.

Click the button  to open the "Change trigger" dialog.

Editor window
The editor window shows and edits the program code of the VBS action. Visual Basic modules, 
tags and pictures can be inserted and modified at the respective current cursor position.

Module selection
The module selection displays Visual Basic modules already available in the form of a directory 
tree. There are three tabs in which "Project modules", "Standard modules" and "Code 
templates" are made available. You can use these modules to create the VBS actions.

See also
Activating Project (Page 132)

Dynamizing Using VBS Action (Page 866)

3.8.4.7 How to Configure a Tag Connection

Introduction
Attributes can be made dynamic using a tag connection. Connecting an attribute to a process 
tag for example enables the change of the measurement value to be displayed graphically.

All tags available in the project can be selected in the "Tags - project: ..." dialog, which is briefly 
described here. More detailed information on the topic can be found under "Making Dynamic 
using Tag Connection and "under "Tag Management".
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"Tags – Project:" dialog ..." Opening
Open the "Properties" tab in the "Object Properties" window. In the "Dynamics" column, select 
the "Tag" entry from the pop-up menu of the attribute to be made dynamic. 

Filter
If there is a large number of configured tags, the search procedure can take some time. For 
instance, for 15,000 tags the search procedure takes about a minute.

By specifying a filter, you can narrow the scope of the search and reduce the duration of the 
search procedure. You can achieve a significant increase in efficiency if you configure tags 
with the aid of a tag prefix.

Data source
You can use the "Data Source" window to select the tags it is intended to display.

Tag groups
The selected tag group complete with its sub-folders is displayed in the left-hand area in the 
form of a folder tree.         
Directories and subdirectories can be opened or closed by clicking on the "+" or "-" icons. The 
tags available for the selected entry are shown in the tag display.

Tag display
The right-hand area contains all the tags that are available for the entry The tag display is 
divided into four columns showing the tag name, type and parameter, and the point in time at 
which the tag was last changed. Tags can be sorted by clicking on the respective column 
heading.
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Procedure
1. Select the required filter. An asterisk means that no filter is to be used or no filter has been 

defined.

2. Select one or more data sources.

3. Open the desired tag group in the left-hand window area.

4. Select the desired tag from the right-hand window area.

5. Confirm you selection with "OK".         
The dialog "Tags - project: ..." will be closed.         
The selected tag is assigned to the selected object and you can continue with the 
configuration.

See also
Dynamizing by Means of Tag Connection (Page 838)

3.8.4.8 You can link the tag connection of objects

Introduction
The "Linking" command is used to reconfigure the tag connection for all selected objects. The 
tag connections configured for the selection are listed in a dialog and can be linked directly or 
with the aid of the "Find" and "Replace" functions.

Open "Linking of the Tag Connection" dialog
Select all the objects whose tag connection contents you want to link.          
On the "Edit" menu select "Linking / Tag Connection" or from the popup menu of the selection.
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Linking tags at the places of use

Tag Selection
The left area of the "Places of Use" tab shows a list of the tags configured in the object selection. 
All objects are assigned to these tags in the form of a folder tree which contains the dynamics 
of the respective tag.

Select a tag or object. The detail view shows the current tag connections.

Details
The right area of the "Places of Use" tab shows the current tag connections for the selected 
tag or object. You can link these tag connections:

Right-click the required tag connection to call the "Linking" command. The "Linking a Tag" 
dialog opens.
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Enter the name of the new tag or click the associated button to select a tag.

Linking tags by searching and replacing

Find
The left area of the "Find and Replace" tag shows the names of all tags configured in the object 
selection. There are three search options available to select certain tag names:
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● Click "Select All" if you want to link the texts displayed.

●
Select a tag name and click the button , if you only wish to change the connections to 
this tag. All remaining tag names are hidden.

● Enter the tag names or parts of names you want to search for in the search field. You can 
also activate the options "Find whole words only" and "Match case". All tags which so not 
meet the search criteria are hidden.

Replace
In the right area of the "Find and Replace" tab you can enter the name of the new tag with 
which the selected tag names should be replaced. Alternatively you can click the associated 
button to select the required tag.

Click "Preview" to view and check the planned replacement.         
Click "Replace" to link the selected tag connections as in the preview.

NOTICE

The "Replace" function replaces only the part of the tag names contents displayed in the 
"Find" text field of the area.

Note

Grouped objects can only be linked if there are no grouped objects in the group itself.

See also
You can change the text contents of objects (Page 405)

How to Configure a Tag Connection (Page 416)

How to Select Multiple Objects (Page 388)

Basic Static Operations (Page 380)

Working with Objects (Page 378)

3.8.4.9 How to Configure a Direct Connection

Introduction
Events can be made dynamic using a direct connection. A direct connection offers the quickest 
dynamics in the picture and acheives the hightest Runtime performance. However the direct 
connection can only be used within a process picture and only one connection can be created.

A direct connection is created with the "Direct Connection" dialog which is briefly described 
here. More detailed information on this topic can be found under "Dynamics with a Direct 
Connection".
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Opening the "Direct Connection" dialog
Open the "Event" tab in the "Object Properties" window. In the "Action" column, select the 
"Direct Connection" entry from the popup menu of the event to be made dynamic.

Source
You can select a constant, object property or a tag as the data source:

Constant
Click the associated buton or select a picture of the PDL format which provides the constant.

Object property
Select the object and an attribute of the object whose value should be used as the data source.

Tag
Click the associated button and select the required tag. Define whether the update of the tags 
should be done permanently (directly) or only when called (indirectly).

Objective
You can select "Current window", "Object in Picture" or "Tag" as the target which should take 
the value of the data source:
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Current window
Select this option if you want to assign the value of the data source to the active picture.

Object in the picture
Select the object and attribute of this object to which you want to assign the value of the data 
source.

Tag
Click the associated button and select the required tag which should take the value of the data 
source. Define whether the update of the tags should be done permanently (directly) or only 
when called (indirectly). If required, you can activate the output of a operator message.

See also
Dynamizing by Means of Direct Connection (Page 841)

3.8.5 The Properties of an Object

3.8.5.1 The Properties of an Object

Introduction
Form, appearance and visibility, position and process connection of an object are determined 
by the "Object properties". These properties can be changed as required in the Graphics 
Designer. 

The properties of an object are described by a large number of "attributes". An object property 
can be changed by assigning a new value to its attribute.

The "Object Properties" window on the "Properties" tab contains all the attributes of a selected 
object or a multiple selection of objects. The attributes are divided into property groups, such 
as "geometry" or "Colors". The type and number of the available property groups and attributes 
are dependent on the type of the selected objects. So, for example, the "Font" property group 
is only shown for the object types which can be displayed with text.

With a multiple selection it is possible that individual property groups for one specific object 
type are summarized to a shared property group. All attributes of the summarized property 
groups available in this group are contained under the "User defined" label.

As an alternative to changing the attributes in the "Object properties" window, objects can also 
be adjusted with the mouse and keyboard or by using the toolbar and palettes. However, in 
this way only certain object properties, such as the basic geometric size, color and line style, 
can be changed.
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See also
Elements and Basic Settings of the Graphics Designer (Page 228)

Working with Objects (Page 378)

Special Runtime Settings (Page 466)

Property Groups and Attributes (Page 437)

The "Object Properties" Window (Page 424)

3.8.5.2 The "Object Properties" Window

The "Object Properties" Window

Introduction
In the Graphics Designer, the "Object Properties" window represents the central dialog for 
changing object properties.

To create process pictures it is firstly important to adapt the static values of attributes to for 
example define the shape, appearance, position or operability of an object. The "Object 
Properties" window allows however process pictures to be made dynamic. By linking the 
attributes with dynamic dialogs, C actions or tags, the properties of an object can be 
dynamically adapted to the requirements of the processes to be displayed. An extensive 
description of dynamic procedures can be found in the chapter Making "Process Pictures 
Dynamic".

As an example, the "Object properties" window can have the following appearance for a 
rectangle with the object name "Rectangle1":

The "Object Properties" window can be pinned on top of the Graphics Designer. The position 
and size of the window can be changed as you like.         
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The "Object Properties" window is subdivided into Elements toolbar, and the "Properties" and 
"Event" tabs. You can find more about these elements in their detailed description.

Keeping the "Object properties" window in the foreground

Activating Pin
By activating the "Pin" button, the "Object Properties" window can be set so that it is always 
in the foreground in the Graphics Designer.

1. On the toolbar of the "Object Properties", click .         

The button is activated and displays the icon .         
    The "Object Properties" window is pinned on top.

Deactivating Pin
1. On the toolbar of the "Object Properties", click .         

The button is deactivated and displays the icon .         
    The "Object Properties" window is hidden, as soon as the mouse is clicked outside the 
window.

Calling direct help for the "Object Properties" window

In the title bar of the "Object properties" window click . Then click the window element for 
which you want to call the direct help. A brief description of the element is shown.

See also
Opening the "Object properties" window (Page 433)

How to Change an Attribute (Page 434)

How to Transfer Object Properties (Page 435)

How to change the default setting of object types (Page 379)

The Toolbar in the "Object Properties" Window (Page 426)

The "Properties" Tab in the "Object Properties" Window (Page 428)

The "Events" Tab in the "Object Properties" Window (Page 431)

The Properties of an Object (Page 423)
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The Toolbar in the "Object Properties" Window

Introduction
You can make the following settings with the toolbar in the "Object properties" window:

● The "Object Properties" can be pinned on top in the Graphics Designer.

● Object properties can be transferred.

● You can select individual objects of the active picture.

● As an example, the toolbar can have the following appearance for a rectangle with the 
object name "Rectangle1":

Elements of the toolbar in the "Object properties" window

Icon Name Function

/ 

"Pin"         
activated/
deactivated

Deactivate:          
The "Object Properties" window will be closed as soon 
as the mouse is clicked outside the windows.         
Aktivated:          
The Object Properties window stays in the foreground 
at all times. Different objects can be edited without 
having to open the window again.

"Eyedropper"         
Copy properties

The properties of a selected object are copied.

"Eyedropper"         
Assign properties

The previously copied properties are transferred to the 
selected object without changing its geometric 
attributes. For different object types, only those 
attributes which both object types have are transferred.

"Object type" Displays the object type of the selected object. With 
several objects, here displays whether it is a "Multiple 
selection", a "Group" or a "User object".

"Object selection" Displays the name of the selected object.          
A different object can be selected in the dropdown list 
field. The dropdown list field shows the names of all 
objects in the active picture. The font style of the entries 
depends on the type of dynamics.
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Font styles of the object selection
Different font style particularly highlight dynamic objects and the type of dynamics in the object 
selection. The following font styles are used:

● normal         
No dynamics were configured for the object. The object is not the target of a configured 
direct connection.

● bold         
At least one dynamics was configured for the object. However, the object is not the target 
of a configured direct connection.

● italics         
No dynamics were configured for the object. The object is the target of at least one 
configured direct connection.

● bold and italic         
At least one dynamics was configured for the object. The object is the target of at least one 
configured direct connection.

See also
Opening the "Object properties" window (Page 433)

How to Change an Attribute (Page 434)

How to Transfer Object Properties (Page 435)

The "Properties" Tab in the "Object Properties" Window (Page 428)

The "Events" Tab in the "Object Properties" Window (Page 431)

The "Object Properties" Window (Page 424)
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The "Properties" Tab in the "Object Properties" Window

Introduction
In the "Object Properties" window, the "Properties" tab represents the central dialog to change 
static values of a selected object. 

● The "Properties" tab can for example have the following appearance for a rectangle with 
the object name "Rectangle1":

The width of both window areas and the columns in the attribute display can be changed by 
moving the vertical separation lines.

Properties folder
The left area shows the selected object with its property groups in the form of a folder tree. 
The selected object is displayed as a directory.          
    With a multiple selection or a user object, this folder only receives the shared property groups 
of the contained individual objects. With a selected group the shared property groups are listed 
first and then, as a subfolder, the individual objects with their property groups.         
    It is not possible to change the entries in the property folder. Directories and subdirectories 
can be opened or closed by clicking on the "+" or "-" icons. The attributes available for the 
selected entry are shown in the attribute display.

Attribute display
The right-hand area contains all the attributes that are available for the entry The attribute 
display is divided into five columns in which the static values of the selected object are 
displayed.         
The displayed values can be changed by double-clicking or opening the pop-up menu in the 
respective column.
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Columns of the attribute display

Column Function Description

Attribute Attribute name All of the attributes from the selected property group that are available 
for the selected object will be shown.         
The name of the attribute cannot be changed. The static value of the 
attribute can be changed by double-clicking the name of the attribute.

Static Static value of the 
attribute

The current value of the attribute is shown for the selected object. The 
value will be displayed as a number, text or graphic display, depending 
on the type of attribute.         
The static value of the attribute can be changed by double-clicking the 
attribute name. Further information can be found in chapter "Changing 
Object Properties".

Dynami
c

Dynamization of 
attribute

The type of dynamics is displayed and marked by one of the following 
icons:         
white bulb = no dynamics         
green bulb = dynamics with one tag         
red lightning = dynamics via a dynamics dialog         
green lightning = dynamics with a C action         
yellow lightning = dynamics with C action that has not yet been 
translated         
         
The dynamics of the attribute can be changed. Right-clicking opens a 
popup menu on which the required dynamics can be set.         
    Further information can be found in chapter "Making Process Picture 
Dynamic".

Current Update cycle of 
the attribute

The setting for the update cycle is displayed if dynamics of the attribute 
are set.         
         
    The update cycle of the attribute can be changed by double-clicking 
on the value. Further information can be found in chapter "Changing 
Object Properties".

Indir. Indirect attribute 
addressing

An attribute can be directly or indirectly made dynamic:         
Direct = The attribute is made dynamic directly with the tag 
content.         
Indirect = The attribute is linked to a tag of the type "string", which 
references another tag. The attribute is made dynamic with the contents 
of the referenced tag.         
         
    Indirect addressing of the attribute can be activated by double-clicking 
the check box if the attribute is made dynamic with a tag. Further 
information can be found in chapter "Making Process Picture Dynamic".
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Font styles to display dynamics and events
Dynamics and events are particularly highlighted with the aid of different font styles. The 
following font styles are used:

● bold         
As soon as a dynamics or event has been configured for an attribute of the selected object, 
this attribute is displayed in bold in the attribute screen. The associated property group in 
the property folder and the selected object in object selection of the toolbar are also 
displayed in bold.

● italics         
If a direct connection was configured for an event, the target of the direct connection is 
displayed in italics in the attribute screen. The target object is also displayed in italics in the 
object selection of the toolbar.

● bold and italic         
If an object is the target of a direct connection as well as dynamic itself, the attribute in the 
attribute screen and the object in the object selection are displayed in bold and italics.

See also
Opening the "Object properties" window (Page 433)

How to Change an Attribute (Page 434)

How to Transfer Object Properties (Page 435)

How to change the default setting of object types (Page 379)

The Toolbar in the "Object Properties" Window (Page 426)

The "Events" Tab in the "Object Properties" Window (Page 431)

The "Object Properties" Window (Page 424)
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The "Events" Tab in the "Object Properties" Window

Introduction
In the "Object Properties" window the "Event" tab represents the central dialog for configuring 
events. Configuring events is described extensively in the chapter "Making Process Pictures 
Dynamic".

● The "Event" tab in the "Object Properties" window, for example, can have the following 
appearance for a rectangle with the object name "Rectangle1":

The width of the two window areas and the columns in the event display can be changed by 
moving the vertical dividing lines.

Event folder
The left area shows the selected object in the form of a folder tree. This folder shows entries 
such as for example "Mouse", "Keyboard", "Focus" and "Misc" with which events for the 
operation of the entire object can be configured. The "Property Topics" displays all property 
groups of the selected object. An event can also be configured for each individual attribute of 
a property group. If there are several individual objects in the selected object, the structure is 
repeated for each individual object.         
    It is not possible to change the entries in the property folder. Directories and subdirectories 
can be opened or closed by clicking on the "+" or "-" icons. The configurable events for the 
selected entry are shown in the event display. 

Event display
The right-hand area contains all the events that are available for the entry The event display 
is divided into two columns in which the events and the linked actions are displayed.         
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The displayed actions can be changed by double-clicking or opening the pop-up menu in the 
"Action" column.

Columns of the event display

Column Function Description

Run at Event 
type

All events are displayed which are available for the selected object and assigned 
to the entry selected in the event directory.         
         
The name of the event cannot be changed. The configured action can be 
changed by double-clicking the name of the attribute.

Action Action 
selection

The action, which is run when the event occurs, is displayed. The selected action 
is marked by one of the following symbols:         
White lightning = There is no action for this event.         
Blue lightning = There is one action for this event via a direct connection.         
Green lightning = There is a C action for this event.         
Yellow lightning = There is a not yet translated C action for this event.         
         
The configured action can be changed by double-clicking on the column "Execute 
with" or by retrieving the pop-up menu in the column "Action". Further information 
can be found in chapter "Making Process Picture Dynamic".

Triggering events

Event Run at Description         
 

Mouse Mouse 
click

Is triggered if the cursor is on the object when the mouse button is pressed and 
released.

Mouse Click left/
right

Is triggered when pressing the mouse button directly on the object. 

Mouse Release 
left/right

Is triggered when releasing the mouse button for the object the cursor was over 
when the mouse button was pressed.

Keyboa
rd

Pressing Is triggered when pressing a key on the keyboard. The keys <F10> and <ALT
+PRINT> must not be used for process operation.

Keyboa
rd

Releasin
g

Is triggered when releasing a key on the keyboard. The keys <F10> and <ALT
+PRINT> must not be used for process operation.

Focus Focus 
change

Occurs during focus reception, caused by C action, VBS action or selection of an 
object using (TAB sequence) or mouse click.

Miscell
aneous

Object 
change

Occurs if at least one object attribute changes.

Object 
attribut
es

Change Most object attributes have the Change event. It is used to be able to react 
specifically to the change of a certain attribute. The event occurs if the attribute 
value changes. The action linked to this event is logged on individually. With 
"Close Picture", all actions logged on at this point are logged off individually. This 
leads to an increased system load. To keep the system load low, this event type 
should be used sparingly and only there where it is absolutely necessary to react 
to the change. This is the case for example when inputting a value in the I/O field.
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See also
Opening the "Object properties" window (Page 433)

How to Change an Attribute (Page 434)

How to Transfer Object Properties (Page 435)

How to change the default setting of object types (Page 379)

The Toolbar in the "Object Properties" Window (Page 426)

The "Properties" Tab in the "Object Properties" Window (Page 428)

The "Object Properties" Window (Page 424)

Opening the "Object properties" window

Introduction
The "Object Properties" window on the "Properties" tab contains all the attributes of a selected 
object or a multiple selection of objects. The changes are made to an object property by 
assigning a new value to accompanying attribute.

Requirements
● Select an object of any type.

Procedure
Open the "Object Properties" window by doing one of the following:

● In the standard toolbar, click the icon .

● Double-click the selected object.

● Choose the "Properties" option from the pop-up menu.

● Select "Properties" on the "View" menu.

Note

If you want to make changes to several objects, you can lock the display of the "Object 
Properties" window with the .
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See also
The "Object Properties" Window (Page 424)

How to Transfer Object Properties (Page 435)

How to Change an Attribute (Page 434)

The "Events" Tab in the "Object Properties" Window (Page 431)

The "Properties" Tab in the "Object Properties" Window (Page 428)

The Toolbar in the "Object Properties" Window (Page 426)

How to Change an Attribute

Introduction
The properties of an object are defined in the Graphics Designer with values, which the 
attributes of objects possess. Every change to an object, for example made with the mouse 
or via a configuration dialog, changes the value of the accompanying attributes.

The "Object Properties" window on the "Properties" tab shows all the attributes of a selected 
object or a multiple selection of objects. The attributes are assigned to so-called "property 
groups". The type and number of the available property groups and attributes are dependent 
on the type of the selected objects. So, for example, the "Font" property group is only shown 
for the object types which can be displayed with text.

An object property can be changed by assigning a new value to its attribute. Depending on 
the attribute type, the change in the value in the attribute display of the "Properties" tab is made 
using different procedures which are broadly described below. Entries for changing a specific 
attribute can be found in the detailed description of that attribute.

Procedure
1. Open the "Object Properties" window.

2. On the "Properties" tab, select the required property group.

3. Double-click the desired attribute.         
A dialog to input or select the new value opens or the value is automatically changed by 
double-clicking.

Attribute change via the "Value Input" dialog
Enter a new value in the "Value" Input dialog and confirm this by clicking "OK".          
Alternatively, you can directly enter the new value by double-clicking on the "Static" column.

Attribute change via the "Text Input" dialog
In the "Text Input" dialog, click the "Text input" field to enter the new text.         
For text with multiple lines, you can make a line break with the key combination <SHIFT
+ENTER> or <CTRL+M>. Confirm you entry with "OK".         
Alternatively, you can directly enter the new value by double-clicking on the "Static" column.
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Attribute change via a switchover
If there are two values available for an attribute, for example the choice between "Yes" and 
"No", each double-click causes a switchover between these two values.          
    Alternatively you can cause the switchover by double-clicking the "Static" column.

Attribute change via a selection dialog

Selection in the form of buttons
Click on the button to set the new value.         
Alternatively you can select the new value in the dropdown list field after double-clicking the 
"Static" column.

Selecting a color
In the selection dialog, select one of the 16 standard colors or open the palette with the 
customized colors. In this palette, you can freely define additional colors.         
Alternatively you can select the color selection by double-clicking the "Static" column.

Selecting a picture
Select a picture from the picture selection or open a selection window using the "Find" button 
via which you can add other pictures to the picture selection. Confirm you selection with 
"OK".         
Alternatively, you can directly enter the name of the new picture by double-clicking on the 
"Static" column.

See also
The "Object Properties" Window (Page 424)

The Start Screen of the Graphics Designer (Page 234)

The "Properties" Tab in the "Object Properties" Window (Page 428)

Property Groups and Attributes (Page 437)

How to Transfer Object Properties (Page 435)

How to Transfer Object Properties

Introduction
The properties of an object can be transferred to another object with the "eyedropper". In the 
Graphics Designer, you can use the following buttons to transfer object properties:

to copy properties of the selected object
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to apply copied properties to a selected object

These buttons are in the standard toolbar and in the "Object properties" toolbar. Alternatively, 
these functions can be selected via the "Edit / Properties" menu.

With the exception of the user object, you can copy the properties of any object using the 
eyedropper. You can also transfer the copied properties to any object such as to a multiple 
selection, a group or a user object. The properties are transferred without changing the 
geometric attributes of the object. With different object types, only those attributes which both 
object types possess are changed.

Procedure
1. Select the object whose properties you want to copy.

2. In the standard toolbar, click .         
The properties of the selected object are copied.

3. Select the object to which you want to assign the copied properties.

4. In the standard toolbar, click .         
The selected object will be displayed with the new properties, but without changing its 
geometric attributes. With different object types, only those attributes which both object 
types possess are changed.

Note

It is possible to transfer the value of a selected attribute to other attributes using the 
eyedroppers in the "Object Properties" window.

See also
How to Change an Attribute (Page 434)

How to change the default setting of object types (Page 379)

The Toolbar in the "Object Properties" Window (Page 426)

The Standard Toolbar (Page 236)

The "Object Properties" Window (Page 424)
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3.8.5.3 Property Groups and Attributes

Property Groups and Attributes

Introduction
On the "Properties" tab of the "Object properties" dialog all property groups are displayed which 
are available for the selected object. If you select one of these properties, the associated 
attributes for the selected object are listed in the attribute display. 

You change the properties of an object by allocating the respective attributes with new values. 
If you make an attribute dynamic, it will be changed dynamically in runtime. 

Note

As soon as an attribute is defined with a global design, it is static and can no longer be made 
dynamic. Pre-defined dynamics have no effect.

This chapter introduces all property groups and the associated attributes. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed. 

An extensive description of the individual attributes can be found in the "Direct help" which can 
be called from the pop-up menu of the required attribute.
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See also
Working with Objects in the Object Palette (Page 473)

"Geometry" Property Group (Page 438)

"Colors" Property Group (Page 441)

"Styles" Property Group (Page 443)

"Font" Property Group (Page 446)

"Flashing" Property Group (Page 448)

"Miscellaneous" Property Group (Page 450)

"Filling" Property Group (Page 453)

The "Display" property group (Page 445)

"Picture" Property Group (Page 454)

"Pictures" Property Group (Page 455)

"Status" Property Group (Page 456)

"Axis" Property Group (Page 457)

"Limits" Property Group (Page 458)

"Output / Input" Property Group (Page 459)

"Message Types" Property Group (Page 461)

"Lock" Property Group (Page 463)

"Connected Objects" Property Group (Page 464)

"Assignment" Property Group (Page 465)

The Properties of an Object (Page 423)

How to Change an Attribute (Page 434)

"Geometry" Property Group

Introduction
The "Geometry" property group contains attributes, which you can use to change the geometric 
properties of objects.

Requirements
The "Geometry" property group is available for all objects.
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Overview
The following table shows all attributes in the "Geometry" property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

Current value X Horizontal position of the currently selected corner 
point, relative to the image origin.         
(Unit: Pixels)

Polygon, polyline, connector

Current value Y Vertical position of the currently selected corner 
point, relative to the image origin.         
(Unit: Pixels)

Polygon, polyline, connector

Alpha Depth angle Alpha for the 3D effect         
(Unit: Degree)

3D Bar

Start angle Start angle for the display of segment or arc 
objects         
(Unit: Degree)

Ellipse arc, ellipse segment, 
circular arc, pie segment, 
tube bend

Number of corners Number of corner points Polygon, polyline, polygon 
tube

Number of boxes Number of available selection fields Check Box, Radio Box
Number of rows Number of rows of text displayed Combobox, list box 
Alignment Direction of movement of the slider control          

(Value: horizontal or vertical)
Slider

Bar Width Width of the 3D bar         
(Unit: Pixels)

3D Bar

Bar Height Height of the 3D bar         
(Unit: Pixels)

3D Bar

Bar direction Direction of the positive bar axis         
(top, bottom, left, right)

Bar, 3D bar

Bar depth Depth of the 3D bar         
(Unit: Pixels)

3D Bar

Base X Horizontal distance from the right bar edge to the 
left object field edge

3D Bar

Base Y Vertical distance from the lower bar edge to the 
upper object field edge

3D Bar

Beta Depth angle Beta for the 3D effect         
(Unit: Degree)

3D Bar

Width     Distance between the left and right borderline 
of an object         
(Unit: Pixels)

All objects except application 
and picture windows

Width Button 1-8 Individual width for each of the eight buttons 
(1-8)         
(Unit: Pixels)

Group Display

Display axis Coordinate axis on which the measurement values 
are displayed as 3D bars

3D Bar

Corner radius X Radius of the corner rounding         
(Unit: Percentage)

Rounded rectangle

Corner radius Y Radius of the corner rounding         
(Unit: Percentage)

Rounded rectangle
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Attribute Function Object type

End angle End angle for the display of segment or arc 
objects         
(Unit: Degree)

Ellipse arc, ellipse segment, 
circular arc, pie segment, 
tube bend 

Window width Distance between the left and right 
borderline         
(Unit: Pixels)

Application window, picture 
window

Window height Distance between the top and bottom border 
line         
(Unit: Pixels)

Application window, picture 
window

Same size Display type of the four buttons Group display
Height Distance between the top and bottom border line 

of an object         
(Unit: Pixels)

All objects except application 
and picture windows

Index Number of the currently selected corner points Polygon, polyline, connector, 
polygon tube

Position X Horizontal distance of the object origin from the 
image origin          
(Unit: Pixels)

All objects

Position Y Vertical distance of the object origin from the 
image origin          
(Unit: Pixels)

All objects

Radius Radius of a circular object          
(Unit: Pixels)

Circle, circular arc, pie 
segment, round button

Radius X Horizontal radius of an elliptical object          
(Unit: Pixels)

Ellipse, ellipse arc, ellipse 
segment, tube bend

Radius Y Vertical radius of an elliptical object          
(Unit: Pixels)

Ellipse, ellipse arc, ellipse 
segment, tube bend

Rotation 
reference X

Horizontal coordinates of the reference point 
around which an object is shown to rotate in 
Runtime (Unit: Percentage)

Line, Polygon, Polyline, 
Static Text

Rotation 
reference Y

Vertical coordinates of the reference point around 
which an object is shown to rotate in Runtime (Unit: 
Percentage)

Line, Polygon, Polyline, 
Static Text

Rotation angle Angle around which an object is shown to rotate 
in Runtime (Unit: Degree)

Line, Polygon, Polyline, 
Static Text

Rotation angle Orientation of a T-piece upwards, left, downwards 
or right (unit: degrees). The values 0, 90, 180 and 
270 are permitted. Other entries are rounded to 
the multiple of 90.

T-piece

Angle settings Type of depth display for the 3D effect 3D Bar
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See also
How to Change an Attribute (Page 434)

Setting Up Rotation of Objects (Page 466)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Colors" Property Group

Introduction
The "Colors" property group contains attributes which you can use to change the color settings 
of objects. 

Note

Either define the color directly in the "Color selection" dialog or select an indexed color from 
the central color palette if a central color palette is defined. 

Prerequisites
The "Colors" property group is available for all objects except application windows, picture 
windows, Control and OLE object. 

If you have selected a global design in the project, it is possible to have certain attributes of 
the "Colors" property group only become effective if the "Global color scheme" is set to "No" 
under "Display". 

Overview
The following table shows all attributes in the "Colors" property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

3D Border Color Top Color of the left and upper part of the 3D border Button, round button
3D Shadow Color Color of the right and lower part of the 3D border Button, round button
List Background 
Color

Background color of the non-selected entries in 
the selection list

Text list, multiline text

List Font Color Font color of the non-selected entries in the 
selection list

Text list, multiline text

Bar Color Color of the bar to display the current value Bar
Bar Background 
Color

Color of the bar background Bar

High Limit Color Color of the upper and right arrow key Slider object
Low Limit Color Color of the lower and left arrow key Slider object
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Attribute Function Object type

Fill pattern color Color of the fill pattern Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, 
rounded rectangle, static 
text,         
I/O field, bar, graphics 
object, text list,         
multiline text, combobox, list 
box, all Windows objects

Background color Fill color of the object Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, 
rounded rectangle, static 
text,         
I/O field, bar, graphics 
object, text list, multiline text, 
combobox, list box, 3D 
bar,         
all Windows objects

Button Color Color of the regulator Slider object
Line color Color of the line all standard objects except 

static text,         
graphics object, status 
display,         
all Windows objects, all tube 
objects

Line background 
color

Background color of line all standard objects,         
graphics object, status 
display,         
all Windows objects

High Limit 
Background Color

Color of the upper and right slider surface Slider object

Border Color Color of the border Static text,         
I/O field, bar, text list, 
multiline text, combobox, list 
box, 3D bar, round button

Border Background 
Color

Background color of the border I/O Field, bar, multiline text, 
combobox, list box, text list, 
round button

Font Flash Color Color that text takes on when flashing  
Font color Color of the text in an object Static text,         

I/O field, text list, multiline 
text, combobox,          
list box, button, check box, 
radio box, round button 

Selection 
Background Color

Background color in the selected entry of the 
selection list

Text list, multiline text

Selection Font Color Color of the font in the selected entry of the 
selection list

Text list, multiline text

Scale Color Color to display the scale and label Bar
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Attribute Function Object type

Trend Color Color of the trend display which is displays the 
trend of the measurement value in the form of a 
small arrow at the lower end of the bar

Bar

Dividing Line Color Color of the dividing lines in the selection list Text list, multiline text
Dividing Line 
Background Color

Background color of the dividing lines in the 
selection list

Text list, multiline text

Low Limit 
Background Color

Color of the lower and left slider surface Slider object

See also
The central color palette (Page 248)

How to Change an Attribute (Page 434)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Styles" Property Group

Introduction
The "Styles" property group contains attributes which you can use to change the style for the 
appearance of objects.

Requirements
The "Styles" property group is available for all objects except application windows, picture 
windows, Control and OLE object.

Overview
The following table shows all attributes in the "Styles" property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

3D border weight Line weight of the 3D border         
(unit: pixel)

Group display         
button, round button

Bar pattern Pattern to display the bar surface, for example 
solid or broken

Bar

Border weight Width of the border of a slider control         
(unit: pixel)

Slider

Display as drop-
down list

Display as single object with arrow button for drop-
down

Text list
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Attribute Function Object type

Corners Representation of the corners of an object, e.g. 
round, flat or pointed          
(associated with the "Line style" attribute)

all standard objects,         
graphics object, status 
display,         
all Windows objects

Latch down Saves the last selected switch positioned 
("Pressed" or "Not pressed")

Button, round button, 

Box alignment Arrangement of the buttons relative to the 
describing text

Check box, radio box

Fill pattern Pattern for the display of background areas, for 
example solid or hatched

Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, rounded 
rectangle, static text,          
I/O field, bar, graphics object, 
text list, combo box, list 
box,         
all Windows objects

Pressed Start position of the switch Button, round button
Background Display of the background 3D bar
Light effect Display of the sides of a 3D bar with different 

brightness
3D bar

Line end Representation of the line ends of an object, e.g. 
round, flat or pointed         
(associated with the "Line style" attribute)

all standard objects,         
graphics object, status 
display,         
all Windows objects

Line style Display type of a line, for example dotted or dashed all standard objects,         
graphics object, status 
display,         
all Windows objects

Line end style Display type for the end points of a line Line, polyline, connector
Line weight Thickness of a line         

(Unit: pixel)
all standard objects,         
graphics object, status 
display,         
all Windows objects,         
 all tube objects

Line connection 
type

Type of transition at a corner point Polygon tube

Draw Border 
Inside

 Ellipse, circle, ellipse 
segment, circular segment, 
ellipse arc, circle arc, 
rectangle, round rectangle, 
static text, graphic object, 
status display, all Window 
objects

Border style Display type of a border line, for example dotted 
or broken

I/O field, bar, multiline text, 
combo box, list box, multiline 
text, 3D bar

Border width Thickness of a border line         
(unit: pixel)

I/O field, bar, multiline text, 
combo box, list box, multiline 
text, 3D bar

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
444 System Manual, 11/2008,  



Attribute Function Object type

Dividing line style Display type of the dividing lines of a selection list, 
for example dotted or broken

Text list

Dividing line 
weight

Thickness of the separation lines in a selection 
list         
(Unit: pixel)

Text list

See also
How to Change an Attribute (Page 434)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

The "Display" property group

Introduction
The "Display" property group contains attributes with which you can change the optical 
appearance of the objects. 

Requirements
The "Display" properties group is available for all objects of the object palette besides the 
following Smart objects: application window, picture window, control, OLE object, Faceplate 
instance, .NET control and WPF control. 
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Overview
The following table shows all attributes in the "Display" property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed. 

Attribute Function Object type

Global shadow Takes over the global setting for 
a shadow underlying the object 

Single objects, I/O Field, bar, 
graphic object, status display, 
text list, multiline text, 
combobox, list box, 3D bar, 
group display, status display, 
analog display, button, check 
box, radio box, round button, 
slider object, polygon tube, T-
piece, double T-piece, tube bend 

Global color scheme Takes on the global color 
scheme 

Single objects, I/O Field, bar, 
graphic object, text list, button, 
check box, radio box, round 
button, slider object, polygon 
tube, T-piece, double T-piece, 
tube bend 

Object transparency Defines the transparency of the 
objects between 0 (not 
transparent) and 100 
(completely transparent).          
100 % transparent or invisible 
objects can also be operated in 
runtime. 

Single objects, I/O Field, bar, 
graphic object, text list, 3D bar, 
button, check box, radio box, 
round button, slider object, 
polygon tube, T-piece, double T-
piece, tube bend 

[V6.2] Windows Style Shows the objects in the 
Windows style of WinCC V6.2 

Button, Slider object 

WinCC style Defines the design of the objects button, round button, slider 
object 

Display options Defines the type of display. Button, round button 

"Font" Property Group

Introduction
The "Font" property group contains attributes which you can use to change the appearance 
of text in objects.

Prerequisites
The "Font" property group is only available for the following objects: Static text, I/O field, bar, 
text list, group display, multiline text, combobox, list box, button, check box and radio box.
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Overview
The following table shows all attributes in the "Font" property group. The function of an attribute 
is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

Bold Text is displayed in boldface Static text,         
I/O field, bar, text list, group 
display         
button, check box, radio box

Index Number of the label field displayed in the dialog Check box, radio box, 
combobox, list box

Italic Text is displayed in italics Static text,         
I/O field, text list, group 
display,         
button, check box, radio box

Text orientation Horizontal or vertical arrangement of the text in the 
object

Static text,         
I/O field, text list,         
button, check box, radio box

Text Object label for current index Static text,          
button, check box, radio box, 
multiline text, combobox, list 
box

Underline Text is displayed underlined Static text,         
I/O field, text list, group 
display,         
button, check box, radio box

X alignment Horizontal alignment of the text in the object Static text,         
I/O field, text list, group 
display,         
button, check box, radio box

Y alignment Vertical alignment of the text in the object Static text,         
I/O field, text list, group 
display,         
button, check box, radio box

Font Font of the text Static text,         
I/O field, bar, text list, group 
display         
multiline text, combobox, list 
box, button, check box, radio 
box

Font size Font size of the text in points Static text,         
I/O field, bar, text list, group 
display         
multiline text, combobox, list 
box, button, check box, radio 
box
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See also
How to Change an Attribute (Page 434)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Flashing" Property Group

Introduction
The "Flashing" property group contains attributes with which you can change the flashing of 
object elements. The settings of the "Flashing" property group can only be seen in Runtime.

Prerequisites
The "Flashing" property group is available for all objects except application windows, picture 
windows, multiline text, combobox, list box, control, OLE object and 3D bar. 

If you have selected a global design in the project, it is possible to have the color attributes of 
the "Flashing" property group only become effective if the "Global color scheme" is set to "No" 
under "Display". 

Overview
The following table shows all the attributes of the "Flashing" property group. The function of 
an attribute is described briefly and the object types for which the attribute is available are 
listed. 

Attribute Function Object type

Flashing 
Background Active

Activates flashing of the background Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, rounded 
rectangle, static text,          
I/O field, bar, graphics object, 
text list         
all Windows objects

Flashing Line 
Active

Activates flashing of the line all standard objects,         
bar, graphics object, status 
display,         
all Windows objects

Flashing Border 
Active

Activates flashing of the border I/O field, Text List

Flashing Text 
Active

Activates flashing of the font Static text,         
I/O field, text list,         
button, check box, radio box

Flash frequency Frequency for the flashing of the group display Group Display
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Attribute Function Object type

Background Flash 
Frequency

Frequency for the flashing of the background Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, rounded 
rectangle, static text,          
I/O field, bar, graphics object, 
text list         
all Windows objects

Line Flash 
Frequency

Frequency for the flashing of the line all standard objects,         
bar, graphics object, status 
display,         
all Windows objects

Border Flash 
Frequency

Frequency for the flashing of the border I/O field, bar, text list

Text Flash 
Frequency

Frequency for the flashing of the text Static text,         
I/O field, text list,         
button, check box, radio box

Flashing 
Background Color 
Off

Color for the flash state "Off" Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, rounded 
rectangle, static text,          
I/O field, bar, graphics object, 
text list         
all Windows objects

Flashing 
Background Color 
On

Color for the flash state "On" Polygon, ellipse, circle, 
ellipse segment, pie 
segment, rectangle, rounded 
rectangle, static text,          
I/O field, bar, graphics object, 
text list         
all Windows objects

Flashing Line 
Color Off

Color for the flash state "Off" all standard objects,         
bar, graphics object, status 
display,         
all Windows objects 

Flashing Line 
Color On

Color for the flash state "On" all standard objects,         
bar, graphics object, status 
display,         
all Windows objects

Flashing Border 
Color Off

Color for the flash state "Off" I/O field, bar, text list

Flashing Border 
Color On

Color for the flash state "On" I/O field, bar, text list

Flashing Text 
Color Off

Color for the flash state "Off" Static text,         
I/O field, text list,         
button, check box, radio box

Flashing Text 
Color On

Color for the flash state "On" Static text,         
I/O field, text list,         
button, check box, radio box
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See also
How to Change an Attribute (Page 434)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Miscellaneous" Property Group

Introduction                                                             
The "Miscellaneous" property group contains attributes which you can use to change the 
miscellaneous settings of objects.

Requirements
The "Miscellaneous" property group is available for all objects.

The availability of the attributes depends on the type of selected objects. Only the attributes 
which the selected object has will be displayed.

Overview
The following table shows all attributes in the "Miscellaneous" property group. The function of 
an attribute is described briefly and the object types for which the attribute is available are 
listed. 

Attribute Function Object type

Update cycle Type and frequency of the update Picture window, picture 
object

Display Activates the display of an object All objects
Display options Specifies if a button is assigned to a graphic, text, 

or both
Button

Operator control 
enable

Release to operate an object All objects         
except:         
application window         
picture window

Operator input 
message

Defines whether a message is output following 
operation

I/O field, text list, combo 
box, list box, check box, 
radio box, slider

Operator activities 
report

Defines whether the reason for an operation 
should be logged

I/O field, text list, combo 
box, list box, slider

Operation steps Defines how many steps the slider is moved on 
the slider surface when the mouse is clicked

Slider

User value 1-4 Any 32-Bit value which for example can be used 
for a script evaluation

Group display
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Attribute Function Object type

Authorization User-specific authorization to operate an object all objects         
except:         
application window         
picture window         
control

Adapt picture Permits adaptation of the picture size to the 
window size

Picture window

Picture name Defines the name of the picture to be shown Picture window
Picture offset X Horizontal coordinate to define a picture section Picture window
Picture offset Y Vertical coordinate to define a picture section Picture window
Picture Status Off Defines the picture displayed when a button is 

not pressed
Button

Picture status on Defines the picture displayed when a button is 
pressed

Button

Bit pattern group 
display

System-internal Output Value Group display

Cursor mode Specifies if a process picture is operated in 
Runtime using the alpha cursor or the tab cursor.

Picture object

Cursor control Defines whether the Alpha cursor automatically 
jumps to the next field of the TAB order following 
input in a field

I/O field         
text list

Date of last change Indicates the date when the process picture was 
last saved.

Picture object

Immediate input Defines whether when jumping to the object it 
should change directly to input mode

I/O field         
text list

Extended operation Defines whether the slider jumps to the minimum 
or maximum value when the mouse is clicked on 
the slider surface

Slider

Extended zooming The view of the process picture in Runtime may 
be zoomed in or out using the mouse wheel. 

Picture object

Change color Defines whether the color changes segment-by-
segment or for the entire bar when the limit value 
is reached

Bar

Adapt size Permits adaptation of the window size to the 
picture size

Picture window

Window mode Defines the position and scaling of the picture 
window 

Picture window

Sizeable Permits the operator to change the window size Application window         
Picture window

Hotkey Defines a key or key combination as an 
alternative operation to a mouse action

Button

Hysteresis Permits display with hysteresis Bar
Hysteresis Range Defines the hysteresis in percentage of the 

display range
Bar

Maximum value Absolute value to display the largest value Bar         
3D bar         
slider

Maximizable Permits the enlargement of a window to the 
maximum screen size

Application window         
Picture window
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Attribute Function Object type

Menu/Toolbar 
configuration

Enables the assignment of an MTL file with the 
layout of menu and toolbars 

Picture window 

Minimum value Absolute value to display the smallest value Bar         
3D bar         
slider

Average value Permits the an average value over the last 15 
values

Bar

Monitor number Defines the monitor, on which the picture window 
will be displayed 

Picture window 

Zero point value Absolute value to display the zero point Bar         
3D bar

Process driver 
connection

Default values for the display in Runtime if the 
associated tag is not linked or updated

Bar         
3D bar         
slider

Acknowledgment 
mask

During display of the group display object, the 
events "Tolerance low", "Tolerance high", 
"Operator request" and "Measuring point 
blocked" are automatically identified as being 
acknowledged.

Group display

Border Display of a window with or without a border Application window         
Picture window

Adapt border Dynamic adaptation of the field border to the text 
size

Static text         
I/O field         
text list         
button         
check box         
radio box

Scroll bar Permits a scroll bar in the window Picture window
Scroll bar position X Horizontal move of picture scroll bar in picture 

window with scroll bar
Picture window

Scroll bar position Y Vertical move of picture scroll bar in picture 
window with scroll bar

Picture window

Group relevant Defines the consideration to form a group display Group display
Group value Collect value of the current state of the active 

message classes
Group display

Closable Permits a window to be closed Application window         
Picture window

Selected box Defines the number of the highlighted of 
displayed text field 

Combo box, list box 

Selected text Shows certain text with the "Selected box" 
attribute 

Combo box, list box 

Server name Display under which name an embedded object 
is registered in the operating system

Control         
OLE object

Server prefix Name of the server from which the picture to be 
shown is called

Picture window

Scaling factor Zoom factor to display the picture in the window Picture window
Scaling mode Scaling and display of the components of the 

faceplate instance. 
Faceplate instance
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Attribute Function Object type

Configured 
languages

Displays the languages configured for the 
selected object

Static text, button, check 
box, radio box, multiline 
text, combo box, list box

Text reference Defines whether the language-dependent 
assignment texts are managed in the text library 
or directly in the object

Text list

Title Activates the title bar of a window Application window         
Picture window

Tooltip text Describing text which appears in Runtime as 
soon as the cursor is positioned on the object

all objects except:         
application window         
picture window         
control

Trend Permits the display of the trend of a 
measurement value

Bar

Heading Headline displayed in the title bar of the picture 
window

Picture window

Independent window Defines whether the picture window can be used 
in position and scaling independent of the 
process picture 

Picture window

Tag prefix Name extension prefixed on all tag in the picture Picture window
Visualize tag status Determines of the object is grayed out when a 

bad quality code or tag status is detected.
Bars, I/O field, group 
display, text list, 3D bar, 
status display (extended), 
analog display (extended) 

Movable Permits a window to be moved Application window         
Picture window

Foreground Defines whether a window is pinned on top Application window         
Picture window

See also
How to Change an Attribute (Page 434)

How to configure the display of windows (Page 468)

How to Configure Logging and Operator Authorizations (Page 469)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Filling" Property Group

Introduction
The "Filling" property group contains attributes, which you can control the dynamic filling of 
objects.
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Requirements
The "Filling" property group is available for all objects. Polygon, ellipse, circle, ellipse segment, 
circlular segment, rectangle, round rectangle, static text, graphic object, button, tab, option 
group, round button and slider.

Overview
The following table shows all the attributes of the "Filling" property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

dynamic filling Permits dynamic filling of objects with closed 
border line

All the objects mentioned 
above

Fill Level Height of the object filling with closed border line 
as a percentage of the object height

All the objects mentioned 
above

See also
How to Change an Attribute (Page 434)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Picture" Property Group

Introduction
The "Picture" property group contains attributes with which you can change the properties of 
the picture to be displayed.

Prerequisites
The "Picture" property group is only available for the object "Graphic Object".

Overview
The following table shows all attributes of the "Picture" property group and brief description of 
their function.

Attribute Function

Picture Picture displayed in the Graphic Object
Picture referenced Defines whether the picture itself or only a reference to the picture is 

incorporated
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Attribute Function

Picture Transparent Color Defines which color of the picture is set to "transparent"
Picture Transparent Color On Permits the "Transparent Color function"

See also
How to Change an Attribute (Page 434)

How to insert a graphic object (Page 547)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Pictures" Property Group

Introduction
The "Pictures" property group contains attributes with which you can change the properties of 
the pictures to be displayed for different states.

Prerequisites
The "Pictures" property group is only available for the objects "Button" and "Round Button".

Overview
The following table shows all attributes of the "Pictures" properties group. The functionality of 
an attribute is described briefly and assigned to the object types for which the attribute is 
available. 

Attribute Function Object type

Picture Off Referenced For the "Off" state, defines whether the picture itself or only a 
reference to the picture are incorporated

Button, round button

Picture Off Transparent Color For the "Off" state, defines which color of the picture is set to 
"Transparent"

Button, round button

Picture Off Transparent 
Color On

Permits the "Transparent Color" function for the "Off" state Button, round button

Picture Deact. Referenced For the "Deactivated" state, defines whether the picture itself or only 
a reference to the picture are incorporated

Round Button

Picture Deact. Transparent 
Color

For the "Deactivated" state, defines which color of the picture is set 
to "Transparent"

Round Button

Picture Deact. Transparent 
Color On

Permits the "Transparent Color" function for the "Deactivated" state Round Button

Picture On Referenced For the "On" state, defines whether the picture itself or only a 
reference to the picture are incorporated

Button, round button
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Attribute Function Object type

Picture On Transparent Color For the "On" state, defines which color of the picture is set to 
"Transparent"

Button, round button

Picture On Transparent 
Color On

Permits the "Transparent Color" function for the "On" state Button, round button

Picture Status Off Picture displayed for the "Off" state Button, round button
Picture Status Deactivated Picture displayed for the "Deactivated" state Round Button
Picture Status On Picture displayed for the "On" state Button, round button
Picture alignment Defies the picture alignment and scaling Button, round button

See also
How to Change an Attribute (Page 434)

How to insert a round button (Page 594)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Status" Property Group

Introduction
The "Status" property group contains attributes with which you can change the properties of 
the status display.

Requirements
The "Status" property group is only available for the object "Status Display".

Overview
The following table shows all attributes of the "Status" property group and brief description of 
their function.

Attribute Function

Current status Status set to display a basic picture or a flash picture
Flash Picture Picture to be displayed as a flash picture
Flash Picture Referenced Defines whether the picture itself or only a reference to the picture is 

incorporated
Flash Picture Transparent 
Color

Defines which color of the flash picture is set to "transparent"

Flash Picture Transparent 
Color On

Permits the "Transparent Color" function for the flash picture

Flashing Flash Picture Active Activates flashing of the flash picture
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Attribute Function

Flash picture flash frequency Frequency for the flashing of the flash picture
Basic Picture Picture to be displayed as basic picture
Basic Picture Referenced Defines whether the picture itself or only a reference to the picture is 

incorporated
Basic Picture Transparent 
Color

Defines which color of the basic picture is set to "Transparent"

Basic Picture Transparent 
Color On

Permits the "Transparent Color" function for the basic picture

See also
How to Change an Attribute (Page 434)

How to insert a status display (Page 550)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Axis" Property Group

Introduction
The "Axis" property group contains attributes with which you can change the properties of the 
bar.

Requirements
The "Axis" property group is only available for the object "Bar".

Overview
The following table contains all attributes of the "Axis" property group and brief description of 
their function.

Attribute Function

Axis section Distance between the main tick marks         
(value difference between two adjacent axis labels)

Alignment Orientation of the scale relative to the bar         
(top/bottom or left/right)

Bar Scaling Type of scale divisions         
(for example linear or logarithmic)

Label Each Number of labeled main tick marks         
(each one, every second one, every third one ...)

Exponent display Permits number representation with exponents
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Attribute Function

Large Tick Marks Style for the display of the main tick marks of a scale         
(bold or normal)

Large Tick Marks Length Length of the main tick marks of a scale. The length of the trend tick 
marks is 50% of the value set here         
(Unit: Pixels)

Decimal Places Number of digits to the right of the decimal point to display numerical 
values on the scale

Zero point Position of the zero point relative to the distance of the scale end 
values         
(Unit: Percentage)

Only Large Tick Marks Defines whether only the main tick marks or only the trend tick marks 
are displayed on the scale.

Scale Permits the display of a scale to display the values
Scale Marks Number of bar segments subdivided by the main tick marks of the scale
Digits to the Left of the 
Decimal Point

Number digits to the left of the decimal point to display numerical values 
on the scale

See also
How to Change an Attribute (Page 434)

How to insert a bar (Page 539)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Limits" Property Group

Introduction
The "Limits" property group contains attributes with which you can set limit values and the 
monitoring of limit values.

Requirements
The "Limits" property group is only available for the following objects. I/O field, bar and 3D bar
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Overview
The following table shows all the attributes of the "Limits" property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed. 

Attribute Function Object type

Type         
(AH, WH, TH, RH4, 
RH5,         
AL, WL, TL, RL4, RL5)

Type of display for the specified limit value         
(percent or absolute)

Bar

Bar color (0 - 10) Color the 3D bar takes when the specified limit is 
reached

3D Bar

Bar color         
(AH, WH, TH, RH4, 
RH5,         
AL, WL, TL, RL4, RL5)

Color the bar takes when the specified limit is 
reached

Bar

Limit (0 – 10) Value of the specified limit 3D Bar
Limit Marker Permits the display of the limit values on the scale Bar
High limit value Upper limit to display a value in the I/O field I/O Field
Upper limit         
(AH, WH, TH, RH4, RH5)

Value of the specified upper limit Bar

Low Limit Value Lower limit to display a value in the I/O field I/O Field
Lower limit         
(AL, WL, TL, RL4, RL5)

Value of the specified lower limit Bar

Monitor (0 – 10) Activates monitoring of the specified limit 3D Bar
Monitor         
(AH, WH, TH, RH4, 
RH5,         
AL, WL, TL, RL4, RL5) 

Activates monitoring of the specified limit Bar

See also
How to Change an Attribute (Page 434)

How to insert an I/O field (Page 527)

How to insert a bar (Page 539)

How to Insert a 3D Bar (Page 575)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Output / Input" Property Group

Introduction
The "Output / Input" property group contains attributes with which you can set the properties 
of input and output values.
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Prerequisites
The "Output / Input" property group is only available for the following objects: I/O field, text list, 
check box and radio box.

Overview
The following table shows all the attributes of the "Output / Input" property group. The function 
of an attribute is described briefly and the object types for which the attribute is available are 
listed.

Attribute Function Object type

Number of visible Lines Defines how many lines the selection list should 
contain

Text list

Output format Format indication for the display of the output value I/O Field
Output value Default values for the display in Runtime if the 

associated tag is not linked or updated
I/O field, Text List

Bit Number Number of the relevant bit in the output value Text list
Data Format Data type of the field content         

(binary, decimal, string, hexadecimal)
I/O Field

Input value Enables the display of the input value via direction 
connection, even after acceptance with "OK". 

I/O Field

Field type Defines the function type of the field I/O field, Text List
List type Data type of the field content         

(binary, decimal, bit)
Text list

Clear on Invalid Input Defines whether the field content is automatically 
deleted if input is incorrect

I/O Field

Clear on New Input Defines whether the existing field contents are 
deleted when the input field is activated

I/O Field

Selected boxes Informs the system about which fields are active Check Box
Selected Box Informs the system about which field is activated Radio box
Apply on Exit Defines whether the specified data are applied on 

exiting the field.
I/O field, Text List

Transfer with Complete Input Defines whether the field is automatically exited 
and the data applied simultaneously as soon as 
the predefined number of characters have been 
entered

I/O Field

Hidden Input Defines whether the input is visible immediately or 
replaced by "*"

I/O Field

Assignments Assignment between the output value and the 
output value to be actually output

Text list
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See also
How to Change an Attribute (Page 434)

How to insert an I/O field (Page 527)

How to add a text list (Page 557)

How to insert a check box (Page 589)

How to insert an radio box (Page 592)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Message Types" Property Group

Introduction
The "Message Types" property group contains attributes with which you can set the display 
of messages depending on message type and message class.

Requirements
The "Message Types" property group is only available for the object "Group Display".

Overview
The following table contains all attributes of the "Message Types" property group and brief 
description of their function.

Attribute Function

Display Text Label of buttons depending on the displayed message type
Went Out Unacknowledged 
–         
Background Flashing

Permits flashing background when a message goes out 
unacknowledged

Went Out Unacknowledged 
–         
Background Color Off

Background color for the flash state Off

Went Out Unacknowledged 
–         
Background Color On

Background color for the flash state On

Went Out Unacknowledged 
–         
Text Flashing

Permits flashing font when a message goes out unacknowledged

Went Out Unacknowledged 
–         
Text Color Off

Color of the text for the flash state Off

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  461



Attribute Function

Went Out Unacknowledged 
–         
Text Color On

Color of the text for the flash state On

Came in –         
Background flashing

Permits flashing background when a message comes in

Came in –         
Background Color Off

Background color for the flash state Off

Came in –         
Background Color On

Background color for the flash state On

Came in –         
Text flashing

Permits flashing text when a message comes in

Came in –         
Text Color Off

Color of the text for the flash state Off

Came in –         
Text Color On

Color of the text for the flash state On

Came in acknowledged 
–         
Background flashing

Permits flashing background when a message comes in acknowledged

Came in acknowledged 
–         
Background Color Off

Background color for the flash state Off

Came in acknowledged 
–         
Background Color On

Background color for the flash state On

Came in acknowledged 
–         
Text flashing

Permits flashing text when a message comes in acknowledged

Came in acknowledged 
–         
Text Color Off

Color of the text for the flash state Off

Came in acknowledged 
–         
Text Color On

Color of the text for the flash state On

Message Type Defines the message type (for example AL, AH, WL, etc.) for which the 
attributes of the "Message Types" property group are configured

See also
How to Change an Attribute (Page 434)

How to Insert a Group Display (Page 578)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)
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The "Background picture" property group

Introduction
The "Background picture" properties group contains attributes with which you can change the 
picture file used and the respective display for the background picture of the process picture. 

Prerequisites
The "Background picture" property group is available for the process picture. 

Overview
The following table shows all attributes in the "Background picture" property group. The 
functionality of the attribute is briefly described. 

Attribute Function

Picture File name of the background picture          
Files of format EMF, WMF, DB, BMP, GIF, JPG, JPEG and ICO are suitable 

Show as Display of the picture in relation to the process picture and runtime window

"Lock" Property Group

Introduction
The "Lock" property group contains attributes with which you can change the properties to 
display locked measuring points.

Requirements
The "Lock" property group is only available for the object "Group Display".

Overview
The following table contains all attributes of the "Lock" property group and a brief description 
of their function.

Attribute Function

Lock Display Permits viewing a locked measuring point
Lock Display Text Label of the buttons for a locked measuring point
Lock Background Color Background color of the buttons for a locked measuring point
Lock Text Color Font color of the buttons for a locked measuring point
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See also
How to Change an Attribute (Page 434)

How to Insert a Group Display (Page 578)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Connected Objects" Property Group

Introduction
The "Connected Objects" property group contains attributes with which you can change the 
connection of two objects using the "Connector" object.

Requirements
The "Connected Objects" property group is only available for the object "Connector".

Overview
The following table shows all attributes of the "Connected Objects" property group and brief 
description of their function. 

Attribute Function

Object name of the source object Defines the object which is connected to the beginning of the 
connector

Connection point index of the source 
object

Defines for the beginning at which connection point of the 
source object the connection is established

Object name of the target object Defines the object which is connected to the end of the 
connector

Connection point index of the target 
object

Defines for the end at which connection point of the target 
object the connection is established

Change Orientation Turns the definition from the "Start" and "End" of the 
connector with the current assignments around.

Connection Type Defines whether an automatic or simple direct connection 
should be created between the objects.

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
464 System Manual, 11/2008,  



See also
How to Change an Attribute (Page 434)

How to use the connector (Page 506)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

"Assignment" Property Group

Introduction
The "Assignment" property group contains attributes you use to assign message types to 
buttons of the group display object. The display of message types is configured in the "Message 
Types" property group.

Requirements
The "Assignment" property group is only available for the "Group Display" object.

Overview
The following table shows all attributes of the "Assignment" property group and a brief 
description of their function. 

Attribute Function

Message Types for Button 1 Specifies one or several message events for the first button 
of the group display object. 

Message Types for Button 2 Specifies one or several message events for the second 
button of the group display object. 

Message Types for Button 3 Specifies one or several message events for the third button 
of the group display object. 

Message Types for Button 4 Specifies one or several message events for the fourth button 
of the group display object. 

Message Types for Button 5 Specifies one or several message events for the fifth button 
of the group display object. 

Message Types for Button 6 Specifies one or several message events for the sixth button 
of the group display object. 

Message Types for Button 7 Specifies one or several message events for the seventh 
button of the group display object. 

Message Types for Button 8 Specifies one or several message events for the eighth 
button of the group display object. 
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See also
How to Change an Attribute (Page 434)

How to Insert a Group Display (Page 578)

The Properties of an Object (Page 423)

Working with Objects in the Object Palette (Page 473)

Property Groups and Attributes (Page 437)

3.8.5.4 Special Runtime Settings

Special Runtime Settings

Introduction
To display and operate individual objects in Runtime, there are different attributes available 
whose change is only visible in Runtime:

● Rotation of objects

● Display of windows

● Operation and logging

● Multiple picture windows

The objects can also be displayed as transparent right to invisible in runtime. 

These settings are described extensively below.

See also
Property Groups and Attributes (Page 437)

How to Configure Logging and Operator Authorizations (Page 469)

How to configure the display of windows (Page 468)

Setting Up Rotation of Objects (Page 466)

How to support multiple picture windows (Page 470)

How to define the visibility of objects (Page 473)

Setting Up Rotation of Objects

Introduction
    A rotation around a reference point can be configured for objects of the type line, polygon, 
polyline or static text.         
The rotation of an object is only visible in Runtime.
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The coordinates of the reference point and the configured start position are defined by the 
attributes "Rotation reference X", "Rotation reference Y" and "Rotation angle in the "Geometry" 
property group.

Rotation reference X, Rotation reference Y
The attribute "Rotation reference X" and "Rotation reference Y" define the horizontal and 
vertical distance of the reference point from the object origin.

The values are specified in percent. The object width or object height correspond to a value 
of 100%. The reference point value can be outside the selection rectangle. This means that 
both negative values and values higher than 100% are possible.

Rotation angle
The "Rotation Angle" attribute defines the rotation of an object around the reference point. 

The Rotation Angle is specified in degrees. The configured start point corresponds to a value 
of 0°. The position of an object deviates from its configured start position by the value of the 
"Rotation Angle" attribute. 
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See also
The Properties of an Object (Page 423)

Special Runtime Settings (Page 466)

How to Draw a Polyline (Page 483)

How to Draw a Polygon (Page 481)

How to Draw a Line (Page 478)

How to configure the display of windows

Introduction
The "Application Window" and "Picture Window" objects are displayed in Runtime as a window 
in a process picture. The properties of this window display can be changed as required with 
the attributes described here. Some of these attributes are available for other object types.

Adapt Size
The "Adapt Size" attribute specifies whether or not a picture window adapts to the size of the 
embedded picture in Runtime.

Sizeable
The "Sizeable" attribute specifies whether or not the size of a window can be changed in 
Runtime.

Border
The "Border" attribute specifies whether or not a window is displayed with a border.

Scroll Bar
The "Scroll Bar" attribute specifies whether or not a picture window is displayed with a scroll 
bar if required. A scrollbar is only visible in Runtime.

Can Be Closed
The "Can Be Closed" attribute specifies whether or not a window can be closed in Runtime.

Title
The "Title" attribute specifies whether a window is displayed in Runtime with or without a title 
bar.
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Heading
The "Heading" attribute specifies which text appears in the title of a picture window.

Movable
The "Movable" attribute specifies whether or not a window can be moved in Runtime.

Foreground
The "Foreground" attribute specifies whether or not a window lies in the foreground. This 
setting is independent of the layer to which the window is assigned.

See also
The Properties of an Object (Page 423)

Special Runtime Settings (Page 466)

"Miscellaneous" Property Group (Page 450)

How to insert a picture window (Page 516)

How to Insert an Application Window (Page 513)

How to Configure Logging and Operator Authorizations

Introduction
In WinCC to operate a process picture you can define user-specific authorization for the 
contained objects. Each Operation may be logged and sent to the message system. The 
associated settings can be changed with the attributes described here.

Display
The "Display" attribute specifies whether or not an object is displayed in Runtime.

Operator-Control Enable
The "Operator-Control Enable" attribute specifies whether or not an object can be operated in 
Runtime.

Operator input message
The "Operator Input Message" attribute specifies whether or not a message is displayed after 
an operation. If the attribute "Operator Input Message" has been set to "yes", a message is 
generated upon operation, sent to the message system and archived. Using the message 
system, a message may be output in a message line, for example.
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Operator Activities Report
The "Operator Activities Report" attribute specifies whether or not the reason for an operation 
is to be logged by the operator. The Operator Activities Report is archived in the message 
system.

Authorization
The User Administrator editor is used in WinCC to assign authorizations for the users. An 
authorization can be assigned for every object in the Graphics Designer. The object can only 
be operated by those users with the corresponding authorization. 

Note

An object can only receive an operator authorization as a "Whole". A customized object can 
have an operator authorization but its subordinate objects cannot.

Cursor Control
The "Cursor Control" attribute specifies whether the Alpha Cursor automatically jumps to the 
next field in the TAB sequence after an entry has been made in a field. This function enables 
rapid input in different fields without having to use the tab key to jump.

Hotkey
As an alternative to operation with the mouse, a button can also be triggered using the 
keyboard. To do so, a hotkey must be set. 

See also
The Properties of an Object (Page 423)

Special Runtime Settings (Page 466)

"Miscellaneous" Property Group (Page 450)

How to support multiple picture windows

Introduction
WinCC supports independent picture windows. Independent picture windows can be can be 
used and positioned absolutely without being connected to the respective process picture. 
With the respective hardware and the support of the operating system, you can control more 
monitors to handle processes with greater scope and differentiation. 

For example, you can visualize the process on monitors 1 to 3 and use monitor 4 to display 
another view of the process with an Excel list. 

The main window, in which you have configured the individual picture window, is no longer 
required. You can hide it to increase the impact of more independent runtime windows. 
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Procedure
1. Configure more picture windows with the desired process pictures in the start picture.

2. Open the properties for each picture window with a double click.
The "Object Properties" dialog is opened. 

3. Set the attribute "Independent window" to "Yes".

4. Define the display for the configured picture window with window mode:

– Standard: configured size in the configured position

– Center: configured size in the central position

– Maximize: display adapted to the size of the monitor

5. If you want to use more monitors:          
Select the desired monitor for the picture window with the "Monitor number" attribute.
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6. If you want to hide the main window:          
Select "Properties" in the WinCC Explorer of the pop-up menu of the computer, select the 
respective computer and click on "Properties".
The "Computer Properties" dialog opens. 

7. Activate check box "Hide main window" on the "Graphics Runtime" tab under "Independent 
picture window".

Results
In runtime, the selected process pictures appear in several picture windows that are to be 
controlled independent of one another. 

See also
How to insert a picture window (Page 516)
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How to define the visibility of objects

Introduction
The visibility of objects is controlled with the "Object transparency" property. The operability 
of an object does not depend on its visibility. Even a completely transparent, or invisible, object 
can be controlled in runtime. 

Procedure
1. Select "Properties" in the shortcut menu.

The "Properties" dialog opens. 

2. Define the object transparency as a percentage in the "Display" property group.
0% means no transparency, therefore complete visibility. 
100% means complete transparency, therefore invisibility of the object. 
The text and fields of the graphic objects are only transparent at 100%.

Note

The transparency of the object is shown in the Graphics Designer as well as later in 
runtime.

Finding objects again
A 100% transparent object cannot be seen in the project as well as in runtime. The selection 
marks for the rectangle surrounding the object are also not seen in the project.

Use the setting with the knowledge that operation of an invisible object is still possible.

In order to have an overview of which objects belong to the process picture in the project, 
select the "View Project Documentation" command in the "File" menu. 

Existing, invisible objects are also included in the project documentation. The position of the 
objects in the process picture are indicated in the schematic overview graphic. 

3.8.6 Working with Objects in the Object Palette

3.8.6.1 Working with Objects in the Object Palette

Introduction
"Objects" in the Graphics Designer are the predefined graphic elements that enable efficient 
creation of process pictures. You can easily insert all objects into a picture from the object 
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palette. The "Default" register tab of the Object Palette provides the objects in the following 
four object groups: 

Standard objects Smart objects Windows objects Tube objects

Line         
polygon         
polygon line         
ellipse         
circle         
ellipse segment         
circle segment         
ellipse arc         
circle arc         
rectangle         
rounded rectangle         
static text         
connector

Application window         
Picture window         
Control         
OLE object         
I/O Field         
Bar         
Graphic object         
Status display         
Text list         
Multi-line text         
Combobox         
List box         
Faceplate instance         
.NET control         
WPF control         
3D bar         
Group display         
Status display (Ext.)         
Analog display (Ext.)

Button         
Check-Box         
Radio Box         
Round button         
Slider object

Polygon tube         
T-piece         
Double T-piece         
Tube bend

Note
Line display when zooming in "WinCC Classic" design

If you have set the "WinCC Classic" design, all occurrences of a dashed line with a line 
thickness of "1" are shown as a solid in the Graphics Designer when zooming over 100%. 

This effect is dictated by the graphics system of Microsoft. The effect does not occur if the 
line thickness is greater than "1" or the zoom is less than 100% or if another design is defined. 

See also
Working with Standard Objects (Page 475)

Working with Smart Objects (Page 509)

Working with Windows Objects (Page 583)

Working with Combined Objects (Page 613)

The Object Palette (Page 238)

The Properties of an Object (Page 423)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)
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3.8.6.2 Working with Standard Objects

Working with Standard Objects

Introduction
The standard objects include geometric shapes and static text. The geometric shapes draw 
the individual elements of the process picture. For example, static text can be used for labels.

In the Graphics Designer, the various object types have default properties. When they are 
inserted the objects import these default properties (except for individual geometric properties). 
After insertion the properties of an object can be modified. In the same way the default settings 
for the object types can be modified as required.

Overview

Icon Object Description

Line The line is an open object. The length and angle of a line are determined 
by the height and width of the rectangle around the object. The line 
ends, for example, can be shown as arrows or points.

Polygon The polygon is a closed object that can be filled with a color or pattern. 
A polygon can have any number of corners. The corners are numbered 
in their sequence of creation and can be modified individually or deleted.
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Icon Object Description

Polyline The polyline is an open object. Even if the start and finish point have 
the same coordinates, the area cannot be filled. A polyline can have 
any number of corners. The corners are numbered in their sequence 
of creation and can be modified individually or deleted. The line ends 
of a polyline can for example be shown as arrows or points.

Ellipse The ellipse is a closed object that can be filled with a color or pattern. 
The height and width of an ellipse can be modified as desired to allow 
it to be aligned horizontally or vertically.

Circle A circle is a closed object that can be filled with a color or pattern. A 
circle can be resized at will.

Ellipse 
segment

The ellipse segment is a closed object that can be filled with a color or 
pattern. The height and width of an ellipse segment can be modified as 
desired to allow it to be aligned horizontally or vertically.

Pie segment The pie segment is a closed object that can be filled with a color or 
pattern. A pie segment can be resized at will.

Ellipse arc The ellipse arc is an open object. The height and width of an ellipse arc 
can be modified as desired to allow it to be aligned horizontally or 
vertically.

Circular arc The circular arc is an open object. A circular arc can be resized at will.

Rectangle The rectangle is a closed object that can be filled with a color or pattern. 
The height and width of a rectangle can be modified as desired to allow 
it to be aligned horizontally or vertically.

Rounded 
rectangle

The rounded rectangle is a closed object that can be filled with a color 
or pattern. The height and width of a rounded rectangle can be modified 
as desired to allow it to be aligned horizontally or vertically. The corners 
of a rounded rectangle can be rounded as much as desired.

Static text The field for static text is a closed object that can be filled with a color 
or pattern. The static text is entered into a field of any desired size. One-
line or multiline text can be input for all design languages.

Connector The connector is a linear object whose ends can be connected with the 
connection points of other objects. The number and arrangement of the 
connection points depend on the specific object type. If connected 
objects are moved, the connector's length and direction are 
automatically adapted and the connection is retained.
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See also
How to Draw a Line (Page 478)

How to Draw a Polygon (Page 481)

How to Draw a Polyline (Page 483)

How to Draw an Ellipse (Page 487)

How to Draw a Circle (Page 489)

How to draw an Ellipse Arc (Page 491)

How to Draw a Circular Arc (Page 493)

How to Draw an Ellipse Segment (Page 495)

How to Draw a Pie Segment (Page 497)

How to Draw a Rectangle (Page 500)

How to Draw a Rounded Rectangle (Page 502)

How to Insert Static Text (Page 504)

How to use the connector (Page 506)

How to change the default setting of object types (Page 379)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Object Palette (Page 238)

The Coordinate System of a Process Picture (Page 228)

The Coordinate System of an Object (Page 230)

The Rectangle Surrounding the Object (Page 232)

Working with Objects in the Object Palette (Page 473)

Working with Combined Objects (Page 613)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)
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How to Draw a Line

Introduction
The line is an open object. The length and angle of a line are determined by the height and 
width of the rectangle around the object. The line ends, for example, can be shown as arrows 
or points.

Drawing a line
1. Open the picture into which you want to insert a line.

2. Click the "Line" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the 
line.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the line to the length and direction you want.         
When you release the mouse button, the line is finished.

Alternatively you can double-click the line in the Object Palette. A line with default object 
properties is then inserted near the picture origin.

Changing a line
Select an object of the line type if you wish to carry out one of the following changes:
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Actions with the mouse
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the line color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Configuring the Line Style

Line style
The "Line Style" attribute specifies the style in which a line appears. For example, a dotted or 
dashed representation is possible.

A line with line weight 1 pixel can be displayed in two colors. To do so, you must select a broken 
line style and assign another color to the background of the line. If the line color is identical to 
the line background color in the "Colors" property group, breaks in the line are invisible.

Five line styles are available for selection.

Line termination
The "Line termination" attribute determines the appearance of the line termination. The 
definition of the attribute applies to both ends of the line. Select one of the three following 
options:

● A round termination sets the center of a circle at the end point of the line. The diameter of 
the circle adapts to the line weight.

● A rectangular termination set the center of a square at the end point of the line. The width 
and the height of the square adapts to the line weight.

● A flat termination ends the line at its end points.
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Configuring line end style
The "Line End Style" attribute specifies the style of the ends of a line object. The ends of a line 
object can have different shapes. For example, a line can begin with a dot and end with an 
arrow.

Configuring rotation in Runtime
The line can rotate around a reference point in Runtime. The rotation is defined by the attributes 
"Rotation Reference X", "Rotation Reference Y" and "Rotation Angle".

See also
Setting Up Rotation of Objects (Page 466)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)
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How to Draw a Polygon

Introduction
The polygon is a closed object that can be filled with a color or pattern. A polygon can have 
any number of corners. The corners are numbered in their sequence of creation and can be 
modified individually or deleted.

Drawing a polygon
1. Open the picture in which you want to insert a polygon.

2. Click the standard object "Polygon" in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert a 
polygon.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Click the selected starting point with the left mouse button.

5. Click any other desired corner of the polygon with the left muse button.

6. Click once with the right mouse button to correct the last drawn section of the polygon.

7. Finish the polygon by double-clicking the left mouse button.
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Alternatively, you can double-click the polygon in the Object Palette. A polygon with default 
object properties is then inserted near the picture origin.

Changing a polygon
● Select an object of the polygon type if you wish to carry out one of the following changes:

Actions with the mouse
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Changing corners
The positions of the corners can be changed with the attributes "Current Value X" and "Current 
Value Y" in the "Object Properties" window. The position number of the current selected corner 
is shown by the "Index" attribute in the "Geometry" property group. Changing the value 
specified here enables targeted selection of a corner. A change of the "Index" attribute for the 
current selected corner also changes the displayed value of the attributes "Current Value X" 
and "Current Value Y".

You can also change corners by actions with the mouse:

Moving corners
Position the mouse pointer on the corner that is to be moved and drag it to the desired position 
with the mouse button held down.

Inserting corners
Hold down the <ALT> key and insert another corner by double-clicking on a corner. The 
additional corner is inserted between the clicked corner and the previously created corner.

Deleting corners
Position the mouse pointer of the corner that you want to delete. Hold down the <CTRL> key 
and delete the corner by double-clicking on the left mouse button.
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Configuring rotation in Runtime
The line can rotate around a reference point in Runtime. The rotation is defined by the attributes 
"Rotation Reference X", "Rotation Reference Y" and "Rotation Angle".

See also
Setting Up Rotation of Objects (Page 466)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

How to Draw a Polyline

Introduction
The polyline is an open object. Even if the start and finish point have the same coordinates, 
the area cannot be filled. A polyline can have any number of corners. The corners are 
numbered in their sequence of creation and can be modified individually or deleted. The line 
ends of a polyline can for example be shown as arrows or points.
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Drawing a polygon line
1. Open the picture into which you want to insert a polyline.

2. Click the "Polyline" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert a 
polyline.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Click the selected starting point with the left mouse button.

5. Click every other desired corner of the polyline with the left mouse button.

6. Click once with the right mouse button to correct the last drawn section of the polyline.

7. Finish the polyline by double-clicking the left mouse button. 

Alternatively you can double-click the polyline in the Object Palette. A polyline with default 
object properties is then inserted near the picture origin.

Changing a polyline
Select an object of the polyline type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the line color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Changing corners
The positions of the corners can be changed with the attributes "Current Value X" and "Current 
Value Y" in the "Object Properties" window. The position number of the current selected corner 
is shown by the "Index" attribute in the "Geometry" property group. Changing the value 
specified here enables targeted selection of a corner. A change of the "Index" attribute for the 
current selected corner also changes the displayed value of the attributes "Current Value X" 
and "Current Value Y".

You can also change corners by actions with the mouse:
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Moving corners
Position the mouse pointer on the corner that is to be moved and drag it to the desired position 
with the mouse button held down.

Inserting corners
Hold down the <ALT> key and insert another corner by double-clicking on a corner. The 
additional corner is inserted between the clicked corner and the previously created corner.

Deleting corners
Position the mouse pointer of the corner that you want to delete. Hold down the <CTRL> key 
and delete the corner by double-clicking on the left mouse button.

Configuring the Line Style

Line style
The "Line Style" attribute specifies the style in which a line appears. For example, a dotted or 
dashed representation is possible.

A line with line weight 1 pixel can be displayed in two colors. To do so, you must select a broken 
line style and assign another color to the background of the line. If the line color is identical to 
the line background color in the "Colors" property group, breaks in the line are invisible.

Five line styles are available for selection.

Line termination
The "Line termination" attribute determines the appearance of the line termination. The 
definition of the attribute applies to both ends of the line. Select one of the three following 
options:

● A round termination sets the center of a circle at the end point of the line. The diameter of 
the circle adapts to the line weight.

● A rectangular termination set the center of a square at the end point of the line. The width 
and the height of the square adapts to the line weight.

● A flat termination ends the line at its end points.

Corners
The "Corners" attribute define the appearance of the corner intersections of where lines meet. 
The definition applies to all the corners of the object. Select one of the three following options:
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● A round corner sets the center of a circle at the intersection of two line ends. The diameter 
of the circle adapts to the line weight.

● The two outer corner points of the line connection are linked by a straight line. This flattening 
effect causes the corners to appear beveled.

● A pointed corner corresponds to the real corner intersection of the meeting lines.

Configuring line end style
The "Line End Style" attribute specifies the style of the ends of a line object. The ends of a line 
object can have different shapes. For example, a line can begin with a dot and end with an 
arrow.

Configuring rotation in Runtime
The line can rotate around a reference point in Runtime. The rotation is defined by the attributes 
"Rotation Reference X", "Rotation Reference Y" and "Rotation Angle".
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See also
Setting Up Rotation of Objects (Page 466)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

How to Draw an Ellipse

Introduction
The ellipse is a closed object that can be filled with a color or pattern. The height and width of 
an ellipse can be modified as desired to allow it to be aligned horizontally or vertically.
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Drawing an ellipse
1. Open the picture into which you want to insert an ellipse.

2. Click on the "Ellipse" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the 
ellipse.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the ellipse to the size and direction you want.         
When you release the mouse button, the ellipse is finished.

Alternatively, you can double-click the ellipse in the Object Palette. An ellipse with default 
object properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the ellipse, the "Ellipse" object is created in 
the shape of a circle.

Changing an ellipse
Select an object of the Ellipse type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
488 System Manual, 11/2008,  



How to Draw a Circle

Introduction
A circle is a closed object that can be filled with a color or pattern. A circle can be resized at 
will.

Drawing a circle
1. Open the picture into which you want to insert a circle.

2. Click the "Circle" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert a 
circle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the circle to the size and direction you want.         
When you release the mouse button, the circle is finished.

Alternatively you can double click the circle in the Object Palette. A circle with default object 
properties is then inserted near the picture origin.
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Change circle
Select an object of the circle type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the color palette to change the background color.         
Use elements of the Style Palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)
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How to draw an Ellipse Arc

Introduction
The ellipse arc is an open object. The height and width of an ellipse arc can be modified as 
desired to allow it to be aligned horizontally or vertically. An ellipse arc is by default a quarter 
ellipse and can be configured after it has been created.

Drawing an ellipse arc
1. Open the picture in which you want to insert an ellipse arc.

2. Click the "Ellipse arc" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you wish to position the center 
point of the ellipse arc.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the ellipse arc to the size and direction you 
want.         
When you release the mouse button, the ellipse arc insertion is finished.
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5. The start and end points of the ellipse arc are shown by small gray squares. Position the 
mouse pointer over one of these squares.         
The mouse pointer changes to a crosshair with arrow points with either an A (start angle) 
or E (end angle) above it.

6. Drag the start or end point to the desired position while holding down the mouse button.

Alternatively, you can double-click the ellipse arc in the Object Palette. An ellipse arc with 
default object properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the ellipse, the "Ellipse arc" object is created 
in the shape of a arc.

Changing an ellipse arc
Select an object of the Ellipse Arc type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the line color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Setting the length of the ellipse arc
The length of the ellipse arc is set by the "Start Angle" and "End Angle" attributes. They specify 
the angle in degrees by which the start and end angle of the object deviate from the zero 
position (0°).

The start and end points of the ellipse arc are shown by small gray squares. Place the mouse 
pointer on one of these squares. The mouse pointer changes to a crosshair with arrow points 
with either an A (start angle) or E (end angle) above it. Drag the start or end point to the desired 
position while holding down the mouse button.

Note

Even if the values of the start and end angle are identical, an ellipse arc does not turn into a 
closed ellipse.
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See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

How to Draw a Circular Arc

Introduction
The circular arc is an open object. A circular arc can be resized at will. A circular arc is by 
default a quarter circle and can be configured after it has been created.

Drawing a circular arc
1. Open the picture into which you want to insert a circular arc.

2. Click the "Circular arc" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you wish to position the center 
point of the circular arc.         
The mouse pointer changes into a crosshair with an object symbol attached.
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4. Hold down the mouse button and drag the circular arc to the size and direction you 
want.         
When you release the mouse button, the circular arc insertion is finished.

5. The start and end points of the circular arc are shown by small gray squares. Place the 
mouse pointer on one of these squares.          
The mouse pointer changes to a crosshair with arrow points with either an A (start angle) 
or E (end angle) above it.

6. Drag the start or end point to the desired position while holding down the mouse button.

Alternatively, you can double-click the circular arc in the Object Palette. A circular arc with 
default object properties is then inserted near the picture origin.

Changing circular arc
Select an object of the Circular Arc type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the line color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Configuring the length of the circular arc
The length of the circular arc is set by the "Start Angle" and "End Angle" attributes. They specify 
the angle in degrees by which the start and end angle of the object deviate from the zero 
position (0°).

The start and end points of the circular arc are shown by small gray squares. Place the mouse 
pointer on one of these squares. The mouse pointer changes to a crosshair with arrow points 
with either an A (start angle) or E (end angle) above it. Drag the start or end point to the desired 
position while holding down the mouse button.

Note

Even if the values of the start and end angle are identical, a circular arc does not turn into a 
closed circle.
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See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

How to Draw an Ellipse Segment

Introduction
The ellipse segment is a closed object that can be filled with a color or pattern. The height and 
width of an ellipse segment can be modified as desired to allow it to be aligned horizontally or 
vertically. An ellipse segment is by default a quarter ellipse and can be configured after it has 
been created.

Drawing an ellipse segment
1. Open the picture in which you want to insert a ellipse segment.

2. Click the "Ellipse segment" standard object in the Object palette.
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3. Place the mouse pointer at the position in the picture where you wish to position the center 
point of the ellipse segment.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the ellipse segment to the size and direction you 
want.         
When you release the mouse button, the ellipse segment insertion is finished.

5. The start and end points of the ellipse segment are shown by small gray squares. Position 
the mouse pointer over one of these squares.         
The mouse pointer changes to a crosshair with arrow points with either an A (start angle) 
or E (end angle) above it.

6. Drag the start or end point to the desired position while holding down the mouse button.

Alternatively, you can double-click the ellipse segment in the Object Palette. An ellipse 
segment with default object properties is then inserted near the picture origin.          
If you hold down the <SHIFT> key while drawing, the "Ellipse Segment" object is created in 
the shape of a pie segment.

Changing an ellipse segment
Select an object of the ellipse segment type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Configuring size of the ellipse segment
The length of the ellipse segment is set by the "Start Angle" and "End Angle" attributes. They 
specify the angle in degrees by which the start and end angle of the object deviate from the 
zero position (0°).

The start and end points of the ellipse segment are shown by small gray squares. Place the 
mouse pointer on one of these squares. The mouse pointer changes to a crosshair with arrow 
points with either an A (start angle) or E (end angle) above it. Drag the start or end point to the 
desired position while holding down the mouse button.
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Note

Even if the values of the start and end angle are identical, an ellipse segment does not turn 
into a closed ellipse.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

How to Draw a Pie Segment

Introduction
The pie segment is a closed object that can be filled with a color or pattern. A pie segment can 
be resized at will. A pie segment is by default a quarter circle and can be configured after it 
has been created.

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  497



Drawing a pie segment
1. Open the picture in which you want to insert a pie segment.

2. Click in the "pie segment" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you wish to position the center 
point of the pie segment.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the pie segment to the size and direction you 
want.         
When you release the mouse button, the pie segment insertion is finished.

5. The start and end points of the pie segment are shown by small gray squares. Position the 
mouse pointer over one of these squares.         
The mouse pointer changes to a crosshair with arrow points with either an A (start angle) 
or E (end angle) above it.

6. Drag the start or end point to the desired position while holding down the mouse button.

Alternatively, you can double-click the pie segment in the Object Palette. A pie segment with 
default object properties is then inserted near the picture origin.

Changing Pie Segment
Select an object of the pie segment type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Configuring size of the pie segment
The size of the pie segment is set by the "Start Angle" and "End Angle" attributes. They specify 
the angle in degrees by which the start and end angle of the object deviate from the zero 
position (0°).

The start and end points of the pie segment are shown by small gray squares. Place the mouse 
pointer on one of these squares. The mouse pointer changes to a crosshair with arrow points 
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with either an A (start angle) or E (end angle) above it. Drag the start or end point to the desired 
position while holding down the mouse button.

Note

Even if the values of the start and end angle are identical, a pie segment does not turn into 
a closed circle.

See also
How to change the default setting of object types (Page 379)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

Working with Objects in the Object Palette (Page 473)
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How to Draw a Rectangle

Introduction
The rectangle is a closed object that can be filled with a color or pattern. The height and width 
of a rectangle can be modified as desired to allow it to be aligned horizontally or vertically.

Drawing a rectangle
1. Open the picture into which you want to insert a rectangle.

2. Click the "Rectangle" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the 
rectangle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the rectangle to the size and direction you 
want.         
When you release the mouse button, the rectangle is finished.

Alternatively, you can double-click the rectangle in the Object Palette. A rectangle with default 
object properties is then inserted near the picture origin.          
If you hold down the <SHIFT> key while drawing, the "Rectangle" object is created in the shape 
of a square.
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Changing rectangle
Select an object of the Rectangle type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)
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How to Draw a Rounded Rectangle

Introduction
The rounded rectangle is a closed object that can be filled with a color or pattern. The height 
and width of a rounded rectangle can be modified as desired to allow it to be aligned horizontally 
or vertically. The corners of a rounded rectangle can be rounded as much as desired.

Drawing a rounded rectangle
1. Open the picture into which you want to insert a rounded rectangle.

2. Click the "Rounded rectangle" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the rounded 
rectangle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the rounded rectangle to the size and direction you 
want.         
When you release the mouse button, the rounded rectangle is finished.
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Alternatively, you can double-click the rounded rectangle in the Object Palette. A rounded 
rectangle with default object properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the rounded rectangle, the "Rounded 
rectangle" object is created in the shape of a circular arc.

Changing Rounded Rectangle
Select an object of the Static Text type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Changing corner radii
The radii for rounding the corners of the rounded rectangle are specified with the "corner radius 
X" and "corner radius Y" attributes. They define the horizontal or vertical distance between the 
corners of the rectangle around the object and the starting point of the corner rounding. The 
value is specified as a percentage of the half width and the half height of the object.

Note

If the "Corner Radius X" and "Corner Radius Y" attributes are both set to the value 100%, 
the rounded rectangle is displayed as an ellipse or circle. The rectangle is shown without 
rounded corners when either one of the two attributes is set to 0%.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)
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How to Insert Static Text

Introduction
The field for static text is a closed object that can be filled with a color or pattern. The static 
text is entered into a field of any desired size. One-line or multiline text can be input for all 
design languages.

Inserting static text
1. Open the picture in which you want to insert static text.

2. Click the "static text" standard object in the Object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the static 
text.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the text field to the required size.         
The field for the static text is complete as soon as you release the mouse button.         
Several marked question marks will appear in the field.

5. Overwrite these question marks with the desired text.         
For text with multiple lines, you can make a line break with the key combination <SHIFT
+ENTER> or <CTRL+M>.

6. Press <ENTER> to finish text input.
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Alternatively you can double-click static text in the Object Palette. Static text with default object 
properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the static text, the "Static text" object is created 
in the shape of a circular arc.

Changing static text
Select an object of the Static Text type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object or to change the 
appearance of the text.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Changing the Contents of the Static Text
Double-click the static text to open the input mode for text. The complete text is selected. 
Position the insertion point with another click at the position in the text at which you want to 
change something.         
Line breaks must be entered manually: You can create a line break with either <SHIFT
+ENTER> or <CTRL+M>.         
A line break is shown in the "Object Properties" window in the "Static" column as a control 
character.

Configuring rotation in Runtime
The static text can be rotated around a reference point in Runtime. The rotation is defined by 
the attributes "Rotation Reference X", "Rotation Reference Y" and "Rotation Angle". The 
rotation is displayed in Graphics Designer during configuration.

In order to rotate static text in a group object, watch for the following:

The current position and the rotation angle of the object "Static text" in Runtime are always 
the result of the current values of properties "RotationReferenceX", "RotationReferenceY" and 
"Rotation Angle". The orientation of static text depends on the sequence in which these 
properties were applied.
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If the rotation references refer to the group object, the display in Runtime may deviate from 
the display in the configuration system. This is caused by the fact that the sequence in which 
these properties are updated is not always the same due to system constraints. You avoid 
unexpected display problems in Runtime, if you do not dynamisize the properties 
RotationReferenceX, RotationReferenceY and RotationAngle directly at the group object. 
Instead, perform the dynamization directly at the respective object "Static Text" within the group 
object.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

How to use the connector

Introduction
The connector is a linear object whose ends can be connected with the connection points of 
other objects. Multiple connectors can also be connected together.

The number and arrangement of the connection points depend on the specific object type. If 
connected objects are moved, the connector's length and direction are automatically adapted 
and the connection is retained.

It is possible to select between two connection types. In the case of "Automatic" connection 
type, the connector is comprised of horizontal and vertical parts.

If the connection type "Simple" is selected, the connecting points are connected by a straight 
line.
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The start and end of a selected connector can be highlighted by small colored rectangles to 
show their status:

● Green rectangles identify unconnected ends

● Red rectangles identify connected ends

Inserting connectors
1. Open the picture in which you want to insert a connector.

2. In the Object Palette, click the standard object "Connector".

3. Place the mouse pointer at the position in the picture where you want to insert a 
connector.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the connector to the size and direction you 
want.         
When you release the mouse button, the connector insertion is finished.         
The connector is displayed as a selected object with green ends.

Alternatively, you can double-click the connector in the Object Palette. A connector with default 
object properties is then inserted near the picture origin.

Changing a connector
Select an object of the connector type if you wish to carry out one of the following changes:

Palettes and toolbars
Use the color palette to change the line color.         
Use elements of the Style Palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.
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Connecting objects

1. Select the connector which you would like to connect objects two.         
Start and end of the connectors are symbolized by small green rectangles.

2. Drag the start of the connector to the first object that you want to connect without releasing 
the mouse button.         
The red connection points of the object to be connected in the beginning are displayed.

3. Position the start of the connector on the desired connection point of the object.         
As soon as the mouse button is released, the connection to the first object is established. 
The start of the selected connector is shown as red and the other unconnected end is green.

4. Drag the end of the connector to the second object that you want to connect without 
releasing the mouse button.         
The red connection points of the object to be connected in the end are displayed.

5. Position the end of the connector on the desired connection point of the second 
object.         
As soon as the mouse button is released, the connection is established. The beginning and 
end of the selected connector are now symbolized by red rectangles.          
The position of the connected objects can be changed as needed.

Changing connection
Select the connector and drag one end of the connector to the new position. For example, you 
can connect the end to another connection point of the same object, or to a connection point 
on a new object.

Alternatively you can change the attributes of the "Connected Objects" property group in the 
"Object Properties" window.

The type of connector can be changed within the "Connected objects" property group using 
the "Connection type" attribute. Select between the two connection types "Automatic" and 
"Simple".

Releasing connection
Select the desired connector and press <DEL> to delete the "Connector" object.
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See also
"Connected Objects" Property Group (Page 464)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)

3.8.6.3 Working with Smart Objects

Working with Smart Objects

Introduction
Smart objects offer the option of building complex system pictures. The smart objects include 
items such as various windows, fields and bars, which offer a variety of dynamic options. 

In the Graphics Designer, the various object types have default properties. When added, 
objects take on these defaults, with the exception of individual geometric properties. After 
inserting the properties you can modify the properties of an object. In the same way, you can 
adapt the default settings for the object types as required. 
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Overview

Symbol Object Description

Application 
Window

The application window is an object that can be provided from 
applications of the global script and the logging system. In Runtime, 
these applications open an application window, transfer information 
and enable operation. 
The size and properties which an application window accepts in 
Runtime are defined in the Graphics Designer.

Picture Window The picture window offers the option of displaying other pictures that 
were created with the Graphics Designer in the current picture. For 
example, with dynamics the contents of a picture window can be 
continuously updated. 
The size and properties that a picture window has in Runtime are 
defined in the Graphics Designer.

Control The Object Control provides the option to integrate system process 
control and monitoring elements into a picture. Controls are 
prefinished objects such as for example alarm windows, measurement 
value windows, selection dialogs or buttons. ActiveX Controls, WinCC 
Controls and controls from other manufacturers are available if they 
are registered in the operating system. These are changed as required 
and dynamically integrated into the process. 
The size and properties which a control accepts in Runtime are defined 
in the Graphics Designer.

OLE object The OLE object enables files created in other programs to be inserted 
into a picture. Therefore all OLE object registered in the operating 
system can be integrated. 
The size and properties which an OLE object accepts in Runtime are 
defined in the Graphics Designer. 
No changes can be made to OLE objects in Runtime.

I/O Field The I/O Field can be defined as an input field, an output field or a 
combined input/output field. The following data formats are available: 
Binary, decimal, string and hexadecimal. Limit values such as "Hidden 
Input" or "Accept on complete input" can also be specified. 
The size and properties which an I/O Field accepts in Runtime are 
defined in the Graphics Designer.

Bar The bar offers the option of displaying values graphically. The values 
can also be displayed in a combined view as graphics with freely 
definable number scale. 
The size and properties which a bar accepts in Runtime are defined 
in the Graphics Designer.

Graphic Object The graphic object enables graphics created in other programs to be 
inserted into a picture. Graphics and pictures of the following formats 
can be inserted:          
EMF, WMF, DIB, BMP (to 32 Bit), GIF, JPEG, ICO and PNG. 
The size and properties which a graphic object accepts in Runtime are 
defined in the Graphics Designer.
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Symbol Object Description

Status display The status display offers the option to display almost any number of 
different states of an object. The states are implemented via tags 
whose value corresponds to the respective state. The states are 
displayed via the assigned pictures. 
The size and properties which a status display accepts in Runtime are 
defined in the Graphics Designer.

Text list The text list offers the option of assigning specific values to a text. The 
text list can be defined as an input list, an output list or as a combined 
input/output list. The following data formats are available: Decimal, 
binary or bit. 
The size and properties which a text list has in Runtime are defined in 
the Graphics Designer.

Multiple row text The Multiline Text object makes it possible to display text over several 
lines in a rectangular, scrolling field and to edit it in runtime. 
The size and properties which a multiline text takes on in Runtime are 
defined in the Graphics Designer. 

Combo box The combobox makes it possible to display a drop-down list of several 
values and to use the selection as the input. 
The size and properties which a combobox takes on in runtime are 
defined in the Graphics Designer.

List box The list box makes it possible to highlight a scrolling list of several 
values and to use the selection as an input. 
The size and properties which a list box accepts in Runtime are defined 
in the Graphics Designer.

Faceplate 
Instance

You can insert a Faceplate instance into the picture with the Faceplate 
instance object. Faceplate types must first be saved on your system. 
The size and properties which a Faceplate instance has in runtime are 
defined in the Graphics Designer.

.NET Control You insert a .NET application (Assembly) as a control into your picture 
with the .NET control object. 
The size and properties which a .NET control takes on in runtime are 
defined in the Graphics Designer.

WPF Control The WPF control object makes it possible to insert a WPF file into your 
picture as a control. 
The size and properties which a WPF control accepts in Runtime are 
defined in the Graphics Designer.

3D Bar The 3D bar graph enables values to be displayed graphically three-
dimensionally. 
The size and properties which a 3D bar has in Runtime are defined in 
the Graphics Designer. 
The 3D bar is only available if the "Basic Process Control" optional 
package was installed with WinCC.

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  511



Symbol Object Description

Group Display The group display enables the current states of certain message types 
to be displayed by hierarchy. Four buttons allow messages to be 
represented and operated. Using a group display, you can configure 
a quick change to represent an error source for example. 
The size and properties which a group display accepts in Runtime are 
defined in the Graphics Designer.
The group display is only available if the "Basic Process Control" 
optional package was installed with WinCC.

Status display 
(Ext.)

You can use an extended status display to assign "Came In" (+), 
"Came In Acknowledged" (+Q) and "Went Out Unacknowledged" (-) 
and "OK" picture statuses. 
The sizes and properties of the extended status display in runtime are 
defined in the Graphics Designer. 
Extended status display is available only when a PCS 7 OS is installed. 

Analog display 
(Ext.)

The extended analog display is used to display the value of a tag in 
different colors depending on the alarm status of a component. 
The sizes and properties of the extended analog display in runtime 
are defined in the Graphics Designer. 
Extended analog display is available only when a PCS 7 OS is 
installed. 
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See also
How to Insert an Application Window (Page 513)

How to insert a picture window (Page 516)

How to insert a control (Page 520)

How to Insert an OLE Object (Page 522)

How to insert an I/O field (Page 527)

How to insert a bar (Page 539)

How to insert a graphic object (Page 547)

How to insert a status display (Page 550)

How to add a text list (Page 557)

How to insert multiline text (Page 565)

How to insert a combobox (Page 567)

How to insert a list box (Page 569)

How to insert a Faceplate instance (Page 571)

How to insert a .NET control (Page 572)

How to insert a WPF control (Page 573)

How to Insert a 3D Bar (Page 575)

How to Insert a Group Display (Page 578)

How to change the default setting of object types (Page 379)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Object Palette (Page 238)

The Coordinate System of a Process Picture (Page 228)

The Coordinate System of an Object (Page 230)

The Rectangle Surrounding the Object (Page 232)

Working with Objects in the Object Palette (Page 473)

Working with Combined Objects (Page 613)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)

How to Insert an Application Window

Introduction
The application window is an object that can be provided from applications of the global script 
and the logging system. In Runtime, these applications open an application window, transfer 
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information and enable operation. The size and properties which an application window 
accepts in Runtime are defined in the Graphics Designer.

Inserting application window
1. Open the picture in which you want to insert an application window.

2. In the Object Palette, click the smart object "Application Window".

3. Place the mouse pointer at the position in the picture where you want to insert the 
application window.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the application window to the required size.          
The "Window contents" dialog will open.

5. In the "Window Contents" dialog select the desired display option and confirm your input 
with "OK".         
The "Template" dialog will open.

6. In the "Template" dialog select a template for the selected display option and confirm your 
input with "OK".         
The insertion process for the "Application window" object is finished.

Alternatively you can double-click the smart object "Application Window" in the object palette. 
An application window with the default object properties is then inserted near the picture origin. 
The "Window Contents" and "Template" dialogs open. As soon as you have confirmed your 
entries with "OK", the insertion process is completed.         
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If you press and hold down <SHIFT> during the size change, the object "Application window" 
will assume the shape of a square.

Changing application windows
Select an object of the application window type if you wish to carry out one of the following 
changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Configuring window contents and template
The contents of the application window are changed with the "Window Contents" and 
"Template" attributes. Application windows can be provided from applications of the global 
script and the logging system. In Runtime, these applications open an application window, 
transfer information and enable operation. 

The "Window Contents" attribute specifies for an application window which application is to be 
displayed. The "Template" attribute specifies the template for displaying the window contents. 
Depending on the value of the "Window Contents" attribute the following templates are 
available:

Window Contents = Global Script
● GSC – diagnostics         

The application window is supplied by applications of the Global Script. The results of the 
diagnosis system are displayed.

● GSC – Runtime         
The application window is supplied by applications of the Global Script. The analysis results 
regarding characteristics in Runtime are displayed.

Window Contents = Print Jobs
● All Jobs         

The application window is supplied by the logging system. The available reports are 
displayed as a list.

● All Jobs – Context Menu         
The application window is supplied by the logging system. The available reports are 
displayed as a list. The shortcut menu enables the selection of print options, display of a 
print preview as well as a printout of the log.
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● Job Detail View         
The application window is supplied by the logging system. The available reports are 
displayed in a selection menu. Detailed information is displayed for the selected report.

● Selected Jobs – Context Menu         
The application window is supplied by the logging system. The available reports are 
displayed as a list. This list only contains reports which you have activated the option "Mark 
for print job list" in the "Print Job Properties" dialog. The shortcut menu enables the selection 
of print options, display of a print preview as well as a printout of the log.

Window display in Runtime
The application window is displayed in Runtime as a separate window within a process picture. 
The characteristics of the window display can be configured with attributes of the 
"Miscellaneous" property group.

See also
How to configure the display of windows (Page 468)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

How to insert a picture window

Introduction
The picture window offers the option of displaying other pictures that were created with the 
Graphics Designer in the current picture. For example, you can continuously update the 
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contents of a picture window with dynamics. The size and properties that a picture window has 
in runtime are defined in the Graphics Designer. 

Inserting a picture window
1. Open the picture in which you want to insert a picture window.

2. In the Object Palette, click the smart object "Picture Window".

3. Place the mouse pointer at the position in the picture where you want to insert a picture 
window.
The mouse pointer changes into a crosshair with an object symbol attached. 

4. Drag the picture window to the desired size with the mouse.
The insertion process is finished as soon as you release the mouse button. 
Alternatively, you can double-click the "Picture window" object in the object palette. A 
picture window with default object properties is then inserted near the picture origin. 

Note

If you hold down the <Shift> key during insertion, the "Picture Window" object is created 
in the shape of a square. 
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5. Drag the rectangle surrounding the object to a new position in order to arrange the object 
in the picture.

6. Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Configuring the picture window
Double click to open the "Object properties" dialog, in which you define the picture to be 
displayed and the other attributes of the picture window. 

Picture Name
Double-click on the "Picture name" attribute and select a picture of the "*.pdl" picture file that 
you want to display in the picture window. 

Open integrated picture
Use <Ctrl> and double click to immediately open the process picture integrated in the picture 
window. 

Specify picture zoom area
You can use the "Scaling factor" attribute to set the zoom factor for the display of the picture 
in the picture window. 

You can display the integrated process picture in the picture window a zoom area (cut-out) as 
well. The origin of this zoom area is determined by the "Picture Offset X" and "Picture Offset 
Y" attributes. 

You use the picture offset to define the fixed point for the scaling of the picture as well. 
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Independent picture window
WinCC supports many pictures windows and on several monitors. This requires attributes 
"Independent picture window", "Window mode" and "Monitor number". More information on 
this can be found under "How to support multiple picture windows". 
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See also
How to support multiple picture windows (Page 61)

Selecting pictures (Page 610)

How to configure the display of windows (Page 468)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

How to insert a control

Introduction
The "Control" object offers the option of integrating system process control and monitoring 
elements into a picture. Controls are prefinished objects such as for example alarm windows, 
measurement value windows, selection dialogs or buttons. ActiveX Controls, WinCC Controls 
and controls from other manufacturers are available if they are registered in the operating 
system. These are changed as required and dynamically integrated into the process. The size 
and properties which a control accepts in Runtime are defined in the Graphics Designer.

For the detailed description of the controls and their configuration dialogs see "Working with 
Controls".

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
520 System Manual, 11/2008,  



Prerequisites
● The display of the object palette is activated.

● The use of the configuration dialogs is activated under "Tools > Settings..." on the "Options" 
tab.

Procedure
1. Open the picture in which you want to insert a control.

2. In the Object Palette, click the smart object "Control".

3. Place the mouse pointer at the position in the picture where you want to insert the 
control.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the control to the desired size with the mouse button pressed.         
The "Insert a Control" dialog is opened.         
The description of this dialog is to be found in the chapter "Working with controls".

5. Select one of the controls registered in the operating system and confirm your entry with 
"OK".         
With some controls, the corresponding configuration dialog will open.         
The detailed description of the controls and their configuration dialogs can be found in the 
chapter "Working with Controls".

6. Adapt the settings of the configuration dialog according to your needs and confirm the entry 
with "OK".         
The insertion process for the object "Control" is finished.

Alternatively you can select the desired control directly in the "Control" tab of the Object Palette. 
Step five of the procedure described above is not used here.         
If you hold down the <Shift> key when drawing the picture window, the "Control" object is 
created in the shape of a square. 

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

Working with Controls (Page 319)
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OLE object

How to Insert an OLE Object

Introduction
The OLE object enables files created in other programs to be inserted into a picture. Therefore 
all OLE object registered in the operating system can be integrated. The size and properties 
which an OLE object accepts in Runtime are defined in the Graphics Designer. No changes 
can be made to OLE objects in Runtime.

Requirements
● The display of the object palette must be enabled.

● The desired file type must be registered in the operating system.

Inserting Ole object
1. Open the picture into which you want to insert an OLE object and click the smart object 

"OLE object" in the Object Palette.

2. Place the mouse pointer at the position in the picture where you want to insert the OLE 
object.         
The mouse pointer changes into a crosshair with an object symbol attached.
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3. Drag the OLE object to the desired size.         
The "Insert Object" dialog is opened.

4. Select the option "Create from file" or "Create new".         
These two options are described in detail in the chapter "OLE object".

Create from file
With the option "Create from file", an already existing file is chosen for display in the selected 
OLE object. The selected file is edited in the OLE object with the program that is registered 
for editing the selected file type in the operating system.

Create new
The "Create new" option selects a file type for a new file that is created in the selected OLE 
object. The selected file is edited in the OLE object with the program that is registered for 
editing the selected file type in the operating system.

Note

To prevent problems in Runtime, a video object of the AVI format is inserted as a control 
object and not as an OLE object.

Changing OLE object
Select an object of the OLE object type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Editing embedded file in the OLE object
1. Double-click the OLE object to edit the embedded file in the OLE object.          

The program registered in the Windows operating system for editing the associated file 
type opens in the Graphics Designer.

2. Execute the desired changes.         
    See the help system of the program for information on the editing procedures.

3. Finish editing the embedded file by deselecting the OLE object.

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  523



Note

An OLE object that you want to edit in a picture must be in the original path. If this is not the 
case, double-clicking on the OLE object may affect the operation of the Graphics Designer.

 

After processing an OLE object, it can occur that the toolbars of the Graphics Designer are 
no longer displayed. You can prevent this error after processing an OLE object if you first 
close the server application (for example Excel or Paint) before exiting the Graphic Designer.

To restore the display of toolbars, proceed as follows:

1. Select all of the objects available in the active picture.

2. Open the "View" menu and select the "Toolbars..." option.

3. In the "Toolbars" dialog, click the "Restore" button.

See also
How to insert an OLE object with the "Create from file" option (Page 524)

How to insert an OLE object with the "Create new" option (Page 526)

Quick Object Configuration (Page 606)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

How to insert an OLE object with the "Create from file" option

Introduction
The OLE object enables files created in other programs to be inserted into a picture.

With the option "Create from file", an already existing file is chosen for display in the selected 
OLE object. The selected file is edited in the OLE object with the program that is registered 
for editing the selected file type in the operating system.
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Requirements
● The display of the object palette must be enabled.

● The desired file type must be registered in the operating system.

Procedure
1. Open the picture into which you want to insert an OLE object and click the smart object 

"OLE object" in the Object Palette.

2. Place the mouse pointer at the position in the picture where you want to insert the OLE 
object.         
The mouse pointer changes into a crosshair with an object symbol attached.

3. Drag the OLE object to the desired size.         
The "Insert Object" dialog is opened.

4. Select option Create from File.         
In the Create from File dialog are an input field, the "Browse..." button and the "Link" check 
box.

5. Enter the directory path and the name of the desired file into the input field. Or click the 
"Browse..." button to select the desired file with the "Browse" dialog.

6. Mark the "Link" check box if the selected file should not be copied to the OLE object, but 
rather should only be used as a reference.

7. Mark the "As icon" check box if only an icon for the associated file type should be displayed 
and not the contents of the selected file.

8. Confirm the input with "OK".          
The insertion process for the "OLE" object is finished.
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See also
How to Insert an OLE Object (Page 522)

How to insert an OLE object with the "Create new" option (Page 526)

How to insert an OLE object with the "Create new" option

Introduction
The OLE object enables files created in other programs to be inserted into a picture.

The "Create new" option selects a file type for a new file that is created in the selected OLE 
object in the "Insert object" dialog. The selected file is edited in the OLE object with the program 
that is registered for editing the selected file type in the operating system.

Requirements
● The display of the object palette must be enabled.

● The desired file type must be registered in the operating system.

Procedure
1. Open the picture into which you want to insert an OLE object and click the smart object 

"OLE object" in the Object Palette.

2. Place the mouse pointer at the position in the picture where you want to insert the OLE 
object.         
The mouse pointer changes into a crosshair with an object symbol attached.

3. Drag the OLE object to the desired size.         
The "Insert Object" dialog is opened.
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4. Select the option Create New.         
The Insert Object dialog, a list of all file types registered in the Windows operating system 
is displayed.

5. Select the object type for the file that you want to create in the selected OLE object.

6. Mark the "As icon" check box if only an icon for the associated file type should be displayed 
and not the contents of the selected file.

7. Confirm the input with "OK".          
The insertion process for the "OLE" object is finished.

8. Double-click the OLE object to edit the embedded file in the OLE object.          
The program registered in the Windows operating system for editing the associated file 
type opens in the Graphics Designer.

9. Finish editing the embedded file by deselecting the OLE object.         
The changes are accepted.

See also
How to Insert an OLE Object (Page 522)

How to insert an OLE object with the "Create from file" option (Page 524)

I/O Field

How to insert an I/O field

Introduction
The I/O Field can be defined as an input field, an output field or a combined input/output field. 
The following data formats are available: Binary, decimal, string and hexadecimal. Limit values 
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such as "Hidden Input" or "Accept on complete input" can also be specified. The size and 
properties which an I/O Field accepts in Runtime are defined in the Graphics Designer.

Requirements
● The display of the object palette must be enabled.

● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools / 
Settings..." menu.

Inserting an I/O Field
1. Open the picture in which you want to insert an I/O Field.

2. In the Object Palette, click the smart object "I/O Field".

3. Place the mouse pointer at the position in the picture where you want to insert the I/O 
field.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the I/O field to the desired size with the mouse button pressed.         
The "I/O Field Configuration" dialog is opened. 
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5. Enter the desired values into the fields of the configuration dialog.         
You will find the description of the configuration dialog in the next section.

6. Confirm the input with "OK".          
The insertion process for the "I/O field" is finished.

Alternatively you can double-click the smart object "I/O Field" in the object palette. An I/O Field 
with default object properties is then inserted near the picture origin. The "I/O Field 
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the 
insertion process is completed.         
If you press and hold down <SHIFT> during the insertion, the object "I/O field" will assume the 
shape of a square.

Changing I/O Field
Select an object of the I/O Field type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object or to change the 
appearance of the text.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.
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See also
How to configure an I/O Field (Page 530)

How to change limit values and type of value input of an I/O field (Page 531)

How to define the output format for the "Binary" data type (Page 533)

How to define the output format for the "Decimal" data type (Page 535)

How to define the output format for the "Hexadecimal" data type (Page 536)

How to define the output format for the "String" data type (Page 537)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

How to configure an I/O Field

Introduction
The "I/O-Field Configuration" dialog opens after the insertion process if the use of configuration 
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables fast 
configuration of the important features of the I/O Field. 

The configuration dialog can also be opened with the object's pop-up menu. Specific attributes 
can be changed in the "Object Properties" window.
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Tag
The I/O Field can be set dynamically by embedding tags. Regardless of the selected field type, 
the value of these tags can be displayed as output or changed by entering data.

Enter the name of the desired tag or click the , to open the dialog "Tags - project: ..." to 
select a tag. See the "Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the value displayed as 
output.         
    Enter the desired interval or select an interval from the dropdown list. See the "Changing 
update cycle" section for the detailed description.

Field type
The I/O Field can be defined as an input field, an output field or a combined input/output 
field.         
Define the desired field type.

Font
The font for displaying input and output values can be changed regardless of the selected field 
type.         
Click one of the three possible buttons to open the associated dialogs.

See also
How to insert an I/O field (Page 527)

How to define the output format for the "String" data type (Page 537)

How to define the output format for the "Hexadecimal" data type (Page 536)

How to define the output format for the "Decimal" data type (Page 535)

How to define the output format for the "Binary" data type (Page 533)

How to change limit values and type of value input of an I/O field (Page 531)

Quick Object Configuration (Page 606)

Selecting a tag (Page 608)

How to change limit values and type of value input of an I/O field

Introduction
A value range can be defined for input and output of an I/O Field using limit values. Values 
outside this value range cannot be displayed or input. Additional settings that offer protection 
against accepting incorrect values can be made for value input.
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Specifying field type
The I/O Field can be defined as an input field, an output field or a combined input/output 
field.         
Specify the desired field type with the "Field type" attribute in the "Output / Input" property 
group.

Setting Limit Values
The "High Limit Value" attribute defines the maximum limit value for input and output. The 
specified value depends on the "data format" of the I/O field. The "Low Limit Value" attribute 
defines the minimum limit value for input and output. The specified value depends on the "data 
format" of the I/O field. 

If a value is lower than the low limit value or higher than the high limit value, the following 
effects may occur in Runtime:

● Field type = "Input"         
The "WinCC Runtime" dialog is opened and displayed the error message "The entered 
value is outside the configured limits".         
Confirm this error message with "OK" and enter another value.

● Field type = "Output"         
The display of the value is substituted by the character string "***".

The "Data Format" and "Field Type" attributes can be changed in the "Output / Input" property 
group. A limit value cannot be specified for the "String" format.

Input value into an I/O Field
1. Double-click the I/O field.         

The input mode opens. A placeholder is displayed for every character corresponding to the 
specified output format.         
If a value has already been input, it is highlighted.

2. Enter a new value.

3. Depending on the setting of the attributes of the I/O Field, the value is accepted on 
completion of input or the input must be finished by pressing <Enter> .

Specifying type of value input

Immediate Input
The "Immediate Input" attribute specifies for input fields whether or not a direct change is made 
into the input mode on jumping to the object.

Clear on New Input
The "Clear on New Input" attribute specifies whether the field contents are cleared when 
selecting the input field.
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Clear on Invalid Input
The "Clear on Invalid Input" attribute can be used to prevent adoption of an incorrect input 
value when the field is left. For example, an input value that does not correspond to the 
predefined data format of the input field is incorrect.

Apply on Full
The "Apply on Full" attribute specifies when an input value is applied. If the attribute has the 
value "No", the input value is only applied when the input is confirmed with <Enter> . Otherwise 
the input value is automatically applied as soon as the preset number of characters has been 
entered. 

Apply on Exit
The "Apply on Exit" attribute can also be enabled for a value input in the event that the I/O 
Field is exited without prior confirmation or reaching the required number of characters.

Hidden Input
The "Hidden Input" attribute specifies whether the input value is displayed during input as 
normal or encrypted. If this attribute has the value "Yes", every character input is replaced with 
the "*" character. The value entered and the data format of the value cannot be recognized.

Continue to shoe input value after <Enter>
After confirming the entry with <Enter>, the entered value is deleted. If you configure a direct 
connection between the "Input value" attribute and the "Output value" attribute, the input value 
continues to be shown after confirming with <Enter>. 

See also
How to insert an I/O field (Page 527)

How to define the output format for the "String" data type (Page 537)

How to define the output format for the "Hexadecimal" data type (Page 536)

How to define the output format for the "Decimal" data type (Page 535)

How to define the output format for the "Binary" data type (Page 533)

How to configure an I/O Field (Page 530)

How to define the output format for the "Binary" data type

Introduction
Four different data formats are available for the input and output of values in an I/O field. 
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data 
format must be specified for the I/O Field to display text.
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Based on the specified data format different output formats can be selected or freely defined 
for displaying the field contents.          
The definition for an output format can be rewritten as a sequence of formatting codes. The 
formatting codes act as placeholders for a specific group of characters. For example, if a 
formatting code for which only the display of the numbers 0-9 is preset for a specific position 
in the display of an I/O Field, only letters can be input at this position.

NOTICE

If the value you want to display does not correspond exactly to the definition of the output 
format, only three asterisks are displayed. This applies for the length of the entire character 
string and also for the type and position of the individual characters.

Formatting codes - "binary" data type

1 Placeholder for the binary values 0 and 1. The number of the formatting code "1" 
specifies the permissible number of positions for displaying a binary value.

0 If necessary a leading zero is placed before the binary value. The output format can 
therefore begin with the formatting code "0", but can only have this once.

Example - "binary" data type
The 8-digit binary value 10011101 can be displayed as follows:

Output format Allowed number of positions Display

11 2 01
011 2 + leading zero 001
1111 4 1101
01111 4 + leading zero 01101
1111111 7 0011101
01111111 7 + leading zero 00011101
1111111111 10 10011101
01111111111 10 + leading zero 010011101

See also
How to insert an I/O field (Page 527)

How to define the output format for the "String" data type (Page 537)

How to define the output format for the "Hexadecimal" data type (Page 536)

How to define the output format for the "Decimal" data type (Page 535)

How to change limit values and type of value input of an I/O field (Page 531)

How to configure an I/O Field (Page 530)
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How to define the output format for the "Decimal" data type

Introduction
Four different data formats are available for the input and output of values in an I/O field. 
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data 
format must be specified for the I/O Field to display text.

Based on the specified data format different output formats can be selected or freely defined 
for displaying the field contents.          
The definition for an output format can be rewritten as a sequence of formatting codes. The 
formatting codes act as placeholders for a specific group of characters. For example, if a 
formatting code for which only the display of the numbers 0-9 is preset for a specific position 
in the display of an I/O Field, only letters can be input at this position.

NOTICE

If the value you want to display does not correspond exactly to the definition of the output 
format, only three asterisks are displayed. This applies for the length of the entire character 
string and also for the type and position of the individual characters.

Formatting codes - "decimal" data type

9 Placeholder for the binary values 0 and 9. The number of the formatting code "9" 
specifies the permissible number of positions for displaying a decimal value. If the actual 
number of decimal places exceeds the number specified in the display format, the 
displayed value is rounded out.

, A comma defines the position for decimal point. The formatting code "," can be at any 
position in the output format, but can only be used once.

s Positive decimal numbers are displayed with signs. The formatting code "s" must be at 
the first position of the output format and must be used only once.

0 Leading and following zeroes are displayed when the actual number of position before 
and after the decimal point is less that the number set in the display format. The 
formatting code "0" must be before the first "9" and must be used only once.

e The decimal number is displayed in exponential format. The formatting code "e" must 
be at the last position of the output format and must be used only once.

Example - "Decimal" data type
The 6-digit decimal number 123.456 can be displayed as follows:

Output format Allowed number of positions Display

999 3 124
999,9 4 123,5
s999.9 4 + sign +123,5
999,999 6 123,456
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Output format Allowed number of positions Display

09999,9999 8 + zeroes 0123,4560
s09999.9999 8 + sign + zeroes +0123,4560
1111111111 10 10011101
9.99999e 6 1.23456e+002

Note

If a floating point number is saved in the IEEE format of the S5, an output format that allows 
the sign and exponent should be used for display in an I/O Field (e.g. s0999.999e).

See also
How to configure an I/O Field (Page 530)

How to change limit values and type of value input of an I/O field (Page 531)

How to define the output format for the "Binary" data type (Page 533)

How to define the output format for the "Hexadecimal" data type (Page 536)

How to define the output format for the "String" data type (Page 537)

How to insert an I/O field (Page 527)

How to define the output format for the "Hexadecimal" data type

Introduction
Four different data formats are available for the input and output of values in an I/O field. 
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data 
format must be specified for the I/O Field to display text.

Based on the specified data format different output formats can be selected or freely defined 
for displaying the field contents.          
The definition for an output format can be rewritten as a sequence of formatting codes. The 
formatting codes act as placeholders for a specific group of characters. For example, if a 
formatting code for which only the display of the numbers 0-9 is preset for a specific position 
in the display of an I/O Field, only letters can be input at this position.

NOTICE

If the value you want to display does not correspond exactly to the definition of the output 
format, only three asterisks are displayed. This applies for the length of the entire character 
string and also for the type and position of the individual characters.
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Formatting codes - "Hexadecimal" data type

f Placeholder for the letters A-F and a-f and the digits 0-9, which are used to display 
hexadecimal numbers. The allowed number of characters is defined by the number of 
the formatting code "f" in the output format.

0 Leading zeros of the hexadecimal value are displayed if the output format begins with 
the formatting code "0". The formatting code "0" must be included only once.

See also
How to configure an I/O Field (Page 530)

How to change limit values and type of value input of an I/O field (Page 531)

How to define the output format for the "Binary" data type (Page 533)

How to define the output format for the "Decimal" data type (Page 535)

How to define the output format for the "String" data type (Page 537)

How to insert an I/O field (Page 527)

How to define the output format for the "String" data type

Introduction
Four different data formats are available for the input and output of values in an I/O field. 
Numerical values can be edited in binary, decimal or hexadecimal format. The "String" data 
format must be specified for the I/O Field to display text.

Based on the specified data format different output formats can be selected or freely defined 
for displaying the field contents.          
The definition for an output format can be rewritten as a sequence of formatting codes. The 
formatting codes act as placeholders for a specific group of characters. For example, if a 
formatting code for which only the display of the numbers 0-9 is preset for a specific position 
in the display of an I/O Field, only letters can be input at this position.

NOTICE

If the value you want to display does not correspond exactly to the definition of the output 
format, only three asterisks are displayed. This applies for the length of the entire character 
string and also for the type and position of the individual characters.

Formatting codes - "String" data type
The allowed length of a character string is defined by the number of formatting codes used 
(exception "*").

* Input of a character string of any length
? Input of any character string
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a Lower-case letters, upper-case letters and digits are allowed         
no separators or similar.

A Upper-case letters and digits are allowed         
no lower case letters, separators or similar.

b Lower-case letters and upper-case letters are allowed         
no digits, separators or similar.

B Only upper-case letters are allowed         
no lower case letters, digits, separators or similar.

1-9 The formatting codes "1", "2", ..., "9" are used as placeholders for digits.         
The selected formatting code also defines the actual digits allowed: For example, 
if the "2" is specified, only the digits 0, 1 or 2 can be displayed. The formatting code 
"8" allows all digits except for the 9.

h Only the digits 0-9 and the letters A-F or a-f are allowed.         
The formatting code "h" allows only characters that are required to display 
hexadecimal numbers.

t The formatting code "t" forces input of a separator at the specified position. These 
separators are valid: Slash, colon, comma, period and space.

See also
How to configure an I/O Field (Page 530)

How to change limit values and type of value input of an I/O field (Page 531)

How to define the output format for the "Binary" data type (Page 533)

How to define the output format for the "Decimal" data type (Page 535)

How to define the output format for the "Hexadecimal" data type (Page 536)

How to insert an I/O field (Page 527)

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
538 System Manual, 11/2008,  



Bar

How to insert a bar

Introduction
The "Bar" object offers the option of displaying values graphically. The values can also be 
displayed in a combined view as graphics with freely definable number scale. The size and 
properties which a bar accepts in Runtime are defined in the Graphics Designer.

Requirements
● The display of the object palette must be enabled.

● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools / 
Settings..." menu.
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Inserting bar
1. Open the picture in which you want to insert a bar.

2. In the Object Palette, click the smart object "Bar".

3. Place the mouse pointer at the position in the picture where you want to insert a 
bar.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the bar to the desired size with the mouse button pressed.         
The "Bar Configuration" dialog is opened. 

5. Enter the desired values into the fields of the configuration dialog.         
You will find the description of the configuration dialog in the next section.

6. Confirm the input with "OK".          
The insertion process for the "Bar" object is finished.

Alternatively you can double-click the smart object "Bar" in the object palette. A bar with default 
object properties is then inserted near the picture origin. The "Bar Configuration" dialog opens. 
As soon as you have confirmed your entries with "OK", the insertion process is 
completed.         
If you press and hold down <SHIFT> during the insertion, the object "Bar" will assume the 
shape of a square.

Changing bar
Select an object of the bar type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object or to change the 
appearance of the text.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.
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See also
How to configure a bar (Page 541)

How to configure the limits of a bar (Page 542)

How to configure the bar scale (Page 544)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

How to configure a bar

Introduction
The "Bar Configuration" dialog opens after the insertion process if the use of configuration 
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables fast 
configuration of the important features of the bar. 

The configuration dialog can also be opened with the object's pop-up menu. Specific attributes 
can be changed in the "Object Properties" window.

Tag
The display value of the bar can be dynamically changed by embedding a tag.
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Enter the name of the desired tag or click the , to open the dialog "Tags - project: ..." to 
select a tag. See the "Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the value displayed by the 
bar.         
    Enter the desired interval or select an interval from the dropdown list. See the "Changing 
update cycle" section for the detailed description.

Limits
The two ends of the bar view are specified by the maximum value and the minimum value of 
the bar.         
Enter the desired limits for the bar display. See the "Change maximum value" and "Change 
minimum value" for the detailed description.

Bar direction
Specify the direction of the coordinate axis to which the maximum value of bar points.         
See the "Changing bar direction of the bar" section for the detailed description.

See also
Selecting a tag (Page 608)

How to configure the limits of a bar (Page 542)

How to configure the bar scale (Page 544)

How to insert a bar (Page 539)

Quick Object Configuration (Page 606)

How to configure the limits of a bar

Introduction
For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

Name Upper limit (High) Lower limit (Low)

Alarm limit A         
Warning limit W         
Tolerance limit T         
Reserve 4 R4         
Reserve 5 R5

AH – Alarm High         
WH – Warning High         
TH – Tolerance High         
RH4 – Reserve High 4         
RH5 – Reserve High 5

AL – Alarm Low         
WL – Warning Low         
TL – Tolerance Low         
RL4 – Reserve Low 4         
RL5 – Reserve Low 5

General: Limit X XH – High Limit Value of limit X XL – Low Limit Value of limit X
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Upper limit, Lower limit, type
The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values. 

Bar color, Change Color
The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

Monitoring, Limit Marker
The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Trend
The "Trend" attribute specifies whether or not the trend is displayed.         
The trend display enables a fast overview of changes for the bar. If the value displayed in the 
scale is exceeded, a small arrow is displayed beside the scale by default. The arrow indicates 
that the measured value cannot be displayed on the scale. Another scale can be shown on 
the other side of the bar to avoid having to wait for the next update. This arrow shows the trend 
of the current movement of the bar. 

Hysteresis, Hysteresis Range
So that a color change is not triggered immediately in the case of a slight limit violation, the 
"Hysteresis" and "Hysteresis Range" attributes can be used to define a distribution range for 
the display of the value.         
The "Hysteresis" attribute specifies for the "Bar" object whether the display with hysteresis is 
permitted or not.          
The "Hysteresis Range" attribute specifies for the "Bar" object the hysteresis as a percentage 
of the display range.

See also
How to configure a bar (Page 541)

How to configure the bar scale (Page 544)

How to insert a bar (Page 539)
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How to configure the bar scale

Introduction
The "Bar" object can be labeled by showing a scale. The layout and graduation of the scale 
and the size and format of the label can be configured by changing the relevant attributes as 
required.

Setting scale end values and zero point value
The attribute "Maximum value" defines the absolute value for the display of the highest 
value.         
The attribute "Minimum value" defines the absolute value for the display of the smallest 
value.         
The attribute "Zero point value" defines the absolute value for the zero value of the bar.

Setting layout of the scale
The "Scale" attribute specifies for the "Bar" object whether the bar is labeled with a 
scale.         
The "Bar Direction" attribute specifies for the "Bar" object the direction of the coordinate axis, 
which the highest display value of the bar points to.         
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    The "Alignment" attribute defines the arrangement of the scale relative to the bar for the 
"Bar" object. Depending on the setting for the "Bar Direction" attribute in the "Geometry" 
property group, the scale can be displayed to the left or right or above or below the bar.

Defining bar segments
The "Scale Marks" attribute specifies the number of segments into which the bar is divided by 
the large tick marks of the scale.         
The "Axis Section" attribute defines the distance between the large tick marks. The value is 
shown as the difference in value between two adjacent large tick marks.

Setting scale division
The "Zero Point" attribute specifies for the representation of the bar in which position the zero 
point value is displayed. The value is specified relative to the spacing of the scale end values 
in %. For a value of 0 %, for example, the zero point value is shown at the height of the large 
tick mark with the lowest value. The zero point can also be outside of the range 
represented.         
The "Zero Point" attribute is only evaluated if the "Bar Scaling" attribute has the value 
"Automatic". The absolute value for the zero point is set with the "Zero Point Value" attribute 
in the "Miscellaneous" property group.

The "Bar Scaling" attribute specifies the type of scale division. By selecting suitable scale 
divisions, it is possible to emphasize a particular range of values in the bar display.
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Setting format of tick marks
The "Large Tick Marks Length" attribute specifies for the "Bar" object whether the sections 
between the large tick marks in the scale of the bar are divided by shorter tick marks.         
The "Large Tick Marks" attribute specifies whether the large tick marks of the scale are shown 
in bold or normal.         
The "Length of Large Tick Marks" attribute specifies the length of the large tick marks. The 
length of the shorter tick marks corresponds to half of the value specified here. The values are 
specified in pixels.

Setting format of label
The "Label Each" attribute specifies the number of labeled large tick marks. If, for example, 
the attribute has the value "3", only every third large tick mark is labeled, starting with the large 
tick mark with the lowest value.

The "Exponent Display" attribute shows whether the numerical values of the scale are shown 
as exponents or as decimal values without exponents.         
The "Decimal Places" attribute specifies the number of digits before the decimal point for the 
display of numerical values in the scale.         
The "Decimal Places" attribute specifies the number of digits to the right of the decimal point 
for the numerical value display in the scale.
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See also
How to configure a bar (Page 541)

How to configure the limits of a bar (Page 542)

How to insert a bar (Page 539)

How to insert a graphic object

Introduction
The graphic object enables graphics created in other programs to be inserted into a picture. 
You can insert graphics or images with the following formats:          
EMF, WMF, DIB, BMP (to 32 Bit), GIF, JPEG, ICO and PNG. 

The size and properties that a graphic object has in runtime are defined in the Graphics 
Designer. 
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Prerequisites
● The display of the object palette is activated.

● The use of the configuration dialogs is activated under "Tools > Settings..." on the "Options" 
tab.

Inserting Graphic Object
1. Open the picture in which you want to insert a graphic object.

2. In the Object Palette, click the smart object "Graphic Object".

3. Place the mouse pointer at the position in the picture where you want to insert a graphic 
object.
The mouse pointer changes into a crosshair with an object symbol attached. 

4. Hold down the mouse button and drag the graphic object to the required size.
The "Graphic Object Configuration" dialog opens. 

5. Select the picture that you want to display in the graphic object.
The description of the configuration dialog can be found in the next section. 

6. Click "OK" to confirm your input.
The insertion process for the "Graphic Object" is finished.

Alternatively, you can double-click the smart object "Graphic Object" in the object palette. A 
graphic object with default object properties is then inserted near the picture origin. The 
"Graphic Object Configuration" dialog opens. The insertion process is finished when you 
confirm your inputs with "OK". 

If you hold down the <Shift> key during insertion, the "Graphic object" object is created in the 
shape of a square.

Configuring a graphic object
The "Graphic object configuration" dialog opens after the insertion process if the use of 
configuration dialogs is enabled in the "Options" tab under "Tools > Settings...". It enables fast 
configuration of the important features of the graphic object. 

You can open the configuration dialog with the pop-up menu for the object. You can change 
the individual attributes in the "Object properties" window. 
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Preview
The picture selected in the picture selection is displayed as a preview.

Selection of Picture
The picture selection shows all pictures in the EMF, WMF, DIB, BMP, GIF, JPEG, ICO and 
PNG formats that are in the graphics directory "GraCS" of the current WinCC project.          
Select the picture that you want to display in the graphic object. Click on the "Browse ..." button 
to insert additional pictures from the picture selection.          
See the "Select pictures" section for the detailed description.

Changing Graphic Object
Select an object of the graphic object type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.          
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the "Rotate" element of the standard toolbar to rotate the object.          
Use elements of the Style Palette to change the display style for the object.
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Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Note

If the "Picture Transparent Color On" attribute has the value "Yes" for a graphic object, the 
available flash frequency is also reduced if necessary. 

See also
Selecting pictures (Page 610)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

Status display

How to insert a status display

Introduction
The status display offers the option to display almost any number of different states of an 
object. The states are implemented via tags whose value corresponds to the respective state. 
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The states are displayed via the assigned pictures. The size and properties which a status 
display accepts in Runtime are defined in the Graphics Designer.

Requirements
● The display of the object palette must be enabled.

● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools / 
Settings..." menu.

Inserting a status display
1. Open the picture in which you want to insert a status display.

2. In the Object Palette, click the smart object "Status Display".

3. Place the mouse pointer at the position in the picture where you want to insert the status 
display.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the status display to the desired size with the mouse button pressed.         
The "Status Display Configuration" dialog is opened. 
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5. Enter the desired values into the fields of the configuration dialog.         
You will find the description of the configuration dialog in the next section.

6. Confirm the input with "OK".          
The insertion process for the "Status display" object is finished.

Alternatively you can double-click the smart object "Status Display" in the object palette. A line 
with default object properties is then inserted near the picture origin. The "Status Display 
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the 
insertion process is completed.         
If you press and hold down <SHIFT> during the insertion, the object "Status display" will 
assume the shape of a square.

Changing Status Display
Select an object of the Status Display type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the color palette to change the line color.         
Use elements of the Style Palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

See also
How to configure a status display (Page 553)

How to configure states (Page 554)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Standard Objects (Page 475)
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How to configure a status display

Introduction
The "Status Display Configuration" dialog opens after the insertion process if the use of 
configuration dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. The 
"Status Display Configuration" dialog enables fast configuration of the important features of 
the status display. 

The configuration dialog can also be opened with the object's pop-up menu. Specific attributes 
can be changed in the "Object Properties" window.

Tag
The value of the status you want to display can be set dynamically by embedding a tag.

Enter the name of the desired tag or click the , to open the dialog "Tags - project: ..." to 
select a tag. See the "Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the status display.         
    Enter the desired interval or select an interval from the dropdown list. See the "Changing 
update cycle" section for the detailed description.
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Status list
The status list shows the linked pictures and the specified flash frequency for all configured 
states.         
States can be inserted and every setting can be changed with a pop-up menu. Pictures of the 
picture selection can be referenced by dragging them with the mouse to the required position 
in the state list. See the "Configuring Status" section for the detailed description.

Bit Position
A status can also be assigned to a specific bit position of the tags.         
Click the arrow keys to select a bit position. Click the field "Add" to enter the status of this bit 
position in the status list. Click the button "Add" again to add the next highest bit 
position.         
See the "Configuring Status" section for the detailed description.

Preview
The picture selected in the picture selection is displayed as a preview.

Selection of Picture
The picture selection shows all pictures in the graphics directory "GraCS" of the current WinCC 
project. Graphics and pictures of the following formats can be inserted:          
BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.         
Use the mouse to drag a picture of the picture selection to the desired position in the status 
list in order to assign it to a status as a basic picture or a flash picture. Click the "Browse ..." 
button to insert additional pictures from the picture selection.         
You will find the detailed description in the section "Select pictures".

See also
Selecting pictures (Page 610)

Selecting a tag (Page 608)

How to configure states (Page 554)

How to insert a status display (Page 550)

How to configure states

Introduction
The status display offers the option to display almost any number of different states of an 
object. The states are implemented via tags whose value corresponds to the respective state. 

In Runtime the states are displayed via the assigned pictures. If no picture that you want to 
display is defined for a status, the symbol for the status display is shown as a 
placeholder.         
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If a status that has not been configured occurs in Runtime, the pictures of the prior status are 
shown. The settings for the following status are shown if there was no prior status.

States can be configured in the status list of the "Status Display Configuration" dialog. The 
configuration dialog is also be opened with the "Status Display" object's pop-up menu. The 
status list shows the linked pictures and the specified flash frequency for all configured states. 
States can be inserted and every setting can be changed with a pop-up menu. A state can 
also be assigned to a certain bit position on the tag.

The status display is divided into four columns, the width of which can be changed by moving 
the separation lines. Every line of the status list shows the settings for a specific state. Clicking 
on the exact position of a setting opens the pop-up menu. The following settings can be 
configured in the status list:

● Status column         
Shows the value of the configured status. States can be inserted or deleted. The command 
"Clear List" of the pop-up menu removes all states to which no pictures are assigned.

● Basic Picture column         
Shows the name of the picture that is displayed in Runtime when the status happens. The 
basic picture of a status can be deleted via the pop-up menu.

● Flash Picture column         
Shows the name of the picture that is displayed alternating with the basic picture, if a flash 
frequency is set for the blinking attribute. The flash picture of a status can be deleted via 
the pop-up menu.

● Flashing attribute column         
Displays the set flash frequency. The values "no flashing", "Slow", "Medium" and "Fast" 
can be set via the pop-up menu.
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Inserting status
Select the position in the "State" column at which you wish to insert a status. Select the entry 
"Add" in the pop-up menu. The status for the next free position is inserted.

Inserting status as bit position
Click the arrow key to select a bit position. Click the field "Add..." to enter the status of this bit 
position in the status list. The value selected as bit position is increased by one position. Click 
the "Add" button again to insert the next higher bit position.

Renaming status
Double-click the position in the state column at which you wish to rename a status. Enter the 
new value and confirm this by pressing <ENTER>. If the new value is already assigned, no 
change is made.

Deleting status
Select the position in the state column at which you wish to delete a status. Select the entry 
"Delete" in the pop-up menu. The status is deleted so long as at least one additional status is 
configured.

Clearing status list
Open the pop-up menu at any status in the state column and select the entry "Clear List". All 
states to which no pictures are assigned are cleared.

Assigned pictures
Select the picture in the picture selection that you want to assign a status as basic picture or 
flash picture. Drag the picture to the desired position with the mouse. An existing picture is 
replaced by the new picture.

Delete pictures
Select the entry "Delete" in the pop-up menu of a configured picture to remove the picture from 
the status list.

Changing flashing attribute
If a status is assigned only one basic picture, the associated flash automatically receives the 
"no flashing" attribute. If a basic picture and flash picture are assigned to a status, you can 
change the flash with the pop-up menu.
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See also
How to configure a status display (Page 553)

How to insert a status display (Page 550)

Text list

How to add a text list

Introduction
The text list offers the option of assigning specific values to a text. The text list can be defined 
as an input list, an output list or as a combined input/output list. The following data formats are 
available: Decimal, binary or bit. The size and properties which a text list has in Runtime are 
defined in the Graphics Designer.

Requirements
● The display of the object palette must be enabled.

● The use of configuration dialogs must be enabled in the "Options" tab of the "Tools / 
Settings..." menu.
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Inserting Text List
1. Open the picture in which you want to insert a text list.

2. In the Object Palette, click the smart object "Text List".

3. Place the mouse pointer at the position in the picture where you want to insert the text 
list.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the text list to the desired size with the mouse button pressed.         
The "Text List Configuration" dialog is opened. 

5. Enter the desired values into the fields of the configuration dialog.         
You will find the description of the configuration dialog in the next section.

6. Confirm the input with "OK".          
The insertion process for the "Text List" object is finished.

Alternatively you can double-click the smart object "Text List" in the object palette. A text list 
with default object properties is then inserted near the picture origin. The "Text List 
Configuration" dialog opens. As soon as you have confirmed your entries with "OK", the 
insertion process is completed.         
If you press and hold down <SHIFT> during the insertion, the object "Text List" will assume 
the shape of a square.

Note

If you assign a text to a value in the text list, the text must not include a semicolon.

The semicolon is a WinCC control character and will be automatically deleted in a text.

Changing text list
Select an object of the text list type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object or to change the 
appearance of the text.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.
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See also
How to configure a text list (Page 559)

How to configure apply values and display text of a text list (Page 560)

How to configure assignments for the "Decimal" type list (Page 562)

How to configure assignments for the "Binary" list type (Page 563)

How to configure assignments for the "Bit" list type (Page 564)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

How to configure a text list

Introduction
The "Text List Configuration" dialog opens after the insertion process if the use of configuration 
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables fast 
configuration of the important features of the text list. The configuration dialog can also be 
opened with the object's pop-up menu. Specific attributes can be changed in the "Object 
Properties" window.
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Tag
The text list can made dynamic by embedding a tag. Regardless of the selected field type, the 
value of these tags can be displayed as output or changed by entering data.

Enter the name of the desired tag or click the , to open the dialog "Tags - project: ..." to 
select a tag. See the "Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the value displayed as 
output.         
    Enter the desired interval or select an interval from the dropdown list. See the "Changing 
update cycle" section for the detailed description.

Field type
The text list can be defined as an input list, an output list or as a combined input/output 
list.         
Define the desired field type.

Font
The font for displaying input and output values can be changed regardless of the selected field 
type.         
Click one of the three possible buttons to open the associated dialogs.

See also
Selecting a tag (Page 608)

How to configure apply values and display text of a text list (Page 560)

How to configure assignments for the "Decimal" type list (Page 562)

How to configure assignments for the "Binary" list type (Page 563)

How to configure assignments for the "Bit" list type (Page 564)

How to add a text list (Page 557)

Quick Object Configuration (Page 606)

How to configure apply values and display text of a text list

Introduction
Output value and apply values can be configured by changing the associated attributes for the 
"Text List" object as required. In addition, assignments and reference for the display text can 
be configured.
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Specifying field type
The fields of the text list can be defined as an input field, output field or combined input/output 
field. Specify the desired field type with the "Field type" attribute in the "Output / Input" property 
group.

Change output value
The "Output Value" attribute specifies a start value for the output which is displayed in Runtime 
in the case of a missing process driver connection or if an update has not yet taken place.

Activating apply values on exit
The "Apply on Exit" attribute specifies whether the input is applied when you exit the text list 
with <TAB> or by clicking the mouse.

Specifying text reference
The "Text Reference" attribute specifies where the language-dependent assignment texts are 
stored. The texts can be managed directly in the object or in the text library where the 
translation into other languages is made.

Configuring assignments
The "Assignments" attribute in the "Input/Output" property group allows display texts to be 
specified. The display texts are displayed depending on the current "Output Value"

Note

If you assign a text to a value in the text list, the text must not include a semicolon.

The semicolon is a WinCC control character and will be automatically deleted in a text.

See also
How to configure a text list (Page 559)

How to configure assignments for the "Decimal" type list (Page 562)

How to configure assignments for the "Binary" list type (Page 563)

How to configure assignments for the "Bit" list type (Page 564)

How to add a text list (Page 557)
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How to configure assignments for the "Decimal" type list

Introduction
The text list offers the option of assigning specific values to a text. The "Assignments" attribute 
in the "Input/Output" property group allows display texts to be specified. The display texts are 
displayed depending on the current "Output Value".

The "Decimal" list type allows specific values or value ranges to display texts.

Requirements
● Select a text list of the "Decimal" list type.

● Open the "TextList assignments (decimal)" dialog by double-clicking on the "Assignments" 
attribute in the "Output/Input" property group.

Defining new assignments
1. Select a range type from the dropdown list field to specify the desired value range:         

"Individual value" - A display text is assigned to an individual value.         
"From Value" - A display text applies to all values greater than or equal to that specified 
here.         
"To Value" - A display text applies to all values lesser than or equal to that specified 
here.         
"From To Value" - A display text applies to all values of the value range specified here.

2. Enter the desired value or value range.

3. Enter the text that you want to display for this value or value range. The text must not include 
a semicolon.

4. Click the "Append" button.         
    The new assignment is input into the assignments list.
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Sorting assignments
Select the assignments that you want to sort. Click the "Up" or "Down" button to move these 
assignments to the assignments list.

Deleting assignments
Select the assignments that you want to delete in the assignments list and click the "Delete" 
button.

See also
How to configure a text list (Page 559)

How to configure apply values and display text of a text list (Page 560)

How to configure assignments for the "Binary" list type (Page 563)

How to configure assignments for the "Bit" list type (Page 564)

How to add a text list (Page 557)

How to configure assignments for the "Binary" list type

Introduction
The text list offers the option of assigning specific values to a text. The "Assignments" attribute 
in the "Input/Output" property group allows display texts to be specified. The display texts are 
displayed depending on the current "Output Value"

Display texts are assigned by bit number for the "Binary" list type. Up to 32 display texts can 
be defined. If a bit set in the output value is not assigned a display text, three asterisks appear 
in the drop-down list.

Requirements
● Selecting a text list of the "Binary" list type.

● Open the "TextList assignments (binary)" dialog by double-clicking on the "Assignments" 
attribute in the "Output/Input" property group.

Defining new assignments
1. Enter the bit number that you want to assign to a display text.

2. Enter the desired display text. The text must not include a semicolon.

3. Click the "Append" button.         
The new assignment is input into the assignments list.
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Sorting assignments
Select the assignments that you want to sort. Click the "Up" or "Down" button to move these 
assignments to the assignments list.

Deleting assignments
Select the assignments that you want to delete in the assignments list and click the "Delete" 
button.

See also
How to configure a text list (Page 559)

How to configure apply values and display text of a text list (Page 560)

How to configure assignments for the "Decimal" type list (Page 562)

How to configure assignments for the "Bit" list type (Page 564)

How to add a text list (Page 557)

How to configure assignments for the "Bit" list type

Introduction
The text list offers the option of assigning specific values to a text. The "Assignments" attribute 
in the "Input/Output" property group allows display texts to be specified. The display texts are 
displayed depending on the current "Output Value"

With the "Bit" list type one display text each can be defined for the statuses "1 - Bit set" and 
"0 - Bit not set" of the relevant bit in the output value. The "Bit Number" attribute specifies the 
number of the relevant bit in the output value.
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Requirements
● Selecting a text list of the "Bit" list type.

● Open the "TextList assignments (bit)" dialog by double-clicking on the "Assignments" 
attribute in the "Output/Input" property group.

Defining assignments

Enter the desired display text for the states 0 and 1 and confirm the assignments with "OK". 
The display text must not include a semicolon.

See also
How to configure a text list (Page 559)

How to configure apply values and display text of a text list (Page 560)

How to configure assignments for the "Decimal" type list (Page 562)

How to configure assignments for the "Binary" list type (Page 563)

How to add a text list (Page 557)

How to insert multiline text

Introduction
The "Multiline Text" object makes it possible to display multiple lines of text in a rectangle in 
the picture. If the text is larger than the rectangle, WinCC automatically adds a scroll bar on 
the right-hand edge. 

If you enable operation, the operator can scroll and edit the text in Runtime. By connecting 
variables, you can use the multilined text for entering or outputting text. 

You define the size and properties of the "Multiline Text" object in the Graphics Designer. 
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Insert multiline text
1. Open the picture into which you want to insert the object.

2. In the Object Palette, click the smart object "Multiline text".

3. Move the cursor to the screen position where you want to insert the "Multiline Text" object.
The mouse pointer changes into a crosshair with an object symbol attached. 

4. Drag the rectangle to the desired size with the mouse.
The insertion process is finished as soon as you release the mouse button. 
As an alternative, double click in the Object palette on the smart object "Multiline 
text".          
The object with the default object properties is then inserted near the picture origin. 

5. Drag the rectangle surrounding the object to a new position in order to arrange the object 
in the picture.

6. Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

7. In order to change the background color, use the color palette.

8. Use elements of the Style Palette to change the display style for the object.

Edit multiline text
Select the "Properties" menu point in the shortcut menu of the object and define the attributes 
of the "Multiline Text" object in the "Object properties" window. 
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"Font" property group
You define the text and the respective display with the attributes under "Font". Enter the text 
in the "Dialog" window. 

"Miscellaneous" property group
If the attribute "Operator-Control Enable" is set to "Yes" and the operator has the access 
authorization, the operator can scroll the window and edit text in runtime. 

Dynamization
If you connect tags to the "Text" attribute, you can use the "Multiline Text" object for entering 
and outputting text. 

How to insert a combobox

Introduction
The combobox makes it possible to select one of many possible text records from a drop-down 
list for displaying and inserting in runtime. The text can be defined with tags. 

The size and properties which a combobox takes on in runtime are defined in the Graphics 
Designer. 

Insert combobox
1. Open the picture into which you want to insert an combobox.

2. In the Object Palette, click the smart object "Combobox".
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3. Place the mouse pointer at the position in the picture where you want to insert a combobox.
The mouse pointer changes into a crosshair with an object symbol attached. 

4. Press the mouse button and drag the combobox to the required size.
The insertion process is finished as soon as you release the mouse button.
Alternatively you can double-click the smart object "Combobox" in the object palette. A 
combobox with default object properties is then inserted near the picture origin. 

5. Drag the rectangle surrounding the object to a new position in order to arrange the object 
in the picture.

6. Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

7. In order to change the background color, use the color palette.

8. Use elements of the Style Palette to change the display style for the object.

Note

The color that backs the respectively selected field in runtime is defined in the operating 
system as the color for the "Selected elements" and cannot be changed in WinCC. 

Edit combobox
Select the "Properties" menu point in the context menu (pop-up menu) of the object and define 
the attributes of the combobox in the "Object properties" window. 

"Geometry" property group
Use the "Number of rows" attribute to define the amount of lines shown in the combobox. 

"Font" property group
You define the text and the respective display with the attributes under "Font". Enter the 
respective text for each index from 1 to "Number of rows". 

"Miscellaneous" property group
The "Selected text" attribute defines the index, the text of which is displayed in the combobox 
in runtime. 

If the attribute "Operator-Control Enable" is set to "Yes" and the operator has the access 
authorization, the operator can drop the combobox down and select another text in runtime. 
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Dynamics
If you connect the respective tags, you can use the combobox: 

● For the entry of a predefined text or the respective index.

● For the output of one or many predefined text records.

With other tags, you can predefine the text records dynamically yourself. 

How to insert a list box

Introduction
The list box make it possible to highlight one of many text records or select it for entry in runtime. 
If the list is longer than the list box is high, the list box is provided with two scroll arrows on the 
right for scrolling upwards and downwards. 

The size and properties that a list box has in runtime are defined in the Graphics Designer. 

Insert list box
1. Open the picture into which you want to insert an list box.

2. In the Object Palette, click the smart object "List box".

3. Place the mouse pointer at the position in the picture where you want to insert a list box.
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the list box to the desired size.
The insertion process is finished as soon as you release the mouse button. 
Alternatively you can double-click the smart object "List box" in the object palette. A list box 
with default object properties is then inserted near the picture origin. 
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5. Drag the rectangle surrounding the object to a new position in order to arrange the object 
in the picture.

6. Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

7. In order to change the background color, use the color palette.

8. Use elements of the Style Palette to change the display style for the object.

Edit list box
Select the "Properties" menu point in the shortcut menu of the object and define the attributes 
of the list box in the "Object properties" window. 

"Geometry" property group
Use the "Number of rows" attribute to define the amount of entries that the list box has. The 
number of displayed entries is defined by the height of the list box. 

Make sure that the list box is wide enough for displaying the text. Horizontal scrolling is not 
possible. Text that is too long will be cut off. 

"Font" property group
You define the text and the respective display with the attributes under "Font". Enter the 
respective text for each index from 1 to "Number of rows". 

"Miscellaneous" property group
The "Selected box" attribute defines the index, the text of which is highlighted in the list box 
when runtime is started. 

If the attribute "Operator-Control Enable" is set to "Yes" and the operator has the access 
authorization, the operator can select another text and highlight it in the list box in runtime. 
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Note

The color that backs the respectively selected field in runtime is defined in the operating 
system as the color for the "Selected elements" and cannot be changed in WinCC. 

Dynamization
If you connect tags to the respective attributes, you can use the list box for the following: 

● For entering a predefined text record or the respective index

● For outputting one of the predefined text records

You can also make the predefined text records dynamic with the respective text tags. 

How to insert a Faceplate instance

Introduction
You can insert a Faceplate instance into your picture with the Faceplate object. Faceplate 
types must first exist in your project. 

Faceplates are preconfigured combinations of objects. You save such a combination as a 
Faceplate type and can use them again and again as Faceplate instances afterwards. 

The size and properties that a Faceplate instance takes on in runtime are defined in the 
Graphics Designer. 

Insert Faceplate instance
1. Open the picture in which you want to insert a Faceplate instance.

2. In the Object palette, click the smart object "Faceplate instance".
The mouse pointer changes into a crosshair with an object symbol attached.

3. Click with the mouse on the point in the picture that you would like to insert the Faceplate 
instance.
The file selection dialog opens. 

4. Select the desired FPT file.

5. Drag the Faceplate instance to the desired size with the mouse.
Alternatively, you can double-click the smart object "Faceplate instance" in the object 
palette and select the Faceplate type. A Faceplate instance with default object properties 
is then inserted near the picture origin.
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Change Faceplate instance
Select the "Properties" menu point in the context menu (pop-up menu) of the Faceplate 
instance and edit the attributes of the Faceplate instance in the "Object properties" window. 

The properties that you can change here depend on how the properties of the Faceplate type 
are defined. Every Faceplate type has two types of attributes: 

● Type-specific attributes: These attributes can only be changed in the Faceplate type. After 
changes in the Faceplate type, the changes are effective in the Faceplate instance by 
reloading the picture.

● Instance-specific attributes: These attributes are predefined in the Faceplate type and can 
be changed in the Faceplate instance. A change in the Faceplate type has no effects on 
already inserted Faceplate instances.

Other information on Faceplate types are found in chapter "Working with Faceplate types". 

See also
Working with Faceplate Types (Page 299)

How to insert a .NET control

Introduction
The .NET framework by Microsoft is also installed with WinCC. This makes it possible to 
integrate .NET applications (Assemblies) as controls in your pictures. 

When inserting the Smart object ".NET control" select the desired control in the "Insert control" 
dialog. Here, all controls that are available on your system are displayed. 

NOTICE

Possible problems when using third-party controls

The user of the software is responsible for problems caused by the deployment of external 
controls.          
We recommend testing for safe operation before implementation.

At the end of the insertion process normally a configuration dialog is opened, which the 
properties of the control are adapted to. You can call up this dialog later by double clicking on 
the control. 

WinCC uses the designation of the control linked with a sequential number as the object name 
as default. You can change these names with the "Object name" attribute in the "Object 
properties" window. 
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Procedure
1. In the Object Palette, click the smart object ".NET control".

The mouse pointer changes into a crosshair with an object symbol attached. 

2. Click on the position in the picture where you want to insert the control.
The "Insert control" dialog is opened with the controls from the "Global assembly cache". 

3. Select the required control and confirm with "OK".

4. Choose the desired type in the "Select type" dialog.
The associated configuration dialog now opens for some controls.

5. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK."
The insertion process for the ".NET control" object is finished. 

As an alternative, double click in the object palette on the Smart Object ".NET control", in order 
to insert it with the default properties into the process picture. Select the desired control in the 
"Insert control" and "Insert type" dialogs. 

Edit .NET Control
You open the "Object properties" dialog in the context menu of the .NET control with 
"Properties". You can define the specific attributes of the selected controls in the "Control 
properties" properties group. 

How to insert a WPF control

Introduction
The Windows Presentation Framework 3.0 (WPF) by Microsoft is also installed with WinCC. 
This makes it possible to integrate WPF files as controls in your pictures. 

When inserting the Smart object "WPF control", select the desired control. Here, all controls 
that are available on your system are displayed. 
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NOTICE

Possible problems when using third-party controls

The user of the software is responsible for problems caused by the deployment of external 
controls.          
We recommend testing for safe operation before implementation.

At the end of the insertion process normally a configuration dialog is opened, which the 
properties of the control are adapted to. You can call up this dialog later by double clicking on 
the control. 

WinCC uses the designation of the control linked with a sequential number as the object name 
as default. You can change these names with the "Object name" attribute in the "Object 
properties" window. 

Procedure
1. In the object palette, click the smart object "WPF control".

The mouse pointer changes into a crosshair with an object symbol attached. 

2. Click on the position in the picture where you want to insert the control.
The "Insert control" dialog is opened with the "PresentationFramework 3.0" entry. 

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
574 System Manual, 11/2008,  



3. Select the "PresentationFramework 3.0" and confirm with "OK".

4. Choose the desired type in the "Select type" dialog.
The associated configuration dialog now opens for some controls.

5. Adapt the settings of the configuration dialog as needed. Confirm your entries with "OK".
The insertion process for the "WPF Control" object is finished. 

As an alternative, double click in the object palette on the Smart Object "WPF control", in order 
to insert it with the default properties into the process picture. Select the desired control in the 
"Insert control" and "Insert type" dialogs. 

Edit WPF control
You open the "Object properties" dialog in the context menu of the WPF control with 
"Properties". You can define the specific attributes of the selected controls in the "Control 
properties" properties group. 

How to Insert a 3D Bar

Introduction
The 3D bar graph enables values to be displayed graphically three-dimensionally. The size 
and properties which a 3D bar has in Runtime are defined in the Graphics Designer.

The 3D bar is only available if the "Basic Process Control" optional package was installed with 
WinCC.
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Inserting 3D Bar
1. Open the picture in which you want to insert a 3D bar.

2. In the Object Palette, click the smart object "3D Bar".

3. Place the mouse pointer at the position in the picture where you want to insert a 3D 
bar.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the 3D bar to the size and direction you 
want.         
When you release the mouse button, the circular arc insertion is finished.

Alternatively you can double-click the smart object "3D Bar" in the object palette. A 3D bar with 
default object properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the picture window, the "3D bar" object is 
created in the shape of a square.
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Changing 3D Bar
Select an object of the 3D bar type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the color palette to change the background color.         
Use elements of the Style Palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Note

The 3D bar is always surrounded by a rectangular frame. Do not use a black background. 
The arrows indicating that an area has been exceeded are not visible at this time.

Configuring limits of the 3D bar
For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

See also
"Limits" Property Group (Page 458)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)
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How to Insert a Group Display

Introduction     
The group display enables the current states of certain message types to be displayed by 
hierarchy. Up to eight buttons permit display and operation of messages. Using a group display, 
it is possible for example to implement a quick change to represent an error source. The size 
and properties which a group display accepts in Runtime are defined in the Graphics Designer.

The group display is only available if the "Basic Process Control" optional package was 
installed with WinCC.

Inserting group display
1. Open the picture in which you want to insert a group display.

2. In the object palette, click the smart object "Group display".

3. Place the mouse pointer at the position in the picture where you want to insert the group 
display.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the group display to the size and direction you 
want.         
When you release the mouse button, the circular arc insertion is finished.

Alternatively you can double-click the smart object "Group display" in the object palette. A 
group display with default object properties is then inserted near the picture origin.          
If you hold down the <SHIFT> key while drawing, the "Group display" object is created in the 
shape of a square.
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Changing group display
Select an object of the group display type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the color palette to change the background color.         
Use elements of the Style Palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Note

You cannot use group display objects in a group because of ORing UP.

Default settings of group display
If you insert a picture into the group display, the group display will have five buttons. 11 
message types and their respective colors and texts are assigned to those five buttons. You 
may change the assignment and may configure three additional buttons. The default settings 
of graphics objects are changed by using the property dialog (right mouse button) of the default 
object selected in the object palette.

Dynamizing the group display
The group display object is triggered by a tag which represents the message status. You can 
use this tag to display the group display states in the other WinCC components . Other types 
of dynamization are not possible.

Connect a group display with a PCS 7 measuring point
To configure the link to the tag, use the Dynamic Wizard "Link Group Display with PCS 7 
Measuring Point". Start the wizard and define the required settings. The group display "Group 
value" attribute is linked to the "EventState" structure tag of the PCS 7 measuring point 
concerned.

The individual bits of this tag are interpreted in PCS 7 as follows:
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Status information of PCS 7 tag "EventState":

Bit in double word Message class Message type

Bit 31 (MS bit) Alarm AH
Bit 30 Alarm AL
Bit 29 Warning WH
Bit 28 Warning WL
Bit 27 Tolerance TH
Bit 26 Tolerance TL
Bit 25 AS Process control message Fault
Bit 24 AS Process control message Error
Bit 23 Maintenance request Maintenance request
Bit 22 Process message PM
Bit 21 Not assigned Not assigned
Bit 20 Operator request OR
Bit 19 Operator input message OM
Bit 18 Status message Automation system (AS) 

status
Bit 17 Status message Status OS
Bit 16 Measuring point locked X

Acknowledgment information of PCS 7 tag "EventState":

Bit in double word Message class Message type

Bit 15 Alarm AH acknowledged
Bit 14 Alarm AL acknowledged
Bit 13 Warning WH acknowledged
Bit 12 Warning WL acknowledged
Bit 11 Tolerance does not require acknowledgment for 

PCS 7 *
TH acknowledged *

Bit 10 Tolerance does not require acknowledgment for 
PCS 7 *

TL acknowledged *

Bit 9 AS Process control message Fault acknowledged
Bit 8 AS Process control message Fault acknowledged
Bit 7 Maintenance request MR acknowledged
Bit 6 Process message PM acknowledged
Bit 5 Not assigned Not assigned
Bit 4 Operator request acknowledgment not required for 

PCS 7
-

Bit 3 Operator input message acknowledgment not 
required for PCS 7

-

Bit 2 Status message acknowledgment not required for 
PCS 7

-
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Bit in double word Message class Message type

Bit 1 Status message acknowledgment not required for 
PCS 7

-

Bit 0 (LS-bit) Measuring point block acknowledgment not required 
for PCS 7

-

* With new projects as of WinCC V7.01, you can configure messages of the "Tolerance" 
message class as mandatory acknowledgement messages. The option is selected in the OS 
Project Editor.

You may assign any of the 16 message types to any bit and thereby change the default settings. 
Configuration is performed in the "Message type" property in "Message Types" property group. 

Connecting a group display with a custom tag
Independent of PCS 7, you may connect a group display with a tag. In this tag you will assign 
individual bits on a need basis.

1. Open the group display shortcut menu and select "Properties".

2. Select "Miscellaneous" in the "Properties" tab.

3. Open the shortcut menu in the "Group value" line, "Dynamic" column and select "Tag...". 
The tag must be a signed 32-bit variable.

4. Select one of the tags from the process layer or from the internal tags in the "Select tag" 
window.

5. Activate the "Upon Change" update cycle in the "Current" column.

If an internal tag is used, it should have the start value 65535 (0x0000FFFF). In this manner, 
you can ensure that at the start - from the view of the group display - there are no 
unacknowledged messages.

For individually configured group displays, the supplied PCS7 settings for acknowledgment 
sample of "17" or "3089" is most likely not suitable for your project and must be adjusted.

You can thus influence the quitting pattern via the ""@EventQuit" tag. 

Configuring Message Types
The "Message Types" property group contains attributes with which you can set the display 
of messages depending on the 16 message types. For example, each message type may be 
visualized by an appropriate label and by color changes of the button.

Assigning message types to buttons
In the "Assignment" object property of the group display you assign message types to the 
buttons. Enter the respective bit numbers in the group value. 

The buttons may have multiple assignments

● with bit numbers corresponding to message classes. These are separated by "/".

● with bit numbers corresponding to message types. These are separated by ",".
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The sequence of entries determines their priority. The earliest entry is displayed with the 
highest priority in case of concurrent events.

 

Lock display
The "Lock" property group contains attributes with which you can change the view of locked 
measuring points. The "Lock display" attribute specifies for a group display, whether or not a 
locked measuring point should be displayed. The lock applies to all buttons of the group display, 
independent of which other events in the hierarchy are pending.

In the default settings for the group display, the fifth button is reserved for display of status 
"Measuring point locked" by using "Group value bit 16". This allows to display not only pending 
events in the hierarchy but also those locked in subordinate measuring points.

See also
"Message Types" Property Group (Page 461)

"Lock" Property Group (Page 463)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Smart Objects (Page 509)

Influencing the quitting pattern using EventQuit tag
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3.8.6.4 Working with Windows Objects

Working with Windows Objects

Introduction
The Windows objects are elements familiar from Windows applications: button, check box, 
radio box and slider. A round button can also be designed. The objects can be modified and 
made dynamic in many ways. They enable you to operate process events and to control 
processes.

In the Graphics Designer, the various object types have default properties. When they are 
inserted the objects import these default properties (except for individual geometric properties). 
After insertion the properties of an object can be modified. In the same way the default settings 
for the object types can be modified as required.

Overview

Icon Object Description

Button The button enables process operation. It is used for example to 
acknowlege messages. A button can have one of two statuses: "On" 
and "Off". A button is integrated into the process by providing the 
corresponding attributes with dynamics.

Check box The check box enables the operator to select several options and to 
check the corresponding check boxes. It is also possible to check check 
boxes by default so that the operator only changes the predefined value 
as required. A check box is integrated into the process by providing the 
corresponding attributes with dynamics.

Radio box The option box enables the operator to selected one of the presented 
options and to activate the corresponding options field. It is also 
possible to activate one of the options fields by default so that the 
operator only changes the predefined value as required. An option box 
is integrated into the process by providing the corresponding attributes 
with dynamics.
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Icon Object Description

Round 
Button

The round button enables process operation. It is used for example to 
acknowlege messages or to navigate in Runtime. A round button can 
have one of three statuses: "On", "Off" and "Deactivated". It is also 
possible to define whether a round button should by default be 
displayed as pressed and whether it should latch down when pressed. 
A round button is integrated into the process by making the 
corresponding attributes dynamic

Slider The slider is a slide controller and can be used to control processes. 
For example, it can be used for infinitely variable changes to a value. 
A slider is integrated into the process by providing the corresponding 
attributes with dynamics.

See also
How to insert a button (Page 585)

How to insert a check box (Page 589)

How to insert an radio box (Page 592)

How to insert a round button (Page 594)

How to insert a slider (Page 597)

How to change the default setting of object types (Page 379)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Object Palette (Page 238)

The Coordinate System of a Process Picture (Page 228)

The Coordinate System of an Object (Page 230)

The Rectangle Surrounding the Object (Page 232)

Working with Objects in the Object Palette (Page 473)

Working with Combined Objects (Page 613)

Working with Objects (Page 378)

Process Picture Dynamics (Page 815)
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Button

How to insert a button

Introduction
The button enables process operation. A button is used for such actions as acknowledging 
messages or for navigation in Runtime. A button can have one of two statuses: "On" and "Off". 
A button is integrated into the process by providing the corresponding attributes with dynamics.

Inserting a button
1. Open the picture in which you want to insert a button.

2. In the Object Palette, click the Windows object "Button".

3. Place the mouse pointer at the position in the picture where you want to insert a 
button.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the button to the desired size with the mouse button pressed.         
The "Button Configuration" dialog is opened.

5. Enter the desired values into the fields of the configuration dialog.         
You will find the description of the configuration dialog in the next section.

6. Confirm the input with "OK".          
The insertion process for the "Button" object is finished.

Alternatively you can double-click the Windows object "Button" in the object palette. A button 
with default object properties is then inserted near the picture origin. The "Button Configuration" 
dialog opens. As soon as you have confirmed your entries with "OK", the insertion process is 
completed.         
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If you press and hold down <SHIFT> during the insertion, the object "Button" will assume the 
shape of a square.

Changing a button
Select an object of the button type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the element "Rotate" in the standard toolbar to rotate the object.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

See also
How to configure a button (Page 586)

How to configure a hotkey for navigation in Runtime (Page 588)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Windows Objects (Page 583)

How to configure a button

Introduction
The "Button Configuration" dialog opens at the end of the insertion process if the use of 
configuration dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables 
fast configuration of the important features of the button. 

The configuration dialog can also be opened with the object's pop-up menu. Specific attributes 
can be changed in the "Object Properties" window.
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Text
The button can display a text that describes its function.         
Enter the desired text. Only one text line is available in the configuration dialog. Multiline text 
can be input by changing the "Text" attribute in the "Object Properties" window. You can find 
the detailed description in the "Changing field labels with the "Text" attribute" section.

Font
The font for displaying the text can be changed.         
Click one of the three possible buttons to open the associated dialogs. You can find the detailed 
description of the dialogs in the sections "Changing the Font" and "Changing Font Color".

Operation
An authorization can be assigned for operation of the button. A hotkey can be defined for the 
button, which allows the control with a key or key combination.         
Click one of the two offered buttons to open the respective dialogs. You can find the detailed 
description of the dialogs in the "Set hotkey for navigation in Runtime" section.

Change Picture on Mouse Click
An event can be assigned for the selected button with this function. If the button is clicked with 
the mouse, the display of the process picture specified here is opened.
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Enter the name of the picture to be displayed or click the , to open the dialog "Pictures" to 
select a picture. The "Pictures" Dialog shows all pictures in the PDL format in the graphics 
directory "GraCS" of the current WinCC project.         
    There is an extensive description of this topic in the chapter "Making Process Pictures 
Dynamic".

Note

You must not use the "Change Picture on Mouse Click" function in the Basic Process Control 
area. Use the SSMChangeWorkField function for opening a picture in the working area. Use 
the SSMOpenTopField function to open an additional picture window.

See also
Selecting a tag (Page 608)

How to configure a hotkey for navigation in Runtime (Page 588)

How to insert a button (Page 585)

Quick Object Configuration (Page 606)

How to configure a hotkey for navigation in Runtime

Introduction
The "Button" object is used to open a configured event. For example, objects of the button 
type can be placed between multiple pictures. 

The configured change to another process picture is made as soon as the button is clicked 
with the mouse in Runtime. This event can also be triggered by a keyboard operation if a 
specific key or key combination was configured for the button with the "Hotkey" attribute. An 
authorization can also be assigned for operation of the button.

Configuring change picture
The change picture is configured with a constant for the mouse-click event as direct connection. 
If the button is clicked with the mouse, the display of the process picture specified here is 
opened.

The name of the picture that you want to display can be configured in the "Insert Button" dialog. 
Alternatively you can also change the configured direct connection in the "Events" tab of the 
"Object Properties" window. You can find the detailed description in "Making Process Pictures 
Dynamic".

Setting hotkeys
As an alternative to operation with the mouse, a button can also be triggered using the 
keyboard. To do so, a hotkey must be set.
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Double-click the "Hotkey" attribute in the "Miscellaneous" property group of the "Object 
Properties" window. Select one of the function keys with the mouse or enter a key or key 
combination. If a hotkey has been defined for a button, an arrow is displayed in the object 
properties beside the "Hotkey" attribute.

Note

If a group is to be operated with a hotkey, the hotkey must only be assigned to the single 
"Button" object in the group. A hotkey assigned to the entire group will not work in Runtime.

Setting authorizations
The User Administrator editor is used in WinCC to assign authorizations for the users. An 
authorization can be assigned for every object in the Graphics Designer. Only the user with 
the appropriate authorization can operate this object. 

Double-click the "Authorization" attribute in the "Miscellaneous" property group of the "Object 
Properties" window. Select one of the available authorizations.

Note

To operate the button in Runtime, the "Operator-Control Enable" and "Display" attributes 
must have the value "Yes". The value of the "Authorization" attribute must contain the access 
authorization of the current user.

See also
How to configure a button (Page 586)

How to insert a button (Page 585)

How to insert a check box

Introduction
The check box enables the operator to select several options and to check the corresponding 
check boxes. Check boxes can be activated by default so the user changes the default values 
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only as required. A check box is integrated into the process by providing the corresponding 
attributes with dynamics.

Inserting a check box
1. Open the picture in which you want to insert a check box.

2. In the Object Palette, click the Windows object "Check box".

3. Place the mouse pointer at the position in the picture where you want to insert the check 
box.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the check box to the size and direction you 
want.         
When you release the mouse button, the check box insertion is finished.

Alternatively you can double-click the Windows object "Check box" in the object palette. A 
check box with default object properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the picture window, the "Check box" object 
is created in the shape of a square.

Changing a check box
Select an object of the check box type if you wish to carry out one of the following changes:
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Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object or to change the 
appearance of the text.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Setting the number of boxes
The "Number of Boxes" specifies the total number of boxes for the selected object. For each 
object, a maximum number of 32 boxes can be set.

At the same time, the value of the "Number of Boxes" attribute specifies the upper limit value 
for the "Index" attribute in the "Font" property group. Changing the value can have the following 
effects:

Increasing the number
New fields are inserted under the field with the highest value in the "Index" attribute. The 
standard labeling of the new box can be changed using the "Text" attribute in the "Font" 
property group.

Reducing the number
All boxes with the value of the "Index" attribute higher than the new number are deleted.

Setting selected boxes
The "Selected Boxes" attribute sets which fields in a check box are to be shown as enabled. 
Multiple boxes can be enabled simultaneously.

Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding 
bit must have the value "1". The 32-bit word contains the information for all fields of the check 
box. The value of the "Selected Boxes" attribute is specified in hexadecimals.
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See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Windows Objects (Page 583)

How to insert an radio box

Introduction
The option box enables the operator to selected one of the presented options and to activate 
the corresponding options field. One of the option groups can be activated by default so the 
user changes the default values only as required. An option box is integrated into the process 
by providing the corresponding attributes with dynamics.

Inserting Radio box
1. Open the picture in which you want to insert an option group.

2. In the Object Palette, click the Windows object "Option Group".
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3. Place the mouse pointer at the position in the picture where you want to insert the radio 
box.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the radio box to the size and direction you 
want.         
When you release the mouse button, the circular arc insertion is finished.

Alternatively you can double-click the Windows object "Option Group" in the object palette. A 
radio box with default object properties is then inserted near the picture origin.         
If you hold down the <SHIFT> key when drawing the picture window, the "Radio box" object 
is created in the shape of a square.

Changing radio box
Select an object of the option group type if you wish to carry out one of the following changes:

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the elements in the standard toolbar to mirror or rotate the object or to change the 
appearance of the text.         
Use the color palette to change the background color.         
Use the elements in the style palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

Setting the number of boxes
The "Number of Boxes" specifies the total number of boxes for the selected object. For each 
object, a maximum number of 32 boxes can be set.

At the same time, the value of the "Number of Boxes" attribute specifies the upper limit value 
for the "Index" attribute in the "Font" property group. Changing the value can have the following 
effects:

Increasing the number
New fields are inserted under the field with the highest value in the "Index" attribute. The 
standard labeling of the new box can be changed using the "Text" attribute in the "Font" 
property group.
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Reducing the number
All boxes with the value of the "Index" attribute higher than the new number are deleted.

Setting selected boxes
The "Selected Box" attribute sets which option field in an option group is displayed as activated. 
Only one of the boxes can be enabled.

Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding 
bit must have the value "1". The 32-bit word contains the information for all fields of the check 
box. The value of the "Selected Box" attribute is specified in hexadecimals.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Windows Objects (Page 583)

How to insert a round button

Introduction
The round button enables process operation. For example, it is used to acknowlege messages. 
A round button can have one of three statuses: "On", "Off" and "Deactivated". It is also possible 
to define whether a round button should by default be displayed as pressed and whether it 
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should latch down when pressed. A round button is integrated into the process by making the 
corresponding attributes dynamic

Inserting a round button
1. Open the picture in which you want to insert a round button.

2. In the Object Palette, click the Windows object "Round Button".

3. Place the mouse pointer at the position in the picture where you want to insert a round 
button.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the round button to the size and direction you 
want.         
When you release the mouse button, the circular arc insertion is finished.

Alternatively you can double-click the Windows object "Round Button" in the object palette. A 
round button with default object properties is then inserted near the picture origin.

Changing a round button
Select an object of the round button type if you wish to carry out one of the following changes:
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Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use the color palette to change the background color.         
Use elements of the Style Palette to change the display style for the object.

Attributes
Open the "Object Properties" window to change the current values of the desired attributes.

See also
Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Windows Objects (Page 583)
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Slider

How to insert a slider

Introduction
The slider is a slide controller and can be used to control processes. For example, it can be 
used for infinitely variable changes to a value. A slider is integrated into the process by 
providing the corresponding attributes with dynamics.

Inserting a slider
1. Open the picture in which you want to insert a slider.

2. In the Object Palette, click the Windows object "Slider".

3. Place the mouse pointer at the position in the picture where you want to insert a 
slider.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the slider to the desired size with the mouse button pressed.         
The "Slider Configuration" dialog is opened. 
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5. Enter the desired values into the fields of the configuration dialog.         
You will find the description of the configuration dialog in the next section.

6. Confirm the input with "OK".          
The insertion process for the "Slider" object is finished.

Alternatively you can double-click the Windows object "Slider" in the object palette. A slider 
with default object properties is then inserted near the picture origin. The "Slider Configuration" 
dialog opens. As soon as you have confirmed your entries with "OK", the insertion process is 
completed.         
If you press and hold down <SHIFT> during the insertion, the object "Slider" will assume the 
shape of a square.

Changing a slider
Select an object of the slider type if you wish to carry out one of the following changes:

Rectangle surrounding the object

Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the picture.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars

Use the element "Rotate" in the standard toolbar to rotate the object.         
Use the color palette to change the background color of the border.         
Use the elements in the style palette to change the display style for the object.

Attributes

Open the "Object Properties" window to change the current values of the desired attributes.

See also
How to configure a slider (Page 598)

How to configure the value range and operation of a slider (Page 600)

Basic Static Operations (Page 380)

Basic Dynamic Operations (Page 407)

The Properties of an Object (Page 423)

Working with Windows Objects (Page 583)

How to configure a slider

Introduction
The "Slider Configuration" dialog opens after the insertion process if the use of configuration 
dialogs is enabled in the "Options" tab of the "Tools / Settings..." menu. It enables fast 
configuration of the important features of the slider.
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The configuration dialog can also be opened with the object's pop-up menu. Specific attributes 
can be changed in the "Object Properties" window.

Tag
The slider can made dynamic by embedding a tag.

Enter the name of the desired tag or click the , to open the dialog "Tags - project: ..." to 
select a tag. See the "Select Tag" section for the detailed description.

Updating
The frequency of updating the display can be configured for the value displayed by the 
slider.         
    Enter the desired interval or select an interval from the dropdown list. See the "Changing 
update cycle" section for the detailed description.

Limits
The two holders of the slider are specified by the maximum value and the minimum value of 
the slider. Setting operation steps specifies the number of increments by which the slider is 
moved when the mouse is clicked on the slider.         
Enter the desired limits and the number of operation steps for displaying the slider.

Alignment
Specifies whether the slider is moved horizontally or vertically.
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See also
Selecting a tag (Page 608)

How to configure the value range and operation of a slider (Page 600)

How to insert a slider (Page 597)

Quick Object Configuration (Page 606)

How to configure the value range and operation of a slider

Introduction
The value range of the required operation steps and the appearance of the "Slider" object can 
be configured as required by changing the relevant attributes.

Setting scale end values and zero point value
The attribute "Maximum value" defines the absolute value for the display of the highest 
value.         
The attribute "Minimum value" defines the absolute value for the display of the smallest 
value.         
The attribute "Zero point value" defines the absolute value for the zero value of the bar.

Operation Steps
The "Operation Steps" attribute specifies for the slider the number of steps the slider is moved 
in the corresponding direction with one mouse-click the slide surface.

The number of times to click the slider surface for the slider to move from one end to the other 
is calculated as follows:          
("Maximum value" – "Minimum value") / "Operation steps". 

Example:
Where maximum value = 100, minimum value = 0, operation steps = 25 the slider surface must 
be clicked four times to move the slider from one end to the other.

Alignment
The "Alignment" attribute defines for the "Slider" object whether the movement of the slider is 
in a horizontal or vertical direction.

Windows Style
The "Windows Style" attribute specifies whether the style for displaying the objects in the 
Graphics Designer is set or the operating system defaults are used.
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See also
How to insert a slider (Page 597)

How to configure a slider (Page 598)

3.8.6.5 Working with Tube Objects

Working with tube objects

Introduction
With WinCC you can recreate in your process pictures systems of interconnected tubes, tanks 
and other objects. 

To do this, select suitable objects from the library and connect them with each other using the 
tube objects. Due to the provided fill pattern, the tubes appear three-dimensionally and thus 
allow the creation of intuitively well ascertainable pictures. 

Tube objects
WinCC provides the following tube objects: 

Tube objects  Function

Polygon Tube Tube made of a polyline 

T-piece T-shaped branch in four possible orientations

Double T-piece Cross-shaped connector 

Tube Bend Cross- or elliptical-shaped bend of any radian 

You create your system from these tube objects and the objects in the object library, e.g. tanks 
and valves. 
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See also
How to insert a polygone tube (Page 602)

How to insert a T-piece (Page 603)

How to insert a double T-piece (Page 604)

How to insert a tube bend (Page 605)

How to insert a polygone tube

Introduction
WinCC has tube objects for simulating pipe systems. Using the polygon tube, you create pipes 
with as many bends as is required. You can round off the corner points or display them as 
angled corners. 

The polygon tube is an open polygon: Even if you select the same start and end point, the 
ends will not be connected with one another. 

A polygon tube can have any number of corners. The corner points are numbered in the order 
of their creation. You can move them individually. 

Procedure
1. Open the picture in which you want to insert a polygon tube.

2. In the object palette, click the tube object "Polygon tube".

3. Place the mouse pointer at the position in the picture where you want to begin the polygon 
tube.
The mouse pointer changes into a cross with arrows pointing inward.

4. Click the selected starting point with the left mouse button.

5. Click every other desired corner of the polygon tube with the left mouse button.
Click with the right mouse button to correct the last drawn section of the polygon tube. 
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6. In order to complete the polygon tube, double click on the desired end point. 

7. In order to move an individual corner point at a later point in time, drag the small square 
next to the end point to the desired point. 

Properties
Use the "Line connection type" attribute under "Styles" to set the type of corner display: 

● Square: No rounding on the corner points

● Round: Arc-formed corner rounding

Use the "Line weight" attribute under "Styles" to set the width of tube display. 

How to insert a T-piece

Introduction
WinCC contains tube objects to recreated pipe systems. You can create a T-shaped tube 
connection with the T-piece. 

You can give the T-piece any of four possible orientations. 

Procedure
1. Open the picture into which you want to insert a T-piece.

2. Click on the tube object "T-piece" in the object palette.
The mouse pointer will change to a hollow T. 

3. Position the mouse point at the position in the picture where you want to insert the T-piece 
and click on the desired position.
The T-piece is inserted. You can change the position and size using the mouse. 
Change the orientation using the properties of the T-piece. 
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Properties
Set the width of the tube using the "Line Weight" and "Styles" attribute. 

Set the orientation of the T-piece in degrees using the "Rotation Angle" attribute. This 
determines whether the "leg" of the "T" points downwards (0), to the left (90), upwards (180) 
or to the right (270). The entered value is automatically rounded to a multiple of 90. 

Note

If you have grouped the "T piece" tube object and then dissolve the group, the tube object 
loses the rotation position and jumps backs to the original location.

How to insert a double T-piece

Introduction
WinCC has tube objects for simulating pipe systems. Use the double T-piece to construct a 
tube-crossing. 

Procedure
1. Open the picture in which you want to insert a double T-piece.

2. In the object palette, click the tube object "Double T-piece".
The mouse pointer will change to a hollow cross. 

3. Position the mouse pointer on the place in the picture that you want to put the double T-
piece and click on the desired point.
The double T-piece is inserted. You can adapt it in position and size. 
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Features
Use the "Line weight" attribute under "Styles" to set the width of tube display. 

How to insert a tube bend

Introduction
WinCC has tube objects for simulating pipe systems. Use the tube bend to create a bend in a 
piece of pipe. 

You can set the size, shape - circular or elliptical arc - and bend dimensions of the tube bend 
to your requirements. 

Procedure
1. Open the picture in which you want to insert a tube bend.

2. In the object palette, click the tube object "Tube bend".

3. Place the mouse pointer at the position in the picture where you want to insert the tube 
bend. 
The mouse pointer will change to a hollow quarter-ellipse.

4. Click on the selected position.
The tube bend is inserted with certain start parameters: As a circular arc with equal width 
and height in the first quadrant with a circular dimension 90° = ½ π. 

5. Adapt the tube bend in position, size and shape.
If the width and height are not equal, the circular arc becomes an elliptical arc. 

6. To change the orientation of the quarter-arc, mirror or turn it.

7. To move the start or end point at a later point in time, drag the small square next to the 
affected point in the desired direction. 
This changes the circular dimensions of the tube bend. 
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Features

Geometry of the tube bend
Define the size and shape of the tube bend with the attributes under "Geometry". The "Start 
angle" and "End angle" attributes determine the circular dimensions. 

The attributes are independent from one another. 

● If you change the "Width" and "Height", the "RadiusX" and "RadiusY" change with them 
automatically. Start and end angle remain. 

● If the start and end angle change, the "Width" and "Height" change with them automatically. 
RadiusX and RadiusY remain. 

● If you change "RadiusX" and "RadiusY", the "Width" and "Height" change with them 
automatically. Start and end angle remain. 

Tube width
Use the "Line weight" attribute under "Styles" to set the width of tube display. 

3.8.6.6 Quick Object Configuration

Quick Object Configuration

Introduction
The Graphics Designer has configuration dialogs for quick configuration of individual objects. 
the important features of an object can be set in the configuration dialogs. 

If the use of configuration dialogs is activated in the "Options" tab of the "Tools / Settings..." 
menu, the associated dialog is opened when an object is inserted.          
    The configuration dialog can also be opened with the object's pop-up menu.

Configuration dialogs are available for the following objects: I/O Field, Bars, Graphic Object, 
Status Display, Text List, Button and Slider. The contents of the configuration dialogs are 
different for different objects.

Short description of the configurable features

Features Description Object type

Updating Specifies the frequency with which the display of the displayed value 
is updated. Enter the desired interval or select an interval from the 
dropdown list.

I/O field, bar, 
status display, 
text list, slider

Alignment Specifies whether the slider is moved horizontally or vertically. Slider
Bar direction Specifies the direction of the coordinate axis to which the maximum 

value of bar points.
Bar
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Features Description Object type

Operation An authorization can be assigned for operation of the button. A hotkey 
can also be defined, which allows operation with a key or key 
combination.         
You can find the detailed description in the "Button" chapter.

Button

Bit Position A state can also be assigned to a certain bit position on the tag.         
Click the arrow key to select a bit position.

Status display

Picture 
Selection 
with Preview

The picture selection shows all pictures in the graphics directory 
"GraCS" of the current WinCC project. The picture selected in the 
picture selection is displayed as a preview. Select a picture or click the 
"Browse ..." button to insert additional pictures from the picture 
selection.          
See the "Select Pictures" section for the detailed description.

Graphic 
object, Status 
Display

Change 
Picture on 
Mouse Click

An event can be assigned for the selected button with this function. If 
the button is clicked with the mouse, the display of the process picture 
specified here is opened.         
See the "Select Pictures" section for the detailed description.

Button

Field type Specify whether the selected object is used for input, output or input 
and output of values.

I/O field, Text 
List

Limits Enter values as "Max. value" and "Min. value" to define the two ends 
of the slider. You can also define the number of operation steps for the 
slider. The number of operation steps specifies the number of 
increments by which the slider is moved when the mouse is clicked on 
the slider.

Bar, Slider

Font Change font options for viewing button labels and display values. Click 
one of the buttons to open the associated dialog.

I/O field, Text 
List, button

Text Enter a text as a button label, which for example describes its 
function.         
Only one text line is available in the configuration dialog. Multiline text 
can be input by changing the "Text" attribute in the "Object Properties" 
window.

Button

Tag The selected object can be set dynamically by embedding a tag. With 
an I/O field and text list the value of the tags can be displayed as output 
or changed by an input depending on the selected field type.         
See the "Select Tags" section for the detailed description.

I/O field, bar, 
status display, 
text list, slider

Status list The status list shows the linked pictures and the specified flash 
frequency for all configured states. States can be inserted and every 
setting can be changed with a pop-up menu. Pictures of the picture 
selection can be referenced by dragging them with the mouse to the 
required position in the state list.          
You can find the detailed description in "Status Display".

Status display
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See also
Working with Objects in the Object Palette (Page 473)

How to configure a slider (Page 598)

How to configure a button (Page 586)

How to configure a text list (Page 559)

How to configure a status display (Page 553)

How to insert a graphic object (Page 547)

How to configure a bar (Page 541)

How to configure an I/O Field (Page 530)

Selecting pictures (Page 610)

How to configure states (Page 554)

Selecting a tag (Page 608)

Selecting a tag

Introduction
Tags are a central element in the dynamics of process pictures created with the aid of the 
Graphics Designer. By linking a process tag to an object, such things as the change in a 
measured value can be represented graphically. More details about the use of tags can be 
found in the chapter called "Tag Management".

The dialog "Tags – project: ..." contains all tags available in the project. This dialog can look 
as follows:
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● The width of both window areas and the columns in the tag display can be changed by 
moving the vertical separation lines.

Filter
If there is a large number of configured tags, the search procedure can take some time. For 
instance, for 15,000 tags the search procedure takes about a minute.

By specifying a filter, you can narrow the scope of the search and reduce the duration of the 
search procedure. You can achieve a significant increase in efficiency if you configure tags 
with the aid of a tag prefix.

Data source
You can use the "Data Source" window to select the tags it is intended to display.

Tag groups
The selected tag group complete with its sub-folders is displayed in the left-hand area in the 
form of a folder tree.         
Directories and subdirectories can be opened or closed by clicking on the "+" or "-" icons. The 
tags available for the selected entry are shown in the tag display.

Tag display
The right-hand area contains all the tags that are available for the entry The tag display is 
divided into four columns showing the tag name, type and parameter, and the point in time at 
which the tag was last changed. Tags can be sorted by clicking on the respective column 
heading.

Procedure
1. Select the required filter. An asterisk means that no filter is to be used or no filter has been 

defined.

2. Select one or more data sources.

3. Open the desired tag group in the left-hand window area.

4. Select the desired tag from the right-hand window area.

5. Confirm you selection with "OK".         
The dialog "Tags - project: ..." will be closed.         
The selected tag is assigned to the selected object and you can continue with the 
configuration.

See also
Quick Object Configuration (Page 606)

Working with Windows Objects (Page 583)

Working with Smart Objects (Page 509)
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Selecting pictures

Introduction
Pictures can be linked to many objects in the Graphics Designer.         
Depending on the object, the linked pictures can be in various file formats:

Object Formats How pictures are linked

Picture Window PDL Open the "Picture Name" selection dialog via the "Object 
Properties" window, "Picture Name" attribute, in the 
"Miscellaneous" property group

Graphic Object BMP, DIB, 
ICO, CUR, 
EMF, WMF, 
GIF, JPG

Open the "Picture" selection dialog via the "Object Properties" 
window, "Picture" attribute,         
or         
The configuration dialog can also be opened with the object's pop-
up menu

Status display BMP, DIB, 
EMF, WMF

Open the "Picture" selection dialog via the "Object Properties" 
window, "Basic Picture" and "Flash Picture" in the property group 
"Status",         
or         
The configuration dialog can also be opened with the object's pop-
up menu; it has a picture selection with picture preview

Button BMP, DIB, 
ICO, CUR, 
EMF, WMF, 
GIF, JPG

Open the "Picture" selection dialog via the "Object Properties" 
window, "Picture Status On" and "Picture Status Off" attributes, in 
the "Miscellaneous" property group

Round Button BMP, DIB, 
ICO, CUR, 
EMF, WMF, 
GIF, JPG

Open the "Picture" selection dialog via the "Object Properties" 
window, "Picture Status On", "Picture Status Off" and "Picture 
Status Deactivated" attributes, in the "Pictures" property group

The "Picture Name" selection dialog

The "Picture Name" selection dialog displays all the PDL files in the current project. Any file 
that you wish to link to the picture window must belong to the current WinCC project.
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The "Picture" selection dialog

The "Picture" selection dialog lists the pictures that are available in the project. These pictures 
are held in the "GraCS" graphic folder belonging to the current WinCC project. To add further 
pictures to the current project, you can use the "Browse ..." button to open another selection 
dialog.

Configuration Dialog
The appearance of a configuration dialog depends on the selected object. For instance it may 
look like this for a graphic object:

The picture selection lists the pictures that are available in the project. These pictures are held 
in the "GraCS" graphic folder belonging to the current WinCC project. To add further pictures 
to the current project, you can use the "Browse ..." button to open another selection dialog.
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Find Picture
This dialog can be used to switch to any folder in order to select one or more pictures and add 
them to the current project. These are then displayed in the selection of pictures in the selection 
dialog.

Note

Referenced graphic files must be copied to the "GraCS" graphic folder for the current WinCC 
project in order to be available on a destination computer. If you use the Browse ..." button 
in the picture selection, the selected graphic files are automatically copied to the "GraCS" 
graphic folder.

To select a series of pictures:         
Hold down the <SHIFT> key and click the first and the last picture.         
To select individual pictures:         
Hold down the <CTRL> key and click the individual pictures.

See also
Quick Object Configuration (Page 606)

Working with Windows Objects (Page 583)

Working with Smart Objects (Page 509)
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3.8.7 Working with Combined Objects

3.8.7.1 Working with Combined Objects

Introduction
The objects of the Object Palette can be combined by forming a group or a customized object 
from a multiple selection. In addition, a group or a combined object can be inserted into the 
project library. This makes the group or the combined object available as a library object for 
re-use in other process pictures or projects.

Overview

Object Description

Group A multiple selection of objects can be combined into a group. A group of objects 
can be edited like a single object in the Graphics Designer. In addition, it is possible 
to edit the objects in the group individually.         
         
Unlike multiple selection, the selection marks of the individual objects in a group 
are not shown. The selection marks cover the entire group. The selection frame 
of the multiple selection becomes the rectangle around all the objects of the group.

Customized 
Object

A customized object allows the properties and events that are displayed and 
changed in the "Object Properties" window to be configured individually. A 
customized object can be edited in the Graphics Designer like a single object of 
the object palette.          
         
As in a group the selection marks of the individual objects are no longer shown 
after creation of a customized object. The selection marks surround the entire 
customized object. The selection frame of the multiple selection becomes the 
rectangle around all the objects of the customized object.

Library object The library of the Graphics Designer is versatile tool for saving and managing 
graphic objects that can be used for creating process pictures. It is divided into 
two areas:         
         
The "Global Library" offers a variety of prefinished graphic objects that are inserted 
into a picture as library objects and can be configured as required.          
         
The "Project Library" enables a project-specific library to be built.

See also
Working with the library (Page 646)

Working with Customized Objects (Page 618)

Working with Groups (Page 614)

Multiple Selection of Objects (Page 386)

Working with Objects in the Object Palette (Page 473)

Working with Objects (Page 378)
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3.8.7.2 Working with Groups

Working with Groups

Introduction
A multiple selection of objects can be combined into a group. A group of objects can be edited 
like a single object in the Graphics Designer. It is also possible to edit objects in the group 
individually.

Unlike multiple selection, the selection marks of the individual objects in a group are not shown. 
The selection marks cover the entire group. The selection frame of the multiple selection 
becomes the rectangle around all the objects of the group.

See also
Working with Combined Objects (Page 613)

Working with Objects (Page 378)

Multiple Selection of Objects (Page 386)

How to ungroup a group (Page 617)

How to change the properties of a group (Page 616)

How to change the objects of a group (Page 615)

How to group objects (Page 614)

How to group objects

Introduction
The objects of a multiple selection can be combined into a group with the "Group" command. 

Requirements
● Select at least two objects of any type, except for control and OLE objects.

Procedure
1. Open the pop-up menu of the multiple selection or the "Edit" menu.

2. Select the entry "Group / Grouping".         
The selected objects are combined into a group. The selection frame of the multiple 
selection becomes the rectangle around the group. Selection marks are shown for the group 
only.
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Note

Single groups can be combined into larger groups with the "Group" command. This allows a 
group hierarchy to be built up. Groups can be ungrouped in the reverse order of grouping.

See also
Working with Objects (Page 378)

The Rectangle Surrounding the Object (Page 232)

Multiple Selection of Objects (Page 386)

Working with Groups (Page 614)

How to ungroup a group (Page 617)

How to change the properties of a group (Page 616)

How to change the objects of a group (Page 615)

How to change the objects of a group

Introduction
The objects included in a group can be edited individually by changing their attributes. The 
objects are displayed in the "Object Properties" window with their property groups as a 
component of the "Group" object type.

Requirements
● Select a group.

Procedure
1. Open the "Object Properties" window.

2. Select the property group of the desired individual object in the "Properties" tab that contains 
the attribute you want to change.         
The change of attributes is described in detail in the section "Change object properties".
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See also
Working with Groups (Page 614)

Working with Objects (Page 378)

The Rectangle Surrounding the Object (Page 232)

Multiple Selection of Objects (Page 386)

The Properties of an Object (Page 423)

How to ungroup a group (Page 617)

How to change the properties of a group (Page 616)

How to group objects (Page 614)

How to change the properties of a group

Introduction
A group can be edited in the Graphics Designer like all other objects.

The following elements are shown as components of the "Group" object type in the "Object 
Properties" window:

● Property groups and attributes that have at least one of the selected objects.

● All objects in the group with their own property groups and attributes.

Changing a common group attribute affects all single objects that have this attribute. However, 
for some attributes this effect has special rules that only apply to the group.

Examples
● If the origin of a group is moved, the values of the individual objects are configured for the 

new coordinates. The attributes "Position X" and "Position Y" of the individual objects do 
not change relative to the origin of the group. 

● If the size of a group is changed, the attributes "Height" and "Width" of the individual objects 
are adjusted by percentage to match the resize.

● If a rotation has been specified for single objects of a group in Runtime, these settings are 
matched to the size of the group. The reference points for the rotation refer to the origin of 
the group, not the origin of the single object. In Runtime, the objects for which no rotation 
was specified remain unchanged.

● Linear objects that are in a group with surface objects always take the color that was last 
selected for the background color or the line color in the properties of the group.

● If a group is to be operated with a hotkey, the hotkey must only be assigned to the single 
"Button" object in the group. A hotkey assigned to the entire group will not work in Runtime.
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Requirements
● Select a group.

Procedure
1. Open the "Object Properties" window.

2. Select the property group in the "Properties" tab that contains the attribute you want to 
change.         
The change of attributes is described in detail in the section "Change object properties".

Alternative Operation
You can also change the properties of a group with the mouse. The complete group is edited 
in the same way as single objects.

Note

The objects included in a group can also be edited individually by changing their attributes. 
The objects are displayed in the "Object Properties" window with their property groups as a 
component of the "Group" object type.

See also
How to group objects (Page 614)

How to change the objects of a group (Page 615)

How to ungroup a group (Page 617)

The Properties of an Object (Page 423)

Multiple Selection of Objects (Page 386)

The Rectangle Surrounding the Object (Page 232)

Working with Objects (Page 378)

Working with Groups (Page 614)

How to ungroup a group

Introduction
Use the "Ungroup" command to split a group into its individual objects. The individual objects 
are then shown as a multiple selection.
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Requirements
● Select a group.

Procedure
1. Open the pop-up menu or the "Edit" menu.

2. Select "Group / Ungroup".         
The group selection marks are hidden.         
The objects of the group are shown as a multiple selection.

Note

The "Group" command can be used to group single objects again and thus to build up a 
hierarchy of groups. Groups can be ungrouped in the reverse order of grouping.

See also
How to group objects (Page 614)

Multiple Selection of Objects (Page 386)

The Rectangle Surrounding the Object (Page 232)

Working with Objects (Page 378)

Working with Groups (Page 614)

Working with Combined Objects (Page 613)

3.8.7.3 Working with Customized Objects

Working with Customized Objects

Introduction
A customized object allows the properties and events that are displayed and changed in the 
"Object Properties" window to be configured individually.

A customized object can be edited in the Graphics Designer like a single object of the object 
palette. As in a group, the selection marks of the individual objects are no longer shown after 
creation of a customized object. The selection marks surround the entire customized object. 
The selection border of the multiple selection becomes the rectangle around all the objects of 
the customized object.

Note the following features for working with customized objects:

● The "Undo" function is not available for editing a customized object.

● Configured events of the single objects are deleted when the customized object is created.
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● If editing mode is exited without an object having been selected, the customized object is 
deleted. When edit mode is exited, only the selected objects are imported into the 
customized object.

● Assigning hotkeys and specifying a TAB sequence for objects within the customized object 
is not supported.

● If a group display is embedded in a customized object, the attributes "group value", "group 
relevant" and "bit pattern group display" are available for the customized object to capture 
and acknowledge states.

● It is not possible to create an attribute name twice. These attributes are preassigned by the 
system (standard attributes). If the attributes of a customized object are deleted, these 
attribute names cannot be used in a user specific attribute. Further information on the 
standard attributes is available under "ScreenItem Object".

● User-specific attribute names of the customized object must not contain special characters.

● Use the "Configuration Dialog Customized Object" to display the properties for the 
customized object. If a standard property is deleted in "Configuration Dialog Customized 
Object", this property is not displayed on the Graphics Designer user interface. Access to 
the property is still possible using VBS. This relates to the following properties: ObjectName, 
Layer, Left, Top, Width, Height, Visible, Enabled and PasswordLevel

● Properties with the prefix "@" are not electronically numbered (enum) by VBA. Therefore, 
these properties cannot be edited by VBA either.

● Properties with the prefix "@" cannot be accessed by VBS.

● When addressing the user-specific properties of a customized object, the spelling used in 
the VB scripts must correspond to the spelling in the Configuration dialog. Particular 
attention must be paid to upper/lower case.

● The property name is dependent on the language set. In the case of customized object with 
multilanguage, user-specific properties, the language must be set in the "Configuration 
Dialog Customized Object" before editing the customized object. The required language 
can then be selected.

Note

The text properties of the text object must be dynamic to allow changes from external 
sources so the language change can function.
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See also
How to create a customized object (Page 620)

How to configure the property groups of the customized object (Page 625)

How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

Events of a customized object (Page 632)

How to configure the events of a customized object (Page 633)

How to edit a customized object (Page 634)

How to delete a customized object (Page 635)

Working with Objects (Page 378)

Working with Combined Objects (Page 613)

Example: How to create a compressor as a customized object (Page 636)

Configuration on a Customized Object (Page 621)

Properties of a Customized Object (Page 623)

Multiple Selection of Objects (Page 386)

How to create a customized object

Introduction
The objects of a multiple selection can be combined into a customized object with the command 
"Customized Object / create..." in the pop-up menu or the "Edit" menu. A customized object 
can be created from one single object. The object types Application Window, Picture Window, 
OLE object, Group or another customized object cannot be imported into a customized object.

Requirements
● Select at least two objects of any type, except for Application Window, Picture Window, 

OLE object, Group or another customized object.

Procedure
1. Open the pop-up menu or the "Edit" menu.

2. Select the entry "Customized object / create...".         
The dialog "Configuration Dialog Customized object" will open.
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3. Configure the available properties and events of the customized object.         
For more information on the configuration of a customized object see section "The 
Configuration of a Customized Object".

4. Confirm your configuration with "OK".         
The selected objects are combined into a customized object.         
The selection border of the multiple selection becomes the rectangle around the customized 
object.

See also
How to edit a customized object (Page 634)

How to delete a customized object (Page 635)

Example: How to create a compressor as a customized object (Page 636)

Working with Objects (Page 378)

Multiple Selection of Objects (Page 386)

Working with Customized Objects (Page 618)

Configuration on a Customized Object (Page 621)

Properties of a Customized Object (Page 623)

Configuration on a Customized Object

Introduction
The "Configuration Dialog Customized object" can be used to specify which properties and 
events can be configured for the customized object. The "Object Properties" window will show 
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only the properties and events defined in the configuration dialog for the customized object. 
The settings are configured in the "Properties" and "Events" tab.

The "Configuration Dialog Customized object" can be opened from the pop-up menu of a 
selected customized object.

"Properties" Tab
A selection of the available property groups and attributes can be defined in the "Properties" 
tab. The name and configured language of an available attribute can be changed. Every 
attribute of the customized object can also be linked to attributes of the included single objects.

"Event" Tab
The events available for the customized object are configured with the "Events" tab. It is also 
possible to make "Object Events" available for the included single objects.
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See also
How to configure the properties of attributes of the customized object (Page 629)

How to add and delete attributes of a customized object (Page 628)

How to configure the property groups of the customized object (Page 625)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

Properties of a Customized Object (Page 623)

Events of a customized object (Page 632)

Properties of a Customized Object

Introduction 
A selection of the available property groups and attributes is defined in the "Properties" tab. 
The name and configured language of an available attribute can be changed. Every attribute 
of the customized object can also be linked to attributes of the included single objects.

Configuration Dialog

Object type
The name of the selected customized object is shown and can be changed.         
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Enter the desired name.

Language
The customized object and the attributes of the selected properties can be configured for 
different languages.         

Select the desired attribute and click the  to select one of the languages installed in WinCC.

Selected Properties
This area contains the property groups and attributes that are displayed as properties of the 
customized object in the "Object Properties" window. Property groups and attributes can be 
inserted or removed from the selection as required.

Click the "+" or "-" symbols to show or hide subordinate entries.         
The detailed description can be found in the following chapters: "Configuring property groups 
of a customized object" and "Configuring attributes of a customized object".

Objects
This area contains all objects included in the customized object.         
Select an object for which you want to show the available attributes in the "Properties" area.

Properties
This area contains all available attributes for the object selected in the "Objects" area.         
Double-click the desired attribute to insert it into the assigned position in the "Selected 
Properties" area. The detailed description can be found in "Inserting or deleting attributes of a 
customized object".

Note

An object can only receive an operator authorization as a "Whole". A customized object can 
have an operator authorization but its subordinate objects cannot.

Object Properties dialog

"Inherit Status" attribute
The statuses of the "Display" and "Operator-Control Enable" properties of the user object can 
be inherited by the individual objects of the customized object. The "Inherit status" property 
determines whether a change in the outer "Display" and "Operator-Control Enable" properties 
will be passed on to the inner objects.
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Example 1
You have configured the "Inherit status" properties for the customized object with "Yes" and 
"Display" as "Visible".

One object of the customized object has the property "invisible".

If the customized object is made invisible and then again visible, then all objects of the 
customized object are shown as visible even if one object of the customized object has the 
property "invisible".

Example 2
You have configured the "Inherit status" property for the customized object with "No" and 
"Display" as "Visible".

The customized object is now switched to invisible. If you then set the property of an inner 
object to "Visible", the inner object will not be visible. The inner object will only become visible 
if the customized object is changed to visible.

See also
How to configure the property groups of the customized object (Page 625)

How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

Events of a customized object (Page 632)

How to configure the property groups of the customized object

Introduction
Only the property groups that are listed in the "Selected Properties" area are shown for the 
customized object in the "Object Properties" window. The selection of the property groups is 
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configured with the "Theme Selection" dialog. The predefined name of the user-defined 
property groups can be changed.

All Themes
All property groups that can be made available for the customized object are listed in the left 
section of the dialog.

Selected Themes
All property groups that have been selected for the customized object are listed in the right 
section of the dialog.

Arrow buttons
Use the arrow buttons to move property groups in the direction of the arrow:

Moves the selected property groups from the left to the right section.

Moves the selected property groups from the right to the left section.

Prerequisites
● The "Properties" tab in the "Configuration Dialog Customized object" must be open for the 

selected customized object.

● There must be at least one property group in the "Selected Themes" area.
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Selecting property groups
1. Select the "Theme Selection..." entry in the pop-up menu of the "Selected Properties" 

area".         
The "Theme Selection" dialog will open.

2. Select the desired property groups and move them with the arrow buttons.

3. Confirm your configuration with "OK".

Renaming property groups
User-defined property groups can also be used for a customized object. By default they contain 
the name "User-defined" and a sequential number. The name of the user-defined property 
groups can be changed.

1. Select "Rename" in the pop-up menu of the property group.         
The name of the property group can now be edited.

2. Enter the new name for the property group.

3. Confirm your entry with <ENTER>.

See also
How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

Properties of a Customized Object (Page 623)

Events of a customized object (Page 632)
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How to add and delete attributes of a customized object

Introduction
Attributes of the customized object that are to be shown in the "Object Properties" window can 
be added or deleted from the selection in the "Selected Properties" area of the configuration 
dialog.

Prerequisites
● The "Properties" tab in the "Configuration Dialog Customized object" must be open for the 

selected customized object.

Adding attributes
1. Select an object in the "Objects" area from which you want to provide an attribute for the 

customized object.         
The available attributes of the selected object are shown in the "Properties" area.

2. Double-click the desired attribute in the area "Properties".         
    The selected attribute is added at the relevant position in the "Selected Properties" area. 
The attribute name is extended by the object name of the object.

3. Repeat steps 1 and 2 until all desired attributes are in the "Selected Properties" area.

Alternatively you can drag attributes to the desired position in the "Selected Properties" area 
with the mouse.
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Note

The attributes of the customized object are automatically assigned to the associated property 
group. The default assignments cannot be changed.

Deleting attributes
1. Select the attributes of the customized object that you want to delete in the "Selected 

Properties" area.

2. Select "Delete" in the pop-up menu of the selected attribute.         
    The selected attribute is removed from the selection.

See also
How to configure the property groups of the customized object (Page 625)

How to configure the properties of attributes of the customized object (Page 629)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

Properties of a Customized Object (Page 623)

Events of a customized object (Page 632)

How to configure the properties of attributes of the customized object

Introduction
The properties of the attributes available in the customized object can be changed for display 
in the "Object Properties" window. The properties of the attributes can bee configured with the 
"Properties" dialog.
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Current language
Displays the language for which the attribute was designed.

Attribute Name
Displays the attribute names under which the attribute is registered in WinCC. The "OLE 
Automation Name" must be unique. A change of the attribute name affects all languages 
configured for the attribute.

Name of Property
Property names with which the attribute is displayed in the "Object Properties" window.

Prerequisites
● The "Properties" tab in the "Configuration Dialog Customized object" must be open for the 

selected customized object.

Procedure
1. Select the attribute of the customized object whose properties you want to configure in the 

"Selected Properties" area.

2. Select "Properties..." in the pop-up menu of the selected attribute.         
Opens the "Properties" dialog.

3. Change the settings and confirm your input with "OK".

See also
How to configure the property groups of the customized object (Page 625)

How to add and delete attributes of a customized object (Page 628)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

Properties of a Customized Object (Page 623)

Events of a customized object (Page 632)

Linking a Customized Object with a Structure Tag

Introduction
Customized object may be linked with a structure tag with an open tag dialog in Graphics 
Designer simply by using Drag&Drop. Using the object properties of two text fields, structure 
type and unique identification of the object are characterized using the structure tag.
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Prerequisites
● A structure type and at least one structure tag must be configured.

● In the customized object, you have added two objects "Static Text" with the property "Text" 
in "Selected Properties" to "UserDefined2".

● In Graphics Designer, the tag dialog must be open. Using the menu "View/Toolbars..." you 
activate the tag dialog.

Procedure
1. In "Configuration Dialog Customized Object" in the area "Selected Properties", select one 

of the static texts for the Customized Object.

2. In the dialog "Properties" for "Attribute Name", enter the name "StructureType".

3. In "Configuration Dialog Customized Object" in the area "Selected Properties", select the 
second static text for the Customized Object.

4. In the dialog "Properties" for "Attribute Name", enter the name "tagname".

5. Confirm your settings with "OK".

6. In the "Object Properties" dialog of the Customized Object, enter under attribute 
"StructureType" the name of the structure type as text.

7. Dynamize the desired properties with an element of a valid structure tag.

8. If you now select the Customized Object, the open tag dialog will only display the available 
tags of the assigned structure type.

9. Using Drag&Drop, you connect the desired structure tag from the tag dialog with the 
customized object. The structure tag is entered into the object property "tagname".

Duplicate customized object may be assigned a tag of the same structure type using 
Drag&Drop.

See also
How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

Working with Customized Objects (Page 618)

Configuration on a Customized Object (Page 621)

Properties of a Customized Object (Page 623)

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  631



Events of a customized object

Introduction
The events available for the customized object are configured with the "Events" tab. It is also 
possible to make "Object Events" available for the included single objects.

Selected Events
This area contains the event groups "Mouse", "Keyboard", "Focus", "Miscellaneous" and 
"Object Events". The events designed for the customized object are assigned to these event 
groups. All events that are designed for the single objects in the customized object are assigned 
to the "Object Events" event group.         
    Click the "+" or "-" symbols to show or hide subordinate entries.

Objects
This area contains all objects included in the customized object.         
Select an object for which you want to show the available events in the "Properties" area.

Event
This area contains all available events for the object selected in the "Objects" area.         
Double-click the desired event to insert it into the assigned position in the "Selected Events" 
area.
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See also
Properties of a Customized Object (Page 623)

How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

How to configure the property groups of the customized object (Page 625)

How to configure the events of a customized object

Introduction
The events available for the customized object are configured with the "Events" tab. It is also 
possible to make "Object Events" available for the included single objects.

Prerequisites
● Select a customized object.

● Open the "Configuration Dialog Customized object" from the pop-up menu and select the 
"Events" tab.

Adding events
1. In the "Objects" area, select an object for which you want to configure an event in the 

customized object.         
The events available for the selected object are displayed in the "Events" area.

2. Double-click the desired event in the area "Properties".         
    The selected event is inserted into the respective event group in the "Selected Events" 
area. The event name is extended by the object name of the object.

3. Repeat steps 1 and 2 until all desired events are in the "Selected Events" area.

4. Confirm your configuration with "OK".

Alternatively you can drag events to the desired position in the "Selected events" area with the 
mouse.

Note

The events configured for the customized object are automatically assigned to the associated 
event group. The default assignments cannot be changed.
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Deleting events
1. Select the event of the customized object that you want to delete in the "Selected Events" 

area.

2. Select "Delete" in the pop-up menu of the selected event.         
    The selected event is removed from the selection.

See also
How to configure the property groups of the customized object (Page 625)

How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

How to configure the events of a customized object (Page 633)

Working with Customized Objects (Page 618)

Properties of a Customized Object (Page 623)

Events of a customized object (Page 632)

How to edit a customized object

Introduction
The edit mode for the customized object is activated with the "Customized object / Edit ..." 
function. In edit mode the properties of all included single objects can be separately changed. 
Single objects can be added or deleted. A single object contained in a customized object is 
edited as described in "Working with objects".

The selection marks of the single objects are shown as gray squares with a white border in 
edit mode. When edit mode is exited, only the selected objects are imported into the 
customized object.

Prerequisites
● Select a customized object.

Activating edit mode
1. Open the pop-up menu or the "Edit" menu.

2. Select "Customized object / Edit...".         
The Edit mode will be activated.         
Like multiple selection of objects, selection marks for the single objects contained in the 
customized object are shown. The selection marks are shown as gray squares with a white 
border in edit mode.
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Exit edit mode
1. Open the pop-up menu or the "Edit" menu.

2. Select "Customized object / Exit edit".         
Edit mode is deactivated.         
When edit mode is exited, only the selected objects are imported into the customized object. 
If no object is selected, the customized object is discarded.

See also
Working with Customized Objects (Page 618)

Configuration on a Customized Object (Page 621)

Working with Objects (Page 378)

How to delete a customized object (Page 635)

How to create a customized object (Page 620)

How to delete a customized object

Introduction
A customized object can be split into its component objects with the command "Customized 
Object / Delete" in the pop-up menu or the "Edit" menu. The individual objects are then shown 
as a multiple selection.

Prerequisites
● Select a customized object.

Procedure
1. Open the pop-up menu or the "Edit" menu.

2. Select "Customized Object / Delete".         
The selection marks of the customized object are hidden.         
The individual objects of the customized object are shown as a multiple selection.

See also
How to create a customized object (Page 620)

Multiple Selection of Objects (Page 386)

The Rectangle Surrounding the Object (Page 232)

Working with Customized Objects (Page 618)

Working with Combined Objects (Page 613)
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Example: How to create a compressor as a customized object

Introduction
A customized object that can be used to display a compressor is to be prepared for a system 
design. Only specific properties should be configurable to allow multiple use of the 
"Compressor" customized object in the design.          
    The "Compressor" customized object should have the check-back messages "On", "Off", 
"Approach" and "Retract". The "On" and "Off" states must be visualized by a change in a 
background color. The "Approach" and "Retract" states must be displayed by flashing lines.

The following example implements this task step-by-step.
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Procedure
1. Create a graphic to show the compressor.

The compressor is created from the following standard objects: 2 circles, 3 lines and a static 
text.

2. Select all objects from which the customized object must be created.          
Select "Customized Object / Create..." in the multiple selection context menu.

The "Configuration Dialog Customized object" dialog opens.
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3. The "Configuration Dialog Customized Object" shows all the single objects contained in the 
customized object with their properties and events.         
Select the "Properties" tag.

In this example the "UserDefined2" property group is used to define the desired properties 
and events of the customized object.
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4. Select "Rename" in the pop-up menu of the "UserDefined2" property group.

In this example the term "Settings" is entered as the new name of the "UserDefined2" 
property group.
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5. The "On" and "Off" states must be visualized by changing the background color of 
Circle1:         
Select the object "Circle1".         
Drag the "Background color" property by Drag&Drop to the "Settings" property group.

The customized object now has the "Circle1.Background Color" attribute in the "Settings / 
Background Color" property group.

6. Select "Properties..." in the pop-up menu of the attribute "Circle1.Background color".         
Opens the "Properties" dialog.

Enter a name for the dynamics of the attribute by C or VBS actions in the "Attribute Name" 
field. The "Name of Property" field contains the exact name of the attribute for the display 
in the "Object Properties" window and can also be changed.
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7. The "Approach" and "Retract" states must be displayed by flashing lines:          
The line colors of all objects, which flashing is to be configured for, can be combined into 
an attribute of the customized object.         
Select the desired objects in sequence and drag the property "Line Color" via Drag&Drop 
into the property group ""Settings".

The customized object now has the "Object.Line Color" attributes in the "Settings / Line 
Color" property group.
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8. Repeat this process for all attributes that the customized object requires.

In this example the attributes "Flashing Line Color On", "Flashing Line Color Off" and 
"Flashing Line Active" are added to various single objects.
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9. Select the "Events" tab to configure the required events for the customized object.

In this example only the "Mouse Action" event is configured.
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10.Select the event "Mouse".         
Select the "CustomizedObject1" object that is to respond to the desired event. If the event 
is to be configured for a contained single object, select the single object only.         
Double-click the event "Mouse click".

The customized object now has the "CustomizedObject1.Mouse Action" event in the 
"Mouse" event group.         
Add more events in the same manner.
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11.The customized object should have the name "myCompressor":         
Select the "Properties" tab.         
Enter the name "myComprssor" in the field "Object type".         
    Click the entry "Customized Object" in the "Selected Properties" area to accept the name.

Confirm the configuration with "OK" to finish creating the "myCompressor" customized 
object.         
The configuration dialog "Configuration Dialog Customized object" will be closed.

12.Select the new customized object in your process picture.         
Open the window "Object Properties" to check the configuration of the customized object.
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The "Settings" property group only shows the properties and events that you defined in the 
"Configuration Dialog Customized Object".

See also
How to create a customized object (Page 620)

How to configure the property groups of the customized object (Page 625)

How to add and delete attributes of a customized object (Page 628)

How to configure the properties of attributes of the customized object (Page 629)

How to configure the events of a customized object (Page 633)

How to edit a customized object (Page 634)

How to delete a customized object (Page 635)

Configuration on a Customized Object (Page 621)

Events of a customized object (Page 632)

Properties of a Customized Object (Page 623)

3.8.7.4 Working with the library

Working with the library

Introduction
The library of the Graphics Designer is versatile tool for saving and managing graphic objects 
that can be used for creating process pictures. It is divided into two areas:
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Global Library
The "Global Library" offers a variety of prefinished graphic objects that are inserted into a 
picture as library objects and can be configured as required. Sorted by subject in the form of 
a folder tree, graphic views of machine and system parts, instruments, control elements and 
buildings can be provided.

The "Global Library" can be extended with user-defined objects to make them available for 
other projects. However, these objects must not be linked with dynamics, to prevent errors 
when embedding them in other projects.

Project Library
The "Project Library" enables a project-specific library to be built. The objects can sorted by 
subjects by creating folders and subfolders.

User-defined objects can be stored here as copies and made available for multiple use. 
Because the Project Library is only available for the current project, dynamic objects should 
only be included in this library. The names of user-defined objects inserted into the library can 
be freely selected.

Opening library
The Graphics Designer library can be shown or hidden with the "Library" command in the 
"View" menu or via the icon . The structure and functions of the library are similar to the 
Windows Explorer. The display of the library objects can be configured with the elements of 
the toolbar.

Backup library objects
The project library is only available for the current project. If it has been extended with user-
defined objects, the project library should be backed up. 

In WinCC the library objects are stored in different folder paths:
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● All information on the global library is by default saved in the "\aplib" subfolder of the WinCC 
installation folder.

● Objects of the project library as components of the current project are stored in the "\library" 
subfolder of the

To be able to use the user-defined configurations of the project library in other projects, the 
contents of the relevant folder must be copied to the relevant folder of the target project. It is 
also recommended that you create a backup copy of the "\library" folder and update it regularly.

Types of library objects
Two different object types are used as library objects in the global library. Accordingly a library 
object that has been inserted into a picture is changed in various configuration dialogs:

Customized Objects
The folders "System Modules", "Displays", "Operation" and "Symbols" contain prefinished 
customized objects.         
If such a library object is inserted into a picture, changes can be executed in the window "Object 
properties" and in the configuration dialog "Customized Object". Both dialogs can be opened 
from the pop-up menu of the inserted object.

Controls
The "Siemens HMI Symbol Library" folder contains a comprehensive symbol library, whose 
elements can also be inserted in a picture as controls.         
If such a library object is inserted into a picture, changes can be executed in the window "Object 
properties" and in the dialog "Properties of Siemens HMI Symbol Library". The window "Object 
Properties" is opened from the pop-up menu of the inserted object. The "Properties of Siemens 
HMI Symbol Library" dialog can only be opened by double-clicking on the inserted object.

See also
Working with Combined Objects (Page 613)

"Siemens HMI Symbol Library" Folder (Page 655)

How to import objects into the library (Page 653)

How to convert library objects (Page 652)

How to import library objects into a picture (Page 650)

The Library Toolbar (Page 649)
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The Library Toolbar

Introduction
You can make the following settings with the tools in the toolbar of the "Library" dialog:

● Folders for sorting library objects by subject can be created and deleted in the library.

● Library objects can be copied, moved and deleted or added to the current picture.

● The library can be extended with user-defined objects.

● The display of the library objects can be configured.

Overview

Icon Name Function

New subfolder Creates a new subfolder in the selected folder.         
    Folders can be renamed or deleted from their pop-up menu.

Cut The "Cut" command is used to copy a selected library object to the 
operating system clipboard. The library object is removed from the 
library.

Copying The "Copy" command is used to copy a selected library object to the 
operating system clipboard. The library object itself is not changed.

Paste The "Paste" command can be used to add the current contents of the 
clipboard to the selected library folder as often as desired.

Deleting The "Delete" command removes a selected library object from the 
current library folder.

Giant Icons The "Giant Icons" command shows the library objects in the current 
folder as large symbols.         
No detailed information is shown except for the name of the 
object.         
If the preview is activated, the symbol for the picture contents of the 
library object is used.

Large Icons The "Large Icons" command shows the library objects in the current 
folder as medium-sized symbols.         
No detailed information is shown except for the name of the 
object.         
If the preview is activated, the symbol for the picture contents of the 
library object is used.

Small Icons The "Small Icons" command shows the library objects in the current 
folder as a list with small symbols.          
    No detailed information is shown except for the name of the 
object.         
If the preview is activated, the symbol for the picture contents of the 
library object is used.
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Icon Name Function

List The "List" command shows the library objects in the current folder as 
a list with small symbols.          
Besides the name of the object, the file size and the date of the last 
modification are displayed as detailed information.         
If the preview is activated, the symbol for the picture contents of the 
library object is used.

Preview The picture contents of the library objects are used for the symbolic 
display of the library object.          
If the preview is not activated, a default symbol is shown.

See also
Working with the library (Page 646)

"Siemens HMI Symbol Library" Folder (Page 655)

How to import objects into the library (Page 653)

How to convert library objects (Page 652)

How to import library objects into a picture (Page 650)

The Library Toolbar (Page 649)

How to import library objects into a picture

Introduction
Library objects can be added to a picture by dragging them with the mouse or by using the 
operating system clipboard.

When a library object is added to a picture, the object name is by default a combination of the 
name of the object type and a sequential number. This name can be changed with the "Object 
name" attribute in the "Object Properties" window.
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Requirements
● A picture must be opened.

Procedure
1. In the default toolbar of the Graphics Designer click the icon .         

The "Library" dialog will open.

2. Select a subfolder of the global library or the project library in the left section of the 
dialog.         
The library objects in this subfolder are shown in the right section of the dialog.

3. Select a library object and drag it with the mouse to the desired position in the 
picture.         
When you release the mouse button, the insertion procedure is finished.

Alternative Procedure
1. In the default toolbar of the Graphics Designer click the icon .         

The "Library" dialog will open.

2. Select a subfolder of the global library or the project library in the left section of the 
dialog.         
The library objects in this subfolder are shown in the right section of the dialog.

3. Select the desired library object.

4. In the toolbar of the "Library" dialog, click .         
The library object will be copied to the clipboard of the operating system.

5. In the default toolbar of the Graphics Designer click the icon .         
The library object will be inserted into the current picture from the clipboard.

See also
How to convert library objects (Page 652)

How to import objects into the library (Page 653)

How to Rename Objects (Page 383)

The Library Toolbar (Page 649)

"Siemens HMI Symbol Library" Folder (Page 655)

Working with the library (Page 646)
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How to convert library objects

Introduction
Library objects that were created in an older version of WinCC can be converted to the current 
format for continuing use. The commands for converting the libraries are opened from the pop-
up menu of the "Graphics Designer" entry in the WinCC Explorer navigation window.

The conversion can be only run completely for the Global Library or the Project Library. 
Individual library objects cannot be selected.

 

NOTICE

The conversion starts immediately, as soon as you have selected the entry. No confirmation 
prompt appears.         
Conversion of the libraries cannot be undone.

Creating Process Pictures
3.8 Working with Objects

MDM - WinCC: Working with WinCC
652 System Manual, 11/2008,  



Requirements
● A project must be opened.

Procedure
1. Right-click the entry "Graphics Designer".         

The pop-up menu will be opened.

2. Select the entry "Convert global library" or "Convert project library" from the pop-up 
menu.         
The procedure may take some time, depending on the number and file size of the included 
library objects.

See also
How to import library objects into a picture (Page 650)

How to import objects into the library (Page 653)

The Library Toolbar (Page 649)

The shortcut menu in the Navigation window (Page 212)

"Siemens HMI Symbol Library" Folder (Page 655)

Working with the library (Page 646)

How to import objects into the library

Introduction
The objects in a picture can be added to the library by dragging them with the mouse or by 
using the operating system clipboard. The objects can sorted by subjects by creating folders 
and subfolders. A new name can be assigned to the imported library object to simplify later 
use.

The "Global Library" can be extended with user-defined objects to make them available for 
other projects. These objects must not be linked with dynamics, to prevent errors when 
embedding them in other projects.          
Because the Project Library is only available for the current project, dynamic objects can also 
be included in this library.
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Requirements
● A picture must be opened.

Procedure
1. In the default toolbar of the Graphics Designer click the icon .         

The "Library" dialog will open.

2. Select or create a subfolder of the global library or the project library in the left section of 
the dialog.         
The library objects in this subfolder are shown in the right section of the dialog.

3. Select the object that you want to add to the selected folder in the active picture.

4. Hold down the mouse button and drag the selected object into the library folder.         
When you release the mouse button, the check box insertion is finished.

5. If you want to assign a name for later use to the new library object, select "Rename" in the 
pop-up menu of the new library object.         
The name of the library object will become editable.

6. Enter the new name and confirm this by pressing <ENTER>.

Alternative Procedure
1. In the default toolbar of the Graphics Designer click the icon .         

The "Library" dialog will open.

2. Select or create a subfolder of the global library or the project library in the left section of 
the dialog.         
The library objects in this subfolder are shown in the right section of the dialog.

3. Select the object that you want to add to the selected folder in the active picture.

4. In the standard toolbar of the Graphics Designer, click .         
The selected object will be copied to the clipboard of the operating system.
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5. In the toolbar of the "Library" dialog, click .         
The new library object will be inserted into the selected library folder from the clipboard of 
the operating system.

6. If you want to assign a name for later use to the new library object, select "Rename" in the 
pop-up menu of the new library object.         
The name of the library object will become editable.

7. Enter the new name and confirm this by pressing <ENTER>.

See also
How to import library objects into a picture (Page 650)

How to convert library objects (Page 652)

The Library Toolbar (Page 649)

"Siemens HMI Symbol Library" Folder (Page 655)

Working with the library (Page 646)

"Siemens HMI Symbol Library" Folder

Introduction
The global library contains a comprehensive symbol library in the "Siemens HMI Symbol 
Library" folder. It contains different objects from the other library objects. 

The objects of this library area are provided by a control of the same name and can also be 
added to a picture as a control from the object palette.
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An object of this type is changed in the "Properties of the Siemens HMI Symbol Library" 
configuration dialog, which can only be opened by double-clicking on the inserted object.

The detailed description of the "Siemens HMI Symbol Library" is in the chapter "Working with 
Controls".

See also
How to import objects into the library (Page 653)

How to convert library objects (Page 652)

How to import library objects into a picture (Page 650)

Working with Controls (Page 319)

Working with Combined Objects (Page 613)

The Library Toolbar (Page 649)

Working with the library (Page 646)

3.9 Process Pictures in Runtime

3.9.1 Testing Process Pictures in Runtime

Introduction
The behavior of process pictures, which were created and dynamized in Graphics Designer, 
can be tested in Runtime. Some object properties, such as the rotation or flashing of an object, 
can only be displayed in Runtime.

In this chapter, you will learn

● activate and deactivate Runtime

● test changes to a picture in directly Runtime

● modify the settings for the execution of Runtime

● configure mouseless operation for Runtime

See also
Activating Project (Page 132)

How to activate / deactivate Runtime (Page 657)

How to test the active picture in Runtime (Page 658)

How to set up Runtime (Page 112)

How to set up a picture for mouseless operation (Page 677)

Virtual keyboard - General Information (Page 673)
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3.9.2 How to activate / deactivate Runtime

Introduction
Runtime can be activated from WinCC Explorer or Graphics Designer. If it is called in WinCC 
Explorer, Runtime will start with the predefined start picture. If it is started from Graphics 
Designer, the active picture will be opened in Runtime. Runtime can only be deactivated from 
WinCC Explorer.

Requirements
● A project must be opened.

● The local computer's name must be entered as the computer name in the project.

● A process picture, which is found in the project, must be defined as the start picture.

● Changes in a picture can only be displayed in Runtime, when the picture was saved before 
Runtime was activated.

Activating Runtime
Runtime is executed in the "WinCC-Runtime" program window. The "Runtime" command is 
used to load additional program modules, which are required for the execution of Runtime.

WinCC Explorer
Click this button in the toolbar to open Runtime with the predefined start picture.

As an alternative, you can select "Activate" in the "File" menu. When Runtime is activated this 
will be indicated by a tick in front of the entry "Activate".

Graphics Designer
Click this button in the default toolbar to open Runtime with the active picture.

As an alternative, you can select "Runtime" in the "File" menu.

Deactivate Runtime
Runtime can only be deactivated from WinCC Explorer.

Click this button in the toolbar to deactivate Runtime.         
The modules for the execution of Runtime are deactivated. The "WinCC-Runtime" program 
window will be closed.

As an alternative, you can select "Activate" in the "File" menu. The tick in front of the entry 
"Activate" will be removed.
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See also
How to test the active picture in Runtime (Page 658)

How to set up Runtime (Page 112)

Testing Process Pictures in Runtime (Page 656)

3.9.3 How to test the active picture in Runtime

Introduction
The behavior of process pictures, which were created and dynamized in Graphics Designer, 
can be tested in Runtime. Furthermore, changes made to the configuration of a picture can 
be checked directly in Runtime.

Requirements
● Runtime must be activated.         

To start Runtime directly with the active picture, it must be activated from Graphics Designer.

● To test - in Runtime - the changes made, the active picture must first be saved.

Procedure
1. Open the picture that you want to change.

2. Change the desired Properties and Events.

3. In the standard toolbar, click the button .         
The active picture is saved with the changes applied.

4. In the standard toolbar, click the button .         
The active picture is activated in Runtime and can be tested in the program window "WinCC-
Runtime".

5. Repeat steps 2 - 4 to make further changes.

See also
How to set up Runtime (Page 112)

Testing Process Pictures in Runtime (Page 656)

Working with Objects (Page 378)

How to activate / deactivate Runtime (Page 657)
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3.9.4 Menus and Toolbars

3.9.4.1 User-defined menus and toolbars

Introduction
In the "Menus and Toolbars" editor you can configure customized menus and toolbars. The 
customized menus and tool bars can be displayed in the basic picture of a project and also in 
the picture windows. You connect menu items and symbols using procedures from Global 
Script VBS.

Usage
You used customized menus and tootbars, for e.g. to implement a picture navigation. The 
customized menus and toolbars are displayed in the basic picture of the project. You can thus 
shift from any picture to the pictures that you have configured the picture change using menu 
commands and symbols.

Principle
You save the customized menus and toolbars in configuration files. For each configuration file 
you can save one menu and any number of toolbars you want. You can indicate a configuration 
file as "Start Configuration" in the "Computer Properties":

Configure a file in the "Menu/Toolbar configuration" attribute in the picture window.

Note
Customized menus and toolbars in the WebNavigator

If you have indicated a configuration file in the "Start Configuration", the customized menus 
and toolbars are also displayed in the WebNavigator.
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Configuration Options for Customized Menus and Toolbars

Operator authorization
You can assign authorizations to customized menus and toolbars and their elements. The 
elements are automatically disabled if a logged in user does not have the required 
authorization. 

Inactive or invisible elements
Further, you can disable or hide customized menus and toolbars and their elements. You can 
also exchange the configuration file, for e.g. in case of user change during runtime, if you save 
the modified functional scope in a new configuration file. 

Language-dependent configuring
In the "Menus and Toolbars" editor you can configure language-dependent texts for menus 
and toolbars. For this, switch to the language in the Menus and Toolbars editor. Then re-enter 
the language-dependent texts. 

Connect menu command or icon to procedure
Use the following syntax to connect a procedure from the global script to a menu item or icon:
Sub <Procedurename> (ByVal Item)
Tag declarations
'Instructions
End Sub
The transfer parameter "Item" shows the object that the user has clicked. Use the "User data" 
field in the "Menus and Toolbars" editor to apply a parameter to the procedure 

The following example shows the "ActivateScreen" procedure that executes the picture 
change. Enter the picture name in the "User Data" field:
Sub ActivateScreen (ByVal Item)
Dim objScreen
Dim strScreenName
' "UserData" contains the screen name specified 
' in editor menus and toolbars.
strScreenName = Item.Userdata
HMIRuntime.BaseScreenName = strScreenName
End Sub
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Change Customized Menus or Toolbars at Runtime
You can dynamize the "Menu/Toolbar configuration" attribute in a picture window. There is 
also the possibility of changing the configuration of the basic picture and the picture window 
with VBS.

The following example shows a procedure that applied the configuration file to be loaded as 
parameter. 
Sub ChangeMenuToolbarConfigFile (ByVal strMTConfigFile)
HMIRuntime.MenuToolBarConfig = strMTConfigFile
End Sub

Note
Updating Changed Configuration in Runtime

A changed VB script that is connected with "Menus and toolbars" is only updated after 
Runtime is restarted.

If you change the properties of "Menus and toolbars" in Runtime, the changes are only applied 
in the following cases:
● After a picture change, if the configuration change does not affect the basic picture.
● When you load another configuration file and reload the modified configuration file.

 

3.9.4.2 How to Create a Menu

Introduction
In each picture, a menu is placed at the top margin. You can configure one menu bar for each 
configuration file.

Menu structure
The configuration options for a menu element depend on the position where the menu is 
located in the menu structure. 

The following picture shows a typical menu structure with different menu elements:
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The following table explains the function of the menu elements shown in the picture:

Menu element Function

MainMenu Represents a menu bar. 
Clean Displays a menu item. You can add menu commands, separators or other menu 

items (as sub-menus) in a menu item.
Sort Represents a menu command. Assign a procedure that is run when you click 

on the menu command to a menu command. You can enter a parameter (for 
e.g. picture frame) that is to be transferred to the procedure under "User Data". 

Requirement
● The menu structure is yet to be planned.

● The Menus and Toolbars editor is open.

● The tab "Menus" is displayed

Procedure
1. Add the required number of menu elements.

2. Assign the menu elements to the desired hierarchy levels.

3. Enter a Name and a Text for each menu element.

4. For each menu element, select a procedure that is run while clicking a menu element. Enter, 
if required, a transfer parameter for the procedure under "User data".

5. Define, if required, for each element whether it is "visible" or "active" during runtime and 
whether an authorization to operate is necessary.

6. While configuring a multi-lingual user interface, select the desired target language and enter 
the Texts for the menu elements.

7. Select "File > Save" to save the configuration.
Select "File > Save As" to save the configuration under a new name.
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Results
The following picture shows the menu structure with a configured menu "Clean":

The following picture shows the menu at runtime:
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Changing Configuration
1. Select the "File > Open" command to load a configuration file.

2. Change the menu elements.

3. Save the configuration.

3.9.4.3 How to Create a Toolbar

Introduction
You can configure any number of tools for each configuration file. For each toolbar you can 
define the placement position of the toolbar in the picture. Further, you can also define whether 
the user should have the option of freely placing the toolbar. 

Requirement
● The toolbar structure is yet to be planned.

● The Menus and Toolbars editor is opened.

● The tab "Toolbars" is displayed.

Procedure
1. To add a new toolbar, select the "Edit > Add Toolbar" command. 

2. Enter a Name and a Text for each toolbar. 

3. Select an "Alignment" and the "Mode" and define the "Masking color", if required. 

4. Define, if required, whether the toolbar is "visible or "active" during runtime and whether an 
authorization is required for operation.

5. To add a new icon to the toolbar, select the "Edit > Add Toolbar element" command. 
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6. Configuring the icon:

– Depending on the toolbar configuration, enter a text for the icon and/or select a picture. 

– If required, also enter a tooltip text that is to be displayed at runtime as help for the icon.

– For the icon, select the procedure that is to be run when the icon is clicked. Under "User 
data" enter a transfer parameter for the procedure.

– Define, if required, whether the icon is "visible or "active" during runtime and whether 
an authorization is required for operation.

7. Select "File > Save" to save the configuration.
Select "File > Save As" to save the configuration under a new name.
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Results
The following picture shows a toolbar with three icons that are labeled with a text.

The following picture shows the toolbar at runtime:
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3.9.4.4 How to configure menus and toolbars in a picture

Introduction
For each project you can save a configuration file with configured menus and toolbars. The 
customized menus and toolbars are displayed in each basic picture at the configured position.

You can use VBScript to load other configuration files at runtime. You can e.g. load different 
configuration files depending on the selected picture or from users that are logged in.

Procedure
1. Click the Computer component in the navigation window of the WinCC Explorer.          

WinCC displays the list of computers in the data window.

2. Select the computer and then click the Properties command in the pop-up menu.
The "Computer properties" dialog will open.

3. Click "Search" in the "Start configuration menu and toolbars" area of "Graphics Runtime" 
tab.

4. Select the configuration file in the file selection dialog.

5. Click "OK" to close all dialogs.

Results
When you activate a project, all customized menus and toolbars will be displayed in the basic 
picture of the project. 

3.9.4.5 How to configure menus and toolbars in a picture window

Introduction
Independent of the start configuration, you can load, in a picture window, an additional 
configuration file with user-defined menus and toolbars. 
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The customized menus and toolbars of the picture window and the start configuration can thus 
be displayed in the picture window. 

Note

The "Configuration of menu/toolbars" attribute can be made dynamic using the 
"MenuToolBarConfig" name. 

Requirements
● The picture is opened.

● Picture window can be configured.

Procedure
1. Open the object properties of the configured picture window.

2. Select the "Others" property group.

3. Double-click the "Configuration of menu/toolbars" attribute and select the desired 
configuration file in the file selection dialog.

Results
The customized menus and toolbars are displayed in the picture window during runtime. 

3.9.4.6 Control elements of the "Menus and Toolbars" editor

Common features
The toolbars, menus and their elements have the following properties:

Properties Function Explanation

Name Defines the name of the element. Use the internal name to uniquely 
identify the element. 

Text Defines the text that is displayed in the 
menu or toolbar.

The text is language-dependent. 

Active defines whether the element is active 
(enabled).

Use these settings if you have 
already configured the structure of 
the menus and toolbars; however, 
not all elements are capable of 
functioning. 

Visible defines whether the element is visible

Authorization Defines the authorization required to 
operate the element at runtime. 

The element is disabled 
automatically when the logged-in 
user does not have the 
authorization. 
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Properties of Menus and Toolbars
The following properties are available only for menus and toolbars:

Properties Function Explanation

Fixed (only toolbar) Determines whether the toolbar is fixed If the toolbar is not fixed, the user 
can move it to any margin of the 
window (docked) or it can also be 
displayed as a separate window 
("floating").

Alignment (only 
toolbar)

Defines the toolbar position. Possible positions are:
Top, right, left or bottom

Mode (only toolbar) Defines the display type for the element 
in the toolbar. 

Possible display types are:
Text, picture or text+picture

Picture size Defines the picture size in pixels for the 
icon. 

The selected picture is automatically 
scaled to the defined picture size. 

Masking Color Indicates which icon color is to be 
replaced by the background color of the 
menu or toolbar.

Use the masking color if you use, for 
e.g. round, symbols. 

Properties of menu items and icons
The following properties are available only for menu items and icons:

Properties Function Explanation

Tooltip text (only 
toolbar)

Defines the help text for the icon. The help text is displayed if the user 
points with the mouse on the icon. 

Separator Configuring the element as separator. Use separators to optically 
demarcate the function groups from 
each other. 

User Data Contains the value that is transferred 
during procedure call. 

You can enter, for e.g. the picture 
name that is transferred to the 
procedure as parameter. 

Script Defines the procedure that is run when 
the element is clicked. 

Use "..." to open a selection dialog. 
Use "R" to remove the procedure. 

Picture Defines the icon displayed for the 
element. 

Use "..." to open a selection dialog 
where you can select a picture. 

Commands for Changing the Structure of Menus and Toolbars

Command Icons in the 
Toolbar

Function

Paste Element Adds a new menu item under the selected menu 
item. 

Add toolbar Adds a new toolbar.

Add icon Adds a new icon to the selected toolbar.
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Command Icons in the 
Toolbar

Function

Delete object Deletes the selected object.

Moves Object Up Moves up an element within a layer.

Move Object Down Moves down an element within a layer.

Move Object Left Moves a menu item to one higher layer.

Move Object Right Moves a menu item to one lower layer.

Reduce Closes the highlighted part of the tree when the 
tree part has been opened.

Expand Opens the highlighted part of the tree when the 
tree part is closed.

3.9.4.7 How to define the font for the various languages

Introduction
You can define the font and text size for the menus and toolbars for each language individually.
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Requirements
● The WinCC Explorer is open.

Procedure
1. Select item "Font settings" command from the "Menus and Toolbars" context menu.

The "Font settings" dialog opens.

2. Select the language for which you want to define a font.
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3. Click on "Font".
The "Font" dialog box will open.

4. Select the font and text size.

5. Click "OK".
The changes that have been made are shown in the "Font settings" dialog.

6. Repeat steps 2 to 5 for all languages for which you want to define the font.
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3.9.5 Virtual keyboard

3.9.5.1 Virtual keyboard - General Information

Introduction
The virtual keyboard is a virtual keyboard on the screen of the operator device, which is 
generally a Panel PC with a touchscreen, since these do not have a built-in keyboard. The 
operator can click the keys shown on the screen to e.g. fill in an entry field.

Properties of the virtual keyboard
● The virtual keyboard has keys for entering numerical or alphanumeric characters.

● The key labels shown on the virtual keyboard are set to agree with the Regional Settings 
in the Windows Control Panel. In other words, an English keyboard will not have any special 
characters for German or French. The layout of the letters on the keyboard is also in part 
different. If several keyboard layouts have been installed, you can click the "Regional 

Settings" button, here , to change the keyboard layout.

The illustration shows a German virtual keyboard for entering alphanumeric values.

Activating the virtual keyboard
The virtual keyboard can be either displayed automatically for an input or activated by the 
operator when needed by pressing a key. The virtual keyboard can only be hidden using the 
"X" button in the virtual keyboard's title bar or by clicking on a place outside of an entry field.

Virtual keyboard - position on screen
The default position of the virtual keyboard is at the lower edge of the screen. The virtual 
keyboard can be positioned on the screen and minimized like any other window, but cannot 
be maximized to a full-screen setting. 

See also
How to configure the activation of the virtual keyboard (Page 674)

How to operate the virtual keyboard (Page 675)
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3.9.5.2 How to configure the activation of the virtual keyboard

Introduction
The behavior of the virtual keyboard can be configured as follows:

● The virtual keyboard will be displayed automatically for an entry and then hidden once the 
entry is finished. 

● The virtual keyboard can be displayed manually when the operator presses a key. The 
virtual keyboard can only be hidden using a button in its title bar.

Display virtual keyboard automatically for input
The virtual keyboard will always be shown in Runtime as soon as the operator has selected 
an entry field. Once the entry has been completed, the keyboard will be automatically hidden 
again.

Procedure
1. In WinCC Explorer double-click "Computer" and then right click in the project window on 

the right to open the pop-up menu with the properties of the computer.

2. On the "Runtime" tab, use the check box "Virtual keyboard".

Press a key to display the virtual keyboard
In this configuration, the operator can call up the virtual keyboard and use it not only for making 
entries in WinCC, but also in other applications such as Excel. 

Connect the action to start the virtual keyboard to a button. If the operator clicks on the button 
in Runtime, the virtual keyboard will remain on the screen even after a switching to another 
application or exiting from WinCC. To close it, the operator must use the button in the virtual 
keyboard's title bar.

Prerequisite
● Start the Graphics Designer and open a picture.

Procedure
1. Configure a button by dragging the Windows "Button" object from the Object palette into 

the picture. Label the button in the Configuration dialog with the appropriate text.

2. On the Dynamic Wizard's "System Functions" tab, double-click the "Start other applications" 
function. The configured button must be selected in the picture while you perform the above 
step.

3. In the Wizard select a trigger, e.g. a mouse action, which will be used to start the virtual 
keyboard.
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4. To select the application to start the virtual keyboard, click the button . The file selection 
dialog opens.

5. Select the path in which WinCC is installed. In this path open the "Common/PTTouchInput" 
directory and then start the application "TouchInputPC.exe".

6. Exit from the Wizard and save the picture.

The operator can use this button to display the virtual keyboard permanently. To close it, the 
operator must use the button in the virtual keyboard's title bar.

See also
How to operate the virtual keyboard (Page 675)

Virtual keyboard - General Information (Page 673)

3.9.5.3 How to operate the virtual keyboard

Entering alphanumeric values
To enter character strings and numeric values in hexadecimal format, WinCC will automatically 
display an alphanumeric virtual keyboard in Runtime, as soon as you

● have selected an entry field,

● double-clicked a cell in a WinCC Online Table Control in Editing mode or

● double-clicked a table element in a WinCC User Archive Table Control.

Once the entry has been completed, the keyboard will be automatically hidden again.

Keyboard levels
The alphanumeric virtual keyboard has several levels:

● the normal level

● the shifted level for entering uppercase and special characters

● the Alt Gr level for entering special characters

● the function key level for accessing the function keys F1 to F12

Alphanumeric values can be entered character by character using the virtual keyboard's 
buttons. Click on the Enter key to confirm the value entered; with "ESC", you can cancel your 
entry. In both cases, the virtual keyboard will be closed.
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Note

Click the button  twice to activate the taskbar.

Entering numerical values
To enter numerical values, click the "Num" button to display the numeric virtual keyboard. Once 
the entry has been completed, the keyboard will be automatically hidden again.

Numeric values can be entered character by character using the virtual keyboard's buttons. 
Click on the Enter key to confirm the value entered; with "ESC", you can cancel your entry. In 
both cases, the virtual keyboard will be closed.

Disable keys and key combinations
The following key combinations and keys can also be disabled for the virtual keyboard in 
WinCC:

● CTRL+ALT+DEL

● CTRL+ESC

● CTRL+SHIFT+ESC

● ALT+TAB

● Windows Buttons

1. In WinCC Explorer double-click "Computer" and then right click in the project window on 
the right to open the pop-up menu with the properties of the computer.

2. On the "Parameters" tab, activate the check box "CTRL+AL+DEL" in "Disable Keys". This 
will disable all of the key-combinations described above and the keys on the virtual 
keyboard.

See also
Virtual keyboard - General Information (Page 673)
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3.9.6 Setting up Mouseless Operation of a Picture

3.9.6.1 How to set up a picture for mouseless operation

Introduction
Objects such as buttons or I/O fields must be operated in Runtime to influence the process. 
To ensure convenient operation and that all necessary entries are made, you can configure 
the operation via the keyboard. In this case, the process of entering the data is simplified, since 
the cursor will jump from one object to the next as the operator makes the required entries.

Operable objects
The objects must be enabled for operation and the operator must be granted the required 
permission. Set the Operator-Control Enable and the Authorization for each object. Click on 
the object and select the object properties on the "Properties" tab. In the "Miscellaneous" 
property group, you can set the Operator-Control Enable and the Authorization.

Mouseless operation
There are two types of mouseless operation.

● "Alpha cursor"         
The user jumps only to those objects in Runtime, into which values can be entered. These 
objects are the I/O Field and the TextList.

● "Tab Order"         
Depending on the setting, the user jumps only to those objects, into which values can be 
entered.

The cursor mode can be changed in Runtime, but must be specified before starting Runtime. 
The cursor mode is set in the picture's object properties. To accomplish this, click a free area 
in the picture and select the "Properties" tab in the object settings. The value of "Cursor Mode" 
attribute in the "Miscellaneous" property group can be set to either "Alpha Cursor" or "Tab 
Order cursor".

Combining the alpha and tab order cursors in a picture
The cursor mode can be switched in Runtime, if a hotkey has been assigned for this purpose, 
see the chapter entitled "Hotkeys for operation and screen navigation". With this hotkey, the 
operator can then toggle back and forth between using the alpha or tab order cursor in Runtime. 
In this case, the tab sequence must be set for both types of cursor.

Jump from one object to the next in Runtime
The tab sequence is used to set the order in which objects are operated in Runtime. By default, 
the cursor is moved in operation with the <TAB> key (or <SHIFT+TAB> for the reverse order). 
You can also configure the operation to use shortcuts or the mouse. It is also possible to define 
hotkeys. For more information on this topic, please see the chapter entitled "Setting up 
Runtime".
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See also
Defining the Alpha cursor's tab sequence (Page 678)

Setting the tab order cursor's tab sequence (Page 679)

Tips on Changing the Tab Sequence (Page 681)

Removing Objects from the Tab Sequence (Page 682)

Putting Objects Back into the Tab Sequence (Page 683)

How to define hotkeys for operation and screen navigation (Page 119)

How to Assign Hotkeys in the Project (Page 110)

How to configure the cursor control in Runtime (Page 124)

How to set up Runtime (Page 112)

Virtual keyboard - General Information (Page 673)

Testing Process Pictures in Runtime (Page 656)

3.9.6.2 Defining the Alpha cursor's tab sequence

Introduction
The <TAB> key can be used in Runtime to move from one object to another to make entries.

In Runtime, the alpha cursor will only access two object types - I/O field and text list. The order 
in which the cursor will move from one object to another in Runtime is set with the TAB 
Sequence. When the alpha cursor is selected in Runtime, you can move through the process 
picture with the key, the mouse or previously defined hotkeys. 

You can display and, if necessary, change the tab sequence. Individual objects can be 
removed from or restored to the tab sequence.
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Example: With the configuration in the picture, the cursor will (in Runtime) move to the I/O field 
(number 1) first and then to the text list (number 2).

Procedure
1. In the "Edit" menu, "TAB Sequence", "Alpha Cursor" select "Order". All objects of the types 

I/O field and text list are given a number in a square (classic design) or a circle (other 
designs) in the upper left corner. This number was assigned automatically when the object 
was created.         
Note: If the "Order" entry is not active, the picture contains no I/O field or text list objects.

2. Beginning with the first one, click all of the objects in the desired tab sequence. The numbers 
will be changed accordingly.         
If you want to cancel the assignment of the tab sequence and begin again, press the 
<SHIFT> key and click the object which should be assigned the number 1. Then release 
the <SHIFT> key and click all of the objects in the desired sequence.

3. To conclude the entry, click the work surface.

Requirement for Runtime
● The cursor mode for the process picture must be set to "Alpha Cursor". To accomplish this, 

click a free area in the picture and select the "Properties" tab in the object settings. The 
"Cursor Mode" attribute in the "Miscellaneous" property group must be assigned the value 
"Alpha Cursor".

● The objects must be enabled for operation and the operator must be granted the required 
permission. Set the operator control enable and the authorization for each object. Click on 
the object and select the object properties on the "Properties" tab. In the "Miscellaneous" 
property group, you can set the operator control enable and the authorization.

See also
Setting the tab order cursor's tab sequence (Page 679)

Tips on Changing the Tab Sequence (Page 681)

Removing Objects from the Tab Sequence (Page 682)

Putting Objects Back into the Tab Sequence (Page 683)

How to set up a picture for mouseless operation (Page 677)

3.9.6.3 Setting the tab order cursor's tab sequence

Introduction
The <TAB> key can be used in Runtime to move from one object to another to make entries.

Every object can be accessed in Runtime with the tab order cursor. The order in which the 
cursor will move from one object to another in Runtime is set with the TAB Sequence. When 
the tab order cursor is selected in Runtime, you can move through the process picture with 
the key, the mouse or previously defined hotkeys. 
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You can display and, if necessary, change the tab sequence. Individual objects can be 
removed from or restored to the tab sequence.

First set which types of objects should be operable.

Setting object types
In the "Edit" menu, "TAB Sequence", "Tab Order" select "Settings". Using the "Object Types" 
check boxes, you can set the types of objects for which the tab sequence should apply.

Once you have confirmed your selection(s) by clicking on "OK", all of the objects will be 
displayed with a tab sequence number in accordance with your settings.

Example: With the settings in the picture, the cursor will first move to the I/O Field (number 1), 
then to the TextList (number 2) and then to the bar (number 3) etc. in Runtime.
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Setting the tab order cursor's sequence
1. In the "Edit" menu, "TAB Sequence", "Tab Order" select "Order" All of the objects will be 

given a number in the upper left corner in accordance with the settings in the "Object Types" 
window. This number was assigned automatically when the object was created.         
Note: If "Order" is not active, the picture does not contain any objects of the type selected 
in "Object Types" window.

2. Beginning with the first one, click all of the objects in the desired tab sequence. The numbers 
will be changed accordingly.         
If you want to cancel the assignment of the tab sequence and begin again, press the 
<SHIFT> key and click the object which should be assigned the number 1. Then release 
the <SHIFT> key and click all of the objects in the desired sequence.

3. To conclude the entry, click the work surface.

Prerequisite for Runtime
● The cursor mode for the process picture must be set to "Tab Order". To accomplish this, 

click a free area in the picture and select the "Properties" tab in the object settings. The 
"Cursor Mode" attribute in the "Miscellaneous" property group must be assigned the value 
"Tab Order".

● The objects must be enabled for operation and the operator must be granted the required 
permission. Set the Operator-Control Enable and the Authorization for each object. Click 
on the object and select the object properties on the "Properties" tab. In the "Miscellaneous" 
property group, you can set the Operator-Control Enable and the Authorization.

See also
Defining the Alpha cursor's tab sequence (Page 678)

Tips on Changing the Tab Sequence (Page 681)

Removing Objects from the Tab Sequence (Page 682)

Putting Objects Back into the Tab Sequence (Page 683)

How to set up a picture for mouseless operation (Page 677)

3.9.6.4 Tips on Changing the Tab Sequence

Introduction
Graphics Designer supports a number of options for avoiding the necessity of resorting all of 
the objects if the tab sequence is changed.
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Setting the tab sequence - keys
● <SHIFT>         

Hold down the <SHIFT> key while clicking the object. This object will be given the number 
1 in the tab sequence.

● <CTRL>         
Hold down the <CTRL> key while clicking the last object to keep its present number. Then 
release the <CTRL> key and click the object which should come next in the sequence.

● <SHIFT+CTRL>         
Hold down the <SHIFT+CTRL> key while clicking an object to remove this object from the 
TAB sequence or to put an object back into the TAB sequence.

See also
How to set up a picture for mouseless operation (Page 677)

Setting the tab order cursor's tab sequence (Page 679)

Defining the Alpha cursor's tab sequence (Page 678)

3.9.6.5 Removing Objects from the Tab Sequence

Introduction
The <TAB> key can be used in Runtime to move from one object to another to make entries. 
If you do not want the cursor to jump to an object, remove it from the tab sequence. 

Example: A complex process picture contains many objects for which the operator could make 
entries. Normally, however, entries need only be made for a few objects. In this case, simply 
put these objects in the tab sequence. If necessary, the operator can click the other objects to 
activate them and make his entries.

Procedure
1. In the "Edit" menu, "TAB Sequence" select one of the two types of cursor and then the entry 

"Order".          
Based on the settings, the objects are given a number in a square (classic design) or a 
circle (other designs) in the upper left corner. This number was assigned automatically 
when the object was created.

2. Hold the keys <SHIFT+CTRL> pressed and click the object, which should be removed from 
the tab sequence. The number of the object will be replaced by an asterisk. The objects 
with higher numbers will be automatically renumbered.

3. To conclude the entry, click the work surface.
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Requirement for Runtime
● The objects must be enabled for operation and the operator must be granted the required 

permission. Set the operator control enable and the authorization for each object.          
Click on the object and select the object properties on the "Properties" tab. In the 
"Miscellaneous" property group, you can set the operator control enable and the 
authorization.

See also
How to set up a picture for mouseless operation (Page 677)

Tips on Changing the Tab Sequence (Page 681)

Setting the tab order cursor's tab sequence (Page 679)

Defining the Alpha cursor's tab sequence (Page 678)

3.9.6.6 Putting Objects Back into the Tab Sequence

Introduction
The <TAB> key can be used in Runtime to move from one object to another to make entries. 
If you have removed an object from the tab sequence, you can put it back into the sequence.

Procedure
1. In the "Edit" menu, "TAB Sequence" select one of the two types of cursor and then the entry 

"Order".          
Based on the settings, the objects are given a number in a square (classic design) or a 
circle (other designs) in the upper left corner. This number was assigned automatically 
when the object was created. Objects, which have an asterisk instead of a number, have 
been removed from the tab sequence and can be put back into it.

2. Hold the keys <SHIFT+CTRL> pressed and click the object, which should be put back into 
the tab sequence. The asterisk in the rectangle or circle will be replaced by a 
number.         
If you now want to redefine the tab sequence, hold the <SHIFT> key pressed and click the 
object to which the cursor should first jump. Then release the <SHIFT> key and click all of 
the objects in the desired sequence.

3. To conclude the entry, click the work surface.
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Requirement for Runtime
● The objects must be enabled for operation and the operator must be granted the required 

permission. Set the operator control enable and the authorization for each object.          
Click on the object and select the object properties on the "Properties" tab. In the 
"Miscellaneous" property group, you can set the operator control enable and the 
authorization.

See also
How to set up a picture for mouseless operation (Page 677)

Removing Objects from the Tab Sequence (Page 682)

Tips on Changing the Tab Sequence (Page 681)

Setting the tab order cursor's tab sequence (Page 679)

Defining the Alpha cursor's tab sequence (Page 678)

3.10 Object properties

3.10 Resources

3.10.1 "Axis" Property Group

3.10.1.1 Axis Section (AxisSection)
The "Axis Section" attribute defines the distance between the large tick marks for the "Bar" 
object. The value is specified as the difference in value between two neighboring large tick 
marks.

There is a free choice of value. A meaningful limit is provided by the minimum value and 
maximum value of the scale.

0 The spacing between the large tick marks is set automatically according to the setting 
of the "Bar Scaling" attribute.

The "Axis Section" attribute can be made dynamic with the name "AxisSection".

3.10.1.2 Alignment
The "Alignment" attribute defines the arrangement of the scale relative to the bar for the "Bar" 
object. Depending on the setting for the "Bar Direction" attribute in the "Geometry" property 
group, the scale can be displayed to the left or right or above or below the bar.
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The possibilities for arrangement of the scale relative to the bar depend on the value of the 
"Bar Direction" attribute in the "Geometry" property group.

Above / Below The scale is displayed above or below the bar.
Left / Right The scale is displayed to the left or right of the bar.

The "Alignment" attribute can be made dynamic with the name "Alignment".

3.10.1.3  Bar Scaling (ScalingType)
The "Bar Scaling" attribute specifies the type of scale division for the "Bar" object. By selecting 
suitable scale divisions, it is possible to emphasize a particular range of values in the bar 
display.

Linear The large tick marks are evenly distributed across the scale.         
 The spacing between the large tick marks corresponds to the value of 
the "Axis Section" attribute.

Logarithmic The distribution of the large tick marks on the scale follows a logarithmic 
function.         
 The representation of low values is strongly emphasized.

Negative 
logarithmic

The distribution of the large tick marks on the scale follows a negative 
logarithmic function.         
 The representation of high values is strongly emphasized.

Automatic (linear) The large tick marks are evenly distributed across the scale.         
 The spacing between the large tick marks is set automatically.

Tangent The distribution of the large tick marks on the scale emphasizes the 
representation of the low and high values.

Square The distribution of the large tick marks on the scale follows a square 
function.         
 The representation of high values is emphasized.

Cubic The distribution of the large tick marks on the scale follows a cubic 
function. The representation of high values is emphasized.

The "Bar Scaling" attribute can be made dynamic with the name "ScalingType".

3.10.1.4 Label Each (Long StrokesText Each)
The "Label Each" attribute specifies the number of labeled large tick marks for the "Bar" object. 
If, for example, the attribute has the value "3", only every third large tick mark is labeled, starting 
with the large tick mark with the lowest value.

There is a free choice of value. A meaningful limit results from the number of large tick marks.

0 The large tick marks are not labeled
1 Each large tick mark is labeled
5 Every fifth large tick mark is labeled

The "Label Each" attribute cannot be made dynamic.

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  685



3.10.1.5 Exponent Display (Exponent)
The "Exponent Display" attribute specifies for the "Bar" object whether the numerical values 
of the scale are shown exponentially or as decimal values without exponent.

The representation of decimal values can be defined with the attributes "Decimal Places" and 
"Digits to the Left of the Decimal Point".

Yes The numerical values of the scale are displayed exponentially.
No The numerical values of the scale are displayed as decimal values without 

exponent.

The "Exponent display" attribute can be made dynamic with the name "Exponent".

3.10.1.6 Large Tick Marks (LongStrokesBold)
The "Large Tick Marks" attribute specifies for the "Bar" object whether the large tick marks of 
the scale are shown in bold or as normal.

Normal The large tick marks of the scale are displayed normally.
Bold The large tick marks of the scale are displayed in bold.

The "Large Tick Marks" attribute can be made dynamic with the name "LongStrokesBold".

3.10.1.7 Large Tick Marks Length (LongStrokesSize)
The "Large Tick Marks Length" attribute specifies the length of the large tick marks for the 
"Bar" object. The length of the shorter tick marks corresponds to half of the value specified 
here. The values are specified in pixels.

If the "Only Large Tick Marks" attribute has the value "Yes", no shorter tick marks are displayed.

There is a free choice of value.

The "Only Large Tick Marks" attribute can be made dynamic with the name "LongStrokesSize".

3.10.1.8 Decimal Places (RightComma)
The "Decimal Places" attribute specifies for the "Bar" object the number of digits after the 
decimal point for the display of numerical values in the scale.

0 - 20 The value can be chosen freely within the specified limits.

The "Decimal Places" attribute can be made dynamic with the name "RightComma".

3.10.1.9 Zero Point (ZeroPoint)
The "Zero Point" attribute specifies for the representation of the bar in which position the zero 
point value is displayed. The value is specified relative to the spacing of the scale end values 
in %. For a value of 0 %, for example, the zero point value is shown at the height of the large 
tick mark with the lowest value. The zero point can also be outside of the range represented.
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The "Zero Point" attribute is only evaluated if the "Bar Scaling" attribute has the value 
"Automatic". The absolute value for the zero point is set with the "Zero Point Value" attribute 
in the "Miscellaneous" property group.

There is a free choice of value.

The "Zero Point" attribute can be made dynamic with the name "ZeroPoint".

3.10.1.10 Only Large Tick Marks (LongStrokesOnly)
The "Only Large Tick Marks" attribute specifies for the "Bar" object whether the sections 
between the large tick marks in the scale of the bar are divided by shorter tick marks.

The length of the large tick marks is specified with the "Large Tick Marks Length" attribute. 
The length of the shorter tick marks corresponds to half of the value specified here.

Yes In the scale of the bar, only large tick marks are displayed.
No In the scale of the bar, the sections between the large tick marks are divided by 

shorter tick marks.

The "Only Large Tick Marks" attribute can be made dynamic with the name "LongStrokesOnly".

3.10.1.11 Scale (Scaling)
The "Scale" attribute specifies for the "Bar" object whether the bar is labeled with a scale.

Yes The bar is displayed with a scale.
No The bar is displayed without a scale.

The "Scale" attribute can be made dynamic with the name "Scaling".

3.10.1.12 Scale Marks (ScaleTicks)
The "Scale Marks" attribute specifies for the "Bar" object the number of segments into which 
the bar is divided by the large tick marks of the scale.

0 - 100 The "Bar" object can be divided into a maximum of 100 segments.
= 0 The optimum number of segments is set automatically.

The "Scale Marks" attribute can be made dynamic with the name "ScaleTicks".

3.10.1.13 Digits to the Left of the Decimal Point (LeftComma)
The "Digits to the Left of the Decimal Point" attribute specifies for the "Bar" object the number 
of digits before the decimal point for the display of numerical values in the scale.

0 - 20 The value can be chosen freely within the specified limits.
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The "Digits to the Left of the Decimal Point" attribute can be made dynamic with the name 
"LeftComma".

3.10.2 "Output / Input" Property Group

3.10.2.1 Number of Visible Lines (NumberLines)
The "Number of Visible Lines" attribute specifies the number of lines displayed in the selection 
list of a text list. If the amount of configured text is larger than this value, the selection list 
receives a vertical scroll bar in Runtime.

There is a free choice of value.

The " Number of Visible Characters" attribute can be made dynamic with the name 
"NumberLines".

3.10.2.2 Output Format (OutputFormat)
The "Output Format" attribute specifies the format for the display of an output value in the I/O 
field. The available format definitions depend on the value of the "Data Format" attribute.

Four different data formats are available for the input and output of values in an I/O field. 
Numerical values can be processed in binary, decimal or hexadecimal form; for the display of 
text, the I/O field must be assigned the data format "String".

The "Output Format" can be dynamized using the "OutputFormat" name.

3.10.2.3 Output Value (OutputValue)
The "Output Value" attribute specifies a start value for the output which is displayed in Runtime 
in the case of a missing process driver connection or if an update has not yet taken place.

It must be possible to display the output value with the format specifications specified with the 
"Output Format" attribute. If this is not the case, three asterisks are displayed instead of the 
output value.

There is a free choice of value.

The "Output Value" attribute can be made dynamic with the name "OutputValue".

3.10.2.4 Bit Number (BitNumber)
The "Bit Number" attribute specifies the number of the relevant bit in the output value.

0 - 31 The value can be chosen freely within the specified limits.

The "Bit Number" attribute can be made dynamic with the name "BitNumber".
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3.10.2.5 Data Format (DataFormat)
The "Data Format" attribute defines the data type for a value to be displayed.

Four different data formats are available for the input and output of values in an I/O field. 
Numerical values can be processed in binary, decimal or hexadecimal form; for the display of 
text, the data format "String" must be assigned.

It must be possible to display the output value with the format specifications specified with the 
"Output Format" attribute. If this is not the case, three asterisks are displayed instead of the 
output value.

The "Data Format" attribute cannot be made dynamic.

3.10.2.6 Input value
The "Input value" attribute defines the value to be entered in the I/O field by the user. 

You can configure the I/O field with this attribute so that the input value changed by the user 
is also displayed in the I/O field after confirming with the <Return> key. 

This requires that you configure a direct connection between the attributes "Input value" and 
"Output value". Without this direct connection, the entered value is deleted after acceptance 
with the <Return> key. The direct connection is only practical when no tag is connected to the 
output value, but the user can nevertheless query the specified value, for example, through a 
script.

The "Input value" attribute can be made dynamic with the name "InputValue". 

3.10.2.7 Field Type (BoxType)
The "Field Type" attribute defines the application area for I/O fields or fields of a text list.

Input The field is only used for the input of values.
Edition The field is only used for the output of values.
Input/Output The field can be used for the input and output of values.

The "Field Type" attribute can be made dynamic with the name "BoxType".

3.10.2.8 List Type (ListType)
The "List Type" attribute defines the data type for the "Text List" object.

Depending on the selected list type, a distinction is made in the specification of display texts 
for test lists defined with the "Assignment" attribute.

Decimal Display texts are assigned for certain value ranges.
Binary Display texts are assigned for each bit number.
Bit One display text can be assigned for each of the statuses "1 

bit set" and "0 - bit not set".

The "List Type" attribute cannot be made dynamic.
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3.10.2.9 Clear on Invalid Input (ClearOnError)
The "Clear on Invalid Input" attribute can be used to prevent adoption of an incorrect input 
value when the field is left. An input value is bad, for example, when it does not correspond to 
the predefined data format of the input field.

Yes An incorrect input value is deleted automatically on leaving the field.
No An incorrect input value is not deleted automatically on leaving the field.

The "Clear on Invalid Input" attribute can be made dynamic with the name "ClearOnError".

3.10.2.10 Clear on New Input (ClearOnNew)
The "Clear on New Input" attribute specifies whether the current field contents are 
automatically deleted when an input field is selected.

Yes The field contents are deleted automatically when the field is selected.
No The field contents not are deleted automatically when the field is selected.

The "Clear on New Input" attribute can be made dynamic with the name "ClearOnNew".

3.10.2.11 Selected Boxes (Process)
The "Selected Boxes" attribute sets which fields in a check box are to be shown as enabled.

Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding 
bit must have the value "1". The 32-bit word contains the information for all fields of the check 
box. The value of the "Selected Boxes" attribute is specified in hexadecimals.

The "Selected Boxes" attribute can be made dynamic with the name "Process".

3.10.2.12 Selected Box (Process)
The "Selected Box" attribute sets which option field in an option group is displayed as activated.

Each field is represented by a bit in a 32-bit word. In order to activate a field, the corresponding 
bit must have the value "1". The 32-bit word contains the information for all fields of the check 
box. The value of the "Selected Box" attribute is specified in hexadecimals.

The "Selected Box" attribute can be made dynamic with the name "Process".

3.10.2.13 Apply on Exit (AssumeOnExit)
The "Apply on Exit" attribute can be used to activate application of a value for the case that 
the user leaves the I/O field without confirmation or before the required number of characters 
is reached.

The "Apply on Exit" attribute has no effect if the "Apply on Complete Input" attribute has the 
value "Yes".
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Yes The field contents are accepted automatically when the field is selected.
No The input value is only accepted when the input is confirmed by the ENTER (return) 

key.

The "Apply on Exit" attribute can be made dynamic with the name "AssumeOnExit".

3.10.2.14 Apply on Complete Input (AssumeOnFull)
The "Apply on Complete Input" attribute specifies when an input value is applied.

Yes The input value is automatically applied as soon as the preset number of 
characters has been entered.

No The entered value is only applied when the input is confirmed by the ENTER 
(return) key

The "Apply on Complete Input" attribute can be made dynamic with the name "AssumeOnFull".

3.10.2.15 Hidden Input (HiddenInput)
The "Hidden Input" attribute specifies whether the input value is displayed during input as 
normal or encrypted.

Yes Each entered character is replaced in the display with the "*" character. The value 
entered and the data format of the value cannot be recognized.

No Each entered character is displayed as normal.

The "Hidden Input" attribute can be made dynamic with the name "HiddenInput".

3.10.2.16 Assignments (Assignments)
The "Assignments" attribute enables specification of display texts that are displayed depending 
on the current "Output Value" in the text list. The type of assignment depends on the selected 
"List Type".

List Type 
Decimal

Display texts are assigned for certain value ranges. The following criteria can 
be used to define the value range:         
"Single Value" - A display text is assigned to a single value.         
"From Value" - A display text applies to all values greater than or equal to that 
specified here.         
"To Value" - A display text applies to all values lesser than or equal to that 
specified here.         
"From To Value" - A display text applies to all values of the value range specified 
here.

List Type 
Binary

Display texts are assigned for each bit number. Up to 32 display texts can be 
defined. If a bit set in the output value is not assigned a display text, three 
asterisks appear in the drop-down list.

List Type 
Bit 

One display text can be assigned for each of the statuses "1 - bit set" and "0 - 
bit not set" of the bit relevant in the output value.
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Note

When you assign a text to a value in the text list, this text may not contain a semicolon";". 
The semicolon is a WinCC control character and will be automatically deleted in a text.

The "Assignments" attribute cannot be made dynamic.

3.10.3 "Picture" Property Group

3.10.3.1 Picture (PictureName)
The "Picture" attribute specifies which picture is displayed in a graphic object. Pictures with 
the following formats can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.         
 If no picture that you want to display is defined for a graphic object, the symbol for the graphic 
object is shown as a placeholder.

The graphic object should be the same size as the selected picture; otherwise, its display is 
distorted.         
 In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in 
the "Picture Selection" dialog.

The "Picture" attribute can be made dynamic with the name "PictureName".

3.10.3.2 Picture Referenced (PicReferenced)
The "Picture Referenced" attribute specifies whether the picture itself or only the reference in 
the form of a cross-reference to the picture is integrated.

Yes Only the reference of the picture is integrated and saved.
No The picture itself is integrated and saved.

The "Picture Referenced" attribute cannot be made dynamic.

3.10.3.3 Picture Transparent Color (PicTransColor)
The "Picture Transparent Color" attribute specifies the transparent color of the picture to be 
displayed. Transparent colors can only be displayed for pictures in BMP or DIB format. The 
"Picture Transparent Color On" attribute must have the value "Yes".

The "Picture Transparent Color" attribute can be assigned dynamic properties by means of 
the name "PicTransColor".
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3.10.3.4 Picture Transparent Color On (PicUseTransColor)
The "Picture Transparent Color On" attribute specifies whether the "Transparent Color" 
function is to be used for the picture to be displayed. Transparent colors can only be displayed 
for pictures in BMP or DIB format.

Yes The "Picture Transparent Color On" attribute is enabled.
No The "Picture Transparent Color On" attribute is disabled.

The "Picture Transparent Color On" attribute can be assigned dynamic properties by means 
of the name "PicUseTransColor".

3.10.4 "Pictures" Property Group

3.10.4.1 Picture Off Referenced (PicUpReferenced)
The "Round button" object can have three different statuses: "On", "Off" or "Deactivated".

For each status, a picture to be displayed can be selected. The attributes "Picture Off 
Referenced", "Picture On Referenced and "Picture Deact. Referenced" determine for the 
various statuses whether the pictures or only references to the pictures are integrated.

Yes Only the reference of the picture is integrated and saved.
No The picture itself is integrated and saved.

The "Picture Off Referenced" attribute cannot be made dynamic.

3.10.4.2 Picture Off Transparent Color (PicUpTransparent)
The "Picture Off Transparent Color" attribute specifies the transparent color of the picture to 
be displayed in "Off" state. Transparent colors can only be displayed for pictures in BMP or 
DIB format.

The "Picture Off Transparent Color On" attribute must have the value "Yes".

The "Picture Off Transparent Color" attribute can be assigned dynamic properties by means 
of the name "PicUpTransparent".

3.10.4.3 Picture Off Transparent Color On (PicUpUseTransColor)
The "Picture Off Transparent Color On" attribute specifies whether the "Transparent Color" 
function is to be used for the picture to be displayed in "Off" state. Transparent colors can only 
be displayed for pictures in BMP or DIB format.

Yes The "Picture Off Transparent Color On" attribute is enabled.
No The "Picture Off Transparent Color On" attribute is disabled.
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The "Picture Off Transparent Color On" attribute can be assigned dynamic properties by means 
of the name "PicUpUseTransColor".

3.10.4.4 Picture Deact. Referenced (PicDeactReferenced)
The "Round button" object can have three different statuses: "On", "Off" or "Deactivated".

For each status, a picture to be displayed can be selected. The attributes "Picture Off 
Referenced", "Picture On Referenced and "Picture Deact. Referenced" determine for the 
various statuses whether the pictures or only references to the pictures are integrated.

Yes Only the reference of the picture is integrated and saved.
No The picture itself is integrated and saved.

The "Picture Deact. Referenced" cannot be made dynamic.

3.10.4.5 Picture Deact. Transparent Color (PicDeactTransparent)
The "Picture Deact. Transparent Color" specifies the transparent color for the picture to be 
displayed in "Deactivated" state. Transparent colors can only be displayed for pictures in BMP 
or DIB format.

The "Picture Deact. Transparent Color On" attribute must have the value "Yes".

The "Picture Deact. Transparent Color" attribute can be assigned dynamic properties by means 
of the name "PicDeactTransparent".

3.10.4.6 Picture Deact. Transparent Color On (PicDeactUseTransColor)
The "Picture Deact. Transparent Color On" attribute specifies whether the "Transparent Color" 
function is to be used for the picture to be displayed in "Deactivated" state. Transparent colors 
can only be displayed for pictures in BMP or DIB format.

Yes The "Picture Deact. Transparent Color On" attribute is enabled.
No The "Picture Deact. Transparent Color On" attribute is disabled.

The "Picture Deact. Transparent Color On" attribute can be assigned dynamic properties by 
means of the name "PicDeactUseTransColor".

3.10.4.7 Picture On Referenced (PicDownReferenced)
The "Round button" object can have three different statuses: "On", "Off" or "Deactivated".

For each status, a picture to be displayed can be selected. The attributes "Picture Off 
Referenced", "Picture On Referenced" and "Picture Deact. Referenced" determine for the 
various statuses whether the pictures or only references to the pictures are integrated.

Yes Only the reference of the picture is integrated and saved.
No The picture itself is integrated and saved.

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
694 System Manual, 11/2008,  



The "Picture On Referenced" attribute cannot be made dynamic.

3.10.4.8 Picture On Transparent Color (PicDownTransparent)
The "Picture On Transparent Color" attribute specifies the transparent color of the picture to 
be displayed in "On" state. Transparent colors can only be displayed for pictures in BMP or 
DIB format.

The "Picture On Transparent Color On" attribute must have the value "Yes".

The "Picture On Transparent Color" attribute can be assigned dynamic properties by means 
of the name "PicDownTransparent".

3.10.4.9 Picture On Transparent Color On (PicDownUseTransColor)
The "Picture On Transparent Color On" attribute specifies whether the "Transparent Color" 
function is to be used for the picture to be displayed in "On" state. Transparent colors can only 
be displayed for pictures in BMP or DIB format.

Yes The "Picture On Transparent Color On" attribute is enabled.
No The "Picture On Transparent Color On" attribute is disabled.

The "Picture On Transparent Color On" attribute can be assigned dynamic properties by means 
of the name "PicDownUseTransColor".

3.10.4.10 Picture Status Off (PictureUp)
A round button can have one of three statuses: "On", "Off" or "Deactivated".

For each status, a picture to be displayed can be selected. Pictures with the following formats 
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the 
"Picture Selection" dialog.

The "Picture Status Off" attribute can be made dynamic with the name "PictureUp".

3.10.4.11 Picture Status Deactivated (PictureDeactivated)
A round button can have one of three statuses: "On", "Off" or "Deactivated".

For each status, a picture to be displayed can be selected. Pictures with the following formats 
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

The "Picture Status Deactivated" attribute can be made dynamic with the name 
"PictureDeactivated".

In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the 
"Picture Selection" dialog.
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3.10.4.12 Picture Status On (PictureDown)
A round button can have one of three statuses: "On", "Off" or "Deactivated".

For each status, a picture to be displayed can be selected. Pictures with the following formats 
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

The "Picture Status On" attribute can be made dynamic with the name "PictureDown".

In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the 
"Picture Selection" dialog.

3.10.4.13 Picture Alignment
The "Picture alignment" attribute defines the position and scaling of the picture placed on the 
round button. 

centered The picture is positioned, centered in the original proportions. 
Left justified The picture is positioned with original proportions, with left justification on 

the left-hand side of the round button. 
Right justified The picture is positioned with original proportions, with right justification on 

the right-hand side of the round button. 
Stretched The picture is scaled to a square and is adapted to the size of the round 

button. 

The attribute "Picture alignment" can be made dynamic with the name "BackPictureAlignment". 

3.10.5 "Flashing" Property Group

3.10.5.1 Flashing (EnableFlashing)
The "Flashing" attribute shows whether the value for status "OK" and "Simulation" appears 
flashing or not in the extended analog display in Runtime.

So that the flashing is visible in Runtime, the font flashing color must be different to the 
background flashing color.

Yes Flashing for status "OK" and "Simulation" in Runtime is enabled.
No Flashing for status "OK" and "Simulation" in Runtime is disabled.

The "Flashing" attribute can be made dynamic with the name "EnableFlashing".

3.10.5.2 Flashing Background Active (FlashBackColor)
The "Flashing Background Active" attribute specifies whether in Runtime a background is to 
appear as flashing or not.
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To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to set flashing for a button or slider, the "Windows 
Style" attribute must be set to "No".

Yes The background of the object flashes in Runtime.
No The background of the object does not flash in Runtime.

The "Flashing Background Active" attribute can be made dynamic with the name 
"FlashBackColor".

3.10.5.3 Flashing Line Active (FlashBorderColor)
The "Flashing Line Active" attribute specifies whether in Runtime a line is to appear as flashing 
or not.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. 

Yes The line of the object flashes in Runtime.
No The line of the object does not flash in Runtime.

The "Flashing Line Active" attribute can be made dynamic with the name "FlashBorderColor".

3.10.5.4 Flashing Border Active (FlashBorderColor)
The "Flashing Border Active" attribute specifies whether in Runtime a border is to appear as 
flashing or not.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off".

Yes The border of the object flashes in Runtime.
No The border of the object does not flash in Runtime.

The "Flashing Border Active" attribute can be made dynamic with the name 
"FlashBorderColor".

3.10.5.5 Flashing Text Active (FlashForeColor)
The "Flashing Text Active" attribute specifies whether in Runtime a text is to appear as flashing 
or not.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. 

Yes The text in the object flashes in Runtime.
No The text in the object does not flash in Runtime.
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The "Flashing Text Active" attribute can be made dynamic with the name "FlashForeColor".

3.10.5.6 Flash Frequency (FlashRate)
The "Flash Frequency" attribute defines at what speed the messages flash in the group display, 
the extended status display, and in the extended analog display in Runtime. The frequencies 
"slow", "medium" and "fast" can be set. The flash frequency depends on the system 
performance.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off".

Slow The messages flash slowly in Runtime.
Medium The messages flash at medium speed in Runtime.
Fast The messages flash quickly in Runtime.

The "Flash Frequency" attribute can be made dynamic with the name "FlashRate".

3.10.5.7 Background Flash Frequency (FlashRateBackColor)
The "Background Flash Frequency" attribute specifies the speed at which a background 
flashes in Runtime. The frequencies "slow", "medium" and "fast" can be set. The flash 
frequency depends on the system performance.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to set flashing for a button or slider, the "Windows 
Style" attribute must be set to "No".

Slow The background of the object flashes slowly in Runtime.
Medium The background of the object flashes in Runtime at medium rate.
Fast The background of the object flashes quickly in Runtime.

The "Background Flash Frequency" attribute can be made dynamic with the name 
"FlashRateBackColor".

3.10.5.8 Line Flash Frequency (FlashRateBorderColor)
The "Line Flash Frequency" attribute specifies the speed at which a line flashes in Runtime. 
The frequencies "slow", "medium" and "fast" can be set. The flash frequency depends on the 
system performance.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to set flashing for a button or slider, the "Windows 
Style" attribute must be set to "No".

Slow The line of the object flashes slowly in Runtime.
Medium The line of the object flashes in Runtime at medium speed.
Fast The line of the object flashes quickly in Runtime.
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The "Line Flash Frequency" attribute can be made dynamic with the name 
"FlashRateBorderColor".

3.10.5.9 Border Flash Frequency (FlashRateBorderColor)
The "Border Flash Frequency" attribute specifies the speed at which a border flashes in 
Runtime. The frequencies "slow", "medium" and "fast" can be set. The flash frequency depends 
on the system performance.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off".

Slow The border of the object flashes slowly in Runtime.
Medium The border of the object flashes in Runtime at medium speed.
Fast The border of the object flashes quickly in Runtime.

The "Border Flash Frequency" attribute can be made dynamic with the name 
"FlashRateBorderColor".

3.10.5.10 Text Flash Frequency (FlashRateForeColor)
The "Text Flash Frequency" attribute specifies the speed at which a text flashes in Runtime. 
The frequencies "slow", "medium" and "fast" can be set. The flash frequency depends on the 
system performance.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off".

Slow The text in an object flashes slowly in Runtime.
Medium The text in an object flashes in Runtime at medium speed.
Fast The text in an object flashes quickly in Runtime.

The "Text Flash Frequency" attribute can be made dynamic with the name 
"FlashRateForeColor".

3.10.5.11 Flashing Background Color Off (BackFlashColorOff)
The "Flashing Background Color Off" attribute specifies the color a background assumes in 
flash status "Off". The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for 
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No". 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Background Color Off" attribute can be made dynamic with the name 
"BackFlashColorOff".
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3.10.5.12 Flashing Background Color On (BackFlashColorOn)
The "Flashing Background Color On" attribute specifies the color a background assumes in 
flash status "On". The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for 
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No". 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Background Color On" attribute can be made dynamic with the name 
"BackFlashColorOn".

3.10.5.13 Flashing Line Color Off (BorderFlashColorOff)
The "Flashing Line Color Off" attribute specifies the color a line assumes in flash status "Off". 
The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Line Color Off" attribute can be made dynamic with the name 
"BorderFlashColorOff".

3.10.5.14 Flashing Line Color On (BorderFlashColorOn)
The "Flashing Line Color On" attribute specifies the color a line assumes in flash status "On". 
The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Line Color On" attribute can be made dynamic with the name 
"BorderFlashColorOn".

3.10.5.15 Flashing Border Color Off (BorderFlashColorOff)
The "Flashing Border Color Off" attribute specifies the color a border assumes in flash status 
"Off". The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off".

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 
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The "Flashing Border Color Off" attribute can be made dynamic with the name 
"BorderFlashColorOff".

3.10.5.16 Flashing Border Color On (BorderFlashColorOn)
The "Flashing Border Color On" attribute specifies the color a border assumes in flash status 
"On". The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off".

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Border Color On" attribute can be made dynamic with the name 
"BorderFlashColorOn".

3.10.5.17 Flashing Text Color Off (ForeFlashColorOff)
The "Flashing Text Color Off" attribute specifies the color a text assumes in flash status "Off". 
The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for 
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No". 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Text Color Off" attribute can be made dynamic with the name 
"ForeFlashColorOff".

3.10.5.18 Flashing Text Color On (ForeFlashColorOn)
The "Flashing Text Color On" attribute specifies the color a text assumes in flash status "On". 
The flashing is only visible in Runtime.

To make the flashing visible in Runtime, the flashing color of the status "On" must differ from 
the flashing color of the status "Off". In order to activate flashing, the "Global color scheme" 
attribute must be set to "No" - except with Design WinCC Classic. In order to set flashing for 
a button or slider object, the "[V6.2] Windows Style" attribute must be set to "No". 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Text Color On" attribute can be made dynamic with the name 
"ForeFlashColorOn".
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3.10.6 The "Display" property group

3.10.6.1 Display Options (DisplayOptions)
The "Display options" attribute defines what can be displayed in the object. 

Picture or text Either pictures or text can be displayed in the object. 
Picture and text Pictures and text can be displayed in the object.
Text only Only text can be displayed in the object.
Picture only Only pictures can be displayed in the object.

The "Display Options" attribute can be made dynamic with the name "DisplayOptions". 

3.10.6.2 Global Shadow
The "Global shadow" attribute defines whether the object will be displayed with the shadowing 
defined in the active design. 

yes Uses the global shadowing defined for this object type. 
no No shadowing. 

The attribute "Global shadow" can be made dynamic with the name "GlobalShadow". 

3.10.6.3 Global Color Scheme 
The "Global color scheme" attribute defines whether the colors defined for the current design 
in the global color scheme will be used for this object. 

yes Uses the colors from the global color scheme defined for this type of object. 
no Uses the colors from the color scheme defined for this type of object under 

"Colors". 

The attribute "Global color scheme" can be made dynamic with the name 
"GlobalColorScheme". 

3.10.6.4 Object Transparency
The "Transparency" attribute defines the percentage to which the object will become 
transparent. 

0 - 100          
(integer)

Defines the percentage of transparency.          
0 = no transparency; 100 = complete transparency (invisible) 

The text and fields of the graphic objects are only transparent at "100."

In runtime, a completely transparent object (invisible) is also functional. 

The attribute "Transparency" can be made dynamic with the name "Transparency". 
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3.10.6.5 [V6.2] Windows Style
The attribute "[V6.2] Windows Style" defines whether the object will be shown in Windows style 
by WinCC version 6.2. It can only be selected if "WinCC Classic" is chosen as the current 
design. 

yes Shows the object using the Windows style from WinCC version 6.2. 
no Shows the object not using the Windows style from WinCC version 6.2.

The "[V6.2] Windows style" attribute can be made dynamic with the name "WindowsStyle". 

3.10.6.6 WinCC style
The attribute "WinCC Style" defines the style in which the object will be displayed. 

User-defined Shows the object according to the respective settings. 
Global Shows the object in a globally defined design. 
Windows Style Shows the object in Windows style. 

The attribute "WinCC Style" can be made dynamic with the name "WinCCStyle". 

3.10.7 "Colors" Property Group

3.10.7.1 Colors - 3D to H

3D Border Color Top (BorderColorTop)
The "3D Border Color Top" attribute defines the color for the left and upper part of a 3D border.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "3D Border Color Top" attribute can be made dynamic with the name "BorderColorTop".

3D Border Color Bottom (BorderColorBottom)
The "3D Shadow Color" attribute defines the color for the right and lower part of a 3D border.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "3D Shadow Color" attribute can be made dynamic with the name "BorderColorBottom".

List Background Color (UnselBGColor)
The "List Background Color" attribute defines for the "Text list" object the color with which the 
entries not selected in the selection list of the background are displayed.
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Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "List Background Color" attribute can be made dynamic with the name "UnselBGColor".

List Font Color (UnselTextColor)
The "List Font Color" attribute defines for the "Text list" object the color with which the text not 
selected in the selection list of the background is displayed.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "List Font Color" attribute can be made dynamic with the name "UnselTextColor".

Bar Color (BackColor2)
The "Bar Color" attribute defines the color with which the current value is displayed for the 
"Bar" object.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Bar color" attribute can be made dynamic with the name "BackColor2".

Bar Background Color (BackColor3)
The "Bar Background Color" attribute defines the color with which the background of the bar 
is displayed for the "Bar" object.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Bar background color" attribute can be made dynamic with the name "BackColor3".

High Limit Color (HighLimitColor)
The "High Limit Color" attribute defines the color with which the upper or right arrow key is 
displayed for the "Slider object" object. The position of the slider is set using the "Alignment" 
attribute in the "Geometry" property group.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "High Limit Color" attribute can be made dynamic with the name "HighLimitColor".

Low Limit Color (LowLimitColor)
The "Low Limit Color" attribute defines the color with which the lower or left arrow key is 
displayed for the "Slider object" object. The position of the slider is set using the "Alignment" 
attribute in the "Geometry" property group.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 
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The "Low Limit Color" attribute can be made dynamic with the name "LowLimitColor".

Fill Pattern Color (FillColor)
The "Fill Pattern Color" attribute defines the color of the pattern that is displayed on the picture 
background.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The selected color is only effective if the "Global color scheme" is set to "No" under "Display". 

The "Fill Pattern Color" attribute can be made dynamic with the name "FillColor".

Fill Pattern Color (FillColor)
The "Fill Pattern Color" attribute defines the color of the pattern that is displayed on a filled 
area.

The "Fill Pattern Color" attribute can be made dynamic with the name "FillColor".

Background Flash Color (BackColor)
The "Background Flash Color" attribute defines the color used to display the background of 
the picture when flashing.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Background Flash Color" attribute can be made dynamic with the name "BackColor".

Background flashing fill color (OK, simulation) (BackFillColor)
The "Background flashing fill color (OK, simulation)" attribute defines the background color of 
the flashing picture.

Either define a permanent color directly in the "Color selection" dialog, or select an indexed 
color from the central color palette if a central color palette is defined. 

The "Background flashing fill color (OK, simulation)" attribute can be assigned dynamic 
properties by means of the name "BackFillColor".

Background flashing fill pattern (OK, simulation) (BackFillStyle)
The "Background flashing fill pattern (OK, simulation)" attribute defines the background pattern 
of the flashing picture.

There is a choice of 50 fill patterns. "Solid" fill pattern 0 fills the object with the set background 
color; "Transparent" fill pattern 1 disables the display of a background and of a fill pattern. 

The "Background flashing fill pattern (OK, simulation)" attribute can be assigned dynamic 
properties by means of the name "BackFillColor".
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Background Color (BackColor)
The "Background Color" attribute defines the color used to display the background.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The selected color is only effective if the "Global color scheme" is set to "No" under "Display". 

The "Background Color" attribute can be made dynamic with the name "BackColor".

Background Color (BackColor)
The "Background Color" attribute defines the color used to display a filled area.

The "Background Color" attribute can be made dynamic with the name "BackColor".

Background Color (OK) (BackColor_OK)
The "Background Color (OK)" attribute defines the color used to display the background with 
the status "OK".

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Background Color (OK)" attribute can be made dynamic with the name "BackColor_OK".

Background Color (Simulation) (BackColor_Simulation)
The "Background Color (Simulation)" attribute defines the color used to display the background 
with the status "Simulation".

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Background Color (Simulation)" attribute can be made dynamic with the name 
"BackColor_Simulation".

Background fill color (OK) (BackColor_OK)
The "Background fill color (OK)" attribute defines the background color used to indicate the 
"OK" state.

Either define a permanent color directly in the "Color selection" dialog, or select an indexed 
color from the central color palette if a central color palette is defined. 

The "Background fill color (OK)" attribute can be assigned dynamic properties by means of 
the name "BackFillColor_OK".

Background fill color (simulation) (BackColor_Simulation)
The "Background fill color (simulation)" attribute defines the background color used to indicate 
the active "Simulation" state.

Either define a permanent color directly in the "Color selection" dialog, or select an indexed 
color from the central color palette if a central color palette is defined. 
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The "Background fill color (simulation)" attribute can be assigned dynamic properties by means 
of the name "BackFillColor_Simulation".

Background fill pattern (OK) (BackColor_OK)
The "Background fill pattern (OK)" attribute defines the background pattern used to indicate 
the "OK" state.

There is a choice of 50 fill patterns. "Solid" fill pattern 0 fills the object with the set background 
color; "Transparent" fill pattern 1 disables the display of a background and of a fill pattern. 

The "Background fill pattern (OK)" attribute can be assigned dynamic properties by means of 
the name "BackFillStyle_OK".

Background fill pattern (simulation) (BackColor_Simulation)
The "Background fill pattern (simulation)" attribute defines the background pattern used to 
indicate the "Simulation" state.

There is a choice of 50 fill patterns. "Solid" fill pattern 0 fills the object with the set background 
color; "Transparent" fill pattern 1 disables the display of a background and of a fill pattern. 

The "Background fill pattern (simulation)" attribute can be assigned dynamic properties by 
means of the name "BackFillStyle_Simulation".

3.10.7.2 Colors - I to R

Button Color (ButtonColor)
The "Button Color" attribute defines the color of a "Slider object" object.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Button Color" attribute can be made dynamic with the name "ButtonColor".

Line Color (BorderColor)
The "Line Color" attribute defines the color for representation of a line.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Line Color" attribute can be made dynamic with the name "BorderColor".

Line Background Color (BorderBackColor)
The "Line Background Color" attribute defines the color used to display the background of a 
broken line. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 
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In Design WinCC Classic, the background color is only visible with a line weight of "1". With 
line weight of "2" or greater, the intermediate areas are shown as being transparent. 

The "Line Background Color" attribute can be made dynamic with the name "BorderBackColor".

High Limit Background Color (BackColorTop)
The "High Limit Background Color" attribute defines the color with which the upper or right 
area of the slide surface is displayed for the "Slider object" object. The range depends on the 
"Alignment" attribute in the "Geometry" property group. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "High Limit Background Color" attribute can be made dynamic with the name 
"BackColorTop".

Border Color (BorderColor)
The "Border Color" attribute defines the color for representation of a border line.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Border Color" attribute can be made dynamic with the name "BorderColor".

Border Background Color (BorderBackColor)
The "Border Background Color" attribute defines the color used to display the background of 
a broken border line.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Border Background Color" attribute can be made dynamic with the name 
"BorderBackColor".

Grid Color
The "Grid Color" attribute defines the color used to display the grid in the workspace of the 
current picture.

The grid is a utility of the Graphics Designer which makes it easier to position objects in a 
process picture precisely. The grid lines of the grid are symbolized by display of the intersection 
points. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Grid Color" attribute cannot be made dynamic.

Grid Color with Quality Code: "bad" (PaintColor_QualityCodeBad)
The "Grid Color with Quality Code: "bad"" attribute defines the color that the grid will be shown 
in when a poor status exists, e.g. if the connection to the server is broken. 
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Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Grid Color with Quality Code: "bad"" attribute can be made dynamic with the name 
"PaintColor_QualityCodeBad".

Grid Color with Quality Code: "uncertain" (PaintColor_QualityCodeUnCertain)
The "Grid Color with Quality Code: "uncertain"" attribute defines the color that indicates that 
the grid in an uncertain status. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Grid Color with Quality Code: "uncertain"" attribute can be made dynamic with the name 
"PaintColor_QualityCodeUnCertain".

3.10.7.3 Colors - S to Z

Font Flash Color (ForeColor)
The "Font Flash Color" attribute defines the color of a text when flashing. The flashing is only 
visible in Runtime.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Flashing Text Color Off" attribute can be made dynamic with the name "ForeColor".

Font Color (ForeColor)
The "Font Color" attribute defines the color of the text in the object.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The selected color is only effective if the "Global color scheme" is set to "No" under "Display". 

The "Font Color" attribute can be made dynamic with the name "ForeColor".

Font Color (OK) (ForeColor_OK)
The "Font Color (OK)" attribute defines the color in which the foreground is displayed with the 
status "OK".

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Font Color (OK)" attribute can be made dynamic with the name "ForeColor_OK".

Font Color (Simulation) (ForeColor_Simulation)
The "Font Color (Simulation)" attribute defines the color in which the foreground is displayed 
with the status "Simulation".
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Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Font Color (Simulation)" attribute can be made dynamic with the name 
"ForeColor_Simulation".

Selection Background Color (SelBGColor)
The "Selection Background Color" attribute defines for the "Text list" object the color with which 
the background of the entry selected in the selection list is displayed.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Selection Background Color" attribute can be made dynamic with the name "SelBGColor".

Selection Font Color (SelTextColor)
The "Selection Font Color" attribute defines for the "Text list" object the color with which the 
text selected in the selection list of the background is displayed.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Selection Font Color" attribute can be made dynamic with the name "SelTextColor".

Scale Color (ScaleColor)
The "Scale Color" attribute defines the color with which the scale and the label are displayed 
for the "Bar" object.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Scale Color" attribute can be made dynamic with the name "ScaleColor".

Trend Color (TrendColor)
The "Trend Color" attribute defines the color with which the trend display is shown for the "Bar" 
object. The trend display shows the tendency of the measured value in the form of a small 
arrow at the lower end of the bar.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Trend Color" attribute can be made dynamic with the name "TrendColor".

Dividing Line Color (ItemBorderColor)
The "Dividing Line Color" attribute defines the color with which the dividing line in the selection 
list is displayed for the "Text list" object.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 
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The "Dividing Line Color" attribute can be made dynamic with the name "ItemBorderColor".

Dividing Line Background Color (ItemBorderBackColor)
The "Dividing Line Background Color" attribute defines for the "Text list" object the color with 
which the background of a broken line in the selection list is displayed.

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Dividing Line Background Color" attribute can be made dynamic with the name 
"ItemBorderBackColor".

Low Limit Background Color (BackColorBottom)
The "Low Limit Background Color" attribute defines the color with which the lower or left area 
of the slide surface is displayed for the "Slider object" object. The range depends on the 
"Alignment" attribute in the "Geometry" property group. 

Either permanently define the color in the "Color selection" dialog or select an indexed color 
from the central color palette if a central color palette is defined. 

The "Low Limit Background Color" attribute can be made dynamic with the name 
"BackColorBottom".

3.10.8 "Filling" Property Group

3.10.8.1 Dynamic Filling (Filling)
The "Dynamic Filling" attribute specifies whether an object with a closed border line can be 
filled.

Yes The object can be filled.
No The object cannot be filled.

The "Dynamic Filling" attribute can be made dynamic with the name "Filling".

3.10.8.2 Fill Level (FillingIndex)
The "Fill Level" attribute specifies the height up to which an object is filled. The value is entered 
as a percentage, in relation to the object height.

The fill level is displayed according to the value of the "Background Color" attribute in the 
"Colors" property group. The non-filled background is displayed as "transparent".

0% - 100% The value can be chosen freely within the specified limits.

The "Fill Level" attribute can be made dynamic with the name "FillingIndex".

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  711



3.10.9 "Geometry" Property Group

3.10.9.1 Geometry - A to B

Current Value X (ActualPointLeft)
The "Current Value X" attribute specifies the horizontal position of the currently selected corner. 
The value stands in relation to the picture origin and specifies in pixels the distance of the 
corner from the left picture border.

The currently selected corner is uniquely determined by the "Index" attribute. In order to display 
the current value X of another corner, the value of the "Index" attribute must be modified.

There is a free choice of value. A meaningful limit results from the picture size.

The "Current Value X" attribute can be made dynamic with the name "ActualPointLeft".

Current Value Y (ActualPointTop)
The "Current Value Y" attribute specifies the vertical position of the currently selected corner. 
The value stands in relation to the picture origin and specifies in pixels the distance of the 
corner from the top picture border.

The currently selected corner is uniquely determined by the "Index" attribute. In order to display 
the current value Y of another corner, the value of the "Index" attribute must be modified.

There is a free choice of value. A meaningful limit results from the picture size.

The "Current Value Y" attribute can be made dynamic with the name "ActualPointTop".

Alpha (AngleAlpha)
The "Alpha" attribute specifies the depth angle Alpha for the 3D display of the right side of a 
3D bar. The values are specified in degrees.

0° - 90° There is a free choice of value for the depth angle Alpha within the specified 
limits.

The "Alpha" attribute can be made dynamic with the name "AngleAlpha".

Start Angle (StartAngle)
For segment or arc objects, the "Start Angle" attribute specifies the angle by which the starting 
point of the object deviates from the zero position (0°). The values are specified in degrees.

The start angle can be chosen freely. A meaningful limit results from the definition of a circle.

The "Start Angle" attribute can be made dynamic with the name "StartAngle".
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Number of Corners (PointCount)
The "Number of Corners" specifies the total number of corners for the selected object. The 
minimum number of three corners is given.

Changing the "Number of Corners" attribute has the following effects:

Increasing the number: All new corners are placed on the corner with the highest value for the 
"Index" attribute. The exact position can be set by dragging with the mouse or changing the 
individual position values.

Reducing the number: All corners are removed for which the value of the "Index" attribute is 
higher than the new number of corners.

There is a free choice of value. The minimum number of corners is 3.

The "Number of Corners" attribute cannot be made dynamic.

Number of Boxes (BoxCount)
The "Number of Boxes" specifies the total number of boxes for the selected object. For each 
object, a maximum number of 32 boxes can be set.

At the same time, the value of the "Number of Boxes" attribute specifies the upper limit value 
for the "Index" attribute in the "Font" property group. Changing the value can have the following 
effects:

● Increasing the number: New fields are inserted under the field with the highest value in the 
"Index" attribute. The standard labeling of the new box can be changed using the "Text" 
attribute in the "Font" property group.

● Reducing the number: All fields are removed for which the value of the "Index" attribute is 
higher than the new number.

1 - 32 There is a free choice of value within the specified value range.

The "Number of Boxes" attribute can be made dynamic with the name "BoxCount".

Number of rows
The "Number of rows" attribute defines the number of text lines for a combination field and a 
list field. You can define a maximum of 100,000 lines. 

At the same time, the value of the "Number of rows" attribute specifies the upper limit value 
for the "Index" attribute in the "Font" property group. Changing the value can have the following 
effects: 

● Increasing the number: New lines are added at the bottom. The standard labeling of the 
new filed can be changed using the "Text" attribute in the "Font" property group.

● Reducing the number: All lines are removed for which the value of the "Index" attribute is 
higher than the new number.

1 - 100 000 There is a free choice of value within the specified value range.

The attribute can be made dynamic with the name "NumberLines". 

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  713



Alignment (Direction)
The "Alignment" attribute defines for the "Slider" object whether the movement of the slider is 
in a horizontal or vertical direction.

Horizontal The movement of the slider is in horizontal direction.
Vertical The movement of the slider is in vertical direction.

The "Alignment" attribute can be made dynamic with the name "Direction".

Bar Width (BarWidth)
The "Bar Width" attribute defines for 3D bars the distance between the vertical limitation lines 
of the front bar area. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the object size.

= 0 The representation of the 3D bar is reduced to a vertical line.

The "Bar Width" attribute can be made dynamic with the name "BarWidth".

Bar Height (BarHeight)
The "Bar Height" attribute defines for 3D bars the distance between the horizontal limitation 
lines of the front bar area. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the object size.

= 0 The representation of the 3D bar is reduced to a horizontal line.

The "Bar Height" attribute can be made dynamic with the name "BarHeight".

Bar Direction (Direction)
The "Bar Direction" attribute specifies for the "Bar" object the direction of the coordinate axis 
in which the highest display value of the bar points.

Up The highest display value of the bar points upwards.
Down The highest display value of the bar points downwards (negative direction).
Left The highest display value of the bar points to the left (negative direction).
Right The highest display value of the bar points to the right.

The "Bar Direction" attribute can be made dynamic with the name "Direction".
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Bar Direction (Direction)
The "Bar Direction" attribute specifies for the "3D bar" object whether the highest display value 
of the bar points in the positive or negative direction of the coordinate axis. The position of the 
3D bar in the coordinate system is specified using the "Display Axis" attribute.

Positive The highest display value of the 3D bar points towards the positive coordinate 
axis.

Negative The highest display value of the 3D bar points towards the negative 
coordinate axis.

The "Bar Direction" attribute can be made dynamic with the name "Direction".

Bar Depth (BarDepth)
The "Bar Depth" attribute defines for the 3D bar the length of the oblique lines for the depth 
display. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the object size.

= 0 The representation of the 3D bar appears in two dimensions.

The "Bar Depth" attribute can be made dynamic with the name "BarDepth".

Base X (BaseX)
The "Base X" attribute defines for the 3D bar the distance between the left object border and 
the right limitation line of the front bar area. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the object size.

The "Base X" attribute can be made dynamic with the name "BaseX".

Base Y (BaseY)
The "Base Y" attribute defines for the 3D bar the distance between the top object border and 
the bottom limitation line of the front bar area. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the object size.

The "Base Y" attribute can be made dynamic with the name "BaseY".

Beta (AngleBeta)
The "Beta" attribute specifies the depth angle Beta for the 3D display of the left side of a 3D 
bar. The values are specified in degrees.

0° - 90° There is a free choice of value for the depth angle Beta within the specified 
limits.

The "Start Angle" attribute can be made dynamic with the name "AngleBeta".
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Picture Width (Width)
The "Picture Width" attribute defines the width of a process picture. The default value 
corresponds to the vertical component of the current screen resolution and is specified in pixels.

If the value for the picture width exceeds the screen resolution, scroll bars appear in Runtime 
to enable movement of the picture.

1 - 10000 pixels The value can be chosen freely within the specified limits. A meaningful 
limit results from the screen resolution.

The "Picture Width" attribute can be made dynamic with the name "Width".

Picture Height (Height)
The "Picture Height" attribute defines the height of a process picture. The default value 
corresponds to the horizontal component of the current screen resolution and is specified in 
pixels.

If the value for the picture height exceeds the screen resolution, scroll bars appear in Runtime 
to enable movement of the picture.

1 - 10000 pixels The value can be chosen freely within the specified limits. A meaningful 
limit results from the screen resolution.

The "Picture Height" attribute can be made dynamic with the name "Height".

Width (Width)
The "Width" attribute defines the horizontal distance between the left and right limitation line 
of an object. The values are specified in pixels.

In the case of the objects "Group Display", "Button" and "Round Button", changing the object 
size can make it necessary to adapt the "3D Border Width" attribute in the "Styles" property 
group.

0 - 10000 The value can be chosen freely within the specified limits.

The "Width" attribute can be made dynamic with the name "Width".

With the object "Connector", the attribute "Width" cannot be made dynamic.

Button 1 Width (Button1Width)
The "Button 1 Width" attribute defines for the "Group Display" object the width of the first button 
from the left. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 1 Width" attribute can be made dynamic with the name "Button1Width".
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Button 2 Width (Button2Width)
The "Button 2 Width" attribute defines for the "Group Display" object the width of the second 
button from the left. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 2 Width" attribute can be made dynamic with the name "Button2Width".

Button 3 Width (Button3Width)
The "Button 3 Width" attribute defines for the "Group Display" object the width of the third 
button from the left. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 3 Width" attribute can be made dynamic with the name "Button3Width".

Button 4 Width (Button4Width)
The "Button 4 Width" attribute defines for the "Group Display" object the width of the fourth 
button from the left. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 4 Width" attribute can be made dynamic with the name "Button4Width".

Button 5 Width (Button5Width)
The "Button 5 Width" attribute defines the width of the fifth button from the left for the "Group 
Display" object. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 5 Width" attribute can be made dynamic with the name "Button5Width".

Button 6 Width (Button6Width)
The "Button 6 Width" attribute defines the width of the sixth button from the left for the "Group 
Display" object. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".
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The "Button 6 Width" attribute can be made dynamic with the name "Button6Width".

Button 7 Width (Button7Width)
The "Button 7 Width" attribute defines the width of the seventh button from the left for the 
"Group Display" object. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 7 Width" can be made dynamic with the name "Button7Width".

Button 8 Width (Button8Width)
The "Button 8 Width" attribute defines the width of the eighth button from the left for the "Group 
Display" object. The values are specified in pixels.

There is a free choice of value. If the button should not be visible, set the width to "0".

Different values for the buttons are only displayed if the "Same Size" attribute has the value 
"No".

The "Button 8 Width" attribute can be made dynamic with the name "Button8Width".

3.10.9.2 Geometry - C to Z

Display Axis (Axe)
The "Display Axis" attribute defines the position of the 3D bar in the coordinate system.

X axis The representation of the 3D bar takes place on the X axis.
Y axis The representation of the 3D bar takes place on the Y axis.
Z axis The representation of the 3D bar takes place on the Z axis.

The "Display Axis" attribute can be made dynamic with the name "Axe".

Corner radius (CornerRadius)
The "Corner radius" attribute defines the rounding radius of the rectangles which enclose 
objects in the extended analog display. The values are defined in pixels.

The range of values which can be displayed for the corner radius depends on the values set 
for the "height" and "width" attributes. The maximum corner radius value which can be 
displayed is equivalent to 50% of the lower one of the "height" or "width" values. The maximum 
value is used if higher values are entered. 

The "Corner Radius" attribute can be assigned dynamic properties by means of the name 
"CornerRadius".
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Corner Radius X (RoundCornerHeight)
The "Corner Radius X" attribute defines for a rounded rectangle the horizontal distance 
between the corner of the rectangle around the object and the starting point of a rounded 
corner. The value is specified as a percentage of half the object width.

If the "Corner Radius X" and "Corner Radius Y" attributes are both set to the value 100%, the 
rounded rectangle is displayed as an ellipse or circle. The rectangle is shown without rounded 
corners when either one of the two attributes is set to 0%.

0% - 100% The value can be chosen freely within the specified limits.
0 No rounded corners; the rounded rectangle has the appearance of a normal 

rectangle.
100 The Corner Radius X corresponds to half the width of the rounded rectangle.

The start point of the curved section is located at the vertical center line of 
the object. Both horizontal limitation lines are displayed as arcs.

The "Corner Radius X" attribute can be made dynamic with the name "RoundCornerHeight".

Corner Radius Y (RoundCornerWidth)
The "Corner Radius Y" attribute defines for a rounded rectangle the vertical distance between 
the corner of the rectangle around the object and the starting point of a rounded corner. The 
value is specified as a percentage of half the object height.

If the "Corner Radius X" and "Corner Radius Y" attributes are both set to the value 100%, the 
rounded rectangle is displayed as an ellipse or circle. The rectangle is shown without rounded 
corners when either one of the two attributes is set to 0%.

0% - 100% The value can be chosen freely within the specified limits.
0 No rounded corners; the rounded rectangle has the appearance of a normal 

rectangle.
100 The Corner Radius Y corresponds to half the height of the rounded 

rectangle.         
 The start point of the curved section is located at the vertical center line of 
the object. Both vertical limitation lines are displayed as arcs.

The "Corner Radius Y" attribute can be made dynamic with the name "RoundCornerWidth".

End Angle (EndAngle)
For segment or arc objects, the "End Angle" attribute specifies the angle by which the end 
point of the object deviates from the zero position (0°). The values are specified in degrees.

There is a free choice of value. A meaningful limit results from the definition of a circle.

The "End Angle" attribute can be made dynamic with the name "EndAngle".
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Window Width (Width)
The "Window Width" attribute defines the horizontal distance between the left and right 
limitation line of an object. The values are specified in pixels.

0 - 10000 The value can be chosen freely within the specified limits.

The "Window Width" attribute can be made dynamic with the name "Width".

Window Height (Height)
The "Window Height" attribute defines the vertical distance between the top and bottom 
limitation line of an object. The values are specified in pixels.

0 - 10000 The value can be chosen freely within the specified limits.

The "Window Height" attribute can be made dynamic with the name "Height".

Same Size (SameSize)
The "Same Size" attribute defines whether the buttons of a group display will have the same 
width or whether the widths can be defined individually for each button.

Yes All buttons that have the "Button ... Width" attribute defined as unequal to "0" will 
be set to the same size within the overall width of the "Group Display" object. 
Changing the overall width of the object changes the width of the all buttons that 
have a width unequal to 0.

No The width of the buttons can be defined individually using the "Button ... Width" 
attributes.

The "Same Size" attribute can be made dynamic with the name "SameSize".

Height (Height)
The "Height" attribute defines the vertical distance between the top and bottom limitation line 
of an object. The values are specified in pixels.

In the case of the objects "Group Display", "Button" and "Round Button", changing the object 
size can make it necessary to adapt the "3D Border Width" attribute in the "Styles" property 
group.

0 - 10000 The value can be chosen freely within the specified limits.

The "Height" attribute can be made dynamic with the name "Height".

With the object "Connector", the attribute "Height"

Index (Index)
The "Index" attribute indicates the item number of the currently selected corner. Changing the 
value specified here enables targeted selection of a corner.
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Changing the "Index" attribute also changes the displayed value of the "Current Value X" and 
"Current Value Y" attributes. The display of these three attributes only applies to the currently 
selected corner in each case.

1 - "Number of Corners" The value can be chosen freely within 
the specified limits.

The "Index" attribute can be made dynamic with the name "Index".

Position X (Left)
The "Position X" attribute defines the horizontal distance of the object origin from the left picture 
border. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the picture size.

The "Position X" attribute can be made dynamic with the name "Left".

With the object "Connector", the value can only be changed with unlinked ends.

Position Y (Top)
The "Position Y" attribute defines the vertical distance of the object origin from the top picture 
border. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the picture size.

The "Position Y" attribute can be made dynamic with the name "Top".

With the object "Connector", the value can only be changed with unlinked ends.

Radius (Radius)
The "Radius" attribute defines the radius of circular objects. The values are specified in pixels.

0 - 5000 The value can be chosen freely within the specified limits.

The "Radius" attribute can be made dynamic with the name "Radius".

Radius X (RadiusWidth)
The "Radius X" attribute defines the horizontal radius of elliptical objects. The values are 
specified in pixels.

0 - 5000 The value can be chosen freely within the specified limits.

The "Radius X" attribute can be made dynamic with the name "RadiusWidth".
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Radius Y (RadiusHeight)
The "Radius Y" attribute defines the vertical radius of elliptical objects. The values are specified 
in pixels.

0 - 5000 The value can be chosen freely within the specified limits.

The "Radius Y" attribute can be made dynamic with the name "RadiusHeight".

Grid On
The "Grid On" attribute specifies whether a grid is shown in the workspace of the current picture.

The grid is a utility of the Graphics Designer which makes it easier to position objects in a 
process picture precisely. The grid lines of the grid are symbolized by display of the intersection 
points.

If the additional option "Snap to Grid" is enabled, all objects are automatically aligned

Grid Height
The "Grid Height" attribute is used to specify the vertical distance for the grid lines of the grid. 
The value is specified in pixels.

The grid is a utility of the Graphics Designer which makes it easier to position objects in a 
process picture precisely. The grid lines of the grid are symbolized by display of the intersection 
points.

The minimum grid height that can be displayed on the screen is 10 pixels. A low value can be 
specified, but only the intersection points with a spacing of at least 10 pixels are displayed on 
the screen.

With a grid height of 4 pixels, only each third intersection is displayed. The objects can however 
also be aligned to the two grid lines between them.

Grid Width
The "Grid Width" attribute is used to specify the horizontal distance for the grid lines of the The 
value is specified in pixels.

The grid is a utility of the Graphics Designer which makes it easier to position objects in a 
process picture precisely. The grid lines of the grid are symbolized by display of the intersection 
points.

The minimum grid width that can be displayed on the screen is 10 pixels. A low value can be 
specified, but only the intersection points with a spacing of at least 10 pixels are displayed on 
the screen.

With a grid width of 4 pixels, only each third intersection is displayed. The objects can however 
also be aligned to the two grid lines between them.

Rotation Reference X (ReferenceRotationLeft)
The "Rotation Reference X" attribute defines the horizontal coordinates of the reference point 
around which the object rotates in Runtime. The value describes the horizontal distance 
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between the reference point and the origin of the object. The value is indicated in percentages, 
whereby the object width corresponds to 100%.

The reference point value can be outside the selection rectangle. This means that both 
negative values and values higher than 100% are possible.

The rotation of an object is visible only in Runtime. The direction of rotation depends on the 
value of the "Rotation Angle" attribute.

There is a free choice of value. Both negative values and values greater than 100% are 
permitted.

Example:

-100% The reference point lies to the left of the object origin (distance = one object 
width).

0% The vertical coordinates of the reference point and object origin are the same.
50% The reference point lies on the vertical center axis of the object.
100% The reference point lies to the right of the object origin (distance = one object 

width).
200% The reference point lies to the right of the object origin (distance = two object 

widths).

The "Rotation Reference X" attribute can be made dynamic with the name 
"ReferenceRotationLeft".

Rotation Reference Y (ReferenceRotationTop)
The "Rotation Reference Y" attribute defines the vertical coordinates of the reference point 
around which the object rotates in Runtime. The value describes the vertical distance between 
the reference point and the origin of the object. The value is indicated in percentages, whereby 
the object width corresponds to 100%.

The reference point value can be outside the selection rectangle. This means that both 
negative values and values higher than 100% are possible.

The rotation of an object is visible only in Runtime. The direction of rotation depends on the 
value of the "Rotation Angle" attribute.

There is a free choice of value. Both negative values and values greater than 100% are 
permitted.

Example:

-100% The reference point lies above the object origin (distance = one object width).
0% The horizontal coordinates of the reference point and object origin are the 

same.
50% The reference point lies on the horizontal center axis of the object.
100% The reference point lies below the object origin (distance = one object width).
200% The reference point lies below the object origin (distance = two object widths).

The "Rotation Reference Y" attribute can be made dynamic with the name 
"ReferenceRotationTop".
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Rotation Angle (RotationAngle)
The "Rotation Angle" attribute defines the rotation of an object around a reference point. The 
value of the rotation angle is specified in degrees; the starting value corresponds to a value of 
0°.

The position of the object deviates from its configured start position by the value of the "Rotation 
Angle" attribute. The changed orientation of the object is only visible in Runtime.

The coordinates of the reference point are defined with the "Rotation Reference X" and 
"Rotation Reference Y" attributes. 

-360° - 360° The value can be chosen freely within the specified limits.
< 0° The object is rotated counterclockwise. 
= 0° The object is not rotated (display of the configured start position).
> 0° The object is rotated clockwise. 

The "Rotation Angle" attribute can be made dynamic with the name "RotationAngle".

Rotation Angle (RotationAngle)
The "Rotation Angle" attribute defines the orientation of a T-piece. The attribute can have one 
of four values that are specified in degrees. 

The orientation is produced by rotating the T-piece clockwise around the center point by the 
specified number of degrees. 

If you enter another value, it is automatically converted to modulus 360 and rounded up or 
down to the closest permissible value. 

0 The standard position of the T-piece is the shape of the letter "T" 
90 The "leg" of the "T" points towards the left 
180 The "leg" of the "T" points upwards
270 The "leg" of the "T" points to the right

The "Rotation Angle" attribute can be made dynamic with the name "RotationAngle". 

Angle Settings (PredefinedAngles)
The "Angle Settings" attribute offers three predefined variants for the depth display of a 3D 
bar. A fourth variant enables free setting of the two depth angles Alpha and Beta.

If the "Angle Settings" attribute is changed, the "Alpha" and "Beta" attributes receive predefined 
values.

Cavalier Depth display with the values: Alpha = 45° and Beta = 0°
Isonometric Depth display with the values: Alpha = Beta = 45°
Axionometric Depth display with the values: Alpha = 10° and Beta = 42°
Freely Defined There is a free choice of values for Alpha and Beta.
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3.10.10 "Limits" Property Group

3.10.10.1 Limits - A

Type AH (TypeAlarmHigh)
The "Type AH" attribute specifies for the "Bar" object whether the value of the Limit AH is 
displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are shown on the side of the bar opposite the scale.

Absolute The value of limit AH is accepted as an absolute value in the representation 
of the bar.

% The value of limit AH is displayed as a percentage value, starting from the 
zero point of the bar display.

The "Type AH" attribute can be made dynamic with the name "TypeAlarmHigh".

Type AL (TypeAlarmLow)
The "Type AL" attribute specifies for the "Bar" object whether the value of the Alarm Low Limit 
AL is displayed as an absolute value or as a percentage value, starting from the zero point of 
the bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.
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The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are shown on the side of the bar opposite the scale.

Absolute The value of Alarm Low Limit AL is accepted as an absolute value in the 
representation of the bar.

% The value of Alarm Low Limit AL is displayed as a percentage value, starting 
from the zero point of the bar display.

The "Type AL" attribute can be made dynamic with the name "TypeAlarmLow".

Type RH4 (TypeLimitHigh4)
The "Type RH4" attribute specifies for the "Bar" object whether the value of the High Limit RH4 
is displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are shown on the side of the bar opposite the scale.

Absolute The value of High Limit RH4 is accepted as an absolute value in the 
representation of the bar.

% The value of High Limit RH4 is displayed as a percentage value, starting from 
the zero point of the bar display.

The "Type RH4" attribute can be made dynamic with the name "TypeLimitHigh4".

Type RH5 (TypeLimitHigh5)
The "Type RH5" attribute specifies for the "Bar" object whether the value of the High Limit RH5 
is displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:
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The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are shown on the side of the bar opposite the scale.

Absolute The value of High Limit RH5 is accepted as an absolute value in the 
representation of the bar.

% The value of High Limit RH5 is displayed as a percentage value, starting from 
the zero point of the bar display.

The "Type RH5" attribute can be made dynamic with the name "TypeLimitHigh5".

Type RL4 (TypeLimitLow4)
The "Type RL4" attribute specifies for the "Bar" object whether the value of the Low Limit RL4 
is displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Absolute The value of Low Limit RL4 is accepted as an absolute value in the 
representation of the bar.

% The value of Low Limit RL4 is displayed as a percentage value, starting from 
the zero point of the bar display.

The "Type RL4" attribute can be made dynamic with the name "TypeLimitLow4".
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Type RL5 (TypeLimitLow5)
The "Type RL5" attribute specifies for the "Bar" object whether the value of the Low Limit RL5 
is displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Absolute The value of Low Limit RL5 is accepted as an absolute value in the 
representation of the bar.

% The value of Low Limit RL5 is displayed as a percentage value, starting from 
the zero point of the bar display.

The "Type RL5" attribute can be made dynamic with the name "TypeLimitLow5".

Type TH (TypeToleranceHigh)
The "Type TH" attribute specifies for the "Bar" object whether the value of the Limit TH is 
displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.
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Absolute The value of limit TH is accepted as an absolute value in the representation 
of the bar.

% The value of limit TH is displayed as a percentage value, starting from the 
zero point of the bar display.

The "Type TH" attribute can be made dynamic with the name "TypeToleranceHigh".

Type TL (TypeToleranceLow)
The "Type TL" attribute specifies for the "Bar" object whether the value of the Limit TL is 
displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Absolute The value of limit TL is accepted as an absolute value in the representation 
of the bar.

% The value of limit TL is displayed as a percentage value, starting from the 
zero point of the bar display.

The "Type TL" attribute can be made dynamic with the name "TypeToleranceLow".

Type WH (TypeWarningHigh)
The "Type WH" attribute specifies for the "Bar" object whether the value of the Limit WH is 
displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  729



Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Absolute The value of limit WH is accepted as an absolute value in the representation 
of the bar.

% The value of limit WH is displayed as a percentage value, starting from the 
zero point of the bar display.

The "Type WH" attribute can be made dynamic with the name "TypeWarningHigh".

Type WL (TypeWarningLow)
The "Type WL" attribute specifies for the "Bar" object whether the value of the Limit WL is 
displayed as an absolute value or as a percentage value, starting from the zero point of the 
bar display.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Absolute The value of limit WL is accepted as an absolute value in the representation 
of the bar.

% The value of limit WL is displayed as a percentage value, starting from the 
zero point of the bar display.

The "Type WL" attribute can be made dynamic with the name "TypeWarningLow".

3.10.10.2 Limits - Bar color

Bar Color 0 (Layer00Color)
The "Bar Color 0" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 0" attribute.
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You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 0" attribute can be made dynamic with the name "Layer00Color".

Bar Color 1 (Layer01Color)
The "Bar Color 1" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 1" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 1" attribute can be made dynamic with the name "Layer01Color".

Bar Color 2 (Layer02Color)
The "Bar Color 2" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 2" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 2" attribute can be made dynamic with the name "Layer02Color".

Bar Color 3 (Layer03Color)
The "Bar Color 3" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 3" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.
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The "Bar Color 3" attribute can be made dynamic with the name "Layer03Color".

Bar Color 4 (Layer04Color)
The "Bar Color 4" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 4" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 4" attribute can be made dynamic with the name "Layer04Color".

Bar Color 5 (Layer05Color)
The "Bar Color 5" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 5" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 5" attribute can be made dynamic with the name "Layer05Color".

Bar Color 6 (Layer06Color)
The "Bar Color 6" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 6" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 6" attribute can be made dynamic with the name "Layer06Color".

Bar Color 7 (Layer07Color)
The "Bar Color 7" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 7" attribute.
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You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 7" attribute can be made dynamic with the name "Layer07Color".

Bar Color 8 (Layer08Color)
The "Bar Color 8" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 8" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 8" attribute can be made dynamic with the name "Layer08Color".

Bar Color 9 (Layer09Color)
The "Bar Color 9" attribute defines for the "3D bar" object the color for the representation of a 
display value that is lower than the value of the "Limit 9" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.

The "Bar Color 9" attribute can be made dynamic with the name "Layer09Color".

Bar Color 10 (Layer10Color)
The "Bar Color 10" attribute defines for the "3D bar" object the color for the representation of 
a display value that is lower than the value of the "Limit 10" attribute.

You can define up to 11 limit values for the "3D bar" object by means of the "Limit N" (N = 0 
to 10) attributes. For each limit value, the "Bar Color N" attributes can be used to specify a 
color change. This color setting is activated if the corresponding "Monitoring N" attribute has 
the value "Yes".

A display value is output in the Bar Color N as long as it is less than the value of Limit N. A 
black arrow at the ends of the bar display symbolizes display values that are less than Limit 0 
or greater than Limit 10.
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The "Bar Color 10" attribute can be made dynamic with the name "Layer10Color".

Bar Color AH (ColorAlarmHigh)
The "Bar Color AH" attribute defines for the "Bar" object the color for the representation of a 
display value that is higher than the value of the upper limit "Alarm High".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color AH" attribute can assogned dynamic properties by means of the name 
"ColorAlarmHigh".

Bar Color AL (ColorAlarmLow)
The "Bar Color AL" attribute defines for the "Bar" object the color for the representation of a 
display value that is lower than the value of the lower limit Alarm Low".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color AL" attribute can assogned dynamic properties by means of the name 
"ColorAlarmLow".
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Bar Color RH4 (ColorLimitHigh4)
The "Bar Color RH4" attribute defines for the "Bar" object the color for the representation of a 
display value that is higher than the value of the upper limit "Reserve High 4".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color RH4" attribute can assigned dynamic properties by means of the name 
"ColorAlarmHigh4".

Bar Color RH5 (ColorLimitHigh5)
The "Bar Color RH5" attribute defines for the "Bar" object the color for the representation of a 
display value that is higher than the value of the upper limit "Reserve High 5".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color RH5" attribute can assigned dynamic properties by means of the name 
"ColorAlarmHigh5".

Bar Color RL4 (ColorLimitLow4)
The "Bar Color RL4" attribute defines for the "Bar" object the color for the representation of a 
display value that is lower than the value of the lower limit "Reserve Low 4".
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For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color RL4" attribute can assigned dynamic properties by means of the name 
"ColorAlarmLow4".

Bar Color RL5 (ColorLimitLow5)
The "Bar Color RL5" attribute defines for the "Bar" object the color for the representation of a 
display value that is lower than the value of the lower limit "Reserve Low 5".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color RL5" attribute can assigned dynamic properties by means of the name 
"ColorLimitLow5".

Bar Color TH (ColorToleranceHigh)
The "Bar Color TH" attribute defines for the "Bar" object the color for the representation of a 
display value that is higher than the value of the upper limit "Tolerance High".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:
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The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color TH" attribute can assogned dynamic properties by means of the name 
"ColorToleranceHigh".

Bar Color TL (ColorToleranceLow)
The "Bar Color TL" attribute defines for the "Bar" object the color for the representation of a 
display value that is lower than the value of the lower limit "Tolerance Low".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color TL" attribute can be assigned dynamic properties by means of the name 
"ColorToleranceLow".

Bar Color WH (ColorWarningHigh)
The "Bar Color WH" attribute defines for the "Bar" object the color for the representation of a 
display value that is higher than the value of the upper limit "Warning High".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.
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The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color WH" attribute can be assigned dynamic properties by means of the name 
"ColorWarningHigh".

Bar Color WL (ColorWarningLow)
The "Bar Color WL" attribute defines for the "Bar" object the color for the representation of a 
display value that is lower than the value of the lower limit "Warning Low".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

The "Bar Color WL" attribute be assigned dynamic properties by means of  the name 
"ColorWarningLow".

3.10.10.3 Limits - Bar fill color

Bar fill color 0 (Layer00FillColor)
The "Layer00FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
0".

The "Layer00FillColor" attribute can be made dynamic with the name "Layer00FillColor".

Layer01FillColor
The "Layer01FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
1".
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The "Layer01FillColor" attribute can be made dynamic with the name "Layer01FillColor".

Layer02FillColor
The "Layer02FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
2".

The "Layer02FillColor" attribute can be made dynamic with the name "Layer02FillColor".

Layer03FillColor
The "Layer03FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
3".

The "Layer03FillColor" attribute can be made dynamic with the name "Layer03FillColor".

Layer04FillColor
The "Layer04FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
4".

The "Layer04FillColor" attribute can be made dynamic with the name "Layer04FillColor".

Layer05FillColor
The "Layer05FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
5".

The "Layer05FillColor" attribute can be made dynamic with the name "Layer05FillColor".

Layer06FillColor
The "Layer06FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
6".

The "Layer06FillColor" attribute can be made dynamic with the name "Layer06FillColor".

Layer07FillColor
The "Layer07FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
7".

The "Layer07FillColor" attribute can be made dynamic with the name "Layer07FillColor".

Layer08FillColor
The "Layer08FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
8".

The "Layer08FillColor" attribute can be made dynamic with the name "Layer08FillColor".
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Layer09FillColor
The "Layer09FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
9".

The "Layer09FillColor" attribute can be made dynamic with the name "Layer09FillColor".

Layer10FillColor
The "Layer10FillColor" attribute defines the color with which the bar is filled in relation to "Limit 
10".

The "Layer10FillColor" attribute can be made dynamic with the name "Layer10FillColor".

3.10.10.4 Limits - Bar fill style

Layer00FillStyle
The "Layer00FillStyle" attribute defines the style of the bar in relation to "Limit 0". For the fill 
pattern to become visible, "bar fill color 0" must differ from "bar color 0". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer00FillStyle" attribute can be made dynamic with the name "Layer00FillStyle".

Layer01FillStyle
The "Layer01FillStyle" attribute defines the style of the bar in relation to "Limit 1". For the fill 
pattern to become visible, "bar fill color 1" must differ from "bar color 1". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer01FillStyle" attribute can be made dynamic with the name "Layer01FillStyle".

Layer02FillStyle
The "Layer02FillStyle" attribute defines the style of the bar in relation to "Limit 2". For the fill 
pattern to become visible, "bar fill color 2" must differ from "bar color 2". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer02FillStyle" attribute can be made dynamic with the name "Layer02FillStyle".

Layer03FillStyle
The "Layer03FillStyle" attribute defines the style of the bar in relation to "Limit 3". For the fill 
pattern to become visible, "bar fill color 3" must differ from "bar color 3". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
740 System Manual, 11/2008,  



The "Layer03FillStyle" attribute can be made dynamic with the name "Layer03FillStyle".

Layer04FillStyle
The "Layer04FillStyle" attribute defines the style of the bar in relation to "Limit 4". For the fill 
pattern to become visible, "bar fill color 4" must differ from "bar color 4". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer04FillStyle" attribute can be made dynamic with the name "Layer04FillStyle".

Layer05FillStyle
The "Layer05FillStyle" attribute defines the style of the bar in relation to "Limit 5". For the fill 
pattern to become visible, "bar fill color 5" must differ from "bar color 5". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer05FillStyle" attribute can be made dynamic with the name "Layer05FillStyle".

Layer06FillStyle
The "Layer06FillStyle" attribute defines the style of the bar in relation to "Limit 6". For the fill 
pattern to become visible, "bar fill color 6" must differ from "bar color 6". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer06FillStyle" attribute can be made dynamic with the name "Layer06FillStyle".

Layer07FillStyle
The "Layer07FillStyle" attribute defines the style of the bar in relation to "Limit 7". For the fill 
pattern to become visible, "bar fill color 7" must differ from "bar color 7". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer07FillStyle" attribute can be made dynamic with the name "Layer07FillStyle".

Layer08FillStyle
The "Layer08FillStyle" attribute defines the style of the bar in relation to "Limit 8". For the fill 
pattern to become visible, "bar fill color 8" must differ from "bar color 8". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer08FillStyle" attribute can be made dynamic with the name "Layer08FillStyle".
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Layer09FillStyle
The "Layer09FillStyle" attribute defines the style of the bar in relation to "Limit 9". For the fill 
pattern to become visible, "bar fill color 9" must differ from "bar color 9". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer09FillStyle" attribute can be made dynamic with the name "Layer09FillStyle".

Layer10FillStyle
The "Layer10FillStyle" attribute defines the style of the bar in relation to "Limit 10". For the fill 
pattern to become visible, "bar fill color 10" must differ from "bar color 10". 

There is a choice of 50 fill styles. The 0 "Solid" fill style fills the object with the set background 
color. The 1 "Transparent" fill style means neither a background nor a fill pattern is displayed. 

The "Layer10FillStyle" attribute can be made dynamic with the name "Layer10FillStyle".

3.10.10.5 Limits - C to T

Limit 0 (Layer00Value)
The "Limit 0" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 0.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 0" attribute can be made dynamic with the name "Layer00Value".

Limit 1 (Layer01Value)
The "Limit 1" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 1.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.
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There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 1" attribute can be made dynamic with the name "Layer01Value".

Limit 2 (Layer02Value)
The "Limit 2" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 2.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 2" attribute can be made dynamic with the name "Layer02Value".

Limit 3 (Layer03Value)
The "Limit 3" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 3.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 3" attribute can be made dynamic with the name "Layer03Value".

Limit 4 (Layer04Value)
The "Limit 4" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 4.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.
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There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 4" attribute can be made dynamic with the name "Layer04Value".

Limit 5 (Layer05Value)
The "Limit 5" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 5.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 5" attribute can be made dynamic with the name "Layer05Value".

Limit 6 (Layer06Value)
The "Limit 6" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 6.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 6" attribute can be made dynamic with the name "Layer06Value".

Limit 7 (Layer07Value)
The "Limit 7" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 7.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.
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There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 7" attribute can be made dynamic with the name "Layer07Value".

Limit 8 (Layer08Value)
The "Limit 8" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 8.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 8" attribute can be made dynamic with the name "Layer08Value".

Limit 9 (Layer09Value)
The "Limit 9" attribute defines for the "3D bar" object the limit value up to which a display value 
is displayed with Bar Color 9.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 9" attribute can be made dynamic with the name "Layer09Value".

Limit 10 (Layer10Value)
The "Limit 10" attribute defines for the "3D bar" object the limit value up to which a display 
value is displayed with Bar Color 10.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the bar color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.
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There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "3D bar".

The "Limit 10" attribute can be made dynamic with the name "Layer10Value".

Limit Marker (Marker)
The "Limit Marker" attribute specifies for the "Bar" object whether the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Display elements The configured and monitored limits are marked by marking arrows.
Do Not Display The configured and monitored limits are not marked by marking arrows.

The "Limit Marker" attribute can be made dynamic with the name "Marker".

High Limit Value (LimitMax)
The "High Limit Value" attribute defines for the "I/O field" object the maximum limit value for 
input and output. The specified value depends on the "data format" of the I/O field.

If a value is higher than the upper limit value, the following effects are possible in Runtime:

Field type = "Input": The "WinCC Runtime" dialog is opened and displayed the error message 
"The entered value is outside the configured limits".         
 Confirm the error message with "OK" and enter another value.

Field type = "Output": The display of the value is substituted by the character string "***".

The "Data Format" and "Field Type" attributes can be changed in the "Output / Input" property 
group.

There is a free choice of value depending on the "data format" of the I/O field.

The "High Limit Value" attribute can be made dynamic with the name "LimitMax".

Limit AH (AlarmHigh)
The "Limit AH" attribute defines for the "Bar" object the upper limit value for the alarm limit 
"Alarm High". If the display value exceeds the value specified here, it is displayed in the Bar 
Color AH.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.
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The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Limit AH" attribute can be made dynamic with the name "AlarmHigh".

High Limit RH4 (LimitHigh4)
The "High Limit RH4" attribute defines for the "Bar" object the upper limit value for the limit 
"Reserve High 4". If the display value exceeds the value specified here, it is displayed in the 
Bar Color RH4.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "High Limit RH4" attribute can be made dynamic with the name "LimitHigh4".

High Limit RH5 (LimitHigh5)
The "High Limit RH5" attribute defines for the "Bar" object the upper limit value for the limit 
"Reserve High 5". If the display value exceeds the value specified here, it is displayed in the 
Bar Color RH5.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.
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The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "High Limit RH5" attribute can be made dynamic with the name "LimitHigh5".

Limit TH (ToleranceHigh)
The "Limit TH" attribute defines for the "Bar" object the upper limit value for the tolerance limit 
"Tolerance High". If the display value exceeds the value specified here, it is displayed in the 
Bar Color TH.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Limit TH" attribute can be made dynamic with the name "ToleranceHigh".

Limit WH (WarningHigh)
The "Limit WH" attribute defines for the "Bar" object the upper limit value for the warning limit 
"Warning High". If the display value exceeds the value specified here, it is displayed in the Bar 
Color WH.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.
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The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Limit WH" attribute can be made dynamic with the name "WarningHigh".

3.10.10.6 Limits - U to Z

Monitoring 0 (Layer00Checked)
For the "3D bar" object, the "Monitoring 0" attribute activates the monitoring of Limit 0.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 0 is monitored. The display value is displayed with bar color 0 until Limit 0 is 
exceeded.

No Limit 0 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 0" attribute can be made dynamic with the name "Layer00Checked".

Monitoring 1 (Layer01Checked)
For the "3D bar" object, the "Monitoring 1" attribute activates the monitoring of limit 1.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 1 is monitored. The display value is displayed with bar color 1 until Limit 1 is 
exceeded.

No Limit 1 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 1" attribute can be made dynamic with the name "Layer01Checked".
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Monitoring 2 (Layer02Checked)
For the "3D bar" object, the "Monitoring 2" attribute activates the monitoring of limit 2.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 2 is monitored. The display value is displayed with bar color 2 until Limit 2 is 
exceeded.

No Limit 2 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 2" attribute can be made dynamic with the name "Layer02Checked".

Monitoring 3 (Layer03Checked)
For the "3D bar" object, the "Monitoring 3" attribute activates the monitoring of limit 3.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 3 is monitored. The display value is displayed with bar color 3 until Limit 3 is 
exceeded.

No Limit 3 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 3" attribute can be made dynamic with the name "Layer03Checked".

Monitoring 4 (Layer04Checked)
For the "3D bar" object, the "Monitoring 4" attribute activates the monitoring of limit 4.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.
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Yes Limit 4 is monitored. The display value is displayed with bar color 4 until Limit 4 is 
exceeded.

No Limit 4 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 4" attribute can be made dynamic with the name "Layer04Checked".

Monitoring 5 (Layer05Checked)
For the "3D bar" object, the "Monitoring 5" attribute activates the monitoring of limit 5.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 5 is monitored. The display value is displayed with bar color 5 until Limit 5 is 
exceeded.

No Limit 5 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 5" attribute can be made dynamic with the name "Layer05Checked".

Monitoring 6 (Layer06Checked)
For the "3D bar" object, the "Monitoring 6" attribute activates the monitoring of limit 6.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 6 is monitored. The display value is displayed with bar color 6 until Limit 6 is 
exceeded.

No Limit 6 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 6" attribute can be made dynamic with the name "Layer06Checked".

Monitoring 7 (Layer07Checked)
For the "3D bar" object, the "Monitoring 7" attribute activates the monitoring of limit 7.

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  751



For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 7 is monitored. The display value is displayed with bar color 7 until Limit 7 is 
exceeded.

No Limit 7 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 7" attribute can be made dynamic with the name "Layer07Checked".

Monitoring 8 (Layer08Checked)
For the "3D bar" object, the "Monitoring 8" attribute activates the monitoring of limit 8.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 8 is monitored. The display value is displayed with bar color 8 until Limit 8 is 
exceeded.

No Limit 8 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 8" attribute can be made dynamic with the name "Layer08Checked".

Monitoring 9 (Layer09Checked)
For the "3D bar" object, the "Monitoring 9" attribute activates the monitoring of limit 9.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.
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Yes Limit 9 is monitored. The display value is displayed with bar color 9 until Limit 9 is 
exceeded.

No Limit 9 is not monitored. A color change only takes place when the next monitored 
limit is exceeded.

The "Monitoring 9" attribute can be made dynamic with the name "Layer09Checked".

Monitoring 10 (Layer10Checked)
For the "3D bar" object, the "Monitoring 10" attribute activates the monitoring of limit 10.

For the "3D bar" object, up to 11 limit values can be defined using the attributes "Limit N" (N 
= 0 to 10). For each limit value, the "Bar Color N" attributes can be used to specify a color 
change. If the corresponding attribute "Monitoring N" has the value "Yes", the color setting is 
activated.

A display value is displayed in the Bar Color N as long as it is lower than the value of the Limit 
N. A black arrow at the ends of the bar display symbolizes display values that are lower than 
Limit 0 or higher than Limit 10.

Yes Limit 10 is monitored. The display value is displayed with bar color 10 until Limit 
10 is exceeded.

No Limit 10 is not monitored. There is no color change.

The "Monitoring 10" attribute can be made dynamic with the name "Layer10Checked".

Monitoring AH (CheckAlarmHigh)
The "Monitoring AH" attribute defines for the "Bar" object the monitoring of the alarm limit 
"Alarm High".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit AH is monitored. The display value is displayed with the bar color AH as soon 
as it exceeds the Limit AH.

No Limit AH is not monitored. No color change takes place.
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The "Monitoring AH" attribute can be made dynamic with the name "CheckAlarmHigh".

Monitoring AL (CheckAlarmLow)
The "Monitoring AL" attribute defines for the "Bar" object the monitoring of the alarm limit "Alarm 
Low".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit AL is monitored. The display value is displayed with the bar color AL as soon 
as it falls below the Alarm Low Limit AL.

No Limit AL is not monitored. No color change takes place.

The "Monitoring AL" attribute can be made dynamic with the name "CheckAlarmLow".

Monitoring RH4 (CheckLimitHigh4)
The "Monitoring RH4" attribute defines for the "Bar" object the monitoring of the limit "Reserve 
High 4".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.
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Yes Limit RH4 is monitored. The display value is displayed with the bar color RH4 as 
soon as it exceeds the High Limit RH4.

No Limit RH4 is not monitored. A color change only takes place when the next 
monitored limit is exceeded.

The "Monitoring RH4" attribute can be made dynamic with the name "CheckLimitHigh4".

Monitoring RH5 (CheckLimitHigh5)
The "Monitoring RH5" attribute defines for the "Bar" object the monitoring of the limit "Reserve 
High 5".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit RH5 is monitored. The display value is displayed with the bar color RH5 as 
soon as it exceeds the High Limit RH5.

No Limit RH5 is not monitored. A color change only takes place when the next 
monitored limit is exceeded.

The "Monitoring RH5" attribute can be made dynamic with the name "CheckLimitHigh5".

Monitoring RL4 (CheckLimitLow4)
The "Monitoring RL4" attribute defines for the "Bar" object the monitoring of the limit "Reserve 
Low 4".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.
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The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit RL4 is monitored. The display value is displayed with the bar color RL4 as 
soon as it falls below the Low Limit RL4.

No The limit RL4 is not monitored. A color change only takes place when the value 
falls below the next monitored limit.

The "Monitoring RL4" attribute can be made dynamic with the name "CheckLimitLow4".

Monitoring RL5 (CheckLimitLow5)
The "Monitoring RL5" attribute defines for the "Bar" object the monitoring of the limit "Reserve 
Low 5".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit RL5 is monitored. The display value is displayed with the Bar Color RL5 as 
soon as it falls below the Low Limit RL5.

No Limit RL5 is not monitored. A color change only takes place when the value falls 
below the next monitored limit.

The "Monitoring RL5" attribute can be made dynamic with the name "CheckLimitLow5".

Monitoring TH (CheckToleranceHigh)
The "Monitoring TH" attribute defines for the "Bar" object the monitoring of the tolerance limit 
"Tolerance High".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.
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The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit TH is monitored. The display value is displayed with the Bar Color TH as 
soon as it exceeds the Limit TH.

No Limit TH is not monitored. A color change only takes place when the next 
monitored limit is exceeded.

The "Monitoring TH" attribute can be made dynamic with the name "CheckToleranceHigh".

Monitoring TL (CheckToleranceLow)
The "Monitoring TL" attribute defines for the "Bar" object the monitoring of the tolerance limit 
"Tolerance Low".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit TL is monitored. The display value is displayed with the Bar Color TL as soon 
as it falls below the Limit TL.

No Limit TL is not monitored. A color change only takes place when the value falls 
below the next monitored limit.

The "Monitoring TL" attribute can be made dynamic with the name "CheckToleranceLow".

Monitoring WH (CheckWarningHigh)
The "Monitoring WH" attribute defines for the "Bar" object the monitoring of the warning limit 
"Warning High".

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  757



For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit WH is monitored. The display value is displayed with the Bar Color WH as 
soon as it exceeds the Limit WH.

No Limit WH is not monitored. A color change only takes place when the next 
monitored limit is exceeded.

The "Monitoring WH" attribute can be made dynamic with the name "CheckWarningHigh".

Monitoring WL (CheckWarningLow)
The "Monitoring WL" attribute defines for the "Bar" object the monitoring of the warning limit 
"Warning Low".

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

Yes Limit WL is monitored. The display value is displayed with the Bar Color WL as 
soon as it falls below the Limit WL.

No Limit WL is not monitored. A color change only takes place when the value falls 
below the next monitored limit.

The "Monitoring WL" attribute can be made dynamic with the name "CheckWarningLow".
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Low Limit Value (LimitMin)
The "Low Limit Value" attribute defines for the "I/O field" object the minimum limit value for 
input and output. The specified value depends on the "data format" of the I/O field.

If a value is lower than the low limit value, the following effects are possible in Runtime:

Field type = "Input": The "WinCC Runtime" dialog is opened and displayed the error message 
"The entered value is outside the configured limits".         
 Confirm the error message with "OK" and enter another value.

Field type = "Output": The display of the value is substituted by the character string "***".

The "Data Format" and "Field Type" attributes can be changed in the "Output / Input" property 
group.

There is a free choice of value depending on the "data format" of the I/O field.

The "Low Limit Value" attribute can be made dynamic with the name "LimitMin".

Alarm Low Limit AL (AlarmLow)
The "Alarm Low Limit AL" attribute defines for the "Bar" object the lower limit value for the 
alarm limit "Alarm Low". If the display value falls below the value specified here, it is displayed 
in bar color AL.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Alarm Low Limit AL" attribute can be made dynamic with the name "AlarmLow".

Low Limit RL4 (LimitLow4)
The "Low Limit RL4" attribute defines for the "Bar" object the lower limit value for the limit 
"Reserve Low 4". If the display value falls below the value specified here, it is displayed in bar 
color RL4.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:
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The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Low Limit RL4" attribute can be made dynamic with the name "LimitLow4".

Low Limit RL5 (LimitLow5)
The "Limit RL5" attribute defines for the "Bar" object the lower limit value for the limit "Reserve 
Low 5". If the display value falls below the value specified here, it is displayed in bar color RL5.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Low Limit RL5" attribute can be made dynamic with the name "LimitLow5".

Limit TL (ToleranceLow)
The "Limit TL" attribute defines for the "Bar" object the lower limit value for the tolerance limit 
"Tolerance Low". If the display value falls below the value specified here, it is displayed in bar 
color TL.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:
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The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Limit TL" attribute can be made dynamic with the name "ToleranceLow".

Limit WL (WarningLow)
The "Limit WL" attribute defines for the "Bar" object the lower limit value for the warning limit 
"Warning Low". If the display value falls below the value specified here, it is displayed in bar 
color WL.

For the "Bar" object, up to 5 limits can be defined, each of which has an upper (High) and a 
lower (Low) limit value. The limits are termed:

The "Upper Limit XH" and "Lower Limit XL" attributes specify the limit values for the 
corresponding Limit X. The "Type X" attributes specify whether the specified limit values are 
displayed as absolute values or as percentage values.

The "Bar Color XH" and "Bar Color XL" attributes can be used to assign a color to any Limit 
X. The display value is shown in the corresponding color as soon as, starting from the zero 
point of the bar display, it is higher than the corresponding Upper Limit XH or lower than the 
Lower Limit XL. The "Change Color" attribute in the "Miscellaneous" property group specifies 
whether this color change is to take place segment-wise or for the entire display.

The color change can only be displayed for a limit X if the "Monitoring X" attribute has the value 
"Yes". If the "Limit Marker" attribute has the value "Display", the configured and monitored 
limits are indicated by marking arrows. These limit markers receive the bar color of the 
corresponding limit and are displayed on the side of the bar opposite the scale.

There is a free choice of value. A meaningful limit results from the value range that is to be 
displayed with the object "Bar".

The "Limit WL" attribute can be made dynamic with the name "WarningLow".
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3.10.11 The "Background picture" property group

3.10.11.1 BackPictureName
The "Picture" attribute defines the name of the file that is used as the background image in the 
process picture. The file must exist in the \GraCS subdirectory. If you assign the attribute in 
the properties dialog, you can select it from any directory. The selection creates a copy in the 
\GraCS directory. 

Files of format EMF, WMF, DB, BMP, GIF, JPG, JPEG and ICO are suitable. 

The "Picture" attribute can be made dynamic with the name "BackPictureName". 

3.10.11.2 Show as (Back Picture Alignment)
The "Show as" attribute defines the method of displaying the background image of the process 
picture. 

Normal The background picture is centered in the original size. When 
opening the picture in runtime, it remains in the location. 

Stretched (window) The background picture is scaled to the larger of the two windows 
runtime window and process picture. In runtime, it is scaled to the 
size of the runtime window and is scaled further when opening. 

Tiled Graphics Designer and process picture are exhibited with the picture 
in its original size. 

Stretched (picture) The background picture is scaled to the configured size of the 
process picture. When opening the picture in runtime, it retains its 
size. 

The "Show as" attribute can be made dynamic with the name "BackPictureAlignment". 

3.10.12 "Message Types" Property Group

3.10.12.1 Display Text (MCText)
The "Display Text" attribute is used to specify the type of text for the representation of a 
message of the selected "Message Type".

The "Display Text" attribute can be made dynamic with the name "MCText".
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3.10.12.2 Went Out Unacknowledged - Background Flashing (GNQBackFlash)
The "Went Out Unacknowledged - Background Flashing" attribute specifies for the selected 
message type and the status "Went Out Unacknowledged" whether the background of the 
value to be displayed flashes when a message goes out unacknowledged.

Yes When a message goes out unacknowledged, the background of value to be 
displayed flashes.

No When a message goes out unacknowledged, the background of the displayed 
value flashes.

The "Went Out Unacknowledged - Background Flashing" attribute can be made dynamic using 
the name "GNQBackFlash."

3.10.12.3 Went Out Unacknowledged - Background Flashing (MCGUBackFlash)
The "Went Out Unacknowledged - Background Flashing" attribute specifies for the selected 
message type whether the background of the button flashes when a message goes out 
unacknowledged.

Yes When a message goes out unacknowledged, the background of the button flashes.
No When a message goes out unacknowledged, the background of the button does 

not flash.

The "Went Out Unacknowledged - Background Flashing" attribute can be made dynamic using 
the name "MCGUBackFlash".

3.10.12.4 Went Out Unacknowledged - Background Color Off (GNQBackColorOff)
The "Went Out Unacknowledged - Background Color Off" attribute specifies for the selected 
message type and the status "Went Out Unacknowledged" which color the background of the 
value to be displayed assumes for flashing status "Off" when a message goes out 
unacknowledged.

The "Went Out Unacknowledged - Background Color Off" attribute can be made dynamic using 
the name "GNQBackColorOff".

3.10.12.5 Went Out Unacknowledged - Background Color Off (MCGUBackColorOff)
The "Went Out Unacknowledged - Background Color Off" attribute specifies for the selected 
message type which color the background of the button assumes for the flashing status "Off" 
when a message goes out unacknowledged.

The "Went Out Unacknowledged - Background Color Off" attribute can be made dynamic using 
the name "MCGUBackColorOff".

3.10.12.6 Went Out Unacknowledged - Background Color On (GNQBackColorOn)
The "Went Out Unacknowledged - Background Color On" attribute specifies for the selected 
message type and the status "Went Out Unacknowledged" which color the background of the 
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value to be displayed assumes for flashing status "On" when a message goes out 
unacknowledged.

The "Went Out Unacknowledged - Background Color On" attribute can be made dynamic using 
the name "GNQBackColorOn".

3.10.12.7 Went Out Unacknowledged - Background Color On (MCGUBackColorOn)
The "Went Out Unacknowledged - Background Color On" attribute specifies for the selected 
message type which color the background of the button assumes for the flashing status "On" 
when a message goes out unacknowledged.

The "Went Out Unacknowledged - Background Color On" attribute can be made dynamic using 
the name "MCGUBackColorOn".

3.10.12.8 Went Out Unacknowledged - Text Flashing (GNQTextFlash)
The "Went Out Unacknowledged - Text Flashing" attribute specifies for the selected message 
type and the status "Went Out Unacknowledged" whether the text of the value to be displayed 
flashes when a message goes out unacknowledged.

Yes When a message goes out unacknowledged, the text of the message flashes.
No When a message goes out unacknowledged, the text of the message does not 

flash.

The "Went Out Unacknowledged - Text Flashing" attribute can be made dynamic using the 
name "GNQTextFlash."

3.10.12.9 Went Out Unacknowledged - Text Flashing (MCGUTextFlash)
The "Went Out Unacknowledged - Text Flashing" attribute specifies for the selected message 
type whether the text of the button flashes when a message goes out unacknowledged.

Yes When a message goes out unacknowledged, the text of the button flashes.
No When a message goes out unacknowledged, the text of the button does not flash.

The "Went Out Unacknowledged - Text Flashing" attribute can be made dynamic using the 
name "MCGUTextFlash".

3.10.12.1
0

Went Out Unacknowledged - Text Color Off (GNQTextColorOff)

The "Went Out Unacknowledged - Text Color Off" attribute specifies for the selected message 
type and the status "Went Out Unacknowledged" which color the text of the button assumes 
for flashing status "Off" when a message goes out unacknowledged.

The "Went Out Unacknowledged - Text Color Off" attribute can be made dynamic using the 
name "GNQTextColorOff".
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3.10.12.1
1

Went Out Unacknowledged - Text Color Off (MCGUTextColorOff)

The "Went Out Unacknowledged - Text Color Off" attribute specifies for the selected message 
type which color the text of the button assumes for the flashing status "Off" when a message 
goes out unacknowledged.

The "Went Out Unacknowledged - Text Color Off" attribute can be made dynamic using the 
name "MCGUTextColorOff".

3.10.12.1
2

Went Out Unacknowledged - Text Color On (GNQTextColorOn)

The "Went Out Unacknowledged - Text Color On" attribute specifies for the selected message 
type and the status "Went Out Unacknowledged" which color the text of the button assumes 
for flashing status "On" when a message goes out unacknowledged.

The "Went Out Unacknowledged - Text Color On" attribute can be made dynamic using the 
name "GNQTextColorOn".

3.10.12.1
3

Went Out Unacknowledged - Text Color On (MCGUTextColorOn)

The "Went Out Unacknowledged - Text Color On" attribute specifies for the selected message 
type which color the text of the button assumes for the flashing status "On" when a message 
goes out unacknowledged.

The "Went Out Unacknowledged - Text Color On" attribute can be made dynamic using the 
name "MCGUTextColorOn".

3.10.12.1
4

Came In - Background Flashing (CBackFlash)

The "Came In - Background Flashing" attribute specifies for the selected message type and 
status "Came In" whether the background of the value to be displayed flashes.

Yes When the message comes in, the background of the displayed value flashes.
No When the message comes in, the background of the displayed value does not 

flash.

The "Came In - Background Flashing" attribute can be made dynamic using the name 
"CBackFlash".
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3.10.12.1
5

Came In - Background Flashing (MCKOBackFlash)

The "Came In - Background Flashing" attribute specifies for the selected message type 
whether the background of the button flashes when a message comes in.

Yes When the message comes in, the background of the button flashes.
No When the message comes in, the background of the button does not flash.

The "Came In - Background Flashing" attribute can be made dynamic using the name 
"MCKOBackFlash".

3.10.12.1
6

Came In - Background Color Off (CBackColorOff)

The "Came In - Background Color Off" attribute specifies for the selected message type which 
color the background of the value to be displayed assumes for flashing status "Off" when a 
message comes in.

The "Came In - Background Color Off" attribute can be made dynamic using the name 
"CBackColorOff".

3.10.12.1
7

Came In - Background Color Off (MCKOBackColorOff)

The "Came In - Background Color Off" attribute specifies for the selected message type which 
color the background of the button assumes for the flashing status "Off" when a message 
comes in.

The "Came In - Background Color Off" attribute can be made dynamic using the name 
"MCKOBackColorOff".

3.10.12.1
8

Came In - Background Color On (CBackColorOn)

The "Came In - Background Color On" attribute specifies for the selected message type which 
color the background of the value to be displayed assumes for flashing status "On" when a 
message comes in.

The "Came In - Background Color On" attribute can be made dynamic using the name 
"CBackColorOn".

3.10.12.1
9

Came In - Background Color On (MCKOBackColorOn)

The "Came In - Background Color On" attribute specifies for the selected message type which 
color the background of the button assumes for the flashing status "On" when a message 
comes in.

The "Came In - Background Color On" attribute can be made dynamic using the name 
"MCKOBackColorOn".
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3.10.12.2
0

Came In - Text Flashing (CTextFlash)

The "Came In - Text Flashing" attribute specifies for the selected message type and status 
"Came In" whether the text of the value to be displayed flashes.

Yes When the message comes in, the text of the value to be displayed flashes.
No When the message comes in, the text of the value to be displayed does not flash.

The "Came In - Text Flashing" attribute can be made dynamic using the name "CTextFlash".

3.10.12.2
1

Came In - Text Flashing (MCKOTextFlash)

The "Came In - Text Flashing" attribute specifies for the selected message type whether the 
text of the button flashes when a message comes in.

Yes When the message comes in, the text of the button flashes.
No When the message comes in, the text of the button does not flash.

The "Came In - Text Flashing" attribute can be made dynamic using the name 
"MCKOTextFlash".

3.10.12.2
2

Came In - Text Color Off (CTextColorOff)

The "Came In - Text Color Off" attribute specifies for the selected message type which color 
the text of the button assumes for flashing status "Off" when a message comes in.

The "Came In - Text Color Off" attribute can be made dynamic using the name "CTextColorOff".

3.10.12.2
3

Came In - Text Color Off (MCKOTextColorOff)

The "Came In - Text Color Off" attribute specifies for the selected message type which color 
the text of the button assumes for the flashing status "Off" when a message comes in.

The "Came In - Text Color Off" attribute can be made dynamic using the name 
"MCKOTextColorOff".

3.10.12.2
4

Came In - Text Color On (CTextColorOn)

The "Came In - Text Color On" attribute specifies for the selected message type which color 
the text of the button assumes for flashing status "On" when a message comes in.

The "Came In - Text Color On" attribute can be made dynamic using the name "CTextColorOn".
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3.10.12.2
5

Came In - Text Color On (MCKOTextColorOn)

The "Came In - Text Color On" attribute specifies for the selected message type which color 
the text of the button assumes for the flashing status "On" when a message comes in.

The "Came In - Text Color On" attribute can be made dynamic using the name 
"MCKOTextColorOn".

3.10.12.2
6

Came In Acknowledged - Background Flashing (CQBackFlash)

The "Came In Acknowledged - Background Flashing" attribute specifies for the selected 
message type and the status "Came In Acknowledged" whether the background of the value 
to be displayed flashes when the arrival of a message is acknowledged.

Yes The background of the value to be displayed flashes when the arrival of a message 
is acknowledged.

No The background of the value to be displayed does not flash when the arrival of a 
message is acknowledged.

The "Came In Acknowledged - Background Flashing" attribute can be made dynamic using 
the name "CQBackFlash".

3.10.12.2
7

Came In Acknowledged - Background Flashing (MCKQBackFlash)

The "Came In Acknowledged - Background Flashing" attribute specifies for the selected 
message type whether the background of the button flashes when the arrival of a message is 
acknowledged.

Yes The background of the button flashes when the arrival of a message is 
acknowledged.

No The background of the button does not flash when the arrival of a message is 
acknowledged.

The "Came In Acknowledged - Background Flashing" attribute can be made dynamic using 
the name "MCKQBackFlash".

3.10.12.2
8

Came In Acknowledged - Background Color Off (CQBackColorOff)

The "Came In Acknowledged - Background Color Off" attribute specifies for the selected 
message type and the status "Came In Acknowledged" which color the background of the 
value to be displayed assumes for flashing status "Off" when the arrival of a message is 
acknowledged.

The "Came In Acknowledged - Background Color Off" attribute can be made dynamic using 
the name "CQBackColorOff".
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3.10.12.2
9

Came In Acknowledged - Background Color Off (MCKQBackColorOff)

The "Came In Acknowledged - Background Color Off" attribute specifies for the selected 
message type which color the background of the button assumes for the flashing status "Off" 
when the arrival of a message is acknowledged.

The "Came In Acknowledged - Background Color Off" attribute can be made dynamic using 
the name "MCKQBackColorOff".

3.10.12.3
0

Came In Acknowledged - Background Color On (CQBackColorOn)

The "Came In Acknowledged - Background Color On" attribute specifies for the selected 
message type and the status "Came In Acknowledged" which color the background of the 
value to be displayed assumes for flashing status "On" when the arrival of a message is 
acknowledged.

The "Came In Acknowledged - Background Color On" attribute can be made dynamic using 
the name "CQBackColorOn".

3.10.12.3
1

Came In Acknowledged - Background Color On (MCKQBackColorOn)

The "Came In Acknowledged - Background Color On" attribute specifies for the selected 
message type which color the background of the button assumes for the flashing status "On" 
when the arrival of a message is acknowledged.

The "Came In Acknowledged - Background Color On" attribute can be made dynamic using 
the name "MCKQBackColorOn".

3.10.12.3
2

Came In Acknowledged - Text Flashing (CQTextFlash)

The "Came In Acknowledged - Text Flashing" attribute specifies for the selected message type 
and the status "Came In Acknowledged" whether the text of the value to be displayed flashes 
when the arrival of a message is acknowledged.

Yes The text of the value to be displayed flashes when the arrival of a message is 
acknowledged.

No The text of the value to be displayed does not flash when the arrival of a message 
is acknowledged.

The "Came In Acknowledged - Text Flashing" attribute can be made dynamic using the name 
"CQTextFlash".
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3.10.12.3
3

Came In Acknowledged - Text Flashing (MCKQTextFlash)

The "Came In Acknowledged - Text Flashing" attribute specifies for the selected message type 
whether the text of the button flashes when the arrival of a message is acknowledged.

Yes The text of the button flashes when the arrival of a message is acknowledged.
No The text of the button does not flash when the arrival of a message is 

acknowledged.

The "Came In Acknowledged - Text Flashing" attribute can be made dynamic using the name 
"MCKQTextFlash".

3.10.12.3
4

Came In Acknowledged - Text Color Off (CQTextColorOff)

The "Came In Acknowledged - Text Color Off" attribute specifies for the selected message 
type and the state "Came In Acknowledged" which color the text of the value to be displayed 
assumes for flashing status "Off" when the arrival of a message is acknowledged.

The "Came In Acknowledged - Text Color Off" attribute can be made dynamic using the name 
"CQTextColorOff".

3.10.12.3
5

Came In Acknowledged - Text Color Off (MCKQTextColorOff)

The "Came In Acknowledged - Text Color Off" attribute specifies for the selected message 
type which color the text of the button assumes for the flashing status "Off" when the arrival 
of a message is acknowledged.

The "Came In Acknowledged - Text Color Off" attribute can be made dynamic using the name 
"MCKQTextColorOff".

3.10.12.3
6

Came In Acknowledged - Text Color On (CQTextColorOn)

The "Came In Acknowledged - Text Color On" attribute specifies for the selected message 
type and the status "Came In Acknowledged" which color the text of the value to be displayed 
assumes for flashing status "On" when the arrival of a message is acknowledged.

The "Came In Acknowledged - Text Color On" attribute can be made dynamic using the name 
"CQTextColorOn".

3.10.12.3
7

Came In Acknowledged - Text Color On (MCKQTextColorOn)

The "Came In Acknowledged - Text Color On" attribute specifies for the selected message 
type which color the text of the button assumes for the flashing status "On" when the arrival 
of a message is acknowledged.
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The "Came In Acknowledged - Text Color On" attribute can be made dynamic using the name 
"MCKQTextColorOn".

3.10.12.3
8

Message Type (MessageClass)

The "Message Type" attribute shows all message types that can be configured for the group 
display and the extended analog and status display. They configure the type of message using 
a bit in the group value.

For each message type, you can configure the following attributes for the statuses "Came in", 
"Came in acknowledged" and "Went unacknowledged":

● Font color

● Background color

● Flashing text 

● Flashing background

A change of attribute applies to the selected message type.

The "Message Type" attribute can be made dynamic with the name "MessageClass".

3.10.13 The "Object" Property Group

3.10.13.1 Layer (Layer)
The "Layer" attribute specifies the position of an object in the picture.

In the Graphics Designer, a picture consists of 32 layers in which the objects can be inserted. 
Objects of the layer 0 are located at the screen background, while objects of the layer 32 are 
located in the foreground.

Depending on certain events, the Layer object can be used with VBScript to obtain access to 
the properties of a complete layer in order, for example, to hide or unhide a layer with operating 
elements according to the operator authorization. More information is available in the VBS 
Reference in the Information System.

0 - 31 There is a free choice of layer for each object.

The "Layer" attribute cannot be changed in Runtime. However, layers can be hidden or 
unhidden in Runtime.

3.10.13.2 Faceplate Type FPT
The "Faceplate type" attribute shows the file name of the respective faceplate type. 

The attribute is defined by selecting the faceplate type and cannot be changed. 

The "Faceplate type" attribute cannot be made dynamic. 
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3.10.13.3 Window Contents (Application)
The "Window Contents" attribute specifies for an application window which application is to be 
displayed. Application windows can be supplied from applications of the Global Script and the 
report system. In Runtime, these applications open an application window, transfer information 
and enable operation.

Global Scripts The application window is supplied by applications of the Global Script.
Print Jobs The application window is supplied by the report system.

The "Window Contents" attribute cannot be made dynamic.

3.10.13.4 Object Name (ObjectName)
The "Object Name" attribute specifies the name of an object in the picture. The object name 
is unique within a picture and, for example, is used in the project engineering of C actions for 
the call instruction of the object.

When an object is inserted, the object name assigned as standard is the description of the 
object type with a consecutive number. This name can be changed using the "Object Name" 
attribute.

There is a free choice of object name and it can have a length of up to 128 characters without 
restriction.

The "Object Name" attribute cannot be made dynamic.

3.10.13.5 Template (Template)
The "Template" attribute specifies for an application window which template is to be used for 
display of the window contents. The available templates depend on the value of the "Window 
Contents" attribute.

Application windows can be supplied from applications of the Global Script and the report 
system.

GSC Diagnostics The application window is supplied by applications of the Global Script. 
The results of the diagnosis system are displayed.

GSC Runtime The application window is supplied by applications of the Global Script. 
The analysis results regarding characteristics in Runtime are displayed.

All Jobs The application window is supplied by the report system. The available 
reports are displayed as a list.

All Jobs – Shortcut 
Menu

The application window is supplied by the report system. The available 
reports are displayed as a list. The shortcut menu enables the selection 
of print options, display of a print preview as well as a printout of the log.
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Job Detail View The application window is supplied by the report system. The available 
reports are displayed in a selection menu. Detailed information is 
displayed for the selected report.

Selected Jobs - 
Shortcut Menu

The application window is supplied by the logging system. The available 
reports are displayed as a list. This list only contains reports which you 
have activated the option "Mark for print job list" in the "Print Job 
Properties" dialog. The shortcut menu enables the selection of print 
options, display of a print preview as well as a printout of the log.

The "Template" attribute cannot be made dynamic.

3.10.14 "Font" Property Group

3.10.14.1 Bold (FontBold)
The "Bold" attribute specifies whether or not the text in an object is displayed as bold.

Yes The text is displayed in bold face.
No The text is not displayed in bold face.

The "Bold" attribute can be made dynamic with the name "FontBold".

3.10.14.2 Format (Format)
The "Format" attribute shows in which format the value of the analog display is displayed. 

No Character Displays the number without formatting.
( 0 ) Displays a digit or a zero.
( # ) Displays a digit or no output.
( . ) Placeholder for decimal character.
( % ) Placeholder for percentage.
( , ) Thousand separator.
( ( E- E+ e- e+ ) Scientific format. 
- + $ ( ) Display of a literal character. 

         
Display the next character in the format character sequence.

( ( "ABC" ) Displays the string in inverted commas (" "). 

The "Format" attribute can be made dynamic with the name "Format".

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  773



3.10.14.3 Index (Index)
The "Index" attribute is a help attribute that is used in the "Object properties" dialog for 
accessing text of fields or lines of the object. 

● The number of the fields of an object is defined with the "Number of Boxes" attribute in the 
"Geometry" properties group to determine the supply of values for the "Index" attribute. 

● The number of the lines of an object is defined with the "Number of rows" attribute in the 
"Geometry" properties group to determine the supply of values for the "Index" attribute. 

Use the "Index" attribute to set the position number of the field or the line that you want to 
display or edit. The content of the field or the line is shown as a value of the "Text" attribute. 
Changing the "Index" attribute also changes the displayed value of the "Text" attribute. 

1 - "Number of 
Boxes"

Check Box, Radio Box

1 - "Number of rows" Combination field, List field

The "Index" attribute can be made dynamic with the name "Index".

3.10.14.4 Italic (FontItalic)
The "Italic" attribute specifies whether or not the text in an object is displayed in italics.

Yes The text is displayed in italic.
No The text is not displayed in italic.

The "Italic" attribute can be made dynamic with the name "FontItalic".

3.10.14.5 Text Orientation (Orientation)
The "Text Orientation" attribute specifies whether a text appears with a vertical or horizontal 
orientation. Changing the attribute only changes the position of the text within an object, while 
the object itself remains unchanged.

Horizontal The orientation of the text is from left to right.
Vertical The orientation of the text is from top to bottom.

The "Text Orientation" attribute can be made dynamic with the name "Orientation".

3.10.14.6 Text (Text)
The "Text" attribute specifies the text for a text field. Here, for example, buttons can be labeled. 
In the case of the objects "Check Box" and "Option Group", each text field is selected 
individually via the "Index" attribute.

Line breaks must be entered manually: You can create a line break with either <SHIFT
+ENTER> or <CTRL+M>.
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A line brake is shown in the "Object Properties" window in the "Static" column as a control 
character.

A text of any length can be entered. A meaningful limit results from the object size.

The "Text" attribute can be made dynamic with the name "Text".

3.10.14.7 Underline (FontUnderline)
The "Underline" attribute specifies whether or not the text in an object is displayed as 
underlined.

Yes The text is displayed as underlined.
No The text is not displayed as underlined.

The "Underline" attribute can be made dynamic with the name "FontUnderline".

3.10.14.8 X alignment (AlignmentLeft)
The "X Alignment" attribute specifies the horizontal alignment of a text in an object. Changing 
the attribute only changes the position of the text within an object, while the object itself remains 
unchanged.

On left The text is aligned to the left in the object.
centered The text is centered horizontally in the object.
right The text is aligned to the right in the object.

The "X Alignment" attribute can be made dynamic with the name "AlignmentLeft".

3.10.14.9 Y alignment (AlignmentTop)
The "Y Alignment" attribute specifies the vertical alignment of a text in an object. Changing the 
attribute only changes the position of the text within an object, while the object itself remains 
unchanged.

top The text is aligned to the top of the object.
centered The text is centered vertically in the object.
bottom The text is aligned to the bottom of the object.

The "Y Alignment" attribute can be made dynamic with the name "AlignmentTop".

3.10.14.1
0

Font (FontName)

The "Font" attribute specifies in which font a text appears. You can use every font that is 
installed in the Windows operating system. 

If a selected font is not available on a system, the text is automatically displayed in "Arial".

Any of the fonts installed in the Windows operating system can be selected.
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The "Font" attribute can be made dynamic with the name "Font Name".

3.10.14.1
1

Font Size (FontSize)

The "Font Size" attribute specifies in which font size a text appears. The values are specified 
in points.

The size of the font can be set between 1 point and 127 points.

The "Font Size" attribute can be made dynamic with the name "FontSize".

3.10.15 "Miscellaneous" Property Group

3.10.15.1 Others -  A to B

Update Cycle (UpdateCycle)
The "Update Cycle" attribute defines the type and the frequency for updating a process picture.

The value specified here corresponds to the "picture cycle", which can be set as the update 
cycle for individual objects. In this case, the display of these objects will be updated at the 
same time as the display of the process picture.

The "Update Cycle" attribute cannot be made dynamic.

Update Cycle (UpdateCycle)
The "Update Cycle" defines the type and the frequency of the update for a picture window.

The "Update Cycle" attribute cannot be made dynamic.

Display (Visible)
The "Display" attribute specifies whether or not a process picture is displayed in Runtime.

Yes The process picture is displayed in Runtime.
No The process picture is not displayed in Runtime.

The "Display" attribute can be made dynamic with the name "Visible".

Display (Visible)
The "Display" attribute specifies whether or not an object is displayed in Runtime.

Yes The object is displayed in Runtime.
No The object is not displayed in Runtime.
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The "Display" attribute can be made dynamic with the name "Visible".

Display Options (DisplayOptions)
The "Display Options" attribute specifies whether a button will be allocated with a picture or 
text or both.

0 Picture or text: If a picture exists, the button is assigned with the picture, otherwise 
it is assigned with text.

1 Picture and text
2 Text only
3 Picture only

The "Display Options" attribute can be made dynamic with the name "DisplayOptions".

Operator-Control Enable (Operation)
The "Operator-Control Enable" attribute specifies whether or not a process picture can be 
operated in Runtime.

In order to be able to operate a process picture, the operator must have the relevant 
authorization. You specify this with the "Authorization" attribute.

Yes The process picture can be operated in Runtime.
No The process picture cannot be operated in Runtime.

The "Operator-Control Enable" attribute can be made dynamic with the name "Operation".

Operator-Control Enable (Operation)
The "Operator-Control Enable" attribute specifies whether or not an object can be operated in 
Runtime.

In order to be able to operate an object, the operator must have the relevant authorization. 
You specify this with the "Authorization" attribute.

Yes The object can be operated in Runtime.
No The object cannot be operated in Runtime.

The "Operator-Control Enable" attribute can be made dynamic with the name "Operation".

With WinCC Alarm Control, the attribute cannot be made dynamic.

Operator Input Message (OperationMessage)
The "Operator Input Message" attribute specifies whether or not a message is displayed after 
an operation. If the attribute "Operator Input Message" has been set to "yes", a message is 
generated upon operation, sent to the message system and archived. Using the message 
system, a message may be output in a message line, for example.
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So that the operator can enter a reason for the operation after its completion, the "Operator 
Activities Report" attribute must be enabled. The reason for the operator input is displayed as 
a comment for the operator input message in the long-term archive list.

Yes An operator output message is displayed.
No An operator output message is not displayed.

The "Operator Input Message" attribute can be made dynamic with the name 
"OperationMessage".

Operator Actions Report (OperationReport)
The "Operator Activities Report" attribute specifies whether the reason for an operation will be 
logged by the operator. The operator activities report is archived in the message system. The 
reason for the operator input is displayed as a comment for the operator input message in the 
long-term archive list.

Yes The reason for the operation is logged. On operation of the object, a dialog opens 
in Runtime in which the operator can enter a text.

No The reason for the operation is not logged.

The "Operator Activities Report" attribute can be made dynamic with the name 
"OperationReport".

Operation Steps (SmallChange)
The "Operation Steps" attribute specifies for the slider the number of steps the slider is moved 
in the corresponding direction with one mouse-click on the slide surface.

The number of times to click on the slider surface for the slider to move from one end to the 
other is calculated as follows: ("maximum value" - "minimum value") / "operation steps".

Example: Where maximum value = 100, minimum value = 0, operation steps = 25 the slider 
surface must be clicked four times to move the slider from one end to the other.

With one mouse-click on the slide surface, the slider can be set to the minimum or maximum 
value if the "Extended Operation" attribute has the value "Yes".

There is a free choice of value.

The "Operation Steps" attribute can be made dynamic with the name "SmallChange".

User Value (UserValue1)
The "User Value 1" to "User Value 4" attributes make it possible to enter sample values for a 
group display. Any values can be entered and, for example, evaluated in a script. In Runtime, 
the entered user values are neither displayed nor evaluated.

0 (232-1) The value can be chosen freely within the specified limits.

The "User Value 1" attribute can be made dynamic with the name "UserValue1".

The "User Value 2" attribute can be made dynamic with the name "UserValue2", etc.
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Authorization (PasswordLevel)
The User Administrator editor is used in WinCC to assign authorizations for the users. In the 
Graphics Designer, an authorization can be assigned for each process picture, which means 
that this process picture can only be operated by those users who have the corresponding 
authorization.

So that a process picture can be operated, the "Operator-Control Enable" attribute must have 
the value "Yes".

The "Authorization" attribute can be made dynamic with the name "PasswordLevel".

Authorization (PasswordLevel)
The User Administrator editor is used in WinCC to assign authorizations for the users. In the 
Graphics Designer, an authorization can be assigned for each object, which means that this 
object can only be operated by those users who have the corresponding authorization.

So that an object can be operated, the "Operator-Control Enable" attribute must have the value 
"Yes".

The "Authorization" attribute can be made dynamic with the name "PasswordLevel".

Adapt Picture (AdaptPicture)
The "Adapt Picture" attribute specifies whether or not the picture displayed in a picture window 
adapts to the size of the picture window in Runtime.

Yes The picture adapts to the size of the picture window in Runtime.
No The picture does not adapt to the size of the picture window in Runtime. 

The "Adapt Picture" attribute cannot be made dynamic.

Picture Status Off (PictureUp)
A button can have one of two statuses: "On" or "Off".         
 For each status, a picture to be displayed can be selected. Pictures with the following formats 
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the 
"Picture Selection" dialog.

The "Picture Status Off" attribute can be made dynamic with the name "PictureUp".

Picture Status On (PictureDown)
A button can have one of two statuses: "On" or "Off".         
 For each status, a picture to be displayed can be selected. Pictures with the following formats 
can be inserted: BMP, DIB, ICO, CUR, EMF, WMF, GIF and JPG.

In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the 
"Picture Selection" dialog.

The "Picture Status On" attribute can be made dynamic with the name "PictureDown".
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Picture Name (PictureName)
The "Picture Name" attribute specifies which picture is displayed in a picture window. Only 
pictures of the format PDL that belong to the current project can be inserted. 

If no picture to be displayed is defined for a picture window, the picture window is not displayed 
in Runtime.

The "Picture Name" attribute can be made dynamic with the name "PictureName".

Picture Offset X (OffsetLeft)
A process picture that is embedded in a picture window can only be displayed as a zoom area. 
The origin of this zoom area is determined by the "Picture Offset X" and "Picture Offset Y" 
attributes.

The "Picture Offset X" specifies the horizontal coordinates for the origin of the zoom area. The 
values are specified in pixels.

There is a free choice of value. A meaningful limit results from the size of the integrated picture.

The "Picture Offset X" attribute can be made dynamic with the name "OffsetLeft".

Picture Offset Y (OffsetTop)
A process picture that is embedded in a picture window can only be displayed as a zoom area. 
The origin of this zoom area is determined by the "Picture Offset X" and "Picture Offset Y" 
attributes.

The "Picture Offset Y" specifies the vertical coordinates for the origin of the zoom area. The 
values are specified in pixels.

There is a free choice of value. A meaningful limit results from the size of the integrated picture.

The "Picture Offset Y" attribute can be made dynamic with the name "OffsetTop".

Bit Pattern Group Display (SignificantMask)
The value of the attribute is an internal system output value. The value is updated if the group 
display is clicked for a loop-in-alarm.

The "Bit Pattern Group Display" attribute should not be made dynamic by the user.

3.10.15.2 Others -  C to O

Cursor Mode
The "Cursor Mode" attribute specifies whether a process picture is operated in Runtime by 
means of an "Alpha Cursor" or a "Tab Order".

The cursor mode can be toggled in Runtime if a hotkey is configured for the toggle.

Alpha-Cursor Operation in Runtime is by means of the Alpha Cursor.
Tab Order Operation in Runtime is by means of Tab Order.
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The "Cursor Mode" attribute cannot be made dynamic.

Cursor Control (CursorControl)
The "Cursor Control" attribute specifies whether the Alpha Cursor automatically jumps to the 
next field in the TAB sequence after an entry has been made in a field. This function enables 
rapid input in different fields without having to use the tab key to jump.

Yes The cursor automatically jumps to the next field of the TAB sequence after the 
input has been made.

No The cursor does not automatically jump to the next field of the TAB sequence after 
the input has been made.

The "Cursor Control" attribute can be made dynamic with the name "CursorControl".

Date of Last Change
The "Date of Last Change" attribute shows the date on which the process picture was last 
saved.

The "Date of Last Change" attribute cannot be made dynamic.

Immediate Input (EditAtOnce)
The "Immediate Input" attribute specifies for input fields whether or not a direct change is made 
into the input mode on jumping to the object. 

Yes When the focus moves to the object, the input mode is immediately active.
No When the focus moves to the object, the input mode is not immediately active.

The "Immediate Input" attribute can be made dynamic with the name "EditAtOnce".

Extended Operation (ExtendedOperation)
The "Extended Operation" attribute specifies whether the slider jumps on the slide surface in 
one step to the minimum value or maximum value when clicked.

Yes With one mouse-click on the slide surface, the slider jumps to the minimum value 
or maximum value.

No With a mouse-click on the slide surface, the slider is moved in the corresponding 
direction by the value set in the "Operation Steps" attribute.

The "Extended Operation" attribute can be made dynamic with the name "ExtendedOperation".
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Extended Zooming (ExtendedZoomingEnable)
The "Extended Zooming" specifies whether the picture can be zoomed in on or out of for the 
selected process picture with the mouse wheel. Requirements for using the zoom function:

● a mouse driver by Logitech or Microsoft Intellimouse

● the mouse wheel must be set to "Autoscroll".

● The "Extended Zooming" function must be enabled in the "Graphics Runtime" tab of the 
"Computer Properties" dialog for all process pictures. 

Yes The mouse wheel can be used to zoom in on or out of the picture. Press the 
<CTRL> key in Runtime, while you turn the mouse wheel. If you turn the mouse 
wheel away from the palm of your hand, you increase the zoom factor. 

No Rotating the mouse wheel does not zoom in on or out of the picture, even if 
extended zooming is enabled for all process pictures.

The "Extended Zooming" attribute can be made dynamic with the name 
"ExtendedZoomingEnable".

Change Color (ColorChangeType)
The "Change Color" attribute specifies for the "Bar" object whether a color change is run 
segment-wise or for the entire bar. With segment-wise display, for example, it is possible to 
visualize which limits are exceeded by the displayed value.

Total When a limit is reached, the entire bar changes color.
Segment When a limit is reached, the bar changes segment by segment. The 

color allocation takes place in accordance with the settings in the "Limits" 
property group.

The "Change Color" attribute can be made dynamic with the name "ColorChangeType".

Adapt Size (AdaptSize)
The "Adapt Size" attribute specifies whether or not the picture window adapts to the size of 
the embedded picture in Runtime.

Yes The picture window adapts to the size of the picture in Runtime.
No The picture window does not adapt to the size of the picture in Runtime. 

The "Adapt Size" attribute cannot be made dynamic.
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Windows Position Mode
The "Window mode" attribute defines the position and scaling of the picture window on the 
screen. It is only effective if the "Independent window" attribute is set to "Yes". 

Standard The picture window is positioned in its original size in the configured position 
on the screen. 

Center The picture window is positioned in its original size, centered on the screen. 
Maximize The picture window is scaled to the size of the screen. 

The "Window mode" attribute can be made dynamic with the name "WindowPositionMode". 

Outgoing State Visible (AlarmGoneVisible)
The attribute "Outgoing State Visible" defines for an object whether an outgoing state is visible 
or not.

Yes The outgoing state is visible
No The outgoing state is suppressed

The "Outgoing State Visible" attribute can be made dynamic with the name 
"AlarmGoneVisible".

Sizeable (Sizeable)
The "Sizeable" attribute specifies whether or not the size of a window can be changed in 
Runtime.

Yes The size of the window can be changed in Runtime.
No The size of the window cannot be changed in Runtime.

The "Sizeable" attribute cannot be made dynamic.

Hotkey (Hotkey)
As an alternative to operation with the mouse, a button can also be triggered using the 
keyboard. 

To do so, a hotkey must be set.

If a hotkey has been defined for a button, an arrow is displayed in the object properties beside 
the "Hotkey" attribute.

The "Hotkey" attribute cannot be made dynamic.

Hysteresis (Hysteresis)
So that a color change is not triggered immediately in the case of a slight limit violation, the 
"Hysteresis" and "Hysteresis Range" attributes can be used to define a distribution range for 
the display of the value.
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The "Hysteresis" attribute specifies for the "Bar" object whether the display with hysteresis is 
permitted or not.

Set the hysteresis value with the "Hysteresis Range" attribute.

Yes Display with hysteresis.
No Display without hysteresis.

The "Hysteresis" attribute can be made dynamic with the name "Hysteresis".

Hysteresis Range (HysteresisRange)
So that a color change is not triggered immediately in the case of a slight limit violation, the 
"Hysteresis" and "Hysteresis Range" attributes can be used to define a distribution range for 
the display of the value.

The "Hysteresis Range" attribute specifies for the "Bar" object the hysteresis as a percentage 
of the display range.

The "Hysteresis Range" attribute can be made dynamic with the name "HysteresisRange".

Maximum Value (Max)
The "Maximum Value" attribute specifies the absolute value for display of the largest value for 
bars, 3D bars and sliders.

The hysteresis range is only taken into account if the "Hysteresis" attribute has the value "Yes".

There is a free choice of value.

The "Maximum Value" attribute can be made dynamic with the name "Max".

Can Be Maximized (MaximizeButton)
The "Can Be Maximized" attribute specifies whether or not a window can be enlarged to the 
maximum screen size in Runtime.

The attributes "Can Be Maximized" and "Can Be Closed" are displayed in the title bar; if one 
of the attributes has the value "Yes", the "Title" attribute is automatically assigned the value 
"Yes".

Yes The window can be maximized in Runtime.
No The window cannot be maximized in Runtime.

The "Can Be Maximized" attribute cannot be made dynamic.

Configuration of Menu/Toolbars
Defines the configuration file using the user-defined menus and toolbars that are displayed in 
the picture screen. 

The "Configuration of menu/toolbars" attribute cannot be made dynamic using the 
"MenuToolBarConfig" name.
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Minimum Value (Min)
The "Minimum Value" attribute specifies the absolute value for display of the smallest value 
for bars, 3D bars and sliders.

There is a free choice of value.

The "Minimum Value" attribute can be made dynamic with the name "Min".

Average Value (Average)
The "Average Value" attribute specifies for the "Bar" object whether or not a mean value of 
the last 15 values is formed.

Yes An average value of the last 15 values is formed.
No An average value is not formed.

The "Average Value" attribute can be made dynamic with the name "Average".

Monitor number (WindowMonitorNumber)
The "Monitor number" attribute specifies the monitor that displays the picture window. This 
requires that your system supports more than one monitor. 

The attribute is only effective if the "Independent window" attribute is set to "Yes". 

1-n The number of the monitor in the operating system on which the picture window is 
displayed.

The "Monitor number" attribute can be assigned dynamic properties by means of the name 
"WindowMonitorNumber". 

Zero Point Value (ZeroPointValue)
The "Zero Point Value" attribute specifies the absolute value for the zero point of bars or 3D 
bars.

The display of the zero point value on the scale is specified using the "Zero Point" attribute in 
the "Axis" property group.

There is a free choice of value within the limits of "minimum value" and "maximum value".

The "Zero Point Value" attribute can be made dynamic with the name "ZeroPointValue".

3.10.15.3 Others -  P to S

Process Driver Connection (Process)
If an object of the type "Bar", "3D Bar" or "Slider" is not embedded using a tag in the process, 
the object accesses a preset value in Runtime and displays this value.
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The "Process Driver Connection" attribute specifies the default setting for the value to be 
displayed.

There is a free choice of value.

The "Process Driver Connection" attribute can be made dynamic with the name "Process".

Acknowledgment Sample (EventQuitMask)
The events "ToleranceLow," "ToleranceHigh," "Operator Request," and "Measuring point 
blocked" are not acknowledgeable events in the PCS7 environment. These events are 
automatically indicated as being acknowledged during the group display calculations using the 
"@EventQuit" tag.

To eliminate flashing, the "Acknowledgment mask" is used to automatically indicate the events 
"ToleranceLow," "ToleranceHigh," "Operator Request," and "Measuring point blocked" as 
being acknowledged when the group display object is displayed.

The attribute is assigned a default start value of 0x00000C11 (3089). These are precisely the 
acknowledgment bits for "ToleranceLow," "ToleranceHigh," "Operator Request," and 
"Measuring point blocked." By setting other acknowledgment bits, you can indicate other 
events as being acknowledged as well with the display of the group display object and the 
extended analog and status display.

With new projects as of WinCC V7.01, you can configure messages of the "Tolerance" 
message class as mandatory acknowledgement messages. The option is selected in the OS 
Project Editor. This causes the events "ToleranceLow" and "ToleranceHigh" to be identified 
as not acknowledged. The start value of the attribute is then 0x00000011 (17).

The value of the attribute should be identical for all group, analog, and status display objects 
as well as for the "@EventQuit" tag.

Border (WindowBorder)
The "Border" attribute specifies whether or not an application window or picture window is to 
be displayed with a border.

If the "Sizeable" attribute for a window is set to the value "Yes", the "Border" attribute 
automatically assumes the value "Yes".         
 So that the picture window is displayed in Runtime, a picture must be embedded.

Yes The window is displayed with a border.
No The window is displayed without a border.

The "Border" attribute cannot be made dynamic.

Adapt Border (AdaptBorder)
The "Adapt Border" attribute defines for objects that contain text whether the field border adapts 
dynamically to the text size.

The dynamic change of the text in the field can mean that the field size changes continuously 
in Runtime.         
 The performance in Runtime is higher if the "Adapt Border" attribute has the value "No".
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Yes The field border resizes dynamically to fit the text size.
No The field border retains its size regardless of the text.

The "Flash Picture" attribute cannot be made dynamic.

Scroll Bars (ScrollBars)
The "Scroll Bars" attribute specifies whether or not a picture window is displayed with a scroll 
bar if required. This setting is only visible in Runtime.

The "Scroll Bars", "Adapt Size" and "Adapt Picture" attributes can influence one another.

Yes The picture window is displayed in Runtime with scroll bars if the picture to be 
displayed does not fit in the picture window.

No The picture window is always displayed in Runtime without scroll bars, even if the 
picture to be displayed does not fit in the picture window.

The "Scroll Bars" attribute cannot be made dynamic.

Scroll Bar Position X (ScrollPositionX)
The "Scroll Bar Position X" attribute specifies the horizontal movement of the scroll bar position 
in a picture window with the scroll bar. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the size of the integrated picture.

The "Scroll Bar Position X" can be made dynamic with the name "ScrollPositionX".

Scroll Bar Position Y (ScrollPositionY)
The "Scroll Bar Position Y" attribute specifies the vertical movement of the scroll bar position 
in a picture window with the scroll bar. The values are specified in pixels.

There is a free choice of value. A meaningful limit results from the size of the integrated picture.

The "Scroll Bar Position Y" attribute can be made dynamic with the name "ScrollPositionY".

Group Relevant (Relevant)
All displays in a class can be grouped hierarchically into a group display. This makes possible 
a rapid overview of alarms, warnings and malfunctions.

The "Group Relevant" attribute specifies for the object whether or not the object is taken into 
account for the formation of the group, extended analog or status display.

Yes The object is taken into account for the formation of the group display.
No The object is not taken into account for the formation of the group display.

The "Group Relevant" attribute can be made dynamic with the name "Relevant".
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Collect Value (CollectValue)
All displays in a class can be grouped hierarchically into a group display. This makes possible 
a rapid overview of alarms, warnings and malfunctions.

The "Collect Value" attribute specifies as an initial value the current status of the active 
message classes in each case.

So that an object of the group display type is taken into account for the formation of the group, 
extended analog or status display, the "Group Relevant" attribute must have the value 
"Yes".         
When a new group display is inserted, it has the collect value 65535 as start value. In this 
manner, you can ensure that at the start - from the view of the group display - there are no 
unacknowledged messages.

The group value is controlled by a tag. Other types of dynamization are not possible.

Use Group Value for Display (UseEventState)
The "Use Group Value for Display" attributed defines for the extended status display whether 
the group value is evaluated for the display of the statuses.

If the group value is used, you can assign pictures for the individual alarm statuses.

Yes The group value is taken into consideration for the display of the extended status 
display.

No The group value is not taken into consideration for the display of the extended 
status display.

The attribute "Use Group Value for Display" can be made dynamic with the name 
"UseEventState".

Can be Closed (CloseButtton)
The "Can Be Closed" attribute specifies whether or not a window can be closed in Runtime.

The attributes "Can Be Maximized" and "Can Be Closed" are displayed in the title bar; if one 
of the attributes has the value "Yes", the "Title" attribute is automatically assigned the value 
"Yes".

Yes The window can be closed in Runtime.
No The window cannot be closed in Runtime.

The "Can Be Closed" attribute cannot be made dynamic.

Selected text (SelText)
The "Selected text" attribute shows the text defined with the "Selected box" attribute, which is 
highlighted in the object. 

You cannot directly change the "Selected text" attribute. You change the "Selected text" 
attribute by changing the "Selected box" attribute or the text itself in the "Font" properties group. 

The "Selected text" attribute can be made dynamic with the name "SelText". 
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Selected box (SelIndex)
The "Selected box" attribute defines the index, the text of which is highlighted in the 
combination field or the list field. 

1 - Number of 
rows

Index of the highlighted field

The "Selected Box" attribute can be made dynamic with the name "SelIndex". 

Server Prefix (ServerPrefix)
Pictures that are embedded can be stored on any server in a multi-client system. Either the 
server is specified directly on embedding a picture, or assigned later via the object properties 
of the picture window.

The "Server Prefix" attribute specifies on which server the picture to be displayed in the picture 
window is located.

Changes to the server prefix only take effect when the picture is loaded once again. When the 
picture is changed, this occurs automatically, otherwise the picture name must be reassigned.

The "Server Prefix" attribute can be made dynamic with the name "ServerPrefix".

ServerName (ServerName)
The "ServerName" attribute indicates under which name an embedded object is registered in 
the Windows operating system. A change of the registration is not possible in the Graphics 
Designer.

The "ServerName" attribute cannot be made dynamic.

Simulation (Simulation)
With the "Simulation" attribute, you define the linking with any tag which is used for simulation.

The "Simulation" attribute can be made dynamic with the name "Simulation".

Simulation Bit (SimulationBit)
The "Simulation Bit" attribute shows the bit position of the linked simulation tags that are used 
for evaluation.

The value of the simulation tag is only evaluated with the alarm status "OK".

The "Simulation Bit" attribute can be made dynamic with the name "SimulationBit".

Scaling Factor (Zoom)
The "Scaling Factor" attribute sets the zoom factor for the display of the picture in the picture 
window. The values are specified as a percentage.

1 - (231-1) The value can be chosen freely within the specified limits.  
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The "Scaling Factor" attribute can be made dynamic with the name "Zoom".

Scaling Mode
The "Scaling mode" attribute defines the size to display the objects of the faceplate instance. 

Default Like scaling mode "proportional" 
1 : 1 The faceplate type is displayed centered in the original size in the 

faceplate instance. If the faceplate instance is too small, its size is 
adapted to the size of the faceplate type. 

proportional The faceplate type is scaled in proportion with the size of the faceplate 
instance. 

The "Scaling mode" attribute cannot be made dynamic. 

Configured Languages (DataLanguage)
The "Configured Languages" attribute specifies in which language variant an entry in a text 
object is displayed.         
 The "Configured Languages" attribute can only be modified if the individual languages have 
been set beforehand in the "View" "Languages" menu. With the "Configured Languages" 
attribute, configured languages can only be deleted, not added.

The "Configured Languages" attribute cannot be made dynamic.

Status (ProcessValue)
With the "Status" attribute, you define the linking with any tag.

The "Status" attribute can be made dynamic with the name "ProcessValue".

Status1 (Process)
In the "Status1" attribute, you can preset the first tag used for the calculation of the status value 
for the extended status display. In the configuration dialog of the extended status display, you 
can define the bit position taken into account for the status value calculation of this tag. This 
results in the statuses, to which you can then assign pictures.

The "Status1" attribute can be made dynamic with the name "Process".

Status2 (Process1)
In the "Status2" attribute, you can preset the second tag used for the calculation of the status 
value for the extended status display. In the configuration dialog of the extended status display, 
you can define the bit position taken into account for the status value calculation of this tag. 
This results in the statuses, to which you can then assign pictures.

The "Status2" attribute can be made dynamic with the name "Process1".
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Status3 (Process2)
In the "Status3" attribute, you can preset the third tag used for the calculation of the status 
value for the extended status display. In the configuration dialog of the extended status display, 
you can define the bit position taken into account for the status value calculation of this tag. 
This results in the statuses, to which you can then assign pictures.

The "Status3" attribute can be made dynamic with the name "Process2".

Status4 (Process3)
In the "Status4" attribute, you can preset the fourth tag used for the calculation of the status 
value for the extended status display. In the configuration dialog of the extended status display, 
you can define the bit position taken into account for the status value calculation of this tag. 
This results in the statuses, to which you can then assign pictures.

The "Status4" attribute can be made dynamic with the name "Process3".

3.10.15.4 Others - T to Z

Tag (tag)
The "Tag" attribute is used for the Tool Graphic Object Update Wizard and is not evaluated 
for the object.

The "Tag" attribute can be made dynamic with the name "tag".

Tagname (tagname)
The attribute "Tag Name" is used for the Tool Graphic Object Update Wizard and is not 
evaluated for the object.

The "Tag Name" attribute can be made dynamic with the name "tagname."

Tagtype (tagtype)
The "Tag Type" attribute is used for the Tool Graphic Object Update Wizard and is not 
evaluated for the object.

The "Tag Type" attribute can be made dynamic with the name "tagtype."

Text Reference (LanguageSwitch)
The "Text Reference" attribute specifies where the language-dependent assignment texts are 
stored:

Yes The texts are managed in the text library. They are translated into other languages 
in the text library.

No The texts are managed directly in the object.

The "Text Reference" attribute cannot be made dynamic.
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Title (Caption)
The "Title" attribute specifies whether a window is displayed in Runtime with or without a title 
bar.

The attributes "Can Be Maximized" and "Can Be Closed" are displayed in the title bar; if one 
of the attributes has the value "Yes", the "Title" attribute is automatically assigned the value 
"Yes".

Yes In Runtime, the window is displayed with a title bar.
No In Runtime, the window is displayed without a title bar.

The "Title" attribute cannot be made dynamic.

Tooltip text (ToolTipText)
The "Tooltip text" attribute specifies the tooltip text to display in Runtime by positioning the 
mouse pointer on the object. The tooltip text can be entered for all available languages.

To define a tooltip text which contains the special character "&", enter three successive 
commercial ampersands, e.g.:

● Save &&& Close

Two "&" have the effect of underlining the next character.

One "&" has no effect.

The "Tooltip text" attribute can be assigned dynamic properties by means of the name 
"ToolTipText".

Trend (trend)
The attribute "Trend" is used for the Tool Graphic Object Update Wizard and is not evaluated 
for the object.

The "Trend" attribute can be made dynamic with the name "trend."

Trend (Trend)
The trend display enables a fast overview of changes for the bar. As standard, when the values 
shown in the scale are exceeded, a small arrow is displayed beside the scale to indicate that 
the measured value cannot be displayed on the scale. In order to avoid having to wait for the 
next update, an additional arrow can be shown on the other side of the bar to show the trend 
of the current movement of the bar.

The "Trend" attribute specifies whether or not the trend is displayed.

Yes The trend is displayed.
No The trend is not displayed.

The "Trend" attribute can be made dynamic with the name "Trend".
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Caption (CaptionText)
The "Caption" attribute specifies which text appears in the title of a picture window.

The "Caption" attribute can be made dynamic with the name "CaptionText".

Independent window
The "Independent window" attribute defines whether the display of the picture window in 
runtime depends on the process picture in which the picture window was configured. 

Yes Size and position of the picture window change with the shift or scaling of the process 
picture 

No Size and position of the picture window are independent of the process picture and 
only defined by the "Window mode" attribute 

The "Independent window" attribute can be made dynamic with the name 
"IndependentWindow". 

Tag Prefix (TagPrefix)
WinCC offers a wide variety of possibilities to define and structure tags. For a picture window, 
a tag prefix can be assigned to precede all tags that are used in the picture. In this way, a 
picture that is embedded in a picture window retains access to its own tags while another 
accesses other tags.

The "Tag Prefix" attribute specifies the prefix that is placed before all tags present in the picture.

Changes to the tag prefix only take effect when the picture is loaded once again. When the 
picture is changed, this occurs automatically, otherwise the picture name must be reassigned.

The prefix can be freely defined, but must match the name of the structure tags. It must end 
with a period, for example "Structure2.".

The "Tag Prefix" attribute can be made dynamic with the name "TagPrefix".

The TagPrefix property is not available for the controls.

Visualize tag status (ShowBadTagState)
The "Visualize tag status" attribute defines whether the graphic object is grayed out when a 
bad QualityCode or tag status is detected. For both objects "extended analog display" and 
"extended status display," the attribute determines whether the settings for attributes "Grid 
Color of Quality code: "bad" and "Grid Color of Quality code: "uncertain" are used.

Yes If the quality code or the the tag status are poor, the object is grayed out or the 
settings for the grid color are used.

No If the quality code or the the tag status are poor, the object is not grayed out or 
the settings for the grid color are not used.

The "Visualize tag status" attribute can be made dynamic with the name "ShowBadTagState".
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Movable (Moveable)
The "Movable" attribute specifies whether or not a window can be moved in Runtime.

Yes The window can be moved in Runtime.
No The window can not be moved in Runtime.

The "Movable" attribute cannot be made dynamic.

Foreground (OnTop)
The "Foreground" attribute specifies whether or not a window lies in the foreground. This 
setting is independent of the layer in which the window lies.

If two windows overlap, and they both have the value "Yes" for the "Foreground" attribute, the 
settings exclude one another.

Yes The window is always in the foreground.
No The window is not always in the foreground.

The "Foreground" attribute cannot be made dynamic.

Value (OutputValue)
With the attribute "Value", you define the linking with any analog/text tag. The analog display 
represents the value of this tag in the configured colors depending on the alarm state.

The "Value" attribute can be made dynamic with the name "OutputValue".

Value as Text (UseValueText)
The attribute "Value as Text" shows whether a text tag is linked instead of a formatted analog 
value.

Yes The value is linked with a text tag.
No The value is not linked with a text tag

The "Value as Text" attribute can be made dynamic with the name "UseValueText".

Inherit status [WinCC V6]
The statuses of the "Display" and "Use release" properties of the user object can be inherited 
by the individual objects of the user object.

Example: You have configured the "Inherit status" properties for the user object with "Yes" and 
"Display" as "Visible". One object of the user object has the property "invisible". If the user 
object is now made invisible and then again visible, then all objects of the user object are 
shown as visible even if one object of the user object has the property "invisible".

The "Inherit Status" attribute cannot be made dynamic.
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3.10.16 "Lock" Property Group

3.10.16.1 Lock Display (LockStatus)
The "Lock Display" attribute defines for the marked group display whether a locked measuring 
point should be displayed. The lock applies to all the buttons of the group display.

The attributes "Lock Display Text", "Lock Text Color" and "Lock Background Color" are only 
evaluated if the attribute "Lock Display" has the value "Yes".

Yes A locked measuring point is displayed as locked.
No A locked measuring point is not displayed as locked. The queued message classes 

are displayed normally.

The "Lock Display" attribute can be made dynamic with the name "LockStatus".

3.10.16.2 Lock Display Text (LockText)
The "Lock Display Text" attribute specifies the text that is displayed as button label for a locked 
measuring point. The value applies to all the buttons of the selected group display.

The "Lock Display Text" attribute is only evaluated if the "Lock Display" attribute has the value 
"Yes".

The "Lock Display Text" attribute can be made dynamic with the name "LockText".

3.10.16.3 Lock Background Color (LockBackColor)
The "Lock Background Color" attribute specifies the background color that the buttons assume 
for a locked measuring point. The value applies to all the buttons of the selected group display.

The "Lock Background Color" attribute is only evaluated if the "Lock Display" attribute has the 
value "Yes".

The "Lock Background Color" attribute can be made dynamic with the name "LockBackColor".

3.10.16.4 Lock Text Color (LockTextColor)
The "Lock Text Color" attribute specifies the color that the button labels assume for a locked 
measuring point. The value applies to all the buttons of the selected group display.

The "Lock Text Color" attribute is only evaluated if the "Lock Display" attribute has the value 
"Yes".

The "Lock Text Color" attribute can be made dynamic with the name "LockTextColor".
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3.10.17 "Styles" Property Group

3.10.17.1 3D Border Width (BackBorderWidth)
The "3D Border Width" attribute defines the line width of a 3D border. The values are specified 
in pixels.

= 0 The object has no 3D border.
> 0 There is a free choice of value depending on the object size.

The "3D Border Width" attribute can be made dynamic with the name "BackBorderWidth".

3.10.17.2 Bar Pattern (FillStyle2)
The "Bar Pattern" attribute specifies the fill pattern for display of the bar area.

So that the fill pattern becomes visible, the color of the fill pattern must differ from that of the 
background. The "Solid" fill pattern fills the object with the set background color; the 
"Transparent" fill pattern defines that neither a background nor a fill pattern are displayed.

There is a choice of 45 fill patterns.

The "Bar Pattern" attribute can be made dynamic with the name "FillStyle2".

3.10.17.3 Border Weight (BackBorderWidth)
The "Border Weight" attribute defines the width of the border of a slider. The values are 
specified in pixels.

= 0 The object has no border.
> 0 There is a free choice of value depending on the object size.

The "Border Width" attribute can be made dynamic with the name "BackBorderWidth".

3.10.17.4 Display as DropDownList
The "Display as DropDownList" attribute displays all entries of the text box in a drop-down box.

The "Display as DropDownList" attribute cannot be made dynamic.

3.10.17.5 Latch Down (Toggle)
The "Latch Down" attribute specifies whether or not a round button latches down. The setting 
of the "Latch Down" attribute is only visible in runtime.

The initial position of the round button can be set using the "Pressed" attribute.
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Yes The round button latches down in the new switch setting when pressed. In order 
to release it, it must be pressed again.

No On pressing, the round button jumps back to the initial position.

The "Latch Down" attribute can be made dynamic with the name "Toggle".

3.10.17.6 Box Alignment (BoxAlignment)
The "Box Alignment" attribute defines the arrangement of the buttons in a check box or option 
group. The buttons can be arranged to the right or left of the descriptive text.

The descriptive text of the buttons can be aligned using the "Text Orientation", "X Alignment" 
and "Y Alignment" attributes in the "Font" property group.

Aligned Left The buttons appear in the field aligned left.
Aligned Right The buttons appear in the field aligned right.

The "Box Alignment" attribute can be made dynamic with the name "BoxAlignment".

3.10.17.7 Fill Pattern (FillStyle)
The "Fill Pattern" attribute specifies the pattern for display of the picture background. So that 
the fill pattern becomes visible, the color of the fill pattern must differ from that of the 
background. 

There is a choice of 49 fill patterns. The "Solid" fill pattern 1 fills the object with the set 
background color; the "Transparent" fill pattern 2 defines that neither a background nor a fill 
pattern are displayed. 

The "Fill Pattern" attribute can be made dynamic with the name "FillStyle".

3.10.17.8 Fill Pattern (FillStyle)
The "Fill Pattern" attribute specifies the pattern for display of the background areas. So that 
the fill pattern becomes visible, the color of the fill pattern must differ from that of the 
background. 

There is a choice of 49 fill patterns. The "Solid" fill pattern 1 fills the object with the set 
background color; the "Transparent" fill pattern 2 defines that neither a background nor a fill 
pattern are displayed. 

The "Fill Pattern" attribute can be made dynamic with the name "FillStyle". 

3.10.17.9 Pressed (Pressed)
The "Pressed" attribute specifies whether a round button is displayed in the initial position as 
"pressed" or "not pressed".

The "Latch Down" attribute specifies whether or not a round button latches down when pressed.
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Yes The round button has the initial position "pressed".
No The round button has the initial position "not pressed".

The "Pressed" attribute can be made dynamic with the name "Pressed".

3.10.17.1
0

Background (Background)

The "Background" attribute specifies whether a 3D bar is displayed with or without a 
background.

Yes The background of the 3D bar is visible.
No The background of the 3D bar is not visible.

The "Background" attribute can be made dynamic with the name "Background".

3.10.17.1
1

Light Effect (LightEffect)

The "Light Effect" attribute specifies whether or not the 3D bar is displayed as illuminated.

Yes The 3D bar is displayed spatially by means of a bright/dark contrast.  
No The 3D bar is displayed as normal.  

The "Light Effect" attribute can be made dynamic with the name "LightEffect".

3.10.17.1
2

Line Style (BorderStyle)

The "Line Style" attribute specifies the style in which a line appears. For example, a dotted or 
dashed representation is possible.

A line with line width of  1 pixel can be displayed in two colors. To do so, you must select a 
broken line style and assign another color to the background of the line. If the line color is 
identical to the line background color in the "Colors" property group, breaks in the line are 
invisible.

There is a choice of 5 line styles.

The "Line Style" attribute can be made dynamic with the name "BorderStyle".

Line termination
The "Line termination" attribute determines the appearance of the line termination. The 
definition of the attribute applies to both ends of the line. Select one of the three following 
options:
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● A round termination sets the center of a circle at the end point of the line. The diameter of 
the circle adapts to the line width.

● A rectangular termination set the center of a square at the end point of the line. The width 
and height of the square adapts to the line width.

● A flat termination ends the line at its end points.

Corners
The "Corners" attribute define the appearance of the corner intersections of where lines meet. 
The definition applies to all the corners of the object. Select one of the three following options:

● A round corner sets the center of a circle at the intersection of two line ends. The diameter 
of the circle adapts to the line width.

● The two outer corner points of the line connection are linked by a straight line. This flattening 
effect causes the corners to appear beveled.

● A pointed corner corresponds to the real corner intersection of the meeting lines.

The "Line termination" and "Corners" attributes cannot be dynamized.

3.10.17.1
3

Line End Style (BorderEndStyle)

The "Line End Style" attribute specifies in which style the ends of a line appear. The ends of 
a line can be designed differently. It is possible, for example, that a line begins with a dot and 
ends with an arrow.

There is a choice of 7 line end styles.

The "Line End Style" attribute can be made dynamic with the name "BorderEndStyle".

3.10.17.1
4

Line Weight (BorderWidth)

The "Line Weight" attribute specifies the width of a line. The value is specified in pixels.

In order to display a line in two colors, select the broken line style and assign the "Line color" 
and "Line background color" attributes with different colors. In Design WinCC Classic, only 
one line can be displayed with a 1 pixel line weight. 

0 - 100 There is a free choice of value within the limits. With line weight 0, no line is 
visible.

The "Line weight" attribute can be made dynamic with the name "BorderWidth".
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3.10.17.1
5

Line connection type (LineJoinStyle)

The "Line connection type" attribute defines the way that corners are displayed in a tube 
polygon. 

Angle The tubes are joined at corner points without rounding
Round The tubes are rounded at the outside corner points. 

The attribute "Line connection type" can be made dynamic with the name "LineJoinStyle". 

3.10.17.1
6

Pattern alignment (Fill Style Alignment)

The "Pattern alignment" attribute defines the alignment of the fill pattern for the process picture. 

Normal The fill pattern refers to the process picture. In runtime, no scaling is 
performed when opening the picture.  

Stretched 
(window)

The fill pattern refers to the window in the Graphics Designer. In runtime, 
scaling is performed when opening the picture.  

The "Pattern alignment" attribute can be made dynamic with the name "FillStyleAlignment". 

3.10.17.1
7

Draw Border Inside (DrawInsideFrame)

For all line thicknesses greater than 1, the "Draw Border Inside" attribute defines whether the 
border lines are to be drawn inside the object frame or symmetrically on the frame.

The following objects have the "Draw Border Inside" attribute:

Ellipse, circle, ellipse segment, circlular segment, ellipse arc, circle arc, rectangle, round 
rectangle, static text, graphic object, status display, button, checkbox, radio box, slider object.

Yes The border lines are drawn inside the object frame.
No The border lines are drawn symmetrically on the object frame.

The "Draw Border Insider" attribute cannot be made dynamic.

3.10.17.1
8

Border Style (BorderStyle)

The "Border Style" attribute specifies the style in which a border appears. For example, a dotted 
or dashed representation is possible.

A border with border width 1 pixel can be displayed in two colors. To do so, you must select 
a broken border style and assign another color to the background of the border. If the border 
color is identical to the border background color in the "Colors" property group, breaks in the 
border are invisible.
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There is a choice of 5 border styles.

The "Border Style" attribute can be made dynamic with the name "BorderStyle".

3.10.17.1
9

Border Width (BorderWidth)

The "Border Width" attribute specifies the width of a border. The values are specified in pixels.

A border with border width 1 pixel can be displayed in two colors. To do so, you must select 
a broken border style and assign another color to the background of the border. If the border 
color is identical to the border background color in the "Colors" property group, breaks in the 
border are invisible.

0 - 100 There is a free choice of value within the limits.          
With border width 0, no border is visible.  

The "Border Width" attribute can be made dynamic with the name "BorderWidth".

3.10.17.2
0

Dividing Line Style (ItemBorderStyle)

The "Dividing Line Style" attribute specifies in which style the separation lines in a selection 
list appear. For example, a dotted or dashed representation is possible. The setting of the 
"Dividing Line Style" attribute is only visible in runtime.

If a broken dividing line style (e.g. dashed, dotted) is chosen, only the dividing line weights 0 
pixel and 1 pixel can be displayed.

There is a choice of 5 dividing line styles.

The "Dividing Line Style" attribute can be made dynamic with the name "ItemBorderStyle".

3.10.17.2
1

Dividing Line Weight (ItemBorderWidth) 

The "Dividing Line Weight" attribute specifies the width of a dividing line. The values are 
specified in pixels. The setting of the "Dividing Line Weight" attribute is only visible in Runtime.

If a broken dividing line style (e.g. dashed, dotted) is chosen, only the dividing line weights 0 
pixel and 1 pixel can be displayed.

0 - 10 There is a free choice of value within the limits. With dividing line weight 0, 
no dividing line is visible.

The "Dividing Line Weight" attribute can be made dynamic with the name "ItemBorderWidth".
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3.10.17.2
2

Windows Style (WindowsStyle)

The "Windows Style" attribute specifies for the "Button" or "Slider" objects whether the style 
for the display of the objects in the Graphics Designer is set or taken from the default settings 
of the Windows operating system.

A change to the "Border Width" or "Background Color" attributes sets the value of the "Windows 
Style" attribute to "No" if the new values do not match the default settings

Yes The objects are displayed according to the default settings of the Windows 
operating system. Attributes that do not match the Windows style are ignored.

No The objects are displayed according to the settings of the Graphics Designer.

The "Windows Style" attribute can be made dynamic with the name "WindowsStyle".

3.10.18 "Connected Objects" Property Group

3.10.18.1 Index of the Connection Point of the First Object Connected 
(TopConnectedConnectionPointIndex)

The "Index of the Connection Point of the First Object Connected" attribute specifies for the 
start of the connector at which connection point of the object the connection is formed.

The "Index of the Connection Point of the First Object Connected" attribute can be made 
dynamic with the name "TopConnectedConnectionPointIndex".

3.10.18.2 Index of the Connection Point of the Object Connected at the End 
(BottomConnectedConnectionPointIndex)

The "Index of the Connection Point of the Object Connected at the End" attribute specifies for 
the end of the connector at which connection point of the object the connection is formed.

The "Index of the Connection Point of the Object Connected at the End" attribute can be made 
dynamic with the name "BottomConnectedConnectionPointIndex".

3.10.18.3 Object Name of the First Object Connected (TopConnectedObjectName)
The "Object Name of the First Object Connected" attribute specifies the object that is 
connected to the start of the connector.

The "Object Name of the First Object Connected" attribute can be made dynamic with the 
name "TopConnectedObjectName".

3.10.18.4 Object Name of the Object Connected at the End (BottomConnectedObjectName)
The "Object Name of the Object Connected at the End" attribute specifies the object that is 
connected to the end of the connector.

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
802 System Manual, 11/2008,  



The "Object Name of the Object Connected at the End" attribute can be made dynamic with 
the name "BottomConnectedObjectName".

3.10.18.5 Change Orientation (Orientation)
The "Change Orientation" attribute reverses the definition of "Start" and "End" of the connector, 
including the current assignments

The "Change Orientation" attribute can be made dynamic with the name "Orientation".

3.10.18.6 Connection Type (ConnectorType)
The "Connection Type" attribute defines the type of connector. It is possible to select between 
two connection types.

Automatic Both objects are connected by a polyline made up of 
horizontal and vertical parts.

Simple Both objects are connected by a straight line between the 
connecting points.

The "Connection Type" can be dynamized with the name "ConnectorType".

"Assignment" Property Group

3.10.19 "Assignment" Property Group

3.10.19.1 Message Types for Button 1 (Button1Messagetype)
Define one or more message events for displaying the first button in the group display. This is 
done by entering the numbers of the bits in the collect value. The display of the message events 
is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 1" attribute can be made dynamic with the name 
"Button1Messagetype".

3.10.19.2 Message Types for Button 2 (Button2Messagetype)
For displaying both buttons, define one or more message events in the group display. This is 
done by entering the number of the bit in the  collect value. The display of the message events 
is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

Creating Process Pictures
3.10 Object properties

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  803



One event can be displayed simultaneously in more than one button.

The "Message Types for Button 2" can be made dynamic with the name 
"Button2Messagetype".

3.10.19.3 Message Types for Button 3 (Button3Messagetype)
For displaying the third button, define one or more message events in the group display. This 
is done by entering the number of the bit in the collect value. The display of the message events 
is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 3" attribute can be made dynamic with the name 
"Button3Messagetype".

3.10.19.4 Message Types for Button 4 (Button4Messagetype)
For displaying the fourth button, define one or more message events in the group display. This 
is done by entering the number of the bit in the collect value. The display of the message events 
is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 4" attribute can be made dynamic with the name 
"Button4Messagetype".

3.10.19.5 Message Types for Button 5 (Button5MessageType)
For displaying the fifth button, define one or more message events in the group display. This 
is done by entering the number of the bit in the collect value. The display of the message events 
is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 5" attribute can be made dynamic with the name 
"Button5Messagetype".

3.10.19.6 Message Types for Button 6 (Button6Messagetype)
For displaying the sixth button, define one or more message events in the group display. This 
is done by entering the number of the bit in the collect value. The display of the message events 
is configured in the "Message Types" property group.
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If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 6" can be made dynamic with the name 
"Button6Messagetype".

3.10.19.7 Message Types for Button 7 (Button7Messagetype)
For displaying the seventh button, define one or more message events in the group display. 
This is done by entering the number of the bit in the collect value. The display of the message 
events is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 7" attribute can be made dynamic with the name 
"Button7Messagetype".

3.10.19.8 Message Types for Button 8 (Button8Messagetype)
For displaying the eighth button, define one or more message events in the group display. This 
is done by entering the number of the bit in the collect value. The display of the message events 
is configured in the "Message Types" property group.

If you want to assign several message events, separate the numbers with a comma. The 
sequence of the assignment defines the priority. If there are more than one selected event for 
one button, the event that has been entered first is displayed.

One event can be displayed simultaneously in more than one button.

The "Message Types for Button 8" attribute can be made dynamic with the name 
"Button8Messagetype".

3.10.20 "Status" Property Group

3.10.20.1 Current Status (Index)
The "Current Status" attribute shows the identification number of the currently selected status. 
Changing the value specified here selects the individual statuses of a status display to specify 
the settings of the other attributes in the "Status" property group.

4,294,967,296 different states can be shown for a status display. The permitted value range 
is from 0 to 4.294.967.295 (= 232 - 1).

The "Current Status" attribute can be made dynamic with the name "Index".
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3.10.20.2 Bit Selection 0 (BitSelect0)
"Bit Selection 0" indicates the status tag that you have defined for the first bit of the status 
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".

0 The first bit of the status value is not evaluated. No status tag is used.
1 Status tag "Status1" is used for the status value of the first bit.
2 Status tag "Status2" is used for the status value of the first bit.
3 Status tag "Status3" is used for the status value of the first bit.
4 Status tag "Status4" is used for the status value of the first bit.

The "Bit Selection 0" attribute can be made dynamic with the name "BitSelect0".

3.10.20.3 Bit Selection 1 (BitSelect1)
"Bit Selection 1" indicates the status tag that you have defined for the second bit of the status 
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".

0 The second bit of the status value is not evaluated. No status tag is used.
1 Status tag "Status1" is used for the status value of the second bit.
2 Status tag "Status2" is used for the status value of the second bit.
3 Status tag "Status3" is used for the status value of the second bit.
4 Status tag "Status4" is used for the status value of the second bit.

The "Bit Selection 1" attribute can be made dynamic with the name "BitSelect1".

3.10.20.4 Bit Selection 2 (BitSelect2)
"Bit Selection 2" indicates the status tag that you have defined for the third bit of the status 
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".

0 The third bit of the status value is not evaluated. No status tag is used.
1 Status tag "Status1" is used for the status value of the third bit.
2 Status tag "Status2" is used for the status value of the third bit.
3 Status tag "Status3" is used for the status value of the third bit.
4 Status tag "Status4" is used for the status value of the third bit.

The "Bit Selection 2" attribute can be made dynamic with the name "BitSelect2".

3.10.20.5 Bit Selection 3 (BitSelect3)
"Bit Selection 3" indicates the status tag that you have defined for the fourth bit of the status 
value. The tags are defined in the "Miscellaneous" property group under "Status1" to "Status4".

0 The fourth bit of the status value is not evaluated. No status tag is used.
1 Status tag "Status1" is used for the status value of the fourth bit.
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2 Status tag "Status2" is used for the status value of the fourth bit.
3 Status tag "Status3" is used for the status value of the fourth bit.
4 Status tag "Status4" is used for the status value of the fourth bit.

The "Bit Selection 3" attribute can be made dynamic with the name "BitSelect3".

3.10.20.6 Flash Picture
The "Flash Picture" attribute specifies which flash picture is to be displayed for the currently 
selected status. Pictures with the following formats can be inserted: EMF, WMF, DIB, BMP.

If no flash picture  has been defined for the selected status, the symbol for the status display 
is shown as a placeholder during flashing. The flashing is only visible in Runtime.

The "Flashing Flash Picture Active" attribute must have the value "Yes".

The flash picture should have the same picture size as the basic picture, otherwise, its display 
is distorted.

 In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in 
the "Picture Selection" dialog.

The "Flash Picture" attribute cannot be made dynamic.

3.10.20.7 Flash Picture (FlashPicture)
The "Flash Picture" attribute specifies which flash picture is to be displayed for the currently 
selected status. Pictures with the following formats can be inserted: EMF, WMF, BMP, GIF, 
JPG.

The flashing is only visible in Runtime.

The flash picture should have the same picture size as the basic picture, otherwise, its display 
is distorted.

The "Flash Picture" attribute can be made dynamic with the name "FlashPicture".

3.10.20.8 Flash Picture Referenced (FlashPicReferenced)
The "Status Display" object can have an almost infinite number of different statuses.         
 For each status, you can choose a basic picture and a flash picture. The "Flash Picture 
Referenced" attribute specifies whether the flash picture for the selected status itself or only 
the reference in the form of a cross-reference to the picture is integrated.

Yes Only the reference of the picture is integrated and saved.
No The picture itself is integrated and saved.

The "Flash Picture Referenced" attribute cannot be made dynamic.

3.10.20.9 Flash Picture Transparent Color (FlashPicTransColor)
The "Flash Picture Transparent Color" attribute specifies the transparent color of the flashing 
picture. Transparent colors can only be displayed for pictures in BMP or DIB format.
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The "Flash Picture Transparent Color" attribute can be assigned dynamic properties by means 
of the name "FlashPicTransColor".

3.10.20.1
0

Flash Picture Transparent Color On (FlashPicUseTransColor)

The "Flash Picture Transparent Color On" attribute specifies whether the "Transparent Color" 
function is to be used for the picture to be displayed. Transparent colors can only be displayed 
for pictures in BMP or DIB format.

Yes The "Flash Picture Transparent Color On" attribute is enabled.
No The "Flash Picture Transparent Color On" attribute is disabled.

The "Flash Picture Transparent Color On" attribute can be assigned dynamic properties by 
means of the name "FlashPicUseTransColor".

3.10.20.1
1

Flashing Flash Picture Active (FlashFlashPicture)

The "Flashing Flash Picture Active" attribute specifies whether in runtime only the basic picture 
is displayed or the basic picture and the flash picture alternate in the display.

If no flash picture has been defined, a symbol is displayed as placeholder in runtime.

Yes In Runtime, the basic picture and flash picture alternate in the display.
No Only the basic picture is displayed in Runtime.

The "Flashing Flash Picture Active" attribute can be made dynamic with the name 
"FlashFlashPicture".

3.10.20.1
2

Flash Picture Flash Frequency(FlashRateFlashPic)

The "Flash Picture Flash Frequency" attribute specifies how quickly the basic picture and flash 
picture alternate in Runtime. The frequencies "slow", "medium" and "fast" can be set. The flash 
frequency depends on the system performance.

The "Flashing Flash Picture Active" attribute must have the value "Yes".

Slow In Runtime, the basic picture and flash picture alternate slowly.
Medium In Runtime, the basic picture and flash picture alternate at medium speed.
Fast In Runtime, the basic picture and flash picture alternate quickly.

The "Flash Picture Flash Frequency" attribute can be made dynamic with the name 
"FlashRateFlashPic".
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3.10.20.1
3

Basic Picture (BasePicture)

The "Basic Picture" attribute specifies which picture is to be displayed for the currently selected 
status. Pictures with the following formats can be inserted: EMF, WMF, DIB, BMP.

If no picture that you want to display is defined for a status, the symbol for the status display 
is shown as a placeholder.

In order to cancel an existing assignment, the "Cancel Selection" button must be clicked in the 
"Picture Selection" dialog.

The "Basic Picture" attribute cannot be made dynamic.

3.10.20.1
4

Basic Picture (BasePicture)

The "Basic Picture" attribute shows which picture is to be displayed for the currently selected 
status. Pictures with the following formats can be inserted: EMF, WMF, BMP, GIF, 
JPG.         
 If no picture that you want to display is defined for a status, the symbol for the status display 
is shown as a placeholder.

The "Basic Picture" attribute can be made dynamic with the name "BasePicture".

3.10.20.1
5

Basic Picture Referenced (BasePicReferenced)

The "Status Display" object can have an almost infinite number of different statuses.         
 For each status, you can choose a basic picture and a flash picture. The "Basic Picture 
Referenced" attribute specifies whether the basic picture for the selected status itself or only 
the reference in the form of a cross-reference to the picture is integrated.

Yes Only the reference of the picture is integrated and saved.
No The picture itself is integrated and saved.

The "Basic Picture Referenced" attribute cannot be made dynamic.

3.10.20.1
6

Basic Picture Transparent Color (BasePicTransColor)

The "Basic Picture Transparent Color" attribute specifies the transparent color of a picture. 
Transparent colors can only be displayed for pictures in BMP or DIB format.

The "Basic Picture Transparent Color" attribute can be assigned dynamic properties by means 
of the name "BasePicTransColor".
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3.10.20.1
7

Basic Picture Transparent Color On (BasePicUseTransColor)

The "Basic Picture Transparent Color On" attribute specifies whether the "Transparent Color" 
function is to be used for the picture to be displayed. Transparent colors can only be displayed 
for pictures in BMP or DIB format.

Yes The "Basic Picture Transparent Color On" attribute is enabled.
No The "Basic Picture Transparent Color On" attribute is disabled.

The "Basic Picture Transparent Color On" attribute can be assigned dynamic properties by 
means of the name "BasePicUseTransColor".

3.10.20.1
8

Highest Index (MaxIndex)

The "Highest Index" attribute shows the highest index of all configurable alarm and status 
combinations.

The "Highest Index" attribute can be made dynamic with the name "MaxIndex".

3.10.20.1
9

Index (Index)

The "Index" attribute shows the index of the currently selected state. By changing the value 
specified here, you can define the object properties for this index in the property group "Status".

The "Index" attribute can be made dynamic with the name "Index".

3.10.20.2
0

Priority Bit 16 (PrioBit16)

The "Priority Bit 16" indicates the priority of bit 16 (measuring point locked) in the collect value 
for the alarm evaluation for the extended analog and status display. The alarm evaluation starts 
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 16" attribute can be made dynamic with the name "PrioBit16".

3.10.20.2
1

Priority Bit 17 (PrioBit17)

The "Priority Bit 17" indicates the priority of bit 17 (OS status) in the collect value for the alarm 
evaluation for the extended analog and status display. The alarm evaluation starts at the 
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority 
0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 17" attribute can be made dynamic with the name "PrioBit17".
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3.10.20.2
2

Priority Bit 18 (PrioBit18)

The "Priority Bit 18" indicates the priority of bit 18 (AS status) in the collect value for the alarm 
evaluation for the extended analog and status display. The alarm evaluation starts at the 
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority 
0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 18" attribute can be made dynamic with the name "PrioBit18".

3.10.20.2
3

Priority Bit 19 (PrioBit19)

The "Priority Bit 19" indicates the priority of bit 19 (operator input message) in the collect value 
for the alarm evaluation for the extended analog and status display. The alarm evaluation starts 
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 19" attribute can be made dynamic with the name "PrioBit19".

3.10.20.2
4

Priority Bit 20 (PrioBit20)

The "Priority Bit 20" indicates the priority of bit 20 (operator instruction) in the collect value for 
the alarm evaluation for the extended analog and status display. The alarm evaluation starts 
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 20" attribute can be made dynamic with the name "PrioBit20".

3.10.20.2
5

Priority Bit 21 (PrioBit21)

The "Priority Bit 21" indicates the priority of bit 21 (system message) in the collect value for 
the alarm evaluation for the extended analog and status display. The alarm evaluation starts 
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 21" attribute can be made dynamic with the name "PrioBit21".

3.10.20.2
6

Priority Bit 22 (PrioBit22)

The "Priority Bit 22" indicates the priority of bit 22 (process message) in the collect value for 
the alarm evaluation for the extended analog and status display. The alarm evaluation starts 
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at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 22" attribute can be made dynamic with the name "PrioBit22".

3.10.20.2
7

Priority Bit 23 (PrioBit23)

The "Priority Bit 23" indicates the priority of bit 23 (maintenance instruction) in the collect value 
for the alarm evaluation for the extended analog and status display. The alarm evaluation starts 
at the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 23" attribute can be made dynamic with the name "PrioBit23".

3.10.20.2
8

Priority Bit 24 (PrioBit24)

The "Priority Bit 24" indicates the priority of bit 24 (AS control technology error) in the collect 
value for the alarm evaluation for the extended analog and status display. The alarm evaluation 
starts at the highest priority (priority 1). Bits that are not used for the alarm evaluation are 
assigned priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 24" attribute can be made dynamic with the name "PrioBit24".

3.10.20.2
9

Priority Bit 25 (PrioBit25)

The "Priority Bit 25" indicates the priority of bit 25 (AS control technology fault) in the collect 
value for the alarm evaluation for the extended analog and status display. The alarm evaluation 
starts at the highest priority (priority 1). Bits that are not used for the alarm evaluation are 
assigned priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 25" attribute can be made dynamic with the name "PrioBit25".

3.10.20.3
0

Priority Bit 26 (PrioBit26)

The "Priority Bit 26" indicates the priority of bit 26 (tolerance low) in the collect value for the 
alarm evaluation for the extended analog and status display. The alarm evaluation starts at 
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 26" attribute can be made dynamic with the name "PrioBit26".
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3.10.20.3
1

Priority Bit 27 (PrioBit27)

The "Priority Bit 27" indicates the priority of bit 27 (tolerance high) in the collect value for the 
alarm evaluation for the extended analog and status display. The alarm evaluation starts at 
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 27" attribute can be made dynamic with the name "PrioBit27".

3.10.20.3
2

Priority Bit 28 (PrioBit28)

The "Priority Bit 28" indicates the priority of bit 28 (warning low) in the collect value for the 
alarm evaluation for the extended analog and status display. The alarm evaluation starts at 
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 28" attribute can be made dynamic with the name "PrioBit28".

3.10.20.3
3

Priority Bit 29 (PrioBit29)

The "Priority Bit 29" indicates the priority of bit 29 (warning high) in the collect value for the 
alarm evaluation for the extended analog and status display. The alarm evaluation starts at 
the highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned 
priority 0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 29" attribute can be made dynamic with the name "PrioBit29".

3.10.20.3
4

Priority Bit 30 (PrioBit30)

The "Priority Bit 30" indicates the priority of bit 30 (alarm low) in the collect value for the alarm 
evaluation for the extended analog and status display. The alarm evaluation starts at the 
highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority 
0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 30" attribute can be made dynamic with the name "PrioBit30".

3.10.20.3
5

Priority Bit 31 (PrioBit31)

The "Priority Bit 31" indicates the priority of bit 31 (alarm high) in the collect value for the alarm 
evaluation for the extended analog and status display. The alarm evaluation starts at the 
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highest priority (priority 1). Bits that are not used for the alarm evaluation are assigned priority 
0.

If several bits are queued in the collect value, the status is determined by the priority.

The "Priority Bit 31" attribute can be made dynamic with the name "PrioBit31".

3.10.20.3
6

Status Word Bit 0 (BitPosition0)

The "Status Word Bit 0" indicates the bit position of the selected tag for bit 0 of the status value. 
The content is only evaluated, if a tag is selected for bit selection 0. The tags are defined in 
the "Miscellaneous" property group under "Status1" to "Status4".

Enter a value from 0 to 31. Each value can only be assigned once.

The "Status Word Bit 0" attribute can be made dynamic with the name "BitPosition0".

3.10.20.3
7

Status Word Bit 1 (BitPosition1)

The "Status Word Bit 1" indicates the bit position of the selected tag for bit 1 of the status value. 
The content is only evaluated, if a tag is selected for bit selection 1. The tags are defined in 
the "Miscellaneous" property group under "Status1" to "Status4".

Enter a value from 0 to 31. Each value can only be assigned once.

The "Status Word Bit 1" attribute can be made dynamic with the name "BitPosition1".

3.10.20.3
8

Status Word Bit 2 (BitPosition2)

The "Status Word Bit 2" indicates the bit position of the selected tag for bit 2 of the status value. 
The content is only evaluated, if a tag is selected for bit selection 2. The tags are defined in 
the "Miscellaneous" property group under "Status1" to "Status4".

Enter a value from 0 to 31. Each value can only be assigned once.

The "Status Word Bit 2" attribute can be made dynamic with the name "BitPosition2".

3.10.20.3
9

Status Word Bit 3 (BitPosition3)

The "Status Word Bit 3" indicates the bit position of the selected tag for bit 3 of the status value. 
The content is only evaluated, if a tag is selected for bit selection 3. The tags are defined in 
the "Miscellaneous" property group under "Status1" to "Status4".

Enter a value from 0 to 31. Each value can only be assigned once.

The "Status Word Bit 3" attribute can be made dynamic with the name "BitPosition3".
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Process Picture Dynamics 4
4 Resources

4.1 Process Picture Dynamics

Contents
This chapter shows you how to dynamize process pictures using WinCC. It contains 
information on

● Dynamizing Using Dynamic Wizard

● Dynamizing by Means of Tag Connection

● Dynamizing by Means of Direct Connection

● Dynamizing Using Dynamic Dialog

● Dynamizing Using VBS Action

● Dynamizing Using C Action

4.2 Types of Dynamization

Introduction
WinCC offers various ways of dynamizing the objects of a process picture.

Basically, there are two types of dynamization.
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● Dynamic objects change their appearance and position depending on, for example, a 
process value. An example of a dynamic object is a bar whose length is influenced by a 
current temperature, a pointer instrument with a moving pointer, or an object which changes 
color depending on the position of a workpiece.

● Operator-controllable objects react to events, e.g. a mouse-click, and enable the operator 
to actively intervene in the process. Operator-controllable objects can be, for example, 
buttons, sliders, or I/O fields used for entering certain process parameters.

Note

If you copy a dynamized object in the Graphics Designer, the dynamics are also copied. 
The copied object will then be affected by the dynamics in just the same way as the original 
object.

Graphics Designer will permit identical object names in a picture which differ only in lower 
and upper case letters. For dynamization of objects in a picture, however, you must assign 
a unique nomenclature. Differentiation of object names by upper and lower cases alone 
shall not be sufficient.

Dynamizing by Means of Direct Tag Connection
When a tag is connected to a property of an object, the value of the tag is transferred directly 
to the object property. This means, for example, that the value of a tag can be directly 
influenced by an I/O field.

Dynamization by means of tag connection is indicated in the Object Properties dialog with the 
 icon and the name of the tag.

Dynamizing by Means of Indirect Tag Connection
When a tag is connected to a property of an object, the value of the tag is interpreted as the 
tag name. The value of this tag is transferred to the object property. You configure an indirect 
tag connection by double-clicking the box in the "Indirect" column of the "Object Properties" 
dialog.

Dynamization by means of tag connection is indicated in the Object Properties dialog with the 
 icon and the name of the tag. The indirect tag connection is indicated with the icon  in 

the "Indirect" column of the "Object Properties" dialog.

Dynamizing by Means of Direct Connection
Direct connection is used for reacting to events. If the event occurs in Runtime, the value of a 
source element is used for a target element. The values of the source element and target 
element can be defined by:

● a constant

● a WinCC tag

● the value of an object property

Dynamizing by means of direct connection is indicated in the Object Properties dialog with the 
 icon.

Process Picture Dynamics
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Dynamizing Using Dynamic Dialog
The Dynamic dialog is used for dynamizing an object property. You should use the Dynamic 
dialog if you want to map the value of a tag to a value which can be interpreted by the operator. 
For example, you can use the Dynamic dialog to map the value range of a tag to color values.

Dynamizing using the Dynamic dialog is indicated in the Object properties dialog with the  
icon.

Dynamizing Using VBS Action
VBS actions are used to dynamize an object property or to react to events. You should use 
VBS actions if, for example, you want to process several input parameters in one action or you 
want to execute conditional instructions (if ... then ...).

Dynamization with a VBS action is indicated with the  icon in the "Object Properties" dialog.

Dynamizing Using C Action
C actions are used to dynamize an object property or to react to events. You should use C 
actions if, for example, you want to process several input parameters in one action or you want 
to execute conditional instructions (if ... then ...).

Dynamization with a C action is indicated with the  icon in the "Object Properties" dialog.

4.3 Using tag prefixes and server prefixes

Introduction
WinCC offers a wide variety of possibilities to define and structure tags. For a picture window, 
a tag prefix can be assigned to precede all tags that are used in the picture.

Pictures that are embedded can be stored on any server in a multi-user system. Either the 
server is specified directly on embedding a picture with the server prefix, or assigned later via 
the object properties of the picture window. Tags can also be requested from other servers 
with the server prefix.

TagPrefix Property
Use "TagPrefix" to define or return the tag prefix that is added to all tags, which are contained 
in the picture window object, or that returns a tag prefix. In this way, a picture that is embedded 
in a picture window retains access to its own tags while another picture accesses other tags.

Example: In a picture window the "temperature" tag is requested on an object. If the "Motor1." 
tag prefix is assigned to the picture window, the tag "Motor1.Temperature" is requested.

Note

The TagPrefix property is only provided for "WinCC Gauge Control" and "WinCC Slider 
Control" where controls are concerned.
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ServerPrefix Property
Use "ServerPrefix" to determine in a multi-user system:

● the server where the picture to be displayed in the picture window is located.

● the server, from which the tags are read.

Requesting tags without prefix
The example below shows a reason for requesting tags without prefix.

You want to read the local user using the "@CurrentUser" tag. In a multi-user system, or if the 
faceplate technology is used, the tag names are always preceded by a server prefix or a tag 
prefix. You can use the following tag add-ons to switch off the prefix in order to read the 
"@CurrentUser" tag.

● "@NOTP" switches off the tag prefix.

● "@NOSP" switches off the server prefix.

● "@NOP" switches off the tag prefix and the server prefix.

The add-ons cannot be used in the "TagPrefix" or "ServerPrefix" properties of a picture window 
or basic picture.

The add-ons are available in all dynamization types. It only makes sense to switch off the 
server prefix in the case of clients with their own project.

If a standard server is set up on a multi-user system, you cannot use the "@NOP" and 
"@NOSP" add-ons.

Tag prefixes will only function for tags.

Example
The following VBScript reads the "@CurrentUser" tag without tag prefix and outputs the content 
as a trace in a diagnostics window.

 
'VBS200
Dim tag
tag = HMIRuntime.Tags("@NOTP::@CurrentUser").Read
HMIRuntime.Trace "CurrentUser: " & tag & vbNewLine

 

Note

The setting of the prefix only becomes effective when newly supplying the picture name. This 
means you must either set the prefix before picture selection or newly supply the picture name 
if the picture is not changed.
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4.4 Trigger Types

4.4.1 Trigger Types

Introduction
Triggers are used to execute actions at runtime. To do this, a trigger is linked to an action, 
forming the triggering event for calling the action. Actions without triggers will not be carried 
out.

The following triggers are available for the dynamization of objects:

● Cyclic Triggers

● Cyclic Triggers Based on Window Cycle

● Cyclic Triggers Based on Picture Cycle

● Tag Triggers

● Event-Driven Triggers

Note

It is important to remember that the cycle time has a major effect on the performance of the 
project. All the actions of a picture must be completed within their cycle time. Apart from the 
runtimes of the actions, the times required for requesting the tag values and the reaction 
times of the automation systems must also be taken into consideration. You should only set 
trigger events with a cycle time under one second if variables which change rapidly have to 
be queried.

4.4.2 Cyclic Triggers

Introduction
Cyclic triggers are a means of processing periodic actions in WinCC. In the case of a cyclic 
trigger, the action is executed when the trigger event occurs, e.g. every 20 seconds.

Principle of Operation
When actions with a cyclical trigger are configured in a picture, each tag is requested 
individually following selection of the picture.

The start of the first time interval coincides with the start of Runtime. The length of the interval 
is determined by the cycle. Cycles between 250 ms and 1 h can be selected. Self-defined user 
cycles are also available.
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The action is always executed when the triggering event occurs.

Note

Depending on the system, it cannot be guaranteed that an action with a cyclic trigger is carried 
out at exactly the specified time.

Cyclic Triggers Based on Window Cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update 
Cycle of the Picture Window object. This cycle provides the option of defining the cycles of all 
the actions used in a picture window centrally.

Cyclic Triggers Based on Picture Cycle
A cyclic trigger is used as the trigger. The cycle time is defined by the object property Update 
Cycle of the picture object. This cycle provides the option of defining the cycles of all the actions 
used in a picture centrally.

Recommendation
In order that the WinCC project has a high level of performance, it is advantageous to dispense 
with actions which have a cyclical trigger and to realize periodic actions in the automation 
system.

4.4.3 Tag Triggers

Introduction
Tag triggers consist of one or more specified tags. The action which is connected to such a 
trigger is executed if a change in the value of one of these tags was detected when the query 
was launched.

Principle of Operation
When actions with tag triggers are configured in a picture, all the tag triggers related to an 
action are requested block by block when the picture is selected.
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The beginning of the first interval coincides with the point at which the picture is first selected. 
The length of the interval is determined by the cycle. Query cycles between 250 ms and 1 h 
can be selected. Self-defined user cycles are also available.

The action is only executed when the value of the tag triggers has changed.

Note

If a tag briefly changes within a query cycle and then resumes its original value, the action is 
not executed.

Note
Reaction in case of non-existing variables

A C/VBS action is not executed after screen selection if a non-existing tag is requested. The 
object is shown regardless. However, a dynamic dialog is executed once after screen 
selection. The object is not shown.

Upon change
You can also configure a tag trigger so that the action is executed whenever the tag value is 
changed.

The "On change" mode setting for process tags corresponds to a cyclic read request with a 
cycle time of 1 second.

Note

If the WinCC diagnostics tags are used as action triggers, this form of the tag trigger should 
not be used. Diagnostics tags can change very quickly. Since every change could trigger the 
action, it can lead to high system utilization.
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Recommendation
Tag triggers should be used in order that the WinCC project has a high performance level:

● With cyclic actions, the action is always executed, e.g. every 2 seconds. The tag trigger 
only executes the action if a change in the value of the tag has been detected. This reduces 
the load on the system and increases performance.

● When a picture is selected, all of the tags contained in tag triggers are known and can be 
requested all at the same time by the automation system. The best possible optimization 
can thus be achieved from the channel.

4.4.4 Event-Driven Triggers

Introduction
Actions which are connected to an event are executed whenever this event occurs. Events 
can be, for example, mouse control, keyboard control, or changes in focus.

If the Mouse Control event is connected to an action, this action is also triggered by a configured 
hotkey.

Mode of Operation
The action is only executed when the object's triggering event is triggered. If the event occurs, 
all the tags contained in the action are registered. Process tags are subsequently updated at 
a cycle time of 1 s.

Recommendation
Event-driven triggers are not suitable for bulk configuration in the case of dynamizing with C-
actions because each action must be logged on and off individually by the action control.

4.5 Dynamic Wizard

4.5.1 Dynamizing Using Dynamic Wizard

Introduction
With the Dynamic Wizard, you can dynamize an object using C actions. When you execute a 
wizard, preconfigured C actions and trigger events are defined and transferred to the object 
properties. If necessary, you can change the C actions in the object properties using the Events 
tab.
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Dynamic Wizard

The preconfigured C actions are divided into the following groups:

● System functions

● Standard dynamics

● Picture components

● Import functions

● Picture functions

● SFC

The available groups and the wizards contained in the groups depend on the WinCC 
installation type, the project type, and the selected object.

Note

You can use the Toolbars... item in the View menu of the Graphics Designer to show or hide 
the Dynamic Wizard.

See also
SFC (Page 836)

System Functions (Page 835)

Standard Dynamics (Page 829)

Import Functions (Page 828)

Picture Components (Page 827)

Picture Functions (Page 824)
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4.5.2 Picture Functions

 Updating Picture Objects

This wizard updates all user objects with type identification contained in the current WinCC 
picture or in the project.

The wizard is part of the Graphic Object Update functionality.

Note

The Wizard functionality is only available in a PCS7-OS.

 Changing User Object Connection

This wizard is used to change the individual connections of user objects at a later stage, e.g. 
connection to a different AS block instance.

The wizard is part of the Graphic Object Update functionality.

Note

The Wizard functionality is only available in a PCS7-OS.

 Picture Selection in Process Window

With this wizard you can create an action used to change a picture in the process window. The 
name of the picture to be displayed is specified in the wizard.

Note

This wizard is only available if the WinCC Basic Process Control and SFC Visualization option 
is installed and the project has been processed with the OS Project Editor.

 Picture Selection Via Measurement Point

With this wizard you can create an action used to select a picture by means of a measurement 
point which you must select. The name of the measurement point and of the picture to be 
displayed is specified in the wizard.

Note

This wizard is only available if the WinCC Basic Process Control and SFC Visualization option 
is installed and the project has been processed with the OS Project Editor.
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 Picture Selection Via Group Display

With this wizard you can create an action used to select a picture by means of a group display. 
If an alarm occurs in Runtime, the location (graphic) of this alarm is displayed.

Note

This wizard is only available if the WinCC Option Basic Process Control is installed, the project 
has been processed with the OS Project Editor, and a group display has been selected.

 Picture Navigation

This wizard creates an action which performs the selected picture navigation when the trigger 
occurs at the selected object.

The following picture navigation functions can be selected:

● Display Start Picture

● Display Previous Picture

● Display Next Picture

● Display Stored Picture

● Store Picture

Note

This wizard is only available if the project has not been processed with the OS - Project 
Editor.

 Picture Change in Working Area

With this wizard you can create an action used to change a picture in the working area. The 
name of the picture to be displayed is specified in the wizard.

Note

This wizard is only available if the WinCC Basic Process Control is installed and the project 
has been processed with the OS Project Editor.

 Picture Change in Window

This wizard is used to change the content of a window object in a Graphics Designer picture.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.
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 Simple Picture Change

With this wizard you can create an action used to change a picture. The name of the picture 
to be displayed is specified in the wizard.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

 Picture Object Export

This wizard exports user objects with type identifier contained in the current picture and in the 
project into an Excel table (.csv format). Information such as the object type and connection 
information is exported.

The wizard is part of the Graphic Object Update functionality.

Note

The Wizard functionality is only available in a PCS7-OS.

 Display Error Box

The wizard creates an action which displays a dialog. The type of dialog, info box, question 
box, or emergency box, and the title and text of the dialog must be specified in the wizard.

The action which calls the error box is not resumed until the box has been closed. Other actions 
which have been configured under the same trigger type in the same application are not 
triggered while the box is open.

If one of the buttons in the dialog is clicked in Runtime, the action is given a return value which 
you can evaluate in your script:

Button Return value
OK 1
Cancel 2
Yes 6
No 7

 

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.
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 Picture Object Import

This wizard imports user objects into WinCC pictures. The required information is normally 
read from a file that has earlier been generated and modified using the Dynamic Wizard "Export 
Picture Objects".

The wizard is part of the Graphic Object Update functionality.

Note

The Wizard functionality is only available in a PCS7-OS.

 Display WinCC Dialog

With this wizard you can display any picture of the Graphics Designer in a picture window. The 
name of the picture to be displayed and the appearance of the picture window is set in the 
wizard.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

See also
Dynamizing Using Dynamic Wizard (Page 822)

4.5.3 Picture Components

 Creating faceplate as type - V 1.14

This wizard is used to configure the assignment between the object properties of the picture 
and the structural components of a structured data type.

● Supply output value of an I/O field every second with .actual value

● Provide data to the process connection of a bar graph at intervals of two seconds. 
Temperature

Here .actual value and .temperature are components of a structured data type

The original picture has become a type picture.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

The WebNavigator does not support the basic faceplate technology of the wizard.
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 Creating instances in the plant picture - V 1.14

With this wizard you can create a picture window in a parent picture and then call a type picture 
in this picture window. When doing so, you specify which tag of a structured data type the 
picture window works with and at which position the picture window is placed. The instance 
wizard enables the positioning of picture windows in several ways:

● as a fixed component in the picture

● as a displayable component which can be called using a button

● as several displayable components which can each be called using a button

● as a fixed component with a selectable name .he name of the component can be pre-
assigned with a tag.

Note

This wizard is only available if the project has not been edited using the OS - Project Editor.

The WebNavigator does not support the basic faceplate technology of the wizard.

Picture Module Technology
The documentation concerning the Picture module technology explains the WinCC screen-in-
screen technology. An example project illustrates how to create and modify a picture module.

See also
Dynamizing Using Dynamic Wizard (Page 822)

4.5.4 Import Functions

 Import Messages

With this wizard you can import a COROS LS-B message list into WinCC. You will find further 
information in the WinCC Information System under WinCC Documentation, Smart Tools, 
Migration of COROS LS-B to WinCC.

 Import S5L, Tag Only

With this wizard you can import a COROS LS-B tag list into WinCC. You will find further 
information in the WinCC Information System under WinCC Documentation, Smart Tools, 
Migration of COROS LS-B to WinCC.

 Import S7 S5 ASLI

With this wizard you can read the assignment list of STEP 5 and STEP 7 into WinCC. You will 
find further information in the WinCC Information System under WinCC Documentation, Smart 
Tools, Importing Assignment List.
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See also
Dynamizing Using Dynamic Wizard (Page 822)

4.5.5 Standard Dynamics

 Operative with Authorization

With this Wizard you may generate an action to check the authorization level of a user.

 Link picture component with measuring point

Using the "Link Picture Component with Measuring Point" wizard you can link an existing 
picture component with the measuring points existing in the project.

Perform the following steps to establish such a link:

1. Open a picture with the desired picture component in Graphics Designer.

2. Select this picture component (mark the header, not the object contained within the picture 
component).

3. Select the "Standard Dynamics" tab in the "Dynamic Wizard" and start the wizard by double 
clicking it.

4. Follow the instructions in the Dynamic Wizard dialogs.

5. Using the tag selection dialog, the wizard will offer you all measuring points corresponding 
to the structure tag of the selected picture component. Select the desired measuring point.

6. Start the action by clicking the Finish button.

The wizard will link the objects of the picture component with the structure tags of the selected 
measuring point.

Note

The Wizard functionality is only available in a PCS7-OS. One component icon must have 
been selected.

 Bit Set/Reset

Using this wizard you may create an action to set or reset the bit of a tag. The tag to be changed 
as well as the bit number will be displayed during the wizard run

Color Dynamics - Create a New Entity

Dynamizations done using the "Color dynamics with table" wizard can also contain references 
to structure tags. For example: there can be a reference to a structure tag "Engine1" for a user 
object to display an engine. To copy this object, for e.g. for displaying another engine, then 
the references to the structure tag "Engine1" are to be modified.
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The wizard does the required changes by switching all references to "Engine1" to the new 
structure instance that is to be mentioned. This affects all dynamizations established through 
tag links or scripts. Excluded are dynamizations established through Dynamic Dialog.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

Color Dynamics With Table

Color attributes of graphics objects may be controlled during Runtime by using a table. Each 
table entry may be assigned a color and a logical expression. The logical expression is a link 
of bit information of one or several tags from the WinCC Tag Management. The table is 
prioritized. The top table entry has the highest priority, the lowest table entry the lowest priority. 
If several expressions are valid during Runtime, the one with the highest priority will be used.

After selecting a graphics object in Graphics Designer the wizard is ready to start. Initially the 
wizard lists all object properties from which a dynamic color property may be selected. 
Afterwards the update timer for the tag trigger is set. All used tags are entered as triggers. 
Upon reselection of the wizard, the settings for any color dynamization previously made are 
displayed again.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

 Set/Reset Several Bits

Using this wizard you may create an action to set or reset several bits of a tag. The tag to be 
changed as well as the number of the bits will be displayed during the wizard run.

 Network Entry Point

Using this wizard you may implement a direct network entry point during Runtime, triggered 
by an object event to be configured.

If the event occurs the program editor is started from STEP 7. At the same time a direct entry 
is made into the respective network.

In order to use the wizard, the following prerequisites must be met:

● the WinCC project with the picture to which entry is supposed to be made and the STEP 7 
project must be on the same computer

● the WinCC project must be created as a subdirectory of the STEP 7 project (STEP 7-Project
\wincproj\WinCC project)

● the S7 tags are mapped onto the WinCC tags

For the current object you specify an event which will trigger the entry. For e.g. "Click with the 
left mouse key" on a button. In addition, the selected WinCC tag will be linked with an attribute 
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of the current object, for example the background color of the button. This attribute is controlled 
by the contents of the WinCC tag upon modification of tag value.

Once the triggering event occurs on the respective object during Runtime, e.g., click with the 
left mouse button, the program editor (KOP, FUP, AWL) is started from STEP 7 and direct 
entry is made into the network defined by the selected tag.

 Move Object

The object properties "Position X" and "Position Y" can be linked with tags in the course of the 
wizard so that the position of the object can be dynamized.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

 Fill Object

With this wizard you may create an action to dynamize the fill level of an object through a tag. 
During the wizard run you may also define the tags as well as upper and lower limits for fill 
levels 0% and 100%.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

 Dynamize Prototype

With this wizard you may dynamize the object properties through a structure tag element.

 Dynamic Entity of Prototype

You can use this wizard to link an object property or user object edited using "Dynamize 
Prototype" in runtime with a tag of a structured data type.

The wizard can only be used if the selected object has the "tagname" property in the correct 
upper and lower case.

You can only use the wizard together with the "Link Prototype with Structure or Rename 
Existing Ones" wizard.

 Link Prototype with Structure or Rename Existing Ones

With this wizard you may link object properties to a structure or may rewire the link with a 
structure. 

The following options may be selected:
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● Change Object Name: The structure name is assumed as the object name.

● Check Structures: Checks if the stated structure is known.

● Remove Server Prefix: Removes server prefix from tag name.

This wizard makes all necessary changes by modifying all references to the new structure 
entity. This affects all dynamizations established through actions, direct links, or dynamic 
dialog. 

You can only use the wizard together with the "Dynamic Entity of Prototype" wizard.

 Link Group Display with Picture

The wizard is only offered for selection if a picture component or group display is marked in 
Graphics Designer.

With this wizard you may link the selected group display to a picture which is linked to additional 
group displays/picture components. In the selected group display in Runtime, you will see a 
display of the message states for the linked picture.

Note

This wizard is only available if the WinCC Basic Process Control is installed, the project has 
been processed with the OS Project Editor, and a group display has been selected.

 Link Group Display with PCS7 Measuring Point

The wizard is only offered for selection if a picture component or group display is marked in 
Graphics Designer.

With this wizard you may link an existing group display to the measuring points available in 
the project.

Note

This wizard is only available if the WinCC Basic Process Control is installed, the project has 
been processed with the OS Project Editor, and a group display has been selected.

 Actual Value Bar

Issues the tag content as actual value on a bar. Cycle time, tag name, minimum and maximum 
value, and zero of the bar display may be entered during the wizard run.

Note

This wizard is only available if a bar has been selected.
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See also
Color Dynamics with Table (Page 833)

Dynamizing Using Dynamic Wizard (Page 822)

4.5.6 Color Dynamics with Table

Dialog for the Creation of Color Dynamics
This dialog is used to define color changes which are controlled by tag states. The color can 
be determined by a single tag or by the logical combination of several tags.

AND and OR conditions are available as logical operations.

A maximum of 10 color definitions are possible. These are then processed in the listed 
sequence. Entries which are at the top of the table have a higher priority than entries which 
are at the bottom of the table. The last entry in the table is always the Default entry. Its priority 
cannot be changed.

Creating Color Change Table
Before new color conditions can be added, a new row must be inserted using the New button. 
The empty entry is then automatically highlighted and can be changed in the editing area for 
expressions. The editing area is below the table.
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 Properties button. All the bit masks in the selected row are displayed in sequence. They 
can be changed.

 Color button. This button opens the color selection dialog. The color selection dialog can 
also be opened by double-clicking the selected row.

 New List Entry button. This button inserts a new row in the table.

 Delete List button. All entries in the table are deleted, except for the entry other (table 
area).

 Delete Highlighted Entry button. The highlighted row is deleted.

 Up button. The selected row is moved up in the table and is thus given a higher priority.

 Down button. The selected row is moved down in the table and is thus given a lower 
priority.

Editing Expression

 Delete Entire Expression button. Deletes the entire expression.

Delete the Last Part of the Expression button. Deletes the last part of the expression.

Accept Expression in Table button. Transfers the expression into the highlighted table row.

Tag Selection button. Opens the tag selection dialog. All tags of the Bit, Byte, Word, and 
DWord type are displayed. When the tags have been selected, the tag bit mask appears in 
which the bits to be checked are set.

And button. If permitted syntactically, a logical AND operation is attached to the expression.

Or button. If permitted syntactically, a logical OR operation is attached to the expression.

Open Parenthesis button. If permitted syntactically, an opening parenthesis is attached to 
the expression.

Close Parenthesis button. If permitted syntactically, a closing parenthesis is attached to 
the expression.

Note

It is not possible to edit the expression manually.

Dialog for Creating Tag Bit Mask
This dialog is used to enter the tag bits to be checked.

Up to four bytes (only one bit in the case of binary tags) of the tag value are displayed. The 
states to be checked are entered here. An 'x' means that the bit is ignored.
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If '0' or '1' is entered, the state of the bits concerned is checked accordingly.

See also
Dynamizing Using Dynamic Wizard (Page 822)

4.5.7 System Functions

 Start Other Applications

With this wizard you can create an action which starts another application. The path and name 
of the application to be started is entered in the wizard.

 Hardcopy

With this wizard you can create an action for making a hardcopy of the screen.

 Set Up Redundant Connection

With this wizard you can create an action for SIMATIC S7 Protocol Suite which performs a 
dynamic connection switch.

Further information can be found in the description of S7 Protocol Suite.

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

 Language Switch

With this function you can create an action which switches the Runtime language.
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 Exit WinCC

With this wizard you can create an action which closes WinCC. The action only acts on the 
computer on which the action is executed (this also applies to multi-user systems).

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

 Exit WinCC or Windows

With this wizard you can create an action which closes WinCC or the operating system.  You 
can specify how the operating system is to be closed (Exit, Restart, Relogin). The action only 
acts on the computer on which the action is executed (this also applies to multi-user systems).

 Exit WinCC Runtime

With this wizard you can create an action which closes Runtime. The action only acts on the 
computer on which the action is executed (this also applies to multi-user systems).

Note

This wizard is only available if the project has not been processed with the OS - Project Editor.

See also
Dynamizing Using Dynamic Wizard (Page 822)

4.5.8 SFC

Introduction
The Sequential Function Chart (SFC) is a process control which is used to control the sequence 
of processes.

You can use the "SFC Visualization" software package using the WinCC configurations for 
SFC visualization and to use and observe the SFC plans and SFC instances in runtime.

The help becomes available when SFC is installed.

Note

You can find information about the Dynamic Wizard and SFC in the SFC documentation by 
searching for "Dynamic Wizard".
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Configuring SFC Control

You can use this wizard to link an existing "PCS 7 SFC Control" with a SFC-Plan or SFC-
Instance existing in the project. 

Requirement
● A "PCS 7 SFC Control" has been selected

Procedure
1. Open a picture with a "PCS 7 SFC Control" in Graphics Designer and select this control.

2. Select the "SFC" tab in the "Dynamic Wizard" and start the wizard by double clicking 
"Configure SFC Control".

3. Follow the instructions in the Dynamic Wizard dialogs.

4. The wizard offers all the available SFCs via the SFC selection dialog. Select an SFC.

5. Select the required representation for this SFC.

6. Start the action by clicking the "Next" button and confirm it by clicking "Finish". The wizard 
connects "PCS 7 SFC Control" with the selected SFC.

Note

The Wizard functionality is only available in a PCS7-OS.

 Configure SFC Browser

You can use this wizard to dynamize a graphic object, say a button, to open the SFC browser 
at runtime using configured operations and to select and display a SFC plan or a SFC instance. 

For additional information, see "SFC Visualization" in the PCS 7 description.

Note

The Wizard functionality is only available in a PCS7-OS.

 Configure SFC Button

You can use this wizard to dynamize a graphic object, say a button, to select and display a 
SFC plan or a SFC instance during runtime using configured operations. 

For additional information, see "SFC Visualization" in the PCS 7 description.

Note

The Wizard functionality is only available in a PCS7-OS.
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See also
Dynamizing Using Dynamic Wizard (Page 822)

4.6 Dynamizing by Means of Tag Connection

4.6.1 Dynamizing by Means of Tag Connection

Introduction
When a tag is connected to a property of an object, the value of the tag is transferred directly 
to the object property. This means, for example, that the value of a tag can be directly 
influenced by an I/O field.

You should always use this type of dynamization if you want to transfer the value of a tag 
directly to an object property.

See also
Example: Dynamic Filling of Rectangle (Page 840)

How to Configure a Tag Connection (Page 838)

Types of Dynamization (Page 815)

4.6.2 How to Configure a Tag Connection

Requirement
● Start Graphics Designer and open a picture.

Procedure
1. Open the Object Properties dialog of the object to be dynamized.

2. Click the Properties tab.

3. In the left-hand window area, select the property group to which the property you want to 
dynamize belongs.

4. In the right-hand window area, select the property which you want to dynamize.
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5. Right-click the  icon belonging to this property and select the Tag... command in the pop-
up menu.

The tag selection dialog is displayed.

6. Select the tag which you want to link to the property.

7. Close the tag selection dialog using the OK button.          
Dynamization by means of tag connection is indicated in the Object Properties dialog by 
the  icon and the name of the tag. The default trigger set in the Graphics Designer is 
used as the update cycle.

8. Check the update cycle and, if necessary, make changes using the pop-up menu.

Alternative Operation
You can also configure a tag connection by dragging a tag from the Tags toolbar onto the 

 icon.

You can also configure a tag connection by double-clicking the  icon. The name of the tag 
can then be entered directly in the entry field.

You can also configure a tag connection to the Output Value object property by dragging a tag 
from the Tags toolbar onto the object in the Graphics Designer picture.

See also
Example: Dynamic Filling of Rectangle (Page 840)

Dynamizing by Means of Tag Connection (Page 838)
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4.6.3 Example: Dynamic Filling of Rectangle

Introduction
A process tag is to directly influence the fill level of a rectangle. In the example, the process 
tag is simulated by an internal tag, the value of which can be changed by means of an I/O field.

Requirement
● Configure a "FillLevel" tag of data type "Unsigned 8-Bit Value".

● Start Graphics Designer and open a picture.

● Insert an I/O field into the picture and connect it to the "FillLevel" tag.

● Insert a rectangle into the picture.

Procedure
1. Open the "Object Properties" dialog of the rectangle and click the "Properties" tab (if not 

already activated).

2. In the left-hand window area, select the "Filling" property group.

3. In the right-hand window area, double-click the "Dynamic Filling" property. "Yes" now 
appears in the "Static" column.

4. Right-click the  button belonging to the Fill Level property and select the Tag... command 
in the pop-up menu.

The tag selection dialog is displayed.

5. In the tag selection dialog, select the "FillLevel" tag and close the tag selection dialog using 
the "OK" button.
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6. Dynamization by means of tag connection is indicated in the Object Properties dialog with 
the  icon and the name of the tag. The default trigger set in the Graphics Designer is 
used as the update cycle.

7. Save the picture and activate Runtime using the  button.

8. In Runtime you can change the value of the tag using the I/O field. If, for example, you enter 
the value 30 in the I/O field, the bottom third of the rectangle is filled with the background 
color of the rectangle. The top two thirds of the rectangle are transparent.

See also
Dynamizing by Means of Tag Connection (Page 838)

4.7 Dynamizing by Means of Direct Connection

4.7.1 Dynamizing by Means of Direct Connection

Introduction
Direct connection can be used as a reaction to events. If the event occurs in Runtime, the 
'value' of a source element (Source) is used for a target element (Target).

Constants, tags, or the attributes of the objects in the picture are available as sources.

Tags or the dynamizable attributes of objects and windows or tags can be used as targets.

The advantages of direct connection are the simple configuration and the time response in 
Runtime. Direction connection has the best performance of all dynamization types.

Copying Objects
If in the Graphics Designer you copy an object whose properties are dynamized with a direct 
connection, the dynamizations are also copied.

If the direct connection in the original object relates to an object property of this object, the 
direct connection in the copied object relates to the corresponding property of the copied object.

If the direct connection in the original object relates to an object property of a third object, this 
third object is influenced by the direct connection of the copied object in exactly the same way 
as the direct connection of the original object.

Process Picture Dynamics
4.7 Dynamizing by Means of Direct Connection

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  841



See also
Example: Picture Change in Picture Window (Page 844)

How to Configure a Direct Connection (Page 843)

Application Examples of Direct Connection (Page 842)

Types of Dynamization (Page 815)

4.7.2 Application Examples of Direct Connection

Constants As Source of Direct Connection
If a constant is selected as the source of the direct connection, a character string can be entered 
in the entry field.

The table below explains the effect that the entries have on various target elements.

Source Objective Explanation

picture1.pdl Current window / 
picture name

If the event occurs, a picture change is performed. The 
picture with the name picture1.pdl is displayed in the window.

picture1 Button1 / text The picture with the name picture1.pdl is displayed in the 
window.

50 Rectangle1 / width If the event occurs, the object Rectangle1 is displayed with 
a width of 50 pixels.

50 Tag, direct with 
operator message

If the event occurs, the tag is assigned the value 50. An 
operator message is sent at the same time.

Note

You can also use the  button to configure a picture change. This button opens the picture 
selection dialog in which all configured pictures are displayed.

Object Properties As Source of Direct Connection
The table below explains the effects of various direct connections when an object property is 
used as the source.

Source Objective Explanation

Circle1 / fill 
pattern

Rectangle1 / fill pattern If the event occurs, the fill pattern of the object Rectangle1 
is adapted to the fill pattern of the object Circle1.

Circle / width Current window / width If the event occurs, the width of the window is adapted to the 
width of the object Circle1.

Bar1 / height Tag, direct If the event occurs, the height of the object Bar1 is assigned 
to the tag.
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Note

The list of objects contains the entry this object. If you use properties of the currently selected 
object as the source or target of the direct connection, this entry is used automatically when 
the dialog is closed. The dynamics are also copied when an object is copied. The direct 
connection of the object created during copying therefore refers to this object. The newly 
created object is therefore used as the source or target of the direct connection.

Tags As Source of Direct Connection
The table below explains the effects of various direct connections when a tag is used as the 
source.

Source Objective Explanation

Tag1, direct Tag2, indirect with 
operator message

If the event occurs, the tag whose name is stored in Tag2 is 
given the value of Tag1. An operator message is also sent.

Tag1, direct Circle1 / radius If the event occurs, the radius of the object Circle1 is changed 
according to the value of the tag.

See also
Example: Picture Change in Picture Window (Page 844)

How to Configure a Direct Connection (Page 843)

Dynamizing by Means of Direct Connection (Page 841)

4.7.3 How to Configure a Direct Connection

Requirement
● Start the Graphics Designer and open a picture.

Procedure
1. Open the Object Properties dialog of the object for which you want to configure an action.

2. Click the Event tab.

3. In the left-hand window area, select the event trigger, e.g. mouse, background color, ...
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4. In the right-hand window area, double-click the event type: e.g. mouse click, 
change, ...          
The Direct Connection dialog opens.

5. Set the source of the direct connection.

6. Set the target of the direct connection.

7. In the "Direct Connection" dialog, click the "OK" button. Dynamizing by means of direct 
connection is indicated in the Object Properties dialog with the  icon.

See also
Example: Picture Change in Picture Window (Page 844)

Application Examples of Direct Connection (Page 842)

Dynamizing by Means of Direct Connection (Page 841)

4.7.4 Example: Picture Change in Picture Window

Introduction
In a picture window, a picture change is executed by means of a direct connection.
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Requirement
● Start the Graphics Designer.

● Create two pictures "NewPDL1.pdl" and "NewPDL2.pdl". These pictures should contain 
objects which allow a distinction to be made between the objects.

● Insert a button into a new picture.

● Insert a picture window into the picture. Enter the picture name "NewPDL1.pdl" in the 
"Picture Name" object property.

Procedure
1. Open the "Object Properties" dialog of the button and click the "Event" tab (if not already 

activated).

2. In the left-hand window area, select the mouse as the event trigger.

3. In the right-hand window area, select Mouse Control as the event type.

4. Right-click the  button belonging to the Fill Level property and select the Tag... command 
in the pop-up menu.

The "Direct Connection" dialog opens.

5. In the Source area, select a constant as the source of the direct connection.         
Click the  button and double-click the picture NewPdl2.pdl in the picture selection dialog.

Process Picture Dynamics
4.7 Dynamizing by Means of Direct Connection

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  845



6. In the "Target" area, select the object "PictureWindow1" and the property "Picture Name".

7. In the "Direct Connection" dialog, click the "OK" button. Dynamizing by means of direct 
connection is indicated in the Object Properties dialog with the  icon.

8. Save the picture and activate Runtime using the  button.

9. In Runtime, the picture "NewPdl1.pdl" is displayed in the picture window. If you click the 
"Button" object, a picture change occurs in the picture window and the picture 
"NewPdl2.pdl" is displayed.

See also
Dynamizing by Means of Direct Connection (Page 841)

4.8 Dynamizing Using the Dynamic Dialog

4.8.1 Dynamizing Using the Dynamic Dialog

Introduction
The Dynamic Dialog is used to dynamize object properties. In Dynamic Dialog you formulate 
an expression by using tags, functions, and arithmetic operands. The value of the expression, 
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the status as well as the quality code of tags used within the expression are used to form the 
object property value in Runtime.

The Dynamic Dialog may be used for the following purposes:

● Map the value ranges of a tag into colors

● Monitor single tag bits and map bit value onto colors or texts

● Monitor a Boolean tag and map bit value onto colors or texts

● Monitor tag status

● Monitor tag quality code

Note

If you divide two tags in a dynamic dialog, the decimal places are removed in the result. In 
the generated C code, a "LONG" is erroneously placed before the "GetTagDouble".

Remove the "LONG" so that the result of the division is output correctly.

Note

When using several tags or operands, the essential performance advantage of Dynamic 
Dialog is lost.

Convert to C Action
An action created with Dynamic Dialog is indicated in the "Object Properties" dialog with the 

 icon.

The code of this action is displayed if you use the right mouse button to click the  icon in 
the "Object Properties" dialog and select the command "C Action..." in the pop-up menu. This 
converts the dynamization created with Dynamic Dialog into a C action.

If you save the action or modify the code of the action, the action may no longer be modified 
by using the Dynamic Dialog.

Note

The "check_limits" feature generated during conversion of the Dynamic Dialog is reserved 
for the Dynamic Wizards.
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See also
Example: Color Change Depending on Position (Page 864)

Monitoring Quality Code (Page 859)

Monitoring Tag Status (Page 857)

Defining a Valid Range (Page 854)

Creating Expressions (Page 850)

How to Configure Dynamization Using the Dynamic Dialog (Page 848)

4.8.2 How to Configure Dynamization Using the Dynamic Dialog

Requirement
● Start the Graphics Designer and open a picture.

Procedure
1. Open the "Object properties" dialog of the object to be dynamized.

2. Click the Properties tab.

3. In the left window area, select the property group which contains the property to be 
dynamized.

4. In the right window area, select the property to be dynamized.

5. With the right mouse button, click the  button belonging to the property and select the 
Dynamic Dialog... command in the pop-up menu.
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6. The Dynamic dialog opens.

7. Click the  button and specify the trigger.

8. In the Result of Expression/Formula area, specify the data type of the expression 
result.         
The data type determines the options to specify the printout and to define the value ranges.

9. In the Expression/Formula area specify the expression which will control the object 
properties.          
You may enter the expression either directly or add tags, functions and operands to your 

expression by using the  button.

10.Click the button "Check" to check the syntax of your expression.

11.Specify the valid ranges in the "Result of Expression/Formula" area.

12.Assign a value to the object properties of each valid range.

13.Specify whether or not to perform an analysis of the tag status of quality code of a tag. 
Assign values to the object properties of the desired status or quality codes, if any.

14.Close the tag selection dialog by clicking the Apply button.         
Dynamizing using the Dynamic dialog is indicated in the Object Properties dialog by the 

 icon.
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Note

If you do not set a trigger, the trigger event is defaulted by the system. The default values 
are dependent upon the contents of the formulated expression.

The direct connection to a text tag as output value of the I/O field cannot be dynamized using 
"Direct" data type in the Dynamic dialog.

See also
Example: Color Change Depending on Position (Page 864)

Monitoring Quality Code (Page 859)

Monitoring Tag Status (Page 857)

Defining a Valid Range (Page 854)

Creating Expressions (Page 850)

Dynamizing Using the Dynamic Dialog (Page 846)

4.8.3 Creating Expressions

Introduction
In Dynamic Dialog you formulate an expression by using tags, functions, and arithmetic 
operands. The value of the expression is used to formulate the value of the object property 
during Runtime.

The options to formulate the expression are dependent upon the desired data type of the 
printout result.
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Formulating the Expression for Analog, Boolean, Direct Data Types

Tags

Tags may be entered either directly or by clicking the  button and the tag selection dialog. 
For direct entry, make sure that tag names are included in single quotation marks.

Note

If you enter the name of a tag which cannot be found, the dialog Missing tags appears. 

Click the OK button to define a new tag with this name. Click the Cancel button to edit the 
tag name.

Click the Ignore button to link the attribute with a nonexistent tag. This is useful, for example, 
if you work with structure tags in a picture window or subsequently wish to import tags. Check 
prior to commissioning that the respective tag is actually found in the system. 

Functions

Functions may be entered either directly or by using the  button and the function browser. 
You may use all C functions of the Global Script within an expression.
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Operands

Operands may be entered either directly or by using the  button. Within an expression, 
operands may be used for addition, subtraction, multiplication or division.

Decimal numbers may be entered directly. Only a period is permissible as the decimal point.

Note

When using several tags or operands, the essential performance advantage of Dynamic 
Dialog is lost.

Creating an Expression for Bit Data Types

Tags

Tags may be entered either directly or by clicking the  button and the tag selection dialog. 
For direct entry, make sure that tag names are included in single quotation marks.

Masking Relevant Bits

For 8-bit, 16-bit and 32-bit tags, clicking the  button will open a dialog to mask the relevant 
bits.
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Checking the Expression Syntax
Clicking the Check or Apply buttons, the syntax of the expression will be checked. You will 
receive an error message if the expression contains an error.

Clicking the Details button, you will receive additional information on the error message.

Note

Clicking the Check or Apply buttons will sort the list of value ranges Result of Expression/
Formula in ascending order by range upper limit.

See also
Example: Color Change Depending on Position (Page 864)

Monitoring Quality Code (Page 859)

Monitoring Tag Status (Page 857)

Defining a Valid Range (Page 854)

How to Configure Dynamization Using the Dynamic Dialog (Page 848)

Dynamizing Using the Dynamic Dialog (Page 846)
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4.8.4 Defining a Valid Range

Value Ranges for an Expression of Data Type Analog

For an expression of data type Analog, you may specify several value ranges. Use the Add 
button to create new value ranges. A new value range is always created between the most 
recently creates value range and the range Other.

The upper limit of a value range is changed by double-clicking the respective value in column 
to.

The applicable value of an object property in a value range is changed by double-clicking the 
respective value in the column of the object property.

Settings shown in the picture have the following effect:

● If the value of the tag Position is less or equal 100, the property Position X is set to 300.

● If the value of the tag Position is greater than 100 and less or equal 200, the property 
Position X is set to 500.

● If the value of the tag Position is greater than 200, the property Position X is set to 0.
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Value Ranges for an Expression of Data Type Boolean

The applicable value of an object property in a value range is changed by double-clicking the 
respective value in the column of the object property.

Settings shown in the picture have the following effect:

● If the tag Position equals TRUE, the property Position X is set to 300.

● If the tag Position equals FALSE, the property Position X is set to 0.
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Value Ranges for an Expression of Data Type Bit

The applicable value of an object property in a value range is changed by double-clicking the 
respective value in the column of the object property.

Settings shown in the picture have the following effect:

● If Bit4 of the tag Position is set, the property Position X is set to 300.

● If Bit4 of the tag Position is not set, the property Position X is set to 0.
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Value Ranges for an Expression of Data Type Direct

Settings shown in the picture have the following effect:

● The value of tag Position is divided by 10. The result of this calculation is accepted as the 
value for the object property to be dynamized.

See also
Defining a Valid Range (Page 854)

Example: Color Change Depending on Position (Page 864)

Monitoring Quality Code (Page 859)

Monitoring Tag Status (Page 857)

Creating Expressions (Page 850)

How to Configure Dynamization Using the Dynamic Dialog (Page 848)

Dynamizing Using the Dynamic Dialog (Page 846)

4.8.5 Monitoring Tag Status

Introduction
Dynamizing by using the Dynamic Dialog may also be used to monitor the status of a WinCC 
tag in Runtime. Monitoring the tag status will also allow for conclusions on the status of 
associated links for external tags.

Process Picture Dynamics
4.8 Dynamizing Using the Dynamic Dialog

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  857



If you activate the check box Tag Status, the Dynamic Dialog is extended.

The left subarea will display all tags used in the expression.

In the right subarea, you may assign a value for each tag status of the object property to be 
dynamized. The applicable value of an object property for a tag status is changed by double-
clicking the respective value in the column of the object property.

Note

If definitions for the value of an object property in the areas Result of Expression/Formula 
and Tag status contradict each other, the value of the object property is determined by the 
definition in area Tag status.
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See also
Example: Color Change Depending on Position (Page 864)

Monitoring Quality Code (Page 859)

Defining a Valid Range (Page 854)

Creating Expressions (Page 850)

How to Configure Dynamization Using the Dynamic Dialog (Page 848)

Dynamizing Using the Dynamic Dialog (Page 846)

4.8.6 Monitoring Quality Code

Introduction
Dynamizing by using the Dynamic Dialog may also be used to monitor the quality code of a 
WinCC tag in Runtime. Monitoring the quality code of external tags will also allow for 
conclusions on the quality of associated tags during the process.

If you activate the check box Quality Code, the Dynamic Dialog is extended.
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The left subarea will display all tags used in the expression.

In the right subarea, you may assign a value for each quality code of the object property to be 
dynamized. The applicable value of an object property in a quality code is changed by double-
clicking the respective value in the column of the object property.

Note

If definitions for the value of an object property in the areas Result of the Expression/Formula 
and Quality Code contradict each other, the value of the object property is determined by the 
definition in area Quality Code.

Quality Codes that can be Dynamized
In the right-hand portion of the Dynamic dialog, a selection of the possible Quality Codes is 
shown. The missing Quality Codes are combined in the collection signals "bad miscellaneous 
state" and "uncertain miscellaneous states".
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The Quality Codes that are offered in the Dynamic dialog are found in the following table. This 
list of Quality Codes is ordered by descending priority. If an expression is comprised of several 
tags, the expression contains the Quality Code of the tags for which the Quality Code is highest 
in the table.

Quality Code         
(Hex)

 

0x1C bad (0x1C) out of service
0x18 bad (0x18) no communication (no usable value)
0x14 bad (0x14) no communication (last usable value)
0x0C bad (0x0C) device failure
0x08 bad (0x08) not connected
0x04 bad (0x04) configuration error, value not accepted
0x00 bad (0x00) non specific
0x28 bad (0x28) process related, substitute value
0x2B bad (0x2B) process related, no maintenance
remaining codes with quality bad bad miscellaneous states
0x68 uncertain (0x68) maintenance demanded
0x60 uncertain (0x60) simulated value
0x54 uncertain (0x54) engineering unit range violation, no limits set
0x55 uncertain (0x55) engineering unit range violation, low limits set
0x56 uncertain (0x56) engineering unit range violation, high limits 

set
0x78 uncertain (0x78) process related, no maintenance
0x4C uncertain (0x4C) initial value
0x48 uncertain (0x48) substitute set
0x44 uncertain (0x44) last usable value
0x40 uncertain (0x40) non specific
remaining codes with quality uncertain uncertain miscellaneous states
0x02 high limited (0x02)
0x01 low limited (0x01)

See also
Example: Color Change Depending on Position (Page 864)

Editing Triggers (Page 862)

Monitoring Tag Status (Page 857)

Defining a Valid Range (Page 854)

Creating Expressions (Page 850)

How to Configure Dynamization Using the Dynamic Dialog (Page 848)

Dynamizing Using the Dynamic Dialog (Page 846)
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4.8.7 Editing Triggers

Introduction
If you do not set a trigger, the trigger event is defaulted by the system. The default setting 
depends on the content of the formulated expression in the Dynamic dialog.

● If the expression contains one or more tags, a tag trigger with the standard cycle set in the 
Graphics Designer is used as the trigger. All tags contained in the expression are entered 
in the tag list.

● If the expression does not contain any tags, a cyclic trigger with the standard cycle set in 
the Graphics Designer is used as the trigger.

Trigger Events
The following trigger events are available in the Dynamic dialog.

● Tag: A tag trigger is used as the trigger. The query can be performed either when a change 
is made or cyclically. Query cycles between 250 ms and 1 h can be selected. Self-defined 
user cycles are also available.

● Standard cycle: A cyclic trigger is used as the trigger. Cycle times between 250 ms and 1 
h can be selected. Self-defined user cycles are also available.

● Picture cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object 
property Update Cycle of the picture object. This cycle provides the option of defining the 
cycles of all the actions used in a picture centrally.

● Window cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object 
property Update Cycle of the Picture Window object. This cycle provides the option of 
defining the cycles of all the actions used in a picture window centrally.

Note

It is important to remember that the cycle time has a major effect on the performance of 
the project. All the actions of a picture must be completed within their cycle time. Apart 
from the runtimes of the actions, the times required for requesting the tag values and the 
reaction times of the automation systems must also be taken into consideration. You 
should only set trigger events with a cycle time under one second if variables which change 
rapidly have to be queried.
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Requirement
● Open the Dynamic dialog

Procedure
1. Click the  button in the "Event Name" area.

2. The Change Trigger dialog opens.

3. Select the desired trigger event in the Event section.

4. Select the desired cycle time in the Cycle section.

5. For the trigger events Standard Cycle, Picture Cycle, and Window Cycle, you can enter a 
specific name for your trigger in the Trigger Name field.

6. Click "OK".

See also
How to Configure Dynamization Using the Dynamic Dialog (Page 848)

Dynamizing Using the Dynamic Dialog (Page 846)
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4.8.8 Example: Color Change Depending on Position

Introduction
The position of a workpiece is to influence the background color of the workpiece. In the 
example, the workpiece is simulated by a rectangle and the position by an internal tag. The 
position may be changed by using an I/O field.

Requirement
● Configure a "Position" tag of data type "Unsigned 16-Bit Value".

● Start Graphics Designer and open a picture.

● Insert an I/O field into the picture and connect it to the "Position" tag.

● Insert a rectangle into the picture. Dynamize the "Position X" object property by means of 
a tag connection to the "Position" tag.

Procedure
1. Open the "Object properties" dialog of the rectangle and click the "Properties" tab, unless 

already activated.

2. In the left-hand window area, select the "Colors" property group.

3. Use the right mouse button to click the  button next to the property Background color. 
From the pop-up menu, select the command "Dynamic Dialog...".
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4. The Dynamic dialog opens.

5. In the Expression/Formula area, left-click the  button and select the Tag... 
command.         
The tag selection dialog opens.

6. In the tag selection dialog, select the "Position" tag and close the tag selection dialog using 
the "OK" button.

7. Click the Add button in the Result of Expression / Formula area.         
The first value range is created.

8. In the Background color column, double-click the color bar and select green as the 
background color.

9. Click the Add button in the Result of Expression / Formula area.         
The second value range is created.

10.In the Background color column, double-click the color bar and select yellow as the 
background color.

11.Double-click the value "200" in the "to" column. Enter "300" in the value entry dialog.

12.Click the Add button in the Result of Expression / Formula area.         
The third value range is created.

13.In the Background color column, double-click the color bar and select red as the background 
color.

14.Click the "Accept" button.

15.Dynamizing using the Dynamic dialog is indicated in the Object properties dialog with the 
 icon. A tag trigger with the standard cycle set in the Graphics Designer is used as the 

trigger.
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16.Save the picture and activate Runtime using the  button.

17.In Runtime, you may change the X position of the rectangle by using the I/O field. Four 
value ranges (0-100, 101-300, 301-500, 501-...) have been defined by Dynamic Dialog 
dynamization. The background color of the rectangle changes according to the value range 
in which the left-hand edge of the rectangle is located.

See also
Monitoring Quality Code (Page 859)

Monitoring Tag Status (Page 857)

Defining a Valid Range (Page 854)

Creating Expressions (Page 850)

How to Configure Dynamization Using the Dynamic Dialog (Page 848)

Dynamizing Using the Dynamic Dialog (Page 846)

4.9 Dynamizing Using VBS Action

4.9.1 Dynamizing Using VBS Action

Introduction
Apart from the dynamization options using direct connection, C action, and tags, WinCC also 
offers VBS actions for dynamizing graphic objects in Runtime.

You should use VBS actions if

● you want to process several input parameters in an action

● you want to execute conditional instructions (if ... then ...)

● you want to change several object properties in an action 

● you want to access selection dialogs of the operating system, e.g. file selection dialog or 
color selection dialog

You create VBS actions in the VBS action editor of the Graphics Designer.  The action editor 
offers a similar range of functions to the VBS editor Global Script. From the Graphics Designer 
you can also access procedures which you have created in Global Script.

Actions which you create in the Graphics Designer are always stored with the picture in which 
they have been configured. In addition to all configured object properties, the configured VBS 
actions are also documented in the project documentation of the Graphics Designer. All of the 
VBS actions configured in this picture are displayed if you select a picture in the WinCC 
Explorer and call up the Properties dialog using the pop-up menu.

Further information on VBS actions can be found in the section Creating Procedures and 
Actions Using VBScript.
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Application Scenarios

VBS Action for Dynamizing Object Properties
You use VBS actions for dynamizing an object property. You can dynamize the value of the 
object property in Runtime depending on a trigger, a tag, or the status of other object properties. 
You should use a VBS action if the options provided by tag connection or the Dynamic dialog 
are not sufficient to solve the task in question.

VBS Action for Events
You can use a VBS action to react to an event which occurs at a graphic object. You should 
use a VBS action if the options provided by tag connection or the Dynamic dialog are not 
sufficient to solve the task in question.

The use of actions to react to changes to object properties influences performance in Runtime.

The event occurs if the value of the object property changes. The action associated with the 
event is then started. When a picture is closed, all of the started actions are stopped one by 
one. This can cause high system loads.

See also
Editing Triggers (Page 875)

How to Configure a VBS Action (Page 874)

Working in Action Editor (Page 871)

Action Editor in Graphics Designer (Page 868)

Working with VBS Actions (Page 867)

Types of Dynamization (Page 815)

4.9.2 Working with VBS Actions

Introduction
If you create VBS actions in the Graphics Designer, it is important to note the following 
differences compared to actions in Global Script:

● An action in the Graphics Designer is always saved with the picture.

● If you copy a graphic object for which you have configured an action, the action is copied 
together with the properties of the graphic object.

● Actions can only be saved in the Graphics Designer if they have the correct syntax. 
Therefore use the syntax check before you save an action.

● You cannot create globally applicable procedures in the Graphics Designer.
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Working with Actions
The editor for VBS actions in the Graphics Designer provides the following options:

● Before you save an action, check it to make sure that it is syntactically correct.         

To do so, click the  button in the toolbar or select the appropriate command from the 
pop-up menu in the VBS dialog.

● To delete actions from object properties, open the Object Properties dialog of the graphic 
object and select the relevant command from the pop-up menu:         

         
         
If a different type of dynamics is configured for a property or event, the previous type of 
dynamizing is automatically deleted.

See also
Editing Triggers (Page 875)

How to Configure a VBS Action (Page 874)

Working in Action Editor (Page 871)

Action Editor in Graphics Designer (Page 868)

Dynamizing Using VBS Action (Page 866)

4.9.3 Action Editor in Graphics Designer

Introduction
You create and process VBS actions at graphic objects in the editor for VBS actions in the 
Graphics Designer. The action editor offers a similar range of functions to the VBS editor Global 
Script.
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Calling Action Editor
You start the editor for VBS actions from the Object Properties dialog of a graphic object in 
the Graphics Designer. If you configure an action to dynamize an object property, you call the 
dialog in the Properties tab. Place the mouse pointer in the Dynamic column and select the 
VBS Action command from the pop-up menu: 

If you want to react to an event at a graphic object using an action, you call the dialog in the 
Event tab. Place the mouse pointer in the Action column and select the VBS Action command 
from the pop-up menu:
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Layout of Action Editor
The editor for VBS actions offers a similar range of functions to the VBS editor Global Script.

Toolbar (1)
In the toolbar you will find all the commands needed to create actions. 

Navigation window (2)
You manage your actions in the navigation window. Here you will also find:

● Project and standard procedures which you have created in Global Script and which you 
can insert into your action code (drag and drop).

● Code templates which you can insert into your action or procedure (drag and drop).

Editor window (3)
You write and edit your actions in the Editor window.
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See also
Editing Triggers (Page 875)

How to Configure a VBS Action (Page 874)

Working with VBS Actions (Page 867)

Dynamizing Using VBS Action (Page 866)

Working in Action Editor (Page 871)

4.9.4 Working in Action Editor

Declaration Area in Actions
If you create actions in Graphics Designer, you can display the declaration area of the action 

using the button . When creating a new action, the Option explicit instruction is 
automatically entered in the declaration area and cannot be deleted. The instruction is 
necessary as it prevents errors caused by the incorrect notation of tags without declaration.

The instruction requires that tags are always defined in your code with the Dim instruction.

Do not use the instruction Option explicit in your code as this can cause runtime errors.

In the declaration area, you can also make general settings which you want to use globally for 
the current picture, e.g.:

● Tag Definitions

● Procedures which you only want to use in this picture

In the declaration area of the actions, you may define global tags independent of each other 
in the areas Event and Properties of an object. There is no link between global tags of identical 
names in both areas. 

Note

Always make sure that the procedures in the declaration area have correct syntax, i.e. with 
Sub - End Sub. Do not create directly executable codes in the declaration area as this can 
cause runtime errors.

Please note that when creating a tag, it must not contain a value (Value = VT_EMPTY). 
Initialize the tags after declaration with the corresponding value.

In the general declaration part of screens, no check is made whether a procedure or function 
name has already been assigned. Therefore, a name could occur several times and it is not 
defined which function will be executed. This is standard behavior of the MS Scripting Engine.
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Intellisense and Highlight Syntax
During text entry, context-sensitive lists appear containing the properties, methods, and objects 
possible at the current code position. If you insert an element from the list, the required syntax 
is also indicated automatically.

Note

Full intellisense for all objects can only be utilized in the Graphics Designer if the list is 
accessed using the object name and the result is assigned to a tag. Otherwise, you are only 
offered a list of standard properties.

Example of full intellisense:

Dim Tag

Set Tag = ScreenItems (Circle1)

Variable.<Intellisense selection>

If picture window limits are exceeded during addressing, it is once again only the standard 
properties which are offered since the picture of the picture window is not loaded.

General VBS Functions
Using the pop-up menu in the Editor window you can view a list of the possible VBS standard 
functions, e.g. Abs, Array, ... , Year.

Lists of Objects, Properties and Methods
Using the pop-up menu in the Editor window you can view a list of the possible objects by 
calling the Object List command in Graphics Designer.

Use the Properties/Methods pop-up menu command to call in a list of possible properties and 
methods.

The same lists can be called in with the key combination <CTRL + SPACEBAR> but according 
to the context of the script.

Code Templates
In the Code templates tab in the Navigation window of the Editor, you will find a selection of 
frequently used instructions, e.g. for loops and conditional instructions. You can insert these 
templates into your process code by dragging and dropping or by double-clicking.

If you insert a code template into your code, it is important to note that, for example, conditions 
in the templates are identified by _XYZ_. You must replace these placeholders with the 
appropriate information.

Process Picture Dynamics
4.9 Dynamizing Using VBS Action

MDM - WinCC: Working with WinCC
872 System Manual, 11/2008,  



Selection Dialogs
If you use WinCC tags or picture objects in the code, you can open the following selection 
dialogs: 

●  Opens the tag selection dialog and gives the selected tag name as the return value.

●  Opens a tag selection dialog and returns the tag name with an associated reference.

●  Opens a picture/object browser in which a picture/object can be selected whose name 
is then used for the return value.

●  Opens a picture selection dialog for pictures and returns the picture name, with the 
server prefix if necessary.

Syntax Check
The Action Editor supports you by providing a syntax check which you can perform after the 
code has been created. Syntax errors in the code are displayed in the output window of the 
editor. You can move to the erroneous point in the code directly by double-clicking the error 
in the output window.

Note

The syntax check can only detect syntax errors in the code. Programming errors, such as 
missing references, only become visible in Runtime. You should therefore also always check 
your scripts in the Runtime environment.

See also
Editing Triggers (Page 875)

How to Configure a VBS Action (Page 874)

Working with VBS Actions (Page 867)

Action Editor in Graphics Designer (Page 868)

Dynamizing Using VBS Action (Page 866)
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4.9.5 How to Configure a VBS Action

Introduction
In the Graphics Designer you configure VBS actions to

● dynamize an object property. You can, for example, display a fill level according to a tag 
value, implement a color change if a tag value is exceeded, or create cyclic actions (e.g. 
flashing).

● react to an event which is triggered on an object: This can involve the execution of actions, 
for example, on clicking the mouse or a color change following the change of an object 
property.

The procedure is basically the same for both types of action.

Executing Actions in Runtime
An action which you have configured for an event is executed whenever the triggering event 
(e.g. mouse click) occurs.

Actions which you have used to dynamize object properties always need a trigger for execution. 
Actions without trigger are not executed in Runtime.

Procedure
1. Open the Object Properties dialog of the object for which you want to configure an action.

2. Activate the Properties tab if you want to dynamize an object property.         
Activate the Event tab if you want to react to an event with an action.

3. Highlight the Dynamic column of the object property which you want to dynamize, or the 
Action column of the event to which you want to react.  Select the command VBS Action 
from the pop-up menu.         
The editor for VBS actions is opened.

4. Create the VBS action.

5. Check your action with <F7>. If your action contains syntax errors, they are displayed in 
an output window. Correct the code and check it again.

6. If your action is syntactically correct, exit the dialog with OK.

Note

Actions can only be saved in the Graphics Designer if they have the correct syntax. To save 
an erroneous action temporarily, you must first remove the comment from the action.

Result
The action is displayed in the Object Properties dialog of the object with the following symbol:
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See also
Editing Triggers (Page 875)

How to Configure a VBS Action (Page 874)

Working in Action Editor (Page 871)

Action Editor in Graphics Designer (Page 868)

Working with VBS Actions (Page 867)

Dynamizing Using VBS Action (Page 866)

4.9.6 Editing Triggers

Introduction
If you configure an action for an event, you do not have to configure a trigger. The event is the 
trigger for the action. You have to assign triggers if you configure an action for dynamizing an 
object property.

A cyclic trigger with the standard cycle set in the Graphics Designer is used by default as the 
trigger.

Trigger Events
The following trigger events are available in the editor for VBS actions.

● Tag: A tag trigger is used as the trigger. The query can be performed either when a change 
is made or cyclically. Query cycles between 250 ms and 1 h can be selected. Self-defined 
user cycles are also available.

● Standard cycle: A cyclic trigger is used as the trigger. Cycle times between 250 ms and 1 
h can be selected. Self-defined user cycles are also available.

● Picture cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object 
property Update Cycle of the picture object. This cycle provides the option of defining the 
cycles of all the actions used in a picture centrally.

● Window cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object 
property Update Cycle of the Picture Window object. This cycle provides the option of 
defining the cycles of all the actions used in a picture window centrally.

Note

It is important to remember that the cycle time has a major effect on the performance of 
the project. All the actions of a picture must be completed within their cycle time. Apart 
from the runtimes of the actions, the times required for requesting the tag values and the 
reaction times of the automation systems must also be taken into consideration. You 
should only set trigger events with a cycle time under one second if variables which change 
rapidly have to be queried.
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Automatic Ending of Actions
After a change of picture, scripts still running are automatically stopped 1 minute after the 
change of picture.          
Scripts which are still running when runtime is terminated are stopped after 5 seconds.

Requirement
● Open the editor for VBS actions.

Procedure
1. In the toolbar, click the  button.

The Change Trigger dialog opens.

2. Select the desired trigger event in the Event section.

3. Select the desired cycle time in the Cycle section.

4. For the trigger events Standard Cycle, Picture Cycle, and Window Cycle, you can enter a 
specific name for your trigger in the Trigger Name field.

5. Click "OK".
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See also
How to Configure a VBS Action (Page 874)

Working in Action Editor (Page 871)

Action Editor in Graphics Designer (Page 868)

Working with VBS Actions (Page 867)

Dynamizing Using VBS Action (Page 866)

Trigger Types (Page 819)

4.10 Dynamizing Using C Action

4.10.1 Dynamizing Using C Action

Introduction
C actions are used to dynamize an object property or to react to events. When object properties 
are dynamized, the value of the object property is determined by the return value of the C 
function.

Use C actions if, for example, you want to process several input parameters in one action or 
you want to execute conditional instructions (if ... then ...). It is advisable to use C actions 
especially if in the case of recipes, for example, you want to access several tags in the 
automation system at the same time.

Application Scenarios

C Action for Dynamizing Object Properties
You use C actions for dynamizing an object property. You can dynamize the value of the object 
property in Runtime depending on a trigger, a tag, or the status of other object properties. You 
should use a C action if the options provided by tag connection or the Dynamic dialog are not 
sufficient to solve the task in question.

C Action As Reaction to Events
You can use C actions to react to an event which occurs at a graphic object. You should use 
a C action if the options provided by tag connection or the Dynamic dialog are not sufficient to 
solve the task in question.

The use of actions to react to changes to object properties influences performance in Runtime.

The event occurs if the value of the object property changes. The action associated with the 
event is then started. When a picture is closed, all of the started actions are stopped one by 
one. This can cause high system loads.
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See also
Types of Dynamization (Page 815)

Importing and Exporting Actions (Page 886)

Editing Triggers (Page 883)

How to Apply Functions in the Action Code (Page 882)

How to Configure a C Action (Page 879)

Working with C Actions (Page 878)

4.10.2 Working with C Actions

Introduction
If you create C actions in the Graphics Designer, it is important to note the following differences 
compared to actions in Global Script:

● An action in the Graphics Designer is always saved with the picture.

● If you copy a graphic object for which you have configured an action, the action is copied 
together with the properties of the graphic object.

● Actions can be saved in the Graphics Designer if they can be compiled without error.

● You cannot create functions in the Graphics Designer; you can only call functions in actions 
which you have created in Global Script.

Layout of Editor for C Actions
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Toolbar
In the toolbar you will find the commands needed to create actions.

Navigation window
The navigation window enables you to access the existing C functions. You can apply these 
functions to the function code by double-clicking.

Edit Window
You write and edit your C actions in the Editor window.

In order to utilize the functions of the Cross Reference editor used to locate the places of use 
of tag and picture names, the tag and picture names used in a C action must first be declared. 
This is done in the areas WINCC:TAGNAME_SECTION and WINCC:PICNAME_SECTION. 
More detailed information can be found under WinCC Coding Rules

See also
Importing and Exporting Actions (Page 886)

Editing Triggers (Page 883)

How to Apply Functions in the Action Code (Page 882)

How to Configure a C Action (Page 879)

Dynamizing Using C Action (Page 877)

4.10.3 How to Configure a C Action

Introduction
In the Graphics Designer you configure C actions to

● dynamize an object property. You can, for example, display a fill level according to a tag 
value, implement a color change if a tag value is exceeded, or create cyclic actions (e.g. 
flashing).

● react to an event which is triggered on an object: This can involve the execution of actions, 
for example, on clicking the mouse or a color change following the change of an object 
property.

The procedure is basically the same for both types of action.

Processing of Actions in Runtime
An action which you have configured for an event is executed whenever the triggering event 
(e.g. mouse click) occurs.
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Actions which you have used to dynamize object properties always need a trigger for execution. 
Actions without trigger are not executed in Runtime.

Requirement
● Start the Graphics Designer and open a picture.

Procedure
1. Open the Object Properties dialog of the object to be dynamized.

2. To dynamize an object property: In the left window area, select the property group. In the 
right window area, select the property.

3. To configure a reaction to an event: In the left-hand window area, select the event trigger, 
e.g. mouse, background color, etc. In the right window area, select the type of the event: 
e.g. mouse click, change, etc.

4. Right-click the associated  button and select the command C Action... in the pop-up 
menu.
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5. The editor for C actions opens.

6. Formulate the C function.

7. Click the  button and specify the trigger.

8. Click on the  command button. The function is compiled. This process is indicated in the 
status bar of the dialog by the message "Compile Action...".

9. If compilation has been completed without error, the message 0 Error(s), 0 Warning(s) is 
displayed in the status bar. Click on the OK button. The Edit Action dialog is closed.         
Dynamizing using a C action is indicated in the Object Properties dialog by the  icon.

10.If compilation has not been completed without error, the number of errors and warnings is 
displayed in the status bar. More detailed information about the errors is shown at the 
bottom of the Editor window.

11.Correct all errors. Recompile the function. Close the dialog by activating the "OK" 
button.         
Dynamizing using a C action is indicated in the Object Properties dialog by the  icon.
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See also
Importing and Exporting Actions (Page 886)

Editing Triggers (Page 883)

Working with C Actions (Page 878)

Dynamizing Using C Action (Page 877)

How to Apply Functions in the Action Code (Page 882)

4.10.4 How to Apply Functions in the Action Code

Introduction
You can use internal functions, standard functions, or project functions within your action. The 
function is always inserted in the action code at the cursor position.

Requirement
● Open the editor for C actions.

How to Export an Action
1. Place the cursor at the point at which the function is to be inserted.

2. In the navigation window, double-click the function to be inserted.

3. If the function to be inserted has parameters, the Set Parameters dialog opens.

4. This dialog shows a list of all parameters belonging to the function to be inserted, and allows 
you to set parameters for this function.

5. In the Value column, click the parameter which you want to set.
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6. You can enter tags either directly or using the ... button and the tag selection dialog.         
You can enter objects and object properties either directly or using the ... button and the 
selection dialog for pictures, objects, and object properties.         
You can enter pictures either directly or using the ... button and the picture selection 
dialog.         
With direct entry, make sure that you put names between quotation marks.

7. Click the OK button.         
The Set Parameters dialog is closed and the function is inserted in the action code at the 
cursor position.

Alternative Operation
You can also open the Set Parameters dialog using the commands Apply or Parameter 
Assignment in the pop-up menu of the functions in the navigation window.

Notes on special functions
The SetProperty function should not be used within a C-action because it initiates a 'Redraw' 
of the picture.

See also
Working with C Actions (Page 878)

Dynamizing Using C Action (Page 877)

4.10.5 Editing Triggers

Introduction
If you configure an action for an event, you do not have to configure a trigger. The event is the 
trigger for the action.

You have to assign a trigger if you configure an action for dynamizing an object property. A 
cyclic trigger with the standard cycle set in the Graphics Designer is used by default as the 
trigger.

Trigger Events
The following trigger events are available in the Edit C Action dialog.

● Tag: A tag trigger is used as the trigger. The query can be performed either when a change 
is made or cyclically. Query cycles between 250 ms and 1 h can be selected. Self-defined 
user cycles are also available.

● Standard cycle: A cyclic trigger is used as the trigger. Cycle times between 250 ms and 1 
h can be selected. Self-defined user cycles are also available.
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● Picture cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object 
property Update Cycle of the picture object. This cycle provides the option of defining the 
cycles of all the actions used in a picture centrally.

● Window cycle: A cyclic trigger is used as the trigger. The cycle time is defined by the object 
property Update Cycle of the Picture Window object. This cycle provides the option of 
defining the cycles of all the actions used in a picture window centrally.

Note

It is important to remember that the cycle time has a major effect on the performance of 
the project. All the actions of a picture must be completed within their cycle time. Apart 
from the runtimes of the actions, the times required for requesting the tag values and the 
reaction times of the automation systems must also be taken into consideration. You 
should only set trigger events with a cycle time under one second if variables which change 
rapidly have to be queried.
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Requirement
● Open the editor for C actions in the Graphics Designer.

Procedure
1. In the toolbar, click the  button.

2. Select the desired trigger event in the Event section.

3. Select the desired cycle time in the Cycle section.

4. For the trigger events Standard Cycle, Picture Cycle, and Window Cycle, you can enter a 
specific name for your trigger in the Trigger Name field.

5. Click "OK".

See also
How to Configure a C Action (Page 879)

Working with C Actions (Page 878)

Dynamizing Using C Action (Page 877)
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4.10.6 Importing and Exporting Actions

Introduction
In order to transfer an action to a different object or object property, you can export and then 
import the function code.

When exporting, no check is performed to determine whether or not the function code can be 
compiled without error.

Requirement
● Open the editor for C actions.

How to Export an Action
1. Click the  button in the toolbar.

2. The file selection dialog opens.         
Enter an appropriate name for the exported file. Click OK. Click OK.

How to Import an Action
1. Click the  button in the toolbar.

2. The file selection dialog opens.         
Select the file containing the function code to be imported. Click OK. Click OK.

See also
Working with C Actions (Page 878)

Dynamizing Using C Action (Page 877)
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Setting up a Message System 5
5 Resources

5.1 WinCC Alarm Logging

Content
The signaling system

● Access to comprehensive information about error and operating states

● Early detection of critical situations

● Prevention of and reduction in downtime

● Quality improvements

● Targeted documentation of error and operating states

You use the "Alarm Logging" editor to configure the following: 

● Preparation of messages

● Representation of messages in runtime

● Acknowledgement of messages

● Archiving of messages

5.2 Message System in WinCC

Introduction
The message system processes results from functions that monitor actions in the process, on 
the automation level and in the WinCC System. The message system indicates detected alarm 
events both visually and acoustically and archives them electronically and on paper. Direct 
access to the messages and supplementary information for individual messages ensures that 
faults are localized and cleared quickly.

Archiving
Depending on the message class, changes that occur in message states are written to 
configurable archives.

Archiving takes place in the message archive. For this purpose, various parameters such as 
the archive size, time range, switchover time, etc., are set. If one of the configured criteria is 
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exceeded, the oldest messages in the archive are overwritten. The backup of the archiving 
databases can be specified through additional settings. 

Display of messages saved in a message archive takes place in a long-term archive list or a 
short-term archive list. Display of messages in the short-term archive list is updated 
immediately upon receipt of a new incoming message.

Hiding Messages
Hiding messages reduces the information load for the system user. You can select whether 
the messages are to be displayed in the message list, short-term archive list and long-term 
archive list. The display depends on the activated option in the "Display Options" dialog. The 
possible options are:

● Display All Messages

● Display visible messages (default setting)

● Display Hidden Messages

The hidden messages are displayed in the list of messages to be hidden and can be shown 
again.

You can hide messages in two ways:

● Automatic hide: Messages are hidden and shown again later depending on a certain status 
of the hide tag. You can configure the condition for hide or show using the hide mask.

● Hide Manually: In the message window, you can use a button to define when you want to 
hide a message. You can also show the messages again using another button. The system 
displays the messages again after a configurable time.

Operator Input Message
An operation in the process can trigger an operator input message. 

The configuration of an operator input message depends on the object being operated and 
the type of operation: 
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● For the control of certain objects, such as the input of a value in an I/O field, you have the 
option of activating the "Operator Input Message" property for the respective object in the 
Graphics Designer. This is done by setting the "Operator Input Message" attribute. The 
structure of this message cannot be edited. The message number of the operator input 
message is "12508141". The operator input message contains the value before the 
operation (old value) in process value block 2, and the modified value (new value) in process 
value block 3.
By activating the "Operator Activities Report" attribute, the user can enter the reason for 
an operation as a comment on the message in a dialog after he performs the operation. 
The "Operator Activities Report" comment can be viewed in the long-term archive list using 
the "Comment" button. The Comment dialog only shows the old value and new value for 
the operator input message "12508141".

● For operating optional graphic WinCC objects, you can configure your own operator 
message as a C action or as a VBS action.

– Execute the respective C action as a reaction to the operation event. In this case, the 
operation event can be e.g. the mouse click on the WinCC object. Configure your own 
operator input message with the "GCreateMyOperationMsg" function from the "Alarms" 
function group.

– Execute the respective VBS action as a reaction to the operation event. In this case, 
the operation event can be e.g. the mouse click on the WinCC object. Configure your 
own operation message with the "HMIRuntime.Alarms" object.

● For the operation of a message, such as the acknowledgement of locking/releasing or 
message, an operator input message is configured in the WinCC Alarm Logging. You must 
create the WinCC system messages in the Alarm Logging Editor for this purpose.
By default, an operator input message may contain information on the logged-on user and 
current computer. For this purpose, you add the "User name" and "Computer name" system 
blocks in the Alarm Logging Editor. You add the system blocks to the selected message 
blocks on the "Message Lists" tab in the WinCC AlarmControl.
The triggering event for an operational message is activated in the WinCC AlarmControl 
on the "Operator input messages" tab. You can also configure the operator input message 
itself there. Before WinCC V7, the triggering events for an operator input message are 
activated in the WinCC Alarm Control on the "Message Lists" tab using the "Operator Input 
Message" button.
To display or enter a comment for a selected operator input message, a dialog can be 
opened in the long-term archive list using the "Comment" button. When the "Comment" 
system block is inserted in the message line in the AlarmControl, this message block 
indicates the existence of a comment for this message.

Single Message, Group Message
WinCC Alarm Logging distinguishes between two message forms: 

● Single messages. Each event is assigned a separate message.

● Group messages are used to compile multiple single messages. In the case of group 
messages from message classes, all associated messages and message types are stored. 
With user-defined group messages, you can combine any of the single messages into group 
messages, which can then be combined to form higher-level group messages.          
To automatically display individual messages, you need a customized group message.
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Single Acknowledgement, Group Acknowledgement
A pending message can be acknowledged in two different ways:

● Messages that are not assigned the "Group Acknowledgement" attribute must be 
acknowledged individually.

● Group Acknowledgement can be used to collectively acknowledge all messages with the 
"Group Acknowledgement" attribute that are visible in the message window.

The message acknowledgement log can include the identity of the acknowledging user and 
computer used. This requires that you insert the "User Name" and "Computer Name" system 
blocks in the message line of a message in the WinCC AlarmControl. Upon acknowledgement 
of a message, the user name and computer name are not displayed in the message line of 
the incoming message but rather are displayed in the operator input message of the 
acknowledgement in the short-term archive list and the long-term archive list. The operator 
input message must be activated in the WinCC AlarmControl on the "Operator input messages" 
tab. Before WinCC V7, the operator input message must be activated in the WinCC 
AlarmControl on the "Message lists" tab using the "Operator input message" button. 

Events
The message system distinguishes between binary events and monitoring events:

● Binary events are state changes of internal or external tags.

● Monitoring events are not supported directly from the WinCC Alarm Logging. Monitoring 
events include overflow of archives and hard disks, printer messages, server failure and 
faulty process communication.

Initial Value Message, New Value Message
● The initial value message is a message of a message class with single-mode 

acknowledgement, which is highlighted as the first message of the message class by 
flashing in the message window.

● The new value message is a message of a message class with single-mode 
acknowledgement or duel-mode acknowledgement, highlighted by flashing in the message 
window.

Alarms
The message system is used to chronologically signal and archive events that occur 
sporadically during the process via messages at a central location. A message can be caused 
by an event or a message frame.

The message system distinguishes between three messages:

● Operating messages are used to display a state in the process.

● Alarm messages are used to display an error in the process.

● System messages are used to display error messages from other applications.

In Alarm Logging, messages with similar behavior, for example, with the same 
acknowledgement theory or color assignment of message states, can be grouped into 
message classes and message types.
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Message Classes, Message Types
● Message classes are used to define numerous basic settings for messages. Message 

classes differ from one another with respect to the acknowledgement theory. The following 
message classes are preconfigured in Alarm Logging: "Error", "System, Requires 
Acknowledgement", and "System, Without Acknowledgement". You can define up to 16 
message classes. Messages with the same acknowledgement theory can be combined 
into a single message class.

● Message types are subgroups of the message classes and can differ with respect to the 
color assignment of the message states. You can create up to 16 message types for each 
message class.

Message blocks
The state change of a message is displayed in a message line during runtime. You define the 
information you want to have displayed in the message line during configuration of the 
message blocks:

● System blocks enable the specification of information that is predefined and not freely 
utilizable, such as date, time, duration, comment. The value of the message block (for 
example, the time of day) is displayed in the message line.

● User text blocks enable you to assign a message to up to ten different freely definable texts. 
The message line will display the content of the text you defined. The message text of a 
user text block can also display a process value. You define the output format for it.

● Using process value blocks, you can display the values of tags in the message line. The 
formatting that is used for this cannot be user-defined. You specify the associated tags for 
the process value blocks.

When using in multi-user systems  the content of a message can be displayed on a client by 
configuring the message blocks equally on all servers. This also applies to the output of 
alarms via the WinCC CAS.

Message Event, Message State
● Message events refer to the "coming in", "going out", and "acknowledging" of messages. 

All message events are stored in the message archive.

● Message states are the possible states of a message: "Came In", "Went Out", 
"Acknowledged".

Alarm window
During runtime, the changes in message states are indicated in a message window. You can 
configure the appearance and operating options of the message window in the Graphics 
Designer.

A message window contains all messages that have yet to be displayed in a table. Each 
message to be displayed appears in its own line – the message line.

The content of the message window can be influenced by a user-defined filter, for example 
sorting according to message blocks. 
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Depending on the source of the messages displayed in the Message Window, a distinction is 
made between five types of message windows.

● Message lists are used for displaying currently pending messages.

● Short-term archive lists are used to display messages that are stored in a message archive. 
The display of messages is immediately updated when a new message arrives.

● Long-term archive lists are used to display messages that are stored in a message archive.

● All messages in the system that have been locked are displayed in the lock list. Locked 
messages can be unlocked by means of a button in the toolbar.

● The hit list contains statistical information on the messages.

● The list of hidden messages shows all messages that to be hidden due to automatic or 
manual hide in the message list, in the short-term archive list or the long-term archive list.

Message Frames
Message frames originate from either the process or from the process-control monitoring 
system. They are exchanged between the control system or the monitoring application and 
Alarm Logging.

Message tag
In the bit message procedure, the control system signals the occurrence of an event in the 
process by means of the message tag. Several messages can be masked via one message 
tag. You can only use a bit of the message tag for a single message.

Message procedure
The message procedure is a result of the configuration of the message. Alarm Logging 
supports multiple message procedures: 

● In the bit message procedure, the control system signals the occurrence of an event by 
means of a message tag. The time stamp (date and time) of the message is assigned by 
Alarm Logging.

● With chronological reporting, the control system transmits a message frame with the 
message data when the event occurs. This is evaluated in Alarm Logging. The time stamp 
(date and time) of the message is assigned by the controller.
-If the "Acknowledgement-Triggered Messaging" (QTM) procedure is activated on an AS 
S7-400, not every signal change is transmitted to the OS. With the QTM procedure, when 
messages occur frequently due to sensor chatter, the AS does not send a new message 
about a signal change until the last signaled positive signal change (incoming message) 
has been acknowledged in the OS. 

● Limit value monitoring can be used to monitor the course of an analog tag for violation of 
the upper and lower limit values.
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Message line
In a message window, each message is displayed in its own message line. The content of the 
message line depends on the message blocks to be displayed:

● In the case of system message blocks, the value of the message block is displayed, for 
example date and time.

● In the case of process and user text blocks, the content is displayed, for example, the text 
you have defined.

Logging
There are two options available in WinCC AlarmControl for logging messages:

● With message sequence reports, all state changes (came in, went out, acknowledged) from 
all currently pending messages are output to a printer.

● The messages in the individual message lists can be printed out directly via Print Current 
View button in WinCC AlarmControl.

Acknowledgement theory
The acknowledgement theory refers to the manner in which a message is to be displayed and 
processed from the time it "comes in" to the time it "goes out." The following acknowledgement 
theories can be implemented in Alarm Logging:

● Single message without acknowledgement

● Single message with incoming acknowledgement

● Message with dual-mode acknowledgment

● Initial value message with single-mode acknowledgment

● New-value message with single-mode acknowledgment

● New-value message with dual-mode acknowledgment

● Message without "Went Out" status and without acknowledgement

● Message without "Went Out" status and with acknowledgement

Acknowledgement tag
The acknowledgement tag contains the "Acknowledgement Status" of a message. A central 
signaling device can thus be controlled using the acknowledgement tag.

Locking and Unlocking Messages
In order to reduce the number of message events, known recurring messages can be locked 
and unlocked again. The system distinguishes between active and passive locking/unlocking 
of messages. For active locking, the message source must support the locking/unlocking of 
messages with confirmation and a valid date/time stamp. In addition, a general query of the 
source must return the currently locked messages. If the message source meets these 
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requirements, the messages are locked/unlocked in active mode; otherwise, the messages of 
WinCC are locked/unlocked in passive mode.

● In the case of active locking, a lock request is sent to the message source (for example, 
the AS). The message is locked in WinCC only after the source confirms that the message 
as locked. The above procedure is also used to unlock messages. Only messages that 
have been configured chronologically on the AS level are locked/unlocked in active mode.

● In the case of passive locking, the message is locked/unlocked in the alarm server of 
WinCC. The message source is not involved in this process.

Status tag
The "Came In / Went Out" status of the message type and an identifier for messages requiring 
acknowledged are stored in the status tag.

See also
Working with Message Blocks (Page 905)

How to Configure the Message System Using the System Wizard (Page 904)

Alarm Logging (Page 896)

Principles of the Message System (Page 894)

WinCC Alarm Control (Page 1070)

5.3 Principles of the Message System

5.3.1 Principles of the Message System

Introduction
Messages inform the operator about operating states and error states in the process. They 
help identify critical situations early so that downtimes can be avoided.

Structure of a Message
Messages are displayed during runtime in the form of lines in a table. The individual messages 
are composed of information that is shown in the fields of the table. These individual pieces 
of information are referred to as message blocks.

The message blocks are subdivided into three groups:
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● System blocks with system data, for example, date, time of day, message number, and 
status

● Process value blocks with process values, for example, current fill levels, temperatures or 
rotational speeds

● User text blocks with explanatory texts, for example, the message text containing 
information on the location and cause of a fault

Whereas the contents of the system blocks are fixed, the contents of the process value blocks 
and user text blocks can be modified by the user. Selections in system blocks affect only the 
data display but not the logging.

Configuration
You configure messages in Alarm Logging. Several wizards are available to assist you during 
configuration:

● The System Wizard assists you in defining the basic settings of the message system.

● The Interconnection Wizard facilitates the assignment of process tags to messages.

● A selection of single messages can be processed simultaneously.

● You can assign the same text to several user text blocks.

You configure the message window for displaying messages in runtime in the form of an 
ActiveX control in the Graphics Designer. You can configure the appearance and operating 
options of the message window here according to your requirements.

The Report Designer is used to configure the printout of messages in chronological order and 
to log message archives.
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Display of Messages during Runtime
In runtime, Alarm Logging records, evaluates, and archives the events coming from the 
controllers or process control system and then displays them in a message window. 

See also
Working with Message Blocks (Page 905)

How to Configure the Message System Using the System Wizard (Page 904)

Alarm Logging (Page 896)

Message System in WinCC (Page 887)

WinCC Alarm Control (Page 1070)

5.3.2 Alarm Logging

Introduction
You configure the messages and the message archive in Alarm Logging. You start Alarm 
Logging by double-clicking in WinCC Explorer.
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Structure of alarm logging
The alarm logging interface consists of the navigation, data and table windows.

(1) Navigation window
To configure messages, you work through the folders in the tree view in their given order. The 
shortcut menu menu allows you to access the individual areas and their elements.

(2) Data window
The data window contains the icons of the available objects. By double-clicking an object, you 
can access the respective message system settings. You can use the shortcut menu to display 
the object properties. These differ from object to object.

(3) Table window
The table window contains a table of the individual generated messages and the configured 
properties. The individual fields can be accessed for editing with a double-click. You can use 
the "Find" menu to search for terms and numbers in all or selected columns.
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Note

If there is an inconsistency in the configuration of a single message, the entries in the table 
window are shown with a dark magenta background. An inconsistent configuration results 
when the message class or message type of the single message is not available in the 
message configuration data. 

See also
Working with Single Messages (Page 927)

Working with Message Classes (Page 913)

Working with Message Blocks (Page 905)

Configuring the Message System (Page 903)

Basic Settings of Alarm Logging (Page 898)

Message Archiving in WinCC (Page 994)

5.3.3 Basic Settings of Alarm Logging

5.3.3.1 Basic Settings of Alarm Logging

Introduction
The following basic Alarm Logging settings can be adapted:

● Adding and removing columns in the data window

● Changing the configuration language

● Integrating add-ins to the message system

● Changing the text input mode

See also
Adding and Removing Columns (Page 899)

How to Change the Text Input Mode (Page 901)

How to Integrate Add-Ins into the Message System (Page 900)

How to Change the Configuration Language (Page 899)

Setting up a Message System
5.3 Principles of the Message System

MDM - WinCC: Working with WinCC
898 System Manual, 11/2008,  



5.3.3.2 Adding and Removing Columns

Introduction
You can use the "Add/Remove Columns" command to hide or unhide individual columns in 
the table window.

Procedure
1. In the "View" menu, select "Add/Remove Columns..."

2. In the "Add/Remove Columns" dialog, all columns to be displayed are marked with a check 
mark. You can click select or clear the checkmarks for individual columns.

3. Click "OK" to close the dialog. The table window is updated, and the non-selected columns 
are hidden.

 

See also
Basic Settings of Alarm Logging (Page 898)

5.3.3.3 How to Change the Configuration Language

Introduction
You can change the configuration language by selecting the desired language from a list. 

The language change affects only the texts stored in the text library. The language of the user 
interface is not affected by the language change. If no texts are stored for the selected 
language, the user interface language is used.
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Procedure
1. In the "View" menu, select "Language...".

2. Select the desired language from the list and click "OK" to confirm.

Note

You enter the texts in the various languages in the "Text Library" editor.

See also
Basic Settings of Alarm Logging (Page 898)

5.3.3.4 How to Integrate Add-Ins into the Message System

Introduction
Add-ins are only integrated into the message system, if needed. The limit value monitoring is 
available as an add-in.

Setting up a Message System
5.3 Principles of the Message System

MDM - WinCC: Working with WinCC
900 System Manual, 11/2008,  



Procedure
1. In the "Tools" menu, select "Add Ins...".

2. Select the add-in in the dialog.

3. Click "OK" to close the dialog. The add-ins selected are displayed in the navigation window.

See also
Working with the Limit Value Monitoring (Page 984)

Basic Settings of Alarm Logging (Page 898)

5.3.3.5 How to Change the Text Input Mode

Introduction
You can specify how text changes are to take effect in the table fields of single messages.
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Text Input Options
The following text input options are available:

option Description

Changes to the selected text apply 
to all identical texts.

If a text is changed, all single message text fields containing this 
text are changed.

Changes apply only to the 
selected text.

The change to a text in a text field applies only to that field.

Keep settings. The selected mode is retained for future text changes; otherwise 
the selected mode applies only to the current change.

Effects on Multilingual Projects
If a message text is configured in a different language after the project language has been 
changed, the text input mode settings determine whether the text is stored in the text library.

● "Changes to the selected text apply to all identical texts": The message text is stored in the 
text library under the same ID. When the runtime language is changed, the translation of 
the text is displayed.

● "Change applies only to the selected text": The message text is stored in the text library 
under a new ID. You can now enter the translation of the changed message text in the text 
library.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the "Messages" menu, select "Text Input Mode...". The "Text Input Mode" dialog opens.

2. Select the desired input mode.

See also
How to Specify the Message Texts of a Single Message (Page 938)

Basic Settings of Alarm Logging (Page 898)

5.4 Configuring the Message System

5.4.1 Configuring the Message System

Introduction
In Alarm Logging, you can specify which messages and which content are to be displayed in 
the message window and archived.
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General Procedure
Configuration of the message system is broken down into the following steps:

1. Use the System Wizard to specify the basic settings for the message system.

2. Configure the message blocks in accordance with your requirements.

3. Configure the message classes and message types.

4. Configure the single messages and group messages.

5. Configure the data archiving method.

6. After completion of each configuration step, save the changes made in Alarm Logging.

Note

Make use of the wizards and configuration dialogs for all aspects of creation of new messages.

See also
Message System in WinCC (Page 887)

Working with Group Messages (Page 970)

Working with Single Messages (Page 927)

Working with Message Classes (Page 913)

Working with Message Blocks (Page 905)

How to Configure the Message System Using the System Wizard (Page 904)

Alarm Logging (Page 896)

Message Archiving in WinCC (Page 994)

5.4.2 How to Configure the Message System Using the System Wizard

Introduction
The System Wizard is used to preconfigure the message system. Here, for example, frequently 
used message blocks and message types are created. You can adapt the objects created by 
the wizard at a later time.

The System Wizard generates the messages in all installed languages in the text library. After 
the wizard has run, you can delete any unnecessary languages from the text library. If you 
install a language at a later time, you must set the configuration language for the existing 
project to the new language in Alarm Logging. The messages will then also be generated in 
this language.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the File menu, select "Select Wizard" and then select "System Wizard". Click "OK".

2. After the start screen, specify the message blocks you want to create with the System 
Wizard in the "Select Message Blocks" dialog..

3. In the "Preset Classes" dialog, specify the message classes along with their respective 
acknowledgement theory and associated message types.

4. The "Final" dialog contains a summary of the message blocks and message classes to be 
created by the wizard. Click "Finish". 

Note

Any settings that are modified after execution of the System Wizard will be lost when the 
wizard is run again.

See also
Configuring the Message System (Page 903)

5.4.3 Working with Message Blocks

5.4.3.1 Working with Message Blocks

Introduction
The content of a message consists of message blocks. Each message block corresponds to 
one column in the tabular display of the message window.

There are three groups of message blocks:

● System blocks with system data, for example, date, time, message number and status. The 
description of the system blocks provides information on the individual system blocks.

● User text blocks with explanatory texts, for example, message text with information on the 
cause of a fault or the fault location.

● Process value blocks are used to link the messages to process values, for example, current 
fill levels, temperatures or speeds. In each message system, up to 10 individually 
configurable process value blocks are available for each single message.
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Configuring Message Blocks
You use Alarm Logging to

● Add message blocks from an existing selection list

● Remove available message blocks

● Modify the properties of the available message blocks

General Properties of Message Blocks
A message requiring acknowledgement or single message blocks can be displayed flashing 
in runtime. To do this, the following conditions must be satisfied:

● The "Flashing On" property must be activated in the message class to which the message 
is assigned. You configure this property in the "Configure Message Class" dialog on the 
"Acknowledgement" tab.

● "Flashing On" must also be enabled in the properties of the message block to be displayed 
as flashing. You configure this property in the "Properties" dialog of the message block. If 
several message blocks or all message blocks in a message are to be displayed flashing, 
this property must be enabled in each message block of this message.

"Status" System Block
The status texts of the messages are displayed in the "Status" system block. The length of this 
system block must be configured so that the status texts can be displayed in full.

Length Restrictions for User Text Blocks and Process Value Blocks
User text blocks can contain a maximum of 255 characters.

The display of  process value blocks is restricted during runtime to the following:

● Maximum of 32 characters for chronological reporting

● Maximum of 255 characters for the bit message procedure

 

See also
Description of System Blocks (Page 907)

How to Remove Message Blocks (Page 912)

How to Change the Properties of Message Blocks (Page 910)

How to Add Message Blocks (Page 909)
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5.4.3.2 Description of System Blocks

Introduction
System blocks allow for the specification of predefined information that is not freely utilizable, 
such as date, time and duration.

The value of the message block (for example, the time of day) is displayed in the message 
line. The description of the system blocks provides information on the individual system blocks.

Overview

System block Description Standard 
length

AS/CPU-Number Number of the CPU and AS in which the message is 
triggered. During runtime, the value of this system block 
is not taken from the AS but rather is taken from the 
configured data of the single message. The value has no 
function in the communication with the AS.

2

Archiving Indicates whether the message will be archived. 1
Type One of 16 message types per message class. The text is 

user-defined.
2

User Name Indicates the name of the user (login name):
● The user name is shown the short-term archive list 

and the long-term archive list if the user has entered 
a comment in the long-term archive list and has 
changed windows.

● After acknowledgement of a message, the user who 
was logged on to WinCC at time of acknowledgement 
is identified in the operator input message in the short-
term archive list and the long-term archive list. The 
operator input message must be activated in WinCC 
Alarm Control on the "Message Lists" tab.

10

Date Date for the "incoming", "outgoing" and "acknowledged" 
states of a message.

-

Duration Period of time between the "incoming" and "outgoing" 
states and the acknowledgement of a message. There is 
only one column for duration:
● The column remains blank for messages with "came 

in" status.
● For messages with "gone out" status , the time that 

elapses between "came in" and "went out" is 
displayed.

● When the message is acknowledged, the time 
between "came in" and "acknowledged" is displayed.

-

Limit Violation This field is highlighted when a limit violation 
occurs.          
This is not supported during runtime.

-
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System block Description Standard 
length

Info Text Information texts for the message, limited to a maximum 
of 255 characters, for example, "Message might be 
caused by...". The system block indicates whether an info 
text is available for this message. Info texts cannot be 
edited during runtime.

1

Class One of 16 message classes. The text is user-defined. 8
Comment The "Comment" system block indicates whether there is 

a comment for this message. A comment is an entry made 
by the user in the event of a message occurrence, for 
example  "This message occurred today because...".

1

Loop In Alarm This field is marked with an "X" when the "Loop In Alarm" 
function is activated.

1

Number Message number 3
Priority Defines the priority of a message. You can sort the list of 

messages by priority. By sorting according to priority, you 
can ensure that, in single-line message view the most 
important message (that is, the message with highest 
priority) is shown. In this case, a message with a lower 
priority is not displayed, even if it occurred later.         
         
Value range: 0 - 16          
In WinCC, the value corresponding to the highest priority 
is not specified. When using the Basic Process Control 
or PCS7, reserve priority "16" for the highest priority 
messages of the system.

3

Logging Indicates whether the message will be logged (message 
number-specific). Starting from WinCC V6, the logging is 
incorporated into every message by default. Logging 
cannot be changed or removed.

1

Acknowledgement Status Indicates whether a message has been acknowledged. 
The status texts displayed in this system block are 
configured in the message class and depend on the 
window type of the message window.

1

Computer Name Indicates the name of the computer:
● The name of the computer used by the operator is 

shown in the short-term archive list and the long-term 
archive list, provided that the user has entered a 
comment in the long-term archive list and has 
changed windows.

● After acknowledgement of a message, the computer 
on which this has message was acknowledged is 
shown in the operator input message in the short-term 
and long-term archive lists. The operator input 
message must be activated in WinCC Alarm Control 
on the "Message Lists" tab.

10

Daylight Saving Time/
Standard Time

An "X" in this system block indicates whether daylight 
saving time applies.

1

Time of day Time of day for "incoming", "outgoing" and 
"acknowledged".          
Accuracy of the WinCC time stamp: 1 s.          
Display accuracy: 10 ms.

-
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System block Description Standard 
length

Tag The "Tag" system block is not yet supported at this time. 1
Status Message status, for example, "Came In" or "Went 

Out".          
The status texts displayed in this system block are 
configured in the message class and depend on the 
window type of the message window.

1

Note

If the "ISO 8601-Swap Format to All Components" setting is activated in the "Computer 
Properties" dialog, the formats configured for system blocks "Date" and "Time" are affected.

See also
How to Add Message Blocks (Page 909)

How to Configure the Status Texts of a Message Class (Page 925)

5.4.3.3 How to Add Message Blocks

Introduction
You can add message blocks that are necessary for the archiving and display of messages to 
the message system.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "Message Blocks" folder in the navigation window.

2. Select "Message Blocks..." in the shortcut menu. The "Configure Message Blocks" dialog 
opens.

3. Select the message block that you want to add, for example, a system block. Click "Add".
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4. Select the required message blocks from the list of available system blocks. Click  
to add these message blocks to the list of selected system blocks.

5. If you want to add all available system blocks, click . Click "OK" to confirm your 
selection.

6. Proceed in the same way to add user text blocks and process value blocks.

Alternative Procedure
1. Select the "Message Blocks" folder in the navigation window.

2. Select the desired message block, for example, system blocks, in the data window, and 
select "Add/Remove" in the shortcut menu.

3. Select the required message blocks in the list of available system blocks. Click  to 
add these message blocks to the list of selected system blocks. If you want to add all 
available system blocks, click . Click "OK" to confirm your selection.

4. Proceed in the same way to add user text blocks and process value blocks.

 

See also
Working with Message Blocks (Page 905)

5.4.3.4 How to Change the Properties of Message Blocks

Introduction
You can display and modify the properties of a message block in the Properties dialog for the 
message block.
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Requirement
● You have added the message blocks to the message system.

Procedure
1. Select the "Message Blocks" folder in the navigation window.

2. Select "Message Blocks..." in the shortcut menu. The "Configure Message Blocks" dialog 
opens.

3. In the tree view, select the message block you want to modify, for example, the "Time of 
day" system block.

4. Click the "Properties" button. The Properties dialog for the selected message block opens.

5. Edit the properties of the message block, for example, the name, in the dialog. Click "OK."

Alternative Procedure
1. Select the "System Blocks" folder in the navigation window.

2. In the data window, select the desired message block, for example, time of day. Select 
"Properties" in the shortcut menu, or double-click the message block. The Properties dialog 
for the selected message block opens.

3. Edit the properties of the message block, for example, the name, in the dialog. Click "OK."

4. Proceed in the same way to change the properties of the user text blocks and process value 
blocks.
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See also
Working with Message Blocks (Page 905)

5.4.3.5 How to Remove Message Blocks

Introduction
You have the option of removing message blocks that are no longer required for archiving and 
displaying messages from the message system.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "Message Blocks" folder in the navigation window.

2. Select "Message Blocks..." in the shortcut menu. The "Configure Message Blocks" dialog 
opens.

3. In the tree view, select the message block you want to remove, for example, the "Time of 
day" system block.

4. Click "Remove". Clicking "OK" removes the "Time of day" message block from the message 
system. Proceed in the same way to remove other message blocks.
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Alternative Procedure
1. Select the "Message Blocks" folder in the navigation window.

2. Select the message block to be removed, for example, system blocks, in the data window 
and then select "Add/Remove" in the shortcut menu.

3. Select the message blocks you want to remove in the list of selected system blocks.
Click  to move these message blocks to the list of available system blocks. If you 
want to remove all selected system blocks, click . Click "OK" to confirm your selection.

4. Proceed in the same way to remove user text blocks or process value blocks.

 

See also
Working with Message Blocks (Page 905)

5.4.4 Working with Message Classes

5.4.4.1 Working with Message Classes

Introduction
When configuring the message system, you must assign a message class to each message. 
This means you do not have to make a lot of individual basic settings; instead, you can make 
settings that apply globally for the entire message class.

Overview
WinCC provides 16 message classes and two preset system message classes. The following 
standard message classes are available:

● Fault

● System, requires acknowledgement

● System, without acknowledgement

You configure the following basic settings for message classes:

● Assigned message types

● Acknowledgement theory and associated status texts

● Output of acoustical/optical signals
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Configuring Message Classes
Message classes are configured using the "Message Classes" folder in the navigation window 
in Alarm Logging. You can add, remove or configure message classes.

See also
System Message Classes (Page 914)

How to Configure the Acknowledgement of a Message Class (Page 922)

How to Configure Message Classes (Page 916)

How to Delete Message Classes (Page 917)

How to Add Message Classes (Page 915)

How to Add Message Types for the Message Class (Page 918)

5.4.4.2 System Message Classes

Introduction
System messages are messages that are generated internally by the system, such as 
messages from operator inputs or system failures.

WinCC provides special system classes for the processing of system messages. You cannot 
add new system classes. The acknowledgement theory is preset.

System Message Class Requiring Acknowledgement
An incoming message that is assigned to the system message class that requires 
acknowledgement must be acknowledged in order to remove it from the queue. The message 
disappears immediately following an acknowledgement.

You configure the parameter settings in the "Configure Message Classes" dialog for the system 
message class.

The following message types are available:

● Process control messages. Messages are generated by the process control system, for 
example, during system startup.

● System messages. Messages are generated by the system, for example, when a system 
component fails.
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Note

The "Went Out" status is not registered or stored in the archive.

System Message Class Without Acknowledgement
A message that is assigned to the system message class not requiring acknowledgement does 
not have to be acknowledged. 

You configure the parameter settings in the "Configure Message Classes" dialog for the system 
message class.

The following message types are available:

● Process control messages. Messages are generated by the process control system, for 
example, during system startup.

● Operator input messages. Messages are generated by the operator input, for example, 
through operation of a component.

Note

Be aware that an erroneous operator input will also be reported in an operator input message.

See also
How To Insert WinCC System Messages (Page 960)

How to Configure Message Classes (Page 916)

5.4.4.3 How to Add Message Classes

Introduction
You add additional message classes to the message system in order to combine messages 
having the same acknowledgement theory into additional message classes.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "Message Classes" folder in the navigation window.

2. Select "Add/Remove" in the shortcut menu. The "Add Message Class..." dialog opens.
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3. Select the required message classes in the list of available message classes. Click 
 to add these message classes to the list of selected message classes.

4. If you want to add all available message classes, click . Click "OK" to confirm your 
selection.

 

See also
Working with Message Classes (Page 913)

5.4.4.4 How to Configure Message Classes

Introduction
You configure the following basic settings for message classes:

● Name of message class

● Assigned message types

● Acknowledgement theory and associated status texts

● Output of acoustical/optical signals
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Requirement
● You have added the message classes to the message system.

Procedure
1. Select the "Message Classes" folder in the navigation window.

2. Select the message class to be configured in the data window. Select "Properties" in the 
shortcut menu, or double-click the message class. The Properties dialog for the selected 
message class opens.

3. In the "Configure Message Classes..." dialog, click the tab on which you want to display 
and edit the properties of the message class.

4. Click "OK" to close the dialog. 

See also
How to Configure the Status Texts of a Message Class (Page 925)

How to Configure the Acknowledgement of a Message Class (Page 922)

How to Remove Message Types (Page 921)

How to Change the Properties of Message Types (Page 920)

Working with Message Classes (Page 913)

How to Add Message Types for the Message Class (Page 918)

5.4.4.5 How to Delete Message Classes

Introduction
You remove a message class from the message system when you no longer need it for the 
configured messages.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "Message Classes" folder in the navigation window.

2. Select "Add/Remove" in the shortcut menu. The "Add Message Class..." dialog opens.
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3. Select the message classes you want to remove in the list of selected message classes. 
Click  to move these message classes to the list of available message classes.

4. If you want to remove all selected message classes, click . Click "OK" to confirm your 
selection.

Note

You cannot remove the "System, requires acknowledgement" and "System, without 
acknowledgement" message classes.

See also
Working with Message Classes (Page 913)

5.4.4.6 How to Add Message Types for the Message Class

Introduction
You configure message types within a message class that differ with respect to the color 
assignment for the message statuses.
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Requirement
● You have added the message class to the message system.

Procedure
1. Select the message class to be configured in the navigation window.

2. Select "Add/Remove Message Types..." in the shortcut menu. The "Add Message Type..." 
dialog opens.

3. Select the required message types in the list of available message types. Click  to 
add these message types to the list of selected message types.

If you want to add all available message types, click . Click "OK" to confirm your selection.

Alternative Procedure
1. Select the "Message Class" folder in the navigation window.

2. Select the desired message class in the data window. Select "Properties" in the shortcut 
menu. The "Configure Message Classes..." dialog opens.

3. Click "Add".          
The "Add Message Type..." dialog opens.

4. Select the required message types in the list of available message types. Click  to 
add these message types to the list of selected message types. If you want to add all 
available message types, click . Click "OK" to confirm your selection. 

See also
How to Configure Message Classes (Page 916)

How to Change the Properties of Message Types (Page 920)
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5.4.4.7 How to Change the Properties of Message Types

Introduction
You configure the properties of a message type in the Properties dialog for the message type. 
You have the option of changing the name of the message type and the display color of the 
messages for the statuses "Came In", "Went Out" and "Acknowledged". 

Requirement
● You have added the message type to the message class.

Procedure
1. Select the message class whose message type you want to change in the navigation 

window.

2. Select the desired message type in the data window.

3. Select "Properties" in the shortcut menu. The "Type" dialog opens.

4. Change the properties of the message type, for example, the text color of the "Came In" 
status, in the dialog. Click "OK" to close the dialog.

Alternative Procedure
1. Select the message class whose message type you want to change in the navigation 

window.

2. Select "Properties" in the shortcut menu. The "Configure Message Classes" dialog iopens.
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3. Select the desired message type in the dialog, and click "Properties". The "Type" dialog 
opens.

4. Change the properties of the message type, for example, the text color of the "Came In" 
status, in the dialog. Click "OK" to close the dialog.

 

See also
How to Configure Message Classes (Page 916)

5.4.4.8 How to Remove Message Types

Introduction
You remove a message type from the message class if it is no longer required for the configured 
message class.

Note

You cannot remove the "Process Control System", "System Messages", and "Operator Input 
Messages" message types.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the message class from which you want to remove a message type in the navigation 

window.

2. Select "Add/Remove Message Types..." in the shortcut menu. The "Add Message Type..." 
dialog opens.
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3. Select the message types you want to remove in the list of selected message types. Click 
 to move these message types to the list of available message types.

4. If you want to remove all selected message types, click . Click "OK" to confirm your 
selection.

Alternative Procedure
1. Select the "Message Class" folder in the navigation window.

2. Select the desired message class in the data window. Select "Properties" in the shortcut 
menu. The "Configure Message Classes..." dialog opens.

3. Select the message type you want to remove. Click "Remove".          
The message type is removed from the message class. Click "OK" to close the dialog.

 

See also
How to Configure Message Classes (Page 916)

5.4.4.9 How to Configure the Acknowledgement of a Message Class

Introduction
For the acknowledgement of a message, you specify how the message is to be displayed and 
processed during runtime from "Incoming" status to "Outgoing" status.
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Requirement
● You have opened the "Configure Message Classes" dialog for the message class in Alarm 

Logging.

Basic procedure
On the "Acknowledgement" tab, you configure the acknowledgement theory of a message of 
the message class and the acknowledgement of a message using a central signaling device.

You can choose between eight different statuses for the acknowledgement of a message: 

● Single message without acknowledgement

● Single message with incoming acknowledgement

● Single message with dual-mode acknowledgement

● Initial-value message with single-mode acknowledgement

● New-value message with single-mode acknowledgement

● New-value message with dual-mode acknowledgement

● Message without "Went Out" status and with acknowledgement

● Message without "Went Out" status and without acknowledgement
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Acknowledgement Theory Options

option Description

Acknowledgeme
nt came in 

Select the check box for a single message with incoming acknowledgement. 
Incoming messages of this message class must be acknowledged. The message 
remains pending until it is acknowledged.

Acknowledgeme
nt went out

Select the  check box for a single message with dual-mode acknowledgement. 
Outgoing messages of this message class must be acknowledged. 

Flashing On Select the check box for a new-value message with single-mode or dual-mode 
acknowledgement. The messages of this message class are displayed flashing in 
the message window. In order for a message block of a message to flash in runtime, 
flashing must be enabled in the properties of the respective message block.

Only Initial Value Select the check box for an initial-value message with single-mode 
acknowledgement. Only the first message in this message class is displayed 
flashing in the message window, The "Flashing On" check box must have been 
selected beforehand.

Message 
Without Status 
"Went Out"

Select the check box for a message without "Went Out" status and with or without 
acknowledgement. If this option is selected, the messages doe not have "Went Out" 
status. If the message only recognizes the "Came In" status, it is not entered in the 
message window and is only archived.

Comments with 
Explicit User

If you select the check box, the comments in the message window are assigned to 
the logged-on user. The user is entered in the "User Name" system block. If no 
comment has yet been entered, any user can enter the first comment. After the first 
comment has been entered, all other users have only read access to this comment.

Comment of 
Incoming 
Message Always 
in Message List

If you select the check box, the comment of the incoming message is always 
displayed in the user text blocks with the dynamic components "@100%s@", 
"@101%s@", "@102%s@" und "@103%s@". The display then depends on the 
status of the message in the message list.

If certain options have been selected, other options may no longer be available for selection. 
If you want to select one of these options, you must undo the previous selection.

Note

If a message type does not need to be acknowledged and is not assigned a "Went Out" status, 
it is not displayed in the message window. The message is only archived. If such a message 
is used within a group message, the occurrence of the message does not trigger the group 
message.
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Acknowledgement of a Central Signaling Device

option Description

Separate 
acknowledgemen
t button

Central signaling devices that are triggered when a message comes in are 
acknowledged by the user by means of a separate acknowledgement button in the 
toolbar or by means of a keyboard entry. The acknowledgement button must be 
configured in the message window. The separate acknowledgement button is 
always available, even if the "By Means Of Single Ack." option has been selected.

By Means of 
Single 
Acknowledgemen
t

Central signaling devices that are triggered when a message comes in are 
acknowledged together with the triggering message.

Variable The central signaling device is controlled by a defined tag.
Opens the "Select Tag" dialog so that a tag can be selected as an 
acknowledgement tag.

 

See also
How to Configure Message Classes (Page 916)

5.4.4.10 How to Configure the Status Texts of a Message Class

Introduction
Message status texts of a message are displayed in the message line in the "Status" and the 
"Acknowledgement Status" system blocks.

Requirement
● You have opened the "Configure Message Classes" dialog for the message class in Alarm 

Logging.

Display in the Message Window
The display of customizable status texts depends on the type of the selected Message Window:

Window Type System Block Display of the Status Texts from the Field

Message list State "Came In", or "Came In and Went Out"
Message list Acknowledgeme

nt Status
"Acknowledged"

Archive List State "Came In", "Acknowledged" or "Went Out"
Archive List Acknowledgeme

nt Status
No text is displayed.
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Window Type System Block Display of the Status Texts from the Field

Lock list State No text can be configured. Locked messages are labeled with 
"Lock"; the lock cannot be configured.

Lock list Acknowledgeme
nt Status

No text can be configured. No text is displayed.

Note

The system generates the display of status texts "Ackn System" for system-acknowledged 
messages and "Ackn Reset" for acknowledged messages using emergency 
acknowledgement.

Configuration of Status Texts
You configure the texts for the individual message statuses on the "Status Texts" tab.

option Description

Came In Text for "incoming" messages when there is a change to the signaling 
operating state

Went Out Text for "outgoing" messages when there is a change from the signaling 
operating state

Acknowledged Text for acknowledged messages
Came In and Went Out Text for message that has come in and gone out
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Note

Status texts are displayed in the message line only up to their configured length in the system 
block properties. Therefore, a system block should be long enough for the longest status text 
to be displayed.

See also
How to Configure Message Classes (Page 916)

5.4.5 Working with Single Messages

5.4.5.1 Working with Single Messages

Introduction
With single messages, a message is assigned to every event. Several single messages can 
be compiled to form a group message. A single message is made up of the defined message 
blocks. 

Configuring Single Messages
You can process single messages in the table window of Alarm Logging:

● Create and copy single messages

● Delete single message

● Define and modify parameters of a single message

See also
How to Delete a Single Message (Page 931)

Parameters of a Single Message (Page 928)

How to Create a Single Message (Page 931)
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5.4.5.2 Parameters of a Single Message

Introduction
Make the following settings on the "Parameters" tab of the "Single Message" dialog:

● Parameters of the single message, e.g. association with a message class and message 
type

● Parameters for the connections to different tags, such as the message tag

Opening the "Single message" dialog
You open the properties dialog for a single message by selecting "Properties" in the shortcut 
menu of the single message selected.

Click  to open the dialog for tag selection.

Click  to reset the tag assignment and the bit used in it.
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Parameters of single messages
You can set the following parameters for a single message:

Parameters Description

Number Number of the single message. You can only set the number in the table window.
Class Message class of the single message.
Type Message type of the single message.
Group You can select a configured group message in the selection list when assigning the single 

message to a user-defined group message.
Hide mask Defines the condition for hiding the message based on a hexadecimal value. If the value of 

the hide tag number corresponds to a system status in runtime, the message is automatically 
hidden in the message list and in the short-term or long-term archive list. The single message 
must be assigned to a user-defined group message and a hide tag must have been configured 
for the group message.

Priority Defines the message priority. Messages can be selected and sorted based on their priority. 
The range of values is "0" to "16".          
The value which is equivalent to the highest priority is not specified in WinCC. The value 16 
corresponds to the highest priority in the PCS7 environment. 

requires single 
acknowledgment

The message must be acknowledged separately. It cannot be acknowledged using a group 
acknowledgement button.

controls the central signaling 
device

Activation of a message triggers central signaling device.

will be archived The message is saved to the archive.
Is created on a negative 
edge

You can specify whether to trigger generation of a message for discrete alarms at the positive 
or at the negative signal edge . Message generation is always triggered at the positive signal 
edge for all other message procedures.         
The message tag for messages triggered at the negative edge must be assigned start value 
"1".

triggers an action The message triggers the default GMsgFunction which you can edit using the "Global Script" 
editor. The function is available at "Standard Functions/Alarm" in the function browser of 
Global Script.

contains expanded 
associated values

The option "contains expanded associated values" refers to the evaluation of message events 
from message blocks by means of raw data tags. If the option is activated, the process values 
are evaluated according to the data type of associated values defined in the dynamic text 
parts in Alarm Logging and are archived or displayed in the single message. The 12 bytes of 
the associated values can contain the following data types: Byte(Y), WORD(W), DWORD(X), 
Integer(I), Integer(D), BOOL(B), CHAR(C) and REAL(R). E.g. @1Y%d@, @2W%d@, @3W
%d@, @3X%d@, @5W%d@, @6Y%d@. "@2W%d@" references the second associated 
value as "WORD", for example.

AS Number Number of the AS (sublevel controller - PLC) which triggers the message.          
This field is only displayed if the "AS/CPU-Number" block is available in the system message 
blocks.         
The value configured in this field is displayed in the message block of the single message at 
runtime and has no function for communication with the AS. 

CPU number Number of the CPU which triggers the message.          
This field is only displayed if the "AS/CPU-number" block is available in the system message 
blocks.         
The value configured in this field is displayed in the message block of the single message at 
runtime and has no function for communication with the AS or CPU. 

Message tag The message tag contains the bit which is used to trigger the currently selected message.
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Parameters Description

Message bit Number of the message tag bit which is used to trigger the currently selected message.
Acknowledgment tag Select this field to specify the acknowledgment tag.
Acknowledgment bit Number of the acknowledgment tag bit that is used to acknowledge the message.
Status tag Select this field to specify the tag to which single message states are saved ("activated / 

deactivated" and acknowledgment state).
Status bit Number of the status tag bit which indicates the message status. The bit for mandatory 

acknowledgment is determined automatically.
Format DLL If the message tag is a raw data tag, you must select the corresponding compiler program in 

this field.
DLL parameters Enter the interface-specific DLL message parameters (Format DLL) in this field. This setting 

is only required if this message belongs to a separate format DLL which is interconnected by 
means of ODK.

 

Note

Do not combine any tag bits of the message with other tags of the message, such as message 
tag and status tag.

Parameter input for single messages in the table window
You have several options of entering parameters in the fields of the table window. Double-click 
has the following functions:

● Opening dialogs for single messages, e.g. to select a tag.

● Selecting parameters be means of selection field.

● Direct input of parameters.

See also
How to Link a Picture to a Single Message (Page 943)

How to Specify the Message Texts of a Single Message (Page 938)

How to Connect Tags and Messages Using the Interconnection Wizard (Page 937)

How to Specify the Tag of a Single Message (Page 936)

Status Tag of a Single Message (Page 933)

Acknowledgement Tag of a Single Message (Page 935)

Message Tag of a Single Message (Page 932)

Working with Single Messages (Page 927)

How to Configure the Hiding of Messages (Page 945)

Hide tag of a User-Defined Group Message (Page 975)
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5.4.5.3 How to Create a Single Message

Introduction
You create a single message in the table window of Alarm Logging by inserting a new line or 
copy and paste and existing single message.

Requirement
● The "Alarm Logging" editor is open.

Creating a New Single Message
1. In the table window, select "Add New Line" in the shortcut menu.

2. A line will be added at the bottom of the table. This line contains the data of the new 
message. If necessary, change the properties of the new single message.

Copying and Pasting a Single Message
1. In the table window, select a field of the single message that you want to copy.

2. Select "Copy line" in the shortcut menu.

3. Select "Append copied line" in the shortcut menu.

4. A line will be added at the bottom of the table. This line contains the data of the copied 
message. If necessary, change the properties of the copied single message.

 

See also
How to Delete a Single Message (Page 931)

Parameters of a Single Message (Page 928)

Working with Single Messages (Page 927)

5.4.5.4 How to Delete a Single Message

Introduction
You can delete a single message in the table window of Alarm Logging.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the table window, select a field of the single message that you want to delete.

2. Select "Delete line" in the shortcut menu. 

3. The single message is deleted and removed from the table.

 

See also
Parameters of a Single Message (Page 928)

How to Create a Single Message (Page 931)

Working with Single Messages (Page 927)

5.4.5.5 Tags of a Single Message

Message Tag of a Single Message

Introduction
The message is triggered by means of the message tag. The structure of message tags is not 
specified.

You have the following options of configuring message tags:

● Configuring separate message tags for single messages.

● Triggering several single messages using one message tag. The message bit is used to 
identify the single messages. A message tag bit can only be used for a single message.

Procedure for Configuration
Select "Properties" in the shortcut menu of the selected single message. You specify the 
message tag on the "Parameters" tab of the "Single Message" dialog.

Click  to open the dialog for selection of the tag to be used as the message tag.

Click  to reset the message tag assignment and the message bit.

Note

Do not combine any tag bits of the message with other tags of the message, such as a status 
tag.
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See also
How to Connect Tags and Messages Using the Interconnection Wizard (Page 937)

Parameters of a Single Message (Page 928)

Status Tag of a Single Message (Page 933)

Acknowledgement Tag of a Single Message (Page 935)

Status Tag of a Single Message

Introduction
There are two determining message statuses for a single message:

● The "Came In / Went Out" status indicates whether the message is incoming or outgoing.

● The acknowledgement status indicates whether the message requires acknowledgement 
and has not yet been acknowledged.

Both statuses of the single message are stored in a status tag. Depending on the data type of 
the tag, up to 16 single messages can be recorded in a status tag. Each single message 
occupies 2 bits in the status tag.

"Acknowledgment bit"
The acknowledgement bit in the status tag changes to "1" as soon as a single message 
requiring acknowledgement has come in and has not yet been acknowledged. The 
acknowledgement bit changes to "0" as soon as a single message requiring acknowledgement 
has been acknowledged. 

Position of the bits in "activated/deactivated" state and in acknowledgment state
The position of the bit for "activated/deactivated" states in the status tag is identified by the 
status bit. The position of the "acknowledgment bit" depends on the data type of the status 
tag.          
The distance to the bit with the "Came In / Went Out" status is:

● 4 bits for the "8 bit unsigned" tag.

● 8 bits for the "16 bit unsigned" tag.

● 16 bits for the "32 bit unsigned" tag.

Status tag of data type "32 Bit Unsigned"
If the status tag is of data type "32 bit unsigned" and the status bit = 9,

● bit 9 of the status tag indicates the "activated/deactivated" state of the single message.

● bit 25 of the status tag indicates whether this single message requires acknowledgment.

Bits "0-15" correspond accordingly to bits "16-31" of a "32-bit" status tag.
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Status tag of data type "16 Bit Unsigned"
If the status tag is of data type "16 bit unsigned" and the status bit = 3,  

● bit 3 of the status tag indicates the "activated/deactivated" state of the single message.

● bit 11 of the status tag indicates whether this single message requires acknowledgment.

Bits "0-7" correspond accordingly to bits "8-15" of a "16-bit" status tag.

Status tag of data type "8 Bit Unsigned"
If the status tag is of data type "8 bit unsigned" and the status bit = 3,  

● bit 3 of the status tag indicates the "activated/deactivated" state of the single message.

● bit 7 of the status tag indicates whether this single message requires acknowledgment.

Bits "0-3" correspond accordingly to bits "4-7" in an "8-bit" status tag.

Configuring the status tags
Select "Properties" in the shortcut menu of the selected single message. Specify the status 
tag on the "Parameters" tab of the "Single Message" dialog.

Click  to open the dialog for selecting the status tag.

Click  to reset the status tag assignment and the status bit.

Note

Do not combine any tag bits of the status with other tags of the message, such as an 
acknowledgment tag.
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See also
How to Connect Tags and Messages Using the Interconnection Wizard (Page 937)

Parameters of a Single Message (Page 928)

Message Tag of a Single Message (Page 932)

Acknowledgement Tag of a Single Message (Page 935)

Acknowledgement Tag of a Single Message

Introduction
One bit of the acknowledgment tag in single messages is used to trigger the acknowledgment 
and to display the status. The following rules apply:

● The single message was acknowledged if the corresponding acknowledgment bit has the 
value "1".

● The single message has not yet been acknowledged if the corresponding acknowledgment 
bit has the value "0".

This acknowledgment bit is set when a single message is acknowledged at runtime.

The structure of the acknowledgment tag is not specified. You have the following options of 
configuring message tags:

● Configure a separate acknowledgment tag for each single message.

● Group several single messages in a single acknowledgment tag. The acknowledgment bit 
is used to distinguish between the single messages.

Note

For the acknowledgment of the single message using the WinCC Alarm Control, the 
acknowledgment bit assigned to the single message is set. The acknowledgment bit is 
reset by user actions, for example, by clicking a button in the WinCC process window or 
by means of a program in the AS.

Configuring acknowledgment tags
Select "Properties" in the shortcut menu of the selected single message. Specify the 
acknowledgment tag on the "Parameters" tab of the "Single Message" dialog.

Click  to open the dialog for selection of the tag you want to use as an acknowledgment tag.

Click  to reset the acknowledgment tag assignment and the acknowledgment bit.

Note

Do not combine any bits of the acknowledgment tag with other tags of the message, such as 
a status tag.

Setting up a Message System
5.4 Configuring the Message System

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  935



See also
How to Connect Tags and Messages Using the Interconnection Wizard (Page 937)

Parameters of a Single Message (Page 928)

Status Tag of a Single Message (Page 933)

Message Tag of a Single Message (Page 932)

How to Specify the Tag of a Single Message

Introduction
The process variables are represented by tags. You must connect the process value blocks 
configured for the single message to the associated WinCC tags.

Requirement
● You have already created single messages.

● At least one process value block has been added to the message system.

Procedure
1. Select "Properties" in the shortcut menu of the selected single message. The "Single 

Message" dialog opens.

2. Select the "Tag / Action" tab.
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3. Click  for the configured process value block. Select the process tag that you want to 
connect the process value block to in the displayed tag selection dialog. Click "OK."

4. Click  to reset the process tag assignment.

 

See also
How to Link a Picture to a Single Message (Page 943)

How to Specify the Message Texts of a Single Message (Page 938)

How to Add Message Blocks (Page 909)

Parameters of a Single Message (Page 928)

How to Create a Single Message (Page 931)

How to Connect Tags and Messages Using the Interconnection Wizard

Introduction
The Interconnection Wizard assists you in connecting the message tags and 
acknowledgement tags of messages to the tags of WinCC Explorer. The tag connections 
generated by the wizard can be changed later on in the table window.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the File menu, select "Select Wizard" and then select "Interconnection Wizard". Click 

"OK". Alternatively, you can start the Interconnection Wizard in the "Messages" menu.

2. Click the  button to select a message tag in the "Interconnect Tag: Message Tag" dialog. 
Enter the numbers of the messages to which you want to interconnect the selected 
message tag.

3. Click the  button to select an acknowledgement tag in the "Interconnect Tag: 
Acknowledgement Tag" dialog. Enter the numbers of the messages to which you want to 
interconnect the selected acknowledgement tag.

4. Click "Apply" to close the wizard. The selected tags are interconnected with the 
corresponding messages.

 

See also
Parameters of a Single Message (Page 928)
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5.4.5.6 How to Specify the Message Texts of a Single Message

Introduction
In message texts for a message, you can specify, for example, information on the cause of a 
fault or the location of the fault.

Settings for Configuring Message Texts
You specify the configurable texts of the single message on the "Text" tab of the "Single 
Message" dialog.

You can make the following settings on the "Text" tab:

option Description

Info text Here, you enter an information text containing up to 255 characters. Info texts 
cannot be changed during runtime.

Blocks 1 to 10 Here, you enter a text for each block containing up to 255 characters.          
Blocks 1 to 10 represent the respective user text blocks.
In the user text block, you can display the field contents of the comment dialog of 
the message using the following formatting instructions:
@100%s@ = Computer Name (max. 16 characters)          
         
@101%s@ = Application name (max. 32 characters)          
         
@102%s@ = User name (max. 16 characters)          
         
@103%s@ = Comment (max. 255 characters) of the message in the long-term 
archive list. For this, a comment must have been entered in the message.
The format instructions should not contain any alphabets in upper case.
Click the button to display the "Insert Process Value" dialog. Here, you insert a 
process value in the user text block.          
The inserted process value is identified in the user by the format instruction 
@.....@.
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Requirement
● You have already created single messages.

Procedure
1. Select the desired single message in the table window.

2. Select "Properties" in the shortcut menu. The "Single Message" dialog opens.

3. Make the desired settings on the "Text" tab.
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Alternative Procedure
1. In the table window, double-click the field in the selected single message whose text you 

want to insert or change. Edit the user text blocks directly in the table field. In the case of 
"Info text", the "Info Text" dialog opens.

2. In the "Info Text" dialog, enter an additional information text containing up to 255 characters 
for a single message. An information text can be used, for example, to describe why a 
message can arrive.
You can use the shortcut menu and the standard editing functions to copy or paste text in 
the dialog. Info texts cannot be changed during runtime.

 

See also
Parameters of a Single Message (Page 928)

How to Create a Single Message (Page 931)

5.4.5.7 How to Insert Process Values in User Text Blocks

Introduction
You can insert the value of a process variable in a user text block. However, the maximum 
length of a user text block (i.e., 255 characters) must not be exceeded.

Settings for Configuring Process Values
You assign the format in the user text block to the process value in the "Insert Process Value" 
dialog.

The following settings can be made:
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Icon Description

User text block Indicates the user text block in which a process value is to be inserted.
Length Indicates the defined text length of the user text block.
Text Mirrors the appearance of the user text.
Process value 
block

Here, you select the process variable whose value you want to insert.

Type Defines the format type of the process value to be inserted.          
The following options are available:          
- Text          
- Fixed-point number (decimal, octal, hexadecimal)          
- Floating-point number

Position Determines the position of the format statement in the text. Specifying "Position: 
10" causes the process value to be inserted after the tenth character in the user 
text.

Number of digits Defines the number of digits reserved in the user text for the process value.
Accuracy Defines who many digits of the process value are to be inserted in the user text.
Pad with 0 If this function is activated, floating-point numbers are filled in until the number of 

digits specified in the "Precision" text field is reached.
Align Left If the number of digits in the process value to be inserted is less than the number 

of digits reserved, this function is used to specify whether the process value is 
aligned right or left when it is inserted in the user text.

Format statement Indicates the specified format statement.
Example: Displays examples of how the specifications regarding the number of digits, 

precision, left alignment, and padding affect the different types of process values.

Requirement
● You have already created single messages.

● You have added at least one process value block to the message system.

Procedure
1. Select the desired single message in the table window.

2. Select "Properties" in the shortcut menu. The "Single Message" dialog opens.
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3. Click  for a user text block on the "Texts" tab. The "Insert Process Value" dialog opens.

4. Specify the desired settings.

 

See also
How to Add Message Blocks (Page 909)

Parameters of a Single Message (Page 928)

How to Create a Single Message (Page 931)
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5.4.5.8 How to Link a Picture to a Single Message

Introduction
You can display a plant graphic for a single message during runtime that represents the part 
of the process where the message occurred. To do this, assign the name of the plant graphic 
to a picture function that is triggered in the message window as follows:

● By double-clicking a message. The configuration is performed on the "Parameters" tab in 
the WinCC Alarm Control.

● By clicking the "Loop in Alarm" button on the toolbar.

Note

The WinCC standard function "OpenPicture" is used for the picture function. You can 
specify any function and specify another file as the transfer parameter.

If you wish to use a different function, you should note the following:
● Use a function that accepts a transfer parameter of the type char*, for example: void 

MyFunction(char* NameOwnData).
● Use only functions whose return parameter corresponds to the "unsigned char", "short 

int", "long int", "float", "double", "bool", or "void" types

Requirement
● You have already created single messages.

● You have configured a plant graphic in the Graphics Designer.
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Procedure
1. Select "Properties" in the shortcut menu of the selected single message. The "Single 

Message" dialog opens.

2. Select the "Tag/Action" tab.

3. Enter the name of the picture in the "Picture Name/Call Parameter" text field or click . 
Select the picture in the project directory. Click  to reset the picture name assignment.

4. If you are using a different picture function, click  in the "Function Name" field. Select 
your function in the function browser that appears.

5. Click on OK to confirm.
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Alternative Procedure
1. Double-click the "Loop in Alarm" field in the selected single message in the table window. 

The "Loop in Alarm" dialog opens.

2. Enter the name of the picture in the "Picture Name/Call Parameter" text field or click . 
Select the desired picture in the directory of your project. Click  to reset the picture name 
assignment. Click "OK."

3. If you are using a different picture function, click  in the "Function Name" field. Select 
your function in the function browser that appears.

4. Click on OK to confirm.

 

See also
Parameters of a Single Message (Page 928)

How to Create a Single Message (Page 931)

5.4.5.9 How to Configure the Hiding of Messages

Introduction
Hiding messages reduces the information load for the system user. You as user can 
concentrate better on the messages only if selected messages are shown.
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Properties of Hidden Messages
Hidden messages are:

● In the message list, short-term archive list and long-term archive list, you can select whether 
the hidden messages are to be displayed. The display depends on the activated option in 
the "Display Options" dialog.

● They are included in the list of messages to be hidden and displayed there.

● They are archived.

● They do not trigger the alarm in Basic Process Control.

● The central messaging tag is not set in WinCC.

● You can manually or automatically unhide messages that are hidden.

● In manual hide, they are displayed again after a certain defined period.

● Manual hiding forces you to acknowledge messages that need acknowledgement and 
triggers an operator input message.

● Automatic hiding does not force you to acknowledge and therefore it also does not trigger 
an operator input message.

● In the period when messages requiring confirmation are hidden, the system acknowledges 
the outgoing messages. If a message does not have the "gone" status, the system 
acknowledges it immediately.

Hide process 
You can hide messages in two ways: 

● Automatic hide: Messages are hidden and shown again later depending on a certain system 
status of the hide tag. You need to assign a hide tag to a group message. You add the 
single messages that you want to hide during runtime to the group message. You can 
configure the system status for hide or show using the hide mask in the single message.

● Hide Manually: In the message window, you can use a button to define when you want to 
hide a message from one of the three message lists. You can also show the messages 
again using another button in the Message window. The system displays the messages 
again after a configurable time. Operator input messages can be triggered in Manual Hide.

Configuring Hide
You can configure automatic hide and the duration for manual hide in Alarm Logging. This 
section describes the configuration process. 

You configure the button for manual hide in WinCC Alarm Control in the Graphics Designer. 
Refer chapter "How to Hide and Unhide Messages" for details about configuring and operating 
in runtime during manual hide in WinCC Alarm Control.

Requirement
● The "Alarm Logging" editor is open.

● Single messages have been created.
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Procedure for Automatic Hiding
1. Select the "User-Defined" folder in the "Group Messages" folder.

2. Select "Add Group Message" in the shortcut menu. The "New Group Message" dialog 
opens.

3. Enter the name of the new group message in the "Name" box. Choose the hide tag via the 
tag selection dialog. You can use an unsigned 8 bit, 16 bit or 32 bit value as a hide tag.

4. Click "OK" to save your settings.

5. Add the single messages that you want to hide automatically to the group message. Select 
"Add Single Message" in the pop-up menu of the group message.
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6. Define the hide condition for each single message of the group message. Select the 
"Properties" command in the pop-up menu of the single message selected. The "Single 
Message" dialog opens.

7. Select the group with the hide tag in the "Group" field.
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8. You will determine the system status of the hide tag in the field "Hide mask" when the 
message will be hidden. Enter the hexa-decimal value in the "Hide mask" or click .

Select the system statuses in the "System status" dialog. The selected system statuses 
are then entered into the "Hide mask" as a hexadecimal value.

9. Click "OK" to save your settings.

Procedure for Manual Hiding
1. If the messages are hidden manually, define the duration for hiding messages from the 

messages list in the "Alarm Logging" editor. Select the menu command "Tools" > "Hide 
Manually...".

2. Enter the required duration. 30 minutes are preset. The period is interpreted internally in 
minutes. You can enter a maximum of 9 days, 23 hours and 59 minutes. This corresponds 
to 239 hours and 59 minutes or 14399 minutes.

3. Click "OK" to save your settings.
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See also
Hide tag of a User-Defined Group Message (Page 975)

Parameters of a Single Message (Page 928)

How to Create a User-Defined Group Message (Page 979)

How to Add a Single Message to a Group Message (Page 982)

How to Hide and Show Messages (Page 1100)

5.4.5.10 Description of WinCC System Messages

Introduction
The system messages generated by the various WinCC modules are described below. You 
can integrate these messages into your message system using the "WinCC - System 
Messages" menu command.

Note

When you assign system messages to a user-defined message class, the message class 
must have the same properties as the system message class.

Note

You can obtain additional information on the system messages in the system message block 
"Comment" for the message.

WinCC system messages

Number Error Message / Description

1000000 WCCRT:Error
1000001 WCCRT:Error loading the object engine
1000002 WCCRT:Channel could not be loaded
1000003 WCCRT:Tag - Violated lower limit
1000004 WCCRT:Tag value of the high limit is exceeded
1000005 WCCRT:Format error of tag
1000006 WCCRT:Scale error of tag
1000100 WCCRT:Drive error
1000200 WCCRT:Status
1000201 WCCRT:Object Engine was loaded
1000202 WCCRT:Runtime has been activated
1000203 WCCRT:Runtime has been deactivated
1000204 WCCRT:Connection not established
1000205 WCCRT:Connection established
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Number Error Message / Description

1000206 WCCRT:Client connection established
1000207 WCCRT:Client connection disconnected
1000208 WCCRT:Client connection broken
1000209 WCCRT:Connection deleted
1000210 WCCRT:Connection modified
1000211 WCCRT:Connection reestablished
1000300 WCCRT:Driver state
1000800 PACKAGE:Import
1000801 PACKAGE:Export
1000802 PACKAGE:Delete
1000803 PACKAGE:New
1000804 PACKAGE:Reload
1000805 PACKAGE:DefaultServer
1000806 PACKAGE:Implicit update
1000807 PACKAGE:Update
1000900 PERFMON: is low
1000901 PERFMON: is OK
1000902 PERFMON: is high
1000903 PERFMON: is OK
1000904 PERFMON: is low
1000905 PERFMON: is OK
1000906 PERFMON: is high
1000907 PERFMON: is OK
1000908 PERFMON: is low
1000909 PERFMON: is OK
1000910 PERFMON: is high
1000911 PERFMON: is OK
1000912 PERFMON: Redundancy loss of the terminal adapter
1000913 PERFMON: Redundancy of the terminal adapter restored
1000914 PERFMON: Terminal adapter connected
1000915 PERFMON: Terminal adapter disconnected
1001000 PDLRT: General error
1001001 PDLRT: Operator action not active
1001002 PDLRT: Wrong picture format
1001003 PDLRT: Picture not found
1001004 PDLRT: No dynamic active in picture
1001005 PDLRT: Tag could not be written
1001006 PDLRT: Dynamic Actions not active
1002000 TLGRT: General error
1002001 TLGRT: Error during initialization
1002002 TLGRT: Error during loading of run-time data
1002003 TLGRT: Error during language switch
1002004 TLGRT: Error during access to database
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Number Error Message / Description

1002005 TLGRT: Error during creation of run-time objects
1002006 TLGRT: Error during on-line configuration
1002007 TLGRT: Error in client/server environment
1002008 TLGRT: Error in memory management
1002009 TLGRT: Error compiling measured values
1002010 TLGRT: Error processing measured values
1002011 TLGRT: Error archiving measured values
1002012 TLGRT: Error in Format DLL
1002013 TLGRT: Error with user archive option
1002014 TLGRT: Error in process controlled archiving
1002015 TLGRT: Error in the API
1002016 TLGRT: Error with the application window
1002017 TLGRT: System error
1002018 TLGRT: Database queue overflow
1002019 TLGRT: Notification queue overflow
1002020 TLGRT: Norm DLL queue overflow - data is lost!
1002021 TLGRT: Problems with the connection to the central archive server.
1002022 TLGRT: The problem with the connection to the central archive server was fixed.
1003018 ALGRT:Message does not require acknowledgment.

An attempt was made to acknowledge a message that does not require acknowledgement.
1003019 ALGRT:Message has already been acknowledged

An attempt was made to acknowledge a message that has already been acknowledged.
1003020 ALGRT:Message class for the message not found

The message class associated with the message does not exist.
1003021 ALGRT:Message status cannot be processed

The message status (Came In, Went Out, Acknowledged, ...) could not be interpreted.
1003022 ALGRT:Message is locked

This message occurs if you attempt to trigger a locked message via the API.
1003023 ALGRT:Message date/time-stamp invalid

The date/time stamp from the AS could not be interpreted.
1003032 ALGRT:Message window template name unknown

This error occurs when a message window that was previously configured in the Graphics 
Design is deleted subsequently.         
In the case of client/server projects, this message could also be triggered by a 
communication error in the network.

1003033 ALGRT:Message window could not be created
1003034 ALGRT:Message window data invalid

The configuration data are faulty.
1003048 ALGRT:Bit is outside the tag range.

For example, an attempt was made to trigger the 18th bit of a 16-bit tag.
1003049 ALGRT:No tag change
1003050 ALGRT:Message tag (bit) already occupied by a message

The bit of the message tag has already been interconnected to a message.
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1003051 ALGRT:Acknowledge tag(bit) already used
The acknowledgement tag bit has already been interconnected to a message.

1003052 ALGRT:Status tag already occupied by message
The bit of the status tag has already been interconnected to a message.

1003053 ALGRT:Error during conversion of the variant data type
1003054 ALGRT:Message tag (bit) already occupied-->different type
1003055 ALGRT:Event tag or tag type invalid

The data type of the message tag is invalid. A tag with sign was used, for example.
1003056 ALGRT: Acknowledgment tag or tag type invalid

The data type of the acknowledgement tag is invalid. A tag with sign was used, for example.
1003057 ALGRT:Status tag or tag type invalid

The data type of the status tag is invalid. A tag with sign was used, for example.
1003058 ALGRT:Handle invalid

This error message can occur during accesses via the API.
1003059 ALGRT: Selection criteria invalid

This error message can occur during accesses via the API.
1003060 ALGRT: Resources DLL for language not found

One of the language-dependent files is missing.
1003061 ALGRT:Error while creating the memory mapped file

This internal error indicates a problem involving the memory.
1003062 ALGRT:Error while creating the synchronization mechanism.

This error occurs when the operating system is overloaded.
1003063 ALGRT:Wrong parameter

This error message can occur during accesses via the API.
1003064 ALGRT:Transfer buffer too small

This error message can occur during accesses via the API.
1003065 ALGRT:This function is not available at this time

This error message can occur during accesses via the API.
1003066 ALGRT:Format DLL send data cannot be evaluated.
1003067 ALGRT:Format DLL. Do not execute function
1003068 ALGRT:No message blocks in the report

Check the message sequence report.
1003069 ALGRT:Invalid log
1003070 ALGRT:Report printout is already active

An attempt was made to restart an active report.
1003071 ALGRT:Message system runtime <Server> not installed

The server reports that the project was activated without the runtime component of Alarm 
Logging.

1003072 ALGRT:Printout of the message report could not be started.
1003073 ALGRT:Printout of the short-term archive not started.
1003074 ALGRT:Printout of the sequence archive report not started.
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1003075 ALGRT:Limit of Messages for Online Configuration exceeds.
The maximum number of messages that can be configured online (default setting is 600) 
has been exceeded.

1003076 NRMS7:Parameter error for S7 message frame
A parameter error has occurred on the interface to S7.

1003077 NRMS7:Parameter error for ALGRT
A parameter error has occurred on the interface to ALGRT.

1003078 NRMS7:Invalid parameter TLGRT
A parameter error has occurred on the interface to TLGRT.

1003079 NRMS7:Invalid process value blocks
The additional data of the messages are faulty.

1003080 NRMS7:Parameter error at AR_SEND
The structure of the AR-SEND user data is faulty.

1003081 NRMS7:General error
An internal error of unknown cause has occurred.

1003082 NRMS7:Message loss on the automation system
1003083 NRMS7:Link-up and update on PLC active
1003084 NRMS7:Link-up and update on PLC finished
1003085 NRMS7:System modification in RUN (CiR) active
1003086 NRMS7:System modification in RUN (CiR) inactive
1003087 NRMS7:Error while logging on to receive message
1003098 ALGRT:Message archiving overflow - messages will be lost
1003099 ALGRT:[Computer Name]:Locked messages [message number] [message text of locked 

message]
This message occurs when a message is locked.

1003100 ALGRT:[Computer Name]:Message [message number] unlocked [message text of 
unlocked message]
This message occurs when a message is unlocked.

1003101 ALGRT:Acknowledgement request for message [message number]  was issued
This message occurs when a message is acknowledged.

1003102 ALGRT:[Computer Name]:Message group [message group number] locked
This message occurs when a message group is locked.

1003103 ALGRT:[Computer Name]:Message group [message group number] unlocked
This message occurs when a message group is unlocked.

1003104 ALGRT:[Computer Name]:Alarm Message Archive Overflow ended - no more Alarms will 
be lost

1003105 ALGRT:[Computer Name]:alarm input queue reaches critical count
1003106 ALGRT:[Computer Name]:alarm input queue reaches uncritical count
1003107 ALGRT:[Computer Name]:Message [Message Number] hidden:@1%s@
1003108 ALGRT:[Computer Name]:Message [Message Number] shown:@1%s@
1003109 ALGRT:[Computer name]: The connection to the master was interrupted.
1003110 ALGRT:[Computer name]: Incomplete configuration data for message [message number] 

detected
1004000 RPTRT:General error
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1004001 RPTRT:PRT_OUT-Folder full.
1004002 RPTRT:Spool-Folder full.
1004003 RPTRT:Report was not printed. PRT_OUT directory full
1004004 RPTRT:Report was not printed. Spool folder full
1004005 RPTRT:Message sequence report is reprinted.
1004006 RPTRT:Spool-Folder full.
1004007 RPTRT:Hardcopy was not printed. Spool folder full
1005000 TXTRT:General error
1005001 TXTRT:Error while logging off runtime applications.
1005002 TXTRT:Error during connection of the run-time applications.
1005003 TXTRT:Error during initialization of the MMF.

A memory error has occurred.
1005004 TXTRT:Error while loading the MMF.

Error during access to database.
1005005 TXTRT:Error while opening the MMF.

A memory error has occurred.
1005006 TXTRT:An error occurred while creating the Service window.
1005007 TXTRT:No language found.
1005008 TXTRT:Text ID not found.

The requested Text ID could not be found in the text library.
1005009 TXTRT:MMF Read access refused.
1005010 TXTRT:Language not found.

The requested language has not been configured in the text library.
1005011 TXTRT:Language table could not be opened.

Either the data are faulty or the table is locked in the database.
1005012 TXTRT:Text table could not be opened.

Either the data are faulty or the table is locked in the database.
1005013 TXTRT:Invalid Language specified.

The Language ID specified is invalid.
1005014 TXTRT:DBConnect error

No connection to the database could be set up.
1006000 GSCRT:Error
1007000 SCRIPT:Overflow

Overload: either there are too many actions running in a cycle that is too small, or an action 
is suspended (endless loop, dialog output). All the other actions are in the queue and cannot 
be processed.
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1007001 SCRIPT:Action error
One of the following errors has occurred:
● Exception in the action (specific cause unknown)
● Exception upon access to the return result (char* associated memory invalid)
● Stack overflow upon execution of the action
● The action contains a division by 0
● The action contains an access to a non-existing symbol
● The action contains an access violation

In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in 
your script, which allows for a detailed analysis of errors.

1007002 SCRIPT:Overflow
Internal lists have overflowed.

1007003 SCRIPT:Connection error
The connection to the server is broken.

1007004 SCRIPT:Action error 1
The called function is not known. Check the spelling in the function call and the 
implementation of the function.

1007005 SCRIPT:Action error 2
This error can have several causes:
● The action does not contain a P code. Recompile the action.
● The function could not be loaded, for example, due to incorrect function name.
● The type of the returned value of the function is invalid.

In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in 
your script, which allows for a detailed analysis of errors.

1007006 SCRIPT:Tag error
A requested tag was not supplied by WinCC Explorer within 10 seconds. Check the spelling 
of the tag name. In the case of external tags, there may be a communication problem 
between the WinCC Explorer and the PLC.         
From WinCC version 4.0, you have the option to incorporate the OnErrorExecute function 
into your script, which allows for a detailed analysis of errors.

1007007 SCRIPT: Info
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1007009 SCRIPT:Error in Thread
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1008000 USERT:Connection to chip card reader paused
1008001 USERT:Incorrect login name/password
1008002 USERT:Incorrect login name/password by chip card
1008003 USERT:Manual Login
1008004 USERT:Login by chipcard
1008005 USERT:Manual Logout
1008006 USERT:Logout by chipcard
1008007 USERT:Automatic Logout by timeout
1009000 LBMRT:Error
1010000 STRRT:Error
1010001 Storage:included for compatibility to earlier versions
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1010002 Storage:included for compatibility to earlier versions
1010003 Storage:included for compatibility to earlier versions
1010004 Storage:included for compatibility to earlier versions
1010005 Storage:included for compatibility to earlier versions
1010006 Storage:included for compatibility to earlier versions
1010007 Storage:included for compatibility to earlier versions
1010008 Storage:included for compatibility to earlier versions
1010101 CAS:Starts archive service
1010102 CAS:Archive service is running
1010103 CAS:Archive service could not be started, error
1010104 CAS:Stops archive service
1010105 CAS:Archive service could not be stopped, error
1010106 CAS:Media backup completed successfully
1010107 CAS:Backup process failed, error
1010108 CAS:Backup medium created
1010109 CAS:Backup medium closed
1010110 CAS:Backup connected
1010111 CAS:Backup connection failed, error
1010112 CAS:Backup disconnected
1010113 CAS:Backup disconnection failed, error
1010114 CAS:Import of archive started
1010115 CAS:Import of archive failed, error
1010116 CAS:Import of archive completed
1010117 CAS:Archive failed, error
1010118 CAS:Archive completed
1010119 CAS:Starts processing of archive 
1010120 CAS:Data backup started
1010121 CAS:Data backup completed successfully
1010122 CAS: No symbolic name could be assigned to the physical server.
1010123 CAS: Caution, License not found: SIMATIC PCS7 StoragePlus Server. Long-term archiving 

deactivated
1010124 CAS: Archive cannot be verified.
1010130 StoragePlus: Directory cannot be created, error
1010131 StoragePlus: File cannot be moved, error
1011000 CSIG:Group display error at start up
1011001 CSIG:Group display hierarchy not updated
1011002 Group display: Connection fault
1011003 Group display: Tag does not exist
1011101 PTM: Error during start up
1011201 SSM: Error during start up
1011202 The fill level of the project drive is over 80%
1011203 The project was created with the wrong WinCC version
1012001 SYNC:Switched to master operation
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1012002 SYNC:Cannot issue time message frame
1012003 SYNC:Time receipt service: Poor or failed signal
1012004 SYNC:Cannot receive time message frame
1012005 SYNC:Cannot receive any time message frame on redundant bus
1012006 SYNC:No time message frame. Switch to redundant device
1012007 SYNC:Can issue time message frame properly
1012008 SYNC:Time reception service functions properly
1012009 SYNC:Can receive time message frame properly
1012010 SYNC:Can receive time message frame properly on redundant bus
1012011 SYNC:Switched to slave operation
1012012 SYNC:Time synchronization deactivated
1012013 SYNC:Time synchronization activated
1012014 SYNC:DCF77 client service has failed
1012015 SYNC:DCF77 client service is working properly
1012016 SYNC:Device switched to master operation
1012017 SYNC:Device switched to slave operation
1012018 SYNC:Device cannot issue time message frame
1012019 SYNC:Device can issue time message frame properly
1012020 SYNC:Device sets local time
1012021 SYNC:LAN sync: Time synchronization fault on PC
1012022 SYNC:LAN sync: Time synchronization set on PC
1012023 SYNC:LAN sync: Time synchronization established with PC
1012024 SYNC:Configured device name for the time synchronization does not agree with PC 

installation
1012025 SYNC:LAN sync: Cannot acquire time from the connected WinCC server
1012026 SYNC:Time jump - switched to permanent slave mode
1012027 SYNC:Time jump - time synchronization permanently deactivated
1012028 SYNC:Time reception service not started
1012029 SYNC:Time reception service
1012200 REDRT:Partner station has failed
1012201 REDRT:Partner station restarted
1012202 REDRT:Projects are not functionally identical
1012203 REDRT:Archive synchronization failed
1012204 REDRT:Internal error in Redundancy
1012205 REDRT:Connection to partner disturbed
1012206 REDRT:Connection to the partner has been reestablished
1012207 REDRT:Partner server - WinCC has not been started
1012208 REDRT:Archive synchronization starts
1012209 REDRT:Synchronization finished
1012210 REDRT:Tag Logging is being synchronized
1012211 REDRT:Tag Logging synchronization finished
1012212 REDRT:Alarm Logging is being synchronized
1012213 REDRT:Alarm Logging synchronization finished
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1012214 REDRT:User Synchronization launched
1012215 REDRT:User Archive synchronization finished
1012216 REDRT:Synchronization was paused
1012217 REDRT:Partner Server-Project has not been activated
1012218 SWITCH:Client has been switched automatically
1012219 SWITCH:Client has been switched manually
1012220 REDRT:Synchronization is not ready for all User Archives
1012221 REDRT:Synchronization is ready for all User Archives
1012222 SWRED:Main connection disturbed
1012223 SWRED:Main connection operational
1012224 SWRED:Backup connection disturbed
1012225 SWRED:Backup connection operational
1012226 REDRT:Partner Server-Project has been activated
1012227 REDRT:Error: Partner computer is not a server
1012228 REDRT:CAS: Archive synchronization launched
1012229 REDRT: CAS: Archive synchronization finished
1012240 REDRT:RedundancyControl error triggered switching
1012241 REDRT:RedundancyControl: Switch to status
1012242 DELTALOADER:Delta loading was started
1012243 DELTALOADER:Delta loading ended
1012244 REDRT:Overload during Alarm Logging online update
1012245 REDRT:RedundancyControl: Loss of serial connection
1012246 REDRT:RedundancyControl: Serial connection reestablished
1012247 REDRT: OS server (standby) redundancy error
1012248 REDRT: OS server (standby) redundancy reestablished
1012250 AM:Archive database inconsistency possible
1012251 AM:Internal error
1012252 AM:Backup:Error on writing to backup path
1012253 AM:Backup:Insufficient storage space on destination drive
1012254 AM:No connection to WriteArchiveServer
1012255 AM:No connection to Microsoft Message Queue
1012256 AM:No connection to WinCC project
1012257 AM:No connection to the database
1012258 AM:No connection to text library
1012259 AM:Error on generating TagLogging data
1012260 AM:Error on generating AlarmLogging data
1012265 AM:Data base verification failed
1012301 CA:No access to SQL Server (loss of data possible)
1012348 AM:Insufficient free memory space on project drive
1012349 REDRT:RedundancyControl: Connection of network card (MAC) address lost
1012350 REDRT:RedundancyControl: Connection via network card (MAC) address established 

again
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1012400 WEBRT:WebClient connection established
1012401 WEBRT:WebClient connection disconnected

 

See also
How To Insert WinCC System Messages (Page 960)

5.4.5.11 How To Insert WinCC System Messages

Introduction
The installation directory of WinCC contains the "LTMDaten.CSV" file. This file contains special 
system messages that are triggered by various WinCC components at runtime.

Use the "WinCC System Messages" menu command to integrate the system messages into 
your message system.

Note

If installing a language later while having already created the WinCC system messages using 
this dialog, you once again have to read in the system messages. 

Click "OK" in the "WinCC system messages" dialog. This enters the message texts of the 
new language in the text library.
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Prerequisite
● The "Alarm Logging" editor is open.

Procedure
1. Select "WinCC System Messages..." in the "Tools" menu. The "WinCC System Messages" 

dialog opens.

2. In the dialog, select the message generation parameters.

3. Click "Create" to start generating the system messages according to the options selected. 
Click "Close" to exit the dialog.

 

See also
Description of WinCC System Messages (Page 950)
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5.4.5.12 Importing and Exporting Messages

Structure of the Import/Export File

Introduction
You can import text files into Alarm Logging and export the configured messages.

ASCII is the reference format for the import and export files. The individual message blocks 
are separated by commas, and the message lines are separated by paragraph symbols (hard 
returns).

Messages are imported individually. Both of the system-internal classes are also exported. 
System classes changed by the import are to be disregarded.

Note

When importing texts, you must set the associated indices to "0".

Structure of the File
The data are output and input according to a standardized sequence. 

Alphabetical order corresponds to the columns in MS Excel tables.

Column Description

A Message number
B Parameter bit-coded.         

For exact coding details, refer to "ODK Open Developers Kit" documentation. The 
documentation is only available when WinCC option "ODK" is installed.

C Message classes 1-16 and default message classes 17+18
D Message type (1-260, depending on class; 256 user-defined message types, 4 system-

internal message types)         
Class 1: ;1-16         
Class 2: ;17-32,         
Class 3: ;33-48,         
Class n: ;(n-1)*16+1 to n*16

E Index of 1st user text block in the text library
F Index of 2nd user text block in the text library
G Index of 3rd user text block in the text library
H Index of 4th user text block in the text library
I Index of 5th user text block in the text library
J Index of 6th user text block in the text library
K Index of 7th user text block in the text library
L Index of 8th user text block in the text library
M Index of 9th user text block in the text library
N Index of 10th user text block in the text library
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Column Description

O Text of the 1st user text block
P Text of the 2nd user text block
Q Text of the 3rd user text block
R Text of the 4th user text block
S Text of the 5th user text block
T Text of the 6th user text block
U Text of the 7th user text block
V Text of the 8th user text block
W Text of the 9th user text block
X Text of the 10th user text block
Y Tag of the 1st process value bock for the message
Z Tag of the 2nd process value bock for the message
AA Tag of the 3rd process value bock for the message
AB Tag of the 4th process value block for the message
AC Tag of the 5th process value bock for the message
QD Tag of the 6th process value bock for the message
AE Tag of the 7th process value bock for the message
AF Tag of the 8th process value bock for the message
AG Tag of the 9th process value bock for the message
AH Tag of the 10th process value bock for the message
AI Message tag
AJ Message bit
AK Acknowledgement tag
AL Acknowledgement bit
AM Status tag
AN Status bit
AO Automation system number
AP PLC subnumber (CPU number)
AQ Info text
AR Action type (LoopInAlarm)
AS Function name 
AT Function parameter (Picture Name)
AU Name of the Format DLL
AV Group identification
QW Group name
AX Hide mask
AY Creator identification
AZ Priority
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See also
How to Export Single Messages (Page 966)

How to Import Single Messages (Page 964)

How to Import Single Messages

Introduction
You can import text files containing messages in standard text format in Alarm Logging. Empty 
or non-occupied positions of a message to be imported must be assigned a "0" in the text file.

Settings for Importing
You can specify the following settings for importing single messages:

Mode Description

Import new messages and 
overwrite existing messages

When messages are imported, messages with as yet non-existing 
message numbers are imported while messages with existing message 
numbers are overwritten

Import new messages only When messages are imported, only messages with as yet non-existing 
message numbers are imported.

Deleting messages When messages are imported, messages with existing message 
numbers are deleted.

Note

The text that you want to import import into the message system must not contain any special 
characters, e.g., commas, semicolons, tabs, paragraph end marks, and line breaks. The 
special characters are interpreted as separators during an import.

Check files imported from external applications for incorrect assignments and interconnection 
errors.

If the tags are not configured in the WinCC tag management, the tag connection is lost when 
the messages are imported. These messages must be deleted following an import before 
new messages are compiled using "OS-Compile".
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the "Messages" menu, select "Import Single Messages...". The "Import Messages" dialog 

is opened.

2. Click the  button next to the "File:" box. Select an import file in the file selection dialog 
that appears.

3. If you want to import single messages that were exported using WinCC Version 1.0, select 
"File Format WinCC Version 1.0".

4. Specify the import mode of the text file in the "Mode" group.

5. Click "Import" to import the text file into the message system. Click "Cancel Import" to cancel 
the import in progress.

6. Click "Close" to close the dialog.

 

See also
Structure of the Import/Export File (Page 962)
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How to Export Single Messages

Introduction
You can export all configured messages or messages belonging to a specific message class. 
In so doing, the messages to be exported are transferred in standard format to a text file. You 
cannot select individual messages.

Settings for Exporting
The following options can be set for exporting single messages:

Options Description

Format Only text files (ASCII-format) can be exported at this time.
Separator within 
the fields

You must activate this option if separators, such as commas, colons, semicolons, 
etc., are contained in the field texts to be exported.          
During the export, the content of a field is checked. If the text in a field to be 
exported contains a separator, this text will be placed in quotation marks in the 
export file.

Set text identifiers 
to 0

This option is used to specify whether the ID of the message in the text library is 
also to be exported.         
If an import to another file is to be carried out, we recommend that you set the 
IDs to 0.         
If the messages are to be re-imported at a later stage into the current project, we 
recommend not setting the text IDs to 0.

Set group 
identifiers to 0

This option is used to define whether the group ID is also to be exported with the 
message.         
If an import to another file is to be carried out, we recommend that you set the 
group IDs to 0.         
If the messages are to be re-imported at a later stage into the current project, we 
recommend not setting the group IDs to 0.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the "Messages" menu, select "Export Single Messages...". The "Export Message" dialog 

opens.

2. Click the  button next to the "File:" box. Select an export file in the selection dialog that 
appears.

3. If you want to export only specific single messages, click "Selection". In the "Specify 
Selection" dialog, select the message classes you want to export messages from.

4. Click "Export" to start exporting the messages. Click "Cancel Export" to cancel the export 
in progress.

5. Click "Close" to close the dialog.

 

See also
Structure of the Import/Export File (Page 962)

5.4.5.13 How to Edit Multiple Messages

Introduction
A selection of single messages can be edited simultaneously.
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Possible Actions
You can edit multiple messages simultaneously with the following actions:

Action Description

Deleting messages The messages indicated in the "Message Numbers" box are deleted.
Append messages to the end of 
the list

The messages indicated in the "Message Numbers" box are 
appended to the end of the table of single messages.

Delete tag connections of the 
messages

The tag connections of the messages indicated in the "Message 
Numbers" box are deleted

Delete text connections of the 
messages

The text fields of the messages indicated in the "Message Numbers" 
box are deleted.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the "Messages" menu, select "Multiple Messages...". The "Multiple Messages" dialog 

opens.

2. In the "Message Numbers" field, enter the numbers or the number ranges of the individual 
messages that you want to edit.

3. Select the action to be carried out by clicking the appropriate button.
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5.4.5.14 How to Assign Texts to Multiple Messages

Introduction
You can assign the same text to several user text blocks.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. In the "Messages" menu, select "Texts for Multiple Messages...". The "Messages with Same 

Text" dialog opens.

2. In the "Message Numbers:" box, enter the numbers or the number range of the individual 
messages to which you wish to assign the text.

3. Enter a text of up to 255 characters in the desired user text blocks. By clicking , you can 
insert process values into your user text blocks.

4. If you exit the dialog by clicking "OK", the entries in the text library are changed accordingly.
If the "Keep Existing Text" function is not activated, new text IDs are created in the text 
library. The existing texts are no longer linked to the specified messages.
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See also
How to Change the Text Input Mode (Page 901)

How to Insert Process Values in User Text Blocks (Page 940)

How to Specify the Message Texts of a Single Message (Page 938)

5.4.6 Working with Group Messages

5.4.6.1 Working with Group Messages

Introduction
A group message is used to combine several single messages into one overall message.

You can combine single messages into two different group messages:

Compilation into a "Group Message from Message Classes"
When a new message class is created, the associated group message is also created from 
all the included messages. All message types within the message class are applied to the 
group message.

Compilation into a "User-defined group message"
User-defined group messages can contain single messages as well as other group messages 
and can be processed via the shortcut menu. However, a single message can only be included 
in one group message.

Assignment of Tags
The following tags can be assigned to a group message:

● The status tag returns the message status. You can also query the message status of a 
group message from the other WinCC components.

● Using the lock tag you can evaluate the lock of a group message.

● Use an acknowledgement tag to define the acknowledgement of the group message.

● Use the hide tag of a customized group message to define the conditions for single 
messages of the group - when should a message be automatically hidden from the 
message list, short-term archive list and long-term archive list.
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See also
How to Delete a User-Defined Group Message (Page 983)

How to Remove a Single Message from a Group Message (Page 983)

How to Add a Single Message to a Group Message (Page 982)

How to Create a User-Defined Group Message (Page 979)

User-defined group message (Page 978)

How to Change the Properties of a Group Message from Message Classes (Page 977)

Acknowledgement Tag of a Group Message (Page 974)

Lock Tag of a Group Message (Page 973)

Status Tag of a Group Message (Page 971)

Hide tag of a User-Defined Group Message (Page 975)

5.4.6.2 Status Tag of a Group Message

Introduction
Two message states are associated with a group message:

● The "activated/deactivated" states indicate the corresponding state of one of the nested 
messages. This can also be another group message.

● The acknowledgment status indicates whether the triggering single message of the group 
message requires acknowledgment and has not yet been acknowledged.

Both states of the group message are saved to a status tag. Depending on the data type of 
the tag, up to 16 group messages can be logged to a status tag. Each group message uses 
2 bits of the status tag.

"Acknowledgment bit"
The acknowledgment bit in the status tag changes to the status "1" as soon as at least one 
single message that belongs to the group message and that requires acknowledgment was 
activated and was not acknowledged. The acknowledgment bit changes to the status "0" as 
soon as all the single messages that belong to the group message and that require 
acknowledgment have been acknowledged.

Position of the bits in "activated/deactivated" state and in acknowledgment state
The position of the bit for "activated/deactivated" states in the status tag is identified by the 
status bit. The position of the "acknowledgment bit" depends on the data type of the status tag.

The distance to the bit with "activated/deactivated" state is:

● 4 bits for the "8 bit unsigned" tag.

● 8 bits for the "16 bit unsigned" tag.

● 16 bits for the "32 bit unsigned" tag.
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Status tag of data type "32 Bit Unsigned"
If the status tag is of data type "32 bit unsigned" and the status bit = 9, 

● bit 9 of the status tag indicates the "activated/deactivated" state of the group message.

● bit 25 of the status tag indicates whether the group message contains a message requiring 
acknowledgment that has not yet been acknowledged.

Bits "0-15" correspond accordingly to bits "16-31" of a "32-bit" status tag.

Status tag of data type "16 Bit Unsigned"
If the status tag is of data type "16 bit unsigned" and the status bit = 3,  

● bit 3 of the status tag indicates the "activated/deactivated" state of the group message.

● bit 11 of the status tag indicates whether the group message contains a message requiring 
acknowledgment that has not yet been acknowledged.

Bits "0-7" correspond accordingly to bits "8-15" of a "16-bit" status tag.

Status tag of data type "8 Bit Unsigned"
If the status tag is of data type "8 bit unsigned" and the status bit = 3,  

● bit 3 of the status tag indicates the "activated/deactivated" state of the group message.

● bit 7 of the status tag indicates whether the group message contains a message requiring 
acknowledgment that has not yet been acknowledged.

Bits "0-3" correspond accordingly to bits "4-7" in an "8-bit" status tag.

Configuring the status tags
Select "Properties" in the shortcut menu of a group message you created. Specify the status 
tag in the "Properties" dialog.

Click  to open the dialog for selecting the status tag.

Click  to reset the status tag and the status bit assignment.
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Note

Do not combine any tag bits of the status with other tags of the message, such as an 
acknowledgment tag.

See also
How to Change the Properties of a Group Message from Message Classes (Page 977)

Lock Tag of a Group Message (Page 973)

Acknowledgement Tag of a Group Message (Page 974)

Working with Group Messages (Page 970)

5.4.6.3 Lock Tag of a Group Message

Introduction
The lock tag of a group message is used to evaluate the locked status of the group message. 
Define a lock bit in the lock tag for this purpose.

The structure of the lock tag is not specified. You have the following options of configuring lock 
tags:

● Configure a separate lock tag for each group message.

● Group several group messages in a single lock tag. Group messages are identified by 
means of the lock bit.

If a group message is locked at runtime by means of the lock dialog, the associated lock bit is 
set in the configured tag.

Configuring the lock tag
Select "Properties" in the shortcut menu of a group message you created. Specify the lock tag 
in the "Properties" dialog.

Click  to open the dialog for selection of the tag you want to use as a lock tag.

Click  to reset the lock tag and the lock bit assignment.

Note

Do not mix any lock tag bits of the message with other tags of the message, such as a status 
tag.
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See also
How to Change the Properties of a Group Message from Message Classes (Page 977)

Acknowledgement Tag of a Group Message (Page 974)

Status Tag of a Group Message (Page 971)

Working with Group Messages (Page 970)

5.4.6.4 Acknowledgement Tag of a Group Message

Introduction
The acknowledgment tag of a group message is used to acknowledge all of its single 
messages. Define an acknowledgment bit in the acknowledgment tag for this purpose.

The structure of the acknowledgment tag is not specified. You have the following options of 
configuring acknowledgment tags:

● Configure a separate acknowledgment tag for each group message.

● Group several group messages in a single acknowledgment tag. Group messages are 
distinguished by means of the acknowledgment bit.

The corresponding acknowledgment bit is set to acknowledge the group message at runtime. 
The acknowledgment or the reset of the acknowledgment bit is triggered by actions, e.g. by 
clicking a button on the WinCC process screen, or by means of a program in the AS.

Note

The acknowledgment bit of a group message of a specific message class, or of a user-defined 
group message, does not indicate any acknowledgments triggered by the WinCC Alarm 
Control.

Configuring acknowledgment tags
Select "Properties" in the shortcut menu of a group message you created. Specify the 
acknowledgment tag in the "Properties" dialog.

Click  to open the dialog for selection of the tag you want to use as an acknowledgment tag.

Click  to reset the acknowledgment tag and acknowledgment bit definition.

Note

Do not combine any bits of the acknowledgment tag with other tags of the message, such as 
a status tag.
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See also
How to Change the Properties of a Group Message from Message Classes (Page 977)

Lock Tag of a Group Message (Page 973)

Status Tag of a Group Message (Page 971)

Working with Group Messages (Page 970)

5.4.6.5 Hide tag of a User-Defined Group Message

Introduction
The hide tag of a customized group message is used for automatically hiding single messages 
that belong to this group message.

Overview
In the parameters of the single message you will specify the system status for the hiding of 
the single mask via the hide mask. Select the system statuses in the "System status" dialog. 

The selected system statuses are then entered into the "Hide mask" as a hexadecimal value.

During runtime, if the value of the tag number matches a system status, the message is 
automatically hidden in the message list, short-term archive list and long-term archive list. The 
hidden messages are added to the list of hidden messages.

Relation between hide tag and hide mask
The hexadecimal value of the hide mask is composed of the configured system statuses. The 
hide tag must accept the value of the system status so that the message can be hidden. Thus, 
multiple messages can be hidden for a value of the system status if you have configured the 
hide masks accordingly. 

In the following sections you will see five examples for 8, 16 and 32-bit values of the hide tag. 
The value of the hide tag corresponds to the respective system status.
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● Hide mask 0x0. Hiding is deactivated. The message is never hidden. The system status is 
configured as follows:         

● Hide mask 0x1. If the hide tag assumes the value "1", the message is hidden. The system 
status is configured as follows:         

● Hide mask 0xD. If the hide tag assumes the value "1", "3" or "4", the message is hidden. 
The system status is configured as follows:         

● Hide mask 0x80000008. If the hide tag assumes the value "4" or "32", the message is 
hidden. The system status is configured as follows:         

● Hide mask 0xFFFFFFFF. If the hide tag has a value greater than zero, the message is 
hidden. The system status is configured as follows:         

Configuring the hide tags
Select the "Properties" command in the group message pop-up menu in the case of a group 
message already created. Define the hide tag in the "Properties" dialog. You can use an 
unsigned 8 bit, 16 bit or 32 bit value as a hide tag.

Click  to open the dialog for selecting the tags you want to use as hide tag.

Click  to reset the definition of the hide tag.
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See also
Parameters of a Single Message (Page 928)

User-defined group message (Page 978)

How to Configure the Hiding of Messages (Page 945)

5.4.6.6 How to Change the Properties of a Group Message from Message Classes

Introduction
You can change the properties of the group message:

● for Group Message from Message Classes

● for the Message Types within the Group Message from Message Classes

As a result, you can assign various status tags, lock tags and acknowledgement tags to the 
group messages.

Parameters of Group Messages from Message Classes
You can set the following properties for a group message:

Parameters Description

Status tag Here, you specify the tag in which the statuses of the group message ("Came In / 
Went Out" and acknowledgement status) are to be stored.

Status bit The status bit is used to specify the two bits of the status tag in which the statuses 
of the currently selected group message are to be stored.

Lock tag If you lock a group message via the Lock dialog during runtime, the relevant bit is 
set in the tag defined here.

Lock bit If you are using a lock tag for several group messages, you specify the assignment 
to a group message by means of a lock bit.

Acknowledgement
 tag

Here, you specify the tag to be used as the acknowledgement tag.

Acknowledgement
 bit

Here, you specify the bit in the acknowledgement tag that is to be used to 
acknowledge the message.

Click  to open the dialog for tag selection.

Click  to reset the tag assignment and the bit used in it.
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select a group message from message classes or a message type within a message class 

from message classes.

2. Select "Properties" in the shortcut menu. The "Properties" dialog opens.

3. Change the specifications for status tags, lock tags and acknowledgement tags, e.g., in the 
message class of a group message.

4. Click "OK" to save your settings.

 

See also
User-defined group message (Page 978)

Working with Group Messages (Page 970)

5.4.6.7 User-defined group message

User-defined group message

Introduction
You can use user-defined group messages to configure a message hierarchy tailored to your 
own needs.
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You can combine single messages as well as another group message into one overall 
message. However, a single message can only be included in one user-defined group 
message. A maximum of six nesting levels of the user-defined group message is possible.

You need a customized group message with single messages whose messages you want to 
hide in runtime from the message list, short-term archive list or long-term archive list.

Configuration
You have the following configuration options:

● Inserting and configuring customized group messages

● Display and modify the properties of a user-defined group message

● Add additional single messages to an existing group message

● Add additional group messages to an existing group message

● Modify the properties of a single message contained in a group message

See also
How to Delete a User-Defined Group Message (Page 983)

How to Remove a Single Message from a Group Message (Page 983)

How to Add a Single Message to a Group Message (Page 982)

How to Create a User-Defined Group Message (Page 979)

Hide tag of a User-Defined Group Message (Page 975)

How to Create a User-Defined Group Message

Introduction
You have the following options available when creating user-defined group messages:

● Create a new user-defined group message

● Create a subordinate group message to a user-defined group message

User-Defined Group Message Parameters
You can set the following properties for a user-defined group message:

Parameters Description

Source Name of the higher-level object in the navigation window.
Name Name of the user-defined group message
Status tag Here, you specify the tag in which the statuses of the group message ("Came In / 

Went Out" and acknowledgement status) are to be stored.
Status bit The status bit is used to specify the two bits of the status tag in which the statuses 

of the currently selected group message are to be stored.
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Parameters Description

Lock tag If you lock a group message via the Lock dialog during runtime, the relevant bit is 
set in the tag defined here.

Lock bit If you are using a lock tag for several group messages, you specify the assignment 
to a group message by means of a lock bit.

Acknowledgement
 tag

Here, you specify the tag to be used as the acknowledgement tag.

Acknowledgement
 bit

Here, you specify the bit in the acknowledgement tag that is to be used to 
acknowledge the message.

Hide tag You define here the hide tag needed to hide messages of the single message of 
the group message.

Click  to open the dialog for tag selection.

Click  to reset the definition of the tags.

Note

In the case of a group message made up of message classes or a user-defined group 
message, the acknowledgement bit does not indicate an acknowledgement made through 
the WinCC Alarm Control.

Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select the "User-Defined" folder in the "Group Messages" folder.

If you want to subordinate a group message, select a user-defined group message that you 
have already created.

2. Select "Add Group Message" in the shortcut menu. The "New Group Message" dialog 
opens.
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3. Enter the name of the new group message in the "Name" box. Configure the tags you need 
for the group message.

4. Click "OK" to save your settings.

 

See also
How to Delete a User-Defined Group Message (Page 983)

How to Remove a Single Message from a Group Message (Page 983)

How to Add a Single Message to a Group Message (Page 982)

User-defined group message (Page 978)

How to Change the Properties of a Group Message from Message Classes (Page 977)

Acknowledgement Tag of a Group Message (Page 974)

Status Tag of a Group Message (Page 971)

Hide tag of a User-Defined Group Message (Page 975)
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How to Add a Single Message to a Group Message

Requirement
● The "Alarm Logging" editor is open.

● You have already created a user-defined group message.

Note

If you delete a single message in the table window, all assignments of this single message 
in the group messages are also deleted.

Procedure
1. In the "Group Messages" folder, select the user-defined group message to which you want 

to add single messages.

2. Select "Add Single Message" in the shortcut menu. The "New Single Message(s)" dialog 
opens.

3. Enter the numbers of the single messages in the "Message Number(s)" box that correspond 
to the numbers in the table window.

4. The "Only then insert single message(s) if it does not already belong to a group" option 
prevents you from changing existing assignments.
If this option is not selected, the existing assignments are canceled and replaced by an 
assignment to the selected group message.          
If this option is selected, existing assignments of single messages to a group message are 
retained.          
If the assignment is changed, no message is issued by WinCC.

5. Click "OK" to save your settings.
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See also
How to Delete a User-Defined Group Message (Page 983)

How to Remove a Single Message from a Group Message (Page 983)

User-defined group message (Page 978)

How to Remove a Single Message from a Group Message

Requirement
● The "Alarm Logging" editor is open.

● You have already created a user-defined group message.

Procedure
1. Select the single message whose group assignment you want to change in the table window.

2. Select "Properties" in the shortcut menu. The "Single Message" dialog opens.

3. Change the group assignment in the "Group" selection list on the "Parameters" tab. If you 
do not want to assign the single message to any group message, select "None".

4. Click "OK" to confirm the change.

Alternative Procedure
1. In the table window, double-click the single message whose group assignment you want 

to change.

2. Change the group assignment in the selection list. If you do not want to assign the single 
message to any group message, select "None".

See also
How to Delete a User-Defined Group Message (Page 983)

How to Add a Single Message to a Group Message (Page 982)

User-defined group message (Page 978)

How to Delete a User-Defined Group Message

Requirement
● The "Alarm Logging" editor is open.

● You have already created a user-defined group message.
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Procedure
1. In the "Group Messages" folder, select the user-defined group message that you want to 

delete.

2. Select "Delete Group Message" in the shortcut menu. The group message is removed from 
the message system.

See also
How to Remove a Single Message from a Group Message (Page 983)

How to Create a User-Defined Group Message (Page 979)

User-defined group message (Page 978)

5.4.7 Working with the Limit Value Monitoring

5.4.7.1 Working with the Limit Value Monitoring

Introduction
The limit value monitoring allows you to specify any number of limit values for a tag. A message 
is generated in runtime if one of the limit values is exceeded.

The limit value monitoring function is an add-on in WinCC and must be integrated into the 
message system. The "Limit Value Monitoring" folder is then incorporated in the navigation 
window of the message system.

Configuring Limit Value Monitoring
1. Integration of the limit value monitoring

2. Specification of the tag to be monitored

3. Specification of a limit value to be monitored
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Note

Changes in the dialogs of the limit value monitoring are applied immediately to the database 
tables after the dialog is closed.

In the case of online configuration, you must save your message system in order to supply 
the modified values to the project during runtime.

See also
Messages of the Limit Value Monitoring (Page 985)

How to Delete Objects of the Limit Value Monitoring (Page 991)

How to Specify the Limit Values to be Monitored (Page 989)

How to specify the tag to be monitored (Page 986)

How to Integrate Add-Ins into the Message System (Page 900)

5.4.7.2 Messages of the Limit Value Monitoring

Specification of message numbers
In the "Properties" dialog for the tag and the limit value, you can specify the number of a 
message that is to be generated during a limit violation. This affects the configuration of a 
message as follows:

● If you specify the number of a message that does not yet exist, this message will be created 
automatically.

● If you specify the number of an existing message, several properties of that message will 
be changed. Settings for message tags as well as the interconnections of process value 
blocks 1 to 3 will be deleted. 

Note

When configuring the limit value monitoring, you must not create the automatically generated 
messages additionally via the table window in Alarm Logging.. After Alarm Logging is 
restarted, the messages are visible and can be modified in the table window.

The values of the limit value, hysteresis, and trigger value are stored in process value blocks 
1 to 3. The process value blocks 4 to 10 must not be used for a limit value monitoring message.

See also
Working with the Limit Value Monitoring (Page 984)

How to Specify the Limit Values to be Monitored (Page 989)

How to specify the tag to be monitored (Page 986)
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5.4.7.3 How to specify the tag to be monitored

Parameters of the tag
You can set the following properties for the tag to be monitored:

Parameters Description

Number of limit 
values

This field displays the number of limit values to be monitored.

A message for all 
limit values

If this option is selected, the same message is always displayed if one of the 
configured limit values is violated during runtime.

Message number Here, you specify the number of the message that is to be generated during 
runtime in the event of a limit violation.

Delay time Here, you specify the delay time between the limit value violation and the 
generation of the message. The message will only be triggered if the limit value 
has been violated for the entire delay time.
The delay time can be set from 250 to 10,000 ms. If you wish no delay time, enter 
the value "0".

Requirement
● The "Alarm Logging" editor is open.

● Limit value monitoring has been integrated into the message system.

Procedure
1. Select the "Limit Value Monitoring" folder in the navigation window.

2. Select "New..." in the shortcut menu. The "Properties" dialog opens.
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3. Enter the name of the tag in the "Tag to be Monitored" box or click . Select the tag in 
the dialog that opens:

4. Specify the other tag properties.

5. Click "OK" to save your settings.

 

See also
How to Change the Properties of a Tag to be Monitored (Page 988)

Messages of the Limit Value Monitoring (Page 985)

How to Delete Objects of the Limit Value Monitoring (Page 991)

How to Specify the Limit Values to be Monitored (Page 989)

Working with the Limit Value Monitoring (Page 984)
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5.4.7.4 How to Change the Properties of a Tag to be Monitored

Parameters of the tag
You can change the following properties for the tag to be monitored:

Parameters Description

A message for all 
limit values

If this option is selected, the same message is always displayed if one of the 
configured limit values is violated during runtime.

Message number Here, you specify the number of the message that is to be generated during 
runtime in the event of a limit violation.

Delay time Here, you specify the delay time between the limit value violation and the 
generation of the message. The message will only be triggered if the limit value 
has been violated for the entire delay time.
The delay time can be set from 250 to 10,000 ms. If you wish no delay time, enter 
the value "0".

Requirement
● The "Alarm Logging" editor is open.

● Limit value monitoring has been integrated into the message system.

● You have configured a tag of the limit value monitoring to be monitored.

Procedure
1. Select the tag whose properties you want to change in the "Limit Value Monitoring" folder 

in the navigation window or in the data window.

2. Select "Properties" in the shortcut menu. The "Properties" dialog opens.
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3. Change the properties of the tag.

4. Click "OK" to save your settings.

 

See also
Messages of the Limit Value Monitoring (Page 985)

How to Delete Objects of the Limit Value Monitoring (Page 991)

How to Specify the Limit Values to be Monitored (Page 989)

How to specify the tag to be monitored (Page 986)

How to Integrate Add-Ins into the Message System (Page 900)

Working with the Limit Value Monitoring (Page 984)

5.4.7.5 How to Specify the Limit Values to be Monitored

Introduction  
You can specify any number of limit values to be monitored for a tag. To do this, call up the 
dialog for specifying limit values multiple times.
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Parameters of Limit Values
You can set the following properties for the limit values to be monitored:

Parameters Description

High limit A message is generated when the tag value exceeds the high limit.
Low limit A message is generated when the tag value falls below the low limit.
Limit value or tag The edit box contains the limit value to be monitored or the specified tag. Click 

"Tag" to open the tag selection dialog.
When you click "OK" to close the variable selection dialog, the "Indirect" option 
will be selected. Do not use a tag whose name is comprised solely of numbers to 
define indirect limit values. The tag name must start with a letter. With indirect limit 
value specification, the value of the tag to be monitored is stored in process value 
block 3 when the message is triggered.

Hysteresis If a hysteresis has been defined, messages are not triggered immediately when 
the limit value is reached; rather, they are triggered when the actual tag value 
exceeds or falls below the limit value by the amount of the hysteresis.
You can specify the hysteresis either as an absolute deviation or as a percentage 
deviation from the limit value. Depending on the selected setting, the hysteresis 
will become effective while a message is generated or revoked.

Message Here, you enter the number of the message to be generated in runtime if a limit 
value violation occurs.
This field can only be edited if you did not select the "A message for all limit values" 
option in the "Properties of Tags" dialog.

No check with 
quality codes 
other than 
"GOOD"

If this option is activated, a possible value change for the tag with a quality code 
other than "GOOD" is not checked for a limit value violation, such as a failed 
connection to the automation system.

Requirements
● The "Alarm Logging" editor is open.

● Limit value monitoring has been integrated into the message system.

● You have configured a tag of the limit value monitoring to be monitored.

Procedure
1. Select the tag to be monitored in the "Limit Value Monitoring" dialog in the navigation 

window or in the data window.

2. Select "New..." in the shortcut menu. The "Properties" dialog opens.
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3. Specify the properties of the limit value.

4. Click "OK" to save your settings.

 

See also
Examples of Configuring a Limit Value (Page 992)

Messages of the Limit Value Monitoring (Page 985)

How to Delete Objects of the Limit Value Monitoring (Page 991)

How to specify the tag to be monitored (Page 986)

Working with the Limit Value Monitoring (Page 984)

5.4.7.6 How to Delete Objects of the Limit Value Monitoring

Introduction
You can delete the tag to be monitored and the limit values.

Deleting a Tag To Be Monitored
1. Select the tag to be monitored that you want to delete in the "Limit Value Monitoring" folder 

in the navigation window or in the data window.

2. Select "Delete" in the shortcut menu. The tag along with the configured limit values are 
deleted. The assigned message is retained in the message system.
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Deleting a limit value
1. In the data window of the tag of the limit value monitoring to be monitored, select the limit 

value.

2. Select "Delete" in the shortcut menu. The configured limit value is deleted. The assigned 
message is retained in the message system.

5.4.7.7 Examples of Configuring a Limit Value

Introduction
The following examples illustrate how the configuration of limit values affects the behavior of 
the limit value monitoring.

Example 1

Message No. 4 is triggered (arrives) when the tag to be monitored has exceeded the value 
220.

Message No. 4 is revoked (exits) when the tag to be monitored drops below the value 200.
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Example 2

Message No. 4 is triggered (arrives) when the tag to be monitored has exceeded the value in 
the "Limit Value" tag.

Message No. 4 is revoked (exits) when the tag to be monitored has dropped below the value 
of the "Limit Value" tag by 10%.

 

See also
Messages of the Limit Value Monitoring (Page 985)

How to Specify the Limit Values to be Monitored (Page 989)

How to specify the tag to be monitored (Page 986)

Working with the Limit Value Monitoring (Page 984)
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5.5 Message Archiving

5.5 Resources

5.5.1 Message Archiving in WinCC

Introduction
With the archive management feature in WinCC, you have the option to archive process values 
and messages for the documentation of specific operational faults and error statuses. A 
Microsoft SQL Server is used for archiving.

Messages configured in Alarm Logging are output during runtime when the corresponding 
event occurs, for example, a fault or a limit violation. Messages are archived if events known 
as message events occur, for example:

● when the message occurs,

● when the status of the message changes (e.g., from "Message Came In" to "Message 
Acknowledged")

You can save the message events in an archive database and archive it as a message report 
on paper. The messages archived in the database can, for example, be output in a message 
window.

Archived Message Data
All data associated with a message, including the configuration data, is saved in the message 
archives. You can read out all properties of a message from the archives, including its message 
type, time stamp, and texts. A subsequent change to the configuration data of a message 
results in the creation of a new archive with the new configuration data. This ensures that the 
change has no effect on messages that were archived before the change was made.

Note

The time stamp on archived messages is always in standard UTC format (Coordinated 
Universal Time).

Because messages are configured on a language-dependent basis, archives contain a table 
with the configuration data for each configured language. 
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Quantity Structure
The following table shows the number of messages that WinCC can process. The actual 
number depends on the server in use. The information in the table refers to the following server 
configuration: 

● Intel Pentium III with 1.4 GHz

● 512 MB RAM

● 40 GB hard disk

● Maximum of 16 clients

 Server Special archive server 

Sustained message load (per second) 10 messages 100 messages
Message flow (per 10 seconds) 2,000 messages 15,000 messages

Note

The values for message flow apply only to archiving. For further processing in Alarm Logging, 
additional time must be planned: five minutes must elapse before a new message overload 
can be created. 

See also
Message Server (Page 1012)

Output of Message Archive Data in Runtime (Page 1004)

Configuration of Message Archiving (Page 995)

5.5.2 Configuration of Message Archiving

5.5.2.1 Configuration of Message Archiving

Introduction
To archive messages, WinCC uses short-term archives of configurable size, which you can 
configure with or without backup. 

Storing archive files
Archive files are always stored so that they are local to the computer in the associated project. 
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Properties of message archives
A WinCC message archive consists of multiple individual segments. You can configure both 
the size of the message archive and the size of the individual segments in WinCC:

● The size of the message archive or individual segments, for example,  Message archive 
size 100 MB, 5 MB per individual segment.

● The archiving period of the message archive or the individual segments, for example,  The 
message archive archives all messages which occur within one week, each individual 
segment archives the messages which occur within one day. The configuration of the 
archiving period is called archive partitioning.

You can always configure both conditions at the same time. If either of the two criteria is 
exceeded, the following happens:

1. Criteria for message archive (DB) is exceeded: the oldest messages (i.e. the oldest 
individual segment) are deleted.

2. Criteria for individual segment is exceeded: a new individual segment (ES) is created.

A new individual segment is also created when you configure message data online. 

Note

When starting Runtime, the system checks whether the configured size of the individual 
segment has been calculated to a sufficient size. If the configured size is too small, the system 
automatically adapts the segment to the minimum size.

Backing up archived messages
The data of the message archives can be stored in a backup.  

See also
How to Link an Archive Backup (Page 1002)

How to Configure the Archive Backup (Page 1000)

How to Configure a Message Archive (Page 998)

How to Configure Messages for Archiving (Page 997)
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5.5.2.2 How to Configure Messages for Archiving

Introduction
You can select the messages to be archived from all configured messages. 

Note

A newly created message in WinCC is archived by default. In principle, you need only carry 
out the procedure described below for messages whose archiving status has been modified.

Requirement
The message system is configured. For additional information on how to configure the 
message system, please refer to the online help for Alarm Logging.

Procedure
1. Open Alarm Logging.

2. Select the message you wish to archive in the Alarm Logging message list.

3. From the shortcut menu, select the "Properties" command.

4. In the Properties dialog for the message, select the "This message will be archived" check 
box.

5. Click "OK" to confirm your entry.
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See also
How to Configure the Archive Backup (Page 1000)

How to Configure a Message Archive (Page 998)

Configuration of Message Archiving (Page 995)

5.5.2.3 How to Configure a Message Archive

Introduction
You have the option to configure the message archive in Alarm Logging.

Note

Make sure that the archive size does not exceed the free memory space available. The 
archive manager does not check the selected settings for plausibility. A high number of linked 
database segments can lead to longer waiting periods in the system when starting and ending 
Runtime.
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Procedure
1. Open Alarm Logging and select "Archive Configuration" in the Alarm Logging navigation 

window.

2. Select the "Message Archive" and then select the "Properties" command from the shortcut 
menu.         
The "AlarmLogging" dialog is opened.

3. Make the following settings for the archive:

– Time period of all segments and their maximum size. This specification defines the size 
of the archive database. If one of the criteria is violated, a new segment is started and 
the oldest segment is deleted.

– The time period in which messages are to be archived in an individual segment and its 
maximum size. If either of these criteria is violated, a new individual segment is started. 
When the criterion for "Time period of all segments" is violated, the oldest individual 
segment is also deleted.

4. In the "Time of the segment change", field enter the start date and the start time for the first 
segment change.         
When a new individual segment begins, the configuration of "Time of the segment change" 
is taken into account.

5. Click "OK" to confirm your entry.
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Note

If you modify the archiving size (time range) in Runtime, such a modification will take effect 
with the next segment change.

Example:
In the above screen shot, the segment changes for the first time on January 17 at 23:59. The 
next time-related segment change occurs at the configured time in the cycle defined in "Time 
period covered by a single segment". With the above cycle settings "1 day", the change is 
made every day at 23:59. If the cycle is set to "1 month", the segment change takes place on 
the 17th day of the next month at 23:59.         
The segment is also changed, if the configured size is violated after Runtime start ("Max. size 
of all segments"). In this case, the oldest individual segment is also deleted. 

NOTICE

After selecting the "Reset" command in the Archive Configuration shortcut menu, the Runtime 
data is deleted from the archives.

See also
How to Configure the Archive Backup (Page 1000)

How to Configure Messages for Archiving (Page 997)

Configuration of Message Archiving (Page 995)

5.5.2.4 How to Configure the Archive Backup

General procedure
Create regular backups of your archive data to ensure seamless documentation of your 
process.

Note

The backup normally starts 15 minutes after the first time-related segment change. If the start 
of backup and start of segment should be synchronous with the start of Runtime, define the 
start time for the segment change prior to the start of Runtime.

You can change the displayed message in Runtime using Alarm Control. If the location of 
the archive segment where the message is stored has already been changed, then the 
modified comment is not accepted in the swapped-out archive. The change is limited to the 
local archive segment.

If the archive segment has not yet been swapped out, then the changed comment is accepted 
permanently.
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Procedure
1. Open Alarm Logging in WinCC Explorer.

2. In the Alarm Logging navigation window, select the "Archive Configuration" option. In the 
data window, select "Message Archive" and then select the "Properties" command from 
the shortcut menu. The "AlarmLogging" dialog is opened.

3. Select the "Backup Configuration" tab.

4. Select the "Signing off activated" check box, if the swapped archive data are to receive a 
signature. Upon reconnection with WinCC, the signature allows the system to determine 
whether any modifications have been made to the archive backup file after its swap-out.

5. Select the "Activate Backup" check box, if the archived data are to be backed up. In addition, 
select the "Backup to both paths" check box, if the archived data are to be saved in both 
directories, "Destination path" and "Alternative destination path".

6. Enter the destination path in which the backup files are to be stored. Network paths are 
also valid as destination paths. The "Alternative destination path" is used if:
- The memory space of a backup medium is occupied.
- The original destination path does not exist, for example due to network failure.
After the corresponding system messages have been configured, the messages are output 
if the specified destination path is not available. 

7. Click "OK" to confirm your entry.
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Result
The archive backup is stored in the specified destination path. 

Structure of the Archive Backup File
An archive backup consists of two files, with the extensions LDF and MDF. To transfer an 
archive backup, for example to another computer, copy the corresponding LDF and MDF files. 
The file name is as follows: 
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". The type 
identification of the message archive is "ALG". The time period is specified in format 
yyyymmddhhmm, for example 200212021118 for December 2, 2002, 11:18 hours. 
Underscores ("_") in the project name are displayed as "#". 

Signing Off of Archive Backup Files
Upon activated signing off and activated backup, each archive backup file is signed off upon 
swapping out. It is thus possible to determine upon reconnection of the file with WinCC whether 
or not the file has been changed after swapping.

The "Signing off activated" check box must be selected to verify the data.

If you use archive signing-off, the maximum size of a single segment may not exceed 200 MB.

See also
How to Link an Archive Backup (Page 1002)

How to Configure a Message Archive (Page 998)

How to Configure Messages for Archiving (Page 997)

Configuration of Message Archiving (Page 995)

5.5.2.5 How to Link an Archive Backup

Introduction
To access data in an archive backup during Runtime, link the associated database files to the 
project. You have the option to manually establish a link to an archive in the Alarm Logging 
Editor or to let the system establish a connection automatically. The archived messages are 
displayed in the message display  in Runtime.

Requirement
The corresponding LDF file and MDF file of the archive backup are stored in a local directory 
on the configuration computer, such as hard disk, MOD, or CD. The project is loaded on the 
configuring computer and is in Runtime. 
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Note

The messages are only displayed in Runtime if the time window in the message display has 
been configured accordingly. Example: You have configured a time window to display only 
the messages of the past 24 hours. If you link up to an archive backup containing messages 
that are older than 24 hours, these messages are not included in the message display. 

Linking to the Archive Using the Alarm Logging Editor
1. Open the Alarm Logging in WinCC Explorer.

2. In the navigation window of Alarm Logging, select "Archive Configuration". In the data 
window, right-click "Message Archive" and select "Link Archive" from the shortcut menu.

3. Select the desired database file and click "Open". After selecting the file, the message 
archive is linked to the project.

If signing off is activated and you link a modified or unsigned archive backup file to the project, 
you must acknowledge the link to these files, as the archive backup files are otherwise not 
linked. A WinCC system message is generated and an entry is added to the Windows event 
log in the "Application" section. 

Automatic Linking to an Archive
1. Add the archive backup files to the "ProjectName\CommonArchiving" directory.

2. In Runtime, the message archive is automatically linked to the project.

If signing off has been activated, modified signed-off archive backup files are not automatically 
linked. A WinCC system message is generated and an entry is added to the Windows event 
log in the "Application" section. 

Linking an Archive Using a Script
Using the "AlarmLogs" VBS object, you can link the archive backup files to the WinCC project 
using a script. The archive segments are then copied with the "Restore method" to the common 
archiving directory of the Runtime project. For more information, refer to chapters "AlarmLogs 
VBS Object" and "VBS Method 'Restore'". 

See also
How to Display Archived Messages in Runtime (Page 1005)

How to Configure the Archive Backup (Page 1000)

How to Disconnect an Archive Backup (Page 1004)
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5.5.2.6 How to Disconnect an Archive Backup

Introduction
If you no longer wish to access the data in an archive backup during Runtime, disconnect the 
associated database files from the project. 

Requirements
Archive backup files are linked. The project is loaded on the configuring computer and is in 
Runtime. 

Procedure
1. Open the Alarm Logging in WinCC Explorer.

2. In the navigation window of Alarm Logging, select "Archive Configuration". Right-click 
"Message Archive" in the data window and select "Disconnect from archive" from the 
shortcut menu. 

3. Select the desired archive file and click "OK".         
The link to the archive file is disconnected. Access is no longer possible to the archived 
messages in Runtime.

Automatically linked archives must be removed from the "Project name" directory. This can be 
done manually or by using a script in "AlarmLogs" VBS object.

See also
Output of Message Archive Data in Runtime (Page 1004)

How to Display Archived Messages in Runtime (Page 1005)

How to Configure the Archive Backup (Page 1000)

How to Link an Archive Backup (Page 1002)

5.5.3 Output of Message Archive Data

5.5.3.1 Output of Message Archive Data in Runtime

General procedure
Messages stored in message archives can be output in Runtime in the following ways:

● Display the archived messages in a message window; in the event of a power failure, the 
messages queued for loading from the archive to the message system are loaded with the 
correct time stamp (reloading after power failure).

● Prin archive report.
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● Access to message archive database via OLE-DB for output of archived messages.

● Access via ODK.

● Access by means of suitable client applications.

See also
Direct Access to the Archive Database (Page 1010)

How to Configure a Message Archive Report (Page 1008)

How to Configure Reloading of Messages Following a Power Failure (Page 1007)

How to Display Archived Messages in Runtime (Page 1005)

5.5.3.2 How to Display Archived Messages in Runtime

Introduction
In Runtime, use the WinCC Alarm Control to display current messages and call up messages 
from the archive. You have the option to display archive messages in a short-term archive list 
or long-term archive list. The short-term archive list also contains current messages. 

Requirement
All archived data displayed in Runtime must be stored locally on the archive server. The SQL 
server does not permit access to backup files held elsewhere, for example on another computer 
in the network.

For additional information on this topic, refer to chapter "Message Server" in this 
documentation. 
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Procedure
The following procedure describes just the principle steps for the display of archived messages 
in Runtime. For detailed instructions on the configuration of the WinCC Alarm Control, refer to 
the online help, chapter "Message System Structure / Display of Messages in Runtime".

1. Insert a WinCC AlarmControl into the desired picture in the Graphics Designer.

2. Double-click the control to open the "WinCC AlarmControl Properties" dialog.          

3. In the "General" tab, select which list will be shown when the picture opens in the 
"Properties" area. To display archived messages, select "Short-term archive list" or "Long-
term archive list". 
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4. If you want to only display messages from a certain server in a distributed system, 

deactivate the "All servers" checkbox. Click on  to select a server. Confirm with "OK".

5. Go to the "Toolbar" tab. Activate the "Display toolbar" check box. Select at least button 
function "Short-term archive list" or "Long-term archive list". Confirm with "OK".

Note

When displaying messages in the short-term archive list, the system immediately updates 
new incoming messages. This is not the case when the long-term archive list is selected. 
In the short-term archive list, you cannot enter or view comments. This is only possible in 
the long-term archive list.

Results

In Runtime, click  or  to display messages from the archive in the message list. You 
can also filter the messages from the archive, for example to display messages of the "Fault" 
type only or to view messages from particular plant sections.

See also
Direct Access to the Archive Database (Page 1010)

How to Configure a Message Archive Report (Page 1008)

How to Configure Reloading of Messages Following a Power Failure (Page 1007)

Output of Message Archive Data in Runtime (Page 1004)

5.5.3.3 How to Configure Reloading of Messages Following a Power Failure

General procedure
To display the most recent messages in Runtime following a power failure, configure the 
"Reload after power failure" function in the Alarm Logging. In the event of a power failure, a 
user-defined number of messages is read from the message archive to reconstruct the most 
recent process image. 

Procedure
1. Open the "Archive Configuration" group in the Alarm Logging navigation window.

2. Select "Message Archive" and then select the "Reload after power failure" command from 
the shortcut menu.
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3. In the "Message Archive" dialog, enter the number of messages to be reloaded after a 
power failure. In the following example, the last 60 messages are displayed again after a 
power failure:

4. Select the "Reload Message List After Power Failure" check box so that the message list 
is reloaded in Runtime after the system has rebooted.

5. Click "OK" to confirm your entry.

See also
Direct Access to the Archive Database (Page 1010)

How to Configure a Message Archive Report (Page 1008)

How to Display Archived Messages in Runtime (Page 1005)

Output of Message Archive Data in Runtime (Page 1004)

5.5.3.4 How to Configure a Message Archive Report

Introduction
You can print the archived messages. You configure the log for the message archive in the 
Report Designer.
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Overview
WinCC provides you with a pre-configured system layout for the log, which you can adjust to 
suit your specific needs. You can also create your own log layouts. You have three alternatives 
to configure the layout for a message archive:

● Configuration with the layout of the "WinCC Control Runtime Print Provider". The layouts 
are available with WinCC V7 and higher. The message archive list is either printed out in 
table format with all messages or the current display of the message archive list in 
AlarmControl is printed out. The output of the archive log is only possible via the WinCC 
AlarmControl with the button "Print current view".

● Configuration with the layout "WinCC Alarm Control". You initiate the print job with the "Print 
current view" button in the WinCC Alarm Control. You can initiate the output of the archive 
log outside the Alarm Control as well.

● Configuration with the layout "Alarm Logging RT". You initiate the print job outside the Alarm 
Control.

Configuration with the layout of the "WinCC Control Runtime Print Provider"
1. Open the Report Designer in the WinCC Explorer. Either open the layout "@Alarm Control 

- Table.RPL" for a table print-out or the layout "@Alarm Control - Picture.RPL" for printing 
the current display.

2. Double click on "WinCC Control Runtime Print Provider.Table" or "WinCC Control Runtime 
Print Provider.Picture" in the open layout. The "Object properties" dialog opens.

3. Configure the layout of the table in the "Properties" tab.

4. Save the configuration in the Report Designer.

5. The layouts of the "WinCC Control Runtime Print Provider" are connected with the 
respective print jobs "@Report Alarm Control - Table" or "@Report Alarm Control - Picture". 
Select one of these print jobs in the "General" tab of the Graphics Designer in the picture 
with the AlarmControl . If you click on the "Print current view" button in Runtime, the 
messages are printed according to the configured layout.

Configuration with the layout "WinCC Alarm Control"
1. Open the Report Designer in the WinCC Explorer. then open the "@CCAlarmCtrl-CP.RPL" 

layout.

2. Double click the table "WinCC Alarm Control.Table" in the open layout. The "Object 
properties" dialog opens.

3. Configure the layout of the table in the "Properties" tab.

4. Change the output options for the WinCC Alarm Control. For more detailed information, 
refer to  

5. Save the configuration in the Report Designer.
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6. The layout "@CCAlarmCtrl-CP.RPL" is connected with the print job "@Report 
AlarmControl-CP". Select this print job in the Graphics Designer in the picture with the 
AlarmControl in the "General" tab. If you click on the "Print current view" button in Runtime, 
the messages of the selected message list are printed out in a table.

7. You can also define a print job outside of the Alarm Control, for example by configuring a 
cyclic log output. If all archiving data is to be logged, the output cycles are not to be shorter 
than the configured archiving period. For more detailed information, refer to  

Configuration with the layout "Alarm Logging RT"
1. Open the Report Designer in the WinCC Explorer. then open the 

"@CCAlgRtSequenceArchive.RPL" layout.

2. Double click the table "Alarm Logging RT Archive Log" in the open layout. The "Object 
properties" dialog opens.

3. Configure the layout of the table in the "Properties" tab.

4. Change the output options for the archive log. For more detailed information, refer to  

5. Save the configuration in the Report Designer.

6. The layout "@CCAlgRtSequenceArchive.RPL" is connected with the print job "@Report 
Alarm Logging RT Sequence archive New". Configure this print job to define the output of 
the archive log. You can, for example, configure a cyclic log output. If all archiving data is 
to be logged, the output cycles are not to be shorter than the configured archiving period. 
For more detailed information, refer to  

See also
Direct Access to the Archive Database (Page 1010)

How to Configure Reloading of Messages Following a Power Failure (Page 1007)

How to Display Archived Messages in Runtime (Page 1005)

Output of Message Archive Data in Runtime (Page 1004)

5.5.3.5 Direct Access to the Archive Database

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also 
enable you to directly access the WinCC archive databases. Direct access lets you  read 
process values, for example, for editing in spreadsheet programs. 

Access to archive databases with ADO/OLE DB
The process values are partially saved in compressed format to the archive databases. Use 
the WinCC OLE DB Provider to access such compressed process values. You can use the 
Visual Basic or Visual C++ programming languages, for example. 
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Note

Note that the table structure may vary in a new WinCC version when directly accessing the 
archive database using ADO/OLE DB.

For additional information, refer to the Microsoft MSDN Library "Win32 and COM Development 
> Data Access and Storage > Windows Data Access Components SDK" available on the 
Internet at:

●     http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/
library/default.aspx) 

Access to the archive database using OPC
OPC (OLE for Process Control) provides interfaces for communication with process 
automation systems. The OPC interface enables harmonized interconnection of devices and 
applications from different manufacturers. You can use WinCC as an OPC client to access 
process data or messages of an OPC server. WinCC can be used as OPC server to manage 
archive data.

For additonal information, refer to:

● "WinCC Information System", "Communication" > "OPC",

● "WinCC Information System", "System Overview" > "Open Source"

● On the Internet at "http://www.opcfoundation.org"

Access to the archive database using C-API/ODK
You can use the "WinCC Open Development Kit" option to access WinCC data and functions 
by means of open source programming interfaces. 

For additional information, refer to: 

● Documentation on the WinCC Open Development Kit

See also
http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/library/
default.aspx)

How to Configure a Message Archive Report (Page 1008)

How to Configure Reloading of Messages Following a Power Failure (Page 1007)

How to Display Archived Messages in Runtime (Page 1005)

Output of Message Archive Data in Runtime (Page 1004)
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5.5.4 Message Server

Introduction
When using WinCC to configure a client/server system, you have the option to configure 
different scenarios for message archiving.

Archiving on WinCC Servers
The messages are archived on every server (2) in a client/server system. All Runtime 
applications including archiving run on each server. The clients (1) have access to the message 
archives on the servers.

Use this configuration, if each server is dedicated to a certain section of the plant. Each server 
thereby monitors a specific section of the plant, and manages its own messaging and archiving 
system.

Archiving on archive servers without a process driver connection (server/server communication)
Archiving on a central archive server (3) on which the message archives (and process value 
archives, if any) are stored. The only programs run on the archive server are the archiving 
applications. The archive server receives the data to be archived from the servers (2). The 
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clients (1) access the archive server (3) to display archived data. All other Runtime data is 
provided by the servers (2):

Note

This configuration cannot be implemented for message archives in a PCS7 environment, as 
messages are generated separately on each server and cannot be brought together on a 
single server.

For additional information, refer to the WinCC documentation "Client/Server Systems" and 
"Redundancy".

See also
Output of Message Archive Data in Runtime (Page 1004)

Configuration of Message Archiving (Page 995)

Message Archiving in WinCC (Page 994)
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5.6 Display of Messages during Runtime

5.6 Resources

5.6.1 WinCC AlarmControl

Introduction
WinCC AlarmControl is an alarm window used to display message events. All messages are 
displayed in a separate message line. The content of the message line depends on the 
message blocks to be displayed.

Lists in the message window
You have the option of viewing six different lists in the message window:

● Message list to view currently activated messages.

● Short-term archive list, to view archived messages. The display is updated immediately 
after activation of new messages.

● Long-term archive list, to view archived messages.

● Lock list, to view currently locked messages.

● Hitlist, to view statistics data.

● List of messages to be hidden, to view hidden archived messages.

The figure below shows an example of a message list:
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Note

A message is shown with a crossed-out date and time stamp in the message list if any of the 
following events are triggered:
● A locked message is released again.
● A message is reloaded after power failure. This applies only to correct chronological 

messaging.
● The AS is restarted. This applies only to correct chronological messaging.

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

5.6.2 Configuring the AlarmControl

5.6.2.1 How to configure the AlarmControl

Introduction
The messages are displayed in a message window in runtime. You can configure a 
corresponding WinCC AlarmControl in Graphics Designer. 

Prerequisite
● A message system has been set up using the "Alarm Logging" editor.

● You configured the necessary message blocks, message classes and the message types 
according to requirements configured in "Alarm logging".

● You configured the necessary single and group messages and their properties in "Alarm 
logging".

Configuration steps
1. Insert the AlarmControl into a picture of Graphic Designer.

2. Configure the basic properties of the AlarmControl in the "General" tab.

– The message window properties

– The general properties of the control

– The time base of the control

– The default sorting order in the table

– Properties of the long-term archive list

– The action to be triggered by double-clicking in the message line
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3. Configure the content of the message lines in the message window. The content of the 
message line depends on the configuration of the message blocks. Go to the "Message 
blocks" tab.

4. Select the "Message lists" tab to define the message blocks to be shown as columns in the 
message window. Use the selection dialog to define the messages to be displayed in the 
message window.

5. Configure the layout and properties of the message window in the "Parameter", "Display" 
and "Marker" tabs.

6. Configure the toolbar and the status bar of the message window.

7. Configure a hitlist if you want to view message statistics.

8. Configure the display for the operator input messages to adapt these as required.

9. Save your configuration data.

5.6.2.2 How to configure the message blocks

Introduction
The message content to be displayed in the message line depends on the message blocks 
configured. The message blocks configured in the "Alarm logging" editor can be applied without 
changes, or be configured in AlarmControl.

Prerequisite
● You created a message system using the "Alarm Logging" editor.

● In "Alarm logging", you configured the message blocks to be used in the message line.
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Configuring existing message blocks
1. Go to the "Message blocks" tab in AlarmControl. All of the message blocks configured in 

the "Alarm logging" editor are listed in "Available message blocks". The message blocks 
for the hitlist are also listed.

2. If the "Apply project settings" option is activated, the message blocks and their properties 
you configured in "Alarm logging" are activated in the AlarmControl. The message blocks 
are displayed with these properties in the message window and can only be changed by 
means of the Alarm logging. The message blocks of the hitlist depend on "Alarm logging". 
You can configure these message blocks as required.

3. Deactivate the "Apply project settings" option to let you add or remove message blocks for 
the message lists, or to configure message block properties. The changed properties are 
stored in the picture. Changes to properties made in "Alarm logging" are ignored in this 
control.
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4. Activate the check box next to the name of a message block to be used in the message 
window in the "Available message blocks" list.

5. A selected message block can be set as criteria in the selection dialog by activating the 
"Use selection dialog" option for this message block.

Message block names
1. You can assign the message blocks custom names for the column header in the message 

window. Remove the text ID and enter a name in the "Name" field. The name is saved to 
the picture in the currently active language.

2. Use a corresponding entry from the text library for multi-lingual functions and for the 
message block names in all pictures. Enter an existing text ID from the text library in the 
"Text ID" field. The text ID stored in the text library is entered in the "Name" field.

Displaying message blocks
1. Resize the message block width in the message window as required. Enter a value in the 

"Length in chars" field.

2. Certain message blocks can also visualize the content and column of the message window 
by means of an icon. The content of message block "State" in the message lists, for 
example, can be visualized by means of "activated", "activated/deactivated" and "activated/
acknowledged" icons in the "Display" field. The text and icons can be displayed in parallel.

3. You can format certain message blocks. Select the message block from the "Available 
message blocks" list. Define the format in the "Format" field.

4. Save the configuration.

5.6.2.3 How to define the content of the message window

Introduction 
All messages are displayed in a separate message line in the message windows. The content 
of the message window is determined by the message blocks and messages selected.

Requirement
● You created a message system using the "Alarm Logging" editor.

● You configured the message blocks to be used in the message line.

Determine the message blocks to be displayed in the message lists.
Define the message window content on the "Message lists" tab.
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Procedure
1. Go to the "Message lists" tab.

2. Select the "Available message blocks" list and select the configured message blocks to be 
displayed in the message lists. Use the arrow buttons to move these message blocks to 
the "Selected message blocks" list. Using the arrow keys you can cut selected message 
blocks from the message lists and paste these to the "Available message blocks" list.

3. You can define the sorting order of selected message blocks in the message lists and move 
these using the "Up" and "Down" buttons.

4. Save the configuration.
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Selecting messages to be displayed in the message lists
Use a selection dialog to select the message to be displayed in the message lists. You can 
configure one permanent and several custom selections. 

The configured fixed selection is always used in Runtime. The custom selections configured 
are only used in Runtime if activated.

You can also import custom selections. The import is used, for example, to reuse selection in 
the project made by the user or to compare selections of clients. The imported selection 
replaces the existing selection in this case. Importing selections does not require an export.

Any activated custom selection used is logically linked with the fixed selection you are using 
by means of "AND" operation. 

Procedure
1. Click "Edit..." in the "Selection" area to create or edit custom selections. The selection dialog 

is opened.

2. Click on "New..." to create a selection or import a selection. Activate the new or existing 
selections. For further information on the selection of messages, refer to .

3. Click "OK" to close the selection dialog. The activated selections are included in the 
message window at the start of Runtime.

4. Click on "Edit..." in the "Fixed selection" area to create or edit a fixed selection. The selection 
dialog is opened.

5. Select the message blocks. Enter one operand and a text or value in the "Setting" column, 
depending on the message block, or select an option.

6. Press "OK" to save the fixed selection and close the selection dialog. The fixed selection 
is included in the message window at the start of Runtime.

Configuring the sorting order of messages
You configure the sorting order of the columns in the message lists in the "Sorting" field. You 
can also define sorting criteria using the toolbar in Runtime. Disable the "Auto-Scrolling" option 
to activate the configured sorting order in Runtime. Only the default sorting order is available 
if "Auto-Scrolling" is activated.
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Procedure
1. Click "Edit...". The sorting dialog opens.

2. Define a sorting order. For further information on the sorting of messages, refer to .

3. Click "OK" to close the sorting dialog.

Note

You can change the default sorting order by "date/time/number" to "message block/date/
time/number". Configure the "DefaultSort2Column" and "DefaultSort2" object properties 
accordingly. Define a message block and its object name in the "DefaultSort2Column" 
object property. Define the ascending or the descending sorting order in the "DefaultSort2" 
object property.

5.6.2.4 How to configure the display for the table

How to configure the properties of the table elements

Introduction
You can adjust the properties of the table elements in the WinCC controls to suit requirements. 

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Parameters" tab.

2. Specify the properties for of

– Column header

– Line labeling

– Sorting

– Table content

3. Save the configuration.

How to configure the colors of the table elements

Introduction
You can adjust the colors of the table elements in the WinCC controls to suit requirements. 

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Display" tab.

2. Define the colors for the background or text here for:

– Table content. You can define different colors for even and odd line numbers to improve 
differentiation between both.

– Contents of the table header

– Separating lines in the table and for table headers

3. Define the color and the line weight in the "General" area in terms of:

– Control borders

– Window dividers for control elements

4. Save the configuration.
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How to configure the marking of the selected cells and lines

Introduction
You can customize the marking of the selected cells and rows in the WinCC control to suit 
requirements. 

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Marker" tab.

2. Define whether to select rows or only cells using the mouse.

3. Configure the properties of the selection rectangle that can be displayed around selected 
table cells or rows.

4. Configure the marking color for selectable cells and/or rows. The system colors are used 
for marking with "Automatic coloring" property.

5. Save the configuration.

How to configure sorting via the column heading

Introduction
You can adjust the sorting order by means of table column header in the WinCC controls to 
suit requirements. 
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Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameters" tab.

2. Define whether to enable sorting and the sorting method by column header. In WinCC 
AlarmControl, you can only sort by column header if the "Auto-Scrolling" is disabled. You 
can deactivate "Auto-Scrolling" either in the "General" tab, or using the "Autoscroll" toolbar 
icon of the WinCC AlarmControl.

3. Determine the sorting order by mouse click on the column header. Select ascending, 
descending or no sorting order.

4. Configure the sorting icon and index to be displayed in the column header with right 
justification. These show the sorting order and sequence of the columns.

5. Activate the "Use sorting button" to display the sorting icon as sorting button above the 
vertical scroll bar. Click this sorting button to activate a configured sorting order for the 
column selected. The sort button is not displayed if a vertical scroll bar is missing.

6. Save the configuration.

5.6.2.5 How to configure the toolbar and the status bar 

Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The 
status bar contains information pertaining to the current status of the WinCC control. You can 
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime. 
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Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The WinCC control is assigned the "Configuration dialog" button function for opening the 
configuration dialog in Runtime.

● The configuration dialog of the WinCC control is open.

How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in 
Runtime. For information on the button functions, refer to the description of the 
corresponding WinCC control at "Operation in runtime".
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3. Determine the sorting order for displaying the button functions in the toolbar. Select the 
button functions from the list and the move the functions using the "Up" and "Down" buttons.

4. Define a hotkey for the functions of the toolbar buttons.

5. Any button functions assigned operator authorizations are only available in Runtime to 
authorized users.

6. An activated button function is displayed in runtime if you deactivate its "Active" option, 
however, it cannot be operated.

7. You can set separators between the button functions. Activate the "Separator" option for 
the button function to be restricted by separator.

8. Configure the general properties of the toolbar, e.g. alignment or background color.
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How to configure the status bar
1. Go to the "Status bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required in runtime in the list of status bar elements. For further 
information on status bar elements, refer to the descriptions of the corresponding WinCC 
control at "Operation in runtime".

3. Determine the sorting order for displaying of the status bar elements. Select the elements 
from the list and move these using the "Up" and "Down" buttons.

4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a 
pixel value for the width.

5. Configure the general properties of the status bar, e.g. alignment or background color.
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5.6.2.6 How to Configure a Hit List of Messages

Introduction 
The hit list displays statistic calculations for archived messages in the message window. In 
addition to statistics, the hit list can display configured message blocks. The message blocks 
display the data of the message most recently activated if contents are variable. 

Overview
Customize the hit list columns which consist of message blocks and statistics data.

The following statistic calculations are available for messages:

● Frequency of a message number. The frequency is only increased if the archive contains 
a message with "activated" state. If the frequency of a message number in the selected 
message range is "0", an entry does not exist for this message number in statistics data.

● The cumulative duration of a message number for the status:

– "activated/activated" (Message block: Sum +/+)

– "activated/deactivated" (Message block: Sum +/-)

– "activated/initial acknowledgment" (message block: Sum +/*1)

– "activated/second acknowledgment" (message block: Sum +/*2).

● The average duration of a message number for the states:

– "activated/activated" (Message block: average +/+),

– "activated/deactivated" (Message block: Average +/-),

– "activated/initial acknowledgment" (message block: average +/*1)

– "activated/second acknowledgment" (message block: average +/*2).

Only the "Acknowledgment", "System Acknowledgment" and "Emergency Acknowledgment" 
states are included in the statistics calculation of acknowledgment times.

Note

Messages with "Acknowledgment", "System acknowledgment", "Emergency 
Acknowledgment" and "Deactivated" state are only included in the calculation of statistic data 
if the events available for statistics calculation includes a corresponding, previous message 
with "activated" state.         
         
If only one acknowledgment is triggered for a message with initial or second acknowledgment, 
the acknowledgment time is included in the calculation of the cumulative and average duration 
of the "activated/initial Acknowledgment" and "activated/second Acknowledgment" 
states.         
         
The message is only entered several times in the archive with "activated" state and included 
several times in the calculation if runtime was stopped/restarted several times and a message 
was active within this time, for example, due to the external discrete message procedures or 
chronological messaging.
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Requirement
● You opened a picture which contains the AlarmControl in Graphics Designer.

● You configured the message blocks to be included in the hit list.

● You activated the "Hit List" button function on the "Toolbar" tab of the AlarmControl.

Procedure
1. Go to the "Hit list" tab.

2. Select the message blocks to be displayed in the hit list from the list of available message 
blocks. Use the arrow buttons to move these message blocks to the "Selected message 
blocks" list. You can cut message blocks from the hit list and paste these to the "Available 
message blocks" list using the arrow keys.
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3. You can define the sorting order of message blocks in the hit list by selecting and then 
moving these using the "Up" or "Down" buttons.

4. Specify the criteria to be used for displaying messages in the hit list, such as a specific 
message class or a specific time range in the "Selection" area of the tab. All times are 
included in the calculation of average values if you have not specified a time range. Note 
that a long-range selection can adversely affect performance. Click the "Edit..." button to 
configure a selection or import it. The imported selection replaces the existing selection in 
this case. Importing selections does not require an export. You can also define selection 
criteria for the hit list in runtime using the "Selection dialog" button. For further information 
on the selection of messages, refer to "How to select messages".

5. Define the sorting criteria for the hit list columns in the "Sorting" area of the tab, for example, 
first descending by date and then ascending by message number. Click the "Edit..." button 
to configure a sorting order. You can also define the sorting criteria for the hit list in runtime 
by means of the "Sort dialog" button.

6. In the lower portion of the tab, define the settings in terms of quantity and time limits for the 
creation of statistics data.

7. Save the configuration.

Results
The hit list is configured for display in the message window. Call the hit list at runtime by clicking 

 in the toolbar.

The values in the hit list are sorted by frequency in descending order if you have not set any 
sorting criteria.

New activated messages are not automatically included in the hit list. To include them, you 
must reselect the hit list.

5.6.2.7 How to configure operator messages

Introduction
Operation of a message can trigger an operator message. Operator messages can be 
triggered at the following events:

● Lock message

● Enable message

● Acknowledge message

● Hide message

● Show message

Configure operator messages in WinCC AlarmControl:

● If you want to use and adapt the default operator messages of WinCC

● If you want to use custom operator messages
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Prerequisite
● You defined the WinCC system messages in the "Alarm logging" editor.

● In the "Alarm logging" editor, you configured the messages editor to be used as operator 
messages in WinCC Alarm control.

● You opened Graphics Designer and configured a picture with a WinCC AlarmControl.

● The configuration dialog of the AlarmControl is open.
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Procedure
1. Go to the "Operator messages" tab.

2. In the list, activate "Operator input message for:" the events which trigger operator 
messages.

3. If not using the operator messages from WinCC, enter the message number of the 
configured message for every event.

4. Assign the message blocks of the operated message to the process value blocks of the 
operator message. The message blocks must be selected in the "Message Blocks" tab.

5. Define whether to transfer the content as text or value for further value-based processing.
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Example
An operator message is to be generated on locking a message. The content of "User text block 
1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process value block 1" of 
the operator message. This requires that you select "1" under process value as the message 
block of operated message "User text block 1".

Note

It is recommend to use message class "System, without acknowledgment" for all operator 
messages. Always use message classes that are configured as "without deactivated status".

Note

Operator messages can only be logged if corresponding system messages are set up in the 
message archive.

Operator message triggering upon locking and unlocking a message
Operator messages triggered by locking and unlocking messages are always assigned 

● a time stamp

● name of the logged on user

● the computer name in the message archive of the alarm server concerned

The time stamp for the message is derived from:

● the message source (e.g., AS), in the case of active locking and unlocking

● the alarm server (OS), in the case of passive locking and unlocking

Actively locked messages are visible and operable on all WinCC servers and clients.

Results
The contents of operated messages are displayed in the updated process value blocks of the 
operator message. The process value blocks must have been selected in the "Message Lists" 
tab to enable the display of process value blocks of the operator message. The hitlist displays 
statistic data of the operator messages.

5.6.2.8 How to export runtime data

Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set 
up operation of the data export in runtime in the configuration dialog.
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Requirements
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.

How to configure the operation of the data export
1. Go to the "Export" tab. 

2. A standard file name and a standard directory are already entered in the "Data export default 
settings." In this case for AlarmControl. If necessary, define a file name and a directory for 
the export file.

3. CSV is currently available as data format. Click on  to define the separator in the CSV 
file.

4. Define the scope of the data export:

– All runtime data is exported

– Selected runtime data is exported. This data export is only possible in WinCC controls 
with tabular display.

5. Configure the operation of the data export in runtime. Define:

– whether users are allowed to rename the file, or change the directory.

– whether to display the "Data export default settings" dialog in Runtime.

6. If "Display dialog" is deactivated, the data for operation of the "Export data" button function 
is immediately exported to the defined export file.

7. Save the configuration.

8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results

You can export all or selected data to a defined file at runtime using button function .
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5.6.2.9 How to define the effect of the online configuration

Introduction
Users can parameterize the WinCC controls in Runtime. You must define the runtime effects 
of the online configuration.

Changes configured at runtime are saved to a separate picture in the configuration system. 
The original picture configuration is retained in the configuration system.

Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults 
are only available in the configuration system. The option buttons are not available in 
runtime.         
Select one of the three effects of the online configuration:

– "Do not retain". The online configurations are not retained in Runtime. This default 
setting disables all options for runtime users. Online configurations are lost at the next 
picture change and on activation/deactivation of the project.

– "Retain during runtime". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the 
project.

– "Retain permanently". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
and on activation/deactivation of the project if the "retain" option is enabled. 

3. Define corresponding user authorizations for online configuration.

4. The option buttons of the "Online configuration on next picture change" can be enabled for 
operation in the configuration system and at runtime by setting the "retain at runtime" and 
"retain permanently" defaults. The "reset" operation is only available in runtime, because 
the configuration system contains the original configuration.         
Select one of three effects of the online configuration at the next picture change:

– Select "discard" if to discard the online configuration at the next picture change.

– Activate "retain" to activate the online configuration based on default settings at the next 
picture change or on activation/deactivation of the project.

– Activate "reset" to activate a picture which is older than the version stored in the 
configuration system for runtime. All online changes are lost.         

Note

The picture is also replaced at runtime if you save it in Graphics Designer, or when 
loading deltas in online mode. All online changes are lost.

5. Save the configuration.

Note

The different configurations are only activated for new users after you performed a picture 
change.

5.6.2.10 SQL statements for filtering messages in AlarmControl

Introduction
WinCC AlarmControl only supports SQL statements which can also be generated using the 
selection dialog of the message window. The following conditions are valid for WinCC: 

● The syntax consists of the "field", "operand", and "value", with parameters separated by 
space characters. For example: DATETIME >= '2007-12-21 00:00:00' AND MSGNR >= 
100 (as of 2007-12-21, all messages with message number greater than and equal to 100)

● Strings, date, and time must be passed in single quotation marks.

● The date and time in the DATETIME argument must be separated by a space character. 
The output of DATETIME is based on the "Local Time", regardless of any other time base 
setting in the object properties. Exception: UTC is set as the time base: in this case, the 
output is based on the "UTC" time base.
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Valid arguments

Name SQL name Type Data Example

Date/time DATETIME Date 'YYYY-MM-DD hh:mm:ss.ms' DATETIME >= '2007-12-03 
16:00:00.000'
Outputs messages as of 12/03/2007, 
16.00 hours.

Number MSGNR Integer Message number MSGNR >= 10 AND MSGNR <= 12
Outputs messages with message 
numbers 10 - 12.

Class Class  Integer Message class ID 1-16 and 
system message classes 17 + 18

Class = 1         
Outputs messages of message class 1.
Class IN ( 1,2 )         
Outputs messages of message class 1 
and message class 2.

Type Type Integer Message type ID 1-256 and 
system message types 257, 258, 
273, 274

Type = 1         
Outputs messages of message type 1.
Type IN (1,2,3 )         
Outputs messages of message type 1 
and message type 2

State State Integer Valid values:         
1 = activated messages         
2 = deactivated messages         
3 = acknowledged 
messages         
4 = blocked messages         
10 = hidden messages         
11 = displayed messages         
16 = messages acknowledged by 
the system         
17 = Emergency-acknowledged 
messages         
18 = ackn. central signaling 
devices

State = 1
State IN(1,2,3,16,17)

Computer name ComputerName Text Search text for the computer name Computer name LIKE 'PC1234'
Outputs messages whose computer 
name corresponds to "PC1234".
Computer name LIKE '%C12%'
Outputs messages whose computer 
name corresponds to "C12".

User name UserName Text Search text for the user name User name LIKE 'User123'
Outputs the messages whose user 
name corresponds to "User123".
User name LIKE '%er12%'
Outputs messages whose user name 
corresponds to "er12".

Priority Priority Integer Message priority 0 - 16 Priority >= 1 AND Priority =< 5
Outputs messages with priority 1 to 5.
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Name SQL name Type Data Example

AS number (AS/
CPU number)

AGNR Integer AS Number AGNR >= 2 AND AGNR <= 2
Outputs messages with the AS number 
2.

CPU number 
(AS/CPU 
number)

CPU__NR Integer AS subnumber CPU__NR >= 5 AND CPU__NR <= 5
Outputs messages with AS subnumber 
5.

Instance Instance Text Instance -
Block: 1         
...         
Block: 10

Textxx Text Search text for block: 1 - Block: 10 Text2 LIKE 'Fault'
Outputs message whose block: 2 
corresponds to "Fault".
Text2 LIKE '%Fault%'
Outputs message whose block: 2 
contains the "Fault" entry.

Process value: 
1         
...         
Process value: 
10

PValuexx Double Search value for process value: 1 
- Process value: 10

PValue1 >= 0 AND PValue1 <= 50
Outputs messages with process value 
between 0 and 50.

Valid operands
● >=, <=, =, >, <

● IN(...) : Several values as comma separated array, e.g.: Class IN(1, 2, 3) AND Type IN(1, 
2,19, 20, 37,38)

● LIKE : The message text must match the string. The message text must only contain the 
string if this string is enclosed with "%" characters. The "LIKE" operand is only valid for 
"Textxx" arguments.

Invalid arguments and operands 
Only the arguments defined in the table and the operands from the list are valid.

Group arguments are invalid, e.g. by means of parenthesis.

Note

If using SQL statements of versions older than WinCC V7 in the new WinCC AlarmControl 
V7, you possibly have to convert the operands and contents for "Textxx" arguments. Only 
the "LIKE" operand is used for "Textxx" arguments.
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5.6.2.11 How to make the toolbar for the AlarmControl dynamic

Introduction
The default functions for operating the WinCC AlarmControl are no longer supported in the 
new WinCC AlarmControl for WinCC V7.0 or higher. However, you can use the dynamic 
methods of WinCC to operate the function of a toolbar button by means of script.

Overview
WinCC Controls V7.0 or higher no longer requires special functionality for operating the control 
by means of dynamic toolbar. The default functions "AXC_OnBtn..." and "OnBtn..." used 
previously are no longer supported.

If you do not want to operate the message window using the toolbar, you can set the "ID" of a 
button to the "ToolbarButtonClick" object property using any dynamic mode. 

Determine a toolbar button "ID":

● using the table on page "Operation of the AlarmControl in Runtime".

● by means of the "Object ID" field of the the "Toolbars" tab in the configuration dialog of the 
AlarmControl.

Example: Open the control configuration dialog
The following options of assigning dynamic properties are available for opening the control 
configuration dialog:

● VBScript:

– ScreenItems("Control1").ToolbarButtonClick = 2

– As an alternative to the "ToolbarButtonClick" property, you can use the VBS methods 
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog

– Or, with the following notation and support of "Intellisense":          
Dim obj         
Set obj = ScreenItems("Control1")         
obj.ShowPropertyDialog

● C script:

– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);

● Direct connection

– Enter "2" as source constant in the direct connection dialog.

– Select the "ToolButtonClick" property for the "Control1" object as the "Object in picture" 
target.

See also
Operating the AlarmControl in runtime (Page 1042)
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5.6.3 Operation during runtime

5.6.3.1 Operating the AlarmControl in runtime

Introduction
You operate the message window at runtime using the toolbar buttons. If you do not want to 
operate the message window using the toolbar, you can set the "ID" of a button to the 
"ToolbarButtonClick" object property using any dynamic mode.

Icon Description ID
"Help"
Calls the WinCC AlarmControl help.

1

"Configuration dialog"
Opens the configuration dialog for editing the properties of the AlarmControl.

2

"Message list"
Lists currently active messages.

3

"Short-term archive list"
Lists the archived messages of the short-term archive list.

4

"Long-term archive list"
Shows the messages saved to the long-term archive list.

5

"Lock list"
Shows all messages locked in the system.

6

"Hitlist"
Displays the message blocks and the statistic data you configured on the Hitlist tab 
of the AlarmControl.

7

"List of messages to be hidden"
Shows all messages which were hidden automatically or manually in the message 
list.

8

"Ackn. central signaling devices"
Acknowledges a visual or acoustic signal generator.

9

"Single acknowledgment"
Acknowledgment of a selected and visible single message. If using the multiple 
selection, the selected messages which require single acknowledgment are not 
acknowledged.

10

"Group acknowledgment"
Acknowledges all active, visible messages which require acknowledgment in the 
message window, unless these require single acknowledgment. If you use the 
multiple selection, all marked messages are acknowledged, even if the messages 
are hidden.

11
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"Emergency acknowledgment"
Emergency acknowledgment of a message requiring acknowledgment. This 
function transfers the acknowledgment signal of a selected single message directly 
to the AS, even if this message is not activated. 
Acknowledgment of inactive messages only refers to messages which were 
configured in proper chronological order.

18

"Selection dialog"
Specifies the selection criteria for messages to be displayed in the message window. 
The messages which do not meet these criteria are not displayed but are 
nevertheless archived.

13

"Display options dialog"
Specifies the messages to be displayed in the message window. 
If the "All Messages" option is activated, the message windows shows the hidden 
as well as displayed messages.
If the "Shown messages only" option is activated, only shown messages are 
displayed in the message window.
If the "Hidden messages only" option is activated, only hidden messages are 
displayed in the message window.

14

"Lock dialog"
Defines the locking criteria. All messages that meet these criteria are neither 
displayed, nor archived.

15

"Print"
Start printing of the messages of the selected list. Define the print job in the "General" 
tab of the the configuration dialog. 

17

"Export data"
Use this button to export all or selected runtime data to a CSV file. If the option 
"Display dialog" is enabled, a dialog opens in which you can view the export settings 
and start the export. You can select the export file and directory, provided you are 
granted corresponding authorizations.         
The data is exported immediately to the default file if this dialog is not displayed.

35

"Autoscroll"
If "Autoscroll" is activated, the last message in chronological order is selected in the 
message window. The visible range of the message window is moved if necessary.
New messages are not selected if "Autoscroll" is disabled. The visible range of the 
message window is not modified.
Messages can only be selected explicitly if "Autoscroll" is disabled.

12

"First message"
The first of the currently active messages is selected. The visible range of the 
message window is moved if necessary. The button is only available if "Autoscroll" 
is disabled.

19

"Previous message"
The message activated previously to the currently selected message is selected. 
The visible range of the message window is moved if necessary. The button is only 
available if "Autoscroll" is disabled.

20

"Next message"
The next message relative to the currently selected message is selected. The visible 
range of the message window is moved if necessary. The button is only available if 
"Autoscroll" is disabled.

21
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"Last message"
The last of the currently active messages is selected. The visible range of the 
message window is moved if necessary. The button is only available if "Autoscroll" 
is disabled.

22

"Infotext dialog"
Opens a dialog for viewing infotexts.

23

"Comments dialog"
Opens a text editor for entering comments

24

"Loop-in-alarm"
Shows a picture for the selected message or triggers a script. 

25

"Lock message"
The selected message is locked in the message list and in the message archive list.

26

"Enable message"
Enables messages selected in the lock list.

27

"Hide message"
Hides the message you selected in the message list, or in short-term or long-term 
archive list. The message is entered in the "List of messages to be hidden".

28

'Unhide messages"
Reactivates the display of messages you selected in the "List of messages to be 
hidden" in the message list, or in the short-term or long-term archive list. The 
message is removed from the "List of messages to be hidden".

29

"Sort dialog"
Opens a dialog for setting custom sorting criteria for displayed messages. 
A custom sorting order has higher priority than the sorting order set at attribute 
"MsgCtrlFlags".

30

"Time base dialog"
Opens a dialog for setting the time base for times displayed in the messages.

31

"Copy rows"
Copies the selected messages. You can paste the copy to the table editor or text 
editor.

32

"Connect backup"
Use this button to open a dialog for interconnecting selected backup files with WinCC 
Runtime. 

33

"Disconnect backup"
Use this button to open a dialog for disconnecting selected backup files from WinCC 
Runtime. 

34

"First page"
Returns you to the first page of the long-term archive list. The button is only available 
if paging is enabled in the long-term archive list. You can activate this setting in the 
"General" tab of the configuration dialog.

36

"Previous page"
Returns you to the previous page of the long-term archive list. The button is only 
available if paging is enabled in the long-term archive list. You can activate this 
setting in the "General" tab of the configuration dialog.

37
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"Next page"
Opens the next page of the long-term archive list. The button is only available if 
paging is enabled in the long-term archive list. You can activate this setting in the 
"General" tab of the configuration dialog.

38

"Last page"
Opens the last page of the long-term archive list. The button is only available if 
paging is enabled in the long-term archive list. You can activate this setting in the 
"General" tab of the configuration dialog.

39

"User-defined 1"
Shows the first button function created by the user. The button function is user-
defined.

1001

Available status bar elements
The following elements can be output to the status bar of the message window:

Icon Name Description

Pending messages Shows the number of current messages in the message list.

Pending 
acknowledgeable 
messages

Shows the number of pending messages requiring 
acknowledgment.

Number of pending 
hidden messages

Shows the number of pending messages that are hidden.

Messages in the list Shows the number of messages in the current message 
window. The count includes messages hidden in the 
message list.

Selection A message selection exists.

Display option The filter criteria is active. The "Display all messages" or 
"Show hidden messages only" option is currently active.

Locked The lock is set on messages.

Pending hidden 
messages

There are hidden messages pending.

Connection status Shows the status of the connection to the alarm servers:
● No connection errors
● Faulty connections exist
● All connections are faulty

Date Shows the system date.

Time Shows the system time.

Time base Shows the time base used for displaying times.
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5.6.3.2 How to Select Messages

Introduction     
You can use the selection dialog in Runtime to specify the messages to be displayed in the 
message window. You define new selection criteria in the selection dialog, or select an already 
existing selection.

New properties of the selection dialog
The design of the selection dialog was enhanced to improve handling comfort and offers the 
following new properties:

● Concise input of selection criteria.

● The "*" and "?" wildcards are supported for setting a criterion.

● Saving a selection enables reuse of the selection without having to reenter the selection 
criteria.

● Creating several selections.

● Duplicating a configured selection

● Linking specific selections in terms of a logical "OR" operation.

● A fixed selection is available that cannot be changed in Runtime. The fixed selection and 
the active user-defined selections are logically linked by "AND" operation.

● All users are granted full access to all user-defined selections.

● The SQL statements you created by means of scripting, or entered in the object property 
"MsgFilterSQL", are written to the list of selections and provided with a comment.

Requirement
● You configured the "Selection dialog" button function on the "Toolbar" tab of the 

AlarmControl.

● You activated the message blocks that are available as the selection criteria on the 
"Message blocks" tab using the "Selectable in selection dialog" option.

● If a fixed selection is configured, other activated selections and the fixed selection are 
logically linked by "AND" operation.

Procedure
1.

Click on  in Runtime. The "Selections" dialog opens.

2. Click "New..." to create a selection. You can also activate existing selections by clicking in 
the check box in front of the selection name.

3. When creating a new selection, assign a name to the selection and an expressive comment 
to distinguish it from other selections.
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4. Click in the first empty row of the "Criterion" column. The list with the selectable system 
blocks, configured user text blocks and process value blocks is displayed. Select the 
message block.

5. Select the suitable operand using the "Operand" column.

6. Click in the corresponding row of the "Setting" column. Depending on the text block, enter 
a text or a value, or select an option.

7. Click "OK". The selection is saved and is listed in the table of selections.

8. You can create other selections or edit, remove or duplicate existing selections in the 
selection dialog.

9. In the table, activate the selections to be included in the message window.

10.Click "Apply". The message window shows the selected messages.

11.Click "OK" to close the selection dialog.

NOTICE

Ensuring the display of all messages

Observe the proper use of criteria, operands and settings of selections. 

Incorrectly linked criteria can lead to important messages not being displayed in the 
AlarmControl. Use the "Apply" button in Runtime to check the selection.

Test all selections separately and before linking these, and then test the linked selections. 
Verify that all expected messages are also displayed in combination.

This ensures that all selections are displayed in the AlarmControl.

Note

It is not possible to enter text as selection criterion for a process value. If you want to select 
based on the text of a process value block or on the displayed process tags, proceed as 
follows:

1) Insert this process value as message text of a user text block in a message.

2) Select the messages based on the text in the "Message Text" text block in Runtime.

In multi-user systems, you must ensure that contents displayed in the selection dialog on 
a client are named identically on all servers. 

Note
Displaying messages from WinCC/CAS in WinCC AlarmControl

You must specify a time range in the selection dialog to display messages from WinCC/CAS 
in AlarmControl. If you did not specify a time range, only messages from the server are 
displayed.
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5.6.3.3 How to Lock and Unlock Messages

Introduction
Message locking suppresses the display and archiving of messages. You can set a lock for 
the following:

● Single messages

● Message types

● Message classes

● Group messages and user-defined group messages

Persistence of message locking
● The lock of single messages is not persistent. Locked single messages are unlocked 

automatically at the restart of WinCC Runtime. Exceptions are messages that are locked 
directly in the AS by means of data blocks (locking via source).

● The lock of message classes and message types also remains active after the restart of 
WinCC Runtime.

Prerequisite
● You configured the relevant button functions on the "Toolbar" tab of the AlarmControl.

Locking and enabling selected messages using the "Lock message" and "Enable message" button 
functions

1. In the message list, select the message row which contains the message to be locked.

2.
Click the "Lock message" button . The message is removed from the message list.

3.
You can view the locked message by clicking the "Lock List" button . You can enable 

the selected message again by clicking the "Enable message" button . The message 
is removed from the lock list.

Note

Users who are authorized to lock and unlock messages must have been granted both 
authorizations in the User Administrator, and these authorizations must be configured 
directly one below the other. This is necessary as the authorization level defined below 
the authorization for "Lock Messages" in the User Administrator is used automatically as 
the authorization for enabling.

Note

If locking/enabling a single message of an Alarm_8P using S7PMC, you lock/enable all 8 
single messages of this block.
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Locking and enabling single messages using the message number
1.

Click the "Lock Dialog" button . The "Set the lock list parameters" dialog opens.

2. Click a server in the server list, or click the local computer for workstation projects.

3. Click the "Add" button. Enter the message number to be locked in the next dialog.

4. You can lock several messages simultaneously. Enter comma separated message 
numbers accordingly. Enter a range with the syntax "5-10" for a message number range. 
Only continuous message ranges are locked. If there are gaps in the specified range, the 
message "Invalid Range" is returned.

5. To enable a locked message, select the message from the list of locked messages and 
then click the "Delete".

Note

You can lock and enable a up to 50 messages simultaneously.

Locking and enabling of messages based on message class, message type, or user-defined group 
message criteria

1.
Click the "Lock Dialog" button . The "Set the lock list parameters" dialog opens.

2. Click a server in the server list, or click the local computer for workstation projects.
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3. In the tree view, select the message class, the message type, or the user-defined group 
message to be locked. Click the "Lock" button. All message of the specified message class, 
message type or user-defined group message are locked.

4. To enable the locked messages, select the relevant message class, message type or user-
defined group message and then click the "Enable" button.

Note

The server list contains only those server projects whose "Packages" are loaded on the 
computer containing the project where you are configuring the control.

5.6.3.4 How to Perform an Emergency Acknowledgement

Introduction
In exceptional cases, a message can be acknowledged on the basis of its message number. 
In this case, the acknowledgment signal is also transferred to the AS if the message is currently 
inactive. Acknowledgment of inactive messages only refers to messages which were 
configured in proper chronological order.

Note

The emergency acknowledgment function is not provided for general acknowledgment. The 
function may only be used in extreme emergency situations.
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Prerequisite
● You configured the "Emergency Acknowledgment" button function on the "Toolbar" tab of 

the AlarmControl.

Procedure
1.

Click the "Emergency acknowledgment" button . The "Emergency acknowledgment 
of messages" dialog opens.

2. Select a server. In the "Message number" input field, enter the number of the message to 
be acknowledged.

3. Click the "Send request" button. In the message window, the message now appears in the 
color that you specified for an acknowledged message.

Note

In the dialog for the selection of the servers, only server projects are shown whose 
"Package" is loaded onto the computer.

5.6.3.5 How to Sort the Display of Messages

Introduction
During runtime, you can sort the messages in the message window on the basis of message 
blocks. You sort the message blocks either via the "Sort Dialog" keyboard function or directly 
via the column headers of the message blocks. User defined sorting is only executed if auto-
scrolling is disabled. The default sorting mode is executed if auto-scrolling is enabled

Examples of message sorting: 
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● Descending by date, time and message number. The most recent message is displayed 
at the top. This is the default descending setting.

● Messages are displayed based on their priority. To apply this sorting method, you must 
have specified the priorities of messages in the "Alarm logging" editor and configured the 
"Priority" message block in the WinCC AlarmControl. As a result, in a single-line message 
view, only the top-priority message appears in the message window. The messages are 
usually shown in chronological order.

● Display of messages in ascending or descending order based on various message blocks, 
allowing for user-defined sorting during runtime.

● The "Status" message block is sorted according to the status type and not according to the 
configured status texts. If sorting is in ascending order, the messages are sorted in the 
following order: "Activated", "Deactivated", "Acknowledged", "Locked", "Enabled", "System 
acknowledgement", "Emergency acknowledgement" and "Activated/deactivated".

Note

You can also specify the sort criteria during configuration in the AlarmControl by clicking 
the "Edit..." button under "Sorting" on the "Message lists" tab. You configure the sort 
criteria for the hit list on the "Hit List" tab.

How to sort with the Sort dialog

Prerequisite
● You have configured the button function "Sort dialog" on the "Toolbar" tab of the 

AlarmControl.

● You have deactivated the button function "Autoscroll" in the toolbar or option "Auto-
scrolling" on the "General" tab.
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Procedure
1.

Click the "Sort Dialog" button .

2. In the "Sort By" field, select the message block by which to sort first. Select the relevant 
check box to specify sorting in ascending or descending order. If you want to sort by more 
than one message block, select the other message blocks in the desired order in the "Then 
sort by" lists.

How to sort the displayed message blocks with the column heading 
When sorting using the column header, you are able to specify the sort order for more than 
four message blocks. A sorting icon and sorting index, displayed with right-justification in the 
column heading, show sorting order and sorting sequence of the message blocks.

Prerequisite
● You have permitted the sorting in the list field "Sorting with column heading" by clicking or 

double clicking on the WinCC AlarmControl on the "Parameter" tab.

● You have activated the "Show sorting icon" and "Show sorting index" check boxes.

● You have deactivated the button function "Autoscroll" in the toolbar or option "Auto-
scrolling" on the "General" tab.

Procedure
1. Click the column header of the message block you want to sort by first. The sorting index 

"1" is displayed, and the sorting icon points upwards for ascending sort order.

2. If you want to sort in descending order, click the column header again.
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3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the 
message block with a third click.

4. If you want to sort on the basis of several message blocks, click the header columns of the 
respective message blocks in the desired sequence.

5.6.3.6 How to Hide and Unhide Messages

Introduction
Manual hiding of messages puts lesser information load on the user of the system. You as 
user can concentrate better on the messages only if lesser important messages are not shown.

Manual hide process 
During manual hide, you as user will decide whether to hide a message by using a button in 
the message window. You can show the message again using a button or the system will show 
the message after a configurable period. Operator input messages can be triggered in Manual 
Hide. 

Requirement
● You have configured the button functions "Hide message" and "Unhide message" and "List 

of messages to be hidden" on the "Toolbar" tab in WinCC AlarmControl.

● Runtime has been activated and the WinCC AlarmControl is displayed.

Procedure
1. Select the message you want to hide in the message list, short-term archive list or long-

term archive list.

2.
Click the "Hide message" button. The message is no longer displayed in the list and 
is added to the list of messages to be hidden.

3.
Click the "List of messages to be hidden" button to display the hidden messages.

4. To show these messages again, display the "List of messages to be hidden". Select a 

message and click the "Unhide message" button. The message is removed from the 
"List of messages to be hidden" and displayed back in the original list.

5. If you do not take any action to show the hidden messages, the configured duration will 
decide when the system has to display back a message and remove it from the "List of 
messages to be hidden".
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Runtime response to manual and automatic hiding of messages
Using the manual and automatic hide functions during Runtime has an effect on both the hide 
modes:

● If the message is hidden automatically, you can display it again by clicking "Unhide 
message".

● Automatic hiding takes priority over manual hiding:

– If the status of the hiding tag occurs for automatic hiding of the message, the message 
is shown again, even if the time period for manual hiding has not yet elapsed.

– If a message has the status of the hide tag for automatic hiding, the message remains 
hidden, even if the time period for manual hiding has elapsed.

5.6.4 AlarmControl example project

5.6.4.1 Examples of configuring an AlarmControl

Introduction
The following example shows the configuration of a WinCC Alarm Control and the display of 
messages in runtime. 

Prerequisite
● A message system has been set up using the "Alarm Logging" editor.

The procedure in principle
In Alarm Logging

1. Configure the required message blocks, message classes and message types according 
to your requirements.

2. Configure the single messages and group messages that you require.

In Graphics Designer

1. Link the WinCC AlarmControl to a Graphics Designer picture and change the properties of 
the control.

2. For the example, configure buttons to trigger and acknowledge messages in the Graphic 
Designer.
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5.6.4.2 How to Configure the Message System

Introduction
If you have created a message system in Alarm Logging, you configure the message system 
in Alarm Logging according to your requirements.

The following settings are configured for the AlarmControl example:

● Number of displayable characters in the "Message Text" user text block

● Acknowledgment conception for message class "Error"

● Coloring of message states for the "Alarm" and "Warning" message classes
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Prerequisite
● The "Alarm Logging" editor is open.

Procedure
1. Select "Properties" in the shortcut menu of the "Message Text" user text block, and change 

the length of the message block.

2. Select "Properties" in the shortcut menu of the "Error" message class, and select the 
"Acknowledgment activated" check box on the "Acknowledgment" tab.
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3. Select the "Properties" command in the shortcut menus of message type "Alarm" or 
"Warning," respectively, and select the font color and background color for the message 
states.

4. Save the settings in Alarm Logging.

Setting up a Message System
5.6 Display of Messages during Runtime

MDM - WinCC: Working with WinCC
1058 System Manual, 11/2008,  



5.6.4.3 How to Configure Single Messages

Introduction
In the example, four message are displayed during runtime. You configure these message in 
Alarm Logging with the following settings:

No. Class Type Message tag Message text Point of error

1 Fault Alarm Tank1 Tank 1 empty Tank 1
2 Fault Alarm Tank2 Tank 2 empty Tank 2 
3 Fault Alarm Tank3 Tank 3 empty Tank 3 

Prerequisite
● Configure the three "Binary" type tags "Tank1", "Tank2" and "Tank3" in the Tag 

Management.

● The "Alarm Logging" editor is open.

Procedure
1. In the Alarm Logging table window, add a new line for each message using the shortcut 

menu.

2. Select "Properties" in the shortcut menu of the messages created.
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3. On the "Parameters" tab of the "Single Message" dialog, select the class and type indicated 
above and connect the message to the respective message tag.

4. Activate the option "is single acknowledgment only"in order to acknowledge the message 
with an acknowledgment button in the example project.

5. On the "Text" tab of the "Single Message" dialog, enter the text indicated above for 
"Message Text" and "Point of Error".

6. Configure two additional messages with "Tank2" and "Tank3".

7. Save the settings in Alarm Logging.

Note

You can create the tags used as message tags either in the Tag Management of WinCC 
Explorer or directly by selecting the message tag on the "Parameters" tab of Alarm Logging.
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5.6.4.4 How to configure the AlarmControl in the Graphics Designer

Introduction
Messages are displayed in runtime in WinCC AlarmControl. Configure the AlarmControl in the 
Graphics Designer.

The following settings are configured for the example project:

● Keyboard functions in the toolbar

● Selection in the message window

● Selection and order of the message blocks that are displayed in the message window

Procedure
1. Start Graphics Designer and open a new picture.

2. On the object palette, double-click the "WinCC AlarmControl" on the "Controls tab".

3. The Control is inserted into the picture. Click the Control at the drag point and drag it to the 
desired size.

4. Double-click the Control. The "Properties of WinCC AlarmControl" is opened with the 
"General" tab.
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5. "Normal" is already selected as the window heading. Enter the desired window name in the 
"Text" input field.
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6. On the "Toolbar" tab, select the "Display Toolbar" check box. Select the keyboard functions 
you require. You need button functions "Configuration dialog", "Message list", "Lock list", 
"Single acknowledgment", "Selection dialog", "Autoscroll", "Lock message" and "Enable 
message" for the examples.
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7. Select "Single selection" as lines that can be marked and "Line" as selection outline on the 
"Marker" tab. Define the marking colors as you wish.

8. Define the other display options as you like on the "Parameter" and "Display" tabs.
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9. Select the available message blocks "Time", User text block 1" and "User text block 2" to 
change the format and name on the "Message blocks" tab. You can only change the 
message blocks if you have deactivated the "Apply project settings" option. Select the 
desired format in the "Format" field for "Time". For "User text block 1", the name "Message 
text" and for "User text block 2" the name "Fault location" are already entered.
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10.Define the message blocks and the sequence as columns on the "Message lists" tab. Using 
the arrow keys, move the selected message blocks from the list of "Available message 
blocks" to the list of "Selected message blocks". Change the order by selecting a message 
block and clicking "Up" or "Down".

11.Click "OK" to close the dialog, and save your settings in the Graphics Designer.

Results
The WinCC AlarmControl is configured for the example. If you have activated button function 
"Configuration dialog" on the "Toolbar" tab, you can change the display of tables in the control 
at any time in runtime.
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5.6.4.5 How to Configure Buttons for Changing Message Tags

Introduction
You have configured three single messages in Alarm Logging. In order to reproduce the 
example for the Alarm Control, you configure three buttons in the Graphics Designer that you 
use during runtime to set and reset the binary message tags of the individual messages. The 
message window shows the message statuses with the configured colors.

Procedure
1. In the object palette of the Graphics Designer, select the "Standard" tab and click the 

"Button" object in the "Windows Object" group. Position the cursor in the picture to the spot 
where you want to insert the button, and enter the text "Tank1".

2. Select "Properties" in the shortcut menu.

3. Make the "Press left" event dynamic by establishing a direct link between the constant "1" 
and the tag "Tank1".

4. Make the "Press right" event dynamic by establishing a direct link between the constant "0" 
and the tag "Tank1".

5. Likewise, configure two additional buttons with "Tank2" and "Tank3".

6. Save your settings in the Graphics Designer.
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5.6.4.6 Example of making the toolbar of the AlarmControl dynamic

Introduction
In order to operate a button function of the toolbar of the WinCC AlarmControl from another 
location, you must provide the "ToolbarButtonClick" property with the respective "ID".

In principle, any object can be used to operate the AlarmControl. In the following example, the 
standard object "Button" is used to acknowledge a message.

Prerequisite
● You have configured the example project for AlarmControl.

● You have opened the picture with the configured AlarmControl in the Graphics Designer.

Procedure
1. Determine the object name of the AlarmControl based on the object properties of the 

control, for example, "Control1".

2. Insert a button object from the Windows objects of the object palette into the picture. Enter 
a button text, e.g. "Acknowledge".

3. In order to make the button object dynamic, open the shortcut menu for the properties of 
the button object. In the "Event" tab, select the "Mouse" property. Make the attribute "Mouse 
click" dynamic with a C action.

4. Select "C action..." with the right mouse button. The "Edit action" window is opened.

5. Insert the following into the right window area:

– \\ activate toolbar button single acknowledgment (ID: 10)

– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 10);

6. Compile and save the C action.

7. Save your settings in the Graphics Designer.

5.6.4.7 How to operate the example on AlarmControl

Prerequisite
● You have saved the configured picture in the Graphics Designer.

● You have entered the configured picture as the start screen in the "Computer properties" 
dialog on the "Graphics Runtime" tab.

● You have activated "Graphics Runtime", "Alarm Logging Runtime" and "Global Script 
Runtime" applications in the startup list of WinCC Explorer using the "Computer properties" 
dialog.
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Activating and deactivating Runtime
1. Activate runtime by clicking the relevant button in the toolbar or selecting the relevant menu 

option in WinCC Explorer.

2. Click on the three buttons with the left mouse button. The respective messages are 
incoming and are displayed.

3. Click on the "Tank 1" button with the right mouse button for example. The message is 
outgoing. The message status changes, indicated by the changed color.

4. After you have tested other control capabilities, e.g. locking messages, deactivate runtime. 
You can deactivate Runtime using the toolbar or the menu bar of WinCC Explorer.

Locking and enabling messages
1. In the message list, select the message line containing the message to be locked, for 

example, "Tank1".

2.
Click on the  button. The message is removed from the message list.

3.
If you click the button , you will see the locked message in the lock list.

4.
You can unlock the selected message in the lock list again by clicking button . The 
message will be removed from the lock list.

Acknowledging a message using the acknowledgment button
1. Mark one of the messages that has the "Activated" state, e.g. the message "Tank 3 empty".

2. Now click on the dynamic acknowledgment button. The message is acknowledged. The 
message status changes, indicated by the changed color.
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5.7 Before WinCC V7: Display of Messages during Runtime

5.7 Resources

5.7.1 WinCC Alarm Control

Introduction
WinCC Alarm Control is used as a message window for displaying message events. 

Lists in the Message Window
You have the option to view six different lists in the message window:

● Message list showing the currently pending messages.

● Short-term archive list showing archived messages. The display is updated immediately 
when new incoming messages occur.

● Long-term archive list showing archived messages.

● Lock list showing the currently locked messages.

● Hit list showing statistics.

● List of hidden messages to show messages that have been archived but are not displayed.
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Note

A message is shown with a crossed-out date and time stamp in the message list when any 
of the following occur:
● A locked message is unlocked.
● A message is reloaded after a power failure. This applies only to chronological messaging.
● The AS is restarted. This applies only to chronological messaging.

See also
Configuration of the WinCC Alarm Control (Page 1071)

How to Configure Single Messages (Page 1075)

5.7.2 Configuration of the Alarm Control

5.7.2.1 Configuration of the WinCC Alarm Control

Introduction
Using an example, you will see how to display messages during runtime WinCC Alarm Control. 

Requirement
● You have created a message system with the "Alarm Logging" editor.

General Procedure
In Alarm Logging

1. Configure the required message blocks, message classes and message types according 
to your requirements.

2. Configure the single messages and group messages that you require.

In Graphics Designer

1. Link the WinCC Alarm Control to a Graphics Designer picture and change the properties 
of the Control.

2. In order to reproduce the message window settings for the example, you must configure 
buttons for setting and resetting the message tags in the Graphics Designer.

Note

Standard functions can be used to control the message window. If you do not want to use 
the toolbar functions to operate the message window, you can make any of the Graphics 
Designer objects dynamic using the appropriate functions.
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See also
Standard Functions for Operation of WinCC Alarm Control (Page 1106)

How to Configure the Alarm Control in the Graphics Designer (Page 1077)

How to Configure Single Messages (Page 1075)

How to Configure the Message System (Page 1072)

Configuring the Message System (Page 903)

5.7.2.2 How to Configure the Message System

Introduction
If you have created a message system in Alarm Logging, you configure the message system 
in Alarm Logging according to your requirements.

The following settings are configured for the Alarm Control example::

● Number of displayable characters in the "Message Text" user text block

● Acknowledgement theory for message class "Error".

● Color assignment for the message statuses of message types "Alarm" and "Warning"
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Requirement
● The "Alarm Logging" editor is open.

Procedure
1. Select "Properties" in the shortcut menu of the "Message Text" user text block, and change 

the length of the message block.

2. Select "Properties" in the shortcut menu of the "Error" message class, and select the 
"Acknowledgement Came In" check box on the "Acknowledgement" tab.
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3. Select the "Properties" command in the shortcut menus of message type "Alarm" or 
"Warning," respectively, and select the text color and background color for the message 
statuses.

4. Save the settings in Alarm Logging.
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See also
How to Configure the Alarm Control in the Graphics Designer (Page 1077)

How to Configure Single Messages (Page 1075)

Configuring the Message System (Page 903)

5.7.2.3 How to Configure Single Messages

Introduction
In the example, four message are displayed during runtime. You configure these message in 
Alarm Logging with the following settings:

No. Class Type Message tag Message text Location of 
fault

1 Fault Alarm Tank1 Tank 1 empty Tank 1
2 Fault Alarm Tank2 Tank 2 empty Tank 2 
3 Fault Alarm Tank3 Tank 3 empty Tank 3 
4 Fault Warning Motor Motor on  

Requirement
● Configure the four "Binary"-type tags "Tank1", "Tank2", "Tank3" and "Motor" in the Tag 

Management.

● The "Alarm Logging" editor is open.

Procedure
1. In the Alarm Logging table window, add a new line for each message using the shortcut 

menu.

2. Select "Properties" in the shortcut menu of the created message.
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3. On the "Parameters" tab of the "Single Message" dialog, select the class and type indicated 
above and connect the message to the respective message tag.

4. On the "Text" tab of the "Single Message" dialog, enter the text indicated above for 
"Message Text" and "Point of Error".

5. Likewise, configure three additional messages with "Tank2", "Tank3" and "Motor".

6. Save the settings in Alarm Logging.

Note

You can create the tags used as message tags either in the Tag Management of WinCC 
Explorer or directly by selecting the message tag on the "Parameters" tab of Alarm Logging.

See also
How to Configure the Message System (Page 1072)

Configuring the Message System (Page 903)
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5.7.2.4 How to Configure the Alarm Control in the Graphics Designer

Introduction
During runtime, the message events are displayed in an ActiveX Control, which is inserted 
and configured in a picture in the Graphics Designer.

The following settings are configured for the example project:

● Keyboard functions in the toolbar

● Selection in the message window

● Selection and order of the message blocks that are displayed in the message window

Procedure
1. Start Graphics Designer and open a new picture.

2. In the object palette on the "Controls" tab, double-click "WinCC Alarm Control".

3. The Control is inserted into the picture. Click the Control at the drag point and drag it to the 
desired size.
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4. Double-click the Control to open the "WinCC Alarm Control Properties" dialog. Enter a name 
for the window in the "Window Header" box and select the "Window Header" check box in 
order to display the window name during runtime.
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5. On the "Toolbar" tab, select the "Display Toolbar" check box. Select the keyboard functions 
you require. For the examples, you need the following keyboard functions: "Message List", 
"Lock List", "Selection Dialog", "Lock Dialog", "Emergency Acknowledgement", "Lock/
Unlock Message" and "Sort Dialog".
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6. In the "Selection" group of the "Parameters" tab, select the "Line" option.
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7. On the "Message Blocks" tab, select the "Time" system block and the two user text blocks 
"Message Text" and "Point of Error".
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8. On the "Message Lists" tab, specify the message blocks and the order in which they are to 
be displayed in the message window. Using the arrow keys, move the selected message 
blocks from the list of "Existing Message Blocks" to the list of "Selected Message Blocks". 

Change the order by selecting a message block and clicking  or .

9. Click "OK" to close the dialog, and save your settings in the Graphics Designer.

See also
How to Configure Buttons for Changing Message Tags (Page 1083)

Configuration of the WinCC Alarm Control (Page 1071)
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5.7.2.5 How to Configure Buttons for Changing Message Tags

Introduction
You have configured four single messages in Alarm Logging. In order to reproduce the example 
for the Alarm Control, you configure four buttons in the Graphics Designer that you use during 
runtime to set and reset the binary message tags of the individual messages. The message 
window shows the message statuses with the configured colors.

Procedure
1. In the object palette of the Graphics Designer, select the "Standard" tab and click the 

"Button" object in the "Windows Object" group. Position the cursor on the image at the spot 
where you want to insert the button, and enter the text "Tank1".

2. Select "Properties" in the shortcut menu.

3. Make the "Left-click" event dynamic by establishing a direct link between the constant "1" 
and the tag "Tank1".

4. Make the "Right-click" event dynamic by establishing a direct link between the constant "0" 
and the tag "Tank1".

5. Likewise, configure three additional buttons with "Tank2", "Tank3" and "Motor".

6. Save your settings in the Graphics Designer.
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See also
How to Configure the Alarm Control in the Graphics Designer (Page 1077)

Configuration of the WinCC Alarm Control (Page 1071)

5.7.2.6 How to Configure a Hit List of Messages

Introduction
The hit list displays statistics for the archived messages in the message window. In addition 
to statistics, a limited selection of configured message blocks can also be displayed in the hit 
list. In the case of variable contents, the message blocks display the data for the last incoming 
message. 

You assemble the columns of the hit list yourself, which consist of the message blocks and 
the statistics.

The following statistical calculations are available fro messages:

● Frequency of a message. The frequency is only increased, if a message with status "Came 
In" is included in the archive. If the frequency of a message number in the selected message 
range is "0", no entry is made in the statistics for this message number.

● The cumulative duration of a message number in seconds for status "Came In/Came In"(+/
+),"Came In/Went Out"(+/-), the status "Came In/Initial Acknowledgment"(+/*1) or the status 
"Came In/Second Acknowledgement"(+/*2).

● The average duration of a message number in seconds for status "Came In/Came In"(+/
+),"Came In/Went Out"(+/-), the status "Came In/Initial Acknowledgment"(+/*1) or the status 
"Came In/Second Acknowledgement"(+/*2).

Only the acknowledgement statuses "Acknowledgement", "System Acknowledgement" and 
"Emergency Acknowledgement" are taken into account in the statistical calculation of the 
acknowledgement times.

Note

Messages with the statuses "Acknowledgement", "System acknowledgement", "Emergency 
Acknowledgement" and "Went Out" are only taken into account in the statistical calculation 
if the event set available for the statistical calculation includes a relevant, earlier-occurring 
message with "Came In" status.         
         
If only one acknowledgement occurs for a message with single or double acknowledgement, 
the acknowledgement time is taken into account for the calculation of the cumulative duration 
and the average duration of the two statuses "Came In/Initial Acknowledgement" and "Came 
In/Second Acknowledgement".         
         
If runtime has been deactivated and reactivated several times and a message is pending 
during this time, for example, due to the external bit message procedure or chronological 
messaging, the message will be entered multiple times in the archive with status "Came In", 
so that it is also counted several times in the calculation.
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Requirement
● You have opened the Graphics Designer is opened and linked an Alarm Control.

● You have selected the message blocks you want to incorporate in the hit list on the 
"Message Blocks" tab.

● You have specified the properties of the message blocks that you want to incorporate in 
the hit list.

● You have activated the keyboard function "Hit List" on the "Toolbar" tab of the Alarm Control.
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Procedure
1. Double-click the Control. Select the "Hit List" tab.

2.
Select the columns you want to display in the hit list. To do so, click . The "Add 
Columns" dialog opens.
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The dialog contains all statistical calculations that are available, as well as a limited number 
of configured message blocks. You add the columns to the hit list by making one or more 
selections and clicking "OK". If you want to remove columns from the hit list, select the 

relevant columns in the "Hit List Columns" list and click .

3. You can change the order in which the columns are displayed in the hit list by selecting the 

column and clicking  or  to move it within the list.

4. Configure the column properties for the statistics data columns. You can rename the 
column, change the alignment and the format of the values in the column, and adjust the 
width of the column.

5. Columns can be named in two ways: If you are assigning a column name that is identical 
every runtime language, enter a name in the edit box. If you want to use multiple languages, 

use a text entry in the test library. Click  to select an existing text ID from the text library.
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6. If you want to configure the format of the column, select the "User Defined" check box. 

Enter the desired format specification in the edit box or click . If you have selected the 
column for "Frequency" or a summation, the "Integer Formatting Help" dialog opens. For 
formatting the averaging calculation, the "Formatting Help Floating-Point Number" dialog 
opens.

Specify the format settings. The preview shows the effect of your column format settings. 
In the Format Specification box, you can enter additional text in front of and behind the 
formatting specification. Click  to confirm your entry. Click "OK" to confirm the format 
specification.

7. Using the "Selection" button, specify the criteria to be used for displaying messages in the 
hit list, such as a specific message class or a specific time range. If no time range is 
specified, all times are taken into account in calculating average values. Note that a long-
range selection can adversely affect performance. Alternatively, you can specify the 
selection criteria for the hit list during runtime.

8. Using the "Sort..." button, specify the criteria to be used for sorting the columns in the hit 
list, for example, first descending by date and then ascending by message number. 
Alternatively, you can define the sort criteria for the hit list during runtime using the Sort 
dialog or "Sort by Column Header" function.
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9. Using the "Settings..." button, specify limitations regarding the number of messages and 
the time range to be taken into account in the statistical calculations for the hit list. This 
enables you to avoid adverse impacts on performance.

If no time range is specified in the selection dialog, you can select the relevant check box 
and enter a time factor and a time type to be used to generate the statistics. If the check 
box is not selected, the time factor is set to "0" and no time filter is applied.
In the "Quantity Limitation" field, specify the maximum number of data records from the 
message archive that are to be used to generate the hit list.         
Example: You have specified the "Message Class Alarm High" filter in the selection dialog. 
For the compilation of the hit list, all alarm messages that meet this criteria are retrieved 
from the message server. From this group, the number of data records that is taken into 
account in the statistics is limited to the amount you specified in the quantity limitation.
 When the maximum number of records is reached, a warning can be issued.

10.Click "OK" or "Apply" to confirm the settings for the hit list. The hit list is now compiled. You 
can access the hit list during runtime by clicking  in the toolbar.

If no sort criteria are specified, the values in the hit list are sorted in descending order of 
frequency.

New incoming messages are not automatically included in the hit list. To include them, you 
must reselect the hit list.

See also
How to Configure the Alarm Control in the Graphics Designer (Page 1077)

Configuration of the WinCC Alarm Control (Page 1071)
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5.7.2.7 How to Activate the Example for Alarm Control

Requirement
Prior to activating the example for the WinCC Alarm Control, you must

● Activate "Graphics Runtime" and "Alarm Logging Runtime" in the startup list of WinCC 
Explorer using the "Computer Properties" dialog

● Save the picture you configured in the Graphics Designer and enter it as the startup picture 
on the "Graphics Runtime" tab of the "Computer Properties" dialog.

Procedure
1. Activate runtime by clicking the relevant button in the toolbar or selecting the relevant menu 

option in WinCC Explorer.

2. Click the four buttons. The corresponding messages are displayed. If you now right-click 
the "Tank 2" button, the message status changes as indicated by the color assignment.

3. Deactivate runtime by clicking the relevant button in the toolbar or selecting the relevant 
menu option in WinCC Explorer.
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5.7.3 Operation during runtime

5.7.3.1 Operation of Alarm Control during Runtime

Introduction
The buttons on the toolbar are used to operate the message window during runtime. If you do 
not want to use the toolbar to operate the message window, you can use the functions available 
in the "Standard Functions/Alarm" group of the "Global Script" editor.

"Message list"
Shows the currently pending messages.
"Short-term archive list"
Shows the archived messages in the short-term archive list.
"Long-term archive list"
Shows the archived messages in the long-term archive list
"Lock List"
Shows all messages blocked in the system.
"Hit List"
Displays the message blocks and the static information that you have configured on the 
hit list tab of alarm control.
"Ackn. Central Signaling Devices"
Acknowledges a visual or audio messenger
"Single acknowledgment"
Acknowledges a selected single message
"Group acknowledgement"
Acknowledges all pending visible messages in the message window that require 
acknowledgement, unless they require single acknowledgment
"Autoscroll"
If "Autoscroll" has been activated, the latest modified message is selected in the message 
window. The visible range of the message window is moved, if necessary.
If "Autoscroll" is not activated, a new message that appears is not selected. The visible 
range of the message window is not modified.
Message rows can be selected in a targeted manner only if "Autoscroll" is activated.
"Selection dialog"
Specifies the selection criteria for the messages to be displayed in the message window. 
The messages that meet these criteria are not displayed but are nevertheless archived.
"Display options dialog"
Defines which messages are to be displayed in the message window. 
If the "Display all messages" option has been activated, the message windows shows the 
hidden as well as displayed messages.
If the "Display shown messages only" option is activated, only shown messages are 
displayed in the message window.
If the "Display hidden messages only" option is activated, only hidden messages are 
displayed in the message window.
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"Lock dialog"
Defines the blocking criteria. All messages that meet these criteria are neither displayed 
nor archived.
"Print message report"
Function for generating documentation containing a user-defined selection of messages
"Print current view"
Starts the printout of the messages displayed in the message window. Print job used during 
printing can be specified in the control properties on the "General" tab.          
In the Parameter dialog of the layouts linked to the print order, select the list of messages 
you want to print.
"Emergency acknowledgement"
Emergency acknowledgement of a message requiring acknowledgement. This function is 
used to send the acknowledgment signal of a selected single message directly the the 
AS, even when the message is not queued.         
The acknowledgment of unqueued messages only relates to messages configured in 
correct chronological order.
"First message"
The first of the currently pending messages is selected. The visible range of the message 
window is moved, if necessary. The button is only available if "Auto scrolling" is deactivated.
"Last message"
The last of the currently pending messages is selected. The visible range of the message 
window is moved, if necessary. The button is only available if "Auto scrolling" is deactivated.
"Next message"
The next message (relative to the currently selected one) is selected. The visible range 
of the message window is moved, if necessary. The button is only available if "Auto 
scrolling" is deactivated.
"Previous message"
The previous message (relative to the currently selected one) is selected. The visible range 
of the message window is moved, if necessary. The button is only available if "Auto 
scrolling" is deactivated.
"Info text dialog"
Opens a dialog where you can display info texts
"Comments dialog"
Opens a text editor where you can enter comments
This button is only available in the long-term archive window. The configuration of this 
function therefore has an effect on the alarm control properties only for this window type.
"Loop in alarm"
Shows a picture related to the selected message, or triggers a script. 
The function can also be started by double-clicking a message.
"Enable message"
Click this button to unlock a message selected in the lock list.
"Lock message"
A selected message is locked in the current message list and in the message archive list.
"Sort dialog"
Opens a dialog for setting user-defined sort criteria for the displayed messages. 
User-defined sort criteria override the sort criteria resulting from the "MsgCtrlFlags" 
attribute.
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"Time base dialog"
Opens a dialog for setting the time base for the time data displayed in the messages.
"List of hidden messages"
The list of hidden messages shows all messages that are not visible due to automatic or 
manual hide in the message list, in the short-term archive list or the long-term archive list.
"Hide messages"
Hides the message you have selected in the message list, short-term archive list or long-
term archive list. The message is entered in the list of hidden messages.
'Unhide messages"
Shows again the message you have selected in the "List of hidden messages" in the 
message list, short-term archive list or long-term archive list. The message is removed 
from the list of hidden messages.

Possible elements of the status bar

Icon Description

Date System date
Time of day System time
List: Number of current messages in the message list.
Window: Number of messages in the window
Ackn: Number of pending messages requiring acknowledgement

Selection has been made.

Filter criterion is effective, i.e. the "Display all messages" or "Display hidden 
messages only" option is currently active.
Lock is set.

There are hidden messages pending.

See also
Standard Functions for Operation of WinCC Alarm Control (Page 1106)

Configuration of the WinCC Alarm Control (Page 1071)

5.7.3.2 How to Select Messages

Introduction       
You can use selection criteria during runtime to define which messages you want to display 
in the message window. In the example below, only messages that contain message text 
"Motor on" are displayed.
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Requirements
● You have configured the relevant keyboard functions on the "Toolbar" tab of the Alarm 

Control.

Procedure
1. Click the "Selection Dialog" button during runtime. The "Selection" dialog opens.

2. Double-click the "Text Blocks" folder in the tree structure, and click "Message Text". In the 
right pane, select the "Search Text" check box and double-click the "Search Text" selection.
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3. The "Text Input" dialog opens. Enter the search text "Tank 1" and click "OK" to confirm.

4. Click "OK" to close the "Specify Selection" dialog. The message window now shows only 
the selected messages.

Notes on defining the dialog
For certain message blocks, such as the date and time-of-day system blocks, you specify the 
start and end times or a search text in the dialog. The entry must conform to the format required 
in the dialog. 

In the "Specify Selection" dialog, you can make the following settings:

Array Description

Text selection if 
exact match

If the "Text selection if exact match" check box is not selected, all text blocks 
containing the search string are selected.
If the "Text selection if exact match" check box is selected, all text blocks correspond 
exactly to the search string are selected.

Persistence in 
RT

If the "Persistent in RT" check box is selected, changes in the search criteria are 
retained even after a picture change.

Persistence in 
CS and RT

If the "Persistent in RT and CS" check box is selected, the modified settings are also 
applied to the configuration system. To do this, you must open the picture in Graphics 
Designer and save it once again. The changed settings are also used when the 
project is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS 
with PCS 7 projects or TIA projects. When you completely load the ES to the OS, 
the changed settings on the OS will be overwritten.         
Configure the properties of the controls on the ES.

Delete selection Click this button to delete all configured selection criteria.
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Note

It is not possible to enter text as a selection criterion for a process value. If you want to select 
based on the text of a process value block or the displayed process tags, proceed as follows:

1) Insert this process value as a message text of a user text block in a message.

2) During runtime, select the messages based on the text in the "Message Text" text block.

In multi-user systems, you must ensure that contents displayed in the selection dialog on a 
client are named identically on all servers.

To select based on the time of day, start and stop values are not automatically adjusted when 
the time base of the Alarm Control is changed. For example, a computer located in time zone 
"UTC + 1h" has the "Local Time Zone" time base specified in the Control. A selection criterion 
based on the time of day 10:00 a.m. to 11:00 a.m. is then applied. If the time base of the 
Control is now switched to "UTC" and you want to display the same messages in the Control 
as before, the start and stop values of the selection must be changed to 9:00 a.m. and 10:00 
a.m., respectively.

See also
Operation of Alarm Control during Runtime (Page 1091)

Configuration of the WinCC Alarm Control (Page 1071)

5.7.3.3 How to Lock and Unlock Messages

Introduction
Locked messages are not shown on the display and not archived. You can set a lock for the 
following:

● Single messages

● Single messages with multiple instances. The selected instance of the message will be 
locked.

● Message types

● Alarm classes

● Group messages

Persistence in Locking of Messages
● The locking of single messages is not persistent. Locked single messages are automatically 

unlocked when WinCC Runtime restarts. Exception: messages that are locked directly in 
the AS by means of data blocks (locking at source).

● The locking of message classes and message types remains in force even after a restart 
of WinCC Runtime.
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Requirement
● You have configured the relevant keyboard functions on the "Toolbar" tab of the Alarm 

Control.

Locking and Unlocking Selected Messages using Keyboard Function "Lock/Unlock Message"
1. In the message list, select the message line containing the message to be locked, for 

example, "Tank1".

2. Click the "Lock/Unlock Message" button . The message is removed from the message 
list.

3. If you click the "Lock List" button , you will see the locked message. You can unlock 

the selected message again by clicking the "Lock/Unlock Message" button . The 
message will be removed from the lock list.

Note

If a user is authorized to lock and unlock messages, this user must have both authorizations 
in the User Administrator, and these authorizations must be configured directly one below 
the other. This is necessary, since the unlock authorization for locked messages automatically 
uses the authorization level defined in the authorization for "Lock Messages" in the User 
Administration.

 

Note

Locking/unlocking of a single message of an Alarm_8(P) using S7PMC always results in the 
locking/unlocking of all 8 single messages of this block.

Locking and Unlocking of Single Messages Using the Message Number
1. Click the "Lock Dialog" button . The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local computer in the case of a single-user 
projects.
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3. Click the "Add" button. In the subsequent dialog, enter the message number that you want 
to lock.

4. You can lock several messages simultaneously. To do this, enter the message numbers 
separated by commas. To select the a range of message numbers, enter a range in the 
form "5-10". Only uninterrupted message ranges are locked. If there are gaps in the 
specified range, the message "Invalid Range" is returned.

5. To unlock a locked message, select the messages in the list of locked messages and click 
the "Delete" button.

Note

You can lock and unlock a maximum of 50 messages simultaneously.

Locking and Unlocking of Messages Using the Message Class, Message Type or User-Defined Group 
Message

1. Click the "Lock Dialog" button . The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local computer in the case of a single-user 
projects.
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3. In the tree structure, select a message class, message type or user-defined group message 
that you want to lock. Click the "Lock" button. All message of the specified message class, 
 message type or user-defined group message are locked.

4. To unlock the locked messages, select the relevant message class, message type or user-
defined group message and click the "Unlock" button.

Note

The server list contains only those server projects whose "Packages" are loaded on the 
computer containing the project where you are configuring the Control.

Operator Input Message upon Locking a Message
In the Alarm Control, you can specify whether an operator input message is generated when 
a message is locked or unlocked. You can configure the operator input message yourself. It 
contains the following information, by default: 

● Time stamp

● Logged-on user

● Name of the computer in the message archive of the relevant alarm server

The time stamp for the message comes from the following:

● The message source (e.g., AS), in the case of active locking

● The alarm server (OS), in the case of passive locking

Actively locked messages are visible and operable on all WinCC servers and clients.
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Procedure
1. On the "Message Lists" tab in the properties dialog for the Alarm Control, click the "Operator 

Input Messages..." button.

2. In the "Operator Input Messages" dialog, select the relevant check boxes if an operator 
input message is to be triggered when messages are locked or unlocked.

3. If you want to configure the content of the operator input message yourself, click .
In the configuration dialog, enter the number of a message that you have configured 
previously in Alarm Logging. You assign the message blocks of the locked message to the 
process value blocks of the operator input message. These message blocks must be 
selected on the "Message Blocks" tab. Click "OK" to confirm your settings.

Note

Operator input messages can only be archived if system messages are set up in the message 
archive.

See also
Operation of Alarm Control during Runtime (Page 1091)

Configuration of the WinCC Alarm Control (Page 1071)

5.7.3.4 How to Hide and Show Messages

Introduction
Manual hiding of messages puts lesser information load on the user of the system. You as 
user can concentrate better on the messages only if lesser important messages are not shown.

Properties of Hidden Messages
Hidden messages are:

● In the message list, short-term archive list and long-term archive list, you can select whether 
the hidden messages are to be displayed. The display depends on the activated option in 
the "Display Options" dialog.

● They are included in the list of hidden messages and displayed there.

● They are archived.

● They do not trigger the alarm in Basic Process Control.

● You can again show messages that are hidden manually or automatically.

● In manual hide, they are displayed again after a certain defined period.

● Manual hiding forces you to acknowledge messages that need acknowledgement and 
triggers an operator input message.
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● Automatic hiding does not force you to acknowledge and therefore it also does not trigger 
an operator input message.

● In the period when messages requiring confirmation are hidden, the system acknowledges 
the outgoing messages. If a message does not have the "gone" status, the system 
acknowledges it immediately.

Hide process 
During manual hide, you as user will decide whether to hide a message by using a button in 
the message window. You can show the message again using a button or the system will show 
the message after a configurable period. Operator input messages can be triggered in Manual 
Hide.

Configuring Message Hiding in Alarm Logging
You can configure automatic hide and the duration for manual hide in Alarm Logging. The 
configuration process is described in the chapter "How to Configure th Hiding of Messages". 

Requirement
● You have configured the key functions "Hide/Show Message" and "List of Hidden 

Messages" in the "Toolbar" tab in WinCC Alarm Control.

● Runtime has been activated and the WinCC Alarm Control is displayed.

Procedure
1. Select the message you want to hide in the message list, short-term archive list or long-

term archive list.

2. Click the "Hide/Show message"  button. The message is no longer displayed in the list 
and is added to the list of hidden messages.

3. Click the "List of Hidden Messages" button to display the hidden messages.

4. To show these messages again, display the "List of Hidden Messages". Select a message 

and click the "Hide/Show Message"  button. The message is removed from the "List 
of Hidden Messages" and displayed back in the original list.

5. If you do not take any action to show the hidden messages, the configured duration will 
decide when the system has to display back a message and remove it from the "List of 
Hidden Messages".
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Runtime Behavior in Mnaual and Automatic Hiding of Messages
Using the manual and automatic hide functions during runtime has an effect on both the hide 
types:

● If the message is hidden automatically, you can display it again by clicking "Hide/Show 
Message".

● You have manually hidden the message using the "Hide/Show Message" button. The 
message is shown again when the hide tag reaches the state for automatic display. The 
period for manual hide should not have elapsed.

● You have manually hidden the message using the "Hide/Show Message" button. Further, 
the message has the status of the hide tag for automatic hiding. If the period for manual 
hide has expired, this message remains hidden.

See also
How to Configure the Hiding of Messages (Page 945)

5.7.3.5 How to Perform an Emergency Acknowledgement

Introduction
In exceptional cases, a message can be acknowledged on the basis of its message number. 
In this case, the acknowledgement signal is sent to the AS even if the message is currently 
not pending. Acknowledging messages that are not pending only refers to messages that are 
configured in chronological order.

For this reason, the function should only be used in extreme emergency situations. 
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Requirements
● You have configured the keyboard function "Emergency Acknowledgement" on the 

"Toolbar" tab of the Alarm Control.

Procedure
1. Click the "Emergency Acknowledgement" button . The "Emergency Acknowledgement 

for Messages" dialog opens.

2. Select a server. In the "Message Number" box, enter the number of the message to be 
acknowledged. Click the "Request" button. In the message window, the message now 
appears in the color that you specified for an acknowledged message.

Note

In the dialog for the selection of the servers, only server projects are shown whose "Package" 
is loaded onto the computer.

See also
Operation of Alarm Control during Runtime (Page 1091)

Configuration of the WinCC Alarm Control (Page 1071)
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5.7.3.6 How to Sort the Display of Messages

Introduction
During runtime, you can sort the messages in the message window on the basis of message 
blocks. You sort the message blocks either via the "Sort Dialog" keyboard function or directly 
via the column headers of the message blocks.

Examples for sorting messages: 

● Display of messages in descending order by date, time and message number The most 
recent message is displayed at the top.

● Display of messages according to priority. To apply this sorting method, you must have 
specified the priorities of messages in Alarm Logging and configured the "Priority" message 
block in the Alarm Control. As a result, in a single-line message view, only the top-priority 
message appears in the message window. A message with a lower priority is not displayed, 
even if it is more recent. Normally, the messages are shown in chronological order.

● Display of messages in ascending or descending order based on various message blocks, 
allowing for user-defined sorting during runtime.

● The "Status" message block is sorted according to the status type and not according to the 
configured status texts. If sorting is in ascending order, the messages are sorted in the 
following order: Came In, Went Out, Acknowledged, Locked, Unlocked, System 
Acknowledgement, Emergency Acknowledgement, Came In/Went Out.

Note

You can also specify the sort criteria during configuration in the Alarm Control by clicking 
the "Sorting..." button on the "Message Lists" tab. You configure the sort criteria for the 
hit list on the "Hit List" tab.
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Sorting Using the Sort Dialog

Requirement
● You have configured the "Sort Dialog" keyboard function on the "Toolbar" tab of the Alarm 

Control.

Procedure
1. Click the "Sort Dialog" button .

2. In the "Sort By" field, select the message block by which to sort first. Select the relevant 
check box to specify sorting in ascending or descending order. If you want to sort by more 
than one message block, select the other message blocks in the desired order in the "Then 
By" lists.

Sorting Using the Column Headers of Message Blocks
When sorting using the column header, you can specify the sort order for more than four 
message blocks. An arrow and a number are shown in the column header (right-justified). The 
arrow indicates the sort direction, i.e. ascending or descending. The number beside the arrow 
indicates the sort order of the message blocks.

Requirement
● You have selected the "Sort by Column Header" check box on the "Parameters" tab of the 

Alarm Control.

● You have deactivated the "Autoscroll" keyboard function.
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Procedure
1. Click the column header of the message block you want to sort by first. The number "1" is 

displayed, and the arrow points upwards for ascending sort order.

2. If you want to sort in descending order, click the column header again.

3. If you want to clear the sorting of the message block, click the column header a third time.

4. If you want to sort on the basis of several message blocks, click the header columns of the 
respective message blocks in the desired sequence.

Note

Sorting is not affected by events or changes in the message block configuration. If you have 
defined a message block as a sort criterion in the sort dialog and you subsequently delete 
this block from the message line, the specified sort order remains in place. In the sort dialog, 
a blank field is displayed instead of the deleted message block. If you have not specified 
another sort order and the deleted message block is included again in the message block 
configuration of the Control, the messages are again shown in the original sort order.

See also
Operation of Alarm Control during Runtime (Page 1091)

Configuration of the WinCC Alarm Control (Page 1071)

5.7.3.7 Standard Functions for Operation of WinCC Alarm Control

Introduction
If you do not want to use the toolbar to operate the message window, you can use the functions 
available in the "Standard Functions/Alarm" group of the "Global Script" editor.

Function Description

AXC_OnBtnAlarmHidingList Function used to switch the message window to show the list of hidden 
messages.

AXC_OnBtnArcLong This function is used to switch the message window to show the 
messages in the long-term archive list.

AXC_OnBtnArcShort This function is used to switch the message window to show the 
messages in the short-term archive list.

AXC_OnBtnComment This function opens the dialog for entry of a message comment.
AXC_OnBtnEmergAckn This function is used for an emergency acknowledgement of a 

message.
AXC_OnBtnHideUnhideMsg The function hides the selected message or displays again the hidden 

message.
AXC_OnBtnHit This function is used to switch the message window to show the 

messages in the hit list.
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Function Description

AXC_OnBtnHornAckn This function can be used to acknowledge a central signaling device 
assigned to the selected message.

AXC_OnBtnInfo This function opens an information window showing the stored 
information text.

AXC_OnBtnLoop You can use this function to change the picture to the configured loop-
in alarm picture of the selected message.

AXC_OnBtnMsgFirst This function selects the first message and shifts the visible range in 
the message window, if necessary.

AXC_OnBtnMsgLast This function selects the last message and shifts the visible range in 
the message window, if necessary.

AXC_OnBtnMsgNext This function selects the next message and shifts the visible range in 
the message window, if necessary.

AXC_OnBtnMsgPrev This function selects the previous message and shifts the visible range 
in the message window, if necessary.

AXC_OnBtnMsgWin This function is used to switch the message window to show the 
messages in the message list.

AXC_OnBtnPrint Depending on the current display type (message list, short-term 
archive list, long-term archive list), this function is used to generate a 
printout of the currently pending or archived messages that meet the 
selection criteria. The print layout depends on the type of the message 
window.

AXC_OnBtnProtocol This function starts a printout of the current view of the Control. All 
messages meeting the selection criteria are printed.

AXC_OnBtnScroll This function can be used to change the Autoscroll behavior of the 
message window.

AXC_OnBtnSelect This function opens the selection dialog.
AXC_OnBtnSinglAckn This function is used for acknowledgement of a selected single 

message.
AXC_OnBtnSortDlg This function opens the dialog for creating a user-defined sort criteria 

for the displayed messages.
AXC_OnBtnTimeBase This function opens the dialog for setting the time base for the time 

data displayed in the messages.
AXC_OnBtnVisibleAckn This function is used for acknowledgement of all messages visible in 

the message window.
AXC_OnBtnLock This function opens the dialog where messages can be locked.
AXC_OnBtnLockWin This function activates the lock list view.
AXC_OnBtnLockUnlock This function locks the currently selected message in Alarm Control in 

the message list, short-term archive list and long-term archive list 
views.         
         
If the lock list view is selected, this function is used to unlock the 
currently selected message.

AXC_SetFilter This function can be used to define a filter for selection of messages 
to be displayed in the message window. The filter criteria must be 
defined within the action script.
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See also
Example of the Use of Standard Functions (Page 1108)

Operation of Alarm Control during Runtime (Page 1091)

Configuration of the WinCC Alarm Control (Page 1071)

5.7.3.8 Example of the Use of Standard Functions

Introduction
In order to operate the WinCC Alarm Control by means a function, you must configure the 
corresponding function. This is done by making objects dynamic with standard functions of 
Global Script in the Graphics Designer.

In principle, any object can be used to operate the Alarm Control. In order to achieve similarity 
with the toolbar of a message window, the following example will insert a graphic object for 
acknowledging a message.

Requirement
● You have configured the example project for Alarm Control.

● You have opened the picture containing the configured Alarm Control in the Graphics 
Designer.

Procedure
1. Determine the object name of the Alarm Control based on the object properties of the 

Control, for example, "OLE-Control1".

2. Insert a graphic object from the smart objects of the object palette into the picture. Use the 
mouse to resize the graphic object to the desired size. In the configuration dialog, select 
the picture to be displayed, for example,
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3. In order to make the graphic object dynamic, open the Properties dialog for the object via 
the shortcut menu of the graphic object. On the "Events" tab, select the "Mouse" object and 
use a C-Action to make the "Mouse Action" attribute dynamic.
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4. In order to enable a single acknowledgement of messages, you must select the 
"AXC_OnBtnSinglAckn" function from the "Alarm" standard functions group in the "Edit 
Action" window. To do so, double-click the function.

5. The "Set Parameters" window opens. Click "OK" to close the window without changes.
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6. In the "Edit Action" window, replace the string "lpszObjectName" with the object name of 
the Alarm Control. In the example, the string is replaced with "OLE-Control1". After 
successful creation of the action, click "OK" to close the window.

7. Save your settings in the Graphics Designer.

8. Start Runtime. Click the "Tank 1" button to generate a message. Now, click  

. The message is acknowledged, and the color of the message changes.

See also
How to Configure Buttons for Changing Message Tags (Page 1083)

Configuration of the WinCC Alarm Control (Page 1071)

Standard Functions for Operation of WinCC Alarm Control (Page 1106)
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5.7.4 SQL Statements for Filtering of Messages in Alarm Control

Introduction
In WinCC Alarm Control, only the SQL statements that can also be generated using the 
selection dialog of the message window are permitted. The following conditions apply to 
WinCC: 

● The structure consists of "Field", "Operand", and "Value", with the individual parameters 
separated by blanks. E.g.: DATETIME >= '2006-12-21 00:00:00' AND MSGNR >= 100 (all 
messages as of 21.12.2006 with a message number greater than and equal to 100)

● Character strings, date, and time must be passed in single quotation marks.

● In the DATETIME argument, the date and time of day are separated by a blank. Regardless 
of the time base setting in the object properties, the output of DATETIME is based on the 
time base Local Time. The exception to this is when "UTC" is set as the time base. In this 
case, output is based on the time base "UTC".

Permissible Arguments

Name SQL name Type Data Example:

Date/time DATETIME Date 'YYYY-MM-DD 
hh:mm:ss.msmsms'

DATETIME >= '2007-05-03 
16:00:00.000'
Outputs messages as of 03/05/2007, 
16:00 hours.

Number MSGNR Integer Alarm number MSGNR >= 10 AND MSGNR <= 12
Outputs the messages with message 
numbers 10 - 12.

Class/type CLASS IN 
AND TYPE 
IN

Integer - Message class ID 1-16 and 
system message classes 17 + 18
- Message type ID 1-256 and 
system message types 257, 258, 
273, 274

CLASS IN ( 1 ) AND TYPE IN ( 2 )
Outputs messages of message class 1, 
message type 2.

State STATE Integer Value "ALARM_STATE_xx"
Only the operands "=" and "IN(...)" 
are permitted.
ALARM_STATE_1         
ALARM_STATE_2         
ALARM_STATE_3         
ALARM_STATE_4         
ALARM_STATE_10         
ALARM_STATE_11         
ALARM_STATE_16         
ALARM_STATE_17

STATE IN(1,2,3)
Outputs all messages that came in, went 
out and were acknowledged.
Possible value:         
1 = incoming messages         
2 = outgoing messages         
3 = acknowledged messages         
4 = locked messages         
10 = hidden messages         
11 = shown messages         
16 = messages acknowledged by the 
system         
17 = Emergency-acknowledged 
messages

Priority PRIORITY Integer Message priority 0 - 16 PRIORITY >= 1 AND PRIORITY =< 5
Outputs messages that have a priority 
between 1 and 5.
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Name SQL name Type Data Example:

AS Number AGNR Integer AS Number AGNR >= 2 AND AGNR <= 2
Outputs messages with the AS number 
2.

CPU Number AGSUBNR Integer AG sub-number AGSUBNR >= 5 AND AGSUBNR <= 5
Outputs messages with AG sub-number 
5.

Instance INSTANCE Text Instance -
Block: 1         
...         
Block: 10

TEXTxx Text Search text for Text1 - Text10 TEXT2 = "Error"
Outputs the messages whose Text2 
corresponds with "Error".
TEXT2 IN ('Error','Fault')
Outputs the messages whose Text2 
corresponds with the text "Error" or 
"Fault".
TEXT2 LIKE 'Error'
Outputs the messages whose Text2 
includes the text "Error".

Process value: 
1         
...         
Process value: 
10

PVALUExx Double Search value for PVALUE1-
PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 50
Outputs process value 1 with start value 
0 and stop value 50.

Permissible Operands
● >= , <= , = , > , <

● IN(...) : Several values as an array, separated by commas, e.g.: CLASS IN( 1 ,2 ,3 ) AND 
TYPE IN( 1 ,2 ,19 ,20 ,37 ,38 )

● LIKE : Text must contain string, e.g.: TEXT1 LIKE 'Error' relays message where Text1 
contains the search text "Error". The operand LIKE is only permitted for Text arguments.

Illegal arguments and operands 
Only the arguments indicated in the table and operands from the list are permitted.

Grouping arguments, for example with brackets, is not permitted.
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Archiving Process Values 6
6 Resources

6.1 Archiving Process Values

Content
WinCC can be used to:

● Process and archive process values from a plant

● Output process values in pictures or in reports.

The "Tag Logging" editor provides you with a number of wizards for the configuration of 
archives. 

This chapter contains

● the basics of process value archiving

● configuration instructions of the process value archiving, and

● instructions for the output of process values.

6.2 Process Value Archiving in WinCC

Introduction
The archive system is used for the archiving of process values in Runtime. The archive system 
processes the process values cached in the Runtime database and writes them to the archive 
database. 

The following WinCC subsystems are involved in the process value archiving: 
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● Automation system (AS): saves the process values that are sent to WinCC via 
communication drivers.

● Data manager (DM): processes the process values and returns them to the archive system 
via process tags.

● Archive system: processes the acquired process values (e.g. forming the average value). 
The method of processing depends on the configuration of the archive.

● Runtime database (DB): saves the process values that are to be archived.

Term definitions
The question of whether and when process values are acquired and archived is dependent 
on a variety of parameters. The parameters to be configured for your project depend on the 
applied archiving method.

● Acquisition cycle: determines when the value of a process tag is read out in the automation 
system. You might configure an acquisition cycle, for example, for the continuous cyclic 
archiving of process values.

● Archiving cycle: determines when the processed process value is saved in the archive 
database. You might configure an archiving cycle, for example, for the continuous cyclic 
archiving of process values.

● Start event: starts process value archiving when a specified event occurs, for example when 
the plant is turned on. You might configure a start event, for example, for a selective cyclic 
archiving of process values.

● Stop event: terminates process value archiving when a specified event occurs, for example 
when the plant is turned off. You might configure a stop event, for example, for a selective 
cyclic archiving of process values.

● Event-controlled archiving: Process values are archived when a certain event occurs, for 
e.g. when marginal values are exceeded. You can configure event-controlled archiving in 
acyclic archiving of process values.

● Archiving process values during changes: Process values are archived only when they 
have been changed. You can configure the archiving in acyclic archiving of process values.

See also
Process Value Archiving for Multi-User Projects (Page 1118)

Configuration of Process Value Archiving (Page 1142)

Storing Process Values (Page 1136)

Archiving Methods (Page 1126)

Process Values and Tags (Page 1120)

Basics of Process Values Archiving (Page 1117)
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6.3 Basics of Process Values Archiving

6.3.1 Basics of Process Values Archiving

Introduction
The process value archiving serves for compiling, processing and archiving of process data 
from an industrial plant. The process data gained can be filtered according to important 
economic and technical criteria relating to the operating status of a plant.

Principle of Operation
The process values to be archived are compiled, processed and saved in the archive database 
in Runtime. Current or previously archived process values can be output in Runtime as a table 
or trend. In addition, it is possible to print out archived process values as a protocol. 

Configuration
The process value archiving is configured in Tag Logging. There, you can configure process 
value archives as well as compressed archives, define acquisition and archiving cycles and 
select the process values to be archived.

WinCC Controls are configured in Graphics Designer to display process data in runtime. The 
process data can be output in table or trend curve form. 

The protocol output of archived process data is configured as a protocol in Report Designer. 
The process value output in the protocol can be in table or trend curve form. 

Application
The process value archiving can be used for the following tasks:

● Early detection of danger and fault conditions

● Increase of productivity

● Increase of product quality

● Optimization of maintenance cycles

● Documentation of the progress of process values
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See also
Process Value Archiving in WinCC (Page 1115)

Output of Process Values (Page 1184)

Configuration of Process Value Archiving (Page 1142)

Storing Process Values (Page 1136)

Archiving Methods (Page 1126)

Process Values and Tags (Page 1120)

6.3.2 Process Value Archiving for Multi-User Projects

Introduction
In multi-user projects, process values can be archived by various servers.  The following client-
server scenarios illustrate possible configurations. 

Client/Server Scenarios

Scenario 1
Process value archiving runs on several servers (2). Clients (1) can access the process value 
archives on the available servers: 

Scenario 2 
Message and process value archiving runs on one server (3), together with process 
communication. All other servers (2) deal with process-oriented tasks (e.g. displaying pictures). 
Clients (1) can access all available servers: 
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Scenario 3 
A server (3) without a process driver connection deals solely with message and process value 
archiving. The server (3) collects the data from all other servers (2) through server-server 
communication and distributes it to the clients (1): 

See also
Process Value Archiving in WinCC (Page 1115)

Basics of Process Values Archiving (Page 1117)
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6.3.3 Process Values and Tags

6.3.3.1 Process Values and Tags

Principle
Process values are data stored in the memory of one of the connected automation systems. 
They represent the status of a plant, for example, temperatures, fill levels or states (e.g. motor 
off). To work with the process values, you define tags in WinCC. 

The link between WinCC and the automation systems is provided by process tags, which 
correspond to a certain process value in the memory of an automation system. The value of 
a process tag is obtained by reading out the process value from the memory of the automation 
system. On the other hand, a process value can also be written back to the memory of the 
automation system. 

See also
Archiving Methods (Page 1126)

Telegram Tags (Page 1121)

External and Internal Tags (Page 1120)

Basics of Process Values Archiving (Page 1117)

6.3.3.2 External and Internal Tags

Introduction
External tags in WinCC are used for acquiring process values and access a memory address 
in the connected automation system. External tags are therefore referred to as process tags. 
Internal tags do not have a process link and only carry values within WinCC. 

External and internal tags can be stored in archive tags in the process value archive. 
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Note

As the primary task of process value archiving is the archiving of external tag values, this 
documentation refers only to process tags.  

Archive Tags
Process values are stored in archive tags in the process value archive. The system 
distinguishes between the following types of archive tags:

● Analog archive tags store numerical process values, e.g. the fill level of a tank. 

● Binary archive tags store binary process values, e.g. whether a motor is switched on or off. 

● Process-controlled tags store process values that have been sent to the archive system as 
telegrams, e.g. process values in a series of measurements. 

Archived process values can be compressed. This compression is achieved through the 
application of mathematical functions (e.g. averaging). Compressed process values of this 
type are stored in compressed tags in a compressed archive. 

See also
Creating Archive Tags (Page 1150)

Configuring Archives (Page 1144)

Storing Process Values (Page 1136)

Compressed Archive (Page 1135)

Process-Controlled Process Value Archiving (Page 1134)

Telegram Tags (Page 1121)

Process Values and Tags (Page 1120)

Basics of Process Values Archiving (Page 1117)

6.3.3.3 Telegram Tags

Introduction
Telegramtags are needed for the acquisition of quickly changing process values, or if you want 
to combine several measuring points from one plant. 

Note

Telegram tags are of the "raw data type" in WinCC and are therefore also referred to a "raw 
data tags". 
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Principle
In the automation system the process values are written to a binary file, and are sent as a 
telegram to WinCC where they are stored in a raw data tag. 

Archiving of Telegrams
If you want the acquired process values belonging to a raw data tag to be archived, you need 
to configure a process-controlled tag in the process value archive. To enable the archive 
system to process the telegram in the process-controlled tag, select a format DLL. The format 
DLL is supplied with the automation system that you are using and dismantles the telegram 
(e.g. to ascertain the process values). The process values are then written to the archive 
database. 

A format DLL for the SIMATIC S7 is included as standard in the scope of delivery of WinCC. 

See also
Archiving Methods (Page 1126)

Storing Process Values (Page 1136)

Process-Controlled Process Value Archiving (Page 1134)

External and Internal Tags (Page 1120)

Process Values and Tags (Page 1120)

Process Value Archiving in WinCC (Page 1115)

Basics of Process Values Archiving (Page 1117)

6.3.3.4 Structure of a Telegram with Raw Data Tags

Introduction
A telegram for the transfer of raw data tags consists of two parts: a header and a body.
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Telegram header
The header contains general data, i.e. length of the telegram.  The high byte of data word 0 is 
not used by the system and might thus be assigned by the user as required.

Telegram body
In the block status word, the format of the measurement values and the format of the 
measurement areas, among other things, are defined. Bit 10 is reserved and will be used in 
future versions for switching daylight saving and standard times (daylight saving time = 1).

Time and date are structured in accordance with the definition of the sequential time indication. 

To transfer a measurement area, 8 data words are necessary. In these words, the upper and 
lower limits of the tag and the archive are specified.
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The following section contains a number of sample telegram types.

Type 1
Measured value of a process tag + date and time

Type 2
n measured values of a process tag + date and time of each measured value

Type 3
n measured values of a process tag with date and time, and sampling cycle
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Type 4
n measured values of various process tags with time and date

Type 5
n measured values of various process tags without time and date
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6.3.3.5 Diagnostic Tags of Tag Logging Runtime
Tag logging has some diagnostics tags which enable the current archiving rate of the system 
to be established.

Diagnostic tags are created as internal tags in the WinCC Explorer and are part of the 
"TagLoggingRT" tag group.

@TLGRT_TAGS_PER_SECOND
The tag specifies the average archiving rate of Tag Logging cyclically as an archive tag per 
second.

@TLGRT_AVARAGE_TAGS_PER_SECOND
The tag specifies the arithmetic average value of the average archiving rate of Tag Logging 
cyclically as an archive tag per second since Runtime as started.

@TLGRT_SIZEOF_NOTIFY_QUEUE
This tag contains the current number of entries in the ClientNotify queue. All local trend and 
table windows receive current data via this queue.

@TLGRT_SIZEOF_NLL_INPUT_QUEUE
This tag contains the current number of entries in the queue for the format DLL. This queue is 
used to store the values transmitted by raw data tags.

6.3.4 Archiving Methods

6.3.4.1 Archiving Methods

Introduction
You can use different archiving methods to archive process values. You can therefore e.g. 
monitor a single process value at any point in time and make the monitoring dependent on 
certain events. You can archive quickly changing process values without increasing the system 
load in doing so. You can compress process values already archived to reduce the data 
volume. 
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Archiving methods
The following archiving methods are available in Runtime: 

● Continuous cyclic process value archiving: continuous process value archiving (e.g. 
monitoring a process value).

● Cyclic-selective process value archiving: Event-controlled, continuous process value 
archiving, for example for monitoring a process value within a specific period of time.

● Acyclic process value archiving: event-controlled process value archiving (e.g. archiving a 
current process value when a critical limit value is exceeded).

● Archiving process values during changes: Process values are archived in a acylic manner 
only when they have been changed. 

● Process-controlled process value archiving: archiving of several process tags or of rapidly 
changing process values.

● Compressed archive: compression of individual archive tags or of entire process value 
archives (e.g. the hourly averaging of process values archived every minute).

See also
Compressed Archive (Page 1135)

Storing Process Values (Page 1136)

Process-Controlled Process Value Archiving (Page 1134)

Acyclic Process Value Archiving (Page 1133)

Cyclic-Selective Process Value Archiving (Page 1131)

Continuous cyclic process value archiving (Page 1129)

Cycles and Events (Page 1127)

Basics of Process Values Archiving (Page 1117)

6.3.4.2 Cycles and Events

Introduction
Process value archiving is controlled by cycles and events. The acquisition and archiving 
cycles enable continuous acquisition and archiving of process values. Furthermore, process 
value archiving can also be triggered or ended by events and actions. Cycles and events may 
be combined: A process value is for example acquired regularly; archiving is however only 
triggered by a binary event. 

Acquisition cycle
The acquisition cycle determines the interval at which the process value of a process tag is 
read. The shortest possible value is 500 ms. All other values are integer multiples of this value. 
The starting point of an acquisition cycle is determined by the run-up time of the WinCC 
Runtime.
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Note

A short acquisition cycle may lead to a high system load. Use telegram tags in case of frequent 
or fast process value changes. 

Archiving cycle
The archiving cycle determines when a process value is saved in the archive data bank. The 
archiving cycle is always an integer multiple of the acquisition cycle. The starting point of the 
archiving cycle depends on either the run-up time of WinCC Runtime or the starting point of 
the time used. 

Specification of a starting point allows for delay archiving and a more even distribution of the 
archiving load. Examples:

● Process values are archived in three cycles: every minute, every two minutes, and every 
three minutes. This causes a high archiving load every six minutes. Assign a different 
starting point to each of the three cycles. For example, archive every minute at the 15th 
second, every two minutes at the 30th second, and every three minutes at the 45th second. 
The archiving load is thus distributed.

● Many process values must be archived every ten seconds. In order to distribute the 
archiving load you can, for example, configure two "10 second" cycles with different starting 
points. Archiving is carried out at the 0th and the 5th second.

All process values read from the process tags during the time period between acquisition and 
archiving will be processed by the archiving function. In the process value archive, you can 
use only one of the following archiving functions:

● Current value: Saves the last acquired process value.

● Total: Saves the sum of all acquired process values.

● Maximum value: Saves the highest of all acquired process values.

● Minimum value: Saves the lowest of all acquired process values.

● Average value: Saves the mean of all acquired process values.

● Action: The most recently acquired process value is calculated, using a function created in 
Global Script.

Note

If the same cycle is used for acquisition and archiving, it does not necessarily mean that 
acquisition and archiving are started simultaneously.

There might be a system delay of up to the length of an acquisition cycle between 
acquisition and archiving.
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Start/Stop Events and Actions
Events start and end process value archiving. Conditions which trigger an event can be linked 
to a tag or to scripts (C, VBS). In WinCC, events / actions are differentiated as follows:

● Binary action: Response to changes in a Boolean process tag. Example: turning on a motor 
might start the archiving of a process value.

● Limit value event: Triggered by a limit value being exceeded or reached. Limit value events 
might be in absolute or scaled numbers. Example: temperature fluctuations of more than 
2% might trigger archiving.

● Time-controlled event: Triggered when a fixed point in time is reached, or a defined period 
of time from the start time of the process value archiving has elapsed. Example: a report 
is generated after each shift change.

See also
How to Configure a New Timer (Page 1151)

Configuration of Process Value Archiving (Page 1142)

Compressed Archive (Page 1135)

Process-Controlled Process Value Archiving (Page 1134)

Acyclic Process Value Archiving (Page 1133)

Cyclic-Selective Process Value Archiving (Page 1131)

Continuous cyclic process value archiving (Page 1129)

Archiving Methods (Page 1126)

Basics of Process Values Archiving (Page 1117)

6.3.4.3 Continuous cyclic process value archiving

Introduction
Continuous cyclic process value archiving begins when Runtime is started. The process values 
are acquired at fixed cycles and stored in the archive database. Continuous cyclic process 
value archiving ends when Runtime is terminated. 
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Mode of Operation

Each process tag in WinCC corresponds to a certain process value in the memory of one of 
the connected automation systems (A). The acquisition cycle (1) governs when the process 
value is read out from the memory of the connected automation system. 

The Runtime component of the archive system (C) processes the process value:

● Whether the process value is archived at all depends on the way you have configured the 
system. Example: the process value must be changed by a certain amount or percentage 
(2).

● The archiving function (3) determines how the acquired process values are to be processed 
(e.g. averaging).

The archiving cycle (4) determines when the processed process value is written to the archive 
database (D). 

Note

If you have configured a fast acquisition cycle but a slow archiving cycle, it may give the 
impression when displaying the values in the controls, that no more values will be archived. 
This is because the control updates are based on the archiving cycles. 

If you want the values in the controls to be updated with the acquisition cycle, activate the 
option "Refresh cyclic values in the acquisition cycle" in the project properties in the "Tag 
Logging" editor. The project properties are opened by clicking with the right mouse-button on 
the project name in the navigation window in Tag Logging.
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See also
Configuration of Process Value Archiving (Page 1142)

Storing Process Values (Page 1136)

Compressed Archive (Page 1135)

Process-Controlled Process Value Archiving (Page 1134)

Acyclic Process Value Archiving (Page 1133)

Cyclic-Selective Process Value Archiving (Page 1131)

Cycles and Events (Page 1127)

Archiving Methods (Page 1126)

Basics of Process Values Archiving (Page 1117)

6.3.4.4 Cyclic-Selective Process Value Archiving

Introduction
The cyclic-selective process value archiving is started in Runtime as soon as a start event 
occurs. The process values are subsequently acquired at fixed cycles and stored in the archive 
database. 

The cyclic process value archiving ends in the following cases:

● When a stop event occurs

● When you terminate Runtime

● When the start event no longer exists

The start event or the stop event is determined from the value or the return value of the 
configured tags or script. You configure the tags or scripts in Tag Logging in the properties of 
the process value tags in the "Actions" area. 
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Mode of Operation

Each process tag in WinCC corresponds to a certain process value in the memory of one of 
the connected automation systems (A). Process value archiving begins on the occurrence of 
the start event (1). The acquisition cycle (2) governs when the process value is read out from 
the memory of the connected automation system. 

The Runtime component of the archive system (C) processes the process value:

● Whether the process value is archived at all depends on the way you have configured a 
hysteresis. The process value must be changed by a certain amount or percentage (3).

● The processing method (4) determines how the acquired process values are processed, 
e.g. by averaging.

Until the occurrence of the Stop event (6), the archiving cycle (5) determines when the 
processed process value is written to the archive database (D). 

See also
Configuration of Process Value Archiving (Page 1142)

Storing Process Values (Page 1136)

Compressed Archive (Page 1135)

Process-Controlled Process Value Archiving (Page 1134)

Acyclic Process Value Archiving (Page 1133)

Continuous cyclic process value archiving (Page 1129)

Cycles and Events (Page 1127)

Archiving Methods (Page 1126)

Basics of Process Values Archiving (Page 1117)
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6.3.4.5 Acyclic Process Value Archiving

Introduction
Acyclic process value archiving uniquely saves during runtime the current process value in the 
archive database. The following is archived:

● every time the process value changes.

● if a trigger variable assumes a value of "1" and then takes on value "0" again. The 
prerequisite is that you have configured an event with a tag for the acyclic process value 
archiving.

● If a script receives return value "TRUE" and then takes on the return value "FALSE" again. 
The prerequisite is that you have created an event with a script for the acyclic process value 
archiving.

Mode of Operation

Each process tag in WinCC corresponds to a certain process value in the memory of one of 
the connected automation systems (A).

If the tag takes on a value of "1" and then a value of "0" again or the script takes on return 
value "TRUE" and then "FALSE" again with a configured event (1), the process value is 
archived. 

If you have not configured an event, then each process value change is read from the memory 
of the connected automation system (2). 

The Runtime component of the archive system (C) processes the process value.

The current process value is then written to the archive database (D) (3).

Acyclic process value archiving ends when Runtime is terminated
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See also
Storing Process Values (Page 1136)

Configuration of Process Value Archiving (Page 1142)

Compressed Archive (Page 1135)

Process-Controlled Process Value Archiving (Page 1134)

Cyclic-Selective Process Value Archiving (Page 1131)

Continuous cyclic process value archiving (Page 1129)

Cycles and Events (Page 1127)

Archiving Methods (Page 1126)

Basics of Process Values Archiving (Page 1117)

6.3.4.6 Process-Controlled Process Value Archiving

Introduction
Process-controlled process value archiving is used for archiving several process tags or rapidly 
changing process values. The process values are written to a telegram tag, which is decoded 
by the archive system. The process values obtained in this way are then stored in the archive 
database. 

Principle

Each process tag in WinCC corresponds to a certain process value in the memory of one of 
the connected automation systems (A). At the start of Runtime, the process values of the 
selected process tags are read out (1) and written to the configured telegram tag as binary 
data. 

The Runtime component of the archive system (C) processes the telegram tag:

● The format DLL (2) is part of the archive system and decodes the binary data of the telegram 
tag. 

The decoded process values are then written to the archive database (D) (3). 
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See also
Compressed Archive (Page 1135)

Configuration of Process Value Archiving (Page 1142)

Storing Process Values (Page 1136)

Acyclic Process Value Archiving (Page 1133)

Cyclic-Selective Process Value Archiving (Page 1131)

Continuous cyclic process value archiving (Page 1129)

Cycles and Events (Page 1127)

Archiving Methods (Page 1126)

Telegram Tags (Page 1121)

Basics of Process Values Archiving (Page 1117)

6.3.4.7 Compressed Archive

Introduction
In order to reduce the volume of data in the archive database, the archive tags for a specified 
period can be compressed. To do this a compressed archive is created, which stores each 
archive tag in a compressed tag. The archive tags are retained, but they can also be copied, 
moved or deleted. The compressed archive is stored in the archive database in the same way 
as the process value archive. 

Mode of Operation
This compression is achieved through the application of mathematical functions. To achieve 
this, one of the following functions is applied to the archived process values in a specified 
period of time: 

● Max. Value: The highest process value is saved in the compressed tag.

● Min. Value: The lowest process value is saved in the compressed tag.

● Average value: The average process value is saved in the compressed tag.

● Weighted Average Value: Saves the weighted average value of the process values in the 
compressed tag. The time span, in which a recorded value has the same value, is 
considered in the calculation of the weighted average value.

● Sum: The sum of all process values is saved in the compressed tag.

What happens to the old archived process values after compression depends on which method 
of compression is used:

● Calculate: the process values of the archive tags of the specified period are read out and 
compressed. The process values of the archive tags are retained.

● Calculate and copy: the process values of the archive tags of the specified period are read 
out, compressed and copied to the compressed archive.
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● Calculate and delete: the process values of the archive tags of the specified period are read 
out, compressed and then deleted.

● Calculate, copy, and delete: the process values of the archive tags of the specified period 
are read out, compressed and moved to the compressed archive.

Example
The following examples illustrate the way that the compressed archive works:

● Average value: A process value is archived once every minute and returns 60 values in 
one hour. The compression with the average value is performed over a period of one hour. 
Every hour, the average value is formed from the 60 values and is stored in the compressed 
tag. What happens to the 60 values depends on the compression method described above.

● Weighted Average Value: A process value is acquired every second and returns 60 values 
in one minute. The value is "50" for 40 seconds, the value is "60" for 20 seconds The 
compression with the weighted average value is performed over a period of one minute. 
Every minute, the weighted average value of 60 values is archived, therefore 40x50 + 
20x60 / 60 = 53.33. 

See also
Configuration of Process Value Archiving (Page 1142)

Process-Controlled Process Value Archiving (Page 1134)

Acyclic Process Value Archiving (Page 1133)

Cyclic-Selective Process Value Archiving (Page 1131)

Continuous cyclic process value archiving (Page 1129)

Archiving Methods (Page 1126)

Basics of Process Values Archiving (Page 1117)

6.3.5 Storing Process Values

Introduction
Process values can be stored either on hard disk in the archive database or in the main memory 
of Tag Logging Runtime. 
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Storing in Archive Database
The process values to be archived are stored in two separate cyclic archives (A, B) in the 
archive database. Each cyclic archive consists of a configurable number of data buffers. The 
data buffer is defined in terms of size in MB, and a period of time (e.g. one day).

The process values are written continuously in the data buffers (1). When the configured size 
of the data buffer is reached or the time periods exceeded, the system switches to the next 
one (2). When all the data buffers are full, the process data in the first data buffer is overwritten 
(3). In order that process data is not destroyed by the overwritten process, it can be swapped 
(exported). 

Cyclic archive A stores the process values whose acquisition cycle is less than or equal to one 
minute. These process values are initially saved and compressed in a binary file. When the 
binary file has reached a specific size, it is stored in the cyclic archive. 

Cyclic archive B stores process values whose acquisition cycle is greater than one minute and 
compressed archives. The data is written immediately in the cyclic archive and not compressed.

Note

When starting Runtime, the system tests whether the configured size of a data buffer has 
been calculated to a sufficient size. If the configured size is too small, the system automatically 
adapts to the minimum size. 

Saving in Main Memory
In contrast with storage in the archive database, process values archived in the main memory 
are only available for as long as Runtime is active. Storing in the main memory has the 
advantage, however, that the values can be written and read out very quickly. The process 
values stored in the main memory cannot be swapped out. 
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Note

Compressed archives cannot be saved in the main memory. 

See also
How to Configure an Archive Backup (Page 1177)

How to Configure Archive (Page 1175)

How to Configure the Data Buffer on the Hard Disk (Page 1174)

Configuration of Process Value Archiving (Page 1142)

Swapping Out Process Values (Page 1138)

Basics of Process Values Archiving (Page 1117)

6.3.6 Swapping Out Process Values

Introduction
You can swap out process values from the archive database as a backup. All process values 
contained in a data puffer are swapped out. When the swapping-out actually takes place 
depends on how you configure the system. 
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General procedure
You configure the swapping-out of process values in Tag Logging in the "Archive 
Configuration" dialog. This is where you configure the data buffer on the hard disk and the 
swap-out settings: 

On the Archive Configuration tab enter the settings for the individual data buffers and specify 
what period of time is to be contained in the archive. 

On the "Backup Configuration" tab, specify whether you want to create a backup of the archived 
process values and where the backup is to be stored. 

Note

You can change the displayed process value in runtime using Online Table Control.

If the location of the archive segment where the process value is stored has already been 
changed, then the modified value is not accepted in the shifted archive. The change is done 
only in the local archive segment.

If the archive segment has not yet been moved out, then the changed value is accepted 
permanently.
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Long-term archive server
The long-term archive server is used for backing up process value archives. Swap files can 
be accessed in three different ways:

● Copy swap files onto the configuration computer on which Runtime is run. Link the swap 
files to the project in the Alarm Logging or Tag Logging. The archived values are displayed 
in Runtime.

● Access via OLE-DB

● Access via DataMonitor Web Edition

To set up a long-term archive server, run the WinCC "Fileserver Setup" on the computer. A 
minimum installation of WinCC is then installed on the computer. In order to be able to access 
the stored process value archive with ADO/OLE DB, the MS SQL server is also installed. 

See also
How to Configure an Archive Backup (Page 1177)

How to Configure Archive (Page 1175)

How to Configure the Data Buffer on the Hard Disk (Page 1174)

Direct Access to the Archive Database (Page 1423)

Storing Process Values (Page 1136)

6.3.7 Significance of Archive Value Flags
For each value written to the archive, Tag Logging will set a flag which provides information 
on the tag state.

Representation of this flag is in the form of a 2-word value, encoded in decimal form and listed 
in the 3rd column of the data bank archive. This flag must be converted to its hexadecimal 
representation for analysis purposes.

The high word contains the WinCC status flag or quality code and the low word contains the 
tag logging status flags, as well as a code for the content of the high word.
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Code for High Word Content:

 Description

0x0 High word contains WinCC status flags
0x1 High word contains quality code

Quality Code
 

WinCC Status Flags
 

Tag Logging Status Flags:

Name of flag Value Description

PDE_RT_DAYLIGHT 0x001 Summer time
PDE_RT_SUBSTITUTION 0x002 Substitute value
PDE_RT_TIME_BEVOR_JUMP 0x004 Value prior to time jump
PDE_RT_TIME_BEHIND_JUMP 0x008 Value after time jump
PDE_RT_TIME_OVERLAPPED 0x010 Values during time overlap
PDE_RT_LOAD_SYSTEM 0x020 Value initially archived after archive creation
PDE_RT_RELOAD_SYSTEM 0x040 Initial value after archiving of RT
PDE_RT_CMPCOPY 0x080 Compressed value
PDE_RT_TIME_CHANGED 0x100 Time change took place
PDE_RT_HAND 0x200 Manual tag supply

Examples

Value in database 16842753
Hexadecimal 
representation

0101 0001

Coding for high word 0: High word contains WinCC status flag
Tag logging status flag 001: Summer time
WinCC status flag 0101: Link to partner not established; tag initialization value 

Value in database 266242
Hexadecimal representation 0004 1002
Coding for high word 1: High word contains quality code
Tag logging status flag 002: Substitute value
Quality Code 0004: Configuration error, value not accepted
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6.4 Configuration of Process Value Archiving

6.4.1 Configuration of Process Value Archiving

Introduction
The process value archiving is configured in Tag Logging. There, you can define the process 
values to be archived. WinCC provides you with the process value archive and the compressed 
archive for the archiving of process values. 

General Procedure
The configuration procedure for process value archives consists of the following steps:

1. Configuring the process value archive: In Tag Logging, the process value archive is created 
and the process tags are selected with the help of the "Archive Wizard". 

2. Creating the archive tags: Define whether and when a process value is to be archived for 
each archive tag. 

See also
How to Link an Archive Backup (Page 1180)

Output of Process Values (Page 1184)

Configuring Archives (Page 1144)

Creating Archive Tags (Page 1150)

Cycles and Events (Page 1127)

Tag Logging (Page 1142)

Process Values and Tags (Page 1120)

Archiving Methods (Page 1126)

6.4.2 Tag Logging

Introduction
In Tag Logging, the archives, the process values to be archived and the times for the acquisition 
and archiving cycles are configured. In addition, you also specify the configuration of the data 
buffer on the hard disk and the swapping out of process values in Tag Logging. 

As with all editors in WinCC, to start Tag Logging double-click it in WinCCExplorer.
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Structure of Tag Logging
Tag Logging is divided into the navigation window, data window and table window. 

(1) Navigation window
Here you can choose whether you want to edit times or archives. 

(2) Data window
Depending on the selection you made in the navigation window, here you can edit existing 
archives or times or create new ones. 

(3) Table window
The table window is where the archive tags or compressed tags are displayed that are stored 
in the archive that is selected in the data window. You can change the properties of the 
displayed tags here or add a new archive tag or compressed tag. 

See also
Configuring Archives (Page 1144)

Creating Archive Tags (Page 1150)

Configuration of Process Value Archiving (Page 1142)
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6.4.3 Configuring Archives

6.4.3.1 Configuring Archives

Principle
For the configuration of archives, the system distinguishes between the following archive types:

● The process value archive stores process values in archive tags. When configuring the 
process value archive you select the process tags that are to be archived and the storage 
location. 

● The compressed archive compresses archive tags from process value archives. When 
configuring the compressed archive you select a calculation method and the compression 
time period. 

See also
How to Configure Compressed Archives (Page 1147)

How to Configure a Process Value Archive (Page 1144)

Output of Process Values (Page 1184)

Configuration of Process Value Archiving (Page 1142)

Compressed Archive (Page 1135)

Process-Controlled Process Value Archiving (Page 1134)

Acyclic Process Value Archiving (Page 1133)

Cyclic-Selective Process Value Archiving (Page 1131)

Continuous cyclic process value archiving (Page 1129)

6.4.3.2 How to Configure a Process Value Archive

Introduction
The procedure for the configuration of a process value archive is broken down into the following 
steps:

1. Creating process value archive: Create the new process value archive and select the tags 
that are to be archived.

2. Configuring the process value archive: Configure the process value archive by selecting 
the memory location, etc.
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Procedure

Creating Process Value Archive
1. In the navigation window of Tag Logging, right-click "Archives". From the pop-up menu, 

select the "Archive Wizard..." command. The "Creating an archive" dialog is opened.

2. Enter an appropriate name in "Archive name". "Process value archive" is already selected. 
Click "Next".

3. Click "Select" to select the tags whose values you wish to be archived. You can add further 
tags after you have created the process value archive.

4. Click "Apply". The new process value archive is included in the Tag Logging data window. 
The selected tags are displayed in the table window.

Configuring Process Value Archive
1. In the Tag Logging data window, double-click the process value archive you wish to 

configure. The "Process Value Archive Properties" dialog is opened.

2. Enter the name of the process value archive on the "General Information" tab. If you are 
working in a multi-user system, also select the server.
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3. On the "Memory location" tab, select the memory location and enter the data record size.

4. Close the dialog by clicking "OK".  

Note

You can define default settings for process value archives in the Tag Logging navigation 
window. Each newly created process value archive will then be preconfigured with the 
parameters that you have set.

Right-click the "Archive" button and then select "Default settings" > "Process value archive" 
from the pop-up menu. 

See also
How to Configure a New Timer (Page 1151)

Output of Process Values (Page 1184)

Creating Archive Tags (Page 1150)

Configuring Archives (Page 1144)

Tag Logging (Page 1142)
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6.4.3.3 How to Configure Compressed Archives

Introduction
The procedure for the configuration of a compressed archive consists of the following steps:

1. Creating the compressed archive: Create the new compressed archive and select the tags 
to be archived.

2. Configuring the compressed archive: Configure the compressed archive by selecting the 
memory location, calculation method, etc.

3. Creating the compressed tag: Select the archive tags to be included in the compressed 
archive.

Procedure

Creating Compressed Archive
1. In the navigation window of Tag Logging, right-click "Archives". From the pop-up menu, 

select the "Archive Wizard..." command. The "Creating an archive" dialog is opened.

2. Enter an appropriate name in "Archive name" and select "Compressed archive". Click 
"Apply". The new compressed archive is included in the Tag Logging data window.
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Configuring Compressed Archive
1. In the Tag Logging data window, double-click the compressed archive that you wish to 

configure. The "Properties of compressed archive" dialog is opened.

2. Enter a name for the compressed archive on the "General Information" tab. If you are 
working in a multi-user system, select the server on which the compressed archive is to be 
stored.

3. On the "Compression" tab, select the calculation method and the compression time period.

Archiving Process Values
6.4 Configuration of Process Value Archiving

MDM - WinCC: Working with WinCC
1148 System Manual, 11/2008,  



4. For compression time periods, all times created in Tag Logging that are greater than 1 
minute are available. If the desired compression time period is not available, first configure 
it in Tag Logging as a new time period and set the compression time period afterwards.

5. Close the dialog by clicking "OK".

Note

You can define default settings for compressed archives in the Tag Logging navigation 
window. Each newly created compressed archive will then be preconfigured with the 
parameters that you have set.

Right-click the "Archive" button and select "Default settings" > "Compressed archive" from 
the pop-up menu.

Creating Compressed Tag
The procedure is explained in this documentation under "Creating Compressed Tags".
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See also
How to Configure a New Timer (Page 1151)

How to Create a Compressed Tag (Page 1170)

Output of Process Values (Page 1184)

Creating Archive Tags (Page 1150)

Configuring Archives (Page 1144)

Tag Logging (Page 1142)

6.4.4 Creating Archive Tags

6.4.4.1 Creating Archive Tags

General procedure
Archive tags are used to save the process values to be archived. The following archive tags 
can be used in a process value archive: 

● A binary archive tag is used for storing binary process values.

● An analog archive tag is used for storing numeric process values.

● A process-controlled tag is used for storing process values which have been sent to the 
archive system as a telegram.

In a compressed archive each compressed process value is stored in a separate compressed 
tag. 

Basic procedure
In the case of binary and analog archive tags you specify the archiving type (e.g. cyclic) and 
acquisition and archiving cycles. Depending on the archiving type, select events and actions 
which trigger or end archiving. Depending on the type of archive tag, specify the display limits 
and parameters for processing the process values.

When configuring a compressed tag, select the compression function that for example forms 
the average value from the process values that are to be compressed. 

Note

In Tag Logging, if you delete, save and subsequently recreate a tag with the same name as 
the deleted tag, the values of the deleted tag can no longer be accessed for display or 
archiving. Reason: The newly created archive tag is assigned a new ID. The ID of the deleted 
archive tag is no longer accessible.
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See also
How to Create a Compressed Tag (Page 1170)

How to Create a Process-Controlled Tag (Page 1167)

How to Create an Analog Archive Tag (Page 1159)

How to Create a Binary Archive Tag (Page 1153)

How to Configure a New Timer (Page 1151)

Configuring Archives (Page 1144)

Tag Logging (Page 1142)

6.4.4.2 How to Configure a New Timer

Introduction
If you wish to use timers for acquisition and archiving cycles other than the standard timers, 
you can configure new timers. The new timer is calculated on a defined basis (for example 1 
second), multiplied with an integer factor.
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Procedure
1. In the navigation window of Tag Logging, right-click "Timers". From the pop-up menu, select 

the "New..." command. The "Timers Properties" dialog is opened.

2. Define the new timer: Enter a name, select the desired basis from the list, and enter an 
integer factor.

3. Under "Starting point of the cycle" you can enter additional properties for the new timer. By 
entering the new starting point, you can specify when an archiving is executed by the cycle 
(e.g. at the 0th second every 7 seconds). Specification of the starting point allows for an 
even distribution of the archiving load.

4. Click "OK" to apply the new timer. It is displayed in the data window and can be selected 
as the acquisition and archiving cycle.

See also
How to Create a Compressed Tag (Page 1170)

How to Create a Process-Controlled Tag (Page 1167)

How to Create an Analog Archive Tag (Page 1159)

How to Create a Binary Archive Tag (Page 1153)

Cycles and Events (Page 1127)

Creating Archive Tags (Page 1150)
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6.4.4.3 How to Create a Binary Archive Tag

Introduction
The procedure for the creation of binary archive tags consists of two steps:

1. Creating the binary archive tag: Select the process tag whose process value is to be stored 
in the binary archive tag.

2. Configuring the binary archive tag. You can define the following settings:

– Properties of archive tags

– Archiving type and acquisition of archiving

– Archiving parameters

Procedure

Creating Binary Archive Tag
1. In the Tag Logging data window, select the archive in which you wish to create a new binary 

archive tag. Right-click the table window and select the "New tag" menu option from the 
pop-up menu.

2. In the "Tags" window select the binary tag whose value you wish to archive. You also have 
the option to create a new binary tag.

3. Click "OK" to accept the selected tag in the Tag Logging table window.
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Configuring the Properties of Archive Tags
1. Select the process value archive in the Tag Logging data window. In the table window, right-

click the binary archive tag and select the "Properties" menu option from the pop-up menu. 
The "Process tag properties" dialog is opened.

2. In the "Archive Tag" tab change, if required, the name of the archive tag.

3. Define whether the archive tags are provided manually or by the same.

4. In the "Archiving" group, define whether archiving is to be released at system start. Activate 
the control box "Relevant long term" if the archive tag is viewed by the Central Archive 
Server (CAS) as a tag with long-term relevance.

5. The value of the archive tag can also be written into an internal tag in order to use the 
archived tags for other purposes. The update process is determined by the cycle settings 
for the archive tag. Select the internal tag by clicking the "Select" button.
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Configure Archiving type and Acquisition of Archiving
1. Select the archiving type and acquisition in the "Archiving" tab. You can configure four 

archiving methods:

– Continuous cyclic process value archiving

– Cyclic-selective Archiving

– Acyclic, event-controlled archiving

– Acyclic archiving when process values are modified

2. For continuous cyclic archiving, select the "cyclic" archiving type in the "Archiving" tab. Set 
the archiving cycle.

3. For cyclic-selective archiving, you can also configure the start and stop events in the 
"Actions" group. Use "..." to select a tag in Tag Management or a C-Script in the Function 
Browser. The tag or function must return the values "1" or "0" or the return values "TRUE" 
or "FALSE". If the value TRUE occurs, the archiving is started or closed as the case may 
be.
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4. For a acyclic, event-controlled archiving, you need to define the basic event in the "Events" 
group. Use "..." to select a tag in Tag Management or a C-Script in the Function Browser. 
The tag or function must return the values "1" or "0" or the return values "TRUE" or "FALSE". 
If the value "1" or "TRUE" occurs, archiving is done one time.

5. To archive process tags due to change in values, select archiving type "acyclic" and "On 
Change" for acquisition. In WinCC Controls, define a cycle for the display to display values 
that have not been modified for a long time. Otherwise, in the long run, the value will 
disappear from the display. Activate option "Archive after segment change", if during a 
segment change, the process value of the tags are also to be archived if the value has not 
been changed.
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Configure Archiving Parameters
1. In the "Archiving" section on the "Parameters" tab, specify when the process value is to be 

archived. Select "always", if the current process value is always to be displayed in the trend 
display.

2. In the "Save on error" field define the error value that is to be accepted.
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3. In the "Number of values" group you can enter values for the leader and trailer when the 
start and stop actions are configured for a cyclic-selective archiving. The actions are called 
and edited in the acquisition cycle depending on the leader or trailer buffer of the application.

4. Complete configuration of the binary archive tag by clicking "OK".

In the Tag Logging table window, the archiving type and acquisition of archiving tags are 
combined in the "Acquisition type" column. For acyclic, event-controlled archiving, "acyclic" is 
entered in the column; "Archiving on change" is entered when there is a change in the process 
value.

Note

You can define default settings for binary archive tags in the Tag Logging navigation window. 
Each newly added binary archive tag will then be preconfigured with the parameters that you 
have set.

Right-click "Archive" and then select the "Default settings" > "Binary tag" menu option from 
the pop-up menu. 
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See also
How to Create a Compressed Tag (Page 1170)

How to Create a Process-Controlled Tag (Page 1167)

How to Create an Analog Archive Tag (Page 1159)

How to Configure a New Timer (Page 1151)

Configuring Archives (Page 1144)

Creating Archive Tags (Page 1150)

Process Values and Tags (Page 1120)

Cycles and Events (Page 1127)

Tag Logging (Page 1142)

6.4.4.4 How to Create an Analog Archive Tag

Introduction
The procedure for the creation of analog archive tags consists of two steps:

1. Creating the analog archive tag: Select the process tag whose process value is to be stored 
in the analog archive tag.

2. Configuring the analog archive tag: You can define the following settings:

– Properties of archive tags

– Archiving type and acquisition of archiving

– Archiving parameters

– the display area or the adding area of the archive tags

Procedure

Creating Analog Archive Tag
1. In the Tag Logging data window, select the archive in which you wish to create a new analog 

archive tag. Right-click the table window and select the "New tag" menu option from the 
pop-up menu.

2. In the "Tags" window, select the tag whose value you wish to archive. You can also create 
a new tag.

3. Click "OK" to accept the selected tag in the Tag Logging table window.
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Configuring the Properties of Archive Tags
1. Select the process value archive in the Tag Logging data window. In the table window, right-

click the analog archive tag and select the "Properties" menu option from the pop-up menu. 
The "Process tag properties" dialog is opened.

2. In the "Archive Tag" tab change, if required, the name of the archive tag.

3. Define whether the archive tags are provided manually or by the same.

4. In the "Archiving" group, define whether archiving is to be released at system start. Activate 
the control box "Relevant long term" if the archive tag is viewed by the Central Archive 
Server (CAS) as a tag with long-term relevance.

5. The value of the archive tag can also be written into an internal tag in order to use the 
archived tags for other purposes. The update process is determined by the cycle settings 
for the archive tag. Select the internal tag by clicking the "Select" button.
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Configure Archiving type and Acquisition of Archiving
1. Select the archiving type and acquisition in the "Archiving" tab. You can configure four 

archiving methods:

– Continuous cyclic process value archiving

– Cyclic-selective Archiving

– Acyclic, event-controlled archiving

– Acyclic archiving when process values are modified

2. For continuous cyclic archiving, select the "cyclic" archiving type in the "Archiving" tab. 
Define the acquisition cycle and the archiving cycle in the "Archiving" group. In the 
Hysteresis filed, configure whether only the process value that is absolute ("abs") or relative 
("in %") above or below the given threshold is to be archived.
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3. For cyclic-selective archiving, you can also configure the start and stop events in the 
"Actions" group. Use "..." to select a tag in Tag Management or a C-Script in the Function 
Browser. The tag or function must return the values "1" or "0" or the return values "TRUE" 
or "FALSE". If the value TRUE occurs, the archiving is started or closed as the case may 
be.
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4. For an acylic, event-controlled archiving, select archiving type as "acyclic" and acquisition 
as "event-controlled' on the Archiving tab. In the Events group, define the underlying event. 
Use "..." to select a tag in Tag Management or a C-Script in the Function Browser. The tag 
or function must return the values "1" or "0" or the return values "TRUE" or "FALSE". If the 
value "1" or "TRUE" occurs, archiving is done one time.

5. To archive process tags due to change in values, select archiving type "acyclic" and "On 
Change" for acquisition. In WinCC Controls, define a cycle for the display to display values 
that have not been modified for a long time. Otherwise, in the long run, the value will 
disappear from the display. Activate option "Archive after segment change", if during a 
segment change, the process value of the tags are also to be archived if the value has not 
been changed.
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Configure Archiving Parameters
1. For cyclic archiving, select an archiving function in the "Parameter" tab. If the Action" option 

is activated, the most recently recorded process value is calculated through a function 
created by Global Script. Use the "Select" button to call the Function Browser.

2. In the "Number of values" group you can enter values for the leader and trailer when the 
start and stop actions are configured. The actions are called and edited in the acquisition 
cycle depending on the leader or trailer buffer of the application.

3. In the "Save on error" field define the error value that is to be accepted.
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Configure the display area or the adding area of the archive tags
1. To archive or display only the process values that lie between the lower and upper limit, 

select the "Configured directly" option in the Display tab.

2. Complete configuration of the analog archive tag by clicking "OK".

In the Tag Logging table window, the archiving type and acquisition of archiving tags are 
combined in the "Acquisition type" column. For acyclic, event-controlled archiving, "acyclic" is 
entered in the column; "Archiving on change" is entered when there is a change in the process 
value.

Archiving Process Values
6.4 Configuration of Process Value Archiving

MDM - WinCC: Working with WinCC
1166 System Manual, 11/2008,  



Note

You can define default settings for analog archive tags in the Tag Logging navigation window. 
Each newly added analog archive tag will then be preconfigured with the parameters that you 
have set.

Right-click "Archive" and then select the "Default settings" > "Analog tag" menu option from 
the pop-up menu. 

See also
How to Create a Compressed Tag (Page 1170)

How to Create a Process-Controlled Tag (Page 1167)

How to Create a Binary Archive Tag (Page 1153)

How to Configure a New Timer (Page 1151)

Configuring Archives (Page 1144)

Creating Archive Tags (Page 1150)

Process Values and Tags (Page 1120)

Cycles and Events (Page 1127)

Tag Logging (Page 1142)

6.4.4.5 How to Create a Process-Controlled Tag

Introduction
In order to acquire and archive rapidly changing process values or process values from several 
measuring points, these values are sent from the AS to WinCC using a raw data tag. To archive 
the data in archive tags, the assignment of a raw data tag to an archive tag is defined in a 
process-controlled tag. Only raw data tags for the supply of values to archive tags can be 
assigned in process-controlled tags.

Structure of the Archive Tag Name
When the process-controlled tag is configured, WinCC generates an internal archive tag name. 
You have however the option to define an alias in the "Archive Tag Name" field in the 
"Properties of process controlled tag" dialog. If no alias is entered, the internal archive tag 
name is used for administration in the process value archive and addressing the archive tag 
in WinCC.   

The internal archive tag name is structured as follows:

● when using format DLL "nrms7pmc.nll":   #<raw_tag_name>#m#pppppppp#ssss

● when using another format DLL (e.g. "S5STD.NLL"):   #xxxxxxxxx#yyyy
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Parameters Meaning

<raw_tag_name> Name of raw data tags; maximum of 24 characters          
(maximum length of total archive tag name: 52 characters) 

m Code "A" for raw data type "Archive data link" 
pppppppp Archive tag number "AR_ID"; eight-digit hexadecimal value
ssss AR_ID sub number; four-digit hexadecimal value optional component of 

name 
xxxxxxxx ID of raw data tags; eight-digit hexadecimal value          

(maximum length of total archive tag name: 25 characters) 
yyyy Tag number; four-digit hexadecimal value decimal input 

 

Note

When using the format DLL "nrms7pmc.nll", before WinCC Version 5.1 Hotfix, 4 the name of 
the process-controlled archive tag was generated automatically. The name was limited to 
maximum 25 characters and instead of the name of the raw data tag it contained its ID as an 
eight-digit hexadecimal value. In projects that have been migrated to Version V5.1 HF4 or 
higher, the archive tag names can continue to be used in the original structure with ID or they 
can be converted to the new structure. The names are converted by once opening and closing 
the properties dialog box of the process-controlled archive tags. An alias does not have to 
be assigned.

If in a project all external tags are remapped using the "AS-OS-Transfer" function, the archive 
tag name must therefore be converted once to the new structure! The new structure is then 
maintained. 
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Procedure
1. In the Tag Logging data window, select the process value archive in which you wish to 

create a new process-controlled tag. Right-click the table window and select the "New 
Process Controlled Tag" menu option from the pop-up menu. The "Properties of process 
controlled tag" dialog is opened.

2. From the list, select the "format DLL" matching the controller being used.  

3. Click "Select" in order to select the raw data tag in the tag selection dialog. When you have 
selected the raw data tag, you are prompted to enter one or more IDs. The number of IDs 
depends on the selected format DLL. Values are used to form the internal archive tag name.

4. If necessary, enter an alias for the process-controlled tag under "Archive Tag Name". If no 
name is entered in this field, the internal archive tag name in WinCC is used.

5. Activate the control box "Long-time relevance" if the archive tag is viewed by the Central 
Archive Server (CAS) as a tag with long-term relevance.

6. Click "OK" to accept the new process-controlled tag in the Tag Logging table window.
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See also
How to Create a Compressed Tag (Page 1170)

How to Create an Analog Archive Tag (Page 1159)

How to Create a Binary Archive Tag (Page 1153)

Creating Archive Tags (Page 1150)

Configuring Archives (Page 1144)

Process Values and Tags (Page 1120)

Cycles and Events (Page 1127)

Tag Logging (Page 1142)

6.4.4.6 How to Create a Compressed Tag

Introduction
The procedure for creating a compressed tag consists of two steps:

1. Creating the compressed tag: Select the archive tags that are to be included in the 
compressed archive.

2. Configuring the compressed tag: Select the method by which the process values are to be 
compressed (e.g. averaging).

Requirement
The relevant compressed archive must have been created. 
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Procedure

Creating Compressed Tag
1. Select a compressed archive in the Tag Logging data window. Right-click the table window 

and select the "Select tag" menu option from the pop-up menu. The "Select Compressed 
Tags" dialog is opened.

All available archives are displayed in the left half of the window. 

2. To include an archive tag in the compressed archive, select the archive tag and click ">". 
If you want to include all displayed archive tags, click ">>".

3. Click "OK" to transfer the compressed tags. A compressed tag appears in the table window 
for each selected archive tag.
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Configuring Compressed Tag
1. Select the compressed archive in the Tag Logging data window. Right-click the compressed 

tag in the table window and select the "Properties" menu option from the pop-up menu. The 
"Properties of compressed tag" dialog is opened.

2. If necessary, change the name of the compressed tag.

3. In the "Archiving" group, define whether archiving is to be released at system start. Activate 
the control box "Long-time relevance" if the archive tag is viewed by the Central Archive 
Server (CAS) as a tag with long-term relevance.
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4. In the "Processing" section on the "Parameters" tab, select how the process values are to 
be compressed.

5. Complete configuration of the compressed tag by clicking "OK".

See also
How to Create a Process-Controlled Tag (Page 1167)

How to Create an Analog Archive Tag (Page 1159)

How to Create a Binary Archive Tag (Page 1153)

Configuring Archives (Page 1144)

Creating Archive Tags (Page 1150)

Process Values and Tags (Page 1120)

Cycles and Events (Page 1127)

Tag Logging (Page 1142)
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6.4.5 How to Configure the Data Buffer on the Hard Disk

Introduction
In the case of a process value archive, it is possible to define whether the data buffer should 
be stored on the hard disk or in the main memory. 

In contrast with storage in the archive database, process values archived in the main memory 
are only available for as long as Runtime is active. Storing in the main memory has the 
advantage, however, that the values can be written and read out very quickly. The process 
values stored in the main memory cannot be swapped out. 

Note

Compressed archives can only be stored on the hard disk. 

Procedure
1. In the data window, double-click the required process value archive whose data buffer is 

to be configured. The "Properties" dialog is opened:.

2. Select the memory location on the "Archive Parameters" tab.

3. If you select "In the main memory" as the storage location, you must also enter the "Size 
in data records".

4. Click "OK" to complete configuration of the data buffer.
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See also
Storing Process Values (Page 1136)

Basics of Process Values Archiving (Page 1117)

6.4.6 How to Configure Archive

Introduction
The Archive is configured in Tag Logging. The data buffer of an archive with an archiving cycle 
of less than one minute is configured in "Tag Logging Fast". The data buffer of an archive with 
an archiving cycle greater than one minute is configured in "Tag Logging Slow". 

Note

Ensure that the archive size does not exceed the free memory space available. The archive 
manager does not check the selected settings for plausibility. A high number of linked 
database segments can lead to longer waiting periods in the system when starting and ending 
Runtime.
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Procedure
1. Open Tag Logging in WinCC Explorer.

2. In the "Tag Logging" navigation window, select the "Archive Configuration" entry. In the 
data window, double-click "Tag Logging Slow" or "Tag Logging Fast". The "Archive 
Configuration" dialog is opened.

3. Make the following settings for the archive:

– Time period of all segments and its maximum size. This specification defines the size 
of the archive database. If one of the criteria is exceeded, a new segment is started and 
the oldest segment is deleted.

– The period of time in which process values are to be archived in an individual segment, 
and its maximum size. If either of these criteria is violated, a new individual segment is 
started. When the criterion for "Time period of all segments" is exceeded, the oldest 
individual segment is also deleted.

4. Enter the following under "Time of segment change":

– Start date and start time for the first segment change.

5. Click "OK" to confirm your entry.

Archiving Process Values
6.4 Configuration of Process Value Archiving

MDM - WinCC: Working with WinCC
1176 System Manual, 11/2008,  



Note

If you modify the archiving size (time range) in Runtime, such modifications take effect only 
upon the next segment change.

Example:
In the above screen shot, the segment changes for the first time on January 17 at 23:59. The 
next time-related segment change occurs at the configured time in the cycle defined in "Time 
period covered by a single segment". The segment is also changed even if the configured size 
("Max. size of all segments") is exceeded after starting Runtime. In this case, the oldest 
individual segment is also deleted. 

Changing the Archive Type
If the user does not change the respective settings, the archive tags are archived with a cycle 
time of <= 1 min in the "Tag Logging Fast" process value archive. Archive tags with a cycle 
time > 1 min are archived in the "Tag Logging Slow" process value archive. The cycle time of 
archive tags must not be changed in Runtime beyond the above-mentioned limits. The change 
of an archive tag from archive type "Fast" to "Slow" and vice-versa is not possible in Runtime.

Following a cycle change or reconfiguration, if tags are supposed to be stored in a different 
archive type, said tags are read from the currently valid archive. Previous archive values of 
this tag are not accessible in Runtime.

Following changes, if tags are no longer archived in "Tag Logging Fast" but in "Tag Logging 
Slow" instead, the size of required databases for these tags may increase by several factors.

NOTICE

Runtime data in archives are deleted during a reset in the archive configuration of Tag 
Logging. Only previously swapped-out databases remain intact.

See also
Swapping Out Process Values (Page 1138)

Basics of Process Values Archiving (Page 1117)

6.4.7 How to Configure an Archive Backup

Introduction
Create regular backups of your archive data in order to ensure seamless documentation of 
your processes.
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Note

The backup normally starts 15 minutes after the first time-related segment change. If the start 
of backup and start of segment should be synchronous with the start of Runtime, define the 
start time for the segment change prior to the start of Runtime.

You can change the displayed process value in runtime using Online Table Control. If the 
location of the archive segment where the process value is stored has already been changed, 
then the modified value is not accepted in the shifted archive. The change is done only in the 
local archive segment.

If the archive segment has not yet been moved out, then the changed value is accepted 
permanently.

Procedure
1. Open Tag Logging in WinCC Explorer.

2. In the "Tag Logging" navigation window, select the "Archive Configuration" entry. In the 
data window, double-click "Tag Logging Slow" or "Tag Logging Fast". The "Archive 
Configuration" dialog is opened.

3. Click the "Backup Configuration" tab.
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4. Activate the "Signing off activated" check box if the archive backup files are supposed to 
contain a signature. Upon reconnection with WinCC, the signature allows the system to 
determine whether any modifications have been made to the archive backup file after its 
swap-out.  

5. Select the "Activate Backup" check box, if the archived data are to be backed up. In addition, 
select the "Backup to both paths" check box, if the archived data are to be saved in both 
directories "Destination path" and "Alternative destination path".

6. Enter the destination path in which the backup files are to be stored. Network paths are 
also valid as destination paths. The "Alternative destination path" is used when for instance:

– the storage space on a backup medium is full;

– the original destination path is not available, e.g. due to a network failure;
After the corresponding system messages have been configured, the messages are 
output, if the specified path is not available. 

7. Click "OK" to confirm your entry.

Results
The archive backup is stored in the specified destination path. 

Structure of the Archive Backup File
An archive backup consists of two files, with the extensions LDF and MDF. In order to transfer 
an archive backup, e.g. to another computer, copy the corresponding LDF and MDF files. The 
file name is in the following form: 
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". The type is 
defined by the archive type:

● TLG_F: Process value archive with an archiving cycle of less than one minute ("Tag Logging 
Fast")

● TLG_S: Process value archive with an archiving cycle greater than one minute ("Tag 
Logging Slow")

The period is specified in the following format: yyyymmddhhmm, e.g. 200212021118 for 
December 2, 2002, 11:18 hours Underscores ("_") in the project name are displayed as "#". 

Signing Off of Archive Backup Files
Upon activated signing off and activated backup, each archive backup file is signed off upon 
swapping out. It is thus possible to determine upon reconnection of the file with WinCC whether 
or not the file has been changed after swapping.

If you use archive signing-off, the maximum size of a single segment may not exceed 200 MB. 

In order to verify the data, the "Signing off activated" check box must be selected. Longer 
verification times result from connecting "Tag Logging Slow" archives. The "Link archive" menu 
entry is gray-shaded for the duration of the connection.

For archiving of signed-off data, the following values apply:
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Archiving of signed-off data in Runtime Values/second

Archiving in database for server/single user ("Tag Logging Fast") 1.000
Archiving in database for central archive server (Logging Fast Tag) 5.000
Archiving in database for server/single user ("Tag Logging Slow") 5001) 

Archiving in database for central archive server (Logging Slow Tag) 5001) 

1) During "Tag Logging Slow", you must expect longer picture selection times for identical 
quantity structures than in "Tag Logging Fast".

Note

If you deactivate signing off, for example in order to establish a quick link to the backup files, 
any segment change during deactivation should be avoided. After the link has been 
established, signing off should be reactivated in order to enable signing off for archived data.

See also
How to Link an Archive Backup (Page 1180)

Swapping Out Process Values (Page 1138)

Basics of Process Values Archiving (Page 1117)

6.4.8 How to Link an Archive Backup

Introduction
In order to access a file in an archive backup in Runtime, connect the associated database 
files to the project again. You can link to the archive yourself using the Tag Logging Editor, or 
have the link established automatically.

Requirement
The corresponding LDF file and MDF file of the archive backup are located in a local directory 
on the configuration computer, e.g. hard disk, MOD, or CD. The project is loaded on the 
configuration computer and is located in Runtime. 

Displaying the Process Values in Runtime
In Runtime, the archived process values are inserted in the display configured at the relevant 
point according to the time stamp. 

Further Access Options to Archive Backups
Apart from the options described above, you can use OLE-DB or DataMonitor Web Edition to 
directly access the long-time archive server. 
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Linking to the Archive Using the Tag Logging Editor
1. Open Tag Logging in WinCC Explorer.

2. In the navigation window of Tag Logging, select the "Archive Configuration" entry. In the 
data window, right-click "Tag Logging Slow" or "Tag Logging Fast" and select "Link archive" 
from the pop-up menu.

3. Select the required database file and click "OK".          
The database file is linked with to the project. The process values can be displayed directly 
in Runtime.

If signing off is activated and you link a modified or unsigned archive backup file to the project, 
you must acknowledge the link to these files, as the archive backup files are otherwise not 
linked. A WinCC system message is generated and an entry is added to the Windows event 
log in the "Application" section.

Longer verification times result from connecting "Tag Logging Slow" archives. The "Link 
archive" menu entry is gray-shaded for the duration of the connection.

Automatic Linking to an Archive
1. Add the archive backup files to the "ProjectName\CommonArchiving" directory.

2. In Runtime, the process value archive is automatically linked to the project.

         
If signing off has been activated, modified signed-off archive backup files are not automatically 
linked. A WinCC system message is generated and an entry is added to the Windows event 
log in the "Application" section. 

Linking an Archive Using a Script
Using the "DataLogs" VBS object, you can link the archive backup files to the WinCC project 
using a script. The archive segments are then copied with the "Restore method" to the common 
archiving directory of the Runtime project. For more information, refer to chapters "DataLogs 
VBS Object" and "VBS Method 'Restore'". 

See also
How to Configure Archive (Page 1175)

Output of Process Values (Page 1184)

Basics of Process Values Archiving (Page 1117)

6.4.9 How to Disconnect an Archive Backup

Introduction
If you no longer wish to access the data in an archive backup during Runtime, disconnect the 
associated database files from the project. 
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Requirement
Archive backup files are linked. The project is loaded on the configuration computer and is in 
Runtime. 

Procedure
1. Open Tag Logging in WinCC Explorer. 

2. In the navigation window of Tag Logging, select the "Archive Configuration" entry. In the 
data window, right-click "Tag Logging Slow" or "Tag Logging Fast" and select "Disconnect 
from Archive" from the pop-up menu. 

3. Select the desired archive file and click "OK".         
The link to the archive file is disconnected. You will no longer have access to the archived 
process values in Runtime.

Automatically linked archives must be removed from the "Project name" directory. This can be 
done manually or by using a script in "DataLogs" VBS object.

See also
Basics of Process Values Archiving (Page 1117)

6.4.10 How to Assign Archive Tags to Archive Types

Introduction
The process value archiving uses two different archive types for saving data:

● "Tag Logging Slow" process value archive

● "Tag Logging Fast" process value archive

The archive tags are automatically assigned to the respective archive type by WinCC. 
However, you can change this assignment in Tag Logging.

In Runtime, a changed assignment will only be accepted when the project has been 
deactivated and runtime is restarted.

Procedure
1. Open Tag Logging in WinCC Explorer.

2. In the "Tag Logging" navigation window, select the "Archive Configuration" entry. Double-
click "Tag Logging Fast" in the data window. The "Archive Configuration" dialog is opened.
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3. Click the "Archive contents" tab.

4. If the acyclic measured value should be archived in the "Tag Logging Fast" process value 
archive, select the "Event-controlled measured values" check box.

5. If all cyclic measured values should be archived at an archiving cycle shorter than or equal 
to a limit value in the "Tag Logging Fast" archive, proceed as follows:

6. Select the "Cyclic measured values with cycle <=" check box.

7. Enter the required value for the upper limit of the archiving cycle.

8. If all compressed measured values should be archived at an archiving cycle shorter than 
or equal to a limit value in the "Tag Logging Fast" archive, proceed as follows:

9. Select the "Compressed measured values with cycle <=" check box.

10.Enter the required value for the upper limit of the archiving cycle.

11.If the process-controlled measured value should be archived in the "Tag Logging Fast" 
process value archive, select the "process-controlled measured value" check box.

Results
All the archive tags, for which these settings apply, are archived in the "Tag Logging Fast" 
archive. All the archive tags to which these settings apply are archived in the "Tag Logging 
Fast" archive.

See also
Basics of Process Values Archiving (Page 1117)

Archiving Methods (Page 1126)

Archiving Process Values
6.4 Configuration of Process Value Archiving

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1183



6.5 Output of Process Values

6.5.1 Output of Process Values

Introduction
You can output process values in process displays and as a report. You can also directly 
access the archive database via various interfaces. 

Process Value Output in Process Pictures
In Runtime you can output process values in tabular form or as trends. To do this you can load 
process values from the archive database or monitor the running process directly. 

Process Value Output in Reports
You can print out process values from the archive database as a report. You can also choose 
between tabular and graphic output format. In the Report Designer, both output forms are 
available as predefined layouts. 

Direct Access to the Archive Database
--

See also
Process value output in reports (Page 1313)

Configuration of Process Value Archiving (Page 1142)
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6.5.2 Process Value Output in Process Pictures

6.5.2.1 Process value output in process pictures

Introduction
You have the option to display archived and current process values in Runtime. WinCC 
provides two ActiveXControls that you insert as table windows or trend windows in a process 
picture for this.
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Process Value Output in a Table
To display process values in table format in Runtime, use the WinCC OnlineTableControl. You 
can connect the values in the table with archive tags or process tags.

Process value output in trends
To display process values in trend format in Runtime, use the WinCC OnlineTrendControl. 
You can connect the values in the trend with archive tags or process tags.
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6.5.2.2 Process Value Output in Table Format

Resources

WinCC OnlineTableControl

Overview
Current incoming process data or archived values are shown in a table with the WinCC Online 
Table Control. The process data is represented in online tags, archive values in archive tags.

You can arrange the display of the table as you wish.

You can create statistics from them in runtime or you can export the data for further processing.

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

Configuring the OnlineTableControl

How to configure the OnlineTableControl:

Introduction
The values in the table are shown in runtime in an ActiveX control. You can configure a WinCC 
OnlineTableControl for this in the Graphics Designer.

Configuration steps
1. Link the WinCC OnlineTableControl to a Graphics Designer picture.

2. Configure the basic properties for the OnlineTableControl on the "General" tab.
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3. Configure one or more time columns with the time ranges for the table.

4. Configure one or more value columns. Assign time columns to the value columns. Every 
value column configured must be connected with an online tag or archive tag. Define the 
data connection for each value column.

5. Configure the display and properties of the table on the "Parameter", "Display" and "Marker" 
tabs.

6. Configure the toolbar and status bar of the table window.

7. If you want to show the statistics values, configure a statistics window as well. Connect the 
statistics window with the OnlineTableControl.

8. Save the configurations.

How to configure the time columns for the table

Introduction
You configure the time range in the table display with time columns. A table can have separate 
time columns for several value columns or a common time column. 

Time range of a table
Basically, there are two different time references in the table:

● Static display. The time range of the table is determined by a pre-defined, fixed time interval, 
independent of the current system time.

● Dynamic display. The time range of the table is determined retrospectively from the most 
current values. The display is continuously updated. The configured time range follows the 
current system time.

You have three different ways to define the time range of a time column for each of the two 
time references:
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● The table values are displayed within a defined time interval. You define a start time and 
an end time. In a dynamic display, the end time corresponds with the current system time. 
The time difference between the start time and the end time is the time range for the table.

● The table values are displayed from a start time throughout a defined time range, e.g. 30 
minutes from the start time. In the dynamic display, the defined time range up to the current 
system time is used, e.g. 30 minutes to the current system time.

● Starting from a start time, a defined number of values are shown, e.g. 100 values from the 
start time. With the dynamic display, the last values up to the current system time are shown.
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Requirement
● You have opened the picture with the WinCC OnlineTableControl in the Graphics Designer.

Procedure
1. Define one or more time columns with the "New" button on the "Time columns" tab. The 

sequence in the list determines the arrangement of the columns in the table.

2. If you do not want to show a time column in the table, deactivate the time column by clicking 
on the checkbox in front of the name in the list. During runtime, you can show it again by 
activating the time column in the table.

3. Configure the properties and the formats for time and date for every time column.
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4. Configure a time range for every time column. If you want a dynamic display, activate the 
"Update started" option on the "General" tab.

5. Set the time range:

– If you want to define a fixed time interval, select setting "Start to end time" Enter the 
date and time for each.

– If you want to define a time period, select the setting "Time range". Define the date and 
time for the start time. The time range is the result of a multiplication of the "Factor" and 
"Time unit", e.g. 30 times "1 minute" for a time range of 30 minutes. Enter the factor and 
the time unit in the "Time range" field.

– If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

6. Save the configuration.

Note

Upon starting Runtime the values to be displayed are either read from the archive or are 
set to zero. Define whether the update will start upon opening the picture on the "General" 
tab.

How to configure the value columns for the table

Introduction 
You can display several value columns in a table. Every value column is connected with a time 
column. The value columns can have a common time column.

Requirements
● You have opened the picture with the WinCC OnlineTableControl in the Graphics Designer.

● You have defined time columns.
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Procedure
1. Define one or more value columns with the "New" button on the "Value columns" tab. The 

sequence in the list determines the arrangement of the value columns in the table relative 
to the assigned time axis.

2. Assign time columns that have been configured already to the value columns. If more than 
one value column is to use a common time column, assign the same time column to these 
value columns.

3. If you do not want to show a value column in the table, deactivate the value column by 
clicking on the checkbox in front of the name in the list. You can use key function "Column 
On/Off/Move" in runtime to display the value column in the table again.

4. Configure the properties and the display for each value column.
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5. Define the data source for each value column. Your options are:

– Data source with archive tags of a process value archive

– Data source with online tags from the tag management

6. Click on , to select a tag.

7. Save the configuration.

How to configure the display for the table

How to configure the properties of the table elements

Introduction
You can adjust the properties of the table elements in the WinCC controls to suit requirements. 

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Parameters" tab.

2. Specify the properties for of

– Column header

– Line labeling

– Sorting

– Table content

3. Save the configuration.

How to configure the colors of the table elements

Introduction
You can adjust the colors of the table elements in the WinCC controls to suit requirements. 

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Display" tab.

2. Define the colors for the background or text here for:

– Table content. You can define different colors for even and odd line numbers to improve 
differentiation between both.

– Contents of the table header

– Separating lines in the table and for table headers

3. Define the color and the line weight in the "General" area in terms of:

– Control borders

– Window dividers for control elements

4. Save the configuration.
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How to configure the marking of the selected cells and lines

Introduction
You can customize the marking of the selected cells and rows in the WinCC control to suit 
requirements. 

Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Marker" tab.

2. Define whether to select rows or only cells using the mouse.

3. Configure the properties of the selection rectangle that can be displayed around selected 
table cells or rows.

4. Configure the marking color for selectable cells and/or rows. The system colors are used 
for marking with "Automatic coloring" property.

5. Save the configuration.

How to configure sorting via the column heading

Introduction
You can adjust the sorting order by means of table column header in the WinCC controls to 
suit requirements. 

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1195



Prerequisite
● You opened Graphics Designer and configured a picture with a WinCC control.

● The configuration dialog of the WinCC control is open.

Procedure
1. Go to the "Parameters" tab.

2. Define whether to enable sorting and the sorting method by column header. In WinCC 
AlarmControl, you can only sort by column header if the "Auto-Scrolling" is disabled. You 
can deactivate "Auto-Scrolling" either in the "General" tab, or using the "Autoscroll" toolbar 
icon of the WinCC AlarmControl.

3. Determine the sorting order by mouse click on the column header. Select ascending, 
descending or no sorting order.

4. Configure the sorting icon and index to be displayed in the column header with right 
justification. These show the sorting order and sequence of the columns.

5. Activate the "Use sorting button" to display the sorting icon as sorting button above the 
vertical scroll bar. Click this sorting button to activate a configured sorting order for the 
column selected. The sort button is not displayed if a vertical scroll bar is missing.

6. Save the configuration.

How to configure the toolbar and the status bar 

Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The 
status bar contains information pertaining to the current status of the WinCC control. You can 
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime. 
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Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The WinCC control is assigned the "Configuration dialog" button function for opening the 
configuration dialog in Runtime.

● The configuration dialog of the WinCC control is open.

How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in 
Runtime. For information on the button functions, refer to the description of the 
corresponding WinCC control at "Operation in runtime".
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3. Determine the sorting order for displaying the button functions in the toolbar. Select the 
button functions from the list and the move the functions using the "Up" and "Down" buttons.

4. Define a hotkey for the functions of the toolbar buttons.

5. Any button functions assigned operator authorizations are only available in Runtime to 
authorized users.

6. An activated button function is displayed in runtime if you deactivate its "Active" option, 
however, it cannot be operated.

7. You can set separators between the button functions. Activate the "Separator" option for 
the button function to be restricted by separator.

8. Configure the general properties of the toolbar, e.g. alignment or background color.
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How to configure the status bar
1. Go to the "Status bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required in runtime in the list of status bar elements. For further 
information on status bar elements, refer to the descriptions of the corresponding WinCC 
control at "Operation in runtime".

3. Determine the sorting order for displaying of the status bar elements. Select the elements 
from the list and move these using the "Up" and "Down" buttons.

4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a 
pixel value for the width.

5. Configure the general properties of the status bar, e.g. alignment or background color.
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How to configure the Ruler window/Statistics window/Statistics area window

Introduction
Evaluated data and statistics are shown in a table in a ruler window, statistics window or a 
statistics area window. The ruler window/statistics window/statistics area window are 
configured in the WinCC RulerControl.

Overview of the WinCC RulerControl
The RulerControl can be connected with the following controls:

● WinCC OnlineTrendControl

● WinCC OnlineTableControl

● WinCC FunctionTrendControl

Depending on the data evaluation, there are three different types of windows for displaying 
values. The following window types are available:

● The ruler window shows the coordinate values of the trends on a ruler or values of a selected 
line in the table.

● The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. The statistics area window is not 
planned for the WinCC FunctionTrendControl.

● The statistics window shows the statistic evaluation of the trends between two rulers or the 
selected values in the table. The statistics window is not planned for the WinCC 
FunctionTrendControl.

All windows can also display additional information on the connected trends or columns.
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Requirements
● You have opened a picture with an OnlineTrendControl, OnlineTableControl or 

FunctionTrendControl in the Graphics Designer.

Procedure
1. Insert RulerControl into the picture from the WinCC object palette.

2. Double click on the RulerControl to open the configuration dialog.

3. Configure the properties of the control on the "General", "Toolbar" and "Status bar" tabs.

4. Go to the "General" tab in the field "Source" and select the object name of the control that 
is already configured. The type of control is displayed in the "Type" field.
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5. Set the window type in the "Window" field. If the key function "Configuration dialog" can be 
operated in runtime, you can change the window type in runtime.

6. Go to the "Columns" tab.

7. Use the arrow keys to select the column of the window type that you want to display for the 
assigned control. Columns for the basic data and columns that are only for the selected 
window type or the assigned control are available. Define the column sequence with buttons 
"Up" and "Down".
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8. Go to the "Blocks" tab.

Every column corresponds with a block. In order to define the properties for the selected 
columns, click on the respective blocks.

9. If a special format exists for a block, you can configure the format of the block. Deactivate 
the option "Apply from source" if the format settings of the connected control are not to 
apply in this case. Define the desired format.

10.Define whether the data for the column and the column heading is to be displays as text or 
as an icon in the table under "Display".

11.Save the configuration.
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12.Configure the properties and the display of the table for the RulerControl in the "Parameter," 
"Effects" and "Selection" tabs. You can find more on configuring the display of the table 
under .

13.You can export the evaluated data. This requires activating the "Export data" key function 
on the "Toolbar" tab. You can find more on exporting data under .

14.Configuring the TrendRulerControl is possible in runtime. You can find more on this under .

How to export runtime data

Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set 
up operation of the data export in runtime in the configuration dialog.

Requirements
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.

How to configure the operation of the data export
1. Go to the "Export" tab. 

2. A standard file name and a standard directory are already entered in the "Data export default 
settings." In this case for AlarmControl. If necessary, define a file name and a directory for 
the export file.

3. CSV is currently available as data format. Click on  to define the separator in the CSV 
file.

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
1204 System Manual, 11/2008,  



4. Define the scope of the data export:

– All runtime data is exported

– Selected runtime data is exported. This data export is only possible in WinCC controls 
with tabular display.

5. Configure the operation of the data export in runtime. Define:

– whether users are allowed to rename the file, or change the directory.

– whether to display the "Data export default settings" dialog in Runtime.

6. If "Display dialog" is deactivated, the data for operation of the "Export data" button function 
is immediately exported to the defined export file.

7. Save the configuration.

8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results

You can export all or selected data to a defined file at runtime using button function .

How to define the effect of the online configuration

Introduction
Users can parameterize the WinCC controls in Runtime. You must define the runtime effects 
of the online configuration.

Changes configured at runtime are saved to a separate picture in the configuration system. 
The original picture configuration is retained in the configuration system.

Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults 
are only available in the configuration system. The option buttons are not available in 
runtime.         
Select one of the three effects of the online configuration:

– "Do not retain". The online configurations are not retained in Runtime. This default 
setting disables all options for runtime users. Online configurations are lost at the next 
picture change and on activation/deactivation of the project.

– "Retain during runtime". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the 
project.

– "Retain permanently". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
and on activation/deactivation of the project if the "retain" option is enabled. 

3. Define corresponding user authorizations for online configuration.

4. The option buttons of the "Online configuration on next picture change" can be enabled for 
operation in the configuration system and at runtime by setting the "retain at runtime" and 
"retain permanently" defaults. The "reset" operation is only available in runtime, because 
the configuration system contains the original configuration.         
Select one of three effects of the online configuration at the next picture change:

– Select "discard" if to discard the online configuration at the next picture change.

– Activate "retain" to activate the online configuration based on default settings at the next 
picture change or on activation/deactivation of the project.

– Activate "reset" to activate a picture which is older than the version stored in the 
configuration system for runtime. All online changes are lost.         

Note

The picture is also replaced at runtime if you save it in Graphics Designer, or when 
loading deltas in online mode. All online changes are lost.

5. Save the configuration.

Note

The different configurations are only activated for new users after you performed a picture 
change.

How to make the toolbar for the OnlineTableControl dynamic

Introduction
The default functions for operating the WinCC OnlineTableControl are no longer supported for 
the new WinCC OnlineTableControl as of WinCC V7.0. You can use the WinCC types of 
dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC controls as of V7.0, special functions are no longer required for operating the 
control with toolbar dynamics. The previously used standard functions 
"TlgTableWindowPress..." are no longer supported.

If you do not want to operate the control via the toolbar, you can write the "ID" for the desired 
button in the "ToolbarButtonClick" object property with an optional type of dynamics. 

The "ID" of a button of the toolbar can be determined:
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● with the table on page "Operation of the OnlineTableControl in Runtime".

● in the configuration dialog of the OnlineTableControl on the "Toolbars" tab via field "Object 
ID".

Example: Open the configuration dialog for the control
In order to open the configuration dialog of the control, dynamics are possible as follows:

● VBScript:

– ScreenItems("Control1").ToolbarButtonClick = 2

– As an alternative to the property "ToolbarButtonClick", there are also methods in VBS 
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog

– Or, with the following notation with the support of "Intellisense":          
Dim obj         
Set obj = ScreenItems("Control1")         
obj.ShowPropertyDialog

● C script:

– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);

● Direct connection

– In the dialog for the direct connection for the source, enter "2" as a constant

– Select the property "ToolButtonClick" for the object "Control1" for the target "Object in 
picture"

See also
Operating the OnlineTableControl in runtime (Page 1208)

Operation in Runtime

Operating the OnlineTableControl in runtime

Introduction
In Runtime, the table window is operated by means of the toolbar buttons. If you do not want 
to operate the table window via the toolbar, you can write the "ID" for the desired button in the 
"ToolbarButtonClick" object property with an optional type of dynamics.

Overview

Icon Description ID
"Help"
Calls up the help on WinCC Online TableControl.

1
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"Configuration dialog"
Opens the configuration dialog, in which you can change the properties of 
the Online TableControl.

2

"First Data Record"
This button displays the tag trend over time in the table window, starting with 
the first archived value and extending over a defined time range. The button 
is only available if the values originate from a process value archive.

3

"Previous Data Record"
This button displays the tag trend of the previous time interval in the table 
window, starting from the currently displayed time interval. The button is only 
available if the values originate from a process value archive.

4

"Next Data Record"
This button displays the tag trend of the following time interval in the table 
window, starting from the currently displayed time interval. The button is only 
available if the values originate from a process value archive.

5

"Last Data Record"
This button displays the tag trend over time in the table window, ending with 
the last archived value and extending over a defined time range. The button 
is only available if the values originate from a process value archive.

6

"Edit"
Upon activating this button, you can double-click any table cell to edit its 
contents This requires stopping the updated display.

7

"Copy lines"
Copies the content of the selected lines to the clipboard. This requires 
stopping the updated display.

8

"Select data connection"
This button opens a dialog for the archive selection and tag selection.

9

"Select columns"
This button opens the dialog for toggling the visible and invisible column 
view. You can also change the sequence of the columns in the table.

10

"Select Time Range"
This button opens the dialog where you can specify the time range to be 
displayed in a table window.

11

"Previous column"
This button is used to move the value column in front of the previous value 
column. The function refers to the value columns that are assigned with a 
time axis.

12

"Next column"
This button is used to move the value column in behind of the next value 
column. The function refers to the value columns that are assigned with a 
time axis.

13

"Stop"
The updated display is stopped. The data is saved to the clipboard and 
added to the table when the button is clicked again.

14

"Start"
Resume updated display.

14
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"Print"
Start the print-out of the values shown in the table. The print job used for 
printing is defined in the configuration dialog on the "General" tab.

15

"Export data"
This button is used for exporting all or the selected runtime data into a "CSV" 
file. If the option "Display dialog" is active, a dialog opens in which you can 
view the settings for exporting and can start the export. With the respective 
authorization, you are also allowed to select the file and the directory for the 
export.         
If a dialog is displayed, the export of the data to the predefined file starts 
immediately.

20

"Define statistics area"
This button is used to define the time range for calculating the statistics in 
the table window.

16

"Calculate Statistics"
The button shows the statistical values in the statistics window. The 
displayed values refer to a selected column with the configured calculation 
time range. The button is only functional if a statistics window is connected 
with the OnlineTableControl.

17

"Connect backup"
This button opens a dialog in which you connect the selected archive with 
WinCC Runtime. 

18

"Disconnect backup"
This button opens a dialog in which you disconnect the selected archive from 
WinCC Runtime. 

19

"User-defined 1"
Shows the first key function created by the user. The function of the button 
is user-defined.

1001

Possible elements of the status bar
The following elements can appear in the status bar of the table window:

Icon Name Description

Connection status Shows the status of the data connections:
● No faulty connections
● Faulty connections exist
● All connections are faulty

Selected Row Shows the number of the selected line.

Selected column Shows the number of the selected column.

Date Shows the system date.

Time Shows the system time.

Time Base Shows the time base used in the display of times.
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Double click on the icon for the connection status to open the window "Status of the data 
connections", in which the name, status and tag name of the data connection are listed.

Online configuration of the OnlineTableControl

Introduction
In runtime, you can configure online and change the display of the WinCC OnlineTableControl. 
Configuring the WinCC OnlineTableControl defines how to proceed with a picture change or 
after ending runtime with online configurations.

Overview
The following buttons functions make online configuration possible in OnlineTableControl:

● With key function "Configuration dialog"

● With key function "Select data connection"

● With key function "Select columns"

● With key function "Select time range"

Key function "Configuration dialog"

With the key function "Configuration dialog"  you have access to the configuration dialog 
tab for changing the display of the table for instance.

The key function "Select data connection"

With key function "Select data connection"  you select the archive tags or online tags for 
the value columns, which you want to show in the table:
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Field Description

Value column Choose the configured value column for which you want to change the data 
connection.

Data Source Define whether the selected value column is supplied with an archive tag or online 
tag.

Tag name Select the tag name for the data connection.

The key function "Select column"

Key function "Select column"  opens a dialog for showing or hiding columns. You can 
change the sequence of the value columns that are assigned with a time column. The value 
columns can only be moved in reference to the anchored time column.

Note

The first column of a table window cannot be hidden.

The key function "Select time range"
Select the time range to be displayed for the time columns with key function "Select time range" 

. If the columns of a table window are to be displayed with a common time axis, the 
specified time range applies to all columns.
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Field Description

Time column Select the configured time column for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

The entry format of the date and time depends on the runtime language used.

Starting and Stopping Update

Introduction
The update of the column in the table window can be started and stopped with the "Start/Stop" 
key function. 

Certain key functions, e.g. "Define statistics area", stop the update automatically.

The appearance of the button indicates whether the update is stopped or not:

●
: Update is stopped. Click on the button to continue updating.

●
: Update is started. Click on the button to stop updating.

How to edit a table field in runtime

Introduction
Key function "Edit" can be used to change the displayed values in WinCC OnlineTableControl.

Requirements
● You have configured an OnlineTableControl.

● You have configured the "Edit" key function.

● You have activated runtime.
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Procedure
1.

In OnlineTableControl, click on . The updated display is stopped, the process data 
continues being archived.

2.
Click .

3. Double click on the desired table field of a value column. Now, change the value of the 
table field. The changed values are archived.

4.
In order to continue with the display of runtime data in OnlineTableControl, click on .

How to move the columns in the table

Introduction
The time column is always shown in the first column in the table. The value columns that are 
assigned with this time column are displayed next. If there are more than one time columns 
configured, the second time column follows with the assigned value columns.

How to change the sequence of the columns in runtime
You can change the sequence of the value columns that are assigned with a time column in 
runtime. The value columns can only be moved in reference to the anchored time column. The 
sequence of the time columns with the assigned value columns must be defined on the "Time 
axes" tab. 

Requirements
● You have configured key functions "Select columns", "Previous column" and "Next column".

Procedure
●

 changes the sequence of the columns in the dialog. Deactivate the checkbox in front 
of the column name if you do not want to display the column.

●
 is used to move the value column behind the next value column. The function refers 

to the value columns that are assigned with a time axis.

●
 is used to move the value column in front of the previous value column. The function 

refers to the value columns that are assigned with a time axis.
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How to display archived values

Introduction
Use the buttons in the toolbar of a table window or the corresponding key combinations to 
browse through an archive.

The values archived for a tag will be displayed within a time interval. You define the time interval:

● In the configuration dialog of the Online TableControl on the "Time columns" tab.

●
During runtime using the  button.

Buttons for Archived Values

The table displays the tag values within a specified time range, beginning with 
the first archived value.
The table displays the tag values within the previous time interval, based on the 
currently displayed time interval.
The table displays the tag values within the next time interval, based on the 
currently displayed time interval.
The table displays the tag values within the specified time interval, ending with 
the last archived value.

Note

The WinCC Online Table Control displays a maximum of 1000 values within a selected time 
range.

How to Generate Statistics of Runtime Data

Introduction
You can generate an evaluation of runtime process data in the table window. The evaluated 
data is shown in a separate WinCC RulerControl.
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Overview
Depending on the data evaluation, there are three different types of windows for displaying 
values. The following window types are available: 

● The ruler window shows the values of a selected line in the table.

● The statistics area window shows the values of the lower limit and upper limit of the selected 
area in the table.

● The statistics window shows the statistical evaluation of the selected values in the table. 
Among other things, the statistics include:

– Minimum

– Maximum

– Average

– Standard deviation

– Integral

All windows can also show additional information on the values of the connected columns.

Requirements
● You have configured a WinCC OnlineTableControl.

● You have configured a WinCC RulerControl and connected it with the OnlineTableControl.

● You have selected the window in the RulerControl which shows the desired data.

● You have configured key functions "Set statistics range", "Calculate statistics" and "Start/
Stop". If a display of the values in a ruler window is sufficient, you do not need key functions 
"Select statistics area" and "Calculate statistics".

● You require key function "Select time range", if you wish to choose a statistics area outside 
of the time range displayed in the table.

● You require key function "Configuration dialog" of the RulerControl if you want to switch 
between the statistics window and the ruler window.

● You have activated runtime.
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How to show the data in a ruler window
1.

In OnlineTableControl, click on . The updated display is stopped, the process data 
continues being archived.

2. Select an line. Data in the columns that you have configured is shown in the ruler window.

3.
In order to continue with the display of runtime data in OnlineTableControl, click on .
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How to display the data in a statistics area window
1.

In OnlineTableControl, click on . The updated display is stopped, the process data 
continues being archived.

2. In order to specify the time period for the calculation, use the mouse to select the table lines 
for the desired time frame. For different columns with different time frames you can select 
different time ranges for the calculation of statistics.

3.
Click  in the toolbar. The evaluated data is displayed in the columns that you have 
configured in the statistics area window.

4. If you want an evaluation of data that is not displayed in OnlineTableControl, click on 

. Enter the desired time range for the selected time column in the "Time selection" 
dialog. The data for the defined time range is displayed. You can now evaluate this data.

5.
In order to continue with the display in OnlineTableControl, click on .
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How to display the data in a statistics window
1.

In OnlineTableControl, click on . The updated display is stopped, the process data 
continues being archived.

2.
Click . In order to specify the time period for the calculation, use the mouse to select 
the table lines for the desired time frame. For different columns with different time frames 
you can select different time ranges for the calculation of statistics.

3.
Click . The evaluated data is displayed in the columns that you have configured in the 
statistics window.

4. If you want an evaluation of process data that is not displayed in OnlineTableControl, click 

on . Enter the desired time range for the selected time column in the "Time selection" 
dialog. The process data for the defined time range is displayed. You can now evaluate 
this data.

5.
In order to continue with the display in OnlineTableControl, click on .

Note

For additional statistical analysis of process data and archiving of results you can write 
the scripts yourself.
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6.5.2.3 Process Value Output in the Form of Trends in Process Pictures

Resources

WinCC OnlineTrendControl

Introduction
In order to process data in graphic form, WinCC uses Online TrendControl to offer the option 
of displaying the data as a trend. The trend display can be configured as you wish. The trends 
can display currently incoming values and archived values.

Requirements
The following requirements apply to the display of trends in WinCC Online Trend Control:

● In a WinCC Online Trend Control any number of trends can be displayed in one or more 
trend windows. Displaying a maximum of 8 trends is recommended.

● In order to display tags as a function of other tags, use the WinCC Function Trend Control.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen 
resolution and selected size of the trend window. Therefore, when displaying trends, it is 
possible that fewer values are displayed in the trend window than actually exist.

If, for example, in an area of 100 pixels 200 measured values are archived, each pixel 
represents 2 measured values. The value shown on the screen is that of the most recent data 
(most recent time stamp).
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See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

Representation Trend Lines

Representation Trend Lines

Introduction
The WinCC OnlineTrendControl has many ways of displaying the progress of a trend.
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Representation formats
To display values graphically, three basic representation types are available:

● No trend         
The values are shown as dots. The display of the points can be configured as you wish.

● Connect dots linearly         
The trend line is interpolated on a linear basis from the point values. The display of the lines 
and points can be configured as you wish.

● Stepped trend         
The progress of the trend line is determined from the values as a stepped trend. The display 
of the lines and points can be configured as you wish.

The display of the trend can be configured on the "Trends" tab of the OnlineTrendControl.

Write direction
With the write direction option, you can specify where the current values for all trend windows 
are to be entered. Normally, the current values are written in the trend window from the right. 
All four write directions can be configured. The write direction is configured on the "General" 
tab of the OnlineTrendControl.

Representation Using Common Axes

Introduction
When displaying more than one trend in a trend window, you can assign every trend with its 
own axes or use a common time axis and/or value axis for all trends.
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Representation Using Different Axes
If the values to be displayed in a trend window differ greatly, a common value axis makes no 
sense. The values can be read more easily if different axial scales are used. Individual axes 
can be hidden if required.

Representation Using Common Axes
If the comparability of the trend lines is important, common axes in a trend window is sensible. 
Connected trend windows can have a common time axis.
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Configuring
The axes are configured on the "Value axis" and "Time axis" tabs of OnlineTrendControl. The 
assignment of the axes for the trends can be configured on the "Trends" tab. In this case, you 
can assign the individual trends to the same axes.

Note

In OnlineTrendControl, only tags with the same update cycles should be displayed for more 
than one trend with a common time axis. In the case of different updating cycles, the length 
of the time axis is not identical for all tags. Since the trends are updated at different times 
due to the different updating cycles, a minimal different in the end time for the time axis occurs 
on each change. As a result, the trends displayed skip slightly to and fro on each change.

Configuring the OnlineTrendControl

How to configure the OnlineTrendControl

Introduction
In runtime, the trends are displayed in an ActiveX control. You can configure a WinCC 
OnlineTrendControl for this in the Graphics Designer.

Configuration steps
1. Insert the OnlineTrendControl into a picture of the Graphics Designer.

2. Configure the basic properties for the OnlineTrendControl on the "General" tab:

– the window properties of the control

– the display of the control

– the write direction of the trend values

– the time base of the control

3. Define one or more trend windows.

4. Configure one or more time axes and value axes with their respective properties. Assign 
the axes to the trend windows.

5. Define trends that you want to display in the trend windows. Assign the trends to the trend 
windows. The value axis of a trend can only be the value axis of the assigned trend window. 
Assign the trends with one or more time axes.

6. Every configured trend must be connected with an online tag or an archive tag. Define the 
data connection for each trend.

7. Configure the display for each trend.

8. Configure the toolbar and status bar of the trend window.
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9. If you want to display coordinates or statistic values, configure a ruler window, statistics 
window or statistics area window as well. Connect the ruler window/statistics window/
statistics area window with the OnlineTrendControl.

10.Save the configurations.

How to create trend windows in OnlineTrendControl

Introduction
The WinCC OnlineTrendControl can contain one or more trend windows. The trend window 
provides an area to display trends in.

Overview of the trend window
The trend window has the following properties:

● Every trend window is assigned with at least one trend, which has one time axis and one 
value axis.

● The value axis of the trend determines the trend window, in which the trend will be displayed.

● A trend can only be assigned to one trend window.

● Several trends can be displayed in a trend window.

● A trend window can display value axes, independent of the displayed trends. Value axes 
and time axes can be hidden in runtime.

● The sequence of the configured trend window is determined by the position in 
OnlineTrendControl. The first trend window in the list of trend windows is displayed in the 
lower position, the last trend window is shown in the top position.

● If more than one trend window is configured, the trend windows can be connected. The 
connected trend windows have the following properties:

– They can have a common time axis.

– They have a scroll bar.

– They have a ruler.

– The zoom functions for a trend window affect the connected trend windows.
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Procedure
1. Define one or more trend windows with the "New" button on the "trend windows" tab.

2. If you have defined more than one trend window, more configurations are possible:

– Assign every trend window with an area selection in the displayed OnlineTrendControl.

– Define the position of the trend windows with the "Up" and "Down" buttons.

– Define whether the trend window will be connected on the "General" tab.

3. If you want to hide a trend window in runtime, deactivate the checkbox in front of the name 
of the trend window in the list. The respective axes are then hidden as well.

4. Configure the gridlines for every trend window.
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5. Configure the display of the ruler. If you want to use a statistics area window, configure the 
ruler that will be used with the statistics area as well.

6. If you use "Graphic" for the display of the ruler, you can configure the color and the line 
weight of the ruler.

7. Define the level on which to display the ruler in the trend window.

8. Save the configuration.

How to configure the time axes of trend windows

Introduction
The time range for trend display is configured with time axes. Several time axes can be 
assigned with one or more trend windows. Connected trend windows may have a common 
time axis.

Time range of the trend display
Basically, there are two different time references in the trend display:

● Static display. The time range of the trend display is determined by a pre-defined, fixed 
time interval, independent of the current system time.

● Dynamic display. The time range of the trend display is determined retrospectively from the 
most current values. The display is continuously updated. The configured time range follows 
the current system time.

You have three different ways to define the time range of a time range for each of the two time 
references:
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● The trend is displayed within a defined time interval. You define a start time and an end 
time. In a dynamic display, the end time corresponds with the current system time. The 
time between the start time and the end time is the time range for the trend display.

● The trend is displayed from a start time throughout a defined time range, e.g. 30 minutes 
from the start time. In the dynamic display, the defined time range up to the current system 
time is used, e.g. 30 minutes to the current system time.

● Starting from a start time, a defined number of values are shown, e.g. 100 values from the 
start time. With the dynamic display, the last values up to the current system time are shown.

Requirements
● You have opened a picture with the OnlineTrendControl in the Graphics Designer.

● You have defined one or more trend windows.
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Procedure
1. Define one or more time axes with the "New" button on the "Time axes" tab.

2. Define the positioning of the configured time axes for a trend window. The sequence in the 
list of time axes determines the positioning in the trend window. If several time axes are 
arranged on the same page of a trend window, the first time axis in the list assumes the 
position in the bottom left and the last time axis in the list then assumes the position at the 
top right.

3. Assign the time axes to the configured trend windows.

4. If you want to hide a time axis in the trend window, click on the checkbox in front of the 
name of the time axis in the list. You can display the axes again in runtime with the key 
functions.
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5. Configure the properties and the formats for time and date for every time axis.

6. If the trends in the trend window assigned to the time axis are always updated, activate the 
"Update" option. If you e.g. want to compare a current trend display with an earlier trend 
display, deactivate the "Update" option for the time axis of the comparison trend.

7. Configure the time range for every time axis:

– If you want to define a fixed time interval, select setting "Start to end time". Enter the 
date and time for each.

– If you want to define a time period, select the setting "Time range". Define the date and 
time for the start time. The time range is the result of a multiplication of the "Factor" and 
"Time unit", e.g. 30 times "1 minute" for a time range of 30 minutes. Enter the factor and 
the time unit in the "Time range" field.

– If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

8. Save the configuration.

Note

Upon opening the picture of a trend window in runtime, the trend values to be displayed 
are either read from the archive or are set to zero. Define what is to be done via the "Load 
archive data" option on the "General" tab.

How to configure the value axes of trend windows

Introduction
You can configure several value axes that you will assign to one or more trend windows. 
Configure the value range and the scaling for every value axis.

If you have defined a value axis, the value range and the scaling are pre-configured as follows:

● The value range is based on the current values of the assigned trend.

● The value axis scale is linear to the value range.

Requirements
● You have opened the picture with the OnlineTrendControl in the Graphics Designer.

● You have defined trend windows.
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Procedure
1. Define one or more value axes with the "New" button on the "value axes" tab.

2. Assign the value axes to the configured trend windows.

3. If you want to hide a value axis in the trend window, click on the checkbox in front of the 
name of the value axis in the list. You can display the value axes again in runtime with the 
key functions.

4. Configure the orientation and the scaling for every value axis.

5. Configure the display of the value axis in trend windows.

6. Deactivate the "Automatic" option in "Value range" if you want to define a fixed value range 
for the value axis.
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7. Enter the minimum value and maximum value of the value range in the input fields "From:" 
and "To:".

8. If you want to define the scaling of the value axis yourself, activate the "Use" option in field 

"User scaling". Click on  to open the "User scaling" dialog.

9. Click "Add" to define an area. You must define segments without gaps for the entire 
configured value range and assign areas on the value axis. If you have defined a value 
range of "0 - 100000" you can divide this value range e.g. into three sections that you can 
display as follows on the value axis:

E.g. value range "0 - 50000" is displayed in runtime on the value axis in the "100 - 500" 
range.

10.In a ruler window, the key function "Ruler" displays e.g. measurement values. You can have 
a name shown as well in the "Y value" of the ruler window next to the measurement value 
and the status display "i" and "u". Area names can be assigned for certain value ranges.

11.If you want to display area names, activate the "Display" option in the "Area names" field. 

Click on  to open the "Area names" dialog.
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12.Click "Add" to define ranges with the respective names.

13.Save the configuration for the value axis.

How to create trends for the trend window

Introduction
Every trend is assigned with a time axis and a value axis. The value axis assigned to the trend 
determines the trend window, in which the trend will be displayed. 

Requirements
● You have inserted the OnlineTrendControl into a picture of the Graphics Designer.

● You have configured time axes, value axes and trend windows.

● The following prerequisites apply for the data source:

– If you want to connect data of online tags, you have to have defined process values in 
the tag management.

– If you want to connect the data from archive tags, you have to have configured a process 
value archive with archive tags.

– If you want to supply the trend values with data in runtime with scripts, you require a 
script via the API interface.
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Procedure
1. Go to the "Trends" tab.

2. Use the "New" button to define the desired number of trends.

3. Define the sequence of trends in the trend window using "Up" and "Down" keys.

4. Assign each trend of trend window with a time axis and a value axis.

5. Define the data source for each trend. You can select the following:

– Archive tags of a process value archive

– Online tags from the tag management

– No configured data source to establish a connection in runtime via a script.
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6. Click on  to select a tag for the trend.

7. Configure the value range for the data in which the trend will be displayed. Click the  
button in the "Data connection" field. The dialog "Automatic value range" will be opened.

Choose how the value range is defined from the following possibilities:

– Automatically from the displayed data.

– From the defined value range. Enter the values for the lower limit and the upper limit of 
the value range.

– From online tags. The lower limit and the upper limit of the value range are made from 
the values from connected online tags. Enter a tag name for the lower limit and the upper 
limit.

8. Configure the display for each trend. More information can be found on page "How to 
configure the display of trends".

9. Save the configuration.

How to configure the display of trends

Introduction
You can adjust the display of trends to suit your requirements in the WinCC controls. The 
following WinCC controls are shown in trends:

● WinCC OnlineTrendControl

● WinCC FunctionTrendControl
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Overview
The following trends features can be configured:

● The types of trends and trend lines

● The properties of trend lines

● The colors of the trends, the trend points and the fill color

● Color identification for a limit value violation

Requirements
● You have opened the Graphics Designer and configured a picture with the above mentioned 

WinCC control.

● The configuration dialog of the WinCC control is opened.
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Configuring the types of trends and trend lines
1. Go to the "Trends" tab. Here e.g. in WinCC OnlineTrendControl.

2. Choose a trend under "Trends".

3. Define the type of the trends and trend lines in the "Display" area.

4. If you want to highlight the display of the area under the trend, activate the "Filled" option.

5. In the small picture in the right-hand margin of the "Display" area, the result of the 
configuration is shown.

6. Save the configuration.
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Configuring the properties of trend lines
1. Choose a trend under "Trends".

2. Define the properties of the trend lines in the "Display" area.

3. Define the line weight and the properties of the trend points.

4. In the small picture in the right-hand margin of the "Display" area, the result of the 
configuration is shown.

5. Save the configuration.

Configuring the colors of the trends, the trend points and the fill color
1. Choose a trend under "Trends".

2. Define the colors in the "Display" area.

3. If you want to configure the colors of the trend points and the fill color, activate the 
"Extended" option.

4. In the small picture in the right-hand margin of the "Display" area, the result of the 
configuration is shown.

5. Save the configuration.

Configuring the color identification for a limit value violation
1. Choose a trend under "Trends".

2. Click in the "Display" area on the "Limit values" button. This will open the "Limit values" 
dialog.

3. Activate the limit values, for which you want a colored identification.

4. Define the color for every activated option.
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5. The colored identification has the following effect:

– Low limit value. Whenever a displayed trend value is below the value defined in the 
"Value" input field, the value is shown in the configured color.

– High Limit Value. Whenever a displayed trend value is above the value defined in the 
"Value" input field, the value is shown in the configured color.

– Value with uncertain status. Values, whose start value is unknown on activating runtime 
or for which a substitute value is used, have an uncertain status. These values are 
displayed in the configured colors.

6. Save the configuration.

How to configure the toolbar and the status bar 

Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The 
status bar contains information pertaining to the current status of the WinCC control. You can 
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime. 

Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The WinCC control is assigned the "Configuration dialog" button function for opening the 
configuration dialog in Runtime.

● The configuration dialog of the WinCC control is open.

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1239



How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in 
Runtime. For information on the button functions, refer to the description of the 
corresponding WinCC control at "Operation in runtime".

3. Determine the sorting order for displaying the button functions in the toolbar. Select the 
button functions from the list and the move the functions using the "Up" and "Down" buttons.

4. Define a hotkey for the functions of the toolbar buttons.

5. Any button functions assigned operator authorizations are only available in Runtime to 
authorized users.
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6. An activated button function is displayed in runtime if you deactivate its "Active" option, 
however, it cannot be operated.

7. You can set separators between the button functions. Activate the "Separator" option for 
the button function to be restricted by separator.

8. Configure the general properties of the toolbar, e.g. alignment or background color.

How to configure the status bar
1. Go to the "Status bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required in runtime in the list of status bar elements. For further 
information on status bar elements, refer to the descriptions of the corresponding WinCC 
control at "Operation in runtime".
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3. Determine the sorting order for displaying of the status bar elements. Select the elements 
from the list and move these using the "Up" and "Down" buttons.

4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a 
pixel value for the width.

5. Configure the general properties of the status bar, e.g. alignment or background color.

How to configure the Ruler window/Statistics window/Statistics area window

Introduction
Evaluated data and statistics are shown in a table in a ruler window, statistics window or a 
statistics area window. The ruler window/statistics window/statistics area window are 
configured in the WinCC RulerControl.

Overview of the WinCC RulerControl
The RulerControl can be connected with the following controls:

● WinCC OnlineTrendControl

● WinCC OnlineTableControl

● WinCC FunctionTrendControl

Depending on the data evaluation, there are three different types of windows for displaying 
values. The following window types are available:

● The ruler window shows the coordinate values of the trends on a ruler or values of a selected 
line in the table.

● The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. The statistics area window is not 
planned for the WinCC FunctionTrendControl.

● The statistics window shows the statistic evaluation of the trends between two rulers or the 
selected values in the table. The statistics window is not planned for the WinCC 
FunctionTrendControl.

All windows can also display additional information on the connected trends or columns.
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Requirements
● You have opened a picture with an OnlineTrendControl, OnlineTableControl or 

FunctionTrendControl in the Graphics Designer.

Procedure
1. Insert RulerControl into the picture from the WinCC object palette.

2. Double click on the RulerControl to open the configuration dialog.

3. Configure the properties of the control on the "General", "Toolbar" and "Status bar" tabs.

4. Go to the "General" tab in the field "Source" and select the object name of the control that 
is already configured. The type of control is displayed in the "Type" field.
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5. Set the window type in the "Window" field. If the key function "Configuration dialog" can be 
operated in runtime, you can change the window type in runtime.

6. Go to the "Columns" tab.

7. Use the arrow keys to select the column of the window type that you want to display for the 
assigned control. Columns for the basic data and columns that are only for the selected 
window type or the assigned control are available. Define the column sequence with buttons 
"Up" and "Down".
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8. Go to the "Blocks" tab.

Every column corresponds with a block. In order to define the properties for the selected 
columns, click on the respective blocks.

9. If a special format exists for a block, you can configure the format of the block. Deactivate 
the option "Apply from source" if the format settings of the connected control are not to 
apply in this case. Define the desired format.

10.Define whether the data for the column and the column heading is to be displays as text or 
as an icon in the table under "Display".

11.Save the configuration.
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12.Configure the properties and the display of the table for the RulerControl in the "Parameter," 
"Effects" and "Selection" tabs. You can find more on configuring the display of the table 
under .

13.You can export the evaluated data. This requires activating the "Export data" key function 
on the "Toolbar" tab. You can find more on exporting data under .

14.Configuring the TrendRulerControl is possible in runtime. You can find more on this under 
How to define the effect of the online configuration (Page 1247).

See also
How to define the effect of the online configuration (Page 1247)

How to export runtime data

Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set 
up operation of the data export in runtime in the configuration dialog.

Requirements
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.

How to configure the operation of the data export
1. Go to the "Export" tab. 

2. A standard file name and a standard directory are already entered in the "Data export default 
settings." In this case for AlarmControl. If necessary, define a file name and a directory for 
the export file.
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3. CSV is currently available as data format. Click on  to define the separator in the CSV 
file.

4. Define the scope of the data export:

– All runtime data is exported

– Selected runtime data is exported. This data export is only possible in WinCC controls 
with tabular display.

5. Configure the operation of the data export in runtime. Define:

– whether users are allowed to rename the file, or change the directory.

– whether to display the "Data export default settings" dialog in Runtime.

6. If "Display dialog" is deactivated, the data for operation of the "Export data" button function 
is immediately exported to the defined export file.

7. Save the configuration.

8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results

You can export all or selected data to a defined file at runtime using button function .

How to define the effect of the online configuration

Introduction
Users can parameterize the WinCC controls in Runtime. You must define the runtime effects 
of the online configuration.

Changes configured at runtime are saved to a separate picture in the configuration system. 
The original picture configuration is retained in the configuration system.

Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults 
are only available in the configuration system. The option buttons are not available in 
runtime.         
Select one of the three effects of the online configuration:

– "Do not retain". The online configurations are not retained in Runtime. This default 
setting disables all options for runtime users. Online configurations are lost at the next 
picture change and on activation/deactivation of the project.

– "Retain during runtime". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the 
project.

– "Retain permanently". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
and on activation/deactivation of the project if the "retain" option is enabled. 

3. Define corresponding user authorizations for online configuration.

4. The option buttons of the "Online configuration on next picture change" can be enabled for 
operation in the configuration system and at runtime by setting the "retain at runtime" and 
"retain permanently" defaults. The "reset" operation is only available in runtime, because 
the configuration system contains the original configuration.         
Select one of three effects of the online configuration at the next picture change:

– Select "discard" if to discard the online configuration at the next picture change.

– Activate "retain" to activate the online configuration based on default settings at the next 
picture change or on activation/deactivation of the project.

– Activate "reset" to activate a picture which is older than the version stored in the 
configuration system for runtime. All online changes are lost.         

Note

The picture is also replaced at runtime if you save it in Graphics Designer, or when 
loading deltas in online mode. All online changes are lost.

5. Save the configuration.

Note

The different configurations are only activated for new users after you performed a picture 
change.

How to make the toolbar for the OnlineTrendControl dynamic 

Introduction
The default functions for operating the WinCC OnlineTrendControl are no longer supported 
for the new WinCC OnlineTrendControl as of WinCC V7.0. You can use the WinCC types of 
dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC controls as of V7.0, special functions are no longer required for operating the 
control with toolbar dynamics. The previously used standard functions 
"TlgTrendWindowPress..." and "TrendToolbarButton" are no longer supported.

If you do not want to operate the control via the toolbar, you can write the "ID" for the desired 
button in the "ToolbarButtonClick" object property with an optional type of dynamics. 

The "ID" of a button of the toolbar can be determined:
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● with the table on page "Operation of the OnlineTrendControl in Runtime".

● in the configuration dialog of the OnlineTrendControl on the "Toolbar" tab via field "Object 
ID".

Example: Open the configuration dialog for the control
In order to open the configuration dialog of the control, dynamics are possible as follows:

● VBScript:

– ScreenItems("Control1").ToolbarButtonClick = 2

– As an alternative to the property "ToolbarButtonClick", there are also methods in VBS 
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog

– Or, with the following notation with the support of "Intellisense":          
Dim obj         
Set obj = ScreenItems("Control1")         
obj.ShowPropertyDialog

● C script:

– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);

● Direct connection

– In the dialog for the direct connection for the source, enter "2" as a constant

– Select the property "ToolButtonClick" for the object "Control1" for the target "Object in 
picture"

See also
Operating the OnlineTrendControl in runtime (Page 1250)

Operation in Runtime

Operating the OnlineTrendControl in runtime

Introduction
The trend window is operated in runtime via the buttons in the toolbar. If you do not want to 
operate the trend window via the toolbar, you can write the "ID" for the desired button in the 
"ToolbarButtonClick" object property with an optional type of dynamics.

Overview

Icon Description ID
"Help"
Calls up the help on WinCC OnlineTrendControl.

1
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"Configuration dialog"
Opens the configuration dialog, in which you can change the properties of 
the OnlineTrendControl.

2

"First Data Record"
This button displays the tag trend over time in the trend window, starting with 
the first archived value and extending over a defined time range. The button 
is only available if the values originate from a process value archive.

3

"Previous Data Record"
This button displays the tag trend of the previous time interval in the trend 
window, starting from the currently displayed time interval. The button is only 
available if the values originate from a process value archive.

4

"Next Data Record"
This button displays the tag trend of the following time interval in the trend 
window, starting from the currently displayed time interval. The button is only 
available if the values originate from a process value archive.

5

"Last Data Record"
This button displays the tag trend over time in the trend window, ending with 
the last archived value and extending over a defined time range. The button 
is only available if the values originate from a process value archive.

6

"Zoom area"
Define an area by dragging with the mouse in the trend window. This cut-out 
of the trend window is made larger. The "Original view" button brings back 
the original size of the view.

8

"Zoom +/-"
Zooms in on or out off the trends in the trend window. The left mouse button 
increases the size of the trends. By holding the "Shift" button down, the left 
mouse button zooms out of the trends. The "Original view" button brings 
back the original size of the view.

9

"Zoom time axis +/-"
Zooms in on or out off the time axes in the trend window. The left mouse 
button increases the size of the time axes. By holding the "Shift" button down, 
the left mouse button zooms out of the time axes. The "Original view" button 
brings back the original size of the view.

10

"Zoom value axis +/-"
Zooms in on or out off the value axes in the trend window. The left mouse 
button increases the size of the value axes. By holding the "Shift" button 
down, the left mouse button zooms out of the value axes. The "Original view" 
button brings back the original size of the view.

11

"Move trend area"
This button moves the trends along the time axis and the value axis in the 
trend window. 

12

"Move axes area"
This button moves the trends along the value axis in the trend window.

13

"Original view"
This button returns from the zoomed trend display back to the original view.

14

"Select data connection"
This button opens a dialog for the archive selection and tag selection.

15
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"Select trends"
This button opens the dialog for toggling the visible and invisible trends. You 
can also define which trend is displayed in the foreground.

16

"Select Time Range"
This button opens the dialog where you can specify the time range to be 
displayed in a trend window.

17

"Previous trend"
This button is used for displaying the previous trend of the trend window in 
the foreground.

18

"Next trend"
This button is used for displaying the next trend of the trend window in the 
foreground.

19

"Stop"
The updated display is stopped. The data is saved to the clipboard and 
added when the button in the trend window is clicked again.

20

"Start"
Resume updated display.

20

"Print"
Click this button to print the trend shown in the trend window. The print job 
used for printing is defined in the configuration dialog on the "General" tab.

21

"Export data"
This button is used for exporting all or the selected runtime data into a "CSV" 
file. If the option "Display dialog" is active, a dialog opens in which you can 
view the settings for exporting and can start the export. With the respective 
authorization, you are also allowed to select the file and the directory for the 
export.         
If a dialog is displayed, the export of the data to the predefined file starts 
immediately.

26

"Ruler"
The coordinate points of a trend are queried with this button. The trend data 
is displayed in the ruler window.

7

"Define statistics area"
This button is used to define the time range for calculating the statistics in 
the trend window.

22

"Calculate Statistics"
The button shows the statistical values in the statistics window. The 
displayed values refer to a selected trend with the configured calculation 
time range. The button is only functional if a statistics window is connected 
with the OnlineTrendControl.

23

"Connect backup"
This button opens a dialog in which you connect the selected archive with 
WinCC Runtime. 

24

"Disconnect backup"
This button opens a dialog in which you disconnect the selected archive from 
WinCC Runtime. 

25
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"Relative axis"
Switches from displaying the absolute values to the percentage display of 
value axis. The high and low limits for the trend correspond with a range of 
0 to 100%.

27

"User-defined 1"
Shows the first key function created by the user. The function of the button 
is user-defined.

1001

Possible elements of the status bar
The following elements can appear in the status bar of the trend window:

Icon Name Description

Connection status Shows the status of the data connections:
● No faulty connections
● Faulty connections exist
● All connections are faulty

Date Shows the system date.

Time Shows the system time.

Time Base Shows the time base used in the display of times.

Double click on the icon for the connection status to open the window "Status of the data 
connections", in which the name, status and tag name of the data connection are listed.

Online configuration of the OnlineTrendControl

Introduction
In runtime, you can configure online and change the display of the WinCC OnlineTrendControl. 
Configuring the OnlineTrendControl defines how to proceed with a picture change or after 
ending runtime with online configurations.

Overview
The following buttons functions make online configuration possible in OnlineTrendControl:

● With key function "Configuration dialog"

● With key function "Select data connection"

● With key function "Select trends"

● With key function "Select time range"
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Key function "Configuration dialog"
With the key function "Configuration dialog" you have access to the configuration dialog tab, 
e.g. for changing the display of the trend.

The key function "Select data connection"
With key function "Select data connection" you select the archive tags or online tags for the 
value axes, which you want to show in the trend.

Field Description

Trend Choose one of the configured trends.
Data Source Define whether the selected trend is supplied with an archive tag or online tag.
Tag name Select the tag name for the data connection.

Key function "Select trends"

The key function "Select trends"  opens a dialog, in which you can show or hide trends. 
You move trends to the foreground by changing the sequence of the trends. 

Note

The first trend of a trend window can not be hidden.
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Key function "Select Time Range"
Select the time range to be displayed for the time axes with key function "Select time range" 

. If the trends in a trend window are to be displayed with a common time axis, the specified 
time range applies to all trends.

Field Description

Time axis Select the configured time axis for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

The entry format of the date and time depends on the Runtime language used.

Starting and Stopping Update

Introduction
The update of the trend in the trend window can be started and stopped with the "Start/Stop" 
key function.

The button indicates whether the update is stopped or not:
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●
: Update is stopped. Click on the button to continue updating.

●
: Update is started. Click on the button to stop updating.

How to display the trend in the foreground

Introduction
If more than one trend are to be displayed in a trend window, you can use key functions to 
define which trends will be displayed in the foreground.

Requirements
● You have configured key functions "Select trends", "Previous trend" and "Next trend".

Procedure
●

 is used for opening a dialog for displaying or hiding trends. You can also define which 
trend is in the foreground.

●
 is used for displaying the next trend of the trend window in the foreground.

●
 is used for displaying the previous trend of the trend window in the foreground.

How to Determine the Coordinates of a Point

Introduction
Key function "Ruler" is used for using a ruler to determine the coordinates of a point on the 
trend. You can zoom in on an area of the trend to make coordinate finding easier. If you click 
on the trend with the mouse, several trend parameters are shown in the tooltip for the trend 
window.

Requirements
● You have configured a WinCC OnlineTrendControl. In order to highlight the ruler in the 

trend window, you can increase the line weight of the ruler on the "Trend window" tab and 
configure the color.

● You have configured the "Ruler" key function. If you want to zoom in on a section of the 
trend, configure key functions "Zoom area" and "Original view".

● You have configured a WinCC RulerControl and connected it with the OnlineTrendControl.
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● You have selected the ruler window in the RulerControl which shows the coordinates.

● You have activated runtime.

How to display the coordinates
1.

In OnlineTrendControl, click on .

2. Move the ruler to the desired position with the mouse.

3.
If you want to zoom in on an area, click on . Move the ruler to the desired position with 
the mouse.

4.
If you want to return to the original view, click on .

Result
A ruler appears in the trend window. In the ruler window, besides the X value/time stamp and 
the Y value, the data that you have configured in WinCC RulerControl is shown in the columns. 

The displayed values can be assigned an additional attribute in the form of a letter:
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● Letter "i." : The displayed value is an interpolated value.

● Letter "u." : The displayed value has an uncertain status. The value is not certain if the initial 
value is not known after runtime has been activated, or when a substitute value is used.

Other values can be determined by positioning the mouse pointer on the ruler and moving it 
to the desired position while holding the left mouse button pressed.

Note

The "uncertain" status of a value can also be indicated in the displayed trend characteristic. 
You must activate the "Value with uncertain status" option on the "Trends" tab under "Limit 
values". 

How to use the zoom functions in trend windows

Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view 
for trends, axes and various zoom areas of the trend window.
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Overview
The following zoom functions are available in the trend window:

● "Zoom area"

● "Original view"

● "Zoom +/-"

● "Zoom time axis +/-"

● "Zoom value axis +/-"

● "Move trend area"

Requirements
● You have configured a WinCC OnlineTrendControl.

● You have configured the buttons for the required zoom functions for the toolbar.

● You have activated runtime.

How to zoom in on a segment of a trend window
1.

Click . The updated display is stopped.

2. In the trend window, click one corner of the area that you wish to enlarge.

3. Hold down your left mouse button and drag the area you want to enlarge until it reaches 
the desired size. If the highlighted area contains at least two measured values, the selected 
trend area is displayed in the trend window.

4. Release the left mouse button. The selected segment is magnified. If you want to increase 
the size further, repeat the process.

5.
Click . The trend window is shown in the originally configured view again.

6.
Click on  to start the update again. The values that have been defined earlier are used 
for the X axis and the Y axis.

How to zoom in and zoom out of the trends
1.

Click . The updated display is stopped.

2. Click in the trend window with the left mouse button to zoom in on the trends in the trend 
window. If you want to increase the size further, repeat the process.

3. If you want to zoom out of the trends, press the "Shift" button while clicking with the left 
mouse button.

4. While zooming in or zooming out with trends, the 50% value of the trends is always in the 
middle of the value axes.
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5.
Click . The trend window is shown in the original view again.

6.
Click on  to start the update again. The values that have been defined earlier are used 
for the X axis and the Y axis.

Note

If you change the value area of a value axis on the "Value Axis" tab in the configuration 
dialog while zooming, the visible zoom area is set to the new value area.

How to zoom with time axes and value axes
1.

Click on  to zoom time axes or on  to zoom value axes. The updated display is 
stopped.

2. Click in the trend window with the left mouse button to zoom in on the time axes or value 
axes. If you want to increase the size further, repeat the process.

3. If you want to zoom out of the time axes or value axes, press the "Shift" button while clicking 
with the left mouse button.

4. While zooming with axes, the 50% value of the trend is always in the middle of the axes.

5.
Click . The trend window is shown in the original view again.

6.
Click on  to start the update again. The values that have been defined earlier are used 
for the X axis and the Y axis.

How to move the trend area
1.

Click . The updated display is stopped.

2. While holding the left mouse button down, move the cursor in the desired direction in the 
trend window. The displayed area in the trend window is adapted on the time axis and on 
the value axis.

3.
If you click on  again, the trend window is shown in the original view again.

How to Generate Statistics of Runtime Data

Introduction
You can generate an evaluation of runtime process data in the trend window. The evaluated 
data is shown in the WinCC RulerControl.
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Overview
Depending on the data evaluation, there are three different types of windows for displaying 
values. The following window types are available: 

● The ruler window shows the coordinates of a trend on the ruler.

● The statistics area window shows the values of the lower limit and upper limit of the trends.

● The statistics window shows the statistical evaluation of the trends. Among other things, 
the statistics include:

– Minimum

– Maximum

– Average

– Standard deviation

– Integral

All windows can also show additional information on the values of the connected trends.

Requirements
● You have configured a WinCC OnlineTrendControl. In order to highlight the ruler defining 

the statistics area, you can increase the line weight of the ruler on the "Trend window" tab 
and configure the color.

● You have configured a WinCC RulerControl and connected it with the OnlineTrendControl.

● You have selected the window in the RulerControl which shows the desired data.

● You have configured key functions "Set statistics range", "Calculate statistics" and "Start/
Stop". If a display of the values in a ruler window is sufficient, you do not need key functions 
"Select statistics area" and "Calculate statistics".

● You require key function "Select time range", if you wish to choose a statistics area outside 
of the time range displayed in the trend window.

● You require key function "Configuration dialog" if you want to switch between the statistics 
windows and the ruler window.

● You have activated runtime.

How to display the data in a statistics area window
1.

Click on  in OnlineTrendControl if the updated display is supposed to be stopped.

2.
Click . The updated display is stopped, process data continue to be archived. Two 
vertical lines are displayed at the left and right edge of the trend window.

3. Move the ruler until the desired area is selected.
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4. The evaluated data is displayed in the columns that you have configured in the statistics 
area window.

5. If you want an evaluation of data that is not displayed in OnlineTrendControl, click on 

. Enter the desired time range for the selected time axis in the "Time selection" dialog. 
The data for the defined time range is displayed. You can now evaluate this data.

6.
In order to continue with the display in OnlineTrendControl, click on .

How to display the data in a statistics window
1.

In OnlineTrendControl, click on . The updated display is stopped, the process data 
continues being archived.

2.
Click . The updated display is stopped, process data continue to be archived. Two 
vertical lines are displayed at the left and right edge of the trend window.

3. Move the ruler until the desired area is selected.

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
1262 System Manual, 11/2008,  



4.
Click . The evaluated data is displayed in the columns that you have configured in the 
statistics window.

5. If you want an evaluation of data that is not displayed in OnlineTrendControl, click on 

. Enter the desired time range for the selected time axis in the "Time selection" dialog. 
The data for the defined time range is displayed. You can now evaluate this data.

6.
In order to continue with the display in OnlineTrendControl, click on .

Note

The displayed values can be assigned an additional attribute in the form of a letter:
● Letter "i." : The displayed value is an interpolated value.
● Letter "u." : The displayed value has an uncertain status. The value is not certain if the 

initial value is not known after runtime has been activated, or when a substitute value 
is used.

Note

For additional statistical analysis of process data and archiving of results you must write 
the scripts yourself.
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How to display archived values

Introduction
Use the buttons in the toolbar of a trend window or the corresponding key combinations to 
browse through an archive.

The values archived of a tag are displayed within a time interval in the trend window. The time 
interval is defined by entering a time range or by entering a start and end time.

Requirements
● The buttons for browsing in archive are available only if data is supplied through archive 

tags.

● You have defined a time range or a start and end time.

Buttons for Archived Values

  

The progress of a tag over a specified time period, beginning with the first archived value, 
is displayed in the trend window.

The progress of a tag within the previous time interval is displayed in the trend window, 
starting with the currently displayed time interval.

The progress of a tag within the following time interval is displayed in the trend window, 
starting with the currently displayed time interval.

The progress of a tag over a specified time period, ending with the last archived value, is 
displayed in the trend window.

 

Example project for OnlineTrendControl

Example configuration of an OnlineTrendControl

Introduction
The following example shows the configuration of a WinCC OnlineTrendControl with two trends 
and the display in runtime. With key function "Configuration dialog" in runtime, you can change 
the display of the trends at any time and view the effects immediately. 

Configuration steps
1. Insert the OnlineTrendControl into a picture of the Graphics Designer.

2. Configure the OnlineTrendControl properties.

3. Create a trend window.
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4. Configure a time axis with the respective properties. Assign the time axes to the trend 
window.

5. Configure two value axis with the respective properties. Assign the value axes to the trend 
window.

6. Define two trends and assign the trends to the trend windows. Assign the trends with the 
time axis and the value axes.

7. Connect the two trends with an online tag for each.

8. Configure the display for each trend.

9. Save the picture with the OnlineTrendControl in the Graphics Designer.

10.Define the picture as a start picture with the example project.

11.Start runtime.

12.Start the tag simulator to supply the trends with data.

13.Deactivate runtime if you want to end the example project.

How to configure the trend window

Introduction
The example has a trend window embedded in a WinCC OnlineTrendControl. This chapter 
shows the configuration of the properties of the control and the trend window. 

Requirements
● You have opened a picture in the Graphics Designer.

Procedure
1. Insert a WinCC OnlineTrendControl into the picture from the object palette in the Graphics 

Designer. Use the mouse to drag the control to the desired size.

2. Double-click in the control. The configuration dialog opens.
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3. Go to the "General" tab.

4. Select the "Normal" window heading. Activate the "Moveable", "Can Be Closed" and 
"Sizeable" options. "From the right" is defined as the writer orientation and updating will 
start when the picture is opened.

5. Save the configuration.

6. Go to the "Trend windows" tab. Define a trend window with the "New" button. The gridlines 
are displayed in runtime.

7. Configure the display of the ruler. If you use "Graphic" for the display of the ruler, you can 
configure the color and the line weight of the ruler.

8. Save the configuration.
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9. Go to the "Toolbar" tab. You require the following key functions to test the example:

– Configuration Dialog

– All key functions for zooming and moving

– Original view

– Ruler

10.Save the configuration.

How to configure the axes of the OnlineTrendControl

Introduction
The trend window of the example has a time axis and two value axes. The last 50 values of 
the trend in relation to the current time are shown in the trend window.
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Requirements
● You have defined a trend window.

Procedure
1. Go to the "Time axes" tab. Define a time axis with the "New" button.

2. Assign the time axis to the configured trend window. Select "Bottom" for the alignment of 
the time axis.

3. Activate the "Update" option to display the values in relation to the current time.
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4. Select setting "Number of measurement points" in the "Time range" area. You do not have 
to define the start time because the last 50 values in relation to the current time will be 
displayed in the example. Enter "50" for the number of measurement points in the input 
field.

5. Configure the desired format for time and date.

6. Save the configuration.

7. Go to the "Value axes" tab. Define two value axes with the "New" button.

8. Assign the value axes to the configured trend window.

9. Configure the alignment for each value axis. The first value axis should be left-justified, the 
second right-justified.
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10.Select "Linear" for the scaling.

11.The option "Automatic" is activated for both value axes in the "Value range" area. The value 
range for the value axes is based on the tag values.

12.Save the configuration.

How to configure the trends

Introduction
The trend window in the example shows two trends with a common time axis. Each trend has 
its own value axis. The trends are supplied with data by online tags. The customer display can 
be configured individually.

Requirements
● You have defined a trend window.

● You have configured a time axis and two value axes.

● You have created two non-binary tags in the tag management.
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Procedure
1. Go to the "Trends" tab. Define two trends with the "New" button.

2. Assign each trend with the configured trend window and the time axes. Trend1 is assigned 
with ValueAxis1 and Trend2 with ValueAxis2.

3. Define the data connection for each trend. Select "Online tags".

4. Click on , to select the tags for the trends.

5. Configure the display for each trend as desired. More information on configuration can be 
found on page .

6. Save the configuration.
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How to start the example on OnlineTrendControl

Introduction
In order to test the example of the OnlineTrendControl in runtime, you must made many 
settings in the project.

Requirements
● You have saved the configured picture in the Graphics Designer.

● You have defined the picture in the WinCC Explorer as the start picture via the context 
menu.

● You have checked for whether "Graphics Runtime" and "Tag Logging Runtime" are 
activated in the "Computer properties" dialog.

Procedure
1. Activate runtime by clicking the relevant button in the toolbar or selecting the relevant menu 

bar.

2. Start the tag simulator to test the WinCC OnlineTrendControl with the tags.

3. Go to "Start/SIMATIC/WinCC/Tools" on your computer.

4. Select the "WinCC Tag Simulator". The simulation program will open.

5. Define two tags that you have connected in OnlineTrendControl.

6. Assign the tag with property "Random" and click on the "Active" option.

7. Save the settings in each case.
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8. Click the "Start Simulation" button. The simulation is started and the trend supplied with 
data.

9. Deactivate runtime if you want to end the example project.

Result
The trends are displayed in runtime with the values that create the tag simulator.

Button  brings you to the configuration dialog, in which you can change the display of the 
trends as you wish on the "Trends" tab. You will immediately see the results of your 
configuration.

Test all functions for zooming and move the trend or the axes. More information is found under 
 .

More information on operating the OnlineTrendControl in runtime is found under  .

You can expand the OnlineTrendControl with a ruler window for example. More information 
can be found under  and  .
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6.5.2.4 Process Value Output as a Function of Another Tag

Resources

WinCC FunctionTrendControl

Introduction
For a graphic processing of tags, WinCC FunctionTrendControl in WinCC offers the option of 
displaying one tag as a function of another tag. For example, temperature may be shown as 
a function of pressure. 

Requirements
For the display of trends in WinCC FunctionTrendControl the following prerequisites apply:

● You can display as many trends as you need in a WinCC FunctionTrendControl. 
Configuring a maximum of 8 trends is recommended.

● A trend can represent a maximum of 10000 value pairs.

● You can use online tags, archive tags or data from user archives for the trends.

● The online tags of a trend must have the identical update cycle.
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● The archive tags of a trend must have the same update cycle and must be recorded in a 
continuous cycle.

● The representation of tags in the form of functions over time is only possible, if the values 
of the trend are supplied through the API interface. In order to display tags as time functions, 
use the WinCC OnlineTrendControl.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen 
resolution and selected size of the trend window. Therefore, when displaying trends, it is 
possible that fewer values are displayed in the trend window than are actually archived.

If, for example, in an area of 100 pixels 200 measured values are archived, each pixel 
represents 2 measured values. The value shown on the screen is that of the most recent data 
(most recent time stamp).

See also
Short Description of the WinCC Controls and Additional Controls (Page 320)

Display of Trends

Representing Trend Lines

Introduction
The WinCC FunctionTrendControl has many ways of displaying the progress of a trend.
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Representation formats
To display values graphically, three basic representation types are available:

● No trend         
The values are shown as dots. The display of the points can be configured as you wish.

● Connect dots linearly         
The trend line is interpolated on a linear basis from the point values. The display of the lines 
and points can be configured as you wish.

● Stepped trend         
The progress of the trend line is determined from the values as a stepped trend. The display 
of the lines and points can be configured as you wish.

The display of the trend can be configured on the "Trends" tab of the FunctionTrendControl.

Write direction
With the write direction option, you can specify where the current values for all trend windows 
are to be entered. Normally, the current values are written in the trend window from the right. 
All four write directions can be configured. The write direction is configured on the "General" 
tab of the FunctionTrendControl.

Displaying the trends with logarithmic axes
The axes in the trend window can be scaled on either a logarithmic or a linear basis. No 
negative values can be displayed in the display with logarithmic axes. No positive values can 
be displayed in the display with negative logarithmic axes. The display with logarithmic axes 
is configured on the "X axes" and "Y axes" tabs of the FunctionTrendControl.
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Display with common axes

Introduction

When displaying more than one trend in a trend window, you can assign every trend with its 
own axes or use a common time X axis or Y axis.

Representation Using Different Axes
If the values to be displayed in a trend window differ greatly, a common axis makes no sense. 
The values can be read more easily if different axial scales are used. Individual axes can be 
hidden if required.
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Representation Using Common Axes
If the comparability of the trend lines is important, common axes in a trend window is sensible. 
Connected trend windows can have a common axis.

Configuring
The axes are configured on the "X axis" and "Y axis" tabs of the FunctionTrendControl. The 
assignment of the axes for the trends can be configured on the "Trends" tab. In this case, you 
can assign the individual trends to the same axes.

Configuring the FunctionTrendControl

How to configure the FunctionTrendControl

Introduction
Process values of a tag can be displayed depending on the process values of another tag in 
trends. You can configure a WinCC FunctionTrendControl for this in the Graphics Designer.
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Configuration steps
1. Insert the FunctionTrendControl into a picture of the Graphics Designer.

2. Configure the basic properties for the FunctionTrendControl on the "General" tab:

– the window properties of the control

– the display of the control

– the write direction of the trend values

– the time base of the control

3. Define one or more trend windows.

4. Configure one or more X axes and Y axes with their respective properties. Assign the axes 
to the trend windows.

5. Define trends that you want to display in the trend windows. Assign the trends to the trend 
windows. Assign each trend an X axis and a Y axis that belong to the respective trend 
window.

6. Configure the display for each trend.

7. Every configured trend must be connected with an online tag, archive tag or a user archive 
via the X axis and Y axis. Define the data supply for the axes of each trend.

8. Configure the toolbar and status bar of the trend window.

9. If you want to display the coordinates of the trends, configure a ruler window as well. 
Connect the ruler window with the FunctionTrendControl.

10.Save the configurations.

How to create the trend window in FunctionTrendControl

Introduction
The WinCC FunctionTrendControl can contain one or more trend windows. The trend window 
provides an area to display trends in.

Overview of the trend window
The trend window has the following properties:

● Every trend window is assigned with at least one trend, which has one X axis and one Y 
axis.

● A trend can only be assigned to one trend window.

● Several trends can be displayed in a trend window.

● A trend window can display X axes and Y axes independent of the displayed trends. X axes 
and Y axes can be hidden in runtime.
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● The sequence of the configured trend window is determined by the position in 
FunctionTrendControl. The first trend window in the list of trend windows is displayed in 
the lower position, the last trend window is shown in the top position.

● If more than one trend window is configured, the trend windows can be connected. The 
connected trend windows have the following properties:

– They can have a common X axis.

– They have a scroll bar.

– They have a ruler.

– The zoom functions for a trend window affect the connected trend windows.
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Procedure
1. Define one or more trend windows with the "New" button on the "trend windows" tab.

2. If you have defined more than one trend window, more configurations are possible:

– Assign every trend window with an area selection in the displayed FunctionTrendControl.

– Define the position of the trend windows with the "Up" and "Down" buttons.

– Define whether the trend window will be connected on the "General" tab.

3. If you want to hide a trend window in runtime, deactivate the checkbox in front of the name 
of the trend window in the list. The respective axes are then hidden as well.

4. Configure the gridlines for every trend window.
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5. Configure the display of the ruler. If you use "Graphic" for the display of the ruler, you can 
configure the color and the line weight of the ruler.

6. Define the level on which to display the ruler in the trend window.

7. Save the configuration.

How to configure the axes of trend windows

Introduction
You can configure several X axes and Y axes that you assign to one or more trend windows. 
Configure the value range and the display for each X axis and Y axis.

Requirements
● You have opened the picture with the FunctionTrendControl in the Graphics Designer.

● You have defined trend windows.
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Procedure
1. Define one or more axes with the "New" button on the "X axes" and "Y axes" tabs. Here 

e.g. tab "X axes":

2. Assign the X axes and Y axes to the configured trend windows.

3. If you want to hide an X axis or Y axis in the trend window, click on the checkbox in front 
of the name of the axis in the list. You can display the axes again in runtime with the key 
functions.

4. Configure the orientation and scaling for each X axis and Y axis.

5. Configure the display of the axes in trend windows.
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6. Deactivate the "Automatic" option in "Value range" if you want to define a fixed value range 
for the X axis or Y axis.

7. In the "From:" and "To:" input fields enter the minimum and maximum value of the value 
range.

8. Save the configuration.

How to create trends for the trend window

Introduction 
Every trend is displayed in a trend window with an X axis and a Y axis. The trends can use 
the same axes in a trend window. 

Requirements
● You have inserted the FunctionTrendControl into a picture of the Graphics Designer.

● You have configured X axes, Y axes and trend window.
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Procedure
1. Go to the "Trends" tab.

2. Use the "New" button to define the desired number of trends.

3. Define the sequence of trends in the trend window using "Up" and "Down" keys.

4. Assign every trend to a trend window. Several trends can be assigned to one trend window.

5. Assign an X axis and a Y axis to every trend. You can only use the axes that belong to the 
assigned trend window for the trend.

6. Configure the display for each trend. More information can be found on page "How to 
configure the display of trends".

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1285



7. The data connection of the trends are configured on the "Data connection" tab. More 
information can be found on page "How to configure the data connection of trends".

8. Save the configuration.

How to configure the display of trends

Introduction
You can adjust the display of trends to suit your requirements in the WinCC controls. The 
following WinCC controls are shown in trends:

● WinCC OnlineTrendControl

● WinCC FunctionTrendControl

Overview
The following trends features can be configured:

● The types of trends and trend lines

● The properties of trend lines

● The colors of the trends, the trend points and the fill color

● Color identification for a limit value violation

Requirements
● You have opened the Graphics Designer and configured a picture with the above mentioned 

WinCC control.

● The configuration dialog of the WinCC control is opened.
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Configuring the types of trends and trend lines
1. Go to the "Trends" tab. Here e.g. in WinCC OnlineTrendControl.

2. Choose a trend under "Trends".

3. Define the type of the trends and trend lines in the "Display" area.

4. If you want to highlight the display of the area under the trend, activate the "Filled" option.

5. In the small picture in the right-hand margin of the "Display" area, the result of the 
configuration is shown.

6. Save the configuration.
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Configuring the properties of trend lines
1. Choose a trend under "Trends".

2. Define the properties of the trend lines in the "Display" area.

3. Define the line weight and the properties of the trend points.

4. In the small picture in the right-hand margin of the "Display" area, the result of the 
configuration is shown.

5. Save the configuration.

Configuring the colors of the trends, the trend points and the fill color
1. Choose a trend under "Trends".

2. Define the colors in the "Display" area.

3. If you want to configure the colors of the trend points and the fill color, activate the 
"Extended" option.

4. In the small picture in the right-hand margin of the "Display" area, the result of the 
configuration is shown.

5. Save the configuration.

Configuring the color identification for a limit value violation
1. Choose a trend under "Trends".

2. Click in the "Display" area on the "Limit values" button. This will open the "Limit values" 
dialog.

3. Activate the limit values, for which you want a colored identification.

4. Define the color for every activated option.
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5. The colored identification has the following effect:

– Low limit value. Whenever a displayed trend value is below the value defined in the 
"Value" input field, the value is shown in the configured color.

– High Limit Value. Whenever a displayed trend value is above the value defined in the 
"Value" input field, the value is shown in the configured color.

– Value with uncertain status. Values, whose start value is unknown on activating runtime 
or for which a substitute value is used, have an uncertain status. These values are 
displayed in the configured colors.

6. Save the configuration.

How to Configure the Data Connection of Trends

Introduction
The trends are provided with values from various tags to display a tag as a function of another 
tag in a certain time range. The values of the trends can also originate from a user archive 
independent of time, to e.g. display a setpoint trend.
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Time range of the trend display
Basically, there are two different time references in the trend display:

● Static display. The time range of the trend display is determined by a pre-defined, fixed 
time interval, independent of the current system time.

● Dynamic display. The time range of the trend display is determined retrospectively from the 
most current values. The display is continuously updated. The configured time range follows 
the current system time.

You have three different ways to define the time range of a time range for each of the two time 
references:

● The trend is displayed within a defined time interval. You define a start time and an end 
time. In a dynamic display, the end time corresponds with the current system time. The 
time difference between the start time and the end time is the time range for the trend 
display.

● The trend is displayed from a start time throughout a defined time range, e.g. 30 minutes 
from the start time. In the dynamic display, the defined time range up to the current system 
time is used, e.g. 30 minutes to the current system time.

● Starting from a start time, a defined number of values are shown, e.g. 100 values from the 
start time. With the dynamic display, the last values up to the current system time are shown.
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Requirements
● You have opened a picture with the FunctionTrendControl in the Graphics Designer.

● You have defined one or more trends.

● The following prerequisites apply for the basic data:

– If you want to connect data of online tags, you have to have defined process values in 
the tag management.

– If you want to connect the data from archive tags, you have to have configured a process 
value archive with archive tags.

– If you want to connect the data from an archive tag, you have to have configured a user 
archive with columns.

– If you want to use a script to supply the trend values with data in runtime, you will require 
a script through the API interface. E.g. the display of a tag as a time function if you do 
not want to use the WinCC OnlineTrendControl.
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Procedure
1. Go to the "Data connection" tab.

2. Define the data source for each trend. You can select the following:

– Archive tags of a process value archive

– Online tags from the tag management

– User archive columns

– No configured data source to establish a connection in runtime via a script.
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3. Click on  to select the tags for the X axis and the Y axis. The online tags connected to 
a trend must have the identical update cycle. The archive tags connected with a trend must 
originate from the process archive of a server and be acquired in a continuous cycle.

4. If the data is connected with a user archive, select columns of the user archive for the X 
axis and Y axis. Define the "ID" for each column, starting from which the values of the 
column will be used.

5. If the trends in the trend window are always updated, activate the "Update" option. If you 
e.g. want to compare a current trend display with an earlier trend display, deactivate the 
"Update" option for the comparison trend.

6. Configure the time range in which the trend will be displayed:

– If you want to define a fixed time interval, select setting "Start to end time". Enter the 
date and time for each.

– If you want to define a time period, select the setting "Time range". Define the date and 
time for the start time. The time range is the result of a multiplication of the "Factor" and 
"Time unit", e.g. 30 times "1 minute" for a time range of 30 minutes. Enter the factor and 
the time unit in the "Time range" field.

– If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

– If the trend will be provided via a user archive, define the number of value pairs for the 
area to be displayed. Enter the desired number in the "Number of measurement points" 
field.

7. Save the configuration.

How to configure the toolbar and the status bar 

Introduction
The WinCC controls are operated at runtime using the functions of the toolbar buttons. The 
status bar contains information pertaining to the current status of the WinCC control. You can 
adapt the toolbar and the status bar for all WinCC controls when configuring, or at runtime. 

Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The WinCC control is assigned the "Configuration dialog" button function for opening the 
configuration dialog in Runtime.

● The configuration dialog of the WinCC control is open.
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How to configure the toolbar
1. Go to the "Toolbar" tab. In the WinCC AlarmControl, for example:

2. In the list, activate the button functions you require for operating the WinCC control in 
Runtime. For information on the button functions, refer to the description of the 
corresponding WinCC control at "Operation in runtime".

3. Determine the sorting order for displaying the button functions in the toolbar. Select the 
button functions from the list and the move the functions using the "Up" and "Down" buttons.

4. Define a hotkey for the functions of the toolbar buttons.

5. Any button functions assigned operator authorizations are only available in Runtime to 
authorized users.
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6. An activated button function is displayed in runtime if you deactivate its "Active" option, 
however, it cannot be operated.

7. You can set separators between the button functions. Activate the "Separator" option for 
the button function to be restricted by separator.

8. Configure the general properties of the toolbar, e.g. alignment or background color.

How to configure the status bar
1. Go to the "Status bar" tab. In the WinCC AlarmControl, for example:

2. Activate the elements required in runtime in the list of status bar elements. For further 
information on status bar elements, refer to the descriptions of the corresponding WinCC 
control at "Operation in runtime".
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3. Determine the sorting order for displaying of the status bar elements. Select the elements 
from the list and move these using the "Up" and "Down" buttons.

4. To resize the width of a status bar element, deactivate the "Automatic" option and enter a 
pixel value for the width.

5. Configure the general properties of the status bar, e.g. alignment or background color.

How to configure the Ruler window/Statistics window/Statistics area window

Introduction
Evaluated data and statistics are shown in a table in a ruler window, statistics window or a 
statistics area window. The ruler window/statistics window/statistics area window are 
configured in the WinCC RulerControl.

Overview of the WinCC RulerControl
The RulerControl can be connected with the following controls:

● WinCC OnlineTrendControl

● WinCC OnlineTableControl

● WinCC FunctionTrendControl

Depending on the data evaluation, there are three different types of windows for displaying 
values. The following window types are available:

● The ruler window shows the coordinate values of the trends on a ruler or values of a selected 
line in the table.

● The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. The statistics area window is not 
planned for the WinCC FunctionTrendControl.

● The statistics window shows the statistic evaluation of the trends between two rulers or the 
selected values in the table. The statistics window is not planned for the WinCC 
FunctionTrendControl.

All windows can also display additional information on the connected trends or columns.
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Requirements
● You have opened a picture with an OnlineTrendControl, OnlineTableControl or 

FunctionTrendControl in the Graphics Designer.

Procedure
1. Insert RulerControl into the picture from the WinCC object palette.

2. Double click on the RulerControl to open the configuration dialog.

3. Configure the properties of the control on the "General", "Toolbar" and "Status bar" tabs.

4. Go to the "General" tab in the field "Source" and select the object name of the control that 
is already configured. The type of control is displayed in the "Type" field.
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5. Set the window type in the "Window" field. If the key function "Configuration dialog" can be 
operated in runtime, you can change the window type in runtime.

6. Go to the "Columns" tab.

7. Use the arrow keys to select the column of the window type that you want to display for the 
assigned control. Columns for the basic data and columns that are only for the selected 
window type or the assigned control are available. Define the column sequence with buttons 
"Up" and "Down".
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8. Go to the "Blocks" tab.

Every column corresponds with a block. In order to define the properties for the selected 
columns, click on the respective blocks.

9. If a special format exists for a block, you can configure the format of the block. Deactivate 
the option "Apply from source" if the format settings of the connected control are not to 
apply in this case. Define the desired format.

10.Define whether the data for the column and the column heading is to be displays as text or 
as an icon in the table under "Display".

11.Save the configuration.
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12.Configure the properties and the display of the table for the RulerControl in the "Parameter," 
"Effects" and "Selection" tabs. You can find more on configuring the display of the table 
under .

13.You can export the evaluated data. This requires activating the "Export data" key function 
on the "Toolbar" tab. You can find more on exporting data under .

14.Configuring the TrendRulerControl is possible in runtime. You can find more on this under .

How to export runtime data

Introduction
The runtime data shown in the WinCC controls can be exported using a button function. Set 
up operation of the data export in runtime in the configuration dialog.

Requirements
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.

How to configure the operation of the data export
1. Go to the "Export" tab. 

2. A standard file name and a standard directory are already entered in the "Data export default 
settings." In this case for AlarmControl. If necessary, define a file name and a directory for 
the export file.

3. CSV is currently available as data format. Click on  to define the separator in the CSV 
file.
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4. Define the scope of the data export:

– All runtime data is exported

– Selected runtime data is exported. This data export is only possible in WinCC controls 
with tabular display.

5. Configure the operation of the data export in runtime. Define:

– whether users are allowed to rename the file, or change the directory.

– whether to display the "Data export default settings" dialog in Runtime.

6. If "Display dialog" is deactivated, the data for operation of the "Export data" button function 
is immediately exported to the defined export file.

7. Save the configuration.

8. Go to the "Toolbar" tab to activate the "Export data" button function for runtime.

Results

You can export all or selected data to a defined file at runtime using button function .

How to define the effect of the online configuration

Introduction
Users can parameterize the WinCC controls in Runtime. You must define the runtime effects 
of the online configuration.

Changes configured at runtime are saved to a separate picture in the configuration system. 
The original picture configuration is retained in the configuration system.

Prerequisite
● A picture showing a WinCC control is opened in Graphics Designer when configuring.

● The configuration dialog of the WinCC control is open.
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Procedure
1. Go to the "Online configuration" tab. For example, in OnlineTrendControl:

2. The option buttons of the "Online configuration" field for setting online configuration defaults 
are only available in the configuration system. The option buttons are not available in 
runtime.         
Select one of the three effects of the online configuration:

– "Do not retain". The online configurations are not retained in Runtime. This default 
setting disables all options for runtime users. Online configurations are lost at the next 
picture change and on activation/deactivation of the project.

– "Retain during runtime". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
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if the "retain" option is enabled, however, these are lost on activation/deactivation of the 
project.

– "Retain permanently". This default setting enables the "discard", "retain" or "reset" 
options for runtime users. Online configurations are retained at the next picture change 
and on activation/deactivation of the project if the "retain" option is enabled. 

3. Define corresponding user authorizations for online configuration.

4. The option buttons of the "Online configuration on next picture change" can be enabled for 
operation in the configuration system and at runtime by setting the "retain at runtime" and 
"retain permanently" defaults. The "reset" operation is only available in runtime, because 
the configuration system contains the original configuration.         
Select one of three effects of the online configuration at the next picture change:

– Select "discard" if to discard the online configuration at the next picture change.

– Activate "retain" to activate the online configuration based on default settings at the next 
picture change or on activation/deactivation of the project.

– Activate "reset" to activate a picture which is older than the version stored in the 
configuration system for runtime. All online changes are lost.         

Note

The picture is also replaced at runtime if you save it in Graphics Designer, or when 
loading deltas in online mode. All online changes are lost.

5. Save the configuration.

Note

The different configurations are only activated for new users after you performed a picture 
change.

How to make the toolbar for the FunctionTrendControl dynamic

Introduction
The default functions for operating the WinCC FunctionTrendControl are no longer supported 
for the new WinCC FunctionTrendControl as of WinCC V7.0. You can use the WinCC types 
of dynamics to e.g. operate a key function of the toolbar with a script.

Overview
With WinCC controls as of V7.0, special functions are no longer required for operating the 
control with toolbar dynamics. The previously used standard functions "TrendToolbarButton" 
are no longer supported.

If you do not want to operate the control via the toolbar, you can write the "ID" for the desired 
button in the "ToolbarButtonClick" object property with an optional type of dynamics. 

The "ID" of a button of the toolbar can be determined:
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● with the table on page "Operation of the FunctionTrendControl in runtime".

● in the configuration dialog of the FunctionTrendControl on the "Toolbar" tab via field "Object 
ID".

Example: Open the configuration dialog for the control
In order to open the configuration dialog of the control, dynamics are possible as follows:

● VBScript:

– ScreenItems("Control1").ToolbarButtonClick = 2

– As an alternative to the property "ToolbarButtonClick", there are also methods in VBS 
for operating the toolbar: ScreenItems("Control1").ShowPropertyDialog

– Or, with the following notation with the support of "Intellisense":          
Dim obj         
Set obj = ScreenItems("Control1")         
obj.ShowPropertyDialog

● C script:

– SetPropWord(lpszPictureName, "Control1", "ToolbarButtonClick", 2);

● Direct connection

– In the dialog for the direct connection for the source, enter "2" as a constant

– Select the property "ToolButtonClick" for the object "Control1" for the target "Object in 
picture"

See also
Operating the FunctionTrendControl in runtime (Page 1304)

Operation in Runtime

Operating the FunctionTrendControl in runtime

Introduction
The trend window is operated in runtime via the buttons in the toolbar. If you do not want to 
operate the trend window via the toolbar, you can write the "ID" for the desired button in the 
"ToolbarButtonClick" object property with an optional type of dynamics.

Overview

Icon Description ID
"Help"
Calls up the help on WinCC FunctionTrendControl.

1
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"Configuration dialog"
Opens the configuration dialog, in which you can change the properties of 
the FunctionTrendControl.

2

"Zoom area"
Define an area by dragging with the mouse in the trend window. This cut-out 
of the trend window is made larger. The "Original view" button brings back 
the original size of the view.

4

"Zoom +/-"
Zooms in on or out off the trends in the trend window. . The left mouse button 
increases the size of the trends. By holding the "Shift" button down, the left 
mouse button zooms out of the trends. The "Original view" button brings 
back the original size of the view.

5

"Zoom X axis +/-"
Zooms in on or out off the X axis in the trend window. The left mouse button 
increases the size of the X axis. By holding the "Shift" button down, the left 
mouse button zooms out of the X axis. The "Original view" button brings back 
the original size of the view.

6

"Zoom Y axis +/-"
Zooms in on or out off the Y axis in the trend window. The left mouse button 
increases the size of the Y axis. By holding the "Shift" button down, the left 
mouse button zooms out of the Y axis. The "Original view" button brings back 
the original size of the view.

7

"Move trend area"
The button moves the trend along the X axis and Y axis in the trend window. 

8

"Move axes area"
This button moves the trends along the value axis in the trend window.

9

"Original view"
This button returns from the zoomed trend display back to the original view.

10

"Select data connection"
This button opens a dialog for the archive selection and tag selection.

11

"Select trends"
This button opens the dialog for toggling the visible and invisible trends. You 
can also define which trend is displayed in the foreground.

12

"Select Time Range"
This button opens the dialog where you can specify the time range to be 
displayed in a trend window.

13

"Previous trend"
This button is used for displaying the previous trend of the trend window in 
the foreground.

14

"Next trend"
This button is used for displaying the next trend of the trend window in the 
foreground.

15

"Stop"
The updated display is stopped. The data is saved to the clipboard and 
added when the button in the trend window is clicked again.

16

"Start"
Resume updated display.

16
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"Print"
Click this button to print the trend shown in the trend window. The print job 
used for printing is defined in the configuration dialog on the "General" tab.

17

"Export data"
This button is used for exporting all or the selected runtime data into a "CSV" 
file. If the option "Display dialog" is active, a dialog opens in which you can 
view the settings for exporting and can start the export. With the respective 
authorization, you are also allowed to select the file and the directory for the 
export.         
If a dialog is displayed, the export of the data to the predefined file starts 
immediately.

20

"Ruler"
The coordinate points of a trend are queried with this button. The trend data 
is displayed in the ruler window. The button is only functional if a ruler window 
is connected with the FunctionTrendControl.

3

"Connect backup"
This button opens a dialog in which you connect the selected archive with 
WinCC Runtime. 

18

"Disconnect backup"
This button opens a dialog in which you disconnect the selected archive from 
WinCC Runtime. 

19

"User-defined 1"
Shows the first key function created by the user. The function of the button 
is user-defined.

1001

Possible elements of the status bar
The following elements can appear in the status bar of the trend window:

Icon Name Description

Connection status Shows the status of the data connections:
● No faulty connections
● Faulty connections exist
● All connections are faulty

Date Shows the system date.

Time Shows the system time.

Time Base Shows the time base used in the display of times.

Double click on the icon for the connection status to open the window "Status of the data 
connections", in which the name, status and tag name of the data connection are listed.
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Online configuration of the FunctionTrendControl

Introduction
In runtime, you can configure online and change the display of the WinCC 
FunctionTrendControl. Configuring the WinCC FunctionTrendControl defines how to proceed 
with a picture change or after ending runtime with online configurations.

Overview
The following buttons functions make online configuration possible in FunctionTrendControl:

● With key function "Configuration dialog"

● With key function "Select trends"

● With key function "Select time range"

Key function "Configuration dialog"

With the key function "Configuration dialog"  you have access to the configuration dialog 
tab, e.g. for changing the display of the trend.

Key function "Select trends"

The key function "Select trends"  opens a dialog, in which you can show or hide trends. 
You move trends to the foreground by changing the sequence of the trends. 
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Key function "Select time range"
Select the time range in which the trend will be displayed with key function "Select time range" 

.

Field Description

Trends Select the trend for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

The entry format of the date and time depends on the Runtime language used.

Starting and Stopping Update

Introduction
The update of the trend in the trend window can be started and stopped with the "Start/Stop" 
key function.

The button indicates whether the update is stopped or not:
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●
: Update is stopped. Click on the button to continue updating.

●
: Update is started. Click on the button to stop updating.

How to display the trend in the foreground

Introduction
If more than one trend are to be displayed in a trend window, you can use key functions to 
define which trends will be displayed in the foreground.

Requirements
● You have configured key functions "Select trends", "Previous trend" and "Next trend".

Procedure
●

 is used for opening a dialog for displaying or hiding trends. You can also define which 
trend is in the foreground.

●
 is used for displaying the next trend of the trend window in the foreground.

●
 is used for displaying the previous trend of the trend window in the foreground.

How to Determine the Coordinates of a Point

Introduction
Key function "Ruler" is used for defining the coordinates of a point on the trend with cross-hairs 
or the rulers. You can zoom in on an area of the trend to make coordinate finding easier. You 
can also read many trend parameters in the trend window with the mouse on the trend.

Requirements
● You have configured a WinCC FunctionTrendControl. In order to highlight the ruler in the 

trend window, you can increase the line weight on the "Trend window" tab and configure 
the color.

● You have configured the "Ruler" key function. If you want to zoom in on a section of the 
trend, configure key functions "Zoom area" and "Original view".

● You have configured a WinCC RulerControl as a ruler window and connected it with the 
FunctionTrendControl.

● You have activated runtime.
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How to display the coordinates
1.

In FunctionTrendControl, click on .

2. Move the cross-hairs or the ruler to the desired position with the mouse.

3.
If you want to zoom in on an area, click on . Move the ruler to the desired position with 
the mouse.

4.
If you want to return to the original view, click on .

Result
Two rulers or the cross-hairs appear in the trend window. In the ruler window, besides the X 
value and the Y value, the data that you have configured in WinCC RulerControl is shown in 
the columns. 

The displayed values can be assigned an additional attribute in the form of a letter:

● Letter "i." : The displayed value is an interpolated value.

● Letter "u." : The displayed value has an uncertain status. The value is not certain if the initial 
value is not known after runtime has been activated, or when a substitute value is used.
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Other values can be determined by positioning the mouse pointer on the cross-hairs or the 
ruler and moving it to the desired position while holding the left mouse button pressed.

Note

The "uncertain" status of a value can also be indicated in the displayed trend characteristic. 
You must activate the "Value with uncertain status" option on the "Trends" tab under "Limit 
values".

How to use the zoom functions in trend windows

Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view 
for trends, axes and various zoom areas of the trend window.

Overview
The following zoom functions are available in the trend window:

● "Zoom area"

● "Original view"

● "Zoom +/-"

● "Zoom X axis +/-"

● "Zoom Y axis +/-"

● "Move trend area"

Requirements
● You have configured a WinCC FunctionTrendControl.

● You have configured the buttons for the required zoom functions for the toolbar.

● You have activated runtime.

How to zoom in on a segment of a trend window
1.

Click .

2. In the trend window, click one corner of the area that you wish to enlarge.

3. Hold down your left mouse button and drag the area you want to enlarge until it reaches 
the desired size. If the highlighted area contains at least two measured values, the selected 
trend area is displayed in the trend window.
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4. Release the left mouse button. The selected segment is magnified. If you want to increase 
the size further, repeat the process.

5.
Click . The trend window is shown in the originally configured view again.

How to zoom in and zoom out of the trends
1.

Click .

2. Click in the trend window with the left mouse button to zoom in on the trends in the trend 
window. If you want to increase the size further, repeat the process.

3. If you want to zoom out of the trends, press the "Shift" button while clicking with the left 
mouse button.

4. While zooming in or zooming out with trends, the 50% value of the trends is always in the 
middle of the value axes.

5.
Click . The trend window is shown in the original view again.

Note

If you change the value area on the "X Axes" or "Y Axes" tab in the configuration dialog 
while zooming, the visible zoom area is set to the new value area.

How to zoom the X axis and the Y axis
1.

Click on  to zoom the X axis or on  to zoom the Y axis.

2. Click in the trend window with the left mouse button to zoom in on the X axis or Y axis. If 
you want to increase the size further, repeat the process.

3. If you want to zoom out of the X axis or Y axis, press the "Shift" button while clicking with 
the left mouse button.

4. While zooming with axes, the 50% value of the trend is always in the middle of the axes.

5.
Click . The trend window is shown in the original view again.

How to move the trend area
1.

Click .

2. While holding the left mouse button down, move the cursor in the desired direction in the 
trend window. The displayed area in the trend window is adapted on the X axis and on the 
Y axis.

3.
If you click on  again, the trend window is shown in the original view again.
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6.5.3 Process value output in reports

6.5.3.1 Process value output in reports

Introduction
You have the option to output process values in the form of a report. At the end of each shift, 
you can for example load the achieved production figures from the process value archive and 
print them out in report format. You create reports in the Report Designer. 

Report Designer:
The Report Designer contains a number of preset layout templates that you can change to 
suit your needs. The Report Designer is also used to create print jobs to initiate the output.

For the output of process values in report format, you can make use of many preset layout 
templates.

Layouts on the basis of WinCC Controls as of WinCC V7

Use the new layouts that are based on the "WinCC Control Runtime Printprovider" layout 
templates in WinCC V7 or higher. The output of the report object depends on the layout of the 
control in Runtime. 
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● @Online Table Control - Picture.RPL and @Online Table Control - Table.RPL: Process 
value output on the basis of WinCC Online Table Control.

● @Online Trend Control - Picture.RPL: Process value output on the basis of WinCC 
OnlineTrendControl.

● @Function Trend Control - Picture.RPL: Process value output on the basis of WinCC 
FunctionTrendControl.

Layouts on the basis of WinCC Controls prior to WinCC V7

You have detailed parameterization options in the following layouts. You can configure many 
setting options of the tabs and the dynamizable parameters of the WinCC Controls prior to 
WinCC V7.

● @CCOnlineTableCtrl-CP.RPL: Process value output on the basis of WinCC Online Table 
Control.

● @CCOnlineTrendCtrl-Curves-CP.RPL: Process value output on the basis of WinCC Online 
Trend Control.

● @CCFunctionTrendCtrl-CP.RPL Process value output on the basis of WinCC Function 
Trend Control.

Basic procedure
The configuration procedure for reports consists of the following steps: 

1. Selection of process data and adjustment layout: Select the process data that will be 
displayed in the report. If necessary, modify the report layout.

2. Configuring the Print Job Configure the print output of the report by defining the time period, 
the number of pages and the output medium.

See also
Output of Process Values (Page 1184)

How to Configure the Static Parameters of WinCC Online Table Control (Page 1635)

How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 1638)

How to Configure the Static Parameters of WinCC Online Trend Control (Page 1640)

How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 1643)

How to Configure the Static Parameters of WinCC Function Trend Control (Page 1645)

Configuring the dynamic parameters of the WinCC Function Trend Control (Page 1647)

Introduction to Runtime Documentation (Page 1469)

How to create print jobs for the Runtime documentation (Page 1474)
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6.5.4 Process value output before WinCC V7

6.5.4.1 Process value output in process pictures before WinCC V7

Introduction
You have the option to output archived and current process values in Runtime. For this, WinCC 
provides two ActiveX Control that can be inserted into a process picture, which consists of a 
table or trend window. 

Process Value Output in Tables
To output process values in table format in Runtime, use the WinCC Online Table Control. 
You can display the archive tags:
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Process Value Output as Trends
To output process values in trend format in Runtime, use the WinCC Online Trend Control. 
You can then fill the table with archived or process tags: 

Use the WinCC Online Trend Control to display process trends, etc. You also have the option 
to show more than one trends in a window, and to highlight areas that are outside the limit 
range in a different color. 

6.5.4.2 Before WinCC V7: Process Value Output in Table Format

Resources

WinCC Online Trend Control

Introduction
In order to process data in table form, WinCC uses Online Table Control to offer the option of 
displaying process data in a table. You have the option to display either current or archived 
values.

Display of tag values during Runtime takes place in ActiveX Control, inserted and configured 
in a picture in Graphics Designer. In order to facilitate access to the tags to be displayed, 
process value archives and the tags contained therein must be configured in Tag Logging.
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Requirement
The following prerequisites apply to the display of trends in WinCC Online Table Control:

● Only archive tags can be used for tables.

● Each table can contain maximum 30,000 values.

● Archive tags in a table must originate from the same process value archive of a server, 
must have the same update cycle, and must be recorded in a continuous cycle.

Representation Formats

Introduction
Two basic display types are available for displaying tag values in tabular format.

Shared time column
In this display type, the table contains only one time column. This column displays the archived 
times of the tag output in the first column. A table to display the values of three tags will therefore 
consist of four columns in Runtime.

Note

The display of tags with different acquisition times in a table with a shared time column is 
problematic, since the tag values might not correspond to the indicated archived times of the 
time column. These values are displayed as crossed out.
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Separate time columns
In this display type, the archived times of each tag are displayed in separate columns. A table 
to display the values of three tags will therefore consist of six columns in Runtime.

Configuration
The table display type to be used is specified on the "General" tab of the "Properties of WinCC 
Online Table Control" dialog.

See also
Time Range of a Table Display (Page 1319)
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Time Range of a Table Display

Introduction
With respect to time ranges to be displayed, the table display of tags can be shown in various 
ways:

Static Display
In a static display the archived tag values are shown for a defined time period.

In the "Column" tab of the "WinCC Online Table Controls" property dialog, the static display 
type is configured by deactivating the "Update" option. The time range to be displayed is set 
either

● by entering a start time and a time range.

● by entering a start time and an end time.
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Dynamic Display
In a dynamic display the end time in a table always corresponds to the current system time. 
New measurement values coming in will be included in the display.

In the "Column" tab of the property dialog of "WinCC Online Table Controls" the dynamic 
display type is configured by activating the "Update" option. The time range to be displayed is 
set either

● by entering a time range.

● by the time difference between the specified start and end times.

Note

Upon starting Runtime the tag values to be displayed are either read from the archive or are 
set to zero. This function is set in the "General" tab of the "Properties" dialog.

See also
Representation Formats (Page 1317)
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Configuration

Configuration of WinCC Online Table Control

Introduction
In order to display process values in Runtime using WinCC Table Control, you must execute 
the following steps:

In Tag Logging
1. Use the Archive Wizard to create a process value archive.

2. Configure the process value tags it will contain.

In Graphics Designer
1. Link the WinCC Table Control to a Graphics Designer picture.

2. Link the columns to be displayed in Table Control to the tags of the process value archive.

Note

The table window can be influenced by means of standard functions. If you do not wish to 
use the toolbar functions to operate the table window, any Graphics Designer objects can be 
made dynamic using the appropriate functions.

See also
How to Create a Process Value Archive (Page 1322)

How to Insert the Online Table Control in a Picture (Page 1321)

How to Insert the Online Table Control in a Picture

Introduction
Tags are displayed in runtime in an ActiveX Control, which is inserted in a picture and 
configured with the aid of the Graphics Designer.
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Procedure
1. Start Graphics Designer and open a new picture.

2. Click the "WinCC Online Table Control" object on the "Controls" tab in the object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the 
control.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the control to the desired size.         
The "Insert a Control" dialog is opened.

5. Select the WinCC Online Table Control and confirm your selection by clicking "OK".         
The "Properties of WinCC Online Table Control" quick configuration dialog box opens.

6. Configure the table properties according to your specifications.

7. Close the dialog with the "OK" button.

See also
How to Display Process Value Tags (Page 1323)

How to Create a Process Value Archive

Introduction
In order to display tags in a WinCC Online Table Control, you must configure a process value 
archive. A process value archive is created most easily with the help of the Archive wizard.
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Procedure
1. Start Tag Logging and select the "Archive Wizard ...". command in the archive pop-up menu.

2. In the second step of the Archive Wizard, assign a meaningful name to the process value 
archive.

3. In the third step of the Archive Wizard, include the desired tags in the process value archive.

4. Close the Wizard by clicking "Apply".

Note

Provided that the process tags contained in an archive were not defined within the Archive 
Wizard, new tags can be added by using the pop-up menu of a process value archive.

See also
Configuration of WinCC Online Table Control (Page 1321)

How to Display Process Value Tags

Requirement
● Configure tags of data type "Signed 16-bit value".

● Create a process value archive using the configured tags as process value tags.

● Insert the Online Table Control in a picture of Graphics Designer.

Procedure
1. Open a picture in Graphics Designer using Online Table Control.

2. Double-click the Online Table Control.
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3. Click the "Columns" tab.

4. In the "Archive/Tag Selection" section, use the "Selection" button to select the process 
value tag for the selected column.
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5. Click the "General" tab.

6. Define the behavior of the control in Runtime.

7. Configure additional properties using the "Control" tabs.

8. Close the dialog with the "OK" button.

9. Save the picture.

See also
How to Insert the Online Table Control in a Picture (Page 1321)

How to Create a Process Value Archive (Page 1322)
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Operation in Runtime

Operation of Online Table Control in Runtime

Introduction
In Runtime, the table window is operated by means of the toolbar buttons.

"Online Help System"
Calls up the online help
"Open the Configuration Dialog"
Select dialog to assign display parameters.
"First Data Record"
The table displays the tag values within a specified time range, beginning with 
the first archived value.
"Previous Data Record"
The table displays the tag values within the previous time interval, based on 
the currently displayed time interval.
"Next Data Record"         
         
The table displays the tag values within the next time interval, based on the 
currently displayed time interval.
"Last Data Record"         
         
The table displays the tag values within the specified time interval, ending 
with the last archived value.
"Edit"
Upon activating this button, you can double-click any table cell to edit its 
contents This will stop the updated display.
"Dialog for Archive and Tag Selection"         
         
This button will open the dialog for archive and tag selection.
"Dialog for Selecting Columns"
This button will open the dialog for toggling visible and invisible column view.
"Select Time Range"         
         
This button will open the dialog to specify the time range displayed in a table 
window.
"Previous Column to Front"         
         
This button allows you to display the current last column of the table window 
as the first data column of the table. In a joint selection the corresponding 
archived times are displayed in the time column. In a joint selection the 
corresponding archived times are displayed in the time column
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"Next Column to Front"         
         
This button allows you to display the current last column of the table window 
as the first data column of the table. In a joint selection the corresponding 
archived times are displayed in the time column. In a joint selection the 
corresponding archived times are displayed in the time column
"Start/Stop the Update"
The updating for the display is stopped. The values are stored in interim 
memory and resupplied after reactivating the button.
"Start/Stop the Update"
Resume display.
"Print Log"
Initiates printing of columns displayed in table window. Print job used during 
printing can be specified in the control properties on the "General" tab.
"Select Statistics Area"
Enables mouse-based specification of time frame for calculation of statistics 
in table window.
"Calculate Statistics"
Opens a statistics window to display minimum, maximum, average and 
standard deviation for a specified time frame and a specified column.

See also
Starting and Stopping Update (Page 1332)

How to Generate Statistics of Runtime Data (Page 1335)

Display Column in Front (Page 1332)

How to Edit a Table Cell in Runtime (Page 1333)

Online Configuration for Online Table Control (Page 1327)

Online Configuration for Online Table Control

Introduction    
In order to change the configuration of Online Table Control in Runtime, you have four options 
available.
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Key function "Open the Parameter Dialog"

The key function "Open Set Configuration Dialog" provides access to all essential settings 
for table display. 
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Key function "Dialog for Archive and Tag Selection"

The key function "Dialog for Archive and Tag Selection" allows for the specification of the 
tags linked to the columns of a table window.

Array Description

Column Here, you can select one of the configured columns.
Selectio
n

Using the "Selection" button, you open the dialog to select an archive and the tags contained 
therein.

Persiste
nce

If the "Persistence in RT and CS" option is not activated, any changes made to the settings 
are only effective within Runtime. Whether or not any changed settings remain effective 
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, any changed settings are also 
transferred to the configuration system. To do this, you must open the picture in Graphics 
Designer and save it once again. The changed settings are also used when the project is 
reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with PCS 
7 projects or TIA projects. When you completely load the ES to the OS, the changed settings 
on the OS will be overwritten.         
Configure the properties of the controls on the ES.
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Key Function "Dialog for Selecting Trends"

The key function "Dialog for Selecting Columns"  opens the dialog for toggling between 
visible and invisible columns.

Array Description

Column to 
Front

If a shared time column is used, the archived timers of the first column of the table will 
be displayed. The first column can be changed either in this dialog or by using the 
"Previous column in the front" and "Next column in the front" buttons in the toolbar.

Column 
visible/
invisible

In this area, you can specify which configured columns are not to be shown.

Persistence If the "Persistence in RT and CS" option is not activated, any changes made to the 
settings are only effective within Runtime. Whether or not any changed settings remain 
effective after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, any changed settings are also 
transferred to the configuration system. To do this, you must open the picture in 
Graphics Designer and save it once again. The changed settings are also used when 
the project is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with 
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the 
changed settings on the OS will be overwritten.         
Configure the properties of the controls on the ES.

Note

The first column of a table window cannot take the "invisible" attribute.
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Key Function "Select Time Range"

The key function "Select Time Range"  opens a dialog to specify the time range to be 
displayed. If the columns of a table window are to be displayed with a common time axis, the 
specified time range applies to all columns.

Array Description

Column Here, you can select one of the configured columns.
Time 
Selection

The time interval to be displayed in the table window can be set
● by entering a start and an end point (the "Time Range" setting not activated).
● by entering a start time and a time range. ("Time Range" setting activated). The length 

of the time interval to be displayed is determined by multiplying the "Factor" by the 
"Range".

Persistenc
e

If the "Persistence in RT and CS" option is not activated, any changes made to the settings 
are only effective within Runtime. Whether or not any changed settings remain effective 
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, any changed settings are also 
transferred to the configuration system. To do this, you must open the picture in Graphics 
Designer and save it once again. The changed settings are also used when the project 
is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with 
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the changed 
settings on the OS will be overwritten.         
Configure the properties of the controls on the ES.

The entry format of the date and time depends on the Runtime language used.
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Note

The WinCC Online Table Control cannot display more than 1000 values within a selected 
time range. This has to be taken into account when setting the time range.

See also
Configuration of WinCC Online Table Control (Page 1321)

Operation of Online Table Control in Runtime (Page 1326)

Starting and Stopping Update

Introduction
With the key function "Start/Stop Update", you can stop or continue the updates of the columns 
contained in the table window. When updates are stopped, you can change the displayed time 
frame and therefore display measurement values from the process value archive in the table 
window.

When updates are stopped, you can change the displayed time frame and therefore display 
measurement values from the process value archive in the table window.

● : When updates are stopped, you can change the displayed time frame and therefore 
display measurement values from the process value archive in the table window.

● : When updates are started, you can change the displayed time frame and therefore 
display measurement values from the process value archive in the table window.

See also
Operation of Online Table Control in Runtime (Page 1326)

Display Column in Front

Introduction
If a shared time column is used, the archived times of the first column of the table will be 
displayed in the time column.

The sequence of columns in the table window can be changed in Runtime:

● using the  button (key function "Dialog for Column Selection")

● using the  button: (key function "Next Column to Front")

● using the  button: (key function "Previous Column to Front")
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Configuration
The sequence of columns is configured on the "Column" tab of the "Properties of WinCC Online 
Table Control" dialog. It can be changed via the "Up" and "Down" buttons.

See also
Operation of Online Table Control in Runtime (Page 1326)

How to Edit a Table Cell in Runtime

Introduction
With the key function "Edit" you have the option of manually inserting laboratory or correction 
values into a process value archive.

Requirement
● Configuration of Online Table Control.

● Configure the display of a toolbar by using the "Edit" key function.

● Start Runtime.
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Procedure

By clicking the "Edit" button , the table display is halted. Double-click any cell in the table 
to change the content of that cell. Values that occur during the edit process are archived.

Note

Values occurring during the edit process can be viewed in the static display. The static display 
is configured on the "Column" tab of the "Properties" dialog by deactivating the "Update" 
option.

If the time stamp for a joint selection is changed by editing, the new value will only be written 
in the first column of the database. The time stamp for the other columns will remain 
unchanged.

Return to the table display in Runtime mode by clicking the "Edit" button again.

See also
Operation of Online Table Control in Runtime (Page 1326)

Display of Archived Values

Introduction
The buttons in the toolbar of a table window and the respective keyboard shortcuts allow you 
to "page" through the archive.

In the table window, the values archived for a tag will be displayed within a time interval. The 
width of this interval is determined by the time range to be displayed or results from the time 
difference of entered start and end times.

Buttons for Archived Values

The table displays the tag values within a specified time range, beginning with 
the first archived value.
The table displays the tag values within the previous time interval, based on the 
currently displayed time interval.
The table displays the tag values within the next time interval, based on the 
currently displayed time interval.
The table displays the tag values within the specified time interval, ending with 
the last archived value.

Note

The WinCC Online Table Control cannot display more than 1000 values within a selected 
time range.
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See also
Operation of Online Table Control in Runtime (Page 1326)

Online Configuration for Online Table Control (Page 1327)

Configuration of WinCC Online Table Control (Page 1321)

How to Generate Statistics of Runtime Data

Introduction
You can generate a statistical evaluation of Runtime process data in the table window. The 
following results are displayed in a statistics window for all selected columns and a specified 
time frame:

● Minimum

● Maximum 

● Average

● Standard deviation

Requirement
● Configuration of Online Table Control.

● Configure the display of a toolbar by using the key functions "Select statistics area", 
"Calculate statistics" and "Start/stop update". If you wish to calculate statistics for all values 
of a table, you do not need the key function "Select statistics area".

● Configure the display by using the key function "Select time range" if you wish to choose 
a statistics area outside of the time range displayed in the columns.

● You can specify the font for the table that is displayed with the key function "Calculate 
statistics" in the "Font" tab and via the property "StatisticsFont". 

● Start Runtime.
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Procedure
1. In the toolbar, click the  button. If you wish to calculate statistics for all table values, 

click .         
The updated display is stopped, while process data archiving is continued.

2. In order to specify the time period for the calculation, use the mouse to select the table lines 
for the desired time frame. For different columns with different time frames you can select 
different time ranges for the calculation of statistics.  

3. In the toolbar, click the  button.

4. The "Statistics" window opens with results of the calculation for the specified time frame of 
one column.

5. If you wish to display the results of additional table columns, select the appropriate column 
in the "Column" field.

6. In order to continue with the display of Runtime data in the table, close the statistics window 

and click the  button in the toolbar.

7. If you require a statistical analysis of process data not displayed in the table window, click 

the  button. Enter the desired time frame in the "Select time range" dialog. The process 
data will be displayed for the specified time frame, and statistics can be calculated.

Note

For additional statistical analysis of process data and archiving of results you must write the 
scripts yourself.
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See also
Operation of Online Table Control in Runtime (Page 1326)

Online Configuration for Online Table Control (Page 1327)

Configuration of WinCC Online Table Control (Page 1321)

6.5.4.3 Before WinCC V7: Process Value Output in the Form of Trends in Process Pictures

Resources

WinCC Online Trend Control

Introduction
In order to process data in graphic form, WinCC uses Online Trend Control to offer the option 
of displaying process data as a trend. The trend type to be used can be selected. Furthermore 
you have the option of displaying current or archived values.

Display of tag values during Runtime takes place in ActiveX Control, inserted and configured 
in a picture in Graphics Designer. 

Requirement
The following requirements apply to the display of trends in WinCC Online Trend Control:

● In a WinCC Online Trend Control any number of trends can be displayed. However, it is 
recommended to configure no more than 8 trends.

● A trend can represent a maximum of 30000 value pairs. Depending on the screen resolution 
and the settings, the display might however vary.

● The trends can be based on online tags or archived tags.
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● Online tags of a trend must have the identical update cycle.

● In order to display tags as a function of other tags, you should use the WinCC Function 
Trend Control.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen 
resolution and selected size of the trend window. Therefore, when displaying trends, it is 
possible that fewer values are displayed in the trend window than are actually archived.

If, for example, in an area of 100 pixels 200 measured values are archived, each pixel 
represents 2 measured values. The value shown on the screen is that of the most recent data 
(most recent time stamp).

Representation Trend Lines

Representation Trend Lines

Introduction
WinCC Online Trend Control has a multitude of options to display a trend.

See also
Representation of Staggered Trends (Page 1342)

Identification of Time Jumps and Time Overlaps (Page 1346)

Time Range of Trend Display (Page 1343)

Write direction (Page 1343)

Representation Using Common Axes (Page 1340)

Representation formats (Page 1339)
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Representation formats

Introduction
Three basic trend format are available for the graphic display of tag values.

Single Values
Value of measurement points are shown as dots.

Linear Interpolation
The trend line is interpolated on a linear basis from values of measurement points. The trend 
is represented as either a solid line or a dashed line. The area under the curve can also be 
displayed in a solid color.

Stepped trend
The trend line is interpolated as a stepped curve from the values of measurement points. The 
trend is represented as either a solid line or a dashed line. The area under the curve can also 
be displayed in a solid color.
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Configuration
You configure the trends in the Graphics Designer in the Properties dialog on WinCC Online 
Trend Control in the Trends tab.   

See also
Representation Trend Lines (Page 1338)

Representation Using Common Axes

Introduction
If multiple trends are to be displayed in a trend window, you have the choice of using individual 
axes for each trend or using shared X/Y axes for all trends.
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Representation Using Different Axes
If the tag values to be displayed in a tag window differ greatly, the use of shared axes for the 
trend display is not recommended. The tag values can be read more easily if different axial 
scales are used. You can singly display the Y-axis for the trend in the foreground.

Representation Using Common Axes
If comparison of trend characteristics is important, it is recommended to display trends with 
common axes. You can assign a color for the common X-axis.

You can determine the exact tag values Runtime through zoom or coordinate inquiry.
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Configuration
You configure the display options of the axes in the Graphics Designer in the Properties dialog 
on WinCC Online Trend Control in the General tab.  

Note

When configuring an Online Trend Control, only tags with an identical updating cycle should 
be displayed in a trend window in the case of several trends with a common time axis. In the 
case of tags with different updating cycles, the length of the time axis is not identical for all 
tags. Since the tag trends are updated at different times due to the different updating cycles, 
a minimal different in the end time for the time axis occurs on each change. As a result, the 
trends displayed skip slightly to and fro on each change.

See also
Representation Trend Lines (Page 1338)

Representation of Staggered Trends

Introduction
In a staggered display, the trends are displayed offset over each other in the trend window. 
For each trend, the value range to be displayed can be set for the Y axis.

Configuration
You configure the display of the staggered curves in the Graphics Designer in the Properties 
dialog on WinCC Online Trend Control in the General tab.  
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See also
Representation Trend Lines (Page 1338)

Write direction

Introduction
With the "Write Direction" option, you can specify where the current measurement values are 
to be displayed. Setting "From the bottom" means that the current measurement values are 
processed from downward.

If you select for the write direction the "From the top" or "From the bottom" setting, you must 
use a True-Type font for the best display of the time axes labels in the trend window.

Configuration
You configure the write direction of the data in the Graphics Designer in the Properties dialog 
on WinCC Online Trend Control in the General tab.  

See also
Representation Trend Lines (Page 1338)

Time Range of Trend Display

Introduction
With regard to the time ranges to be displayed, there are a number of ways to present a trend 
display of tags:
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Static Representation of a Trend
Static representation presents the course of a tag within a defined time interval, based on the 
archived values.

The static display is configured on the "Time Axis" tab of the "Properties" dialog by deactivating 
the "Update" option. The time range to be displayed is set either

● by entering a start time and a time range.

● by entering a start time and an end time.

● by entering a start time and the number of measurement points to be displayed.

Note

This type of display can only be used for archive tags.
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Dynamic Representation of a Trend
In a dynamic display, the end time of a trend always corresponds to the current system time. 
New measurement values coming in are included in the display.

The static display is configured on the "Time Axis" tab of the "Properties" dialog by deactivating 
the "Update" option. The time range to be displayed is set either

● by entering a time range.

● by entering the number of measurement points to be displayed.

● by the time difference between the specified start and end times.

Note

Upon opening the trend window in Runtime, the tag values to be displayed are either read 
from the archive or are set to zero. This function is set in the "General" tab of the "Properties" 
dialog.

See also
How to Dynamize a Time Range in a Sript (Page 1352)

Representation Trend Lines (Page 1338)
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Identification of Time Jumps and Time Overlaps

Introduction
By changing the time, e.g. by switching from daylight saving to standard time or vice versa, 
time jumps or time overlaps may occur in the archive.

In a trend display of archived values, the time axis labeling is modified and marked with a 
vertical line in the presence of time gaps or time overlaps.
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Configuration
On the "Limit Values" tab of the "Properties of WinCC Online Trend Control" dialog, the marker 
line can be assigned a color.

See also
Representation Trend Lines (Page 1338)

Configuration

Configuration of WinCC Online Trend Control

Introduction
The steps necessary for configuration of WinCC Online Trend Control depend on the tags you 
wish to display.
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Display of Online Tags
1. The tags you wish to display need to be configured in WinCC Explorer.

2. Link WinCC Online Trend Control to a picture in Graphics Designer and modify the 
properties of ActiveX Control.

Display of Archive Tags
1. The tags you wish to display need to be configured in WinCC Explorer.

2. Use the Archive Wizard to create a process value archive.

3. Configure the process value tags it is to contain.

4. Link WinCC Online Trend Control to a picture in Graphics Designer and modify the 
properties of ActiveX Control.

See also
How to Insert an Online Trend Control in a Picture (Page 1348)

How to Configure Trends in Online Trend Control (Page 1350)

How to Dynamize a Time Range in a Sript (Page 1352)

How to Activate the Example for Online Trend Control (Page 1355)

How to Insert an Online Trend Control in a Picture

Introduction
The trends are displayed during Runtim in an ActiveX Control that you can configure in 
Graphics Designer.
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Procedure
1. Start Graphics Designer and open a new picture.

2. Click the "WinCC Online Trend Control" object on the "Controls" tab in the object palette.

3. Place the mouse pointer at the position in the picture where you want to insert the control. 
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the control to the desired size.         
The "Properties of WinCC WinCC Online Trend Control" quick configuration dialog is 
opened.
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5. Configure the properties of WinCC Online Trend Control in the General tab.

6. Close the dialog with the "OK" button.

See also
How to Configure Trends in Online Trend Control (Page 1350)

How to Configure Trends in Online Trend Control

Introduction
Define the trend properties in the tabs of the WinCC Online Trend Control configuration dialog.
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Requirement
● You have inserted the tags for data supply to the trends in Tag Management.

● You have configured the process value archive while supplying archive tags as data.

● You have inserted WinCC Online Trend Control in a picture in Graphics Designer and 
defined the properties of Control.

Procedure
1. Double-click WinCC Online Trend Control.

2. Click the "Curves" tab.

3. Use "+" key to define the desired number of trends.
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4. Define the sequence of trends in control using "Up" and "Down" keys.

5. Select in the Trends section: one trend to define the trend properties and data supply.

6. In the "Archive/ Tag selection" define the data supply to the trend. In the "Data supply" field, 
define whether the data is to be provided online or from an archive. Select the corresponding 
tag via the "Selection" button.

7. Specify the display type and line weight of the trend.

8. Configure additional properties of the trend on the WinCC Online Trend Control tab.

– In the Time Axis tab, you can define the time range for accessing the archived values.

– In the Value Axis tab define the value range properties, for e.g. scaling.

9. Close the dialog with the "OK" button. Configuration of WinCC Online Trend Control is 
saved.

See also
How to Configure the Value Range of Trends (Page 1353)

How to Dynamize a Time Range in a Sript

Introduction
With WinCC Online Graph Control, the properties for "EndTime" and "BeginTime" can be 
dynamically configured using a C script. 

In the example, the values for EndTime and BeginTime are defined in two I/O fields. The entry 
is of the following format: "dd.mm.yyyy hh.mm.ss" e.g. 04.09.2002 10:20:00.

The time range in WinCC Online Trend Control is updated using a C script. The C script is 
triggered by clicking the button control. To update the time range, the C script deactivates and 
reactivates the WinCC Online Trend Control.

Procedure
1. In Tag Management, configure the tags "strVar_1" and "strVar_2" of data type "text tag 8-

bit value" and the tag "TagLog" of data type"unsigned 16-bit value".

2. Start Tag Logging and create a process value archive by using the Archive Wizard and 
configure the process value tag contained therein.

3. Start Graphics Designer and open a picture. Insert a WinCC Online Trend Control into the 
picture and link it to the process value tag.

4. Insert two I/O fields into the picture and link it to the tags "strVar_1" and "strVar_2", 
respectively. In object properties "Output/Input" of the I/O fields, enter "String" as data 
format and "*" as output format.

5. Insert a button into the picture and save the picture as “NewPDL0.PDL“.

6. Open the "Object Properties" dialog of the button and click the "Event" tab.

7. In the left pane, select "Mouse click" as the trigger of the event.
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8. Right-click the "Mouse click" event and select the "C Action..." command from the pop-up 
menu.

9. The StartTime and EndTime properties are dynamized with the following script. Copy this 
script into the edit field of the "Edit Action" dialog and click "OK".
 //Set index for Trend1
SetPropWord("NewPdl0.Pdl","Control1","Index",0);  //return type :BOOL 
                              SetPropBOOL("NewPdl0.PDL","Control1","Online",FALSE); 
       SetPropBOOL("NewPdl0.PDL","Control1","TimeRange",FALSE); 
    SetPropBOOL("NewPdl0.PDL","Control1","Activate",FALSE);     
//Sets BeginTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","BeginTime",GetTagChar("strVar_1"));
//Sets EndTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","EndTime",GetTagChar("strVar_2"));  
//Set Index for Trend2
SetPropWord("NewPdl0.Pdl","Control1","Index",1); //return type :BOOL         
SetPropBOOL("NewPdl0.PDL","Control1","Online",FALSE); 
       SetPropBOOL("NewPdl0.PDL","Control1","TimeRange",FALSE); 
   SetPropBOOL("NewPdl0.PDL","Control1","Activate",FALSE); 
//Sets BeginTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","BeginTime",GetTagChar("strVar_1"));
//Sets EndTime Parameter: dd.mm.yyyy hh:mm:ss
SetPropChar("NewPdl0.PDL","Control1","EndTime",GetTagChar("strVar_2"));  
//Activate BeginTime and EndTime at Trend Control
SetPropBOOL("NewPdl0.PDL","Control1","Activate",TRUE);        

10.Save the picture and start Runtime.

11.In the I/O fields, enter the values for "EndTime" and "StartTime" in format "dd.mm.yyyy 
hh.mm.ss". Confirm each entry with "Enter".

12.By clicking the button, the time range is updated in WinCC Online Trend Control.

See also
How to Activate the Example for Online Trend Control (Page 1355)

Time Range of Trend Display (Page 1343)

How to Configure the Value Range of Trends

Introduction
For each trend, you can customize the value range and the scaling for the trend display in the 
Value Axis tab of the Configuration Dialog of WinCC Online Trend Control.

When you have inserted a trend, the value range and the scaling to be displayed is pre-
configured as follows:

● The value range is automatically based on the minimum and maximum value of the selected 
curve. If you use a common value axis, the minimum and maximum values of all trends of 
the trend window are dtermined.

● The value axis scale is linear to the value range.
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Requirement
● You have inserted the trends and configured the data supply.

Procedure
1. Click the configuration dialog of WinCC Online Trend Control on the Value Axis tab.

1. In Trend: select the trend whose value axis you want to change.

2. In the Range Selection, deactivate the Automatic option button if you want to define a fixed 
value range and a separate scaling of the value axis.

3. In the "From:" and "To:" input fields enter the minimum and maximum value of the value 
range.
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4. For configuring the scaling, activate the User Scaling option button. Click "..." to define a 
scaling for the selected value range.

5. You must define segments without gaps for the entire value range and assign areas on the 
value axis. If you have defined a value range, say "0 - 100000" you can divide this value 
range into three sections that you can display as follows on the value axis:

For e.g. value range "0 - 50000" is displayed during Runtime on the value axis in the "100 - 
500" range if the User Scaling option box is activated.

How to Activate the Example for Online Trend Control

Requirement
Before activating the WinCC Online Trend Control example, you must complete the following 
steps:

● Save the picture configure by you.

● Use the pop-up menu in the WinCC Explorer to select the stored picture as the start picture.
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● Check whether "Graphics Runtime" and "Tag Logging Runtime" are selected in the startup 
list of WinCC Explorer ("Computer Properties" dialog).

Procedure
You have several options to start Runtime:

● From the toolbar of the WinCC Explorer

● From the menu bar of the WinCC Explorer

During configuration you can call individual pictures in Runtime:

● From the toolbar of the Graphics Designer

● From the menu bar of the Graphics Designer

How to apply the configuration of trend parameters from PCS 7

Introduction
In PCS 7, you can use the SIMATIC Manager to configure the properties of tags that have an 
effect on the display in Trend Controls. The specified parameters can be transferred to WinCC 
Online Trend Control.

Automatic configuration of trend parameters from PCS 7 data
In WinCC Online Trend Control, the properties for tags planned in PCS 7 are applied as trend 
parameters. The following parameters are configured automatically:

● The low limit of the trend range

● The high limit of the trend range

● The units of measurement for the trend
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In runtime, the tag values are shown as a trend within these limits. The unit of measurement 
is shown on the "Y axis".

Procedure
1. Add a new trend in WinCC Online Trend Control.

2. Select an archive tag or online tag that has already been configured in PCS 7. If the 
properties indicated above are configured for these tags, the following parameters are 
configured in the "Value Axis" tab:

– The "Label" field contains the unit of measurement for the tag. You can change the label.

– In the "Range selection" area, the "Apply the properties of the tag display" option is 
activated and the "Automatic" option is deactivated.

– The tag names for the high limit and the low limit of the variables are entered in the fields 
"From" and "To" in the "Range selection" area. These limits cannot be changed.

– The "User Scaling" option is deactivated in the "Scaling" area.

3. If you want to change the limits for the trend range and configure a user scale, deactivate 
the "Apply tag properties" option.

Operation in Runtime

How to Operate Online Trend Control in Runtime

Introduction
The trend window is operated in runtime via the buttons in the toolbar.

Overview

"Online-Help-System"
Opening the online help

"Open the Configuration Dialog"
Selecting the dialog to assign display parameters.
"First Data Record"
Click this button to display the tag trend in the trend window, starting with the first 
archived tag.
"Previous Data Record"
Click this button to display the tag trend of the previous time interval in the trend 
window, based on the currently displayed time interval.
"Next Data Record"         
         
Click this button to display the tag trend of the next time interval in the trend window, 
based on the currently displayed time interval.
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"Online-Help-System"
Opening the online help

"Last Data Record"         
         
Click this button to display the tag trend ending with the last archived value in the 
trend window, based on the currently selected time interval.
"Display Value at this Position"
Click this button to query the coordinate points of a trend.
"Zoom Area"
Click this button to zoom in on any section of the trend window.
"Activate Original View"
Click this button to return to the configured normal view (after zooming).
"Dialog for Archive and Tag Selection"         
         
This button opens the dialog for archive and tag selection.
"Dialog for Trend Selection"
Click this button to open the dialog for the selection of visible and invisible trends.
"Select Time Range"         
         
Click this button to open the dialog where you can specify the time range to be 
displayed in a trend window.
"Previous trend in foreground"         
         
Click this button to display the previous trend in the foreground of the trend window.
"Next trend in the front"         
         
Click this button to display the next trend in the foreground of the trend window.
"Start/Stop update"
The updated display is stopped. The values are buffered and updated when the 
button is clicked again.
"Start/Stop update"
Resume display.
"Print Log"
Click this button to print the trend shown in the trend window. Print job used during 
printing can be specified in the control properties on the "General" tab.
"Select Statistics Area"
Click this button to define the time period for the calculation of statistics in trend 
window using vertical lines.
"Calculate Statistics"
Click this button to open the statistics window where the minimum, maximum, 
average and standard deviation for a specified time frame and trend are shown.
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"Online-Help-System"
Opening the online help

"Save report"
Saves the current data of the control for the displayed trends in the time frame 
indicated. The updated display must be stopped.
The report will be saved as a ".csv" file in the WinCC project directory under "Export/
TagLogging". The file name consists of window title of Control and the 
timestamp.         
If you import the file into MS Excel, the local language settings are used. The "List 
separator" and the "Comma sign" can then lead to an incorrect display. In order to 
ensure a correct display, give the ".csv" file the extension "*. txt". You then have 
the ability to select the "List separator" and the "Comma sign" manually during the 
import.
"Zoom out"
Decreases the zoom factor.
"Zoom in"
Increases the zoom factor.
"Relative scale"
Switches from displaying the absolute values to the percentage display of value 
axis. The high and low limits for the trend correspond with a range of 0 to 100%.
The following requirements apply to the "Relative scale" keyboard function:
● All trends displayed are assigned a fixed value range.
● The trends have no user scaling.
● The trends are scaled linearly.

Right-click trend When the update is stopped, right-click the trend to display the archive name, the 
tag name and the coordinates of the respective point.

 

Note

Click the "Display value at this position" button in the toolbar to display the coordinate points 
of a trend. The displayed tag values can be assigned an additional attribute in the form of a 
letter. Where:
● Letter "i" : The displayed tag value is interpolated.
● Letter "u" : The displayed value is of uncertain status. This attribute is displayed when the 

initial value is not known after Runtime has been activated, or when a substitute value is 
used.

 

The "Page" buttons in archives are only available, if the trend to be displayed originates in a 
process value archive.
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See also
How to Generate Statistics of Runtime Data (Page 1371)

Starting and Stopping Update (Page 1365)

Trend to Front (Page 1365)

How To Enlarge a Segment of a Trend (Page 1369)

How to Determine the Coordinates of a Point (Page 1367)

Online Configuration of Online Trend Control (Page 1360)

Online Configuration of Online Trend Control

Introduction
There are four options available to change the configuration of the Online Table Control in 
Runtime:
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Key function "Open the Parameter Dialog"

The "Open Set Configuration Dialog" key function provides access to all essential settings 
for trend display. 
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Key function "Dialog for Archive and Tag Selection"

The "Dialog for Archive and Tag Selection" key function allows for the specification of the 
tags linked to the trends in a trend window.

Array Description

Trend Select a configured trend.
Selectio
n

Use the Selection button to open the dialog for selecting the linked tags.

Persiste
nce

If the "Persistence in RT and CS" option is not activated, any changes made to the settings 
are only effective within Runtime. Whether or not any changed settings remain effective 
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, all changed settings are also 
transferred to the configuration system. To do this, you must open the picture in Graphics 
Designer and save it once again. The changed settings are also used when the project is 
reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with PCS 
7 projects or TIA projects. When you completely load the ES to the OS, the changed settings 
on the OS will be overwritten.          
Configure the properties of the controls on the ES.
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Key Function "Dialog for Selecting Trends"

The "Dialog for Trend Selection"  key function opens the dialog for the selection of visible 
and invisible trends.

Array Description

Trend in the 
foreground

If a common axis is used, the settings for the display of the first trend are applied for 
the display of the axis. You can configure a uniform color for the common X-axis. The 
first trend can be changed either in this dialog or by using the "Previous trend in 
foreground" and "Next trend in the front" buttons in the toolbar.

Trend visible/
invisible:

In this area, you can specify the trends that are not to be shown.

Persistence If the "Persistent in RT and CS" option is not activated, any changes made to the 
settings are only effective within Runtime. Whether or not any changed settings remain 
effective after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, all changed settings are also 
transferred to the configuration system. To do this, you must open the picture in 
Graphics Designer and save it once again. The changed settings are also used when 
the project is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with 
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the 
changed settings on the OS will be overwritten.          
Configure the properties of the controls on the ES.

 

Note

The first trend in a trend window cannot be made "invisible".
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Key Function "Select Time Range"

The key function "Select Time Range"  opens a dialog to specify the time range to be 
displayed. If the trends in the trend window are to be displayed with a common time axis, the 
specified time range applies to all trends.

Array Description

Trend Select a configured trend.
Time 
Selection

The time interval to be displayed in the trend window can be set
by entering a start and an end point (the "Time Range" setting not activated).
by entering a start time and a time range. ("Time Range" setting activated). The length of 
the time interval to be displayed is determined by multiplying the "Factor" by the "Range".

Persistenc
e

If the "Persistent in RT and CS" option is not activated, any changes made to the settings 
are only effective within Runtime. Whether or not any changed settings remain effective 
after a picture change depends on the "Persistence in RT" option.
If the "Persistence in RT and CS" option is activated, all changed settings are also 
transferred to the configuration system. To do this, you must open the picture in Graphics 
Designer and save it once again. The changed settings are also used when the project 
is reactivated.
Changes to the control properties in Runtime are not persistently accepted in CS with 
PCS 7 projects or TIA projects. When you completely load the ES to the OS, the changed 
settings on the OS will be overwritten.          
Configure the properties of the controls on the ES.

The entry format of the date and time depends on the Runtime language used.
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See also
Configuration of WinCC Online Trend Control (Page 1347)

How to Generate Statistics of Runtime Data (Page 1371)

How to Operate Online Trend Control in Runtime (Page 1357)

Starting and Stopping Update

Introduction
The update of the trend window can be started and stopped with the "Start/Stop" key function. 

If updating has stopped, you can: 

● change the displayed time range and thus display the measured values from the process 
value archive in the trend window. 

● save the data of the displayed trends for the displayed time range in a report.

Certain functions, such as the "Zoom Area" keyboard function automatically stop the update 
of value of measurement points.

You will recognize the status of the update by the appearance of the button.

● : When updates are stopped, you may change the displayed time frame and therefore 
display measurement values from the process value archive in the table window.

● : When updates are started, you may change the displayed time frame and therefore 
display measurement values from the process value archive in the table window.

See also
How to Operate Online Trend Control in Runtime (Page 1357)

Trend to Front

Introduction
You can modify the trend displayed on top in runtime:

● by clicking the  button ("Dialog for Trend Selection" key function)

● by clicking the  button: ("Next trend to Front" key function)

● by clicking the  button: ("Previous Trend to Front")

If common axes are used, the settings for the trend displayed in the foreground are used for 
displaying the axes. You can however configure a uniform color for the common X-axis. 
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Configuration
You define the sequence of the trends in the Trends tab of the Properties dialog in WinCC 
Online Trend Control. Select a trend and click "Up" or "Down" button.

See also
How to Operate Online Trend Control in Runtime (Page 1357)
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How to Determine the Coordinates of a Point

Introduction
You can use the "Display Value at this Position" key function to determine the coordinates of 
a point in the trend. To make it easier to determine the coordinates, you can also enlarge a 
particular segment of the trend lines.

Requirement
● Configure the Online Trend Control.

● Configure the display of a toolbar, using the key functions "Zoom Area" and "Activate 
Original View".

● You can specify the font for the tag value table that is displayed with the key function 
"Display value here" in the "Font" tab and via the property "RulerFont". 

● Start Runtime.

Procedure

When activating the  button for "Display Value at This Position" a vertical line, a ruler, is 
added to the trend window. Below the trend window, the X and Y coordinates of the measured 
value are displayed together with the archive and tag names.

The displayed tag values can be assigned an additional attribute in the form of a letter. Where:
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● Letter "i" : The displayed tag value is interpolated.

● Letter "u" : The displayed value is of uncertain status. This attribute is displayed when the 
initial value is not known after Runtime has been activated, or when a substitute value is 
used.

Other measurement values can be determined by positioning the mouse pointer on the ruler 
and moving it – while keeping the left mouse button pressed – to the desired position.

Note

The "uncertain" status of a tag value can also be identified in the displayed trend 
characteristic. To do this, you must activate the "Value with uncertain status" option on the 
"Limit Values" tab of the "Properties of WinCC Online Trend Control" dialog. 

 

If you do not wish to display the tag link in the table, you must set "HideTagNames" in the 
object property dialog to "Yes".

See also
How to Operate Online Trend Control in Runtime (Page 1357)
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How To Enlarge a Segment of a Trend

Introduction
You can use the "Enlarge Area" key function to zoom in on any segment of the trend window. 
You may then find that the keyboard function "Display Value at this Position" is easier to use 
within the enlarged display to determine the coordinates of a particular measurement point. 
Use the "Activate Original View" key function to switch back from an enlarged display to normal 
display mode.

Requirement
● Configure the Online Trend Control.

● Configure the display of a toolbar, using the buttons assigned to key functions "Zoom Area" 
and "Activate Original View".

● Start Runtime.

Procedure
1. Click the "Enlarge Area"  button in the toolbar.         

The display stops being updated and the mouse pointer changes to a cross-hair.

2. In the trend window, click one corner of the area that you wish to enlarge.

3. Hold down your left mouse button and drag the area you want to enlarge until it reaches 
the desired size. If the highlighted area contains at least two measured values, the selected 
trend area is displayed in the trend window.

4. Release the left mouse button.         
The section you selected is now shown enlarged.

5. Click the "Activate Original View" button  in the toolbar.         
The trend window is displayed again in normal view as originally configured.

6. Click the "Start/Stop the Update" button in the toolbar to restart updating the display in the 
trend window. For the value ranges of the X and Y axes, the preset values is used by default.

See also
How to Operate Online Trend Control in Runtime (Page 1357)

Expanded zoom functions

Introduction
Using the "Zoom area", "Zoom in" and "Zoom out" keyboard functions, a segment of the trend 
window can be made larger or smaller in WinCC Online Trend Control. 
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"Zoom in" and "Zoom out" keyboard functions
Updating the trend values is stopped when zooming with the "Zoom area" keyboard function.

The trend values can be updated while zooming as well by activating the "Zoom in" and "Zoom 
out" keyboard functions.

Requirement
The following requirements apply to "Zoom in" and "Zoom out.

● All trends displayed are assigned a fixed value range.

● The trends have no user scaling.

● The trends are scaled linearly.

"Zoom in", "Zoom out" and original view buttons
The following buttons have been added to the toolbar of WinCC Online Trend Control for new 
keyboard functions:

 Zoom in. Increases the zoom factor.

 Zoom out. Decreases the zoom factor.

While zooming in or zooming out, the 50% value of the trend is always shown in the center of 
the value axis.

If you change the limits in the "Value Axis" tab in the configuration dialog while zooming, the 
visible zoom area is set to the new limits.

If you want to view the trend window in the original configured view again, click "Activate original 
view" in the tool bar:

 Activate original view.

Display of archived values

Introduction
Use the buttons in the toolbar of a trend window or the corresponding key combinations to 
browse through an archive.

The values archived of a tag are thereby displayed within a time interval in the trend window. 
The width of this interval is determined by the time range to be displayed or results from the 
time difference of entered start and end times.

Requirement
The buttons for browsing in archive are available only if data is supplied through archive tags.
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Buttons for Archived Values

  

The trend displays the tag values within a specified time range, beginning with the first 
archived value.
The trend displays the tag values within the previous time interval, based on the currently 
displayed time interval.
The trend displays the tag values within the next time interval, based on the currently 
displayed time interval.
The trend displays the tag values within a specified time range, ending with the last 
archived value.

 

See also
How to Operate Online Trend Control in Runtime (Page 1357)

Online Configuration of Online Trend Control (Page 1360)

Configuration of WinCC Online Trend Control (Page 1347)

How to Generate Statistics of Runtime Data

Introduction
You can generate a statistical evaluation of Runtime process data in the trend window. The 
following results are displayed in a statistics window for all displayed trends and a specified 
time frame:

● Minimum

● Maximum 

● Average

● Standard deviation

Requirement
● Configure the Online Trend Control.

● Configure the display of a toolbar by using the key functions "Select statistics area", 
"Calculate statistics" and "Start/stop update".

● Configure the display with the "Select Time Range" keyboard function, if you wish to choose 
a statistics area outside of the time range displayed in the columns.

● You can specify the font for the tables that is displayed with the key functions "Select 
statistics range" and "Calculate statistics" in the "Font" tab and via the property 
"StatisticsFont".

● Start Runtime.
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Procedure
1. In the toolbar, click the  button.         

The updated display is stopped; process data continues to be archived. The updated display 
is stopped, process data continue to be archived. Two vertical lines are displayed at the 
left and right edge of the trend window. A window containing the statistics area shows the 
current upper (OG) and lower (UG) limits of the trends.

2. Specify the time frame for calculation by dragging both lines to their desired x axis position, 
using the mouse.

3. In the toolbar, click the  button.

4. The "Statistics" window opens showing the results of the calculation for the specified time 
frame of one trend.

5. If you wish to display the results of an additional trend in the trend window, select the 
appropriate trends in the "Trends" field.

6. In order to continue with the display of Runtime data in trends, close the statistics window 
and click the  button in the toolbar.

7. If you require a statistical analysis of process data that are not displayed in the trend window, 
click the  button. Enter the desired time frame in the "Select time range" dialog. The 
process data are displayed for the specified time frame, and statistics can be calculated.
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To view the process value and the X/Y coordinates of a point in the trend, right-click it. The 
information is shown in a tooltip window.

Note

For additional statistical analysis of process data and archiving of results you must write the 
scripts yourself.

See also
How to Operate Online Trend Control in Runtime (Page 1357)

Online Configuration of Online Trend Control (Page 1360)

Configuration of WinCC Online Trend Control (Page 1347)

6.5.4.4 Before WinCC V7: Process Value Output as a Function of Another Tag

Resources

WinCC Function Trend Control

Introduction
For a graphic processing of tags, Function Trend Control in WinCC offers the option of 
displaying one tag as a function of another tag. For example, temperature may be shown as 
a function of pressure. Furthermore, trends may be compared to target trends.

Display of trends during Runtime takes place in ActiveX Control, inserted and configured in a 
picture in Graphics Designer.
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Requirement
For the display of trends in WinCC Function Trend Control the following prerequisites apply:

● In a WinCC Function Trend Control any number of trends may be displayed. However, it 
is recommended to configure no more than 8 trends.

● A trend can represent a maximum of 10000 value pairs.

● For these trends, either online tags, archive tags or data from user archives may be used.

● Online tags of a trend must have the identical update cycle.

● Archive tags of a trend must have the same update cycle and must be recorded in a 
continuous cycle.

● Data from user archives can be used for target trends.

● The representation of tags in the form of functions over time is only possible, if the values 
of the trend are supplied through the API interface. In order to display tags as a function of 
time, you should use the WinCC Online Trend Control.

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen 
resolution and selected size of the trend window. Therefore, when displaying trends, it is 
possible that fewer values are displayed in the trend window than are actually archived.
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If, for example, in an area of 100 pixels 200 measurement values are archived, each pixel will 
represent 2 measurement values. The value shown on the screen is that of the most recent 
data (most recent time stamp).

Display of Trends

Representing Trend Lines

Introduction
WinCC Function Trend Control provides a number of options for representing a trend line.

See also
Comparison with an Ideal Trend (Page 1389)

Identification of Special Values (Page 1387)

Time Range of Trend Display (Page 1386)

Write Direction (Page 1384)

Display of Staggered Trends (Page 1382)

Display with Logarithmic Axes (Page 1380)

Display with common axes (Page 1378)

Forms of Display (Page 1375)

Forms of Display

Introduction
To graphically display tag values, three basic representation types are available.

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1375



Single Values
Value of measurement points are shown as dots.

Linear Interpolation
The trend line is interpolated on a linear basis from values of measurement points. The trend 
is represented as either a solid line or a dashed line. The area under the curve can also be 
displayed in a solid color.

Stepped Trend
The trend line is interpolated as a stepped curve from the values of measurement points. The 
trend is represented as either a solid line or a dashed line. The area under the curve can also 
be displayed in a solid color.
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Configuration
The display of trends is configured on the General tab of the Properties of WinCC Online Trend 
Control dialog.

See also
Properties of Function Trend Control - Trends Tab (Page 1420)

Representing Trend Lines (Page 1375)
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Display with common axes

Introduction
If multiple trends are to be displayed in a trend window, you have the choice of using individual 
axes for each trend or using shared X/Y axes for all trends.

Display with Different Axes
If the tag values to be displayed in a tag window differ greatly, the use of shared axes for the 
trend display is not recommended. The tag values can be read more easily if different axial 
scales are used.
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Display with Common Axes
If comparison of trend characteristics is important, it is recommended to display trends with 
common axes. The exact tag values may be determined in Runtime through zoom or 
coordinate inquiry.

Configuration
The display of common axes is configured in the General tab of the Properties of WinCC 
Function Trend Control dialog.
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See also
Properties of Function Trend Control - General Tab (Page 1416)

Representing Trend Lines (Page 1375)

Display with Logarithmic Axes

Introduction
The axes in the trend window can be scaled on either a logarithmic or a linear basis. 
Representation using logarithmic axes means that no negative values can be displayed, and 
representation using negative logarithmic axes means that no positive values can be displayed.
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Configuration
Representations using logarithmic axes are configured in the X axis or Y axis tab of the 
Properties of WinCC Function Trend Control dialog.

See also
Representing Trend Lines (Page 1375)
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Display of Staggered Trends

Introduction
In a staggered display, the trends are displayed offset over each other in the trend window. 
For each trend, the value range to be displayed can be set for the Y axis.
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Configuration
The display of staggered trends is configured in the General tab of the Properties of WinCC 
Online Trend Control dialog.

See also
Properties of Function Trend Control - General Tab (Page 1416)

Representing Trend Lines (Page 1375)
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Write Direction

Introduction
The write direction defines the direction in which the positive values on the axes are depicted. 
Thus the setting from the bottom means that positive values on the Y axis will be shown in the 
downward direction.

If a setting of From the top or From the bottom is selected for the write direction, only True-
Type fonts should be used inside the Trend window to ensure a clear display of labels on the 
vertical axis.
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Configuration
The write direction configured in the General tab of the Properties of WinCC Function Trend 
Control dialog.

See also
Properties of Function Trend Control - General Tab (Page 1416)

Representing Trend Lines (Page 1375)
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Time Range of Trend Display

Introduction
With regard to the time ranges to be displayed, there are a number of ways to present a trend 
display of tags:

Static Representation of a Tag
Static representation presents the course of a tag within a defined time interval, based on the 
archived values.

If display updating is stopped in runtime, the Data Linking tab of the Properties of WinCC 
Function Trend Control dialog can be used to configure the time range that needs to be 
represented. This time range is derived either by defining a starting time and end time or by 
defining a starting time and the number of value pairs to be represented.

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
1386 System Manual, 11/2008,  



Dynamic Display of Tags
When displaying one tag as a function of another tag in dynamic mode, the value of 
measurement point associated with the current system time changes along the function graph. 
New measurement values coming in will be included in the display.

The time range to be represented is configured in the Data Linking tab of the Properties of 
WinCC Function Trend Control dialog. This time range is derived either by defining a starting 
time and end time or by defining the number of value pairs to be represented.

See also
Representing Trend Lines (Page 1375)

Identification of Special Values

Introduction
In any trend, values may occur which are above or below a limiting value, or which have an 
uncertain status. Such special values can be highlighted in color. Values with an uncertain 
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status are those whose initial value is not known after runtime has been activated, or for which 
a substitute value is used.

Configuration
Color-coded identification of special values is configured in the Limiting Values tab of the 
Properties of WinCC Function Trend Control dialog.

See also
Representing Trend Lines (Page 1375)
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Comparison with an Ideal Trend

Introduction
Any trend can be configured with an ideal trend. It is then possible to make an effective 
comparison between the actual trend line and the specified ideal trend. The values for the ideal 
trend must be held in a user archive. You can create user archives with the aid of WinCC option 
User Archives.

Configuration
The values for the ideal trend are configured in a user archive. 

The display for an ideal trend is configured in the Trends tab of the Properties of WinCC 
Function Trend Control dialog box.
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See also
Properties of Function Trend Control - Trends Tab (Page 1420)

Representing Trend Lines (Page 1375)
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Configuration

Configuration of WinCC Online Trend Control

Introduction
The steps you need to take in order to configure WinCC Function Trend Control are dependent 
on the tags you wish to display.

Display of Online Tags
1. The tags you wish to display need to be configured in WinCC Explorer.

2. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the 
properties of the ActiveX Control.

Display of Archive Tags
1. The tags you wish to display need to be configured in WinCC Explorer.

2. Use the Archive Wizard to create a process value archive.

3. Configure the process value tags it will contain.

4. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the 
properties of the ActiveX Control.

Display of Values from User Archive
1. Create a user archive.

2. Configure the fields it will contain.

3. Link the WinCC user archive table element to a Graphics Designer picture and edit the 
properties of the ActiveX Control.

4. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the 
properties of the ActiveX Control.

5. Enable runtime and input the display values into the user archive or import them from a csv 
file.

Comparison with an Ideal Trend
1. Create a user archive.

2. Configure the fields it will contain.

3. Link the WinCC user archive table element to a Graphics Designer picture and edit the 
properties of the ActiveX Control.
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4. Link the WinCC Function Trend Control to a Graphics Designer picture and edit the 
properties of the ActiveX Control.

5. Enable runtime and input the ideal trend values into the user archive or import them from 
a csv file.

See also
How to Display Archive Tags (Page 1394)

How to Compare Tag Values with an Ideal Trend (Page 1396)

How to Display Data from User Archives (Page 1395)

How to Display Online Tags (Page 1393)

How to Insert Function Trend Control in a Picture (Page 1392)

How to Insert Function Trend Control in a Picture

Introduction
Tags are displayed in runtime in an ActiveX Control, which is inserted in a picture and 
configured with the aid of the Graphics Designer.

Procedure
1. Start Graphics Designer and open a new picture.

2. In the Object Palette Default tab, click the smart object Control.

3. Place the mouse pointer at the position in the picture where you want to insert the 
control.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Drag the control to the desired size.         
The Insert a Control dialog is opened.

5. Select WinCC Function Trend Control and confirm your selection by clicking OK.         
The Properties of WinCC Function Trend Control quick configuration dialog box opens.

6. Click OK to close the dialog.

See also
How to Compare Tag Values with an Ideal Trend (Page 1396)

How to Display Data from User Archives (Page 1395)

How to Display Online Tags (Page 1393)

How to Display Archive Tags (Page 1394)
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How to Display Online Tags

Requirement
● Configure two tags (Tag1, Tag2) with data type signed 16-bit value.

● Insert the Function Trend Control into a Graphics Designer picture.

Procedure
1. In Graphics Designer, open a picture using Function Trend Control.

2. Double-click the Function Trend Control.

3. Click the "Data Linking" tab.

4. For "Data Source", select the "Online Tags" setting.

5. In the "Select Archive/Tag" area, use the button marked "..." and select Tag1 for the X axis.

6. In the "Select Archive/Tag" area, use the button marked "..." and select Tag2 for the Y axis.

7. To define the time range you wish to display, specify a starting time and the number of 
value pairs to be represented.

8. Close the dialog with the "OK" button.

9. Save the picture.

10.Enable runtime and start the WinCC Tag Simulator.

Note

The tags to be displayed within a trend must have the same updating cycle.

See also
How to Use the Simulator (Page 1401)

How to Insert Function Trend Control in a Picture (Page 1392)

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1393



How to Display Archive Tags

Requirement
● Configure two tags (Tag1, Tag2) with data type signed 16-bit value.

● Create a process value archive containing Tag1 and Tag2.

● Insert the Function Trend Control into a Graphics Designer picture.

Procedure
1. In Graphics Designer, open a picture using Function Trend Control.

2. Double-click the Function Trend Control.

3. Click the "Data Linking" tab.

4. For "Data Source", select the "Archive Tags" setting.

5. In the "Select Archive/Tag" area, use the button marked "..." and select Tag1 stored in 
process value archive PW1 for the X axis.

6. In the "Select Archive/Tag" area, use the button marked "..." and select Tag2 stored in 
process value archive PW2 for the Y axis.

7. To define the time range you wish to display, specify a starting time and the number of 
value pairs to be represented.

8. Close the dialog with the "OK" button.

9. Save the picture.

10.Enable runtime and start the WinCC Tag Simulator.

Note

The tags to be displayed in a trend must originate from an archive on a server and be acquired 
in a continuous cycle.
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See also
How to Use the Simulator (Page 1401)

How to Insert Function Trend Control in a Picture (Page 1392)

How to Create a Process Value Archive (Page 1412)

How to Display Data from User Archives

Introduction
You can use WinCC Function Trend Control to display value pairs from user archives. You 
can create user archives with the aid of WinCC option User Archives.

Requirement
● Configure a user archive with the columns "Setpoint X" and "Setpoint Y".

● In runtime, input values for "Setpoint X" and "Setpoint Y".

● Insert the Function Trend Control into a Graphics Designer picture.

Procedure
1. In Graphics Designer, open a picture using Function Trend Control.

2. Double-click the Function Trend Control.

3. Click the "Data Linking" tab.

4. Go to "Provider" and select the setting "User Archive".

5. In the "User Archive" area, use the button marked "..." and select user archive UA1.

6. In the "Column for X Values" area, select the "Setpoint X" column.

7. In the "Column for Y Values" area, select the "Setpoint Y" column.

8. To define the time range you wish to display, specify the number of value pairs to be 
represented and the ID of the first value pair.

9. Close the dialog with the "OK" button.

10.Save the picture.

11.Enable runtime and start the WinCC Tag Simulator.
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See also
How to Use the Simulator (Page 1401)

How to Insert Function Trend Control in a Picture (Page 1392)

How to Create a User Archive (Page 1413)

How to Compare Tag Values with an Ideal Trend

Requirement
● Configure a user archive with the columns "Setpoint X" and "Setpoint Y".

● In runtime, input values for "Setpoint X" and "Setpoint Y".

● Insert the Function Trend Control into a Graphics Designer picture.

● Configure the data linking for the Function Trend Control.

Procedure
1. In Graphics Designer, open a picture using Function Trend Control.

2. Double-click the Function Trend Control.

3. Click the "Trends" tab.

4. Select the "Ideal Trend" check box.

5. Click the "Properties..." button.         
The "Properties of the Ideal Trend" dialog box opens.

6. In the "User Archive" area, use the button marked "..." and select user archive UA1.

7. In the "Column for X Values" area, select the "Setpoint X" column.

8. In the "Column for Y Values" area, select the "Setpoint Y" column.
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9. To define the time range you wish to display, specify the number of value pairs to be 
represented and the ID of the first value pair.

10.Select the color and representation type for the ideal trend.

11.Click "OK" to close all open dialogs.

12.Save the picture.

13.Enable runtime and start the WinCC Tag Simulator.

See also
How to Use the Simulator (Page 1401)

How to Insert Function Trend Control in a Picture (Page 1392)

How to Create a User Archive (Page 1413)

How to Create a Process Value Archive (Page 1412)
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How to Display a Tag as a Function of Time

Introduction
You can also use Function Trend Control to display tags as a function of time.  However, this 
is only possible if the data source for the trends is connected over the application programming 
interface (API). For this the setting none must be selected (as Provider) in the Data Linking 
tab of the Properties of WinCC Function Trend Control dialog box.

Note

In order to display tags as a function of time, you should use the WinCC Online Trend Control.

Example
The example shows the supply of values for a trend using the API interface. The third trend 
(index = 2) of Control1 in a picture is supplied with data. This results in a sine curve, consisting 
of 1440 value pairs:
// Definitions for the calculation of sine
#define NUMVALUES 1440 // Number of value pairs
#define PI  3.14159265359 // PI
  // Variant for supply of DataXY property
  VARIANT vtDataXY;
  // Variant that contains a single data pair
  VARIANT vtPair;
  // Represents the X value of a data pair
  VARIANT vtDataX;
  // Represents the Y value of a data pair
  VARIANT vtDataY;
  // For faster access to the SAFEARRAY data that is contained in the 
Variants.
  VARIANT* pvtDataXY = NULL;
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  VARIANT* pvtPair = NULL;
  int i = 0;
  long lIndex = 0;
  double dAngle = 0;
  HRESULT hr = 0;
  SAFEARRAYBOUND rgsabound[1];
  // Initializing of the DataXY Variant
  VariantInit( &vtDataXY );
  // Creation of the SAFEARRAY for the DataXY property
 rgsabound[0].cElements = NUMVALUES; // NUMVALUES - value pairs
  rgsabound[0].lLbound = 0;
  vtDataXY.u.parray = SafeArrayCreate( VT_VARIANT, 1, rgsabound );
  if( vtDataXY.u.parray )
  {
    vtDataXY.vt = (VARTYPE)( VT_ARRAY | VT_VARIANT );
  }
  else
  {
    // No memory left
    return;
  }
   // Set the trend index
  SetPropBOOL( lpszPictureName, Control1, Index, 2 );
   // Delete all trend data
  SetPropBOOL( lpszPictureName, Control1, DeleteData, TRUE );
  // Obtain direct access to values of the DataXY-SAFEARRAYS
  hr = SafeArrayAccessData( vtDataXY.u.parray, &pvtDataXY );
  if( hr == 0 && pvtDataXY )
  {
    for( i = 0; i < NUMVALUES; ++i )
    {
      // Initializing of the Variants in order to fill the DataXY-
SAFEARRAY
       VariantInit( &vtPair );
       VariantInit( &vtDataX );
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       VariantInit( &vtDataY );
       // Generation of a single value pair SAFEARRAY
       // Always two values, respectively for the X and Y value.
       rgsabound[0].cElements = 2;
       vtPair.u.parray = SafeArrayCreate( VT_VARIANT, 1, rgsabound );
       if( vtPair.u.parray )
       {
          vtPair.vt = (VARTYPE)(VT_ARRAY | VT_VARIANT );
          // Obtain direct access to the data of the DataXY-SAFEARRAY
          SafeArrayAccessData( vtPair.u.parray, &pvtPair );
          if( pvtPair )
          { 
            // Set the X value
            vtDataX.vt = VT_R8;
            vtDataX.u.dblVal = (double)( i - NUMVALUES/2 );
            dAngle = ( i - NUMVALUES/2 ) * 2 * PI / 360;
            // Set the Y value
            vtDataY.vt = VT_R8;
            vtDataY.u.dblVal = sin( dAngle );
            // Write values into the value pair SAFEARRAY
            VariantCopy( &pvtPair[0], &vtDataX  );
            VariantCopy( &pvtPair[1], &vtDataY  );
           
            // Re-enable the value pair SAFEARRAY data
            SafeArrayUnaccessData( vtPair.u.parray );
            pvtPair = NULL;
            // Copy the value pair into DataXY-SAFEARRAY
            VariantCopy( &pvtDataXY[i], &vtPair );
         }
      }
      // Enable the used SAFEARRAYs
      VariantClear( &vtDataX );
      VariantClear( &vtDataY );
      VariantClear( &vtPair );
    }
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    // Enable access to the DataXY-SAFEARRAY data.
    SafeArrayUnaccessData( vtDataXY.u.parray );
     // Set the DataXY property
    PDLRTSetPropEx( PDLRT_AM_DEFAULT, lpszPictureName, Control1, 
DataXY,
VT_VARIANT, (void*)&vtDataXY, NULL, NULL, 0, NULL, NULL );
     // Add value pairs at the end
    SetPropBOOL( lpszPictureName, Control1, InsertData, TRUE );
   }
   VariantClear( &vtDataXY );

How to Use the Simulator

Introduction
To familiarize yourself with the functionality of the WinCC Function Trend Control in runtime, 
you can use the Tag Simulator to simulate the tags configured in the examples. 

Requirement
● Configure a WinCC Function Trend Control in the Graphics Designer.

● Enable runtime.

● Start the Tag Simulator.

Procedure
1. In the Edit menu, click the New Tag command.

2. Select Tag 1 and confirm your selection by clicking OK.

3. Click the Properties tab and input the following values for Tag 1.         
Amplitude: 50         
Offset: 50         
Vibration period: 25

4. Click the Tags tab.

5. In the Edit menu, click the New Tag command.

6. Select Tag 1 and confirm your selection by clicking OK.

7. Click the Properties tab and input the following values for Tag 1.         
Amplitude: 50         
Offset: 50         
Vibration period: 50

8. Click the Tags tab.
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9. Click the Start Simulation button.

10.In WinCC runtime, track the display of the tags in the WinCC Function Trend Control. 

 

Operation in Runtime

How to Operate Function Trend Control in Runtime

Introduction
The trend window is operated in runtime via the buttons in the toolbar.

"Online-Help-System"         
Calling up the Online help

"Open the Configuration Dialog"         
Selecting the dialog to assign display parameters.

"Display Value at this Position"         
Click this button to query the coordinate points of a trend.

"Zoom Area"         
Click this button to zoom in on any section of the trend window.

"Activate Original View"         
Click this button to return to the configured normal view (after 
zooming).
"Opens the dialog for selecting a trend"         
Opens a dialog to configure the settings for the selected trends

"Previous trend in foreground"         
Click this button to display the previous trend in the foreground of the 
trend window
"Next trend in the front"         
Click this button to display the next trend in the foreground of the trend 
window
"Start/Stop update"         
Updates are stopped/started and can be continued/stopped by 
clicking the button.
"Print Log"         
Click this button to print the trend shown in the trend window. Print job 
used during printing can be specified in the control properties on the 
"General" tab.
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See also
Properties of Function Trend Control - Toolbar Tab (Page 1414)

Starting and Stopping Update (Page 1405)

Displaying a Trend on Top (Page 1406)

How To Enlarge a Segment of a Trend (Page 1410)

How to Determine the Coordinates of a Point (Page 1408)

Online Configuration of Function Trend Control (Page 1403)

Online Configuration of Function Trend Control

Introduction
There are two possible methods by which you can modify the configuration of the Function 
Trend Control in runtime.
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Keyboard function Open the Parameter Dialog
Keyboard function Open the Configuration Dialog allows you to access virtually all Function 
Trend Control settings including data linking for the trends that are to be displayed. Only the 
input privileges configured for persistence cannot be amended in runtime.
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Keyboard function Opens the dialog for selecting a trend 
Keyboard function Opens the dialog for selecting a trend allows you to access certain Function 
Trend Control settings.

See also
How to Operate Function Trend Control in Runtime (Page 1402)

Starting and Stopping Update

Introduction
You can use keyboard function Start/Stop the Update to halt or restart the update in the trend 
window. When the update is stopped you can modify the time range being displayed, and 
display value of measurement points from the process value archive in the trend window. 
Certain functions, such as keyboard function Enlarge Area automatically stop the update of 
value of measurement points.

When updates are stopped, you may change the displayed time frame and therefore display 
measurement values from the process value archive in the table window.

: When updates are stopped, you may change the displayed time frame and therefore 
display measurement values from the process value archive in the table window.

: When updates are started, you may change the displayed time frame and therefore 
display measurement values from the process value archive in the table window.
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See also
How to Operate Function Trend Control in Runtime (Page 1402)

Displaying a Trend on Top

Introduction
If a common axis is used, the settings for the trend displayed displaying the axis.

You can modify the trend displayed on top in runtime:

●
with the  button: (keyboard function Opens the dialog for selecting a trend)

● with the  button: (keyboard function Next trend on top)

●
with the  button: (keyboard function Previous trend on top)

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
1406 System Manual, 11/2008,  



Configuration
The sequence to be used for the trends is configured in the Limiting Value tab of the Properties 
of WinCC Function Trend Control dialog box. It can be changed via the Up and Down buttons.

See also
How to Operate Function Trend Control in Runtime (Page 1402)
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How to Determine the Coordinates of a Point

Introduction
You can use the "Display Value at this Position" key function to determine the coordinates of 
a point in the trend. To make it easier to determine the coordinates, you can also enlarge a 
particular segment of the trend lines.

Requirement
● Configure a Function Trend Control.

● Configure the display of a toolbar, using the buttons assigned to key functions "Zoom Area" 
and "Activate Normal View".

● You can specify the font for the tag value table that is displayed with the key function 
"Display value here" in the "Font" tab and via the property "RulerFont". 

● Start Runtime.

Procedure
1. In the toolbar, click the "Display Value at this Position" button.          

A cross-hair appears in the trend window. The coordinates for the center point of the cross-
hair are displayed below the trend window.

2. Move the mouse over one of the axes or the center point of the crosshair.

3. Hold down your left mouse button and drag the center point of the crosshair to the position 
of the value of measurement point whose coordinates you wish to know.
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4. Release the left mouse button.

5. Read off the coordinates for the value of measurement point from the area below the trend 
window.

6. In the toolbar, click the "Display Value at this Position" button.          
The cross-hair disappears.

Note

Points which lie between two measured value pairs and have therefore interpolated are 
identified with an "i".

See also
How to Operate Function Trend Control in Runtime (Page 1402)
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How To Enlarge a Segment of a Trend

Introduction
You can use the "Enlarge Area" key function to zoom in on any segment of the trend window. 
You may then find that the keyboard function "Display Value at this Position" is easier to use 
within the enlarged display to determine the coordinates of a particular measurement point. 
Use the "Activate Original View" key function to switch back from an enlarged display to normal 
display mode.

Requirement
● Configure a Function Trend Control.

● Configure the display of a toolbar, using the buttons assigned to key functions "Zoom Area" 
and "Activate Normal View".

● Start Runtime.

Procedure
1. Click the "Enlarge Area" button in the toolbar.         

The display stops being updated and the mouse pointer changes to a cross-hair.

2. In the trend window, click one corner of the area that you wish to enlarge.
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3. Hold down your left mouse button and drag the area you want to enlarge until it reaches 
the desired size.

4. Release the left mouse button.         
The section you selected is now shown enlarged.

5. Click the "Activate Original View" button in the toolbar.         
The trend window is once more displayed in normal view as originally configured.

6. Click on the "Start/Stop the Update" button in the toolbar to restart updating the display in 
the trend window.

See also
How to Operate Function Trend Control in Runtime (Page 1402)
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Appendix

How to Create a Process Value Archive

Introduction
In order to display archive tags in a WinCC Function Trend Control, you must configure a 
process value archive. A process value archive is created most easily with the help of the 
Archive wizard.

Procedure
1. Start Tag Logging and select the "Archive Wizard ...". command in the archive pop-up menu.

2. In the second step of the Archive Wizard, assign a meaningful name to the process value 
archive.

3. In the third step of the Archive Wizard, include the desired tags in the process value archive.

4. Close the Wizard by clicking "Apply".

Note

For the other examples of Function Trend Control, you require process value archive PW1 
with the three tags Tag 1, Tag 2 and Tag 3, each with data type signed 16-bit value.

See also
How to Display Archive Tags (Page 1394)
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How to Create a User Archive

Introduction
To display ideal trends or values from user archives in a WinCC Function Trend Control, you 
need to configure a user archive. You can create user archives with the aid of WinCC option 
User Archives.

Procedure
1. Start User Archives and from the Archives pop-up menu select the command New Archive.

2. Give the user archive a meaningful name and click the Finish button.

3. Answer the question about creating a field in the archive with Yes.

4. Give the first field a meaningful name and click the Finish button.

5. Answer the question about creating another field in the archive with Yes.

6. Give the second field a meaningful name and click the Finish button.

7. Answer the question about creating another field with No.

8. Answer the question about creating another archive with No.

9. Click the Save button in the toolbar.

Note

For the other examples of Function Trend Control, you require user archive UA1 with columns 
Setpoint X and Setpoint Y.
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See also
How to Insert the User Archive Table Element into a Picture (Page 1419)

How to Compare Tag Values with an Ideal Trend (Page 1396)

How to Display Data from User Archives (Page 1395)

Properties of Function Trend Control - Toolbar Tab

Introduction
On the Toolbar tab, define the toolbar buttons which may be used to operate the trend window 
in runtime.

Display
Defines whether a toolbar can be used to operate the trend window in runtime.

Alignment
Defines at which edge of the trend window the toolbar will be displayed.

Keyboard Functions
This attribute defines which keyboard functions will be displayed as buttons in the toolbar and 
be available for operating the trend window.

Online-Help System

Open the Configuration Dialog

Display Value at this Position 

Enlarge Area 
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Activate Original View

Opens the dialog for selecting a trend 

Next Trend to the Front 

Previous Trend to the Front 

Start/Stop the Update

Key, Hot Key
Specifies the hot key with which a chosen keyboard function can be triggered.

See also
How to Operate Function Trend Control in Runtime (Page 1402)

Properties of the Function Trend Control (Page 1421)

Properties of Function Trend Control - Font Tab

Introduction
On the Font tab, you can set the font to be used in the trend window. If you select either from 
the top or from the bottom as the direction to be written, you should use True-Type fonts within 
the trend window to ensure a clean display of the X axis labeling.

Note

The appearance of this tab and the names of the different fields depend on other installed 
programs.

Font
Specifies the name of the character set which is to be used.

Font Size
Sets the size of the selected character set.
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Display
Sets the font style for the selected character set (e.g. bold, italic, underline).

Sample Text
Shows a preview using the chosen settings.

See also
Properties of the Function Trend Control (Page 1421)

Properties of Function Trend Control - General Tab

Introduction
On the General tab, you can define the general appearance and behavior of the trend window.

Window Title - Display
Defines whether the title bar of the trend window will be displayed in Runtime.

Window Title - Input Field
Defines the text that will be displayed in the title bar of the trend window in Runtime.

Background Color
Defines the background color that will be used in the trend window in Runtime.

Open Picture - Display Ruler
Defines whether the ruler for querying the coordinate points will automatically be displayed in 
the trend window every time there is a picture exchange in Runtime.
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Open Picture - Load archive data
Defines whether archived values should be loaded or currently occurring values should be 
displayed when the picture is opened.

Display - Status Bar
Defines whether the status bar of the trend window will be displayed in Runtime.

Display - Toolbar
Defines whether the toolbar of the trend window will be displayed in Runtime.

Display - Write Direction
Defines the direction in which the positive values on the axes are dipicated.

From the Right Positive values run to the right and upwards.
From the Left Positive values run to the left and upwards.
From the Top Positive values run to the right and upwards.
From the 
Bottom

Positive values run to the right and downwards.

Display - Common X Axis
Defines whether the common X axis will be used for all the trends in the trend window. The 
first trend in the list of trend window elements (Trends tab) determines the color and the range 
of the axis.

Display - Common Y Axis
Defines whether the common Y axis will be used for all the trends in the trend window. The 
first trend in the list of trend window elements (Trends tab) determines the color and the range 
of the axis.

Display - Sizable
Defines whether the size of the trend window can be changed in Runtime.

Display - Can Be Closed
Defines whether the trend window can be closed in Runtime.

Persistence in RT
Specifies in Runtime whether changes made to the Function Trend Control settings should 
also be effective after a picture exchange.
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In the Configuration System you can use the "Selection..." button to select one of the 
authorizations configured in the User Administrator. Should you assign an operator 
authorization, the persistence setting can only be changed in runtime if the logged in user has 
the authorization to do so.

Persistence in RT and CS
Specifies in runtime whether changes made to the Function Trend Control settings will also 
be applied to the Configuration System and be used when the project is reactivated.

In the Configuration System you can use the "Selection..." button to select one of the 
authorizations configured in the User Administrator. Should you assign an operator 
authorization, the persistence setting can only be changed in runtime if the logged in user has 
the authorization to do so.

Changes to the control properties in Runtime are not persistently accepted in CS with PCS 7 
projects or TIA projects. When you completely load the ES to the OS, the changed settings 
on the OS will be overwritten.         
Configure the properties of the controls on the ES.

Time Base
Defines the base for the time setting in WinCC.

See also
Properties of the Function Trend Control (Page 1421)

Setting Time in WinCC (Page 64)

Quick Configuration of Function Trend Control

Introduction (*** OUTDATED TRANSLATION! ***)
After inserting a Function Trend Control into a picture in the Graphics Designer, the Quick 
Configuration dialog box opens. This simplifies the configuration task by bringing together the 
main features of Function Trend Control in a single dialog box.
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See also
Properties of the Function Trend Control (Page 1421)

How to Insert the User Archive Table Element into a Picture

Introduction
To display ideal trends or values from user archives in a WinCC Function Trend Control, you 
need to configure a user archive. You can create user archives with the aid of WinCC option 
User Archives. Values are entered in the user archive in runtime in the WinCC User Archive - 
Table Element, which is inserted in a picture and configured with the aid of the Graphics 
Designer.

Requirement
● Configure a user archive UA1 with the columns Setpoint X and Setpoint Y.

Procedure
1. Start Graphics Designer and open a new picture.

2. In the Object Palette, Controls tab, click the object WinCC User Archive - Table Element.

3. Place the mouse pointer at the position in the picture where you want to insert the 
control.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the control to the desired size.

5. Double-click the User Archive - Table Element.

6. In the Source area, click the Select button.

7. Select the user archive.

8. Click OK to close the dialog.

9. Save the picture.

10.Enable runtime and enter values in the Setpoint X and Setpoint Y columns.

See also
How to Compare Tag Values with an Ideal Trend (Page 1396)

How to Display Data from User Archives (Page 1395)

How to Create a User Archive (Page 1413)
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Properties of Function Trend Control - Trends Tab

Introduction
On the Trends tab, you can define the tags you wish to display and the appearance of the 
trends.

Trends
Defines the trends to be displayed. Use the + and - buttons to add new or delete existing trends. 
Use the Up and Down buttons to change the order of the trends. The order of the trends is 
analyzed in runtime by the keyboard functions Previous trend on top and Next trend on top. 
When using shared axes, the first trend in the list determines the color and value range of the 
axes.
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Name
Defines the name of the trend. This name is used in the list of elements.

Display - Visible
Defines whether the trend selected in the list of elements is to be displayed in runtime. With 
this setting, you can suppress the display of configured trends without actually having to delete 
them.

Display - Color
Defines the color with which the trend selected in the list of elements and its associated axes 
will be displayed in runtime.

Ideal Trend
Defines whether an ideal trend is to be displayed with the trend selected in the list of elements. 
Use the Properties button to set the properties of the ideal trend.

See also
Displaying a Trend on Top (Page 1406)

Properties of the Function Trend Control - Setpoint Trend Properties (Page 1422)

Properties of the Function Trend Control (Page 1421)

Properties of the Function Trend Control

Introduction
The properties of WinCC Function Trend Control can be modified by using either the Quick 
Configuration dialog, the Configuration dialog or the Properties.

Quick Configuration
The Quick Configuration dialog box opens automatically when you insert a Function Trend 
Control into a picture in the Graphics Designer.

Configuration Dialog
The Configuration dialog box opens when you double-click or use the Configuration dialog... 
command in the Function Trend Control pop-up menu.

Properties
The Properties dialog box opens when you use the Properties command in the Function Trend 
Control pop-up menu.

Archiving Process Values
6.5 Output of Process Values

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1421



See also
Properties of Function Trend Control - Font Tab (Page 1415)

Properties of Function Trend Control - Toolbar Tab (Page 1414)

Properties of Function Trend Control - Trends Tab (Page 1420)

Properties of Function Trend Control - General Tab (Page 1416)

Quick Configuration of Function Trend Control (Page 1418)

Properties of the Function Trend Control - Setpoint Trend Properties

Introduction
In the Setpoint Trend Properties dialog, select the color, layout and data basis of the setpoint 
trend.

Archive Linking - Source
Defines the name of the user archive in which the value pairs of the setpoint trend are stored. 
Click ... to select a configured user archive.
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Archive Linking - Column for X-Values
Defines the column in the user archive that contains the X coordinates of the value pairs for 
the setpoint trend.

Archive Linking - Column for Y-Values
Defines the column in the user archive that contains the Y coordinates of the value pairs for 
the setpoint trend.

Archive Linking - Number of Values
Defines the number of values on which the setpoint trend is based.

Archive Linking - from ID
Defines the record in the user archive in which the value pairs of the setpoint trend are stored.

Display - Color
Defines the color in which the trend is displayed in runtime.

Display of Format
Defines the format in which the trend is displayed in runtime.

See also
Properties of the Function Trend Control (Page 1421)

6.6 Direct Access to the Archive Database

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also 
enable you to directly access the WinCC archive databases. Direct access lets you, for 
example, read process values for editing in spreadsheet programs. 

Prerequisite
The project is loaded on the configuration computer and is located in Runtime. 
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Access to archive databases with ADO/OLE DB
The process values are partially saved in compressed format to the archive databases. Use 
the WinCC OLE DB Provider to access such compressed process values. You can use the 
Visual Basic or Visual C++ programming languages, for example. 

Note

Note that the table structure may vary in a new WinCC version when directly accessing the 
archive database using ADO/OLE DB.

For further information, refer to the Microsoft MSDN Library at "Win32 and COM Development 
> Data Access and Storage > Windows Data Access Components SDK" on the Internet:

● http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/
library/default.aspx) 

Access to the archive database using OPC
OPC (OLE for Process Control) provides interfaces for communication with process 
automation systems. The OPC interface enables harmonized interconnection of devices and 
applications from different manufacturers. You can use WinCC as an OPC client to access 
process data or messages of an OPC server. WinCC can by used as OPC server to manage 
archive data.

For further information, refer to:

● "WinCC Information System", "Communication" > "OPC",

● "WinCC Information System", "System Overview" > "Open Source"

● On the Internet at "http://www.opcfoundation.org"

Access to the archive database using C-API/ODK
You can use the "WinCC Open Development Kit" option to access WinCC data and functions 
by means of open source programming interfaces. 

For further information, refer to: 

● Documentation of the WinCC Open Development Kit

See also
http://msdn.microsoft.com/en-us/library/default.aspx (http://msdn.microsoft.com/en-us/library/
default.aspx)
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6.7 Function Call Templates

6.7.1 Function Call Templates
In different dialogs of the Tag Logging" configuration system, you can specify functions to be 
executed when certain events occur. These functions must be  developed by you in the Global 
Script editor and must comply with the nomenclature of the respective template.

The following templates for function calls are available in WinCC:

● Function During Start of Archiving

● Function for Conversion of Tag Values

● Function to Start Archiving

● Function to Stop Archiving

See also
Function to Stop Archiving (Page 1427)

Function to Start Archiving (Page 1427)

Function for Conversion of Tag Values (Page 1426)

Function During Start of Archiving (Page 1425)

6.7.2 Function During Start of Archiving

void function name (Boolean fFlag);

Description
This function is triggered during the start of an archiving process. It can be assigned on the 
"General" tab in the "Properties" dialog in the Archiving group.

Parameters

fFlag
TRUE Lock Archive

FALSE Unlock Archive

Application Example
You can for example use this function to obtain information on the status of an archive.
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6.7.3 Function for Conversion of Tag Values

double function name (double doLmtValue,

                                      double doValue,

                                      int dwCount,

                                      int archiving);

Description
This function can be used to convert a tag value prior to archiving. The value of the process 
tag (here: doValue) can be recalculated according to the requirements. The result is returned 
as a return value of the function to Tag Logging for archiving. The function is assigned under 
Edit/Action in the Properties Process Tag dialog in the Parameter tab .

Parameters
dLmtValue:last acquired value (from last acquisition cycle)

doValue :currently acquired value

dwCount: number of acquisition cycles since the last archiving

Logging: TRUE when archiving is performed

Application Example
The current process value should be divided by 10 and archived.

 
double Norm_PDE(double doLmtValue, double doValue, int dwCount, int 
Archiving)
{
return (doValue/10);
} 

Note

Note that the transfer parameter is declared in exactly the same way as in this example. The 
parameters are transferred from Tag Logging to the function. 

What happens within an action is the responsibility of the user.
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6.7.4 Function to Start Archiving

int function name ( );

Description
The function must return value "0" (corresponds to FALSE) or "1" (corresponds to TRUE). 
Other values are not permissible. An archiving process is triggered, depending on the archiving 
method and the value returned by the function.

For cyclic archiving, the archiving is always triggered, if the return value of the function is "1".

For acyclic archiving, the archiving is always triggered, if the returned value has changed since 
the last function call. The first function call must return value "1".

The function is assigned in the Properties Process Tag dialog in the Archiving tab in the Actions 
group.

6.7.5 Function to Stop Archiving

int function name ( );

Description
The function must return value "0" (FALSE) or "1" (TRUE). Upon a return value of "1" a running 
archiving process can be stopped.

The function is assigned in the Properties Process Tag dialog in the Archiving tab in the Actions 
group.
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6.7.6 Appendix

6.7.6.1 Action for Swap-Out

void function name (

LPTSTR lpszArchivName

LPTSTR lpszVariablenName,

DWORD dwNumberOfRecords);

Description
With this function you can specify how to swap out your short-term archive.

Upon reaching the upper limit of your short-term archive, this function is called for each tag of 
the archive.

Once the function is triggered, the call to this function is cyclic whenever the respective tag 
writes new values to the short-term archive.

This function can be assigned on the "Archive Parameters" tab in the "Process Value Archive 
Properties" dialog.

Parameters

lpszArchivName
Pointer on Name of Archive.

lpszVariablenName
Pointer on Name of Tag.

dwNumberOfRecords
Number of measured values saved in short-term archive.

Note

The function is also executed if the archive is locked.
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6.7.6.2 Action upon Sending

void function name (

bool fFlag);

Description
This function is triggered after a tag is sent. It can be assigned on the "Raw Data Tag" tab of 
the "User Archive Properties" dialog.

Parameters

fFlag
The parameter is assigned value "FALSE" and is reserved for future upgrades.

 

Application Example
This function can be used to ensure that a message is displayed when a raw data tag is sent.

6.7.6.3 Action upon Reception

void function name (

bool fFlag);

Description
This function is triggered after a tag is received. It can be assigned on the "Raw Data Tag" tab 
of the "User Archive Properties" dialog.

Parameters

fFlag
The parameter is assigned value "FALSE" and is reserved for future upgrades.

Archiving Process Values
6.7 Function Call Templates

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1429



Application Example
This function can be used, for example, to evaluate a raw data tag immediately after it is 
received.
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Documentation of Configuration and Runtime Data 7
7 Resources

7.1 The WinCC Reporting System

Content
WinCC offers you extensive scope for documenting a project. There are two categories of log 
available to you for outputting data:

● Reports for project documentation

● Logs for Runtime documentation

The reports for project documentation output the configuration data of a WinCC project (e.g. 
a table with the tags used and their parameters, plant mimic diagrams with their objects, or 
the user groups created).

The logs for Runtime documentation output process data during Runtime (e.g. for printing 
messages chronologically or for logging message archives or user archives during Runtime).

This help system shows you how to document your configuration and Runtime data using the 
layouts contained in the system.

7.2 Documentation of Configuration and Runtime Data

Introduction
To document configuration and Runtime data, reports and logs are created in WinCC, for which 
predefined layouts are supplied. These predefined layouts will cover most of the cases in which 
you need to document data. You can use Report Designer to edit predefined layouts or create 
new layouts to suit your requirements and wishes.

Applications
The reporting system allows you to output:

● Configuration data in a report

● Runtime data in a log

MDM - WinCC: Working with WinCC
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Usage
The documentation of configuration data is referred to below as project documentation. It 
allows the configuration data of a WinCC project to be output in a report.

The documentation of Runtime data is referred to below as Runtime documentation. It allows 
the process data to be output in a log during Runtime. In order to output the Runtime data, the 
corresponding application must be in Runtime.

Report Designer makes print jobs available for outputting the reports and logs. The scheduling, 
output medium and extent of the output is defined in the print jobs.

The dynamic objects of Report Designer are used for data output. These dynamic objects are 
associated with the corresponding applications.

Selection of data for output is application-dependent and is carried out when the layout is 
created, when the print job is created, or when printing is initiated. The current view or the table 
content is output in the WinCC V7 controls and the corresponding layouts and print jobs.

The dynamic objects are supplied with the current values during output of the reports and logs.

The structure and configuration of the reports for project documentation and logs for Runtime 
documentation is largely identical. The essential differences lie in the connection of the data 
source with the dynamic objects and in the initiation of printing.

Output Media
The reports and logs can be output with the following layouts: 

● To a printer

● To a file

● To the screen

Output Formats
The reports and logs can be output with the following layouts:

● A page layout

● A line layout (message sequence report only)

Editors for the Layouts
Report Designer provides the page layout editor for editing page layouts. Both the page layouts 
for the project documentation reports and the logs for Runtime documentation are configured 
in the page layout editor.

Report Designer provides the line layout editor for editing line layouts. Only line layouts for the 
output of the message sequence report are configured in the line layout editor.
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See also
Introduction to Runtime Documentation (Page 1469)

Introduction to Project Documentation (Page 1445)

How to Create Reports in Line Layout (Page 1435)

How to Set Up Reports in the Page Layout (Page 1433)

7.3 How to Set Up Reports in the Page Layout

How the Areas of a Page Layout Are Divided Up
Page layouts are divided up geometrically into a number of different areas. The page range 
corresponds to the total area of the layout. The print margins can be specified for this area. It 
makes sense to begin by configuring the margins of the printable area for the header, footer 
or a company logo and only then to configure the rest of the printable area for the output of 
report data. The printable area inside the margins is referred to as the "body of the page".

The report and log layout contain a static layer and a dynamic layer. The static layer contains 
the header and footer of a layout for outputting the company name, company logo, project 
name, layout name, page number, time, etc. The dynamic layer contains the dynamic objects 
for outputting the configuration and Runtime data.

In the static layer, only static and system objects can be inserted. In the dynamic layer, static 
and dynamic objects can be inserted.

Objects that are inserted in the dynamic part of a page layout are extended dynamically, if 
required. If an object of the type dynamic table is supplied with data, for example, this table is 
extended to allow all data in the table to be output. If there are other objects in the dynamic 
part of the layout, these are moved accordingly. Objects that are to have a fixed position must 
therefore be inserted in the static part of the layout.
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Pages in the Page Layout
Each page layout consists of three pages:

● Cover sheet

● Report contents

● Final page

Cover sheet The cover sheet is a fixed component of a page layout. It is therefore possible to design 
a separate cover sheet for each report.

Report 
contents

The structure and contents of the report for output are defined in this part of the page 
layout. system objects available for defining the report contents.          
The report contents have a static and a dynamic component (configuration 
layer).          
If necessary, the dynamic part of the contents of the report is spread across the various 
subsequent pages at output, since it is not known until the time of output how much 
data there is.

Final page The final page is a fixed part of a page layout. It is therefore possible to design a 
separate final page for each report.

 

The creation and output of the cover sheet and final page are optional. By default, a cover 
sheet is output, but a final page is not output. You edit a page layout in the page layout editor.

The cover sheet and final page also have a static and a dynamic component (configuration 
layer).

Important:
If you use dynamic objects on the cover sheet or final page, only some of this data may be 
included at output. This happens when the data of dynamic objects do not fit on a single page. 
The cover sheet and final page only ever consist of a single page and never contain a page 
break. 

Displaying Layout Properties
You can display the properties of a page layout in WinCC Explorer.

1. If you select the Report Designer entry in the navigation window of WinCC Explorer, the 
Layouts and Print Job subentries are displayed.

2. If you select the Layouts entry, all available layouts are displayed in the data window.

3. Select the Properties command from the pop-up menu of the relevant page layout. The 
creation date and the data of the last change are displayed. If the layout is opened in the 
page layout editor, the message "Currently being edited" is displayed.
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See also
How to Create Reports in Line Layout (Page 1435)

Print Jobs in WinCC (Page 1436)

Introduction to Runtime Documentation (Page 1469)

Introduction to Project Documentation (Page 1445)

7.4 How to Create Reports in Line Layout

How the Areas of a Line Layout Are Divided Up
Line layouts are divided up geometrically into a number of different areas. The page range 
corresponds to the total layout area. The print margins can be defined for this area. It makes 
sense to begin by configuring the margins of the printable area for the header and footer or 
for a company logo and only then to configure the rest of the printable area for the output of 
the log data. The printable area inside the margins is referred to as the "body of the page".

The line layouts contain a static layer and a dynamic layer. The static layer contains the header 
and footer for outputting the company name, project name, layout name, etc. as pure text. The 
dynamic layer contains a dynamic table for outputting Alarm Logging messages.

How a Page Is Divided Up
Each line layout consists of three areas:

● Header

● Log contents (table)

● Page footer
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Header The header is a fixed component of a line layout that is output together with every 
page. A header in the line layout can consist of up to 10 lines. Graphics cannot be 
inserted.

Log 
content         
(table)

The structure and contents of the log for output are defined in this part of the line layout. 
The Alarm Logging selection options and filter criteria for defining the contents of the 
log are available to you for alarm output.          
The design depends on the width of the individual columns and of the font size set.

Page footer The footer is a fixed component of a line layout that is output together with every page. 
A footer in the line layout can consist of up to 10 lines. Graphics cannot be inserted.

The creation and output of a header and footer are optional. By default, 3 lines each are output 
for the header and footer.

Use of the Line Layout
The layout in line format is used exclusively for the message sequence report. You edit it in 
the line layout editor. For a line layout there is only one valid print job, which is integrated in 
the WinCC on a fixed basis. In order to be output, the message sequence report must be 
activated in the startup list of the computer carrying out the logging.

Displaying Layout Properties
You can display the properties of a line layout in WinCC Explorer.

1. If you select the Report Designer entry in the navigation window of WinCC Explorer, the 
Layouts and Print Job subentries are displayed.

2. If you select the Layouts entry, all available layouts are displayed in the data window.

3. Choose the Properties command from the pop-up menu of the relevant line layout. The 
creation date and the data of the last change are displayed. If the layout is opened in the 
line layout editor, the message "Currently being edited" is displayed.

See also
How to Output Online Data with Message Sequence Report (Page 1486)

Print Jobs in WinCC (Page 1436)

How to Create a User-Defined Message Sequence Report (Page 1489)

7.5 Print Jobs in WinCC

7.5.1 Print Jobs in WinCC

Introduction
Print jobs in WinCC are of central importance to the output of project and Runtime 
documentation. In the layouts you configure the external appearance and data supply for 
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output. In the print jobs you configure the output medium, how much is to be printed, the time 
at which printing is to start, and other output parameters. 

For the output, each layout has to be linked to a print job. Various print jobs are provided in 
WinCC for the purpose of project documentation. These system print jobs are already 
associated with the corresponding WinCC applications. They can be neither deleted nor 
renamed.

You can create new print jobs in WinCC Explorer in order to output new page layouts. A special 
print job is provided in WinCC for outputting line layouts. Line layouts can only be output using 
this print job. It is not possible to create a new print job for a line layout.

See also
Introduction to Runtime Documentation (Page 1469)

Introduction to Project Documentation (Page 1445)

How to Change Output Options in Runtime (Page 1476)

How to Change an Existing Print Job (Page 1452)

How to Create a New Print Job (Page 1450)

Print Job Properties (Page 1438)

Defining a Printer (Page 1442)

Selecting the Print Range (Page 1440)
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7.5.2 Print Job Properties

Introduction
You enter the name, the layout used, and the start parameters on the "General" tab. You also 
set additional options that determine what happens when the print job is called on the "General" 
tab.

Name of the Print Job
The name of the print job is displayed in the "Name:" field. You can rename a print job you 
have just created in the "Name:" field . You cannot rename the system print jobs provided with 
the product because they are associated directly with the different applications of WinCC.

Layout 
There are line layouts and page layouts. In the "Layout:" selection field you can select the 
desired layout for the output. 
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Page layout
There are language-neutral and language-dependent line layouts. Further information can be 
found in the "Creating Page Layouts" and "Setting Up Multilingual Projects" documents.

Line layout
You can only select a line layout in the "@Report Alarm Logging RT Message sequence" print 
job. Line layouts do not contain language-dependent text; thus, no language-dependent layout 
files are needed.

Only in this job can the Line Layout for Line Printer option be selected. If the check box is 
checked, then the message sequence report is output to the locally installed line printer. If the 
check box is not checked, the message sequence report is output to a selectable printer in 
page format.

The system print jobs provided and the layouts set in them are for outputting the project 
documentation. Do not connect the system print jobs with other layouts, since otherwise the 
project documentation will no longer function correctly.

Selection for print job list
The "Graphics Designer" editor contains an application window belonging to the reporting 
system, the print job list. If this print job list is integrated into a WinCC picture, then the print 
jobs for the configurations are displayed in Runtime and you can start the output. In the print 
job list you can set the display of print jobs. The following views are available for selection:

● All print jobs

● System print jobs only

● User-defined jobs only

● Print jobs for which Selection for print job list option is selected

The "Selection for print job list" option allows you to compile a list of print jobs that you require 
in Runtime. 

Displaying the Parameter Dialog
To make Runtime documentation more flexible, a number of log parameters have been 
dynamized. This allows you to change log output in Runtime. To do this, select the "Display 
Parameter Dialog" option in the "Dialog" field. When the print job is called in Runtime, a 
parameter dialog is called, in which you can change the parameters for output in Runtime. 
This dialog also allows you to select or change the printer for output. You find more information 
and a list of the relevant log objects in chapter Changing Output Options in Runtime.

Note

The system layouts and the self-configured layouts based on the "WinCC Control Runtime 
Printprovider" layout have no protocol parameters that can be made dynamic. Thus, you 
cannot edit the parameters of these layouts with the parameter dialog.
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Calling the Printer Setup Options
To output logs in a page layout, you can change the printer for output in Runtime. To do this, 
select the Printer Setup option in the Dialog field. When the print job is called in Runtime, a 
dialog is called for selecting the printer.

Setting Start Parameter
In the Start Parameter area, you can set the start time and an output cycle. This setting is used 
primarily to output logs regularly in Runtime documentation (e.g. for shift reports). The start 
parameters are not required for project documentation, since project documentation is not 
executed cyclically. The following print jobs are indicated by a different symbol in the list of 
print jobs in WinCC Explorer:

● Print jobs for which start parameters are configured.

● Print orders for which a cyclical call is configured.

See also
How to Change Output Options in Runtime (Page 1476)

How to Change an Existing Print Job (Page 1452)

How to Create a New Print Job (Page 1450)

Defining a Printer (Page 1442)

Selecting the Print Range (Page 1440)

Print Jobs in WinCC (Page 1436)

7.5.3 Selecting the Print Range

Introduction
On the Selection tab you can specify how much is to be printed. You can specify a selection 
of the page range or a time range for the data to be output.
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Note

If you print out online data using a message sequence log, all settings on the Selection tab 
are deactivated.

Selecting a Page Range
In the Page Range area you can specify how much is to be printed at output. You can output 
individual pages, a page range, or all pages.

Selecting a Time Range for the Data
You can use the Relative option to specify a relative time range for output (going back from 
the print start time). For the relative time range, you have the following time intervals available: 
All, Years, Months, Weeks, Days and Hours.

The Absolute option allows you to specify an absolute time range for the data to be output.

Note

If the time range is configured in the layout of a print job, this setting has priority over the 
settings in the print job. The selection of a time range is only relevant to Runtime 
documentation in Alarm Logging and Tag Logging.

If filter criteria can be set for the selection of the output data, these filter criteria are taken into 
account in addition to the settings in the Print Job Properties dialog. Exception: If filter criterion 
DATETIME is used, the time range settings in the print job are ignored.

If the @ReportAlarmLoggingRT... print jobs are started via the button in the Alarm Control, 
the settings from the layout and the print job are ignored, since the selection of the output 
data is transferred from the Alarm Control.

See also
How to Change Output Options in Runtime (Page 1476)

How to Change an Existing Print Job (Page 1452)

How to Create a New Print Job (Page 1450)

Defining a Printer (Page 1442)

Print Job Properties (Page 1438)

Print Jobs in WinCC (Page 1436)
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7.5.4 Defining a Printer

Introduction
On the Printer Setup tab you can specify the printer or printers for output. You can use the lists 
in the Printer Priorities area to specify the order in which they are to be used. You also specify 
the settings for the print buffer and for output to a file here.

Output to a Printer
On the Printer Setup tab you can specify the printer or printers for output. The printers are 
arranged in order of priority. Reports and logs are output to the printer set under 1.). If this 
printer fails, they are automatically output to the printer set under 2.). The same procedure 
applies to a third printer. If no printer is found that is ready for operation, the print data is saved 
to a file on the hard disk. The files are stored in the project directory in the PRT_OUT folder. 
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In the event of a printer failure, the operating system outputs an error message. In this case, 
you have the following options:

1. Ignoring error message (Recommended)          
Once printer is operational again, the pending messages (print jobs still in the spooler) will 
be printed automatically.

2. Repeat          
If the Repeat button is clicked, the operating system tries to output the print jobs in the 
spooler. This is only useful if the printer is ready for operation.

3. Cancel         
If the Cancel button is clicked, the print job causing the error will be deleted. The print data 
is thus lost. The operating system then tries to print the next print job in the spooler. The 
print data is thus lost. The operating system then tries to print the next print job in the spooler.

Note

It is strongly recommended that you acknowledge the message from the operating system 
by clicking the Ignore button. If you click the Cancel button, all pending print jobs of the 
printer that has failed are lost. 

In the event of a fault affecting the line printer for the message sequence report, you can 
disable the printer by clicking Cancel. You may have to restart the WinCC project to enable 
the printer again.

The time taken to detect a printer failure depends on the configured timeout setting for 
the printer connection. The timeout can be set by means of the properties for the printer 
connection in the operating system.

 

Two substitute printers can also be configured for the line-based message sequence report. 
The line printers must be connected to and installed on the computer carrying out the logging. 
The switchover is takes place as described above. If no printer is found that is ready for 
operation, a WinCC dialog is displayed in addition to the operating system message. The dialog 
provides information on the status of the print job and outputs the printer's fault. The message 
sequence report can be switched off in this dialog. If the message sequence report is switched 
off in this dialog, it is switched on again automatically as soon as one of the configured printers 
is ready for operation again.

Output to a File
If you like, you can output the reports and logs to a file. You find more information in the chapter 
Creating a New Print Job.

Note

If you print a message sequence log in line layout, the output as a file is deactivated.
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Setting a Minimum Value for Disk Space
For log output there is a buffer area for output to a printer and a buffer area for output to a file. 
On the Printer Setup tab you can configure two limit values for the free space on a disk for 
each buffer area. If the limit values are violated, the following actions are triggered:

Limit value Triggered Action

Generate 
warnings

If the free disk space on the hard disk being used is below the value set here, an 
entry is created in the WinCC_SStart_01.log file. If Runtime is activated, a system 
message is generated. The message informs you about the imminent resource 
bottleneck.

Discard trigger for 
logging

If the free disk space on the hard disk being used falls under the value set here, 
log triggering is rejected. In addition, an entry is created in the 
WinCC_SStart_01.log file. If Runtime is activated, a system message is generated 
that brings your attention to the lost log.

 

Recommendations and Limiting Conditions
● The timeouts for the printers should be kept low (approx. 10 seconds).

● Only one printer can be installed on each LPT port.

● When a computer is used for the line-based message sequence report, the substitute printer 
must be configured in the print job of the message sequence report.

● Mixed use of line- and page-based message sequence reports is not supported. The 
substitute printers must also be line printers.

Effect of the Printer Driver
When a report or a log is printed, the printout can be affected by the properties of the printer 
driver used. If you have just installed a printer, it is advisable to check the first few printouts in 
the preview.

Behavior and Time Requirements for Print Jobs
If there is a problem communicating with a WinCC component, a print job may hang at the 
stage of reading data from the application, and it may not be possible for the user to cancel it. 
A hung print job that is to print Runtime data is canceled after a waiting time of 30 minutes. 
Data preparation for project documentation can take considerably longer. Project 
documentation is therefore not canceled automatically.

If a print job stays in the printer spooler for longer than the specified time when there is an 
error (no paper, for example), the output is automatically redirected to the next printer in 
accordance with the specified printer priorities. The basic setting for the waiting time is 5 
minutes. If there is no substitute printer configured or ready, the output is redirected to a file. 
The file is stored in the project directory under Prt_Out$_<Jobname><DateTime>.

If a print job remains in the print spooler for longer than 13 minutes without its status changing, 
it is assigned an error status. Automatic print redirection is then initiated after a further 5 
minutes.
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See also
How to Change an Existing Print Job (Page 1452)

How to Change Output Options in Runtime (Page 1476)

How to Create a New Print Job (Page 1450)

Selecting the Print Range (Page 1440)

Print Job Properties (Page 1438)

Print Jobs in WinCC (Page 1436)

7.6 Project Documentation

7.6.1 Introduction to Project Documentation

Introduction
In order to create project documentation in WinCC, you can start the output of the reports from 
within the various WinCC editors. For this purpose, the editors are associated with print jobs, 
which call a predefined layout for output. Default parameters for output are already set in the 
predefined layouts. You find more information on the output parameters in the the project 
documentation of the various WinCC components.

Components from Which Project Documentation Can Be Called
You can start project documentation directly from the following components of WinCC:

● WinCC Explorer

● Graphics Designer

● Alarm Logging

● Tag Logging

● Global Scripts

● Text Library

● User Administrator

● User Archives

● Time Synchronization

● Horn Editor

● Picture Tree Manager

● Lifebeat Monitoring

● OS Project Editor
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The reports for project documentation are output by the user. On the File menu of the various 
WinCC components you find the following commands:

Menu Command Function Special Features

Print Project 
Documentation

Prints a report immediately. The layout 
that is set in the print job is used. The 
report is output to the printer/file that is 
set in the Print Job Properties dialog.

A printer selection dialog is not 
displayed; printing starts 
immediately. Depending on the size 
of the project, this process can take 
some time. The process cannot be 
canceled while the data is being read 
from the system.

View Project 
Documentation

Opens a preview of the report to be 
output.

Depending on the size of the project, 
this process can take some time. The 
process cannot be canceled while 
the data is being read from the 
system.

Project 
Documentation 
Setup...

Opens the Print Job Properties dialog. 
In this dialog you can specify the layout 
to be used, the printer or file to which 
the reort is to be output, and the pages 
to be printed.

You find more information in chapters 
Print Jobs in WinCC and Changing 
an Existing Print Job.

See also
How to Create a New Print Job (Page 1450)

How to Change an Existing Print Job (Page 1452)

Print Jobs in WinCC (Page 1436)

How to Output Project Documentation (Page 1446)

How to Set Up Reports in the Page Layout (Page 1433)

7.6.2 How to Output Project Documentation

Introduction
The basic procedure for outputting project documentation is described below. You can use the 
page layouts provided with the product for project documentation.

Procedure
In the simplest case you use WinCC's defaults. If you want to check the output before printout, 
choose the View Project Documentation menu command, as described below.
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1. In WinCC Explorer, open the desired WinCC component via the menu bar or the pop-up 
menu in the navigation window.

2. In the component you have started, choose the Print Project Documentation command from 
the File menu.

 

Alternative Operation
If the print job used is known, project documentation can be started in WinCC Explorer by 
starting the corresponding print job directly.

1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 
and Print Job entries are displayed.

2. Double-click the Print Jobs entry in the file window. All existing print jobs are displayed in 
the file window.

3. Open the pop-up menu of the desired print job, and choose the Print the Print Job command.

 

Note

By default, a printer selection dialog is not displayed; printing starts immediately. Depending 
on the size of the project, this process can take some time. The process cannot be canceled 
while the data is being read from the system.

In some editors the output of project documentation from the application differs from the 
output of project documentation that is started directly via the print job in WinCC Explorer. 
You find more information on this in chapters Project Documentation... for the various WinCC 
editors.

 

Changing the Output Options
To change the printer or file for output, or to output a particular page range, you have to change 
the settings in the Print Job Properties dialog. To do this, choose the Project Documentation 
Setup... command from the File menu in the relevant editor. You find more information on this 
in chapter Changing an Existing Print Job.

To make changes to the contents of a report, you can edit or create page layouts and call them 
in a print job. This allows you to design project documentation to suit your requirements. You 
find more information on this in chapter Changing Predefined Layouts.
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See also
System Layouts for Project Documentation (Page 1510)

How to Change an Existing Print Job (Page 1452)

Project Documentation in the Component List Editor (Page 1468)

Project Documentation in the OS Project Editor (Page 1467)

Project Documentation in Lifebeat Monitoring (Page 1467)

Project Documentation in the Picture Tree Manager (Page 1466)

Project Documentation in the Audio Alarm Editor (Page 1465)

Project Documentation in the Time Synchronization Editor (Page 1464)

Project Documentation in the User Administrator (Page 1463)

Project Documentation in the Text Library (Page 1462)

Project Documentation in Global Script (Page 1460)

Project Documentation in Tag Logging (Page 1459)

Project Documentation in Alarm Logging (Page 1457)

Project Documentation in the Graphics Designer (Page 1455)

Project Documentation in the WinCC Explorer (Page 1454)

7.6.3 How to Open a Project Documentation Preview

Introduction
You can open project documentation reports in a preview. This enables you to check that the 
report meets your requirements before you print it.

Procedure
1. In WinCC Explorer, open the desired WinCC component via the menu bar or the pop-up 

menu in the navigation window. 

2. In the component you have started, choose the View Project Documentation command 
from the File menu. The preview is opened.

Alternative Operation
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 

and Print Job entries are displayed.

2. Double-click the Print Jobs entry in the file window. All existing print jobs are displayed in 
the file window.

3. Open the pop-up menu of the desired print job, and choose the Preview Print Job command. 
The preview is opened.
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Printing from the Preview
In the preview window you can print the report directly by clicking the Print... button. The print 
settings from the associated print job are used.

See also
Project Documentation in the Text Library (Page 1462)

System Layouts for Project Documentation (Page 1510)

Project Documentation in the Component List Editor (Page 1468)

Project Documentation in the OS Project Editor (Page 1467)

Project Documentation in Lifebeat Monitoring (Page 1467)

Project Documentation in the Picture Tree Manager (Page 1466)

Project Documentation in the Audio Alarm Editor (Page 1465)

Project Documentation in the Time Synchronization Editor (Page 1464)

Project Documentation in the User Administrator (Page 1463)

Project Documentation in Global Script (Page 1460)

Project Documentation in Tag Logging (Page 1459)

Project Documentation in Alarm Logging (Page 1457)

Project Documentation in the Graphics Designer (Page 1455)

Project Documentation in the WinCC Explorer (Page 1454)

Documentation of Configuration and Runtime Data
7.6 Project Documentation

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1449



7.6.4 How to Create a New Print Job

Introduction
In order to output a report to a printer or a file, the page layout used must be associated with 
a print job. The options for output are specified in the print job.

Requirements
You must have specified a page layout that can output the desired data. This can be a 
predefined WinCC layout or a layout you have created or edited yourself in which the desired 
objects are integrated for data output.

Procedure
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The 

"Layouts" and "Print Job" entries are displayed in the data window.

2. Select the Print Jobs entry. Choose the New Print Job command from the pop-up menu of 
the print job. A new print job called "Print Job001" is created. The number in the print job 
name is incremented each time a new print job is created. After the print job is created, all 
existing print jobs are displayed in the data window.
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3. Select the newly created print job in the file window, and use the pop-up menu to open the 
"Print Job Properties" dialog.

4. In input field "Name:" You can rename the print job. When you click "OK" to apply the 
change, the print job is renamed and the previous name overwritten.

5. Select "Layout:" Select the page layout using the selection field.
The layouts are provided with a symbol:

Icon Description

Layout is language-dependent.          
Layout files exist in all runtime languages. No language-neutral layout file exists.
Layout is language-dependent.          
Layout files do not exist in all runtime languages. You can use the layout. If you change 
to a runtime language, for which there is no layout file available, the English layout file 
is used.
The layout is language-neutral. In Runtime, the language-neutral layout is always 
printed, regardless of whether there are also language-specific layout files for the 
selected layout.

1. Change to the "Printer Setup" tab, and select output to a printer or a file. It is also possible 
to select both output types at the same time.

2. If you select output to a file, you have to specify a folder name in the Location text box. The 
folder PRT_OUT is created in the project path of the WinCC project. A folder with the name 
you entered is created in this folder, and a creation date and time are added to the folder 
name. When output is started, the report is saved in this folder page by page in the form 
of emf files.

3. Click the OK button to apply the settings.

4. Select the print job in the file window, and use the pop-up menu to start output.

 

Note

If you select output to a file, the data is saved in the form of EMF files. A documentation viewer 
is provided for these files with the WinCC Smart Tools.

 

Output options
On the Selection tab you can specify under Page Range whether you want to output all or only 
some of the pages.
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Note

The output type of the log is indicated in the file window of WinCC Explorer in the Type column 
by the abbreviation (F), (F, P), or (P). (F) stands for output to a file, and (P) output to a printer. 
If (F, P) is displayed, the log is output both to a file and a printer.

If a start time is configured in a print job, this print job is shown with the symbol  in WinCC 
Explorer.

If a cycle is configured in a print job, this print job is shown with the symbol  in WinCC Explorer.

7.6.5 How to Change an Existing Print Job

Introduction
The layouts provided with WinCC are already associated with print jobs. The print jobs have 
basic settings. The output options of these print jobs can be changed.

If a print job is renamed, the original print job is overwritten. Changes therefore cannot be 
undone. A print job cannot be copied. It is therefore advisable to create a new print job to 
prevent any unwanted changes being made to a system print job.
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Procedure
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 

and Print Jobs entries are displayed in the data window.

2. Double-click the "Print Job" entry in the data window. All existing print jobs are displayed 
in the data window. Choose the Properties command from the pop-up menu of the desired 
print job. The Print Job Properties dialog is displayed.

3. In the Name text box you can change the name of the print job. When you click OK to apply 
the change, the print job is renamed and the previous name overwritten.

4. On the General tab, select the desired layout under Layout by using the selection dialog.

5. Change to the Printer Setup tab, and select output to a printer or a file. It is also possible 
to select both output types at the same time.

6. If you select output to a file, you have to specify a folder name in the Location text box. The 
folder PRT_OUT is created in the project path of the WinCC project. A folder with the name 
you entered is created in this folder, and a creation date and time are added to the folder 
name. When output is started, the report is saved in this folder page by page in the form 
of emf files.

7. Click the OK button to apply the settings.

8. Select the print job in the file window, and use the pop-up menu to start output.

To change the print job properties for project documentation, you can use the File/Project 
Documentation Setup... command in the editor to call the integrated print job directly.

Note

If you select output to a file, the data is saved in the form of EMF files. A documentation viewer 
is provided for these files with the WinCC Smart Tools.

Output options
On the Selection tab you can specify under Page Range whether you want to output all or only 
some of the pages.

On the Printer Setup tab you can specify a number of printers for output. If the first printer 
cannot be reached, the second printer is used. If this cannot be reached either, the third printer 
is used.
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7.6.6 Project Documentation in the WinCC Explorer

Introduction
WinCC Explorer is prepared for project documentation. The following commands are available 
in the File menu for this purpose:

● Print Project Documentation

● View Project Documentation

● Project Documentation Setup...

Data for Output
The following data are available for project documentation in WinCC Explorer:

Object Output options Function

Computer - Serves to output the name of the computer whose 
data is to be documented.

Tags Selection of tags          
Selection of tag groups          
Selection of tag 
parameters          
Format

Serves to output tags, tag groups, and tag 
parameters from the tag management 
system.         
Formats the tag list.

Connections Selection of connections in a 
selection dialog.

Serves to output the configured connections to 
subordinate controllers.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation. 

Print job Layout used Objects Contained

@Documentation Control Center @mcpcs.RPL Computers, tags, connections

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)
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7.6.7 Project Documentation in the Graphics Designer

Introduction
Graphics Designer is prepared for project documentation. The following commands are 
available in the File menu for this purpose:

● Print Project Documentation

● View Project Documentation

● Project Documentation Setup...

The print jobs for project documentation can be started from the menu of the WinCC component 
or directly in WinCC Explorer. However, there is an important difference to note in the case of 
Graphics Designer project documentation. When a print job is started in Graphics Designer, 
the data of the open picture are output. If the print job is started in WinCC Explorer, the data 
of all Graphics Designer pictures in the project are output. This applies to all documentable 
parameters of Graphics Designer pictures.

Data for Output
The following data are available for project documentation in Graphics Designer:

Actions in Graphics Designer

Object Output options Function

Info The object is available 
for:          
- Actions on the property          
- Actions on the object

Serves to output general 
information such as the picture 
name, object name, and property 
name.

Trigger description The object is available 
for:          
- Actions on the property 

Serves to output the trigger type.

Source text The object is available 
for:          
- Actions on the property          
- Actions on the object

Serves to output the source text of 
an action.

 

Graphics Designer Picture Data

Object Output options Function

General display Selecting Elements:          
All available elements          
The selected element

Serves to output the view of a 
Graphics Designer picture in a 
report.

Picture statistics Selection of statistics data for 
the picture

Serves to output statistics data on 
a Graphics Designer picture.
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Object Output options Function

Attributes Selection of attributes          
Selection of table data

Serves to output the attributes of a 
Graphics Designer picture

Embedded objects Object selection Serves to output the embedded 
objects in a Graphics Designer 
picture.

Actions Selection of action types Serves to output the actions in a 
Graphics Designer picture.

Trigger Object selection         
Selection of actions

Serves to output the triggers for the 
actions in a Graphics Designer 
picture.

Source text Selection of actions Serves to output the source text of 
actions in a Graphics Designer 
picture.

Direct connections Selecting Elements:          
All available elements          
The selected element

Serves to output the direct 
connections in a Graphics Designer 
picture.

 

Graphics Designer Object Data

Object Output options Function

Object statistics Object selection         
Selection of statistics on the 
object

Serves to output statistics data on 
objects in a Graphics Designer 
picture.

Attributes Object selection         
Selection of attributes         
Selection of table data

Serves to output the attributes of 
objects in a Graphics Designer 
picture.

Actions Object selection         
Selection of actions

Serves to output the actions on 
objects in a Graphics Designer 
picture.

Trigger Object selection         
Selection of actions

Serves to output the triggers for the 
actions on objects in a Graphics 
Designer picture.

Source text Object selection         
Selection of actions

Serves to output the source text of 
actions for the selected objects.

Direct connection Object selection Serves to output the direct 
connections of objects
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Points to Note About Object Data Output 
● Control-Object slider:

The following applies to the PictureBack and PictureThumb attributes in project 
documentation:
If there is no picture entered, a hyphen (-) is output in the project documentation.
If a picture is entered, "none" is output.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation. 

Print job Layout used Objects contained

@Documentation Graphics 
Designer Dynamics

@PDLPicDyn.RPL Nested layout for outputting the 
dynamization data of a Graphics 
Designer picture.

@Documentation Graphics 
Designer Overview

@PDLPicOvr.RPL Picture statistics, general display.

@Documentation Graphics 
Designer

@PDLPic.RPL Nested layout for outputting the 
general display, statistics data, 
objects in the picture, picture 
attributes, actions on the picture, 
direct connections to the picture, 
object statistics, attributes of the 
objects, actions on the objects, and 
direct connections to objects. The 
data is output on a separate page 
for each picture.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)

7.6.8 Project Documentation in Alarm Logging

Introduction
The Alarm Logging editor is prepared for project documentation. The following commands are 
available in the File menu for this purpose:

● Print Project Documentation

● View Project Documentation

● Project Documentation Setup...

Documentation of Configuration and Runtime Data
7.6 Project Documentation

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1457



Data for Output
The following data are available for project documentation in the Alarm Logging editor:

Object Output options Function

Message classes - Serves to output the existing message classes with 
their properties.

Single messages Selection of single 
messages

Serves to output the selected single messages with 
their properties.

Archives - Serves to output the existing message archives with 
their properties.

 

Data of the Message Blocks:

Object Output options Function

System Blocks - Serves to output the existing system blocks with their 
properties.

User text blocks - Serves to output the existing user text blocks with their 
properties.

Process value 
blocks

- Serves to output the existing process value blocks with their 
properties.

 

Data of the Group Messages

Object Output options Function

Message 
class         
 

- Serves to output the group messages of message classes.

User-defined         
 

- Serves to output user-defined group messages.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation Alarm 
Logging

@AlgCS.RPL Message blocks, message classes, single messages, 
group messages, archives, and logs 
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Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects. You find a description of the selection of single messages in chapter 
Changing Output Options for Single Messages from Alarm Logging CS.

See also
How to Output Project Documentation (Page 1446)

7.6.9 Project Documentation in Tag Logging

Introduction
The Tag Logging editor is prepared for project documentation. The following commands are 
available in the File menu for this purpose:

● Print Project Documentation

● View Project Documentation

● Project Documentation - Setup...

Data for Output
The following data are available for project documentation in the Tag Logging editor:

Object Output options Function

Timers - Serves to output the existing timers with their properties.

 

Data of the Archives

Object Output options Function

Process value archive Archive names         
Process value 
archive data

Serves to output the configuration data of process 
value archives

Compressed archive Archive names         
Process value 
archive data

Serves to output the configuration data of 
compressed archives

Process value archive 
tag

Tag         
Tag data

Serves to output configuration data of the selected 
process value archive tags

Compressed archive 
tag

Tag         
Tag data

Serves to output configuration data of the selected 
compressed archive tags
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Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation Tag 
Logging

@tlgcs.RPL Message blocks, message classes, single messages, 
group messages, archives, and logs 

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)

7.6.10 Project Documentation in Global Script

Introduction
There are two editors available in Global Script, the C editor and the VBS editor. Both of these 
editors are prepared for project documentation. If you open an action, a function, or a module 
in one of these editors, the following commands are available to you in the File menu of the 
editor:

● Print Project Documentation

● View Project Documentation

● Project Documentation - Setup...

The output applies to the open function, action, or module.

Documentation of all actions, project functions, and standard functions can be output by means 
of three of the print jobs listed below. The output is started in WinCC Explorer.

The same predefined layouts are used to output the project documentation in the C editor and 
the VBS editor. The identifier Language: C Script or Language: VB Script is output in the 
information box at output. This indicates which of the two editors the documentation comes 
from.

Note

The documentation of all actions, functions, and modules can be very extensive. To check 
the number of pages, open the print preview of the print job, and check the page number 
there (format: page 1 of x).
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Data for Output
The following data are available for project documentation in the Global Script editor:

Object Output options Function

Info The object is available 
for:          
- Actions          
- Standard functions          
- Project functions          
- Standard modules          
- Project modules

Serves to output general 
information such as who it was 
created/changed by, the creation 
date, data of change, version, and 
a comment.

Trigger description The object is available 
for:         
- Actions

Serves to output the trigger type.

Source text The object is available 
for:          
- Actions          
- Standard functions          
- Project functions          
- Standard modules          
- Project modules

Serves to output the source text of 
an action/function or a module.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.

Print job Layout used Objects contained

@Documentation Global Script 
Project Function

@GSC_RPFC.RPL Nested layout for outputting the 
information and source text of the 
project functions. Output is started 
in WinCC Explorer.

@Documentation Global Script 
Standard Function

@GSC_RSFC.RPL Nested layout for outputting the 
information and source text of the 
standard functions. Output is 
started in WinCC Explorer.

@Internal Global Script Action @GSC_ACT.RPL Layout for outputting information, a 
trigger description and the source 
text for an action open in the C 
editor or VBS editor or a module 
open in the VBS editor.

@Internal Global Script Project 
Function

@GSC_PFC.RPL Layout for outputting information 
and the source text for a project 
function open in the Global Script 
editor.

@internal Global Script 
Standard Function

@GSC_SFC.RPL Layout for outputting information 
and the source text for a standard 
function open in the Global Script 
editor.
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Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)

7.6.11 Project Documentation in the Text Library

Introduction
The Text Library is prepared for project documentation. The following commands are available 
in the File menu for this purpose:

● Print Project Documentation

● View Project Documentation

● Project Documentation - Setup...

Data for Output
The following data are available for project documentation in the Text Library:

Object Output options Function

General data - Serves to output the configuration data of 
the Text Library.

Text table Language selection for selecting the 
languages for output

Serves to output the texts from the Text 
Library.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.

Print job Layout used Objects contained

@Documentation Text 
Library

@Textlibrary.RPL General data and text table. The texts of the different 
languages are output line by line one after the other.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.
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See also
How to Output Project Documentation (Page 1446)

7.6.12 Project Documentation in the User Administrator

Introduction
The User Administrator editor is prepared for project documentation. The following commands 
are available in the File menu for this purpose:

● Print Project Documentation

● View Project Documentation

● Project Documentation - Setup...

Data for Output
The following data are available for project documentation in the User Administrator editor:

Object Output options Function

Groups - Serves to output the user groups from the User Administrator.
functions - Serves to output the texts from the configured functions from the User 

Administrator.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation User Administration @UACS.RPL Groups and functions

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)
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7.6.13 Project Documentation in the Time Synchronization Editor

Introduction
The Time Synchronization editor is prepared for project documentation. The following buttons 
are available in the editor's dialog:

● Printing

● Preview

● Setup

Data for Output
The following data are available for project documentation in the Time Synchronization editor:

Object Output options Function

Devices - Serves to output the devices and services used.
General - Serves to output the general settings in the Time Synchronization editor.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation Time 
Synchronization

@TimeSync(landscape).R
PL

HornTags, general settings, horn signals, 
and additional reset tags.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)
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7.6.14 Project Documentation in the Audio Alarm Editor

Introduction
The audio alarm editor is prepared for project documentation. The following buttons are 
available in the editor's dialog:

● Project documentation

● Printing

● Preview

● Setup...

Data for Output
The following data are available for project documentation in the Audi Alarm Editor:

Object Output options Function

HornTags - Serves to output the assignment of tag and message class.
General settings - Serves to output the general settings in the Audio Alarm 

Editor.
Horn signals - Serves to output the assignment of signals or signal modules 

to tags.
Additional reset tags - Serves to output multiple acknowledgment via additional 

acknowledgment tags.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation 
Horn

@Horn(landscape).RP
L

HornTags, general settings, horn signals, and 
additional reset tags.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)
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7.6.15 Project Documentation in the Picture Tree Manager

Introduction
The Picture Tree Manager is prepared for project documentation. The following commands 
are available in the File menu for this purpose:

● Print Project Documentation Hierarchy

● View Project Documentation Hierarchy

● Setup Project Documentation Hierarchy...

● Print Project Documentation Group display

● View Project Documentation Group Display

● Project Documentation Group Display Setup...

Data for Output
The following data are available for project documentation in Picture Tree Manager:

Object Output options Function

PTN table - Serves to output the configured container hierarchy and 
the pictures it contains.

Group displays table - Serves to output the configuration data of the Group 
Display.

Elements of Standard Project Documentation
Predefined page layouts and print jobs are provided with WinCC for project documentation.

Print job Layout used Objects contained

@Documentation Picture Tree Manager @ptmcs.RPL Picture Tree Manager table
@Documentation Signal Collection @SCollect.RPL Group displays table

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

See also
How to Output Project Documentation (Page 1446)
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7.6.16 Project Documentation in Lifebeat Monitoring

Introduction
The Lifebeat Monitoring editor is prepared for project documentation. The following commands 
are available on the File menu for this purpose:

● Printing

● View

● Printer Setup...

Data for Output
The following data are available for project documentation in the Lifebeat Monitoring editor:

Object Output options Function

Lifebeat 
Monitoring 
table

- Serves to output the configuration data from Lifebeat Monitoring.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation Lifebeat Monitoring @lbmcs.RPL Lifebeat Monitoring table

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

7.6.17 Project Documentation in the OS Project Editor

Introduction
The OS Project Editor is prepared for project documentation. The following buttons are 
available for it on the General tab:

● Printing

● View

● Printer Setup...
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Data for Output
The following data are available for project documentation in the OS Project Editor:

Object Output options Function

ProjectEditor table - Serves to output the coordinate settings of the monitor, 
overview area, working area, and key area.

TopField table - Serves to output the settings for the display of circular 
pictures in the Runtime window.

TopfieldConfig2 
table

- Serves to output the settings for the display of group pictures 
and general pictures in the Runtime window.

TopfieldConfig3 
table

- Serves to output the settings for the display of trend groups 
in the Runtime window.

AlarmConfig table - Serves to output the settings for the display of the small alarm 
window.

AreaButton table - Serves to output the settings for the buttons for switching 
between areas.

HiddenArea table - Serves to output the settings for hidden areas.
RestData table - Serves to output the general settings in the OS Project Editor.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation OS 
Projecteditor

@Projecteditor.RP
L

ProjectEditor table, TopField table, TopfieldConfig2 
table, TopfieldConfig3 table, AlarmConfig table, 
AreaButton table, HiddenArea table, and RestData table.

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

7.6.18 Project Documentation in the Component List Editor

Introduction
The Component List Editor is prepared for project documentation. The following commands 
are available in the File menu for this purpose:

● Project Documentation Setup...

● View Project Documentation

● Print Project Documentation
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Data for Output
The following data are available for project documentation in the Component List Editor:

Object Output options Function

Attribute table - Serves to output information on the connections between internal 
IDs and texts for display in the Component List Editor. 

Measuring 
point table

- Serves to output the type, entry point picture (Loop In Alarm), 
and area assignments of a component and their designations.

Elements of Standard Project Documentation
A predefined page layout and a print job are supplied with for the project documentation.

Print job Layout used Objects contained

@Documentation LTO 
Component List

@LTO 
Bausteinliste(landscape).RPL

Attribute table, measuring point 
table

Changing the Output Options
You find more information on how to create a report in chapters Working with Layouts and 
Working with Objects.

7.7 Runtime Documentation

7.7.1 Introduction to Runtime Documentation

Introduction
A number of options are available for logging Runtime data in WinCC. The WinCC control for 
displaying Runtime data have an interface for the output of the reports of the Runtime data. 
You can also output Runtime data outside of the WinCC controls.

Overview
The following WinCC controls have a configurable interface for the log output:

● WinCC OnlineTableControl

● WinCC OnlineTrendControl

● WinCC FunctionTrendControl

● WinCC RulerControl
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● WinCC AlarmControl

● WinCC UserArchiveTableControl

Note

As of WinCC V7, the "Print message report" button is no longer available in the 
AlarmControl. 

For the independent logging of Runtime data, you must configure the corresponding layouts 
in Reports Designer and connect them with a print job. 

For the "WinCC Control Runtime Printprovider" layout, you configure only the basic properties 
of the layout in Report Designer. The report parameters for the output are determined by 
properties of the WinCC control and cannot be made dynamic. For all other layouts of the 
Runtime documentation, you configure the properties of the layout in Report Designer and the 
static and dynamic report parameters for the layout. 

You specify scheduling and how much is to be printed in the print job associated with the layout. 
A layout can be used by several print jobs, e.g. an output of different media or a different time 
selection of the data. 

The print jobs can be called in different ways. The following calls are configurable:

● Call via a configurable option in one of the aforementioned WinCC controls

● Call via a configurable button in a WinCC picture

● Call via the Print Job List application window in a WinCC picture

● Call via a configured cycle in the print job

● Call via configured start parameters in the print job

● Call via a script function

Components for Runtime Documentation
You can document Runtime data from the following components of WinCC:

WinCC Control Runtime Printprovider

Report object Function

Table The entire contents of the table of the control is output in the table. Output of the 
report object depends on the display of the control in Runtime and must be initiated 
using the button in the control. You cannot dynamize report parameters. The report 
object is not available for the WinCC OnlineTrendControl and WinCC 
FunctionTrendControl.

Text In addition to the "Table" and "Picture" report objects, you can use report object "Text" 
to output the window caption, the name and the picture name of the control.

Picture The current control display is output in the picture. Output of the report object 
depends on the display of the control in Runtime and must be initiated using the 
button in the control. You cannot dynamize report parameters.
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Note

The Runtime data of a WinCC RulerControl and of an interconnected WinCC control can be 
output in a single report. Insert two corresponding report objects of "WinCC Control Runtime 
Printprovider" in the page layout, e.g. a "picture" for OnlineTrendControl and a "table" for 
RulerControl. Activate the "WinCC RulerControl" option in the "Connect" tab of the properties 
dialog for the object properties of the report object of the RulerControl.

WinCC Online Table Control

Report object Function

Table The table contains the contents of the tags from the process value archives and 
compressed archives. You configure the static and dynamic parameters of the 
control for the output in Reports Designer.

WinCC Online Trend Control

Report object Function

Picture The picture outputs the the content of the tags of process value archives and 
compressed archives in trend format. Configure the output of static and dynamic 
parameters of the controls in the Reports Designer.

WinCC Function Trend Control

Report object Function

Picture The picture shows the process values as a function of another tag from process value 
archives, compressed archives or user archives in trend format. You configure the 
static and dynamic parameters of the control for the output in Reports Designer.

WinCC Alarm Control

Report object Function

Table The table is used for the output of message lists. In contrast to the "message report" 
and "archive report" report objects, all message lists can be accessed. You configure 
the static and dynamic parameters of the control for the output in Reports Designer.

User archive runtime

Report object Function

Table The table contains the contents of the user archives. 
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Alarm Logging Runtime

Report object Function

Message Report The message report outputs all messages in the current message list in Alarm 
Logging.

Archive report The archive log serves to output messages that are stored in the message archive.

Further Runtime Documentation Options

Logging of CSV Files

Report object Function

CSV provider 
table

The CSV provider table logs data from a file in CSV format. The data is output in 
tabular form.

CSV provider 
trend

The CSV provider trend logs data from a file in CSV format. The data is output in 
the form of a trend.

 

Logging Data by Means of ODBC

Report object Function

ODBC database field Serves to output data from a field of a data source by means of ODBC. The 
data is output as text.

ODBC database table Serves to output data from a table of a data source by means of ODBC. The 
data is output in tabular form.

 

Logging of Own COM Servers

Report object Function

COM server The COM server object allows you to integrate your own COM object in WinCC and 
log the data from this object. The COM object can be of the type text, table, or picture.

 

Output of a Hard Copy

Report object Function

Hard copy Serves to output the current contents of the screen, a subarea of it, or a currently 
selected picture window. 
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A hard copy can also be output with the PrintScreen application. You find more information in 
chapter How to Output a Hard Copy.

Dynamic log parameters
Dynamic log parameters were introduced in WinCC to enable the logging of Runtime data to 
be adjusted before output, for e.g. through scripts. In addition to a configured value, you specify 
WinCC tags, from which the parameters for the output are taken in Runtime.

To change the parameters for output immediately before starting printing, a dialog for changing 
the log parameter can be displayed. The display of this dialog can be controlled by the relevant 
print job. The Configuration Dialog option must be set in the Dialog field on the General tab.

See also
How to Create Layouts for Runtime Documentation (Page 1473)

How to Create Reports in Line Layout (Page 1435)

How to Set Up Reports in the Page Layout (Page 1433)

7.7.2 How to Create Layouts for Runtime Documentation

Introduction
For Runtime documentation, new layouts have to be created or predefined layouts adapted to 
suit the project before they are used. You specify in the layout which data are to be logged in 
Runtime. You configure the output format and specify whether the output can be changed 
before printing is started.

We recommend saving an existing layout with a new name first and only then editing the layout. 
If you do this, you can always fall back on the layouts provided with WinCC if you need to.

The system layouts and system print jobs provided with WinCC are used by the WinCC 
components when logging is started. For this reason, you can neither delete nor rename 
system layouts and system print jobs. Changes to the dynamic part of system layouts affect 
logging in Runtime. The system layouts can be identified by the prefix "@" in the layout name.

Editing a Layout
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 

and Print Job entries are displayed.

2. Double-click the "Layouts" entry in the file window. All existing layouts are displayed in the 
file window.

3. Select the layout according to the desired output. Double-click to use the pop-up menu to 
open the layout. The page layout editor is opened to allow you to edit the layout. You find 
a list of the layouts provided for Runtime documentation in the appendix.

4. Select the first report object in the open layout and open the object properties dialog by 
double-clicking it or using the pop-up menu.
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5. In the Object Properties dialog, select the Connect tab and then the log object in the left 
section of the tab. The list of things you can do is displayed on the right.

6. Use the "WinCC Control Runtime Printprovider" layout in WinCC V7 or higher. The output 
of the report object depends on the layout of the control in Runtime. Define the control 
elements for the "Table" and "Picture" report objects to be excluded from printing in the 
"Connect" tab. Activate the "WinCC RulerControl" option to output a RulerControl by means 
of the report object.

7. Open the parameterization dialog or the dynamization dialog if using report objects versions 
prior to WinCC V7. Specify the settings for the output here. You find a description of the 
possible output options for the various objects in chapter Working with Objects for Runtime 
Documentation.

8. Select the next log object in the layout, and repeat steps 4 to 7.

9. If required, change the external appearance of the object by changing the attribute values 
on the Properties tab of the Object Properties window.

10.Save the changes and close the layout.

11.Then edit the associated print job.

Please also note the behavior of dynamic tables at output. You find more information on this 
in chapter Changing Predefined Layouts.

Alternative Procedure
You can also create new layouts for Runtime documentation and use them for logging. A new 
layout must be associated with a print job for output. You can use an existing print job or create 
a new one. The system print jobs provided are used for the log functions integrated in WinCC. 
It is thus only worthwhile using a system print job if you want to use a user-defined layout 
instead of the system layout set there.

See also
System Layouts and Print Jobs for Runtime Documentation (Page 1513)

How to create print jobs for the Runtime documentation (Page 1474)

How to Change Output Options in Runtime (Page 1476)

Changing Predefined Layouts (Page 1554)

7.7.3 How to create print jobs for the Runtime documentation

Introduction
Predefined print jobs are provided with WinCC for logging Runtime data. These system print 
jobs are used by various WinCC components for Runtime documentation. The system print 
jobs can therefore be neither deleted nor renamed. When you use system print jobs for Runtime 
documentation, you can specify output options, how much is to be printed, and the layout to 
be used. Additional information can be found in the chapter "Print Jobs in WinCC".
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For user-defined Runtime documentation you can create new print jobs and configure their 
calls. In this way, you can output Runtime data without negatively affecting the preset log 
functions.

Procedure
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 

and Print Jobs entries are displayed.

2. Double-click the Print Jobs entry in the data window. All existing print jobs are displayed in 
the data window. Choose the Properties command from the pop-up menu of the desired 
print job. The Print Job Properties dialog is displayed. You find a list of the print jobs provided 
for Runtime documentation in the appendix.

3. Use the three tabs in the dialog to set the parameters of the print job. Additional information 
can be found in the chapter "Print Jobs in WinCC".

4. To create a new print job, select the Print Jobs entry in the navigation window of WinCC 
Explorer, and choose the New Print Job command from the pop-up menu. A new print job 
is created with a consecutive number in its name. To assign parameters, proceed as 
described above.

Online Logs for a Client Without Project
If you wish to output Runtime logs in a distributed system using a client without its own project, 
you must activate the option Report Runtime in the startup list of this client.
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In addition, you must set the parameter /CLIENT for Report Runtime. In the startup list, select 
the application Report Runtime and click the Edit... button. Add the necessary parameters in 
the Parameters entry field.

If cyclic print jobs are supposed to be excluded from the output, add the /NO_CYCLE parameter 
to the Parameters entry fields.

See also
Reporting Messages in Runtime (Page 1484)

Print Jobs in WinCC (Page 1436)

System Layouts and Print Jobs for Runtime Documentation (Page 1513)

Reporting Data from Other Data Sources (Page 1492)

Reporting Process Values in Runtime (Page 1490)

How to Change Output Options in Runtime (Page 1476)

How to Output Online Data with Message Sequence Report (Page 1486)

7.7.4 How to Change Output Options in Runtime

Introduction
To make Runtime documentation more flexible, a number of log parameters can be dynamized. 
This allows you to change log output in Runtime. There are two different ways to change these 
log parameters.

● When configuring a layout for Runtime documentation, the parameters can be 
interconnected with WinCC tags for report objects of controls created in a version older 
than WinCC V7. For a print order, the parameters that can be dynamized are provided with 
the current values of the WinCC tag during runtime. Values are supplied to the WinCC tags 
by means of appropriate configuration (e.g. by means of input/output fields in a WinCC 
picture, configurable options with fixed, stored values, or process-controlled actions, or they 
are supplied by other WinCC applications). An overview of the Runtime documentation 
parameters that can be dynamized is included in chapter Dynamizable Parameters for 
Runtime Documentation.

● During configuration of a print job, you can set a parameter dialog in the Dialog field. When 
the print job starts, a dialog listing the dynamic log elements is displayed. The log elements 
are displayed with all dynamizable parameters. If you double-click a parameter, the 
corresponding configuration dialog is displayed. The settings for the current output can be 
changed in the input fields of the configuration dialog. Any WinCC tags which were 
configured in a configuration dialog for report objects of a control created in a version older 
than WinCC V7 are read. The values are entered in the corresponding fields of the static 
parameters. The tag fields themselves are deactivated and cannot be changed in Runtime. 
The printer for output can be changed in Runtime by means of the Printer Setup option.

During configuration of a print job, you can select the Printer Setup dialog in the Dialog field. 
When the print job starts, a dialog is displayed in which you can select the printer for output.
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Assigning dynamic properties to report parameters of report objects for WinCC Controls created in a 
version older than WinCC V7

Apart from the static parameterization by means of the tabs of the WinCC Controls, you have 
the option to dynamize a number of object properties of the WinCC Controls. 

1. Open the desired layout in the page layout editor and call the object properties dialog of 
the log object.

2. In the Object Properties dialog, select the Connect tab and then the log object in the left 
section of the tab. The list of things you can do is displayed on the right.

3. Double-click to open the Dynamizable Parameters configuration dialog. The object 
properties that can be dynamized are shown in the parameter list.

4. In the list of properties, select the parameter you want to dynamize.

5. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.

6. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection 
dialog. If necessary, specify a start value for the tag.

7. Apply the settings by clicking OK and save the layout.

8. Before the log is started in Runtime, the WinCC tag must be supplied with values.

Dynamization of Log Parameters of other Log Objects of the Runtime Documentation
The procedure for dynamization via WinCC tags is the same for all log parameters. 

1. Open the desired layout in the page layout editor and call the object properties dialog of 
the log object.

2. In the Object Properties dialog, select the Connect tab and then the log object in the left 
section of the tab. The list of things you can do is displayed on the right.

3. In the list of things you can do, open the configuration dialog by means of a double-click or 
the pop-up menu.

4. Select the Tag check box for the parameter to be dynamized, and click the folder button. 
The tag selection dialog is displayed.

5. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection 
dialog. Select the desired tag, or create a new tag.          
Edit the properties of the tag in the tag selection dialog. If required, specify a start value for 
the tag. The tag can also be entered directly in the editing field without opening the tag 
selection dialog.

6. Apply the changes by clicking OK and save the layout.

7. Before the log is started in Runtime, the WinCC tag must be supplied with values.

Dynamization of the Log Parameters by Means of the Parameter Dialog 
In the parameter dialog you can change the log parameters in Runtime. Since the relevant 
object name is displayed for the log objects in the parameter dialog, it makes sense to give 
the log objects meaningful names. Otherwise, the objects are displayed in the parameter dialog 
with the standard names assigned by WinCC. WinCC automatically assigns the log object 
standard names together with a consecutive number and increments the number each time a 
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new object is created, e.g. "Dynamic Table 1". Consequently, a numbered selection of dynamic 
tables would be displayed in the parameter dialog, for example, which is not suitable if the user 
wants to make a specific selection.

1. Select the desired print job in WinCC Explorer, and use the pop-up menu to open the 
properties dialog.

2. On the General tab, select the Parameter Dialog option in the Dialog field.

3. Click OK to apply the change.

4. If the print job is started, the parameter dialog is displayed with the integrated log objects. 
Use a double-click to open the configuration dialog of the desired log object, and then set 
the output options.

5. The Printer Setup button allows you to change the selected printer.

6. The Delete button allows you to delete a selection. To do this, select the log object and 
click the Delete button.

7. Once the selection is made, you can start the log.

Selecting the Printer in Runtime
The printer for output is selected when the print job is configured. If the default settings in the 
Print Job Properties dialog remain unchanged, the printer cannot be changed in Runtime. If 
the Printer Selection Dialog option is selected, the printer can also be selected in Runtime, if 
necessary. This option is configured separately for each print job.

1. Select the desired print job in WinCC Explorer, and use the pop-up menu to open the 
properties dialog.

2. On the General tab, select the Printer Selection Dialog option in the Dialog field.

3. Click OK to apply the change.

4. If the print job is started, the printer selection dialog is displayed with the available printers.
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5. Use the dialog to specify the printer for output. If necessary, change the order of priority of 
the printers. Output to a file is also possible.

6. Confirm the selection with "OK". Printing is started.

See also
System Layouts and Print Jobs for Runtime Documentation (Page 1513)

Reporting Data from Other Data Sources (Page 1492)

Dynamizable Parameters for Runtime Documentation (Page 1479)

How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 1638)

How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 1643)

Configuring the dynamic parameters of the WinCC Function Trend Control (Page 1647)

How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 1651)

How to Change the Output Options for Message Reports from Alarm Logging Runtime 
(Page 1654)

How to Change the Output Options for User Archive Tables (Page 1658)

7.7.5 Dynamizable Parameters for Runtime Documentation

Introduction
To make Runtime documentation more flexible, a number of report object parameters can be 
dynamized. The tables below show the parameters that can be dynamized.

Parameters of report objects for WinCC Controls created in a version older than WinCC V7 which 
support dynamization

WinCC Alarm Control

Dynamizable Parameters Explanation

MsgFilterSQL Selection of message by means of SQL statements
ServerNames Server selection in distributed systems
TimeBase Time base of message lists

WinCC Online Table Control

Dynamizable Parameters Explanation

Archives Archive linked to a column
BackColor Background color of the table
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Dynamizable Parameters Explanation

BeginTime Start time of the column time range          
If the "Update" checkbox is activated in the "Column" tab, the start 
time will refer to the current time. The previous values are then 
output in the defined time interval.

Color Color of the column
CommonTime Common time column to be used for the table
EndTime End time of the column time range The "Time range" checkbox 

in the "Column" tab must be deactivated. The value depends on 
TimeAxisX.

ItemVisible Hide/show column
Name Name in column header
Precisions Number of decimal places in a value column
TimeColumnAlignment Alignment of time column
TimeFormat Format of time in column
TimeRangeBase Time range of a column. The time range is calculated by 

multiplying TimeRangeBase with TimeRangeFactor. The 
"TimeRangeBase" and "TimeRangeFactor" properties are only 
evaluated when the "Time range" checkbox in the "Column" tab 
is activated.Format:

TimeRangeFactor Repeat rate of the column time range. The time range is 
calculated by multiplying TimeRangeBase with 
TimeRangeFactor. The "TimeRangeBase" and 
"TimeRangeFactor" properties are only evaluated when the 
"Time range" checkbox in the "Column" tab is activated.Format:

TimeZone Time base of the table
ValueColumnAlignment Alignment of value column
Variable Archive tag linked to a column

WinCC Online Trend Control

Dynamizable Parameters Explanation

BackColor Background color of trend graphic
BeginTime Start time of a trend.         

If the "Update" checkbox is activated in the "Time axis" tab, the 
start time will refer to the current time. The previous values are 
then displayed for a fixed time range or for a fixed number of 
measured points.          
If CommonX is set to Yes, the set BeginTime applies to all trends.

BeginValue Lower limit of value of the range of a trend. Only available if 
Autorange option is deactivated.

Color Color of the trend
CommonX Shared X axis of the trend graphic
CommonY Shared Y axis of the trend graphic
CurveForm Representation of measurements in the form of a trend
EndTime End time of a trend. The "Time Range" and "Number of 

Measuring Points" checkboxes on the "Time Axis" tab must be 
unchecked.
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Dynamizable Parameters Explanation

EndValue Upper limit of value of the range of a trend. Only available if 
Autorange option is deactivated.

GraphDirection Direction of current values in trend graphic
ItemVisible Hide/show trend
LineWidth Line width of trend
MeasurePoints The number of measuring points that are output since start time. 

The "Time range" checkbox in the "Time Axis" tab must be 
unchecked.

Relay Curves Staggered display of trends 
TagName Tags linked by a trend
TimeRangeBase Time range of a trend. The time range is calculated by multiplying 

TimeRangeBase with TimeRangeFactor. The "TimeRangeBase" 
is evaluated only when the "Time range" checkbox in the "Time 
Axis" tab is activated.

TimeRangeFactor Repeat rate of the time range of a trend. The time range is 
calculated by multiplying TimeRangeBase with 
TimeRangeFactor. The "TimeRangeFactor" is evaluated only 
when the "Time range" checkbox in the "Time Axis" tab is 
activated.

TimeZone Time base of trend graphic

WinCC Function Trend Control

Dynamizable Parameters Explanation

AutorangeX Automatic selection of value range along X axis
AutorangeY Automatic selection of value range along Y axis
BackColor Background color of trend graphic
BeginX Lower limit of X axis value range. Only available if 

AutorangeX is set to No. The value range is determined 
by CommonX.

BeginY Lower limit of Y axis value range. Only available if 
AutorangeY is set to No. The value range is determined 
by CommonY.

Color Color of the trend
CommonX Shared X axis of the trend graphic
CommonY Shared Y axis of the trend graphic
CurveForm Representation of measurements in the form of a trend
DesiredCurveColor Color of setpoint trend of a trend. The value depends 

on DesiredCurveVisible.
DesiredCurveCurveForm Representation of measurements of setpoint trend of a 

trend. The value depends on DesiredCurveVisible.
DesiredCurveSourceNumberOfUAValues Number of values of a setpoint trend of trend that can 

be loaded from the user archive. The value depends on 
DesiredCurveVisible.

DesiredCurveSourceUAArchive Name of the user archive to which the setpoint trend of 
a trend is linked. The value depends on 
DesiredCurveVisible.
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Dynamizable Parameters Explanation

DesiredCurveSourceUAArchiveStartID ID of the record of the user archive from which values 
are to be loaded to the setpoint trend of a trend. The 
value depends on DesiredCurveVisible.

DesiredCurveSourceUAColumnX Column of the user archive from where the X values of 
a setpoint trend of a trend are to be read. The value 
depends on DesiredCurveVisible.

DesiredCurveSourceUAColumnY Column of the user archive from where the Y values of 
a setpoint trend of a trend are to be read. The value 
depends on DesiredCurveVisible.

DesiredCurveVisible Hide/show setpoint trend
EndX Upper limit of X axis value range. Only available if 

AutorangeX is set to No. The value range is determined 
by CommonX.

EndY Upper limit of Y axis value range. Only available if 
AutorangeY is set to No. The value range is determined 
by CommonY.

GraphDirection Direction of positive values in trend graphic
ItemVisible Hide/show trend
LabelX Label of X axis of a trend. The value depends on 

TimeAxisX.
LabelY Label of Y axis of a trend
Name Name of a trend
Relay Curves Staggered display of trends 
SourceBeginTime Start time of a trend. 
SourceEndTime End time of a trend. The "Time range" checkbox in the 

"X-Axis" tab must be checked.
SourceNumberOfUAValues Number of value pairs of a trend that are loaded from 

the user archive
SourceNumberOfValues Number of value pairs of a trend that are retrieved from 

archive tags. The "Time range" checkbox in the "X-Axis" 
tab must be unchecked.

SourceTagNameX Archive tag linked to the X axis of a trend
SourceTagNameY Archive tag linked to the Y axis of a trend
SourceUAArchive Name of user archive linked to a trend
SourceUAArchiveStartID ID of the record of the user archive from which values 

are to be loaded to a trend.
SourceUAColumnX Column of the user archive from where the X values of 

a trend are to be read.
SourceUAColumnY Column of the user archive from where the Y values of 

a trend are to be read.
TimeAxisX Use time range of the X axis for a trend
TimeZone Time base of trend graphic

WinCC User Archive Control
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Dynamizable Parameters Explanation

Filter Filter criteria for database access by means of SQL statements
Sort Sort criteria for database access by means of SQL statements
TimeZone Time base of the table

Dynamizable Parameters for other Report Objects

Report object Dynamizable Parameters

Message reports Selected servers          
Filter criterion for alarm output

User archives table Archive name/view name         
Filter condition         
Sorting

ODBC database field ODBC data source          
Users          
Password          
SQL statement

ODBC database table ODBC data source          
Users          
Password          
SQL statement

Hard copy Range selection          
Size and position of a subarea

CSV provider table CSV file name
CSV provider trend CSV file name

See also
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 1638)

How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 1643)

Configuring the dynamic parameters of the WinCC Function Trend Control (Page 1647)

How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 1651)
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7.7.6 Reporting Messages in Runtime

7.7.6.1 Reporting Messages in Runtime

Overview
You can log all messages occurring in the system using the WinCC reporting system. The 
following options are available:

● Output of Runtime data from the message lists.

● Output of a message sequence report.

You print the messages from the message lists directly via a configurable interface in the 
WinCC AlarmControl. The messages from the archive lists are output in accordance with the 
selection configured in the WinCC Alarm Control.

To output messages, you have to do the following things:

● Configure the button in the WinCC AlarmControl for starting the report in Runtime.

● Select "Alarm Logging Runtime" and "Graphics Runtime" in the startup list of the WinCC 
project.

● Select the project, and start the log.

You have the option of logging messages with a selection independent of the WinCC 
AlarmControl. The report system provides layouts, in which you can determine parameters 
that can be made dynamic. For more information, please read  ,  and .

Points to Note About the Message Sequence Report
The message sequence report outputs the messages that occur in the system in chronological 
order in accordance with the specified selection criteria. To this end, the message sequence 
report in the startup list of the WinCC project must be activated. The message sequence report 
is generally output to a line printer, but it can also be output page by page.

See also
How to Create a User-Defined Message Sequence Report (Page 1489)

How to Output Online Data with Message Sequence Report (Page 1486)

How to Output Runtime Data from the Message Lists (Page 1485)

How to Configure the Static Parameters of WinCC Alarm Control (Page 1649)

How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 1651)
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7.7.6.2 How to Output Runtime Data from the Message Lists

Introduction
In WinCC AlarmControl, you configure a button for the report call for the output of the messages 
from the message lists. In Runtime, you must activate the desired message list in AlarmControl 
and press the "Print" button. You determine how the data is output using the print job in 
AlarmControl.

Overview
When messages from the message archive lists are output, you must select the messages 
(e.g. all messages of the last shift) before outputting the report. When outputting a report 
without selection of messages, the scope of the output can be too great and the system can 
become overloaded.

For the output of the messages, the "@Alarm Control - Picture.RPL" or "@ Alarm Control - 
Table.RPL" system layouts are provided with the WinCC V7 AlarmControl. If you want to output 
the messages from the message archive outside of the WinCC AlarmControl, use the 
"@CCAlarmCtrl-CP.RPL" system layout. 

However, you can create a new layout to configure desired settings (e.g. landscape format, 
other aspects of the layout). In this case, you must link the print job to the layout. 

Further information on the layouts and print jobs of the WinCC AlarmControl can be found 
under System Layouts and Print Jobs for Runtime Documentation (Page 1513).

Procedure
1. Open the WinCC picture with the WinCC AlarmControl in Graphics Designer.

2. Double-click the control to open the properties dialog.

3. Go to the "Toolbar" tab and activate the "Print" button function.

4. Go to the "General" tab. A print job is set for output in the "View current print job" field. If 

you want to use a different print job, select the desired print job using the  button.

5. Confirm the setting with "OK". Save and close the WinCC picture.

6. Select the "Graphics Runtime" and "Alarm Logging Runtime" options in the computer's 
startup list.

7. Activate the project.

8. Click the "Print" button in the WinCC AlarmControl for the print output. The current view or 
the full contents of the selected message list of the WinCC AlarmControl is output on the 
printer set in the print job.

Note

When the application starts log output, the system print jobs are used. For this reason 
neither system layouts nor system print jobs can be deleted or renamed.

Documentation of Configuration and Runtime Data
7.7 Runtime Documentation

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1485



In the WinCC Alarm Control before WinCC V7, you can also activate the "Print message report" 

key function. In this case, the  button is displayed in Runtime. This button is for outputting 
logs with a standard layout from WinCC V5 and has been retained in the system for 
compatibility reasons. The contents of this log depend on the configuration settings in the 
layout called and the selection made in the WinCC Alarm Control. When messages from the 
message archive lists are output, you must select the messages (e.g. all messages of the last 
shift) before outputting the report. When outputting a report without selection of messages, the 
scope of the output can be too great and the system can become overloaded.

See also
System Layouts and Print Jobs for Runtime Documentation (Page 1513)

Reporting Data from Other Data Sources (Page 1492)

Reporting Process Values in Runtime (Page 1490)

How to Change Output Options in Runtime (Page 1476)

7.7.6.3 How to Output Online Data with Message Sequence Report

Introduction
The message sequence report allows you to output a chronological list of all messages that 
occur in a project. It is generally output on a line printer. The messages are output in the order 
in which they occur.

If a line printer is used for output, it must be connected locally to the logging computer. The 
Line layout for Line Printer check box in the print job must be selected. However, the message 
sequence report can also be output in a page layout.

The printer does not have to be connected locally to the logging computer in order to output 
the report with a page layout. A message sequence report in a page layout can also be output 
on a network printer. Upon output in page layout, the printout is generated when incoming 
messages have filled a page or if you initiate the printout of the page by clicking the operation 
button.

Print Job and Layout
For the message sequence report there is a set print job that also has to be used for a message 
sequence report you define yourself. It is not possible to create your own print job for a line 
layout.

Print job Layout Remarks

@Report Alarm Logging RT 
Message Sequence

@CCAlgRtSequence.R
P1

System print job for a message sequence 
report in line format. 

@Report Alarm Logging RT 
Message Sequence

@CCAlgRtOnlineMessa
ges.RPL

Print job for the printing of a message 
sequence log in the page layout
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Creating a Line Layout
Before a message sequence report is output in a line layout, the layout has to be adjusted. 
You edit a line layout in the line layout editor.

1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 
and Print Jobs entries are displayed.

2. Double-click the Layouts entry in the file window. All existing layouts are displayed in the 
file window.

3. Double click on line layout "@CCAlgRtSequence.RP1". The layout is opened in the line 
layout editor.

4. In the Page Size area, specify the number of lines per page and the number of columns 
(characters per line).

5. In the Margins section, specify the number of characters for the width of the margins.

6. Edit the contents of the header and footer. These are output on every page.

7. Click the Selection button to open the Log Tables Selection dialog. Use the dialog to specify 
the data for output. You find more information in chapter "Changing Output Options for 
Message Reports from Alarm Logging". When you close the dialog, the selected columns 
and their widths are displayed in characters per line in the Table area. If the number of 
characters per line is too large, a message to this effect is displayed.

8. Save the changes to the line layout, and close the editor.

Prerequisites for Output
● The line printer on which the message sequence report is output must be connected locally 

to the computer carrying out the logging.

● The message sequence report must be activated in the startup list of the computer carrying 
out the logging.

Starting the Message Sequence Report
The message sequence report must be activated in the startup list of the computer carrying 
out the logging. The message sequence report is started automatically when the WinCC project 
is activated.

Interrupting the Message Sequence Report
To interrupt the output of the message sequence report on a line printer, proceed as follows:

● Suspend the output of the message sequence report by calling the 
MSRTActivateMProt(False,Null) function.

To resume output of the message sequence report, proceed as follows:
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● Restart output of the message sequence report by calling the 
MSRTActivateMProt(TRUE,NULL) function.

Note

If the message sequence report is interrupted, the incoming messages for the message 
sequence report are lost.

Printout of Message Sequence Log in Page Layout
Before a message sequence report is output in a page layout, the print job has to be adjusted. 

1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 
and Print Jobs entries are displayed.

2. Double-click the Print Jobs entry. All existing print jobs are displayed in the file window.

3. Double click on print job "@Report Alarm Logging RT Message sequence" marked in 
yellow. The Print Job Properties dialog is displayed.

4. Clear the Line Layout for Line Printer check box on the General tab.

5. From the list of layouts, select layout "@CCAlgRtOnlineMessages.RPL".

6. Select the "Printer Setup" tab. Acknowledge the displayed dialog window "CcPJobApi" with 
"OK".

7. In the "Print output to..." section, select the default printer and the substitute printer. Click 
"OK". After closing the dialog, the yellow marking for the print job "@Report Alarm Logging 
RT Message sequence" disappears in the file window.

The message sequence log in page layout will be printed automatically as soon as the incoming 
messages have filled a page. If you wish to print a page before it is filled, proceed as follows:

● With a call to function MSRTPrintMProt (pointer to page number, pointer on error message), 
start the message sequence log printout.

● If you use Basic Process Control, the key set of the message lists include a printer button 
with which you can print out a page that is not full.

For troubleshooting instructions, refer to chapter Printer Setup.

See also
Defining a Printer (Page 1442)

System Layouts and Print Jobs for Runtime Documentation (Page 1513)

Reporting Data from Other Data Sources (Page 1492)

Reporting Process Values in Runtime (Page 1490)

How to create print jobs for the Runtime documentation (Page 1474)
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7.7.6.4 How to Create a User-Defined Message Sequence Report

Introduction
To create a user-defined message sequence report, you can create a new line layout or page 
layout or save an existing layout with a new name and edit it. Always use the @Report Alarm 
Logging RT Message Sequence print job to output the message sequence report. 

Output in a Line Layout
1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 

and Print Job entries are displayed.

2. Select the Layouts entry, and use the pop-up menu to create a new line layout. A blank 
layout is created and stored under Layouts. The layout is saved with the name 
"NewRP100.RP1". If several layouts are created, the number in the layout name is 
incremented each time a new one is created.

3. Open the new line layout by means of a double-click in the line layout editor.

4. Configure the layout as described in chapter How to Output Online Data with Message 
Sequence Report.

5. Save and close the layout.

Output in a Page Layout
The message sequence report can also be output in a page layout.

1. Create a new page layout, and open it in the page layout editor.

2. In the object palette on the Runtime Documentation tab, select the Message Report object, 
and drag it to the desired size in the working area.

3. Open the Object Properties dialog by double-clicking the object, and select the Connect 
tab.

4. In the list of possible things to do, double-click Selection. The Alarm Logging Runtime: 
Report Table Selection dialog is opened.

5. Use the dialog to specify the data for output. You find more information in chapter Changing 
Output Options for Message Reports from Alarm Logging.

Editing the Print Job
There is only one print job for the message sequence report, so you have to call the line layout 
or page layout you have created in this print job.

1. Select the Report Designer entry in the navigation window of WinCC Explorer. The Layouts 
and Print Jobs entries are displayed.

2. Double-click the Print Jobs entry in the file window. All existing print jobs are displayed in 
the file window.

3. Open the @Report Alarm Logging RT Message Sequence print job by double-clicking it. 
The Print Job Properties dialog is displayed.
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4. On the General tab, select the layout you have created in the Layout field.

5. If you are using a line layout, select the Line layout for Line Printer check box on the General 
tab. If you are using a page layout, clear this check box.

6. On the Printer Setup tab, specify the printer to be used for output, and then close the dialog.

See also
Print Jobs in WinCC (Page 1436)

How to Output Online Data with Message Sequence Report (Page 1486)

System Layouts and Print Jobs for Runtime Documentation (Page 1513)

Reporting Data from Other Data Sources (Page 1492)

Reporting Process Values in Runtime (Page 1490)

7.7.7 Reporting Process Values in Runtime

Introduction
You can output process values from the Logging tag using the WinCC report system. The 
following options are available:

● Output of process values in table form from process value archives and compressed 
archives via the WinCC OnlineTableControl.

● Output of process values in trend curve form from process value archives and compressed 
archives via the WinCC OnlineTrendControl.

● Output of process values in trend curve form as a function of another tag from process 
value archives, compressed archives and user archives via the WinCC 
FunctionTrendControl.

The data can be output directly in the relevant WinCC control using the "Print" button. 

Overview
For the output of the data, the new WinCC V7 controls provide new system layouts for each 
WinCC control. If you output the process values outside of the WinCC controls and you want 
to dynamize the report parameters, continue to use the previous system layouts of the 
respective WinCC control. 

However, you can create a new layout to configure desired settings (e.g. landscape format, 
other aspects of the layout). In this case, you must link the print job to the layout. 

Further information on the layouts and print jobs of the controls can be found under .

Documentation of Configuration and Runtime Data
7.7 Runtime Documentation

MDM - WinCC: Working with WinCC
1490 System Manual, 11/2008,  



Procedure
1. Open the WinCC picture with one of the aforementioned WinCC controls in Graphics 

Designer.

2. Double-click the control to open the properties dialog.

3. Go to the "Toolbar" tab and activate the "Print" button function.

4. Go to the "General" tab. A print job is set for output in the "View current print job" field. If 

you want to use a different print job, select the desired print job using the  button.

5. Confirm the setting with "OK". Save and close the WinCC picture.

6. Select the "Graphics Runtime" and "Tag Logging Runtime" options in the computer's startup 
list.

7. Activate the project.

8. Click the "Print" button in the displayed WinCC AlarmControl for the print output. The current 
view or the trend curves or the full contents of the table is output on the printer set in the 
print job.

Note

When the application starts report output, the system print jobs are used. For this reason 
neither system layouts nor system print jobs can be deleted or renamed.

See also
How to Output Data from User Archives (Page 1491)

How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 1638)

How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 1643)

Configuring the dynamic parameters of the WinCC Function Trend Control (Page 1647)

7.7.8 How to Output Data from User Archives

Introduction
You authorize output of the table of the Win CC UserArchiveControl in Runtime using the "Print" 
button. You determine how the data is output using the print job in the WinCC control.

Overview
For the output of the data, the "@User Archive Control - Picture.RPL" or "@User Archive 
Control - Table.RPL" system layouts are provided with the new WinCC WinCC 
UserArchiveControl. If you want to output the data of the user archive outside of the WinCC 
UserArchiveControl, use the "User Archive - Runtime" layout in Reports Designer. 

However, you can create a new layout to configure desired settings (e.g. landscape format, 
other aspects of the layout). In this case, you must link the print job to the layout. 
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Further information on the layouts and print jobs of the WinCC UserArchiveControl can be 
found under System Layouts and Print Jobs for Runtime Documentation (Page 1513).

Procedure
1. Open the WinCC picture with the WinCC UserArchiveControl in Graphics Designer.

2. Double-click the control to open the properties dialog.

3. Go to the "Toolbar" tab and activate the "Print" button function.

4. Go to the "General" tab. A print job is set for output in the "View current print job" field. If 

you want to use a different print job, select the desired print job using the  button.

5. Confirm the setting with "OK". Save and close the WinCC picture.

6. Select the Graphics Runtime option in the computer's startup list.

7. Activate the project.

8. Click the "Print" button in the WinCC UserArchiveControl for the print output. The current 
view or the full contents of the table of the WinCC UserArchiveControl is output on the 
printer set in the print job.

Note

When the application starts report output, the system print jobs are used. For this reason 
neither system layouts nor system print jobs can be deleted or renamed.

See also
Reporting Data from Other Data Sources (Page 1492)

System Layouts and Print Jobs for Runtime Documentation (Page 1513)

Reporting Messages in Runtime (Page 1484)

7.7.9 Reporting Data from Other Data Sources

7.7.9.1 Reporting Data from Other Data Sources

Overview
The WinCC reporting system also allows you to log data that do not come from a WinCC 
project. There are various log objects available for integrating this kind of data in a WinCC log. 
In addition, WinCC provides a hard copy log object, by means of which the screen or a section 
of the screen showing the current Runtime status can be output in a report.

The following log objects are available for output:
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ODBC database 
field

Serves to output data from a database field in a WinCC log by means 
of ODBC.

ODBC database 
tables

Serves to output data from a database table in a WinCC log by means 
of ODBC.

CSV table Serves to output data from a file in CSV format in a WinCC log. The 
data is output in tabular form.

CSV trend Serves to output data from a file in CSV format in a WinCC log. The 
data is output in the form of a trend.

Hard copy object Serves to output a view of the screen or a section of the screen in a 
WinCC log.

COM server object Permits the integration of a user-specific COM server to output its data 
in a WinCC log.

Detailed knowledge is required in order to configure these logs. Creating a COM server, in 
particular, requires appropriate background knowledge. Information on database accesses by 
means of ODBC, COM servers, and CSV files is not provided here. You find more information 
on these subjects in the relevant technical literature.

See also
How to Output Data from a COM Server in a Report (Page 1509)

How to Output a Hard Copy by Means of a Log Object (Page 1501)

How to Output Data from a CSV Table in a Log (Page 1495)

How to Output Data from an ODBC Database in a Report (Page 1493)

7.7.9.2 How to Output Data from an ODBC Database in a Report

Introduction
Special log objects are provided in the reporting system for integrating data from user-specific 
data sources. It is possible to use two of these log objects to access data sources by means 
of ODBC and to output the data that is read out in a WinCC log. These report objects allow for 
access to these data and output in a WinCC log. This gives the reports and logs uniformity, 
even if the data do not come from WinCC. If WinCC tags are integrated, the selection of the 
data can be dynamized. In other words, the data selection can be changed online before output.

Available ODBC Log Objects

Database field Serves to output data from a field of a data source by means of ODBC.
Database table Serves to output data from a table of a data source by means of ODBC.

Requirements
● Knowledge of how to create layouts and insert log objects

● Knowledge of how to access data sources by means of ODBC
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● Access authorization for the ODBC data source

● Knowledge of SQL

● If WinCC tags are used for dynamization, the WinCC project must be activated for testing 
and output.

Procedure
1. Create a new page layout, and open it in the page layout editor.

2. In the object palette on the Standard Objects tab, select the log object Database Field or 
Database Table, depending on your requirements, and drag it to the required size in the 
working area.

3. Open the Object Properties dialog by double-clicking the object, and select the Connect 
tab.

4. In the list of possible things to do, double-click Database Link. The Data Connection dialog 
is displayed.

5. In the ODBC Data Source area of the selection dialog, select an existing data source, or 
enter a data source in the text box.

6. Edit the other text boxes in accordance with the requirements of your data source.

7. Click OK to close the dialog and save the layout.

8. Create a print job, and select the configured page layout there.

9. Start output by means of the print job in WinCC Explorer or by means of a configured call 
in a WinCC picture, for example.

Output Options
You can use any SQL statement to select the data. Enter it in the SQL Statement field. You 
can use WinCC tags to dynamize the selection of data by means of a SQL statement. For full 
dynamization, select the Tag check box, and integrate a tag. You can also dynamize a 
substring of the SQL statement. To do this, use the Insert Tag button. Select the tag you require 
from the tag selection dialog that is displayed. The tag will be inserted at the current cursor 
position in the text box. The syntax for this is $tagname$.

You can use the Test SQL Statement button to check whether the SQL statement is correct. 
Access to the data source is required in order to carry out the test. If there are WinCC tags in 
the SQL statement, WinCC must be activated for the test. The result of the test is displayed 
in a dialog. If the test is successful, the number of fields is entered automatically for a data 
table.

Errors that occur in Runtime are written to a log file.

You find more information in chapters Changing Output Options for the ODBC Database Field 
and Changing Output Options for the ODBC Database Table.

CAUTION

The SQL statements are not subject to any constraints. If you do the wrong thing, it is possible 
to destroy or delete the data source. 
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7.7.9.3 How to Output Data from a CSV Table in a Log

Introduction
Two log objects are provided in the reporting system for the integration of data in CSV format. 
These report objects allow for access to these data and output in a WinCC log. This gives the 
reports and logs uniformity, even if the data do not come from WinCC. If WinCC tags are 
integrated, the selection of the data can be dynamized. In other words, the data selection can 
be changed in Runtime before output.

Available CSV Log Objects

CSV provider 
table

Serves to output data from a file in CSV format. The data is output in 
tabular form.

CSV provider 
trend

Serves to output data from a file in CSV format. The data is output in the 
form of a trend.

Requirements
● Knowledge of how to create layouts and insert log objects

● Knowledge of the structure of CSV tables.

● If WinCC tags are used for dynamization, the WinCC project must be activated for testing 
and output.

Procedure
1. Create a new page layout, and open it in the page layout editor.

2. In the object palette on the Runtime Documentation tab, select the log object CSV-Provider 
Table or CSV-Provider Trend, depending on your requirements, and drag it to the desired 
size in the working area.

3. Open the Object Properties dialog by double-clicking the object, and select the Connect 
tab.

4. In the list of possible things to do, select CSV Table Selection or CSV Trend Selection. A 
dialog is displayed in which you can select the data source.

5. In CSV File Name area of the selection dialog, select an existing data source, or enter a 
data source in the text box.

6. Click OK to close the dialog and save the layout.

7. Create a print job, and select the configured page layout there.

8. Start output by means of the print job in WinCC Explorer or by means of a configured call 
in a WinCC picture, for example.
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Using the Data Source
To output the log correctly, the data must be stored in the CSV file used on the basis of a 
predefined structure. If current data are to be output, the CSV file must be created before 
output is started. The user is responsible for deleting the CSV file after output. You find more 
information in chapter Requirements to Be Met by a CSV File for Logging.

See also
Requirements to be Met by a CSV File for Reporting (Page 1498)

Example of the Output of CSV Files in a Report (Page 1496)

7.7.9.4 Example of the Output of CSV Files in a Report

Introduction
To illustrate the output of CSV files in a WinCC log, an example is provided of output in tabular 
form, and another is provided of output in the form of a trend. The notation must be rigorously 
adhered to. If the CSV file is created using a spreadsheet program, please check the notation 
before outputting it for the first time. To this end, open the CSV file in a text editor and check 
the contents. You find more information on this in chapters How to Output Data from a CSV 
Table in a Log and Requirements to Be Met by a CSV File for Logging.

Procedure
1. Create a CSV file in which the data are stored as in the examples described below.

2. Configure a page layout for the output. Proceed in the same way as for configuration 
described in chapter How to Output Data from a CSV Table in a Log.

3. Create a print job, and associate it with the page layout. Proceed in the same way as for 
configuration described in chapter Creating Print Jobs for Runtime Documentation.

4. Start the print job. The log is output.

5. Delete the CSV file after output.

Example of Output in Tabular Form
Contents of the CSV file to be printed:

#Table; Name; Columns; Font; Font size

"testfile";4;"Arial";14

#Column; Num; Header; Width; Alignment

0;"Date";10;C

1;"Time";10;C

2;"Number";6;L

3;"Status";16;R
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#Data; Color; Col1; Col2; Col3; Col4;

0xFF00FF;"05/06/02";"15.55.52";85;"+/-"

0xFF00FF;"05/06/02";"15.55.53";86;"+/-"

0x32b400;"05/06/02";"15.55.54";87;"+/-"

0x32b400;"05/06/02";"15.55.55";88;"+/-"

0xFFFFFF;"05/06/02";"15.55.56";89;"+/-"

0xFFFFFF;"05/06/02";"15.55.57";90;"+/-"

0x0000FF;"05/06/02";"15.57.12";100;"+/-"

0x0000FF;"05/06/02";"15.58.01";85;"+/-"

0xFF0000;"05/06/02";"15.58.02";86;"+/-"

0xFF0000;"05/06/02";"15.58.03";87;"+/-"

Output file

 

Example of Output in the Form of a Trend
Contents of the CSV file to be printed:

#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize

"TrendControl1";3;"2001-10-10 16:30:00.000";"2001-10-10 16:40:00.000";0;"Arial";10

#Curve; Num; Name; Count; dMin; dMax; Color; Weight; CurveType;  Filling

0;"Temperature";3;10;30;0x00ff0000;1;STEP;0

1;"Pressure";     5; 0;50;0x0000ff00;2;DOTS;0

2;"Force";    10; 0;50;0x000000ff;5;LINE;1

#Data; Num; Date; Value; Flags; Color

0;"2001-10-10 16:30:00.000";22;0;0x000000FF

0;"2001-10-10 16:31:00.000";24;0;

0;"2001-10-10 16:32:00.000";27;0;

1;"2001-10-10 16:30:00.000";10;0;0x0000FF00

1;"2001-10-10 16:30:30.000";20;0;

1;"2001-10-10 16:31:00.000";20;0;
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1;"2001-10-10 16:31:30.000";30;0;

1;"2001-10-10 16:32:00.000";10;0;

2;"2001-10-10 16:30:00.000";20;0;

2;"2001-10-10 16:31:00.000";27;0;

2;"2001-10-10 16:32:00.000";34;0;0x00FF00FF

2;"2001-10-10 16:33:00.000";45;0;0x00FF0000

2;"2001-10-10 16:34:00.000";20;0;

2;"2001-10-10 16:35:00.000";27;0;

2;"2001-10-10 16:36:00.000";34;0;0x00FF00FF

2;"2001-10-10 16:37:00.000";45;0;0x00FF0000

2;"2001-10-10 16:38:00.000";20;0;

2;"2001-10-10 16:39:00.000";10;0;

2;"2001-10-10 16:40:00.000";25;0;

 

Output file

See also
Requirements to be Met by a CSV File for Reporting (Page 1498)

How to Output Data from a CSV Table in a Log (Page 1495)

7.7.9.5 Requirements to be Met by a CSV File for Reporting

Introduction
To permit the data from a CSV file to be output in a WinCC log, the data must correspond to 
a set structure. The data in a CSV file are prepared by the user. You find more information in 
chapters How to Output Data from a CSV Table in a Log and Example of the Output of CSV 
Files in a Report.
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Requirements for CSV File to be Output in Tabular Form
Each section must begin with the name of the corresponding file structure, followed by one or 
more lines containing the elements of the file structure. All parameters must be separated by 
a semicolon (;), regardless of country-specific settings. The following file structures are defined:

File Structure for Output in Tabular Form
The table, columns, and data must be defined as follows:

#Table; Name; Columns; Font; Font size

- Name = name of the table control or file

- Columns = number of columns

- Font = font of the table

- Font size = font size of the table

 

#Column; Num; Header; Width; Alignment

- Num = number of the column

- Header = header of the column

- Width = width of the column in characters

- Alignment = left aligned/centered/right aligned

 

#Data; Color; Col1; Col2; Col3; Col4; ...

- Color = color attribute of the line (0xbbggrr)

- Col1 = data of column 1

- Col2 = data of column 2

- etc.

Points to Note About the Data in the CSV File
The control characters for color, alignment, etc. are always preceding of the output text and 
can be combined with each other (e.g. <B><U>output text). No distinction is drawn between 
upper and lower case.

The Width parameter indicates the relative width of the columns. The effective width of the 
column in the table is calculated as follows:

[ Table width as a number of characters ] x [ relative width of the column in % ] / [ sum of all 
relative widths of the column ]

The line defined for tables in the CSV file contains one more column than the data lines. If a 
spreadsheet program such as Excel is used to edit the data, the columns for the headings and 
the data will no longer match up. To prevent this from happening, you can enter a semicolon 
(;) as the first character in the data lines of the CSV file. The data blocks of the CSV file may 
not contain blanks. When you open the CSV in Excel, the data columns are shifted one column 
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to the right. The columns for the headings and data will then match up. If the first column does 
not contain anything, you have to insert a blank (;blank;first data value;...). 

Control Characters for Table Output

<END> Concludes the interpretation of control sequences. The rest of the text is 
accepted as specified.

<COLOR=#rrggbb> Font color in hexadecimal notation (default = as set for the table)
<BGCOLOR=#rrggbb
>

Background color in hexadecimal notation (default = as set for the table)

<B> Bold
<U> Underlined
<I> Italic
<STRIKE> Strike-through
<ALIGN=left> Left aligned
<ALIGN=center> Centered
<ALIGN=right> Right aligned

 

Note

The definition of the Color attribute conforms to the Intel byte format. The notation is 0xbbggrr 
(hex blue blue green green red red). The control characters for formatting the table cells 
conform to the HTML standard. The notation for <color=> is #rrggbb.

 

Each section must begin with the name of the corresponding file structure, followed by one or 
more lines containing the elements of the file structure. The following file structures are defined:

File Structure for Output in the Form of a Trend f(t)
#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize

- Name = name of the trend control or file

- Curves = number of trends

- DateFrom = start of time range, notation: 2000-10-30 10:15:00.000 

Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).

- DateTo = end of time range, notation: 2000-10-30 10:15:00.000 

Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).

- Common Y-Axis = common y-axis

- Font = font

- Fontsize = font size
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#Curve; Num; Name; Count; dMin; dMax; Color; Weight; CurveType;  Filling

- Num = number of the trend

- Name = trend name

- Count = number of values

- dMin = lower limit of the trend (for scaling)

- dMax = upper limit of the trend (for scaling)

- Color = color attribute of the trend (0xbbggrr)

- Weight = line weight in points (e.g. 1.5)

- CurveType = trend type ( LINE, DOTS, STEP)

- Filling = filling color for areas ( 0=no, 1=yes). The Filling parameter is currently not in use.

 

#Data; Num; Date; Value; Flags; Color

- Num = number of the trend

- Date = X coordinate of the trend, notation: 2000-10-30 10:15:00.000

Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).

- Value = y coordinate of the trend

- Flags = limit values/time overlap etc.

- Color (if an empty string is specified here, the color is taken from #Curve ...)

7.7.9.6 How to Output a Hard Copy by Means of a Log Object

Introduction
For outputting a hard copy in a log, the page layout editor provides the Hardcopy log object. 
This log object allows you to create a hard copy of the entire screen, a section of the screen, 
or the current window. In contrast to output by means of a key combination, this can be output 
in a defined page layout. It is also possible to insert the log object in a different log and output 
it together with other data. 

Available Hard Copy Log Object

Hard copy Serves to output current screen views.

Requirements
● Knowledge of how to create layouts and insert log objects

● If WinCC tags are used for dynamization, the WinCC project must be activated for testing 
and output.
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Creating a Hard Copy Using the Hardcopy Log Object
1. Create a new page layout, and open it in the page layout editor.

2. In the object palette on the Standard Objects tab, select the Hardcopy log object. In the 
working area, drag it to the required size.

3. Open the object properties dialog by double-clicking the object, and select the Connect tab.

4. In the list of possible things to do, double-click Area Selection. A dialog that allows you to 
select the part of the screen to be output is displayed.

5. Select your preferred option in the Areas section of the selection dialog. If you select Copy 
of a Subarea, you have to specify the position of the upper-left corner and the size of the 
section in pixels in the corresponding text boxes.

6. Click OK to close the dialog and save the layout.

7. Create a print job, and select the configured page layout there.

8. Start output by means of the print job in WinCC Explorer or by means of a configured call 
in a WinCC picture, for example.

Output Options
The selection of the area and the position and size specifications can also be dynamized by 
means of WinCC tags. To do this, select the relevant Tag check box, and use the folder button 
to select a tag from the Tag Selection dialog. If you know the tag name, you can enter it directly 
instead.

You configure tag supply in Graphics Designer.

See also
How to Output a Hard Copy by Means of a Key Combination (Page 1502)

How to Change Output Options in Runtime (Page 1476)

7.7.9.7 How to Output a Hard Copy by Means of a Key Combination

Introduction
In WinCC Explorer you can use the project properties to specify a key combination for 
outputting a hard copy. It is possible to create a hard copy of the entire screen, a section of 
the screen, or the current window. For this purpose, command-line parameters have to be 
transferred to the executing application PrintScreen. In contrast to output of a hard copy via a 
log object, output via PrintScreen is directly to the default printer. A defined page layout is not 
used. Output can be started in two ways:

1. By means of a configured key combination in the project properties

2. By starting the PrintScreen application in the computer's startup list

In the startup list you can pass parameters for output. The parameters are taken into account 
in both of the above ways of starting output. If a hot key has been configured both in the project 
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properties and in the parameters in the startup list, the hot key from the project properties is 
used. Additional output parameters from the startup list are nevertheless still taken into account.

Configuring a Key Combination in the Project Properties
The output of a hard copy via a key combination can be set globally in WinCC. The output is 
directly to the default printer. For the output, the PrintScreen application is used instead of a 
layout from the logging system.

1. Select the name of the project in the navigation window of WinCC Explorer, and use the 
pop-up menu to open the Project Properties dialog.

2. Select the HotKeys tab, and then select Hard Copy in the Actions area.

3. Click in the text box below the Assign button, and enter the key combination. The key 
combination is displayed in the text box.

4. Apply the setting by clicking the Assign button, and close the dialog.

5. The hard copy is output by entering the specified key combination.

Starting the Print Screen Application in the Startup List
The PrintScreen application is entered in the computer's startup list under Additional Tasks/
Applications. The application can be supplied with parameters in command-line format that 
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specify the output You find an overview of the parameters and the applicable conditions in 
chapter Output Parameters for Hard Copies.

1. Select Computer in the navigation window of WinCC Explorer. In the data window, select 
the computer on which you want the hard copy to be output. Use the pop-up menu to open 
the Computer Properties dialog.

2. Select the Startup tab.

3. Click the Add... button. The Add Application dialog is displayed.

4. Click the Browse... button, and navigate to the bin folder in the WinCC installation directory. 
Select the PrtScr.exe application, and click Open.

5. Enter the desired parameters in the Parameters field.

6. The Working Directory and Window at Open fields are not required for PrintScreen.

7. Confirm your entries with "OK."

The PrintScreen application can also be called by means of a script. The parameters for output 
also apply when a script is used.

See also
Output Parameters for Hard Copy (Page 1504)

How to Output a Hard Copy by Means of a Log Object (Page 1501)

7.7.9.8 Output Parameters for Hard Copy

Introduction
When you output a hard copy by means of a key combination or a WinCC Script, you can pass 
parameters for the output. If the output is to be started by means of a key combination, this 
does not have to be specified in the project properties. The key combination can also be passed 
as a parameter.

Parameter for Output
The following parameters can be passed:

No parameters The PrtScr.exe application is started and waits for the key combination 
for the printout to be pressed. In this case, the key combination must be 
specified in the project properties.

-end Terminates a current instance of PrtScr.exe
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-hardcopy Starts PrtScr.exe, starts a hard copy immediately, and then waits for the 
key combination for the next printout to be pressed.

-nomcp Starts PrtScr.exe, starts a hard copy immediately, and then terminates 
PrtScr.exe.

-C= 
left;top;right;botto
m

Starts PrtScr.exe, immediately starts a hard copy for the specified area, 
and then terminates PrtScr.exe (the blank after -C= is important!). 
Example: prtscr.exe -C= 50;50;300;400 (Starting position 50 pixels from 
top, 50 pixels from left, End position 300 pixels from right, 400 pixels from 
bottom).

-l Prints the hard copy in landscape format.
-infinit Serves as a parameter for starting PrtScr.exe on a system without WinCC 

(e.g. a Web client). The key combination for the printout and the 
parameters for the printout are not obtained from the WinCC project; 
instead, they are passed in the command line. The PrtScr.exe application 
is started and waits for the key combination for the printout to be pressed. 
The parameters are passed once only at startup. If you want to change 
the parameters, you have to terminate the PrtScr.exe application and 
restart it with the changed parameters.

-SpoolerLevels= 
a,b

a = SpoolerLevelWarning, b= SpoolerLevelStop. Defines the limit value 
at which a warning is generated or the print job is rejected, if the required 
spooler capacity is not available. If no parameters is specified, the limit 
values are150 MB for warnings and 100 MB for rejection of print 
job.         
Example: -SpoolerLevels= 50,30. if the available capacity of the spooler 
is less than 50 MB, system message 1004006 Spool full is generated. If 
less than 30 MB are available, the print job is rejected. System message 
1004007 No hard copy printed. Spool full is generated.

-hotkey=x Parameters for specifying the key combination for starting the output. The 
following key combinations are permitted:          
{<ALT>, <SHIFT>,<CTRL>} +  {0-9, A-Z, 0xXX}         
The parameters must be entered in upper casing. The keys <ALT>, 
<SHIFT> and <CTRL> can be combined with each other, but it is not 
essential. By means of the hexadecimal value 0xXX, all virtual key codes 
can be expressed for XX. See the table below.

The parameters must be separated by blanks. In addition, a distinction must be drawn between 
upper and lower case.

Examples of the "-hotkey" parameter:
-hotkey=<CTRL+P>       Key combination CTRL and P

-hotkey=0x2C               Print screen (sometimes referred to as the Print key)

-hotkey=<ALT>+0x2C    Key combination of ALT and Print

Each time a key combination is pressed, PrtScr.exe prints a hard copy of the section of the 
screen specified (at program startup) on the default printer.
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Parameter Combinations for Hard Copy Output on a Web Client

One-Time Starting

PrtScr.exe –infinit –
hotkey=<Alt>+p"

Starts PrtScr and waits for key combination <ALT+P>. If the 
key combination is triggered, the entire screen is printed.

PrtScr.exe –infinit –
hotkey="<Alt>+p" –C= 
10;10;100;100

Starts PrtScr and waits for key combination <ALT+P>. If the 
key combination is triggered, the selected partial area is 
printed.

Starting in a Script

PrtScr.exe –nomcp Starts PrtScr, starts a hard copy immediately, and then terminates 
PrtScr.

PrtScr.exe –C= 
10;10;100;100

Starts PrtScr, starts a hard copy of the specified subarea 
immediately, and then terminates PrtScr.

The parameter –l can be added to any parameter combination.

Virtual Key Codes
The following table shows the symbolic constant names, hexadecimal values, and keyboard 
equivalents for the virtual-key codes used by the Microsoft Windows CE operating system. 
The codes are listed in numeric order. 

Symbolic constant name Value (hexadecimal) Touch screen or keyboard equivalent  

VK_LBUTTON 01 Touch screen
VK_CANCEL 03 Control-break processing
-- 05-07 undefined
VK_BACK 08 BACKSPACE key
VK_TAB 09 TAB key
-- 0A-0B undefined
VK_CLEAR  0C CLEAR key
VK_RETURN 0D ENTER key
-- 0E-0F undefined
VK_SHIFT 10 SHIFT key
VK_CONTROL 11 CTRL key
VK_MENU 12 ALT key
VK_CAPITAL 14 CAPS LOCK key
-- 15-19 Reserved for Kanji systems
-- 1A undefined
VK_ESCAPE 1B ESC key
-- 1C-1F Reserved for Kanji systems
VK_SPACE 20 SPACEBAR key
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Symbolic constant name Value (hexadecimal) Touch screen or keyboard equivalent  

VK_PRIOR 21 PAGE UP key
VK_NEXT 22 PAGE DOWN key
VK_END 23 END key
VK_HOME 24 HOME key
VK_LEFT 25 LEFT ARROW key
VK_UP 26 UP ARROW key
VK_RIGHT 27 RIGHT ARROW key
VK_DOWN 28 DOWN ARROOW key
VK_SELECT 29 SELECT key
-- 2A Original equipment manufacturer-specific (OEM-

specific)
VK_EXECUTE 2B EXECUTE key
VK_SNAPSHOT 2C PRINT SCREEN key for Windows 3.0 and later
VK_HELP 2F HELP key
VK_0 30 0 key
VK_1 31 1 key
VK_2 32 2 key
VK_3 33 3 key
VK_4 34 4 key
VK_5 35 5 key
VK_6 36 6 key
VK_7 37 7 key
VK_8 38 8 key
VK_9 39 9 key
-- 3A-40 undefined
VK_A 41 A key
VK_B 42 B key
VK_C 43 C key
VK_D 44 D key
VK_E 45 E key
VK_F 46 F key
VK_G 47 G key
VK_H 48 H key
VK_I 49 I key
VK_J 4A J key
VK_K 4B K key
VK_L 4C L key
VK_M 4D M key
VK_N 4E N key
VK_O 4F O key
VK_P 50 P key
VK_Q 51 Q key
VK_R 52 R key
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Symbolic constant name Value (hexadecimal) Touch screen or keyboard equivalent  

VK_S 53 S key
VK_T 54 T key
VK_U 55 U key
VK_V 56 V key
VK_W 57 W key
VK_X 58 X key
VK_Y 59 Y key
VK_Z 5A Z key
-- 5B-5F undefined
VK_NUMPAD0 60 Numeric keypad 0 key
VK_NUMPAD1 61 Numeric keypad 1 key
VK_NUMPAD2 62 Numeric keypad 2 key
VK_NUMPAD3 63 Numeric keypad 3 key
VK_NUMPAD4 64 Numeric keypad 4 key
VK_NUMPAD5 65 Numeric keypad 5 key
VK_NUMPAD6 66 Numeric keypad 6 key
VK_NUMPAD7 67 Numeric keypad 7 key
VK_NUMPAD8 68 Numeric keypad 8 key
VK_NUMPAD9 69 Numeric keypad 9 key
VK_MULTIPLY 6A Asterisk (*) key
VK_ADD 6B Plus sign (+) key
VK_SEPARATOR 6C Separator key
VK_SUBTRACT 6D Minus sign (-) key
VK_DECIMAL 6E Period (,) key
VK_DIVIDE 6F Slash mark (/) key
-- 88-8F unassigned
-- 92-B9 unassigned
-- BA-C0 OEM-specific
-- C1-DA unassigned
-- DB-E4 OEM-specific
-- E5 unassigned
-- E6 OEM-specific
-- E7-E8 unassigned
-- E9-F5 OEM-specific
VK_ATTN F6  
VK_CRSEL F7  
VK_EXSEL F8  
VK_EREOF F9  
VK_PLAY FA  
VK_ZOOM FB  
VK_NONAME FC  
VK_PA1 FD  
VK_EM_CLEAR FE  
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Symbolic constant name Value (hexadecimal) Touch screen or keyboard equivalent  

VK_LWIN 5B  
VK_RWIN 5C  
VK_APPS 5D  
VK_LSHIFT A0  
VK_RSHIFT A1  
VK_LCONTROL A2  
VK_RCONTROL A3  
VK_LMENU A4  
VK_RMENU A5  

 

7.7.9.9 How to Output Data from a COM Server in a Report

Introduction
To integrate user-specific data in a WinCC log, you can integrate a COM server in the reporting 
system. This COM server makes a log object available in the object palette that can be selected 
in the page layout editor and inserted in a page layout. The COM object then provides the user-
specific data for output in the log. You find more information in section COM Provider in the 
Page Layout Editor.

Available Log Objects

COM object defined by the 
user

Serves to output data from data sources of the user in a WinCC log.

Requirements
● Knowledge of how to create layouts and insert log objects

Procedure
1. Create a new page layout, and open it in the page layout editor.

2. In the object palette on the COM Server tab, select a COM object integrated by the user, 
and drag it to the desired size in the working area.

3. The creator of the COM object makes specifications available on the connection and 
selection of the data.

4. Configure the COM object in accordance with the specifications made there.

5. Save the layout.
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6. Create a print job, and select the configured page layout there.

7. Start output by means of the print job in WinCC Explorer or by means of a configured call 
in a WinCC picture, for example.

Output Options
You receive information on possible output options from whoever wrote the COM object.

7.8 Appendix

7.8.1 System Layouts for Project Documentation

Introduction
WinCC provides you with a number of system layouts that have fixed associations with print 
jobs and are used for project documentation.

Print Jobs and Layouts in the Basic WinCC System

Name of the Print Job Layout name

@Documentation Alarm Logging         
         
Used for the output of the configuration data of the Alarm Logging.

@AlgCS.RPL (P)

@Documentation Alarm Center         
         
Used for the output of the configuration data of the WinCC Explorer.

@MCPCS.RPL (P) 

@Documentation Global Script Actions         
         
Used for the output of the Global Script actions.

@GSC_RACT.RPL (P)

@Documentation Global Script Project function         
         
Used for the output of the Global Script project functions.

@GSC_RPFC.RPL (P)

@Documentation Global Script Standard function         
         
Used for the output of the Global Script standard functions.

@GSC_RSFC.RPL (P)

@Documentation Graphics Designer         
         
Used for the output of the configuration data of the Graphics Designer.

@pdlpic.RPL (P)

@Documentation Graphics Designer Dynamics         
         
Used for the output of the configuration data of Graphics Designer pictures.

@pdlpicDyn.RPL (P)
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Name of the Print Job Layout name

@Documentation Graphics Designer Overview         
         
Used for the output of the picture statistics and the general display of 
Graphics Designer pictures.

@pdlpicOvr.RPL (P)

@Documentation Tag Logging         
         
Used for the output of the configuration data of the Tag Logging.

@TlgCS.RPL (P)

@Documentation Text Library         
         
Used for the output of the configuration data of the text library.

@Textlibrary.RPL (P)

@Documentation User Administrator         
         
Used for the output of the configuration data of the User Administrator.

@UACS.RPL (P)

@Internal Global Script Actions         
         
This print job is started internally.

@gsc_act.RPL (P)

@Internal Global Script Project-function         
         
This print job is started internally.

@gsc_pfc.RPL (P)

@Internal Global Script Standard-function         
         
This print job is started internally.

@gsc_sfc.RPL (P)

@Internal Graphics Designer Actions at the object         
         
This print job is started internally.

@akt_obj.RPL (P)

@Internal Graphics Designer Actions at the property         
         
This print job is started internally.

@akt_prop.RPL (P)

You can start project documentation in the application or by starting the corresponding print 
job in WinCC Explorer.

Print Jobs and Layouts of the WinCC Option Basic Process Control

Name of the Print Job Layout name

@Documentation Horn         
         
Used for the output of the configuration data of the horn 
editor.

@Horn(landscape).RPL (P)

@Documentation Lifebeat Monitoring         
         
Used for the output of the configuration data of the Lifebeat 
Monitoring.

@LBMCS.RPL (P)

@Documentation LTO Component List         
         
Used for the output of the configuration data of the 
component list editor.

@LTOBausteinliste(landscape).RPL (P)
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Name of the Print Job Layout name

@Documentation OS Project Editor         
         
Used for the output of the configuration data of the OS 
project editor.

@Projecteditor.RPL (P)

@Documentation Picture Tree Manager         
         
Used for the output of the configuration data of the Picture 
Tree Manager.

@PTMCS.RPL (P)

@Documentation Signal Collection         
         
Used for the output of the configuration data of the signal 
collection.

@SCollect.RPL (P)

@Documentation Time Synchronization @TimeSync(landscape).RPL (P)

Internal System Page Layouts
The page layouts listed in the table below are involved in the standard project documentation 
and should not be edited. If you change these layouts, it affects project documentation.

Name of the Print Job Layout name

Involved in project documentation @Global Script single Action (landscape).RPL 
Involved in project documentation @Global Script single Project Function (landscape).RPL 
Involved in project documentation @Global Script single Standard Function (landscape).RPL 
Involved in project documentation @gscract.RPL 
Involved in project documentation @gscrpfc.RPL 
Involved in project documentation @gscrsfc.RPL 
Involved in project documentation @INC-PDL object actions.RPL
Involved in project documentation @INC-PDL object attributes.RPL
Involved in project documentation @INC-PDL object direct interconnections.RPL
Involved in project documentation @INC-PDL object statistics.RPL
Involved in project documentation @INC-PDL picture actions.RPL
Involved in project documentation @INC-PDL picture attributes.RPL
Involved in project documentation @INC-PDL picture direct interconnections.RPL
Involved in project documentation @INC-PDL picture drawing.RPL
Involved in project documentation @INC-PDL picture embedded objects.RPL
Involved in project documentation @INC-PDL picture single action.RPL
Involved in project documentation @INC-PDL picture statistics.RPL
Involved in project documentation @INC-PDLOBJ object actions.RPL
Involved in project documentation @INC-PDLOBJ object attributes.RPL
Involved in project documentation @INC-PDLOBJ object direct interconnections.RPL
Involved in project documentation @INC-PDLOBJ object single action.RPL
Involved in project documentation @INC-PDLOBJ object statistics.RPL
Involved in project documentation @PDL object actions.RPL
Involved in project documentation @PDL object attributes.RPL
Involved in project documentation @PDL object direct interconnections.RPL 
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Name of the Print Job Layout name

Involved in project documentation @PDL object statistics.RPL
Involved in project documentation @PDL picture actions.RPL
Involved in project documentation @PDL picture attributes.RPL
Involved in project documentation @PDL picture direct interconnections.RPL
Involved in project documentation @PDL picture drawing.RPL
Involved in project documentation @PDL picture embedded objects.RPL
Involved in project documentation @PDL picture statistics.RPL
Involved in project documentation @PDLOBJLT.RPL
Involved in project documentation @PDLPICLT.RPL
Involved in project documentation @ptmcs (landscape).RPL

 

Note

The system print jobs provided with WinCC can be neither deleted nor renamed. These 
system print jobs have fixed associations with the applications.

 

7.8.2 System Layouts and Print Jobs for Runtime Documentation

Introduction
WinCC provides you with a number of system layouts that have fixed associations with print 
jobs and are used to log Runtime data. 

Print Jobs and Layouts in the Basic WinCC System

Name of the Print Job Function of the Print Job Layout name

@AlarmControl - Picture Output of the current display of the 
AlarmControl in Runtime (WinCC V7 or 
higher).

@Alarm Control - Picture.RPL

@AlarmControl - Table Output of all messages of the select list in a 
table from the AlarmControl in Runtime 
(WinCC V7 or higher).

@Alarm Control - Table.RPL

@FunctionTrendControl - Picture Output of the current display of the 
FunctionTrendControl in Runtime (WinCC V7 
or higher).

@Function Trend Control - 
Picture.RPL

@OnlineTableControl - Picture Output of the current display of the 
OnlineTableControl in Runtime (WinCC V7 or 
higher).

@Online Table Control - 
Picture.RPL
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Name of the Print Job Function of the Print Job Layout name

@OnlineTableControl - Table Output of all values in a table from the 
OnlineTableControl in Runtime (WinCC V7 or 
higher).

@Online Table Control - 
Table.RPL

@OnlineTrendControl - Picture Output of the current display of the 
OnlineTrendControl in Runtime (WinCC V7 or 
higher).

@Online Trend Control - 
Picture.RPL

@RulerControl - Picture Output of the current display of the 
RulerControl in Runtime (WinCC V7 or higher).

@Ruler Control - Picture.RPL

@RulerControl - Table Output of all values in a table by the 
RulerControl in Runtime (WinCC V7 or higher).

@Ruler Control - Table.RPL

@UserArchiveControl - Picture Output of the current display of the 
UserArchiveControl in Runtime (WinCC V7 or 
higher).

@User Archives Table Control 
- Picture.RPL

@UserArchiveControl - Table Output of all values in a table from the 
UserArchiveControl in Runtime (WinCC V7 or 
higher).

@User Archives Table Control 
- Table.RPL

@Report OnlineTableControl-CP Output the tables of Online Table Control in 
Runtime (WinCC V6.2 or higher).

@CCOnlineTableCtrl-CP.RPL

@Report FunctionTrendControl-CP Output the trend of Function Trend Control in 
Runtime (WinCC V6.2 or higher).

@CCFunctionTrendCtrl-
CP.RPL

@Report OnlineTrendControl-Curves-CP Output the Online Trend Control trends in 
Runtime (from WinCC V6.2 onwards; replaces 
the @Report Curve Control Contents as 
standard print job).

@CCOnlineTrendCtrl-Curves-
CP.RPL

@Report AlarmControl-CP Output the messages of Alarm Trend Control 
in Runtime (WinCC V6.2 or higher).

@CCAlarmCtrl-CP.RPL

@Report Alarm Logging RT Message 
Sequence

Output the message sequence report on a line 
printer (WinCC V5.0 SP2 or higher).

@CCAlgRtSequence.RPL

@Report Alarm Logging RT Revolving 
archive

Output the revolving archive          
(prior to WinCC V5.0 SP2).

@ALRtUmA.RPL

@Report Alarm Logging RT Sequence 
archive

Output the revolving archive          
(prior to WinCC V5.0 SP2).

@ALRtFoA.RPL

@Report Alarm Logging RT 
OnlineMessages

Output the current messages @CCAlgRtOnline 
Messages.RPL

@Report Alarm Logging RT Sequence 
archive New

Output the Revolving sequence          
(from WinCC V5.0 SP2).

@CCAlgRtSequence 
Archive.RPL

@Report Alarm Logging RT Short Term 
archive New

Output the Revolving sequence          
(from WinCC V5.0 SP2).

@CCAlgRtShortTerm Archiv 
e.RPL

@Report Curve Control Contents         Is started internally and is based on a CSV 
Provider (from WinCC V6.2 onwards as 
standard print job, replaced by @Report 
OnlineTrendControl-Curves-CP).

@CCCurveControlContents 
(P).RPL

@Report Table Control Contents         Is started internally based on a CSV Provider. @CCTableControlContents 
(P).RPL

@Report Tag Logging RT Curves New Output Tag Logging Trends in Runtime (from 
WinCC V5.0 SP2).

@CCTlgtRtCurves.RPL

@Report Tag Logging RT Tables New Output Tag Logging Tables in Runtime (from 
WinCC V5.0 SP2).

@CCTlgRtTables.RPL
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Print Jobs and Layouts of the WinCC Option Basic Process Control

Name of the Print Job Function of the Print Job Layout name

@Report Alarm Logging RT 
OnlineMessages New

Output messages of the 
New List

@CCAlgRtOnlineMessagesNew.RP
L (P)

@Report Alarm Logging RT 
OnlineMessages Old

Output messages of the 
Old List 

@CCAlgRtOnlineMessagesOld.RPL 
(P)

@Report Alarm Logging RT 
OnlineMessages Gone

Output messages of the 
Gone Out List

@CCAlgRtOnlineMessagesGone.R
PL (P)

@Report Alarm Logging RT 
OnlineMessages Hidden

Output of Hidden 
Messages

@CCAlgRtOnlineMessagesHidden.
RPL (P)

@Report Alarm Logging RT 
Sequence archive Journal

Output messages of the 
Journal List

@CCAlgRtSequenceArchiveJournal.
RPL (P)

@Report Alarm Logging RT 
Sequence archive Operation

Output messages of the 
Operation List

@CCAlgRtSequenceArchiveOperati
on.RPL (P)

@Report Alarm Logging RT 
Sequence archive Process

Output messages of the 
Process List

@CCAlgRtSequenceArchiveProcess
.RPL (P)

@Report Asset Faceplate Output diagnosis results 
of Faceplates

@AssetFaceplate.RPL (P)

 

Note

The system print jobs provided with WinCC can be neither deleted nor renamed. These 
system print jobs have fixed associations with the applications.

7.8.3 Filter criteria for alarm output

Introduction
When the selection criteria are transferred from the selection dialog, the filter criteria for alarm 
output are transferred to the Filter Criteria for Alarm Output area. The filter criteria can be edited.
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The following conditions apply to WinCC: 
● The structure consists of the elements Field, Operand and Value, with the individual 

parameters separated by blanks.         
Example: DATETIME >= '2006-12-21 00:00:00' AND MSGNR >= 100 (all messages as of 
21.12.2006 with a message number greater than and equal to 100)

● Strings, date, and time must be passed in single quotation marks.

● In the DATETIME argument, the date and time of day are separated by a blank. Regardless 
of the time base setting in the object properties, the output of DATETIME is based on the 
time base Local Time. Exception: UTC is set as the time base: in this case, the output is 
based on time base UTC.

Permissible Arguments:

Name Type data Example:

DATETIME Date 'YYYY-MM-DD 
hh:mm:ss.msmsms'

DATETIME >= '2007-05-03 
16:00:00'         
Output of message from 
05.03.2007          
16:00 hours.

MSGNR Integer Message number MSGNR >= 10 AND MSGNR <= 
12         
Output of messages with          
message number 10 -12.

CLASS 
IN         
AND         
TYPE IN

Integer - Message class ID 1-16 and 
system message classes 17 
+ 18
- Message type ID 1-256 and 
system message types 257, 
258, 273, 274

CLASS IN ( 1 ) AND TYPE IN 
( 2 )         
Output of messages of message class 
1          
message type 2.
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Name Type data Example:

STATE Integer Value of         
ALARM_STATE_xx         
Only the operands          
"=" and "IN(...)" are          
permitted         
         
ALARM_STATE_1         
ALARM_STATE_2         
ALARM_STATE_3         
ALARM_STATE_4         
ALARM_STATE_5(*)         
ALARM_STATE_6(*)         
ALARM_STATE_7(*)         
ALARM_STATE_10         
ALARM_STATE_11         
ALARM_STATE_16         
ALARM_STATE_17

STATE IN(1,2,3)         
Output of all message that came in, 
went out and were 
acknowledged.         
         
Possible values:         
1 = Came In messages         
2 = Went Out messages         
3 = acknowledged messages         
4 = locked message         
5 = released messages         
6 = messages that came in and have 
been acknowledged          
7 = messages that came in and went 
out         
10 = hidden messages         
11 = displayed messages         
16 = messages acknowledged by the 
system         
17 = emergency-acknowledged 
messages
(*) The "ALARM_STATE_5", 
"ALARM_STATE_6" and 
"ALARM_STATE_7" states can only 
be output via the "Alarm Logging 
Runtime" layout. These states cannot 
be selected in the AlarmControl.

PRIORITY Integer Message priority 0 - 16 PRIORITY >= 1 AND PRIORITY =< 5
Outputs messages that have a priority 
between 1 and 5.

AGNR Integer PLC number AGNR >= 2 AND AGNR <= 2         
Output of messages with          
AG number = 2.

AGSUBNR Integer AG sub-number AGSUBNR >= 5 AND AGSUBNR <= 
5
Outputs messages with AG sub-
number 5.

TEXTxx Text Search text for          
'Text1'-'Text10'

TEXT2 = "Error"
Outputs the messages whose Text2 
corresponds with "Error".
TEXT2 IN ('Error','Fault')
Outputs the messages whose Text2 
corresponds with the text "Error" or 
"Fault".
TEXT2 LIKE 'Error'
Outputs the messages whose Text2 
includes the text "Error".

PVALUExx Double Search text for          
PVALUE1-         
PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 
50         
Output of process value 1 with          
start value 0 and stop value 50.
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The following operands are permissible:

>= , <= , = , > , < ,IN(...),LIKE
IN(...): several values in Array separated by commas, e.g. CLASS IN( 1 ,2 ,3 ) AND TYPE 
IN( 1 ,2 ,19 ,20 ,37 ,38 )

LIKE: Text must contain string, e.g.: TEXT1 LIKE 'Error' relays message where Text1 contains 
the search text Error.

The operand LIKE is only permissible for TEXT arguments.

Arguments and operands other than those mentioned above are not permissible.
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Creating Page Layouts 8
8 Resources

8.1 Creating Page Layouts

Content
The page layout editor is a component of the Report Designer and is used to create and 
dynamize page layouts for the output of reports. The page layout editor can only be used for 
the project currently open in the WinCC Explorer. The layouts are saved are the basis of their 
projects.

This online help will show you

● how to set up the page layout editor

● how to create and edit page layouts

● how to use objects in the object palette

● how to adapt the object properties to the requirements of your project

how to change the output options for reports and logs

8.2 How to Start the Page Layout Editor

Introduction
The page layout editor can be opened in several standard Windows ways. The page layout 
editor can only be used for the project currently open in the WinCC Explorer.

Requirement
● A project must be opened in WinCC Explorer.

Opening the Page Layout Editor
The page layout editor is called from the WinCC Explorer. The following options are available:

Navigation Window/Data Window of WinCC Explorer:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.
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Double-click the "Layouts" entry in the navigation window or select "Layouts" in either the 
navigation or data windows in WinCC and select "Open Page Layout" from the context menu.

The page layout editor is started and a new layout is opened.

WinCC Explorer Data Window:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.

In the navigation window, select "Layouts". The available layouts are displayed in the data 
window. Double-click a page layout or select "Open Page Layout" from the context menu.

The page layout editor starts and the selected page layout is opened.

See also
The Page Layout Editor (Page 1520)

8.3 The Page Layout Editor

8.3.1 The Page Layout Editor

Introduction
The page layout editor offers objects and tools for creating page layouts. Start the page layout 
editor in WinCC Explorer.

Structure of the Page Layout Editor
The page layout editor follows the conventions set by Windows. It possesses a workspace, 
toolbars, menu bar, status bar and various palettes. After opening the page layout editor, the 
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workspace is displayed with the default settings. You can arrange the palettes and bars to your 
liking and also hide them.

(1) The Workspace
The gray area represents the printable area, the white area the page body. Each screen in the 
workspace represents a layout and is saved as a separate rpl file. The layouts can be enlarged 
and reduced according to the Windows standard.

(2) The Menu Bar
The menu bar is always visible. Depending on the context, the functions in the menus are 
active or inactive.

(3) The Toolbar
The toolbar provides buttons to quickly perform common commands of the page layout editor. 
The toolbar can be hidden if required or moved to any location on the screen.
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(4) The Font Palette
The font palette is used to change font type, size and color of text objects as well as the line 
color of standard objects.

(5) The Object Palette
The object palette contains the standard objects, objects for the runtime documentation, COM 
server objects and objects for the project documentation. The objects are used to form a layout.

(6) The Style Palette
The style palette is used to change the appearance of a selected object. Depending on the 
object, the line type, line strength or fill pattern can be changed.

(7) The Alignment Palette
The alignment palette is used to change the absolute position of one or more objects, change 
the position of selected objects relative to each other or unify the height and width of several 
objects.

(8) The Zoom Palette
The zoom palette offers two options to enlarge or reduce the objects of the active layout: either 
via buttons of the standard zoom factors or via a slider.

(9) The Color Palette
The color palette is used to color selected objects. In addition to the 16 standard colors, custom 
colors can be defined.

(10) The Status Bar
The status bar is located at the bottom of the screen and can be hidden if required. Among 
other things, it displays tips, information about the position of the selected objects and the 
keyboard setting.
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See also
The Alignment Palette (Page 1533)

The Status Bar (Page 1538)

The Color Palette (Page 1536)

The Zoom Palette (Page 1535)

The Style Palette (Page 1533)

The Object Palette (Page 1525)

The Font Palette (Page 1537)

The Standard Toolbar (Page 1523)

8.3.2 The Standard Toolbar

Usage
The toolbar is located in its default position under the menu bar, on the upper edge of the page 
layout editor. The buttons arranged on the toolbar allow quick and comfortable access to the 
offered functionality of the page layout editor.

Contents
The standard toolbar contains buttons with the following functions:

Button Function Key combination

Creates a new page layout. <CTRL+N>

Opens an existing page layout. <CTRL+O>

Saves the current page layout. <CTRL+S>

Cuts out the highlighted object (text or drawing object) and copies 
it to the clipboard. Therefore the function is only available when an 
object is highlighted.

<CTRL+X>

Copies the highlighted object (text or drawing object) to the 
clipboard. Therefore the function is only available when an object 
is highlighted

<CTRL+C>

Pastes the contents of the clipboard at the location of the cursor. 
This function is only available, when the clipboard is not empty.

<CTRL+V>

Undoes the last actions (maximum of 30). This function is only 
available when an action has been carried out.

<CTRL+Z>

Redoes the last undone action. This function is only available when 
an action has been undone.

<CTRL+A>
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Button Function Key combination

Prints the contents of the current page layout. Therefore, the 
function is only available when a page layout is open.

<CTRL+P>

Makes the static part of a layout active and the dynamic part 
inactive. If the static part is already active, it remains active. The 
static part can be individually defined for the cover sheet, the 
succeeding pages and for the closing page. The same static part 
will be repeated on all of the succeeding pages.

-

Makes the dynamic part of a layout active and the static part 
inactive. If the dynamic part is already active, it remains active.

-

Makes the cover sheet of a layout active and the contents of the 
report and the closing page inactive. If the cover sheet page type 
is already active, it remains active.

-

Makes the report contents of a layout active and the cover sheet 
and closing page inactive. If the report contents page type is 
already active, it remains active.

-

Makes the closing page of a log active and the cover sheet and 
report contents inactive. If the closing page page type is already 
active, it remains so.

-

Puts the highlighted objects in the layer in the foreground of the 
layout. The objects in the foreground cover objects which lie under 
them.

-

Puts the highlighted objects in the layer in the background of the 
layout. Objects in the background are covered by objects lying in 
front of them.

-

Switches the grid in the active window on or off. -

Switches the "Snap to Grid" function on or off. -

Increases the zoom factor in steps of 50%; the layout is shown 
enlarged. This function is only active until the largest zoom factor 
(400%) has been reached.

-

Decreases the zoom factor in steps of 50%; the layout is shown 
smaller. This function is only active until the smallest zoom factor 
(6.25%) has been reached.

-

Zooms to any picture section you choose. This will be adjusted to 
fit the picture window.

-

Copies the properties of an object to apply them to another object. -

Applies the previously copied properties of an object to another 
object. The function is only active when properties have been 
previously copied.

-

Opens a window in which the properties of the highlighted object 
or object group are displayed.

-

Activates the direct help (What's this?). <SHIFT+F1>

Characteristics
The toolbar can be hidden or shown. It can be attached under the menu bar. When it is not 
attached it can be positioned anywhere on the screen with the mouse.
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See also
How to Change the Standard Toolbar (Page 1541)

How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.3 The Object Palette

8.3.3.1 The Object Palette

Usage
The object palette contains object types that can be inserted into the page layout. Static objects 
and system objects are available for the visual construction of the page layout. Dynamic objects 
are available for data output.

Contents
The objects in the object palette can be summarized in the following 4 object groups:

● Standard objects: static objects, dynamic objects and system objects

● Objects of the runtime documentation: for example Alarm Logging RT, user archive runtime, 
CSV provider,etc.

● COM server objects

● Project documentation objects: for example actions in the Graphics Designer, Alarm 
Logging CS, Global Script, etc.

Operation
Click one of the tabs and select the object you want.

Characteristics
The object palette can be shown and hidden. It can be moved anywhere on the screen with 
the mouse.
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See also
Standard Objects (Page 1526)

Objects for the Project Documentation (Page 1532)

COM Server Objects (Page 1531)

Objects for the Runtime Documentation (Page 1529)

8.3.3.2 Standard Objects

Standard Objects

Usage
Standard objects contain object types that are used to visually construct the page layout. 
Dynamic object types can also be used for this, unlike objects for runtime documentation and 
project documentation, which are not connected to the WinCC components.

Overview
Standard objects can be divided into three object classes:

● Static objects are used for the visual creation of a page layout. You can insert static objects 
into both the static and dynamic parts of a page layout.

● Dynamic objects can be connected with data sources which have a valid data format for 
the current object. That way these data can be output in a WinCC layout. You can only 
insert dynamic objects in the dynamic part of the page layout.

● System objects are used as placeholders for the system time, the current page number 
and the project and layout names. You can only use system objects in the static part of the 
page layout. The required entries are described in the "Format" attribute in the 
"Miscellaneous" property of the system object.

Shared Properties
● The object properties (e.g. geometry, color) of the individual standard objects are preset. 

However, these defaults can be changed. The objects are displayed with the standard 
object properties.

● The properties of the displayed objects can be changed at any time.
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See also
How to Change an Attribute (Page 1576)

Working with Standard Objects (Page 1589)

Overview of the System Objects (Page 1529)

Overview of the Dynamic Objects (Page 1528)

Overview of the Static Objects (Page 1527)

Overview of the Static Objects

Introduction
Static objects are used for the visual creation of a page layout. You can insert standard objects 
in both the static and dynamic parts of a page layout.

Overview

Icon Object Description

Line The line is an open object. The length and angle of a line are determined 
by the height and width of the rectangle around the object.

Polygon The polygon is a closed object that can be filled with a color or pattern. 
A polygon can have any number of corner points; these are numbered 
in the order of their creation and can be changed individually, or even 
deleted.

Polyline The polyline is an open object. Even if the start and finish point have 
the same coordinates, the area cannot be filled. A polyline can have 
any number of corner points; these are numbered in the order of their 
creation and can be changed individually, or even deleted.

Ellipse The ellipse is a closed object that can be filled with a color or pattern. 
The height and width of an ellipse can be modified as desired to allow 
it to be aligned horizontally or vertically.

Circle A circle is a closed object that can be filled with a color or pattern. A 
circle can be resized at will.

Ellipse segment The ellipse segment is a closed object that can be filled with a color or 
pattern. The height and width of an ellipse segment can be modified 
as desired to allow it to be aligned horizontally or vertically.

Pie segment The pie segment is a closed object that can be filled with a color or 
pattern. A pie segment can be resized at will.

Ellipse arc The ellipse arc is an open object. The height and width of an ellipse arc 
can be modified as desired to allow it to be aligned horizontally or 
vertically.

Circular arc The circular arc is an open object. A circular arc can be resized at will.

Rectangle The rectangle is a closed object that can be filled with a color or pattern. 
The height and width of a rectangle can be modified as desired to allow 
it to be aligned horizontally or vertically.
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Icon Object Description

Rounded 
rectangle

The rounded rectangle is a closed object that can be filled with a color 
or pattern. The height and width of a rounded rectangle can be modified 
as desired to allow it to be aligned horizontally or vertically. The corners 
of a rounded rectangle can rounded as much as desired.

Static text The field for static text is a closed object that can be filled with a color 
or pattern. The static text is entered into a field of any desired size. The 
text can be entered on one or more lines.

OLE object You can import the contents of a file or new object into a layout with 
any data type, e.g. an Adobe Acrobat document.

Static metafile You can insert graphic data into a layout with the "Static Metafile" 
object. The graphic files must be in the *.emf (Enhanced Meta File) 
format.

See also
Overview of the System Objects (Page 1529)

Overview of the Dynamic Objects (Page 1528)

Standard Objects (Page 1526)

Overview of the Dynamic Objects

Introduction
With dynamic objects, you can set the data you want to output in a report/log from different 
data sources. You can only insert dynamic objects in the dynamic part of the page layout. 

Overview

Icon Object Description

Embedded layout Layouts for the project documentation can be nested with the 
"Embedded Layout" dynamic object. The object is only used for the 
project documentation in ready-made layouts for WinCC.

Hard copy With the "Hard Copy" object type, you can output a picture of the 
current screen, contents or a defined section of it, in a log. You can 
also output a currently selected picture window.

ODBC database 
field

With the "ODBC Database Field" object type, you can output texts 
from some data sources into a log via the ODBC interface.

ODBC database 
table

With the "ODBC Database Table" object type, you can output tables 
from some data sources into a log via the ODBC interface.

Tag Output the "Variable" values in runtime with the Tag object type. Tag 
values can only be output if the project is activated. In runtime you can 
also call a script for the output.
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See also
Overview of the System Objects (Page 1529)

Overview of the Static Objects (Page 1527)

Standard Objects (Page 1526)

Overview of the System Objects

Introduction
System objects are used as placeholders for the system time, current page number of the 
report and project and layout names. You can only use system objects in the static part of the 
page layout.

Overview

Icon Object Description

Date/time Insert a placeholder for the date and time of the output in the page layout 
with the "Date/Time" system object. During printing, the system date and 
time are added by the computer.

Page number Insert a placeholder for the current page number of the report or log in 
the page layout with the "Page Number" system object.

Project name Insert a placeholder for the project name in the page layout with the 
"Project Name" system object.

Layout name Insert a placeholder for the layout name in the page layout with the 
"Layout Name" system object.

See also
Standard Objects (Page 1526)

Overview of the Static Objects (Page 1527)

Overview of the Dynamic Objects (Page 1528)

8.3.3.3 Objects for the Runtime Documentation

Application
The runtime documentation objects are for outputting logs of the runtime data. The output 
options can be configured using the "Object Properties" dialog. The data for the logs are taken 
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from the linked data sources at the time of the output. You can only insert the runtime 
documentation objects in the dynamic part of the page layout.

Overview

Object Description

Alarm Logging RT 
Archive Log

The "Archive Report" object is connected to the message system and outputs 
the messages saved in the message archive to a table.

Alarm Logging RT 
Message Log

The "Message Report" object is connected to the message system and outputs 
the current messages in the message list to a table.

User archive 
Runtime          
Table

The "User Archive Runtime Table" object is connected to the User Archive and 
outputs the runtime data from the user archives and views to a table.

CSV provider table The "CSV Provider Table" object can be linked to a CSV file. The data contained 
in the file are output to a table. The data must be in a predefined structure.

CSV Provider         
Trend

The "CSV Provider Trend" object can be linked to a CSV file. The data contained 
in the file are output in a curve. The data must be in a predefined structure.

WinCC Alarm 
Control         
Table

The "WinCC Alarm Control/Table" object is used to output the message lists in 
a tabular format. You configure the static and dynamic parameters of the control 
for the output in Reports Designer.

WinCC Control 
Runtime 
Printprovider         
Table

The entire contents of the table of a WinCC control is output in the table. The 
report object is not available for the WinCC OnlineTrendControl and WinCC 
FunctionTrendControl. The report can only be output via the button in the 
WinCC control.

WinCC Control 
Runtime 
Printprovider         
Picture

The current control display is output in the picture. The report can only be output 
via the button in the WinCC control.
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Object Description

WinCC Function 
Trend Control         
Picture

The "WinCC Function Trend Control/Picture" object is used to output process 
data as function of another tag from the process value, compression and user 
archives in the form of a trend. You configure the static and dynamic parameters 
of the control for the output in Reports Designer.

WinCC Online Table 
Control         
Table

The "WinCC Online Table Control/Table" object is used to output process data 
from the associated process value archives and compressed archives in a 
tabular format. You configure the static and dynamic parameters of the control 
for the output in Reports Designer.

WinCC Online Trend 
Control         
Picture

The "WinCC Online Trend Control/Picture" object is used to output process data 
from the associated process value archives and compressed archives in trend 
curve format. You configure the static and dynamic parameters of the control 
for the output in Reports Designer.

Common features
● The object properties (e.g. font) of the individual objects are preset. However, these defaults 

can be changed. The objects are displayed with the default object properties.

● The properties of the displayed objects can be changed at any time.

See also
How to Change an Attribute (Page 1576)

Working with Objects for the Project Documentation (Page 1666)

Working with Objects for the Runtime Documentation (Page 1634)

8.3.3.4 COM Server Objects

Usage
In order to use a COM server object, a COM server projector must be integrated into WinCC. 
This COM server makes the object for logging data available. This way, it is possible to 
integrate user-specific data in a WinCC log. The form and properties of a COM server object 
are determined by the COM server writer. The description of the COM server object is delivered 
with the COM server writer. The options for selecting the output data are determined by the 
current COM server object. The COM server objects can only be inserted into the dynamic 
part of a page layout. Additional information can be found in chapter "Working with COM Server 
Objects".
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8.3.3.5 Objects for the Project Documentation

Usage
The project documentation objects are provided for the report output of configured data. The 
objects for project documentation can only be inserted into the dynamic part of a page layout.

The objects for project documentation are closely connected with the WinCC components. 
The object types are fixed. Depending on the type and size of the configuration data for the 
output, the "Static Text", "Dynamic Metafile" or "Dynamic Table" object types are used. A 
detailed description of the objects used and the output data can be found in chapter "Outputting 
Project Documentation". 

For some of the objects used with the "Dynamic Metafile" and "Dynamic Table" object types, 
you can change the selection of the configuration data for output. Additional information can 
be found in chapter "Working with Objects for Project Documentation".

Shared Properties
● The object properties (e.g. font) of the individual objects are preset. However, these defaults 

can be changed. The objects are displayed with the default object properties.

● The properties of the displayed objects can be changed at any time.

See also
How to Change an Attribute (Page 1576)

Working with Objects for the Runtime Documentation (Page 1634)

Working with Objects for the Project Documentation (Page 1666)
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8.3.4 The Style Palette

Usage
The line type, line weight and background pattern of the selected object can be changed with 
the style palette. Depending on the object type, different style forms are available.

Contents
● The "Line Type" style group contains different line types, such as dashed, dotted, etc.

● The "Line Weight" style group contains different line weights. The line weight is given in 
pixels. 1 mm = 4.73 pixels.

● The "Fill Pattern" style group contains fill patterns for the background of closed objects, 
such as transparent, checkered, diagonal lines, etc.

Displaying the Current Settings
The currently selected settings are displayed in "bold" font.

Characteristics
The style palette can be shown or hidden. It can be placed anywhere on the screen with the 
mouse. 

See also
How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.5 The Alignment Palette

Usage
The alignment palette is used to:

● change the absolute position of one or more objects

● change the position of the selected objects relative to one another

● align the heights and widths of several objects.
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Requirements
The palette buttons are enabled when at least two objects are highlighted.

Overview

Button Function

Align objects left.         
The type of selection determines which object is used as reference for 
alignment.          
If the objects are selected with a selection frame (lasso), the object lying farthest out 
will be used as reference. If the objects are selected with the left mouse button, the 
object selected first will be used as reference for alignment.
Align objects right.          
See section "Align Objects Left" to determine which object will be used as reference for 
alignment.
Align objects top.         
See section "Align Objects Left" to determine which object will be used as reference for 
alignment.
Align objects bottom.         
See section "Align Objects Left" to determine which object will be used as reference for 
alignment.
Align objects on horizontal center.         
The objects are moved to be aligned along a common central horizontal axis.
Align objects on vertical center.          
The objects are moved to be aligned along a common central vertical axis.
Distribute objects evenly in horizontal direction.         
The objects maintain the same horizontal distance from one another.. The location of 
the outer objects remains unchanged.
Distribute objects evenly in vertical direction.         
The objects maintain the same vertical distance from one another.. The position of the 
upper and lower objects remains unchanged.
Standardize width of objects.          
If the objects were selected with the left mouse button, they receive the width of the first 
object selected. The width of lines remains however unchanged.         
If the objects were selected using a selection frame (lasso), the widths will be adjusted 
to the largest width in the group.
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Button Function

Standardize heights of objects.         
If the objects were selected with the left mouse button, they receive the height of the 
first object selected.         
If the objects were selected using a selection frame (lasso), the heights will be adjusted 
to the largest height in the group.
Standardize width and height of objects.         
The objects receive the width and height of the first object configured in the group.

Characteristics
The alignment palette can be show and hidden. It can be placed anywhere on the screen with 
the mouse. 

See also
How to Select Multiple Objects (Page 1567)

How to Align Multiple Objects (Page 1568)

How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.6 The Zoom Palette

Usage
The zoom factor for the objects in the active layout is set with the zoom palette. The current 
zoom factor is displayed under the slider. The zoom palette offers two options for enlarging or 
reducing the objects:

● using buttons with standard zoom factors (e.g. 8, 1/2)

● using a slider.

Characteristics
The zoom palette can be shown and hidden. It can be placed anywhere on the screen with 
the mouse. 
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Note

The zoom factor can also be set incrementally using the   and button in the standard 
toolbar.

See also
How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.7 The Color Palette

Usage
Selected objects can be assigned one of the 16 standard colors, a primary color or a self-
defined color with the color palette. For example, one mouse click in the color palette can 
change:

● the fill color for area objects (e.g. rectangle),

● the line color for line objects (e.g. polyline),

● the background color of text objects.

Characteristics
The color palette can be shown and hidden. It can be placed anywhere on the screen with the 
mouse.
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See also
The Colors Property Group (Page 1579)

How to Create Custom Colors (Page 1539)

How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.8 The Font Palette

Usage
A new text object or another object which contains text will be created with preset text 
properties. The font palette contains tools for changing the font, size and color of text objects, 
as well as the line color of standard objects, at any time. 

Overview

Button Description

Changing font

Change font size

Change font color

Change line color.         
For area objects, this function influences the color of the borderline 
and for line objects it influences the line color.

Characteristics
The font palette can be shown and hidden. It can be placed anywhere on the screen with the 
mouse.

Note

Additional text properties, such as orientation, italic, bold, underline, are changed in the 
"Object Properties" window.
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See also
The Font Property Group (Page 1584)

How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.9 The Status Bar

Usage
The status bar provides you with the following information:

● help text for a selected functions, menu commands and buttons

● information about the name, position and size of a highlighted object

● information about the keyboard status (e.g. the NUM LOCK key).

Characteristics
The status bar can be shown or hidden.

See also
How to Show and Hide the Toolbar and Palettes (Page 1540)

8.3.10 Customizing the Working Environment

8.3.10.1 Customizing the Working Environment

Operator Elements of the Page Layout Editor
You can adjust the following operator elements to your personal needs:

● The toolbars can be shown and hidden.

● Icons can be added to and removed from the standard toolbar.

● Changes to the standard toolbar can be blocked or allowed.

● Toolbars and palettes can be arranged elsewhere on the screen.

● The appearance of the toolbar can be changed.

● The display of the keyboard shortcuts in the menus can be switched off.
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Basic Page Layout Editor Settings
You can adjust the following functions in the page layout editor to your personal needs:

● Snap objects to the grid or not

● Hide or show the grid

● Grid width and height in pixels, centimeters or inches

● Defining the type of object selection surrounding or touching

● Object types in the object palette can be selected or deselected according to the insertion 
of an object

● Configuration settings for the page layout editor can be saved or not when quitting the 
program

● Storage type and path for the objects' default settings

See also
The Basic Settings of the Page Layout Editor (Page 1543)

How to Change the Appearance of the Toolbar and Palettes (Page 1546)

How to Change the Standard Toolbar (Page 1541)

How to Arrange the Toolbar and Palettes (Page 1540)

How to Show and Hide the Toolbar and Palettes (Page 1540)

8.3.10.2 How to Create Custom Colors

Introduction
In addition to the 16 basic colors from the Color Palette, you are free to define other colors.

Procedure
1. On the Color Palette, click . The "Colors" dialog is opened.

2. Click the primary color that comes closest to the color to be created.

3. To change the selected color, open the color matrix using the "Define Colors" button.

4. Change the brightness of the selected color with the slider to the right of the color matrix.

5. Change the saturation of the selected color by vertically moving the cross.
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6. Change the color by horizontally moving the cross.

7. To define the properties of the color more precisely, enter the values for the color, 
saturation, brightness, and the red, green and blue amounts.

8. To accept the color in the user-defined palette, click the "Add Colors" button.

9. Close the dialog by clicking "OK". The newly defined color is saved.

See also
The Colors Property Group (Page 1579)

The Color Palette (Page 1536)

8.3.10.3 How to Show and Hide the Toolbar and Palettes

Introduction
Normally, the standard toolbar and palettes are shown. In order to obtain a larger working area, 
you can hide palettes that you do not need and the standard toolbar and show them again as 
required.

Procedure
1. Open the "View" menu and select the "Toolbars..." option. The "Toolbars" dialog is opened.

2. Clear the check box for the toolbar to be hidden. Alternatively, select the check box for the 
toolbar to be shown.

3. If the dialog should remain open so that you can make additional settings on other tabs, 
click "Apply".

4. If you would like to restore the most recently saved settings, click the "Restore" button.

5. Apply the new settings with "OK". The settings will be saved and the dialog is closed.

See also
How to Change the Appearance of the Toolbar and Palettes (Page 1546)

How to Change the Standard Toolbar (Page 1541)

How to Arrange the Toolbar and Palettes (Page 1540)

8.3.10.4 How to Arrange the Toolbar and Palettes

Introduction
The standard toolbar and the palettes are normally arranged along the edge of the screen. 
You can remove them from their anchoring, change their size and move them anywhere you 
like. The toolbar and palettes can be reanchored in any location.
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Special features
● The size of a palette can only be changed when it is not anchored.

● When you reanchor a palette, its size will not be adjusted to the free space on the edge of 
the screen. Therefore, you must adjust the size of the palette to fit the free space before 
anchoring it.

● When you close the page layout editor, the changed palette positions are saved and used 
again the next time the program is started.

How to Undock the Palette
1. Click on the narrow, outer edge of the palette, hold down the mouse button and drag the 

palette into the working area. Now you can resize the palette as desired in the normal 
Windows way.

Procedure for Restoring the Original Position
1. Open the toolbar dialog by selecting the menu "View" > "Toolbars...".

2. Click the "Restore" button.

Procedure for Docking the Palette
1. Adjust the size of the palette to the free space on the edge of the screen.

2. Click on the title bar of the palette, hold down the mouse button and drag the palette to the 
free space on the edge of the screen. The position of the cursor determines the place where 
the palette will be anchored. If the palette is to be moved between two others, the cursor 
should be placed on the lower edge of the upper palette.

Note

The changes in position can be undone, so long as the page layout editor is open; changes 
you have made will be saved when the program is closed.         
 

See also
How to Change the Appearance of the Toolbar and Palettes (Page 1546)

How to Show and Hide the Toolbar and Palettes (Page 1540)

8.3.10.5 How to Change the Standard Toolbar

Application
You can use drag and drop to adjust the standard toolbar to your requirements, that is adding, 
removing or rearranging buttons. 
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Requirements
On the "Menu/Toolbars" tab in the "Settings" window of the "Tools" menu, all of the checkboxes 
in the "Standard Toolbar" area must be marked.

Procedure for Removing Buttons
1. Hold down the "Alt" key.

2. Use the mouse to drag the button from the toolbar.

Procedure for moving buttons
1. Hold down the "Alt" key.

2. Use the mouse to drag the button to another place on the toolbar.

Procedure for Adding/Removing Buttons
1. Hold down the "Alt" key.

2. Double-click a button. The "Customize Toolbar" window opens.

3. Add: Drag the desired button from the Available buttons list to the Current Buttons 
list.         
Remove: Drag the desired button from the Current Buttons list to the Available Buttons list.

4. Set the order of the buttons on the toolbar using the "Move up" and "Move down" buttons 
in this dialog.

5. You can restore the original state by clicking on the "Reset" button.

6. The changes will be applied and the dialog closed when you click on the "Close" button.

See also
How to Arrange the Toolbar and Palettes (Page 1540)

How to Show and Hide the Toolbar and Palettes (Page 1540)

How to Change the Appearance of the Toolbar and Palettes (Page 1546)
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8.3.10.6 The Basic Settings of the Page Layout Editor

The Basic Settings of the Page Layout Editor

Usage
In the Settings window, you can make basic settings in order to adjust the appearance and 
behavior of the page layout editor to meet your needs. The settings will be saved and retained 
when you open the page layout editor again.

Calling:
The window can be called

● from the menu Tools > Settings and

● from the menu View > Grid.

Setting Options

Tab Description

Grid This is where you can set: 
● whether the objects should snap to the grid,
● whether the grid should be visible,
● the distance between the grid points

Options This is where the fundamental program settings are changed, for example what should 
happen with altered program settings when the program is closed, or how objects should 
be selected and edited.

Units This is where you choose which units of measurement you would like to use for entering 
the size of coordinates, text height and line width.

Menu / 
Toolbars

This is where the appearance and properties for the menu bar, toolbar and palettes can 
be set, for example whether the standard toolbar should be configurable, whether the 
keyboard shortcuts should be shown, etc.
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See also
How to Paste an Object into a Layout (Page 1562)

How to Set the Options for the configuration settings (Page 1545)

How to Set the Grid (Page 1544)

How to Set the Grid

Usage
In order to be able to work precisely in the working area, you can show a grid on the working 
area with the Display Grid function. If you also have the Snap to Grid function switched on, all 
newly created objects will be automatically aligned to the grid points. 

Possible Settings

Snapping to 
grid

Determines whether the objects should be positioned anywhere on the 
drawing area or aligned to the grid.

Display grid Determines whether the grid should be visible or not. If the grid is invisible, 
objects still align to it when the Snap to Grid option is switched on.

Width in/
Height in

Changes the distance between grid points as necessary. Set the units for the 
size entry in the Units tab. The grid width to be set is oriented to the size and 
variety of objects and to the desired positioning precision.

Procedure
1. Open the Tools menu and select the entry Settings. The Settings dialog opens.

2. Change the individual settings as required by selecting or clearing the check boxes.

3. If you want to keep the dialog open to make changes in other tabs, confirm the changes 
you have made with the Apply button.

4. Save the settings with OK.

Creating Page Layouts
8.3 The Page Layout Editor

MDM - WinCC: Working with WinCC
1544 System Manual, 11/2008,  



Note

The minimum grid separation that can be displayed on the screen is 10 pixels. If you set a 
smaller value (e.g. 6 pixels), you can still align your objects to this grid, but the next even 
numbered multiple of this value > 10 pixels will be displayed on the screen (in this case 12 
pixels).

See also
How to Set the Options for the configuration settings (Page 1545)

How to Change the Appearance of the Toolbar and Palettes (Page 1546)

How to Set the Options for the configuration settings

Usage
On the options tab, you can set whether the configuration settings in this dialog are saved 
when the program is closed. This is also where you can choose the method of selecting objects.

Possible Settings

Save settings on exit Determines whether the settings for the page layout editor are 
saved when the program closes.

Object selection          
Surrounding/touching

Surrounding: A frame will be drawn when the left mouse button 
is held down, so that all objects that are completely within this 
frame will be selected.         
Touching: A frame will be drawn when the left mouse button is 
held down, so that all objects touched by this frame will be 
selected.

Always reset object type 
selection

If this option is enabled, an object will be deselected as soon as 
it is pasted into the layout. If the option is disabled, the object will 
remain selected after it has been pasted into the layout. With this 
method, you can paste the same object several times without 
having to reselect the object.
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Procedure
1. Open the Tools menu and select the entry Settings. The Settings dialog opens.

2. Click the Options tab.

3. Change the individual settings as required by selecting or clearing the check boxes.

4. If you want to keep the dialog open to make changes in other tabs, confirm the changes 
you have made with the Apply button.

5. Save the settings with OK.

See also
How to Change the Appearance of the Toolbar and Palettes (Page 1546)

How to Set the Grid (Page 1544)

How to Change the Appearance of the Toolbar and Palettes

Usage
The appearance of the standard toolbar and the palettes in the page layout editor can be 
adjusted to meet your requirements and preferences. 
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Possible Settings

Flat style for toolbars Determines whether the buttons on the toolbar and palettes are 
displayed with a border or without.

Display move 
handles

Determines whether the buttons on the toolbar and palettes are 
displayed with move handles or without.

Display buttons in the 
menu

Determines whether the buttons on the toolbar will be shown in the 
menus on the menu bar.

Display all shortcuts Determines whether the keyboard shortcuts for the menu commands 
will be shown in the menus on the menu bar.

Deactivated buttons 
in color

Determines whether deactivated buttons on the toolbar and palettes 
are displayed in color or grayed out. 

Standard toolbar: 
customizable

Determines whether the standard toolbar can be changed. If this 
option is enabled, the Toolbar dialog can be opened with [ALT
+double-click].

Standard 
toolbar:         
 Drag&drop with ALT 
key active

If this option is enabled, the icons on the toolbar can be moved or 
removed with the mouse by holding down the ALT key.

Procedure
1. Open the Tools menu and select the entry Settings. The Settings dialog opens.

2. Click the Menu/Toolbars tab.

3. Change the individual settings as required by marking or clearing the check boxes.

4. If you want to keep the dialog open to make changes in other tabs, confirm the changes 
you have made with the Apply button.

5. Save the settings with OK.

See also
How to Change the Standard Toolbar (Page 1541)

How to Arrange the Toolbar and Palettes (Page 1540)

How to Show and Hide the Toolbar and Palettes (Page 1540)

The Standard Toolbar (Page 1523)

How to Set the Options for the configuration settings (Page 1545)

How to Set the Grid (Page 1544)
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8.4 Working with Layouts

8.4.1 Working with Layouts

Introduction
The difference between a layout in the sense of a file and a layout as an object must be clearly 
understood. In this chapter, we will describe dealing with a layout in the form of a file. A layout 
opened in the page layout editor is treated as an object. The layout object has object properties 
and can be edited accordingly. Additional information can be found in the chapter "Working 
with the layout object". 

In this chapter we will show you how to create layouts, display the properties of layouts and 
how to work with several layouts. WinCC comes with several ready-made layouts for most 
standard applications. So it is often simpler and less time consuming to save one of these 
layouts under a new name and adapt it to your own requirements, than to create a new layout.

Note
Language-Neutral and Language-Dependent Layouts

There are language-neutral and language-dependent layouts. Language-neutral layouts 
have the following designation: "<Name of the layout>.rpl". Language-neutral layouts are 
saved in folder "\\<Name of system on which the layout was created>\Project name\PRT".

Language-dependent page layouts contain layout files with the following designation: 
"<Name of the layout>_XXX.rpl". "XXX" stands for the language code of the layout file. The 
language-specific layout file is saved in a language-specific folder in folder "\\<Name of the 
system on which the layout was created>\Project name\PRT". 

Create layout files in all Runtime languages for a language-dependent layout. If the layout 
file of a Runtime language is missing, the English layout file will be used.

The following table shows the language code and the designations of the folders in folder "\
\<Name of the system on which the layout was created>\Project name".

Language Language Code in File Names Language-specific folder

Language-neutral  \PRT
German DEU \PRT\DEU
English ENU \PRT\ENU
French FRA \PRT\FRA
Italian ITA \PRT\ITA
Spanish ESP \PRT\ESP
Simplified Chinese CHS \PRT\CHS
Traditional Chinese CHT \PRT\CHT
Korean KOR \PRT\KOR
Japanese JPN \PRT\JPN
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Configuration steps
1. Create a new page layout.

2. Design the outward appearance in the static part of the layout and save the newly designed 
layout as a template.

3. Apply the design in the layout for the output.

Editing Options
In order to configure quickly, use the various program functions such as:

● Save Layout under New Name

● Applying Object Properties to Other Objects

● Coping or Transferring Objects in Other Layouts

● Adopting Fully Designed Objects and Layouts from Other Projects

Note

This path of the layouts is retained when you duplicate a project or load it on a target 
machine. While printing, the system first tries to load the layout using the entered path. If 
that is not possible, the system searches the layout in the project path of the local computer.

See also
Working with Objects (Page 1558)

Working with Multiple Layouts (Page 1556)

Changing Predefined Layouts (Page 1554)

How to Display the Layout Properties (Page 1553)

Layout File Operations (Page 1549)

8.4.2 Layout File Operations

Introduction
Because layouts are saved as independent files with the extension .rpl, you can carry out the 
usual file operations in the page layout editor or in WinCC Explorer. Many file operations can 
be carried out in the page layout editor and the WinCC Explorer. Layouts are saved as separate 
files.

Layout files of language-neutral layouts
The layout file of a language-neutral layout is saved in the "PRT" folder of the WinCC project.

Creating Page Layouts
8.4 Working with Layouts

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1549



Layout files of language-dependent layouts
You must create layout files in the Runtime languages for a language-dependent layout. The 
name of the layout file contains the language code, e.g. NewRPL01_ENU.RPL and 
NewRPL01_ESP.RPL.

The "PRT" folder of the WinCC project contains a folder for each language installed with 
WinCC. The language-specific layout files must be saved in the corresponding language-
specific folder. The current Runtime language determines which layout file is used.

1. Single-language configuration
You are making configurations in English for English-speaking operators. 
New layouts are saved e.g. under the file name "NewRPL01_ENU.RPL". The layout file is 
saved in folder "\\<Name of computer>\Project name\PRT". 
Alternatively, create your own new layouts as language-neutral layouts.

2. Multilingual configuration
You are making configurations for English-speaking and Spanish-speaking operators. The 
"NewRPL01" layout must be saved in 2 layout files:

– "NewRPL01_ENU.RPL" in folder "\\<Name of the computer>\Project name\PRT\ENU"

– "NewRPL01_ESP.RPL" in folder "\\<Name of the computer>\Project name\PRT\ESP"

In the case of multi-language configurations, be sure to make all changes, copies and 
deletions to all layout files of a layout.
You can also create language-neutral layouts.

Adding a Layout Language
If you need reports and documentation in other languages, you must create language-
dependent layouts. To do this, you must add the language. 

1. Select the "Report Designer" editor in WinCC Explorer. 
The entries "Layouts" and "Print Jobs" appear in the data window.

2. Select the "Layouts" entry and open its context menu.

3. Select the "Add Language ..." command.

4. Select the desired layout language from the list.
You can only add the language-specific folders that use the same codepage. If you need 
to edit layout files in languages that need another codepage, you must set up the associated 
system locale (operating system language) in the system control of your operating system.
The new language folder is created under the "Layouts" entry. Layout files of the current 
language are listed in the right window.

Creating Layout
To create a new report, you first have to create a new layout. Page layouts contain layout files 
with ending ".rpl". 

1. Select the "Report Designer" editor in WinCC Explorer.
The entries "Layouts" and "Print Jobs" appear in the data window.

2. Select the "Layouts" entry and open its context menu.
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3. If necessary, create a new layout language with the "Add Language ..." command.
The layout files of the current language are listed in the right window.

4. Select the desired layout language or the "Language neutral" entry.

5. Select the command "New page layout" from the context menu. A new file with the name 
"NewRPLxx.RPL" is created. The numbers in the file names increase consecutively.

6. In order to open the file select "Open page layout" from the layout context menu.

7. The newly created layout is opened in the page layout editor.

Alternative Operation
You can also create a new layout file in the open page layout editor. To do this, select "New" 
from the "File" menu. The page layout editor creates an empty layout file. Save the layout file 
under the desired name and in the correct folder.

Saving Layout

Note
Language Code in the Layout File

When saving the file, enter the correct language code in the file name, e.g. 
NewRPL01_ENU.RPL. Save the layout file in the correct language folder.

1. Select "Save as..." from the "File" menu in the page layout editor.

2. If you choose "Save as...", a dialog will open.

– Navigate to the correct folder.

– Enter a file name and a language code and save the layout file.

3. The layout file receives extension .rpl.

Opening Layout
1. Select the "Report Designer" editor in WinCC Explorer.

The entries "Layouts" and "Print Jobs" appear in the data window.

2. Select the "Layouts" entry.
The existing language directories are displayed in WinCC Explorer. 

3. Select the desired language folder and open its context menu.
The layout files of the current language are listed in the right window.

4. Select the desired layout file and select the "Open page layout" command from the context 
menu.
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Alternative Operation
If the page layout editor has already been started, you can select "Open" from the "File" menu. 
In the file selection dialog, navigate to the desired language directory. Select the desired layout 
file and then click on "Open". 

Copying a Layout File
You can save layout files under other names and thus copy them, for example to create 
variants.

1. Open the layout file to be copied in the page layout editor.

2. To do this, select "Save As..." from the "File" menu. 
The Save As... dialog opens.

3. Give the layout file a new name and save the layout file.

Renaming a Layout File
1. Select the "Report Designer" editor in WinCC Explorer.

The entries "Layouts" and "Print Jobs" appear in the data window.

2. Select the "Layouts" entry in the data window.
The existing language folders are displayed in WinCC Explorer. 

3. Select the desired language folder.
All project layout files in the selected language are listed.

4. Select the desired layout file and select the "Rename page layout" command from the 
context menu.
The New Name dialog: is opened.

5. Change the name of the selected layout file and click on the "OK" button. Please pay 
attention to the note below.

Deleting a Layout File
1. Select the "Report Designer" editor in WinCC Explorer. 

The entries "Layouts" and "Print Jobs" appear in the data window.

2. Select the "Layouts" entry in the data window.
The existing language folders are displayed in WinCC Explorer. 

3. Select the desired language folder.
All project layout files in the selected language are listed.

4. Select the desired layout file and select the "Delete page layout" command from the context 
menu. The layout file will be deleted without a confirmation.
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Note

The system layouts delivered with WinCC are integrated in the project documentation and 
cannot be deleted or renamed. To use one of the system layouts for your own purposes, 
simply save it under a new name. You can recognize the system layouts by the "@" suffix in 
the file name. Please do not use this symbol to name your own layouts.         
 

If you wish to create a page layout using the SIMATIC Manager, you cannot rename or delete 
this layout in WinCC Explorer. This also applies to a page layout created in WinCC and 
subsequently imported into SIMATIC Manager using the function "Import WinCC Object". 
This import changes the WinCC object into a TIA object.         
 

If you copy a page layout using the Report Designer, the copy is created as a WinCC object. 
You may rename or copy this copy as a WinCC object.

See also
Working with Multiple Layouts (Page 1556)

Changing Predefined Layouts (Page 1554)

How to Display the Layout Properties (Page 1553)

Working with Layouts (Page 1548)

8.4.3 How to Display the Layout Properties

Usage
For each layout file, you can call the creation date, the date of last change and the file size.  

Requirements
The WinCC project must be open.

Procedure
1. Select the "Report Designer" editor in WinCC Explorer. 

The entries "Layouts" and "Print Jobs" appear in the data window.

2. Select the "Layouts" entry in the data window.
The existing language folders are displayed in WinCC Explorer. 

3. Select the desired language folder.
All project layout files in the selected language are listed.

4. Select the desired layout file and select the "Properties" entry from the context menu.
The "Properties" window opens.
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See also
Working with Multiple Layouts (Page 1556)

Changing Predefined Layouts (Page 1554)

Working with Layouts (Page 1548)

Layout File Operations (Page 1549)

8.4.4 Changing Predefined Layouts

Introduction
You can change the predefined layouts in order to fit your needs better. It is advisable to save 
an existing layout file with a new name first and only then to edit the layout file. If you do this, 
you can always fall back on the layouts provided with WinCC if you need to.

The system layouts and system print jobs delivered with WinCC are used by the WinCC 
components when the report output is triggered (e.g. project documentation in the Graphics 
Designer). Therefore, neither the system layouts nor the system print jobs may be deleted or 
renamed.

The system files are located in the WinCC directory in the language-specific folders under 
folder "..\WinCC\syslay". The language-specific folders in a new project are copied to the 
corresponding project directory in the "..\<Project name>\PRT" folder the first time it is 
accessed.

The system layouts and system print jobs are created for every new project.

How to Make Changes to the Static Part of a Layout
The header and footer are defined in the static part of a page layout. You can also change the 
appearance of the report without changing the dynamic properties of the layout. The static part 
of a page in the page layout extends across the entire printable area of the report. You can 
individually define the static part for the cover sheet, the report contents and the closing page. 
Static objects and system objects are available to you for the design.

The same static part will be repeated on all the succeeding pages of the report contents. 

How to activate the static report part:
1. Select "Static Part" from the "View" menu.         

Or         
activate the static report part using the toolbar.

2. Next add static objects or system objects.

Changes in the dynamic part of a layout
You put together the structure and content of the report for output in this part of the page layout. 
There are static, dynamic, and system objects available for defining the report contents. If 
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necessary, the dynamic part of the contents of the report is spread across the various 
subsequent pages at output, since it is not known until the time of output how much data there 
is. The first object in the vertical direction in a layout is automatically moved to the upper 
dynamic edge during output. 

Important:
During the definition of a page layout, you can not predict with absolute certainty on how many 
pages the dynamic part will require. The size of the dynamic tables and text fields is determined 
by the data which is used at the moment of output. Succeeding objects are moved downward 
according to the dynamic size changes.

Generally no line breaks are provided for the output of data in table cells. However, you can 
output large amounts of data in a table cell without the data being cut off by:

1. Select the output of the report in landscape format.

2. Select the "Vertical" table format in the table object properties.

3. Set the relative column width of all columns as narrowly as possible.

4. Use the smallest font size possible.

Static objects which are pasted into the static part of a page layout are in a layer below the 
dynamic objects. Thus, it can happen that the static objects will be covered by the dynamic 
objects, especially by the dynamic extension of a table.

How to enable the report contents for editing:
1. Select "Dynamic Part" from the "View menu".         

Or         
activate the dynamic report part using the toolbar.

2. Next add static, dynamic or system objects.

3. For dynamic objects, then select the data for output from the "Connect" tab in the 
"Properties" dialog.

Note

If you use the "WinCC Control Runtime Printprovider" layout as of WinCC V7, the dynamic 
portion of the report is determined by the underlying control. You can no longer make 
configurations on the "Connect" tab.

Editing the Objects
Objects in the layout are edited using the "Object properties" dialog. This can be opened using 
the toolbar, the pop-up menu for the objects or by double-clicking an object. Please see 
"Working with Objects" for more information.

Creating Page Layouts
8.4 Working with Layouts

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1555



See also
Changing Predefined Layouts (Page 1554)

How to Display the Layout Properties (Page 1553)

Working with Layouts (Page 1548)

Layout File Operations (Page 1549)

8.4.5 Working with Multiple Layouts

Introduction
The page layout editor offers your some options for efficient configuration. In order not to have 
to keep repeating the same configuration steps, you can

● Save Layout under New Name

● Applying Object Properties to Other Objects

● Coping or Transferring Objects in Other Layouts

● Adopting Fully Designed Objects and Layouts from Other Projects

Note
Language-Neutral and Language-Dependent Layouts

There are language-neutral and language-dependent layouts. 

Language-neutral layouts have the following designation: "<Name of the layout>.rpl". 
Language-neutral layouts are saved in folder "\\<Name of system on which the layout was 
created>\Project name\PRT".

Language-dependent page layouts contain layout files with the following designation:

"<Name of the layout>_XXX.rpl". "XXX" stands for the language code of the layout file.

The language-specific layout file is saved in a language-specific folder in folder "\\<Name 
of the system on which the layout was created>\Project name\PRT".

In the case of multi-language configurations, be sure to make all changes, copies and 
deletions to all layout files of a layout.

See chapter " Working with Layouts (Page 1548) " for further instructions.

Save Layout under New Name
If you want to configure several projects, it is recommended that you first save a layout as a 
template. Set the elements which remain the same, such as headers and footers, in this layout. 
Set the page format and the orientation. Set the print margins and the dynamic margins. Save 
the finished layouts as often as you want under new names. Then you can add the log objects 
you want to the individual layouts and set their parameters. You will find more information in 
the "Layout File Operations" chapter.
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Applying Object Properties to Other Objects
If you have an object with certain properties in a layout, then you can easily apply these 
properties to another object. Use the eyedropper function for this. You will find more information 
in the "Transferring Object Properties" chapter.

Coping or Transferring Objects in Other Layouts
This is a very useful function in order to paste already configured objects or object groups into 
another layout. In this way, you can, for example, design a complete header and transfer it to 
other layouts.

In order to copy an object or object group, highlight the object(s) and copy the selection to the 
operating system clipboard. Next open the target layout and paste in the contents of the 
clipboard. The contents of the clipboard can be pasted into as many other layouts as desired. 
The next time an object is copied, the data in the clipboard will be overwritten.

In order to transfer an object or object group, highlight the object(s) and cut the selection out. 
The selection will be copied to operating system clipboard. Then you can proceed with this 
selection as with copying.

Adopting Fully Designed Objects and Layouts from Other Projects
If you have already created a project with WinCC, then you can transfer existing layouts to the 
new project. You can also transfer objects from an existing layout to a layout in the new project.

There are two options for transferring a complete layout:

1. Navigate to the root directory of the old project using Windows Explorer. Open the "PRT" 
folder.

– For language-neutral layouts:
Copy the desired layout file and add it to the folder "PRT" of the new project.

– For language-dependent layouts:
Open the desired language-dependent folder. Copy the desired layout file and add it to 
the language-dependent folder in folder "PRT" of the new project.
Repeat the process for all Runtime languages, if necessary.

2. Open the page layout editor in the new project and click the folder button in the toolbar. 
The "Open" dialog will appear.

– For language-neutral layouts:
Use this dialog to navigate to the "PRT" folder of the old project. Open the desired layout 
file in the page layout editor. Save the layout file in the "PRT" folder of the new project 
using the "Save" or "Save as..." function.

– For language-dependent layouts:
Use this dialog to navigate to the language-dependent folder in the "PRT" folder of the 
old project. Open the desired layout file in the page layout editor. Save the layout in the 
language-dependent folder in the "PRT" folder of the new project using the "Save" or 
"Save as..." function. 
Repeat the process for all Runtime languages, if necessary.
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Requirements
In order to transfer a fully defined object from another project, open the layout which contains 
this object in one of the two ways described above. Select the object or group of objects that 
you want and copy the selection to the clipboard. Open the target layout and paste in the 
contents of the clipboard.

Note

If you are copying system layouts, we recommend creating a backup copy of the new system 
layout before overwriting it in the "PRT" folder.

See also
How to Transfer Object Properties (Page 1577)

Changing Predefined Layouts (Page 1554)

How to Display the Layout Properties (Page 1553)

Layout File Operations (Page 1549)

8.5 Working with Objects

8.5.1 Working with Objects

Introduction
In this chapter, you will learn

● which basic functions of the page layout editor can be used for working with objects

● what characteristics the individual objects have

● how to use objects to create layouts

● how to specifically change object properties

You will find a description of the available objects in the chapter on the Object Palette.

See also
The Properties of an Object (Page 1570)

Working with Objects for the Project Documentation (Page 1666)

Working with Objects for the Runtime Documentation (Page 1634)

Working with Standard Objects (Page 1589)

The Object Palette (Page 1525)
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8.5.2 The coordinate system in the Report Designer

Introduction
The basis for the definition of position and size entries in the page layout editor is a two-
dimensional coordinate system. The two axes of the coordinate system, x-axis and y-axis, are 
perpendicular to one another and intersect at the coordinate origin. The coordinate origin lies 
with the coordinates (X = 0 / Y = 0) in the top left corner of the desktop. Extending from the 
coordinate origin, the horizontal X-axis runs in the positive direction to the right edge of the 
working area, and the vertical Y-axis runs in the positive direction to the lower edge of the 
working area. Thus the values for X and Y displayed in the status bar of the page layout editor 
increase when the mouse is moved from the upper left to the lower right of the working area. 
Coordinates are displayed in the units set in the Tools/Settings menu on the Units tab.

The position and size of objects in a layout are determined by the coordinates which an object 
has in the coordinate system. For example, the position of the object origin is determined by 
the attributes Position X and Position Y; thus, it has the coordinates (X = Position X / Y = 
Position Y). The values of these attributes describe the distance of the object origin from the 
coordinate axes.
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Definition of Origin
The origin is defined as the point of an area or an object that is used as the reference point for 
entering position and size. For creating a layout in the page layout editor, the following 
reference points are significant:

● Coordinate system origin (X = 0 / Y = 0)         
= Top left corner of the working area

● Picture origin (X = 0 / Y = 0)         
= Top left corner of the layout

● Object origin (X = position X / Y = position Y)         
= Top left corner of the rectangle surrounding the object

Internal Coordinate System of an Object
The validity of the normal coordinate system is canceled for displays within an object. The 
following special form is used for the internal coordinate system of an object:

The positive direction of the Y-axis points downward, the positive direction of the X-axis points 
to the right.

See also
The Status Bar (Page 1538)

The Rectangle Surrounding the Object (Page 1560)

8.5.3 The Rectangle Surrounding the Object

Introduction
The rectangle surrounding an object is defined as a rectangular frame which lies on the outer 
limit of an object. The rectangle surrounding an object is not visible in the page layout editor. 
When an object is selected, however, the handles which are used to grab an object for 
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changing its size are shown. These handles identify the central axes and corner points of the 
rectangle surrounding the object.

The special significance of the rectangle surrounding the object for determining the position 
can be illustrated with a circular or ellipse-shaped object as an example:         
The position of an object is defined by means of the position of its origin relative to the 
coordinate system. The object origin has the coordinates (Position X / Position Y) and is defined 
as the upper left corner of the rectangle surrounding the object. Specified in this way, the 
position of a circular or ellipse-shaped object can be set clearly.

The handles of the rectangle surrounding the object
The handles of the rectangle surrounding the object appear as soon as an object is selected. 
By dragging with the mouse, the size of an object can be modified by shifting a handle to a 
new position.

If the mouse pointer is positioned on a handle, it turns into a double arrow. The alignment of 
the double arrow indicates the directions in which the handle can be moved:

● Horizontal double arrow: The handles on the horizontal center axis can be used to change 
the width of the object.

● Vertical double arrow: The handles on the vertical center axis can be used to change the 
width of the object.

● Diagonal double arrow:The handles on the corners of the object can be used to change 
the height and width of the object.
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Note

Circular objects can only be changed in terms of their whole size; they do not have handles 
for their center axes.

See also
Multiple Selection of Objects (Page 1565)

How to Paste an Object into a Layout (Page 1562)

The coordinate system in the Report Designer (Page 1559)

How to Edit Objects (Page 1563)

8.5.4 How to Paste an Object into a Layout

Introduction
A layout is created in the page layout editor by pasting objects from the object palette into a 
layout.

In the page layout editor, the various object types have predefined properties. When added, 
objects take on these defaults, with the exception of individual geometric properties. After 
insertion the properties of an object can be modified. In the same way the default settings for 
the object types can be modified as required.

When an object is inserted, the object name assigned as standard is the description of the 
object type with a consecutive number. This name can be changed using the Object Name 
attribute.

Requirement
The display of the object palette must be enabled.

Procedure
The Rectangle standard object is shown here as an example for the general procedure for 
pasting an object into a layout. Some object types require additional steps. You can learn more 
about these additional steps in the detailed description of the individual objects.

1. Open the layout in which you want to insert an object.

2. Click the Rectangle standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the 
rectangle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the rectangle to the required size.         
As soon as you release the mouse, the rectangle is added.
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Alternative Operation
Using the Paste command, the current contents of the clipboard can be pasted into the active 
layout as often as you like. If an object has been copied to the clipboard, this command can 
be used to paste as many copies of the object as you like, also into different layouts. The Paste 
command is available through the respective button in the toolbar, by pressing keys <CTRL
+V> or by selecting Edit/Paste in the menu bar.

See also
The Properties of an Object (Page 1570)

Working with Objects for the Project Documentation (Page 1666)

Working with Objects for the Runtime Documentation (Page 1634)

Working with Standard Objects (Page 1589)

The Object Palette (Page 1525)

How to Edit Objects (Page 1563)

8.5.5 How to Edit Objects

Introduction
You can select, position, scale, delete, cut, copy, duplicate and change the properties of objects 
in a layout.

Selecting Objects
Select an object of any type by clicking it. As an alternative, you can select the object you want 
from the object selection list in the Object Properties window.

Positioning Objects
1. Select the object you want.

2.     The mouse pointer changes to a crosshair with arrowheads.         
    The handles of the rectangle surrounding the object appear as soon as an object is 
selected.

3. Hold down the mouse button and move the object to the desired position.

You can also select the object using the arrow keys or by changing the values for the geometric 
attributes Position X and Position Y in the Object Properties window.
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Scaling objects
1. Select the object you want.

2. Position the mouse pointer on one of the handles of the object. The mouse pointer will 
change to a double arrow. The orientation of the double arrow indicates the direction in 
which you can move the handles.

3. Use the mouse to drag the handle to the position you want.

You can also resize the object by changing the values for the geometric attributes Width and 
Height in the Object Properties window.

Deleting Objects
1. Select the object you want.

2. Press the DEL key. The selected object is deleted.

You can also delete the selected object by selecting Delete from the pop-up menu or by 
selecting Edit/Delete from the menu bar.

Cutting Objects
1. Select the object you want.

2. Click the  button in the toolbar. The selected object will be cut from the layout and copied 
to the clipboard.

You can also cut the selected object using the Cut command in the pop-up menu, with the 
CTRL+X key combination or by selecting Edit/Cut from the menu bar.

Copying Objects
1. Select the object you want.

2. Click the  button in the toolbar. The selected object will be copied to the clipboard.

You can also copy the selected object using the Copy command in the pop-up menu, with the 
CTRL+C key combination or by selecting Edit/Copy from the menu bar.

Duplicating Objects
1. Select the object you want.

2. Select Duplicate from the pop-up menu. A copy of the selected object will be created directly 
in the active layout. Position X and Position Y of the copy are approximately 20 pixels higher 
than Position X and Y of the original object.

You can also duplicate the selected object by selecting Edit/Duplicate from the menu bar.

See also
Multiple Selection of Objects (Page 1565)

The Rectangle Surrounding the Object (Page 1560)
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8.5.6 Multiple Selection of Objects

8.5.6.1 Multiple Selection of Objects

Introduction
In order to change the properties of several objects at once, all of the objects to be changed 
must be selected. This procedure is called "multiple selection".

During a multiple selection, the attributes held by at least one of the selected objects are 
displayed in the "Object properties" window. The value of an attribute will only be displayed, 
however, if it is the same for all selected objects.

Along with "selection frames" and the "reference object", a multiple selection has two 
characteristics which play an important role, for example for the common alignment of the 
selected objects. However, these characteristics are not visibly displayed in the page layout 
editor.

Making multiple selections
The multiple selection of objects can be made in several ways in the page layout editor:

● Multiple selection while pressing the Shift key. Click the objects you want, one after the 
other, while holding down the Shift key.

● Multiple selection by dragging a selection frame with the mouse. While dragging, a frame 
will be shown to help with orientation. The selection is dependent on the type of object 
selection set in the page layout editor. For "surrounding object selection", all objects which 
are inside the displayed frame are selected. For "touching object selection", all objects 
touched by the frame will be selected, in addition to those inside of it.
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Selection Frame of a Multiple Selection
The selection frame encloses all objects in a multiple selection, comparable to the rectangle 
surrounding individual objects.

The position and size of the selection frame are dependent on the position of the selected 
object. The midpoint of the selection frame corresponds to the common midpoint of the 
selected objects. The limit line of the selection frame touches the outer edges of the objects 
which have the greatest distance from the common midpoint.

The selection frame is not visible. After finishing the multiple selection, only the handles of the 
individual objects will be shown.

Reference Object of a Multiple Selection
During a multiple selection, one of the selected objects will be set as a reference object. For 
example, if the "Same width" function is selected in the Alignment palette, then all selected 
objects will be set to the same width as the reference object.

If the multiple selection is made by dragging a frame, the first object created is set as the 
reference object.
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If the multiple selection is made with the Shift key, the first object selected is set as the reference 
object.

See also
The Rectangle Surrounding the Object (Page 1560)

The Alignment Palette (Page 1533)

How to Align Multiple Objects (Page 1568)

How to Select Multiple Objects (Page 1567)

8.5.6.2 How to Select Multiple Objects

Introduction
In order to change the properties of several objects at once, all of the objects to be changed 
must be selected. This procedure is called multiple selection.

Requirements
The layout must contain at least two objects.

Procedure
1. On the keyboard hold down the SHIFT key.

2. With the mouse, click the objects you want, one after the other.         
The handles of the rectangle surrounding the object appear for every selected 
object.         
The mouse pointer will change to a crosshair with arrow points when it is positioned over 
a selected object. 

The reference object in this type of multiple selection is the object that was selected first.

Note

If an object has been selected accidentally, it can be removed from the multiple selection by 
clicking it again while holding down the Shift key.

Alternative Procedure
The multiple selection can also be made by dragging a selection frame with the mouse. The 
objects will be selected in accordance with the setting for the type of object selection. The 
procedure described here is for the surrounding object selection type.

1. Hold down the mouse button and drag a frame around the objects you want.

2. As soon as you release the mouse button, the handles for the rectangles surrounding the 
objects will be shown for every selected object.
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The reference object in this type of multiple selection is the object that was created first.

See also
The Rectangle Surrounding the Object (Page 1560)

Multiple Selection of Objects (Page 1565)

How to Set the Options for the configuration settings (Page 1545)

How to Align Multiple Objects (Page 1568)

8.5.6.3 How to Align Multiple Objects

Introduction
The objects in a multiple selection can be edited together using the functions of the Alignment 
palette. These functions can also be called from the "Arrange / Align" menu.

The Alignment Palette contains the following functions for processing the objects in a multiple 
selection:
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● Align:The selected objects are aligned on the border line of the selection frame (up, down, 
left, right).

● Center:The selected objects are centered on a middle axis of the selection frame 
(horizontally, vertically).

● Space: The selected objects are distributed evenly across the height or width of the 
selection frame (horizontally, vertically).

● Align: The size of the reference object is assigned to the selected objects (height, width or 
height and width).

A detailed description of these functions can be found in the section "The Alignment palette".

Requirement
Select at least two objects of any type.

Procedure
1. Click the icon you want in the Alignment Palette.         

The alignment or the size of the selected objects changes.

Alternative Procedure
1. Select the entry you want from the Arrange / Align menu.         

The alignment or the size of the selected objects changes.

See also
Multiple Selection of Objects (Page 1565)

The Alignment Palette (Page 1533)

How to Select Multiple Objects (Page 1567)
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8.5.7 The Properties of an Object

8.5.7.1 The Properties of an Object

Introduction
The shape, appearance, position and application linking of an object are set by the Object 
Properties. These properties can be changed in the page layout editor as needed. 

The properties of an object are described by a large number of attributes. An object property 
can be changed by assigning a new value to its attribute.

The Properties tab of the Object Properties window contains all the attributes of a selected 
object or objects in a multiple selection. The attributes are divided into property groups, such 
as geometry or color. The type and number of the available property groups and attributes are 
dependent on the type of the selected objects. So, for example, the Font property group is only 
shown for the object types which can be displayed with text.

As an alternative to changing the attributes in the Object Properties window, objects can also 
be adjusted with the mouse and keyboard or by using the toolbar and palettes. However, in 
this way only certain object properties, such as the basic geometric size, color and line style, 
can be changed.

See also
How to Change an Attribute (Page 1576)

How to Transfer Object Properties (Page 1577)

The Object Palette (Page 1525)

How to Access the Object Properties Window (Page 1571)

The Object Properties Window (Page 1570)

8.5.7.2 The Object Properties Window

The Object Properties Window

Introduction
The Object Properties window represents the central dialog for changing object properties in 
the page layout editor.

For creating a layout, it is first important to adjust the static values of the attributes, in order, 
for example, to set the form, appearance or position of an object. Change the static values on 
the Properties tab.

With dynamic log objects, you can edit the selection of data for output using the Object 
Properties dialog. You can open the dialogs for editing on the link tab.

Creating Page Layouts
8.5 Working with Objects

MDM - WinCC: Working with WinCC
1570 System Manual, 11/2008,  



The Object Properties Window
As an example, the Object Properties window can have the following appearance for a 
rectangle with the object name "Rectangle1":

The Object Properties window can be kept in the foreground of the page layout editor. The 
position and size of the window can be changed as you like.         
The Object Properties window is subdivided into Elements toolbar, and the Properties and Link 
tabs. You can find more about these elements in their detailed description.

How to Pin the Object Properties Window to the Top
By activating the  button, the Object Properties window can be set so that it is always in the 
foreground in the Graphics Designer. Clicking the button again deactivates the function.

See also
How to Access the Object Properties Window (Page 1571)

The Link tab in the Object Properties Window (Page 1575)

The Properties tab in the Object Properties window (Page 1573)

The Toolbar in the Object Properties Window (Page 1572)

The Properties of an Object (Page 1570)

How to Access the Object Properties Window

Introduction
The Properties tab of the Object Properties window contains all the attributes of a selected 
object or objects in a multiple selection. The changes are made to an object property by 
assigning a new value to accompanying attribute.
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Requirement
Select an object of any type.

Procedure
You can open the Object Properties window in the following ways:

● In the standard toolbar, click the  button.

● Double-click the selected object.

● Select Properties from the pop-up menu of the object.

● In the View menu, select Properties..

Note

If you want to make changes to several objects, you can lock the display of the Object 
Properties window with the .

See also
How to Change an Attribute (Page 1576)

The Link tab in the Object Properties Window (Page 1575)

The Properties tab in the Object Properties window (Page 1573)

The Toolbar in the Object Properties Window (Page 1572)

The Object Properties Window (Page 1570)

The Properties of an Object (Page 1570)

The Toolbar in the Object Properties Window

Introduction
You can make the following settings with the toolbar in the Object Properties window:

● The display of the Object Properties window can be kept in the foreground of the page 
layout editor.

● Object properties can be transferred.

● Individual objects in the active layout can be selected.

As an example, the toolbar can have the following appearance for a rectangle with the object 
name "Rectangle1":
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Elements of the toolbar in the Object Properties window

Icon Name Function

Pin         
activated/
deactivated

Deactivate: the Object Properties window will be 
closed as soon as the mouse is clicked outside the 
selected object.         
Activate: Activate: the Object Properties window 
stays in the foreground at all times. Different objects 
can be edited without having to open the window 
again.

Eyedropper         
Copy properties

The properties of a selected object are copied.

Eyedropper         
Assign 
properties

The previously copied properties are transferred to 
the selected object without changing its geometric 
attributes. For different object types, only those 
attributes which both object types have are 
transferred.

Object type Displays the object type of the selected object. When 
several objects are selected, a multiple selection and 
the number of objects selected is displayed here.

Object 
selection

Displays the name of the selected object.          
Another object can be selected using the selection 
list. If the dynamic part of the layout is enabled, the 
selection list contains the names of all objects in the 
dynamic part of the layout. This is also the case for 
the static part of the layout.

See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Link tab in the Object Properties Window (Page 1575)

The Properties tab in the Object Properties window (Page 1573)

How to Access the Object Properties Window (Page 1571)

The Object Properties Window (Page 1570)

The Properties of an Object (Page 1570)

The Properties tab in the Object Properties window

Introduction
The Properties tab represents the central dialog for changing the static values of a selected 
object in the Object Properties window. 

As an example, the Properties tab can have the following appearance for a rectangle with the 
object name "Rectangle1":
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The Properties tab is divided into two areas:

● Properties display: In the left-hand area, the selected object is displayed with its property 
groups in the form of a directory tree. The selected object is displayed as a 
directory.         
With a multiple selection or a user object, this folder only receives the shared property 
groups of the contained individual objects. For a selected property group, the value of an 
attribute will only be displayed if the value is the same for all selected objects or if the 
attribute belongs to only one of the selected objects.         
The name of the property groups cannot be changed. Directories and subdirectories can 
be opened or closed by clicking the + or - icons.

● Attribute display: The right-hand area contains all attributes which are available for the 
selected property group. The attribute display is divided into two columns in which the static 
values of the selected object are displayed.         
The displayed values can be changed by double-clicking or opening the pop-up menu in 
the Static column.

The width of the two window areas and the columns in the attribute display can be changed 
by moving the vertical dividing lines.

Attribute Display Columns

Column Description

Attribute Name of the attribute. All of the attributes from the selected property group that 
are available for the selected object will be shown.         
         
The name of the attribute cannot be changed. The static value of the attribute can 
be changed by double-clicking the attribute name.

Static Static value of the attribute. The current value of the attribute for the selected object 
is displayed. The value will be displayed as a number, text or graphic display, 
depending on the type of attribute.         
         
The static value of the attribute can be changed by double-clicking the attribute 
name. You can find more in chapter Changing Attributes.
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See also
The Object Properties Window (Page 1570)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Link tab in the Object Properties Window (Page 1575)

The Toolbar in the Object Properties Window (Page 1572)

How to Access the Object Properties Window (Page 1571)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window

Introduction
The Link tab represents the central dialog for configuring links in the Object Properties window.

The dynamic objects are already linked with the corresponding applications. Some of the 
dynamic objects have one or more dialogs for selecting data for output. 

For example, the Link tab in the Object Properties window for a database table with object 
name Dynamic Table 1 might look like this:

The Link tab is divided into two areas:

● In the left-hand area, the linked applications from which the data to be output are taken are 
shown in the form of a directory tree. 

● In the right-hand area, the editing options and, if they exist, the formatting options, are 
shown in the Name column. You can open the appropriate configuration dialog with the 
Edit... button.         
The configured selections are reset with the Delete... button. The selection options remain.

The width of the two window areas and the columns in the event display can be changed by 
moving the vertical dividing lines.
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See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties tab in the Object Properties window (Page 1573)

The Toolbar in the Object Properties Window (Page 1572)

How to Access the Object Properties Window (Page 1571)

The Object Properties Window (Page 1570)

The Properties of an Object (Page 1570)

8.5.7.3 How to Change an Attribute

Introduction
The properties of an object in the page layout editor are determined by the values of the object 
attributes. Every change to an object, for example made with the mouse or via a configuration 
dialog, changes the value of the accompanying attributes.

The Properties tab of the Object Properties window displays all the attributes of a selected 
object or objects in a multiple selection. The attributes are assigned to so-called property 
groups. The type and number of the available property groups and attributes are dependent 
on the type of the selected objects. So, for example, the Font property group is only shown for 
the object types which can be displayed with text.

An object property can be changed by assigning a new value to its attribute. Entries for 
changing a specific attribute can be found in the detailed description of that attribute.

Procedure
1. Open the Object Properties window.

2. In the Properties tab, select the property group you want.

3. Double-click the attribute you want. A dialog for changing attributes will open. Enter a new 
value according to the table below.

4. Click OK to confirm your entries.

As an alternative, you can directly open a dialog for changing attributes by double-clicking in 
the Static column. You can call up direct help for each attribute by right-clicking it in the Attribute 
column.
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Dialogs for Changing Attributes
The table provides information about the possible dialogs for changing attributes and contains 
an example of calling each one.

Dialog Procedure

Value input Enter a new value in the line.          
Example::         
Object: static text; properties group: geometry; attribute: width

Text Input Click in the text field to edit text or enter new text.         
Example:         
Object: static text; properties group: font; attribute: text

Switchover Every double-click produces a switch between the two available standing 
values.         
Example:         
Object: static text; properties group: font; attribute: bold

Selection dialog in the 
form of a button

Click the button to set the new value.         
Example:         
Object: static text; properties group: font; attribute: X alignment

Selecting a color Select one of the 16 standard colors or open the palette with the user-defined 
colors. In this palette, you can freely define additional colors.         
Example:         
Object: static text; properties group: color; attribute: font color

Selecting a picture Choose a picture from the selection dialog or use the Search In dialog to 
find a directory where you can take additional pictures in the picture 
selection.         
Example:         
Object: static metafile; properties group: other; attribute: metafile name

See also
The Styles Property Group (Page 1587)

The Miscellaneous Property Group (Page 1585)

The Font Property Group (Page 1584)

The Geometry Property Group (Page 1581)

The Colors Property Group (Page 1579)

How to Rename Objects (Page 1578)

How to Transfer Object Properties (Page 1577)

8.5.7.4 How to Transfer Object Properties

Introduction
The properties of an object can be transferred to another object with the Eyedropper. The 
following buttons can be used to transfer object properties in the page layout editor:
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to copy properties of the selected object

to apply copied properties to a selected object

These buttons are in the standard toolbar and in the Object Properties window. Alternatively, 
these functions can be called via the Edit / Properties menu.

The properties of any object can be copied with the eyedropper. You can apply the copies to 
any object or multiple selection. The properties are transferred without changing the geometric 
attributes of the object. For different object types, only the attributes held by both the original 
and target objects will be changed.

Procedure
1. Select the object whose properties you want to copy.

2. In the standard toolbar, click .         
The properties of the selected object are copied.

3. Select the object to which you want to assign the copied properties.

4. In the standard toolbar, click .         
The selected object will be displayed with the new properties, but without changing its 
geometric attributes.

See also
The Styles Property Group (Page 1587)

The Miscellaneous Property Group (Page 1585)

The Font Property Group (Page 1584)

The Geometry Property Group (Page 1581)

The Colors Property Group (Page 1579)

How to Rename Objects (Page 1578)

How to Change an Attribute (Page 1576)

8.5.7.5 How to Rename Objects

Introduction
The Object Name attribute determines the name of an object in the layout. The object name 
is unique within a layout. 

When an object is inserted, the object name assigned as standard is the description of the 
object type with a consecutive number. This name can be changed using the Object Name 
attribute.
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The allocation of unique names is important when using objects whose output parameters can 
be changed online. You can find more information in chapter Changing Output Options in 
Runtime.

Requirement
Select an object of any type.

Procedure
1. Open the Object Properties window.

2. In the Properties tab, select the entry for the selected object type to which the property 
groups of the object are subordinate.

3. Double-click the Object Name attribute. The Text Entry dialog opens.

4. Enter the new name.

5. Click OK to confirm your entries.

Value area
The object name is freely selectable and can contain up to 128 characters. When entering the 
name, please make note of the list of characters which are not permitted.

8.5.7.6 The Colors Property Group

The Colors Property Group

Introduction
The Colors property group contains attributes which you can use to change the color settings 
of objects. 
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Requirement
The Colors property group is available for all object types.

The availability of the attributes is dependent on the type of object selected. Only the attributes 
which the selected object has will be displayed.

Overview
The following table shows all attributes in the Colors property group. The function of an attribute 
is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

Fill pattern color Color of the fill 
pattern

Polygon, ellipse, circle, ellipse segment, pie segment, 
rectangle, rounded rectangle, static text, static metafile, all 
dynamic objects, all system objects, all objects for runtime 
documentation and project documentation and the layout 
object.

Background color Background color of 
the object

Polygon, ellipse, circle, ellipse segment, pie segment, 
rectangle, rounded rectangle, static text, static metafile, all 
dynamic objects, all system objects, all objects for runtime 
documentation and project documentation and the layout 
object.

Line color Color of a line All standard objects except static text, all dynamic objects, 
all system objects, all objects for the runtime documentation 
and the project documentation and the layout object.

Line background 
color

Background color of 
a line

All standard objects except static text, all dynamic objects, 
all system objects, all objects for the runtime documentation 
and the project documentation.

Font color Color of the text in 
an object

Static text, all dynamic objects except embedded layout and 
hard copy, all system objects, all logs and tables in the 
objects for runtime documentation, all objects for the project 
documentation

See also
Working with the Colors Property Group (Page 1580)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Color Palette (Page 1536)

Working with the Colors Property Group

Introduction
In the Colors property group you can change the color setting for the background, lines, fill 
pattern and font of an object. The following example Changing the Background Color explains 
how to work with this property group.
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Requirement
Select an object of any type.

Procedure
1. Open the Object Properties window, e.g. using the pop-up menu.

2. On the Properties tab, select the Colors property group.

3. Double-click the Background Color attribute. A selection dialog opens.

4. Select one of the 16 standard colors or open the palette with the user-defined colors. In 
this palette, you can freely define additional colors.

See also
Working with the Colors Property Group (Page 1580)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Color Palette (Page 1536)

8.5.7.7 The Geometry Property Group

The Geometry Property Group

Introduction
The Geometry property group contains attributes which you can use to change the geometric 
properties of objects.

Requirement
The Geometry property group is available for all objects.

The availability of the attributes is dependent on the type of object selected. Only the attributes 
which the selected object has will be displayed.

Overview
The following table shows all attributes in the Geometry property group. The function of an 
attribute is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

Current value X Horizontal position of the currently selected 
corner point, relative to the image origin.

Polygon, polyline

Current value Y Vertical position of the currently selected 
corner point, relative to the image origin.

Polygon, polyline
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Attribute Function Object type

Starting angle Start angle for the display of segment or arc 
objects in degrees.

Ellipse arc, ellipse segment, 
circular arc, pie segment

Number of corners Number of corner points Polygon, polyline
Width Distance between the left and right borders of 

an object, for the layout object the width of the 
layout.

All objects 

Corner radius X Radius of the corner rounding Rounded rectangle
Corner radius Y Radius of the corner rounding Rounded rectangle
End angle End angle for the display of segment or arc 

objects in degrees.
Ellipse arc, ellipse segment, 
circular arc, pie segment

Height Distance between the upper and lower 
borders of an object, for the layout object the 
height of the layout

All objects 

Index Number of the currently selected corner points Polygon, polyline
Left print margin Determines the width of the left print margin Layout object
Left dynamic 
margin

Determines the left margin of the dynamic 
layout part.

Layout object

Top print margin Determines the width of the top print margin Layout object
Top dynamic 
margin

Determines the top margin of the dynamic 
layout part.

Layout object

Orientation Determines the orientation of the printout in 
portrait or landscape format.

Layout object

Position X Horizontal distance of the object origin from 
the image origin

All objects

Position Y Vertical distance of the object origin from the 
image origin

All objects

Radius Radius of a circular object Circle, circular arc, pie segment
Radius X Horizontal radius of an elliptical object         

 
Ellipse, ellipse arc, ellipse 
segment

Radius Y Vertical radius of an elliptical object Ellipse, ellipse arc, ellipse 
segment

Right print margin Determines the width of the right print margin Layout object
Right dynamic 
margin

Determines the right margin of the dynamic 
layout part.

Layout object

Paper size Determines the paper format of the printout Layout object
Columns Number and width of the columns in a table All table objects in the object 

palette, recognizable by the  
icon.

Bottom print 
margin

Determines the width of the bottom print 
margin

Layout object

Bottom dynamic 
margin

Determines the bottom margin of the dynamic 
layout part.         
 

Layout object
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See also
Working with the Geometry Property Group (Page 1583)

How to Change an Attribute (Page 1576)

The Rectangle Surrounding the Object (Page 1560)

The coordinate system in the Report Designer (Page 1559)

The Properties of an Object (Page 1570)

Working with the Geometry Property Group

Introduction
You can change the geometric properties of an object in the Geometry property group. The 
following example Changing the Width explains how to work with this property group.

Requirement
Select an object of any type. You have already set the units of the coordinates (e.g. 
centimeters) in the Tools/Settings/Units menu.

Procedure
1. Open the Object Properties window, e.g. using the pop-up menu.

2. On the Properties tab, select the Geometry property group.

3. Double-click the Width attribute. The Value Input dialog opens.

4. Enter the new value.

5. Click OK to confirm your entries.

Alternative Operation
Change the object size with the mouse by dragging one of the handles on the rectangle 
surrounding the object to the width you want.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Rectangle Surrounding the Object (Page 1560)

The coordinate system in the Report Designer (Page 1559)

The Geometry Property Group (Page 1581)
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8.5.7.8 The Font Property Group

The Font Property Group

Introduction
The Font property group contains attributes which you can use to change the appearance of 
text in objects.

Requirement
The Font property group is available for all objects. Static text, the dynamic objects ODBC 
Database and Tags, the system objects and the objects for online and project documentation

The availability of the attributes is dependent on the type of object selected. Only the attributes 
which the selected object has will be displayed.

Overview
The following table shows all attributes in the Font property group. The function of an attribute 
is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

Bold Text is displayed in 
boldface

Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation

Italic Text is displayed in 
italics

Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation

Text The object text Static text
Underline Text is displayed 

underlined
Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation

X alignment Horizontal orientation 
of the text in the object

Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation which contain dynamic text

Y alignment Vertical orientation of 
the text in the object

Static text, the dynamic object Tag, the system objects 

Font Font of the text Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation

Font size Font size of the text in 
points

Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation

Text wrap Automatic line 
wrapping during output 
of the text

Static text, the dynamic objects ODBC Database and 
Tags, the system objects and the objects for online and 
project documentation which contain dynamic text
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See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with the Font Property Group (Page 1585)

Working with the Font Property Group

Introduction
You can change the text display attributes of an object in the Font property group. The following 
example Changing the Font explains how to work with this property group.

Requirement
Select one of the following objects: Static text, the dynamic objects ODBC Database and Tags, 
the system objects and the objects for online and project documentation

Procedure
1. Open the Object Properties window, e.g. using the pop-up menu.

2. On the Properties tab, select the Font property group.

3. Double-click the Font attribute. The Font Selection dialog opens.

4. Select the font you want in the dialog.

5. Click OK to confirm your entries.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with the Font Property Group (Page 1585)

8.5.7.9 The Miscellaneous Property Group

The Miscellaneous Property Group

Introduction
The Miscellaneous property group contains attributes which you can use to change the 
miscellaneous settings of objects.
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Requirement
The Miscellaneous property group is available for all objects.

The availability of the attributes is dependent on the type of object selected. Only the attributes 
which the selected object has will be displayed.

Overview
The following table shows all attributes in the Miscellaneous property group. The function of 
an attribute is described briefly and the object types for which the attribute is available are 
listed. 

Attribute Function Object type

Output format sets the appearance of the output value tag dynamic object
Output value sets the tags for the output tag dynamic object
Calculation calls a script for further editing of the tag value tag dynamic object
Data type sets the data type of the tags tag dynamic object
Cover sheet Sets whether a cover sheet should be output Layout object
Format sets the appearance of the output value all system objects
Layout file sets the layout to be embedded Embedded layout
Metafile name sets the name of the embedded file Static metafile
Final page Sets whether a closing page should be output Layout object
Page break inserts a page break in front of the object. all objects
Polling list If the output data is output in a single column per line, 

this attribute can be used to output multiple columns per 
line. The data will be written from left to right in the table 
cells.

All table objects in the 
object palette, 
recognizable by the  
icon.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with the Miscellaneous Property Group (Page 1586)

Working with the Miscellaneous Property Group

Introduction
You can change various properties of an object in the Miscellaneous property group. The 
following example Changing the Page Break explains how to work with this property group.

Requirement
Select an object of any type.
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Procedure
1. Open the Object Properties window, e.g. using the pop-up menu.

2. On the Properties tab, select the Miscellaneous property group.

3. Double-click the Page Break attribute. The entered value changes, for example from No to 
Yes. With Yes, a page break is inserted in front of the object. The default setting is Yes.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with the Miscellaneous Property Group (Page 1586)

8.5.7.10 The Styles Property Group

The Styles Property Group

Introduction
The Styles property group contains attributes which you can use to change the style for the 
appearance of objects.

Requirement
The Styles property group is available for all objects.

The availability of the attributes is dependent on the type of object selected. Only the attributes 
which the selected object has will be displayed.

Overview
The following table shows all attributes in the Styles property group. The function of an attribute 
is described briefly and the object types for which the attribute is available are listed.

Attribute Function Object type

Corners Representation of the corners of an 
object, e.g. round, flat or 
pointed         
(associated with the Line Style 
attribute)

all objects

Fill pattern Pattern for the display of background 
areas, for example solid or hatched

Polygon, ellipse, circle, ellipse segment, pie 
segment, rectangle, rounded rectangle, 
static text, static metafile,          
all dynamic objects, all system objects, all 
objects for runtime documentation and 
project documentation and the layout object.
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Attribute Function Object type

Line termination Representation of the line 
terminations of an object, e.g. round, 
flat or pointed         
(associated with the Line Style 
attribute)

all objects

Line type Display type of a line, for example 
dotted or dashed

all objects

Line weight Width of a line in points all objects

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with the Styles Property Group (Page 1588)

Working with the Styles Property Group

Introduction
In the Styles property group, you can change the style for the display of objects. The following 
example Changing the Fill Pattern explains how to work with this property group.

Requirement
Select an object of any type.

Procedure
1. Open the Object Properties window, e.g. using the pop-up menu.

2. On the Properties tab, select the Styles property group.

3. Double-click the Fill Pattern attribute. The Fill Pattern Selection dialog opens.

4. Select the fill pattern you want in the dialog.

5. Click OK to confirm your entries.

Alternative Operation
You can also change the fill pattern with the style palette.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with the Styles Property Group (Page 1588)
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8.5.8 Working with Standard Objects

8.5.8.1 Working with Standard Objects

Introduction
Standard objects include geometric shapes, static text, OLE objects, static metafiles, the 
dynamic objects and the system objects. You can use static objects to design the layout for 
the output. System objects can be used, as an example, to inscribe the project name and page 
numbers in the static part of the report. 

In the page layout editor, the various object types have predefined properties. When they are 
inserted the objects import these default properties, with the exception of individual geometric 
properties. After insertion the properties of an object can be modified. In the same way the 
default settings for the object types can be modified as required.

See also
Working with System Objects (Page 1631)

Working with Dynamic Standard Objects (Page 1618)

Working with Static Objects (Page 1589)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

8.5.8.2 Working with Static Objects

Working with Static Objects

Introduction
In this chapter, you will learn the details of the static objects available in the page layout editor. 
You will learn how to work with the objects, and what are the basic conditions for each object.
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Usage
Static objects are used for the visual design of a report. The static objects can be pasted into 
the static and dynamic parts of a layout.

See also
How to Paste an Object into a Layout (Page 1562)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Rectangle Surrounding the Object (Page 1560)

The Properties of an Object (Page 1570)

Overview of the Static Objects (Page 1527)

How to Draw a Line

Introduction
The line is an open object. The length and angle of a line are determined by the height and 
width of the rectangle around the object. Different line types, such as dashed or dotted, are 
available.
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Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to paste a line.

2. Click the "Line" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the 
line.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the line to the length and direction you want.         
When you release the mouse button, the line is finished.

Changing Lines with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing lines with value input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw a Polygon

Introduction
The polygon is a closed object that can be filled with a color or pattern. A polygon can have 
any number of corners. The corners are numbered in their sequence of creation and can be 
modified individually or deleted.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a polygon.

2. Click the standard object "Polygon" in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the 
polygon.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Click the selected starting point with the left mouse button.
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5. Move the mouse pointer to the next corner point. Click with the left mouse button to set the 
corner point. Set as many further corner points as you like in the same way.

6. Double-click with the left mouse button to set the last corner point and finish the polygon.

Changing Polygons with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Polygons with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)

How to Draw a Polyline

Introduction
The polyline is an open object. Even if the start and finish point have the same coordinates, 
the area cannot be filled. A polyline can have any number of corners. The corners are 
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numbered in their sequence of creation and can be modified individually or deleted. The line 
ends of a polyline can for example be shown as arrows or points.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a polyline.

2. Click the "Polyline" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the 
polyline.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Click the selected starting point with the left mouse button.

5. Move the mouse pointer to the next corner point. Click with the left mouse button to set the 
corner point. Set as many further corner points as you like in the same way.

6. Double-click with the left mouse button to set the last corner point and finish the polyline.
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Changing Polylines with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Polylines with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw an Ellipse

Introduction
The ellipse is a closed object that can be filled with a color or pattern. The height and width of 
an ellipse can be modified as desired to allow it to be aligned horizontally or vertically.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert an ellipse.

2. Click on the "Ellipse" standard object in the Object palette.
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3. Place the mouse pointer at the position in the layout where you want to insert the 
ellipse.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the ellipse to the size and direction you want.         
When you release the mouse button, the ellipse is finished.

Changing an Ellipse with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing an Ellipse with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw a Circle

Introduction
A circle is a closed object that can be filled with a color or pattern. A circle can be resized at 
will.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a circle.

2. Click the "Circle" standard object in the Object palette.
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3. Place the mouse pointer at the position in the layout where you want to insert the 
circle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the circle to the size and direction you want.         
When you release the mouse button, the circle is finished.

Changing Circles with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Circles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw an Ellipse Segment

Introduction
The ellipse segment is a closed object that can be filled with a color or pattern. The height and 
width of an ellipse segment can be modified as desired to allow it to be aligned horizontally or 
vertically. 

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert an ellipse segment.

2. Click the "Ellipse segment" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you wish to position the origin 
of the ellipse segment.         
The mouse pointer changes into a crosshair with an object symbol attached.
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4. Hold down the mouse button and drag the ellipse segment to the size and direction you 
want.         
When you release the mouse button, the ellipse segment insertion is finished.

5. The start and end points of the ellipse segment are shown by small gray squares. Place 
the mouse pointer on one of these squares. The mouse pointer will change to a cross.

6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Ellipse Segments with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing ellipse Segments with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

Note

Even if the values of the start and end angle are identical, an ellipse segment does not turn 
into a closed ellipse.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw a Pie Segment

Introduction
The pie segment is a closed object that can be filled with a color or pattern. A pie segment can 
be resized at will. 

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a pie segment.

2. Click in the "pie segment" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you wish to position the origin 
of the pie segment.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the pie segment to the size and direction you 
want.         
When you release the mouse button, the pie segment insertion is finished.
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5. The start and end points of the pie segment are shown by small gray squares. Place the 
mouse pointer on one of these squares. The mouse pointer will change to a cross.

6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Pie Segments with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Pie Segments with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

Note

Even if the values of the start and end angle are identical, a pie segment does not turn into 
a closed circle.

See also
Working with Standard Objects (Page 1589)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

How to Paste an Object into a Layout (Page 1562)
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How to draw an Ellipse Arc

Introduction
The ellipse arc is an open object. The height and width of an ellipse arc can be modified as 
desired to allow it to be aligned horizontally or vertically. 

Requirement
The display of the object palette must be enabled.

Procedure
1.  Open the layout in which you want to insert an ellipse arc.

2. Click the "Ellipse arc" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you wish to position the origin 
of the ellipse arc.         
The mouse pointer changes into a crosshair with an object symbol attached.
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4. Hold down the mouse button and drag the ellipse arc to the size and direction you 
want.         
When you release the mouse button, the ellipse arc insertion is finished.

5. The start and end points of the ellipse arc are shown by small gray squares. Place the 
mouse pointer on one of these squares. The mouse pointer will change to a cross.

6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Ellipse Arcs with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Ellipse Arcs with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

Note

Even if the values of the start and end angle are identical, an ellipse arc does not turn into a 
closed ellipse.

 

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw a Circular Arc

Introduction
The circular arc is an open object. A circular arc can be resized at will.

Requirement
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a circular arc.

2. Click the "Circular arc" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you wish to position the origin 
of the circular arc.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the circular arc to the size and direction you 
want.         
When you release the mouse button, the circular arc insertion is finished.
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5. The start and end points of the circular arc are shown by small gray squares. Place the 
mouse pointer on one of these squares. The mouse pointer will change to a cross.

6. Drag the start or end point to the desired position while holding down the mouse button.

Changing Circular Arcs with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Circular Arcs with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

Note

Even if the values of the start and end angle are identical, a circular arc does not turn into a 
closed circle.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw a Rectangle

Introduction
The rectangle is a closed object that can be filled with a color or pattern. The height and width 
of a rectangle can be modified as desired to allow it to be aligned horizontally or vertically.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a rectangle.

2. Click the "Rectangle" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the 
rectangle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the rectangle to the size and direction you 
want.         
When you release the mouse button, the rectangle is finished.
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Changing Rectangles with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Rectangles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Draw a Rounded Rectangle

Introduction
The rounded rectangle is a closed object that can be filled with a color or pattern. The height 
and width of a rounded rectangle can be modified as desired to allow it to be aligned horizontally 
or vertically. The corners of a rounded rectangle can be rounded as much as desired.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert a rounded rectangle.

2. Click the "Rounded rectangle" standard object in the Object palette.
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3. Place the mouse pointer at the position in the layout where you want to insert the rounded 
rectangle.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the rounded rectangle to the size and direction you 
want.         
When you release the mouse button, the rounded rectangle is finished.

Changing Rounded Rectangles with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Rounded Rectangles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

Note

If the "corner radius X" and "corner radius Y" attributes are both set to the value of 100pt, 
1cm or 1, depending on the units, the rounded rectangle will be displayed as an ellipse or 
circle. If both attributes have a value of 0, a normal rectangle without rounded corners will be 
displayed.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Insert Static Text

Introduction
The field for static text is a closed object that can be filled with a color or pattern. The static 
text is entered into a field of any desired size. The text can be entered on one or more lines.

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to insert static text.

2. Click the "static text" standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the static 
text.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the text field to the required size.         
The field for the static text is complete as soon as you release the mouse button.         
The word Text appears in the field.
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5. Overwrite the Text with your own text.         
For text on multiple lines, create a line break by pressing the ENTER key, the key 
combination SHIFT+ENTER or the key combination CTRL+M.

6. Clicking outside the object ends the text input.

Changing the Contents of the Static Text
Double-click the static text to open the input mode for text. The complete text is selected. 
Position the insertion point with another click at the position in the text at which you want to 
change something. For text on multiple lines, create a line break by pressing the Enter key, 
the key combination "Shift"+"Enter" or the key combination "Ctrl"+"M".

Changing Static Text with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Static Text with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

Note

In the "Font" property, "Text" attribute a line break will be displayed as a control character in 
the "Static" column. If the text is edited using the dialog for the "Text" attribute, no line breaks 
can be added.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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How to Insert an OLE Object

Introduction
The OLE object enables you to insert files created with other programs into a layout. Therefore 
all OLE elements registered in the Windows operating system can be integrated. The size and 
properties taken on by an OLE object in runtime are defined in the page layout editor. No 
changes can be made to OLE elements in runtime.

Requirements
● The display of the object palette must be enabled.

● The file type you wish to use must be registered in the Windows operating system.

Insert the OLE object, option "Create from file".
With the option "Create from file", an already existing file is chosen for display in the selected 
OLE object. The selected file is edited in the OLE object with the program that is registered 
for editing the selected file type in the Windows operating system.
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1. Open the layout in which you want to paste an OLE object, and click the standard object 
"OLE object" in the Object palette.

2. Place the mouse pointer at the position in the layout where you want to insert the OLE 
object.         
The mouse pointer changes into a crosshair with an object symbol attached.

3. Drag the OLE object to the desired size.         
The "Insert Object" dialog is opened.

4. Select option Create from File.         
In the "Paste object" dialog, an input field, the "Browse..." button and the "Link" check box 
are displayed.

5. Enter the directory path and the name of the desired file into the input field. Or click on the 
"Browse..." button to select the file with the "Browse" dialog.

6. Mark the "Link" check box if the selected file should not be copied to the OLE object, but 
rather should only be used as a reference.

7. Mark the "As icon" check box if only an icon for the associated file type should be displayed 
and not the contents of the selected file.

8. Confirm your entry with "OK". The insertion process for the OLE object is finished.

Inserting the OLE object, "Create new" option.
The "Create new" option selects a file type for a new file that is created in the selected OLE 
object. During editing, the file in the OLE object is edited with the program registered in the 
Windows operating system for editing the selected file type.

1. Open the layout where you want to paste an OLE object, and click on the "OLE object" in 
the Object palette.

2. Place the mouse pointer at the position in the layout where you want to insert the OLE 
object.         
The mouse pointer changes into a crosshair with an object symbol attached.

3. Drag the OLE object to the desired size.         
The "Insert Object" dialog is opened.

4. Select the option Create New.         
The Insert Object dialog, a list of all file types registered in the Windows operating system 
is displayed.

5. Select the object type for the file that you want to create in the selected OLE object.

6. Mark the "As icon" check box if only an icon for the associated file type should be displayed 
and not the contents of the selected file.

7. Confirm your entry with "OK". The insertion process for the OLE object is finished.
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8. Double-click the OLE object to edit the embedded file in the OLE object.          
The program registered in the Windows operating system for editing the associated file 
type opens in the page layout editor.

9. Finish editing the embedded file by deselecting the OLE object.         
The changes are accepted.

Changing OLE Objects with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing OLE Objects with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)

How to Insert a Static Metafile

Introduction
The static metafile field is a closed object that can be filled with a color or pattern. A graphic 
file of any size is entered into the field.

Requirements
● The display of the object palette must be enabled.

● The graphic file must be in the *.emf format.
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Procedure
1. Open the layout in which you want to insert a static metafile.

2. Click the Static Metafile standard object in the Object palette.

3. Place the mouse pointer at the position in the layout where you want to insert the static 
metafile.         
The mouse pointer changes into a crosshair with an object symbol attached.

4. Hold down the mouse button and drag the object to the size and direction you want.         
When you release the mouse button, the static metafile is finished.

5. Double-click the Metafile Name attribute in the Miscellaneous property group of the Object 
Properties window in order to enter the name of the graphic file.

6.  A file dialog opens in which you can select the graphic file you want in the *.emf format.

7. Confirm the selected file with the Open button. The selected graphic file will be inserted in 
the object.

Changing Static Metafiles with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Static Metafiles with Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in section Changing Attribute.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Standard Objects (Page 1589)

How to Paste an Object into a Layout (Page 1562)
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8.5.8.3 Working with Dynamic Standard Objects

Working with Dynamic Standard Objects

Introduction
In this chapter you will learn details about the dynamic standard objects available in the page 
layout editor. You will learn how to work with the objects, and what are the basic conditions 
for each object.

Usage
With dynamic standard objects you link to tags, databases and screen contents that you wish 
to output in a log. You can only paste dynamic standard objects in the dynamic part of a page 
layout. 

See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Rectangle Surrounding the Object (Page 1560)

The Properties of an Object (Page 1570)

How to Paste an Object into a Layout (Page 1562)

Overview of the Dynamic Objects (Page 1528)

Working with Embedded Layouts

Introduction
With the "Embedded layout" dynamic object you can embed one layout in another and output 
both of them together. However, the layouts cannot be nested in just any fashion. A maximum 
of one layer of embedded layouts can be used. An embedded layout within an embedded 
layout is not permitted. If dynamic objects are used in an embedded layout, these also cannot 
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be mixed in just any fashion. The following illustrations will clarify the options for using 
embedded layouts.

Possible combinations: Layouts B1, B2 and a log object are directly embedded in Layout A1. 
An embedded layout with several log objects of the same type is embedded in layout A2.
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Non-permitted combinations: The embedded layout B4 contains several dynamic tables of 
different WinCC components. In layout A4 the nesting depth is too large.

Purpose
The functionality of the "Embedded layout" object is used, for example, with the project 
documentation of pictures from the Graphics Designer. The configuration data of all pictures 
in a WinCC project are output with the "@PdlPic" layout in this way. The data are output in 
blocks for every picture. The output thus occurs in this form:

Picture 1

- output of all data for picture 1

Picture 2

- output of all data for picture 2

Picture n

- output of all data for picture n

If the objects for the project documentation are pasted from the object palette one after the 
other into a layout, then the data of the current object will be collected and output. The output 
then occurs in this form:

Object 1

- output of object data for picture 1, picture 2, picture n

Object 2
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- output of object data for picture 1, picture 2, picture n

Object n

- output of object data for picture 1, picture 2, picture n

For the runtime configuration, the necessary log objects can be filed in a structure. Thus for 
example, additional information you want can be configured in a separate layout and output 
as an embedded layout.

Example:

The output of a tag logging - variable curve is configured in a page layout. Several report 
objects of the "Tag" type, which are to be output in the log for the current measured values of 
the curve, are configured in a layout to be embedded. Additionally, a WinCC tag will be 
configured which forms a mean value via a script. The mean value will likewise be output with 
the "Tag" log object.

Applications

Print job Layout used Function

@Documentation 
Graphics Designer 
Dynamics

@PDLPicDyn Nested layout for outputting the dynamization data of a 
Graphics Designer picture.

@Documentation 
Graphics Designer

@PDLPic Nested layout for outputting the general display, statistics 
data, objects in the picture, picture attributes, actions on 
the picture, direct connections to the picture, object 
statistics, attributes of the objects, actions on the objects, 
and direct connections to objects. The data is output on a 
separate page for each picture.

@Documentation 
Global Script Project 
Function

@GSC_RPFC Nested layout for outputting the information and source text 
of the project functions. Output is started in WinCC 
Explorer.

@Documentation 
Global Script 
Standard Function

@GSC_SFC Layout for outputting information and the source text for a 
standard function open in the Global Script editor.

How to Change the Output Options for the Hardcopy Object

Introduction
With the "Hardcopy" object type, you can paste a shot of the current screen contents, a portion 
thereof, or a currently selected picture window in the dynamic part of a page layout.

Requirements
● The hardcopy object is already pasted into the layout

● The inserted object has been selected.

● The "Object properties" window is open

● You are familiar with the Link tab.
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Procedure
1. Select "Area selection" from the "Name" column in the right area of the Link tab. Clicking 

on the "Edit..." button opens the "Area selection" dialog.

2. From the selection list, choose the area from which you want to prepare a hard copy for 
the report.

3. The configured area is static. You can, however, link a WinCC tag in order to change the 
area to dynamic in runtime. The report system reads the value from the variable at runtime. 
If the variable cannot be read, the configured value is used.          
The WinCC tag must be of the Number type. The numbers have the following 
significance:         
0 – Hard copy of the entire screen         
1 – Hard copy of the current window         
2 – Hard copy of a section

4. If you have selected "Hardcopy of a section", you must enter the X and Y positions of the 
upper left corner of the area in the lower part of the dialog, as well as set the width and 
height of the section in pixels.

5. The numeric values for setting the section can also be dynamized using WinCC tags. The 
WinCC tags must be of the number type. The report system reads the value from the 
variable at runtime. If the variable cannot be read, the configured value is used.

6. If you want to maintain the proportions of the screen contents during printing, select the 
appropriate check box.

Dynamizing with WinCC tags
In order to dynamize parameters for output, the necessary tags must be set in the WinCC tag 
management. WinCC tags can be provided with new values in runtime. You can find further 
information on this subject in the section "Changing output options online".

Changing Hardcopy Objects with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.
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Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Hardcopy Objects by Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Dynamic Standard Objects (Page 1618)

How to Paste an Object into a Layout (Page 1562)

How to Change the Output Options for the ODBC Database Field

Introduction
With the "ODBC database field" object, you can paste the contents of a database field as text 
in the dynamic part of a page layout via the ODBC interface. If the content of the database 
field concerns a text object, only the first value of the first line will be delivered, independent 
of the size of the volume of results.

Requirements
● The "ODBC database field" object is already pasted into the layout

● The inserted object has been selected.

● The "Object properties" window is open

● You are familiar with the Link tab.

● A valid ODBC data source exists and is registered

● Knowledge of ODBC and SQL
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Procedure
1. Select "Database link" from the "Name" column in the right area of the Link tab. Click the 

"Edit..." button to open a configuration dialog.

2. Use the selection list in the "ODBC data source" area to select the desired data source. All 
registered ODBC data sources are available for selection. The project creator is responsible 
for the registration and validity of the data sources.

3. If the data source has any database-specific access limitations, enter the necessary 
information in the fields for the user and password.

4. The selection of the data for output takes place using an SQL statement. Enter the required 
statement in the SQL statement area. Using the "Insert tag..." button, you can insert a tag 
into the SQL statement in order to complete it at runtime.

5. You can check your entries by using the "Test SQL statement" button. The project must be 
activated for the check when using WinCC tags.

6. Confirm your entries by clicking "OK". The dialog closes.

7. Save the layout.

Dynamizing with WinCC tags
All the tasks in this dialog can also be dynamized with WinCC tags. To do so, activate the 
"Tag" checkbox in the "Data connection" dialog and select a tag form the tag selection dialog 
using the folder button. If you know the tag name, you can enter it directly instead. The tags 
must all be of the "Text" type. 

In order to dynamize parameters for output, the necessary tags must be set in the WinCC tag 
management. WinCC tags can be provided with new values in runtime. You can find further 
information on this subject in the section "Types of dynamization".

CAUTION

The SQL statements are not subject to any constraints. If you do the wrong thing, it is possible 
to destroy or delete the data source. 
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Changing the ODBC database field with the mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing the ODBC database field by entering values
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Paste an Object into a Layout (Page 1562)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Dynamic Standard Objects (Page 1618)

How to Change the Output Options for the ODBC Database Table

Introduction
With the "ODBC database table" object, you can paste the contents of a database table as 
text in the dynamic part of a page layout via the ODBC interface.

Requirements
● The "ODBC database table" object is already pasted into the layout

● The inserted object has been selected.

● The "Object properties" window is open

● You are familiar with the Link tab.

● A valid ODBC data source exists and is registered

● Knowledge of ODBC and SQL
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Procedure
1. Select "Database link" from the "Name" column in the right area of the Link tab. Click the 

"Edit..." button to open a configuration dialog.

2. Use the selection list in the "ODBC data source" area to select the desired data source. All 
registered ODBC data sources are available for selection. The project creator is responsible 
for the registration and validity of the data sources.

3. If the data source has any access limitations, enter the necessary information in the fields 
for the user and password.

4. The selection of the data for output takes place using an SQL statement. Enter the required 
statement in the SQL statement area. The example refers to the MCPTVARIABLEDESC 
table from the WinCC database. Using the "Insert tag..." button, you can insert a tag into 
the SQL statement in order to complete it at runtime.

5. You can check your entries by using the "Test SQL statement" button. If the test is 
successful, then the number of columns found in the "Number of columns" field will be 
applied. The project must be activated for the check when using WinCC tags.

6. If the column headings are to be output, then confirm this by marking the accompanying 
check box. Confirm your entries by clicking "OK". The dialog is closed.

7. Save the layout.
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Dynamizing with WinCC tags
All the tasks in this dialog can also be dynamized with WinCC tags. To do so, activate the 
"Tag" checkbox in the "Data connection" dialog and select a tag form the tag selection dialog 
using the folder button. If you know the tag name, you can enter it directly instead. The tags 
must all be of the "Text" type. 

In order to dynamize parameters for output, the necessary tags must be set in the WinCC tag 
management. WinCC tags can be provided with new values in runtime. You can find further 
information on this subject in the section "Types of dynamization".

Formatting the table output
You can format the table output by including the formating instructions in the SQL statement 
with the help of control characters. The formating is as follows for the example of the text 
alignment in the table:

Format statement Representation

SELECT tag name FROM MCPTVARIABLEDESC aligns by default the column text to the left
SELECT tag name as '<ALIGN=right> tag name ' 
FROM MCPTVARIABLEDESC

aligns the column text including column title to the 
right

SELECT '<ALIGN=right>' + tag name as Name' 
FROM MCPTVARIABLEDESC

aligns the column title towards the left and the 
column text to the right

SELECT '<ALIGN=left>' + tag name as 
'<ALIGN=center> Name' FROM 
MCPTVARIABLEDESC

aligns the column title in the center and the column 
text to the left

Control Characters for Table Output

<END> If the interpretation of control sequences is done, the rest of the 
text will be transferred as it is given.

<COLOR=#rrggbb> Font color in hexadecimal notation (default = as set for the table)
<BGCOLOR=#rrggbb> Background color in hexadecimal notation (default = as set for the 

table)
<B> Bold
<U> Underlined
<I> Italic
<STRIKE> Strike-through
<ALIGN=left> Left aligned
<ALIGN=center> Centered
<ALIGN=right> Right aligned

CAUTION

The SQL statements are not subject to any constraints. If you do the wrong thing, it is possible 
to destroy or delete the data source.
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Change Column Width
The width of the columns for output can be set individually for every column.

1. Enable the properties tab in the "Object properties" window.

2. In the "Geometry" property group double-click the "Columns" attribute to open the "Table 
columns" dialog.

3. Use the dialog to define the column width of the individual columns. The widths of the 
columns can be changed relative to one another. Every column will receive its assigned 
share of the total width.

4. Confirm your entries with "OK".

Changing ODBC Database Tables with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing the ODBC Database Table by Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in the section entitled "Change Attribute".

See also
How to Change an Attribute (Page 1576)

How to Transfer Object Properties (Page 1577)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Dynamic Standard Objects (Page 1618)

How to Paste an Object into a Layout (Page 1562)

Creating Page Layouts
8.5 Working with Objects

MDM - WinCC: Working with WinCC
1628 System Manual, 11/2008,  



Working with the Tag Object

Introduction
With the Tag dynamic object, you can output the tag value or the return value of a C action 
during configuration in runtime.

Procedure
1. Open the layout in which you want to insert a Tag object.

2. In the Object Palette, click the standard object Tag.

3. Place the mouse pointer at the position in the layout where you with to insert the 
tag.          
The Tag Selection dialog is opened.

4. Select the tag you want from the list of WinCC tags and confirm your selection with the OK 
button. The Output Value attribute now contains this tag.

Linking a Script
Using the Calculation attribute in the Miscellaneous object property, you can call up a script 
for the output. Then a tag must not be selected.

1. If no script has been specified, then the Create a New Script option field is enabled. After 
confirmation of this dialog, the Edit Action dialog opens. In this dialog you can formulate an 
action in the high-level language ANSI-C.

2. Set the data type for the return value in the Return Value field. You can only set the data 
type while creating the script; it is not possible to change it later.         
The following data types are available: long, double and char.

3. If a script has already been specified, then you can edit this script by selecting the option 
Edit an Existing Script

4. Select the option Delete an Existing Script to delete the specified script without a query 
when the dialog is confirmed.

Setting the Output Format
You can set the display of the output value with the Output Format attribute. The display 
depends on the data type.

Data type Format Description

Binary 1 Every 1 stands for a character of the output value. A preceding 0 
indicates that a leading zero (corresponding to the number position) will 
be added if necessary.

String * the existing string will be output
String ? n characters will be output, starting from the left.
Hexadecimal f Every f stands for a character of the output value. A preceding 0 

indicates that a leading zero corresponding to the number position will 
be added if necessary.
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Data type Format Description

Decimal s the sign will be output
Decimal e Exponent display
Decimal 9 digit between 0 and 9
Decimal 0 Leading zero will be output
Decimal .  Decimal point

Example for the Output
The example shows the different output formats for the output of the value 1.0 of the Decimal 
data type. 

Output format Display

9.9 1.0
s9.9 +1.0
s9.99e +1.0e+000
099.99 01.00

Changing a Tag Object with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing Tag Objects by Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in chapter Changing Attribute.

See also
Working with Dynamic Standard Objects (Page 1618)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

How to Paste an Object into a Layout (Page 1562)
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8.5.8.4 Working with System Objects

Introduction
The following system objects can be output in a report:

● date and time

● Page number

● Project name

● Layout name

You can only paste system objects into the static part of a page layout.  

Requirements
The display of the object palette must be enabled.

Procedure
1. Open the layout in which you want to paste a system object.

2. Select Static Part from the View menu.

3. Click the system object you want on the Standard Objects tab in the object palette.

4. Place the mouse pointer at the position in the layout where

5. Hold down the mouse button and drag the object to the size and direction you want.         
When you release the mouse button, the system object is finished.

Format Options
You can set the display of the output value with the following format options. The representation 
is dependent on the data format. If no format is set, a predefined format will be used for all 
system objects during the report output.

System object Format Description

Layout name %L or %l the layout name
Project name %R or %r the project name
Page number %N or %n the current page number
Page number %T or %t the total page count
Date/Time %a Weekday, short form
Date/Time  %A Weekday, written out
Date/Time %b Month, short form
Date/Time %B Month, written out
Date/Time %c Date and time in standard format
Date/Time %d Day and month as decimal number (01-31)
Date/Time %H Hours in 24 hour format (00-23)
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System object Format Description

Date/Time %I Hours in 12 hour format (01-12)
Date/Time %j Day of the year as a decimal number (000-366)
Date/Time %m Month as decimal number (01-12)
Date/Time %M Minute as decimal number (00-59)
Date/Time %p P.M./A.M. code for 12-hour format
Date/Time %S Seconds as decimal number(00-59)
Date/Time %U Week of the year as decimal number (01-51)
Date/Time %x Date in standard format
Date/Time %X Time in standard format
Date/Time %y Year without century as decimal number (00-99)
Date/Time %Y Year with century as decimal number
Date/Time %z Time zone as name
Date/Time %% Percentage sign

Changing System Objects with the Mouse

Rectangle surrounding the object
Drag the rectangle surrounding the object to a new position in order to arrange the object in 
the layout.         
Drag the handles on the rectangle surrounding the object to a new position in order to resize 
the object.

Palettes and toolbars
Use elements of the Style Palette to change the display style for the object.

Changing System Objects by Value Input
The display of objects can also be changed by entering new values in the attributes. You will 
find more information in chapter Changing Attribute.

See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

How to Paste an Object into a Layout (Page 1562)

Overview of the System Objects (Page 1529)
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8.5.8.5 Working with the Layout Object

Introduction
A layout opened in the page layout editor is treated as an object. The layout object has object 
properties and can be edited Object Properties dialog. However, the properties of the layout 
object cannot be transferred to another layout object using the eyedropper.

The layout object has the following property groups:

● Colors

● Geometry

● Miscellaneous

You can obtain further information in the descriptions of the individual property groups in 
chapter Properties of an Object.

Requirements
A layout must be open in the page layout editor.

Procedure
1. Click with the mouse on any free space in the working area. Click the Properties button in 

the toolbar. The Object Properties dialog will open.

2. Click the Properties tab.

3. Select the property group you want from the left area. The available attributes are shown 
in the right area.

4. Edit the attributes you want.

5. Save your changes.

In principle, changes to the properties of a layout object effect the cover sheet, the report 
contents and the closing page. 

The object name of the layout object is not displayed in the object selection of the Object 
Properties dialog. Therefore, the layout object cannot be selected in the Object Properties 
dialog using the object selection. If the Object Properties dialog is already open and fixed with 
the pin, then simply click any free area of the work area for selection. 

See also
The Miscellaneous Property Group (Page 1585)

The Geometry Property Group (Page 1581)

The Colors Property Group (Page 1579)
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8.5.9 Working with Objects for the Runtime Documentation

8.5.9.1 Working with Objects for the Runtime Documentation

Introduction
The following chapters provide details regarding the Page Layout Editor objects available for 
the runtime documentation. 

Application
The runtime documentation objects are available for the output of runtime data in logs. The 
objects are linked with the pertinent WinCC applications and provide the output data in runtime. 
The objects for runtime documentation can only be inserted in the dynamic part of a page 
layout.

Configure only the basic properties of the layout for the "WinCC Control Runtime Printprovider" 
object. The report parameters for the output are determined by properties of the WinCC Control 
and cannot be assigned dynamic properties. 

In addition to the basic properties, configure the static and dynamic report parameters of the 
layout for all other objects of the Runtime documentation. The objects provide dialogs for the 
selection of output data. 

See also
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 1651)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Rectangle Surrounding the Object (Page 1560)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

How to Configure the Static Parameters of WinCC Online Table Control (Page 1635)

How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 1638)

How to Configure the Static Parameters of WinCC Online Trend Control (Page 1640)

How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 1643)

How to Configure the Static Parameters of WinCC Function Trend Control (Page 1645)

Configuring the dynamic parameters of the WinCC Function Trend Control (Page 1647)

How to Configure the Static Parameters of WinCC Alarm Control (Page 1649)

Objects for the Runtime Documentation (Page 1529)
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8.5.9.2 Modify output options for WinCC Online Table Control

How to Configure the Static Parameters of WinCC Online Table Control

Introduction
The "WinCC Online Table Control/Table" report object is used to output process data from the 
associated Tag Logging Archives in a tabular format.

You can define static parameters for each column of the table and for some proper properties 
of Control. 

Requirements
● The WinCC Online Table Control/Table object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Process value archives or compression archives are inserted

● Archive tags have been inserted

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The 

dialog with the Control properites is displayed.

2. Configure in the Columns tab the columns you want to output. Select an archive tag for 
each column.
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3. Define the table properties in the General tab. Only the non-grayed options can be 
customized for report output.

4. Configure the time range to be considered for each column in the Column tab.
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You can enter a start time and an end time or a start time with a time range. If the "Update" 
checkbox is activated, the start time refers to the current time. The previous values are then 
output in the defined time interval. 

1. Configure the time and value display formats in the Column tab.

See also
How to Configure the Dynamic Parameters of WinCC Online Table Control (Page 1638)
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How to Configure the Dynamic Parameters of WinCC Online Table Control

Introduction
The "WinCC Online Table Control/Table" report object is used to output process data from the 
associated Tag Logging Archives in a tabular format.

You can define dynamic parameters for each column of the table and for some proper 
properties of Control. 

For a print order, the dynamizable parameters of WinCC Online Table Control are provided 
with the current values of the assigned WinCC tags during runtime. 

Value are supplied to WinCC tag through scripts, process-controlled actions or via other 
WinCC applications. An overview of the dynamizable Runtime documentation parameters is 
included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The WinCC Online Table Control/Table object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Process value archives or compression archives are inserted

● Archive tags have been inserted

● You have inserted the columns for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized 

Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property you want to dynamize. When you click with the 
mouse the "?" icon, you will get the following information:

– Description of the properties

– Format of the properties

– Suitable tag type

3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.

4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection 
dialog. If necessary, specify a start value for the tag.

5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Online Table Control (Page 1635)

Dynamizable Parameters for Runtime Documentation (Page 1479)
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8.5.9.3 Modify output options for WinCC Online Trend Control

How to Configure the Static Parameters of WinCC Online Trend Control

Introduction
The "WinCC Online Trend Control/Picture" report object is used to output process data from 
the associated Tag Logging Archives in the form of a trend.

You can define static parameters for each trend and for some properties of Control. 

Requirements
● The WinCC Online Trend Control/Picture object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Process value archives or compression archives are inserted

● Archive tags have been inserted

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The 

dialog with the Control properites is displayed.

2. Configure in the Columns tab the columns you want to output.

– Select an archive tag for each trend

– Define the display format for each trend

– Define the display line weight for each trend
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3. Define the Control properties in the General tab. Only the non-grayed options can be 
customized for report output.

4. Configure the time range or measurement range for each trend in the "Time Axis" tab.
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To output values for a time range, either define the start time or the end time or a start time 
with a time range. To output values for a measurement range define the start time and the 
number of measuring points.

If the "Update" checkbox is activated, the start time refers to the current time. The previous 
values are then output in the defined time interval or measurement range.

1. For each trend, comfigure the properties of the value axis in the Value Axis tab.

See also
How to Configure the Dynamic Parameters of the WinCC Online Trend Control (Page 1643)
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How to Configure the Dynamic Parameters of the WinCC Online Trend Control

Introduction
The "WinCC Online Trend Control/Picture" report object is used to output process data from 
the associated Tag Logging Archives in the form of a trend.

You can define dynamic parameters for each trend and for some properties of Control. 

For a print order, the dynamizable parameters of WinCC Online Trend Control are provided 
with the current values of the assigned WinCC tags during runtime. 

Value are supplied to WinCC tag through scripts, process-controlled actions or via other 
WinCC applications. An overview of the Runtime documentation parameters that can be 
dynamized is included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The WinCC Online Trend Control/Picture object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Process value archives or compression archives are inserted

● Archive tags have been inserted

● You have inserted the trends for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized 

Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property you want to dynamize. When you click in the list the 
"?" icon, you will get the following information:

– Description of the properties

– Format of the properties

– Suitable tag type

3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.

4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection 
dialog. If necessary, specify a start value for the tag.

5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Online Trend Control (Page 1640)

Dynamizable Parameters for Runtime Documentation (Page 1479)
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8.5.9.4 Modify output options for WinCC Function Trend Control

How to Configure the Static Parameters of WinCC Function Trend Control

Introduction
The "WinCC Function Trend Control/Picture" report object is used to output process data as 
function of another tag from the process value, compression and user archives in the form of 
a trend.

You can define static parameters for each trend and for some properties of Control. 

Requirements
● The WinCC Function Trend Control/Picture object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Process value archives, compression archives or user archives are inserted

● Archive tags have been inserted

Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The 

dialog with the Control properites is displayed.

2. Configure in the Columns tab the columns you want to output.

– Configure, if required, the setpoint trend for each trend

– Define the display format for each trend

– Define the display line weight for each trend
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3. Define the Control properties in the General tab. Only the non-grayed options can be 
customized for report output.

4. In the Data Link tab, configure the data supply for the trends with archive tags or from user 
archives.

5. In the X-Axis and Y-Axis tabs, configure the axis properties for each trend.

See also
Configuring the dynamic parameters of the WinCC Function Trend Control (Page 1647)
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Configuring the dynamic parameters of the WinCC Function Trend Control

Introduction
The "WinCC Function Trend Control/Picture" report object is used to output process data as 
function of another tag from the process value, compression and user archives in the form of 
a trend.

You can define dynamic parameters for each trend and for some properties of Control. 

For a print job, the dynamizable parameters of WinCC Function Trend Control are provided 
with the current values of the assigned WinCC tags during runtime. 

Value are supplied to WinCC tag through scripts, process-controlled actions or via other 
WinCC applications. An overview of the Runtime documentation parameters that can be 
dynamized is included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The WinCC Function Trend Control/Picture object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Process value archives, compression archives or user archives are inserted

● Archive tags have been inserted

● You have inserted the trends for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized 

Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property of a trend or control you want to dynamize. When 
you click with the mouse the "?" icon, you will get the following information:

– Description of the properties

– Format of the properties

– Suitable tag type

3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.

4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection 
dialog. If necessary, specify a start value for the tag.

5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Function Trend Control (Page 1645)

Dynamizable Parameters for Runtime Documentation (Page 1479)
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8.5.9.5 Modify output options for WinCC Alarm Control

How to Configure the Static Parameters of WinCC Alarm Control

Introduction
The "WinCC Alarm Control/Table" report object is used to output the message lists in a tabular 
format.

For the output, define a message list and configure the static parameters of the message list. 

Requirements
● The "WinCC Alarm Control/Table" object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Message configuration has been carried out in Alarm Logging
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Parameterization". The 

dialog with the Control properites is displayed.

2. Define the message list you want to output in the General tab. Configure the Control 
properties. Only the non-grayed options can be customized for report output.
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3. In the Message Blocks tab, configure the message blocks that are to be considered for the 
message list output.

4. Assign the message blocks to the table columns of the message list in the Message List 
tab. Click the "Selection..." button to open a dialog where you define the messages you 
want to output.

See also
How to Configure the Dynamic Parameters of WinCC Alarm Control (Page 1651)

How to Configure the Dynamic Parameters of WinCC Alarm Control

Introduction
The "WinCC Alarm Control/Table" report object is used to output the message lists in a tabular 
format. 

You can define dynamic parameters for output to message lists. 

In Runtime, the dynamic parameters are read from the system and written to the WinCC tags. 
The start values of the tags are overwritten. 
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Value are supplied to WinCC tag through scripts, process-controlled actions or via other 
WinCC applications. An overview of the Runtime documentation parameters that can be 
dynamized is included in chapter Dynamizable Parameters for Runtime Documentation.

Requirements
● The "WinCC Alarm Control/Table" object is pasted into the layout.

● The inserted object has been selected.

● The "Object properties" window is open

● Message configuration has been carried out in Alarm Logging

● You have configured the message list for the output via the static parameters.
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Procedure
1. In the "Link" tab of the "Object Properties" window, click the entry "Dynamized 

Parameterization". The dialog with the list of dynamizable properties opens.

2. In the Parameter list, click the property you want to dynamize. When you click with the 
mouse the "?" icon, you will get the following information:

– Description of the properties

– Format of the properties

– Suitable tag type

3. Click the tag selection symbol on the upper right side. The tag selection dialog is displayed.

4. Select the desired tag, or create a new tag. Edit the properties of the tag in the tag selection 
dialog. If necessary, specify a start value for the tag.

5. Apply the settings by clicking OK and save the layout.

See also
How to Configure the Static Parameters of WinCC Alarm Control (Page 1649)

Dynamizable Parameters for Runtime Documentation (Page 1479)
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8.5.9.6 Changing Output Options for Message Reports from Alarm Logging

How to Change the Output Options for Message Reports from Alarm Logging Runtime

Introduction
You can control the output of messages from the message list or from the message archive 
in Runtime in advance via a user-specific selection of messages.

Overview
The following layouts are available for alarm logging in Runtime in the page layout editor:

Archive report The layout is linked to the Alarm Logging message archive and serves to 
display the messages recorded there in a log.

Message report The layout is linked to the Alarm Logging Runtime and serves to display 
the current message list in a log. The layout also provides a message 
sequence report in a page layout.

The output data selection procedure is the same for both layouts. In the following, the steps 
are described for the message report.

In order to return a user-specific selection of messages, you can use a pre-defined layout, or 
create your own layout. You can also create multiple layouts, filter the messages through the 
selection criteria, and return them in separate logs. For the layout output, you need to configure 
a job. See  for more information.

Requirements
● The object "Message report" has already been inserted in the layout

● The inserted object has been selected

● The "Object properties" window is open

● You are familiar with the Link tab.

● Message configuration has been carried out in Alarm Logging.

Editing Options
For the objects "Archive report" and "Message report", you can select the data from the 
message system as well as the time base.

Creating Page Layouts
8.5 Working with Objects

MDM - WinCC: Working with WinCC
1654 System Manual, 11/2008,  



Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "Selection" 

in the list of editing options. The "Alarm Logging Runtime: Log Tables - Selection" dialog 
opens.

2. Select the output data using the dialog. The dialog is described under "Selection of data 
for a message report".

3. Apply the settings by clicking "OK".

See also
How to Modify the Time Range (Page 1655)

Filter Criteria for the Alarm Output (Page 1699)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Runtime Documentation (Page 1634)

Selection of the Data for a Message Report (Page 1656)

How to Modify the Time Range

Introduction
By changing the base for time specifications, you can convert the indicated time in the time 
stamp to a different time base. These indicated times are only converted for output in the log; 
they are not written back to the Alarm Log or Tag Log, or user archives. If, for example, you 
want to output the data of a remote computer in another time zone, you can use this function 
to ensure that the data is output with a comparable time. If, in this case, both computers worked 
with the time base "Local Time", the two systems would contain logs with different time 
specifications. The results would not be directly comparable. You can find additional 
information in the section "Adjusting the Time Settings in the Project".

If you change the time base for the output, ensure that the time reference is also output in the 
report. For example, specify an identifier in the alias for the "Time" message block. For more 
details, please refer to "Selection of data for a message report".

Requirements
● The object "Message report" has already been inserted in the layout

● The inserted object has been selected.

● The "Object properties" window is open

● You are familiar with the Link tab.

● Message configuration has been carried out in Alarm Logging.
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Edit Options
For the objects "Archive report" and "Message report", you can select the data from the 
message system as well as the time base.

Procedure
1. In the "Object Properties" window, you can also change the base for time specifications. 

To do that, double-click the entry "Base for time specifications" in the list of editing options. 
The following dialog will open.

2. Select the required time base and confirm your selection with "OK".

3. Modify the external form of the object, if necessary, by changing the attribute values in the 
Properties tag.

4. Close the "Object Properties" dialog and save the layout.

See also
How to Change the Output Options for User Archive Tables (Page 1658)

How to Change the Output Options for Message Reports from Alarm Logging Runtime 
(Page 1654)

Selection of the Data for a Message Report

Data Selection
The "Alarm Logging Runtime: Report Table Column Selection dialog is used to select the data 
to output in the message report or the message archive report. It allows you to select the 
servers, message blocks, and filter criteria for alarm output.
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Selecting the Servers
Server selection is only necessary if you: 

● generate the message reports on a WinCC Client.         
         
or

● in distributed systems, generate the message reports for one server on another server.

In the "Selection: Server from the Project Data" area, you can select the servers whose 
messages are to be logged. Only those servers whose "packages" have been loaded are 
offered. The selected servers are displayed in the window. In the case of a single-user and 
multi-user project this selection is not required.

Dynamization of Server Selection by Means of a WinCC Variable
You can dynamize server selection in order to select servers when a project is activated directly 
before logging is started. The report system reads the value from the variable at runtime. If the 
variable cannot be read, the configured value is used.

1. Select the "Variable" check box. The text box and the folder button are activated.

2. Use the folder button to open the variable selection dialog. Select the desired variable there, 
and close the variable selection dialog. Alternatively, enter the variable name directly in the 
text box.

Configure value assignment to the WinCC variable. You will find more information in the section 
"Types of Dynamization".

Selecting Message Blocks
In the "Assignment: Message Blocks -> Table Columns" area, you can define the message 
blocks for output in the report. In the "Message Blocks" area, select the desired message 
blocks from the list of existing message blocks. Insert the message blocks, individually or in 
groups, in the current column sequence list using the controls provided in the dialog.

Editing the Properties of the Message Blocks
From the list of the current column sequence of the report you can select individual message 
blocks and edit their properties. To do this, select a message block from the current column 
sequence of the report and click the "Properties" button. You can now assign an alias to the 
block name and change the format for the date and time message blocks. The appearance of 
the dialog that opens depends on the type of message block selected. The changes are only 
effective for the output of the report and are not written back to the Alarm Logging.

If the "Use Aliases" check box is selected, the configured aliases are output as the column 
headings. The aliases cannot be configured for multiple languages. If the check box is cleared, 
the names of the message blocks are used as column headings. If the language is changed, 
the names stored for the message blocks in the text library are output. By default, the check 
box is cleared. If the "Use Aliases" check box is selected and there are no aliases configured, 
the names of the message blocks are output.
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Setting Filter Criteria for Alarm Output
In the "Filter Criteria for Alarm Output" area you can use the "Selection..." button to display the 
dialog for setting criteria for alarm output. In the selection dialog, choose your selection criteria 
by checking the appropriate boxes. When you apply the settings by clicking the "OK" button, 
the selected selection criteria are displayed in the "Filter Criteria for Alarm Output" area. The 
individual arguments are always ANDed. You will find more information in the section "Filter 
Criteria for Alarm Output".

You can also make a selection in the print job by means of the size or time range. Additional 
information can be found in the chapter "Print Jobs in WinCC".

Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as 
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected 
print job. At the start of the runtime output, the configuration dialog will then be launched. 
Through this configuration dialog, you can open the dialog Alarm Logging Runtime: Report 
Table Selection described above, and modify the settings directly before the output. For further 
details, please see the chapter "Changing output options in runtime".

See also
Filter Criteria for the Alarm Output (Page 1699)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Runtime Documentation (Page 1634)

8.5.9.7 Changing Output Options for User Archive Tables

How to Change the Output Options for User Archive Tables

Introduction
The log object User Archive Runtime/Table is available for the output of runtime data from a 
user archive or a view. The object is linked to user archives and provides data output from the 
selected user archive/view.

The output data selection procedure is the same for user archives and views. In the following, 
the steps are described for a user archive.

To return the current view of the User Archive Table Control, you only need to activate a pre-
defined button in this control. For more details, please refer to chapter Data Output from User 
Archives.
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In order to return a user-specific selection of data, you can use a pre-defined layout, or create 
your own layout. For the layout output, you need to configure a job. For more details, please 
refer to chapter Creating Print Jobs for Runtime Documentation.

Requirements
● The object User Archive Runtime Table has already been inserted in the layout.

● The inserted object has been selected.

● The Object Properties window is open

● You are familiar with the Link tab.

● At least one user archive has been created

Editing Options
For the object User Archive Runtime/Table, you can select the data from a user archive or a 
view, as well as the time base.

Procedure
1. Open the Link tab in the Object Properties window and double-click the entry Table 

Selection in the list of editing options. This opens the Table Selection dialog.

2. Use the dialog to configure the selection of data for output. The dialog is described under 
Selection of Data for User Archive Tables.

3. Apply the settings by clicking OK.

See also
How to Modify the Time Range (Page 1661)

How to Modify the Time Range (Page 1655)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Runtime Documentation (Page 1634)

Selection of Data for the User Archive Table (Page 1660)
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Selection of Data for the User Archive Table

Data Selection
The "Table selection" dialog serves to choose a user archive/view, select the table columns, 
and specify the filter conditions and sorting.

Selecting a user archive/view
In the "Archive/View" area, you can select one of the user archives/views that are available in 
the project. Clicking on the Folder button will open the Package Browser which lets you select 
a user archive/view. You can choose from all user archives/views of the servers whose 
packages were loaded.

Selecting the columns
Following the selection of an archive/view, you can choose the desired columns from the 
archive/view. When a column is selected, its properties become unlocked. Use the dialog to 
specify the format, orientation, number of places returned in the output, etc., for each column.

Setting filter conditions
In the "Filter condition" area, you can use SQL statements to set the filter conditions for the 
output values from the archive database. To write up the filter conditions, you need to be 
familiar with the database language SQL. For further information, please refer to the user 
archive help.

Setting the sorting
In the "Sorting" area, you can use SQL statements to set the sorting conditions for the output 
values from the archive database. To write up the sorting conditions, you need to be familiar 
with the database language SQL. For further information, please refer to the user archive help.

Dynamization through a WinCC variable
You can make the archive/view selection as well as the filter and sorting conditions dynamic 
with WinCC variables in order to carry out the selection directly before the logging is triggered 
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with an activated project. The report system reads the value from the variable at runtime. If 
the variable cannot be read, the configured value is used.

1. Activate the "Tag" check box in the corresponding area of the dialog. The text box and the 
folder button are activated.

2. Use the folder button to open the variable selection dialog. Select the desired variable there, 
and close the variable selection dialog. Alternatively, enter the variable name directly in the 
text box.

Configure value assignment to the WinCC variable. You will find more information in the section 
"Types of Dynamization".

Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as 
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected 
print job. At the start of the runtime output, the configuration dialog will then be launched. 
Through this configuration dialog, you can open the dialog "Table selection" described above, 
and modify the settings directly before the output. For further details, please see the chapter 
"Changing output options in runtime".

See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Runtime Documentation (Page 1634)

How to Modify the Time Range

Introduction
By changing the base for time specifications, you can convert the indicated time in the time 
stamp to a different time base. These indicated times are only converted for output in the log; 
they are not written back to the Alarm Log or Tag Log, or user archives. If, for example, you 
want to output the data of a remote computer in another time zone, you can use this function 
to ensure that the data is output with a comparable time. If, in this case, both computers worked 
with the time base "Local Time", the two systems would contain logs with different time 
specifications. The results would not be directly comparable. You can find additional 
information in the section "Adjusting the Time Settings in the Project".

If you change the time base for the output, ensure that the time reference is also output in the 
report. For example, specify an identifier in the alias for the "Time" message block. For more 
details, please refer to "Selection of data for a message report".
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Requirements
● The object "Message report" has already been inserted in the layout

● The inserted object has been selected.

● The "Object properties" window is open

● You are familiar with the Link tab.

● Message configuration has been carried out in Alarm Logging.

Edit Options
For the objects "Archive report" and "Message report", you can select the data from the 
message system as well as the time base.

Procedure
1. In the "Object Properties" window, you can also change the base for time specifications. 

To do that, double-click the entry "Base for time specifications" in the list of editing options. 
The following dialog will open.

2. Select the required time base and confirm your selection with "OK".

3. Modify the external form of the object, if necessary, by changing the attribute values in the 
Properties tag.

4. Close the "Object Properties" dialog and save the layout.

See also
How to Change the Output Options for User Archive Tables (Page 1658)

How to Change the Output Options for Message Reports from Alarm Logging Runtime 
(Page 1654)

8.5.9.8 How to Change the Output Options for CSV Provider Tables

Introduction
The log object "CSV provider table" is available for the output of user-specific data from a data 
source in CSV format. The object can be linked to a data source in CSV format and returns 
the data from this source as a table in a WinCC protocol.

Requirements
● The object "CSV Provider Table" has already been inserted in the layout

● The inserted object has been selected.
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● The "Object properties" window is open

● You are familiar with the Link tab.

● A CSV file is provided, or the file name is known

Edit Options
For the object "CSV provider table", you can select a CSV file for the output.

Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "CSV table 

selection" in the list of editing options. This opens the "CSV table selection" dialog.

2. Use the "..." button to open the file selection dialog. Navigate to the desired CSV data source 
and select it, or enter the path and file name directly in the input field.

3. To take over the font and font size from the file, enable the corresponding check boxes in 
the dialog. If those boxes are not checked, the settings will be taken from the attributes of 
the object properties.

4. Confirm your entries with "OK."

5. You can modify the external form of the object, if necessary, by changing the attribute values 
in the Properties tab of the "Object properties" window.

6. Close the "Object Properties" window and save the layout.

Changing the Output Options

Dynamization through a WinCC variable
To render the selection of output data more flexible, you can make the file selection dynamic. 
This way, you can select the CSV file whose content is to be returned in runtime directly before 
the output. The report system reads the value from the variable at runtime. If the variable 
cannot be read, the configured value is used.

1. Activate the "Tag" check box in the corresponding area of the dialog. The text box and the 
folder button are activated.

2. Use the folder button to open the variable selection dialog. Select the desired variable there, 
and close the variable selection dialog. Alternatively, enter the variable name directly in the 
text box.

Configure value assignment to the WinCC variable. You will find more information in the section 
"Types of Dynamization".
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Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as 
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected 
print job. At the start of the runtime output, the configuration dialog will then be launched. 
Through this configuration dialog, you can open the dialog "CSV table selection" described 
above, and modify the settings directly before the output. For further details, please see the 
chapter "Changing output options in runtime".

Changing the format options
You can modify the external form of the object, if necessary, by changing the attribute values 
in the Properties tab of the "Object properties" dialog. The font and font size settings are applied 
only when the corresponding checkboxes in the "CSV table selection" dialog have not been 
activated.

If the above mentioned check boxes are activated, the formatting information will be taken 
from the CSV file. In the CSV data source, you can add control characters for font size, font, 
color and alignment, etc. For information regarding formatting with control characters, please 
refer to chapter Reporting Requirements for a CSV Data Source.

See also
Requests to a CSV File for Reporting (Page 1696)

How to Change the Output Options for CSV Provider Trends (Page 1664)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Runtime Documentation (Page 1634)

8.5.9.9 How to Change the Output Options for CSV Provider Trends

Introduction
The "CSV provider trend" report object is available for the output of user-specific data from a 
data source in CSV format. The object can be linked to a data source in CSV format and returns 
the data from this source as a curve in a WinCC protocol.

Requirements
● The object "CSV Provider Trend" has already been inserted in the layout

● The inserted object has been selected.

● The "Object properties" window is open
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● You are familiar with the Link tab.

● A CSV file is provided, or the file name is known

Edit Options
For the object "CSV Provider Trend", you can select a CSV file for the output.

Procedure
1. Open the "Link" tab in the "Object Properties" window and double-click the entry "CSV table 

selection" in the list of editing options. This opens the "CSV table selection" dialog.

2. Use the "..." button to open the file selection dialog. Navigate to the desired CSV data source 
and select it, or enter the path and file name directly in the input field.

3. Confirm your entries with "OK."

4. You can modify the external form of the object, if necessary, by changing the attribute values 
in the Properties tab of the "Object properties" window.

5. Close the "Object Properties" window and save the layout.

Changing the Output Options

Dynamization through a WinCC variable
To render the selection of output data more flexible, you can make the file selection dynamic. 
This way, you can select the CSV file whose content is to be returned in runtime directly before 
the output. The report system reads the value from the variable at runtime. If the variable 
cannot be read, the configured value is used.

1. Activate the "Tag" check box in the corresponding area of the dialog. The text box and the 
folder button are activated.

2. Use the folder button to open the variable selection dialog. Select the desired variable there, 
and close the variable selection dialog. Alternatively, enter the variable name directly in the 
text box.

Configure value assignment to the WinCC variable. You will find more information in the section 
"Types of Dynamization".

Dynamization by Means of the Configuration Dialog
Instead of setting the dynamics through WinCC tags, you can use the configuration dialog as 
well. To do this, select the option "Configuration dialog" from the "Dialog" area of the selected 
print job. At the start of the runtime output, the configuration dialog will then be launched. 
Through this configuration dialog, you can open the dialog "CSV trend selection" described 
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above, and modify the settings directly before the output. For further details, please see the 
chapter "Changing output options in runtime".

Changing the format options
In the CSV data source, you can add control characters for the layout of the trend output. 
Numerous options are available. For information regarding formatting with control characters, 
please refer to the chapter "Reporting requirements for a CSV data source".

See also
Requests to a CSV File for Reporting (Page 1696)

How to Change the Output Options for CSV Provider Tables (Page 1662)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Runtime Documentation (Page 1634)

8.5.10 Working with Objects for the Project Documentation

8.5.10.1 Working with Objects for the Project Documentation

Introduction
In this chapter, you will find details regarding the available objects of the page layout editor for 
the project documentation. You will learn how to work with the objects, and what are the basic 
conditions for each object.

The project documentation objects are provided for the report output of configured data. The 
objects are linked to the corresponding WinCC applications and return the configuration data 
of the WinCC project for output in a report. The objects for project documentation can only be 
inserted in the dynamic part of a page layout.
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Some objects provide an option to select output data. This allows you to restrict the output to 
the data you currently need. For some of these objects, the selection options are identical. For 
each type of selection, this chapter will describe the changes that can be made to the output 
options. The relevant objects are listed with the descriptions.

The other objects do not offer an option to select output data. There are 3 types of these 
objects. The editing steps to change the output options are identical for objects of the same 
type and are described once for each object type.

Objects without data selection
The following object types are available:

Dynamic text

Dynamic metafile

Dynamic table

The modification of output options is described for each of these object types.

● Changing output options for dynamic texts

● Changing output options for dynamic metafiles

● Changing output options for dynamic tables without data selection
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See also
How to Change an Attribute (Page 1576)

How to Change the Output Options for the Dynamic Tables without Data Selection 
(Page 1695)

How to Change the Output Options for the Dynamic Metafiles (Page 1693)

How to Change the Output Options for the Dynamic Texts (Page 1692)

How to Call up the Selection Dialogs (Page 1668)

8.5.10.2 How to Call up the Selection Dialogs

Selection dialogs are called in the same way for all project documentation objects. The 
selection options depend on the object in question.

Requirements
● A project documentation object has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Procedure
1. Open the branching node(s) on the left of the Link tab. Choose and entry and select it. The 

list of editing options will then show the item "Selection...". The available selection type 
depends on the object which was chosen from the object tree.

2. Double-click on the entry "Selection...". This will open the corresponding selection dialog.

Depending on the object, you may be given several selection options in the area on the right. 
In this case, make your selections one after the other. When a selection has been made, its 
symbol on the right will be checked with a red mark. The entry "Element" is used for internal 
purposes only.

Creating Page Layouts
8.5 Working with Objects

MDM - WinCC: Working with WinCC
1668 System Manual, 11/2008,  



If the left side of the window contains several hierarchical entries, the subentries may offer 
various selection options, too. This depends on the object in question. It allows you to carry 
out a hierarchical selection. 

In the picture above, for example, the entry "Object" was marked in the window on the left; the 
objects can now be selected in the window on the right. The entry "Attributes" is then marked 
on the left. The attributes can now be selected on the right.

In the output, only the selected attributes for the objects chosen in the previous step will be 
returned.

For an overview of available objects and output options for each component of WinCC, please 
refer to the chapter "Project documentation".

See also
How to Change the Output Options for the Selection of Connection List (Page 1691)

How to Change the Output Options for the Tag Table of WinCC Explorer (Page 1689)

How to Change the Output Options for the Language Selection from the Text Library 
(Page 1687)

How to Change the Output Options for the Selection of the Archive Tags from Tag Logging 
(Page 1684)

How to Change the Output Options for the Selection of Archives from Tag Logging 
(Page 1682)

How to Change the Output Options for the Selection of Action types (Page 1680)

How to Change the Output Options for the Selection of Object Statistics (Page 1679)

How to Change the Output Options for the Selection of Attributes (Page 1677)

How to Change the Output options for the Selection of the Picture Statistics (Page 1675)

How to Change the Output Options for the Selection of Views (Page 1673)

How to Change the Output Options for the Selection of User Archives (Page 1671)

How to Change Output Options for Single Message from Alarm Logging CS (Page 1670)
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8.5.10.3 How to Change Output Options for Single Message from Alarm Logging CS

Introduction
The object "Single Messages" allows you to output all, or individually selected, messages from 
Alarm Logging in a report. The object is located in the Page Layout Editor object tree, in the 
"Project documentation" tab under "Alarm Logging CS".

Requirements
● Messages must be configured in Alarm Logging.

● The object "Single Messages" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
Of all the objects for the Alarm Logging project documentation, the object "Single Messages" 
is the only one that provides the option to select your output data.

For further information, please see the chapter "Project documentation in Alarm Logging".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Single messages". 

The list of editing options will then show the item "Selection".

2. Double-click on the entry "Selection". The Alarm Logging CS dialog: Selecting Single 
Messages dialog is opened.

If the "All single messages" checkbox is checked, all configured single messages that are 
available at the time the report is generated will be returned. The buttons for accepting the 
messages will only be enabled when the checkbox "All single messages" has been 
deactivated.

3. Select the desired items from the list of available single messages and add them individually 
or in groups, using the dialog buttons, to the list of selected single messages.

4. Confirm the selection with "OK".

5. Modify the external form of the object "Single Messages", if necessary, by changing the 
attribute values in the Properties tab.

6. Close the "Object Properties" window and save the layout.
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See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.4 How to Change the Output Options for the Selection of User Archives

Introduction
The object "Archive" allows you to output the configuration data of user archives in a report. 
The object is located in the Page Layout Editor object tree, in the "Project documentation" tab 
under "User archive configuration".

Requirements
● A user archive must have been created.

● The object "Archives" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
The objects "Archive" and "Views" are available for the project documentation of the user 
archive configuration. Both objects offer options to select data for output. For further 
information about the "Views" object, please see the chapter "Changing output options for the 
selection of views".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Archives". The list of 

editing options will then show the item "Archive selection".

2. Double-click on the entry "Archive selection". This will open the Archive selection dialog.

If the "All" checkbox is checked, all configured archives that are available at the time the 
report is generated will be returned. 
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3. From the list of available archives, select one or more for output.

4. Activate the check boxes for the archive attributes which you want to appear in the report.

5. To include archive field information in the output, activate the checkbox "Display fields".

6. Activate the check boxes for the field attributes which you want to appear in the report.

7. Confirm the selection with "OK".

8. Modify the external form of the object "Views", if necessary, by changing the attribute values 
in the Properties tag.

9. Close the "Object Properties" window and save the layout.

Note

If multiple user archives were selected, the selection of archive attributes will be applied 
to all selected user archives. If the checkbox "All" is activated, the configuration data of 
all user archives within the WinCC project will be returned. The selection of archive 
attributes applies to all user archives in this case as well.

The following table shows all the attributes that can be returned. The functions of the attributes 
are briefly described.

Attributes Description

ID ID of the user archive or field.
Name Name of the user archive or field.
Alias Alias name of the user archive or field.
Type Shows whether a user archive belongs to the type Limited or Unlimited (maximum 

number of data records limited or unlimited).         
With fields, the type is the same as the tag type.

Size The size of the user archive.
Changed The date of the last change.
Com. Type Communication type of the connection between user archive and automation 

level.
PLCID Identification number for the connection between user archive and automation 

level.
Variable For archives, the name of the WinCC tag for the connection to the automation 

level.          
For fields, the value in the user archive field.

ID tag Name of the control tag "ID".
Job tag Name of the control tag "Job".
Field tag Name of the control tag "Field".
Value tag Name of the control tag "Value".
Reading rights Reading rights allocated for an archive or archive field.
Write protection Writing rights allocated for an archive or archive field.
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Attributes Description

Flags) Information about set flags.          
For archives:          
Flag for last access, output = LA          
Flag for last user, output = U          
For fields:          
Flag for Field must possess a value, output = NN          
Flag for Field must possess a unique value, output = U          
Flag for Field should be supported by an index, output = I

Length Length of the user archive field.
Decimal places Number of decimal places in the user archive field.
Minimum Configured minimum value of the user archive field.
Maximum Configured maximum value of the user archive field.
Start value Configured start value of the user archive field.

See also
How to Change the Output Options for the Selection of Views (Page 1673)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.5 How to Change the Output Options for the Selection of Views

Introduction
The object "Views" allows you to return the configuration data for views of user archives in a 
report. The object is located in the Page Layout Editor object tree, in the "Project 
documentation" tab under "User archive configuration".

Requirements
● A view must have been created.

● The object "Views" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
The objects "Archive" and "Views" are available for the project documentation of the user 
archive configuration. Both objects offer options to select data for output. For further 
information about the object "Archives", please see the chapter "Changing output options for 
the selection of user archives".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Views". The list of 

editing options will then show the item "View selection".

2. Double-click on the entry "View selection". This will open the View selection dialog.

If the "All" checkbox is active, all configured views that are available at the time the report 
is generated will be returned. 

3. From the list of available views, select one or more for output.

4. Activate the check boxes for the view attributes which you want to appear in the report.

5. To include view column information in the output, activate the checkbox "Display columns".

6. Activate the check boxes for the columns which you want to appear in the report.

7. Confirm the selection with "OK".

8. Modify the external form of the object "Views", if necessary, by changing the attribute values 
in the Properties tag.

9. Close the "Object Properties" window and save the layout.

Note

If multiple views were selected, the selection of view attributes will be applied to all selected 
views. If the checkbox "All" is activated, the configuration data of all views within the WinCC 
project will be returned. The selection of view attributes applies to all views in this case as 
well.

 

The following table shows all the attributes that can be returned. The functions of the attributes 
are briefly described.

Attributes Description

ID ID of the view or column.
Name Name of the view or column.
Alias Alias name of the view or column.
Relation Shows the relation between the user archive fields in a view.
Changed Date and time of the last change.
Archive ID ID of the user archive.
archive Name of the user archive.
Field ID ID of the user archive field.
Array Name of the user archive field.
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See also
How to Change the Output Options for the Selection of User Archives (Page 1671)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.6 How to Change the Output options for the Selection of the Picture Statistics

Introduction
The object "Picture Statistics" allows you to output the statistics data for the pictures of the 
Graphic Designer in a report. The object is located in the Page Layout Editor object tree, in 
the "Project documentation" tab under "Graphics Designer/Picture".

Requirements
● A Graphics Designer picture must have been created.

● The object "Picture statistics" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
For the object "Picture statistics", you can select the statistic data.

For an overview of available objects for the product documentation of the Graphics Designer 
and their output options, please refer to the chapter "Project documentation in the Graphics 
Designer".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Picture Statistics". 

The list of editing options will then show the item "Statistics data for the picture".

2. Double-click on the entry "Statistics data for the picture". This will open the dialog "Selection 
of picture statistics".

If the checkbox "with descriptive column" is checked, a descriptive column will be returned 
along with the statistics data.

3. Choose the desired items from the list of selection options and add them individually or in 
groups, using the dialog buttons, to the list of selected data.

4. Using the "Up" and "Down" buttons, specify the output sequence of the tags.

5. Confirm the selection with "OK".

6. Modify the external form of the object "Picture Statistics", if necessary, by changing the 
attribute values in the Properties tag.

7. Close the "Object Properties" window and save the layout.

 

Output with descriptive column

Picture name PictureDocumentation.Pdl
Creation date 23.07.2002 13:33:47
Number of objects in the picture 1
Number of objects with tag connection 0

 

Output without descriptive column

PictureDocumentation.Pdl  
23.07.2002 13:33:47  
1  
0  
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See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.7 How to Change the Output Options for the Selection of Attributes

Introduction
The object "Attributes" facilitates the output of configuration data for the attributes of Graphics 
Designer pictures and objects within in a report. The provided selection options allow you to 
limit the output to relevant information.

You have two choices:

● All with tag connection – Returns all attributes which are linked to a tag.

● All with action connection – Returns all attributes which are linked to an action.

● All not interconnected – Returns all attributes which are not dynamic.

The object is located in the Page Layout Editor object tree, in the "Project documentation" tab 
under "Graphics Designer/Picture," and under "Graphics Designer/Picture/Object".

Requirements
● A Graphics Designer picture must have been created.

● The object "Attributes" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
For the "Attributes" object of a picture, you can select the attributes as well as the table data.

For the "Attributes" object of an object within a picture, you can additionally select the objects. 
Only the table data of the selected objects will be returned then. For further information, please 
see the chapter "Calling the selection dialogs".

For an overview of available objects for the product documentation of the Graphics Designer 
and their output options, please refer to the chapter "Project documentation in the Graphics 
Designer".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Attributes". The list 

of editing options will then show the entries "Selection of attributes" and "Table data".

2. Double-click on the entry "Selection of attributes". This will open the dialog "Selection of 
attributes".

Make your choices from the list of selection options.

3. Click on the "Default Attributes" button. This will open the dialog "List of default attributes".

Select the attributes that are to be returned always. Confirm the selection with "OK".

4. In the "Link" tab of the "Object Properties" window, double-click the entry "Table data". This 
will open the dialog "Selection of table data".

5. From the list of selection options, choose the info columns which are to appear in the 
attribute data table.

6. Confirm the selection with "OK".

7. Modify the external form of the object "Attributes", if necessary, by changing the attribute 
values in the Properties tag.

8. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

How to Call up the Selection Dialogs (Page 1668)
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8.5.10.8 How to Change the Output Options for the Selection of Object Statistics

Introduction
The object "Object Statistics" allows you to output the statistics data for the objects within the 
pictures of the Graphic Designer in a report. The object is located in the Page Layout Editor 
object tree, in the "Project documentation" tab under "Graphics Designer/Picture/Object".

Requirements
● A Graphics Designer picture must have been created.

● The object "Object Statistics" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
For the object "Object Statistics", you can select the objects as well as the statistics data. Only 
the statistics data of the selected objects will be returned then. For further information, please 
see the chapter "Calling the selection dialogs".

For an overview of available objects for the product documentation of the Graphics Designer 
and their output options, please refer to the chapter "Project documentation in the Graphics 
Designer".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Object". The list of 

editing options will then show the item "Selection of Objects".

2. Double-click on the entry "Selection of objects". This will open the dialog "Selection of 
objects".

Specify whether all objects should appear in the output, or only dynamic objects from 
Graphics Designer pictures. Confirm the selection with "OK".
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3. On the left of the "Object Properties" window, select the entry "Object statistics". This will 
open the dialog "Statistics on the Object".

If the checkbox "with descriptive column" is checked, a descriptive column will be returned 
along with the statistics data.

4. Choose the desired items from the list of selection options and add them individually or in 
groups, using the dialog buttons, to the list of selected data.

5. Using the "Up" and "Down" buttons, specify the output sequence of the tags.

6. Confirm the selection with "OK".

7. Modify the external form of the object "Picture Statistics", if necessary, by changing the 
attribute values in the Properties tag.

8. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

How to Call up the Selection Dialogs (Page 1668)

8.5.10.9 How to Change the Output Options for the Selection of Action types

Introduction
The objects "Trigger" and "Source text" facilitate the output of configuration data for the actions 
within Graphics Designer pictures and objects in a report. 

You have two choices:

● All – Returns all elements with actions. Also returns all elements which have not yet been 
configured at the time of this selection.

● Assignment actions – Returns all elements with assignment actions.

● No assignment actions – Returns all elements without assignment actions.

The objects are located in the Page Layout Editor object tree, in the "Project documentation" 
tab under "Graphics Designer/Actions", and under "Graphics Designer/Picture/Actions".
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Requirements
● A Graphics Designer picture must have been created.

● One of the objects "Trigger" or "Source text" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
You can select the actions for the objects "Trigger" and "Source text" of a picture.

For the objects "Trigger" and "Source text" of an object within a picture, you can additionally 
select the objects. Only the action data of the selected objects will then be returned. For further 
information, please see the chapter "Calling the selection dialogs".

For an overview of available objects for the product documentation of the Graphics Designer 
and their output options, please refer to the chapter "Project documentation in the Graphics 
Designer".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Actions". The list of 

editing options will then show the item "Selection of actions".

2. Double-click on the entry "Selection of actions". This will open the dialog "Selection of action 
types".

Select the action types you want.

3. Confirm the selection with "OK".

4. Modify the external form of the object, if necessary, by changing the attribute values in the 
Properties tag.

5. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

How to Call up the Selection Dialogs (Page 1668)
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8.5.10.10 How to Change the Output Options for the Selection of Archives from Tag Logging

Introduction
The objects "Process value archive" and "Compressed archive" facilitate the output of 
configuration data for process value and compressed archives in a report. 

The objects are located in the Page Layout Editor object tree, in the "Project documentation" 
tab under "Tag Logging CS/Archives".

Requirements
● A process value or compressed archive must have been created.

● One of the objects "Process value archive" or "Compressed archive" has been inserted in 
the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
For the objects "Process value archive" and "Compressed archive", you can select both the 
archives and the archive data.

For an overview of available objects for the Tag Logging product documentation and their 
output options, please refer to the chapter "Project documentation in Tag Logging".

Selection of Archives
1. Open the branching node on the left of the Link tab. Select an entry, either "Process value 

archive" or "Compressed archive". The list of editing options will then show the item "Archive 
names".

2. Double-click on the entry "Archive names". The Tag Logging CS: Archive Selection dialog 
is opened.

If the "All archives" checkbox is checked, the data of all archives will be returned. An existing 
selection will be preserved in the dialog.

3. Choose the desired items from the list of available archives and add them individually or in 
groups, using the dialog buttons, to the list of selected data.

4. Confirm the selection with "OK".
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Selection of Process Value Archive Data
1. In the "Object Properties" window, select the entry "Process value archive". The list of 

editing options will then show the item "Process value archive data".

2. Double-click on the entry "Process value archive data". The Tag Logging CS: Process 
Archive Data Selection dialog is opened.

3. Choose the configuration data you want to appear in the output.

4. Confirm the selection with "OK".

5. Modify the external form of the object "Process value archive", if necessary, by changing 
the attribute values in the Properties tag.

6. Close the "Object Properties" window and save the layout.

The following table shows all the attributes that can be returned. The functions of the attributes 
are briefly described.

Attributes Description

Comment Brief description or comments about the archive.
Archive type Type of the selected archive, here: Process value archive.
Server name Server which is accessed by the archive.
Authorization Authorization for read or write access.
Action During archive start/Enable Specified action which is triggered by certain events. 
Archiving at system start Returns the starting type of the archive.
Archive type Type of the selected archive, short-term or long-term archive.
Fill level message Edited fill level messages for the archive.
Size in data records Specified number of data records which can be stored in a short-

term archive.
Memory location Storage location for swap-out.
Action for relocating the short-
term archive

Specified action for swap-out. 

Variable The configured archive tags.

Selection of compressed archive data
1. In the "Object Properties" window, select the entry "Compressed archive". The list of editing 

options will then show the item "Compressed archive data".

2. Double-click the entry "Compressed archive data". The Tag Logging CS: Compressed 
Archive Data Selection dialog is opened.

3. Choose the configuration data you want to appear in the output.
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4. Confirm the selection with "OK".

5. Modify the external form of the object "Compressed archive", if necessary, by changing the 
attribute values in the Properties tag.

6. Close the "Object Properties" window and save the layout.

The following table shows all the attributes that can be returned. The functions of the attributes 
are briefly described.

Attributes Description

Comment Brief description or comments about the archive.
Archive type Type of the selected archive, here: Compressed archive.
Server name Server which is accessed by the archive.
Authorization Authorization for read or write access.
Action During archive start/Enable Specified action which is triggered by certain events. 
Archive type Type of the selected archive, short-term or long-term archive.
Compressed archive Name of the compressed archive.
Archiving at system start Returns the starting type of the archive.
Variable The configured archive tags.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

How to Call up the Selection Dialogs (Page 1668)

8.5.10.11 How to Change the Output Options for the Selection of the Archive Tags from Tag Logging

Introduction
The objects "Process value archive tag" and "Compressed archive tag" facilitate the output of 
configuration data for process value and compressed archive tags in a report. 

The objects are located in the Page Layout Editor object tree, in the "Project documentation" 
tab under "Tag Logging CS/Archives".

Requirements
● A process value or compressed archive must have been created.

● One of the objects "Process value archive tag" or "Compressed archive tag" has been 
inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.
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Edit Options
For the objects "Process value archive tag" and "Compressed archive tag", you can select the 
archives, tags and tag data. 

For an overview of available objects for the Tag Logging product documentation and their 
output options, please refer to the chapter "Project documentation in Tag Logging".

Selection of the Process Value Archive Tag
1. Open the branching node on the left of the Link tab. Select an entry, either "Process value 

archive tag" or "Compressed archive tag". The list of editing options will then show the item 
"Tag".

2. Double-click the "Tag" entry. The Tag Logging CS: Archive Tag Selection dialog is opened.

In the "Archive" area, select one or more tag types.

3. In the "Archive" area, choose a process value archive from the selection list. The process 
tags of the selected type which are available in the system are shown in the "Available" 
window.

4. Choose the desired items from the list of available tags and add them individually or in 
groups, using the dialog buttons, to the list of selected data.

5. Confirm the selection with "OK".

Selection of Process Value Archive Tag Data
1. In the "Object Properties" window, select the entry "Process value archive tag". The list of 

editing options will then show the item "Tag data".

2. Double-click the "Tag data" entry. The Tag Logging CS: Tag Data Selection dialog is 
opened.

3. Choose the configuration data you want to appear in the output.

4. Confirm the selection with "OK".
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5. Modify the external form of the object "Process value archive tag", if necessary, by changing 
the attribute values in the Properties tag.

6. Close the "Object Properties" window and save the layout.

The following table shows all the attributes that can be returned. The functions of the attributes 
are briefly described.

Attributes Description

Archiving at system start Returns the starting type of the archive tag.
Archiving type Archiving type: acyclic, cyclic-continuous or cyclic-selective 

archiving.
Process tag name Names of the corresponding WinCC tags.
Tag supply Returns the assignment type of the tag. Specifies whether the tag 

is supplied with data manually, or through the system.
Also put archived value in tag Outputs the WinCC tag in which an archived value is additionally 

written.
Cycle Time cycle used for archiving and data display.
Number of values Output of values for leader and trailer.
Save on error Returns the saving behavior in case of errors. Specifies whether, 

in case of an error, the last value is saved, or rather a substitute 
value.

Events Events which trigger archiving.
Editing Returns the processing type. Specifies how data is preprocessed, 

e.g., by calculating an average.
Unit Returns the unit of the specified time value.
Scaling Returns the scaling type.
Name of statuses Returns the names of status 0 and status 1.
Archiving on signal change Returns the behavior which has been specified for a signal change.
Comment Comments regarding archive tags.
Raw data tags Name or ID of the raw data tags.

Selection of Compressed Archive Tag Data
1. In the "Object Properties" window, select the entry "Compressed archive tag". The list of 

editing options will then show the item "Tag data".

2. Double-click the "Tag data" entry. The Tag Logging CS: Tag Data Selection dialog is 
opened.
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3. Choose the configuration data you want to appear in the output. For attribute descriptions, 
please refer to the table above.

4. Confirm the selection with "OK".

5. Modify the external form of the object "Compressed archive tag", if necessary, by changing 
the attribute values in the Properties tag.

6. Close the "Object Properties" window and save the layout.

See also
How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.12 How to Change the Output Options for the Language Selection from the Text Library

Introduction
The object type "Text Library text table" allows you to insert text from the WinCC text library 
in the dynamic part of a page layout. The object is located in the Page Layout Editor object 
tree, in the "Project documentation" tab under "Text Library". Select the languages for which 
text is to be returned in a table in the "Language selection" dialog.

Requirements
● User texts must be configured in the Text Library.

● The object "Text Library text table" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
Of all the objects for the Text Library project documentation, the object "Text Library text table" 
is the only one that provides the option to select your output data.

For further information, please see the chapter "Project documentation in the Text Library".
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Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Text Library text table". 

The list of editing options will then show the item "Language selection".

2. Double-click the "Language selection" entry. This will open the dialog "Text Library 
language selection".

If the "All" checkbox is checked, all configured languages will be returned. An existing 
selection in this dialog will be preserved.

3. Choose the desired items from the list of designed languages and add them individually or 
in groups, using the dialog buttons, to the list of selected languages.

4. Using the "Up" and "Down" buttons, specify the output sequence of the tags.

5. Use the option buttons to specify whether the different languages should appear in the 
output separately, or arranged horizontally or vertically.

6. Confirm the selection with "OK".

7. Modify the external form of the object "Text Library text table", if necessary, by changing 
the attribute values in the Properties tag.

8. Close the "Object Properties" window and save the layout.

Specify a table format
The layout of the report is specified using the table format option buttons. You can view the 
effect of your settings in the preview window. The following table formats are available: 

● If you choose "Separate", each language will be returned in its own table in the report.

● If you choose "Horizontal", the text in the selected languages that belongs to one text ID 
will be returned in one row. With long text or several designed languages, this may well 
exceed the width of the row.

● If you choose "Vertical", the text in the selected languages that belongs to one text ID will 
be returned in separate rows.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)
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8.5.10.13 How to Change the Output Options for the Tag Table of WinCC Explorer

Introduction
The object "Tags" allows you to return the tags from WinCC Tag Management in a report. The 
object is located in the Page Layout Editor object tree, in the "Project documentation" tab under 
"WinCC Explorer".

Requirements
● The Tag Management contains some tags.

● The object "Tags" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
For the object "Tags", you can select the tags, the tag groups and tag parameters. For the Tag 
data type, you can also select the output format.

For an overview of available objects for the product documentation of the WinCC Explorer and 
their output options, please refer to the chapter "Project documentation in the WinCC Explorer".

Selection of Tag Parameters
1. Open the branching node on the left of the Link tab. Select the entry "Tags". The list of 

editing options will then show the item "Selection of tag parameters".

2. Double-click on the entry "Tag parameters". The WinCC Explorer: Selecting Connections 
dialog is opened.

If the "Compact" checkbox is activated, all parameters of a tag will be returned in one row. 
Else, each parameter will be returned in its own row. If, with output in "Compact" form, the 
lines are too long for the rows, the rest will be cut off.

3. Activate the check boxes for the output parameters you want to use.

4. Confirm the selection with "OK".

The following table shows all the tag parameters that can be returned. The functions of the 
parameters are briefly described.

Parameters Description

Data type Returns the data type of a tag.
Group Includes the allocation to a tag group in the output.
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Parameters Description

Parameters Returns the address parameters of a tag.
External tag data Returns information about the external linkage of a tag (e.g., connection, 

channel unit, channel).
Limit values Returns the designed limit values of a tag.
Start value Returns a designed start value of a tag.
Substitute value Returns a designed substitute value of a tag.
Protocol entry Returns information about the type of a configured log entry.

Selection of Tag Groups
1. In the "Object Properties" window, select the entry "Tags". The list of editing options will 

then show the item "Selection of tag groups".

2. Double-click on the entry "Selection of tag groups". The WinCC Explorer: Select Tag 
Groups dialog is opened.

3. Select the desired items from the list of available tag groups and add them individually or 
in groups to the list of selected tag groups, using the dialog buttons.

4. Confirm the selection with "OK".

Selection of Tags
1. In the "Object Properties" window, select the entry "Tags". The list of editing options will 

then show the item "Selection of tags".

2. Double-click the entry "Selection of tags". The WinCC Explorer: Select Tags dialog is 
opened.

If the "All tags" checkbox is active, all available tags will be returned. An existing selection 
in this dialog will be preserved.

3. To be able to select specific tags, deactivate the checkbox "All tags". This will enable the 
"Select" button.

4. Click on the "Select" button to open the WinCC tag selection dialog.

5. Select the desired tags individually or in groups. Confirm the selection with "OK". The 
selected tags will be added to the selection dialog.

6. Confirm the selection with "OK".
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Formatting the Tag List
1. In the "Object Properties" window, select the entry "Tags". The list of editing options will 

then show the item "Format".

2. Double-click the "Format" entry. The WinCC Explorer: Format Tag List dialog is opened.

If the check box is active, the data type of the tag is returned in short form.         
Long formats: Unsigned 32 bit value; floating point number 64 bit IEEE 754         
Short formats: 32 bit value, without sign; 64 bit IEEE 754

3. Select the output form you want.

4. Confirm the selection with "OK".

5. Modify the external form of the object "Tags", if necessary, by changing the attribute values 
in the Properties tag.

6. Confirm the selection with "OK".

7. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.14 How to Change the Output Options for the Selection of Connection List

Introduction
The object "Connections" allows you to output the configured connections via WinCC 
communication drivers in a report. The object is located in the Page Layout Editor object tree, 
in the "Project documentation" tab under "WinCC Explorer".

Requirements
● A connection via a WinCC communication driver has been configured.

● The object "Connections" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Link tab is active.

● You are familiar with the Link tab.

Edit Options
For the object "Connections", you can select the connections.

Creating Page Layouts
8.5 Working with Objects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1691



For an overview of available objects for the product documentation of the WinCC Explorer and 
their output options, please refer to the chapter "Project documentation in the WinCC Explorer".

Procedure
1. Open the branching node on the left of the Link tab. Select the entry "Connections". The 

list of editing options will then show the item "Selection of connection list".

2. Double-click on the entry "Selection of connection list". The WinCC Explorer: Select 
Connections dialog is opened.

If the "All connections" checkbox is active, all available connections will be returned. An 
existing selection in this dialog will be preserved.

3. Select the desired items from the list of available connections and add them individually or 
in groups, using the dialog buttons, to the list of selected connections.

4. Confirm the selection with "OK".

5. Modify the external form of the object "Connections", if necessary, by changing the attribute 
values in the Properties tag.

6. Close the "Object Properties" window and save the layout.

See also
How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

The Link tab in the Object Properties Window (Page 1575)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.15 How to Change the Output Options for the Dynamic Texts

Introduction
Some of the objects in the object tree Project Documentation are of the type Dynamic Text 
and do not offer an option to select data for output. These objects are firmly linked to the WinCC 
applications and provide the designated configuration data as text for output in a report.

Objects of the dynamic text type are marked in the object tree with the symbol . 
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The external form of the objects can be influenced by changing their attributes. The procedure 
is the same for all objects of this type. You can call up direct help for each attribute by right-
clicking it in the Attribute column.

Requirements
● The relevant object of the type Dynamic Text has been inserted in the layout, and selected.

● The Object Properties window is open, and the Properties tab is active.

Procedure
1. On the left of the Properties tab, select the object from the directory tree and open the 

branching node. The property groups of the object are shown in a directory tree.

2. Select a property group. The attribute of this group are shown in the area on the right.

3. Choose an attribute and double-click it. This will open a dialog which allows you to edit the 
attribute properties.

4. Specify the settings you want and confirm your entries with OK.

5. Close the Object Properties window and save the layout.

See also
How to Change the Output Options for the Dynamic Tables without Data Selection 
(Page 1695)

How to Change the Output Options for the Dynamic Metafiles (Page 1693)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Objects for the Project Documentation (Page 1666)

8.5.10.16 How to Change the Output Options for the Dynamic Metafiles

Introduction
Some of the objects in the object tree "Project documentation" are of the type "Dynamic 
metafile" and do not offer an option to select data for output. These objects are firmly linked 
to the WinCC applications and provide the designated configuration data as an image for output 
in a report.
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Objects of the dynamic metafile type are marked in the object tree with the symbol . 

The external form of the objects can be influenced by changing their attributes. The procedure 
is the same for all objects of this type. You can call up direct help for each attribute by right-
clicking on it in the "Attribute" column.

Requirements
● The relevant object of the type "Dynamic metafile" has been inserted in the layout, and 

selected.

● The Object Properties window is open, and the Properties tab is active.

Procedure
1. On the left of the Properties tab, select the object from the directory tree and open the 

branching node. The property groups of the object are shown in a directory tree.

2. Select a property group. The attribute of this group are shown in the area on the right.

3. Choose an attribute and double-click it. This will open a dialog which allows you to edit the 
attribute properties.

4. Specify the settings you want and confirm your entries with "OK".

5. Close the Object Properties window and save the layout.

See also
How to Change the Output Options for the Dynamic Tables without Data Selection 
(Page 1695)

How to Change the Output Options for the Dynamic Texts (Page 1692)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Objects for the Project Documentation (Page 1666)
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8.5.10.17 How to Change the Output Options for the Dynamic Tables without Data Selection

Introduction
Some of the objects in the object tree "Project documentation" are of the type "Dynamic table" 
and do not offer an option to select data for output. These objects are firmly linked to the WinCC 
applications and provide the designated configuration data as a table for output in a report. 
These dynamic tables do not offer any editing options in the "Link" tab of the "Object Properties" 
dialog.

Objects of the dynamic table type are marked in the object tree with the symbol .

The external form of the objects can be influenced by changing their attributes. The procedure 
is the same for all objects of this type. You can call up direct help for each attribute by right-
clicking on it in the "Attribute" column.

Requirements
● The relevant object of the type "Dynamic table" has been inserted in the layout, and selected.

● The Object Properties window is open, and the Properties tab is active.

Procedure
1. On the left of the Properties tab, select the object from the directory tree and open the 

branching node. The property groups of the object are shown in a directory tree.

2. Select a property group. The attribute of this group are shown in the area on the right.

3. Choose an attribute and double-click it. This will open a dialog which allows you to edit the 
attribute properties.

4. Specify the settings you want and confirm your entries with "OK".

5. Close the Object Properties window and save the layout.
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See also
How to Change the Output Options for the Dynamic Metafiles (Page 1693)

How to Change the Output Options for the Dynamic Texts (Page 1692)

How to Transfer Object Properties (Page 1577)

How to Change an Attribute (Page 1576)

The Properties of an Object (Page 1570)

Working with Objects for the Project Documentation (Page 1666)

8.6 Appendix

8.6.1 Requests to a CSV File for Reporting

Introduction
To permit the data from a CSV file to be output in a WinCC log, the data must correspond to 
a set structure. The data in a CSV file are prepared by the user. You will find more information 
in chapter Outputting Data from a CSV Table and Example of Reporting CSV Files.

Requirements for CSV File to be Output in Tabular Form
Each section must begin with the name of the corresponding file structure, followed by one or 
more lines containing the elements of the file structure. The following file structures are defined:

File Structure for Output in Tabular Form
The table, columns, and data must be defined as follows:

#Table; Name; Columns; Font; Font size

- Name = name of the table control or file

- Columns = number of columns

- Font = font of the table

- Font size = font size of the table

 

#Column; Num; Header; Width; Alignment

- Num = number of the column

- Header = header of the column

- Width = width of the column in characters

- Alignment = left aligned/centered/right aligned
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#Data; Color; Col1; Col2; Col3; Col4; ...

- Color = color attribute of the line (0xbbggrr)

- Col1 = data of column 1

- Col2 = data of column 2

- etc.

Points to Note About the Data in the CSV File
The control characters for colors, alignment, etc. are always at the beginning of the output text 
and can be combined with each other (e.g. output text). No distinction is drawn between upper 
and lower case.

The Width parameter indicates the relative width of the columns. The effective width of the 
column in the table is calculated as follows:

[ Table width as a number of characters ] x [ relative width of the column in % ] / [ sum of all 
relative widths of the column ]

The line defined for tables in the CSV file contains one more column than the data lines. If a 
spreadsheet program such as Excel is used to edit the data, the columns for the headings and 
the data will no longer match up. To prevent this from happening, you can enter a semicolon 
(;) as the first character in the data lines of the CSV file. The data blocks of the CSV file may 
not contain blanks. When you open the CSV in Excel, the data columns are shifted one column 
to the right. The columns for the headings and data will then match up. If the first column does 
not contain anything, you have to insert a blank (;blank;first data value;...). 

Control Characters for Table Output

<END> If the interpretation of control sequences is done, the rest of the 
text will be transferred as it is given.

<COLOR=#rrggbb> Font color in hexadecimal notation (default = as set for the table)
<BGCOLOR=#rrggbb> Background color in hexadecimal notation (default = as set for the 

table)
<B> Bold
<U> Underlined
<I> Italic
<STRIKE> Strike-through
<ALIGN=left> Left aligned
<ALIGN=center> Centered
<ALIGN=right> Right aligned
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Note

The definition of the color attribute Color complies with the byte format. The notation is 
0xbbggrr (hex blue blue green green red red). The control characters for formatting the table 
cells comply with the HTML standard. The notation for  is #rrggbb.

 

Each section must begin with the name of the corresponding file structure, followed by one or 
more lines containing the elements of the file structure. The following file structures are defined:

File Structure for Output in the Form of a Trend f(t)
#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize

- Name = name of the trend control or file

- Curves = number of trends

- DateFrom = start of time range, notation: 2000-10-30 10:15:00.000 

Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).

- DateTo = end of time range, notation: 2000-10-30 10:15:00.000 

Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).

- Common Y-Axis = common y-axis

- Font = font

- Fontsize = font size

 

#Curve; Num; Name; Count; dMin; dMax; Color; Weight; CurveType;  Filling

- Num = number of the trend

- Name = trend name

- Count = number of values

- dMin = lower limit of the trend (for scaling)

- dMax = upper limit of the trend (for scaling)

- Color = color attribute of the trend (0xbbggrr)

- Weight = line weight in points (e.g. 1.5)

- CurveType = trend type ( LINE, DOTS, STEP)

- Filling = filling color for areas ( 0=no, 1=yes). The Filling parameter is currently not evaluated.

 

#Data; Num; Date; Value; Flags; Color

- Num = number of the trend

- Date = X coordinate of the trend, notation: 2000-10-30 10:15:00.000

Number of digits: year(4); month(2); day(2); hours(2); minutes(2); seconds(2); milliseconds(3).
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- Value = y coordinate of the trend

- Flags = limit values/time overlap etc.

- Color (if an empty string is specified here, the color is taken from #Curve ...".)

8.6.2 Filter Criteria for the Alarm Output

Introduction
The filter criteria for alarm output are transferred with the transfer of the selection criteria from 
the selection dialog in the "Filter criteria for alarm output" area. The filter criteria can be edited.

The following conditions apply to WinCC: 
● The structure consists of the elements Field, Operand and Value, with the individual 

parameters separated by blanks.         
Example: DATETIME >= 2000-12-21 00:00:00' AND MSGNR >= 100 (all messages since 
12.20.2000 with message number greater than 100)

● Strings, date, and time must be passed in single quotation marks.

● In the DATETIME argument, the date and time of day are separated by a blank. Regardless 
of the time base setting in the object properties, the output of DATETIME is based on the 
time base Local Time. Exception: UTC is set as the time base: in this case, the output is 
based on time base UTC.

Permissible Arguments:

Name Type data Example:

DATETIME Date 'YYYY-MM-DD 
hh:mm:ss.msmsms'

DATETIME >= '1999-05-03 
16:00:00'         
Output of message from 
05.03.1999          
16:00 hours.

MSGNR Integer Message number MSGNR >= 10 AND MSGNR <= 
12         
Output of messages with          
message number 10 -12.

CLASS 
IN         
AND         
TYPE IN

Integer Message class ID 
1-16         
and         
message type ID 1-256

CLASS IN ( 1 ) AND TYPE IN 
( 2 )         
Output of messages of message class 
1          
message type 2.
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Name Type data Example:

STATE Integer Value of          
ALARM_STATE_xx         
Only operands          
= and IN(...) are          
permitted         
         
ALARM_STATE_1         
ALARM_STATE_2         
ALARM_STATE_3         
ALARM_STATE_4         
ALARM_STATE_5         
ALARM_STATE_6         
ALARM_STATE_7         
ALARM_STATE_16         
ALARM_STATE_17

STATE IN(1,2,3)         
Output of all message that came in, 
went out and were 
acknowledged.         
         
Possible values:         
1 = Came In messages         
2 = Went Out messages         
3 = acknowledged messages         
4 = locked message         
5 = released messages         
6 = messages that came in and have 
been acknowledged          
7 = messages that came in and went 
out         
16 = messages acknowledged by the 
system         
17 = emergency-acknowledged 
messages

AGNR Integer PLC number AGNR >= 2 AND AGNR <= 2         
Output of messages with          
AG number = 2.

AGSUBNR Integer AG subnumber AGSUBNR >= 5 AND 
AGSUBNR         
<= 5         
Output of messages with          
AG subnumber = 5.

TEXTxx Text Search text for          
'Text1'-'Text10'

TEXT2 = error         
Output of messages with         
Text2 = "error".

PVALUExx Double or text Search text for          
PVALUE1-         
PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 
50         
Output of process value 1 with          
start value 0 and stop value 50.

The following operands are permissible:

>= , <= , = , > , < ,IN(...),LIKE
IN(...): several values in Array separated by commas, e.g. CLASS IN( 1 ,2 ,3 ) AND TYPE 
IN( 1 ,2 ,19 ,20 ,37 ,38 )

LIKE: Text must contain string, e.g.: TEXT1 LIKE 'Error' relays message where Text1 contains 
the search text Error.

The operand LIKE is only permissible for TEXT arguments.

Arguments and operands other than those mentioned above are not permissible.

Creating Page Layouts
8.6 Appendix

MDM - WinCC: Working with WinCC
1700 System Manual, 11/2008,  



Creating Line Layouts 9
9 Resources

9.1 Creating Line Layouts

Content
The line layout editor is an editor provided by WinCC that allows you to create and dynamize 
line layouts for the output of a message sequence report. As part of WinCC, it can only be 
used to edit line layouts belonging to the project that is open in WinCC.

This section shows you

● How to use the line layout editor

● How to create and edit line layouts

● How to design a line layout

9.2 How to Start the Line Layout Editor

Introduction
In accordance with Windows conventions, there are various ways of opening the line layout 
editor. The line layout editor can only be opened for the current project that is open in WinCC 
Explorer.
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Requirement
● A project must be open in WinCC Explorer.

Opening the Line Layout Editor
The line layout editor is always called in WinCC Explorer.

The following options are available:

Navigation window/data window of WinCC Explorer:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.

In the navigation or data window of WinCC Explorer, select "Layouts" and choose the "Open 
Line Layout Editor" command from the pop-up menu.

The line layout editor is started, and a new layout is opened.
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WinCC Explorer data window:
Select the Report Designer entry. The "Layouts" and "Print Jobs" subentries are displayed.

In the navigation window, select "Layouts". The available layouts are displayed in the data 
window. Double-click a line layout or choose "Open Line Layout" from the pop-up menu.

The line layout editor is started, and the selected line layout is opened.

See also
The Line Layout Editor (Page 1703)

9.3 The Line Layout Editor

9.3.1 The Line Layout Editor

Introduction
The line layout editor is used only to create and edit line layouts for a message sequence 
report. Each line layout contains a dynamic table that is connected to the WinCC message 
system. Additional objects cannot be added to a line layout. Text can be entered in the header 
and footer. Start the line layout editor in WinCC Explorer.
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Layout of the Line Layout Editor
The line layout editor has a toolbar, menu bar, status bar, and various different areas for editing 
a line layout. When opened, the line layout editor appears with the default settings.

(1) The Menu Bar
The menu bar is always visible. Depending on the context, the functions in the menus are 
active or inactive.

(2) The Toolbar
The toolbar is always visible in the line layout editor. There are different buttons on the toolbar 
that allow you to activate the functions of the menu commands quickly. The buttons are either 
active or inactive, depending on the situation.

(3) The Header Area
The Header area allows you to enter text in order to create the header of a line layout. 

(4) The Table Area
The design of the table for output is displayed in the Table area. The configured column 
headings and the width of the columns (number of characters per column) are displayed. The 
table can be configured for output using the buttons in this area.
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(5) The Footer Area
The Footer Area is used to enter text in order to create the footer of a line layout. 

(6) The Page Size Area
The Page Size area is used to set the number of lines and columns for a line layout.

(7) The Margins Area
The Margins area is used to set the margins for the output of a line layout.

(8) The Status Bar
You will find the status bar along the lower edge of the screen. It contains tips on the buttons 
on the toolbar, on menu commands, and on keyboard settings, for example.

See also
The Table Area (Page 1708)

The Header and Footer Areas (Page 1707)

The Page Size and Margins Areas (Page 1706)

The Standard Toolbar (Page 1705)

9.3.2 The Standard Toolbar

Usage
The toolbar is located under the menu bar along the top of the line layout editor. The buttons 
arranged on the toolbar enable you to access the functionality of the line layout editor quickly 
and easily.

Contents
The standard toolbar contains buttons with the following functions:

Button Function Key combination

Creates a new line layout. <CTRL+N>

Opens an existing line layout. <CTRL+O>

Stores the active line layout. <CTRL+S>
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Button Function Key combination

Cuts the selected text from the header or footer and copies it to 
the clipboard. The function is only available when a text is selected.

<CTRL+X>

Copies the selected text from the header or footer to the clipboard. 
The function is only available when a text is selected.

<CTRL+C>

Pastes the contents of the clipboard at the location of the cursor. 
The function is only available if there is a text on the clipboard.

<CTRL+V>

The "Print" function is deactivated in the line layout editor.  

Activates the direct help (What's this?). <SHIFT+F1>

Characteristics
The toolbar in the line layout editor is always activated. You cannot hide it.

See also
The Page Size and Margins Areas (Page 1706)

Working with the Line Layout Editor (Page 1710)

The Table Area (Page 1708)

The Header and Footer Areas (Page 1707)

9.3.3 The Page Size and Margins Areas

Introduction
Line-by-line printing is used in practice for current and synchronous documentation. WinCC 
allows for "line-by-line printing" on appropriate printers. The output to the printer is only possible 
via a local, parallel interface on the computer. You can set the page size and margins for each 
line layout within the permissible limits. 

Page Size in the Line Layout
The page size of a line layout can be set within the following limits:

● The number of lines can be between 1 and 400.

● The number of columns can be between 20 and 400.

The value for the number of columns is defined as the number of characters per line.
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Margins in the Line Layout
Because most printers cannot print right up to the edge of the page, the margins must be set 
accordingly in the line layout. The margins of a line layout can be set within the following limits:

● The value for the margins (left, right, top, bottom) can be between 0 and 30 characters.

Printer Settings
The number of columns set in a line layout under "Page Size" (= characters per line) must be 
supported by the printer used. If the number of columns is greater than the number of 
characters a printer can print per line, a line break is inserted. This overflow of the column text 
into a new line disturbs the column formatting. To remedy this, a narrower font or a smaller 
character width must be set for the printer.

Setting the font or character width depends on the printer used. Please check the printer 
manual for further information.

Note

If the suitable font is not set as the default font on the printer, it will have to be set again each 
time the printer is reset or switched off and on again.

See also
Working with the Line Layout Editor (Page 1710)

The Table Area (Page 1708)

The Header and Footer Areas (Page 1707)

The Standard Toolbar (Page 1705)

How to Set the Page Size (Page 1710)

9.3.4 The Header and Footer Areas

Introduction
You can define a different header and footer for each line layout. The number of headers and 
footers can be between 0 and 10. You can enter any text you like in them. You can output as 
many headers as the number of lines you have set. You do not have to output the header and 
footer.

Usage
The headers and footers are output with each page of the message sequence report. The 
width of the headers and footers is based on the number of columns (= characters per line) 
set under "Page Size". Text in the header or footer that is longer than the configured number 
of columns is truncated at output.
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See also
Working with the Line Layout Editor (Page 1710)

The Table Area (Page 1708)

The Header and Footer Areas (Page 1707)

The Standard Toolbar (Page 1705)

How to Create Headers and Footers (Page 1711)

9.3.5 The Table Area

Introduction
You can define a table for the output of reports and measured values for each line layout. The 
number and contents of the columns are defined using the "Selection..." button. The number 
of columns can be between 1 and 40 and depends on the number of selected message blocks.

Usage
The configured columns with the associated headings and the set column width are displayed 
in the Table area. You can configure the column heading and the column width for each column 
separately.

Use the "Selection..." button to open the "Alarm Logging Runtime: Report - Table Column 
Selection" dialog. In this dialog, you can select the server(s) whose reports you want to log. 
You can assign the message blocks to the table columns and set the filter criteria for the alarm 
output. These changes are only effective for the output of the message sequence report and 
are not written back to the alarm logging. You can find additional information in the sections 
"Outputting Runtime Data with the Message Sequence Report" and "Changing Output Options 
for the Message Sequence Report".

See also
The Time Range (Page 1709)

Working with the Line Layout Editor (Page 1710)

The Table Area (Page 1708)

The Header and Footer Areas (Page 1707)

The Standard Toolbar (Page 1705)

How to Change the Output Options for the Message Sequence Report (Page 1713)
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9.3.6 The Time Range

Introduction
By changing the base for the time settings you can convert the time specified in the time stamp 
of the report data to a different time base. The time settings are only converted for the output 
in the report and are not written back to the alarm logging. If, for example, you want to output 
the data of a remote computer in another time zone, you can use this function to ensure that 
the data is output with a comparable time. If the two computers in this case were working with 
the "Local Time" time base, you would receive reports on the two computers with different 
times. The results would not be directly comparable. You can find additional information in the 
section "Adjusting the Time Settings in the Project".

If you change the time base for the output, ensure that the time reference is also output in the 
report. For example, specify an identifier in the alias for the "Time" message block. You can 
find additional information "Changing the Output Options for the Message Sequence Report".

Usage
You can change the time base in the "Table" area. To do this, click the "Time Base..." button. 
The "Time Base Entry" dialog appears. Select the time base from the list.

See also
The Header and Footer Areas (Page 1707)

The Table Area (Page 1708)

Working with the Line Layout Editor (Page 1710)

The Standard Toolbar (Page 1705)

How to Change the Output Options for the Message Sequence Report (Page 1713)
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9.4 Working with the Line Layout Editor

9.4.1 Working with the Line Layout Editor

Introduction
The line layout editor is only used to create and change line layouts for the message sequence 
report. It therefore has a very simple layout and is easy to use. This section describes how 
you can do the following:

● Set the page size of a line layout

● Create the header and footer

● Create a table in the line layout

● Change the output options for the message sequence report

See also
How to Change the Output Options for the Message Sequence Report (Page 1713)

How to Create a Table in the Line Layout (Page 1712)

How to Create Headers and Footers (Page 1711)

How to Set the Page Size (Page 1710)

9.4.2 How to Set the Page Size

Introduction
You can set the page size and margins for each line layout within the permissible limits. You 
can set the desired values either by using the controls or by entering them directly in the fields.

The following limits apply to the line layout:

Number of lines Values between 1 and 400 are permissible.
Number of columns Values between 20 and 400 are permissible.
Margin width Values between 0 and 30 are permissible.

Procedure
1. Select an existing line layout in WinCC Explorer or create a new line layout and open it in 

the line layout editor.

2. Set the number of lines per page in the "Page Size" area by using the corresponding 
controls or by entering a value.
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3. Set the number of columns (= characters per line) in the "Page Size" area by using the 
corresponding controls or by entering a value.

4. Set the width of the margins for output in the "Margins" area by using the controls or entering 
values.

5. Save the changes and close the line layout editor.

See also
How to Change the Output Options for the Message Sequence Report (Page 1713)

How to Create a Table in the Line Layout (Page 1712)

How to Create Headers and Footers (Page 1711)

9.4.3 How to Create Headers and Footers

Introduction
You can create a header and footer for each line layout in the line layout editor. They are then 
output with each page. Headers and footers consist of text only and can have a maximum of 
10 lines each. You can set the number of lines for headers and footers separately by using 
the corresponding controls or by entering values directly. Lines of text that are longer than the 
page width set in the "Page Size" area (number of columns =characters per line) are truncated 
at output.

Procedure
1. Open the desired line layout in the line layout editor.

2. Set the number of lines in the "Header" area by using the corresponding control or entering 
a value.

3. Enter the text for the header in the text box. Note the number of characters per line. Press 
the return key to insert a line break. 

4. Edit the footer in the same way.

5. Save and close the layout.

If you enter more lines during input than are specified for "Number of Lines", a message to this 
effect appears. Only the number of lines set for "Number of Lines" are output. Excess lines 
are not output.

See also
How to Change the Output Options for the Message Sequence Report (Page 1713)

How to Create a Table in the Line Layout (Page 1712)

How to Set the Page Size (Page 1710)
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9.4.4 How to Create a Table in the Line Layout

Introduction
The table object for the output of reports in the message sequence report is a fixed part of the 
line layout. The static object properties for this table object are predefined. Click the 
"Selection..." button to open the "Alarm Logging Runtime: Report - Table Column Selection" 
dialog. In this dialog you can specify the assignment of the message blocks to the columns for 
output. You also assign the column headings here and set the width of the individual columns 
for output.

Requirements
● The desired layout must be open in the line layout editor.

● Alarm logging must be configured.

Procedure
1. Click the "Selection..." button to open the "Alarm Logging Runtime: Report Table Column 

Selection" dialog.

2. Use the dialog to specify the data for output. You can find additional information in the 
section "Changing the Output Options for the Message Sequence Report". When you close 
the dialog, the selected columns and their widths are displayed in characters per line in the 
"Table" area. If the number of characters per line is too large, a message to this effect 
appears.

3. Change the time base for times, if necessary. You will find more information in the section 
"Table Area".

4. Save the line layout, and close the editor.

See also
How to Create Headers and Footers (Page 1711)

How to Set the Page Size (Page 1710)

The Table Area (Page 1708)

How to Change the Output Options for the Message Sequence Report (Page 1713)
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9.4.5 How to Change the Output Options for the Message Sequence Report

Introduction
To output a user-specific selection of messages, you can either use a predefined line layout 
or create your own line layout. The layout must be called in the "@Report Alarm Logging RT 
Message Sequence" print job.

For the output of a message sequence report in a page layout, changes to the output options 
must be configured in the page layout editor. You will find more information in the section 
"Creating a User-Defined Message Sequence Report".

Note

You cannot output a Message Sequence Report in line layout as a file.

Requirements
● The desired layout must be open in the line layout editor.

● Message configuration has been carried out in Alarm Logging.

Procedure
1. Click the "Selection" button in the "Table" area. The "Alarm Logging Runtime: Report Table 

Column Selection" dialog is opened.

2. Use the dialog to configure the selection of data for output. You will find a description of 
the dialog in the section "Data Selection" below.

3. Apply the settings by clicking "OK".

4. Save the line layout, and close the editor.

Data Selection
The "Alarm Logging Runtime: Report Table Column Selection" dialog is used to select the data 
to output in the message sequence report. It allows you to select the servers, message blocks, 
and filter criteria for alarm output.
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Selecting the Servers
Server selection is only necessary if you: 

● want to log the messages on a WinCC client,         
         
or

● want to log the messages of one server on another server in a distributed system

In the "Selection: Server from the Project Data" area, you can select the servers whose 
messages are to be logged. Only those servers whose "packages" have been loaded are 
offered. The selected servers are displayed in the window. In the case of a single-user and 
multi-user project this selection is not required.

Dynamization of Server Selection by Means of a WinCC Variable
You can dynamize server selection in order to select servers when a project is activated directly 
before logging is started. The report system reads the value from the variable at runtime. If the 
variable cannot be read, the configured value is used.

1. Select the "Variable" check box. The text box and the folder button are activated.

2. Use the folder button to open the variable selection dialog. Select the desired variable there, 
and close the variable selection dialog. Alternatively, enter the variable name directly in the 
text box.

Configure value assignment to the WinCC variable. You will find more information in the section 
"Types of Dynamization".

Selecting Message Blocks
In the "Assignment: Message Blocks -> Table Columns" area, you can define the message 
blocks for output in the report. In the "Message Blocks" area, select the desired message 
blocks from the list of existing message blocks. Use the control elements in the dialog to add 
the message blocks to the list of the current column sequence of the report either individually 
or in groups.

Editing the Properties of the Message Blocks
From the list of the current column sequence of the report you can select individual message 
blocks and edit their properties. To do this, select a message block from the current column 
sequence of the report and click the "Properties" button. You can now assign an alias to the 
block name and change the format for the date and time message blocks. The appearance of 
the dialog that opens depends on the type of message block selected. The changes are only 
effective for the output of the report and are not written back to the Alarm Logging.

If the "Use Aliases" check box is selected, the configured aliases are output as the column 
headings. The aliases cannot be configured for multiple languages. If the check box is cleared, 
the names of the message blocks are used as column headings. If the language is changed, 
the names stored for the message blocks in the text library are output. By default, the check 
box is cleared. If the "Use Aliases" check box is selected and there are no aliases configured, 
the names of the message blocks are output.
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Setting Filter Criteria for Alarm Output
In the "Filter Criteria for Alarm Output" area you can use the "Selection..." button to display the 
dialog for setting criteria for alarm output. Use the check boxes in the dialog to select the 
desired selection criteria. When you apply the settings by clicking the "OK" button, the selected 
selection criteria are displayed in the "Filter Criteria for Alarm Output" area. The individual 
arguments are always ANDed. You will find more information in the section "Filter Criteria for 
Alarm Output".

You can also make a selection in the print job by means of the size or time range. Additional 
information can be found in the chapter "Print Jobs in WinCC".

Note

In a message sequence report, the messages from the report system are logged as soon as 
they arrive. It therefore does not make sense to select the time range for the output.

See also
How to Create a Table in the Line Layout (Page 1712)

How to Create Headers and Footers (Page 1711)

How to Set the Page Size (Page 1710)
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Setting Up Multilingual Projects 10
10 Resources

10.1 Setting Up Multilingual Projects

Contents
WinCC offers the following possibilities: 

● Different languages can be set for the project interface.

● Create projects that run in multiple languages in runtime.

WinCC provides you with the following:

● "Text Library" editor
The "Text Library" editor is a a powerful editor for managing and maintaining practically all 
the texts in your project.

● Text Distributor
The Text Distributor provides all editors with user-friendly export and import options for 
translating the configured text records.

This chapter shows you:

● How to export texts for translating and import them again with the Text Distributor.

● How to manage texts centrally with the "Text Library" editor.

● How to configure multilingual pictures in the "Graphics Designer" editor.

● How to configure multilingual messages in "Alarm Logging" editor.

● How to configure reports for multilingual projects.

● How to configure multilingual date and time displays.

● How to configure changes of language in runtime.
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10.2 Language support in WinCC

10.2.1 Language support in WinCC

Multilingual Configuration in WinCC
WinCC enables you to configure your projects in multiple languages. For this purpose WinCC 
supports the multilingual configuration of almost all objects containing text that is visible in 
runtime.

In addition to direct text entry, WinCC provides you with user-friendly export and import options 
for translating your configuration with the Text Distributor. This is especially advantageous if 
you are configuring large projects with a high text content.

Supported Languages
In principle WinCC allows you to create projects for every language installed on your operating 
system. During installation WinCC also offers you a group of languages in which you can set 
up your WinCC configuration interface.

The following languages can be installed with the standard version of WinCC:

● German

● English

● Spanish

● Italian

● French

Furthermore with the Asian languages version of WinCC you can install the following 
languages: 

● Japanese

● Chinese (traditional and simplified)

● Korean

● English

You can set up the WinCC Configuration interface in the installed languages. In addition, once 
a language has been installed all standard texts are available in that language.

If a project should be used on another computer, then WinCC must be installed on the target 
computer in the same language as on the source computer. You should always install WinCC 
with all available languages. 

Standard texts
Standard texts are all texts that already exist in WinCC's installed languages, e.g. default 
names of message classes in the "Alarm Logging" editor, WinCC system messages, and the 
title bar captions and column titles in WinCC Control.
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Configuration Scenarios
When configuring in other languages the following scenarios can occur:

● You are configuring a project for a language with which you are unfamiliar.
Example: 
You are an English speaking project engineer and configuring for an Asiatic market: Display 
the project user interface of WinCC in your preferred language. 
There are two procedures for configuration: 

– Configure the project in a language with which you are familiar, export the texts, translate 
the texts externally and import the translated texts back into the WinCC project.

– You enter all text for your project directly in the language that is intended to be displayed 
later in runtime. Direct text entry is recommended only in cases where you have 
configured just a small amount of text in your project.

● You are configuring a project for a number of languages with which you are unfamiliar.
Example: 
You are a French speaking project engineer and configuring a project for a system which 
must be operated by Russian, English and German speaking users: Display the project 
user interface of WinCC in your preferred language. Configure the project in a language 
you are familiar with and export all the text. Distribute the exported files to translators for 
each respective language. Following translation, import the translated texts back into your 
WinCC project. Configure a change of language facility for the operators as well, so that 
they can use it in runtime to select the desired language for the operator interface. 

10.2.2 Language expressions in WinCC

Principle of Language Expressions in WinCC
When using WinCC to create multilingual projects, you can set up languages at multiple system 
levels. It is therefore helpful to distinguish between these various levels by using clearly defined 
language expressions.

Operating System Language
The operating system language (system locals) is the language environment set in the 
operating system in which applications such as WinCC run. This setting defines e.g. the used 
"Code Page" in character sets.

Note
WinCC-GUI language and operating system language

Set the operating system language corresponding to your WinCC user interface so that the 
correct code page is used and all character sets are correctly displayed. Alternatively you 
can use an operating system in the corresponding language.

Information about the operating system language and code pages can be found in your 
Windows documentation.
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Operating System User Interface Language
The operating system user interface language is the language in which the GUI of operating 
system is displayed. All Windows menus, dialogs and help text are displayed in this language. 
During configuration, some system dialog boxes are displayed in WinCC Configuration in the 
operating system GUI language, e.g. such as "Open file" and "Save as".

The operating system GUI language can only be switched with multilingual operating systems. 

WinCC GUI Language
The WinCC GUI language is the language of the project interface in WinCC Configuration, i.e. 
the language in which the WinCC menus, dialog boxes and help are displayed during 
configuration. You can set any language as the WinCC GUI language installed during setup. 
In the European version you have a choice between German, English, Italian, Spanish, and 
French. The WinCC GUI languages available in the Asian version are Japanese, Korean, 
Chinese, and English.

The language that you selected for the installation of WinCC is set as the WinCC GUI language 
when you first start WinCC. The next time you start WinCC the interface is displayed in the 
WinCC GUI language that you set up last.

You set the WinCC GUI language centrally in the WinCC Explorer. Select a language you are 
familiar with as the WinCC GUI language for configuration.

Note
WinCC-GUI language and operating system GUI language

If the current WinCC GUI language is not the same as the operating system GUI language, 
the standard dialog elements of certain WinCC editors remain unchanged and continue to 
be displayed in the operating system GUI language. This applies to standard buttons such 
as "Cancel", and standard system dialogs such as "Save as", "Open file" or "Print". 

In order to display these elements in the desired language, you need to set the operating 
system GUI to the same language as you are using for the WinCC GUI language. 

Project language
The project language is the language to be used for the project you are creating. You can 
create a project containing multiple project languages in order to make several languages 
available in runtime.

Note
Operating system languages as configuration languages

In addition to the languages installed with WinCC you can select any other language 
supported by your operating system as the project language.

With regard to operating system languages, WinCC supports only the primary languages, for 
example English (USA) but not English (GB), or traditional Chinese (Taiwan) but not simplified 
China (Peoples' Republic).
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In each case set up the project language directly in the editor you are using for configuration, 
e.g. in the "Alarm Logging" editor or the "Graphics Designer" editor. After switching the 
configuration language, the user interface remains the same in WinCC Configuration. Only the 
language of the texts which you create for your project is switched. The current project 
language is displayed in the status bar of the respective editor.

The following figure shows a section from the "Graphics Designer" editor with English as 
configuration language and WinCC with a German user interface:

Runtime Language
The Runtime language is the language in which the project is displayed in Runtime. You may 
set a Runtime language in WinCC in which the project will start in Runtime. 

When creating a project containing multiple languages, configure operating elements which 
will allow the operator to change the runtime language.
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Note
Runtime language

Always select one of your configuration languages, or the Runtime standard language, as 
the Runtime language. 

Runtime Default Language
In the computer properties in WinCC Explorer, a Runtime default language may be set which 
applies to graphics objects. 

If, for a specific text, there is no translation available into the current runtime language, the text 
is shown in the configured runtime default language. If the text is not available in this language 
"???" is displayed. 

Default Runtime Language for Objects
The default runtime language is English. The default Runtime language is the language used 
for texts of a WinCC object, such as AlarmControl or TableControl, if no translation of the 
respective Runtime language is available. In the main this affects the title bar captions and 
column titles in WinCC Control if the runtime language is not one of the languages installed 
with WinCC. In the languages installed with WinCC the controls are displayed correctly. This 
does not apply to texts and their translations stored in the Text Library. 

10.2.3 Configuring Multiple Languages

Operating system requirements
When configuring projects for multiple languages, your operating system must meet the 
following requirements: 

● The project languages must be installed

● The correct system regional setting (operating system language) must be specified as 
default on your operating system.
This is particularly important if you are configuring for languages which are not Western 
European, e.g. Asian.

● Any special fonts that you use must be available on your operating system. This applies 
particularly to non-Latin fonts used for example in Cyrillic or Asian languages.

● You must install input methods on your operating system to input e.g. Asian fonts.
For each running application, select the input methods independently of one another.

Note

How to make the corresponding settings or installation in your operating system is 
described in your Windows documentation.
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Language combinations
Due to the various language setting options in WinCC and your operating system, a number 
of different language combinations can occur, for example:

● Configure a single-language project in the language preferred:
Operating system language, operating system user interface language, WinCC user 
interface language and configuration language are all the same.

● Configure a single-language project in but not in your preferred language:
Operating system GUI language and WinCC GUI language are your preferred language. 
The project language is the language in which you subsequently display the project in 
runtime.
If you configure for Asian languages, define the operating system language so that the 
character set to be used is displayed in the respective code page. 
If all languages are from one regional area (e.g. Western European), this setting is not 
necessary because it was already made implicitly.

● You are configuring a multilingual project. One of the languages is your preferred language:
Operating system GUI language and WinCC GUI language are your preferred language. 
The project languages are the languages in which you subsequently display the project in 
runtime. Configure the project in your preferred language and hand over the text for 
translation when the project is complete.

● Several project engineers who prefer different languages and configure on one computer:
A neutral language, e.g. English, is selected as the operating system GUI language. Each 
configuration engineer can set the WinCC GUI language to his preferred language. The 
languages that will subsequently be displayed in runtime are set as the project languages.
If you configure for Asian languages, define the operating system language so that the 
character set to be used is displayed in the respective code page.
If all languages are from one regional area (e.g. Western European), this setting is not 
necessary because it was already made implicitly.  

Note

If you are using a multilingual operating system, the configuration engineer can also set 
the operating system GUI language to his preferred language.

Configuring for multiple languages - main editors
When configuring for multiple languages use the following editors:

● Text Distributor: 
The text distributor is a comfortable tool for exporting language-dependent text of the 
WinCC project. The exported data is translated in an external program. You then import 
the texts again following translation.

● Text library: 
All project texts are managed centrally in the "Text Library" editor except for texts from 
"Graphics Designer" editor. The fonts are defined centrally and language-specific in the 
"Text Library" editor. Export the text with the text distributor for the translation. As an 
alternative, you can translate the text directly in the "Text Library" editor or the respective 
editor.
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● Graphics Designer: 
Configure the pictures for the project in the "Graphics Designer" editor. Pictures can contain 
different text elements, such as Static Text, Tooltips or Labels for ActiveX Controls. The 
test is saved in the respective picture. You export the text with the text distributor for the 
translation or you enter the translated text directly.

● Alarm Logging: 
The "Alarm Logging" editor is used to configure messages that are issued in runtime. The 
texts for the message system are managed centrally in the text library. 
To translate the text, you have the following possibilities:

– Export the text for translation with the text distributor

– Translation in the "Text Library" editor

– Translation in the "Alarm Logging" editor

If there is a large number of message text records, it is to your advantage to export them. 
Configuring with SIMATIC STEP7: Alarm logging texts from the SIMATIC Manager are 
stored in the text library when transferred and must be translated there.

● Report Designer: 
The following is configured in the "Report Designer" editor:

– Language-dependent layouts for reports to be output in runtime

– Language-dependent layouts for the project documentation of your project

● User Administrator: 
The authorizations that you configure in the User Administrator are language-dependent. 
These text records are managed centrally in the "Text Library" editor. 
You export these text records with the text distributor or you translate them in the "Text 
Library" editor.
The User Administrator supports the languages which can be defined for the user interface. 
In order that the texts are created in the project text library, you must open the User 
Administrator in the respective language.
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● User Archive (optional): 
All the texts in the user archives are managed centrally in the "Text Library" editor. You 
export these text records with the text distributor or you translate them in the "Text Library" 
editor.

● Picture Tree Manager (optional): 
Texts (e.g. container names) from this WinCC add-on are managed centrally in the text 
library. You export these text records with the text distributor or you translate them in the 
"Text Library" editor.

Note

The project language can be set up separately for the "Graphics Designer" editor and the 
"Alarm Logging" editor. By default the editors start with the set runtime language as the 
project language.

WinCC elements such as archive names, tag names and script functions are unique and 
cannot be configured for multiple languages.

Do not use any national special characters or Asian fonts in language-dependent WinCC 
elements. These characters are illegible or prevent WinCC from working properly after 
switching languages.

Exception:          
You can also use non-ASCII characters, e.g. Asian characters, in tag names.

Non-translated texts
Non-translated texts are displayed differently in Runtime. For more information, refer to 
"Language expressions in WinCC (Page 1719)". 

10.2.4 How to Create a Multilingual Project

Introduction
The following section gives you an overview of the steps you need to take in order to configure 
multilingual projects. The optimal procedure is described in this chapter. Alternative procedures 
are described in the respective segments of this help.

The Procedure in Principle
1. Install all required fonts and input methods on your operating system.

If you are configuring in non-Latin fonts, the relevant fonts must be available as Small Fonts.

2. Activate the languages to be configured in your operating system.
Your Windows documentation will tell you exactly how to do this.

3. Install WinCC complete with all the languages that need to be available as WinCC GUI 
languages.
If you install languages at a later point in time, the default text for these languages is not 
automatically put into the Text Library.
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4. When you create a new project, the WinCC GUI language is the language you selected for 
the installation of WinCC. When launched again, WinCC opens in the WinCC GUI language 
last set.
If you use a language that is not provided with WinCC as the configuration language: 

– Make sure that the default text records of these languages do not exist as translations 
in WinCC. In this case, the default text records are entered in the current WinCC GUI 
language in the Text Library. You can translate these texts later or directly enter the 
language in the "Text Library" editor before changing to the project language.

5. Configure your project in a language with which you are familiar. This project language later 
serves as a basis for translation of the texts.

6. Export the text records with the Text Distributor.
You then have several files to translate.

7. Translate the texts in an external editor.

8. Re-import the translated texts.

9. Test your translated project in runtime.

Note
Creating the WinCC languages when copying a project

If you copy your project to another computer, all WinCC languages must be installed in 
the project's Text Library of the target computer. If necessary, you may have to install the 
missing languages in the project's "Text Library" editor and may have to configure the 
language entries for these languages. 

10.2.5 How to Switch the Language of the Operating System

Introduction      
Windows makes all languages and fonts available. You install languages when you install 
Windows. If you activate a language that is not actually installed, you are prompted to install 
it from the Windows CD. Activate the necessary fonts in your operating system as follows.
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Activating fonts in the operating system

Windows XP
● In "Start > Settings > Control Panel > Regional and Language Options", on the "Language" 

tab click the "Details" button. In the dialog which then appears use the "Add" button and 
add the necessary input locales and keyboard layouts. On this tab you can also define a 
hot key sequence so that you can change the input language. For example if you are 
creating an Asian-language project in an English operating system, you can use a keyboard 
shortcut to change the input language if you are switching to another Windows application.

Windows Vista
● In "Start > Control Panel > Time, Language and Region > Regional and Language Options", 

on the "Keyboard" tab click the "Change keyboards" button. In the "Text services and input 
languages" dialog that appears, add the required input language and keyboard layout on 
the "General" tab. On the "Advanced key settings" tab, you can also define a hot key 
sequence so that you can change the input language. For example if you are creating an 
Asian-language project in an English operating system, you can use a keyboard shortcut 
to change the input language if you are switching to another Windows application.

Note

If you work with the "Chinese (simplified)" operating system and you want to set English 
language support in the WinCC Explorer, you need to set "English" for menus and dialogs:
● For Windows XP under "Start > Settings > Control Panel > Regional and Language 

Options" in the"Languages" tab.
●  For Windows Vista under "Start > Control Panel > Regional and Language Options" in 

the "Keyboards and Languages" tab in "Display Language." 

This will correctly display the fonts in the dialogs and menus.
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10.2.6 How to Change Languages in WinCC

Requirements
When setting up languages in WinCC, observe the following requirements:

● If you are configuring with non-Latin fonts, the necessary fonts and input methods must be 
installed in your operating system.

● All configuration languages you wish to use must be installed in your operating system.

● If you are configuring Asian languages, the proper system input locale (operating system 
language) must be set to change the WinCC GUI language in the operating system control 
panel so that the used character sets are displayed in the right code page.         
If all languages are from one regional area (e.g. Western European), this setting is not 
necessary because it was already made.  

Note

For information on how to enter the appropriate settings and installation in your operating 
system, please refer to your Windows documentation.

Recommendations
In order to configure efficiently, please note the following:

● Always configure for one language at a time if possible.

● Set the runtime language to be the language to be configured. The editors always start with 
the set runtime language as the configuration language.

Changing the WinCC GUI Language
To change the WinCC GUI language, the language must have been installed with WinCC.

To change the WinCC GUI language, select "Tools > Language" in WinCC Explorer. In the 
selection window, you will be offered all installed WinCC languages with the exception of the 
current WinCC GUI language.

Following the change, the operating elements, menus and dialogs in WinCC Configuration are 
changed to the selected language.

Note
Operating system user interface language

If the current WinCC GUI language is not the same as the operating system GUI language, 
the standard dialog elements of certain WinCC editors remain unchanged and continue to 
be displayed in the operating system language. This applies to standard buttons such as 
"Cancel", and standard system dialogs such as "Save as", "Open file" or "Print". 

In order to display these elements in the desired language, you need to set the operating 
system language to the same language as you are using for the WinCC GUI language. 
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Note
Asian languages

If you are configuring for Asian languages and the current WinCC GUI language does not 
correspond to the operating system language, a large part of the Asian interface will not be 
displayed correctly.

Changing the configuration language in the editors
You can set the configuration language separately for the "Graphics Designer" editor and the 
"Alarm Logging" editor. 

To change the configuration language, open the editor concerned and select the menu 
command "View > Language". In a selection window, you will be offered all available languages 
on your system (primary languages only).

Following the change, all configured texts are displayed in the selected configuration language. 
If you have not configured the language yet, all texts in the "Graphics Designer" editor will be 
displayed as "???", and the "Alarm Logging" editor will not display any texts.

The set configuration language is displayed in the status bar of the editor window.

Setting runtime language and runtime standard language
Set the runtime language and runtime standard language in WinCC during centralized 
configuration in the starting configuration of the Runtime computer. For more information, see 
topic " How to Set the Runtime Computer Starting Configuration (Page 1796).

10.2.7 Fonts in Multilingual Projects

Introduction
In WinCC you can set a custom font for each configured language. The fonts that you wish to 
use must be installed in your operating system. You need special fonts if you use project 
languages containing non-Latin characters, such as Cyrillic, Greek or Asian character sets. 
For further information please refer to "Configuring with Non-Latin Fonts".
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Setting fonts in WinCC
In WinCC you can set fonts in the following places:

● In the "Text Library" editor: Here you must at the very least assign an appropriate font to 
each non-Latin language.

● In the "Graphics Designer" editor: For all objects containing a text display you can set the 
font in the Properties dialog of the object concerned, and for certain objects you can also 
use the Configuration dialog.         
In some input windows non-Latin text is not correctly displayed even though the font was 
correctly set. The display is correct in runtime. In such an event you may enter the text in 
another editor (e.g. Word) and transfer it to the input field using copy & paste.

Objects containing nonadjustable font:

● Tooltips: In order to display tooltips in runtime in a non-Latin font, go to the Control Panel 
of your operating system and set the font for tooltips in Display Properties. Note that when 
you make this change, the fonts for the tooltips of all the other applications on your Windows 
system are also changed.

● Window and column headings of ActiveX Controls: If the current runtime language is not a 
WinCC language, text is always displayed in the default runtime language (English).

● In some text input windows of the "Graphics Designer" editor, you cannot set the font. In 
this event select an input dialog in which the font can be set.

Note

If your configuration permits it, set the same language for operating system language, 
operating system GUI language, WinCC GUI language and project language.

10.2.8 Prohibited Characters in WinCC

Principle
Depending on the language and the component, only certain characters 

A complete overview of all the prohibited characters can be found in the WinCC documentation 
under "Prohibited characters".

10.2.9 Configuring with Non-Latin Fonts

Non-Latin Fonts
When configuring your project in languages that use non-Latin fonts, such as Asian or Cyrillic 
character sets, you need the corresponding fonts on your operating system and in WinCC.

In your operating system activate the corresponding languages and keyboard layouts as 
described under "Switching Operating System Languages".
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To display the Asian characters in Runtime, you absolutely require the Asian version of WinCC. 
With the Asian version, in addition to the texts configured by you, WinCC standard texts such 
as e.g. the Runtime dialog boxes, system messages are also available in Asian languages.

Notes regarding the Use of Non-Latin Fonts
For the majority of non-Latin fonts you can use the Input Method Editor (IME) in Windows. For 
further information on using the IME please refer to your Windows documentation.

WinCC does not support Big Fonts. You always have to provide the system with the respective 
fonts as Small Font.

Note

An example of a tool which can be of help in using non-Latin fonts is e.g. the "Kirillica" 
software. Further information on Kirillica is available from the Internet.

Special Characteristics of Non-Latin Fonts in WinCC
When entering text in graphic objects there are some input windows in which non-Latin text is 
incorrectly displayed even though the font was correctly set. The characters are displayed 
correctly in runtime. You can get round this by entering the text in another editor and then using 
Copy & Paste to add it to the input field.

Note

Depending on the operating system and language settings, carry out copy & paste actions 
may not be executed properly. To solve this problem, set the same input methods in the 
source and target application.

With certain objects in WinCC the font either cannot be set or can only be set in special 
circumstances. For further information on objects that cannot be changed see "Fonts in 
Multilingual Projects".
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Notes regarding Configuration with Non-Latin Fonts
● Always configure a language in a uniform font.

– "Alarm Logging" editor
For "Alarm Logging" editor texts, set up the font centrally in the "Text Library" editor. In 
the "Alarm Logging" editor, non-Latin characters are incorrectly displayed. The display 
is correct in the "Text Library" editor if you have set the correct font for the language.

– In the "Graphics Designer" editor you configure the font directly in all the objects that 
contain text.

● The title and column headings for the following objects are only available in the languages 
installed with WinCC and the languages cannot be switched between:

– A few WinCC controls

– Trend control axes labels

If the current runtime language is not a language installed with WinCC, labels are always 
displayed in the default runtime language English.

● If you create records in non-Latin fonts:
Basically, language-specific layouts are used. Possible languages for the layouts are those 
installed with WinCC. 
If a printout is started, the layout of the current runtime language is used. If the current 
runtime language is not a language installed with WinCC, the English layout is used. 
If you want to generate a printout with a non-Latin font, define the respective font in the 
English layout. Select the whole layout and then set the font. 

10.3 Text export and text import with the Text Distributor

10.3.1 Text export and text import in the Text Distributor

Introduction
WinCC allows the configuration of projects for many languages. The text records are displayed 
in runtime depending on the respective language. 

All text for your project is managed centrally in the Text Library except for text from the 
"Graphics Designer" editor.

The Text Distributor is a comfortable tool for exporting and importing all language-dependent 
text. Here you can export and import targeted languages, individual objects or groups of 
objects. The exported data is processed with an external program. 
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10.3.2 Text Distributor

Introduction
You have the following options for starting Text Distributor:

● Double-clicking in WinCC Explorer

● In the "Text Library" editor with the menu command "Tools > Export..." or "Tools > Import..."

● In the "Graphics Designer" editor with the "Tools > Text Import & Export..." menu command.
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Text Distributor Screen Capture
The "Text Distributor" has the following tabs:

● "Exporting texts"

● "Importing texts"
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Both tabs have two windows:

● The left window lists all editors with language-dependent texts. You can include or exclude 
individual editors during export or import.

● The right window has several areas:

– For the "Exporting texts" tab:
Enter the file prefix of the export files in the "Export files" area. You select the following:
The path where the files are to be saved
The file format

– For the "Importing texts" tab:
Enter the file prefix of the import files in the "Import files" area. You select the following:
The path where the files are saved
The file format

– For the "Exporting texts" tab:
In the "Graphics Designer" area, select individual pictures from which you want to export 
text. If necessary, create one file per picture during export.

– For the "Importing texts" tab:
In the "Graphics Designer" area, select individual pictures for which you want to import 
text again. If available, you can import one file per picture.

– In the "Languages" area, select the languages to be exported or imported.

– In the "Existing texts" area, set whether already existing data should be deleted, 
replaced or enhanced.
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10.3.3 How to export language-dependent texts

General procedure
Use the text distributor to export language-dependent texts to CSV files or TXT files. The text 
distributor creates several files that all begin with the same description. 

Example:

In the "File prefix:" field, enter the description "Mixing_station". In the "File format:" field select 
"*.txt". The following files are created:

● Mixing_station_Languages.txt

● Mixing_station_DataManager.txt

● Mixing_station_AlarmLogging.txt

● Etc.

NOTICE

Invalid file format

If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI 
file.

If you want to edit the exported data with Excel, select the "*.txt" file format during export. 

Note
Exportable and importable languages

The text distributor only makes available for export those languages that come from the 
same language area and use the same code page. 

For example, if you want to export Asian text, the associated system locale (operating 
system language) must be set in the system control of your operating system. The 
associated languages will only then be available. 

"English" is always available.

Setting Up Multilingual Projects
10.3 Text export and text import with the Text Distributor

MDM - WinCC: Working with WinCC
1736 System Manual, 11/2008,  



Procedure
1. Open the text distributor by double-clicking in WinCC Explorer.

2. Check or uncheck the editors from which you want to export text. If necessary, check or 
uncheck the individual objects of the editors.

3. In the "Export files" area under "Path:", select the path in which the export files are to be 
stored.

4. In the "File prefix:" field, enter a meaningful description.
All export files are created with a name that begins with this description.

5. In the "File format:" field, select the desired format "*.txt" or "*.csv".

6. Make the settings for the export.
If you only want to export text from individual pictures in the "Graphics Designer" editor:

– Start selecting the desired pictures in the "Graphics Designer" area using the "Selection" 
button.

If you want to create a separate export file for each picture:

– Select "One file per picture" in the "Graphics Designer" area.

If you want to export individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.
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7. Determine how to handle already existing text.
If you want to delete already existing export files:

– Select the option "Delete existing texts" in the "Existing texts" area.

If you want to replace text in the already existing export files.

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite text in already existing export files:

– Select the option "Retain existing texts" in the "Existing texts" area.

8. Start the export process using the "Export" button.

Results
The export files are created and saved in the select path. 

Note

If a picture contains "unknown objects", the export or import of the picture is aborted 
immediately und "Unknown" is appears in the information window.

10.3.4 Structure of the Export Files

10.3.4.1 Overview of the export files

Overview
Use the Text Distributor to export language-dependent texts to CSV files or TXT files. During 
export, the Text Distributor creates several files that all begin with the same description. 

Example:

You enter description "Mixing_station" in the "File prefix" field. You select "*.txt" in the "File 
format:" field. The following files are created:

● Mixing_station_Languages.txt

● Mixing_station_DataManager.txt

● Mixing_station_AlarmLogging.txt

● Etc.
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Export Files
A different number of files are created depending on which objects you select during export. 
The following types of files exist:

● Files for text from the "Text Library" editor

● Files for text from the "Graphics Designer" editor

● File "<Description>_Languages.csv" or "<Description>_Languages.txt"
This file is created. 
This file specifies the following for the text:

– Language-specific font type

– Language-specific font size

– Etc.

–

If font type, font size, etc. are configured for the language-dependent text in the "Graphics 
Designer", the settings in the "Graphics Designer" editor apply.

10.3.4.2 Construction of files with text from the Text Library

Overview
Use the Text Distributor to export language-dependent texts to CSV files or TXT files. During 
export, the text from the Text Library is saved in the following files:

● <Description>_AlarmLogging.txt or <Description>_AlarmLogging.csv

● <Description>_DataManager.txt or <Description>_DataManager.csv

● <Description>_LifeBeatMonitoring.txt or <Description>_LifeBeatMonitoring.csv

● <Description>_PictureTreeManager.txt or <Description>_PictureTreeManager.csv

● <Description>_NoSystemtext.txt or Description>_NoSystemtext.csv

● <Description>_UserAdministrator.txt or Description>_UserAdministrator.csv

● <Description>_GraphicsDesignerReferences.txt or 
<Description>_GraphicsDesignerReferences.csv

The associated files are created depending on which editors you select during export. 

Note

Information on the font type, font size, etc. of a language is entered in the 
"<Description>_Languages.csv" or "<Description>_Languages.txt" file. Change the entries if 
necessary.

You can also generate the "<Description>_NoSystemtext.txt", or 
"<Description>_NoSystemtext.csv" file. This file can contain the following:
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● Text that was not found in the configuration.
This can happen for the following reasons:

– The text is no longer used in the configuration.

– The text is used e.g. in the Global Script.

Structure of the Files
A separate block is created for each object type. Each block has the following structure:

● [Header]
The object type is entered here: e.g.: <MessageClassName> and a header line consisting 
of [ID] and the respective languages, e.g. English, German.

● Exported texts
The text ID from the Text Library is entered in the following rows in the first column. The 
following columns contain the text in the respective language.

Example: File "Example_AlarmLogging.txt" with object blocks <MessageClassStateCome>, 
<MessageTypeName> and <MessageBlocks>

<MessageClassStateCome>    
ID English German Spanish
2 + + +

<MessageTypeName>    
ID English German Spanish
8 Alarm Alarm Alarma
9 Warning Warnung Advertencia

10 Failure Fehler Error
11 Process control 

system
Leittechnik Sistema de control de 

procesos
12 System messages Systemmeldungen Avisos de sistema
13 Operator input 

messages
Bedienmeldungen Avisos de operador

<MessageBlocks>    
ID English German Spanish
14 Date Datum Fecha

10.3.4.3 Construction of files with text records from the "Graphics Designer" editor

Overview
When exporting, the text records of the "Graphics Designer" editor are stored in file 
"<Description>_GraphicsDesigner". If you have activated "One file per picture" for the export 
procedure, another file is created for every picture. 

Per picture, the file contains a header, an object description and the objects.

Example:
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● [Header]
The picture name is entered here, e.g.: <PIC_1.PDL>

● [Object]
Object description: Indicates what is contained in the respective columns.

– Column "Object"
Object name of the object that contains language-dependent text.

– Column "Property"
Language-dependent property of the object.

– The language column, e. g. "English".

– Format information and text for every existing language in the columns:
"FontName", "FontSize", "FontBold", "FontItalic", "FontUnderline"

● [Objects]
The objects are defined with the existing text records and properties in the following lines. 
If the text does not exist, "??????" is entered.

Example: Export file "Example_GraphicsDesigner" with pictures PIC_1.PDL and PIC_2.PDL

The German text records are not translated yet and are entered as "??????".

PIC_1.PDL           
Object Property English English 

Font         
Name

English 
FontSiz
e

English 
FontBold

English 
FontItalic

English         
 Font         
Underline

German German 
Font         
Name

....

Static Text1 Text Valve Arial 12 False False False ?????? Arial ....
Static Text2 Text Motor Arial 12 False False False ?????? Arial ....
Text list Assignm

ent
closed Arial 12 False False False ?????? Arial ....

PIC_2.PDL           
Object Property English English 

Font         
Name

English 
FontSiz
e

English 
FontBold

English 
FontItalic

English          
Font         
Underline

German German 
Font         
Name

....

Static Text1 Text Engine Arial 12 False False False ?????? Arial ....
..... ..... .... .... ... .... ... .... .... .... ...

Note
Text records in text lists

If text records from text lists have been put in the Text Library, these text records are exported 
into the following files:
● "<Description>_GraphicsDesigner" or respective picture file
● "<Designation>_GraphicsDesignerReferences" 

If you import file "<Description>_GraphicsDesignerReferences" again, make sure that the 
text records of the text lists are translated exactly as in the respective export file of the 
"Graphics Designer" editor.

Setting Up Multilingual Projects
10.3 Text export and text import with the Text Distributor

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1741



Line wraps
If line wraps are included in the language-dependent text records, the placeholder {CR} {LF} 
is entered. Do not change or delete the place holder. The placeholder must exist in the identical 
positions in the translated text records. 

10.3.4.4 Structure of the "_Languages" Files

Overview
The "<Description>_Languages.csv" file is created. The file specified the default settings for 
font type, font size, etc. for each language.

Note

If font type, font size, etc. are configured for the language-dependent text in the "Graphics 
Designer", the settings in the "Graphics Designer" editor are applied.

The "*_Languages.csv" is structured as follows:

● [Header]
The header has two lines. 
The file type is entered in the first line: <Languages>.
The headers are entered in the second line. This line indicates which information is entered 
in the following columns:

– LanguageName: Name of the language

– LanguageID: Language code

– FontName: Name of the font type used

– FontSize: Size of the font type

– FontBold: "Bold" font type

– FontItalic: "Italics" font type

– FontUnderlined: Underline

● Information for each language
The following lines contain the corresponding entries for each language created.

Example:

<Languages>       
LanguageName LanguageID FontName FontSize FontBold FontItalic FontUnderlined
English 1033 Arial 9.75 False False False
German 1031 Arial 9.75 False False False
French 1036 Arial 9.75 True False False
Italian 1040 Arial 9.75 False False False
Spanish 1034 Arial 9.75 False False False
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10.3.4.5 Status bar for the export and import
After the export or import, a dialog appears in which all export or import procedures are 
handled. 

The "Info" dialog lists messages in the following categories:

● "OK" (Successful export or import)

● "Warning" 

● "Error" (An error has occurred during export or import.)

● "Info" (With export: Object contains no language-dependent text records, with import: No 
text records have been imported for this object.)

You filter the output of the dialog by clicking on the respective buttons by the categories.

Example:

10.3.5 How to translate the text records externally

General procedure
The exported TXT or CSV files can be edited e.g. in Excel, Access or in a text editor like 
Notepad. This chapter describes the process for editing in Excel.

NOTICE

Invalid file format

If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI file.

Setting Up Multilingual Projects
10.3 Text export and text import with the Text Distributor

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1743



If you want to edit the exported data with Excel, select the "*.txt" file format during export. 

Please note the following:

Only permitted changes can be made in the exported files and before import to WinCC.

Impermissible Changes
The following changes are not permitted:

● Structural changes to the export file.

● Swapping, deleting or duplicate use of IDs or object descriptions.

● Text changes in the header area. This text is generally identified by angled brackets: <>.

● Text changes in WinCC if text is in the translation. New text can be added in the editors. If 
you change exported text, it is overwritten with the original text depending on the setting 
during import.

Line Breaks
If language-dependent text contains line breaks, the placeholders {CR} {LF} are entered. Do 
not change or delete the placeholders. The placeholders must be in the translated text at the 
identical positions. 

Note

To edit texts containing non-Latin fonts, use a software package that can save Unicode. Excel 
is not suitable for this purpose. Use Access instead or use the programming interface from 
WinCC to access picture text. Alternatively, use a version of Excel in the respective language.

Note

Information on the font type, font size, etc. of a language are entered in the 
"<Description>_Languages" file. Change the entries if necessary.

If a language was not created in the Text Library before export, add the language entry for 
this language in the "<Description>_Languages" file.

Note

The export files of the "Graphics Designer" editor also have information on the font, font size, 
etc. Change the entries in the desired languages if required.

NOTICE

Text Import Not Possible

Do not double-click in Windows Explorer to open the files. Otherwise the file will be loaded 
to Excel incorrectly. An import into WinCC is then no longer possible.         
When using Excel, open the file as described below.
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Procedure
1. Open Excel.

2. Select "File > Open".
The "Open" dialog is displayed.

3. Select the path where the export files will be saved.

4. Select type "Text files (*.txt)" from the "File type" list.

5. Select your export file and click "Open".
The file is correctly opened in Excel.

6. Translate the necessary text. Note the aforementioned information.

7. When translation is complete, use "File > Save As" and save the file in TXT format again.

Results
The TXT file contains the translated text. You can import the TXT file into the WinCC project 
using the Text Distributor. 

10.3.6 How to import language-dependent texts

General procedure
During export, the text distributor creates several files that all begin with the same description. 

Example:

In the "File prefix:" field, enter the description "Mixing_station" and in the "File format:" field 
enter "*.txt". The following files are created:

● Mixing_station_Languages.txt

● Mixing_station_DataManager.txt

● Mixing_station_AlarmLogging.txt

● Etc.

If you specify this description again in the "File prefix:" field during import, all available objects 
are listed in the left window. You can select from the present languages and objects.
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Note
Exportable and importable languages

The text distributor only makes available for export those languages that come from the same 
language area and use the same code page. 

For example, if you want to export Asian text, the associated system locale (operating system 
language) must be set in the system control of your operating system. The associated 
languages will only then be available. 

"English" is always available.

Procedure
1. Open the text distributor by double-clicking in WinCC Explorer.

2. Go to the "Import text" tab.

3. Navigate in the "Import files" area under "Path:" to the path where the files you want to 
import are saved.

4. Check or uncheck the desired editors from which you want to import text.

5. In the "File prefix:" field, enter the description with which the text was exported.
All export files were created with a name that begins with this description.
The objects that you can import are listed.
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6. In the "File format:" field, select the format of the texts.

7. Make the settings for the import.
If you only want to import text from individual pictures in the "Graphics Designer" editor:

– Start selecting the desired pictures in the "Graphics Designer" area using the "Selection" 
button.

– If you created one picture per file when exporting, activate "One file per picture".

If you want to import individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.

8. Determine how to handle already existing text.
If you want to replace already existing text entries:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite already existing text entries:

– Select the option "Retain existing texts" in the "Existing texts" area.

9. Start the import process by pressing "Import".

Results
The content of the files is written to the corresponding language columns in the text library or 
to the language-dependent objects in the Graphics Designer. 

Note

If a picture contains "unknown objects", the export or import of the picture is aborted 
immediately und "Unknown" is appears in the information window.

10.4 Text Management with the "Text Library" Editor

10.4.1 Text management with the "Text Library" editor

General Procedure
All text for your project is managed centrally in the Text Library except for text from the Graphics 
Designer. Each text entry is assigned a unique ID, by which the texts in WinCC are referenced.
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Links Between the WinCC Editors and the Text Library
The following WinCC editors store your texts in the Text Library:

● Alarm Logging:
All user defined texts (messages, points of error, etc.) and standard texts (default names 
for message classes, message status, etc.)

● Graphics Designer:
Only the text records from the respectively configured text lists

● User Administrator:
Authorizations

● User Archives (option):
All configured text (field names, etc.)

● Picture Tree Manager (optional):
All configured text

Languages in the Text Library
If you set another project language in an editor, such as the Alarm Logging editor, the 
corresponding language column is automatically created in the Text Library. 

Note

With languages not installed with WinCC, note that the standard texts are entered in the 
current WinCC GUI language because these other languages are not stored in WinCC. If the 
project language and the WinCC GUI language are different, you must also translate the 
standard texts.

Translating the text
You are provided with the following possibilities for translating text records in the Text Library:

● External translation of exported text records
The external translation of the text records involves 3 steps:

– Exporting the text records with the Text Distributor

– Translate the text records in an external program

– Importing the text records with the Text Distributor

If was are managing large amounts of text in the Text Library, you can also use the WinCC 
SmartTool "ConfigurationTool" for importing and exporting the text records for instance.

● Direct input of the translated text records in the respective language columns of the "Text 
Library" editor

Font Administration
You can set a custom font for each language created in the Text Library. This is particularly 
important if you are configuring in non-Latin fonts and to create, say, a Cyrillic font. The set 
font is applied at the referenced locations in WinCC. 
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10.4.2 How to export texts from the Text Library for the translation
You have the following options for translating text in the text library:

● Direct entry of the translated text in the corresponding language columns

● External translation
External translation is recommended for a large amount of text.

External translation
External translation is an easy option for creating multilingual projects.

To estimate the translation effort, show the amount of text using the "Tools > Statistics" menu 
command.

External translation has 3 steps:

1. Export the text

2. Translation

3. Import the translated text

Perform the export and import using the text distributor.

Note
Exportable and importable languages

The text distributor only makes available for export those languages that come from the same 
language area and use the same code page. 

For example, if you want to export Asian text, the associated system locale (operating system 
language) must be set in the system control of your operating system. The associated 
languages will only then be available. 

"English" is always available.

NOTICE

Invalid file format

If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI file.

If you want to edit the exported data with Excel, select the "*.txt" file format during export. 

Requirement
The "Text Library" editor opens.
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Procedure
1. Select the "Tools > Export..." menu command.

The text distributor opens.

2. Check or uncheck the editors from which you want to export text. If necessary, check or 
uncheck the individual objects of the editors.

3. Navigate in the "Export files" area under "Path:" to the path in which the export files are 
stored.

4. In the "File prefix:" field, enter a meaningful description.
All export files are created with a name that begins with this description.

5. In the "File format:" field, select the desired format "*.txt" or "*.csv".

6. Make the settings for the export.
If you want to create a separate export file for each picture:

– Select "One file per picture" in the "Graphics Designer" area.

If you want to export individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.
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7. Determine how to handle already existing text.
If you want to delete already existing export files:

– Select the option "Delete existing texts" in the "Existing texts" area.

If you want to replace text in the already existing export files:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite text in already existing export files:

– Select the option "Retain existing texts" in the "Existing texts" area.

8. Start the export process using the "Export" button.

Results
The text was exported.

You can find additional information on this procedure in the "Text export and text import with 
the Text Distributor (Page 1732)" section.

10.4.3 How to import texts from the Text Library for the translation

Overview
After you have translated the exported text, import the text to the WinCC project using the text 
distributor.

Note
Exportable and importable languages

The text distributor only makes available for export those languages that come from the same 
language area and use the same code page. 

For example, if you want to export Asian text, the associated system locale (operating system 
language) must be set in the system control of your operating system. The associated 
languages will only then be available. 

"English" is always available.

Requirement
The "Text Library" editor opens.
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Proceed as follows to start the import
1. Select the "Tools > Import..." menu command.

The text distributor opens.

2. Go to the "Import text" tab.

3. Navigate in the "Import files" area under "Path:" to the path where the files you want to 
import are saved.

4. Check or uncheck the desired editors from which you want to import text.

5. In the "File prefix:" field, enter the description with which the text was exported.
All export files were created with a name that begins with this description.
The objects that you can import are listed.

6. In the "File format:" field, select the format of the texts.

7. Make the settings for the import.
If you only want to import text from individual pictures in the "Graphics Designer" editor:

– Start selecting the desired pictures in the "Graphics Designer" area using the "Selection" 
button.

– If you created one picture per file when exporting, activate "One file per picture".

If you want to import individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.
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8. Determine how to handle already existing text.
If you want to replace already existing text entries:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite already existing text entries:

– Select the option "Retain existing texts" in the "Existing texts" area.

9. Start the export process by pressing "Import".

Results
The text was imported.

You can find additional information on this procedure in the " Text export and text import with 
the Text Distributor (Page 1732) " section.

10.4.4 Operator's overview of the Text Library

Operation of the Text Library
You will find the editor language entries created in the project listed in clear table form in the 
Text Library. Each language entry is provided with an ID which is its unique reference in the 
WinCC database. The status bar shows how much text there is, and the number of filtered 
texts.
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Operator's Overview
The following sections give you an overview of the most important options for operating the 
"Text Library" editor. Certain menu commands can also be run via the pop-up menus, or via 
the shortcut shown after the menu command concerned.

Note

Inputs or changes are automatically saved to the WinCC database when you exit from a field.

Translating text

Objective Solution

Export text from the Text Library for translation. "Tools > Export..."
Import translated text into the Text Library. "Tools > Import..."

Language administration

Objective Solution

Add a new language. "Language > Add/Remove..."
Delete a language. "Language > Add/Remove..."

Setting fonts

Objective Solution

Set font type for a language, e.g. for cyrillic 
characters.

"Language > Settings..."

Editing entries

Objective Solution

Copy highlighted cell.          
"Edit > Copy cell"

Copy highlighted row(s).          
"Edit > Copy row(s)" 

Insert copied area.         
A line is always inserted in the current cursor 
position.

         
"Edit > Paste"

Delete the content of the highlighted cell          
"Edit > Delete cell contents"

Delete highlighted row(s).          
"Edit > Delete row(s)" 
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Find and replace

Objective Solution

Search and replace text in the selected language 
in the highlighted area or in the entire Text Library.

         
"Edit > Find and Replace"

Filter Text Library

Objective Solution

Only display text from selected editors.          
"Tools > Filter"

Searching for Missing Text IDs

Objective Solution

Find a text ID used in the project but that does not 
exist in the Text Library.

"Tools > Missing text ID"

Text Library View

Objective Solution

Set table properties.          
"Tools > Options..."

Generating reports

Objective Solution

Print contents of the Text Library as a report.          
"File > Print Project Documentation"

Set parameters of a report, e.g. select the 
template.

"File" > "Project Documentation - Setup"

Check a report prior to printing. "File" > "View Project Documentation"
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10.4.5 Working with the Text Library

10.4.5.1 How to Add New Lines into the Text Library

Procedure
A new line is always added at the end of the Text Library.

1. Open the "Text Library" editor.

2. In order to add a term to the Text Library, enter the terms in the respective language columns 
in the last line.
The new text is automatically provided with a new, consecutive ID. 

10.4.5.2 How to Set the Language Font

Introduction
If your WinCC project includes configuration languages with non-Latin fonts, e.g. Cyrillic, Asian 
or Greek, you must set the font for the corresponding language in the "Text Library" editor.

Note

If the newly selected configuration language originates from another linguistic area as the 
previous one, you must also change the operating system language (system locale). 
Switching the operating system language is necessary so that the character set works with 
the proper code page.

Restart your operating system after changing the language.

Procedure
1. Open the "Text Library" editor.

2. Select the "Language > Settings" menu command.
The list of configuration languages is displayed.

3. Click in the list of configuration languages on the desired language.

4. Set the font, the font style and font size as well as other settings.

10.4.5.3 How to Create a New Language

Introduction
A language column must be created for every configuration language in the Text Library. 
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Automatic language definition
Language columns are also created automatically as soon as you change the project language 
in an editor, e.g. in the "Alarm Logging" editor.

Note

Languages must be defined in the Text Library in order for them to be available as runtime 
languages.

Requirement
The language must be installed.

If the new language originates from a linguistic area other than the the previous defined 
language, you must also change the operating system language (system locale). Switching 
the operating system language is necessary so that the character set works with the proper 
code page. Restart your operating system after changing the language. 

Procedure
1. Open the "Text Library" editor.

2. Select the menu command "Language > Add/Remove...".
The "Languages" dialog will appear. The "Languages" dialog contains the lists "All available 
languages" and "Text library languages".

3. Mark the desired language in the list "All available languages" and click on button ">".

4. In order to predefine the new language column with text records from a language that has 
already been defined, select the desired language from the selection field "Define text for 
new languages with:".

5. Close the dialog by clicking "OK".

Results
New columns are created with no entries for the selected languages.

Further procedures for languages with non-Latin character sets
If the language uses a non-Latin font, assign the appropriate font:

1. Select the "Language > Settings..." menu command.
The languages held in the Text Library are displayed for you in a dialog.

2. Mark the language for which you want to change the font.

3. Set the font and the font properties in the "Font" dialog.

4. Close the dialog by clicking "OK".
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10.4.5.4 How to Delete a Language

General procedure
If you no longer need one of the configuration languages in your project, delete the language 
column together with all its associated text entries by means of a centralized operation in the 
"Text Library" editor. 

Delete individual language entries directly in the objects concerned.

NOTICE

Permanently deleting a language

Before deleting a language make absolutely sure that the language is no longer needed in 
your project. When you delete a language, all the existing texts in that language are deleted 
irretrievably.

Procedure
1. Open the "Text Library" editor.

2. Select the menu command "Language > Add/Remove...".
The "Languages" dialog will appear. The "Languages" dialog contains the lists "All available 
languages" and "Text library languages".

3. Mark the desired language in the "Text library languages" list and click on button "<".

4. Close the "Languages" dialog by clicking "OK".

Results
The language columns for the selected languages are permanently deleted from the Text 
Library. 

10.4.5.5 How to copy cells or lines

General procedure
You can copy individual cells or lines in the editor to the clipboard or insert them from the 
clipboard in the "Text Library" editor.

Procedure - copy cell 
1. Open the "Text Library" editor.

2. Select the desired text cell.

3. Select the "Edit > Copy cell" menu command. As an alternative, you can click in the toolbar 
on the icon  or select the command from the pop-up menu.
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Results - copy cell
The text is put in the clipboard and is held there for external applications as well.

Procedure - copying lines 
1. Open the "Text Library" editor.

2. Select the desired lines.
Mark lines that are not next to one another by pressing the CTRL key and the left mouse 
button at the same time.

3. Select the "Edit > Copy line(s)" menu command. As an alternative, you can click in the 
toolbar on the icon  or select the command from the pop-up menu.

Results - copy lines
The marked lines are put in the clipboard and are held there for external applications as well.

Procedure - Insert cell or lines 
1. Mark the desired cell, into which you want to insert. If you are inserting lines, mark the first 

line to insert into in the "ID" column.

2. Select the "Edit > Paste" menu command. As an alternative, you can click in the toolbar on 
the icon  or select the command from the pop-up menu.

Results - Insert cell or lines
The copied cell or lines are inserted from the clipboard into the marked cell or the marked lines.

If you insert lines into the last line, new lines are created with unique IDs. 

10.4.5.6 How to delete cell contents

General Procedure
You can delete the content of individual cells in the "Text Library" editor.

Procedure 
1. Open the "Text Library" editor.

2. Select the desired cell.

3. Select the "Edit > Cell content" menu command. As an alternative, you can click in the 
toolbar on the icon  or select the command from the pop-up menu.

Setting Up Multilingual Projects
10.4 Text Management with the "Text Library" Editor

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1759



Results
The content of the marked cell is deleted. 

10.4.5.7 How to delete lines or areas

General Procedure
You can delete one or more lines in the "Text Library" editor.

Procedure 
1. Open the "Text Library" editor.

2. Mark the desired text line or the desired text lines.
Mark lines that are not next to one another by pressing the CTRL key and the left mouse 
button at the same time.

3. Select the "Edit > Delete line(s)" menu command. As an alternative, you can click in the 
toolbar on the icon  or select the command from the pop-up menu.

Results
The marked lines are deleted. 

10.4.5.8 How to find and replace text

General procedure
You can find text in the text library and replace the text if required. The function "Find and 
replace" can be executed specific to the respective language and only in marked areas if 
required. 

Procedure - finding text
1. Open the "Text Library" editor.

2. Mark the text lines in which you want to find the respective text as required.

3. Select the "Edit > Find and replace" menu command.
The "Find and replace" dialog will appear.

4. In the "Search for:" field, enter the search term.

5. In the "Search for:" field, select the following:

– Choose whether you want to search through the entire text library or only in the marked 
area.

– Choose between "All languages" or a configuration language, in which you want to 
search.
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6. In order to define other search options, click on the "+" button.
The search options are displayed.
Activate the desired search options.

7. Start the search by clicking on the "Find next" button.
The cursor marks the first cell with the search text. If the search text does not exist, a 
message is output.

8. Continue the search by clicking on the "Find next" button.
If no more text is found, a message is output.

Result - finding text
If the search text exists, it is marked in the first location that it is found in the text library.

Procedure - replacing text
1. Mark the text lines within which you want to replace the respective text as required.

2. Select the "Edit > Find and replace" menu command.
The "Find and replace" dialog will appear.

3. Change to the "Replace” tab.

4. In the ""Search for:" field enter the search term.

5. In the "Search for:" field enter the new term.

6. In order to search the entire text library, select "Find in" "Complete text library".

7. In order to search through a marked area, select "Find in" "Current selection".

8. To search through all languages, activate "All languages".

9. To search through certain languages, select the desired languages.

10.In order to define other search options, click on the "+" button.
The search options are displayed.
Activate the desired search options.

11.To replace all text positions at the same time, click on the "Replace all" button. Under "Tools/
Options", you can also specify that all found text should be replaced in one go.

12.Replace targeted text positions by clicking on the "Find next" button. If you want to replace 
the position that has been found, click on the "Replace" button. By clicking on the "Find 
next" button, the cursor jumps to the next instance of the term.
If the search text does not exist, a message is output.

Result - replacing text
The text that matches the search text is replaced in the text library. 
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10.4.5.9 How to filter the display in the "Text Library" editor

General procedure
Use the filter function to display text in the "Text Library" editor.

Texts of the "Graphics Designer" editor
To filter texts of the "Graphics Designer" editor for the first time, proceed as follows:

1. Open the "Text Library" editor.

2. Select the "Tools > Filter" menu command. Alternatively, click  on the toolbar.

3. To launch the view click the "Read" button in the "Graphics Designer" area.
For this procedure, you must close all pictures in the Graphics Designer editor. The 
procedure takes several seconds. The "Text Library" editor creates an internal file. 
As soon as this file has been created, you can additionally select the "Graphics Designer" 
editor in the filter settings. If you then make changes in the "Graphics Designer" editor, you 
must update the text references. To do so, click on the "Update" button in the "Graphics 
Designer" area. 

Procedure
1. Open the "Text Library" editor.

2. Select the "Tools > Filter" menu command. Alternatively, click  in the toolbar.
The "Filter Settings" dialog is displayed. All available editors are listed and activated.

3. Uncheck the the editors, the text from which you do not want to display.

4. Start output with "OK".

Results
The text from the selected editors is displayed. As long as the filter is active, the status bar 
shows the following:

● The  symbol

● The number of filtered texts

Deactivating a Filter
Deactivate the filter by clicking "Delete filter" in the "Filter Settings" dialog box.
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10.4.5.10 How to find inconsistencies in the configuration

General Procedure
Inconsistencies in your configuration can be determined using the filter function and the 
"Missing text" function. 

Text that is not used
The "Not system text" setting in the filter function indicates the following:

Text that exists in the Text Library but is not used in the configuration.

Not system text
The following text is also output with filter setting "Not system text":

● The text records are used e.g. in Global Script.

Procedure - Show not used text 
1. Select the "Tools > Filter" menu command. As an alternative, click this toolbar icon .

The "Filter" dialog opens. All of the editors that are available are listed.

2. Deactivate all editors. Leave only the "Not system text" entry activated.

3. Start the output with "OK".

Results
All text that is not allocated in the configuration is listed.

Missing text
You are presented with the IDs of the text records that are deleted in the Text Library but are 
used in the configuration with the "Missing text" function. The application point is also indicated. 

Procedure - "Find missing text ID" 
1. Select the "Tools > Missing Text ID" menu command.

The "Missing Text ID" dialog is displayed. The IDs of the text records that do not exist but 
are used in the configuration are listed.

2. In order to recreate the marked text entry, click on the "Create" button.
The respective Text ID is created again. 
Enter the respective text in the generated line.

Results
The Text ID is created again. 
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10.4.5.11 How to change the settings of the text library
You can adjust the display to your requirements in the "Text Library" editor.

Procedure
1. Open the "Text Library" editor.

2. Select the "Tools > Options..." menu command. Alternatively, click  on the toolbar.
The "Options" dialog box is opened.

3. Set the desired properties.
The settings become active immediately.

Results
The display is changed in the "Text Library" editor. 

10.5 Multilingual Pictures in the "Graphics Designer" Editor

10.5.1 Multilingual pictures in the "Graphics Designer" editor

Languages in the "Graphics Designer" editor
In the "Graphics Designer" editor, you can create text for graphic objects in all the languages 
that are installed in your operating system. 

The text that you configure in the "Graphics Designer" editor is saved with each picture. You 
can export the text, translate it outside WinCC and import it again. You can export and import 
the text records with the Text Distributor. If you have configured only a few texts for your 
pictures, you can enter the translated texts in each picture as required.

The object known as Text List is a special case. With the Text list object, you can select whether 
you want to store the configured text in the picture itself or in the Text Library. The text is stored 
in the picture as default. 

Note
Operating system support-Languages

Of the operating system languages, WinCC only supports the primary languages, i.e. English 
(USA) but not English (GB).

Language switching in the "Graphics Designer" editor
When you open the Graphics Designer, the selected runtime language is set as the 
configuration language. If you want to check a translation or enter text directly in another 

Setting Up Multilingual Projects
10.5 Multilingual Pictures in the "Graphics Designer" Editor

MDM - WinCC: Working with WinCC
1764 System Manual, 11/2008,  



language, change the configuration language in the "Graphics Designer" editor. This requires 
that the desired configuration language is installed on your operating system.

To change the project language, select the menu "View > Language...". A list box shows you 
all the languages available on your system (primary languages).

After changing, all configured texts are displayed in the selected language. If you have not yet 
configured a language, its texts are displayed with characters "???" instead of the text.

The current project language is displayed in the status bar of the "Graphics Designer" editor.

Note
Different linguistic regions

If the newly selected language originates from another linguistic area as the previous one, 
you must also change the operating system language (system locale). 

Start your operating system again afterwards.

Displaying the text for the controls
The text display for the Controls in the "Graphics Designer" editor is based on the configuration 
language set in the WinCC Explorer. 

Example:

The configuration e.g. in the "Graphics Designer" editor is in an Asian language. In order to 
display the text of an inserted control correctly, you must also select this Asian language in 
the WinCC Explorer.

Restrictions
National special characters from different linguistic regions (e.g. Western European and Asian) 
should not be used together in the same picture. When storing a picture under another 
operating system language, these characters can be changed based on the code page.
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Remedy
● Option 1:

Use different pictures for different linguistic regions. Edit and save the pictures with the 
appropriate language setting.

● Option 2:
Select an Asian operating system language for Latin fonts, too. By modifying the registry, 
automatic font association can be manipulated in such as way that Latin national special 
characters can also be displayed. Further information can be found on the Microsoft support 
pages.
Change the registry entry from [HKEY LOCAL MACHINE\System\CurrentControlSet
\Control\fontassoc\Associated CharSet] "ANSI(00)="yes" to "no".

NOTICE

Influence of the operating system

Always carry out the changes in the Registry carefully because this can otherwise lead 
to unwanted problems with the operating system! 

10.5.2 Language-dependent properties of picture objects

Language Input Options for Picture Objects
Depending on the picture object, you have different options for entering text:

● In the object itself, such as in the case of static text

● In the Configuration dialog, for example for the label on a button

● Object Properties dialog:
In the object properties, enter the major part of the text directly or in other dialogs such as 
tooltips, output text, text attributes.

Additional information on configuring graphic objects can be found in the WinCC information 
system in chapter "Creating process pictures".

Language-Dependent Object Properties
The objects of the "Graphics Designer" editor have different object properties with different 
language properties. With the exception of the window titles of the smart object, picture 
windows/application windows and certain WinCC controls, you can change the language of 
all object properties.

"Text" property
Objects: Static text, Text list, Button, Checkbox, Radio button, Multiple row text, List field, 
Combo-box
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"Font" property
Objects: Static text, I/O field, Bar, Group display, Text list, Multiple row text, List field, Combo-
box

"Tooltip" property
Objects: All objects except Picture Window and Application Window

Special Features: Tooltips can certainly be configured in multiple languages, but without any 
special setting for the font. When configuring tooltips in non-Latin fonts, you must set the 
corresponding font in your operating system's Control Panel in runtime:

● Windows XP:

– Select the "Extended" button under "Start > Settings > Control Panel > Display > Layout".

– Select the "Quickinfo" element from the list.

– Define the font.

● Windows Vista:

– Select the "Extended" button under "Start > Control Panel > Display > Appearance and 
themes > Change color scheme".

– Select the "Quickinfo" element from the list.

– Define the font.

Note that when you change the operating system language, the tooltips in all the other Windows 
applications are also changed. 

"Window Header" property
Objects: Picture Window, Application Window

ActiveX controls
Certain ActiveX Controls have text properties such as Column Name, Window Title or Axis 
Label for which the language cannot be changed. In WinCC these properties are stored in all 
languages installed with WinCC and are correctly displayed in runtime. If you are configuring 
in a language that was not installed via WinCC, these elements are displayed in runtime in the 
default runtime language (English). 

When configuring language changes to languages with non-Latin fonts, use a neutral language 
for these ActiveX Control properties, such as English without a special font. If you have 
configured a non-Latin font for these object properties, this font is used for each displayed 
language.
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Note
Alarm control with the configuration of Asian languages

To add an alarm control to a picture in an Asian Language, the Asian texts such as column 
names in the "Text Library" editor will be inserted when you open the "Alarm Logging" editor 
for the first time. 

10.5.3 How to export and import text from pictures

Introduction
You have the following options for translating text in the "Graphics Designer" editor:

● External translation
External translation is recommended for a large amount of text.

● Direct entry of the translated text in the "Graphics Designer" editor.
Set up the required configuration language.

This section describes the procedure for exporting and importing text with the text distributor.

Note
Text from Text Lists

Text records from text lists stored in the text library are saved in the 
"<Description>_GraphicsDesignerReferences" file. 

External translation 
External translation provides an easy and comfortable option for creating multilingual projects.

To estimate the translation effort, show the amount of text using the "Tools > Statistics" menu 
command.

External translation has 3 steps:

1. Export the text

2. Translating the text

3. Import the translated text

Perform the export and import using the text distributor.

Text Distributor gives you the following options:

● You can export all the pictures from a project or just individual pictures.

● You can create a separate file for each picture.

● You can export all target languages or create a separate file for each language. This is 
advantageous if you want to give the text to several translators. Make sure that no structural 
changes whatsoever are made in the files, e.g. to the order of columns).
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Requirement
All languages that you wish to translate into must be created in the "Text Library" editor. The 
text to be translated in all pictures and picture objects is configured in at least one language. 

Observe the following points during configuration:

● Text length
If you are configuring picture objects for multiple languages, be aware of the different text 
lengths in the various languages. French text is about 50% longer than the equivalent 
German text. Dimension your graphic objects accordingly.

● Adapt Border
For the "Static Text" object ,you can use the Object Properties dialog box to set the attribute 
"Properties > Miscellaneous > Adapt Border" to "Yes". The text border is then automatically 
adapted to the contents.

Procedure - exporting texts

Note
Exportable and importable languages

The text distributor only makes available for export those languages that come from the same 
language area and use the same code page. 

For example, if you want to export Asian text, the associated system locale (operating system 
language) must be set in the system control of your operating system. The associated 
languages will only then be available. 

"English" is always available.

NOTICE

Invalid file format

If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI file.

If you want to edit the exported data with Excel, select the "*.txt" file format during export. 
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1. Open the "Graphics Designer" editor.

2. Select the "Tools > Text Import & Export..." menu command.
The text distributor opens. Only the "Graphics Designer" entry is checked in the left selection 
window.

3. Navigate in the "Export files" area under "Path:" to the path in which the export files are 
stored.

4. In the "File prefix:" field, enter a meaningful description.
All export files are created with a name that begins with this description.

5. In the "File format:" field, select the desired format "*.txt" or "*.csv".
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6. Make the settings for the export.
If you only want to export text from individual pictures in the "Graphics Designer" editor:

– Start selecting the desired pictures in the "Graphics Designer" area using the "Selection" 
button.

If you want to create a separate export file for each picture:

– Select "One file per picture" in the "Graphics Designer" area.

If you want to export individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.

7. Determine how to handle already existing text.
If you want to delete already existing export files:

– Select the option "Delete existing texts" in the "Existing texts" area.

If you want to replace text in the already existing export files:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite text in already existing export files:

– Select the option "Retain existing texts" in the "Existing texts" area.

8. Start the export process using the "Export" button.

You can find additional information on this procedure in the "Text export and text import with 
the Text Distributor (Page 1732)" section.

Translating the text
The text is saved in CSV files after export. You can find additional information on translating 
text in the "How to translate the text records externally (Page 1743)" section.

Procedure - importing texts
1. Open the "Graphics Designer" editor.

2. Select the "Tools > Text Import & Export..." menu command.
The text distributor opens. Only the "Graphics Designer" entry is checked in the left selection 
window.
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3. Go to the "Import text" tab.

4. Navigate in the "Import files" area under "Path:" to the path where the files you want to 
import are saved.

5. Check or uncheck the desired editors from which you want to import text.

6. In the "File prefix:" field, enter the description with which the text was exported.
All export files were created with a name that begins with this description.
The objects that you can import are listed.

7. In the "File format:" field, select the format of the texts.

8. Make the settings for the import.
If you only want to import text from individual pictures in the "Graphics Designer" editor:

– Start selecting the desired pictures in the "Graphics Designer" area using the "Selection" 
button.

– If you created one picture per file when exporting, activate "One file per picture".

If you want to import individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.
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9. Determine how to handle already existing text.
If you want to replace already existing text entries:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite already existing text entries:

– Select the option "Retain existing texts" in the "Existing texts" area.

10.Start the import process by pressing "Import".

You can find additional information on this procedure in the "Text export and text import with 
the Text Distributor (Page 1732)" section.

After import, check your translations in Runtime or in the "Graphics Designer" editor. Reset 
the Runtime language accordingly.

10.5.4 How to configure picture objects for more languages in the "Graphics Designer" 
editor

Introduction
Texts that you configure in your pictures are not stored in the Text Library, but with the picture 
itself. 

This chapter provides the descriptions for procedures used to directly insert the translated text 
records in the "Graphcis Designer" editor. These procedures are mainly suitable for small 
amounts of text.

Observe the following while configuring:

Text length 
If you are configuring picture objects for multiple languages, be aware of the different text 
lengths in the various languages. A French text is about 50% longer than the equivalent 
German. Dimension your graphic objects accordingly.

Adapt Border
For the "Static text" object, use the Object Properties dialog box to set the attribute "Properties 
> Miscellaneous > Adapt border" to "Yes". The text border is then automatically adapted to the 
contents.

Certain graphic objects have elements for which you cannot set the font. For these elements 
select a neutral language such as English for the text entries.
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Note
Text list

The object known as Text List is a special case. If you are configuring a Text List for multiple 
languages, please refer to "Configuring a Text List in Multiple Languages". 

When configuring an I/O field, please note that WinCC only supports numbers for value input 
in the form of Arabic numerals (1, 2, 3, ...).

Basic procedure
In order to configure picture objects for multiple languages, proceed as follows:

1. First configure all pictures and picture objects in your preferred language.

2. Switch the configuration language in the "Graphics Designer" editor.

3. Enter the translated text directly on the objects in the respective language.
Untranslated texts are displayed as "???".

Alternative Procedures
In most cases you have several options for entering labels in picture objects, for example:

● In the "Object Properties" dialog, under "Font" in "Text" field.
The font can be set.

● In the "Configuration" dialog.
The font can be set.

The input window is still available which you can open from the Object Properties dialog:

● For inputting text (an alternative to direct input).
The font cannot be set.

● For inputting Tooltips.
The font cannot be set.

● For inputting text for the Text List.
The font cannot be set.

Note

In the case of non-Latin fonts the text in the input field is sometimes incorrectly displayed 
even though the font was correctly set, but the appearance in the picture is correct in 
runtime. You can remedy this by entering the text in another application (such as Word) 
and then using Copy & Paste to transfer it to the input field. If necessary, set the same 
input methods in the source and target applications to properly carry out copy & paste.

The font for Tooltips cannot be set in WinCC. Text in non-Latin fonts is correctly displayed 
in runtime if the corresponding font for tooltips is set in your operating system's Control 
Panel. When you are configuring a project for Latin and non-Latin fonts, after a change 
of language the font for tooltips must be correspondingly set in the operating system.

Additional information on configuring graphic objects can be found in the WinCC information 
system in chapter "Creating process pictures". 
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10.5.5 Configuring a Text List in Multiple Languages

Special characteristics of the text list
Select whether the configured text should be stored in the picture or in the text library for the 
text list object.

For exporting with the text distributor, the text of the text lists is entered in the following export 
files:

● When storing the text directly in the picture

– Only in the export file of the Graphics Designer or in the respective picture file

● When storing the text in the text library

– In the export file of the Graphics Designer or in the respective picture file

– In the export file "<Description>_GraphicsDesignerReferences"

Procedure
1. Open the "Graphics Designer" editor.

2. Open the "Object Properties" dialog box of the text list from the shortcut menu.

3. On the "Properties" tab activate the "Output/Input" group.

4. Double click on "Assignments".
The "Textlist assignments" dialog box appears.

5. Enter the "Range type", "Value range" and the desired text for every value/value range.

6. Confirm your entries with "OK".

7. If you want to save text in the picture:

– Export the text with the text distributor and translate the text externally.
For more information on the text distributor, refer to the section " How to export language-
dependent texts (Page 1736) ".

– As an alternative, change the configuration language in the "Graphics Designer" editor 
and enter the translated text respectively.

8. If the texts are to be stored in the text library and translated:

– On the "Properties" tab activate the "Miscellaneous" group.

– Then double-click "Text Reference".
The default setting "no" switches to "yes". This stores the text records in the text library.

– Export the text with the text distributor and translate the text externally.
For more information on the text distributor, refer to the section " Text export and text 
import for translations".

– As an alternative, start the "Text Library" editor and translate the text directly in the 
respective language columns.
You can find additional information on translating text in the text library in the section 
" Text management with the "Text Library" editor (Page 1747) ".
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You can find additional information on planning and configuring the text list in the WinCC 
information system in the section "Creating process pictures".

10.6 Multilingual Messages in the "Alarm Logging" Editor

10.6.1 Multilingual messages 

Languages in Alarm Logging
The following text records of the message system are stored centrally in the Text Library:

● Text records that you configure yourself

● Default text from WinCC
e.g. Default designations for message classes and message blocks

Creating the default text records in the "Text Library" editor
The languages are created in the "Text Library" editor. The default text records are entered 
directly in the respective language columns. Standard texts also include the WinCC system 
messages.

● Open the "Alarm Logging" editor in WinCC. Do not open the "Text Library" editor until after 
this.
If you proceed in this order, all standard texts in the installed WinCC languages will be 
already entered in the Text Library. 

Configuring with SIMATIC STEP7
When text for the message system is transferred from the SIMATIC Manager it too is stored 
in the Text Library.

Compile message texts
You have the following possibilities for translating text records:

● Externally, after an export with the Text Distributor

● In the "Text Library" editor

● In the "Alarm Logging" editor

Note

To the greatest possible extent, set the WinCC GUI and the the configuration language 
the same in the "Alarm Logging" editor to prevent non-uniform languages in the GUI in 
the "Text Library" editor. 
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Language-Dependent Message Objects
The "Alarm Logging" editor is where you can find user texts and standard texts, both of which 
are stored in the Text Library:

● User texts
You configure user texts yourself. User text records contain the following:

– Names of message classes

– Names of message blocks

– Names of message types

– Message Text

– Point of error

The user text records are entered immediately after the entry in the Text Library. 

● Standard texts
Standard text records are delivered in the languages installed with WinCC. Standard text 
records are entered in the respective language column in the Text Library with the initial 
call of the "Alarm Logging" editor or when creating the WinCC system messages. Standard 
texts are default occupations for names of message classes, message types and message 
block. Standard text records can be changed in the "Alarm Logging" editor or in the "Text 
Library" editor.

● Info texts
Info text records are also user text records. Help text is not stored in the Text Library and 
its language cannot be changed. Only use help texts if you are configuring just one language 
or enter the texts in a "neutral" language, e.g. English.
You enter Info text in a dedicated input window in the "Alarm Logging" editor.

Note

If you set up a language not installed with WinCC as the project language, the standard 
texts are not entered in the selected project language, but in the current interface 
language. You must therefore take special care that these texts are translated. 

10.6.2 How to export and import message text records for the translation

General procedure
You have the following options for translating text in the "Alarm Logging" editor:

● External translation
External translation is recommended for a large amount of text.

● Direct entry of the translated text into the corresponding language columns of the "Text 
Library" editor

● Direct entry of the translated text in the "Alarm Logging" editor.
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External translation
External translation provides an easy and comfortable option for creating multilingual projects.

To estimate the translation effort, show the amount of text using the "Tools > Statistics" menu 
command.

External translation has 3 steps:

1. Export the text

2. Translating the text

3. Import the translated text

Perform the export and import using the Text Distributor.

Procedure - Exporting texts

Note
Exportable and importable languages

The Text Distributor only makes available for export those languages that come from the 
same language area and use the same codepage. 

For example, if you want to export Asian text, the associated system locale (operating system 
language) must be set in the system control of your operating system. The associated 
languages will only then be available. 

"English" is always available.

NOTICE

Invalid file format

If you are using "*.csv" as the export format, Excel converts the Unicode file into an ANSI file.

If you want to edit the exported data with Excel, select the "*.txt" file format during export. 
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1. Open the Text Distributor in WinCC Explorer.

2. Check or uncheck the editors from which you want to export text. If necessary, check or 
uncheck the individual objects of the editors.

3. Navigate in the "Export files" area under "Path:" to the path in which the export files are 
stored.

4. In the "File prefix:" field, enter a meaningful description.
All export files are created with a name that begins with this description.

5. In the "File format:" field, select the desired format.

6. In the "File format:" field, select the desired format "*.txt" or "*.csv".

7. Make the settings for the export.
If you want to export individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.
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8. Determine how to handle already existing text.
If you want to delete already existing export files:

– Select the option "Delete existing texts" in the "Existing texts" area.

If you want to replace text in the already existing export files:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite text in already existing export files:

– Select the option "Retain existing texts" in the "Existing texts" area.

9. Start the export process using the "Export" button.

Further information on this procedure can be found in the " Text export and text import with 
the Text Distributor (Page 1732) " chapter.

Translating the text
The text is saved in CSV files after export. More information on translating text can be found 
in the " How to translate the text records externally (Page 1743) " chapter.

Procedure - Importing texts
1. Open the Text Distributor in WinCC Explorer.

The Text Distributor opens. 

2. Go to the "Import text" tab.
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3. Navigate to the path where the imported files are saved using "Path" in the "Import files" 
area.

4. Check or uncheck the desired editors from which you want to import text.

5. In the "File prefix:" field, enter the description with which the text was exported.
All export files were created with a name that begins with this description.
The objects that you can import are listed.

6. In the "File format:" field, select the format of the texts.

7. Make the settings for the import.
If you want to import individual languages:

– Start selecting the desired languages in the "Languages" area using the "Selection" 
button.

8. Determine how to handle already existing text.
If you want to replace already existing text entries:

– Select the option "Replace existing texts" in the "Existing texts" area.

If you do not want to overwrite already existing text entries:

– Select the option "Retain existing texts" in the "Existing texts" area.

9. Start the import process by pressing "Import".

Further information on this procedure can be found in the " Text export and text import with 
the Text Distributor (Page 1732) " chapter.

Checking the Translation
After the import, check the translation of the text in Runtime or in the "Alarm Logging" editor. 
Reset the Runtime language accordingly.

10.6.3 How to translate the message text records in the "Text Library" editor

General Procedure
You have the following possibilities for translating the text records of the "Alarm Logging" editor:

● External translation
With a large number of text records, the external translation is recommended.

● Direct input of the translated text records in the respective language columns of the "Text 
Library" editor

● Direct entry of the translated text records in the "Alarm Logging" editor

Enter translated text records in the "Text Library" editor
The text records from the "Alarm Logging" editor are stored in the Text Library. You can enter 
the translated text records directly in the "Text Library" editor in the respective language 
columns.
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Note

To the greatest possible extent, set the WinCC GUI and the the configuration language the 
same in the "Alarm Logging" editor to prevent non-uniform languages in the GUI in the "Text 
Library" editor. 

Note
Configuration language not a language installed with WinCC

If you set up a language not installed with WinCC as the project language, the standard texts 
are not entered in the selected project language, but in the current interface language. You 
must therefore take special care that these texts are translated. 

Procedure
1. Open the "Text Library" editor.

2. Select the "Tools > Filter" menu command. As an alternative, click this toolbar icon .
The "Filter" dialog opens. All of the editors that are available are listed and activated.

3. Deactivate all editors except for "Alarm Logging".

4. Start the output with "OK".
Only the text records from the "Alarm Logging" editor are shown.

5. Change the font centrally for each language where required.

6. Enter the translated text records in the appropriate language columns.

10.6.4 How to translate the message text records in the "Alarm Logging" editor

General Procedure
You have the following possibilities for translating the text records of the "Alarm Logging" editor:

● External translation
With a large number of text records, the external translation is recommended.

● Direct input of the translated text records in the respective language columns of the "Text 
Library" editor

● Direct entry of the translated text records in the "Alarm Logging" editor

Entering the translated text records in the "Alarm Logging" editor
When you open the "Alarm Logging" editor, the selected runtime language is set as the project 
language. If you want to check a translation or enter text directly in another language, change 
the configuration language in the "Alarm Logging" editor.

The desired project language must be installed in your operating system.
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To change the project language, select the menu "View > Language". A list box shows you all 
the languages available on your system (primary languages).

After changing, all configured texts are displayed in the selected language. The text fields will 
be blank or displayed with the user interface language that has been set if you have still not 
configured the language.

The set project language is displayed in the status bar of the "Alarm Logging" editor.

Alternative Procedures
You can input language-dependent Alarm Logging texts in various dialogs.

User texts
You can configure user texts (message texts, names for message classes, message types, 
message blocks, etc.) individually for each message:

● Message texts: Directly in the "Message text" field in table view in the Alarm Logging editor

● In the "Object properties" dialog box for the message concerned (pop-up menu > 
"Properties") on the Text tab in the "Message text" or "Point of error" field

● In the "Text Library" editor

● In the "Object properties" dialog box for the message class/message type/message block

Standard texts
Standard texts are names for message classes, message types and message blocks, and the 
system messages provided by WinCC in the languages installed with WinCC. These text 
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records are default allocations of WinCC for the most popular message blocks, types and 
classes. You can change these text records.

Input standard texts as follows:

● "Object Properties" dialog:
Open the "Object properties" dialog by double clicking on the appropriate symbol. Only 
input translations directly if the number of texts is low.

● In the "Text Library" editor:
Input translations in the "Text Library" editor when configuring with non-Latin fonts, since 
you can set the font from here by means of a centralized operation. In the case of large 
numbers of texts it is advisable use the Text Library export and import function and translate 
the texts externally.

Info texts
Help text is also regarded as user-specific. Help text is not stored in the Text Library and cannot 
be configured for multiple languages. Enter the info text in the "Info text" input field, which you 
open by double clicking on the "Info text" field in table view.

Basic procedure
1. Open the "Alarm Logging" editor.

2. Use menu command "View > Language..." to define the language that you prefer as the 
configuration language.

3. Configure all the message system texts in your preferred language. Additional information 
on configuring messages can be found in the WinCC information system in chapter 
"Message system structure".
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4. Switch the configuration language with menu command "View > Language...".

5. Enter the text in the new language. Remember also to translate the standard texts.

Note

If you are configuring messages for multiple languages, be aware of the different text 
lengths in the various languages. A French text is about 50% longer than the equivalent 
German. Dimension the length of your messages accordingly.

Multiple Use of Message Texts
When a text is input, whether the text already exists in the Text Library is checked. If the text 
is already there, the "Text Input Mode" dialog opens automatically.

Here, you can define whether the identical text is only stored once in the Text Library.

● "Changes to the selected text apply to all identical text"
At other locations in the Alarm Logging, a cross-reference is made to the same Text-ID. If 
you change a multiple use text, all instances of that text are changed at the same time.

● "Change applies only to the selected text"
The text is stored in the Text Library with a new text ID. This is advantageous if you must 
change this precise text again later on.

Note

When configuring in multiple languages, be aware that in the text input mode called 
"Change applies only to the selected text" the modified text is reentered in the Text Library. 
Existing translations are not taken into account. 
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10.7 Reports for Multilingual Projects

10.7.1 Reports for Multilingual Projects

Principle
There are two types of report in WinCC: 

● Project documentation
The project documentation contains reports that are output during the configuration. These 
reports contain overviews of the configured data. You can output the project documentation 
in all runtime languages. 
In the project documentation you document all multilingual texts you configured.

● Logs that are output in runtime, such as regular printouts of measurement data. These 
reports can be output in the respectively defined set runtime language.

10.7.2 Layout and layout file

Print Job and Layout
A print job just be stored for every report or every log in WinCC. Every print job is connected 
with a layout. There are language-neutral and language-dependent layouts.

Layout and layout file
A language-neutral layout contains one layout file. Stored in language-neutral layout files \
\<Name of computer>\Project name\PRT".

A language-dependent layout contains several language-dependent layout files.

Layout files
The designation of language-dependent layout files contains a language ID. The language-
specific layout files are stored in language-specific folders in folder \\<Name of computer>
\Project name\PRT". The following table shows the language IDs and language folder with 
languages that can be installed with WinCC.

Language Language ID in file names Folder

German DEU PRT\DEU
English ENU PRT\ENU
French FRA PRT\FRA
Italian ITA PRT\ITA
Spanish ESP PRT\ESP
Chinese (simplified) CHS PRT\CHS
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Language Language ID in file names Folder

Chinese (Traditional) CHT PRT\CHT
Korean KOR PRT\KOR
Japanese JPN PRT\JPN
Language-neutral  PRT\

If you add other runtime languages in the "Layouts" pop-up menu, the language-specific folder 
is created in the PRT folder in the project folder.

System print jobs
WinCC provides various system print jobs. The respective layout files are available in all 
languages that can be installed with WinCC.

Do not delete these system print jobs and the respective layout files and do not rename them.

For the page layouts installed with WinCC, the layout files for the languages installed with 
WinCC are installed in language-specific folders in the project folder.

Example:

In the European WinCC version, the following layout files belong to the print job 
"Documentation_Alarm_logging":

Language Layout file

German @algcs_DEU.rpl
English @algcs_ENU.rpl
French @algcs_FRA.rpl
Italian @algcs_ITA.rpl
Spanish @algcs_ESP.rpl

In the Asian WinCC version, the following layout files belong to the print job 
"Documentation_Alarm_logging":

Language Layout file

English @algcs_ENU.rpl
Chinese (simplified) @algcs_CHS.rpl
Chinese (Traditional) @algcs_CHT.rpl
Korean @algcs_KOR.rpl
Japanese @algcs_JPN.rpl

Language-dependent layout files
The layout files are only available if you have completed the following:

● You have clicked on the "Report Designer" entry.

More information on creating and configuring logs and log layouts can be found in the WinCC 
Information System in chapter "Documentation of configuration and runtime data". 
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10.7.3 How to change or create layouts

Introduction
A layout is assigned to each print job. You edit page layouts in the page layout editor. 

The layout files of the layout are saved in a folder structure in the WinCC Explorer. 

When printing print jobs with language-dependent layouts, WinCC uses the layout file with the 
language code of the current WinCC Runtime language. 

Adding Additional Languages to System Print Jobs
If you want to print system print jobs in languages other than that installed with WinCC, you 
must add the layout file of the new language to the system layout.
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Print Jobs with Your Own Layout
You can create print jobs with your own page layouts. The easiest thing to do is copy an existing 
layout and change it based on your needs.

If you want to create print jobs with a language-neutral layout, you must create a layout file 
and save it in the \\<Computer name>\Project name\PRT folder.

If you want to create print jobs with a language-dependent layout, you must create a layout 
file for each Runtime language. You must save the language-dependent layout file in the 
correct folder.

Procedure - Creating a language-neutral layout file
1. Click on the "Report Designer" entry.

The "Layouts" and "Print Jobs" sub-entries are displayed in the data window. 

2. Click on the "Layouts" entry.
The "Language-neutral" entry and one or more language-specific folders are located under 
the "Layouts" entry.

3. Click on the "Language-neutral" entry and open the pop-up menu.

4. Select the "Open page layout editor" command in pop-up menu.

5. Create the language-neutral layout file and use "Save as" to save it in the \\<Computer 
name>\Project name\PRT" folder.

Procedure - Adding a new Runtime language for a layout

Note
Display Dependent on System Locale

You can only add the language-specific folders that use the same codepage. If you need to 
edit layout files in languages that need another codepage, you must set up the associated 
system locale (operating system language) in the system control of your operating system.

1. Click on the "Report Designer" entry.
The "Layouts" and "Print Jobs" sub-entries are displayed in the data window.

2. Select the "Layouts" entry and select the "Add language..." command in the pop-up menu.

3. Select the desired Runtime language.

Results
The folder of the new Runtime language is saved in the "\\<Computer name>\Project name
\PRT" folder. The folder of the new Runtime language is displayed in WinCC Explorer.

Procedure - Creating a language-dependent layout file

Setting Up Multilingual Projects
10.7 Reports for Multilingual Projects

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1789



Note

As soon as there is a language-dependent layout file for a layout, the layout is language-
neutral. This does not depend on whether language-dependent layout files also exist. 

If necessary, delete the language-neutral layout file is in the "\\<Computer name>\Project 
name\PRT" folder.

Language-dependent layout files are saved in a language-specific folder in the "PRT" folder 
of the project folder.

1. Click on the "Report Designer" entry.
The "Layouts" and "Print Jobs" sub-entries are displayed in the data window. 

2. Double-click on the "Layouts" entry.
The "Language-neutral" entry and one or more language-specific folders are located under 
the "Layouts" entry.

3. Open the folder of the desired language.

4. Create a new page layout or change an existing layout.

5. When saving the layout file, specify the language code, e.g. "DEU" or "ENU".

6. Save the language-dependent layout file in the corresponding language folder.

7. Also create the layout file for the rest of the Runtime languages.

.

10.7.4 How to change or create print jobs 

Introduction
There must be a layout for every print job.

Procedure - Creating a print job
1. Click on "Print jobs" in the navigation window.

The available print jobs are listed in the data window.

2. Create a new page job or change an existing print job.
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3. From the "Layout:" selection field select the desired format.

4. Save the print job with "OK".

Results
The print job has been created. 

If a language-neutral layout or a language-dependent layout that is not available in all Runtime 

languages is used in the print job, this is displayed by the  symbol.
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Identifying the Layout File
In the "Layout:" selection field the layouts are indicated by a symbol.

Icon Description

Layout is language-dependent.          
Layout files exist in all runtime languages. No language-neutral layout file exists.
Layout is language-dependent.          
Layout files do not exist in all runtime languages. You can use the layout. If you change 
to a runtime language, for which there is no layout file available, the English layout file 
is used.
The layout is language-neutral. In runtime, the language-neutral layout is always active. 
This does not depend on whether language-specific layout files exist for the selected 
layout.

10.7.5 Creating Multilingual Project Documentation

Introduction
You use project documentation in WinCC to document your configured data. You can create 
project documentation with data from the following editors:

● WinCC Explorer

● Graphics Designer

● Alarm Logging

● Tag Logging

● Text library

● User Administrator

Rules for Multilingual Project Documentation
The following rules apply to reports involving project documentation:

● Headings and table names, properties of objects are printed in the current runtime language.
If the current runtime language is not a language installed with WinCC, the text is output in 
English.

● Configured texts are output in the runtime language that you have set up in the computer 
properties.
If configured texts do not exist in English, the string "???" is output.
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Procedure
1. Exit runtime.

2. As the runtime language, set the language to the language in which you want to create the 
project documentation.
All the languages you have created in the Text Library are available for use as runtime 
languages.

3. Check the project documentation by selecting the menu command "View Project 
Documentation" in the respective editor.

4. Output the project documentation by selecting the menu command "Print Project 
Documentation".

More information on creating and configuring logs and log layouts can be found in the WinCC 
Information System in chapter "Documentation of configuration and runtime data".

10.7.6 Multilingual logs in runtime

Introduction
In runtime you can output reports for process values, for instance regular measurement data 
reports, curves or message reports. If your project runs in runtime in multiple languages, logs 
in runtime will always be output in the current runtime language. 

If a log is output in runtime, the layout file of the current runtime language is used.

Note
Layout file does not exist in current runtime language

If the layout file does not exist in the current runtime language, the English layout file is used.

Output of message sequence reports
Message sequence reports are always output in runtime in the language in which Runtime 
was started. This also applies if e.g. the language was changed using the Set Language 
function.

More information on creating and configuring logs and log layouts can be found in the WinCC 
Information System in chapter "Documentation of configuration and runtime data".

10.8 Displaying Regional Date and Time

Principle
Regional date and time displays are language-dependent. In some countries the European 
format is displayed (Day.Month.Year), and the American format (Year/Month/Day) is used in 
others. You must also pay attention to this display format for multilingual objects.
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Date and time displays are configured in Alarm Logging and in Graphics Designer.          
 

Note

If the central date and time format according to ISO 8601 is entered in the "Computer 
Properties" dialog, it will have an effect on the configurable time formats and on the display 
of time during Runtime. The date display is unambiguously set by the ISO 8601 format. You 
may find additional information on ISO 8601 format under "Working with Projects" > "Setting 
Time in WinCC". 

Alarm Logging
In Alarm Logging you can select the format of the date and time in the system blocks "Date" 
and "Time", choosing between the European and American formats. The configured format 
applies to the whole project and is not affected by changing the runtime language.

If you insert an Alarm Control in Graphics Designer, it accepts the date and time setting that 
you configured in Alarm Logging.

Graphics Designer
The following objects, which you can configure in Graphics Designer, display the date and 
time: 

● WinCC Alarm Control: The format of date and time is configured in Alarm Logging. The 
configured setting applies to the entire project.

● WinCC TrendControl, WinCC TableControl: The format of date and time may be configured 
directly under Control Properties. The settings apply to the current picture.

● D/A Clock: The WinCC ActiveX Control Digital/Analog Clock accepts the local computer-
specific settings from your operating system settings. They cannot be changed in the 
Control.

Note

When configuring a Chinese project, you must set China (Taiwan) as the input locale and 
then adjust the date and time display format in the Control Panel of your operating system.

Report Designer:
In the Report Designer you can adapt the format of the date and time by setting the 
corresponding parameters for the "Format" attribute in the "Object Properties" dialog of the 
"Date/Time" system object in the "Miscellaneous" group. You can get an overview of the 
possible parameters and settings from the Direct Help on this attribute.
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Display in Runtime
In runtime, the date and time displays are not changed in the event of a language change. 
Therefore always configure for a primary language.

For further information, please refer to the online help for the Graphics Designer, Alarm Logging 
and the Report Designer.

10.9 Languages in Runtime

10.9.1 Languages in Runtime

Runtime language
You set the language in which your project is displayed in Runtime centrally, in the computer 
properties in WinCC Explorer.

You can select as the runtime language any language for which a language column has been 
created in the Text Library.

Runtime Default Language
In the computer properties in WinCC Explorer, a runtime default language may be set which 
applies to graphics objects.          
If there is no translation available for a certain text, it is displayed in the set runtime default 
language. If the text is not available in this language "???" is displayed. 

Displaying Non-Translated Texts in Runtime
Non-translated texts of graphics objects are displayed in runtime as "???" as long as no 
translated text exists in the runtime default language either.  

If message system texts are not translated, nothing is displayed. By this means you can test 
your project in runtime to check whether all texts are present. 

If you have configured a change to a language that has not been created in the Text Library, 
the previously set language continues to be displayed.

Changing languages in Runtime
When you have configured a project in multiple languages, configure an operating element 
which will allow the operator to change the language in runtime. WinCC offers you several 
preconfigured operating elements that you can use in your project. You can of course also use 
dedicated picture objects for a language change, e.g. buttons.

If the new language originates from another linguistic area as the previous one, you must also 
change the operating system language (system locale). This is necessary so that the character 
set works with the proper code page. Restart your operating system after changing the 
language. 
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10.9.2 How to Set the Runtime Computer Starting Configuration

Requirements
You can only select languages as runtime languages if they have been created in the Text 
Library.

Procedure
1. In WinCC Explorer, select "Computer" with the right mouse button and select "Properties" 

in the pop-up menu.

2. Select the required computer from the list (for multi-user projects only) and click the 
"Properties" button.

3. In the "Computer Properties" dialog, select the Parameters tab.

4. In the "Language Setting at Runtime" field, select the language in which to start the project 
in runtime.

 In the "Default Language at Runtime" field, select the language in which to display texts 
from graphics objects instead. The texts will be displayed in this Runtime default language, 
if translations into the language set in "Language Setting at Runtime" do not exist. 

5. Confirm your settings with "OK".

Results
In runtime, the project will be started in the set language. Non-translated texts of graphics 
objects are displayed as "???" as long as no translated text exists in the runtime default 
language either. 

If message system texts are not translated, nothing is displayed.
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10.9.3 Configuring Language Changes

Introduction
You can configure language changes within operating elements yourself, or use preconfigured 
WinCC objects for changing languages.

The following preconfigured WinCC objects are available:

● Buttons for each WinCC language for operating using mouse or finger (touch screen 
operation).

● Hot key symbols for each WinCC language for operating with the keyboard.

● Radio box lists for changing between two or all available WinCC languages.

Drag & drop WinCC objects for changing languages into your picture from the WinCC library 
("Operation" group, "Language Change" subgroup).

If you are configuring a language change in a picture object and decide not to use any of the 
preconfigured WinCC objects, the following picture objects are recommended:

● A button for changing between two languages.         
 If you use a button, also configure a button with which the operator can switch the language 
back again. By using a toggle function, you can change to a language and back with just 
one button.

● An input/output field in which the operator inputs the language directly. This solution 
requires script programming.

● Radio buttons or check boxes for selecting a language. This solution requires script 
programming.

The following section contains an example to show you how you can configure a language 
change on a single button.
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Requirement
Always configure a change to a language for which texts have already been configured. If 
these texts are not available during Runtime, graphics objects will display "???" after the 
language change as long as no translated text is available in the runtime default language 
either. If message system texts are not translated, nothing is displayed.

Language changes must always have a target language that has been created in the Text 
Library. If the target language is not present, the language change has no effect and the 
previously set language continues to be displayed.

Procedure
1. In the Graphics Designer open the picture in which you wish to configure a language change.

2. Configure a button.

3. Double-click the "Language Change" Wizard in the Dynamic Wizard window.         
The Dynamic Wizard for changing languages appears.

4. Click "Continue" to move on from the opening screen.

5. In the "Select Trigger" dialog, select a trigger for the language change, e.g. Mouse Action.

6. In the "Set Options" dialog, select the language to which you want to change.         
The initial language is always the current runtime language or the current project language 
respectively.

7. Click "Continue" to view your chosen options, and click "Finish" to finish configuring.

Results
If operator clicks the button in runtime, the language is changed from the current runtime 
language to the language you specified.

10.10 Example of Configuration

10.10.1 Example of Configuration

Overview
The following example shows you how to create a small multilingual project in a few steps:

● You configure a graphic object in multiple languages.

● You configure a language change.

● You run the project and change the language in runtime.
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See also
Example: How to translate the text records in different linguistic regions (Page 1807)

10.10.2 Example: How to Configure a Multilingual Graphic Object

Introduction
In the following section you configure a button for the "End Runtime" function with labels in 
English, French and Italian.

Procedure
1. Open the Graphics Designer.

2. Create a new picture for the example, e.g. "language.pdl". In a project you position the 
language change as a rule on the starting page.

3. Select the menu command "View > Language", and select from the list of available 
languages "English (USA)".

4. Create a button from the group of Windows objects in the Object Palette.

5. After creating this, the Configuration dialog is opened. In the Configuration dialog, input the 
button label in English (e.g. "End Runtime").

6. Input a font such as Arial Black and click OK to close the dialogs.

7. Use the appropriate Dynamic Wizard to load the button with the "End Runtime" function.
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8. Select the menu command "View > Language", and select from the list of available 
languages "French (France)". After a language change "???" is displayed on the button 
instead of the English text, since the French text does not yet exist.

9. Open the "Object Properties" dialog box of the button using the pop-up menu command 
"Properties".

10.On the Properties tab, double-click the "Text" field in the "Font" group and enter the text in 
French.

11.For the French display select another font, e.g. Courier New Bold. Make sure that you 
always configure all entries for a language in the same font.

12.Now change the language to Italian and configure the Italian text ("Finire Runtime") in the 
same way.

13.Save your picture.

Results
When you change the project language in the Graphics Designer between English, French 
and Italian, the text is displayed on the button in the current project language in each case.

10.10.3 Example: How to Configure Language Changes

Introduction
Below you configure a language change with which you can change between English, French 
and Italian in runtime.
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Requirement
You must have configured the button as described under "Example": "Configuring a 
Multilingual Graphic Object". 

Procedure

Note

In the following example you configure a Language change by means of an object from the 
WinCC library. These objects are already preconfigured and ready for use. If you wish to 
create a dedicated operating element for changing languages, select the "Language Change" 
Dynamic Wizard.

1. Open the picture "languages.pdl".

2. Click the  button to open the WinCC library or select the menu command "View" > 
"Library".

3. In the Global Library, open the folder "Operation" > "Language Change".
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4. Select the object "Change all Languages" and drag & drop it into your picture. The WinCC 
Library object automatically changes the picture's label to the current project language, in 
this case Italian.

5. Save your picture.

10.10.4 Example: How to Change Language in Runtime

Introduction 
In the following section you execute your example project in runtime.

Requirement
You have configured the button and the language change as described under "Example": 
"Configuring Multilingual Graphic Object" and "Example": "Configuring Language Change".

Procedure

Note

Before starting runtime, you must go to the Text Library and create the languages to be used. 
The texts of the pictures are not stored in the Text Library. A language must, however, be 
created in the Text Library so that it may be selected as runtime language.
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1. Open the WinCC Text Library.

2. Check whether the language you want to use as runtime language (English, Italian, or 
French) is created. Your project starts in the runtime language.

3. If the runtime language is missing, create this language by using the menu command 
"Tools" > "Add Language". In the following example, Italian will be used as the runtime 
language.

4. Close the Text Library.

5. In WinCC Explorer, mark the computer and use the pop-up menu command "Properties" 
to open the "Object Properties" dialog.

6. Click the Parameter tab.
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7. Select the runtime language in the "Language Setting at Runtime" field, such as "Italian" 
and select as runtime default language under "Default Language at Runtime", such as 
"English". Close the dialog by clicking OK.

8. Open the picture "language.pdl" in the Graphics Designer.
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9. Click  to start the picture in runtime. The picture starts in the set runtime language, which 
is Italian.

10.Change the language to one of the configured languages (English or French):
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11.For demonstration purposes change to a language that is in the Text Library but in which 
you have not yet configured any text for the button, e.g. German.

12.For demonstration purposes change the language back to English, and then to a language 
that is neither configured nor created in the Text Library, e.g. Spanish. As the language is 
not available in the Text Library, the language is not changed. The previously set language, 
in this case English, is kept:
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10.10.5 Example: How to translate the text records in different linguistic regions

General Procedure
If you are translating to a language that originates from a different linguistic region, the 
respective system locale must be defined in the control panel of your operating system. 

When translating the text records in other linguistic regions, you must therefore consider the 
settings for your computer.

The following example shows how you translate from English to Chinese (Traditional). 

The example assumes that the text exists in English.

Procedure
1. Export the English text records with the Text Distributor. In the "File prefix:" field, enter 

"ENU_CHT".

2. Set the system locale for Chinese in the control panel of your computer.
The Input Method Editor (IME) is available in Windows for configuring Asian text.

3. Restart the operating system.

4. Open file "ENU_CHT_Languages.csv".

5. Expand the file by the language Chinese. Enter 1028 in the column "Language ID". In 
column "FontName", enter "Ming Lui". Change the other parameters for the font if 
necessary.

6. Save file "ENU_CHT_Languages.csv".

7. Open one of the files with the exported text records of the Text Library.

– Create another column for Chinese in the file.

– Write the text "Chinese" in every object block in line "ID" in the new column.

– Enter the correct translation for every Text ID in the Chinese column.

– Save the file as a CSV file again.

– Repeat these steps for all files with exported text records of the Text Library.

8. Open file "ENU_CHT_GraphicsDesigner.csv" or one of the picture files.
For every line that begins with "Object":

– Enter the following text records in the next free cells: "Chinese", "Chinese FontName", 
"Chinese FontSize", "Chinese FontBold", "Chinese FontItalic", "ChineseFontUnderline".

– Change the entries in column "Chinese FontName" to "Ming Lui" and the other properties 
as desired.

– Enter the translated text in column "Chinese".

– Save the file.

– If you have individual picture files, repeat these steps for every file.

9. Start WinCC.

10.Start the Text Distributor.
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11.Change to the "Import text" tab.

12.Select Chinese (Traditional) under "Select language".

13.Start the import with the "Import text" button.

Results
The Chinese text records are available in the WinCC project. The text records can be displayed 
in the configuration and in runtime. 

Setting Up Multilingual Projects
10.10 Example of Configuration

MDM - WinCC: Working with WinCC
1808 System Manual, 11/2008,  



Structure of the User Administration 11
11 Resources

11.1 "User Adminstrator" Editor

Contents
The User Administrator editor is used to set up and maintain a user administration system. In 
the User Administrator it is possible to set up and maintain access authorizations for WinCC 
functions and WinCC users. Further functions, such as the time-limited login or login by means 
of key-operated switch or chipcard, can be assigned to a user in the User Administrator.

This section shows you how to do the following:

● add and maintain WinCC users

● add WinCC access rights in the authorizations and how to assign these access rights to 
the users

● set up an automatic logout for a user 

● use the "Tag Login" function to log in a user using a tag value, e.g. by means of a key-
operated switch  

● configure the system so that users must log in by means of a chipcard.

● use SIMATIC Logon jointly with WinCC

11.2 Setting up user administration

Functional Principle
The User Administrator editor is used to set up a user administration system. The editor is 
used to assign and check authorizations which allow users to access the individual editors of 
the configuration system and to access the functions in Runtime. Access rights to WinCC 
functions known as authorizations are assigned in the User Administrator. These 
authorizations can be assigned to individual users or to user groups. Authorizations can also 
be assigned in Runtime.

When a user logs on to the system, the User Administrator checks whether the user is 
registered. If the user is not registered, he has no authorizations whatsoever. This means that 
he cannot call up or view data, or perform control operations.

If a registered user calls up a function protected by access authorization, the User Administrator 
checks whether the user has the appropriate authorization to permit this. If not, the User 
Administrator denies access to the desired functionality.
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The User Administrator also provides the configuration functions for the "Tag Login" function 
which allows a user to log on to the workstation by means of a tag value which is set using a 
key-operated switch, for example. The automatic logout of a user after a certain time is also 
configured in the User Administrator.

If the WinCC "Chipcard" option is installed, the User Administrator provides functions for 
maintaining chipcards.

You have the choice between 2 options of user administration:

● WinCC logon

● SIMATIC logon

This manual essentially describes the "WinCC Logon" option. More detailed information on 
the "SIMATIC Logon" option may be found in the respective chapters.

Restrictions in the User Administration System

 Object Maximum number

Authorizations 999
Users 128
User groups 128
Ranges 256 

 

See also
Structure of the User Administrator (Page 1811)

Tasks of the User Administrator (Page 1810)

11.3 Tasks of the User Administrator

Introduction
The User Administrator is divided into two components for assigning and maintaining user 
authorizations.

● Configuration system

● Runtime system

Configuration system
Users and authorizations are maintained in the User Administrator configuration system. Here 
new users are registered, passwords are assigned, authorizations are managed in a table, 
and linkage to SIMATIC Logon is executed.
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Runtime system
The principal task of the User Administrator Runtime system is to monitor the system logins 
and access authorizations.

11.4 Elements of User Administrator

11.4.1 Structure of the User Administrator

Introduction
The user interface of the User Administrator editor consists of:

● Menu bar

● toolbar

● Multi-segment project window

● and the status bar
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11.4.2 "File" Menu

Introduction
Functions for project documentation and file management are combined in this menu.
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Printing Project Documentation
Use the "Print Project Documentation" command to print the configured user administration 
data on the set printer. The page layout "@UACS.RPL", which can be modified with the Report 
Designer, is used as a template for the printout.          
The printed data is dependent on the page layout used.

Viewing Project Documentation
The command "Project Documentation View" command is used to obtain a preview of the 
project documentation.

Project Documentation Setup
The "Project Documentation - Setup" command is used to configure the printer and page layout 
to be used.

Note

For more information, refer to chapter "Working with WinCC" in the configuration and Runtime 
data documentation.

11.4.3 "User" Menu

11.4.3.1 "User" Menu

Introduction
The "User" menu contains all items needed to set up new users or groups. You can group 
users that have or will receive the same authorizations. Those users receive the same 
authorizations as the rest of the group. This way, you can avoid having to assign the same 
authorizations within a group manually. 

See also
Deleting Users/Groups (Page 1816)

Web Options (Page 1817)

Changing Password (Page 1816)

Adding Groups (Page 1815)

Setting Up Users (Page 1814)
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11.4.3.2 Setting Up Users

Introduction
Use the "Add User" menu item in the "User" menu to add a new user to the selected group.

Procedure
1. In the project navigation window, select the group to which you want to add a new user.

2. Select "Add User" in the "User" menu or the associated pop-up menu. The "Establish New 
User" dialog is displayed.

3. Enter the login name in the "Login" field.

4. Enter the new password in the "Password" field. To confirm, re-enter the new password in 
the "Verify Password" field.

5. Select the "Copy Group Settings Also" check box if the authorizations for the group in which 
you have added the new user are also to apply to the new user.

6. Click "OK" to close the dialog.

7. Assign the desired authorizations to the new user.

Note

A user name can only be assigned once. 

11.4.3.3 Copying Users

Introduction
Use the "Copy User" menu item in the "User" menu to copy the selected user with all associated 
settings.
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Procedure
1. In the project navigation window, select the group to which you want to add a new user. 

Please select in this group a user to be copied.

2. Select "Add User" in the "User" menu or the associated pop-up menu. The "Copy User ..." 
dialog is displayed.

3. Enter the login name in the "Login" field.

4. Enter the new password in the "Password" field. To confirm, re-enter the new password in 
the "Verify Password" field.

5. Click "OK" to close the dialog.

6. Assign the desired authorizations to the new user.

 

Note

A user name can only be assigned once.

11.4.3.4 Adding Groups

Introduction
Use the "Add Group" menu item in the "User" menu to add a new group. There are no 
subgroups.
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Procedure
1. Select "Add Group" in the "User" menu or the associated context menu. A new group is 

created in the project navigation window. A text window with cursor appears next to the 
group icon.

2. Enter the name of the new group and then press the ENTER key.

3. Assign the desired authorizations to the new group.

 

Note

A group name can only be assigned once. 

11.4.3.5 Deleting Users/Groups

Introduction
Use the "Delete User/Group" menu item to delete the selected user or group. 

Procedure
1. In the project navigation window, select the user or group to be deleted.

2. Select "Delete" in the "User" menu or the associated pop-up menu. A dialog appears in 
which you must confirm the deletion procedure.

3. Confirm by clicking the "OK" button. 

 

11.4.3.6 Changing Password

Introduction
Use the "Change Password" menu item in the "User" menu to assign a new password to the 
selected user. The password must be between 6 and 24 characters in length.
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Procedure
1. In the project navigation window, select the user to whom you want to assign a new 

password.

2. Select "Change Password" in the "User" menu or the associated context menu. The 
"Change Password" dialog is displayed.

3. Enter the old password in the "Password" field.

4. Enter the new password in the "New Password" field. To confirm, re-enter the new password 
in the "Verify Password" field.

5. Click "OK" to close the dialog. 

 

Note

The abbreviated login name of the user is shown in the dialog (max. 22 characters).

 

11.4.3.7 Web Options

Introduction
Select this menu item to set the "Web Navigator" check box in the table window and to display 
the "Web Options" area. 

The web options are described in more detail under "Table window".

See also
Table Window (Page 1827)

11.4.3.8 How to Change the Name of a User or Group

Introduction
You can change the name of a user or a group. Changing the name does not affect the 
password for the user or group.

Structure of the User Administration
11.4 Elements of User Administrator

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1817



Procedure
1. In the project navigation window, select the user to whom you want to assign a new name.

2. Click the left mouse button on the user name. The name now appears in a text window with 
cursor.

3. Enter the new name. 

4. Confirm the new name by pressing the ENTER key.

 

Note

The user or group name can only be assigned once.

11.4.4 "Table" Menu

11.4.4.1 "Table" Menu

Introduction
Use the "Table" menu to change or expand the user rights in the table window. It is not possible 
to delete the "User Administration" authorization. It is permanently set for members of the 
"Administrator" group.

See also
Plant-Specific Authorizations (Page 1819)

Deleting Authorizations (Page 1819)

Inserting Authorization (Page 1818)

11.4.4.2 Inserting Authorization

Introduction
Use the "Insert Authorization" command to insert a line with a new authorization into the table 
of the table window.

Procedure
1. From the "Table" menu, select the "Insert Authorization" entry. The "Insert Line" dialog is 

displayed.

2. In the dialog, enter the line number of the new authorization. By default the field contains 
the next free number.
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3. Click "OK" to close the dialog.

4. Double-click the "Function" column in the new line and enter the name of the new 
authorization.
The authorization description can have a maximum length of 70 characters.

5. Confirm the new name by pressing the ENTER key.

6. Assign the new authorization to the desired users.

 

Note

A new authorization can be assigned to all users and not only to the user which was selected 
when the authorization was created.

11.4.4.3 Deleting Authorizations

Introduction
Use this command to delete a line in the table of authorizations. 

Authorizations can only be deleted in the configuration system.

Procedure
1. In the table window, mark the line containing the authorization to be deleted. 

2. From the "Table" menu, select the "Delete Authorization" entry. A dialog appears in which 
you must confirm the deletion procedure.

3. Confirm by clicking the "OK" button.

 

Note

The system does not allow certain authorizations to be deleted.          
Deleted authorizations are lost for all registered users.

11.4.4.4 Plant-Specific Authorizations

Introduction
Using the "Plant-specific authorization" command, you can specify for LTO-/PCS7 projects if 
a function should be enabled for the entire device or only for individual areas.
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Procedure
1. In the table window, activate the function whose settings you would like to change.

2. From the "Table" menu, select the "Plant-Specific Authorization" entry. The changed setting 
for the selected function takes effect immediately.

3. Enable the selected function for the entire device or die individual areas, respectively.
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Note

Functions where enabling for individual areas would not be meaningful cannot be enabled 
for individual areas. For example, the function "System Change" can only be enabled for the 
entire device.

If you are not working with an LTO-/PCS7 project, the entry "Device-specific authorization" 
is disabled in the "Table" menu.

11.4.5 "Chipcard" Menu

Introduction
This menu contains functions for the "Chipcard" option.          
The menu can only be activated if the WinCC "Chipcard" option is installed and the WinCC 
project is not in Runtime. 

The menu is described under "Extended Chipcard Menu".  

Note

If you activate the "SIMATIC Logon" option, the "Chipcard" menu is disabled.

See also
"Chipcard" Menu Extension (Page 1833)

11.4.6 "AddOns" Menu

11.4.6.1 "AddOns" Menu

Introduction
This menu contains additional functions.

See also
Tag Login (Page 1823)
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11.4.6.2 Tag Login

Introduction
The "Tag Login" function assigns a tag value to a certain user. This user can then log on to a 
workstation in Runtime by setting the tag value, e.g. by means of a key-operated switch. 

This function is configured by following the steps below:

1. Assign an operating station to a configured tag ("Assignment Computer - Tag" dialog).

2. Determine the minimum and maximum values of the value range which is to be used for 
the "Tag Login" function ("Configuration" dialog). 

3. Assign a certain tag value to a certain user ("Assignment User - Value" dialog).

On completion of his work, the user can log out again by setting the tag value to a configurable 
logout value.

If a user is logged on at the system by means of "Tag Login", it is not possible to log on at the 
same computer using the user dialog.

Note

If you have selected the "SIMATIC Logon" option, the function "Tag Login" must not be used.

 

See also
Assignment User - Value (Page 1825)

Configuration (Page 1824)

Assignment Computer - Tag (Page 1823)

11.4.6.3 Assignment Computer - Tag

Introduction
Select the "Assign Computer" menu item to open a dialog in which a computer for the project 
can be assigned to a configured tag. 

Each computer can be assigned to a different tag or all computers can be assigned to the 
same tag. 

The used tag must be "binary" or 8, 16 or 32 bit. 
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Name Description

"Computer" 
field

Used to select a computer.          
All computers of the project are listed.

"Tag" field Here a tag name can be entered directly or selected in the tag selection dialog.

 

See also
Assignment User - Value (Page 1825)

Configuration (Page 1824)

Tag Login (Page 1823)

11.4.6.4 Configuration

Introduction
Select the "Configuration..." menu item to open a dialog in which a value range can be defined. 
A tag value within this range can be assigned to a user in the "Assigning User to Value" dialog. 
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Name Description

"Minimum Value" field Defines the minimum tag value.         
Value range: 0 - 32767

"Maximum Value" field Defines the maximum tag value.         
The entered value must be greater than the minimum value.          
Value range: 1 - 32768

 

See also
Assignment User - Value (Page 1825)

Assignment Computer - Tag (Page 1823)

Tag Login (Page 1823)

11.4.6.5 Assignment User - Value

Introduction
Select the "User Assignment..." menu item to open a dialog in which a tag value is assigned 
to a certain user. 

If a user was already selected in the User Administrator before the dialog was launched, the 
associated assignment is displayed in the dialog. 
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Name Description

"Value" field Serves to select a value displayed in a table.         
The available tag values are determined by the settings in the "Configuration" 
dialog.

"User" field A user created in the User Administrator can be selected here.
"Assign" button When a selection has been made in the "Value" and "User" fields, this button 

assigns the user to the value and displays the assignment in the table.
"Delete" button Deletes an assignment selected in the table.
"Value - User" table Shows the selectable tag values ("Configuration" dialog) and the existing 

assignments to the users.

 

Note

Each user can only be assigned to one tag value.          
A "User" in the User Administrator can also represent a group of users or a function, e.g. 
"Maintenance" or "Troubleshooting".

See also
Tag Login (Page 1823)

Configuration (Page 1824)

Assignment Computer - Tag (Page 1823)

11.4.7 Toolbar

Introduction
The symbols in the toolbar allow you to perform actions more quickly. You do not have to make 
several selections through the menus until you reach the required function.

Icon Description

"User" "Add User"

"Group" "Add Group"

"User" "Copy User"

"User" "Delete User/Group"

"User" "Change Password"

"What's This?"

"Web Navigator"
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11.4.8 The Project Window

11.4.8.1 The Project Window

Introduction
The user administration data is displayed in the project window. The window consists of:

● the navigation window (left)

● and the multi-segment table window (right).

11.4.8.2 Navigation Window

Navigation Window
The navigation window contains a tree structure showing the configured groups and the 
associated registered users. The selected user name is displayed in the field above the 
navigation window. The "User" menu can be opened as a context menu for the selected user 
or user group.

11.4.8.3 Table Window

Introduction
In the table window, the login name and the associated settings are displayed for the selected 
user and group.

"Login only via chip card" check box
If a user is to be able to log in by means of his chipcard only, this can be set by activating the 
"Login only via chip card" check box. 

Note

The "Login only via chip card" check box is displayed if the WinCC "Chipcard" option has 
been installed. A chip card reader does not have to be connected to the configuration 
computer. As a result, it is possible to set up the "Chipcard" function and use it on other 
WinCC computers without a card reader needing to be available during configuration.

 

If you have selected the "SIMATIC Logon" option, the "Login only via chip card" check box 
is deactivated.
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"Automatic Logout" Area
If the automatic logout function is to be activated for the selected user, then set the duration 
and type of monitoring in this area. The automatic logout prevents unauthorized persons having 
unlimited access to the system.          
If you enter a "0" in the entry field for the period until an automatic logout, the function is 
deactivated. The user remains logged in until the system is shut down or a different user logs 
in.

If you activate the "Absolute time" option, the configured time for the automatic logout begins 
to run down when the user logs in, regardless of whether control operations are performed by 
the user during this time.          
If the "Idle Time" option is activated, the configured time begins to run down from the point at 
which the user last performed a keyboard or mouse operation. The user is automatically logged 
out after this pause.

"SIMATIC Logon" check box
If the box is checked, the user administration "SIMATIC Logon" is used instead of "WinCC 
Logon". Information on the "SIMATIC Logon" option may be found in chapter "Option SIMATIC 
Logon".

"WebNavigator" Check Box and "Web Options" Area
If the box is checked, the "Web Options" area is displayed. In this area, the settings for the 
start picture and language are configured and then applied if the user dials into the WinCC 
project from the web. Only pictures that were published via WebNavigator can be selected as 
the start picture.           
The check box can also be activated using the "WebNavigator" button in the toolbar.

Authorizations Table
The lower part of the table window shows the configured authorizations. Each line contains 
one authorization.          
The number of displayed authorizations depends on the installed options, e.g. the "Basic 
Process Control" option.         
 Authorizations with the numbers 1000 - 1099 are system authorizations which cannot be set, 
modified, or deleted by the user.

Authorization 1 "User Administration" is set by default for users in the "Administrator" group. 
This authorization cannot be deleted. 

In the "Unlock" column, an authorization can be assigned to the selected user by double-
clicking in the desired line.

Each authorization must be assigned separately. Multiple authorizations can only be 
transferred according to the group assignment when you add a new user to a group. The table 
can be edited by selecting the "Table" menu item.          
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11.4.8.4 How to Set an Automatic Logout for a User

Introduction
If the "Automatic Logout" function is set, a logged-in user can be logged out automatically after 
a definable time. This prevents unauthorized persons from having unlimited access to the 
system following control operations by the currently logged-in user.          
If you enter a "0" in the entry field for the period until an automatic logout, the function is 
deactivated. The user remains logged in until the system is shut down or a different user logs 
in.

If you activate the "Absolute time" option, the configured time for the automatic logout begins 
to run down when the user logs in, regardless of whether control operations are performed by 
the user during this time.          
If the "Idle Time" option is activated, the configured time begins to run down from the point at 
which the user last performed a keyboard or mouse operation. The user is automatically logged 
out after this pause.

Procedure
1. In the project navigation window, select the group or user for which you want to configure 

the "Automatic Logout" function.

2. In the input field in the "Automatic Logout" section of the table window, enter the time until 
automatic logout in minutes after which the system is no longer to permit process control 
and the user is to be logged out.

3. The "Absolute Time" option is set by default. Activate the "Idle Time" option if the time after 
which the automatic logout is to be performed is to begin running down from the point at 
which the user last performed a keyboard or mouse operation.

 

Note

If you have selected the "SIMATIC Logon" option, the function "Automatic Logout" can only 
be set for the group. This setting is automatically applied to each user of this group.

 

11.4.8.5 How to Activate the "Login Only Via Chipcard" Function for a User

Introduction
If a user is to be able to log in using his chipcard only, this can be set in the User Administrator 
by activating the "Login Only Via Chipcard" function. 
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Note

The "Login Only Via Chipcard" check box is displayed if the WinCC "Chipcard" option has 
been installed. In addition, the "Terminal Active" option must also be activated in the "WinCC 
Chipcard Terminal" component in the Control Panels of Windows.         
A chipcard reader does not have to be connected to the configuration computer. As a result, 
it is possible to set up the "Chipcard" function and use it on other WinCC computers without 
a card reader needing to be available during configuration.

 

Procedure
1. In the project navigation window, select the user for which the "Login Only Via Chipcard" 

function is to be activated.

2. In the table window, activate the "Login Only Via Chipcard" check box.

See also
"Chipcard" Menu Extension (Page 1833)

11.4.9 Status bar

Introduction
The left side of the status bar contains general program information.

The fields on the right side provide information on keyboard settings.

 

11.5 Procedure in User Administration

11.5.1 Overview of Configuring a User Administration

Introduction
The following basic steps are necessary to set up a user administration system:

1. Set up the required groups.

2. Select the appropriate authorizations for the groups.
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3. Add the users and assign the respective login names and passwords. The properties of 
the group can be copied when new users are added. In this case, it is advisable to assign 
the users to groups with authorizations which you want the users to have.

4. Select the specific authorizations for the various users. It is also possible to set a time here 
after which the system is to automatically log out the user in order to protect the system 
from unauthorized entries. It can also be determined whether the user should be able to 
log in by means of the chipcard only and which user-specific settings apply if the user should 
dial into the system from the web. 

The data is applied without being stored.

11.5.2 Calling an Authorization into Other Editors

Introduction
If you want to assign an authorization in a different editor, e.g. an attribute of an object, the 
following dialog appears.

The authorizations are displayed in numerical order. If you select an authorization here, the 
function or control operation is unlocked in Runtime only for users who have the appropriate 
authorization.

You can open the dialog in various ways, e.g. by means of the "Authorization" attribute in the 
properties for an option button in the Graphics Designer.
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11.5.3 Operation in Runtime

Introduction
The following steps are necessary for a user to log on in Runtime:

1. Start the Runtime system. 

2. Now open the password dialog using the shortcut keys for "Login" defined in the WinCC 
Explorer (Project Properties - Hotkey tab).

3. Enter your login name and the password in the dialog.

The system checks the authorizations you have been assigned with those of the editors and 
the installed components. If the authorizations match, the system unlocks the editors and 
components so that they can be used.

Note

If a large number of authorizations have been assigned to a user, i.e. around the maximum 
number of 999 authorizations per user, several minutes may be required to log in the user.   

11.6 WinCC Options for Administrators

11.6.1 WinCC Options for Administrators

Introduction
Installing WinCC together with the options extends the functionality of the Administrator.

● The OS Project Editor in the "Basic Process Control" option changes the number and 
function of the authorizations in the table window. The authorizations then correspond to 
the PCS7 user hierarchies.   

● The "Chipcard" option inserts the "Chipcard" item together with the associated functions in 
the menu bar and the "Login Only Via Chipcard" check box can then be activated in the 
table window. 
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11.6.2 "Chipcard" Menu Extension

11.6.2.1 "Chipcard" Menu Extension

Introduction
The User Administrator provides functions for controlling a chipcard reader. You can write to 
and check chipcards in the configuration system. The "Chipcard" menu is deactivated in 
Runtime.
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Requirement
The following requirements must be met before WinCC with the "Chipcard" option can be used:

● the "Chipcard" option must be installed and

● an interface (e.g. COM1 or COM2) must be assigned to the chipcard reader.

When these requirements have been met, the "Chipcard" menu becomes available and the 
"Login Only Via Chipcard" check box is displayed in the table window.

Note

No Windows Administrator rights are required to write to and check chipcards in the 
configuration system or to use the chipcards in Runtime.

To be able to write to and read a chipcard, the hardware connection between the chipcard 
reader and computer must be connected before the computer is started.

See also
How to Check a Chipcard (Page 1836)

How to Write to a Chipcard (Page 1835)

How to Set the Interface for the Chipcard Reader (Page 1834)

11.6.2.2 How to Set the Interface for the Chipcard Reader

Introduction
An interface on the WinCC computer must be assigned before a chipcard reader/writer can 
be used in WinCC. 

An interface must also be assigned to activate the "Chipcard" menu in the User Administrator. 
Further requirements can be found under "Extended Chipcard menu".

If the User Administrator is opened again after the interface has been set, the "Chipcard" menu 
is activated in the menu bar. 

If the "Terminal Disabled" option button is activated in the "WinCC Chipcard Terminal 
Configuration" dialog (Control Panels), the "Chipcard" menu is deactivated when the User 
Administrator is opened again.

Note

The current Windows user must have administrator rights in Windows to be able to access 
the "WinCC Chipcard Terminal Configuration" dialog.
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Procedure
1. Open the "WinCC Chipcard Terminal" icon in the Control Panels of Windows. The "WinCC 

Chipcard Terminal Configuration" dialog appears. 

2. Activate the "Terminal active" option button.

3. Select the desired interface in the "Connection" field.

4. Click "OK" to close the dialog.

11.6.2.3 How to Write to a Chipcard

Introduction
When a chipcard is written, all of the data on the card is deleted. The user (login name) and 
the password are stored on the card.

Procedure
1. Select "Write To Chipcard" in the "Chipcard" menu. The "Write To Chipcard" dialog appears.

2. Select the desired user in the "Write to Chip Card for User" field.

3. Activate the "Additional Manual Password Also Required" check box if this condition is to 
be applied when logging in Runtime.

4. Insert the chipcard into the chipcard reader.

5. Click the "Write To Chip Card" button. The User Administrator transfers the data to the 
chipcard. 

6. Close the dialog by clicking the "Close" button.
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Note

To be able to write to and read a chipcard, the hardware connection between the chipcard 
reader and computer must be connected before the computer is started.         
         
This menu option is only available, if WinCC is installed with the "Chipcard" option. Further 
requirements can be found under "Extended Chipcard menu".

11.6.2.4 How to Check a Chipcard

Introduction
This function is used to read a chipcard. It allows the data on the chipcard to be checked if, 
for example, the card has just been written or a reading error has occurred. 

The login name stored on the card is displayed in the "User" field. If the login name already 
exists in the User Administrator, the text "Card is valid" appears in the dialog. If the name does 
not exist, the text "Card is invalid" is displayed.

If there is an error when reading the chipcard, it is noted in this dialog. No user name is provided.

Procedure
1. Insert the chipcard into the chipcard reader.

2. Select "Check Chip Card" in the "Chip Card" menu. The "Check Chip Card" dialog appears.

3. The result of the check is displayed.

4. Close the dialog by clicking the "Close" button.

 

Note

To be able to write to and read a chipcard, the hardware connection between the chipcard 
reader and computer must be connected before the computer is started.         
         
This menu option is only available, if WinCC is installed with the "Chipcard" option. Further 
requirements can be found under "Extended Chipcard menu".
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11.6.3 Chipcard Reader in Runtime

Introduction
To log into WinCC, the user inserts his chipcard into the chipcard reader and the required data 
is read out. If the chipcard is inserted, it is not possible to log on at the system manually. The 
user remains logged on at the system until he removes the card from the chipcard reader. The 
"Automatic Logout" function whereby the user is logged out automatically after a set time is 
only possible in conjunction with chipcard operation.

Note

The "Chipcard" menu is deactivated in Runtime since the functions can only be used in the 
configuration system.

 

11.6.4 Option SIMATIC logon

11.6.4.1 Option SIMATIC logon

Introduction
In systems monitored and controlled by process guidance systems, there are often specific 
requirements for access to functions and system areas. Important requirements for validation 
of systems are:

● Avoiding unwanted access to system. This is facilitated by assigning respective access 
authorization through user administration.

● Documentation of operator access. This generates proof and archiving of important 
operations.

The SIMATIC Logon option facilitates the certification of plants according to FDA 21 CFR Part 
11. These demanding requirements were specified by the U.S. Department of FDA (Food and 
Drug Administration).

Requirement
If you wish to use the option under WinCC, you must install the basic package "SIMATIC Logon 
Service" on all involved computers.

Changing the Script Call "SIMATICLogon" in Project Function "passlogin.fct"
In all WinCC projects where the project function "passlogin.fct" had been used, starting with 
WinCC V6.0 SP3, the call must be modified. Please replace in all scripts "SIMATICLogon (...)" 
by "PASSLoginDialog (...)".
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Note

From WinCC V6.2 the use of SIMATIC Logon has been released for network systems with 
clients without local project.

As soon as you activate the "SIMATIC Logon" option, the users inserted in "WinCC User 
Administrator" are ignored. Only the settings of those groups whose names match those of 
Windows Groups are important.

Detailed information on function and installation of the SIMATIC Logon Service may be found 
in the respective current manual "SIMATIC Logon and Electronic Signature".

11.6.4.2 SIMATIC Logon service

Introduction
Access protection of "SIMATIC Logon Service" is based on mechanisms of the Windows 
operating system. The following section summarizes what you need to watch for in Windows 
settings.

Windows Settings for SIMATIC Logon Service
For the following steps you need:

● Administrator knowledge for dealing with the operating system

● Administrator authorization for Windows

"SIMATIC Logon Service" requires the following settings for flawless operation:

● If you have configured a "Registration Server of SIMATIC Logon Group" as the SIMATIC 
Logon work environment, you must enable access to this computer via the network.

● If you have configured a "Windows Domain" as the SIMATIC Logon work environment, you 
must enable authorization for "Read" and "Change Password" for authorized domain users. 
If a single-user computer is used, no specific settings are necessary.

To use the following functionalities, you need to first perform the following settings:

● In Windows Computer Administration you can enter for each user the "Complete Name" 
under "Local Users and Groups". This name is used by applications for display and reports.

● If logon processes are to be assessed, you must specify the desired settings in "Audit 
Policy" of "Local Security Policy" in Windows:

- Monitoring Registration Events

- Monitoring Registration Attempts

● Settings for user accounts may be specified in "Account Policies" of "Local Security Policy" 
of Windows:

- Password guidelines: e.g., maximum password age, minimum password length

- Account lock guidelines
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Users of a Windows domain

NOTICE

Users of SIMATIC Logon must be direct members of a Windows group.

They must not be members of a subgroup of Windows groups.

Failure of SIMATIC Logon Server
If you work with a registration server for SIMATIC Logon Service, we recommend the following 
measures for possible server failure:

● Install all users with the necessary authorizations on a second computer, e.g., on the local 
computer.

● Select on the respective computer the option "Register to" from the "Configuring SIMATIC 
Logon" dialog.

 

11.6.4.3 How to use the SIMATIC Log on Service with WinCC

Procedure
If you wish to use "SIMATIC Logon Service" with WinCC, we recommend the following 
procedure:

1. Specify settings in Windows user administration.

2. Specify settings in WinCC user administration.

3. Configure visualization of logged-in user.

4. Configure registration dialog "SIMATIC Logon Service".
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Windows User Administration
The connection between Windows user administration and WinCC user administration is 
facilitated through identical names within the group.

WinCC User Administration
In Windows, if you create a group "Group_Operator", you must create in WinCC User 
Administrator a group "Group_Operator" of identical name and must assign the respective 
authorizations:

1. Open WinCC project.

2. Open User Administrator using WinCC Explorer.
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3. Activate "SIMATIC Logon" option.

4. Create group(s).

5. Assign authorizations per groups.

Visualization of Logged-in User in RT

Visualization during WinCC projects
Inn WinCC projects, if you wish to display the logged-in user in a process picture or report, 
you may use one of the two tags:
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Tag         Names in         
WinCC user administration

Names in         
Windows user administration

@CurrentUser User ID User Name
@CurrentUserName User Name Full Name

Depending on which of the two tags you use, either the user ID or the full user name of the 
logged-in user are displayed.

Note

If you do not use the "SIMATIC Logon" option, the user ID of the logged-in user is entered in 
both tags.

Visualization during LTO-/PCS7 projects
In LTO-/PCS7 projects, you may select in the project editor whether the full user name or the 
user ID of the logged-in user are shown in the system summary display.
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"SIMATIC Logon Service" Login Dialog
In order to call the registration dialog "SIMATIC Logon Service" in WinCC RT, you may 
configure any button with any picture in Graphics Designer.

Link the event "Mouse Click" with a C action. If you call the function "PASSLoginDialog" within 
this C action, a click of the button opens the registration dialog.

Note

If you wish to use the function "PASSLoginDialog", the option "Basic Process Control" must 
be installed.

If you are using SIMATIC Logon in PCS7-OS and LTO projects and wish to register using 
the chip card, you must first perform the following setting:
● Open the picture "@Welcome.PDL".
● Customize the object properties under "Event/Picture-Object/Others/Select Picture" the 

C-script by commenting out the "PASSLoginDialog (Screen);" line.
● Save the "@Welcome.PDL" picture.

Upon entering user name, password and domain, the user obtains authorizations of the WinCC 
group to which he is assigned via the respective Windows group.

11.6.4.4 How to configure an electronic signature

Introduction       
You can use an electronic signature to make the execution of critical operation dependent on 
the electronic signature of the user. A given action can only be carried out when the configured 
user is authenticated with a password. If the user is not authorized or enters an incorrect 
password, the action is not performed.

Successfully and aborted signing procedures are documented with a message.
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Runtime requirements
● The basic package for the "SIMATIC Logon Service" is installed on all computers involved.

● The "SIMATIC Logon" option is activated in the "User Administrator" dialog.

● The user must be a direct member of a Windows group and the WinCC User Administration.

Configuring an electronic signature
You can configure an electronic signature for any event of WinCC objects. Example: Clicking 
on a button should open a dialog for authenticating the operator.

To do this, use the CCESigDlg object for the dynamic reaction and call the "ShowDialog" 
function.

Configure the desire action by evaluating the return value. For example, make the output 
command dependent on the success of the authentication.

A message is created documenting the authentication in Runtime.

If you use the WinCC/Audit option, the messages of all authentication attempts are also written 
in the Audit Trail database.

11.6.4.5 Example 1: Creating an electronic signature in a VBS action

Introduction  
This program example shows you how to protect a process control against unauthorized 
execution with an electronic signature. Calling the "ShowDialog" function opens a dialog in 
which the configured user can be authenticated in WinCC Runtime. Make the output command 
dependent on the success of the authentication.

Syntax of "ShowDialog" function
Expression.ShowDialog(User As String, DisplayedUser As String, 
Domain As String, LangID As Long, Comment As String) Long
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Expression
Required. An expression that returns an object of the "CCEsigDlg.ESIG" type.

Parameter

Parameter Description

User User name that is used to authenticate the user.
DisplayedUser Name of the user that is displayed in the "User name" field of the "SIMATIC Logon 

– Electronic Signature" dialog box.
Domain Name of the computer that authenticates the user:         

- Name of the computer that administers the users centrally (SIMATIC Logon 
server)         
- Name of the local computer
If a string is not specified for this parameter, the local computer is entered 
automatically.

LangID Identifier for the desired language variant of the dialog box:         
1028 – Chinese (traditional)         
1031 – German         
1033 – English          
1034 – Spanish         
1036 – French         
1040 – Italian         
1041 – Japanese         
1042 – Korean         
2052 – Chinese (Simplified)

Comment Comment entered by the user.

Return values

Return value Identifier Description

1 IDOK The user has been successfully authenticated.
2 IDCANCEL The user has closed the dialog box using the "Cancel" button.
3 IDABORT The user could not be authenticated even after repeating the logon 

twice.

Example
Output of a dialog for authenticating the user (without forced comment, i.e. forcecomment= 
false):

 
Sub OnClick(ByVal Item)   
Dim myesig
Dim mycomment
Dim ret
 
Set myesig = CreateObject("CCEsigDlg.ESIG")
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'comment optional 
myesig.forcecomment = false  
 
ret = myesig.showDialog("winccadmin","winccadmin","SIMLOGSERV",1031,mycomment)
 
.
.
.
 
End Sub

When this VB script is executed in RT, a dialog for authenticating the user is displayed.

The input of a comment in the entry field is optional.

Configure different reactions to the mouse event of the WinCC object depending on the 
transferred return value "ret".

A message is also generated with which the authentication or the authentication attempt is 
documented.

Note

We recommend that the VBS action be protected against unauthorized modification and 
viewing by a password.

11.6.4.6 Example 2: Creating an electronic signature in a C action

Introduction
This program example shows you how to protect a process control against unauthorized 
execution with an electronic signature. Calling the "ShowDialog" function opens a dialog in 
which the configured user can be authenticated in WinCC Runtime. Make the output command 
dependent on the success of the authentication.

Structure of the User Administration
11.6 WinCC Options for Administrators

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1847



Syntax of "ShowDialog" function
INT ShowDialog(char* lpszUserName, char* lpszDisplayedUserName, char* 
lpszDomainName, int intLangID, variant* vtComment);

Parameter

lpszUserName
User name that is used to authenticate the user.

lpszDisplayedUserName
Name of the user that is displayed in the "User name" field of the "SIMATIC Logon – Electronic 
Signature" dialog box.

lpszDomainName
Name of the computer that authenticates the user:         
- Name of the computer that administers the users centrally (SIMATIC Logon server)         
- Name of the local computer

If a string is not specified for this parameter, the local computer is entered automatically.

intLangID
Identifier for the desired language variant of the dialog box:         
1028 – Chinese (traditional)         
1031 – German         
1033 – English          
1034 – Spanish         
1036 – French         
1040 – Italian         
1041 – Japanese         
1042 – Korean         
2052 – Chinese (Simplified)

vtComment
Comment entered by the user.

Return value

Return value = 1
The user has been successfully authenticated.
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Return value = 2
The user has closed the dialog box using the "Cancel" button.

Return value = 3
The user could not be authenticated even after repeating the logon twice.

Example
Output of a dialog for authenticating the user (with forced comment):

 
#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
 
int nRet = 0;
 
VARIANT vtComment;
 
__object* EsigDlg = __object_create("CCESigDlg.ESIG");
 
if (!EsigDlg)
 
{
  printf("Failed to create Picture Object");
  return;
}
 
nRet = EsigDlg->ShowDialog("winccadmin","winccadmin","SIMLOGSERV",1033 ,&vtComment);
__object_delete(EsigDlg);
 
.
.
.
.
 
}

When this C script is executed in Runtime, a dialog box for authenticating the user is displayed.
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In this program example, the entry of a comment is mandatory.

Configure different reactions to the mouse event of the WinCC object depending on the 
transferred return value "nRet".

A message is also generated with which the authentication or the authentication attempt is 
documented.

Note

We recommend that the C action be protected against unauthorized modification and viewing 
by a password.

11.6.4.7 Notes re. Linking of WinCC/PCS7-OS

Authorization of Logged-In Users
Authorizations result from the group affiliation in User Administrator.

● If the user can be authenticated, the user of SIMATIC Logon is automatically assigned to 
the "Emergency_Operator" group.

● If a user belongs to one or more Windows groups and one of those has been created in 
User Administrator, the user is assigned the rights of that group.

● If a user belongs to one or several Windows groups and one of those has been created in 
User Administrator, the user is allotted all the rights of these groups. 

Note

If a user belongs to multiple Windows groups, your configuration must ensure that there 
are no conflict cases.           
Example: One user belongs to multiple groups.  Automatic logoff after 5 minutes has been 
configured for one of them.  However, if automatic logoff after 2 minutes has been 
configured for the other groups, this will result in impossible situations.
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User "Administrator"
The user name "Administrator" is reserved by WinCC and may not be used by SIMATIC Logon. 
Any registration with this Windows login fails. Rename the user name in Windows user 
accounts or contact the system administrator.

Group "DefaultGroup"
In the configuration dialog of SIMATIC logon, you can activate the "Use following data without 
explicit logon" in the General tab. If no user is logged into RT at a workstation, then the selected 
user is automatically logged on in the "User" field.  By default, the "Default User" is set from 
the "DefaultGroup". 

Note

The "DefaultUser" is a virtual user belonging to the "DefaultGroup". Consequently, you must 
not set up this user in the Windows user administration system.         
The assignment is made by matching the "DefaultGroup" name to a corresponding group in 
the User Administrator.         
So create a group in WinCC with the same name as was assigned to the "DefaultGroup" in 
the Logon dialog. Then assign the desired authorizations to this group.

 

11.7 Overview of Authorizations

11.7.1 Default Authorizations

Introduction
When the User Administrator is opened for the first time, the table window contains certain 
default authorizations. 

The authorizations in the table can be deleted or modified, except for the "User Administration" 
authorization.          
Authorizations with a lower number are not contained in authorizations with higher numbers, 
but instead each authorization functions independently.

A member of the "Administrator Group" always receives access to the "User Administration" 
authorization.

The standard authorizations are assigned in the configuration system, but are only effective 
in Runtime. This prevents a logged-in user from receiving unlimited access to all system areas 
in Runtime.
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Note

The names of the authorizations indicate what kind of influence the corresponding 
authorization should have, but not how you actually use them.

The authorizations are preset by WinCC as follows:

No. 1: User administration
This authorization grants the user access to the User Administration of WinCC. 

If this authorization is set, the user can call up the User Administrator and make changes.

No. 2: Value input
This authorization enables the user to enter values manually, e.g. into I/O fields.

No. 3: Process controlling
This authorization enables the user to perform control operations, e.g. manual/automatic 
switchover. 

No. 4: Picture editing
This authorization enables the user to change pictures and picture elements (e.g. via ODK).

No. 5: Picture change
This authorization enables the user to trigger a picture change and thus open another 
configured picture.

No. 6: Window selection
This authorization enables the user to change the application windows in Windows. 

No. 7: Hard copy
This authorization enables the user to make a hardcopy of the current process picture.

No. 8: Confirming messages
This authorization enables the user to confirm messages.

No. 9: Locking messages
This authorization enables the user to lock messages.
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No. 10: Unlocking messages
This authorization enables the user to unlock (free) messages.

No. 11: Message editing
This authorization enables the user to change messages in Alarm Logging (e.g. via ODK). 

No. 12: Starting archive
This authorization enables the user to start an archiving process.

No. 13: Stopping archive
This authorization enables the user to stop an archiving process.

No. 14: Archive value editing
This authorization enables the user to configure the evaluation process for the archive tags. 

No. 15: Archive editing
This authorization enables the user to control or change the archiving process.

No. 16: Action editing
This authorization gives the user the right to execute and change scripts (e.g. via ODK). 

No. 17: Project manager
This authorization grants the user access to the WinCC Explorer.

 

11.7.2 System authorizations

Introduction
System authorizations are generated automatically by the system and cannot be created, 
modified or deleted by the user. The system authorizations can be assigned to a user just like 
any other authorization.  

The system authorizations are effective in the configuration system and in Runtime. In the 
configuration system, this prevents a user who is not registered in a project from being granted 
access to the project, e.g. a server project.

The authorizations mean:
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No. 1000: remote activation
If set, the user can start or stop the runtime for this project from a different computer.

No. 1001: Remote configuration
If this item is set, the user can configure and make changes to the project from a different 
computer.

No. 1002: DataMonitor - Just monitor
If this item is set, the user can only open the project from a different computer; he cannot make 
changes or perform control operations.  

 

11.7.3 Basis Process Control Authorizations

Introduction
These user authorizations correspond to the user hierarchies from PCS7 and are available 
after the wizard in the OS Project Editor ("Basic Process Control" option) has been activated.

Authorizations can be added and deleted or their names be changed in the configuration 
system. Authorizations with a lower number are not contained in authorizations with higher 
numbers, but instead each authorization functions independently.  

The following preset authorizations cannot be deleted or changed:

No. 1: User administration
If this authorization is set, the user can call up the User Administrator and make changes.

No. 2: Authorization for area
If this authorization is set, the user can select pictures from the specified system areas. 

No. 3: System change
If this authorization is set, the user is granted the right to make status changes, e.g. to 
deactivate the runtime system.

No. 4: Monitoring
If this authorization is set, the user can monitor - but not control - the process, e.g. selection 
of the batch visualization. 
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No. 5: Process controlling
If this authorization is set, process controlling can be performed.

No. 6: Higher process controlling
If this authorization is set, the user is permitted to perform control operations which have 
permanent effects on the process, e.g. modifying the limit values of a controller.

No. 7: Report system
No longer used by the system.

11.7.4 PCS7 System Authorizations

Introduction
System authorizations are generated automatically by the system and cannot be created, 
modified or deleted by the user. The system authorizations can be assigned to a user just like 
any other authorization.

The authorizations mean:

No. 1100: Highest process controlling
Used with PCS7 in combination with the Advanced Process Library only.
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Integration of WinCC in SIMATIC Manager 12
12 Resources

12.1 Integration of WinCC in SIMATIC Manager

Content
WinCC projects can be created and managed in STEP 7 within the framework of Totally 
Integrated Automation. This results in connections between the AS configuration and WinCC 
configuration. The advantages of this "WinCC in STEP 7 integration" are described in this 
chapter. 

The subjects covered in this chapter are:

● Managing WinCC Projects and Objects in STEP 7

● Transferring Tags and Texts to WinCC

● Selection of STEP 7 Symbols

Diagnostic Support in the Event of Faults

12.2 Advantages and Prerequisites of Integration

Introduction
The integration of automation components has become the most important aspect of modern 
automation systems. Both horizontal integration from the receipt of goods, to the production 
process, and on to shipping, and vertical integration from the sensor to the business level are 
intended to achieve enormous reductions in cost and increases in productivity.

Uniformity
However, such integration is only possible if all of the devices and systems associated with 
the automation solution are implemented uniformly on a common technological basis.

This applies to the operating and monitoring systems used in automation solution such as, 
SIMATIC WinCC.
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SIMATIC Manager
Integration is only complete if the automation components are configured and managed on a 
common platform. Access to a common data management system makes configuration much 
easier and allows processes to be automated.

The SIMATIC Manager of STEP 7 provides such a platform on which SIMATIC WinCC can 
also be integrated.

Advantages of Integration
The configuration of SIMATIC WinCC in an integrated environment provides the following 
advantages:

● Simple transfer of tags and texts into the WinCC project

● Direct access to STEP 7 symbols during process connection

● Uniform message configuration

● Loading the configuration data on the Runtime OS

● Extended diagnostic support

Advantages of integration for redundant systems
Integration simplifies the administration of master and standby:

● Inserting and Parameterizing Master and Standby

● Configuring Master and Standby

● Overall Loading of Master and Standby

Integration enables loading online changes in case of redundant system:

● Load Online Changes is automatically activated after overall loading

● Automatic validation of settings and pre-conditions with detailed error messages

● Automatic cancellation while loading on redundant system if the initial load on standby has 
failed

Notes on installation
If you wish to integrate WinCC in STEP 7, you must implement an installation of WinCC as 
well as an installation of SIMATIC STEP 7. For a new installation we recommend the following 
sequence of installations:

● Installation of SIMATIC STEP 7

● User Defined Installation of WinCC

In the described sequence you may install the required WinCC components at the same time. 
You may also install SIMATIC STEP 7 at any time thereafter. You might then have to install 
individual WinCC components afterwards.
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Required Software Components
The following dialog shows the communications components to be activated for an integration 
of WinCC in STEP 7. This applies to communications components:

● SIMATIC Device Drivers

● Object Manager

● AS-OS Engineering

● STEP7 Symbol Server

In addition you must activate the option Basic Process Control.
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If you wish to use a chip card reader, you must activate the option Chip Card during the 
installation of SIMATIC STEP 7 and during the installation of WinCC.

Note

For the installation of SIMATIC STEP 7 and WinCC, please read the notes in the installation 
manual.

Prior to implementing any WinCC-specific configurations in SIMATIC Manager, you must 
ascertain that the language used in SIMATIC Manager is installed in WinCC as well.

Note

Starting with version V6.2, WinCC evaluates the project-related access protection that is used 
to protect STEP 7 or PCS7 projects.

Independent of access protection:         
WinCC Projects that are integrated in a STEP 7/PCS7 project cannot be opened using an 
ES where only WinCC has been installed. For that you also need STEP 7 or NCM PC Edition 
of SIMATIC NET CD on the ES.

If project-related access protection has been activated for WinCC project, then you must also 
enter the STEP 7 project password while opening the project.
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12.3 Managing WinCC Projects and Objects in the SIMATIC Manager

12.3.1 Managing WinCC Projects and Objects in the SIMATIC Manager

Introduction   
The SIMATIC Manager can be used to organize and administrate all the components belonging 
to the automation solution. Accessing these components in a common data management 
system makes system configuration much easier and allows a number of configuration 
processes to be automated.

WinCC projects as WinCC application or OS 
You can create WinCC projects directly in the SIMATIC Manager. In this case, you have to 
differentiate between the following storage options: 

● WinCC project as WinCC application within a PC station

● WinCC project as operator station OS

When creating new projects, you should use WinCC applications. They have the following 
advantages compared to the OS:

● The PC station can be displayed and parameterized in the network configuration.

● The interfaces and access point of the operator station are determined automatically.

OS reference 
Using OS references offers the advantage of loading one WinCC project, the so called basis 
OS, onto several target systems. One target system is attached to each basis OS as well as 
for each individual reference.  

The basis OS must have the following properties:

● Object type OS in the STEP 7 project

● Project type "Single-User" or "Multi User"

● No redundant partner

● The OS reference and the basis OS must be created in the STEP 7 sub-project.         

After processing, you must transfer the project to the target system of basis OS along with all 
the references. Select the "Download to CPU" function for the selected basis OS or OS 
reference.

The objects "WinCC Appl. Ref." und "OS Ref." are used for configuration.

An OS reference supports neither clients with own project nor clients without own project.  
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Note

How to configure the PC station is described in the STEP 7 help.

It is recommended not to store and edit STEP 7 projects with integrated WinCC projects at 
an operator station. 

If you work in SIMATIC Manager with technological views, all WinCC editors must be closed.

WinCC projects created or managed using SIMATIC Manager should not be copied using 
the Project Duplicator.

Multi-projects have the following restriction:         
Do not move any basis OS from a STEP 7 sub-project to another STEP 7 sub-project. While 
moving, you will lose all associated OS reference stations their reference to basis OS.

Integration allows you to execute functions in the WinCC project directly from the SIMATIC 
Manager. These include:

● Opening the WinCC project

● Loading the WinCC project on the target computer

● working with the WinCC objects "Pictures" and "Report Templates"

The Import OS function in the SIMATIC Manager allows to import independent WinCC projects 
into a STEP 7 project.

Prohibited project constellations
No all theoretically imaginable project constellations are practical or allowed in the SIMATIC 
Manager. The following constellations are prohibited on the engineering station:

● A multi-user project to be operated in Runtime, although its package is loaded on another 
server.

● A single-user project or multi-user project to be operated in Runtime, but has been swapped 
out to the central archive server.

Activating Runtime on ES
Activating Runtime with integrated WinCC project on the ES can be influenced 
centrally.         
In WinCC Explorer select the item "Project Properties" in the shortcut menu of the current 
project. In the Options tab, activate the "Allow activation on ES" checkbox .         
The checkbox is unchecked when you insert a new WinCC project.
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You can activate the WinCC project on the ES if the checkbox is activated.

Requirements
● The WinCC project is a TIA Project.         

i.e. the WinCC project is integrated in a STEP 7 project or PCS7 project.

● The corresponding destination path is configured.

If the WinCC project is not a TIA project or the corresponding destination path has not been 
configured in ES, then the checkbox does not have any effect. In such a case, the project can 
be activated at any time.

Editing orders in SIMATIC Manager in parallel
You can edit several orders in SIMATIC Manager in parallel. You can use SIMATIC Manager 
to load a target system and simultaneously create a new WinCC application in the "HW Config" 
dialog. The parallel editing of a WinCC project with WinCC Explorer is also permitted.

If one of the orders cannot be executed at the current time, you will be notified via an error 
message. You can then trigger the cancelled job again at a later point in time.
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See also
Working With WinCC Objects (Page 1889)

Operator Station OS (Page 1879)

WinCC Application (Page 1864)

12.3.2 WinCC Application

12.3.2.1 WinCC Application

Introduction    
In a STEP 7 project, the SIMATIC PC station represents a PC which, similar to the automation 
station AS, contains the software and hardware components required for automation. Apart 
from communication processors and slot or soft PLCs, these components also include 
SIMATIC HMI components.

If a PC station is to be implemented as an operator station, you must add a WinCC application 
during configuration. You can choose between various project types, depending on the 
respective requirements:

● Master server in the multi-user project. The name in the PC station is "WinCC Appl.".

● Standby server as redundancy partner in the multi-user project. The name in the PC station 
is "WinCC Appl. (Stby.)".

● Client in the multi-user project. The name in the PC station is "WinCC Appl. Client".

● Reference to a so-called basis OS.  The name in the PC station is "WinCC Appl. Ref".

● Reference to a so-called base client. The name in the PC station is "WinCC Appl. Client 
Ref.".

● Central archive server (master server or non-redundant archive server). The name in the 
PC station is "WinCC CAS Appl.".

● Central archive server (standby server). The name in the PC station is "WinCC CAS Appl. 
(Stby.)".

● Connectivity station, or Open_PCS7_Station. The name in the PC station is "SPOSA Appl.".

The screenshot below shows an example of how the WinCC applications appear in the 
SIMATIC Manager:
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Note

If you use the PROFIBUS or Industrial Ethernet for communication between AS and OS, you 
should configure an appropriate connection. Only then can you utilize the advantages of the 
PC station, e.g. automatic setting of the unit name.

See also
How to Create an Operator Station (Page 1880)

Operator Station OS (Page 1879)

How to Create a Reference to a WinCC Application (Page 1876)

How to Load the Project on the Target Computer (Page 1875)

How to Set the Path to the Target Computer (Page 1868)

How to Create a WinCC Application (Page 1865)

12.3.2.2 How to Create a WinCC Application

Introduction
This section shows you how to create the WinCC application in a PC station.
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Requirements
● A PC station must have been created in the STEP 7 project.

Procedure
1. Open the hardware configuration for the PC station. To do so, click the PC station in the 

navigation window. Select the Open Object option on the pop-up menu.          
This will open the HW Config dialog.     

2. Click the object PC in the contents window.          
Open the hardware directory using the menu item View > Catalogue and navigate to the 
folder SIMATIC PC Station > HMI.
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3. Select the desired type of WinCC application and drag it onto a free slot of the PC object.

4. Save and close the hardware configuration.

Upon saving the newly created WinCC application, a subordinate OS is created. 

See also
How to Create an Operator Station (Page 1880)

Operator Station OS (Page 1879)

How to Load the Project on the Target Computer (Page 1875)

How to Select the Standby Computer (Page 1872)

How to Set the Path to the Target Computer (Page 1868)

WinCC Application (Page 1864)
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12.3.2.3 How to Set the Path to the Target Computer

Introduction
To be able to load the WinCC project, you must set the path to the target computer in the object 
properties. 

The following description refers to an OS in a WinCC application. For other OS types, the 
dialog structure might differ. 
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Requirements
● The OS is created as an object of a WinCC application.

Procedure
1. Select the WinCC project and open the "Object Properties" using the pop-up menu.

2. If you wish to configure an OS of type OS, select the Target OS and Standby OS 
tab.          
If you wish to configure an OS of type OS (Client), select the Target OS tab.          
The following figures refer to an OS of type OS created in a WinCC application.          
You can enter the path to the target computer directly as shared directory in the format \
\<Computer name>\<Enable>. Following the direct entry, click the Apply button. The WinCC 
project directory and the project file will be supplemented.         
Alternatively, you can open a selection dialog by clicking the Browse button.          
If you have entered the path directly, continue with step 4.
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3. Click the "Browse..." button. In the Select Target OS dialog, select the network drive and 
the folder you require. Click "Open".

4. Check the path to the target computer and then close the Properties dialog.
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Note

The function "Generating/Updating Archive Tags" may only be used jointly with PCS7. 
Additional information on this function may be found in the configuration manual Process 
Guidance System PCS7, Operator Station in the PCS7 documentation.

See also
How to Create an Operator Station (Page 1880)

Operator Station OS (Page 1879)

How to Load the Project on the Target Computer (Page 1875)

How to Select the Standby Computer (Page 1872)

How to Create a WinCC Application (Page 1865)
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12.3.2.4 How to Select the Standby Computer

Introduction
If you configure a redundant system, the master server and the standby server must be 
connected to each other. You set up this connection in the object properties for the master 
server.

Note

The WinCC project of the standby server is a copy of the WinCC project on the master server. 
Both projects must be identical to ensure correct data synchronization in Runtime. For this 
reason, direct configuration of the standby project is not possible in the SIMATIC Manager.

Requirements
● The master server must have been created as WinCC Application.

● The standby server must have been created as WinCC Application (Stby.).

Procedure
1. Select the master project and open the "Object Properties" using the shortcut menu.

2. Select the "Target OS and Standby OS Computer" tab.
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3. Select the standby OS and then close the dialog with "OK".
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4. Check the name of the assigned standby OS in the SIMATIC Manager: It must consist of 
the name of the master OS with the add in "_StBy".

5. Please note that the path to the target computer must also be set in the properties of the 
standby OS. In the properties of the standby OS, check the assignment to the master OS. 
The field for the master OS must display the name of the master OS.
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Note

In the master OS project, the redundancy is given default settings by the system. You have 
to perform different settings from this in the master OS project. You use the "Redundancy" 
editor for this purpose. It is advisable to make these settings on the creation system; no 
configuration is then necessary on the target computers.

See also
How to Create an Operator Station (Page 1880)

Operator Station OS (Page 1879)

How to Load the Project on the Target Computer (Page 1875)

How to Create a WinCC Application (Page 1865)

12.3.2.5 How to Load the Project on the Target Computer

Introduction
When you have completed configuration, you must load the WinCC project on the target 
computer. To do so, use the "Load Target System" function of SIMATIC Manager.

If you have built-up a redundant operator station, then Master server and Standby server will 
be loaded one after the other. The standby server is loaded together with a copy of the WinCC 
project of the master server. Both projects must be identical to ensure correct data 
synchronization in Runtime. For this reason, direct configuration of the standby project is not 
possible in the SIMATIC Manager.

Requirements
● The path to the target computer must have been set.

● The path must be set for Master and Standby for redundant system.

Procedure
1. Select the WinCC project in the WinCC application.

2. Start the "Target System > Load" function using the context menu.

3. In the dialog, select the scope of the load operation using the options Entire WinCC Project 
or Modifications.          
Under the following conditions, only the Entire WinCC Project option is available:          
- When the project is loaded onto the target system for the first time.          
- As a result of configurations in the WinCC project that lead to the loss of the online 
modification capability.          
- When the standby server has not yet loaded the WinCC project of the master server.
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Note

Do not open the project on the target computer until the load operation has been completed.

See also
How to Create a WinCC Application (Page 1865)

How to Create an Operator Station (Page 1880)

Operator Station OS (Page 1879)

How to Select the Standby Computer (Page 1872)

How to Set the Path to the Target Computer (Page 1868)

WinCC Application (Page 1864)

12.3.2.6 How to Create a Reference to a WinCC Application

Introduction
Using OS references offers the advantage of loading one WinCC project, the so called basis 
OS, onto several target systems. The objects "WinCC Appl. Ref." und "OS Ref." are used for 
configuration. 

Apart from the WinCC application and its OS, each additional destination system needs an 
application reference and an OS reference. The configuration is performed in several steps.

1. Creating the application reference.

2. Configuring the OS reference.

This section shows you how to create a reference to a WinCC application in a PC station. 

Requirements
● A PC station must have been created in the STEP 7 project.   

● The basis OS is of object type OS, of project type single-user or multi-user, and does not 
have a redundant partner.
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Procedure
1. Open the hardware configuration for the PC station. To do so, click the PC station in the 

navigation window. Select the Open Object option on the shortcut menu. This will open the 
HW Config dialog.     

2. Click the object PC in the contents window.          
Open the hardware directory using the menu item View > Catalogue and navigate to the 
folder SIMATIC PC Station > HMI.

Integration of WinCC in SIMATIC Manager
12.3 Managing WinCC Projects and Objects in the SIMATIC Manager

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1877



3. Select the application type "WinCC Appl. Ref." and drag the object onto a free slot of the 
PC in the PC object.

4. Save and close the hardware configuration.

5. The navigation window of SIMATIC Manager displays the just created object WinCC Appl. 
Ref(n) displayed.

In order to complete the configuration of an OS reference, the OS Ref. object must still be 
configured. Additional information may be found in the section Configuring a Reference to an 
OS. 

 

Note

You can use the same method to configure the reference to a WinCC application client. The 
corresponding project is then of the project type "Client".
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See also
How to Configure a Reference to an OS (Page 1885)

Managing WinCC Projects and Objects in the SIMATIC Manager (Page 1861)

12.3.3 Operator Station OS

12.3.3.1 Operator Station OS

Introduction
The OS represents a WinCC project in the SIMATIC Manager. Unlike the WinCC application, 
the OS is not integrated in the configuration of the target computer. This means that you have 
to carry out additional configuration steps on the target computer, e.g. setting the unit name.

You can create two different project types:

● Multi-user project

● Client project

The illustration below shows how the operator station appears in the SIMATIC Manager:

Note

Further information on the advantages of the WinCC application can be found under WinCC 
Application.
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See also
How to Configure a Reference to an OS (Page 1885)

How to Create an Operator Station (Page 1880)

How to Load the Project on the Target Computer (Page 1884)

How to Select the Standby Computer (Page 1872)

How to Create a WinCC Application (Page 1865)

WinCC Application (Page 1864)

How to Set the Path to the Target Computer (Page 1880)

12.3.3.2 How to Create an Operator Station

Introduction
This section shows you how to create an operator station in the SIMATIC Manager.

Requirement
● The STEP 7 project must have been opened using the SIMATIC Manager.

Procedure
1. Open the Navigation Window and select the project or library in which the OS should be 

set up.

2. Select the entry Insert New Object in the pop-up menu. You can now select either OS (for 
a server) or OS (client).

See also
How to Load the Project on the Target Computer (Page 1884)

How to Create a WinCC Application (Page 1865)

How to Set the Path to the Target Computer (Page 1880)

12.3.3.3 How to Set the Path to the Target Computer

Introduction
To be able to load the WinCC project, you must set the path to the target computer in the object 
properties. 
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Requirements
● The OS is inserted as object of a WinCC application or as OS (client) directly in the S7 

project.

Procedure
1. Select the OS and open the "Object Properties" using the shortcut menu.

2. If you wish to configure an OS in a WinCC application, select the Target OS and Standby 
OS tab.          
If you wish to configure an OS of type OS (Client), select the Target OS tab.          
The following illustrations refer to an OS in a WinCC application.          
You can enter the path to the target computer directly as shared directory in the format \
\<Computer name>\<Enable>. Following the direct entry, click the Apply button. The WinCC 
project directory and the project file will be supplemented.         
Alternatively, you can open a selection dialog by clicking the Browse button.          
If you have entered the path directly, continue with step 4.
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3. To select a path via a selection dialog, click the "Browse..." button. In the Select Target OS 
dialog, select the network drive and the folder you require. Click "Open".

4. Check the path to the target computer and then close the Properties dialog.
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Note

Enter the computer name and the symbolic computer name and not the IP address of the 
computer.

Note

The function "Generating/Updating Archive Tags" may only be used jointly with PCS7. 
Additional information on this function may be found in the configuration manual Process 
Guidance System PCS7, Operator Station in the PCS7 documentation.

See also
How to Create a WinCC Application (Page 1865)

How to Load the Project on the Target Computer (Page 1884)

How to Create an Operator Station (Page 1880)
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12.3.3.4 How to Load the Project on the Target Computer

Introduction     
When you have completed configuration, you must load the WinCC project on the target 
computer. To do so, use the "Load Target System" function of SIMATIC Manager.

Persistence in CS with integrated WinCC projects
Changes to the control properties in Runtime are not persistently accepted in CS with PCS 7 
projects or TIA projects. When you completely load the ES to the OS, the changed settings 
on the OS will be overwritten.         
Configure the properties of the controls on the ES.

Note

If STEP 7 and the WinCC project are on the operator station, the WinCC project does not 
have to be loaded.

Requirements
● The path to the target computer must have been set.

Procedure
1. Select the OS.

2. Start the "Target System > Load" function using the shortcut menu.

3. In the dialog, select the scope of the load operation using the options Entire WinCC Project 
or Modifications.          
         
You have the Complete WinCC Project option under the following conditions:         
- When the project is loaded for the first time on the target system.         
- Through configurations in the WinCC Project that lead to the load online changes capacity 
being lost.

Open the project on the target computer only after the loading is complete. 

See also
How to Create an Operator Station (Page 1880)

How to Select the Standby Computer (Page 1872)

How to Create a WinCC Application (Page 1865)

How to Set the Path to the Target Computer (Page 1880)
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12.3.3.5 How to Configure a Reference to an OS

Introduction
Using OS references offers the advantage of loading one WinCC project, the so called basis 
OS, onto several target systems. The objects "WinCC Appl. Ref." und "OS Ref." are used for 
configuration. 

Apart from the WinCC application and its OS, each additional target system needs an 
application reference and an OS reference. The configuration is performed in several steps. 

1. Creating the application reference.

2. Configuring the OS reference. You must create the OS reference in STEP 7 sub-project of 
basis OS.

This section shows how to configure an OS reference.          
The "WinCC Appl. Ref." application reference to this basis OS was previously created. 
Additional information may be found in the section Creating a Reference to a WinCC 
Application.

After processing, you must transfer the project to the target system of basis OS along with all 
the references. Select the "Download to CPU" function for the selected basis OS or OS 
reference.  

Requirements
● A PC station must have been created in the STEP 7 project.  

● The basis OS is of object type OS, of project type single-user or multi-user, and does not 
have a redundant partner.

● The "WinCC Appl. Ref." application reference to this basis OS was previously created.  

Procedure
1. In the navigation window of SIMATIC Manager, navigate to the desired object WinCC Appl. 

Ref(n). Select the subordinate object OS Ref.  

2. Select Object properties from the shortcut menu of the object. The Properties - OS 
Reference dialog opens.

3. Change over to the tab OS Ref: Options for OS Reference Objects.

4. Select the basis OS for this reference object in the basis OS field. The name of the 
associated basis OS is applied to the name of the OS reference object in the format 
<name_basic_os>_Ref(n).           
Enter the associated OS path in the field Path to Target OS Computer. Alternatively, you 
can open a selection dialog by clicking the "..." button and select the path in this dialog.

5. Close the dialog with the "OK" button.

The project of the basis OS must now be transferred to the associated OS by using the 
Download to CPU function.

When you make changes in the WinCC project of the basis OS you need to transfer the same 
to the target system of basis OS and to each target system of references. 
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Note

Multi-projects have the following restriction:         
Do not move any basis OS from a STEP 7 sub-project to another STEP 7 sub-project. While 
moving, you will lose all associated OS reference stations their reference to basis OS.

See also
How to Create a Reference to a WinCC Application (Page 1876)

How to Load the Project on the Target Computer (Page 1875)

Managing WinCC Projects and Objects in the SIMATIC Manager (Page 1861)

12.3.4 How to Import a WinCC Project with the SIMATIC Manager

Introduction
You can use the SIMATIC Manager to import a previously independent WinCC project into a 
STEP 7 project. 

Requirements
● The WinCC project to be imported is closed.    

● On the computer used for the import into the STEP 7 project, there are no open WinCC 
projects. 

Procedure
1. In the SIMATIC Manager, open the STEP 7 project in which to import the WinCC project. 

2. In the Tools menu, select Import OS .... The Import OS dialog opens. 

3. . 3 Click the ... button to select the path of the WinCC project you want to import in the Open 
selection dialog.  The selected path is shown in the field OS to import.            
         
If the name of the WinCC project has more than 24 characters without file name extension 
or if it is not unique within the STEP 7 project, a message appears. In this case, you can 
specify another name.  

4. Start the import by clicking the Import OS button.          
When the import has been successfully completed, a message is displayed.         
Exit the dialog by clicking the Exit button.          
         
In errors occurred during the import, an error message is given and the respective errors 
are written into the log file import.log. The log file is stored in the WinCCOM folder under 
the project directory of the imported WinCC project.        
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During the import, a PC station with subordinate WinCC application is created for the WinCC 
project to be imported in the SIMATIC Manager. The imported WinCC project is created as 
subordinate OS object with the name specified for the import. 

In the imported WinCC project, the following actions are performed: 

● Existing packages are deleted. 

● The computer name is set. 

● An activated redundancy is deactivated.  

See also
How to Create an Operator Station (Page 1880)

How to Load the Project on the Target Computer (Page 1875)

How to Select the Standby Computer (Page 1872)

How to Create a WinCC Application (Page 1865)

How to Set the Path to the Target Computer (Page 1880)

12.3.5 Handling WinCC Projects Between STEP 7 Projects and Libraries

Introduction
The following actions can be executed on WinCC projects using the SIMATIC Managers:

● Copying or moving a WinCC project within a STEP 7 project

● Copying or moving a WinCC project between STEP 7 projects

● Copying or moving a WinCC project from a STEP 7 project to a library

● Copying or moving a WinCC project from a library to a STEP 7 project

● Renaming a WinCC project

● Deleting a WinCC project

Requirements
● A WinCC project must have been created in the STEP 7 project.

Copying
1. Open the STEP 7 project into which the WinCC project is to be copied, using the "File > 

Open" option.

2. Select the WinCC project you want to copy and drag it onto the STEP 7 project selected 
as the destination.
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Moving
1. Open the STEP 7 project into which the WinCC project is to be moved, using the "File > 

Open" option.

2. Select the WinCC project you want to move and drag it onto the STEP 7 project selected 
as the destination, holding down the Shift key as you do so.

Renaming
1. Select the WinCC project.

2. Select the "Rename" option on the pop-up menu and enter the new name.

Deleting
1. Select the WinCC project you want to delete.

2. Select the "Delete" option on the pop-up menu and acknowledge the warning with "Yes".

Note

In the same way, a WinCC project can be copied within a STEP 7 project or between a 
STEP 7 project and a library. If the WinCC project is open, Rename, Move and Delete are 
not executed.

12.3.6 Accepting Language Settings from SIMATIC Managers

Introduction
If a WinCC project is opened in SIMATIC Manager, WinCC Explorer will accept the current 
language setting from SIMATIC Manager. The language settings of SIMATIC Manager will 
only take effect on the language setting of the CS (Configuration System).
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Behavior
There are three scenarios during opening of a WinCC project:

Scenario Behavior

The current language of 
SIMATIC Manager was also 
installed in WinCC.

If WinCC Explorer or one of the editors (Graphics Designer, Load Online 
Changes or similar) is started, the language set in SIMATIC Manager is 
loaded. This also applies if the project is opened by using ProAgent, for 
example.

The current language of 
SIMATIC Manager was not 
installed in WinCC.

If WinCC Explorer or one of the editors (Graphics Designer, Load Online 
Changes or similar) is started, the language stored as default language 
is loaded. This also applies if the project is opened by using ProAgent, 
for example.

The WinCC project was 
most recently configured in 
a language not installed in 
SIMATIC Manager.

If WinCC Explorer or one of the editors (Graphics Designer, Load Online 
Changes or similar) is started, its language setting is retained. In this 
case the current language setting of SIMATIC Manager has no effect on 
the language setting of WinCC Explorers or the respective editor.

You can change the language setting in the open WinCC Explorer at any time. When this editor 
is closed and restarted, the current language setting of SIMATIC Manager is loaded again.

 

See also
How to Open the WinCC Project (Page 1897)

12.3.7 Working With WinCC Objects

12.3.7.1 Working With WinCC Objects

Introduction
Apart from the WinCC project, the associated WinCC objects are also displayed in the 
SIMATIC Manager. These objects are pictures and report templates of the project.

If you have created pictures and report templates using the Graphics and Report Designer, 
they are not automatically visible in the SIMATIC Manager. They must be imported first.

You can also create pictures and report templates using the SIMATIC Manager. These objects 
are empty initially and can be processed further using the Graphics Designer and Report 
Designer.

The SIMATIC Manager also provides functions for handling these objects, e.g. copy, move, 
and delete.

In addition, the SIMATIC Manager provides functions for managing model solutions of WinCC 
objects in libraries.

 

The illustration below shows how the WinCC objects appear in the SIMATIC Manager.
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See also
How to Import WinCC Objects (Page 1892)

How to Handle WinCC Objects (Page 1891)

How to Create WinCC Objects (Page 1890)

12.3.7.2 How to Create WinCC Objects

Introduction
In the SIMATIC Manager, you can create the WinCC objects pictures and report templates 
without having to open the WinCC project. These WinCC objects have no content initially. You 
can, however, process them further using Graphics Designer and Report Designer.

Requirement
● A WinCC application or OS must have been created in the SIMATIC Manager.

Procedure
1. Select the WinCC project in the WinCC application or the OS.

2. Select the entry Insert New Object in the pop-up menu. You can now create either a picture 
or a report template.

See also
How to Import WinCC Objects (Page 1892)

How to Handle WinCC Objects (Page 1891)

Working With WinCC Objects (Page 1889)
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12.3.7.3 How to Handle WinCC Objects

Introduction
You can use the SIMATIC Manager to copy, move, rename, and delete pictures and report 
templates. It is possible to copy and move objects between WinCC projects which have been 
created either in the same STEP 7 project or in different STEP 7 projects or libraries.

Configured dynamics are also copied when objects are copied and moved to other WinCC 
projects. The process connection is lost since the used tags do not exist in the target project. 
You can compile a list of nonexistent tags using the CrossReference Editor. This also allows 
process connections to be linked. 

Copying and moving is then mainly used if you want to duplicate certain system sections of a 
template project. You copy the pictures which do not contain any dynamics or contain a 
dynamic prepared with prototypes, to the target project and perform process connection there.

Note

The names of pictures and report templates must be unique within a WinCC project.

Copy
1. Select the WinCC object.

2. Drag the object onto the WinCC project you selected as the destination. If the object is 
copied between two WinCC projects in different STEP 7 projects and an object with the 
same name already exists, the existing object is only overwritten after confirmation.

Moving
1. Select the WinCC object.

2. Drag the object onto the WinCC project you selected as the destination, holding down the 
Shift key as you do so. If the object is moved between two WinCC projects in different STEP 
7 projects and an object with the same name already exists, the existing object is only 
overwritten after confirmation.

Rename
1. Select the WinCC object.

2. Select the "Rename" option on the pop-up menu and enter the new name.
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Delete
1. Select the WinCC object.

2. Select the "Delete" option on the pop-up menu and acknowledge the warning with "Yes".

Note

If the object is opened by Graphics Designer or Report Designer, Rename, Move, and 
Delete are not possible.         

If you create WinCC objects in SIMATIC Manager, you may not rename or delete these 
in WinCC Explorer. This also applies to WinCC objects created in WinCC and imported 
into SIMATIC Manager by using the "Import WinCC objects" function. This import changes 
the WinCC object into a TIA object.         
 

If you copy such a TIA object with Graphics Designer or Report Designer, the copy is 
created as a WinCC object. You may rename or copy this copy as a WinCC object.

Note

If you rename a screen in WinCC Explorer, only use a picture name one time. The software 
does not check whether the name already exists. Duplicate pictures names can lead to 
conflicts during access via VBA or during dynamization.

See also
How to Import WinCC Objects (Page 1892)

How to Create WinCC Objects (Page 1890)

Working With WinCC Objects (Page 1889)

12.3.7.4 How to Import WinCC Objects

Introduction
You can create pictures and report templates using the Graphics Designer and Report 
Designer editors. However, these WinCC objects are not displayed automatically in the 
SIMATIC Manager. You can update the view in the SIMATIC Manager using the Import WinCC 
Objects function.

Requirement
● Pictures and report templates must have been created using the associated editors.

Procedure
1. Select the WinCC project in the WinCC application or the OS.

2. Select the Import WinCC Objects item in the pop-up menu. The pictures and report 
templates are displayed in the SIMATIC Manager.

Integration of WinCC in SIMATIC Manager
12.3 Managing WinCC Projects and Objects in the SIMATIC Manager

MDM - WinCC: Working with WinCC
1892 System Manual, 11/2008,  



See also
How to Handle WinCC Objects (Page 1891)

How to Create WinCC Objects (Page 1890)

Working With WinCC Objects (Page 1889)

12.3.7.5 Setting Up and Monitoring of Server Assignment

Introduction
Using the SIMATIC Manager, you can assign various OS servers to a selected OS. The 
selected OS may be an OS client, an OS server or a central archive server.

If you have selected an OS object, the "Assignment OS Server for <OS> dialog" displays a list 
of servers available in this project. An existing archive server is also listed.          
If the selected OS project contains packages of servers unknown to the S7 project and the 
multi-project, respectively, the list will be expanded by entries of these servers not found. The 
"OS Information" column contains the entry "Unknown" in these cases.

The OS Server Assignment for <OS> Dialog
Open the "OS Server Assignment for <OS>" dialog by selecting the OS in SIMATIC Manager. 
Select the "Assign OS Server..." entry in the pop-up menu.

Alternatively, you may open the dialog in SIMATIC Manager in the Tools menu by using the 
"OS > Assign OS Server..." entry.
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The dialog will display all OS servers accessible and belonging to the S7 project and the multi-
project, respectively. The list might be amended by entries containing the OS information 
"Unknown". The following OS objects are not displayed:

● Selected OS for which a dialog was opened

● Standby OS server

● Clients

● OS of single user project

● OS References

● Client References

An entry may contain the following information:

● Check box to setup or delete an assignment to a selected OS project. Displays upon 
opening of the dialog whether or not an assignment exists.

● OS information consisting of the name of the S7 project and the description of the OS object.

● Symbolic computer name

In order to set up an assignment, select the check box of the OS object and finish the dialog 
with OK. Thus, a package will be imported into the OS for all newly selected OS objects. 

In order to delete an existing assignment, clear the check box of the OS object and finish the 
dialog with OK. Thus, the corresponding package will be deleted from the OS for all newly 
deselected OS objects.

Significance of Colors in List Entries
Using the color of an entry, you obtain information on each OS object.

Type Color Additional information Significance of information

1 black Check box not selected Assignment to server may be established.          
Server has exported package.

2 black Check box selected Assignment to server is established.          
OS has loaded package.

3 gray No check box Assignment to server cannot be 
established.         
Reason: Server does not have exported package.
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Type Color Additional information Significance of information

4 red No check ox          
OS information and symbolic 
computer name are entered

Assignment to server cannot be 
established.         
Reason: Exported package of server does not 
have unique name.          
There are several reasons for this:
● The project already contains a server with an 

identical symbolic computer name.
● The OS object contains an imported package 

with an identical symbolic computer name.
5 red Check box selected          

OS information contains the 
entry "Unknown" and the 
symbolic computer name has 
been entered

The server named in the imported package of the 
selected OS object cannot be found in the S7 
project and multi-project, respectively.         
Reason: OS server no longer belongs to the multi-
project, or package has been deleted.         
In this case you should uncheck the checkbox for 
this entry and exit the "OS Server Assignment for 
<OS>" dialog by clicking OK. Thus, you delete the 
imported package which could not be assigned.

 

Note

If you execute one of the following actions in an S7 project, you should subsequently check 
the OS server assignment in the "OS Server Assignment for <OS>" dialog:
● Dearchiving an S7 project with "Dearchiving"
● Storing an S7 project with "Save As..."
● Removing an S7 project with "Delete for Editing"
● Picking up an S7 project with "Picking up after Editing"
● Copying an S7 project with Windows Explorer
● Moving an S7 project with Windows Explorer

If red entries of Type 5 occur in the list during the "OS Server Assignment for <OS>" dialog, 
proceed as follows:
1. Regenerate all packages by starting the "Compiling Multiple OS" wizard Compilation of 

minimum scope suffices. Therefore, select the check box Changes Only and deactivate 
other options, such as Tags, Messages and SFC.          
If the red entry is concerned with the central archive server, you must additionally trigger 
the generation of server data.

2. For all OS objects, open the "OS Server Assignment for <OS>" dialog and check for 
possible "Unknown" error entries.

3. In these cases, make note of the symbolic computer name.
4. Delete the "Unknown" entries by deactivating the respective checkboxes and by finishing 

the dialog with OK.
5. Open the dialog and search for the symbolic computer name noted in Item 3. Assign these 

computers to the selected OS objects by selecting the respective check box and by 
finishing the dialog with OK.
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12.3.7.6 How to Create Model Solutions of WinCC Projects or WinCC Objects

Introduction
Using the SIMATIC Manager, complete WinCC projects can be copied or moved to a library. 
These WinCC projects can then be edited n the library. The model solutions thus created serve 
as templates for several uses in WinCC projects. The copying or moving processes to or from 
a library behave in the same way as between two Step 7 projects.

Individual screens and report templates can also be copied or moved from a WinCC project 
to an OS within a library and used as a model template.

Requirement
● Copying and moving individual screens and report templates:          

An OS is set up in the library as destination.

● Copying or moving WinCC projects:         
The source project is not activated.

Note

When copying or moving WinCC projects, screens and report templates to and from 
libraries, name conflicts may occur. This means that the library or STEP 7 project already 
contains a WinCC object with this name. To prevent the target object being overwritten, 
a new name is assigned for the inserted object. The name of the object is assigned a 
consecutive number meaning, for example, "Picture1" becomes "Picture1(1)".

Copying a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.

2. Open the STEP 7 project to be used as the source using the menu items "File > Open".

3. Open the library in which the model solution should be copied using menu items "File > 
Open".

4. Select the OS, screen or report template to be copied in the STEP 7 project. Drag the object 
per Drag & Drop onto the target library or OS in the library.

Moving a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.

2. Open the STEP 7 project to be used as the source using the menu items "File > Open".

3. Open the library in which the model solution should be copied using menu items "File > 
Open".

4. Select the OS, screen or report template to be copied in the STEP 7 project. Drag the object 
per Drag & Drop, with the Shift key pressed, onto the target library or OS in the library.

Integration of WinCC in SIMATIC Manager
12.3 Managing WinCC Projects and Objects in the SIMATIC Manager

MDM - WinCC: Working with WinCC
1896 System Manual, 11/2008,  



Copying a WinCC Project or WinCC Object from a Library
1. Open the SIMATIC Manager.

2. Open the library from which the model solution should be copied using menu items "File > 
Open".

3. Open the STEP 7 project to which the model solution should be copied using menu items 
"File > Open".

4. Select the OS, screen or report template to be copied in the library. Drag the object per 
Drag & Drop onto the S7 project selected as target or OS selected as target.

Moving a WinCC Project or WinCC Object from a Library
1. Open the SIMATIC Manager.

2. Open the library from which the model solution should be copied using menu items "File > 
Open".

3. Open the STEP 7 project to which the model solution should be copied using menu items 
"File > Open".

4. Select the OS, screen or report template to be copied in the library. Drag the object per 
Drag & Drop onto the S7 project selected as target or OS selected as target.

Renaming a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.

2. Select the OS, screen or report template to be renamed.

3. Select the "Rename" option on the pop-up menu and enter the new name.

Deleting a WinCC Project or WinCC Object in a Library
1. Open the SIMATIC Manager.

2. Select the OS, screen or report template to be deleted.

3. Select the "Delete" option on the pop-up menu and acknowledge the warning with "Yes".

12.3.8 How to Open the WinCC Project

Introduction
You can start WinCC directly from the SIMATIC Manager and then open the WinCC project.

Integration of WinCC in SIMATIC Manager
12.3 Managing WinCC Projects and Objects in the SIMATIC Manager

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1897



Requirement
● The WinCC project must have been created in the SIMATIC Manager.

Procedure
1. Select the WinCC project in the WinCC application or the OS.

2. Select the "Open Object" option on the context menu.

Note

Starting with version V6.2, WinCC evaluates the project-related access protection that is used 
to protect STEP 7 or PCS7 projects.

Independent of access protection:         
WinCC Projects that are integrated in a STEP 7/PCS7 project cannot be opened using an 
ES where only WinCC has been installed. For that you also need STEP 7 or NCM PC Edition 
of SIMATIC NET CD on the ES.

If project-related access protection has been activated for WinCC project, then you must also 
enter the STEP 7 project password while opening the project.

See also
How to Create a WinCC Application (Page 1865)

WinCC Application (Page 1864)

12.3.9 Starting a Simulation in STEP 7

Introduction
The "Start OS simulation" function creates a temporary copy of the selected project on the 
local computer. This copy of the project is then started in runtime.

The temporary copy is always created locally. In this case, a new directory "OS_Simulation" 
is created in the existing directory structure parallel to the STEP 7 project already open.

If the selected project is on a different computer, the temporary copy is still created on the local 
computer. In this case, the "OS_Simulation" directory is set up in the STEP 7 installation path 
under "S7Proj".

This function is required in order to test the changes made in the WinCC project or STEP 7 
project.
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Note

With connections configured on both sides, it is important to ensure that the connections 
between the local computer and the AS as well as between the target computer and the AS 
have the same name. If this is not the case, no connection will be set up between the local 
computer and the AS.

During simulation, communication to other computers is restricted. The following functions, for 
example, are not available:

● Server-Server communication

● Client-Server communication

● Redundancy

● Communication with a central archive server

Procedure
1. Select the WinCC project in the WinCC application or the OS.

2. Select the "Start OS Simulation" option from the context menu.

Note

If a WinCC project is already in runtime, the "Start OS simulation" cannot be executed. A 
corresponding message is issued.

12.4 Transferring Tags, Texts and Reports to WinCC

12.4.1 Transferring Tags, Texts and Reports to WinCC

Introduction
This chapter explains the Compile OS function, tells you which configuration data is affected 
by the transfer operation, and how this data is stored in the WinCC project. It familiarizes you 
with the dialogs and procedures associated with the transfer operation.

You must transfer the AS configuration data relevant for operator control and monitoring, to 
the data of WinCC so that it is available to you during WinCC configuration and in Runtime. 
To do so, you use the Compile OS function.

During the transfer operation, process tags are stored in the tag management system, user 
texts are stored in the text library, and messages are stored in the alarm logging system of the 
WinCC project.
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See also
Compilation Log (Page 1910)

How to Compile Changes (Page 1906)

How to Compile the Entire OS (Page 1902)

Compiling OS (Page 1900)

12.4.2 Compiling OS

12.4.2.1 Compiling OS

Introduction
You use the "Compile OS" function to create the structures and data in the WinCC project that 
are required for operator control and monitoring.

Note
You may compile one OS or several OS. If you wish to compile one OS, use the "Compile OS" 
wizard. If you wish to compile multiple OS, use the "Compile multiple OSs" wizard.

Both wizards differ only by the number of OS to be compiled. The statements of the wizard 
"Compile OS" therefore apply equally to the wizard "Compile multiple OSs".
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Scope of Compilation
The "Compile OS" function has three compile modes:

● The "Entire OS with memory reset" mode is the default mode. All AS data in the operator 
station is erased and the data for the S7 programs selected for compilation is transferred 
again.

● The "Entire OS" mode is appropriate if with several assigned S7 programs you have not 
selected all for compilation. This mode ensures that the already transferred data of the S7 
programs not selected for compilation is retained in the operator station.

● The "Changes" mode should be used if you have only made minor changes in the S7 
program. If you make changes to a structure tag where one structure element is used as 
message tag, then online changes cannot be loaded for messages.

Functions
The following functions are executed with "Compile OS":

● Creation of the communication driver SIMATIC S7 PROTOCOL SUITE

● Creation of the WinCC units, e.g. Industrial Ethernet, PROFIBUS and so on

● Creation of a logical connection for each S7 program

● Creation of raw data tags for the message system and archive system

● Creation of structure types for the component types to be transferred in WinCC and for the 
global data blocks

● Creation of the process tags in the tag management system

● Generation of the messages

● Transfer of the message and user texts

When Should Compilation Be Performed?
Compilation of OS should be performed:

● before WinCC Runtime is started for the first time

● after new component instances are added or component names are changed

● after operator texts and unit texts are changed

● after the operator control and monitoring attributes of an instance are changed

● after message and user texts are changed

Note

Additional information can be found in the STEP 7 help and in the "Compile OS" Wizard 
help.
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See also
Compilation Log (Page 1910)

How to Compile Changes (Page 1906)

How to Compile the Entire OS (Page 1902)

12.4.2.2 How to Compile the Entire OS

Introduction
You compile the configuration data using the Compile OS wizard. Compilation of the entire 
OS can be performed in two different compilation modes:

● The "Entire OS with memory reset" mode is the default mode. All AS data in the operator 
station is erased and the data for the S7 programs selected for compilation is transferred 
again.

● The "Entire OS" mode is appropriate if with several assigned S7 programs you have not 
selected all for compilation. This mode ensures that the already transferred data of the S7 
programs not selected for compilation is retained in the operator station.

Starting the "Compile OS" Wizard
You can start the "Compile OS" wizard in SIMATIC Manager in different ways.

● If you wish to compile the configuration data of a certain operator station, first select the 
OS and start the assistant by using the menu item "Edit" > "Compile". Alternatively, you 
can also select the "Compile" option in the pop-up menu of the OS.

● If you wish to compile the configuration data of several or all operator stations, start the 
wizard from the menu item "Options > "'Compile Multiple OSs' wizard" > "Start...".

Note

Please note that compiling the entire OS will lead to a loss of online loadability.

Further information on "Compile OS" can be found in the "STEP 7 Help" and "Compile 
OS" wizard Help.
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Requirements
● The WinCC project must have been created.

Procedure
The compilation of a particular operator station is described in this procedure. The compilation 
of several operator stations is performed in the same way.

1. Select the OS, and then select "Compile" in the pop-up menu, or select the menu item "Edit" 
> "Compile".

2. Select the appropriate S7 program in the list of S7 programs (left) and then drag the S7 
program (holding down the left-hand mouse button) onto the desired operator station in the 
list of operator stations (right). Click "Next".

 This page is only displayed if there is more than one operator station and more than one S7 
program in your project. Assignment is otherwise performed automatically.
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1. Using the check box, select the S7 programs that you want to transfer. Data is only 
transferred for the selected S7 programs.

2. Select which network connections are to be used. When you select the operator station in 
the left-hand field, the associated S7 programs together with the configured network 
connections are listed in the right-hand field. To change the network connection, select the 
S7 program and press the "Connection..." button. Select the network connection you 
require. Press "OK" and then "Next".
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3. Select the compilation mode "Entire OS". If you want to delete all the AS data in the operator 
station, select "With memory reset". Click "Next".

4. Check the compilation options and click Compile.

5. When the compilation procedure has been completed, a message may appear informing 
you of errors and warnings that have occurred. If this is the case, check the compilation 
report.

Note

You should not work on the project during compilation.

 

You may use the option Archive Tags only jointly with PCS7. Additional information on this 
function may be found in the configuration manual Process Guidance System PCS7, 
Operator Station in the PCS7 documentation.

See also
Compilation Log (Page 1910)

How to Compile Changes (Page 1906)

Compiling OS (Page 1900)
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12.4.2.3 How to Compile Changes

Introduction
You should compile changes if you have made only minor changes to the S7 programs. In 
contrast to compiling the entire OS, compiling the changes has the advantage of maintaining 
the online loadability.

Starting the "Compile OS" Wizard
You can start the "Compile OS" wizard in SIMATIC Manager in different ways.

● If you wish to compile the configuration data of a certain operator station, first select the 
OS and start the assistant by using the menu item "Edit" > "Compile". Alternatively, you 
can also select the "Compile" option in the pop-up menu of the OS.

● If you wish to compile the configuration data of several or all operator stations, start the 
wizard from the menu item "Options > "'Compile Multiple OSs' wizard" > "Start...".

Further information on "Compile OS" can be found in the "STEP 7 Help" and "Compile OS" 
wizard Help.

Requirements
● The operator station must have been configured.

● Operator control and monitoring data which has been changed must exist in the AS 
configuration.

● An entire compilation or an implicit compilation (with selection of connection) must have 
been performed for the first time.

● If you make changes to a structure tag where one structure element is used as message 
tag, then online changes cannot be loaded for messages.
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Procedure
The compilation of a particular operator station is described in this procedure. The compilation 
of several operator stations is performed in the same way.

1. Select the OS, and then select "Compile" in the pop-up menu, or select the menu item "Edit" 
> "Compile".

2. If you have no changes, click Next.         
If you have changes, select the appropriate S7 program in the list of S7 programs (left) and 
then drag the S7 program (holding down the left-hand mouse button) onto the desired 
operator station in the list of operator stations (right). Click "Next".

This page is only displayed if there is more than one operator station and more than one 
S7 program in your project. Assignment is otherwise performed automatically.

3. If you have no changes, click "Connection".
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4. If you have changes, enable the check boxes to select the S7 programs that you want to 
transfer. Data is only transferred for the selected S7 programs. Click "Connection".

5. If you have no changes, click "Cancel".
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6. If you have changes, select the network connections that you want to use. When you select 
the operator station in the left-hand field, the associated S7 programs together with the 
configured network connections are listed in the right-hand field. To change the network 
connection, select the S7 program and press the "Connection..." button. Select the network 
connection you require. Press "OK" and then "Next".

7. Select the compilation mode "Changes". Click "Next".
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8. Check the compilation options and click Compile.

9. When the compilation procedure has been completed, a message may appear informing 
you of errors that have occurred. If this is the case, check the compilation report.

Note

You should not work on the project during compilation.

 

You may use the option Archive Tags only jointly with PCS7. Additional information on this 
function may be found in the configuration manual Process Guidance System PCS7, 
Operator Station in the PCS7 documentation.

See also
Compilation Log (Page 1910)

How to Compile the Entire OS (Page 1902)

Compiling OS (Page 1900)

12.4.2.4 Compilation Log

Introduction
During compilation, logs are created that provide information about:

● AS-OS connections

● Tag names

● Assignment of messages

● Errors and warnings that occurred during compilation

Compilation Log
The compilation log contains entries on all objects. 

When you have compiled an OS using the Compile OS wizard, subsequently open the 
compilation log using the menu item Options > OS > Display compilation log... directly in 
SIMATIC Manager. Alternatively, you may also open the compilation log transfer.log in the 
WinCC project path with a test editor.

When you have compiled multiple OS with the wizard Compile Multiple OSs, open the 
compilation log afterwards by clicking the menu item Options >  'Compile Multiple OSs' wizard 
> Open Log... directly in SIMATIC Manager. Alternatively, you may also open the compilation 
log transfer.log in the STEP7 project path with a test editor.
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See also
How to Compile Changes (Page 1906)

How to Compile the Entire OS (Page 1902)

Compiling OS (Page 1900)

12.4.3 How to Display Transferred Tags

Introduction
The result of the "Compile OS" function can be checked in the WinCC project.

Procedure
1. Open the Tag Management and then navigate to the configured WinCC unit.

2. Open the logical connection that it contains. All compiled process tags are now displayed.
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Note

In the Tag Management, the compiled tags can be recognized by the structure of their name. 
Their name is made up of the S7 program followed by "/".

 

Compiled tags are write-protected and cannot be deleted from the Tag Management. This is 
only possible with the Compile "OS wizard". 

In the dialog box Which S7 Programs Do You Want to Transfer with Which Network 
Connections? you must disable the S7 programs whose tags are to be deleted in WinCC. To 
do this, remove the check mark in front of the program name. Choose the "Entire OS With 
Reset" option for the compilation mode. During the compilation operation that follows, al the 
tags, connections and messages not created in WinCC are deleted. 

See also
Displaying Transferred Messages and Texts (Page 1912)

Compilation Log (Page 1910)

How to Compile Changes (Page 1906)

How to Compile the Entire OS (Page 1902)

Compiling OS (Page 1900)

12.4.4 Displaying Transferred Messages and Texts

Introduction
The result of the "Compile OS" function can be checked in WinCC.

Blocks of user and message text are stored in the text library, and messages are stored in 
Alarm Logging.

Integration of WinCC in SIMATIC Manager
12.4 Transferring Tags, Texts and Reports to WinCC

MDM - WinCC: Working with WinCC
1912 System Manual, 11/2008,  



User and Message Texts
1. Select the "Text Library" editor in the WinCC Explorer.

2. Select the "Open" option on the context menu.

Alarms
1. Select the "Alarm Logging" editor in WinCC Explorer.

2. Select the "Open" option on the context menu. The transferred messages can be 
recognized by the 10-digit number.
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See also
How to Display Transferred Tags (Page 1911)

Compilation Log (Page 1910)

How to Compile Changes (Page 1906)

How to Compile the Entire OS (Page 1902)

Compiling OS (Page 1900)

12.4.5 How to Configure Messages in STEP7

Introduction
To ensure a consistent message configuration, two points must be observed when creating 
the message texts in STEP7 in order to guarantee the correct response in WinCC. 

Assigning the Message Texts According to "Compile OS"
The following example a configuration of the message texts in the STEP7 message editor. 
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The standard "Message text" and "Info text" texts as well as the additional texts are assigned 
to the following user text blocks of a single message after "Compile OS" in Alarm Logging from 
WinCC. 

Note

"Compile OS" enables messages to be created in Alarm Logging whose message class and 
message type are invalid in WinCC. Invalid messages are prevented by starting the OS 
project editor.
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Creating a Group Message According to "Compile OS"
If an additional text 2 is entered in the STEP7 message editor, a user defined group message 
is created using "Compile OS" in the Alarm Logging.
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12.5 Compiling and Loading Objects

Introduction
Objects can be compiled and loaded in just one step. The SIMATIC Manager provides the 
Compile and Load Object dialog box for this. Further information on this topic can be found in 
STEP 7 Help and Compile and Load Objects Help.

Objects table
In this area you specify which objects are to be compiled and loaded into the target system.
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Objects column
Displays the objects.

Status column
Displays the status of the object.

There are the following statuses:

● undetermined: The status could not be determined.

● modified: The object has been modified. The object must be recompiled and loaded onto 
the system.

● compiled: The object has already been compiled but still needs to be loaded onto the 
system.

● loaded: The object has already been compiled and loaded onto the system already.

Operating status column
Displays the operating status of the system. 

Compile/Load column
Here you define the objects that have to be compiled and loaded onto the system. Only the 
check boxes having a white background can be enabled or disabled.          
If this check box is selected, the column Load in the Table Objects is hidden. 

Settings for Compile/Load

Edit button
The Edit button opens the Settings: Compile OS dialog. You ca use this dialog box to modify 
the settings for compiling and loading the selected object. 

You will find more information about compilation at Compile OS and about loading at Loading 
the project onto the destination computer. 

Compile Only check box
If this check box is selected, the column Load in the Table Objects is hidden. The objects are 
compiled only.

Do Not Load upon Compilation Error check box
If this check box has been selected, the object will not be loaded onto the system when a 
compilation error occurs.
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Displaying Log

Single Object button
Opens the log for a specific object. 

Overall button
Opens the Overall Log. The overall log contains entries about all objects.

Start button
Start the compile and load operation.

Note

You should not work on the project during compilation and loading.

See also
Compiling OS (Page 1900)

How to Load the Project on the Target Computer (Page 1884)

12.6 Selection of STEP 7 Symbols

12.6.1 Selection of STEP 7 Symbols

Introduction
During WinCC configuration, you connect WinCC objects, e.g. I/O fields or archive tags, to 
tags which are used in Runtime to supply the objects with the current process values.

For process linking, you have the option to choose between two groups of tags: WinCC tags 
and STEP 7 symbols.

WinCC Tags
These include the internal and external tags of the Tag Management.

STEP 7 Symbols
These are all inputs, outputs, and bit memories from the symbol list as well as all global data 
blocks of the assigned S7 programs. 
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You can access STEP 7 symbols directly by means of:

● the tag selection dialog

● the tag bar of the Graphics Designer

 

Unlike the external WinCC tags, you can access the STEP 7 symbols without having previously 
performed Compile OS and without selecting with the operator control and monitoring attribute. 
During process connection, an implicit compilation is performed and the symbol is transferred 
to the Tag Management of the WinCC project.

 

See also
Tag Bar (Page 1929)

Tag Selection Dialog (Page 1920)

12.6.2 Tag Selection Dialog

12.6.2.1 Tag Selection Dialog

Introduction
The tag selection dialog allows you to display tags or symbols from various data sources in a 
selection window and to link these tags or symbols to, for example, picture objects of the 
Graphics Designer. You determine the displayed data in the Data Source area.

The tag selection dialog is opened automatically when a tag needs to be selected during 
configuration.
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See also
Tag Bar (Page 1929)

How to Transfer STEP 7 Symbols (Page 1926)

How to Select STEP 7 Symbols (Page 1924)

How to Display STEP 7 Symbols (Page 1921)

12.6.2.2 How to Display STEP 7 Symbols

Introduction
If you activate the STEP 7 Symbol Server check box, a list of all transferable STEP 7 symbols 
are displayed in the data window. These symbols are all inputs, outputs, and bit memories 
from the STEP 7 symbol list as well as the global data blocks.

The tag selection dialog has a tag filter. In this field you can use the placeholders "*" and "?" 
to specify a search condition for the tag name. Only alphanumeric characters can be used for 
the name search. Exit the field using the Tab or Enter key. Only those tags which match your 
search criterion are then displayed.
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Requirement
● The tag selection dialog must be open.

Procedure
1. Activate the STEP 7 Symbol Server check box.

2. Open the STEP 7 Symbol Server folder in the navigation window.
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3. Open and select the desired S7 program. The global data blocks and all symbols in the 
symbol list are now displayed.

4. Open and select the global data block to display its contents.

Note

Only the following data types of a global data block are displayed and can be transferred: 
BOOL, BYTE, WORD, DWORD, INT, DINT, REAL, CHAR and STRING.
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See also
Tag Bar (Page 1929)

How to Transfer STEP 7 Symbols (Page 1926)

How to Select STEP 7 Symbols (Page 1924)

Tag Selection Dialog (Page 1920)

12.6.2.3 How to Select STEP 7 Symbols

Introduction
In the tag selection dialog you can select STEP 7 symbols directly for process connection 
purposes. The selected symbol is then labeled in STEP 7 as operator-controllable and 
monitorable and transferred to the Tag Management of WinCC by implicitly running the 
"Compile OS" function.

Note

If you select the symbol of a global data block, all elements provided with the operator-
controllable and monitorable attributes of this block are transferred implicitly to Tag 
Management of WinCC.
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Requirement
● STEP 7 symbols must be displayed.

Procedure
1. Select the desired symbol.

2. Select the symbol in the Select Tag dialog box and click "OK" to close the Tag Selection 
dialog box.
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3. If the "Compile OS" function or the implicit transfer has not yet been performed, you must 
select the desired channel unit (once only) via which communication with the AS is to be 
set up. In this case, you select the desired network connection.

4. Check the created dynamic in the Object Properties.

See also
How to Transfer STEP 7 Symbols (Page 1926)

How to Display STEP 7 Symbols (Page 1921)

Tag Selection Dialog (Page 1920)

12.6.2.4 How to Transfer STEP 7 Symbols

Introduction
In the tag selection dialog, you can transfer STEP 7 symbols in the Tag Management without 
direct process connection being carried out.
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Requirement
● STEP 7 symbols must be displayed.

Procedure
1. Select the desired symbols. Several symbols can be selected at the same time using the 

CTRL or SHIFT keys and clicking with the mouse.

2. Click the "Transfer Data" button.
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3. If the "Compile OS" function or the implicit transfer has not yet been run, you must select 
the desired channel unit (once only) via which communication with the AS is to be set up. 
In this case, you select the desired network connection.

4. Check the result of the transfer in the Tag Management.

See also
Tag Bar (Page 1929)

How to Select STEP 7 Symbols (Page 1924)

How to Display STEP 7 Symbols (Page 1921)

Tag Selection Dialog (Page 1920)
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12.6.3 Tag Bar

12.6.3.1 Tag Bar

Introduction
Using the tag bar, you can connect tags directly to object attributes and thus dynamize the 
affected attributes. The tag bar is part of the Graphics Designer and is similar in layout to the 
tag selection dialog.

Unlike the tag selection dialog, the tag bar remains open after an assignment operation and 
allows a tag to be connected to an object attribute by means of simple drag and drop.

There are two locations where you can drop the tag:

● on an object in the picture (see below for object types)

● on an attribute in the Properties tab of the Object Properties dialog

Dropping on Object in Picture
If you drop the tag on a graphic object, you do not specify the attribute to be dynamized. The 
following rules therefore apply:

The attribute to be dynamized is specified in the case of objects which have a simplified 
configuration dialog. The table shows the objects and the dynamized attribute.

Object Attribute

I/O Field Output value
Bar Process driver connection
Status display Current status
Text list Output value
Check box Selected fields
Option button Selected fields
Slider object Process driver connection

The used update cycle is the default cycle set in the Default Object Settings tab of the Settings 
dialog. You open the Settings dialog under the Extras ->Settings... menu.

No tags can be dropped on standard objects, e.g. circles and lines.

Dropping on Attribute:
Drop the tag on an attribute in the Properties tab of the Object Properties dialog. This attribute 
is then dynamized by the tag.
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See also
How to Transfer STEP 7 Symbols (Page 1926)

How to Select STEP 7 Symbols (Page 1932)

How to Display STEP 7 Symbols (Page 1930)

Tag Selection Dialog (Page 1920)

12.6.3.2 How to Display STEP 7 Symbols

Introduction
The tag bar is part of the Graphics Designer. Unlike the tag selection dialog, the tag bar remains 
open after an assignment operation.

The tag bar has a tag filter. In this field you can use the placeholders £*£ and £?£ to specify 
a search condition for the tag name. Only alphanumeric characters can be used for the name 
search. Exit the field using the Tab or Enter key. Only those tags which match your search 
criterion are then displayed.
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Requirement
● The Graphics Designer must be open.

Procedure
1. Open the list of toolbars by choosing View > Toolbars from the menu. Select Tags and 

acknowledge with OK.

2. Click on the plus sign in front of the FDLCP5412/A2 icon S7 icon. Select the DB directory. 
The global data blocks are then displayed.

3. Open and select the global data block to display its contents.
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See also
Tag Bar (Page 1929)

How to Transfer STEP 7 Symbols (Page 1926)

How to Select STEP 7 Symbols (Page 1932)

Tag Selection Dialog (Page 1920)

12.6.3.3 How to Select STEP 7 Symbols

Introduction
You can perform process connection by simply dragging the STEP 7 symbol onto an object 
or an object attribute.

The selected symbol is then labeled in STEP 7 as operator-controllable and monitorable and 
transferred to the Tag Management of WinCC by implicitly running the "Compile OS" function.

Note

If you select the symbol of a global data block, all elements provided with the operator-
controllable and monitorable attributes of this block are transferred implicitly to Tag 
Management of WinCC.

Requirements
● The tag bar must be open.

● The STEP 7 symbols must be displayed.
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Procedure
1. Select the desired symbol.

2. Drag the symbol onto the desired object or the object attribute.
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3. If the "Compile OS" function or the implicit transfer has not yet been run, you must select 
the desired channel unit (once only) via which communication with the AS is to be set up. 
In this case, you select the desired network connection.

4. Check the created dynamic in the Object Properties.

See also
Tag Bar (Page 1929)

How to Transfer STEP 7 Symbols (Page 1926)

How to Display STEP 7 Symbols (Page 1930)

Tag Selection Dialog (Page 1920)
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12.7 Diagnostic Support

12.7.1 Diagnostic Support

Introduction
With the network entry jump and the entry jump into the hardware diagnostics, you can jump 
directly into STEP 7 from WinCC Runtime. This allows you to diagnose faults quickly and easily.

You can configure the following jumps:

● Network entry jump into the program editor LAD/FBD/STL of STEP 7. You can perform the 
entry jump with or without the operator authorization check.

● Network return jump from the STEP 7 program editor into the picture in which the process 
tag belonging to the symbol is used.

● Entry jump to the STEP 7 Hardware Diagnosis function of the respective AS.  The entry 
jump can be completed with or without check of the access authorization. 

See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Prerequisites for Jump to Hardware Diagnosis (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

How to Configure the Network Entry Jump (Page 1937)

Requirements for the Network Entry Jump (Page 1936)

Network Entry Jump (Page 1935)

Network Return (Page 1941)

12.7.2 Network Entry Jump

12.7.2.1 Network Entry Jump

Introduction
With the network entry jump, you can jump directly from WinCC Runtime into the appropriate 
program editor LAD / FBD / STL of STEP 7 with the focus on the STEP 7 symbol belonging 
to the process tag. This allows you to diagnose faults quickly and easily.

You can configure the network entry jump with or without operator authorization check.
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With Operator Authorization Check
For full access to the program editor of STEP 7, you must be logged on at the system and 
have the authorization required for the network entry jump in Runtime. If you do not have this 
authorization, you are only granted read access to the blocks in the program editor.

Without Operator Authorization Check
You have read and write access to all blocks in the program editor.

See also
How to Configure the Network Entry Jump (Page 1937)

How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Prerequisites for Jump to Hardware Diagnosis (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

Requirements for the Network Entry Jump (Page 1936)

Network Return (Page 1941)

12.7.2.2 Requirements for the Network Entry Jump

Introduction
During configuration, it is important to remember that a network entry jump is only possible 
under certain conditions.

Requirements:
● The Compile OS function must have been executed.

● A reference list must have been generated in the S7 program.

● If an operator authorization with a dedicated operator control level is to be configured, this 
level must have been created using the User Administrator.

● Since the entry jump is performed using a process tag, this process tag must exist in the 
S7 connection created by the Compile OS function. STEP 7 symbols can be compiled 
implicitly in the tag selection dialog.
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See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Prerequisites for Jump to Hardware Diagnosis (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

How to Configure the Network Entry Jump (Page 1937)

Network Entry Jump (Page 1935)

Network Return (Page 1941)

12.7.2.3 How to Configure the Network Entry Jump

Introduction
In WinCC, you use the Dynamic Wizard to configure the network entry jump at an object created 
in the Graphics Designer.

Requirements
● See: Requirements for the Network Entry Jump

Procedure
1. Insert a graphic object such as a "button" into the picture.

2. Select the object.

3. Start the Dynamic Wizard by choosing "View >Toolbars" from the menu.

4. Open the "Network Entry Jump" wizard on the "Standard Dynamics" tab by double-clicking.

Integration of WinCC in SIMATIC Manager
12.7 Diagnostic Support

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1937



5. The wizard then guides you through the necessary configuration steps. Select the trigger 
with which the network entry jump is to be executed. Then click "Continue".

6. Select an attribute of the object such as "ToolTipText". This attribute is connected to the 
tag selected in the following step.
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7. Now set the tag for which the network entry jump is to apply. Click the selection button to 
open the tag selection dialog. Select a tag and then close the dialog box by clicking "OK". 
Then click "Continue".
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8. Set whether the STEP 7 write authorization is to be checked when the network entry jump 
is performed. If you want a check to be performed, you must also set the authorization level. 
Then click "Continue".

9. An overview of the options you have selected is displayed. Check the options and then 
click "Finish".

If in Runtime you then select the button you have just configured, the program editor LAD / 
FBD / STL of STEP 7 is opened and the place of use of the selected tags is displayed.

See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Prerequisites for Jump to Hardware Diagnosis (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

Requirements for the Network Entry Jump (Page 1936)

Network Entry Jump (Page 1935)

Network Return (Page 1941)
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12.7.3 Network Return

Introduction
With the network return jump, you can jump from a STEP 7 symbol to the place of use of the 
associated WinCC tags. The relationship of STEP 7 symbols to WinCC tags is established 
using the cross reference list of WinCC.

Configuration Rule
Please observe the following when configuring your WinCC pictures and picture windows in 
which you have also used STEP 7 tags:

● It is advisable to use only basic pictures in the entire WinCC project.

● If you want to use picture window systems, you must ensure that all calls of the network 
entry jump and all possible return jump destinations are configured on the same picture 
level. That is to say, either within basic pictures, or within picture windows in basic pictures, 
or within picture windows in picture windows. Possible return jump destinations are all 
pictures in which tags are used that are also used in STEP 7.

Requirements
● The WinCC pictures and picture windows must observe the configuration rule.

● A network entry jump out of WinCC must have been performed.

● The cross reference list of the WinCC project must be up-to-date.
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Procedure
1. Select the desired symbol in the program editor LAD / FBD / STL.

2. Choose the Show Picture option on the context menu.

3. If the symbol is used in just one picture, this picture is opened and displayed in 
Runtime.         
If the symbol is used in more than one picture, you can select the desired picture using a 
selection list.

If the selected symbol is not used in any picture, you can view the current picture in Runtime.
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See also
How to Configure the Network Entry Jump (Page 1937)

How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Prerequisites for Jump to Hardware Diagnosis (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

Requirements for the Network Entry Jump (Page 1936)

Network Entry Jump (Page 1935)

12.7.4 Jump to Hardware Diagnosis

12.7.4.1 Jump to Hardware Diagnosis

Introduction
    The entry jump into the hardware diagnostics enables you to jump directly from WinCC 
Runtime into the STEP 7 function Hardware Diagnostics of the associated AS. It therefore 
allows faults to be diagnosed quickly and easily.

You can configure the entry jump into the hardware diagnostics with or without operator 
authorization check.

With Operator Authorization Check
For full access to the hardware diagnostics of STEP 7, you must be logged on at the system 
and have the authorization required for the entry jump in Runtime. If you do not have this 
authorization, only read access is possible.

Without Operator Authorization Check
You have full access to the hardware diagnostics.

See also
How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Prerequisites for Jump to Hardware Diagnosis (Page 1944)

How to Configure the Network Entry Jump (Page 1937)

Requirements for the Network Entry Jump (Page 1936)

Network Entry Jump (Page 1935)

Network Return (Page 1941)
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12.7.4.2 Prerequisites for Jump to Hardware Diagnosis

Introduction
During configuration, it is important to remember that an entry jump into the hardware 
diagnostics is only possible under certain conditions.

Requirements:
● The Compile OS function must have been executed.

● If an operator authorization with a dedicated operator control level is to be configured, this 
level must have been created using the User Administrator.

● The connection parameters for the AS must have been determined using a process tag. A 
process tag must therefore exist in the S7 connection created during the Compile OS 
operation. STEP 7 symbols can be compiled implicitly in the tag selection dialog.

See also
Requirements for the Network Entry Jump (Page 1936)

How to Configure the Entry Jump into the Hardware Diagnostics (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

How to Configure the Network Entry Jump (Page 1937)

Network Entry Jump (Page 1935)

Network Return (Page 1941)

12.7.4.3 How to Configure the Entry Jump into the Hardware Diagnostics

Introduction
You can configure the entry jump into the hardware diagnostics at an object created in the 
Graphics Designer. A separate wizard for the entry jump into the hardware diagnostics is not 
available which means that you have to use and modify the "Network Entry Jump" wizard.

Requirements
● See: Requirements for Entry Jump into Hardware Diagnostics.

Procedure
1. Insert a graphic object such as a "button" into the picture.

2. Select the object.

3. Start the Dynamic Wizard by choosing "View >Toolbars" from the menu.
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4. Open the "Network Entry Jump" wizard on the "Standard Dynamics" tab by double-clicking.

5. The wizard then guides you through the necessary configuration steps. Select the trigger 
with which the network entry jump is to be executed. Then click "Continue".
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6. Select an attribute of the object such as "ToolTipText". This attribute is connected to the 
tag selected in the following step.

7. Set the tag via which the entry jump is to be performed. Click the selection button to open 
the tag selection dialog. Select a tag and then close the dialog box by clicking "OK". Then 
click "Continue".
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8. Specify whether or not to check the STEP 7 write authorization upon network entry jump. 
If you want a check to be performed, you must also set the authorization level. Then click 
"Continue".

9. An overview of the options you have selected is displayed. Check the options and then 
click "Finish".

10.When the entry jump is configured, a script is created which executes the jump. You must 
rewrite this script for a jump into the hardware diagnostics. To do so, open the Pop-up menu 
of the objects which you are using, and choose the "Properties" option to open the "Object 
Properties" dialog box.
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11.Open the "Event" tab and navigate to "Button > Mouse > Mouse Action".

12.Double-click the symbol in the "Action" column. The editor opens and displays the script.

13.Replace the entry "GetKopFupAwl" with "HWDiag".

14.Close the dialog box and compile the changed script.

You can return to WinCC after entering hardware diagnostics by closing the hardware 
diagnostic program, or by pressing <ALT>+<TAB>.

Integration of WinCC in SIMATIC Manager
12.7 Diagnostic Support

MDM - WinCC: Working with WinCC
1948 System Manual, 11/2008,  



See also
Prerequisites for Jump to Hardware Diagnosis (Page 1944)

Jump to Hardware Diagnosis (Page 1943)

How to Configure the Network Entry Jump (Page 1937)

Requirements for the Network Entry Jump (Page 1936)

Network Entry Jump (Page 1935)

Network Return (Page 1941)
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Alarm window, 887, 894, 1005, 1014, 1070

Configuring, 1005
Hit list, 887
Lock list, 887
Long-term archive list, 887
Message list, 887
output of archive data, 1005
Short-term archive list, 887

AlarmColor, 336
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AlarmControl
Configuring in Graphics Designer, 1015
Configuring operator messages, 1031
Configuring the data export operation, 1034, 1204, 
1246, 1300
Configuring the status bar, 1025, 1196, 1239, 
1293
Configuring the toolbar, 1025, 1196, 1239, 1293
Emergency acknowledgment of messages, 1050
Locking and enabling messages, 1048
Online configuration, 1036, 1205, 1247, 1301
Operation in Runtime, 1042
Properties of the table elements, 1021, 1192
Selecting messages, 1046
Sorting by column header, 1021, 1024, 1192, 
1195
Status bar, 1045
Table element colors, 1022, 1193
Toolbar, 1042

AlarmCorntrol
SQL statements for message filtering, 1038

Alarms, 997
archiving, 997
reloading after power failure, 1007

Align, 392
Object in width and height, 241
Object in width or height, 241

Align / within the layer, 403
Aligning, 392

Objects, 241
Aligning objects, 1568
Alignment, 438, 457, 544, 598, 600, 606, 1581
Alignment palette, 241, 1520, 1533, 1568
all the way to the back, 403
all the way to the front, 403
All Themes, 625
Alpha, 230, 438
Alpha cursor, 678
Alpha-Cursor, 677
Analog alarm, 887, 984
Analog display, 350
Angle of rotation, 1581
Angle settings, 438, 1581
Application Window, 509, 513
Application window:Inserting application windows, 
513
Applications, 111, 116, 418

External applications, 111
Apply on Exit, 459, 531
Apply on Full, 531
Applying tag properties, 1356

PCS 7, 1356

archive, 1175
configuration, 1175

Archive
Disconnecting, 1181
linking, 1002
Linking, 1180

Archive backup
Disconnecting, 1181
Linking, 1180

Archive controlling, 1854
Archive data, 1005

output in message window, 1005
Archive database, 1136
Archive editing, 1851
Archive report, 887, 1484, 1529
Archive report object, 1654, 1655, 1661

Changing, 1654
Insert, 1654
Inserting, 1655, 1661
modify, 1655, 1656, 1661

Archive selection for the project documentation, 
1682
Archive tag, 1120, 1150

analog, 1120
binary, 1120
configuring, 1150
creating, 1150
naming of process-controlled tag, 1167

Archive tags, 1323, 1394
Archive tags selection for the project documentation, 
1684
Archive value editing, 1851
Archives , 1671
Archiving, 994, 997, 1134

Acyclic, 1133
at value change, 1133
configuring messages for archiving, 997
Cyclic, 1129
cyclic-selective, 1131
of messages, 994
process-controlled, 1134

Archiving cycle, 1127
configuring a new timer, 1151

Archiving messages, 887
Archiving methods, 1126, 1182

Acyclic, 1126, 1182
Compression, 1126, 1182
Cyclic, 1182
cyclic continuous, 1126
cyclic-selective, 1126
process-controlled, 1126

Arrow buttons, 216, 625
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Asian, 1730
Configuring, 1730

Assigning computer, 1823
Assigning message blocks, 1656, 1713

In message sequence report, 1713
Assigning user, 1825
Assigning user hierarchies in PCS7, 1819, 1831
Assigning:Assigning objects to layers, 242
Assignment, 242, 459, 560, 562, 563, 564

Deleting assignments, 562
Sorting assignments, 562

Assignment of message blocks, 1713
Assignment:Configuring assignments, 560
Assignment:Defining assignments, 564
Assignment:Deleting assignments, 563
Assignment:Sorting assignments, 563
Attribute, 428, 434, 437, 629, 1573, 1581

Changing, 1576
Configuring Attributes of a Customized Object, 
628
Dynamizing, 408

Attribute display, 1573
Attribute name, 1573
Attribute:Making Attributes Dynamic, 407
Attributes, 1677

Output of not connected, 1677
Output with action connection, 1677
Output with tag linking, 1677

Audio alarm, 1465
Project documentation, 1465

Authorization, 450, 469, 1818, 1827, 1829, 1831, 
1851, 1853, 1854
Authorization for area, 1854
Automatic hide, 945, 975
Automatic logout, 1827, 1829
Auto-Scrolling, 1024, 1195
Autostart, 135

Setup, 135
Available Graphic OLLs, 216
Average, 1335, 1371
Average value, 450
Axes, 1338, 1340, 1342

Display in FunctionTrendControl, 1277
Display of Staggered Trends, 1382
Display with common axes, 1378
Display with Different Axes, 1378
Display with logarithmic axes, 1380
Representation of Staggered Trends, 1342
Representation Using Common Axes, 1340
Representation Using Different Axes, 1340

Axis, 457, 1222, 1227
Axis Label, 369

Axis section, 457, 544

B
back, 403
Background, 345, 443
Background color, 347, 352, 441, 1579
Background picture, 363, 375
backup, 1000

of message archive, configuring, 1000
Bar, 230, 438, 443, 457, 458, 509, 541, 542, 544, 
606
Bar depth, 1581
Bar Graph, 369
Bar:Bar background color, 441
Bar:Bar height, 438
Bar:Changing, 539
Bar:Configuration, 541
Bar:Inserting, 539
Bars:Bar color, 441, 458, 542
Base X, 438, 1581
Base Y, 438, 1581
Basic colors, 244, 272, 347, 352, 373, 1539
Basic Dynamic Operations, 407
Basic operations, 380, 407
Basic Picture, 554
Basic Picture Transparent Color, 456
Basic Picture:Basic Picture Referenced, 456
Basic Picture:Basic Picture Transparent Color On, 
456
Basic Process Control, 54
Basic settings, 228, 254, 1543

Page layout editor, 1543
Basic Settings:The Basic Settings of the Graphics 
Designer, 254
Basic Static Operations, 380
Behavior, 124
Beta, 230, 438, 1581
Binary, 533, 563
Binary tag, 176
Bit, 564
BIT, 176
Bit Number, 459
Bit pattern group display, 450
Bit Position, 553, 606
Bold, 446
Border, 371, 441, 443, 448, 450, 468
Border style, 443
Border weight, 443
Border width, 443
Border:Border background color, 441
Border:Border color, 441
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Border:Flashing Border Color Off, 448
Border:Flashing Border Color On, 448
Box alignment, 443
Browsing, 354, 363, 375
Buffer range, 1442, 1474
Button, 216, 226, 262, 434, 583, 585, 586, 610, 1208, 
1250, 1304
Button Color, 441
Button:"Floppy disk" button, 216
Button:"Preview" button, 216
Button:"Statistics" button, 226
Button:Changing, 585
Buttons, 39, 1541

Adding, 1541
Removing, 1541
Restoring, 1541
WinCC Explorer, 39

Byte, 178

C
C action, 412, 815

Create, 879
Import, 882
modify, 883

C action:exporting, 886
C action:importing, 886
C editor, 1460

Project documentation, 1460
Cache, 128

For Runtime Pictures, 128
Calculating statistics, 1335, 1371
Calculation, 1585
Calling direct help for the "Object Properties" window, 
424
Calling PrtScr.exe, 1502
Calling selection dialog, 1668
Came In, 461
Came In Acknowledged, 461
Can Be Closed, 468
Cell

Copying, 1758
Center, 392

Objects, 241
Center Point Size, 356
Centering objects, 1568
Central color palette, 272

Definition, 248, 249
Edit, 249
Export, 251
Import, 251

Central date and time formatting, 64

Central signaling device, 922
Change

Customized menu, 664
Change color, 450
Change Color, 542
Change Column Width, 1625

In ODBC database table object, 1625
Change Orientation, 464
Change output value, 560
Change Picture on Mouse Click, 586, 606
Changing, 128, 434

Attribute, 1576
Background color, 1579
Color, 1579
Corner, 1587
Dynamic text, 1692
Editing object:ObjectTagObjectTag , 1629
Embedded layout, 1618
Fill pattern, 1588
Fill pattern color, 1579
Fonts in objects, 1585
Line color, 1579
Line termination, 1587
Line type, 1588
Line weight, 1588
Miscellaneous object properties, 1586
Object name, 1578
Object properties, 1570
Object size, 1583
Page layout, 1554
Static metafile, 1616
Styles, 1588
System objects, 1631
Toolbar and palettes, 1546
User archive runtime table, 1658

Changing compressed archive
Edit object:object Process value archive:output of 
configuration data , 1682

Changing connection, 506
Editing object:object connection output , 1691

Changing corner radii, 502
Changing flashing attribute, 554
Changing fonts of objects, 1585
Changing group display, 578
Changing language, 1797, 1800, 1802

Configuration (example), 1800
Configuring, 1797
In runtime, 1797
In runtime (example), 1802

Changing miscellaneous properties, 1586
Changing object size, 1583
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Changing output options, 1664
CSV provider trend, 1664
for WinCC Alarm Control, 1649, 1651
for WinCC Function Trend Control, 1645, 1647
for WinCC Online Table Control, 1635, 1638
In CSV provider table, 1662
WinCC Online Trend Control, 1640, 1643

Changing password, 1816
Changing source text

Action types for the project documentation , 1680
Changing Text Contents of Objects, 405
Changing text input mode, 901
Changing the Contents of the Static Text, 504
Changing the Position of an Object, 403
Char, 177
Characteristics, 1570
Characters, 152, 1718

Illegal characters, 152
Permitted, 1718

Check box, 583, 589
Check Box:Change Check box, 589
Check Box:Insert Check box, 589
Checking chipcard, 1836
Chipcard, 1833, 1834
Chronological messaging, 887
Circle, 475, 489, 1527

Drawing, 1598
modify, 1598

Circle:Change circle, 489
Circular arc, 475, 493, 1527

Drawing, 1606
modify, 1606

Circular arc:Changing a circular arc, 493
Circular arc:Drawing a circular arc, 493
Clear:Clear on Invalid Input, 459, 531
Clear:Clear on New Input, 459, 531
Client, 1118
Client project, 48
Clipboard, 296, 298, 399, 400, 401, 402
Clock, 352
Clock control, 350
Clock Control, 320, 349, 354
Closable, 450
Code page, 1719
Color, 272, 347, 352, 361, 373, 434, 441, 1579

Changing, 1579
Color attribute, 347
Color custom color , 347
Color group, 347, 352, 361, 373

Color palette, 244, 272, 352, 361, 373, 1520, 1536, 
1539

Central color palette, 272
Edit central, 249

Color"User-defined color, 347
Color:High Limit Color, 441
Color:Low Limit Color, 441
ColorChanging

Font color , 1579
Colors, 1539

indexed, 248, 272
Property group, 1580

Column formatting, 1706
In line layout, 1706

Columns, 1573
COM object, 1509
COM server, 1509

Output of data, 1509
Printing data, 1492

COM server objects, 1531
Combined Objects, 378, 613
Combining the alpha and tab order cursors in a 
picture, 677
Combo box, 509
Comment, 907, 938
Communication, 71

Time settings, 64
WinCC V5, 64

Communication driver, 162, 174
Compilation

Display Log, 1910
compile, 1743, 1807

Text , 1743, 1807
Component list editor, 1468

Project documentation, 1468
Compressed archive, 1135, 1147, 1682

Configuring, 1147
Mode of Operation, 1135
Output of configuration data, 1682

Compressed archive tag Process value archive tag, 
1684
Compression, 1136
Compression tag, 1120
Computer, 59

Changing computer name, 59
Specifying properties, 59

Computer Name, 114, 657
Computer type, 114
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Configuration, 995, 1144, 1174, 1175, 1433, 1545
analog archive tag, 1159
archive, 1144, 1175
Archive tag, 1150
binary archive tag, 1153
Compressed archive, 1147
compressed tag, 1150, 1170
Data buffer, 1174
Menus and toolbars, 659
Object selection, 1545
Process value archive, 1144, 1175
process-controlled tag, 1150, 1167
Reports in line layout, 1435
Reports in page layout, 1433

Configuration dialog, 256, 1476
Calling, 1476
Use configuration dialog, 256

Configuration Dialog, 610, 621, 655
Configuration dialog:"Properties of Siemens HMI 
Symbol Library", 655
Configuration Dialog:Customized Object, 621
Configuration file, 659

Menus and toolbars, 659
Configuration on a Customized Object, 621
Configuration settings, 1545
Configured languages, 450
Configuring, 1718, 1730

For multiple languages, 1722
Message archive, 995
With non-Latin fonts, 1730

Configuring change picture, 588
Configuring data buffer, 1174
Configuring message types, 578
Configuring messages, 903

Interconnection Wizard, 937
System Wizard, 904

Configuring operator messages, 1031
Configuring OS reference, 1876, 1885
Configuring replacement printer, 1442
Configuring rotation in Runtime, 478, 481, 504
Configuring size of the ellipse segment, 495
Configuring the length of the circular arc, 493
Configuring window contents and template, 513
Connected Objects, 464
Connection Type, 438, 464, 506
Connection Type:Automatic, 438, 506
Connection Type:Simple, 438, 506
Connector, 475, 506
Connector:Changing a connector, 506
Connector:Inserting connectors, 506
Constant, 421
Content of clipboard, 401

Control, 335, 349, 355, 368, 520, 646
Deregistering, 332
Inserting, 325
Registering, 332

Control character in CSV files, 1498, 1696
Control properties, 336
Control selection, 218, 329
Controls, 320

Selecting OCXs, 218, 329
WinCC Alarm Control, 1014, 1070
WinCC Digital/Analog Clock, 349
WinCC Gauge Control, 355
WinCC Online Table Control, 1186
WinCC Online Trend Control, 1316
WinCC Slider Control, 368

Controls"Control, 340
Controls:WinCC Digital Analog Clock, 349
Controls:WinCC Gauge Control, 355
Controls:WinCC Slider Control, 368
ControlsControl , 340
Converting pictures, 212, 286
Coordinate origin, 1559
Coordinate system, 228, 230, 1559
Coordinate system:Coordinate origin, 228
Coordinate system:Coordinate System of a Process 
Picture, 228
Coordinate system:Coordinate System of an object, 
230
Coordinated universal time, 64
Copying, 298, 400, 1758

from individual lines in the text library, 1759
from individual texts in the text library, 1758
Lines in the Text Library, 1759

Copying multiple messages, 967
Copying of page layouts, 1556
Corner, 443, 481, 483, 1587
Corner radius X, 438, 1581
Corner radius Y, 438, 1581
Corner:Adding corners, 481, 483
Corner:Changing corners, 481, 483
Corner:Deleting corners, 481, 483
Corner:Moving corners, 481, 483
Corners, 1592

Adding polygon, 1592
Adding polyline, 1593
Deleting polygon, 1592
Deleting polyline, 1593
Moving polygon, 1592
Moving polyline, 1593

Cover sheet, 1433
Create

Customized menu, 662
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Create from file, 522, 524
Create new, 522, 526
Creating a New Picture, 280
Creating a table in the line layout, 1712
Creating Analog Archive Tag, 1159
Creating Binary Archive Tag, 1153
Creating Compressed Tag, 1170
Creating footer, 1711

In line layout, 1711
Creating header, 1711

In line layout, 1711
Creating picture components, 827
Creating process-controlled tag, 1167
CSV file, 1498, 1696

Control characters, 1498, 1696
Example for the Output, 1496
File structure, 1498, 1696
Output in table format, 1498, 1696
Output in trend format, 1498, 1696
Reporting, 1662
Requirements, 1498, 1696

CSV file structure, 1498, 1696
CSV provider, 1529

Report table, 1529
Trend report, 1529

CSV provider table, 1662
- outputting, 1662
Changing output options, 1662
modify, 1662
process, 1662

CSV provider trend, 1664
Changing output options, 1664
modify, 1664
process, 1664
Reporting, 1664

CSV table, 1492
Printing data, 1492

CSV table selection, 1662
CSV trend selection, 1664
Current, 428
Current language, 629
Current status, 456
Current value X, 438, 1581
Current value Y, 438, 1581
Current window, 421
Cursor Control, 124, 450, 469
Cursor mode, 450
Curve parameter, 1356
Custom Colors, 272, 352, 1539

Customized Object, 613, 618, 621, 623, 628, 629, 
632, 633, 634

Connect with Structure tags, 630
Creating, 620
Working with Customized Objects, 618

Customized Object:Delete, 635
Customizing, 345, 1540

Palette, 1540
Toolbar, 1541
Toolbar and palettes, 1546

Customizing Menu and Toolbars, 262
Customizing object selection, 1545
Customizing the Working Environment, 271
Cut, 296, 399
Cycle, 1127
Cyrillic, 1730

Configuring, 1730

D
Danger color, 359
Danger Display, 359
Data buffer, 1136
Data Connection, 1289
Data export in runtime, 1034, 1204, 1246, 1300
Data Format, 459
Data Selection, 1656, 1713

For message sequence report, 1713
for the archive report, 1656
For the message report, 1656
For the user archive report, 1660

Data source, 416, 608, 1920, 1929
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Data type, 174, 411, 533, 535, 536, 537
"Binary" data type, 533
"Decimal" data type, 535
"Hexadecimal" data type, 536
"String" data type, 537
Binary tag, 176
BIT, 176
Byte, 178
Char, 177
Double, 185
Dword, 183
float, 184
floating-point number 32-bit IEEE 754, 184
Floating-point number 64-bit IEEE 754, 185
Long, 181
Raw data tag, 187
Short, 179
Signed 16-bit value, 179
Signed 32-bit value, 181
Signed 8-bit value, 177
Signed byte, 177
signed Dword, 181
Signed word, 179
Text reference, 176
Text tag, 16-bit character set, 187
Text tag, 8-bit character set, 187
unsigned 16-bit value, 180
Unsigned 32-bit value, 183
Unsigned 8-bit value, 178
Unsigned byte, 178
Unsigned Dword, 183
Unsigned word, 180
Word, 180

Data window, 41, 221, 896
Data window of the WinCC Explorer, 209
Date, 349, 1631, 1793

Output in a report, 1631
Showing regional, 1793

Date changed, 224
Date created, 224
Date of last change, 450, 1553
Date/time, 64, 1529

Communication, 64
Controls, 64
Project settings, 64, 66
Runtime documentation, 64

Deactivated buttons in color, 262
Decimal, 535, 562
Decimal Places, 457, 544
Decluttering, 126
Default language, 1719
Default Objects, 267

Default objects configuration, 267, 269, 1543
Default settings of object types, 379
Default settings of objects, 267
Define as welcome screen, 221
Defining footer, 1707
Defining header, 1707
Defining hotkey for hardcopy, 1502
Defining new assignments, 562, 563
Defining number of lines, 1711
Defining printer, 1442
Defining printing range, 1440
Definition of origin, 228, 1559
Delete, 459
Deleting, 354, 363, 398, 531, 983, 1759, 1760

Multiple message texts, 967
Multiple messages, 967
of a group message, 983
of a message, 931
Tag assignment, 967

Deleting authorizations, 1819
Deleting users, 1816
Deleting users/groups, 1816
Delta loading, 76
Depressed, 371
Deregistring, 332
Deregistring control, 332
Design Features

for global design, 94
Design of reports, 1431
Details, 418
Device name, 59

Changing, 59
Diagnosis, 155, 1935, 1941, 1943
Diagnostic information

Server, 151
Diagnostic support, 1935, 1941, 1943
Diagnostics, 1935
Diagnostics data, 151
Diagnostics window, 151
Dial, 350
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Dialog, 334, 1570
"Pointer width" dialog, 350
"Style dialog, 343
Color dialog Custom color, 373
Color palette dialog , 347
Dialog "Insert Control"object name, 322
Dialog Controls:HMISymbolLibrary1.3 , 340
Dialog inserting control Object name, 322
Dialog picture graphic files, 354
Dialog properties of WinCC Gauge Control color 
custom color , 361
Dialog properties of WinCC Gauge Control 
Danger, 359
Dialog property of WinCC Gauge Control Picture 
Graphic files , 363
Digital color foreground color, 352
Digital pointer width , 350
Font dialog , 351, 372
Mouse control dialog , 356
Object properties, 1570
Picture dialog Preview, 375
Properties of WinCC Gauge Control font, 360
Scaling dialog , 369
Style dialog , 343, 345, 371
Value dialog , 357, 370

Dialog:"Properties of WinCC Gauge Control" 
dialog"Danger, 359
Dialog:"Properties of WinCC Gauge Control" 
dialog"Font, 360
Dialog:"Properties of WinCC Gauge Control" 
dialog"Picture"graphic files, 363
Dialog:color palette dialog, 347
Dialog:Dialog "Color"Foreground color, 352
Dialog:Dialog "Color"User-defined color, 373
Dialog:Dialog "Controls:HMI Symbol Library 1.3, 340
Dialog:Dialog "Picture"Graphic files, 354
Dialog:Dialog "Picture"Preview, 375
Dialog:font dialog, 351, 372
Dialog:Mouse Control dialog, 356
Dialog:Properties of WinCC Gauge Control dialog 
Color"Custom color, 361
Dialog:Scaling dialog, 369
Dialog:style dialog, 345, 371
Dialog:Value dialog, 357, 370
Digital/Analog clock, 349
Digits to the Left of the Decimal Point, 457, 544
Direct connection, 421, 815

Configuring, 843
Example: picture change in picture window, 844

Direct connection:application examples, 842
Directly edit text contents, 405

Disconnecting, 1181
Archive backup, 1181

Discrete alarm method, 887
Disk space, 335, 336, 338
Disk Space Control, 320, 335, 336, 338
Display, 345, 351, 360, 372, 450, 469, 1722

Non-translated text in runtime, 1795
Display all shortcuts, 262
Display as drop-down list, 443
Display axis, 230, 438, 1581
Display in front, 1332
Display in trend form, 1338
Display Mouse Pointer, 345
Display move handles, 262
Display objects

Language input, 1764
Language-defined, 1764
Multilingual configuration (example), 1799

Display of archived values, 1334, 1338
Display of Disk Space Control in Runtime, 338
Display of Memory Utilization, 338
Display of messages, 1077

Message blocks, 1077
Selection of messages, 1093

Display of windows, 468
Display options, 345
Display process value, 940
Display Text, 461
Display tips and tricks, 256
Displaying configured dynamics, 226
Displaying the Current Settings, 239
Displaying the Parameter Dialog, 1438
Distribute, 392

Objects, 241
Dividing Line Background Color, 441
Dividing Line Color, 441
Dividing line style, 443
Dividing line weight, 443
Documentation, 1484

Introduction to Runtime documentation, 1484
Messages in Runtime, 1484, 1486

Double, 185
Double arrow, 232
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Drawing, 1590
Circle, 1598
Circular arc, 1606
Ellipse, 1596
Ellipse arc, 1604
Ellipse segment, 1600
Line, 1590
Pie segment, 1602
Polygon, 1592
Polyline, 1593
Rounded rectangle, 1610
Square-wave, 1608

Drive, 336, 338
Duplicate, 402
Dword, 183
Dynamic, 428, 1573
Dynamic dialog, 411

Configuring, 848
Example: Color Change Depending on Position, 
864

Dynamic dialog:expression, 850
Dynamic dialog:quality code, 859
Dynamic dialog:tag status, 857
Dynamic dialog:valid range, 854
Dynamic dialog:value range, 854
Dynamic display, 1319
dynamic filling, 453
Dynamic log elements, 1476
Dynamic log parameters, 1476
Dynamic margin, 1581
Dynamic objects, 1526, 1528
Dynamic standard objects, 1618

Editing, 1618
Dynamic value ranges, 411
Dynamic Wizard, 240

Picture Functions, 824
SFC, 836
Standard Dynamics, 829
Triggers, 862

Dynamic Wizard Editor, 1937
Dynamic Wizard:import functions, 828
Dynamic Wizard:picture components, 827
Dynamic Wizard:system functions, 835
Dynamics, 226
Dynamics icon, 408
Dynamics of a Process Picture, 226
Dynamizable Parameters, 1476

For the Runtime documentation, 1476
Dynamization of attribute, 1573
Dynamizing

Cyclic Triggers, 819
Dynamizing:C action, 877, 878

Dynamizing:cyclic trigger, 819
Dynamizing:direct connection, 841
Dynamizing:dynamic dialog, 815, 846
Dynamizing:Dynamic Wizard, 822
Dynamizing:event-driven trigger, 819, 822
Dynamizing:tag connection, 815, 838
Dynamizing:tag trigger, 819, 820
Dynamizing:VBS action, 815, 866, 867

E
Edit, 634
Editing, 1333

Dynamic standard objects, 1618
Dynamic text, 1692
Static objects, 1589

Editing actions, 412
Editing embedded file in the OLE object, 522
Editing multiple layouts, 1556
Editing multiple messages, 967
Editor, 146, 1888

Changing language settings, 1888
Opening, 146, 1888

Editor window, 412, 414
Electronic signature

Configuring, 1844
Create, 1844
Creating in a C action, 1847
Creating in a VBS action, 1845

Element, 228, 426
Element:Elements of the toolbar in the "Object 
properties" window, 426
Ellipse, 475, 487, 1527

Drawing, 1596
modify, 1596

Ellipse arc, 475, 491, 1527
Drawing, 1604
modify, 1604

Ellipse arc:Changing an ellipse arc, 491
Ellipse arc:Drawing an ellipse arc, 491
Ellipse segment, 475, 495, 1527

Drawing, 1600
modify, 1600

Ellipse segment:Changing an ellipse segment, 495
Ellipse segment:Drawing an ellipse segment, 495
Ellipse:Changing an ellipse, 487
Ellipse:Drawing an ellipse, 487
Embedded layout, 1528, 1618
Emergency acknowledgement, 1102
Emergency acknowledgment, 1050
EMF, 287
emf file viewer, 1450
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End angle, 438, 1581
Enhancements, 900
Entry jump, 1935, 1943
Evaluate status of tags, 411
Event, 407, 410, 411, 412, 414, 431, 632, 633

Adding events, 633
Deleting events, 633
Events of a customized object, 633

Event of the Expression / Formula, 411
Event:Configuring Events, 407, 410
Event:Event directory, 431
Event:Event display, 431
Event:Event name, 411, 412, 414
Event:Events of a customized object, 632
Events, 1127

Start, 1127
Stop, 1127

Example - "binary" data type, 533
Example - "Decimal" data type, 535
Example of a CSV file Output, 1496
Example:, 338
Examples of configuring an AlarmControl, 1055, 
1056, 1059, 1061, 1067, 1068, 1264
Exit edit mode, 634
Exponent display, 457, 544
Export, 287

Color palette, 251
Language-dependent text, 1737
Languages with the same code page, 1736, 1746, 
1749, 1751, 1769
Languages with the same codepage, 1778
Languages.csv, 1742
Text from pictures, 1768

Export file
Graphics Designer, 1740
Text Distributor, 1739

Export file Text Library
Structure, 1740

Export Files
Text library, 1739

Exporting Graphics, 287
Exporting messages, 966

Structure of export file, 962
Expression / Formula, 411
Extended, 124
Extended operation, 450
Extended zooming, 450
Eyedropper, 295, 426, 435, 1572, 1577

F
Faceplate type, 256

Fault, 1442
Printers, 1442

Features, 423
Field type, 459, 530, 531, 559, 606
FIFO buffer, 1136

basics, 1136
File Size, 224
File structure, 155
Fill Level, 453
Fill pattern, 443, 1588

Changing, 1588
Fill pattern color, 441, 1580

Changing, 1579
Filling, 453
Filter, 416, 608, 1921, 1930
Filter criteria, 1660

For the user archive report, 1660
Filter criteria for alarm output, 1515, 1656, 1699, 
1713
Filter criteria for the user archive report, 1660
Filter criterion for alarm output, 1515, 1656, 1699, 
1713
Filtering text

Text library, 1762
Final page, 1433
Find, 405, 418

Text in the text library, 1760
FindFast.exe, 111
Finding picture, 354
Finding picture , 354
Flash color, 347
Flash frequency, 448, 456
Flash frequency:Border Flash Frequency, 448
Flash Picture, 456, 554
Flash Picture:Flash Picture Transparent Color, 456
Flash Picture:Flash Picture Transparent Color On, 
456
Flashing, 448, 456
Flashing attribute, 554
Flashing Background Color Off, 448
Flashing Background Color On, 448
Flashing Flash Picture Active, 456
Flashing of a message, 922
Flashing Text Color Off, 448
Flashing Text Color On, 448
Flashing:Flashing Background Active, 448
Flat style for toolbars, 262
Float, 184
Floating-point number 32-bit IEEE 754, 184
Floating-point number 64-bit IEEE 754, 185
Floppy disk, 216
Folder structure, 155
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Font, 446, 530, 559, 586, 606, 1584, 1729, 1730
Central administration, 1747
Changing fonts of objects, 1584
Configuration, 1729, 1756
Configuring a language, 1756
In multilingual projects, 1729
Special objects, 1729
System requirements, 1729

Font , 351, 372
Font color, 441, 1579

Changing, 1579
Font palette, 245, 1520, 1537
Font size, 351, 446
Font Style, 426, 428
Font styles of the object selection, 426
Font styles to display dynamics and events, 428
Font", 351, 372
Font"Schriftart"Gauge, 360
FontFont

Attributes , 1584
Foreground, 424, 450, 468
Foreign languages, 1687
Format, 375, 1585
Format DLL, 928, 1121
Formatting codes - "binary" data type, 533
Formatting codes - "decimal" data type, 535
Formatting codes - "Hexadecimal" data type, 536
Formatting codes - "String" data type, 537
Formatting Instructions, 938
Formatting text, 1584
Forms of Display, 1375
Formula, 411
Forward, 119
Frame picture, 363
Free, 336
FreePercent, 336, 338
Frequency, 1084
front, 403
Function selection, 412

Function Trend Control, 1373
Archive tags, 1394
Changing configuration, 1403
Common axes, 1378
Data from user archives, 1395
Determining coordinates, 1408
Dynamic display, 1386
Enlarging area, 1410
Forms of Display, 1375
Function of time, 1398
Ideal trend, 1389
Ideal Trend, 1396
Inserting, 1392
Linear interpolation, 1375
Logarithmic scaling, 1380
Online tags, 1393
Operation in runtime, 1402
Properties, 1421
Resolution, 1373
Single values, 1375
Staggered trends, 1382
Starting update, 1405
Static display, 1386
Stepped trend, 1375
Stopping update, 1405
Time range, 1386
Trend on top, 1406
Values of uncertain status, 1387
Values outside the limit range, 1387
write direction, 1384
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FunctionTrendControl, 1274
Buttons in the Toolbar, 1304
Change the sequence of the displayed trends, 
1256, 1309
Configuring the axes in the trend window, 1282
Configuring the axes of trends, 1277
Configuring the data connection of trends, 1289
Configuring the data export operation, 1034, 1204, 
1246, 1300
Configuring the evaluation with the RulerControl, 
1200, 1242, 1296
Configuring the status bar, 1025, 1196, 1239, 
1293
Configuring the toolbar, 1025, 1196, 1239, 1293
Configuring trends, 1235, 1286
Configuring trends for the trend window, 1284
Determining the coordinates of a point, 1309
Displaying a trend in the foreground, 1256, 1309
Online configuration, 1036, 1205, 1247, 1301
Online Configuration, 1307
Operation in Runtime, 1304
Representation Trend Lines, 1275
Resolution, 1274
Using the zoom functions in trend windows, 1311

G
Gauge, 355
Gauge Control, 320, 355, 356, 357, 360, 363
Gear ratio, 1900

Entire OS, 1902
Revisions, 1906

General "Background style", 350
General background style , 350
General measuring range , 357
General"Measuring range, 357
Geometry, 326, 438, 1581

Property group, 1583
Geometry of objects, 1583
GeometryRadiusX , 1581
Global Design

Characteristics, 94
Switch off for computer, 128

Global Library, 212, 646, 653
Converting the global library, 212

Global Scripts, 513
GMT, 64
Graphic files, 375
Graphic Object, 509, 547, 610

Changing Graphic Object, 547
Configuring a graphic object, 547
Inserting Graphic Object, 547

Graphic OLL, 212, 216
Graphics Designer, 209, 210, 228, 234, 254, 271, 
657, 1675, 1764

Creating multilingual pictures, 1764
Export file, 1740
Output of statistics data for pictures, 1675
Switching languages, 1728, 1764
Text filtering, 1762

Graphics Designer:Starting Graphics Designer, 209
Graphics Runtime, 112
Greenwich Mean Time, 64
Grid, 254, 1544

Adjusting distance, 1544
Adjusting grid width, 1544
Display grid, 254
Showing, 1543, 1544
Snapping to, 1544

Group, 613, 614, 615, 616, 617
Group acknowledgement, 887
Group display, 578
Group Display, 509
Group message, 887, 970

Acknowledgement bit, 977
Acknowledgment bit, 974
Acknowledgment tag, 974
Adding single message, 982
Deleting, 983
Group message from message classes, 970
Hide tag, 975
Lock bit, 977, 979
Lock tag, 977, 979
Properties of message class, 970
Properties of message type, 977
Status bit, 971, 979
Status tag, 971, 979
User-defined group message, 978

Group Objects, 504
Group relevant, 450
Group value, 450
Grouping, 405, 418, 614

Relinking, 405, 418
Groups:Ungrouping Groups, 617

H
Handles, 232, 326, 393
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Hard copy, 1504, 1528, 1851
Defining area selection, 1621
Defining parameters, 1502
Output in a report, 1501
Output parameter, 1504
Printing, 1492
With a log object, 1501

Hard copy by means of startup list, 1502
Hard copy object, 1621

Changing output options, 1621
Hard disk, 111

Defragmenting, 111
Hard disk capacity, 111, 1442

Minimum value, 1442
setting, 1442

Hard disk drive, 1174
Configuring data buffer, 1174

Hardcopy by means of hotkey, 1502
Hardware diagnostics, 1935, 1943, 1944

Configuring, 1944
Entry jump, 1943
Requirement, 1944

Heading, 450, 468
Height, 326, 438, 1581
Height in pixels, 254
Hexadecimal, 536
Hidden Input, 459, 531
Hide Manually, 945
Hide mask, 945, 975
Hide tag, 945, 975

of a customized group message, 975
Hide/ Show Messages, 887
Hiding, 1540

Palette, 1540
Toolbar, 1540

Hiding Messages, 945
High limit, 458
High Limit Background Color, 441
High limit value, 458
Higher process controlling, 1854
Hit list, 887, 1070, 1084

Configuration, 1029
Hitlist, 1014

Evaluation of operator messages, 1031
Hotkey, 110, 119, 450, 469

Defining, 110
Hard copy, 110
Logging off, 110
Logging on, 110

Hotkey:Configuring Hotkey for Navigation in Runtime, 
588
Hotkey:Define Hotkey, 588

Hotkeys, 588
Hysteresis, 450, 542
Hysteresis range, 450
Hysteresis:Hysteresis Range, 542

I
I/O Field, 509, 527, 530
I/O field:Changing an I/O Field, 527
Ideal trend, 1389
Ideal Trend, 1396
Illegal characters, 152
Images, 1677

Output of attributes in a report, 1677
Immediate input, 450
Immediate Input, 531
Import

Color palette, 251
Languages.csv, 1742
Tag, 163

Importing messages, 964
Structure of import file, 962

Importing selections, 1018, 1029
In trends, 1220, 1337
Increasing the number, 592
Index, 438, 446, 464, 1581
Index:Index of the connection point of the first object 
connected, 464
Index:Index of the connection point of the object 
connected at the end, 464
Indexed colors, 248, 251, 272
Indir., 428
Indirect addressing, 1573
Info text, 938
Initial-value message, 887
Input value into an I/O Field, 531
Insert symbols of the Symbol Library, 340
Inserting, 322, 335, 340, 349, 355, 368, 1658, 1818

Object, 1562
OLE object, 1614
Static metafile, 1616
Static text, 1612
System objects, 1631
User archive runtime table, 1658

Inserting Gauge Control, 355
Inserting group display, 578
Inserting Slider Control, 368
Inserting Symbols of the Symbol Library, 340
Instance, 167
Integration, 1857

Notes on installation, 1857
Required software components, 1857
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Interconnection Wizard, 894, 937
Internal coordinate system, 1559
Interpolation, 1339, 1375

Linear interpolation, 1375
Interval, 336
Invisibility, 473
ISO 8601, 64
Issuing warnings for the cyclic trigger, 256
Italic, 446

J
Jump from one object to the next in Runtime, 677

K
Key combination

Lock, 117
Key combination for hardcopy, 1502
Key function, 1208, 1250, 1304
Key switch, 1822
Keyboard Settings, 247
keys, 124, 681

L
Label Each, 457
Labeling, 355, 370
Labeling attribute, 360, 372
Labeling font, 360
Landscape, 1581
Language, 117, 623, 899, 1719

Add, 1757
Administrating, 1747
Changing in runtime (example), 1802
Changing in WinCC, 1728
Configuring messages, 1781
Creating, 1756
Deleting, 1758
In Alarm Logging, 1776
In runtime, 1795
Remove, 1757
Sample project, 1798
Setting fonts, 1756
Supported , 1718
Term definitions, 1719

Language code
Layout file, 1551

Language expression, 1719
In WinCC, 1719

Language in WinCC, 1719

Language input, 1764, 1776
In Alarm Logging, 1776
In picture objects, 1764

Language Settings in Runtime, 117
Language support, 1718

In WinCC, 1718
Language switching

In runtime, 1795
Language-dependent text

Exporting, 1737
Languages in WinCC

Example of configuration, 1798
Languages.csv

Structure, 1742
Text Distributor, 1742

Large Tick Marks, 457, 544
Large Tick Marks Length, 457, 544
Latch down, 443
Layer, 242, 290, 293, 294, 403
Layer palette, 242, 294
Layer techniques, 290
Layer Techniques - Principles, 290
Layer:Assigning layers, 293
Layer:Renaming layers, 242, 294
Layers:Making layers visible / invisible, 242
Layout, 1431, 1549

Changing, 1554
Configuration steps, 1548
Copy, 1549
create, 1548, 1549
Create, 1431, 1473, 1548
Design, 1431
Displaying properties, 1433
Edit, 1473, 1548
Editing multiple, 1556
File operations, 1549
New layout, 1549
Showing properties, 1553

Layout file
Language code, 1551
Language-specific, 1790

Layout for output, 1436
Layout for Output, 1438
Layout name, 1529

Output in a report, 1631
Layout object, 1633
Layout of the Graphics Designer screen, 234
Layout properties, 1553

Showing, 1553
Layout size, 1581
Library, 646, 649, 653, 1896
Library object, 613, 646, 652

Index

MDM - WinCC: Working with WinCC
System Manual, 11/2008,  1967



Library objects:importing into a Picture, 650
License

Invalid, 152
Lifebeat monitoring, 1467

Project documentation, 1467
Light bulb, 408, 1573
Light effect, 443
Lightning, 408
Limit, 458, 541, 542, 575, 598, 606
Limit value, 198

Defining, 198
Limit value monitoring, 984

Deleting a limit value, 991
Deleting tag, 991
Specifying limit value, 989
Specifying message, 985
Specifying tag, 986

Limit value:Limit marker, 458
Limit values, 336, 458, 531, 542
Limit values:Limit markers, 542
Limit values:Limits and type of value inputs of an I/O 
field, 531
Limit values:Setting Limit Values, 531
Limit:Configuring limits of the 3D bar, 575
Limit:Limit (0 -10), 458
Limit:Limits of a bar, 542
Line, 441, 443, 448, 475, 478, 483, 1527, 1756

Adding new lines to Text Library, 1756
Copying, 1759
Drawing, 1590
modify, 1590

Line color, 1579
Changing, 1579

Line connection type, 443
Line end, 443
Line end style, 443

Line layout, 1435, 1701
Adjusting margins, 1710
Adjusting number of columns, 1710
Adjusting page size, 1710
Adjusting table width, 1710
Application, 1435
Changing, 1489
Column formatting, 1706
Configuration, 1435
Creating footer, 1711
Creating header, 1711
Defining footer, 1707
Defining header, 1707
For message sequence report, 1489
Margins, 1706
Number of columns, 1706
opening, 1701
Page size, 1706
Printer settings, 1706
Setting margin, 1710
Setting up, 1486

Line layout editor, 1703
Structure, 1703
Table area, 1708, 1709
Toolbar, 1705
Working with, 1710

Line pointer, 350
Line style, 443, 483
Line termination, 483, 1587
Line type, 1588

Changing, 1588
Line weight, 443, 1588

Changing, 1588
Line:Change line, 478
Line:Configure line end style, 478, 483
Line:Draw line, 478
Line:Flashing Line Color Off, 448
Line:Flashing Line Color On, 448
Line:Line background color, 441
Line:Line color, 441
Line:Line style, 478
Linking, 1002, 1180, 1575

archive backup, 1002
Archive backup, 1180
Objects in the page layout editor, 1575

List Background Color, 441
List box, 509, 569

Inserting, 569
List Font Color, 441
List of Hidden Messages, 887, 945, 1100
List type, 459, 562, 563, 564

List Type Decimal, 562
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List type:List Type "Binary", 563
List type:List Type "Bit", 564
Load online changes

Activating, 85
Avoiding data inconsistencies, 78, 83
configuring, 83
Configuring, 78, 80
Consistent project, 78, 83
Deactivating, 91
Downloading, 83, 87
enable, 85
Limitations, 80
Network failure, 83
Redundant Systems, 81
Requirements, 78, 83, 87
Resetting, 91
Synchronizing projects, 78, 83
Turn Off, 78
WinCC Web Navigator support, 80

Loading changes, 76
Loading default settings of objects, 267
Loading online changes, 76

Principle, 76
LOC, 64
Local time zone, 64
lock, 117
Lock, 463

Key combination, 117
Lock bit, 973, 977, 979

of a group message, 977, 979
Lock list, 887, 1014, 1070
Lock tag, 973, 977

of a group message, 973, 977
Lock window, 1096
Lock:Lock Background Color, 463
Lock:Lock Display, 463
Lock:Lock Display Text, 463
Lock:Lock Text Color, 463
Locking message, 1096, 1851

Alarm Control, 1096
Locking messages, 887, 1096

Active/passive, 887
Alarm Control, 1096
Persistence, 1096

Log, 1910
Showing, 1910

Log objects, 1469
For the online documentation, 1469

Logging, 1490
Process values, 1490
Tag Table, 1490
Trend, 1490
User archive data, 1491

Logging ODBC database field, 1623
Logging ODBC database table, 1625
Login, 1809, 1838

Complete Username, 1839
Entry, 1838
SIMATIC Logon, 1839
User ID, 1839

Login in Runtime, 1832
Login:in Runtime, 1832
Login:only via chipcard, 1827
Login:only with chipcard, 1829
Login:SIMATIC Logon, 1811
Login:WinCC logon, 1811
Logon

Complete Username, 1844
SIMATIC Logon, 1844
User ID, 1844

Long, 181
Long-term archive list, 887, 1014, 1070
Long-term archive server, 1138

installation (overview), 1138
Loop In Alarm, 943
Low Limit Background Color, 441
Low Limit Value, 458
Lower frame color, 371
Lower limit, 458, 542

M
Main memory, 1174

Configuring data buffer, 1174
Making layers visible / invisible, 294
Making multiple selections, 1565, 1567
Manual hiding, 1100
Margin, 371, 1581
Margins, 1706

In line layout, 1706
Maximizable, 450
Maximum Angle, 357
Maximum value, 357, 370, 450, 544, 600
Maximum , 1335, 1371
Measuring range, 368
Memory capacity, 336
Memory utilization, 338
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Menu, 262
customized ~ define for picture, 667
customized ~ define for picture window, 668
User-defined, 659

Menu bar, 36, 1520, 1703
Menu bar of the WinCC Explorer, 209
Menu:Toolbars, 262
Menus and toolbars, 659

Configuration file, 659
Runtime, 659
User-defined, 659

Message, 72, 887, 1072, 1776, 1851
Acknowledgement status, 887
Acknowledgement tag, 887
Acknowledging, 922, 935
Acknowledgment bit, 935
Acknowledgment tag, 935
Active/passive locking, 887
Alarm message, 887
Archiving, 887
Background color, 920
Collapse, 945, 1100
Configuring a message, 887, 894, 927, 1075
Creating, 931
Defining colors, 920
Deleting a message, 931
Display in runtime, 1070
Display process value, 938
Editing multiple messages, 967
Exporting, 966
Flashing, 905, 922
Format DLL, 928
Group message, 887, 970
Importing, 964
in a group message, 982
Incoming message, 887
Initial-value message, 887
Loop In Alarm, 943
Message bit, 928
Message class, 887, 913
Message number, 928
Message status, 887, 933
Message tag, 887, 932, 991
Message text, 938
Message type, 887
Multilingual, 1776
New-value message, 887
Online configuration, 72
Operational message, 887
Outgoing message, 887
Parameters of a message, 928
Priority, 907
Priority of a single message, 928
Processing in the table window, 928
Properties, 928
Reporting, 887
Representation in runtime, 887
Selection, 1084, 1093
Single message, 927
Specifying an action, 943
Status bit, 933
Status tag, 887, 933
Structure of a Message, 887
System message, 887
Text color, 920
Text for message status, 925
Visualization in runtime, 1014
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Message archive, 995, 998, 1485
archive data output in Runtime, 1004
archive partitioning, 998
backup, 1000
Configuration, 998
Configuring, 995
Properties, 995
Reporting, 1485
signing off of backup, 1000
Size, 998
size of archive files, 998
Swapping, 1000
Time frame, 998

Message archive report, 1484
Message archiving, 994
Message bit, 928, 932, 991

of a message, 928
Message block, 887, 894, 905, 1072

Adding, 909
Configuring message blocks, 1016, 1018, 1072, 
1077
Duration, 905
Process value block, 887, 905
Removing, 912
System block, 905
System Block, 887
Time of day, 905
User text block, 887, 905

Message class, 887, 913, 1072
Acknowledgement theory, 922
Adding, 915
configuring, 1072
Configuring, 913
Deleting, 917
Fault, 913
Message types of message class, 918, 920
of a message, 913
System without acknowledgement, 913
System, requires acknowledgement, 913
Texts of message statuses, 925

Message editing, 1851
Message event, 887
Message frame, 887
Message line, 887, 1016, 1018, 1077
Message list, 887, 1070
Message List, 1014
Message lists, 1485

Reporting, 1485
Message number, 928
Message object, 1776

Language-defined, 1776
Message Priority, 907

Message procedure, 887
Analog alarm, 887
Chronological messaging, 887
Discrete alarm method, 887
Limit value monitoring, 984

Message report, 1484
Message Report, 1529
Message report object, 1654, 1655, 1661

Changing, 1654
Insert, 1654
Inserting, 1655, 1661
modify, 1655, 1661

Message sequence report, 887, 1484, 1486, 1489, 
1713

Assigning message blocks, 1713
Changing, 1489
Changing output options, 1713
Creating a table in the line layout, 1712
In line layout, 1489
In the page layout, 1489
Output of online data, 1486
Setup, 1486
User-defined, 1489

Message server, 1012
Message status, 887, 925

Acknowledged, 887, 925
Came In, 887, 925
Status tag, 933
Went Out, 887, 925

Message tag, 887, 928, 932, 991
Message type, 887, 1072

Adding, 918
Alarm, 918
Configuring the message type, 918, 920, 921, 
1072
Error, 918
Message type of a message, 887
Operator Input Message, 887
Removing, 921
System message, 914
Warning, 918

Message Type, 461
Message Types for Button, 465
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Messages, 1484
archive data output in Runtime, 1004
Configuring the hit list, 1029
List of Hidden Messages, 1054
Locking and enabling in AlarmControl, 1048
Manual or automatic hiding, 1054
Multilingual configuration, 1781
Online reporting, 1484, 1486
Persistence for locking, 1048
Selecting messages in AlarmControl, 1046
Sorting the display, 1051

Messages in Runtime, 483
Messages multilingual

Translating, 1777
Metafile, 1616

Changing, 1616
Inserting, 1616

Migration
Time settings, 64

Minimum, 1335, 1371
Minimum Angle, 357
Minimum value, 357, 370, 450, 544, 600
mirroring, 395
Mirroring, 343, 395
Miscellaneous, 450
Miscellaneous , 1585
Missing Text ID

Text Library, 1763

modify, 1680
Attributes, 1677
Circle, 1598
Circular arc, 1606
CSV provider table, 1662
CSV provider trend, 1664
Dynamic metafile, 1693
Dynamic table, 1695
Editing object:object project 
documentation:output of user texts, 1687
Editingobject:objectObject:picturestatistics, 1675
Ellipse, 1596
Ellipse arc, 1604
Ellipse segment, 1600
Line, 1590
Object Object:trigger , 1680
Object selection of tag group , 1689
Objects for the project documentation, 1666
OLE object, 1614
Pie segment, 1602
Polygon, 1592
Polyline, 1593
Project value archive object:output of 
configuration data , 1684
Rounded rectangle, 1610
Square-wave, 1608
Static text, 1612
User archive runtime table, 1660

Module selection, 414
Modules, 116
Monitor, 458, 542
Monitor keyboard, 128
Monitor:Monitor (0 to 10), 458
Monitoring, 1853, 1854
Mouse pointer, 128
mouseless, 677
Mouseless operation, 677
Movable, 450, 468
Multilingual

Page layout, 1550
Reports, 1550

Multilingual configuration, 1718, 1722
Configuration scenarios, 1718
Editors, 1722
Example, 1798
In WinCC, 1718
Non-translated texts, 1722
Picture object, 1773
Reports, 1786
System requirements, 1722
Text list, 1775
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Multilingual log, 1793
In runtime, 1793

Multilingual message
Configuring in Alarm Logging, 1782

Multilingual message text, 1776
Multilingual messages

External translation, 1777
Multilingual project, 1725

Create, 1725
Multilingual project documentation, 1792

Rules, 1792
Multilingual report

 Layout files, 1788
Multiple Pictures, 295
Multiple row text, 509
Multiple selection, 386, 388, 1570

Text library, 1759
with Ctrl+A, 388
With the mouse, 388

Multiple selection of objects, 1565, 1567
Multiple selection:Multiple selection of objects, 386
Multi-user project, 47

Changing project type, 50

N
Name, 152

Illegal characters, 152
Name of Property, 629
Naming conventions, 152, 164, 166

Tag, 163
Navigation, 659

Menus and toolbars, 659
Navigation window, 41, 209, 212, 652, 896, 1827
Navigation window:navigation window of WinCC 
Explorer, 209
Network entry jump, 1935, 1936, 1937

Configuring, 1937
Requirement, 1936

Network return, 1941
New picture, 212, 280
New-value message, 887
Non-Latin font, 1730

Notes, 1730
Special features, 1730
Tool, 1730

Nontransparent, 350
Normal, 124
Normal Display, 359
Normal without rollback, 124
Not system text, 1763
Number of boxes, 438

Number of columns, 1706
In line layout, 1706

Number of corners, 438, 1581
Number of fields, 1581
Number of visible Lines, 459

O
Object, 216, 224, 256, 296, 298, 378, 382, 385, 388, 
390, 392, 393, 395, 396, 398, 399, 400, 402, 403, 421, 
426, 473, 504, 506, 614, 615, 623, 632, 653, 682, 683, 
1501, 1658

Archives, 1671
Connections, 1691
Copying and pasting objects, 256
Dynamic metafile, 1693
Dynamic table, 1695
Dynamic text, 1692
Editing archive report, 1654, 1655, 1656, 1661
Editing message report, 1654, 1655, 1656, 1661
Embedded layout, 1618
Hard copy, 1501, 1621
Layout, 1633
Pasting, 1562
Selecting, 1668
Single messages, 1670
Tags, 1689
Text library text table, 1687
User archive runtime table, 1658
Views, 1673

Object name, 383, 464, 1578
Changing, 1578

Object name:Object Name of the Object Connected 
at the beginning, 464
Object name:Object Name of the Object Connected 
at the End, 464
Object OLL:Adding Graphic OLLs, 216
Object origin, 228, 1559
Object palette, 238, 378, 473, 1520, 1525

Control selection, 218, 329
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Object properties, 424, 435, 1570
Changing, 1570
Changing attribute, 1576
Changing font, 1585
Changing miscellaneous properties, 1586
Changing styles, 1588
Linking objects, 1575
Object property, 424
Opening, 1571
Renaming objects, 1578
Styles, 1587
Toolbar, 1572
Transferring, 1556, 1577

Object properties"window "Open configuration 
dialog, 334
Object properties:Object properties, 428, 431
Object properties:Object property, 435
Object propertiesTab, 1573
Object propertiesToolbar

WindowPin, 1572
Object property, 421, 428, 431
Object property:Transferring object properties, 435
Object selection, 256, 1563, 1572

Surrounding, 1565
Touching, 1565

Object selection for the project documentation, 1679
Object size, 1560
Object statistics , 1679
Object transparency, 473
Object type, 256, 426, 623, 679, 1572

Always reset object type selection, 256
Setting object types, 679

Object:Changing static text, 504
Object:Copying Objects, 298
Object:Inserting an Object into a Picture, 382
Object:Number of objects, 224
Object:Object in the picture, 421
Object:Object OLL, 216
Object:Object selection, 216, 426
Object:Rotating Objects, 396
Object:Scaling an Object, 393
Object:Selecting Objects, 385
Objective, 421
Object-OLL:Configuring Graphic OLLs, 216

Objects, 1568
Aligning, 1568
Arranging, 1568
Copying, 1563
Cutting, 1563
Default settings, 1543
Deleting, 1563
Duplicating, 1563
Editing, 1563
Editing dynamic standard objects, 1618
Editing for the runtime documentation, 1634
Editing static objects, 1589
For runtime documentation, 1529
For the project documentation, 1532
Invisible, 473
Linking, 1575
Multiple selection, 1567
Objects of the Object Palette, 473
Positioning, 1563
Scaling, 1563
Working with standard objects, 1589

Objects for the project documentation, 1666
Objects for the runtime documentation, 1634

process, 1634
Objects for the Runtime documentation

WinCC Control Runtime Printprovider, 1634
Objects of the Object Palette, 378
Objects:Changing Objects of a Group, 615
Objects:Connecting objects, 506
Objects:Duplicating Objects, 402
Objects:Importing Objects into the Library, 653
Objects:Transferring objects, 296
OCX display, 256
ODBC data source, 1493
ODBC database, 1493

Printing data, 1492, 1493
Reporting, 1493

ODBC database field, 1528
Defining output options, 1623
Defining SQL statement, 1623

ODBC database table, 1528
Defining column width, 1625
Defining output options, 1625
Defining SQL statement, 1625

OLE object, 509, 522, 524, 526, 1527
Inserting, 1614
modify, 1614

OLE object:Change OLE object, 522
OLE object:Create new OLE object, 526
OLE object:Creating OLE Object from File, 524
OLE object:Edit OLE object, 522
OLE Object:OLE object:Inserting OLE Object, 522
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One to the back, 403
One to the front, 403
Online, 1484

Changing log output, 1476
Reporting messages, 1484, 1486

Online configuration, 72, 1036, 1205, 1247, 1301
Messages, 72

Online Configuration, 1211, 1253, 1307
Online delta loading, 76
Online reporting, 1486, 1529

Message lists, 1485
Message report, 1485
Overview of objects, 1529

Online Table Control, 1186, 1316
Changing configuration, 1327
configuration, 1321
display of archived values, 1334
dynamic display, 1319
dynamizing time range, 1319
Inserting, 1322
operation in Runtime, 1326
representation formats, 1317
starting update, 1332
static display, 1319
stopping update, 1332
time range, 1319

Online tags, 1393
Online Trend Control, 1357

Changing configuration, 1360
Common axes, 1340
Determine co-ordinate points, 1367, 1408
Display of archived values, 1370
Inserting, 1348
Linear Interpolation, 1339
Online tags, 1351, 1354
Representation formats, 1339
Resolution, 1220, 1337
Single values Online Trend Control:step curve, 
1339
Staggered trends, 1342
Starting update, 1365
Stopping update, 1365
Trend on top, 1365
Writer function, 1343

Online Trend Control:configuration, 1347
Online Trend Control:dynamic display, 1343
Online Trend Control:dynamizing time range, 1352
Online Trend Control:enlarging section, 1369
Online Trend Control:static display, 1343
Online Trend Control:time jumps, 1346
Online Trend Control:time overlap, 1346
Online Trend Control:time range, 1343

OnlineTableControl, 1186
Buttons in the Toolbar, 1208
Changing the column display in runtime, 1214
Configuring the data export operation, 1034, 1204, 
1246, 1300
Configuring the evaluation with the RulerControl, 
1200, 1242, 1296
Configuring the status bar, 1025, 1196, 1239, 
1293
Configuring the time columns of the table window, 
1187
Configuring the toolbar, 1025, 1196, 1239, 1293
Creating statistics in runtime, 1215
Display of archived values, 1215
Editing table fields in runtime, 1213
Marking the selected cells and rows, 1021, 1024, 
1192, 1195
Online configuration, 1036, 1205, 1247, 1301
Online Configuration , 1211
operation in Runtime, 1208
Properties of the table elements, 1021, 1192
Sorting by column header, 1021, 1024, 1192, 
1195
Start and stop update, 1213
Table element colors, 1021, 1022, 1192, 1193
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OnlineTrendControl, 1224, 1278
Buttons in the Toolbar, 1250
Change the sequence of the displayed trends, 
1256, 1309
Configuring a trend window, 1225, 1265, 1267, 
1270
Configuring the axes of trends, 1222
Configuring the data export operation, 1034, 1204, 
1246, 1300
Configuring the evaluation with the 
TrendRulerControl, 1200, 1242, 1296
Configuring the status bar, 1025, 1196, 1239, 
1293
Configuring the time axes in trend windows, 1227
Configuring the toolbar, 1025, 1196, 1239, 1293
Configuring the value axes in trend windows, 
1230
Configuring the value columns of the table 
window, 1190
Configuring trends, 1235, 1286
Configuring trends for the trend window, 1233
Creating statistics in runtime, 1260
Determining the coordinates of a point, 1256
Display a trend in the foreground, 1256, 1309
Display of archived values, 1264
Online configuration, 1036, 1205, 1247, 1301
Online Configuration, 1253
Online tags, 1190
Operation in Runtime, 1250
Representation Trend Lines, 1221
Start and stop update, 1255, 1308
Using the zoom functions in trend windows, 1258, 
1311

Only Large Tick Marks, 457, 544
Opening, 212, 281, 1519, 1701

Line layout, 1701
Page layout, 1519

Opening library, 646
Opening object properties configuration dialog, 334
Opening the "Settings" window, 254, 256, 264, 267, 
269
Operable objects, 677
Operating archives, 1851
Operating elements, 1538
Operating system, 1726

Changing languages, 1726
Requirements for multilingual configuration, 1726

Operating system language, 1719
Operating system user interface language, 1719
Operation, 119, 586, 606, 677

Documenting, 1837
Operation in Runtime, 1091, 1326, 1357, 1837

Operation steps, 450
Operation Steps, 600
Operator activities report, 450
Operator Activities Report, 469
Operator authorization, 1935, 1943
Operator Authorizations, 469
Operator control enable, 450
Operator input message, 450, 469
Operator Input Message, 887
Operator privilege, 1937, 1944
Operator station

Creating, 1880
Operator Station, 1879
Operator-Control Enable, 469
Operator's overview

Text library, 1753
Operator's Overview, 1753
Option, 146
Option:SIMATIC logon, 1827
Option:WinCC logon, 1827
Options, 256
Orientation, 1581
Origin, 228, 1559

Coordinate origin, 1559
Object origin, 1559

OS, 1879
Compiling, 1900
Creating, 1880
OS properties, 1868, 1880
Standby OS properties, 1872

OS project editor, 1467
Project documentation, 1467

OS properties, 1868, 1880
OS ref.WinCC application

ObjectWinCC Appl. Ref.WinCC 
application:creating reference , 1876, 1885

OS simulation, 1898
Starting, 1898

Other object properties, 1585
Outer frame, 371
Outline, 345
Output format, 459, 533, 535, 536, 537, 1585
Output medium for print jobs, 1442
Output of CSV file as curve, 1664
Output of CSV file as table, 1662
Output of user-specific data, 1509
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Output options, 1476, 1695
Changing in Runtime, 1476
Defining for the OCBC database field, 1623, 
1625
Dynamic table, 1695
Editing object:editObject:object 
Object:objectstatistics , 1679
Editing object:editObject:object user archive 
selectionforprojectdocumentation , 1671
Editing object:editObject:object 
view:configurationdataoutput , 1673
For dynamic metafile, 1693
For dynamic text, 1692

Output parameters for hardcopy, 1504
Output value, 459, 1585
Output/Input, 459
Overview list, 226

P
Package, 1893

Assigning OS server, 1893
Page break, 1585
Page layout, 1433, 1519

Changing, 1554
Configuration, 1433
Copy, 1556
Create, 1473
Displaying properties, 1433
Edit, 1473
For message sequence report, 1489
Multilingual, 1550
Opening, 1519

Page layout editor
Basic settings, 1543
Changing units, 1543
Screen, 1520
Setting options, 1543

Page number, 1529
Output in a report, 1631

Page size, 1706
In line layout, 1706

Page Size in the Line Layout, 1710
Palette, 275, 276, 1540

Adapting, 1540
Hiding, 1540
Moving, 1540
Showing, 1540

Palette:Move palette to the border of the screen, 276
Palette:Moving a palette as a window on the desktop, 
276
Paper format, 1581

Parameter for hard copy, 1502, 1504
Parameters, 112
Parameters of a message, 928
Paste, 296, 298, 401
PC station, 1864, 1865, 1876, 1885
PCS 7

Applying tag properties, 1356
PCS7 System Authorizations, 1855
PDD, 267
Performance, 111
Picture, 119, 122, 221, 278, 280, 281, 282, 284, 286, 
354, 363, 375, 434, 450, 454, 455, 554, 610, 658, 
1889, 1896

Copy, 282, 1891
Copying to library, 1896
Creating, 1890
Creating model solutions, 1896
Define customized menu, 667
Define customized toolbars, 667
Delete, 1891
Deleting in library, 1896
Exporting text, 1768
Importing, 1892
Moving, 1891
Moving to library, 1896
Navigation, 659
Open, 221
Rename, 221, 282, 1891
Renaming in library, 1896

Picture alignment, 454
Picture Buffer, 119
Picture Buffer Size, 119
Picture Cache, 128
Picture change, 1851
Picture content, 342
Picture cycle, 269
Picture Deact. Referenced, 455
Picture Deact. Transparent color, 455
Picture Deact. Transparent Color On, 455
Picture editing, 1851
Picture file, 224
Picture name, 450
Picture Name, 610
Picture object, 450, 1773

Configuring for multiple languages, 1773
Translating text, 1773

Picture Off Referenced, 455
Picture Off Transparent Color, 455
Picture Off Transparent Color On, 455
Picture offset X, 450
Picture offset Y, 450
Picture On Referenced, 455
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Picture On Transparent Color, 455
Picture On Transparent Color On, 455
Picture origin, 228, 1559
Picture properties, 288, 295
Picture Selection with Preview, 606
Picture Size, 224
Picture text

Export, 1768
Picture Tree Manager, 1466

Project documentation, 1466
Picture Window, 509, 516, 610

Change, 516
Define customized menu, 668
Define customized toolbars, 668

Picture: Status Off, 455
Picture:Define picture as start picture, 122
Picture:Deleting, 284
Picture:Saving, 281
Picture:Testing in Runtime, 658
Picture:Transparent Color On, 454
Picture-in-picture method, 827
Pictures, 1764

Generating multilingual, 1764
PicturestatisticsOutputoptions

Changing ObjectProjectdocumentation for picture 
statistics, 1675

Pie segment, 475, 497, 1527
Drawing, 1602
modify, 1602

Pie segment:Changing a pie segment, 497
Pie segment:Drawing a pie segment, 497
Pin, 424, 426

Activating Pin, 424
Deactivating Pin, 424

Pinning window to top, 1570
Plant-specific authorizations, 1819
Pointer length, 350
Polling list, 1585
Polygon, 475, 481, 1527

Drawing, 1592
modify, 1592

Polygon line:Changing a polygon line, 483
Polygon line:Drawing a polygon line, 483
Polygon:Changing a polygon, 481
Polygon:Drawing a polygon, 481
Polyline, 475, 483, 1527

Drawing, 1593
modify, 1593

Portrait, 1581
Position font, 372
Position Text, 369
Position X, 328, 438, 1581

Position Y, 328, 438, 1581
Positioning, 328, 403
Power failure, 1007

reloading messages, 1007
Power management, 111
Power tag, 164
Prerequisite for Runtime, 679
Pressed, 443
Preview, 216, 354, 547, 553, 1448

Project documentation, 1448
Print buffer, 1442
Print job, 1438, 1450, 1474

Attitudes, 1442
creating multiple languages, 1790
Edit, 1438, 1452
Features, 1474
Limit conditions, 1436, 1438, 1440
modify, 1452, 1474
opening, 1452, 1474
process, 1474
Properties, 1452
Selecting a time range for the data, 1440
Settings, 1436, 1438, 1440
Supplementary conditions, 1442

Print job list, 1438
Print job properties, 1436, 1438
Print Jobs, 513
Print jobs for project documentation, 1510
Print jobs for Runtime documentation, 1513
Print Jobs in WinCC, 1436
Print margins, 1581
Printer, 1452

Defining, 1452
Select, 1452

Printer buffer range, 1442, 1474
Printer failure, 1442
Printer fault, 1442
Printer settings for line layout, 1706
Printers, 1442, 1474

Defining, 1442, 1474
Selecting, 1442, 1474
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Printing, 111, 1446, 1474, 1670, 1786, 1812
Cyclic printing, 111
Data from COM server, 1492
Data from CSV table, 1492
Data from external application, 1492
Hard copy, 1492
Multilingual project documentation, 1792
ODBC database, 1492, 1493
Project documentation, 1446
Reports in page layout, 1446, 1474
Single messages, 1670
User archive, 1491
WinCC User Archive Control, 1491

Printing CSV trend, 1492
Printing project documentation, 1812
PrintScreen, 1502
Priority, 907
Priority of a single message, 928
process, 1680

Action types for the project documentation, 1680
Attributes, 1677
Compressed archive object:output of 
configuration data , 1684
CSV provider table, 1662
CSV provider trend, 1664
Dynamic metafile, 1693
Dynamic table, 1695
Object Object:source text , 1680
Object project documentation:tag selection , 1689
Objects for the project documentation, 1666
Objects for the runtime documentation, 1634

Process control message, 914
Process controlling, 1851, 1853, 1854
Process driver connection, 450
Process picture

Creating Process Pictures, 209
Process picture:Testing Process Pictures in Runtime, 
656
Process screen, 656
Process tag, 164, 1120

create, 189
Licensing, 164
Power tag, 164
Usable data types, 164

Process value, 1120
saving in database, 1136
Swapping out, 1138

Process value archive, 1144, 1182, 1322
configuration, 1175
configuring, 1322
Configuring, 1144

Process value archive Process value archive , 1682

Process value archiving, 1117, 1134, 1182
Acyclic, 1133, 1182
Application, 1117
at value change, 1133
client/server scenarios, 1118
configuration, 1142
Configuration, 1117
Cyclic, 1129, 1182
cyclic-selective, 1131
Event-driven, 1133
Fundamentals, 1117
multi-user projects, 1118
Principle of Operation, 1117
process-controlled, 1134
Term definitions, 1115

Process value block, 905
Adding, 909
Features, 910
Removing, 912

Process value output
As table, 1184, 1315
As trend, 1184, 1315
In process picture, 1184, 1315
In Reports, 1313

Process Value Output, 1184
Process values, 1490

Logging, 1490
Process-controlled tag, 1120, 1121
Processor utilization, 111
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Project, 29, 1725, 1888
Activating, 132
Archiving, 138
Basic Process Control, 54
Changing multi-user project into a single-user 
project, 50
Changing project type, 49
Changing single-user project into a multi-user 
project, 50
client project, 48
Closing, 32
Copy, 139, 145
create, 55
Creating, 51, 55
Data storage, 155
Deactivating, 137
Defining computer properties, 59
Defining hotkeys, 110
Duplicate, 138, 142
Faceplate types, 51
File structure, 155
Folder structure, 155
Imported files, 155
Loading online changes, 76
Multilingual creation, 1725
Multi-user project, 47
Naming conventions, 51
Online configuration, 72
opening, 29
Opening, 1888
Picture hierarchy, 51
preparation for creation, 51
Project path, 51
Project type, 46, 51
Reusable project sections, 51
Setting up Autostart, 135
Setting up startup list, 107
Single-user project, 46
Tag groups, 51
Time settings, 64, 66
WinCC client, 48
Working with projects, 29

Project documentation, 1431, 1446, 1680, 1792
Archive selection, 1671, 1682
Attributes, 1677
Calling, 1445
Changing for user archives, 1671
Changing for views, 1673
Changing layouts, 1554
Changing objects, 1666
Changing of attributes, 1677
Create, 1431
Creating, 1446
Defining action types, 1680
Design, 1431
Editing dynamic metafile, 1693
Editing dynamic table, 1695
Editing dynamic text, 1692
Editing objects, 1666
For objects in Pictures, 1679
Generating multilingual, 1792
In Alarm Logging, 1457
In Global Script, 1460
in Graphics Designer, 1455
In tag logging, 1459
In the audio alarm editor, 1465
In the C editor, 1460
In the component list editor, 1468
In the lifebeat monitoring, 1467
In the OS project editor, 1467
In the Picture Tree Manager, 1466
In the Text Library, 1462
In the time synchronization editor, 1464
In the User Administrator, 1463
in the VBS editor, 1460
In the WinCC Explorer, 1454
Introduction, 1445
Menu selection, 1445
Output, 1446
Output of connections, 1691
Overview, 1431
Picture statistics, 1675
Preview, 1448
Selecting languages, 1687

Project documentation setup, 1812
Project duplicator, 138
Project Duplicator, 139, 142, 145
Project language, 899

Switching, 1728
Project Language, 1719
Project library, 212, 646, 653

Converting project library, 212
Project manager, 1851
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Project name, 1529
Output in a report, 1631

Project Planning Notes, 278
Project settings, 64, 66
Project status, 149
Project type, 46

Changing, 49
Changing multi-user project into a single-user 
project, 50
Changing single-user project into a multi-user 
project, 50
Client project, 48
Multi-user project, 47
Single-user project, 46

Project window, 896
Properties, 112, 114, 212, 221, 224, 256, 334, 347, 
351, 352, 355, 360, 361, 363, 372, 373, 375, 428, 616, 
629, 655, 995

Attribute properties of Customized Object, 629
Editing properties, 256
Message archive, 995
Object, 1570
Properties of a Customized Object, 623
Properties of Siemens HMI Symbol Library, 340, 
343, 345, 347
properties of WinCC Digital/Analog Clock Control, 
351, 354
Properties of WinCC digital/analog clock control, 
350
Properties of WinCC Gauge Control, 356, 357, 
359, 360, 361, 363
Properties of WinCC Slider Control, 370, 371, 372, 
375
Transferring object properties, 1577

Properties folder, 428, 1573
Properties of Siemens HMI Symbol Library"Symbol 
Library, 340, 343, 345
Properties of Siemens HMI Symbol 
LibrarySymbolLibrary , 340, 343
Properties of Siemens HMI Symbol 
LibrarySymbolLibrary  , 345
Properties of the WinCC Gauge Control"Decimal 
point, 357
Properties of the WinCC Gauge Control"Labeling 
offset, 356
Properties of the WinCC Slider Control"Appearance, 
369
Properties of the WinCC Slider 
Control"Tab:"General" measuring range tab, 370
Properties of WinCC digital/analog clock control 
"Appearance", 350

Properties of WinCC digital/analog clock control 
appearance , 350
Properties of WinCC Digital/Analog Clock Control 
Background image: , 354
Properties of WinCC Digital/Analog Clock Control 
digital display , 351
Properties of WinCC Digital/Analog Clock Control tab

Clock Control tab, 352
Properties of WinCC Digital/Analog Clock 
Control"digital display, 351
Properties of WinCC Gauge Control Decimal point , 
357
Properties of WinCC Gauge Control Labeling offset , 
356
Properties of WinCC Slider Control 3D effects Tab

Inner Frame tab , 371
Properties of WinCC Slider Control Appearance , 
369
Properties of WinCC Slider Control Tab

Font tab, 372
General tab Measurement area , 370
Tab Clear, 375
Tab Properties:properties of WinCC Slider 
Control, 373

Properties of WinCC Slider Control Tab:Font size tab, 
372
Properties of WinCC Slider Control"3D 
effects"Tab:"Inner Frame tab, 371
Properties:Computer properties, 112, 114
Properties:Object properties, 423
Properties:Properties of a group, 616
Properties:Properties of a picture file, 224
Properties:properties of Siemens HMI Symbol 
Library, 340, 345, 347, 655
Properties:properties of WinCC Digital/Analog Clock 
Control, 351, 354
Properties:properties of WinCC Gauge Control, 356, 
357, 359, 360, 361, 363
Properties:properties of WinCC Slider Control, 370, 
371, 372, 375
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Property group, 437, 438, 441, 443, 446, 448, 450, 
455, 456, 457, 458, 459, 461, 463, 464, 465, 625, 
1581

Background color property group:changing, 1579
Customized Object properties, 625
Font, 1584, 1585
Geometry, 1583
Margins property group:dynamic, 1581
Miscellaneous, 1585, 1586
Object property group:Font, 1584
Object property group:Miscellaneous, 1585
Rename, 625
Styles, 1587, 1588

Property Group:"Assignment" Property Group, 465
Property Group:"Axis" Property Group, 457
Property Group:"Colors" Property Group, 441
Property Group:"Connected Objects" Property 
Group, 464
Property Group:"Flashing" Property Group, 448
Property Group:"Font" Property Group, 446
Property Group:"Geometry" Property Group, 438
Property Group:"Limits" Property Group, 458
Property Group:"Lock" Property Group, 463
Property Group:"Message Types" Property Group, 
461
Property Group:"Output/Input" Property Group, 459
Property Group:"Pictures" Property Group, 455
Property Group:"Status" Property Group, 456
Property Group:Property Group, 453, 454
Protocol, 1469

Activating configuration dialog, 1476
Configuration, 1433
Create, 1473
Dynamic log parameters, 1469
dynamic operation, 1469
Edit, 1473
For the Runtime documentation, 1469
In the page layout, 1433

Protocol parameters, 1476
dynamic operation, 1476

Q
QTM message procedure, 887
Quality codes, 207
Quantity, 226
Quantity limitation, 1084
Quick Configuration, 606

R
Radio box, 583, 592
Radio Box:Change Radio box, 592
Radio Box:Insert Radio box, 592
Radius, 438, 1581
Radius Y, 1581
Radius:Radius X, 438
Radius:Radius Y, 438
Raised, 371
Range selection for hard copy, 1621
Range selection for hardcopy, 1621
Raw data tag, 187
Raw data type, 1121
Rectangle, 232, 475, 500, 1527
Rectangle surrounding the object, 232, 1560
Rectangle:Changing a rectangle, 500
Rectangle:Drawing a rectangle, 500
Reducing the number, 592
Redundancy, 142

Activated project, 145
Copying project, 145
Duplicating project, 142
Runtime, 145

Reference object, 386
Reference Object of a Multiple Selection, 1565
Reference Object:Reference Object of a Multiple 
Selection, 386
Regional date display, 1793
Regional time display, 1793
Registration of OCX controls, 332
Releasing connection, 506
Relinking

Linking of the Tag Connection, 418
Remote activation/deactivation, 1853
Remote configuration, 1853
Replace, 405, 418

Text in the text library, 1761
Report, 1486, 1554, 1889

Changing Layouts, 1554
Chronological output, 1486
Copy, 1891
Creating, 1890
Delete, 1891
From ODBC data source, 1493
Importing, 1892
Introduction, 1431
Message sequence report, 1486
Moving, 1891
Multilingual output in runtime, 1793
Rename, 1891
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Report contents, 1433
Report Designer, 1431

Basic settings, 1538
Report elements, 1476

dynamic operation, 1476
Report functions, 1485

Activation in WinCC Alarm Control, 1485
Report object, 1654, 1655, 1661

Alarm report, 1655, 1661
Archive report, 1654, 1655, 1661
Message report, 1654

Report system, 1431, 1854
Report template, 1896

Copying to library, 1896
Creating model solutions, 1896
Deleting in library, 1896
Moving to library, 1896
Renaming in library, 1896

Reporting, 469, 1658
Data from external application, 1492
ODBC database, 1492, 1493
User archives table, 1658

Reporting compression archive, 1635, 1638, 1640, 
1643, 1645, 1647
Reporting CSV file, 1495
Reporting of messages, 887

Archive report, 887
Message sequence report, 887

Reporting of ODBC database, 1493
Reporting process values, 1635, 1640, 1643, 1647
Reporting user archive, 1658
Reporting user archives table, 1658
Reports, 1431, 1786

Configuration, 1433
In the line layout, 1435, 1486
In the page layout, 1433
Introduction, 1431
Multilingual, 1786
See report, 1431

Representation formats, 1317
Representation in trend format, 1339
Representation of process values, 1220, 1337
Representation of process values in tables, 1186, 
1316
Requirement for Runtime, 678
Reserve 4, 542
Reserve 5, 542
Resetting, 998, 1175
Resolution, 1274, 1373
Restoring, 1540

Buttons, 1541
Palette, 1540

Restoring the original view, 276
Return, 1941
Rotation, 343, 396
Rotation angle, 438, 466, 504
Rotation of objects, 466
Rotation reference X, 438, 466, 504, 1581
Rotation reference Y, 438, 466, 504, 1581
Round Button, 583, 594, 610
Round button:Changing a round button, 594
Round button:Inserting a round button, 594
Rounded rectangle, 475, 502, 1527

Drawing, 1610
modify, 1610

Rounded rectangle:Changing a rounded rectangle, 
502
Rounded rectangle:Drawing a rounded rectangle, 
502
Run at, 431
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Runtime, 72, 76, 112, 116, 119, 124, 126, 132, 206, 
338, 466, 656, 657, 658, 678, 679, 1091, 1211, 1250, 
1253, 1260, 1304, 1307, 1326, 1402, 1795

bringing to front, 1332
Changing the column display in 
OnlineTableControl, 1214
Configuring language change, 1797
Creating trend statistics in OnlineTableControl, 
1215
Defining hotkeys, 110
defining time range, 1319
Display in front, 1365
display of archived values, 1334
Display of archived values, 1370
displaying archived messages, 1005
Displaying archived values in OnlineTableControl, 
1215
Displaying archived values in OnlineTrendControl, 
1264
editing fields, 1333
Editing table fields in OnlineTableControl, 1213
Editing tags in runtime, 206
Emergency acknowledgement of messages, 
1102
Emergency acknowledgment of messages, 1050
Exiting, 137
Language switching, 1795
Loading online changes, 76
Locking and enabling messages, 1048
Locking messages, 1096
Menus and toolbars, 659
message archive data output, 1004
Multilingual project, 1795
Multi-user system, 132, 137
Online configuration, 72
Operating the AlarmControl, 1042
Operating the OnlineTableControl, 1208
Operation of alarm control, 1091
operation of Online Table Control, 1326
Operation of Online Trend Control, 1357
Operation of the Function Trend Control, 1402
Operation of Trend Control, 1357
Output of multilingual reports, 1793
Parameterization dialogs, 1327, 1360
Redundant system, 132
Representation of process values, 1323
Requirements, 105, 132
Runtime Cursor On/Off, 119
Selecting archive, 1327, 1360
selecting columns, 1332
Selecting messages, 1046
Selecting tags, 1327, 1360
Selection of messages, 1093
Setting the runtime computer starting 

configuration, 1796
Setting up Autostart, 135
Setting up startup list, 107
Settings, 105
Sorting messages, 1051, 1104
Starting, 132
Trend Control, 1357
Trend in the foreground, 1256, 1309
Using the zoom functions in trend windows, 1258, 
1311

Runtime computer, 1796
Setting starting configuration, 1796

Runtime documentation, 1474, 1485, 1529
Creating layout, 1473
Dynamic log parameters, 1476
Output, 1474, 1485
Overview of objects, 1529
Setting up print job, 1474

Runtime documentation/components, 1469
Runtime documentation/dynamizable parameters, 
1479
Runtime documentation/dynamization, 1469, 1479
Runtime documentation/introduction, 1469
Runtime language, 1795

Configuration, 1728
Runtime:Activating Runtime, 657
Runtime:Deactivate Runtime, 657
Runtime:defining time range, 1343
Runtime:representation of process values, 1338
Runtime:Runtime module, 116
Runtime:Runtime Settings, 466
Runtime:selecting trend, 1338
Runtime:Setting up Runtime, 112

S
Same size, 438, 1581
Sample Text, 351, 360, 372
Save as, 281
Save settings on exit, 256
Saving default settings of objects, 267
Saving layout under new name, 1556
Scale, 357, 359, 371, 441, 457, 544, 600
Scale end value, 357
Scale font , 360
Scale Offset, 357
Scale text font, 360
Scale:Scale color, 441
Scale:Scale marks, 457, 544
Scale:Setting scale division, 544
Scale:Setting scale end values and zero point value, 
544, 600
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Scaling, 200, 326, 393
Specifying linear scaling, 200

Scaling factor, 450
Screen Navigation, 119, 659
Screen saver, 111
Scroll bar, 450
Scroll Bar, 468
Scroll bar position X, 450
Scroll bar position Y, 450
Search function, 44
Searching, 44

Date, 44
Name, 44
Searchable elements, 44

Segment, 1136
Select the Active Layer, 294
Selected Box, 459
Selected Events, 632
Selected Graphic OLLs, 216
Selected Properties, 623
Selected Themes, 625
Selecting, 385, 1567, 1670

Multiple objects, 1567
Single messages for the project documentation, 
1670

Selecting a color, 434
Selecting a page range, 1440
Selecting a picture, 434
Selecting a time range for the data, 1440
Selecting ActiveX controls, 212
Selecting Message Blocks, 1713
Selecting OCXs , 332
Selecting statistics range, 1335, 1367
Selecting the default trigger, 269
Selecting user hierarchies in PCS7, 1831
Selection, 1682

Changing for picture statistics, 1675
Changing for product documentation of attributes, 
1677
Changing for user archives, 1671
Changing for views, 1673
Of the archive tags, 1684
Of the archives for the project documentation, 
1682

Selection Background Color, 441
Selection borders, 386
Selection Dialog, 434
Selection Font Color, 441
Selection Frame of a Multiple Selection, 1565
Selection Frame:Selection Frame of a Multiple 
Selection, 386
Selection in the form of buttons, 434

Selection marks, 1560
Selection of action types for the project 
documentation, 1680
Selection of Archives, 1682
Selection of compressed archive data, 1682
Selection of configured languages for project 
documentation, 1687
Selection of messages, 1084, 1093, 1656
Selection of objects, 1668
Selection of Picture, 547, 553
Selection of process value archive data, 1682
Selection of Tags, 1689
Selection of the archive tags, 1635, 1638, 1640, 1643, 
1647, 1684
Selection of the connections, 1691
Selection options, 1668

For the project documentation, 1668
Server, 1118, 1838

Diagnostic information, 151
Logon server, 1838

Server data, 1893
Assigning OS server, 1893

Server name, 450
Server prefix, 450, 817
ServerPrefix, 817
Server's time zone, 64
Server-server communication, 1118
Setting authorizations, 588
Setting format of label, 544
Setting format of tick marks, 544
Setting layout of the scale, 544
Setting options, 1543

Page layout editor, 1543
Setting print margins, 1581
Setting print start time, 1438
Setting selected boxes, 589, 592
Setting Start Parameter, 1438
Setting start parameters, 1442
Setting the length of the ellipse arc, 491
Setting the number of boxes, 589, 592
Setting the size range for the display of objects, 264
Setting the tab order cursor's sequence, 679
Setting up print job, 1450, 1474
Setting up users, 1814
Setting zoom ranges for individual layers, 264
Settings, 254
Settings ..., 254, 264, 267, 269
Setup, 1450

Print job, 1450, 1474
Shared time column, 1317
Short, 179
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Shortcut key, 262, 1546
Showing, 1546

Short-term archive list, 887, 1014, 1070
Show/hide, 264
ShowDialog function, 1845, 1847
Showing, 1543

Grid, 1543
Showing and Hiding Layers and Objects, 264
Siemens HMI Symbol Library, 655
Signature, electronic, 1844
Signed 16-bit value, 179
Signed 32-bit value, 181
Signed 8-bit value, 177
Signed byte, 177, 178
Signed Dword, 181
Signed word, 179
Signing Off Archive Backup File, 1000, 1177
SIMATIC logon, 1809
SIMATIC Logon service, 1837, 1838, 1839

Login dialog, 1839
SIMATIC Logon Service, 1844

Login dialog, 1844
SIMATIC Manager, 1857, 1861, 1864, 1879, 1886, 
1888, 1889, 1897, 1898

Adopting language settings, 1888
Simulation, 1898

SIMATIC Manager, 1898
Starting, 1898

Single acknowledgement, 887

Single message, 887, 927, 1075
Acknowledging, 935
Acknowledgment bit, 928, 935
Acknowledgment tag, 935
Archiving, 887
Configuring a message, 928, 1075
Creating, 931
Defining colors, 920
Display process value, 940
Editing multiple messages, 967
Exporting, 966
Format DLL, 928
Formatting Instructions, 938
Hide mask, 928, 945
Hiding Messages, 945, 1054, 1100
Importing, 964
in a group message, 982
Info text, 938
Loop In Alarm, 943
Message bit, 928, 932, 991
Message class, 916
Message group, 928
Message number, 928
Message tag, 932, 991
Message text, 938
Message type, 887
Parameters of a message, 928
Process values in the message text, 940
Properties, 928
Selection, 1093
Specifying an action, 943
Status bit, 928, 933
Status tag, 933
Structure of a Message, 887
Tag of a process value, 936

Single messages, 1670
Objects for the project documentation, 1670
Output in a report, 1670
Printing, 1670
Selecting, 1670

Single values, 1375
Single-user project, 46

Changing project type, 50
Sizeable, 450, 468
Slave Pointer, 356
Slider, 368, 369, 583, 597, 598, 600
Slider control, 368, 369, 370, 371, 372, 373, 375
Slider Control, 320
Slider picture, 375
Slider:Changing Slider, 597
Slider:Inserting Slider, 597
Slider:Slider Configuration, 598
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Smart object, 322, 340
Smart objects, 473, 509, 1558
Snap to Grid, 254
Snapping to grid, 1544
Solid, 345
Sort conditions, 1660

For the user archive report, 1660
Sort text contents, 405
Sorting messages, 1084, 1104
Source, 421
Spacing objects, 1568
Special characters, 152, 1722, 1730

Usage, 1722
Specify picture zoom area, 516
Specifying an action, 943
Specifying field type, 531, 560
Specifying type of value input, 531
SQL statement used to filter messages, 1112
Square, 350, 356
Square-wave

Drawing, 1608
modify, 1608

Standard deviation, 1335, 1371
Standard function, 1106

Example of use, 1068, 1108
Standard objects, 473, 475, 1526, 1558, 1589
Standard toolbar, 236, 262, 277, 1523, 1705
Standard toolbar: Drag&drop with ALT key active, 
262
Standard Toolbar:Changing the Standard Toolbar 
with drag&drop, 277
Standard Toolbar:Changing the Standard Toolbar 
with the Configuration Dialog, 277
Standard toolbar:configurable, 262
Standard Toolbar:Restoring the Standard Toolbar, 
277
Standard trigger, 269
Standby computer, 1872

Selecting, 1872
Standby OS properties, 1872
Start angle, 438
Start Debugger, 128
Start Picture, 122
Start screen, 234
Start sequence of WinCC Runtime, 116
Start value, 189
Starting and stopping the update in table windows, 
1213, 1255, 1308
Starting angle, 1581
Starting archive, 1851
Starting point of archiving, 1127
Startup, 107, 112

Startup list, 107, 1502
Integrating application for hard copy, 1502
Multi-user system, 107
Setting up, 107

State, 456
Static, 428, 1573
Static display, 1319
Static metafile, 1527

Changing, 1616
Inserting, 1616

Static objects, 1526, 1527
Editing, 1589

Static text, 475, 504, 1527
Inserting, 1612
modify, 1612

Static text:Change static text, 504
Static text:Insert static text, 504
Static Text:Rotate, 504
Static text:Rotation in a group object, 504
Static value, 1573
Statistics, 224, 226, 1200, 1215, 1242, 1260, 1296
Statistics of Runtime data, 1371
Statistics range, 1371
Statistics:Displaying statistical characteristics, 224
Status, 207, 554

Connection, 207
Quality codes, 207
Tag, 207

Status bar, 40, 247, 1025, 1091, 1196, 1208, 1239, 
1250, 1293, 1304, 1520, 1538

WinCC Explorer, 40
Status Bar, 1830
Status bit, 928, 933

of a group message, 971, 977, 979
of a message, 928, 933

Status bit of a message, 928, 933
Status display, 509, 550, 553, 610

Status display configuration, 553
Status display:Changing a status display, 550
Status display:Inserting a status display, 550
Status list, 553, 554, 606
Status list:Clearing status list, 554
Status tag, 887, 928, 933

of a group message, 971, 977, 979
of a message, 928, 933

Status texts, 925
Status:Deleting status, 554
Status:Inserting status, 554
Status:Inserting status as bit position, 554
STEP 7, 1914

Message configuration, 1914
STEP 7 symbol, 1920
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STEP 7 symbols, 1929
Selecting, 1924, 1932
Showing, 1930
Transferring, 1926
window, 1921

STEP 7 Symbols, 1919
STEP7 message configuration, 1914
Stepped trend, 1375
Stopping archive, 1851
String, 537
Structure

Export file Text Library, 1740
Structure element, 167
Structure instance, 167
Structure tag, 167
Structure type, 167, 192

Applying, 195
create, 192
Using, 195

Style group, 239
Style original , 345
Style palette, 239, 1520, 1533
Style tab

Alignment tab, 343
Style" original, 345
Style" tab

"Alignment tab, 343
Styles, 443, 1588

Changing, 1588
Changing object properties, 1587

Substitute value, 199
Defining, 199

Swapping, 1000
Message archive, 1000
signing off message archive, 1000

Swapping out, 1138
of process values, 1138

Swapping out of process values, 1138
Switch language, 1764, 1781

In Alarm Logging, 1776
Switching languages, 1764

In Graphics Designer, 1764
Switchover, 434
Symbol Library, 320, 342
Symbols, 342
Symbols dialog

Dialog preview, 342
Symbols"Dialog:Dialog "Preview, 342
Synchronization of tags, 166
System block, 905, 907

System Block, 887
Adding, 909
Features, 910
Removing, 912

System change, 1854
System colors, 347, 352, 361
System layouts for project documentation, 1510
System layouts for Runtime documentation, 1513
System message, 887, 950, 960
System message class, 914

Requires acknowledgement, 914
Without acknowledgement, 914

System object, 1631
Changing, 1631
Date/time, 1631
Format options, 1631
Inserting, 1631
Layout name, 1631
Page number, 1631
Project name, 1631

System objects, 1526, 1529
System print job, 1436, 1452
System requirement, 1722

Multilingual configuration, 1722
System status, 945, 975
System wizard, 894
System Wizard, 904

T
Tab, 334

"Transparent frame" tab, 350
Basic color tab , 361
Clock Control tab , 351
Font size tab , 360
Format tab , 354, 363
General tab Properties:properties of WinCC Slider 
Control, 369
General tab standard color, 359
Library tab , 340
Linking, 1575
Properties of Siemens HMI Symbol Library tab 
Symbol Library, 347
Properties of SiemensHMISymbolLibrary 
categories tab, 342
Properties tab, 1573
Properties tab in Font Style window, 1573
Scale width tab , 357
Shadow tab , 345
Tab General background style, 356
Transparent frame tab , 350

Tab or Alpha Cursor, 119
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Tab Order, 677, 679
TAB order, 678, 679, 681, 682, 683
Tab:"Font Size" tab, 360
Tab:"Properties of Siemens HMI Symbol Library 
categories" tab, 342
Tab:"Properties of Siemens HMI Symbol Library" tab 
"symbol library, 347
Tab:basic color tab, 361
Tab:Clock Control tab, 351
Tab:Format tab, 354, 363
Tab:General tab Properties:"Properties of WinCC 
Slider Control", 369
Tab:Scale Width tab, 357
Tab:shadow tab, 345
Tab:Tab "General"Background style, 356
Tab:Tab "General"Normal color, 359
Tab:Tab "Library, 340
Table, 1695, 1708, 1709

Configuring time columns, 1187
Configuring value columns, 1190
Dynamic table, 1695
In line layout editor, 1708, 1709
separate time columns, 1318
shared time column, 1317

Table display formats, 1317
Table selection, 1660

User archives table, 1660
Table window, 896, 1827, 1829
Tables, 1186, 1316

dynamic display, 1317, 1320
Marking the selected cells and rows, 1021, 1024, 
1192, 1195
Properties of the table elements, 1021, 1022, 
1192, 1193
Sorting by column header, 1021, 1024, 1192, 
1195
static display, 1319
Table element colors, 1021, 1022, 1192, 1193
time range, 1319

Tag, 162, 163, 416, 418, 421, 450, 530, 541, 553, 
559, 598, 606, 608, 1120, 1528, 1920, 1929

communication driver, 174
Copying, 202
Creating internal tags, 190
Creating tag group, 197
Cutting, 202
data type, 174
Data type, 176, 177, 178, 179, 180, 181, 183, 184, 
187
Deleting, 202
Editing, 202
Editing in runtime, 206
Element, 167
external, 1120
External tag, 164
Importing, 163
instance, 167
internal, 1120
Licensing, 164
Linking tags at the places of use, 418
Linking tags by searching and replacing, 418
Moving, 202
Naming conventions, 163
Pasting, 202
Power tag, 164
Process tag, 164
Quality codes, 207
Renaming, 204
Setting up, 188, 190
Specifying linear scaling, 200
Status, 207
Structure element, 167
Structure instance, 167
Structure tag, 167
Structure type, 167
Tag group, 170
Tag management, 159
Tag Selection Dialog, 171
tag type, 174
Text reference, 176
Transferring, 1899
Updating, 163
Usable data types, 164
using structure types, 195

Tag assignment
Configuring, 838
Example: dynamic filling, 840

Tag bar, 1929, 1930, 1932
Tag connection, 416, 418

Linking Tag Connection of Objects, 418
Tag display, 416, 608
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Tag filter, 1921, 1930
Tag group, 170

Setting up, 197
Tag groups, 416, 608
Tag Logging, 1142

data window, 1142
navigation window, 1142
table window, 1142

Tag Login, 1822
Tag Login Assignment of computer, 1823
Tag Login Assignment of user, 1825
Tag Login Configuration, 1825
Tag Login: Configuration, 1824
Tag management, 159, 162

Data window, 159
Menu bar, 159
Navigation window, 159
Searching, 159
Status bar, 159
Structure, 159
toolbar, 159
Tooltip, 159

Tag object
Changing, 1629
Defining output format, 1629
Linking script, 1629

Tag palette, 246
Tag prefix, 450
Tag Prefix, 817
Tag Selection, 418
Tag selection dialog, 1920, 1921, 1924, 1926
Tag Selection Dialog, 171
Tag Table, 1490, 1529

Logging, 1490
Report object, 1529

Tag trigger:cyclic query, 820
Tag trigger:upon change, 820
Tag type, 174
TagPrefix, 817
Tags, 1689

Output of configuration data, 1689
Tags Selection of tag parameters , 1689
Tags:Tags - project: ..., 416
Target computer, 1868, 1875, 1880, 1884

Load project, 1875, 1884
Setting path, 1868, 1880

Target system, 1875, 1884
Loading, 1875, 1884

Tasks, 116
Telegram tag, 1121
Template, 513

Text, 446, 586, 606, 1692, 1747, 1899
Compile, 1743
Compiling, 1807
Displaying transferred text, 1912
Dynamic text, 1692
exportable, 1736, 1751, 1769, 1778
Exportable, 1746, 1749
Exporting from pictures, 1768
Importable, 1736, 1746, 1749, 1751, 1769, 1778
not used, 1763
Transferring, 1899

Text Distributor
Export file, 1739
Languages.csv, 1742
List export procedures, 1743
List import procedures, 1743
Representation, 1734
Status list, 1743
Use, 1732

Text Export, 1734
Text Import, 1734
Text Input, 434
Text library, 1747

 Missing Text ID, 1763
 Paste, 1759
 Replace, 1761
Central language administration, 1747
Copying text, 1758
Creating new language, 1756
Delete cell content, 1759
Delete lines, 1760
Deleting language, 1758
Display, 1764
Editing entries, 1753
Export Files, 1739
Filtering text, 1762
Find , 1760
Fonts, 1747
Generating reports, 1753
Insert new line, 1756
Language administration, 1753
Multiple selection, 1759
Not system text , 1763
Operator's Overview, 1753
Setting fonts, 1753
Translating text, 1753
WinCC Editors, 1747

Text Library
 Copy lines, 1759

Text library text table Foreign languages
Text output , 1687
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Text list, 509, 557, 559, 560, 1775
Configuring text lists in multiple languages, 1775

Text list:Changing text list, 557
Text list:Configuring a text list, 559
Text list:Inserting a text list, 557
Text orientation, 446
Text reference, 176, 450
Text Reference, 560
Text reference:Specifying text reference, 560
Text tag, 16-bit character set, 187
Text tag, 8-bit character set, 187
Text that is not used, 1763
Texts for multiple messages, 969
The "Picture Name" selection dialog, 610
Theme selection, 625
Tick marks, 544
Tick Text Offset, 357
Tick Width, 357
Time, 117, 349, 1631, 1793

Output in a report, 1631
Showing regional, 1793

Time base, 64
Time display, 349
Time format, 64
Time mode, 117
Time range, 1319, 1386
Time settings, 64

Communication, 64
Controls, 64
Project, 64, 66
Runtime documentation, 64

Time synchronization, 1464
Project documentation, 1464

Time values (250 ms - 1 h), 269
Time zone, 64
Tips for changing, 681
Title, 450, 468
Title bar, 40

WinCC Explorer, 40
Tolerance, 336
Tolerance limit, 542
ToleranceColor, 336
toolbar, 275, 276, 277, 412, 414, 426, 649

Toolbar, 39, 1018, 1025, 1077, 1091, 1196, 1208, 
1239, 1250, 1293, 1304, 1326, 1520, 1523, 1703, 
1826

Buttons, 39
Changing, 1541
Changing View, 1546
Configuring, 1543
customized ~ define for picture, 667
customized ~ define for picture window, 668
Hiding, 1540
In line layout editor, 1705
Operating the AlarmControl, 1042
Operation of alarm control, 1091
Showing, 1540
Table Control, 1326
User-defined, 659
WinCC Explorer, 39

Toolbar:Adapt toolbar, 277
Toolbar:The Library Toolbar, 649
Toolbars, 234, 262
Tooltip, 41
Tooltip text, 450
Total, 336, 338
T-piece, 603
Transfer, 1926

STEP 7 symbols, 1926
Transfer with Complete Input, 459
Transferring, 1577

Object properties, 1577
Transferring objects, 1556
Transferring picture properties, 295
Translating text

Text library, 1748
Transparency

Of objects, 473
Transparent, 350, 369
Transparent color, 454
Trend, 450, 542, 1221, 1222, 1227, 1230, 1233, 
1235, 1286, 1289, 1490, 1529

Configuring in OnlineTrendControl, 1225, 1265, 
1267, 1270
Configuring the axes in FunctionTrendControl, 
1282
Logging, 1490
Report object, 1529

Trend Color, 441
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Trend Control, 1220, 1337
Configuring in the Graphics Designer, 1348
Display in front, 1365
Operation in Runtime, 1357
Paramterization dialogs in Runtime, 1360
Runtime:Determine co-ordinates, 1367
Toolbar, 1357

Trend Control:enlarged display Runtime:enlarged 
display, 1369
Trend Control:example of configuration, 1352
Trend Control:representation of archived values, 
1338
Trend display, 1386
Trend representation, 1343
Trend window

Configuring in FunctionTrendControl , 1279
TrendRulerControl

Configuring the data export operation, 1034, 1204, 
1246, 1300
Configuring the ruler window/statistics window/
Statistics area window, 1200, 1242, 1296
Configuring the status bar, 1025, 1196, 1239, 
1293
Configuring the toolbar, 1025, 1196, 1239, 1293
Creating statistics in runtime with the 
OnlineTableControl, 1215
Creating statistics in runtime with the 
OnlineTrendControl, 1260
Marking the selected cells and rows, 1021, 1024, 
1192, 1195
Online configuration, 1036, 1205, 1247, 1301
Properties of the table elements, 1021, 1024, 
1192, 1195
Sorting by column header, 1021, 1024, 1192, 
1195
Table element colors, 1021, 1022, 1192, 1193

Trends
Common axes, 1340
Configuring the axes in FunctionTrendControl, 
1277
Configuring trends for the trend window, 1284
Display in FunctionTrendControl, 1275
Linear Interpolation, 1339
Representation formats, 1339
Single Values, 1339
Staggering, 1342
Stepped trend, 1339
Trends:staggering, 1342

Trends:dynamic display, 1343
Trends:resolution of curve display, 1343
Trends:static display, 1343
Trends:time jump, 1346

Trends:time overlaps, 1346
Trends:time range, 1343
Trigger, 256
Trigger:cyclic trigger, 820
Trigger:event-driven trigger, 819
Trigger:hotkeys, 822
Trigger:tag trigger, 820
Triggers

Cyclic Triggers, 819
modify, 862, 875, 883

Tube objects, 473, 601
Type, 458, 542
Type of dynamics, 226, 408, 410
Types of library objects, 646

U
Underline, 446
Ungroup, 617
Unit font, 360
Unit offset, 355
Unit text, 355
Units, 1543

Page layout editor, 1543
Universal Time Coordinated, 64
Unlocking message, 1851
Unlocking messages, 1096

Alarm Control, 1096
Unsigned 16-bit value, 180
Unsigned 32-bit value, 183
Unsigned 8-bit value, 178
Unsigned Dword, 183
Unsigned word, 180
Update, 1357, 1402

starting, 1332
Starting, 1405
stopping, 1332
Stopping, 1405

Update cycle, 450
Updating, 336, 530, 541, 553, 559, 598, 606, 1326

Start, 1365
Stop, 1365

Upon change, 269
Upper frame color, 371
Upper limit, 542
Used, 336
UsedPercent, 336, 338
User administration, 1851, 1853, 1854
User Administration, 1830
User Administrator, 1463

Project documentation, 1463
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User archive, 1395, 1491, 1671
Displaying data, 1395
Output of configuration data, 1671
Printing, 1491

User Archive - Runtime, 1529
Report table, 1529

User archive data, 1491
Logging, 1491

User archive report, 1658
Data Selection, 1660

User archive runtime, 1660
Report table, 1660

User archive runtime table, 1658, 1660
Inserting, 1658
modify, 1660

User archive selection for the project documentation, 
1660
User archives table, 1660

Selection of the data for a message report, 1660
User authorization, 1851, 1853, 1854
User cycle (1 - 5), 269
User group

DefaultGroup, 1850
Emergency_Operator, 1850

User hierarchies in PCS7:Default Authorizations, 
1851
User hierarchies PCS7, 1854

Inserting, 1818
User interface language, 1719

Switching, 1728
User text block, 905

Adding, 909
Features, 910
Removing, 912

User value 1-4, 450
UserArchiveControl

Configuring the data export operation, 1034, 1204, 
1246, 1300
Configuring the status bar , 1025, 1196, 1239, 
1293
Configuring the toolbar, 1025, 1196, 1239, 1293
Marking the selected cells and rows, 1021, 1192
Online configuration, 1036, 1205, 1247, 1301
Properties of the table elements, 1021, 1192
Sorting by column header, 1021, 1024, 1192, 
1195
Table element colors, 1021, 1022, 1192, 1193

User-defined group message, 978
Adding, 979, 982
Deleting, 983
Features, 978

User-defined menu, 659
create, 662
modify, 664

User-defined toolbar, 659
Users, 1813
UTC, 64

V
Value Import and Display Text of a Text List, 560
Value input, 434, 531, 1851
Value ranges, 359
Values outside the limit range, 1387
Variable

create, 189
Creating a process tag, 189
Creating structure type, 192
Data type, 185
Defining substitute value, 199
Displaying transferred tags, 1911
Internal tag, 166
Specifying limit value, 198
Start value, 189
Usable data types, 166

VBS action, 414
Triggers, 875

VBS action:creating, 868, 871, 874
VBS action:Edit VBS action, 414
VBS editor, 1460

Project documentation, 1460
View selection for the project documentation, 1673
Viewing project documentation, 1812
Views, 1673
Viewsprojectdocumentation

View selection , 1673
Virus scan, 111
visible, 242
Visible layers, 260
Visualization of messages, 1018

Marking the selected cells and rows, 1024, 1195
Message blocks, 1018
Message blocks and message lines, 1016
Properties of the table elements, 1021, 1192
Sorting by column header , 1024, 1195
Table element colors, 1022, 1193

W
Warning, 336, 359, 918
Warning color, 359
Warning Display, 359
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Warning for hard disk capacity, 1442
Warning limit, 542
WarningColor, 336
Went Out Unacknowledged, 461
Wheel Zoom, 126
Width, 326, 371, 438, 1581
Width Button 1-4, 438
Width in pixels, 254
WinCC, 34, 1718

Client project, 48
Editors and functions, 146
Exiting Runtime, 137
Illegal characters, 152
Language support, 1718
Message archiving, 994
Multilingual configuration, 1718
Multi-user project, 47
Naming conventions, 152
Options, 146
Project, 34
Project type, 46
Runtime, 132
Setting up Autostart, 135
Single-user project, 46
Starting, 29
Starting Runtime, 132
Terminating, 32
WinCC client, 48
WinCC Explorer, 34

WinCC Adapter, 1839, 1844
WinCC Alarm Control, 1014, 1070

Changing output options, 1649, 1651
Dynamizing Output parameters, 1649, 1651
Modify layout, 1649, 1651
Reporting, 1649, 1651
Runtime documentation, 1529

WinCC AlarmControl
Default functions, 1041
Standard functions, 1207, 1249, 1303

WinCC application, 1864
create, 1865

WinCC Chipcard Terminal, 1833, 1834
WinCC client, 48
WinCC Control, 1485

Activating report functions, 1485
WinCC Control Runtime Printprovider, 1634

WinCC controls, 320
IXDiskSpace.DiskSpace, 320
Siemens HMI Symbol Library, 320
WinCC Alarm Control, 320
WinCC Digital/Analog Clock Control, 320
WinCC FunctionTrendControl, 320
WinCC Gauge Control, 320
WinCC Media Control, 320
WinCC OnlineTableControl, 320
WinCC OnlineTrendControl, 320
WinCC Push Button Control, 320
WinCC Slider Control, 320
WinCC UserArchiveControl, 320

WinCC Controls
IXDiskSpace.DiskSpace, 335
Siemens HMI Symbol Library, 340
WinCC Digital/Analog Clock Control, 349
WinCC Gauge Control, 355
WinCC Slider Control, 368

WinCC Controls:IXDiskSpace.DiskSpace, 335
WinCC Controls:Siemens HMI Symbol Library, 340
WinCC Controls:WinCC Digital/Analog Clock 
Control, 349
WinCC Controls:WinCC Gauge Control, 355
WinCC Controls:WinCC Slider Control, 368
WinCC Explorer, 34, 35, 209, 210, 286, 652, 657

Buttons, 39
Closing, 32
Closing project, 32
Data Window, 41
Edit menu, 36
Elements, 35
File menu, 36
Help menu, 36
Menu bar, 36
Navigation window, 41
Open project, 29
opening, 29
Searching, 44
Start mode, 29
Status bar, 40
Structure, 35
Title bar, 40
Toolbar, 39
Tools menu, 36
Tooltip, 41
View menu, 36
Window, 41
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WinCC Function Trend Control, 1373
Changing output options, 1645, 1647
Dynamizing Output parameters, 1647
Modify layout, 1645, 1647
Reporting, 1645, 1647
Runtime documentation, 1529

WinCC FunctionTrendControl, 1274
WinCC logon, 1809
WinCC Media Control, 364
WinCC object, 1861, 1889, 1896

Copy, 1891
Copying to library, 1896
Creating, 1890
Creating model solutions, 1896
Delete, 1891
Deleting in library, 1896
Importing, 1892
Moving, 1891
Moving to library, 1896
Rename, 1891
Renaming in library, 1896

WinCC Online Table Control, 1186
Changing output options, 1635, 1638
Dynamizing Output parameters, 1638
Modify layout, 1635, 1638
Reporting, 1635, 1638
Runtime documentation, 1529

WinCC Online Trend Control, 1220, 1316, 1337
Applying tag properties, 1356
Automatic trend parameter configuration, 1356
Changing output options, 1640, 1643
Curve parameter, 1356
Dynamizing Output parameters, 1643
Modify layout, 1640, 1643
Reporting, 1640, 1643
Runtime documentation, 1529
Zoom in, 1369
Zoom out, 1369
Zooming, 1369

WinCC project, 1861, 1864, 1879, 1888, 1896
Copying to library, 1896
create, 1865
Creating, 1880
Creating model solutions, 1896
Deleting in library, 1896
Importing to the SIMATIC Manager, 1886
Loading, 1875, 1884
Moving to library, 1896
opening, 1897
Opening, 1888
Renaming in library, 1896

WinCC server, 1118

WinCC system messages, 950, 960
WinCC User Archive Control

Printing, 1491
Runtime documentation, 1529

Window, 41
Window "Object Properties":Opening the "Object 
Properties" Window, 433
Window Contents, 513
Window Cycle, 269
Window display in Runtime, 513
Window height, 1581
Window On Top, 119
Window selection, 1851
Window width, 438, 1581
Windows

Account rules, 1838
Domain, 1838
Local security regulations, 1838
Settings for SIMATIC logon, 1838

Windows 2000, 1726
Windows objects, 473, 583, 1558
Windows style, 443
Windows Style, 600
Windows system colors, 347, 352, 361, 373
Windows XP, 1726

Switching languages, 1726
within the layer, 403
Wizard, 887

Interconnection Wizard, 937
Select, 887
System Wizard, 904

WMF, 287
Word, 180
Working environment, 271, 1538
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